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Glossary
(*TN) following a term is a new glossary word devised by the researcher (Terrell Neuage) for this thesis.

Applet Window A program designed to be executed from within another application in which a small 
window opens within the larger window. 

Casual Chatroom Chat (CCC) (*TN) A conversation in a chatroom which is not serious or intended to 
discover details on a subject. Most casual chatroom chat, similar to non-formal pub casual chat, consists 
of conversation typical of, “hi” “hows everyone”.

Chat Events (CE) (*TN) These are all the individual turn-taking texts of a particular participator in a chat 
room, including entering, leaving and lurking.

Chatroom graffiti (*TN) The messages conveyed through the work of graffiti artists are often highly 
political and deliberately aggressive. Some people will go from chatroom to chatroom leaving messages 
but not particpating in actual chatroom conversation: I refer to this as chatroom graffiti.

Chat Utterance Sentence Structures (CUSS) (*TN) These are the sentences of a chat turn-taking. 
Unlike sentences which use nouns and verbs to establish a complete thought, chat sentences are typically 
made up of two to five words or emoticons. I have averaged the amount of words in twelve chatrooms, 
consisting of 1357 lines (turn-takings) and found the average word count, including abbreviations and 
emoticons to be 3.7.

Chatter's-Event-Response-Gaps (CERG) (*TN) This is the pause between chatters who are “speaking” 
with one another. There are often other voices which fill these gaps.

Conversational “lag” (*TN) Conversational lag is a pause where the next speaker has been selected but it 
may be filled with responses from others in the chatroom responding to other turn-takings. The “lag” may 
be caused by many other factors, as I have alluded to above.

Cut utterances (*TN) Due to hitting the entrance key an utterance is cut between turn-takings in a 
chatroom. In some cases several turns of other chatters could occupy this space.

Event Pause (EP) (*TN) This refers to the break between utterances of a user in a chatroom. The most 
usual incidence of this is when the server places an advertisement in the chatroom and it appears between 
utterances. It also occurs when no one writes for a specific period of time.

Lag is the distance between speech events of a speaker in a chat situation, a pause between utterances.

http://neuage.org/All.htm (8 of 14) [3/9/08 11:18:20 AM]



Neuage, Terrell. (2005) "Conversational Analysis of Chatroom talk" Universi...uth Australia, 452 p. + 1 CD-ROM (4 3/4 in.). National Library of Australia

Metaphysical-chat-linguistics (MCL) (*TN) is anticipating what will be said before the completion of 
the utterance, either due to the writer-speaker hitting the “enter” key on the keyboard or the chat server 
not allowing more than a couple of lines at a time to be shown on the screen, thus breaking the 
conversation before it is completed.

Multilogue are the many conversations happening at one time within a chatroom as well as the overall 
conversation of all who are present.

Multiple Selves Chat (MSC) (*TN) Is a feature of chatrooms. The author is able to have several different 
representatives of his or her self in conversation at one time. As only one person can log on a chatroom at 
a time the person wanting to have multiple representation in a chatroom would need to have several 
windows open of the one chatroom but be logged on as a different username in each window.

On-line Discourse Analysis Method (ODAM) (*TN) The method I am developing to study the language 
of on-line communication using abbreviations, misspelled words and emoticons.

On-line native speaker (ONS) (*TN). Speech behaviours are established first off-line, and are then 
modified for on-line use – most notably by the current technology which at least demands that texted 
formats intervene in the “chat” processing.

Person2Person-off-line (P2P-off) (*TN)

Person2Person-on-line (P2P-on) (*TN)

Readerly and Writerly Texts These are translated from Barthes' neologisms lisible and scriptable, the 
terms readerly and writerly text mark the distinction between traditional literary works such as the 
classical novel, and those twentieth century works, like the new novel, which violate the conventions of 
realism and thus force the reader to produce a meaning or meanings which are inevitably other than final 
or “authorized.” (Keep, McLaughlin, Parmar, 2000).  http://www.iath.virginia.edu/elab/hfl0250.html 

Speech Act Disruptions (SAD) (*TN) Sponsorship ads appearing in chatrooms are a performative speech 
act disruption.

Speech Act Community On-line (SACO) (*TN) is where people come together to exchange information. 
What is exchanged is dependent on the chatroom topics. The ability to share meaning and continuous 
conversations within the SACO is what makes it a community. 

Speech situations (chatroom situations) are composed of “speech events” (chatroom events) (Hymes, 
1974) and these activities have rules governing the use of speech getting, for example, getting to-know-
you conversations (Gudykunst and Kim 1997 p. 328).

Tangent Topic Thread (TTN) (*TN) This occurs when the original chat topic is taken over by others in 
different strands of unrelated chat. 
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Text-Based-Chatrooms (TBC). (*TN) Text-Based-Chatrooms are a blip in the history of human writing 
and only represent a short time period of computer-mediated communication (CMC). As more and more 
chatrooms add multimedia attributes, writing may become a minor or even a non-existent form of on-line 
communication. With voice-boards and voice-forums such as available from Wimba (http://www.wimba.
com/) and chatrooms being 3D with virtual worlds which use voice and keyboard commands to move 
around the screen and with the growing use of avatars, TBCs may fade into a past genre of electronic 
writing peculiar to the period from approximately 1993-2003. 

Thread is a line of conversation.

Thread-framing   Thread-framing is a phenomenon in chatrooms, where a topic beginning and ending 
are marked. In a chatroom these framed pieces of conversation are not necessarily sequential. They twist 
around, stop and start, and several may occur at one time in a seemingly chaotic fashion. Framing gives a 
starting and finishing point to a thread.

Virtual-Mindfield (*TN) Creations of one’s world-view on-line.

 

Abstract
This study of online communication situated in chatrooms has revealed the importance of investigating 
this medium, at this time. The chatrooms of the late 1990s were at the beginning of a shift in texted 
electronic communication to a system where meaning exchange is often fused between the text-messages 
of the sender and the receiver – or, given the text basis of the electronic exchange, the writer and the 
reader. The resultant complexity of this new electronic means of communication has the potential to 
change or at the least to interrupt the otherwise casual “flow of conversation” used in Internet chat, to a 
point that a new language and a new set of behaviours have emerged. In order for there to be a means of 
interpretation of these parts conversational, part text exchanges between participants, close and detailed 
observations are required. But in order to extend analysis beyond mere observation, the full repertoire of 
analytical theories and methodologies for examining “talk”, and text construction and exchange, must be 
pulled into the ambit of the investigation of online chat. Internet relay Chat in all its variability has one 
standard feature: it is a hybrid or “fusion” form of communication. It requires hybridity and fusion in its 
analysis.  

In this study I started in a purely empirical mode, “capturing” seven primary chatroom dialogues. I chose 
several of these sites randomly, based on the ease of their access. As the study progressed, I chose several 
other chatrooms because of my slowly focusing interest in the varying “talk relations” I was encountering, 
and my suspicion that chat users were themselves make chatroom selections by anticipating the online 
social relations offered in various sites, according to the subject matter of the chatroom as signalled in its 
name. While this sometimes was or sometimes was not a safe prediction, it extended the range of sites, 
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techniques and behaviours I was able to collect and analyse, and required only occasional 
supplementation with sampling from sites outside the core selection.  For the most part, this study 
concentrates on seven case studies, each case study being based on a saved piece of representative 
dialogue from one very distinctive chatroom. Together, these case studies demonstrate features peculiar to 
on-line chat which make it very different from the face-to-face chat of everyday conversation – but also 
from any forms of text-based communication. In the broadest sense chatroom “texted talk” combines face-
to-face chat with text-based communication. 

There are however a number of central and distinctive features that disrupt what might otherwise 
traditionally be considered a simple conversational communication model. There is far more in Internet 
Relay Chat than can be explained in a “sender-message-receiver” relation. Most obviously such features 
include for instance the use of avatars to replace or to represent the physically absent “speaker”; text-
graphic “emoticons” as interfaces to replace words or aural elements representing emotions; the fleeting 
motion of scrolling text; silence or “lurking” by participants as itself  a form of message: the complex 
“braiding” and overlap of various conversational “threads” and the need to compensate and interpret 
discontinuity of posted messages; as well as new forms of word structure, such as standardised 
abbreviations and idiosyncratic mis-spellings. Each of these – and the many more complexities each of 
them conceals – signals major shifts in the communicative activities of online “chat” communities. 

To test ways in which these new communicative forms might be examined and understood, in this study, I 
capture and sample a moment in time of on-line exchange behaviours, and look at them through the lens 
of a wide range of linguistic and discourse theories. Using these theories demonstrates how, despite the 
differences in “chat” conducted on-line from that carried out face-to-face, on-line chat and “natural 
conversation” share some features. Analytical theories developed for inquiry into both conventional 
speech and print-based text reception, can be used for examining on-line chat, and are able to produce 
findings which help explain these new communicative acts. The seven case studies and the theories and 
associated methodologies used to assess are as follows:

Disaster Chat (Hurricane Floyd). Beginning with Reading Response Theory as a text-based analytical 
tool, this Case Study of a natural-disaster-based chat site shows that in on-line chat, both the person 
writing and the one (or many) reading are co-language-meaning creators. 

Instant Messenger. Using the one-on-one talk relation of the Instant Messenger system, this Case Study 
focuses on the technologisation of online talk, and its foundation in the ideas behind Computer Mediated 
Communication. I approached this case study with two questions related to Computer-mediated 
communication: “Do computers change conversation?” and “Are Instant Messenger chatrooms closer to 
off-line-person-to-person conversation than the multi-dialogue found in a multivoiced chatroom? ”   The 
findings suggest that computers do indeed change conversation, and that Instant Messenger chat is closest 
to person-to-person communication – but that even here, the “texted” nature of the talk has produced 
differences.

Celebrity Chatrooms (Britney Spears). In this Case Study the high levels of text-graphic fusion elements 
and abbreviations invited a Semiotic analysis; unexamined on-line communication’s potential to evolve 
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cross-communicative formats. This study reveals analysis within the same repertoire of images, words 
and mixed-mode forms, such as specific “chat community” conventions of abbreviation.

Astrology Chatrooms. Here, Speech Act Theory is used to examine the practical and goal-related uses of 
online language, and so extends the study into how chat participants on-line direct their communicative 
activities towards social actions – and whether these vary in the on-line world from those used off-line. 

General Chat. To assess how the more open chat communities entering general-topic chatrooms on a less 
regular basis, make sense of the chat behaviours present, it is important to understand exactly what it is 
that arriving chat participants “read” from the online texted-talk on screen.  Discourse Analysis examines 
the message structures organizing an on-line community into consensual, resistant or negotiative 
communicative moments.  In the case of General Chat it is able to assess how the communicative 
elements appearing on the screen provide participants with the general or generic “cues” to enter and 
participate in a conversation. 

Computer Chat (on the topic of expert software WEB3D). This case study asks does an expert community 
chat-site operate in the same conversational environment as general chat participants, or as in sites 
offering focused talk relations among strangers. Conversational Analysis, used to examine the structuring 
rules of natural or real-world conversation, has uncovered regulatory behaviours in talk, such as ways to 
perform sequential organization of talk, allocate turn-taking and negotiate repair to conversational break-
down. CA is able to depict interactional competence in conversation. This Case Study examines how 
useful it might be in reading the rules of chatroom talk. 

Baseball Chat. Here an informal “expert” group, with regular and casual users intermixed, is examined, to 
test whether the specialist forms used to demark a specific chat “community” are annexed in from outside 
“natural” baseball chat, or evolve new online “baseball chat” forms of their own. This study applies 
techniques for describing grammatical systems drawn from a number of  Linguistic Schools, to examine 
how many of the common grammatical conventions – such as word order, sentence structure, question 
formation, do not hold up in on-line chat. Further: baseball-chatters on-line do not use the same specialist 
formations as their off-line brethren – raising interesting questions as to the special pressures of online 
chat, even in very specific talk communities with strong offline conventions in their speech. 

Other chat samples saved and referred to in this thesis to enhance and support points include: 911 Chat, 
Afghanistan Chat, Bondage Chat, CNN News Chat on 911 and Christian Chat.

Electronic communication has opened a new realm for communication – both as necessary information 
exchange, and as social play and psychological development of self/selves. With continually evolving 
innovations enabling new communicative activities, we must anticipate new and unpredictable – even as 
yet indescribable – communicative behaviours and understandings. By applying more detailed forms of 
textual analysis to the actual examples of computer mediated communication (CMC) my project sets out 
to detect new modalities as they evolve. 

Chat on-line is “global” only to the extent of accessing many varying “local” structuring references. A 
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“global” or universal “chat speak” is not evident in on-line talk selections – for all the emergence of 
expressive repertoires in netiquette, emoticons or IRC/SMS abbreviation. In this study, I suggest that what 
is evolving here is not – or not yet – separated from speech in the physical world, to the extent of 
disconnection from dominant discursive framings: that on-line texted-talk “chunks” its interactions in 
familiar ways. I am also suggesting however that at the level of “chat” or interpersonal interactivity, new 
behaviours abound. 
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Picture Poems by Terrell Neuage HOME ~ Next Picture Poem ~ Previous Picture Poem

♠ romantic poem of the week 

 

Why is it

When I dance

On your

Roof

At midnight

You have dreams

That 

We are 

Making love

In the rain? 

© Terrell Neuage 1997 Adelaide SA
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this picture poem is 8 by 10 inch and is available from terrellneauge@yahoo.com 

(NOTE 1 - EVERY PICTURE-POEM IS DIFFERENT ONLY THE WORDS REMAIN THE 
SAME  
NOTE 2 - This mat frame is an example of a coloured frame and each pp is available with hand 
painted mat or plain - please say which you wish  
NOTE 3 - All poems less than about 12 lines by Terrell are available as picture poems  
NOTE 4 Other writer's texts are not available in picture-poem form) 
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Leigh Neuage (July 6 1983 - August 16 2003) 
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Picture Poems and other writing and poetry and art from Adelaide, South Australia (July - August) by 
Terrell Neuage and New York City (September - June each year) - Australian gifts, Australian art, 
Adelaide artist, Australian Poetry (restlessdancer products)

These picture poems are available at $20 including postage and handling from 
tneuage@gmail.com updated Wednesday, September 24, 2006

  

latest picture poem

Romantic Philosophical
3-billion women Children Never Grow Old

A better me Lovers

A better me Behind every thought

As far as the song we sing So special 

Balloons Beneath the sea

Bandit Come along weeping mother 

Children playing Flash
I was born this way

Darkside of the Moon Man at the station

Each time I dream Saw an angel

Every scent Snowmen Dance

Exotic places on your body Why we were born with boots on
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Flash Crowded

Halfway to where we were going stage 

Held on to me Never saw a setting Sun without

Holding hands supercalifragilisticepialidocious 

Holes in time Take now tomorrow is born 

As far as I could imagine ten 

I am you Test a dream 

I bet on a race that bore your name THIS MOMENT 

I danced with you in my dream last night Never thought 

I don't know who you are Words Words Words 

I got caught tofu 

I laugh in French If I had the time I'd be 

I lost you in the tunnels The well from which we draw 

I loved you once If I were tomorrow 

If you teach me passion Too many to choose from 

In disguises you and I appear Nature Spirits 

In the lobby Triangle world 

I promised you the world The problem with being a writer

I wanted you Proud to be a communist 

Laughing at the busstop Yoko's tits 

Let go yesterday gypsy sitting naked

Like I once filled you Black or White 

Meadows of rain Time is a frozen waste land 

Melting winter in your warmth I no longer jump for joy 

My hunger for you The Mind of God 

My Kiss We are the same 

My queen Dawn 

Answers in the wind 

My Skin fell in love with a caterpillar 

Once upon a time a long time ago Surrounded by the past 

Our Wedding Dress   
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Patterns on my SKIN   

  

Reservations on forever   

Saw so many in love today  

Seagulls  

Secrets   

Show me  

Ships at sea ships at sea  

Snowfall freezes the feet   

Strangers on the Moon   

Tango   

Technology  

The castle I was building for you   

Trucks  

Use to dream in black and white   

Waking with you   

Wander through your mind  

We are the same as so long ago   

We got lost in the tunnels   

We were children playing by the sea  

When I dance on your roof at midnight   

When I dance on your rooftop   

When you cling onto me   

GLOW and Glow in the dark   

When your kisses began to rain   

Where your kisses meet my dreams   

Windows open   

Words words words   

You are the predicted high   

You came so fast   

You cling on to me  
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You took my love   

Your breathing  

Your kisses  

Your love   

Your love was a rushing train  

Your Music   

Your nails   

Your Socks  

Your touch  

You took my love so far inside  

Wander through your thoughts  

When I loved you  

Where my kisses meet your dreams  

While thinking about you  

Winter is cold  

   

1.  1. I threw away my umbrella 
2.  2.        As far as the song we sing

3.  3.        Tree - the story
4.  4.        Pick a dream and stay awake in it

URL AND ORDER OF PICTUREPOEMS AS LINKS ON INTERNET following Racehorse sequence 

●     http://neuage.indiko.com/racehorse.htm I BET ON A RACEHORSE
●     http://neuage.indiko.com/picture_poems/rooftop.htm ROOFTOP 
●     http://www.geocities.com/picture_poems/tango.htm TANGO 
●     http://www.geocities.com/picture_poems/events/station.htm MAN AT THE STATION
●     http://www.geocities.com/picture_poems/romantic/darkside.htm DARKSIDE 
●     http://www.geocities.com/picture_poems/romantic/flash.htm FLASH 
●     http://www.geocities.com/picture_poems/romantic/iamyou.htm I AM YOU 
●     http://www.geocities.com/picture_poems/romantic/hunger.htm MY HUNGER FOR YOU 
●     http://www.geocities.com/picture_poems/romantic/socks.htm SOCKS
●     http://www.geocities.com/picture_poems/romantic/strangers.htm STANGERS 
●     http://www.geocities.com/picture_poems/romantic/wedding_dress.htm My wedding Dress 9/20/06
●     http://www.geocities.com/picture_poems/angels.html ANGELS 
●     http://www.neuage.org/picture_poems/balloon.html BALLOON 
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●     http://www.neuage.org/picture_poems/behind.html BEHIND 
●     http://www.neuage.org/picture_poems/better.html a BETTER ME 
●     http://www.neuage.org/picture_poems/black.html DREAM IN BLACK
●     http://www.neuage.org/picture_poems/boots.html BOOTS 

�❍     http://www.neuage.org/picture_poems/weekly/weekly3-14.html We are the same 
�❍     http://www.neuage.org/picture_poems/weekly/weekly3-21.html The mind of God 
�❍     http://www.neuage.org/picture_poems/weekly/weekly3-28.html Proud to be a communist
�❍     http://www.neuage.org/picture_poems/weekly/weekly4-04.html I wanted you 
�❍     http://www.neuage.org/picture_poems/weekly/weekly4-11.html I no longer jump for joy 
�❍     http://www.neuage.org/picture_poems/weekly/weekly4-18.html Born this way 
�❍     http://www.neuage.org/picture_poems/weekly/weekly4-25.html TIME IS A FROZEN WASTE LAND 
�❍     http://www.neuage.org/picture_poems/weekly/romo2.html ROMANTIC POEM FOR MAY 02 - 02 

(gypsy sitting naked) 
●     http://www.neuage.org/picture_poems/born2.html BORN THIS WAY 
●     http://www.neuage.org/picture_poems/blue.html BLUE ISN'T A COLOUR 
●     http://www.neuage.org/picture_poems/romantic/bandit.htm BANDIT 
●     http://www.neuage.org/picture_poems/romantic/french2.htm I LAUGH IN FRENCH
●     http://www.neuage.org/picture_poems/romantic/glow.html BECAUSE YOU GLOW IN THE DARK 
●     http://www.neuage.org/picture_poems/crowded.html CROWDED 
●     http://www.neuage.org/picture_poems/saw.html SAW
●     http://www.neuage.org/picture_poems/dino.html DINO 

�❍     http://neuage.indiko.com/romo/teach_me_passion.htm Teach me passion (12-28-2000)
�❍     http://neuage.indiko.com/romo/3-billion.htm Three billion women
�❍     http://neuage.indiko.com/romo/my_kiss.htm My Kiss 
�❍     http://neuage.indiko.com/romo/danced.htm Danced 3 February 2001
�❍     http://neuage.indiko.com/romo.htm 

●     http://www.neuage.org/picture_poems/horses.html HORSES
●     http://www.neuage.org/picture_poems/leaf.html LEAF
●     http://www.neuage.org/picture_poems/promisedworld.html PROMISEDWORLD
●     http://www.neuage.org/picture_poems/weeping2.html WEEPING mother
●     http://www.neuage.org/picture_poems/lovers.html LOVERS
●     http://www.neuage.org/picture_poems/seagull.html SEAGULLS
●     http://www.neuage.org/picture_poems/sea.html We were children playing by the seashore 

�❍     http://www.neuage.org/picture_poems/weekly/weekly5-09.html surrounded by the past 10 May 2000
�❍     http://www.neuage.org/picture_poems/weekly/weekly5-16.html snowfall - with boots on May 17, 2000
�❍     http://www.neuage.org/picture_poems/weekly/weekly5-23.html caterpillar
�❍     http://www.neuage.org/picture_poems/weekly/weekly6-06.html Answers in the wind 
�❍     http://www.neuage.org/picture_poems/weekly/weekly6-20.html Dawn 
�❍     http://neuage.indiko.com/weekly/snowmen.htm Snowmen dance 

●     http://www.neuage.org/picture_poems/secret.html The secrets of my success 
●     http://www.neuage.org/picture_poems/self.html in disguises
●     http://www.neuage.org/picture_poems/showme.html show me an ordinary moment 
●     http://www.neuage.org/picture_poems/sing.html we can only go as far as the song we sing 
●     http://www.neuage.org/picture_poems/special.html so special we are 
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●     http://www.neuage.org/picture_poems/stage.html We are all on the world stage 
●     http://www.neuage.org/picture_poems/sun.html Never saw a setting sun 
●     http://www.neuage.org/picture_poems/super.html supercalifragilisticepialidocious  

feelings 
●     http://www.neuage.org/picture_poems/takenow.html take now tomorrow is born 
●     http://www.neuage.org/picture_poems/technology.html technology will never stop my neolithic desire for 

you 
●      http://www.neuage.org/picture_poems/ten.html Words poured out 
●     http://www.neuage.org/picture_poems/test_a_dream.html test a dream and stay awake in it 
●     http://www.neuage.org/picture_poems/thismoment.html unlike anything ever gone before it 
●     http://www.neuage.org/picture_poems/thought.html Never thought I could be in love 
●     http://www.neuage.org/picture_poems/threw.html when your kisses began to rain down 
●     http://www.neuage.org/picture_poems/time.html if I had the time 
●     http://www.neuage.org/picture_poems/tofu.html Between the curds and the whey 
●     http://www.neuage.org/picture_poems/tomorrow.html If i were tomorrow 
●     http://www.neuage.org/picture_poems/too.html too many to choose from 
●     http://www.neuage.org/picture_poems/tooklove.html you took my love so far inside 
●     http://www.neuage.org/picture_poems/train.html Your love was a rushing train 
●     http://www.neuage.org/picture_poems/tunnel.html I lost you in the tunnels
●     http://www.neuage.org/picture_poems/well.html The well from which we draw 
●     http://www.neuage.org/picture_poems/when.html When I loved you 
●     http://www.neuage.org/picture_poems/where.html Where my kisses meet your dreams 
●     http://www.neuage.org/picture_poems/while.html While thinking about you 
●     http://www.neuage.org/picture_poems/whoyouare.html I don't know who you are 
●     http://www.neuage.org/picture_poems/wide.html Nature spirits 
●     http://www.neuage.org/picture_poems/window.html Like I once filled you

�❍     http://www.neuage.org/picture_poems/romantic/8-03.html Winter is cold 
�❍     http://www.neuage.org/picture_poems/romantic/8-10.htm 8-10-2001 Windows open in the breeze 
�❍     http://www.neuage.org/picture_poems/romantic/8-17.htm Becuase you glow in the dark 

●     http://www.neuage.org/picture_poems/winter.html Melting winter in your warmth 
●     http://www.neuage.org/picture_poems/wordsx3.html wORDS wORDS wORDS 
●     http://www.neuage.org/picture_poems/world.html triangle world 
●     http://www.neuage.org/picture_poems/writer.html The problem with being a writer 5/21/06 - edited 
●     http://www.neuage.org/picture_poems/stallion.html You cling on to me 
●     http://www.neuage.org/picture_poems/romantic/scent.htm
●     http://www.neuage.org/picture_poems/romantic/laugh.htm
●     http://www.neuage.org/picture_poems/romantic/you_are.htm you are the predicted high 
●     http://www.neuage.org/picture_poems/why.htm why is it when I dance on your rooftop
●     http://www.neuage.org/picture_poems/zebra.html Black or white August 31, 2006
●     http://www.neuage.org/picture_poems/wander.html I like to wander through your mind September 14, 2006
●     http://www.neuage.org/picture_poems/trucks.htm Like any man playing with his trucks 9-15-06 
●     http://neuage.org/picture_poems/ships.htm ships at sea rain on roof 9-19-06 
●     http://neuage.org/picture_poems/breathing.htm when your breathing becomes irregular 9-20-06 
●     http://picture-poems.neuage.info/beneath.html beneath the sea 9-21-06 
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●     http://picture-poems.neuage.info/holesintime.html Holes in Time 9-22-06 

●     latest picture poem http://picture-poems.neuage.info/ozone.html I no longer jump for joy 

●     TOP OF LIST DATE ~ ALPHABETICALLY
●     hole in time
●     caught in the revolving doors
●     holding hands
●     mother
●     magic
●     heaven
●     scram
●     score
●     sacraments
●     If I could believe 

 

●     http://www.neuage.org/picture_poems/yoko.html NOT FIXED HERE DOWN
●     

●     

●     

http://www.neuage.org/picture_poems/wantedtoletgo.html let go of yesterday 
●     http://www.neuage.org/picture_poems/we.html
●     http://www.neuage.org/picture_poems/whispered.html
●     http://www.neuage.org/picture_poems/you.html
●     http://www.neuage.org/picture_poems/wantedtoletgo.html
●     http://www.neuage.org/picture_poems/we.html
●     
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romantic poem for May ninth 2000 from Adelaide South Australia by Terrell Neuage

WEEKLY ROMANTIC POEM FOR Tuesday, May 09, 2000 last week's romantic poem of the week NEXT 

WEEKLY POEM random picture poem /ALL / home 

Trip 2006 Albany to Adelaide 

updated Tuesday, 29 August, 2006 1:57 PM

weekly (philosophical of sorts) poem - http://neuage.indiko.com/weekly/snowmen.htm 

 

I was staying at a camping ground a few moments out of Hilo

when first I saw her running toward me

Then in kisses and embraces she enveloped me

She had some white slip thing on that girls

in the '60s wore

and of course bells, beads and scent of sandalwood 
and patchouli oil.

Then she kissed my feet and said she had waited

all her life for me.

I couldn't wait another moment to have her

and did in a cloud of frankincense and myrrh.

She said I was surrounded in white light

as she lit up some Maui-wowie and took more psilocybin

She even dubbed me Saint Terrell

and for decades later she addressed me that way...

Now the world seems so different from

those magical days in Hawaii 25 years ago

Now no one calls me Saint Terrell:

Not me kids

me friends
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tax office

neighbours

nor the ex-thingie (who writes me 'dear shithead')

Chialeah visited me in New Orleans and Los Angles

in the '70s and rambled on about other lives

realms, bodies (the one she had now was enough for me), dimensions

It was all peu de chose to me

Her body and responses throughout the nights-days-weeks...

was enough for every life, dimension, body...

She wanted my soul

I just wanted more of her body (the physical one she had with her then)

an equal trade in any man's book (eternity for a good fuck).

I have no idea where in the world she is

if at all she is on this planet

or whether in fact she now has my soul

(I've sold, traded and given it away so often ~ whom ever ends up with it is a loser for sure)

Maybe her daughters whose father(s)

could have been any number of us saints

are here still (as my dreams reveal)

But every once in awhile

when the day gets to me just a bit too much

I remember her

whispering

'Saint Terrell'

and my satisfied body and I escape smiling

one more time. 
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(c) Saint Terrell Neuage (Adsit - alias Brother Arthur) Victor Harbor South Australia 1993.  

NEXT PICTURE POEM http://neuage.indiko.com/racehorse.htm

1.  I threw away my umbrella 
2.  As far as the song we sing 
3.  Where my kisses meet my dreams 
4.  Pick a dream and stay awake in it 
5.  Tree - the story 

When I first sought her love it was the '60s

Everyone had a go of her

'make love not war'

We all chanted it

we all wanted her

I wanted her just to myself

so did everyone else.

Like being at the service department

in a market

Get in line - wait for your number
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I always take two numbers

it is a habit

from when I wanted her twice an hour

NUMBER 41   

'A kilo of Brie please'

NUMBER 42

Breasts and thighs please

I never did get her all to myself

She had a daughter

gained a lot of weight

No one wanted her

She committed suicide

no one lined up for her funeral.

            9-10-94 Victor Harbor SA

I lost her at an orgy in 1969 in San Francisco

So many arms-legs-and other parts...

Like a caldron of starving snakes slithering sliding

frantic tongues in eager mouths open wide

exploring/experimenting/enjoying/experiencing

Did all those parts regroup - get back to their owners

Or did that pile of bodies stay entangled

and is now moving across the planet

her as its head

A multinational spider-web of lust

Engulfing all that goes before it

like love constantly does
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without me

again

this picture poem is 8 by 10 inch and is available 

Other poems: COLLECTION ONE ~ COLLECTION TWO ~ COLLECTION THREE Begin World 
Wide Web poetry journey ~ 

BEGIN Terrell eating corn in Clilfton Park 
New York 1952 PHOTOS ~ terrell ~ Picture Poem Sampler- order Picture Poems 8x10 matt framed individually 
made to order $15 each includes posting from terrellneuage@yahoo.com Leigh Neuage (July 6 1983 - August 
16 2003) 

To view a list of picture~poems now on line please go to

This picture poem ( 8 by 10 inch) is available for sale

Leigh Neuage (July 6 1983 - August 16 2003) 

ªNext Picture Poem ª romantic poem of the week ª picture poems 
online ªtHIS mOMENT'S tHOUGHTª poems collection 1 ª poems 
collection 2 ª poems collection 3 ~ All Picture Poems ~ Weekly Poem 

♠neuageVIEW

ªHomes for rent upstate 
New York 

Images of Poems

♠ODAM
♠Homepage 

 ♠Next story  

♠ Tree 

♠

curricula de vita 

childrens stories 

PhD thesis

photos
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tofu times 1, 2, 3

♠Restlessdancer

♠BLOG: Albany, New York; Utrecht, Holland; Brugee, Belgiuim; Hamburg, Germany; Beijing, China; 
Singapore, Adelaide, South Australia; Melbourne, Sydney, Australia; Albany, New York: June 14, 2005 
- September 06, 2005

Try This ~ home1 ~ home2 ~ Socks ~ My Skin ~ diabolical bong 
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BACK HOMEcollection 2 

Terrell.Neuage@unisa.edu.au 

COLLECTION 1

 

 

Often I reached out

Often I came close

Often I pulled back

if there was a way to change

wave a magic wand

command a jeanie

roll a lucky dice

Take me deep

Swallow my pride

Tie me down

Chain me up

Let bleed desire's fire

on freedom's alter
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before sacred oaths

dissolve saturn's grip that strangles silken whispers

before YES is breathed

and dies without belief

Like I do

each time I reach out

then pull back

12-25-93 Victor Harbor copyright Terrell Neuage(1151) 

While reviewing the past

the way it was

how we were

such easy thoughts

nothing ever to worry

I realized

I saw

I knew

now was just a cartoon

of what would have been

if we could have

been 
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now

then

 

12-25-93 Victor Harbor copyright Terrell Neuage(1990)

Broke the mode

of who I was

now you see

the source of my shadow

the end of my projection

the face behind every mask.

Just before midnight

I began a new day

another era

a beautiful me

alone in flight

over my broken mode.

So the who you see 

who looks like me

but acts so free

is but master of ceremony

grand performance
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finally on stage

with little left to offer

but

the way I am

again today

in broken mode

once again I am.

 

12-25-93 Victor Harbor copyright Terrell Neuage(99D)

So sure

that this was the right direction

everything always

had led to this spot

until we discovered

that we weren't here

and neither was the spot
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12-26-93 Victor Harbor copyright Terrell Neuage(1342 B)

 

We drew a line

in the sand

but the tides

washed us away

leaving the line

that we drew

dividing us

from being one

to fight the tides

that came

and took us 

away
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12-26-93 Victor Harbor copyright Terrell Neuage(1745 B)

Buried treasures

like hidden talents

leaves us poor

and all alone

with no one

sharing

what we'd have

if hidden treasures

and buried talents

weren't.

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(99 D) 

Shattered illusions

Scattered conclusions

Battered delusions

dissolved by the dawn of reason

Now nothing is left

but created reality
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so clear

I can see forever

Hello New Morning

Good Bye every night

12-93 Victor Harbor copyright Terrell Neuage(1256)

At a final frontier

we conquered fear

to devour

each other

like any

cannibal of love

would

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(62 D)

The day after

The night before

left me

wanting to wake with you
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once again

in the day after

the night before

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1405)

 

This year so quickly went

I went back

to do it once again

just to know

it really had happened.

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1565) 

I looked in the dictionary

to find meaning

but no explanation
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cleared up

my wonderment

of what

this means

You and I

three words in the dictionary

one in my mind.

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(512)

I always thought

one more would be enough

and when it is

it will be

But for now

here I am

only one more

from being enough.
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12-26-93 Victor Harbor copyright Terrell Neuage(288)

 

I was wondering

what will be the last word said

the final line written

the last caress

the final bite

before I die

then I realized

I wouldn't remember anyway

so on I ramble

write

touch

and eat

like any eternal consumer

would

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(842)
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If each thing done

we do as

that to be our masterpiece

then our life

that will be

 

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(349 A)

 

Again

my friend

the end

does send

this trend

again

ABOUT FACE 

CHANGE DIRECTION
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whisper loudly

the blind feel what we don't see

the deaf see what we don't hear

the lonely know every face in the crowd

but at the end

I'll still be your friend

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(6 B)

 

'Lucky me'

said the tree

'I will never be

lost on a freeway

short on what to say

found shopping

seen hopping

lucky me

lucky me

said the tree
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12-26-93 Victor Harbor copyright Terrell Neuage(956 D)

All the advice ever asked

never led anyone to the stars

all the questions pursued

never changed the unexpected

all the theories so explained

never

ever

and it will still all be

the same

again tomorrow

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(12)

 

'Oh No! Oh No!'

said the tree

and all the people stopped
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to question a tree

that would talk

but never more

did that tree say

And that is how

the religion of the tree began

and why everyone

chants

'Oh No! Oh No!'

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1155 B)

All our possessions

are but props

to insulate our space

before we became to know

that we never

needed them anyway.
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12-27-93 Victor Harbor copyright Terrell Neuage(12 B) 

Cold!

Only the physical body knows

take away the cold

I'm still here

take away my body

the cold remains

if I could

I would be

a naked thought sitting on an arctic flow

and diving into frozen illusion tundra

I'd swim in the cold

and pretend my body was with me

like I do now

in this cold world

I've been given to wander.
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12-27-93 Victor Harbor copyright Terrell Neuage(120)

As fragile as each new moment is

the strength to proceed into in

is but BELIEF

given wings

to give flight

when needed to be.

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(61 D a)

Nature brought forth humans

because

dinosaurs couldn't paint

amoebas wouldn't carry a tune

apes refused to write poetry
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and there was no one to understand this.

 

 

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1002 B) 

The reason we do everything

done

we did

is to look at it at the end

to see if

we 

did

it correctly

since the beginning.
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12-27-93 Victor Harbor copyright Terrell Neuage(1467 A) 

Like a poem

going no where

a song

without a tune

seeds planted in the desert

and love with no dawn

life is 

without direction.

 

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(908 B)

We had so many backup plans
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that we crashed

backing up

never seeing

where we were going.

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1769)

While looking for the perfect gift

silence screamed at me

'GIVE NOTHING

BECAUSE THAT IS ALL

WE SHALL HAVE AT THE END'

and now 

we could get use to

getting it early.
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12-28-93 Victor Harbor copyright Terrell Neuage(1983)

I never wanted to be

anything more

than everything

that you are

I never wanted to be white

or so poor

so unknown

I'm not even a part of history's pathways

but if there weren't shadows like me

there would never be

stars like you.

 

 

12-28-93 Victor Harbor copyright Terrell NeuageSA (571 B)

The last verse

was in your purse
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all you had to do

was open and see

but you shot through

and left me free

Yet always the waves

reach the horizon

poems seldom rhyme

nature does not understand humans

and the last verse

was in your purse

lost with my heart

amongst all the things

you carry

wherever you fly.

 

 

 

12-29-93 Victor Harbor copyright Terrell Neuage(1427)

If I said good night

would that change the orbit of the sun

make the collide with Mars
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or a garden snail learn to run

probably not probably not

because within preconceived ideas

giraffes don't become butterflies

love never dies

and I don't hear you

saying good night to me.

 

12-30-93 Victor Harbor copyright Terrell Neuage(380)

We don't live in troubled times

troubled times live in us

swallow butterflies

eat rainbows

drink stars

DIGESTED CHANGE

takes away

troubled times.

 

12-30-93 Victor Harbor copyright Terrell Neuage(1743)

I keep thinking it's a different day
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another life

who opened the windows

and let in

these times

this place

that reflection

which could never be

anything more

than a different day

another life.

 

 

Often I reached out

Often I came close

Often I pulled back

if there was a way to change

wave a magic wand

command a jeanie

roll a lucky dice

Take me deep
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Swallow my pride

Tie me down

Chain me up

Let bleed desire's fire

on freedom's alter

before sacred oaths

dissolve saturn's grip that strangles silken whispers

before YES is breathed

and dies without belief

Like I do

each time I reach out

then pull back

12-25-93 Victor Harbor copyright Terrell Neuage(1151) 

While reviewing the past

the way it was

how we were

such easy thoughts

nothing ever to worry

I realized

I saw

I knew
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now was just a cartoon

of what would have been

if we could have

been 

now

then

 

12-25-93 Victor Harbor copyright Terrell Neuage(1990)

Broke the mode

of who I was

now you see

the source of my shadow

the end of my projection

the face behind every mask.

Just before midnight

I began a new day

another era

a beautiful me

alone in flight

over my broken mode.
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So the who you see 

who looks like me

but acts so free

is but master of ceremony

grand performance

finally on stage

with little left to offer

but

the way I am

again today

in broken mode

once again I am.

 

12-25-93 Victor Harbor copyright Terrell Neuage(99D)

So sure

that this was the right direction

everything always

had led to this spot

until we discovered

that we weren't here
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and neither was the spot

 

 

 

 

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1342 B)

 

We drew a line

in the sand

but the tides

washed us away

leaving the line

that we drew

dividing us

from being one

to fight the tides

that came
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and took us 

away

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1745 B)

Buried treasures

like hidden talents

leaves us poor

and all alone

with no one

sharing

what we'd have

if hidden treasures

and buried talents

weren't.

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(99 D) 

Shattered illusions

http://neuage.indiko.com/collection1.htm (28 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

Scattered conclusions

Battered delusions

dissolved by the dawn of reason

Now nothing is left

but created reality

so clear

I can see forever

Hello New Morning

Good Bye every night

12-93 Victor Harbor copyright Terrell Neuage(1256)

At a final frontier

we conquered fear

to devour

each other

like any

cannibal of love

would
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12-26-93 Victor Harbor copyright Terrell Neuage(62 D)

The day after

The night before

left me

wanting to wake with you

once again

in the day after

the night before

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1405)

 

This year so quickly went

I went back

to do it once again

just to know

it really had happened.
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12-26-93 Victor Harbor copyright Terrell Neuage(1565) 

I looked in the dictionary

to find meaning

but no explanation

cleared up

my wonderment

of what

this means

You and I

three words in the dictionary

one in my mind.

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(512)

I always thought

one more would be enough

and when it is

it will be

But for now

here I am
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only one more

from being enough.

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(288)

 

I was wondering

what will be the last word said

the final line written

the last caress

the final bite

before I die

then I realized

I wouldn't remember anyway

so on I ramble

write

touch

and eat

like any eternal consumer

http://neuage.indiko.com/collection1.htm (32 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

would

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(842)

 

If each thing done

we do as

that to be our masterpiece

then our life

that will be

 

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(349 A)

 

Again

my friend

the end

does send
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this trend

again

ABOUT FACE 

CHANGE DIRECTION

whisper loudly

the blind feel what we don't see

the deaf see what we don't hear

the lonely know every face in the crowd

but at the end

I'll still be your friend

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(6 B)

 

'Lucky me'

said the tree

'I will never be

lost on a freeway

short on what to say

found shopping
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seen hopping

lucky me

lucky me

said the tree

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(956 D)

All the advice ever asked

never led anyone to the stars

all the questions pursued

never changed the unexpected

all the theories so explained

never

ever

and it will still all be

the same

again tomorrow
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12-26-93 Victor Harbor copyright Terrell Neuage(12)

 

'Oh No! Oh No!'

said the tree

and all the people stopped

to question a tree

that would talk

but never more

did that tree say

And that is how

the religion of the tree began

and why everyone

chants

'Oh No! Oh No!'

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1155 B)

All our possessions

are but props

to insulate our space
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before we became to know

that we never

needed them anyway.

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(12 B) 

Cold!

Only the physical body knows

take away the cold

I'm still here

take away my body

the cold remains

if I could

I would be

a naked thought sitting on an arctic flow

and diving into frozen illusion tundra

I'd swim in the cold
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and pretend my body was with me

like I do now

in this cold world

I've been given to wander.

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(120)

As fragile as each new moment is

the strength to proceed into in

is but BELIEF

given wings

to give flight

when needed to be.

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(61 D a)
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Nature brought forth humans

because

dinosaurs couldn't paint

amoebas wouldn't carry a tune

apes refused to write poetry

and there was no one to understand this.

 

 

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1002 B) 

The reason we do everything

done

we did

is to look at it at the end

to see if

we 
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did

it correctly

since the beginning.

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1467 A) 

Like a poem

going no where

a song

without a tune

seeds planted in the desert

and love with no dawn

life is 

without direction.
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12-27-93 Victor Harbor copyright Terrell Neuage(908 B)

We had so many backup plans

that we crashed

backing up

never seeing

where we were going.

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1769)

While looking for the perfect gift

silence screamed at me

'GIVE NOTHING

BECAUSE THAT IS ALL
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WE SHALL HAVE AT THE END'

and now 

we could get use to

getting it early.

 

 

 

 

12-28-93 Victor Harbor copyright Terrell Neuage(1983)

I never wanted to be

anything more

than everything

that you are

I never wanted to be white

or so poor

so unknown

I'm not even a part of history's pathways

but if there weren't shadows like me

there would never be

stars like you.
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12-28-93 Victor Harbor copyright Terrell NeuageSA (571 B)

The last verse

was in your purse

all you had to do

was open and see

but you shot through

and left me free

Yet always the waves

reach the horizon

poems seldom rhyme

nature does not understand humans

and the last verse

was in your purse

lost with my heart

amongst all the things

you carry

wherever you fly.
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12-29-93 Victor Harbor copyright Terrell Neuage(1427)

If I said good night

would that change the orbit of the sun

make the collide with Mars

or a garden snail learn to run

probably not probably not

because within preconceived ideas

giraffes don't become butterflies

love never dies

and I don't hear you

saying good night to me.

 

12-30-93 Victor Harbor copyright Terrell Neuage(380)

We don't live in troubled times

troubled times live in us

swallow butterflies

eat rainbows

drink stars

DIGESTED CHANGE
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takes away

troubled times.

 

12-30-93 Victor Harbor copyright Terrell Neuage(1743)

I keep thinking it's a different day

another life

who opened the windows

and let in

these times

this place

that reflection

which could never be

anything more

than a different day

another life.

 

 

12-30-93 Victor Harbor copyright Terrell Neuage(485 B)

Woken highway

reached out

I held on 

http://neuage.indiko.com/collection1.htm (45 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

through the deserts

ofpver rivers

into mountains

This highway

would not listen to my pleas to stop

This highway

had heard desperate hooves

as horses escaped in the 1800s

had see Porches and Harleys

had felt pain

joy

but never aloneness

like I so often have

This highway

took me to this realm

I can not escape

my family calls it madness

my doctor - a genetic flaw

my psychic said I was born to the highway

I its slave
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and it will be this highway

at the end of the tunnel

where beings of light

will throw me back

and tell me to follow the highway

until I know where it's headed

(like if I would anyway - ever)

Now I'm quite use to this highway which keeps going

into other dimensions

like I do

each time I think of the road once traveled

the road futures will travel

This highway never ending.

12-31-93 Victor Harbor copyright Terrell NeuageSA. (2055)

Morning swallowed

my dreams

made me hungry 

to see if 

they'd come true

like everything else
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I believe in 

does

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(978)

 

 

 

At the beginning

when all there was

was already there

waiting to be put together

like you and me 

and the galaxies

too
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5-1-93 Victor Harbor copyright Terrell Neuage(64)

I was so sleepy

I slept standing up

while the world

lay on its side

watching

 

 

 

 

 

 

 

5-1-93 (838)

the reason 

we are here

is because dawn

doesn't want to 
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come alone

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430)

like steps through history

or a wander through dreams

today's beliefs,efs

grew out of yesterday's crumbled ideologies

for tomorrow's

individual freedom

finally won

to take wings

never to land again

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(916)

I learned shorthand
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speed reading

computerization

experienced Paris in a day

read 'Readers Digest'

condensed pasteurized homogenized great novels

and watched history of civilization

but time stood still

when your touch

became so 

involved

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(492)

I concentrated so hard

on this moment

that yesterday and tomorrow disappeared

now

like neapolitan ice cream

melted

contains the former and the latter

in a future past tense
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that has no ease 

of

explanation 

in this moment

 

5-1-93 Victor Harbor copyright Terrell Neuage(316 C)

There is little difference

between you and me

except that I am conscious

of the little difference

(even calling them my own)

and you see them

being but variations

of your greater self

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430 D)

This life goes so fast

that when I die

I will need

a thousand years
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to review all that happened

in this life

 

 

 

 

5-1-93 (1508)

The continuous pouring out

of creativity

fueled forever's freedom's

perceptual persuasion's performance

reflected perfectly

for me

to 

know
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I wouldn't want to live on Venus
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because there are no trees

nor on Mars with its lack of flowers

and there is no chocolate on Jupiter

or ice cream on Mercury

while on earth

everything I want

is between the sea

the trees

and the shopping mall.

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(858)

If I knew how to write

a poem

I would

if I knew how to sing

I would

If I could dance, take photos
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paint or tell your future

I would

But all I can do

is build you a castle

in the sand

and offer it to you

before the sea

take it from me

 

5-1-93 Victor Harbor copyright Terrell Neuage(376)

the reason

we don't have wings

is because we don't have to fly north

for the winter

But can stay all winter-warm

wrapped in each other's

warmth

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(946)
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The reason

we keep coming to earth

is to learn to stop dying

but we keep

getting into the Plato trap

of this is it

why keep going

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(946 C)

Not every time

is everything

going to be

the way it is

at other times

But instead

like any spinning top everything gets a chance\

to be close at hand

again 

http://neuage.indiko.com/collection1.htm (56 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

if we see

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(1130 C)

We rush through life

like we're in a hurry

to get to the end

not knowing what it is

except that

it will be different

than the rush through

this life is

 

 

 

5-593 Victor Harbor copyright Terrell Neuage(1768)

I write

for the same reasons

a bird flies

far from an oil slick

a whale stays away
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from a stream

and buffaloes avoid mountains

I write only 

to find these answers

that everyone else

already knows

 

 

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(858)

As if this moment could be preserved:

placed in a safe-deposit box, frozen in space, cloned, kept intact

maybe even used again

reincarnated, transmigrated, resuscitated, 

recycled moments 

in another reality

a paralleling toyed universe

where earth-used moments
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are packaged and sold in day-fill programmes

Drive-thru-take-away-moment-services

'Yes I will take three moments to go

two yesterdays and one tomorrow'

And I reach out to take a hold of a yesterday

the moment we said good bye

in hopes of renaming it and bringing it back to life

only to discover the moment I wanted returned

had been used by a patriot in an alternative drifting energy force

and was no longer mine

to have again

but only to observe 

in mutational memory cells

reflecting changing interpretation of

the way it once was

11-28-93 Victor Harbor copyright Terrell Neuage(61 C)

Before: After was known

When storms were calm 

Emotions describable

And colour bland
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Answers were easy

But meaning wasn't.

 

 

 

 

11-29-93 Victor Harbor copyright Terrell Neuage(76)

Inside wholeness

separation is unknown

like the splitting of an atom

is unknown

inside wholeness

But the results

are the same

 

 

 

11-29-93 Victor Harbor copyright Terrell Neuage(576)

Curtains drawn

over windows of time

left imagination
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without a view

like an unlit night

shows what can not be seen

when all that is revealed

is nothing at all

 

11-29-93 Victor Harbor copyright Terrell Neuage(136 B)

In the morning

I looked forward to

meeting the new me

that I heard about

in a dream

But the new me

stayed in the dream 

while mirror showed 

the same snapshot

it had shown

every other morning

fuzzy wakefulness

far from any dream thought possible
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11-30-93 Victor Harbor copyright Terrell Neuage(582)

While sharing one another

with each other

We traded lives

and worked on correcting

all the faults we had

perceived in each other

before we had traded lives 

then we traded back

only to die laughing

at what we had created

Perhaps next time

we'll just accept and not modify

live and not die

and

share and not trade
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11-30-93 Victor Harbor copyright Terrell Neuage(1993)

While making way

for new experiences

the past was stored away

in the attic

where a spider

web-woven

devoured the past

and the present

ran naked

knowing such a fate

could be escaped

if experiences

no longer were stored

away

 

 

11-29-93 Victor Harbor copyright Terrell Neuage(1985)

Without risk
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a billion galaxies

would have not begun to dance

with questions

a billion suns

in our galaxy

would have not take a first deep breath

without nature

chaos would have no joy

without you

a billion cells in my life

will lose their spark.

 

21-1-93 Victor Harbor copyright Terrell Neuage(2051)

Close to where I want to be

But never there

like a future

reachable

not holdable

hoped for

not known
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seeable

But only in a mist

before form 

covers now

in the never to be

so in today once again

as always

all is within reach

and parts even attainable

but never all

never all

never all

 

12-1-93 Victor Harbor copyright Terrell Neuage(118 B)

The release

freed me:

What I once wanted

no longer needed

flew forth

like love does
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once it has wings

 

 

 

 

 

 

 

12-1-93 Victor Harbor copyright Terrell Neuage(1479)

Fresh start

reinvented me

today is the reincarnation of yesterday

But I'm not

Reinvented me

is all I can see.

 

 

 

 

12-1-93 Victor Harbor copyright Terrell Neuage(231 B)
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yy

Without sounding

too philosophical

spiritual

down-to-earth

metaphysical

or psychological

I need you

like any farmer

the rain 

would

 

 

 

 

12-2-93 Victor Harbor copyright Terrell Neuage(2051 B)

I thought nature

was blushing

from listening to me

speak about you
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But it was dawn

that was making nature come

with such colour

not my description of you

 

 

12-2-93 Victor Harbor copyright Terrell Neuage(674)

sky cleared

darkened thoughts

blocking dawn

so morning could see

my wish had come true

you and I free of

darkened thoughts

 

 

 

 

 

12-2-93 Victor Harbor copyright Terrell Neuage(1290)
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Just when I understood

how the final piece fitted

when nature cheered

exploration showed meaning

changes laughed in reason

I awoke

to see clouds disperse

love leap forward

success call my name

 

 

 

12-3-93 Victor Harbor copyright Terrell Neuage(873 B) 

I use to think 

I was the luckiest person

on earth

to be with you

now I realize

you're the lucky one
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I didn't notice

a difference between

day and night 

until you pointed out

that is how 

we are 

shooting stars 

gone too far

passing midnight

passing noon

we'll know soon

which we're like

which we're not

but sameness

is left out doors

somewhere between

day and night
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12-3-93 Victor Harbor copyright Terrell Neuage(321 B)

 

 

I just thought we could stop

along the coast of our first touch

atop the mountain of desire first conquered

past our first laugh over a whispering horizon

But I just got a message from the dawn

saying memory is better than promise

promise is better than forever

forever is better than forever

and in circles

the merry-go-round never strays

like my feelings for you

always changing

never ceasing

always finding

never seeking

always one
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you're never close

because I'm always there

just around a corner

in the back of your memory

 

 

12-3-93 Victor Harbor copyright Terrell Neuage(480)

 

I wanted to be a legend

a whisper amongst time's shadows

spoken about in parliament

dreamt of in alleys

cried over

in Delphi often

number one on MTV

a source of multiple orgasm\inner space colonization\political 
revolution

the dawn at road's end

And I was

somewhere in time
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12-3-93 Victor Harbor copyright Terrell Neuage(778) 

I wanted to be safe

so I gave you a single rose

instead of promising the world

a smile

rather than tomorrow too

a light touch

that could never the place

of all I wanted to give

beyond a single rose

 

 

12-3-93 Victor Harbor copyright Terrell Neuage(782 D)

 

I wanted too much

such a short time

to try it all

have a taste
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devour more than before

to go every direction at once

But I did

so excuse the way I am

because I wanted too much

and it all I did

too

 

12-3-93 Victor Harbor copyright Terrell Neuage(791 A)

I tried to shake away

shadow's memories

fallen beliefs

and dusty mirages

of when you were

an oasis to me

but trials of now

lost in forests of good byes

took me to this corner

this crossroad

this space
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where I remember everything

no matter how much

I try to strike away

memory will cast me forever 

in the starring role

I had 

once with you

 

 

12-3-93 Victor Harbor copyright Terrell Neuage(720 D) 

The cross of reason

tossed experience into now

dreams so real now weren't

feelings once felt dissipated

wishes just another book read

(the seven seas just another pool swam)

The cross of reason

forever there
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12-3-93 Victor Harbor copyright Terrell Neuage(1402 B)

The only reason

nature has let us

get this far

is because it needs

someone to water the flowers

when the rain 

doesn't flow

like we do

when together

the dawn we touch

 

 

 

12-3-93 Victor Harbor copyright Terrell Neuage(1445)

I sang the same line

over so many times

to make it rhyme
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You were following a star

I followed morning

crossed visions left me alone

if only I knew the tone

take me

the sea

I will sail forever

fallen forgotten endeavour

leave me this moment free

for all I can see

is the remainder of me

 

 

 

12-4-93 Victor Harbor copyright Terrell Neuage(614 B) 

While fading into you

I grabbed on to

a final portion of me

like forever

takes a final glimpse of
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the moment

 

 

 

 

12-4-93 Victor Harbor copyright Terrell Neuage(1975)

 

As difficult as the moment appears

it is nothing

compared with

a tree from a seed

a president from a collision of sperm and egg

millions of dollars from six numbers in the lottery

another moment with you

 

12-4-93 Victor Harbor copyright Terrell Neuage(61 C)

 

why this is this way

mist rises 

rain falls
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winter froze

you touch 

I melt

this way it is 

tomorrow too

it will be

 

 

 

12-4-93 Victor Harbor copyright Terrell Neuage(2033) 

Time came

when window

showed little more

than thought cleared sky

echoes whispered

shades of colours

If I knew the way

would have smelt like

a spring morning

when we believed

winter would never return

http://neuage.indiko.com/collection1.htm (80 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

 

 

 

12-4-93 Victor Harbor copyright Terrell Neuage(1567)

 

"HOLD THE MEMORY!"

I yelled

this isn't all

that can be done

before next moment new packages now into

'remember when?'

and pouring forth

more than

better than

I watch the moment explode

shooting forth

galactic droplets

of new moments

each carrying

more than
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better than

within its form

 

 

12-5-93 Victor Harbor copyright Terrell Neuage(282)

Focusing on you

blurred the surroundings

Your life 

nature's victory

Your senses

future's promise

heightened awareness

centred on you

erased everything else

the game in front slipped away

yesterday's storm blew out to sea

questions became irrelevant

answers dissolved

while focusing on you

everything became blurred
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except for you

 

 

 

 

12-4-93 Victor Harbor copyright Terrell Neuage(217 B) 

Still trying to say

what should be so easy

to explain

how forests

laugh in rain

like I do in you

how the universe 

took 15 billion years

to bring forth

mobile phones

and only 30 years

you

how your touch

makes me

feel like
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a christmas tree

waiting to be

decorated

 

 

12-4-93 Victor Harbor copyright Terrell Neuage(1352 D) 

 

 

I reached through time

to grab the bits

I wanted tomorrow to be made of

like any creator would
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12-4-93 Victor Harbor copyright Terrell Neuage(602 B)

I planted an acorn seed

and heard celery grow

in its place

I put my yacht out to sea

but woke in the bath tub

with a toy boat instead

the weather report said 

the sun would shine

over my tropical island today

but i had to shovel through

four feet of snow

to get to my papaya plantation

You said you would stay with me forever

and we haven't met yet

I swam 

when I should have flown

cried instead of laughed

chased cars

dogs were driving
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stood naked

in a crowded subway

And told secrets on Oprah's show

otherwise

everything seems quite normal

 

 

12-5-93 Victor Harbor copyright Terrell Neuage(602) 

It was funny the way

we danced

along the shore

in the moonlight

you sang of rainbows

when no storm was in sight

I collected shells

in the night

looking for pearls

looking for love

looking for what I'd wake with

if we ever stopped dancing

long enough to dream
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of the moment

like anyone having

a near-love experience

would 

 

 

12-5-93 Victor Harbor copyright Terrell Neuage(735 D) 

In clashing colours

we found every difference

but a taste

of each experience

that was free

in clashing colours

 

 

 

 

12-5-93 Victor Harbor copyright Terrell Neuage(558 C)
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Rushed through

all we could have

Leaping brushed-fired passions

devoured us

you opened

I gave

you cried

I whispered

you held on

I let go

filling you with every man's desire

ACCUMULATED EVOLUTIONARY WANT

and in the moment

all creation held her breath

wondering if such fulfillment

was possible

as we rushed through

all we could have

in one final release

that is now
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forever

imprinted on my consciousness

a mutating cell in all future creation.

 

 

 

12-5-93 Victor Harbor copyright Terrell Neuage(1232)

 

I waited for the final song

one last curtain call

a good bye kiss

and a passing caress

You were to become a star

here on earth 

or in the sky

I never knew which

But I knew

as the applause faded

and your whispers rang in my ears

that what I wanted

what you gave
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what I took

was just a borrow

an overdue loan

from this stage

just a further experience

and without saying thank you

too many times

I salute you

and ask for nothing more

but an encore

before this stage

dissolves into

some future production

 

12-5-93 Victor Harbor copyright Terrell Neuage(771 B) 

If nature 

changed her mind

as often as I do

there'd be blizzards in Pago Pago

spring in the winter
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the sun would stop then go the opposite direction

cows would give eggs on Tuesdays

flowers on Friday

and there'd be one of me for each day of the week

 

 

 

 

12-7-93 Victor Harbor copyright Terrell Neuage( 400 B)

 

Like when no one notices

what is

Is the best performance possible

while the rain washes away

the stage

and in suspended thought

birds migrate

with little notice

of what is

is the best performance
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possible.

 

 

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(922)

 

 

Everyone stood in line

waiting to be selected

like a best thought of the day

waits to be realized

Friday waits Thursday to end

a rose waits to be given

and I wait for you to see

I have selected you

like I hope you have me

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(188)
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too much junk mail

too many sensational headlines

and too few peaceful times

left me looking for a comfortable seat

in the midst of a tornado

just to watch 

not be changed

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(1617)

 

 

I was ready 

times weren't

I was there 

space wasn't

I wanted you

you didn't know
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time and space

didn't exist

 

 

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(834)

One step from the finish

I realized 

I was in the wrong race

But it was o.k.

because I was only one step away

from starting a new one

this time correctly run

 

 

 

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(1162)
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I made 

a hundred 

photocopies

of the moment

I met you

and

hand them out

to myself

each time

the moment

tries

to

slip 

away

 

 

12-13-93 Victor Harbor copyright Terrell Neuage(553 B)

 

Here we are
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funny to say

flowers laugh

rain screams

dove for evening meal

but

though

maybe

it is possible

funny to say

we never knew

that it truly

is this way

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(276)

 

I was just getting warmed up

decades of experience

(lay like tumbled children's blocks)

picked up and used again
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to make a bridge

recycled experiences

led me to be free once again

like before blocks of life

began to tumble

 

 

12-7-93 Victor Harbor copyright Terrell Neuage(628)

each moment chosen

like ripen fruit

a perfect gift

each magical touch

the taste of

new fallen snow

and the glow of a first touch

is nothing but perfect

in each moment chosen
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Surprised by the movement

through space

of what I wanted

as it pushed aside

all resistance

and made room in chaos

for all

I wanted

 

 

12-13-93 Victor Harbor copyright Terrell Neuage(1365 B)

Each time I turn around

facing direction's perspective

laughs like time

in the rain

does
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On the back of yesterday

I wrote what happened

How the morning exploded

day gave meaning

freedom flew

and so did I

on the back of yesterday

I never wished for now

to be so far away

from then

and remembered so well
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Children are not

the souvenirs of love

but travelling 

theme parks

they are
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There were so many choices

I fell asleep

and dreamt each one
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complete

that is why

I see rainbows

when others see clouds

And so should we.
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If every direction traveled

arrived at the perfect destination

Discovery forever

would stand behind

closed doors
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laughing at us
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A close score

with little time left

all the players

waited in evening's fading

light

as the stars began to shine

to make complete every game 

that no longer

needs morning to show
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winners

like we do

each time we touch
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I don't like art

I don't like writing

that is why I drew a poem

in the sky

just to watch it

disappear

like I do 
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each time I read

what I write.
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Like any good audience

we are still waiting for

the punch line

2000 years later
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In mistaken identities

trees sprout wings
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birds grow roots

and gravity tossed us into space

like love

with no way

to keep us down to earth
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Morning filled

night before

breeze returned

with your scents

your desire

still fulfilling

bringing now

with

your return
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If only images

were found

to be real

I would become lost

in the image of you
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I thought it was the end of the world
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when the changes began.

As if time really cared

or the sky would disappear

or elephants would stop dancing.
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With no time left

I asked to spend forever with you

With no space 

I asked

if there was room for me

In the frozen wastelands

I looked for a tropical taste of you.
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I have given you

all the great lines

but we have yet 

to dance

I have shown all the possibilities

you have yet to show any

I have visited the stars

you are still here

and the point is

we never go

beyond our own

perspective
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While focusing on you
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I lost sight

of everything else

that is why

I'm wet

from walking into the sea

thinking I was walking 

into you

That is why 

I'm bleeding

from cutting myself in two

on a mirror

I was hanging 

thinking it was you

That is how 

I became lost

thinking I had found you

focusing too

on me.
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Brandy coloured morning

revealed

last night

never ending
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Something to reach for like dawn

at the horizon

rain 

above clouds

and love

before doubt

something to reach for

never having
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We touched the stars

before we were ready

NOW

without oxygen

without bodies

without life

WE search

how to come back down-to-earth

once again
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It's o.k. to take a break

waste some time

take a nap

go for a walk

fondle

the sun is expected 

to shine

for a few billion

more years

and so can we

or at least

some part of

us

 

5-7-93 Victor Harbor copyright Terrell Neuage(732)

We are always

While pushing past the limits once believed

I tossed away bewilderment with

'I don't think it is possible'

touching space and understanding it too
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so that all achievments until now

were nothing more

than cave paintings

just some muddled hieroglyphics

like old age without reason

But that's all behind

back in humanity's nursery book stage

Freedom is the real frontier

with fear of guilt and misplaced beliefs

being the savage native

hiding in the psychic

waiting to attack free thinking

with primitive weapons

of guilt, fear, and mysticism

But it is too late

freedom to know will conquer

and push the only true-value frontier open

so every universe 

without secret

is left bare
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to enter

and have

 

 

4/9/93 Good Friday Poem - Victor Harbor copyright Terrell Neuage(1810 
C)

In change

dreams come awake

in sameness

dreams go to sleep.
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Desire is the slave

of freedom

 

 

 

 

 

4-13-92 Victor Harbor copyright Terrell Neuage(155 b)

 

if everyone knew

what I know now

holy cow
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I'd be out the door

for ever more

that's for sure

But I'm not

so here I am

waiting for more

outside your door
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In chosen images 

beliefs reveal 

what is real

like this moment does

rising over a new horizon
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in unsettled times

where seas

pierce clouded evenings

tranquil message

of what is believed,

and in tomorrow like again today

the future's past

reveals secret's timely wish's desire

held like forever's reflection in today

again found to be 

everything worth waiting for

so as to say

yes it was as real

as ever it was meant to be.
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In ancient thought

beyond reason's pillars
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everyone came together

to predict the future

in Diana's shower

But they turned on the video

and forgot to leave behind

much more

than our ancient interpretation 

in times

that dispels

all

 

 

(554)

 

Sun doesn't see

moon doesn't rise

But we do

each time

we watch

where we're going
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somewhere beyond

destiny's favorite thought

 

 

 

 

4-16-93 Victor Harbor copyright Terrell Neuage(1362)

 

The past 

paints

tomorrow

But if we let go of it

tomorrow 

will have

no added colour

to make it complete 

(and memories only sleep)

 

 

 

 

http://neuage.indiko.com/collection1.htm (121 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

'93 Victor Harbor copyright Terrell Neuage(1424)

This moment

is so close to perfect

that to make it so now

is

no more

than a simple

rearrangement of the way it is

with open door

as an invitation

for nature

to join 

in too

 

 

 

 

'93 Victor Harbor copyright Terrell Neuage(1498 C)

This life

like so many before
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is but a shadow

of our selves

travelling at the speed of laughter

through the universe

on our way

to a fish and chip shop

the only planet

that sells them
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THE BIG BANG

WAS 

JUST

http://neuage.indiko.com/collection1.htm (123 of 504) [3/8/08 2:54:11 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

A WHIMPER

COMPARED TO

WHEN WE MET
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I awoke before time began

before music

before thought

before silence erupted

into the beginning of now

with all the followers

still waiting to awake
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FORGOTTEN

FREEDOMS

FOUND

FROZEN

FAVOUR

FOREVER

FREE
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4-93 Victor Harbor copyright Terrell Neuage(228)

 

How good we are tomorrow

depends on how bad

we are today
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The flower of youth

blossomed

while I looked

the other way

http://neuage.indiko.com/collection1.htm (126 of 504) [3/8/08 2:54:12 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

now in memory

I return

to when my name

was the one called

in morning's sleepless desire

 

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(1402)

 

Forgetfulness of now

took me back to when

I remember you

whispering to me

'never forget this moment 

and it will last forever

somewhere in mind' Now I am a forgotten foreigner

forevermore

full of

forgetfulness
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of now

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(228)

For every gate

that opens

a crowd cheers

I can't see

but I hear

as the melody of strangers

asking for change

like any weekend weather person would
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The only predictable future
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we well 

ever experience

is when we do

what we do

of what we chose to do

 

 

 

4-19-93 (936 B)

I couldn't

t wait

so I rushed toward

the open door...

only realizing there was no floor

on the other side

after my free-fall had begun

lucky for me

I carry a parachute everywhere

for just such an emergency 
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In broken images

and meaningless dreams

the future is drafted

and superglued into place
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While breaking shackles off of
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who we perceived we were to each other

we fell in love

with who we would have been

if broken shackles long ago

had shown us now - then
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While waiting for a new leader

humanity put on clean wool socks

and though it is true

everyone was as lost as ever

we all had warm feet

that didn't smell

and with over five billion people
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that is what is important.
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Platonistic specialization

almost stopped love's integrating freedom

from taking flight

out of the mystic plagued night

that descended so long ago

but now nears its end

as we break the 2000 year old shackles

off of the slaves

we have been
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4-9-93 Victor Harbor copyright Terrell Neuage(1204)Until just a 
moment ago

 

 

everything made sense

now

I will have to
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start all over again

so I say it was logical
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In the silence of my memory

you whispered a song

we once danced too

under a spring filled song

in Golden Gate Park in 1967

And in closed eyes

I now disappear

into your long ago promise

'You'll never need anyone else but me'
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But the ticking of my clock

the barking of the dog

my children yelling for dinner

makes me open my eyes

remembering

I hadn't thought of you

for at least 20 years

until now.
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I am moving to Saturn

where there is more room

more moons

it's a heavy place

the days are longer

and it takes 28 years to equal one year

so now

I can finally get all those things done

I always said I would
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and go multi-moon gazing

with the ones I love
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today is better than yesterday

tomorrow will be worse

than last Friday

But next Tuesday

will make yesterday look sad

so there!
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Childhood spent
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childhood saved

childhood's woven parts

superglued together to remember

the moment each piece was a part of something bigger

that went broom broom click click

tick tick like a clock

(that measured the passing days of childhood)

Children never grow old

they just sprout wings and fly away

returning now and then

to look at how everything

once was together

once was a part of a movement

once was a part of everything that really mattered

until

like sections of life they were reassembled

in a mosaic of memory

just abbreviations of symbolic wholes

where one piece represents

what was played with for weeks at a time
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in the labyrinth of childhood

and now is but a collage

on one of the walls of my life.

 

4-19-93 Victor Harbor copyright Terrell Neuage(106)

they've taken away

the walls

left me

with no boundaries

no blocked views

no hiding place

I roll up into a ball

and roll out into the open space

I never knew existed

until they took away my walls
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While stretching logic
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like some do the truth

I noticed an empty explanation

in the corner of a theory that could have unified it all

so now I am proud to present

the X factor that will unify all of existence

that holds it all together 

that was there at the Big Bang

and will be there at the Big Crunch

and the little nibbles afterwards

and wait for it

it is laughter

that holds it all together

Because it is true (I was there)

the beginning of this present universe

started with a sneeze in the middle of a laugh

and all the galaxies

are just droplets from that sneeze

 

4-20-93 Victor Harbor copyright Terrell Neuage(1811 B)
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the meaning of aloha

(hello - goodbye)

changed when you never returned
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It is better

to seek agreement with ourselves

than solicit it from someone else

don't you agree?
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I liked last month so much

I didn't change the calendar

and that made me so happy

I decided to change it back

all the way to when we met

twenty years ago

when I was only a day younger

than I am now

according to my calendar

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(496)
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I talk fast

because I have so much to say

while others listen slowly

so they don't have to hear it all

but that's o.k.

Because the words in between

seldom have much meaning

anyway

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(662 B)

...whether is is better

to be creative and poor

or rich and uncreative

I will know once I become rich

after I find

the most creative way to do it
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While putting things in order

I noticed how random

the galaxies were tossed about

and thought if they can do that

so can I and that is why\
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everything looks so untidy
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I wanted to believe

what I used to 

but reality

swept away the myths

But I remember the stories

and tell them to my children

who never believed them 

to begin with
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There are over 5 billion people on the planet

and only one in this space

at this time in history

with these thoughts

and it will never occur again

 

 

 

 

 

 

 

4-21-93 Victor Harbor copyright Terrell Neuage(1429 B)

I thought it was

sounds of waves crashing upon the shore

waking me from sleep

But it was just my stomach

telling me to forget

my diet

and eat a snack
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in rhythm to waves upon the shore

 

 

 

 

 

4-23-93 Victor Harbor copyright Terrell Neuage(668) 

All the strategy

of all the people of all time

can't stop the rising sun

or love, death, taxes, birth

all the philosophies, myths, beliefs

have not changed the colour of the sky

the size of a mountain

or anything much of all

which gives little meaning 

to why

ham on rhyme

is better than tofu on sprouts
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8-23-93 Victor Harbor copyright Terrell Neuage(14 B)

It was as if

you knew all along

and had to wait

all these years

for me to realize

we have been together

in one form or another

since the beginning

 

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(735 B)

Even with

all the distraction

of these times

I managed

to deliver fax-free
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in person

all my feelings for you

to you

and again tomorrow

too

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(178)

It was as if yesterday

never had ended

But was just put on pause

for us to experience today

so we could go back to it

tomorrow

again
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4-24-93 Victor Harbor copyright Terrell Neuage(734)

change creates love

love creates change

create to change

change to create

love to change

change to love

 

 

 

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(104)

 

So simple to please

so please be simple

and let complications melt

like I do 

when we are one
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4-20-93 Victor Harbor copyright Terrell Neuage(1342)

I wanted the last word

and that's why I'm still here

in the middle of time

and I'll be around at the end

if it too

just to have 

the final say

 

 

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(776)

* 466 (12x12)

NEC
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Just before God

went off on holiday

I asked if things would change

There was no answer

that was when I realized

God had left earlier

than anticipated

leaving us

in change

to sort out the mess

we're in

 

 

 

 

 

 

June 7 1993 Victor Harbor copyright Terrell Neuage868
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*=465 11x11

NEC

In the fickle

realms of reality

meanings

are invented

as explanations 

while in my world

where reality

is kept out by walls of gold

I am free

in the security

of illusion

and the realism of magic

cascading

through senses

that never were

to be included

in this world

but
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and more ?

No! There was never meant to be anything but this

passing dreams

we have been

seduced by

8-7-93 Victor Harbor copyright Terrell Neuage580

 

 

 

* = 464

NEC

 

 

 

 

 

 

 

 

LIFE 

IS SHORT AND STRANGE
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LIKE

AN ANCIENT POEM

BUT

LIVES FOREVER

LIKE AN ANCIENT POEM

 

 

 

 

 

JUNE 8 93 894 Victor Harbor copyright Terrell Neuage110 VICTORIA 
STREET

 

not quite

but close enough to have a name

different

but up close it all looks the same

meanings

slip away before dawn's early reveal

your touch
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for a moment was almost real

tomorrow

maybe longer

pattern upon pattern

assembled secrets

chant my name

who am I?

but just another not a name

lingering on the tip

of too many swallowed 

meanings

and by listening once again

the whispering shadow

reveals

your touch made me real

7/28/93 110 Victoria Street (1134)

 

 

THE WHISPERING MIST

REVEALED

YOUR TOUCH MADE ME REAL
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SO NO LONGER

A SHADOW TOO

I'D BE

 

 

 

 

 

 

7/28/93 100 Victoria Street (1486)

 

 

in Sarajevo, Belfast, Beirut, Victor Harbor, Los Angeles,

trees grow flowers bloom rain falls

doing what they've been governed to do always

like humans

fulfilling genetic destiny

to war, dispute, desire but never learn

and over looking nature 

who will be and always has been unlike humans
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who were created

for nature's amusement

and who will stay 

until something better

can be created

(this time with some proper genes)

a few dawns 

down the road

a few yawns

left in the mold

a few pawns

of nature's soul

then wooosh

only nature

left

humans 

left

7/29/93 (614(

STARS SO FAR AWAY

take no notice of our daily
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wants wishes

dreams desires

loves losses

games growths

problems possessions

beliefs bingo

troubles thoughts

adventures appreciations

families fortunes

But live their cycles

no matter what we do

like love

so far away

yet always

within sight

7/29/93 110 Victoria Street (1352)

Why only in my waking dream

before dawn's shadow stealing smile

do I find us

so wrapped together

like once we knew
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but too soon forgot?

You not on the earth

me so imprisoned in this form 

dreams link us when I am not quite here

And you so surely elsewhere

is memory playing with mirrors deep in my brain

this perfect hologram of you

reflecting our love forever

though where forever we will be one

I do not know

But you are there constantly

(except when I open my eyes

which I do less all the time in fear of losing you forever

before I find the way to you)

Handing out your smile

asking me to follow but I can't 

the dawn came you left today alone

once again I am blind with my eyes open

7/29/93 110 Victoria Street (1818)
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the proof I have

that much I had

to prove

is simple

I'm a man

born of hand-me-down-genes

explorers, conquerors, kings, lovers, saints, jesters

it's in the genes

fighter pilot, basketballer, rocker, movie star

it's in the dreams

today's dreams tomorrow's genes

the only proof

a man will ever need
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7/29/93 110 Victoria Street (1424)

 

 

 

just as I wrote

in New Orleans, Paris

Honolulu, Fiji, Berlin

Sydney, Auckland, London Bangkok

And the places in between

I will write someday

in a space colony

flying past Mars

or on a moon of Jupiter

just as my ancestors

from caveman, to Plato, Jesus, King Arthur, handfuls of Kennedys

Don Juan-Don Quixote-Don Terrell

and the ones in between
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I will write on and on and on

just as all men before me

'how doth I get me a woman tonight'

TECHNOLOGY CHANGES

MAN'S MIND NEVER WILL

 

 

7/29/93 110 Victoria Street (868)

 

winter on parade

frozen

waitings

wanting

wonderful though weird

we

were

writing upon frozen consciousness

like human beliefs

frozen in place

for thousands of years
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needing

a good nuclear winter

to start the cycle

over

once

again

 

 

 

 

 

7/30/93 110 victoria street (1816)

 

 

 

 

I had you in my dream

we made morning come

I had you in my dream

you gave birth to our shadow

http://neuage.indiko.com/collection1.htm (163 of 504) [3/8/08 2:54:12 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

I had you in my dream

safe-sex again this morning

 

 

 

 

 

 

 

 

 

 

7/29/93 110 Victoria Street (456)

 

POSSESSION

while in a dream

silent mist's shadows

its illusive impulses

becoming incoming coming

wrapped by your desire

projected in astral illusions
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I opened up you entered 

took my body for a spin

around la Grand Palais

through la Arc de Triomphe

(where 'we' had a few in a nearby shadow)

then the disco

on Boulevard la Villette

where 'we' charged a night of pleasure

on my wife's credit cards

now awake me in my own body

back at the hotel

I try to explain to my wife

that it was not me on the all night carousel

as love's scents ooze out of my body

and my hoarse gin breath vainly whispers

but but but

it wasn't me I was asleep

while my body was being used

as all men's are in the final analysis

7/30 110 Victoria Street (1810)
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The last time

I saw my love

was where she stood swaying in scented smile

selling her body

to passing relatives and friends

on her fund raising drive

to buy Bibles for the Russians

and provide low cost love

for the poor
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july 31/93 110 Victoria Street

 

 

 

 

if all my heroes knew me

would they still believe

they were just

a mistake of nature

too?

 

 

 

 

 

 

7/31/93 110 Victoria street (342)
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Too often

while meaning something else

the rain fell

the farmer cheered 

sport fans jeered

Too often

while meaning something else

the waves swelled

fishermen ran ashore

surfers grabbed their boards

Too often 

while meaning something else

I ask for love

but never for long

 

 

7/31/93 110 Victoria Street (1552)
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The last time 

I saw my love

was where she stood smiling

selling her body

to passing relatives and friends

on her fund raising drive

to buy Bibles for the Russians

and provide low cost love

for the poor

 

 

 

7-31-93 Victor Harbor copyright Terrell NeuageSA (1408)

 

 

While being slaves of love
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men will never be free

to be possessed by nature

naturally
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8/01 Victor Harbor copyright Terrell Neuage(1809 A)

 

 

 

 

 

men are born free

(according to the constitution)

but all women cost

(according to reality)

 

 

 

 

 

 

 

 

 

http://neuage.indiko.com/collection1.htm (171 of 504) [3/8/08 2:54:12 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

 

 

 

 

 

 

8-10-93 Victor Harbor copyright Terrell Neuage(970)

 

 

 

 

contact made

like being one 

past minutes

equalled

rolling forever

automatically

like thoughts once so sure

to find the reason

for this
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is too

and 

little

more

 

8-10-93 Victor Harbor copyright Terrell Neuage(130)

 

 

 

 

While writing worthless rhymes

I fell off of a verbal

burble

and never found

my way back
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8-01-93 Victor Harbor copyright Terrell Neuage(1815 B)

 

I met a man 

whose stories came true

as soon as they were heard

I met a woman 

whose songs came true

as soon as they were heard

I met a child

whose wishes came true

as soon as they were heard

 

But I've never met 

anyone 

who knew

how this 

ends
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August 11 93 Victor Harbor copyright Terrell Neuage(538)

 

 

 

 

Driven passion

leaps hurdles

forward thrusting

life changes

in blinks

faster than Pluto's stolen shadows

past burn fast

the new me

you see

is to be free
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without thought

of patience

for the role

I once played

 

 

 

10-02-93 Victor Harbor copyright Terrell Neuage(158)

 

 

 

 

 

While wishfully waiting

we watched where we were

sneak us into

last night's remembered touch

and while loosing control

lost in your breath

we disappeared

never to be seen again
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11-03-93 Victor Harbor copyright Terrell Neuage(1815 A)

 

 

 

 

Like a new page of life

turned too many times

morning's misting memories

made me

remember you

when we galloped forests

to our allegoric lake

We rolled in laughing love
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and captured fleeing passions

that never wanted flight

to begin with

Like now

in too many turned pages\

to remember 

when first

we started over

this our allegoric night

 

 

 

 

 

11-04-93 Victor Harbor copyright Terrell Neuage(906)

 

 

 

Asking answers' allegiance

while not
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leaves outdoors there
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11-05-93 V ictor Harbor (56)

 

 

 

 

SHOCKED!

Perception's reflected illusion

reversed reality

I couldn't see

But only beg

I couldn't feel

beliefs were all wrong

morning was night

flowers turned to seed

touch turned to stone
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that made no words

I slept while awake

But IT was all a dream

this isn't

no longer

Shocked!

 

11-05-93 Victor Harbor copyright Terrell Neuage(1260)

 

 

 

 

 

 

 

forgotten foreign feelings

forged freedoms

final 

fate

no longer here
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11-6-93 (218 b)

 

 

 

 

without all the differences

there
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would be

no picture

 

 

 

 

 

 

 

11-6-93 Victor Harbor copyright Terrell Neuage(1819 b)

 

 

 

 

 

 

 

 

In dawn's early revival

I cheered
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to know

this show

I was part of

once again

 

 

 

 

 

 

 

 

 

11-6-93 Victor Harbor copyright Terrell Neuage(559b)

 

 

 

 

 

While at centre stage

I changed my script
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so this performance

you see

is but a change

I'm going through

 

 

 

 

 

 

11-6-93 Victor Harbor copyright Terrell Neuage(1809 a)

 

 

 

 

I won

I lost

I was

I am
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11-06-93 Victor Harbor copyright Terrell Neuage(856)

 

 

 

 

Changes came quickly before summer's settled passions

oaths were whispered as spring sown seeds settled passions

the times surely so seemingly sullen

would be remembered when now

would be read as ancient history

inventions failing prospering believers

found anything to hold onto gelatinous as first love

But there is the future no one knows everyone predicts

Though no one is quite correct

Touch my mind in pulled forth desires
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dig deep death's dwindling demand

take changes

reshape nature's woken woven womb

whisper to the deaf

wave to the blind

walk with the lame

wake the dead

wonder what was where when no one was there

Fleeing freedom fondles the enslaved

shackles clasp the different

But for all the troubles

all the worries

all the struggles

That this all important tragedy firmly hangs onto

Nothing can be greater that to know some day

This moment will be viewed as but a hiccup in nature 

when changes came quickly

and oaths were whispered only to never be harvested

The future came too fast to think of now as anything more

than a passing shadow eclipsed

11-6-93 Victor Harbor copyright Terrell Neuage(104)
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Your touch

the change

global warming

here to stay

 

 

 

 

 

 

 

 

 

11-17-93 Victor Harbor copyright Terrell Neuage(1900 - D)
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initial surrender

lost time

borrowed destiny

controlled laughter

on we could go

choice so rare

or here stay

dwell; on

the whence

of it all 
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11-16-93 Victor Harbor copyright Terrell Neuage(572)

 

 

 

 

I thought we could share the moment

as if it were 

the last, the first, even forever

we'd be unleashed nature

watching humanity begging for rest

we would be the condemned's

final wish

the cry at birth

the anguish at the end

the fireworks at the completion

of the games

the ecstasy of every experience

pulsating in one Grand Moment

I would be your knight, love, knight, love, king, slave, 

fool, hero...
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even a new-age male

if such a perversion

was your wish

Oh! I'm sorry

you just were asking me what time it was

here, in front of the caulaflowers and parsley

at the supermarket

11-7-93 Victor Harbor copyright Terrell Neuage(680)

 

 

 

 

 

 

Caught in between changes

without names

theories without masks

desires without dreams

caught in between voids

where changes create
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voids

creating change

 

 

 

 

10-8-93 Victor Harbor copyright Terrell Neuage(102)

 

 

 

Forgotten

once again

like watching life pass too quickly

without holding onto

passing reality

nothing comes to be forgotten

and a man in the last row

waves his hands and yells

"forgotten

I'm forgotten"
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But no one hears him 

as the crowds huddle together

trying to remember

what they had forgotten
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I tossed away meaning

like I do apple cores

But it's o.k.

the seeds will grow

and produce meaning

like I once did

before tossed away moments

were used for the landfill programme
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at the edge of the swamp

to build skyscraping apartments

for people to sit in

wondering why there were so many memories

tossed about.
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So much the end here:

less likely futures' glimpse

echoes momentary freedom;

and here brought forth meaning

holds wind chimes'

rhyme
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nature's time

the end falls

from sight

the past strips naked

and sun bathes alongside memory's reflected copulation

HEAR

so much the end.
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When the patterns changed

so much the end looked clear

everything was answered

time lost prescription space discovered dimension
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all figured out the way it should be

why it never is I don't recall

each time a different ending

still the same

always far from the way it should be

if, all-figured-out

was true.
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While building on what went before

I saw tomorrow

glance around the corner

and thank me
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for the foundations 

for future's experience.
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Too late the thaw

when winter's open door

lays waste

hasty autumn's retreat

and ice slices

fields of harvest forgotten

too late too late

like life known

and frozen in winter's

crystal memory

waiting for spring
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like every lover does
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While laughing at the changes

even making believe they weren't real

this moment took flight

with me in tow

And I have no intention of every returning

to say

these changes now

are anything more

than forever lost in flight.
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Each variation

is but an interpretation

of choice.
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While floating upon

thoughts of you

the world slipped away

leaving me to wonder

where'd I'd be

if I wasn't floating upon thoughts of you
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What we shared

even tomorrow will remember

flying free forever foreign feelings

while watching where we merge

as always we expected

we would
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Without appearing

repetitious

all I want to know is

have I presented before

what now

so often it seems I search

the touch
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WELL!

The point never was anything

anymore than not appearing

in changing beliefs:

Like a stunt actor

filling in

while this moment goes on

and I stay behind
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11-16-93 (1684)

 

 

 

 

 

 

 

More like new morning

each thought of you becomes
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11-17-93 Victor Harbor copyright Terrell Neuage(974)

 

 

 

Surprised

the prize rises

but no one held their breath

the wind blew instead

in its tortured

swallowed way

surprise surprise

silently the moment explodes

ripping satin covered dreams

and ravaged virgin thoughts

Take; me

Give me 

There is no exchange

when new born hope drowns
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where too the end?

never knows who to tell
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Changes

like dreams

are programmes

synchronizing
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who we'd be

if all we could be

was let free.
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Perception is just interpretation

And how I perceived you

when we met so long ago

is still the same

because

I never listened too

the world's interpretation
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4-24-93 Victor Harbor copyright Terrell Neuage(1192)

For everything that became

in the way we thought it would

good on ya

and how'd it happen

so as to do it all again

today

 

 

 

 

4-25-93 Victor Harbor copyright Terrell Neuage(218 B)

If I hadn't eaten tomorrow

there'd be something

for the rest of you all

to look forward to

but since there isn't

I'll take your praise today

and remember you well

tomorrow
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creativity is a natural

mutation of nature

free-will is its mutinous crew

and we 

the passing strangers to this life,

the disillusioned captains

looking for a better course
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love is a bird
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blown-away

on the first day of hunting season
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4-25-93 Victor Harbor copyright Terrell Neuage(948)

love is an experiment

that nature evolves with while

philosophy, religion, psychology

politics and the economy

are the stumbling blocks 

after the hurdles

on the way

to love's tasteful experiment
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I take all the concepts

put forth in a philosopher's

life

and sum it up in a few lines
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and feel good for all the trees saved

instead of explaining in volumes of books

'ain't she nice?

and that's why we're here folks...'
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The new empirical theory of blind love

is you and me

out-of-sight

out-of-mind

together
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4-27-93 Victor Harbor copyright Terrell Neuage(1410)

While searching through

memories on file

I accessed the spring dawn

when we rose out of our selves

in tune to the sound of our breath

that echoes now

through a deep memory of long ago

and where are you now
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In forests of forgotten flavours forever forgives foreign freedom for 
fighting frozen memories

tonight
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The most creative moment of the day

is a moment before we awake

when the waking hours are designed

then hidden behind the screen of back-on-earth again

like when we were born
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and to change that moment

would be to change

creation itself

which my dog told me

just before I awoke

this morning

that is not our lot to do

probably

 

4-27-93 Victor Harbor copyright Terrell Neuage(1410)

unlike other poets

who try to sound all flowery, rhyming, mystical, and abstract

I prefer to write down-to-earth-truck-driver's-poetry

like

'hey, where ya goin' baby? 

how about some real lovin' tonight'

and no poet has ever said it

quite as beautiful as that.
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4-27-93 Victor Harbor copyright Terrell Neuage(1573)

We began where we left off

only the century had changed

Now there are flying things

with people in them

and mechanical monsters

carrying the people

doing the work

yeap it was different

but we are the same

I suppose

everyone

really is 

at night with the lights out

it could be 400 BC still

and you would taste just as good
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4-27-93 Victor Harbor copyright Terrell Neuage(1630)

I went to count my money

like I once did my women

OH NO! 

broke again

 

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(850 D)

 

 

full of worry

that missing you

would blind me

from starting over

with someone else

who someday I'd miss too 
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like I once did

and now worry

will never stop 

you

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(234)

 

I showed everything I felt

lucky for me

the President said

it was just another

nuclear accident
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I waited to see if anything

would ever become of me
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before accepting my fate

to be kind of all the local galaxies
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In my humble opinion

God should be

fired
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If we had stopped saying
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this is too difficult 

in 1777

let's go home for tea

we wouldn't be

watching today's battles

on the 6 o'clock news
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I was so sleepy

I slept standing up

while the world

lay on its side

watching
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Like a cloud-free

wind strewn sea
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I reached to be free

But a dawn hugged horizon

showed me

BOUND and ALONE

to WISHES and DREAMS

that filtered through

passing times

when voices believed

merged with my final thought

sinking

this wind stream sea

with me

gasping for a new philosophy

that made sense

to my drowning world.

 

 

 

 

6-2-93 Victor Harbor copyright Terrell Neuage(898)
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waiting for love

is like waiting for a computer to load

with so much memory

and functions

that no end is ever to be

unless it becomes unplugged 

and has no back up batteries.
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So cold

sun so far away

night so close 

of ever I'm warm again

I'll save it 
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at least

in memory

so that when I'm so cold anew

my memory will thaw

my frozen perceptions

that chill me so now

 

6-2-93 Victor Harbor copyright Terrell Neuage(1302)

 

if love

has to 

be explained

it then is a philosophy
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everything we do

is just a preliminary
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for when

there is nothing

left to do
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I don't know why

can't explain it now

perhaps never will

but life never ends

only perceptions

of the moment end

like this verse

one line at a time
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Not enough time?

where'd it go ?

Not enough space?

who filled it up?

not enough love?

why'd they take more than their share?

painted greatness?

we ate the colours

trying to fill time

erase space

wash away loneliness

And that is why 

I am here

you are not 

 

7-6-93 Victor Harbor copyright Terrell Neuage(1130 B)

packaged feelings

on tour

your love 
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my souvenir

come again

like your smile

foreign visa

desire's passport

This is not the real me

I am just like this

because I'm on holiday

your touch

my souvenir

of packaged feelings

placed away

for a rainy day

when I'm without you.
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spent the day

sitting in a warm bubble bath

watching life's truths

ricochet off bubbles
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unlike my children

Though I was being lazy

not making their meals

sewing clothes

cleaning house

But I worked very hard to find truths

here in the bubble bath

and the truth is

it is better in here

than out there.
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poems 

like dreams

love

fantasies

and were never meant to be 

translated

interpreted
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realized

 

 

 

8-7-93 Victor Harbor copyright Terrell Neuage(1210)

Without amnesia

we can never

know youth's passion again

like a flower closed

would open again

if it chose

to break free

of what it perceived 

to be its only way

to be
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I translated my feelings

for you
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in so many ways

that I forgot

which language

you understand

and I'm left incoherent

like love is

7-9-93 Victor Harbor copyright Terrell Neuage(720)

it was as if tomorrow had never had happened

and what 

we were looking forward to

was yesterday

before time had yet to discover 

liberality.
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The problem with my writing 

is that it begins

before it ends

just like us
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now 

at our beginning

 

7-9-93 Victor Harbor copyright Terrell Neuage(1424 C)

stayed awake

when I went to sleep

to see

where dreams begin

and I discovered

the truth

dreams are televised broadcasts

from a planet of a neighboring star

and their electronic waves

always passing through the earth

are on the same frequency

as our dreams

so it's obvious that what we dream

is just so many soap opera

from a distant star
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7-9-93 Victor Harbor copyright Terrell Neuage(1352 C)

Sitting side-saddled

on a shadow

should show

shades of substance

finally found

so fulfilled

But as times travel

so do shadows 

never showing

which side

is best

like love

and the morning after

and shadows of fences

yet to hurdle
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I thought you were
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someone else

than you are

You thought I was someone different

than I really am

so our someone else

got together and had a real good life

while the real you and me

have had a terrible time

being together

wondering why we weren't

someone else

together

 

 

6-9-93 Victor Harbor copyright Terrell Neuage(680 B)

The good poets

write about

Zeus, buffaloes, dew, trees, morning

But since no real man

is really a poet

I write only about
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nails, hammers, chopping trees, 

footy, beer, and trucks

Because no one

wants sensitive

when they can be a man
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While waiting for fame

I lived and died

and left behind

nothing at all

Because I found fame

on a distant galaxy

that will last a lot longer

than this short lived galaxy

our short lived sun

spends its short life

shinning on
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a short lived planet.
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Behind the mountains

Beyond the sea

in the depths we believed

Bright birth borrowed

tomorrow

thinking forever was a circle

now that we know better

we can rest easy

and live now

like we are

in the midst of forever
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6-12-93 Victor Harbor copyright Terrell Neuage(78)

 

The evolution of belief

brings little relief

when the beginning

is unknowable

until now

But for $4.95 plus $5.50 postage and handling

all the answers

will be questioned

and if you act now

a free match will be given

for evolution of belief

to return

to the ashes it first rose from
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6-12-93 Victor Harbor copyright Terrell Neuage(1402 A)

while empty of thought 

I caught

a meaningless pattern

shapeless as love

when first met

I placed it in a motionless container

while rain outside suspiciously fell

and wrote in a cloud above it

'Beware - meaningless pattern near'

but the rain erased my sign

and flooded my empty thoughts

So if I pretend to understand

and smile awhile

remember

so I won't have to next line
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To say what everyone wants to hear

like the great Australia statement

is the only reason

all else

will be fillers

until that time
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As complex

the future may be:

life will be simple

needs met

wishes answered

dreams controlled
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with instant answers

perfect solutions

yet still no cure

for love 

will exist

which is little

different

than

in the beginning

 

6-13-93 Victor Harbor copyright Terrell Neuage(61 B)

Sun rises 

rain falls

river flow

mountain sit

while the rest of us

run around in circles

sorting our selves out.

If we know something nature doesn't

should we say

'hey, we're humans
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we got it all figured out'

or should we let nature

continue along 

without our help

 

6-13-93 Victor Harbor copyright Terrell Neuage(1362 C)

Love like a sun rise

happens every day

but only if we're awake

do we experience it
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While swimming

to the end of this dream

I encountered reality

floating on top
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in a bubble

but like all reality

it popped 

on closer inspection

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1811 E)

Without words

without birds

we wouldn't know

a sentence in flight

And I would be unable

to say Mars is covered

with tomato soup

the moon was of green cheese

Venus - lettuce

and Pluto is made from tofu

(or) in general

we live in an edible section

of the milky way
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but whether we are dessert

or the main course

I can not really say

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1819 H)

EMPTY

that is the only explanation

FULL

is the goal

LOST

is the way

pieces lay alongside the road

huddled together in hysteria

the state of the condition

is frozen within its code

laughter screams in baroque sonnets

it will be o.k. 

it will be o.k.

the earth will shatter at mid-day

splintered with all its wisdom
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art, poetry and good sex

into so many empty pieces

by some love lost comet

and no one will know

that once we cared

 

6-15-93 Victor Harbor copyright Terrell Neuage(176)

Final moments exit

in rhythm to echoes

of a pulsar

at the end of our small universe

but no one knows why

we're so off-key

and nature isn't
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to understand

is to not to believe
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while getting in touch with my feelings

I tripped over reason

fell in love

and broke my heart

now in hospital
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I was given plastic surgery

and though I now look like 

a shadow of myself

at least I'm in touch

with myself

 

 

 

6-15-93 Victor Harbor copyright Terrell Neuage(1809 I)

For the first time

with no reason in sight

we were free 

to be ourself
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while waiting for the right moment

nothing happened

and that was the right 

moment
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Today passed with little importance

and so was added

to a pile of yesterdays

and sent to 

a far corner of the universe

to be recycled

as important days

for the inhabitants

of a distant planet

who live forever
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on our discarded memories

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(1531 C)

As far as dreams can go

we will find

the end

to where

what

will

we

want

with

what we want

where we were

when we were

who?
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6-17-93 Victor Harbor copyright Terrell Neuage(61 B)

Countless times I stayed awake

to worry about

what would happen

only to find

everything changed

so much

I couldn't keep up

with worrying

so now 

like the endless line

of pine trees on the edge of town

wondering whether

they will become tooth picks

firewood

a book of poems

or a Christmas tree

I wonder

too.
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I wrote yesterday

for today

forgetting it is me

and not time

that doesn't change

but stays the same

at least in thought
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I took all the mistakes

ever I made

and lined them up

they reached to the moon

and now I will walk on them

and bring back some

green cheese and market it

Before anyone else
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gets the chance
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It has always been

how to start

that has puzzled

and baffled

everyone so long

But not me

because I never start
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Passions flame

quickly came
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like youthful desire

burns in the fire

turns to ash

then to dash

off into age

another page

is turned 

past burned

and the future is remembered

before it is experienced

while where we had been

is left like so many ruffled leaves
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The fools have died again

traded their life

for a belief

fought wars to protect dreams

crucified themselves for faith
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sacrificed their lives

thought we all cared

those left behind

playing at the casinos

dancing at the discos

tasting love along the shore

they don't care

what the dead believe

while they lay bleeding

with some noble delusion\

floating in their head

we the living are the heroes

because we knew enough

not to fight the losing battle

that death always is

 

7-1-93 Victor Harbor copyright Terrell Neuage(1402)

Death loves nature

in cycles of birth

nourishing eternal sleep
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society endures suffering

and calls it purpose

the reason to continue

for lessons to learn

then quickly forgotten

when death loving nature

takes one's final breath

so to suffer si so wrong

to love one forever will never be

right morals and happy thoughts die too

when death loving nature

takes the final breath that had happened 

for something more

at the end of this life

than a grave that no one can ever free

themselves from

neither to walk heaven's golden streets

or sweat hell's guilty flames
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7-1-93 Victor Harbor copyright Terrell Neuage(144)

What is poem if not to question?

Written in stops and gaps

unlike nature flowing free

who but man would sentences leave unfinished?

to toss about words

like a juggler at the matinee?

what is poem

but meaning gone astray?

waiting for the best minds to pick up

the content and bury the metre and rhymes

and name themselves critics

while expecting a good wage

to tell what the poverty struck poet

really was saying

Because he was to daft

to make it clear to begin with

and too lazy

to get a proper means of support to begin with

for what is poem
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but an abbreviated excuse

to begin with

7-1-93 Victor Harbor copyright Terrell Neuage(1738 B)

EUHEMERISM

Funeral are for the living

the dead will not see the roses and tulips picked

waiting to wilt and die

on a casket made for the living

What a waste the dead are

filling cemeteries

where skyscrapers of offices and frenzied secretaries

or a freeway or a new bowling alley

could be put in place instead

Shame on the dead 

leaving bodies to pollute the world and take up valuable space

the dead are gone

leave 'em be

why?

when I die I wouldn't be her any longer

take my body
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the good parts give 'em to someone alive

and the rest feed to the lions

at Central Park Zoo

for once long ago

I was a Christian and the lions still remember

when I am dead and all this is left

is my crying children and scribbled poems

do not wrap my death and fill the ground

to shelter my bones

because funerals are for the living

the dead are too far away and sound asleep

to ever care

7-2-93 Victor Harbor copyright Terrell Neuage(234 B)

The life she made

the life she lived

thoughts no one else dared to possess

love to desire's full extent

children born children raised

hopes and dreams 

some even fulfilled
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years and years

life's toil

it was all headed somewhere

until a robber stabbed her

she dies on the subway platform amidst rush hour traffic

people rush by

stepping over a life no more

to get home 

in time for dinner and evening t.v.

not wishing th think

tomorrow it could be them

stabbed to death for a few dollars

the sum value of one's life

to a passing stranger

a few dollars 

the price of a cheap bottle of wine

drunk in haste over a life once so full

7-2-93 Victor Harbor copyright Terrell Neuage(1408)

We slipped away

between the rain and bridge

and memories of before
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along mirrored streets

in pregnant whispers

we wanted to hide behind today

and jump out and surprise a future

the wind was strong

I felt your heart beat inside my breast

if only we could be longer than this passing storm

I would lie with you in the rain

until memories died of exhaustion

then we'd float away

like we've done every time before

7-6-93 Victor Harbor copyright Terrell Neuage(1702)

We played in words

juggled meanings

contested emotions

And still I wanted you to know

I wanted you so

But there were no oscars or trophies

for unknown acts

feelings came feelings left
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But I never could keep straight

which one was the right one

Now you're gone

Now I'm not

Now

the words play off of my performance 

just like once they did when meaning made sense

and the game was to be played not to be lost

but to be shared before too late

changed all to this past

that will always be

just apart of a part

and never again

an all

like us 

again now

7-6-93 Victor Harbor copyright Terrell Neuage(1694)

We camped in childhood

well away from who we'd be

when the world

http://neuage.indiko.com/collection1.htm (264 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

would want more than

what we were

when wooded wishes

were so real

 

 

7-17-93 Victor Harbor copyright Terrell Neuage(1636)

In love 

the game

is to be played

not to be lost
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When at last

we take our mask off

is it not strange 

that at that moment

our life ends
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7-17-93 Victor Harbor copyright Terrell Neuage(1746)

HOW LONG THE BATH?

When first hot and bubble filled

like before birth

if I could imagine such 

when news is someone else's life

war, discovery, money, sex, hunger

the precise media

shocking a concise audience once again

"oh the way things are

what will become of it all?"

take me back to the slavery of the womb

or at least this hot bubble bath

where I lay in evolution's start

was it not out of a warm bubble bath

that life first emerged?
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I understand 

we are sorry Sarajevo, Belfast, Lebanon, LA, 

City Streets everywhere

The South will rise again

out of a warm bubble bath

But for now like in the beginning

and to be at the end

I wash my genes

I soak my soul

I merge quickly before the water turns cold

and the bubbles disappear

like death does

when life reappears

7-17-93 7-17-93 Victor Harbor copyright Terrell Neuage(1748)

Your guess

is as good as mine

and every human ever to guess
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My reality is another's nightmare

my dreams

someone else's reality
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I came to this world in my body

and I will leave without it

the meaning of which

if only I knew

I'd be the wises of all people

the starter of a religion

the leader of every follower

the host of my own t.v. show

just like Jesus and all the rest were
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A superstar

a living legend

with the philosophy 

to match

7-17-93 Victor Harbor copyright Terrell Neuage(311 E)

Plato if you discovered death was but a change

and came back to earth with no memory of pasts

would you believe again what once you lied

or would you be a common hooker

standing at the corner of Hollywood and Vine

like all the other greats throughout history

have done at one time or another

and I've seen them all waiting for a trick 

like before Emerson, Arthur, Jesus, Aristotle, Einstein,

Jung, Mary, Joan of Arc, the saints

philosophers. poets and artists

T they all taken their turns

selling themselves for a few coins

not knowing once they had known the way

to get so many to believe 
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when nature used them

like the world does no

so well

 

7-18-93 Victor Harbor copyright Terrell Neuage(1203 B)

with a day gone by

to have nothing to remember it by

is to have it go by without ever having been

but to cast a poem

plot a painting

network a joke worldwide

on a bulletin-board

is to access interactively nature's

transparent lines

is to bond in memory

forever

that there was more

to the day

than the passing wind

7-20-93 Victor Harbor copyright Terrell Neuage(1819 C)

everything was put aside
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giving a clean slate 

like birth

new impressions were everywhere

old interpretations

like in a philosophical amnesic

surprised

even reason made sense

though feelings still didn't

and everything is now so new

and exploratively different

that 

(and it sounds so radical)

I can 

(justifiably)

write

(without shock)

the END

and know it is only the beginning.

7-22-93 Victor Harbor copyright Terrell Neuage(194)

I dreamt
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of a moment like this

now

if only

I could recall

what happened

it would be so sensible

7-22-93 Victor Harbor copyright Terrell Neuage(335 B)

everything 

every moment

every thought

is to be grand

the ultimate

what everything

was done for

while all before

was little more

than the step to now

like winter to spring is

 

7-22-93 Victor Harbor copyright Terrell Neuage(192)
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While exploring every thought ever had

I was amazed to discover

they were all edible

and luckily

calorie free

like rain

which has reflected

the world as it travelled

to earth 

so far
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As we dreamt

in anticipation

of what waking would be

life separated

leaving us

in dream 

for evermore
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7-23-93 Victor Harbor copyright Terrell Neuage(62 B)

Close to the end

meanings so poignant

that the thought will last a thousand years if not more

If God came to earth 2000 years ago

wow!

why didn't he make a video of it?

why go through the dark ages

(the years before television)

without seeing the way it was

why didn't the crusaders

have land Rovers and laser weapons?

Why didn't Jesus use a microwave oven?

to warm the food for the 500,000 at Woodstock?

Why didn't Caesar become a game-show host?

Why walk on water when one can use a hover craft and skim the top?

who changed the water to wine to blood

at Sarajevo, Belfast, La and in the Townships?

Why didn't the twelve disciples

form a baseball team instead of just getting stoned?
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Why didn't the Church build football stadiums instead of churches?

Why would one leave the job of making billions of suns - many with

earth like planets - and come to our earth?

Well it is all so obvious

God did leave videos

and when they are discovered (beneath my house)

I can say

'see I told you so'

7-25-93 Victor Harbor copyright Terrell Neuage(118)

When what was expected

drowned in the rain

covered by an avalanche

blown away be reality

believe in the immense energy

involved

to make so much expected

be but a fart in time
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I've worked so hard

to become everything

I never wanted to be

that if 

what I wanted

happened

ever

no longer would I know

would you?

 

 

7-28-93 Victor Harbor copyright Terrell Neuage(766)

as if endings really were:

Like stepping out of circles

abandoning cycles

spirals

lateralness can only operate in a circle

(giving it the new age illusions we love to share)

leaves no end

beginnings don't struggle

only aborted consciousness does

http://neuage.indiko.com/collection1.htm (277 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

leaving returning

defining

refining

mouths opened wide

everything ever said is wrong

everything ever written false

every love has been scared

the end now is nothing more

but a return on the circle

to doing it all wrong once again

 

 

7-28-93 Victor Harbor copyright Terrell Neuage(61 B)

 

Morning swallowed

my dreams

made me hungry 

to see if 

they'd come true

like everything else
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I believe in 

does
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At the beginning

when all there was

was already there

waiting to be put together

like you and me 

and the galaxies

too
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I was so sleepy

I slept standing up

while the world

lay on its side

watching

 

 

 

 

 

 

 

5-1-93 (838)

the reason 

we are here

is because dawn

doesn't want to 
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come alone

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430)

like steps through history

or a wander through dreams

today's beliefs,efs

grew out of yesterday's crumbled ideologies

for tomorrow's

individual freedom

finally won

to take wings

never to land again
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I learned shorthand
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speed reading

computerization

experienced Paris in a day

read 'Readers Digest'

condensed pasteurized homogenized great novels

and watched history of civilization

but time stood still

when your touch

became so 

involved

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(492)

I concentrated so hard

on this moment

that yesterday and tomorrow disappeared

now

like neapolitan ice cream

melted

contains the former and the latter
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in a future past tense

that has no ease 

of

explanation 

in this moment

 

5-1-93 Victor Harbor copyright Terrell Neuage(316 C)

There is little difference

between you and me

except that I am conscious

of the little difference

(even calling them my own)

and you see them

being but variations

of your greater self

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430 D)

This life goes so fast

that when I die

I will need

a thousand years
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to review all that happened

in this life

 

 

 

 

5-1-93 (1508)

The continuous pouring out

of creativity

fueled forever's freedom's

perceptual persuasion's performance

reflected perfectly

for me

to 

know

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1394)

I wouldn't want to live on Venus
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because there are no trees

nor on Mars with its lack of flowers

and there is no chocolate on Jupiter

or ice cream on Mercury

while on earth

everything I want

is between the sea

the trees

and the shopping mall.

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(858)

If I knew how to write

a poem

I would

if I knew how to sing

I would

http://neuage.indiko.com/collection1.htm (285 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

If I could dance, take photos

paint or tell your future

I would

But all I can do

is build you a castle

in the sand

and offer it to you

before the sea

take it from me

 

5-1-93 Victor Harbor copyright Terrell Neuage(376)

the reason

we don't have wings

is because we don't have to fly north

for the winter

But can stay all winter-warm

wrapped in each other's

warmth

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(946)
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The reason

we keep coming to earth

is to learn to stop dying

but we keep

getting into the Plato trap

of this is it

why keep going

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(946 C)

Not every time

is everything

going to be

the way it is

at other times

But instead

like any spinning top everything gets a chance\

to be close at hand

again 
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if we see

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(1130 C)

We rush through life

like we're in a hurry

to get to the end

not knowing what it is

except that

it will be different

than the rush through

this life is

 

 

 

5-593 Victor Harbor copyright Terrell Neuage(1768)

I write

for the same reasons

a bird flies

far from an oil slick
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a whale stays away

from a stream

and buffaloes avoid mountains

I write only 

to find these answers

that everyone else

already knows

 

 

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(858)
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y

 

just a thought away

from not believing anymore

then to disappear

without a thought in mind

or to live forever

if we wish to believe

that
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But where ever it is

what we do

forever is created

with what is believed

now.

 

4-14-93 Victor Harbor copyright Terrell Neuage(1660)

Sharing quietly

passing perceived thought

only to be

received

through foggy receptors

like speaking

the same words

some other language

 

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(1254)

too many dreams?
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not enough time awake

to make

them 

come

true

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(1568)

The thought

we go to sleep in 

dream in 

wake

in

is in

side

but if it wasn't

we'd

sleep

dream

wake

in
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side

the 

same thought

like when giving birth

to a dream

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(1462)

Like in any dream

giving birth

only changes

after 

waking

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(914)

On the 8th day

God wrote a poem

on the 9th

some people were created
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to read it

But they couldn't

so every day after more folks

were made 

so now each person on earth

represents on year

since the poem was written

and that's how long ago God wrote the poem

and since no one

as yet has read it

we are all still muddled up

trying to read

something so basic

as a poem

 

5-18-93 Victor Harbor copyright Terrell Neuage(1166)

While stopping for awhile

like a passing smile

captures a moment's trial

standing in single file
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I noticed what was the same

was each ending

like life

and every dream that follows

 

5-18-93 Victor Harbor copyright Terrell Neuage(1942)

Importance is an attribute

slippeWhile pushing past the limits once believed

I tossed away bewilderment with

'I don't think it is possible'

touching space and understanding it too

so that all achievments until now

were nothing more

than cave paintings

just some muddled hieroglyphics

like old age without reason

But that's all behind

back in humanity's nursery book stage

Freedom is the real frontier

with fear of guilt and misplaced beliefs

being the savage native
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hiding in the psychic

waiting to attack free thinking

with primitive weapons

of guilt, fear, and mysticism

But it is too late

freedom to know will conquer

and push the only true-value frontier open

so every universe 

without secret

is left bare

to enter

and have

 

 

4/9/93 Good Friday Poem - Victor Harbor copyright Terrell Neuage(1810 
C)

In change

dreams come awake

in sameness

dreams go to sleep.
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4-12-93 Victor Harbor copyright Terrell Neuage(558)

 

Desire is the slave

of freedom
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4-13-92 Victor Harbor copyright Terrell Neuage(155 b)

 

if everyone knew

what I know now

holy cow

I'd be out the door

for ever more

that's for sure

But I'm not

so here I am

waiting for more

outside your door
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4-14-93 Victor Harbor copyright Terrell Neuage(350)

 

 

In chosen images 

beliefs reveal 

what is real

like this moment does

rising over a new horizon

in unsettled times

where seas

pierce clouded evenings

tranquil message

of what is believed,

and in tomorrow like again today

the future's past

reveals secret's timely wish's desire

held like forever's reflection in today
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again found to be 

everything worth waiting for

so as to say

yes it was as real

as ever it was meant to be.

 

 

 

4-16-93 Victor Harbor copyright Terrell Neuage(558)

In ancient thought

beyond reason's pillars

everyone came together

to predict the future

in Diana's shower

But they turned on the video

and forgot to leave behind

much more

than our ancient interpretation 

in times

that dispels

all
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(554)

 

Sun doesn't see

moon doesn't rise

But we do

each time

we watch

where we're going

somewhere beyond

destiny's favorite thought

 

 

 

 

4-16-93 Victor Harbor copyright Terrell Neuage(1362)

 

The past 

paints
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tomorrow

But if we let go of it

tomorrow 

will have

no added colour

to make it complete 

(and memories only sleep)

 

 

 

 

'93 Victor Harbor copyright Terrell Neuage(1424)

This moment

is so close to perfect

that to make it so now

is

no more

than a simple

rearrangement of the way it is

with open door
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as an invitation

for nature

to join 

in too

 

 

 

 

'93 Victor Harbor copyright Terrell Neuage(1498 C)

This life

like so many before

is but a shadow

of our selves

travelling at the speed of laughter

through the universe

on our way

to a fish and chip shop

the only planet

that sells them
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4-18-93 Victor Harbor copyright Terrell Neuage(1497 B)

 

 

THE BIG BANG

WAS 

JUST

A WHIMPER

COMPARED TO

WHEN WE MET
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4-18-93 Victor Harbor copyright Terrell Neuage(1388)

 

I awoke before time began

before music

before thought

before silence erupted

into the beginning of now

with all the followers

still waiting to awake

 

 

 

 

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(298)

 

FORGOTTEN
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FREEDOMS

FOUND

FROZEN

FAVOUR

FOREVER

FREE

 

 

 

 

 

 

 

4-93 Victor Harbor copyright Terrell Neuage(228)

 

How good we are tomorrow

depends on how bad

we are today
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4-18-93 Victor Harbor copyright Terrell Neuage(284)

The flower of youth

blossomed

while I looked

the other way

now in memory

I return

to when my name

was the one called

in morning's sleepless desire

 

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(1402)
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Forgetfulness of now

took me back to when

I remember you

whispering to me

'never forget this moment 

and it will last forever

somewhere in mind' Now I am a forgotten foreigner

forevermore

full of

forgetfulness

of now

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(228)

For every gate

that opens

a crowd cheers

I can't see
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but I hear

as the melody of strangers

asking for change

like any weekend weather person would

 

 

 

 

 

9-18-93 Victor Harbor copyright Terrell Neuage(218 B)

The only predictable future

we well 

ever experience

is when we do

what we do

of what we chose to do

 

 

 

4-19-93 (936 B)

I couldn't
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t wait

so I rushed toward

the open door...

only realizing there was no floor

on the other side

after my free-fall had begun

lucky for me

I carry a parachute everywhere

for just such an emergency 

 

 

 

 

 

 

 

 

4-12-93 Victor Harbor copyright Terrell Neuage(317 A)

In broken images

and meaningless dreams
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the future is drafted

and superglued into place

 

 

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(554)

While breaking shackles off of

who we perceived we were to each other

we fell in love

with who we would have been

if broken shackles long ago

had shown us now - then
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11-1-93 Victor Harbor copyright Terrell Neuage(1809 C)

While waiting for a new leader

humanity put on clean wool socks

and though it is true

everyone was as lost as ever

we all had warm feet

that didn't smell

and with over five billion people

that is what is important.

 

 

 

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(1814 B)
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Platonistic specialization

almost stopped love's integrating freedom

from taking flight

out of the mystic plagued night

that descended so long ago

but now nears its end

as we break the 2000 year old shackles

off of the slaves

we have been
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4-9-93 Victor Harbor copyright Terrell Neuage(1204)Until just a 
moment ago

 

 

everything made sense

now

I will have to

start all over again

so I say it was logical
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4-19-93 Victor Harbor copyright Terrell Neuage(1574 B)

In the silence of my memory

you whispered a song

we once danced too

under a spring filled song

in Golden Gate Park in 1967

And in closed eyes

I now disappear

into your long ago promise

'You'll never need anyone else but me'

But the ticking of my clock

the barking of the dog

my children yelling for dinner

makes me open my eyes

remembering

I hadn't thought of you

for at least 20 years

until now.
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4-18-93 Victor Harbor copyright Terrell Neuage(649 C)

I am moving to Saturn

where there is more room

more moons

it's a heavy place

the days are longer

and it takes 28 years to equal one year

so now

I can finally get all those things done

I always said I would

and go multi-moon gazing

with the ones I love

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(292)

today is better than yesterday

tomorrow will be worse
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than last Friday

But next Tuesday

will make yesterday look sad

so there!

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(1531 B)

Childhood spent

childhood saved

childhood's woven parts

superglued together to remember

the moment each piece was a part of something bigger

that went broom broom click click

tick tick like a clock

(that measured the passing days of childhood)

Children never grow old

they just sprout wings and fly away

returning now and then
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to look at how everything

once was together

once was a part of a movement

once was a part of everything that really mattered

until

like sections of life they were reassembled

in a mosaic of memory

just abbreviations of symbolic wholes

where one piece represents

what was played with for weeks at a time

in the labyrinth of childhood

and now is but a collage

on one of the walls of my life.

 

4-19-93 Victor Harbor copyright Terrell Neuage(106)

they've taken away

the walls

left me

with no boundaries

no blocked views
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no hiding place

I roll up into a ball

and roll out into the open space

I never knew existed

until they took away my walls

 

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(1465 B)

While stretching logic

like some do the truth

I noticed an empty explanation

in the corner of a theory that could have unified it all

so now I am proud to present

the X factor that will unify all of existence

that holds it all together 

that was there at the Big Bang

and will be there at the Big Crunch

and the little nibbles afterwards

and wait for it
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it is laughter

that holds it all together

Because it is true (I was there)

the beginning of this present universe

started with a sneeze in the middle of a laugh

and all the galaxies

are just droplets from that sneeze

 

4-20-93 Victor Harbor copyright Terrell Neuage(1811 B)

 

 

 

the meaning of aloha

(hello - goodbye)

changed when you never returned
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4-20-93 Victor Harbor copyright Terrell Neuage(1410)

 

It is better

to seek agreement with ourselves

than solicit it from someone else

don't you agree?

 

 

 

 

 

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(682)

I liked last month so much

I didn't change the calendar
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and that made me so happy

I decided to change it back

all the way to when we met

twenty years ago

when I was only a day younger

than I am now

according to my calendar

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(496)

I talk fast

because I have so much to say

while others listen slowly

so they don't have to hear it all

but that's o.k.

Because the words in between

seldom have much meaning

anyway
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4-20-93 Victor Harbor copyright Terrell Neuage(662 B)

...whether is is better

to be creative and poor

or rich and uncreative

I will know once I become rich

after I find

the most creative way to do it
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4-20-93 Victor Harbor copyright Terrell Neuage(1809 A)

While putting things in order

I noticed how random

the galaxies were tossed about

and thought if they can do that

so can I and that is why\

everything looks so untidy

 

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(1810 D)

I wanted to believe

what I used to 

but reality

swept away the myths
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But I remember the stories

and tell them to my children

who never believed them 

to begin with

 

 

 

 

 

 

4-23-93 Victor Harbor copyright Terrell Neuage(782 B)

There are over 5 billion people on the planet

and only one in this space

at this time in history

with these thoughts

and it will never occur again
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4-21-93 Victor Harbor copyright Terrell Neuage(1429 B)

I thought it was

sounds of waves crashing upon the shore

waking me from sleep

But it was just my stomach

telling me to forget

my diet

and eat a snack

in rhythm to waves upon the shore

 

 

 

 

 

4-23-93 Victor Harbor copyright Terrell Neuage(668) 

All the strategy

of all the people of all time

can't stop the rising sun
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or love, death, taxes, birth

all the philosophies, myths, beliefs

have not changed the colour of the sky

the size of a mountain

or anything much of all

which gives little meaning 

to why

ham on rhyme

is better than tofu on sprouts

 

 

 

8-23-93 Victor Harbor copyright Terrell Neuage(14 B)

It was as if

you knew all along

and had to wait

all these years

for me to realize

we have been together

in one form or another

http://neuage.indiko.com/collection1.htm (327 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

since the beginning

 

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(735 B)

Even with

all the distraction

of these times

I managed

to deliver fax-free

in person

all my feelings for you

to you

and again tomorrow

too

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(178)

It was as if yesterday

http://neuage.indiko.com/collection1.htm (328 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

never had ended

But was just put on pause

for us to experience today

so we could go back to it

tomorrow

again

 

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(734)

change creates love

love creates change

create to change

change to create

love to change

change to love
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4-24-93 Victor Harbor copyright Terrell Neuage(104)

 

So simple to please

so please be simple

and let complications melt

like I do 

when we are one

 

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(1342)

I wanted the last word

and that's why I'm still here

in the middle of time

and I'll be around at the end

if it too
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just to have 

the final say

 

 

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(776)

* 466 (12x12)

NEC

 

Just before God

went off on holiday

I asked if things would change

There was no answer

that was when I realized

God had left earlier

than anticipated

leaving us

in change

to sort out the mess
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we're in

 

 

 

 

 

 

June 7 1993 Victor Harbor copyright Terrell Neuage868

 

 

*=465 11x11

NEC

In the fickle

realms of reality

meanings

are invented

as explanations 

while in my world

where reality

is kept out by walls of gold

http://neuage.indiko.com/collection1.htm (332 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

I am free

in the security

of illusion

and the realism of magic

cascading

through senses

that never were

to be included

in this world

but

and more ?

No! There was never meant to be anything but this

passing dreams

we have been

seduced by

8-7-93 Victor Harbor copyright Terrell Neuage580

 

 

 

* = 464
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NEC

 

 

 

 

 

 

 

 

LIFE 

IS SHORT AND STRANGE

LIKE

AN ANCIENT POEM

BUT

LIVES FOREVER

LIKE AN ANCIENT POEM
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JUNE 8 93 894 Victor Harbor copyright Terrell Neuage110 VICTORIA 
STREET

 

not quite

but close enough to have a name

different

but up close it all looks the same

meanings

slip away before dawn's early reveal

your touch

for a moment was almost real

tomorrow

maybe longer

pattern upon pattern

assembled secrets

chant my name

who am I?

but just another not a name

lingering on the tip

of too many swallowed 
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meanings

and by listening once again

the whispering shadow

reveals

your touch made me real

7/28/93 110 Victoria Street (1134)

 

 

THE WHISPERING MIST

REVEALED

YOUR TOUCH MADE ME REAL

SO NO LONGER

A SHADOW TOO

I'D BE

 

 

 

 

 

 

7/28/93 100 Victoria Street (1486)
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in Sarajevo, Belfast, Beirut, Victor Harbor, Los Angeles,

trees grow flowers bloom rain falls

doing what they've been governed to do always

like humans

fulfilling genetic destiny

to war, dispute, desire but never learn

and over looking nature 

who will be and always has been unlike humans

who were created

for nature's amusement

and who will stay 

until something better

can be created

(this time with some proper genes)

a few dawns 

down the road

a few yawns

left in the mold
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a few pawns

of nature's soul

then wooosh

only nature

left

humans 

left

7/29/93 (614(

STARS SO FAR AWAY

take no notice of our daily

wants wishes

dreams desires

loves losses

games growths

problems possessions

beliefs bingo

troubles thoughts

adventures appreciations

families fortunes

But live their cycles
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no matter what we do

like love

so far away

yet always

within sight

7/29/93 110 Victoria Street (1352)

Why only in my waking dream

before dawn's shadow stealing smile

do I find us

so wrapped together

like once we knew

but too soon forgot?

You not on the earth

me so imprisoned in this form 

dreams link us when I am not quite here

And you so surely elsewhere

is memory playing with mirrors deep in my brain

this perfect hologram of you

reflecting our love forever

though where forever we will be one

I do not know
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But you are there constantly

(except when I open my eyes

which I do less all the time in fear of losing you forever

before I find the way to you)

Handing out your smile

asking me to follow but I can't 

the dawn came you left today alone

once again I am blind with my eyes open

7/29/93 110 Victoria Street (1818)

 

 

 

the proof I have

that much I had

to prove

is simple

I'm a man

born of hand-me-down-genes

explorers, conquerors, kings, lovers, saints, jesters

it's in the genes
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fighter pilot, basketballer, rocker, movie star

it's in the dreams

today's dreams tomorrow's genes

the only proof

a man will ever need

 

 

 

 

 

 

 

 

 

7/29/93 110 Victoria Street (1424)

 

 

 

just as I wrote

in New Orleans, Paris

http://neuage.indiko.com/collection1.htm (341 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

Honolulu, Fiji, Berlin

Sydney, Auckland, London Bangkok

And the places in between

I will write someday

in a space colony

flying past Mars

or on a moon of Jupiter

just as my ancestors

from caveman, to Plato, Jesus, King Arthur, handfuls of Kennedys

Don Juan-Don Quixote-Don Terrell

and the ones in between

I will write on and on and on

just as all men before me

'how doth I get me a woman tonight'

TECHNOLOGY CHANGES

MAN'S MIND NEVER WILL

 

 

7/29/93 110 Victoria Street (868)

 

winter on parade
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frozen

waitings

wanting

wonderful though weird

we

were

writing upon frozen consciousness

like human beliefs

frozen in place

for thousands of years

needing

a good nuclear winter

to start the cycle

over

once

again
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7/30/93 110 victoria street (1816)

 

 

 

 

I had you in my dream

we made morning come

I had you in my dream

you gave birth to our shadow

I had you in my dream

safe-sex again this morning
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7/29/93 110 Victoria Street (456)

 

POSSESSION

while in a dream

silent mist's shadows

its illusive impulses

becoming incoming coming

wrapped by your desire

projected in astral illusions

I opened up you entered 

took my body for a spin

around la Grand Palais

through la Arc de Triomphe

(where 'we' had a few in a nearby shadow)

then the disco

on Boulevard la Villette

where 'we' charged a night of pleasure

on my wife's credit cards

now awake me in my own body
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back at the hotel

I try to explain to my wife

that it was not me on the all night carousel

as love's scents ooze out of my body

and my hoarse gin breath vainly whispers

but but but

it wasn't me I was asleep

while my body was being used

as all men's are in the final analysis

7/30 110 Victoria Street (1810)

 

 

 

The last time

I saw my love

was where she stood swaying in scented smile

selling her body

to passing relatives and friends

on her fund raising drive

to buy Bibles for the Russians
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and provide low cost love

for the poor

 

 

 

 

 

 

 

 

 

 

 

july 31/93 110 Victoria Street

 

 

 

 

if all my heroes knew me

would they still believe
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they were just

a mistake of nature

too?

 

 

 

 

 

 

7/31/93 110 Victoria street (342)

 

 

 

 

Too often

while meaning something else

the rain fell

the farmer cheered 

sport fans jeered

Too often

while meaning something else
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the waves swelled

fishermen ran ashore

surfers grabbed their boards

Too often 

while meaning something else

I ask for love

but never for long

 

 

7/31/93 110 Victoria Street (1552)

 

 

 

 

The last time 

I saw my love

was where she stood smiling

selling her body

to passing relatives and friends

on her fund raising drive
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to buy Bibles for the Russians

and provide low cost love

for the poor

 

 

 

7-31-93 Victor Harbor copyright Terrell NeuageSA (1408)

 

 

While being slaves of love

men will never be free

to be possessed by nature

naturally
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8/01 Victor Harbor copyright Terrell Neuage(1809 A)

 

 

 

 

 

men are born free

(according to the constitution)

but all women cost
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(according to reality)

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8-10-93 Victor Harbor copyright Terrell Neuage(970)
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contact made

like being one 

past minutes

equalled

rolling forever

automatically

like thoughts once so sure

to find the reason

for this

is too

and 

little

more

 

8-10-93 Victor Harbor copyright Terrell Neuage(130)
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While writing worthless rhymes

I fell off of a verbal

burble

and never found

my way back

 

 

 

 

 

 

 

 

8-01-93 Victor Harbor copyright Terrell Neuage(1815 B)

 

I met a man 

whose stories came true

as soon as they were heard

I met a woman 

whose songs came true

as soon as they were heard
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I met a child

whose wishes came true

as soon as they were heard

 

But I've never met 

anyone 

who knew

how this 

ends

 

 

 

 

 

 

August 11 93 Victor Harbor copyright Terrell Neuage(538)
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Driven passion

leaps hurdles

forward thrusting

life changes

in blinks

faster than Pluto's stolen shadows

past burn fast

the new me

you see

is to be free

without thought

of patience

for the role

I once played

 

 

 

10-02-93 Victor Harbor copyright Terrell Neuage(158)
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While wishfully waiting

we watched where we were

sneak us into

last night's remembered touch

and while loosing control

lost in your breath

we disappeared

never to be seen again

 

 

 

 

 

 

 

11-03-93 Victor Harbor copyright Terrell Neuage(1815 A)
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Like a new page of life

turned too many times

morning's misting memories

made me

remember you

when we galloped forests

to our allegoric lake

We rolled in laughing love

and captured fleeing passions

that never wanted flight

to begin with

Like now

in too many turned pages\

to remember 

when first

we started over

this our allegoric night
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11-04-93 Victor Harbor copyright Terrell Neuage(906)

 

 

 

Asking answers' allegiance

while not

leaves outdoors there
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11-05-93 V ictor Harbor (56)
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SHOCKED!

Perception's reflected illusion

reversed reality

I couldn't see

But only beg

I couldn't feel

beliefs were all wrong

morning was night

flowers turned to seed

touch turned to stone

that made no words

I slept while awake

But IT was all a dream

this isn't

no longer

Shocked!

 

11-05-93 Victor Harbor copyright Terrell Neuage(1260)
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forgotten foreign feelings

forged freedoms

final 

fate

no longer here
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11-6-93 (218 b)

 

 

 

 

without all the differences

there

would be

no picture

 

 

 

 

 

 

 

11-6-93 Victor Harbor copyright Terrell Neuage(1819 b)
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In dawn's early revival

I cheered

to know

this show

I was part of

once again
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11-6-93 Victor Harbor copyright Terrell Neuage(559b)

 

 

 

 

 

While at centre stage

I changed my script

so this performance

you see

is but a change

I'm going through
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11-6-93 Victor Harbor copyright Terrell Neuage(1809 a)

 

 

 

 

I won

I lost

I was

I am

 

 

 

 

 

 

11-06-93 Victor Harbor copyright Terrell Neuage(856)
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Changes came quickly before summer's settled passions

oaths were whispered as spring sown seeds settled passions

the times surely so seemingly sullen

would be remembered when now

would be read as ancient history

inventions failing prospering believers

found anything to hold onto gelatinous as first love

But there is the future no one knows everyone predicts

Though no one is quite correct

Touch my mind in pulled forth desires

dig deep death's dwindling demand

take changes

reshape nature's woken woven womb

whisper to the deaf

wave to the blind

walk with the lame

wake the dead

wonder what was where when no one was there

Fleeing freedom fondles the enslaved

shackles clasp the different
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But for all the troubles

all the worries

all the struggles

That this all important tragedy firmly hangs onto

Nothing can be greater that to know some day

This moment will be viewed as but a hiccup in nature 

when changes came quickly

and oaths were whispered only to never be harvested

The future came too fast to think of now as anything more

than a passing shadow eclipsed

11-6-93 Victor Harbor copyright Terrell Neuage(104)

 

 

 

 

 

Your touch

the change

global warming

here to stay
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11-17-93 Victor Harbor copyright Terrell Neuage(1900 - D)

 

 

 

 

 

initial surrender

lost time

borrowed destiny

controlled laughter

on we could go

choice so rare
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or here stay

dwell; on

the whence

of it all 

 

 

 

 

 

 

 

11-16-93 Victor Harbor copyright Terrell Neuage(572)

 

 

 

 

I thought we could share the moment

as if it were 

the last, the first, even forever

we'd be unleashed nature
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watching humanity begging for rest

we would be the condemned's

final wish

the cry at birth

the anguish at the end

the fireworks at the completion

of the games

the ecstasy of every experience

pulsating in one Grand Moment

I would be your knight, love, knight, love, king, slave, 

fool, hero...

even a new-age male

if such a perversion

was your wish

Oh! I'm sorry

you just were asking me what time it was

here, in front of the caulaflowers and parsley

at the supermarket

11-7-93 Victor Harbor copyright Terrell Neuage(680)
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Caught in between changes

without names

theories without masks

desires without dreams

caught in between voids

where changes create

voids

creating change

 

 

 

 

10-8-93 Victor Harbor copyright Terrell Neuage(102)
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Forgotten

once again

like watching life pass too quickly

without holding onto

passing reality

nothing comes to be forgotten

and a man in the last row

waves his hands and yells

"forgotten

I'm forgotten"

But no one hears him 

as the crowds huddle together

trying to remember

what they had forgotten

 

 

 

 

11-9-93 Victor Harbor copyright Terrell Neuage(218 b)
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I tossed away meaning

like I do apple cores

But it's o.k.

the seeds will grow

and produce meaning

like I once did

before tossed away moments

were used for the landfill programme

at the edge of the swamp

to build skyscraping apartments

for people to sit in

wondering why there were so many memories

tossed about.

 

 

 

 

11-9-93 Victor Harbor copyright Terrell Neuage(692)
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So much the end here:

less likely futures' glimpse

echoes momentary freedom;

and here brought forth meaning

holds wind chimes'

rhyme

nature's time

the end falls

from sight

the past strips naked

and sun bathes alongside memory's reflected copulation

HEAR

so much the end.
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11-18-93 Victor Harbor copyright Terrell Neuage(1332)

 

 

 

 

When the patterns changed

so much the end looked clear

everything was answered

time lost prescription space discovered dimension

 

all figured out the way it should be

why it never is I don't recall

each time a different ending

still the same

always far from the way it should be

if, all-figured-out

was true.
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While building on what went before

I saw tomorrow

glance around the corner

and thank me

for the foundations 

for future's experience.
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Too late the thaw
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when winter's open door

lays waste

hasty autumn's retreat

and ice slices

fields of harvest forgotten

too late too late

like life known

and frozen in winter's

crystal memory

waiting for spring

like every lover does
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While laughing at the changes

even making believe they weren't real
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this moment took flight

with me in tow

And I have no intention of every returning

to say

these changes now

are anything more

than forever lost in flight.
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Each variation

is but an interpretation

of choice.
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11-17-932 Victor Harbor copyright Terrell Neuage(170)

 

 

 

 

 

 

While floating upon

thoughts of you

the world slipped away

leaving me to wonder

where'd I'd be

if I wasn't floating upon thoughts of you
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What we shared

even tomorrow will remember

flying free forever foreign feelings

while watching where we merge

as always we expected

we would
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Without appearing

repetitious

all I want to know is

have I presented before

what now
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so often it seems I search

the touch
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WELL!

The point never was anything

anymore than not appearing

in changing beliefs:

Like a stunt actor

filling in

while this moment goes on

and I stay behind

 

 

 

 

 

 

 

 

 

11-16-93 (1684)
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More like new morning

each thought of you becomes
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Surprised

the prize rises

but no one held their breath

the wind blew instead
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in its tortured

swallowed way

surprise surprise

silently the moment explodes

ripping satin covered dreams

and ravaged virgin thoughts

Take; me

Give me 

There is no exchange

when new born hope drowns

where too the end?

never knows who to tell
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Changes

like dreams

are programmes

synchronizing

who we'd be

if all we could be

was let free.
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11-20-93 Victor Harbor copyright Terrell Neuage(104)

http://neuage.indiko.com/collection1.htm (391 of 504) [3/8/08 2:54:13 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

 

Perception is just interpretation

And how I perceived you

when we met so long ago

is still the same

because

I never listened too

the world's interpretation

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(1192)

For everything that became

in the way we thought it would

good on ya

and how'd it happen

so as to do it all again

today
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If I hadn't eaten tomorrow

there'd be something

for the rest of you all

to look forward to

but since there isn't

I'll take your praise today

and remember you well

tomorrow

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(374)

creativity is a natural

mutation of nature

free-will is its mutinous crew

and we 

the passing strangers to this life,

the disillusioned captains
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looking for a better course
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love is a bird

blown-away

on the first day of hunting season
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love is an experiment

that nature evolves with while

philosophy, religion, psychology

politics and the economy

are the stumbling blocks 

after the hurdles
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on the way

to love's tasteful experiment

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(956)

I take all the concepts

put forth in a philosopher's

life

and sum it up in a few lines

and feel good for all the trees saved

instead of explaining in volumes of books

'ain't she nice?

and that's why we're here folks...'
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The new empirical theory of blind love

is you and me

out-of-sight

out-of-mind

together

 

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(1410)

While searching through

memories on file

I accessed the spring dawn

when we rose out of our selves

in tune to the sound of our breath

that echoes now

through a deep memory of long ago

and where are you now
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In forests of forgotten flavours forever forgives foreign freedom for 
fighting frozen memories

tonight
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The most creative moment of the day

is a moment before we awake

when the waking hours are designed

then hidden behind the screen of back-on-earth again

like when we were born

and to change that moment

would be to change

creation itself

which my dog told me

just before I awoke

this morning

that is not our lot to do

probably

 

4-27-93 Victor Harbor copyright Terrell Neuage(1410)
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unlike other poets

who try to sound all flowery, rhyming, mystical, and abstract

I prefer to write down-to-earth-truck-driver's-poetry

like

'hey, where ya goin' baby? 

how about some real lovin' tonight'

and no poet has ever said it

quite as beautiful as that.

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(1573)

We began where we left off

only the century had changed

Now there are flying things

with people in them

and mechanical monsters

carrying the people

doing the work

yeap it was different

but we are the same
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I suppose

everyone

really is 

at night with the lights out

it could be 400 BC still

and you would taste just as good

 

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(1630)

I went to count my money

like I once did my women

OH NO! 

broke again
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full of worry

that missing you

would blind me

from starting over

with someone else

who someday I'd miss too 

like I once did

and now worry

will never stop 

you

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(234)

 

I showed everything I felt

lucky for me
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the President said

it was just another

nuclear accident

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(649 G)

I waited to see if anything

would ever become of me

before accepting my fate

to be kind of all the local galaxies
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In my humble opinion

God should be

http://neuage.indiko.com/collection1.htm (404 of 504) [3/8/08 2:54:14 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

fired
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If we had stopped saying

this is too difficult 

in 1777

let's go home for tea

we wouldn't be

watching today's battles

on the 6 o'clock news
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I was so sleepy

I slept standing up

while the world

lay on its side

watching
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Like a cloud-free

wind strewn sea

I reached to be free

But a dawn hugged horizon

showed me

BOUND and ALONE

to WISHES and DREAMS

that filtered through

passing times

when voices believed

merged with my final thought

sinking
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this wind stream sea

with me

gasping for a new philosophy

that made sense

to my drowning world.

 

 

 

 

6-2-93 Victor Harbor copyright Terrell Neuage(898)

 

waiting for love

is like waiting for a computer to load

with so much memory

and functions

that no end is ever to be

unless it becomes unplugged 

and has no back up batteries.
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So cold

sun so far away

night so close 

of ever I'm warm again

I'll save it 

at least

in memory

so that when I'm so cold anew

my memory will thaw

my frozen perceptions

that chill me so now
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if love

has to 
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be explained

it then is a philosophy

 

 

 

 

 

6-3-9 Victor Harbor copyright Terrell Neuage(40)3

everything we do

is just a preliminary

for when

there is nothing

left to do
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I don't know why
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can't explain it now

perhaps never will

but life never ends

only perceptions

of the moment end

like this verse

one line at a time

 

 

 

7-6-93 Victor Harbor copyright Terrell Neuage(327 B)

Not enough time?

where'd it go ?

Not enough space?

who filled it up?

not enough love?

why'd they take more than their share?

painted greatness?

we ate the colours

trying to fill time
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erase space

wash away loneliness

And that is why 

I am here

you are not 

 

7-6-93 Victor Harbor copyright Terrell Neuage(1130 B)

packaged feelings

on tour

your love 

my souvenir

come again

like your smile

foreign visa

desire's passport

This is not the real me

I am just like this

because I'm on holiday

your touch

my souvenir

of packaged feelings
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placed away

for a rainy day

when I'm without you.

 

 

6-7-93 Victor Harbor copyright Terrell Neuage(1182)

spent the day

sitting in a warm bubble bath

watching life's truths

ricochet off bubbles

unlike my children

Though I was being lazy

not making their meals

sewing clothes

cleaning house

But I worked very hard to find truths

here in the bubble bath

and the truth is

it is better in here

than out there.
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poems 

like dreams

love

fantasies

and were never meant to be 

translated

interpreted

realized
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Without amnesia

we can never

know youth's passion again

like a flower closed

would open again
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if it chose

to break free

of what it perceived 

to be its only way

to be

 

 

9-7-93 Victor Harbor copyright Terrell Neuage(1825 C)

I translated my feelings

for you

in so many ways

that I forgot

which language

you understand

and I'm left incoherent

like love is

7-9-93 Victor Harbor copyright Terrell Neuage(720)

it was as if tomorrow had never had happened

and what 

we were looking forward to

was yesterday
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before time had yet to discover 

liberality.
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The problem with my writing 

is that it begins

before it ends

just like us

now 

at our beginning

 

7-9-93 Victor Harbor copyright Terrell Neuage(1424 C)

stayed awake

when I went to sleep

to see

where dreams begin

and I discovered

the truth
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dreams are televised broadcasts

from a planet of a neighboring star

and their electronic waves

always passing through the earth

are on the same frequency

as our dreams

so it's obvious that what we dream

is just so many soap opera

from a distant star
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Sitting side-saddled

on a shadow

should show

shades of substance

finally found

so fulfilled

But as times travel

so do shadows 
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never showing

which side

is best

like love

and the morning after

and shadows of fences

yet to hurdle

 

6-10-93 Victor Harbor copyright Terrell Neuage(1278)

I thought you were

someone else

than you are

You thought I was someone different

than I really am

so our someone else

got together and had a real good life

while the real you and me

have had a terrible time

being together

wondering why we weren't

someone else
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together

 

 

6-9-93 Victor Harbor copyright Terrell Neuage(680 B)

The good poets

write about

Zeus, buffaloes, dew, trees, morning

But since no real man

is really a poet

I write only about

nails, hammers, chopping trees, 

footy, beer, and trucks

Because no one

wants sensitive

when they can be a man
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While waiting for fame
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I lived and died

and left behind

nothing at all

Because I found fame

on a distant galaxy

that will last a lot longer

than this short lived galaxy

our short lived sun

spends its short life

shinning on

a short lived planet.
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Behind the mountains

Beyond the sea

in the depths we believed

Bright birth borrowed

tomorrow
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thinking forever was a circle

now that we know better

we can rest easy

and live now

like we are

in the midst of forever
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The evolution of belief

brings little relief

when the beginning

is unknowable

until now

But for $4.95 plus $5.50 postage and handling

all the answers
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will be questioned

and if you act now

a free match will be given

for evolution of belief

to return

to the ashes it first rose from

 

 

 

 

 

6-12-93 Victor Harbor copyright Terrell Neuage(1402 A)

while empty of thought 

I caught

a meaningless pattern

shapeless as love

when first met

I placed it in a motionless container

while rain outside suspiciously fell

and wrote in a cloud above it
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'Beware - meaningless pattern near'

but the rain erased my sign

and flooded my empty thoughts

So if I pretend to understand

and smile awhile

remember

so I won't have to next line

 

 

6-12-93 Victor Harbor copyright Terrell Neuage((1809 F)

To say what everyone wants to hear

like the great Australia statement

is the only reason

all else

will be fillers

until that time
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As complex

the future may be:

life will be simple

needs met

wishes answered

dreams controlled

with instant answers

perfect solutions

yet still no cure

for love 

will exist

which is little

different

than

in the beginning

 

6-13-93 Victor Harbor copyright Terrell Neuage(61 B)
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Sun rises 

rain falls

river flow

mountain sit

while the rest of us

run around in circles

sorting our selves out.

If we know something nature doesn't

should we say

'hey, we're humans

we got it all figured out'

or should we let nature

continue along 

without our help

 

6-13-93 Victor Harbor copyright Terrell Neuage(1362 C)

Love like a sun rise

happens every day

but only if we're awake

do we experience it
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6-13-93 Victor Harbor copyright Terrell Neuage(956 C)

While swimming

to the end of this dream

I encountered reality

floating on top

in a bubble

but like all reality

it popped 

on closer inspection

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1811 E)

Without words

without birds

we wouldn't know
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a sentence in flight

And I would be unable

to say Mars is covered

with tomato soup

the moon was of green cheese

Venus - lettuce

and Pluto is made from tofu

(or) in general

we live in an edible section

of the milky way

but whether we are dessert

or the main course

I can not really say

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1819 H)

EMPTY

that is the only explanation

FULL

is the goal

LOST
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is the way

pieces lay alongside the road

huddled together in hysteria

the state of the condition

is frozen within its code

laughter screams in baroque sonnets

it will be o.k. 

it will be o.k.

the earth will shatter at mid-day

splintered with all its wisdom

art, poetry and good sex

into so many empty pieces

by some love lost comet

and no one will know

that once we cared

 

6-15-93 Victor Harbor copyright Terrell Neuage(176)

Final moments exit

in rhythm to echoes

of a pulsar
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at the end of our small universe

but no one knows why

we're so off-key

and nature isn't

 

 

 

 

 

6-15-93 Victor Harbor copyright Terrell Neuage(212)

 

 

to understand

is to not to believe
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6-15-93 Victor Harbor copyright Terrell Neuage(1560)

while getting in touch with my feelings

I tripped over reason

fell in love

and broke my heart

now in hospital

I was given plastic surgery

and though I now look like 

a shadow of myself

at least I'm in touch

with myself

 

 

 

6-15-93 Victor Harbor copyright Terrell Neuage(1809 I)

For the first time

with no reason in sight
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we were free 

to be ourself

 

 

 

 

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(218 E)

while waiting for the right moment

nothing happened

and that was the right 

moment

 

 

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(1815 A)
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Today passed with little importance

and so was added

to a pile of yesterdays

and sent to 

a far corner of the universe

to be recycled

as important days

for the inhabitants

of a distant planet

who live forever

on our discarded memories

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(1531 C)

As far as dreams can go

we will find

the end

to where

what
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will

we

want

with

what we want

where we were

when we were

who?

 

 

6-17-93 Victor Harbor copyright Terrell Neuage(61 B)

Countless times I stayed awake

to worry about

what would happen

only to find

everything changed

so much

I couldn't keep up

with worrying

so now 

like the endless line
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of pine trees on the edge of town

wondering whether

they will become tooth picks

firewood

a book of poems

or a Christmas tree

I wonder

too.

 

6-17-93 Victor Harbor copyright Terrell Neuage(1166)

I wrote yesterday

for today

forgetting it is me

and not time

that doesn't change

but stays the same

at least in thought
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6-17-93 Victor Harbor copyright Terrell Neuage(860)

I took all the mistakes

ever I made

and lined them up

they reached to the moon

and now I will walk on them

and bring back some

green cheese and market it

Before anyone else

gets the chance

 

 

 

 

6-17-93 Victor Harbor copyright Terrell Neuage(686)

It has always been

how to start

that has puzzled

and baffled
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everyone so long

But not me

because I never start

 

 

 

 

6-19-93 Victor Harbor copyright Terrell Neuage(663 B)

Passions flame

quickly came

like youthful desire

burns in the fire

turns to ash

then to dash

off into age

another page

is turned 

past burned

and the future is remembered

before it is experienced

while where we had been
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is left like so many ruffled leaves

 

 

 

7-1-93 Victor Harbor copyright Terrell Neuage(1186 B)

The fools have died again

traded their life

for a belief

fought wars to protect dreams

crucified themselves for faith

sacrificed their lives

thought we all cared

those left behind

playing at the casinos

dancing at the discos

tasting love along the shore

they don't care

what the dead believe

while they lay bleeding

with some noble delusion\
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floating in their head

we the living are the heroes

because we knew enough

not to fight the losing battle

that death always is

 

7-1-93 Victor Harbor copyright Terrell Neuage(1402)

Death loves nature

in cycles of birth

nourishing eternal sleep

society endures suffering

and calls it purpose

the reason to continue

for lessons to learn

then quickly forgotten

when death loving nature

takes one's final breath

so to suffer si so wrong

to love one forever will never be

right morals and happy thoughts die too
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when death loving nature

takes the final breath that had happened 

for something more

at the end of this life

than a grave that no one can ever free

themselves from

neither to walk heaven's golden streets

or sweat hell's guilty flames

 

 

 

7-1-93 Victor Harbor copyright Terrell Neuage(144)

What is poem if not to question?

Written in stops and gaps

unlike nature flowing free

who but man would sentences leave unfinished?

to toss about words

like a juggler at the matinee?

what is poem

but meaning gone astray?

waiting for the best minds to pick up
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the content and bury the metre and rhymes

and name themselves critics

while expecting a good wage

to tell what the poverty struck poet

really was saying

Because he was to daft

to make it clear to begin with

and too lazy

to get a proper means of support to begin with

for what is poem

but an abbreviated excuse

to begin with

7-1-93 Victor Harbor copyright Terrell Neuage(1738 B)

EUHEMERISM

Funeral are for the living

the dead will not see the roses and tulips picked

waiting to wilt and die

on a casket made for the living

What a waste the dead are

filling cemeteries
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where skyscrapers of offices and frenzied secretaries

or a freeway or a new bowling alley

could be put in place instead

Shame on the dead 

leaving bodies to pollute the world and take up valuable space

the dead are gone

leave 'em be

why?

when I die I wouldn't be her any longer

take my body

the good parts give 'em to someone alive

and the rest feed to the lions

at Central Park Zoo

for once long ago

I was a Christian and the lions still remember

when I am dead and all this is left

is my crying children and scribbled poems

do not wrap my death and fill the ground

to shelter my bones

because funerals are for the living
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the dead are too far away and sound asleep

to ever care

7-2-93 Victor Harbor copyright Terrell Neuage(234 B)

The life she made

the life she lived

thoughts no one else dared to possess

love to desire's full extent

children born children raised

hopes and dreams 

some even fulfilled

years and years

life's toil

it was all headed somewhere

until a robber stabbed her

she dies on the subway platform amidst rush hour traffic

people rush by

stepping over a life no more

to get home 

in time for dinner and evening t.v.

not wishing th think

tomorrow it could be them
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stabbed to death for a few dollars

the sum value of one's life

to a passing stranger

a few dollars 

the price of a cheap bottle of wine

drunk in haste over a life once so full

7-2-93 Victor Harbor copyright Terrell Neuage(1408)

We slipped away

between the rain and bridge

and memories of before

along mirrored streets

in pregnant whispers

we wanted to hide behind today

and jump out and surprise a future

the wind was strong

I felt your heart beat inside my breast

if only we could be longer than this passing storm

I would lie with you in the rain

until memories died of exhaustion

then we'd float away
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like we've done every time before

7-6-93 Victor Harbor copyright Terrell Neuage(1702)

We played in words

juggled meanings

contested emotions

And still I wanted you to know

I wanted you so

But there were no oscars or trophies

for unknown acts

feelings came feelings left

But I never could keep straight

which one was the right one

Now you're gone

Now I'm not

Now

the words play off of my performance 

just like once they did when meaning made sense

and the game was to be played not to be lost

but to be shared before too late

changed all to this past
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that will always be

just apart of a part

and never again

an all

like us 

again now

7-6-93 Victor Harbor copyright Terrell Neuage(1694)

We camped in childhood

well away from who we'd be

when the world

would want more than

what we were

when wooded wishes

were so real

 

 

7-17-93 Victor Harbor copyright Terrell Neuage(1636)

In love 

the game

is to be played

not to be lost
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7-6-93 Victor Harbor copyright Terrell Neuage(564)

When at last

we take our mask off

is it not strange 

that at that moment

our life ends

 

 

 

 

7-17-93 Victor Harbor copyright Terrell Neuage(1746)

HOW LONG THE BATH?

When first hot and bubble filled

like before birth

if I could imagine such 

when news is someone else's life
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war, discovery, money, sex, hunger

the precise media

shocking a concise audience once again

"oh the way things are

what will become of it all?"

take me back to the slavery of the womb

or at least this hot bubble bath

where I lay in evolution's start

was it not out of a warm bubble bath

that life first emerged?

I understand 

we are sorry Sarajevo, Belfast, Lebanon, LA, 

City Streets everywhere

The South will rise again

out of a warm bubble bath

But for now like in the beginning

and to be at the end

I wash my genes

I soak my soul

I merge quickly before the water turns cold
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and the bubbles disappear

like death does

when life reappears

7-17-93 7-17-93 Victor Harbor copyright Terrell Neuage(1748)

Your guess

is as good as mine

and every human ever to guess
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7-17-93 Victor Harbor copyright Terrell Neuage(1886)

My reality is another's nightmare

my dreams

someone else's reality
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7-17-93 Victor Harbor copyright Terrell Neuage(998)

I came to this world in my body

and I will leave without it

the meaning of which

if only I knew

I'd be the wises of all people

the starter of a religion

the leader of every follower

the host of my own t.v. show

just like Jesus and all the rest were

A superstar

a living legend

with the philosophy 

to match

7-17-93 Victor Harbor copyright Terrell Neuage(311 E)

Plato if you discovered death was but a change

and came back to earth with no memory of pasts

would you believe again what once you lied

or would you be a common hooker

standing at the corner of Hollywood and Vine
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like all the other greats throughout history

have done at one time or another

and I've seen them all waiting for a trick 

like before Emerson, Arthur, Jesus, Aristotle, Einstein,

Jung, Mary, Joan of Arc, the saints

philosophers. poets and artists

T they all taken their turns

selling themselves for a few coins

not knowing once they had known the way

to get so many to believe 

when nature used them

like the world does no

so well

 

7-18-93 Victor Harbor copyright Terrell Neuage(1203 B)

with a day gone by

to have nothing to remember it by

is to have it go by without ever having been

but to cast a poem

plot a painting

network a joke worldwide
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on a bulletin-board

is to access interactively nature's

transparent lines

is to bond in memory

forever

that there was more

to the day

than the passing wind

7-20-93 Victor Harbor copyright Terrell Neuage(1819 C)

everything was put aside

giving a clean slate 

like birth

new impressions were everywhere

old interpretations

like in a philosophical amnesic

surprised

even reason made sense

though feelings still didn't

and everything is now so new

and exploratively different
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that 

(and it sounds so radical)

I can 

(justifiably)

write

(without shock)

the END

and know it is only the beginning.

7-22-93 Victor Harbor copyright Terrell Neuage(194)

I dreamt

of a moment like this

now

if only

I could recall

what happened

it would be so sensible

7-22-93 Victor Harbor copyright Terrell Neuage(335 B)

everything 

every moment

every thought
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is to be grand

the ultimate

what everything

was done for

while all before

was little more

than the step to now

like winter to spring is

 

7-22-93 Victor Harbor copyright Terrell Neuage(192)

While exploring every thought ever had

I was amazed to discover

they were all edible

and luckily

calorie free

like rain

which has reflected

the world as it travelled

to earth 

so far
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7-22-93 Victor Harbor copyright Terrell Neuage(1809 F)

As we dreamt

in anticipation

of what waking would be

life separated

leaving us

in dream 

for evermore

 

 

7-23-93 Victor Harbor copyright Terrell Neuage(62 B)

Close to the end

meanings so poignant

that the thought will last a thousand years if not more

If God came to earth 2000 years ago

wow!

why didn't he make a video of it?

why go through the dark ages

(the years before television)

without seeing the way it was
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why didn't the crusaders

have land Rovers and laser weapons?

Why didn't Jesus use a microwave oven?

to warm the food for the 500,000 at Woodstock?

Why didn't Caesar become a game-show host?

Why walk on water when one can use a hover craft and skim the top?

who changed the water to wine to blood

at Sarajevo, Belfast, La and in the Townships?

Why didn't the twelve disciples

form a baseball team instead of just getting stoned?

Why didn't the Church build football stadiums instead of churches?

Why would one leave the job of making billions of suns - many with

earth like planets - and come to our earth?

Well it is all so obvious

God did leave videos

and when they are discovered (beneath my house)

I can say

'see I told you so'

7-25-93 Victor Harbor copyright Terrell Neuage(118)

When what was expected
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drowned in the rain

covered by an avalanche

blown away be reality

believe in the immense energy

involved

to make so much expected

be but a fart in time

 

 

7-28-93 (1800)

I've worked so hard

to become everything

I never wanted to be

that if 

what I wanted

happened

ever

no longer would I know

would you?
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7-28-93 Victor Harbor copyright Terrell Neuage(766)

as if endings really were:

Like stepping out of circles

abandoning cycles

spirals

lateralness can only operate in a circle

(giving it the new age illusions we love to share)

leaves no end

beginnings don't struggle

only aborted consciousness does

leaving returning

defining

refining

mouths opened wide

everything ever said is wrong

everything ever written false

every love has been scared

the end now is nothing more

but a return on the circle

to doing it all wrong once again
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7-28-93 Victor Harbor copyright Terrell Neuage(61 B)

 

Morning swallowed

my dreams

made me hungry 

to see if 

they'd come true

like everything else

I believe in 

does

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(978)

 

 

 

At the beginning
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when all there was

was already there

waiting to be put together

like you and me 

and the galaxies

too

 

 

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(64)

I was so sleepy

I slept standing up

while the world

lay on its side

watching
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5-1-93 (838)

the reason 

we are here

is because dawn

doesn't want to 

come alone

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430)

like steps through history

or a wander through dreams

today's beliefs,efs

grew out of yesterday's crumbled ideologies

for tomorrow's

individual freedom
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finally won

to take wings

never to land again

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(916)

I learned shorthand

speed reading

computerization

experienced Paris in a day

read 'Readers Digest'

condensed pasteurized homogenized great novels

and watched history of civilization

but time stood still

when your touch

became so 

involved
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5-1-93 Victor Harbor copyright Terrell Neuage(492)

I concentrated so hard

on this moment

that yesterday and tomorrow disappeared

now

like neapolitan ice cream

melted

contains the former and the latter

in a future past tense

that has no ease 

of

explanation 

in this moment

 

5-1-93 Victor Harbor copyright Terrell Neuage(316 C)

There is little difference

between you and me

except that I am conscious

of the little difference
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(even calling them my own)

and you see them

being but variations

of your greater self

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430 D)

This life goes so fast

that when I die

I will need

a thousand years

to review all that happened

in this life

 

 

 

 

5-1-93 (1508)

The continuous pouring out

of creativity

fueled forever's freedom's
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perceptual persuasion's performance

reflected perfectly

for me

to 

know

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1394)

I wouldn't want to live on Venus

because there are no trees

nor on Mars with its lack of flowers

and there is no chocolate on Jupiter

or ice cream on Mercury

while on earth

everything I want

is between the sea

the trees

and the shopping mall.
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5-1-93 Victor Harbor copyright Terrell Neuage(858)

If I knew how to write

a poem

I would

if I knew how to sing

I would

If I could dance, take photos

paint or tell your future

I would

But all I can do

is build you a castle

in the sand

and offer it to you

before the sea

take it from me

 

5-1-93 Victor Harbor copyright Terrell Neuage(376)
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the reason

we don't have wings

is because we don't have to fly north

for the winter

But can stay all winter-warm

wrapped in each other's

warmth

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(946)

The reason

we keep coming to earth

is to learn to stop dying

but we keep

getting into the Plato trap

of this is it

why keep going
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5-5-93 Victor Harbor copyright Terrell Neuage(946 C)

Not every time

is everything

going to be

the way it is

at other times

But instead

like any spinning top everything gets a chance\

to be close at hand

again 

if we see

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(1130 C)

We rush through life

like we're in a hurry

to get to the end

not knowing what it is

except that

it will be different
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than the rush through

this life is

 

 

 

5-593 Victor Harbor copyright Terrell Neuage(1768)

I write

for the same reasons

a bird flies

far from an oil slick

a whale stays away

from a stream

and buffaloes avoid mountains

I write only 

to find these answers

that everyone else

already knows
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5-5-93 Victor Harbor copyright Terrell Neuage(858)
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y

 

d in

by interpreters

who think

they've

walked on the moon too!

 

 

 

5-18-93 Victor Harbor copyright Terrell Neuage(546 A)

Pick a dream

make the movie of it

choose a belief

gather a following

become popular

like a commercial

become one with me

and it will be a secret
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just between us

and the stars above

all

22 trillion of them

 

5-18-93 Victor Harbor copyright Terrell Neuage(1196)

I reached into the mist of nature's myths

trying to remember

something lost

long ago

before fables were told

when truth was known

and reality simple

with no explanation needed to walk into

the mist of mature's myths 

to create tales

to explain

what no longer can be known

and wars persist to defend

the stories that no one

no longer
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remember as being made up

to begin with

 

 

5-19-93 Victor Harbor copyright Terrell Neuage(649 E)

If we believed

everything was false

would we be

believers

 

 

 

5-19-93 Victor Harbor copyright Terrell Neuage(410)

The reason I turned 45

was because

I became bored

with being a child

for 44 years.
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5-19-93 Victor Harbor copyright Terrell Neuage(1430 B)

when here 

is no longer questioned

for the reason of its being

then 

here

will lose all

its 

significance.

 

 

 

5-19-93 Victor Harbor copyright Terrell Neuage(1878)

Love

is like a virtual reality game

as long as there

are enough coins to keep it going

the game can
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continue

 

 

 

5-19-93 Victor Harbor copyright Terrell Neuage(954)

I got so mixed up

that I found myself lost

at the travelling circus

now I perform 

finding myself so often

I got lost again

But it was o.k.

Because when the circus

left

I didn't

 

5-19-93 Victor Harbor copyright Terrell Neuage(442)

I traded wisdom

for a new hat

but now that

I've lost my head
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I don't need it

anymore

Now if only 

I could trade

my good luck

for wings

I'd fly free

and away too.

 

 

5-20-93 Victor Harbor copyright Terrell Neuage(710)

I ran out of others

to blame

until I realized

I could say

it was my shadow

and not me

 

5-20-93 (649 F)

The reason
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we are so different

is because

no one else would

and someone had to 

play the role of us

to make it 

complete

 

 

5-21-93 Victor Harbor copyright Terrell Neuage(1430 C)

While sitting about

waiting for the world to end

two million people were born

3.5 million experienced love

5.7 million had hope

6.4 million got what they had hoped for

5 billion plus

didn't see the world end

 

5-21-93 Victor Harbor copyright Terrell Neuage(1942)
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raced through

to taste

every experience

but we collided

in front of the grandstands

filled with the memories

we've been here before

and Every-Time crashed

left the scene

and became another we

only to do it all 

just 

again

 

 

5-22-93 Victor Harbor copyright Terrell Neuage(1764)

while writing out

my theory of 

'why we were together'

life almost passed by

until
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I tossed it to the wind

and though I received a fine

for littering 

it was good

to watch my theories of why we

felt the way we do

go to the dump

for the land-fill programme

that one day

will be a park

with trees

growing on

my theories

of why

we feel 

this way

 

5-22-93 Victor Harbor copyright Terrell Neuage(1962)

Lynn Zimmerman

In a quiet place in my mind
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I hold court with you 

this you know

the way your thoughts

envelope what I feel

your freedom reminds me I'm still in this body

your wish 

that you had not left

quite so soon

created structured sorrows

that don't fit into my mind

where I meet with you

in a quiet place

in a noisy world

wanting to stay

wherever you are

even if only

in my imagination

 

5-21-93 Victor Harbor copyright Terrell Neuage(554 A)

Writing around
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encircling thoughts

evolution of forms

future trappings

whose to believe

even if there was a right

like limited time

and understood dreams

count me out

when the change comes

I'll be left

talking to a tree

and writing around 

an incoherent pass

5-21-93 Victor Harbor copyright Terrell Neuage(1996)

I lived an unplanned life

listening to nature's trumpets

and human's lies

and in between

the audience

and the stars

I acted out
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my dream

 

5-20-93 Victor Harbor copyright Terrell Neuage(501 B)

I saw

how this morning

swept away yesterday

to shine anew

like I do

each moment

I awake

(with you)

 

5-23-93 Victor Harbor copyright Terrell Neuage(649 J)

Sharing quietly

passions passing passage

we grew together

from seed to flower

through every storm

while nature watched

so she too
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could feel

what we did

before dawn

woke us

from dreams

of passion's passing passages

 

 

 

5-23-93 Victor Harbor copyright Terrell Neuage(1254)

Seemed like the end

shadows of memory

flickered 

like ill adjectives

before my eyes

I asked if memories were eternal

but the shadows

had no voice

leaving me

to interpret endings
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just like everyone else

must do

 

 

5-23-93 Victor Harbor copyright Terrell Neuage(1248)

while you were with in reach

I sat sail

believing you'd always be just a ways

over the horizon

for whenever I turned back

to be within reach once more

But now I can't remember

which horizon 

you were on the other side of

And the seas 

are to rough

to continue the search

 

 

5-23-93 Victor Harbor copyright Terrell Neuage(1952)

From cave paintings
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to mobile phones

to future mental links

no one knows for sure

But that's o.k.

But that's o.k.

But that's o.k.

though no one really knows why

 

 

5-23-93 Victor Harbor copyright Terrell Neuage(232)

There must be something 

worth saying

to wake nature's special smile

even for awhile

to ask her to 

romp and roll

whisper and whistle

soft and surely

like in the beginning

when time gave birth
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to nature's reason

and nature were joy

knowing we would too

before dominion over the earth

caused nature

to wish

she'd never been born

 

5-24-93 Victor Harbor copyright Terrell Neuage(1440)

When I saw

how much time

had gone 

birth had winter flown

trees tossed leaves

galaxies shifted

mutinying cells learned to smile

I became still

like a corrupt wind

waiting for

a reversal in time
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that only happens in this some same imagined hibernated dream

5-24-93 Victor Harbor copyright Terrell Neuage(1858)

Excuse this appearance

I just look like this

for this one particular performance

and soon

I will be 

who I imagine I am

"beautiful one day

perfect the next"

 

 

5-24-93 Victor Harbor copyright Terrell Neuage(200)

Borrowed broke

beliefs

gave not a little relief

but like a wandering thief

took my thrill

and left me

with the bill
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5-24-9 Victor Harbor copyright Terrell Neuage(200)

Wake up wake up

morning whispered

behind curtains

long ago placed

wake up wake up

there's more to see

than you saw before

morning sang

wake up wake up

surprises

lives beyond curtains

that no longer

can block out

this wonderful morning

 

 

 

5-25-93 Victor Harbor copyright Terrell Neuage(1734)
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I saw all those experiences

we had together

fly off

to the edge of our galaxy to wait for us

to have them again

once the one

we're having now

is over

 

 

 

5-25-93 Victor Harbor copyright Terrell Neuage(620 B)

 

if nature

took a self-improvement course

we'd be in trouble

like she is

when we try to

improve on her
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5-25-93 Victor Harbor copyright Terrell Neuage(5-25-93 

I travelled so far to get to you

that I had to call the Air Force

to rescue me

from the clouds

the Coast Guard to rescue me

out at sea

a tracker

to find me in the desert

a psychic to get me back into this life

psychologists to remind me I was still lost

But finally I found the key and map to you

on the back of the map to me

Now we're lost together without thought

of our desert island in the cloud far out to sea.

 

5-25-93 Victor Harbor copyright Terrell Neuage(720 B)

Free falling forever frozen
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forgotten freedom

captured caricature

chosen caution

like any proud memory would

pay attention

pay attention

read my thoughts

before

free falling forever 

freezes fortunes freedom

and at the door

destiny cries

it could have been me

it should have been me

 

5-26-93 Victor Harbor copyright Terrell Neuage(228 D) 

May came and went

rolling in with the tide

and disappeared

wearing nothing more
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than a transparent wink

count me in 

I know the lines

I know the rhymes

but in what language

does God laugh

HO HO HO 

But I know

like any mad-man

would

that today to believe

I must invest

in God

or Wall Street

before the share-price

goes too high

all because May came and went

but I didn't

 

5-26-93 Victor Harbor copyright Terrell Neuage(966)
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I wanted to laugh

as you passed me by

in your strip-me-naked-I'm-yours

disguise

but remembering I'm alone again caused my laugh

to fall underfoot

where it was trampled on

by a thousand smiling men

chasing after your

strip-me-naked-I'm yours

disguise

 

 

5-26-93 Victor Harbor copyright Terrell Neuage(790)

Someday when the wind isn't blowing

before evening steals emotions

and memory is raw

I will pass with you

under the clouds

that hold back

my ever constant desire
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for you.

 

 

5-26-93 Victor Harbor copyright Terrell Neuage(1304)

If memory has lust 

well then it must

be for the taste

of you

before the banquet

is devoured by the host

in the form of a ghost

leaving me

wanting you

ever more

 

 

 

5-26-93 Victor Harbor copyright Terrell Neuage(400)

trying new forms...explanations

shadows saddles
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riding thoughts

through the fog

finding...fighting...forgetting

forget forgive 

for

now

frosted forms

frozen futures

foreign beliefs

don't forget me

as past

as whole

as seen

while dusting destiny's desire

to change

ever when 

we can't

do much

but

try new forms
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without explanation 

 

5-27-93 Victor Harbor copyright Terrell Neuage(1600)

while studying

the theory of everything...

what held it all together

the final explanation

of quantum physics

I could think of nothing

but you

how you held

my world together

with your presence

how you moved me to a greater expression

with your touch

how you explained

that I'd never need anyone else

with your smile

while studying the theories of everything

I found your symmetries

wrapped me in completeness
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5-27-93 Victor Harbor copyright Terrell Neuage(1944)

I made a quick observation

of forever

and to my surprise

it made an even quicker

observation of me

 

 

 

5-27-93 Victor Harbor copyright Terrell Neuage(534)

All the plans made passed by

leaving

behind

me

with 

plans made 

but never lived 

like hope 

and wishes 
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leaving me

standing alone

 

 

5-27-93 Victor Harbor copyright Terrell Neuage(13 B)

Never thought there'd be a time

of blank

of empty

of alone

like before birth

and after death

when taste

isn't 

but I am

somewhere felt

yet seen not

somewhere believed

though not known

somewhere ore real

than here
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when sight

sees all 

and that's it

before and after

the big blank

the big empty

and the big alone.

 

5-27-93 Victor Harbor copyright Terrell Neuage(1118)

Knowing today

would be when it would all come true

I jumped out of be

greeted the morning

and let it happen

like

I saw it would

 

 

 

5-28-93 Victor Harbor copyright Terrell Neuage(874)

I wanted to touch
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just to say hi

who are you

that shares the same moving sun

can I melt into you

before the next sun rises

maybe even catch your name

and if you want

we could make it last

longer than 

'wasn't that nice we must do it again sometime'

but for now

I will have to find

the courage

just to say hi!

 

5-28-93 Victor Harbor copyright Terrell Neuage(792)

I wanted to get to know you

but the day was too short

and passing by

like a shooting star
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just a wink...gone

like the dawn

like you and me

and ever after too

 

5-28-93 Victor Harbor copyright Terrell Neuage(790)

If you turn out to be

like my fantasy of you

I'd forget

this century

this planet

these times

and so would you.

 

 

5-28-93 Victor Harbor copyright Terrell Neuage(428)

When I didn't see you today

I thought it was the end of the world

but it was only 

the end of the street
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and you weren't there

but I was 

(at the end of the world)

 

 

5-28-93 Victor Harbor copyright Terrell Neuage(467)

While trading moments

best for better

warm for hot

night for day

yesterday for today

I found the value

of each moment

increased

as time went on

 

 

5-29-93 Victor Harbor copyright Terrell Neuage(1948)

I wanted to stop thinking about you

so I jumped into the cold cold sea

and all I could imagine
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was your warmth

I ran a marathon

But still I needed your nourishment

I climbed a mountain

and realized I'd never surpass your height

I wrote a novel

Made a movie

sang opera

started a business 

had some children

but no matter what I did

I could never 

stop thinking of you

and that is why

I'm writing to tell you

this.

 

5-29-93 Victor Harbor copyright Terrell Neuage(735 B)
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Other poems: COLLECTION ONE ~ COLLECTION TWO ~ COLLECTION THREE

Begin World Wide Web poetry journey here

~ Dr. Terrell Neuage

COLLECTION2

EVERYTHING IN PLACE

NOTHING WAITING

THIS IS IT

TO GO BEYOND HERE

IS TO DENY

WE ARE HERE.

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

THERE IS NEVER

A WASTED STEP

ONLY WASTED THOUGHTS
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TRYING TO INTERPRET

WHETHER EACH STEP

IS WASTED

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

FROM THE MOMENT WE MET

MY LIFE COLLAPSED

INTO PERFECT BALANCE.

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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WHAT I MISSED YESTERDAY

TODAY WILL REPEAT

IF IT

I NEED TO KNOW

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

 

TO FEW THE PLENTY

TO PLENTY THE FEW

WILL THERE EVER BE ENOUGH

FOR THE FEW TO HAVE LESS

AND THE PLENTY TO HAVE MORE

?

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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WHAT GOD WAS REALLY

TRYING TO SAY WAS

'WELL FOLKS

I HOPE YOU ENJOY

YOUR VISIT TO LIFE ON EARTH

IF YOU DON'T

YA GOT TO DO IT OVER AGAIN.

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

IF ONLY IF WE KNEW
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WOULD WE CHANGE SOCKS

THE MOMENT

BEFORE OUR

LAST MOMENT

OF LIFE

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

LAST LIFE TIME

I WAS COMMANDER OF A STAR SHIP

THAT CRASHED ON MARS

THIS LIFE TIME

I WROTE THIS POEM ABOUT IT.
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I FOUND MYSELF

IN THE MARGINS

BETWEEN COMMERCIALS

OF A SATURDAY NIGHT MOVIE
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LOVE IS MORE

THAN A SIMPLE DISCOVERY

OR REDEFINED DEFINITION

STRANGE INVENTION

AN INVASION OF PASSION

WISH FULFILLED.
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LOVE IS LIKE A POMEGRANATE
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GROWING ON A LITCHI NUT TREE

SO OBVIOUS

AND ADMIRED

FOR ITS UNIQUENESS

THAT EVERYONE WANTS

A TREE LIKE THAT.
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TOO OFTEN TO MANY MOMENTS

AREN'T LONG ENOUGH

TO BE FULFILLED MOMENTS.

I KNEW WE'D SPEND TOGETHER

FOREVER

WHEN I FIRST SAW YOU

CROSS THE DANCE FLOOR

THE EVENING PAST

MORNING FOUND US

TANGLED SEAWEED
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ALONG THE DEEP BLUE SEA

ME IN YOU YOU IN ME

IN A MOMENT

LONG AT THE TIME

SHORT NOW THAT

IT'S SO FAR OVER

BUT NEVER GONE

ALWAYS PRESERVED

RIGHT HERE IN THE BACK OF MY MIND.
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I REMEMBER WHEN

THE MORNING FOUND US.

(TANGLED SEAWEED)
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ALONG THE DEEP BLUE SEA

PASSION'S UNDERSTANDING

IN LAUGHTER'S RHYMING COLOUR.

DO YOU REMEMBER THEN

TOO?
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I LOST MY BALANCE

FELL OFF THIS DREAM

LANDED IN THE CENTRE

OF REALITY

OH SHIT!
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I GOT TO HAVE YOU
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WITHOUT YOU THE AIR IS THIN

THE COLD FREEZES MY BALLS

PORNOGRAPHY HAS NO MEANING

WITHOUT YOU

LIFE IS THE PITS
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I'M ALWAYS ACTING

BUT NO ONE SEES

I'M ALWAYS SINGING

BUT NO ONE HEARS

I'M ALWAYS WRITING

BUT NO ONE CAN READ

I'M ALWAYS FEELING

BUT NO LONGER ARE THERE ANY EMOTIONS

TO SHARE WITH NO ONE AT ALL.
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9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

LITTLE LESS

MORE OF YOU

KEPT ME ALONE

AGAIN TONIGHT.
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SURELY THIS TIME

WE WERE MEANT TO BE

MORE CONSCIOUS

THAT WE ARE MERE

CHIMPANZEES WITH SPEECH

MAYBE WE SHOULD GIVE APES

THE BOMB

AND SEE WHAT
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THEY WOULD DO WITH IT.

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

I LOST MY BREATH

ON THE CURVES

SHE NOTICED I DID TOO.
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OUR LOVE

HAD ALL THE MAKINGS

OF A GREAT GAME

TO BE RELEASED ON ARCADE MACHINES

ON BOARD GAMES

AS A LOTTERY GAME
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AS OUR LIFE

WINNER TAKES ALL.
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WITHOUT KNOWING WHY

BLUES TURNS TO RED

SPINACH TO STEAK

YOU TO ME.
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'M ALWAYS OVER

THE TOP

I'VE NEVER KNOWN

ANY OTHER WAY

TO GET PAST THE MOUNTAINS.

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

SEASONAL CHANGES

ANYTHING ELSE

DOESN'T BELONG.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

TOO SOFT YOUR TOUCH

FEATHER OF TORTURE

LET ME

FEEL YOUR TOUCH

SO I KNOW

I'M NOT BEING CARESSED

BY A CLOUD

IN MY DREAM.
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BACK WHEN I WAS A KNIGHT

BEFORE THERE WAS THE GRAND PRIX
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AND THE OZONE WAS STILL LEFT UNPLUGGED

WOMEN DANCED IN AMARANTHINE SILKEN PEIGNOIRS

AND WANTED ME

WHEN THE EARTH WAS FLAT

AND CHIVALRY WAS ALL THE RAGE

I BELIEVED ALL I HAD TO DO

TO FIND THE GRAIL CUP

AND HAVE GUINEVERE

AT THE SAME TIME

WAS TO INVENT CABLE TV

BUT ELECTRICITY WAS YET TO BE DISCOVERED

SO LIKE ALL OTHER HEROES TO BE

I SHORTED OUT BEFORE MY TIME.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

THE PAIN OF TOO MANY PAGES

TO TURN
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TO CHANGE

TO BE FREE

LEFT ME IN THE CHAINS

I WAS PLACED IN

WHEN I WAS A CHILD
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I NEVER WANTED ANYTHING

MORE THAN TO BE THE TOPPING

OF THE CAKE

THAT SHE WAS

ABOUT TO EAT.
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FINALLY FOUND FREEDOM

LEFT ALL AROUND ME

NOT KNOWING

WHAT TO DO

WITH THE SLAVE
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THAT ONCE HAD.

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

MY MUSE

WAS CONFUSED

WITH MY DEMAND FOR A RAP LYRIC

LEFT MY MUSE CONFUSED.
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SUCH A SCORE

BURN THE POOR

WHAT'S THE HITCH

BURN THE RICH

I ONCE THOUGHT MY BELIEFS

WOULD GIVE ME RELIEF
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WHAT A DONG

I WAS WRONG.
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QUIET PERCEPTIONS:

IS THIS ALL DEATH

HAS TO OFFER?

I HAD HOPED TO SEE AN ANGEL OR TWO

SOME RELATIVES

MAYBE SOME FRIENDS

A FEW KENNEDYS

KING ARTHUR, JESUS, ELVIS, EINSTEIN...

I EVEN HAD AN APPLE

TO SHOVE UP EVE

(WHY ARE WE THE SINNERS?)
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OR WAS THIS MY LIFE

WITH NOTHING TO OFFER?

 

9-17-94

 

 

 

 

 

 

SO MANY YEARS WITHOUT A LOVER

WHAT DID cOLUMBUS DO

WHEN HE TRAVELLED SO FAR?

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

BY WATCHING THE SUN

BREAK FREE
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FROM HORIZON'S HOLD

I TOO

LEARNED TO RISE ABOVE

MY HORIZON.
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TRADED WORDS

WITH THE BIRDS

CHIRP

CHIRP

CHIRP

NOW THEY HAVE MY WISDOM

I HAVE THEIRS

CHIRP
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CHIRP

CHIRP
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DESIRE COLLIDED

WITH THE WIND

NOW LAYING

BROKEN

IN FRONT OF HER

CASTLE'S WALLS
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THE 1MISSING LINK I

MILLIONS OF YEARS AGO
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WHEN APES WERE FIRST

EXPERIMENTING WITH

GENETIC ENGINEERING

IN THEIR LABS

IN A FOREST

IN CENTRAL AFRICA

THEY CREATED A MONSTER;

HUMANS.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

THE MISSING LINK II

WHILE WATCHING COMMERCIALS

I DISCOVERED THE MISSING LINK

BETWEEN LOWER AND HIGHER LIFE FORMS;

CONSUMERS.

9-17-94
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EVOLUTION

SAVANNAH

CAVES

CASTLES

SHOPPING MALLS

NUCLEAR POWER

CAVES

SAVANNAH
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HUMANITY FEEL OFF OF

THE EVOLUTION LADDER

WITH THE INVENTION OF TELEVISION.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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I ONCE SAW MY MOTHER

RIDING A COMET THROUGH A NEIGHBORING GALAXY

AND GIVING BIRTH TO NEW LIFE FORMS

AS SHE PAST PLANETS REVOLVING AROUND STARS

AS SHE ONCE DID ME.
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THE BEST ABOUT THE NEW AGE

IS IT WILL WIPE OUT OLD AGE.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THROUGH THE MAGIC OF THINKING

I CAN CLOSE MY EYES

MAKE DISAPPEAR THE MESS MY LIFE IS

AND VISUALIZE THE STARDOM

I WAS ALWAYS MEANT TO HAVE.
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NATURE BROUGHT FORTH

CHEMICALLY PRESERVED FAST FOODS

TELEVISION, DRUGS, RELIGION, AND ROCK AND ROLL

IN ORDER TO RID THE EARTH

OF ALL HUMANS

SO SHE COULD HAVE IT ALL

TO HERSELF
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LIKE IN THE BEGINNING.
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WHEN WE CAN TAKE A SPACE WALK

WITHOUT PRESSURIZED SUITS, OXYGEN, HELMETS, TETHERS

THEN WE WILL BE FREE TO TOUCH THE STARS

AND EACH OTHER.
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SINCE MY MOTHER WAS BURIED

I NO LONGER CAN SEE HER WITH MY EYES OPEN

WHEN I DO SEE HER

SHE IS ALWAYS LAUGHING DANCING

JUMPING ABOUT FROM PLANET TO PLANET

JUST YESTERDAY SHE WAS PLAYING
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WHAT LOOKED LIKE TO ME A GAME OF TENNIS

ON ONE OF JUPITER'S MOONS

WITH MY BROTHER

BUT I HAD TO OPEN MY EYES

TO AVOID HITTING A CAR

AS I WAS DRIVING TO ADELAIDE

AND WHEN I CLOSED MY EYES AGAIN

I NO LONGER COULD SEE THEM

SO I DON'T KNOW WHO WON.

DO YOU?
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I TOOK A PORTION OF THE MIND

WALLED IT IN

CALLED IT MY MIND

AND LEARNED TO ENJOY MY MISTAKES

TRAPPED INSIDE THESE WALLS.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

DISNEY CREATED NEW TOTEMS

WHERE GROUPS AND INDIVIDUALS

CAN BE UNDERSTOOD THROUGH

ASSOCIATING THEMSELVES WITH

ONE OR MORE PARTICULAR CARTOON.
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IT WASN'T LONG AFTER I FELL AND HIT MY HEAD

THAT ZEUS BEGAN TO VISIT ME

AND TELL ME THAT MY MISSION

WAS TO COLLECT SODA BOTTLES

AND GIVE THEM TO THE SCOUTS.

WOW!
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THE FUNNY THING

ABOUT FUNNY THINGS

IS THAT THEY ARE NO LONGER FUNNY

WHEN EXPLAINED

IN A RATIONAL MANNER.
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IF WE BLAME YESTERDAY FOR TODAY

CHILDHOOD FOR YESTERDAY

LAST LIFE FOR CHILDHOOD
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THE LIFE BEFORE FOR LAST LIFE...

DO WE GET TO BLAME NEXT LIFE

ON TOMORROW?
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I HAD THE AMERICAN DECLARATION OF INDEPENDENCE

TATTOOED ON MY RIGHT THIGH IN HIEROGLYPHICS

TO SHOW HOW EQUAL

IF I HADN'T CREATED MYSELF

I COULD HAVE BEEN.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

IF IT WEREN'T FOR TELEVISION

I WOULDN'T BE ABLE

TO LIVE THEIR LIFE

SO COMPLETELY FULFILLED

AS MINE.
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THE WAY I SEE IT IS

I WANT TO SEE IT

DIFFERENTLY.
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I DON'T CARE ABOUT BEING PRAISED

BY THE LIVING AFTER I DIE

BUT BY THOSE WHO WENT BEFORE

WHO WILL APPLAUD

WHEN I RETURN TO REALITY

THAT WHILE ON EARTH

I DID ALL MY LESSONS SO WELL.
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I WHISPERED TO THE MOUNTAIN SIDE

'LATER WHEN THE SUN LEAVES

I'LL PUT A FLOODLIGHT ON YOU

http://neuage.indiko.com/collection2.htm (33 of 56) [3/8/08 2:54:33 PM]



Terrell Neuage poetry collection2

SO ALL CAN SEE YOUR GLORY

IF YOU KEEP SECRET

THE AFFAIR I HAD TODAY

IN YOUR ARMS'.

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

LATER...

WHEN WE'RE CONQUERED NATURE

SAID WHEN IT SHALL RAIN

WHEN THE SUN CAN SHINE

WHEN THE MOON CAN BE FULL

WE'LL GO MAKE LOVE

IN THE RAIN

UNDER A FULL MOON

IN THE MIDDLE OF ANY DAY.
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POPULATION CONTROL
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I MARRIED A MANIKIN

AND PLACED IT IN MY SHOP

FOR THIRTY YEARS

AND SHE IS JUST AS BEAUTIFUL TODAY

AS SHE WAS WHEN I MARRIED HER

NEXT YEAR I'M GETTING US

SOME CHILDREN MANIKINS

TO PUT IN THE SHOP WINDOW TOO

AND BECAUSE I KNOW MY PARENTING SKILLS

THEY WILL NEVER GET INTO TROUBLE

TALK BACK, RUN AWAY, DO DRUGS,

EARRINGS IN THEIR NOSES, OR DREAD-LOCKS

HAVE THEIR OWN VIEWS OR BE A BURDEN ON SOCIETY

WHAT A GOOD PARENT AND HUSBAND I AM.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THROUGH GENETIC ENGINEERING

HUMANS WILL BE ABLE TO LIVE

ON INHOSPITABLE PLANETS

LIKE EARTH

IN THE FUTURE.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

ALL NIGHT WHEN THE SUN HAD RUN

DISAPPEARED IN THE MIST

I LONGED FOR ITS RETURN

TAKE AWAY THIS DARKNESS

THAT STABS AT ME IN THE DARK

BRING BACK MY SHADOW

(MY BEST FRIEND WHO HAUNTS THE CITY AVENUES ALONE)

SHOW ME THE PATH I MUST TRAVEL

TO STUMBLE IN THE DARKNESS

TAKES AWAY THE QUIET

I SEEK OUT

IN THE RUSH HOURS OF THE DAY

ALL NIGHT I LIVE IN FEAR

THIS GUILTY WOMB OF DARKNESS

WON'T PUSH ME OUT

INTO THE BREAK OF DAWN

LIKE WHEN MY MOTHER CROSSED HER LEGS

WHEN I SO DESPERATELY TRIED TO BE BORN

HOLDING ME IN

http://neuage.indiko.com/collection2.htm (36 of 56) [3/8/08 2:54:33 PM]



Terrell Neuage poetry collection2

TO FIGHT THE DARKNESS ALONE

LIKE TONIGHT AGAIN

I SCREAM FOR THE SUN TO RETURN

SO I CAN BE BORN AGAIN.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

WHEN I WAS DEAF

I COULD HEAR THE SONGS OF MY SOUL

NOW ALL I HEAR IS

THE ROAR OF CIVILIZATION

BLOCKING OUT ANY SOUL

THAT CARED TO KNOW.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

COULD HARDLY SAY

PASSING SHADOWS

ON THE GRAFFITI WALLS

REFLECTED CULTURE'S

DOWNWARD TREND.
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TRIED TO BE LESS IRRITABLE

BUT I LOST THE PLOT

FELL DOWN THE CANYON

BROKE MY DREAM

COULD NOT DIGEST

THINGS AS THEY WERE

SO THIS IRRITABILITY IS THE RESULT

BUT TOMORROW WE WILL HAVE A GIGGLE ABOUT IT
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WON'T WE?

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

HISTORY

WE SAT AROUND

SIGNING THE DECLARATION OF INDEPENDENCE

THEN WENT OUT FOR A BIT OF TEA AND SEX

IT WAS A RAINING EVENING

A CUP OF TEA AND SOFT THIGHS

TO BURY MY HEAD INTO

WOULD SUIT ME JUST RIGHT NOW

1776 - I HAD SUGGESTED WE SIGN THE THING

ON JULY 7TH 1777

ALL THOSE SEVENS

I KNEW BY SIGNING IT IN 1776

THERE'D BE NOTHING BUT TROUBLE

BUT I WAS OUTVOTED

IT DIDN'T MATTER

THE FUTURE WOULD SORT ITS SELF OUT

FOR NOW LIKE ALL GOOD INDEPENDENT MEN

ALL THAT WAS IMPORTANT WAS TEA AND SEX
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WE TRADED PARTNERS THAT NIGHT

I HAD BEN'S WIFE, JOHN HAD MINE

IT TURNED OUT TO BE AN ORGY ACTUALLY

THE WOMEN GOT LAID

ONE BY ONE LAYING ON THE DECLARATION OF INDEPENDENCE

THEN THE MEN

A GOOD TIME WAS HAD BY ALL

BACK ON THAT NIGHT IN JULY 1776.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THE REASON I WANT TO BE

A POLITICIAN OR A USED CAR SALESPERSON

A RELIGIOUS LEADER, A LAWYER

OR A JOURNALIST

IS BECAUSE I ENJOY LYING TOO.
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IF IT HADN'T BEEN

FOR THESE THOUGHTS OF YOU

I WOULD HAVE FROZEN HERE

AT THE TRAIN STATION
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WAITING MY ESCAPE

FROM THIS COLD LONELY PLACE

I CALLED MY LIFE.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

ALL THE ANSWERS

WHAT TO DO WITH THEM

IF NO ONE ELSE

DOES WHAT THEY ARE SUPPOSE TO DO

WHAT IS THE POINT

OF HAVING ALL THESE ANSWERS?

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

 

I GAVE UP PROTESTING

TO LIVE MY LIFE

BUT FOUND I COULDN'T
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BECAUSE OF THE PROTESTERS

NOT UNDERSTANDING.

 

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THEY TOLD US

WE WERE LIVING IN IGNORANCE

SO AS TO HAVE

BETTER CONTROL OF US

NOW THAT WE

LIVE IN THEIR KNOWLEDGE

WE'RE ONLY IGNORANT

OF WHOM WE WOULD BE

IF WE WERE FREE

OF THEIR CONTROL OF US.
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IN OVER FIVE-BILLION YEARS OF EARTH

THIS IS THE FIRST NIGHT

WE COULD SPEND TOGETHER SO FREELY

FIVE-BILLION YEARS
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OF WAITING FOR THIS

AND SO WORTH IT

IT WAS.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I UNDERSTAND THIS FRANTIC PACE

WILL ALL DISAPPEAR

BENEATH THE RUINS OF

OUR CIVILIZATION

BEFORE THE NOT DISTANT FUTURE

REPLACES US

WITH A HIGHER SPECIES.
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CROSSED OUT ALL PAST THOUGHTS

REPLACED WITH COLOURS

NO LONGER DO I THINK

I COLOUR

BLUE, RED, GREEN, BLACK, YELLOW
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AND I'LL ANSWER

JUST THE SAME.
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I GREW UP LATE

LONGER AFTER THE OTHERS HAD

AT 47 CLINTON BECAME PRESIDENT

OTHERS...LEADERS IN BUSINESS

DOCTORS, PROFESSORS, ASTRONAUT

ME AT 47

I'M STILL A STUDENT OF LIFE

I PLAN TO GRADUATE IN 20 YEARS

OR SO

BECOME A LEADER

OR A ROCK AND ROLL BAND

OR WRITE OF GREAT STUFF

OR AN ACTOR

WHEN I'M 67

BECAUSE I GREW UP LATE.
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SEX

LIKE A COMPUTER

REPLICATES WHAT IS PUT INTO IT.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

DAMN THESE TIMES

WHERE IS THE PEACE WE ONCE KNEW

SIMPLE WANTS

EASY LIFE

LOVE SO REAL

ALL THESE TROUBLES NOW

THE KILLINGS

DESTRUCTION OF OUR EARTH

DISEASES EVERYWHERE WE TURN

DAMN THESE TIMES

WHAT'S THE POINT

TO CONTINUE
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IS TO END

TO END

END.

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

TODAY'S LARGE VOLCANIC ERUPTIONS

YESTERDAY'S EARTHQUAKE

TOMORROW'S HURRICANE

JUST NATURE

SHOWING HUMANS

WHO TRULY IS THE BOSS.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

THE THRILL OF BEING

WHAT A MOMENT

TO BE CONSCIOUS

SO LONG DREAMS

HELLO MY NEW WORLD.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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I WAS SO FAR AWAY

EVEN MY MIRROR WAS FOREIGN

IF THAT IS ME

THEN I AM SO FAR AWAY

THAT EVEN I

CAN NO LONGER RECOGNIZE MYSELF.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

PISS OFF

11-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

LIFE

IF THIS IS A GAME

WHAT DOES THE LOSER GET?

 

 

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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STILL TRYING TO FOOL ME

LONG AFTER THE SHADES ARE PULLED

IF I WEREN'T SO TIRED

I WOULDN'T BE

SO FOOLED.

 

 

9-19-94

 

SUCH SIGNIFICANCE

AND SO IT SHOULD BE

NOW THAT IMPORTANCE

IS PUT TO SLEEP.

 

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

MAGIC I

NOT LONG AGO
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EVERYTHING I OWNED

FITTED INTO A SUITCASE

NOW I COULDN'T

FIT IT INTO THE STATE OF NEW YORK.

THEN WHEN I'M OLD

IT WILL ALL FIT

INTO A SUITCASE AGAIN.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

MAGIC II

I SAT DOWN

AND WATCHED MY CHILDREN GROW

FROM UNDER TWO FEET TALL

TO MORE THAN SIX FEET TALL

I SHOULDN'T HAVE

SAT DOWN FOR SO LONG.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

IF IT WEREN'T FOR YESTERDAY
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I WOULDN'T BE ABLE TO

PRETEND THAT THIS IS TODAY.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

THE REASON

CAVE MEN

HAD SUCH A DIFFICULT LIFE

WAS DUE TO THE LACK OF

A VARIETY OF TELEVISION SHOWS.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

LIFE IS LIKE A SHOOTING STAR

TO EXPLAIN WHY THOUGH

WOULD BE TO KILL THE METAPHOR.

 

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I TRIED TO EXPLAIN THAT IT IS

6:45 A.M. SEPTEMBER 20TH, 1994

TO MY DOG
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BUT HE JUST LOOKED AT ME

IN SUCH AN ABSTRACT WAY

AND WENT TO THE DOOR FOR A WALK

LEAVING ME ALONE WONDERING

WHEN WAS IT 00:00 A.M. IN THE YEAR 0

DID THEY HAVE A NEW YEAR'S PARTY TOO

LIKE I DID TODAY?

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

WHEN WE GET TO THE YEAR 2000

WE SHOULD START OVER AGAIN

WITH THE YEAR ONE

JUST TO CONFUSE

THE ARCHAEOLOGISTS

1994 YEARS FROM NOW.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

SOON

THE CHILDREN WILL NO LONGER

TAKE THE SCHOOL BUS

SPEND HOURS ON THE TELEPHONE
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WORRY ABOUT ACME

WHAT THEY'LL BE WHEN THEY GROW UP.

BUT I'LL REMEMBER WHEN THEY DID

AS I SIT IN MY SUDDENLY QUIET LIFE

WONDERING HOW THE YEARS GOT TO GO BY

SO FAST

THAT ALL THAT IS LEFT

IS A SOFT ECHO

OF CHILDHOOD AGAINST THE

EMPTY WALLS OF MY LIFE.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I STILL CALL MY SIX-FOOT 13-YEAR OLD

MY LITTLE BOY

I STILL CALL THIS RAPIDLY EXPANDING SUBURB

MY COUNTRY HOME

I STILL CALL THIS WORLD

MY SAFE LITTLE PLANET

I STILL CALL

BUT NO ONE ANSWERS.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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THE DRIED BLOOD OF THE SINNERS

IS HUNG OVER THE SACRED SHRINES

OF THE MOBILE PHONES

AND SATELLITE DISHES

FOR FUTURE GENERATIONS

TO BE BLESSED BY.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

MY LAST DREAM

BEFORE I AWAKE FOR THE DAY

IS MY FINAL FLIGHT

BEFORE LANDING

IN THE WAR TORN ZONE

I CALL MY LIFE.

 

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I WAS SURFING THE LOCAL DIABOLICAL BILLABONG

WHEN FIRST I SAW HER

SUNBATHING IN THE NAKED PADDOCK
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HER BREASTS LIKE

TWO THIRTY CENT ICE-CREAM CONES

FROM A DRIVE-THRU EATERY

BECKONING ME TO CLOAK HER WITH MY RIGHTEOUS SOUL

TO PROTECT HER FROM A RUDE MOUTHED SUN

TRYING TO MELT HER BREASTS

THEN I AWOKE

WITH MY DOG LICKING MY FACE

AND WHINNING TO GO OUTSIDE.

IS THIS THE LEGACY OF JUNG OR FREUD?

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THERE ARE ONLY

ONE-HUNDRED THOUSAND AND SEVENTY SIX

POEMS LEFT IN THE MIND OF THE EARTH

TO BE WRITTEN

ON THE FEW REMAINING TREES

AND I WILL SIXTY-NINE PERCENT OF THEM.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

WHILE INTERPRETING JUNG

http://neuage.indiko.com/collection2.htm (54 of 56) [3/8/08 2:54:33 PM]



Terrell Neuage poetry collection2

WRITING DOWN WHAT HE WAS (REALLY) TRYING TO SAY

I DRIFTED INTO SLEEP

INTO A DREAM

I WAS A FLY ON THE DOOR OF PERCEPTION

JUNG WAS MY SHADOW

FREUD SPRAYED THE SHADOW WITH FLY SPRAY

JUNG FELL DOWN DEAD

I FELT NOTHING

FREUD DIED OF FLY SPRAY POISONING

SO MUCH FOR MEANING.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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Other poems: COLLECTION ONE ~ COLLECTION TWO ~ COLLECTION THREE

Begin World Wide Web poetry journey here
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Other poems: COLLECTION ONE ~ COLLECTION TWO ~ COLLECTION THREE

Begin World Wide Web poetry journey here

 

COLLECTION3

SOMETIME A.M. 

AMTRAK STATION

THINK IT COULD RHYME WITH ELATION

PEOPLE IN LINE

COFFEE DINE

WAITIN' ON THE HOLY WATER SILVER EAGLE EXPRESS

WHILE A SA COPYRIGHT TERRELL NEUAGELAMI FACTORY GURU SA COPYRIGHT 
TERRELL NEUAGEYS LIFE'S A MESS

I DON'T KNOW

GOTTA GO

WHO IS THERE TO STAY

WHEN THE WORLD GOES AWAY

AND A VOICE IN THE RUMBLED WATERS OF TIME

SA COPYRIGHT TERRELL NEUAGEYS I WILL, I WILL, CAN YA SPARE A DIME
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AND THE SELF WITHIN DOTH SA COPYRIGHT TERRELL NEUAGEY

FAR OUT

FAR OUT

AND EVERYONE LEANS TO ONE SIDE

LIKE A TRAIN ON A CURVE

KNOWING

IT'S TIME TO SERVE THE COSMIC HERB

ETC.

 

11-12-75 ALBANY NEW YORK COPYRIGHT TERRELL NEUAGE

SOMETHING TO REACH FOR

LIKE DAWN

LICKING THE HORIZON

RAIN

KISSING CLOUDS

AND LOVE

IMAGINED

BEFORE DOUBT

SOMETHING TO REACH FOR

NEVER HAVING.
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12-22-93 copyright Terrell Neuage

SOMEWHAT LIKE A NEW SPACE

LONG BEFORE DAWN

PERHAPS A FAIRIES' CIRCLE

THE ASCENT OF TOMORROW RAISED

IN SYMBOLISM FOR NO ONE TO UNDERSTAND

AND LITTLE DOES THE MOMENT KNOW

OR EVER COMPREHEND

EVERY NEW SPACE

ALIVE IN MAGIC.

 

 

 

2-80 BALTIMORE COPYRIGHT TERRELL NEUAGE

SOMEWHERE IN YOUR HEART
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I HAVE A HOME

OR A MOTEL ROOM

OR A PLACE

TO PITCH A TENT

I DON'T KNOW WHICH

BUT THERE IS A SPACE THERE

IN YOUR HEART

THAT I FIND MYSELF

GOING TO

TO WATCH THE SUN RISE

EVERY ONCE IN AWHILE.

 

 

3-18-80 NEW YORK COPYRIGHT TERRELL NEUAGE CITY

SOMEWHERE WE ALL COME TOGETHER

AS ONE 

WHERE THE UNIVERSES

THAT WE FOUND

CREATED

LOST
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ATE

ARE PUT TOGETHER

NOT ONE

FOR TOMORROW

TO DANCE

THROUGH 

WITH US 

AS HER 

TRAIL.

 

 

 

 

 

@ 3-22-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

SO OFTEN IT SEEMS

THAT I GET WHAT

OTHERS DON'T WANT

LIKE A SHADOW'S ECHO

ON A BROKEN MIRROR
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MY WANTS AND NEEDS

DISA COPYRIGHT TERRELL NEUAGEPPEAR

INTO OTHER'S POCKETS

LEAVING ME

NAKED AND WANTING.

 

 

 

8-10-89 PORT ELLIOT COPYRIGHT TERRELL NEUAGE

SO SURE

THAT THIS WAS THE RIGHT DIRECTION

EVERYTHING ALWAYS

LED TO THIS SPOT

UNTIL WE DISCOVERED

WE WEREN'T HERE

NEITHER THE SPOT

WAS.
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@ 12-26-93 copyright Terrell Neuage

SPOKEN FIRES

OF YOUR DISTANT THOUGHTS

BLAZE FREELY

THROUGH MY HEART

THAT WAS

CHRISTENED SO LONG AGO

BY YOUR CHAMPAGNED TOUCH.

(picture poem order No. 151)

* # 6-08-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

SPRING RING

FUN IN MIND

NO ONE NEAR

BUT REMAINS IN THE WIND

SO I PLACED A BAG

ON A POLE

TO HAVE THE WIND
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FILL IT 

WITH

ONCE UPON A TIMES OF YOU.

 

 

9-24-85 MT. COMPASS COPYRIGHT TERRELL NEUAGE

 

SPRING

SPRUNG THE THAW

OFF OF FROZEN TUNNELS

AND IMAGINED

ICE CASTLES

WE WRAPPED OURSELVES IN DREAMS

TO KEEP OUT THE COLD

THE FROST SEEMED NEVER TO GO AWAY

BUT THEN THE SUN RETURNED AND WE FLEW OFF

TO TOUCH IT

WE WERE TWO CELESTIAL OBJECTS

LEAVING THE GALAXY WITHOUT REASON.
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5-06-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 

YOUR TOUCH 

MAKES ME FEEL

LIKE

A CHRISTMAS TREE

WAITING TO BE 

DECORATED.

 

 

 

 

 

(picture poem order No.201 )

* # 12-04-93 copyright Terrell Neuage VICTOR 

STRANGER IN TOWN

WON'T YOU BE MY CLOWN

TURN UP YOUR SMILE

I'LL LOVE YOU AWHILE
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PLAY WITH MY WISHES

MY DREAMS AREN'T MISSES

WHEN THE CIRCUS LEAVES TOWN

I'LL NO LONGER BE YOUR CLOWN.

 

 

6-12-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

SUCCESS IS ALWAYS COMING

TOWARD ME

I AM ALWAYS HEADED TOWARD HER

I WAIT FOR THE COLLISION THE OSMOSIS

TO OSCULATE SUCCESS

THE PUSILLANIMOUS KISS OF CHANGE

TO SEE 

TO TASTE

HOLD

I LET GO TWO OFTENS

TOO OFTEN

I LET GO YOU
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I LET GO ME

I LET GO SUCCESS PASSING

LIKE A FADING PIRATE

IN THE OFTEN FOUND REALMS

OF WAITING

THAT I FOREVER FIND MYSELF.

 

 

 

 

10-04-89 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

I WAS GOING TO GIVE MYSELF

TO A SETTING SUN

BUT IT TURNED AWAY

RAN OFF WITH A LONELY MOON

IN PISCES

 

TONIGHT ALONE.
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1-13-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

SUCH A PLACE IN TIME HERE

I THINK I WILL KICK OFF MY SHOES

AND SETTLE INTO THE MOMENT

WATCHING THE FUTURE

DISSIPATE MY PAST LIKE SUGAR CUBES IN HOT BLACK STRONG IMPORTED 
COFFEE

AND I STIR AND DRINK

MY FANTASIES AWAY

I ALWAYS DID HAVE A SWEET TOOTH

THERE WAS ONCE A CRACK IN LOGIC

ALL THE MATHEMATICIANS HID A NUMBER

THINKING THAT THEY HELD THE FINAL PIECE

TO SOME COSMIC PUZZLE

BUT I CAME ALONG

PUZZLED AS IT WERE 

AND KICKED OFF MY SHOES

ONLY TO SEAL LOGIC ALL TOGETHER

WITH MY VISIONS

THAT NEVER WERE ANYTHING MORE
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THAN A SETTLEMENT 

IN TIME.

 

2-80 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

 

I STIR AND DRINK 

MY FANTASIES OF YOU 

IN MY FIRST CUP OF COFFEE

EARLY MORNING SWALLOW

SO INSIDE OF ME

YOU

ALL DAY LONG

WILL STAY

AWAKE

TOO.

 

 

(picture poem order No. 701)

* # 1-12-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE
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TOOK A CHANCE

NOW HERE

EVERYTHING ELSE

NOT YET

EXPLAINED.

 

 

 

 

(picture poem order No. 702)

** @ # 1-13-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

 

ADDED STRENGTH

SKY HIGH

SO DEEP

EXPANDING FOREVER

FORWARD

WITHIN

YOU AND I
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THIS DREAM

SHARED.

 

 

(picture poem order No. 703)

* # 1-07-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

DOORS OPENING

IN THE NIGHT

NO DAYLIGHT

ON THE OTHER 

SIDE

JUST YOU

ARTIFICIAL LIGHT

IN MY NIGHT.

 

 

1-07-96 COPYRIGHT TERRELL NEUAGE

WITHOUT CHANGING

I BECAME
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EVERYTHING

YOU THOUGHT

I WOULD BE

NOW I DON'T REMEMBER

WHO I WAS

HOW.

 

 

(picture poem order No. 704)

* # 1-12-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

SUCH A WOMAN

YOU HAVE CHANGED MY LIFE SO

AND I SEE THE IMPOSSIBILITIES

AHEAD

BUT I WILL ALWAYS KNOW

THAT I HAVE MET

THE LADY

OF MY CHOICE

IF CHOICES
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WERE MINE

TO 

HAVE.

 

 

 

4-09-80 BALTIMORE COPYRIGHT TERRELL NEUAGE

SUN DOESN'T RISE

MOON DOESN'T RISE

ANYMORE

BUT WE DO

EACH TIME

WE WATCH

WHERE WE ARE GOING

SOMEWHERE BEYOND

DESTINY'S FAVORITE JOKE.

 

 

4-16-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR
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SUPERSTARS

ARE REFLECTIONS

OF OTHER'S FANTASIES

CAN I BE

YOURS?

 

(picture poem order No. 31)

* # 2-11-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

SURELY THIS LIFE TIME

I WAS MEANT TO BE A MOUNTAIN CLIMBER

FOR I AM ALWAYS SETTING UP

ANOTHER NEW CAMP

IN CITY WILDERNESS

AND THE CLIMB SEEMS

ALWAYS

SO VERY STEEP.
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2-10-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

SURPRISE

WE KEEP GOING FORWARD

TOMORROW WILL CHANGE

BUT WE WON'T

IN

FLIGHTY FUCKING FREEDOM'S

FINAL

FLIGHT

FOREVER FREE

AGAIN 

TONIGHT.

 

 

7-25-92 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

SURRENDER IS NOTHING AT ALL

BUT A DESIRE

TO BE CONQUERED

BECAUSE OF A FEAR

TO

TAKE HOLD OF
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THE MOMENT.

 

 

10-28-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

SWALLOWED DESIRE

INDIGESTION

EXPLAINED.

 

 

 

(picture poem order No. 203)

** 1-16-94 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR

SWAYING NATURE

LOOSENED SEASONS

LOVE'S SCENTS

SEASON ME.
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(picture poem order No. 204)

** @ 1-12-94 copyright Terrell Neuage 

TAKE ME

LIKE THE SEA

A SUN

WITH DUSK

IN SEARCH FOR

THE MOISTENED LIPS

OF STRANGERS

OH MUSIC AIR

AS NOW

OF YOU.

 

 

 

(picture poem order No. 205)

* 11-25-89 PT. ELLIOT COPYRIGHT TERRELL NEUAGE

'THAT'S ALL'
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THE SCRIPT READ

I BURNED THE SCRIPT

TONIGHT ON FIRE

WITH YOU.

 

 

(picture poem order No. 206)

** # 1-12-94 copyright Terrell Neuage VICTOR HARBOR

THE ACCUMULATED KNOWLEDGE

OF ALL WHO WENT BEFORE US

MAKES US

THE GREATEST PEOPLE

OF ALL TIME.

 

 

(picture poem order No. 207)

* @ 3-16-93 VICTOR HARBOR SA COPYRIGHT TERRELL NEUAGE

THE BEST 
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I HAVE 

TO OFFER YOU

IS YOURSELF

SHADOWS ON PARADE

REFLECTING

THE BEST

OF YOU

IN ME.

 

(picture poem order No. 152)

* # 2-77 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 

THE CANDLE WAS LIT

NO ONE SA COPYRIGHT TERRELL NEUAGEW

THEY CHASED MY NEON LIT SHADOWS

I CRIED TO YOU

IN IMAGES OF FIRE

BUT YOU WERE DRUNKENLY SWAYING

TO A TUNE

IN ICE AND SNOW

YOU PUT ME OUT
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EACH ROAD WAS DARKER

THAN THE ONE BEFORE

I TRAVELLED ALONE

EVERYWHERE MONSTERS

WHO KNEW MY NAME

I DIED IN LAUGHING ASHES

FLUNG OVER A DISEASED SEA

NO ONE REMEMBERS

I WAS ONLY ACTING OUT

MY FANTASY

OF THEM.

 

 

5-16-79 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

THE BEST PART

OF OUR ALL CONSUMING LOVE

IS THAT 

IT WILL

NEVER END
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BECAUSE IT NEVER BEGAN.

 

 

 

11-13-91 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

THE CLOWN OF LAUGHTER 

IS SORROW.

 

 

(picture poem order No. 32 )

** @ 8-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

 

THE CONFESSION

OF MY OBSESSION

IS A SESSION WITH YOU.

 

 

 

(picture poem order No. 208)
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** # 3-89 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA 

 

 

THE DAWN SO YOUNG

YOU SO FREE

YET THE WORLD WAS OUT OF FOCUS

ALL THE COLOURS ON THE PERIPHERY OF OUR TOUCH

BLENDED INTO HUES NO ARTIST EVER HAS KNOWN

WE WATCHED DAWN LEAVE

DAY BECOME HOT

SUNSHINE BURN AWAY

HUES OF LOVE

AND THE MAGIC THAT SWEPT US AWAY 

IN EXPLORATION OF A DAWN

WE ONCE KNEW

BUT WERE NEVER ABLE TO PAINT AGAIN.

 

 

3-79 BALTIMORE COPYRIGHT TERRELL NEUAGE
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THE DAY AFTER

THE NIGHT BEFORE

LEFT ME

WANTING TO WAKE WITH YOU

ONCE AGAIN

IN THE DAY AFTER

THE NIGHT BEFORE.

 

 

12-26-93 copyright Terrell Neuage

THE DAYS HERE LAUGH AND PLAY

AND WITH COSMIC SPIRITS I LAY

WE PLAY HOUSE WITH THE STARS

AND TOMORROW I'LL VISIT MARS

THE CHRISTOS IS A FRIEND INDEED

WE'RE HIS NECKLACE CELESTIAL BEADS.
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5-74 20 STEINER STREET SA COPYRIGHT FRANCISCO COPYRIGHT TERRELL 
NEUAGE

 

THE DAY WAS GOING BY

SO FAST

I TOOK A PHOTO

TO FREEZE

TIME IN PLACE

FROZEN TIME ON A STICK

SO FOREVER I WOULD HAVE

THIS MOMENT'S

FLEETING FEELING'S IMAGES

IN FRONT OF

WHERESOEVER

IT IS

I WAS

GOING TOWARD.
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9-30-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

 

THE LAST BRIDGE I CROSSED

THE LAST DOOR I CLOSED

THE LAST FORK

IN THE LAST ROAD

LED ME TO YOU

AT THE LAST MOMENT.

 

THANKS.

 

 

 

(picture poem order No. 209)

* # 3-22-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

THE LAST THOUGHTS

I WILL EVER HAVE OF YOU

WILL BE OF
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MY FIRST TASTE

OF YOU

FREE BURNING DESIRE

WITH NO IMAGES

BEYOND

THE CONSUMMATION

OF OUR

SYNCHRONIZED

TOUCH.

 

 

 

(picture poem order No. 210)

* # 9-23-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

THE LAST TIE

LEFT TO REMAIN

MEMORY

SA COPYRIGHT TERRELL NEUAGECRIFICED 

NOW

FUN FOR ALL.
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(picture poem order No.211)

* @ 1-12-94 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR SA COPYRIGHT TERRELL NEUAGE

THE ONLY DIFFERENCE

BETWEEN YOU AND ME

AND US AND THEM

IS WHETHER

WE ARE

YOU OR ME

OR US

OR THEM 

 

 

12-28-79 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

 

THE ONLY LOVE LOST
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THAT'S EVER FOUND

IS THE SEASON

MAY I SEASON YOU?

 

 

 

 

 

 

 

 

 

 

(picture poem order No. 33 )

** # 2-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

 

THE ONLY THING

A STOP LIGHT

EVER SHOWED ME

WAS THAT WE CAN'T ALL GO

THE OPPOSITE DIRECTION
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AT THE SA COPYRIGHT TERRELL NEUAGEME TIME.

 

 

 

 

 

 

@ 12-16-72 MOKENA ILLINOIS

THE REASON

WE DON'T HAVE WINGS

IS BECAUSE WE DON'T HAVE TO FLY NORTH

FOR THE WINTER

BUT CAN STAY ALL WINTER WARM

WRAPPED IN EACH OTHER'S WARMTH.

 

 

 

 

 

(picture poem order No. 212)
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* # 5-01-93 copyright Terrell Neuage VICTOR 

 

 

THERE IS NO ONE

TO BE FOR

EXCEPT

FOR

WHO AM I?

IN LAUGHING TIMES

OF LONG AGO

AGAIN 

TODAY

SHALL 

I 

BE.
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@ 9-13-72 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

THERE IS NO TIME

TO STOP AND PICK

FLOWERS

ALONG A FOREST TRAIL

WHEN THEY GROW

BUT FOR A SEASON.

 

 

@ 6-27-72 COLORADO

RITA

THERE WAS A TIME

WHEN TIME WASN'T THERE

WHEN WE WERE FREE

TO GROW INTO DREAMS

WHEN WE WERE FREE

JUST TO DREAM

SA COPYRIGHT TERRELL NEUAGEDNESS WAS NOT KNOWN THEN

ALONG WAS NOT KNOWN

AND JESUS WAS JUST ANOTHER NAME THEN

WE WERE GIVEN THE FIRST TASTE OF LOVE THEN
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THE FIRST TASTE OF HOPE

THE FIRST TASTE OF FEAR

THE FIRST TASTE OF AGE

THE WORLD WAS YOUNG THEN

THE TRAIN TRACKS LED TO STARS

THE STARS LED TO LOVE

LOVE LED TO SEPARATENESS

I SA COPYRIGHT TERRELL NEUAGEW AN ANGEL A MOMENT AGO

WHO SPOKE OF PEACE

AND I SPOKE OF BEING ALONE

AND THE ANGEL SHOWED ME

THE PEACE OF BEING ALONE.

1966 & 1972 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

THERE WAS A TIME IN YOUTH MAYBE IT WAS

WHEN CITY SOUNDS OF FACTORY BELLS

TAXI HORNS

POLICEMAN WHISTLES

AND BOOTS AGAINST PAYMENT

WERE ONLY STORY BOOK SOUNDS THAT NO ONE REALLY LIVED IN

BUT WERE JUST CREATED AS AN AMUSEMENT PARK
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FOR WE OF THE FARM TO PLAY IN

AND TO TURN PAGES

OUT OF A GIGANTIC BOOK

TO SEE PEOPLE DRESSED IN COLOUR

CROSSING STREETS TOGETHER

WHILE A THOUSA COPYRIGHT TERRELL NEUAGEND CARS STOPPED TO WATCH

ALL LINED UP BEHIND BLINKING RED LIGHTS

FLAMING FARES

STAINED GLASS CHURCH WINDOWS AND SLEEPY BEACON LIGHTS

LAZILY SHOWING WHITE PATCHES OF SKY

FROM A TOP OF HUGE ERECTOR SET BUILDINGS

THEN THE WORLD SA COPYRIGHT TERRELL NEUAGEID GO

RED TO ORANGE TO GREEN

AND CARS WERE NO MORE IN LINE

THERE WAS JUST THE SMELL OF CLOVER

AND A FAR OFF RING OF BELLS

FROM A RAMBLING OLD FARM HOUSE

AND THE BOOK CLOSED TURNING OFF PAGES

THAT WERE TOMORROW MAYBE

BUT FOR NOW 
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WE HAD ONLY A LONG FIELD TO CROSS 

TO GO BACK TO WHERE WE BELONGED.

1-16-71 HONOLULU

 

THERE WERE SO MANY ROADS

IN FRONT OF ME

THAT I DIDN'T KNOW WHICH HONE TO TAKE

AND I DIDN'T KNOW THAT THEY ALL

LED TO THE SA COPYRIGHT TERRELL NEUAGEME PLACE

AND I DIDN'T KNOW THAT THAT SA COPYRIGHT TERRELL NEUAGEME PLACE

WAS INSIDE OF ME

WITH A MILLION PATHS

LEADING OUT

WITH A MILLION PATHS

LEADING BACK.

 

 

 

2-28-73 NEW YORK COPYRIGHT TERRELL NEUAGE CITY

THERE WILL ALWAYS BE

SOMEONE WHO CAN
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WRITE A BETTER SONG

THAN I 

WHO CAN OFFER YOU MORE

THAN I

THAT WILL BE SMARTER

BETTER LOOKING

YOUNGER

AND A BETTER TALKER

THAN I 

BUT NO ONE ELSE

CAN GIVE YOU

A BETTER ME

THAN I.

 

 

 

 

(picture poem order No. 213)

* # 8-10-89 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT 
TERRELL NEUAGE
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THE SKY TURNED OFF

THE DAY I WAS BORN

THERE WERE NO FLOWERS IN BLOOM

LIFE WAS NAKED

I WAS IN FLAMES

FIRES EVERYWHERE

I'VE BEEN GONE

SINCE THE SKY TURNED OFF

THE DAY 

I WAS BORN.

 

 

2-28-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

I CRIED 

WHEN I DIED

KNOWING I NEVER COULD

WHEN I WAS ALIVE.
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1-13-96

THE WAY TO HEAVEN

IS LACED

WITH FANCY WOMEN

AND VINTAGE WINE

SO I'M ON MY WAY

HEAVEN IS A BASKET CASE

OF GOOD TIMES

LET LOOSE

AND I LAUGH

IN SUCH SPLENDOR

WOULDN'T YOU?

 

 

 

 

1-19-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE
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THE WINDOW 

THAT I ONCE REACHED THROUGH

TO TOUCH A DISTANT DREAM

HAS GROWN DUSTY

WAITING FOR ME

TO BRING MY DREAMS

THROUGH

TO THIS ROOM

THAT I SEEM

TO HAVE INHERITED

NOW THE DISTANCE BECOMES CLOUDY

IVY HIDES THE FOG

WINTER STALKS

A FINAL TURN

BEFORE LEAPING TOWARD

THE WINDOW

AND I PACK AWAY

MEMORIES

OF DREAMS

THAT WERE ANTIQUATED
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AT THEIR ORIGIN 

WHEN I 

FIRST CAME

TO THIS WINDOW.

 

11-79 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 

THERE WILL NEVER BE A CROWDED

MOMENT

WHEN COUNTRY

ROADS

BECOME PARTS

OF US.

 

 

(picture poem order No. 153)

** @ 8-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

THE SECRETS OF LIFE 

I CHASED THROUGH YOUR EYES

EVENING ROSE

YOUR TOUCH FILLED THE SKY

I WENT TO SLEEP WITH YOU IN MY MIND
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AND WOKE WITH YOU IN MY HEART

SOMETIMES LIFE IS SO UNREAL

WHEN I THINK OF LIFE

I THINK OF YOU MORE

TIME IS CUTE

LIKE A CHILD'S FLUTE

ITS MAGIC IS A SURPRISE

EVEN TO MORNING RISE

AND IT'S ALWAYS IN RHYME

THAT'S HOW I SEE TIME

NOW WHEN I THINK OF YOU

I THINK OF TIME

I THINK OF THE SECRETS OF LIFE

AND IF FIND MYSELF

GALLOPING

THROUGH YOUR EYES.

 

3-78 BALTIMORE COPYRIGHT TERRELL NEUAGE 

THE WELL FROM WHICH WE DRAW

RUNS LOW

http://neuage.indiko.com/collection3.htm (44 of 271) [3/8/08 2:55:09 PM]



collection3

ONLY

WHEN WE

DISCONTINUE

REACHING 

FROM IT.

 

 

(picture poem order No.34 )

** @ 5-09-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

THE WORLD IS IN A STIR

SHE IS IN A BLUR

FROM EATING TOO MANY DREAMS

MADE OF FLUFFY COTTON CANDY.

 

 

 

 

 

 

(picture poem order No. 35 )
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** @ 2-01-72 SA COPYRIGHT TERRELL NEUAGENDMA PUERTO RICO

THEY BAPTIZED ME TODAY

GAVE ME A NEW NAME

THEY BAPTIZED ME TODAY

WHAT I CAN'T SEE ISN'T THE SA COPYRIGHT TERRELL NEUAGEME

AND THE ROCKS ON THE BEACH

LIKE THE SA COPYRIGHT TERRELL NEUAGEND IN THE WIND

IS EVER CHANGING

BUT I DON'T SEE

BUT I DON'T SEE.

 

 

 

 

5-11-75 20 STEINER ST. SA COPYRIGHT TERRELL NEUAGEN FRANCISCO 
COPYRIGHT TERRELL NEUAGE

 

THEY SA COPYRIGHT TERRELL NEUAGEID I'M WASTED

BUT I ONLY DRINK UNTIL I FALL

THEY SA COPYRIGHT TERRELL NEUAGEID I'M NOT GOING TO MAKE IT

THROUGH MANY MORE DAYS
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AND I WAS TOLD THAT MANY YEARS AGO

WHEN I WAS FOUND SO OFTEN IN THE STREET

THEY SA COPYRIGHT TERRELL NEUAGEID I HAVE HAD

TOO MANY LOVERS

TOO MANY STONED DAYS

AND YOU KNOW

I'VE ALREADY MISSED

TEN-THOUSA COPYRIGHT TERRELL NEUAGEND LOVERS TO GET HIGH WITH

AGAIN TODAY.

 

5-05-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

THE WHISPERING MIST

REVEALED 

YOUR TOUCH

MADE ME REAL

SO NO LONGER

A SHADOW TOO

I'D BE.
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(picture poem order No. 214)

* # 7-28-93 copyright Terrell Neuage 110 VICTOR COPYRIGHT TERRELL 
NEUAGEIA STREET VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

THINK LIKE A TREE

WHO SITS AT THE MOUTH OF A RIVER

WHILE HER ROOTS DRINK

OF WISDOM

AND HER LEAVES

SA COPYRIGHT TERRELL NEUAGEIL WITH THE WIND

THINK LIKE A TREE

WHO WILL NEVER ENTER

A CITY FOREST.

 

 

 

(picture poem order No. 154)

* @ 5-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

THIS LOVE IS NO BARGAIN

THERE IS NO DISCOUNT FEELINGS

GARAGE SA COPYRIGHT TERRELL NEUAGELE HOPES
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SECOND HANDED EMOTIONS

OR WALKS OFF A SHORT PIER

BUT THE INVESTMENT

HAS EXCELLENT RETURNS

WITH COMPOUNDED INTEREST

OFTEN.

 

 

2-07-93 copyright Terrell Neuage EAST END MARKET ADELAIDE

JANET

THIS MORNING

LIKE AN INVITATION TO FLY

EVERYWHERE SEEMED TO BE THE PLACE TO BE

AND I WAS HERE

SO DIFFERENT

IT SHOULD FEEL

BUT THE COMFORTS

OF BEING WHERE I FEEL TO BE

IN THIS PASSING MOMENT

GAVE TO ME 
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THE ACCEPTANCE OF SUCH 

AN INVITATION

TO FLY.

 

2-11-80 DALLAS

THIS MORNING 

ON THE NEWS

THEY SA COPYRIGHT TERRELL NEUAGEID AN AMERICAN SPACECRAFT

HAD LEFT OUR SOLAR SYSTEM

HEADED FOR DEEP SPACE

LIKE I AM

LOST IN ORBIT

LOOKING HOW TO LAND

DEEP

IN ALIEN TERRITORY

YOU.

 

 

 

 

(picture poem order No. 215)
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* # 8-24-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

THOUGHT I WOULD NEVER STOP

NEVER REACH MY END

FIND WHAT I WAS LOOKING FOR

BE SA COPYRIGHT TERRELL NEUAGETISFIED

BEYOND BELIEF

SA COPYRIGHT TERRELL NEUAGEY THIS IS IT

AND NOW I SEE

I THOUGHT

RIGHT.
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3-04-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

TODAY ENDED

LIKE ANY RELATIONSHIP WOULD

LEAVING ME STANDING ALONE

UNDER A WARM AUTUMN NIGHT

WITH AN EMPTY BOTTLE OF WINE.

 

 

10-22-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

'PERFORMANCE'

TODAY I COULD DEFEAT THE WORLD

COULD I TRADE YOU

A DEFEATED WORLD

FOR A CAPTURED HEART

AND I SA COPYRIGHT TERRELL NEUAGEW THE PEOPLE 
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MERGE TOGETHER TODAY

IT WAS NOT A CLEAR VISION

THERE WAS ONLY A BLUR

SHAPED AS THE FUTURE

LIKE LINES NEVER MET

YOU WERE A BLURRED SHADOW

WITH NO AUDIENCE

BOWING.

 

8-79 BALTIMORE COPYRIGHT TERRELL NEUAGE

TODAY I LOOKED INTO MY FEELINGS

AND THEY SOARED WITH EVERYTHING

THAT CAME TRUE

AND TO GO ON FROM HERE

IS ONLY A PARACHUTE

RIDE BACK

BUT AT LEAST

THE PARACHUTE IS COLOURFUL.
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(picture poem order No. 155)

* @ 7-08-78 LUTHERVILLE

THE ONLY DIFFERENCE

BETWEEN CAVE MAN

AND MODERN MAN

IS TODAY'S WOMAN.

 

 

 

 

(picture poem order No. 216)

** # 3-16-93 copyright Terrell Neuage 110 VICTOR COPYRIGHT TERRELL 
NEUAGEIA STREET VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA 
COPYRIGHT TERRELL NEUAGE

TODAY'S VIEW

HELD BY FEW

EAT CARROTS

WITH MERIT

SMELLS RAIN

IN PAIN
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SWALLOWS TIME

WITHOUT RHYME

SITS ON THE FENCE

AND MAKES NO SENSE

YIN YANG

THEY SA COPYRIGHT TERRELL NEUAGENG

WHO CARES

IT'S FAIR

BY FAR

THE STAR

YOU SEE

IS

ME.

 

 

 

2-22-90 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

SO EASY TO PREDICT

THE FUTURE

'YOU
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WAKING NEXT TO ME

FAR FROM EARTH

AGAIN TOMORROW

MORNING'.

 

 

 

 

(picture poem order No. 705)

* # 1-13-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

TOO MANY SMILES

TO CHOOSE FROM

TONIGHT ALONE.

 

(picture poem order No. 36 )

* # 4-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

TOO MANY WORDS

ARE

LIKE

A

FORM
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THAT

HAS

NO

PURPOSE.

 

 

(picture poem order No. 156)

* @ 5-01-74 KANSA COPYRIGHT TERRELL NEUAGES

TOUCH ME

I NEED TO COME

AMONGST THE STARS

NEED ME

I FEEL YOU TREMBLE

BENEATH MY BODY

WANT ME

FOR I HAVE NEVER WANTED

ANYONE ELSE

IN SUCH

IGNITED PASSIONS

THAT EVEN THE STARS
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TURN AWAY

BLUSHING 

IN OUR FINE

DESIRE'S AURA.

 

8-12-78

TRUE UNION

IS THE REFLECTION

OF CREATION

SMILING 

AT

ITS MIRRORED IMAGE

IN MORNING MIST.

 

(picture poem order No. 157)

* @ 1-02-80 HONOLULU

WAITED UNTIL THE END

LOVED WINNING

WHEN THERE WERE 

NOTHINGS
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TO WIN

CHALLENGED EVERY BATTLE

WHILE ALONE

LOVED MYSELF

WHEN ON ONE ELSE WOULD

WAITED UNTIL

THE END

AND NEVER WON

NEVER LOVED

KNOWING NEVER NEVER

NEVER 

HAPPENS 

AGAIN.

12-5-89 PT. ELLIOT

Want to be what I want to be

but day revealed me to me

the way we are now for this moment

nothing was missed

tomorrow is marching in

without fanfare

without notice
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Waikiki isn't there yet

It's not even a past dream

just a mirage before creation.

Sidewalks lead to roads

and they go to doors

that are filled with everyone going out

Downtown stores and windows

weren't made for christmas

did baby Jesus have a big belly

a white beard and go ho ho ho

Could these bells and sleighs be for something else

for celebration of the first winter in New York copyright Terrell Neuage City for a 
white person?

But this day brought no snow

just rain for palm trees to grow

and a sleigh being led by fiber-stuffed reindeer to go rusty in

Knowing Waikiki is dressed to dance

I throw out a laugh to the next man I see

with a white beard big belly ho ho ho

and he seeing my ho ho ho is phonier than his
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screams over the ringing of the bell

'I never knew you wanted to be serious

always thought haoles dug this sort of joke'

So going back to the playland in the attic of Sears and Robuck

I build a fort out a thouSA copyright Terrell Neuagend little blocks

each with a letter on its side

to stop the ho ho hos

from stomping on my day

Then taking out my 'T'was the night before Christmas colouring book"

I begin colouring out my programme

to become what I want to become.

11-28-70 Honolulu

 

 

 

 

 

WAS IT THE WIND 

OR THOUGHTS OF YOU

THAT INTOXICATED ME

BEYOND REASON?
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(picture poem order No. 217)

** # 3-29-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

WATCHING CITIES 

OFF TO SLEEP

NOTHING TO KEEP

LISTENING TO CLOUDS

FULL OF SONGS

IN THE WELL DRESSED NIGHT

GOING FLY FREE

FROM HERE

AMID 

CHEERLESS EMPTY CROWDS.
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@ 7-78 BALTIMORE COPYRIGHT TERRELL NEUAGE 

WATCH THEM

MAYBE WE SHOULD

THEY'RE LIKE SOLDIERS MADE OF WOOD

MARCHING LIKE THUNDER

ON TO THEIR NEIGHBOR'S PLUNDER

THEN ON TO EVERYDAY WORK ROUTINE

BELIEVING THAT THERE IS NO PLACE ELSE TO LEARN

OPEN THE DOOR WEAVE A SMILE

MORNING IS FOR ONLY AWHILE

TAKE OFF THEIR HAT UNSTRANGLE THEIR TIE

DON'T YOU SEE THAT EVERYONE IS COMING TO BE BY

AND IN THE RELIGIOUS ORDERS THE MASTERS TELEVISE THE WAY

WHILE IN THE WORLD THERE IS NO PLACE TO GO ASTRAY

DON'T COME TO SA COPYRIGHT TERRELL NEUAGEY WELL THAT WAS GOOD

JUST TO OFFER YOUR KARMA TO A SPIRITUAL HOOD

SO THANK YOU THIS MOMENT WAS VERY NICE

FOR IT IS THE WEAK WHO EAT ONLY RICE.
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3-20-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

WE AREN'T FLOWERS

WE AIN'T STARS

KITTENS LIONS BEARS

YOU ARE NOT MY DIXIE PEACH

I YOU NORTHERN PUMPKIN

WE'RE NOT OUR SIGNS

POLITICAL CANDIDATES

RELIGIOUS FANATICS 

JUGHEAD JUNGIAN JUGULARS

FOR THIS ANTI THAT

NOR ISMS, ISOS, OR ISTS

REFORMED DEFORMED INFORMED PERFORMED

BLUE COLLAR INTELLECTUALS SPYS

NEITHER AGAINST NOR FOR OR IN BETWEEN

WE ARE BUY HUMPS

PLAIN AND SIMPLE

AND THAT IS ALL 

YOU WILL EVER GET
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WHEN YOU

GET THE ALL OF ME.

3-01-90 MIDDLETON

WE ARE THE PRODUCT

OF EVERYONE ELSE'S IMAGES OF US

UNTIL WE IMAGINE

EVERYONE ELSE

AS SEEING US DIFFERENTLY

THAN WE WILL

BE THE NEW PRODUCT

OF OUR CHANGED IMAGINATION

FILTERED THROUGH

EVERYONE ELSE.

3-28-90 MIDDLETON

OTHER LIFE TIMES BELIEVED WE IN 

TO ACCOUNT FOR OUR LOVE

A LOVE SEWN TOGETHER

OVER MANY TIMES IN MANY EMBRACES MANY LANDS

WE PLAYED KING AND QUEEN

VIKINGS
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PLUNDERING EACH OTHER'S DESIRES

SA COPYRIGHT TERRELL NEUAGEINTS BLESSING EACH OTHER'S DESIRE

CAVE DWELLERS LEARNING TO LOVE IN FIRE

WE HAD DISCOVERED ONE SHORT WINTRY EVENING

I WAS YOU YOU ME

TOGETHER

ALWAYS

FOREVER IN THE PAST 

FUTURE

ALL SOUNDED GOOD FEELING EVEN BETTER

AS WE DRAINED ONE ANOTHER'S LOVE

LIPS TOUCHING THROUGH AEONS OF DREAMS

NOW MANY YEARS PAST

I BARELY REMEMBER OUR TOUCH

YOUR'S IS GONE

SO LONG AGO

A SECOND IN ETERNITY

BUT A LONG ONE TO ME

LIFE IS HARD LONG LONG GONE 

HOPES WISHES DASHES OFF TO OFTEN
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SO

ALONG WITH BELIEFS LIFE EXISTS

MORE THAN FLEETING ONES HERE PRESENT

NO LONGER SOME DISTANT KING

HAPPY KNIGHT

AT YOUR SIDE

NO LONGER

BELIEVING

WHAT I BELIEVE.

8-03-89 PT. ELLIOT

I PICKED YOU IN YOUR YOUTH

PLUCKED LOVED

PRESSED NEATLY

BENEATH MY THOUGHTS

FOREVER PRESERVED.
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9-22-89 PT. ELLIOT

WE BROKE 

FROM THE CIRCLE

TO LEARN OF LIFE

SO WE COULD RETURN

TO THE CIRCLE

LEARNED

WE GOT LOST

SLIPPED ON DESTINY

ROLLED DOWN MOUNTAINS

TRIPPED

FELL
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FUMBLED

BUNGLED

GALUMPHED

THE CIRCLE ROLLED OVER US

LEAVING

AS DUST

IN DESTINY'S BIN

US.

 

 

 

3-09-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

WE CAMPED IN CHILDHOOD

WELL AWAY FROM WHO WE'D BE

WHEN WORLDS

WOULD WANT MORE THAN

WHAT WE WERE

WHEN WOODED WISHES 

WERE SO REAL.
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7-17-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

WE CAN ONLY BE

AT 

WHERE WE ARE GOING

AFTER WE ARRIVE

THERE

AND LOOK BACK AT

WHERE WE WERE

BEFORE WE LEFT

TO GO TO

WHERE WE ARE

NOW

ONCE.

 

 

 

2-15-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

I HEARD THE CHEERS

APPLAUSE OF DESTINY
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LEADING ONE ANOTHER

THROUGH THE PROMISE LAND

SETTLING IN

YOUR UNIVERSE

FINALLY.

 

 

 

 

(picture poem order No. 158)

* # 3-25-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

I LIKE WHEN WE ARE 

GODS

SWALLOWING

EACH OTHER'S UNIVERSE.

 

 

 

(picture poem order No. 706)

* # 1-12-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE
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WE ESCAPED

FREEDOM'S

FINAL COLD SHADOW

SO FOREVER

WE WOULD MAKE

MORNING'S MOIST WARMTH

OURS

TO LOVE IN.

 

 

(picture poem order No. 218)

* # 9-04-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

 

WE FELL IN LOVE WITH OURSELVES

IN EACH OTHER

WE SMILED AT OURSELVES

IN ONE ANOTHER'S EYE

THOUGH HOW WE'D LOOK

IN ONE ANOTHER'S CLOTHING
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FELT THE EMBRACE

OF OURSELVES

WHEN WE HUGGED ONE ANOTHER

AND MADE LOVE TO OURSELVES

USING ONE ANOTHER'S BODY 

WE FELL IN LOVE

WITH OUR REFLECTIONS

AND RODE INTO THE NIGHT 

AS TWINS.

 

2-26-90 MIDDLETON

 

 

WE FLEW ACROSS DAWN

RACING NIGHT AWAY

HEADING FOR ABOVE AND FAR AWAY

FROM EVENING'S LONG SPENT TOUCH

MORNING OPENED UP

WE ENTERED 

THE SKY CLOSED BEHIND US
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SEALING US IN THUNDER FROM TOMORROW'S STORM

LEAVING US FREE IN WELL ABOVE

AND FAR AWAY

WHERE TIME HAS NO RECALL

BUT NOW I REMEMBER

BACK HERE AGAIN

WHERE I SEARCH DAWN

WATCHING FOR MORNING'S OPENING

TO PROVIDE SA COPYRIGHT TERRELL NEUAGEFE PASSA COPYRIGHT TERRELL 
NEUAGEGE

FROM LIFE'S LONG SPENT TOUCH.

7-07-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

WE FOLLOWED DIFFERENT STARS

THAT IS THE WAY WE ARE

AND THOUGH WE SHARED AWHILE

LOVE'S SO FREE YET ALWAYS ON TRIAL

WE'VE COME TO THIS POINT

WHERE WE CAN NO LONGER SHARE

ANYTHING MORE

BUT OPENED DOORS

TO OUR SEPARATE WAYS
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BEYOND OUR OWN SA COPYRIGHT TERRELL NEUAGEY

AND I LOVED YOU SO

WE COULD ONLY GROW

AND SO NOW IS THE FALL

OF EVERY SEASON'S LAW

WHERE THE PAST MUST DIE

AND WE CAN ONLY TRY

TO REALIZED

THE VERY SIZE

OF FUTURES APART.

9-28-78 BROADWAY ROAD LUTHERVILLE MARYLAND COPYRIGHT TERRELL 
NEUAGE

WE GO OFF AND PARADE

IN CHANGES WE'VE MADE

WONDERING IF OUR WHIRL

WILL IMPRESS THE WORLD

LOOKING HIGH SEEING LOW

SOCIETY IS ONE LARGE PATROL

AND THE PEOPLE WHO ARE A MESS

ARE THE ONLY ONES LEFT TO IMPRESS.
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8-01-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

LYNN

WE HAD FUN

WE HAD HOPE

WE WERE ON THE WAY

OUR LIVES WERE TO BE SO FULL

BUT IT NEVER HAPPENED

YEAR AFTER YEAR OF HOPE GIVES NO FULFILLMENT

WHEN THE BIG BREAK IN LIFE BREAKS BEFORE IT HAPPENS

WHEN THE ULTIMATE LOVER IS JUST ILLUSION AFTER ILLUSION

GHOSTLY FADED VAPORS DRIFTING IN SPACE

WHEN WE BECOME MIDDLE-AGED WITH TEENAGE FANTASIES

WHAT IS LEFT

YOU TOOK YOUR LIFE

I UNDERSTAND WHY

BUT THANK YOU LEFT WITH IT ALL

GOD BLESS YOU BEAUTIFUL LADY

AS FOR ME I WON'T FOLLOW YOU YET
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BUT I CAN'T LIVE IN HOPE JUST MEMORIES

WE DID HAVE A GOOD TIME LONG AGO

DIDN'T WE?

1-26-86 MEADOWS 

WE HAD SO MANY BACKUP PLANS

THAT WE CRASHED

BACKING UP

NEVER SEEING

WHERE WE WERE GOING.

 

 

12-27-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR SA COPYRIGHT TERRELL NEUAGE

PARENTS

WE HAVE 

ABSORBED MANY

DIFFERENT MOMENTS

WITHIN THE TIME

WE HAVE SHARED

WITHOUT EACH OTHER

AND HERE WE ARE

http://neuage.indiko.com/collection3.htm (77 of 271) [3/8/08 2:55:09 PM]



collection3

BACK TOGETHER

AGAIN

LIKE WE NEVER 

WERE APART.

 

 

10-79 CLIFTON PARK NEW YORK COPYRIGHT TERRELL NEUAGE 

 

WE HAVE PASSED THROUGH SO MANY WINDOWS

AND LIKE VIEWS ON PARADE

WE LISTEN FOR

AN APPLAUSE

FROM A WORLD THAT TOO OFTEN FORGETS.

 

 

 

 

 

1979 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

SO MUCH TO TOUCH
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TRAINS

OVER TRESTLES

RAVINES

FORESTS

STILL

WE FAIL TO STOP

WHISTLE BLOWS.

 

 

 

 

@ 6-25-78 WASHINGTON D.C.

MAGGY

 

WE JUST RAN

INTO EACH OTHER AGAIN

AFTER SO LONG ON THE SA COPYRIGHT TERRELL NEUAGEME STREET

JUST LIKE BUMPER CARS WE WERE

ONLY THE ELECTRICITY

WENT OFF THE MOMENT

WE HIT.
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6-12-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

WE LIVED 

WE DIED

WE HELD HANDS IN OUR DISGUISE

I WENT TO CHANGE YOU

INTO ME

YOU WENT TO CHANGE ME INTO YOU

WE FAILED THROUGH AND THROUGH

SO WE CHANGED INTO US

SPARE CHANGE

ON THE ROAD TO HEAVEN

BEING ONE

IN THE MORNING SUN

NOW WE'RE CHILDREN

WITHOUT A PAST

LAUGHING NOWS

WITHOUT ANY HOWS
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IN FREEDOM'S

FAVORITE FLIGHT.

 

4-28-86 MT. COMPASS COPYRIGHT TERRELL NEUAGE SA COPYRIGHT TERRELL 
NEUAGE

YOU AND ME

LEGENDS OF TIME

IN LOVE'S FINAL HORIZON

BEFORE THE NEW AGE

MAKES US FOSSILS

OF LOVE

AGAIN.

 

3-28-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

WE TOUCHED THE STARS 

BEFORE WE WERE READY

NOW

WITHOUT OXYGEN

WITHOUT BODIES

WITHOUT LIFE

WE SEARCH
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HOW TO COME BACK DOWN TO EARTH

ONCE AGAIN.

 

 

12-22-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR

WE'VE GOTTEN TOGETHER

ALMOST ALL THE TIME

THOUGH WE HAVE NEVER BEEN ANYTHING

MORE THAN PASSING STRANGERS

ON 

OUR

WAY

TO MAKE A GOOD FRIEND OF OURS

AND I CAN BE YOUR EVERY FANTASY

JUST DON'T MAKE ME YOUR MAN

I DON'T LOVE YOU

BUT I WANT TO BE YOUR LOVER

YOU ARE SUCH A FINE

PASSING STRANGER

EVERY TIME
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WE MEET

UNMASKED.

 

 

1-02-79 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

WE WENT TO THE EDGE OF TIME

I HELD YOUR BODY

YOU HELD THOUGHTS

OF AN IMAGINED ME

IN REFLECTED DREAMS

OF LONG AGO

THEN WE AWOKE

ASKING WHY LONG AGO

WAS SO FAR AWAY

AND OUT OF TOUCH

LIKE WE WERE WHEN WE BELIEVED

WE WOULD BE FOREVER TOGETHER

AT THE EDGE OF TIME

IN THE MIDST OF ONE ANOTHER.
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5-08-89 PT. ELIOT

WE WERE SILHOUETTES

IN THE MIDDLE OF SHINNING SEAS

MOVING PAST TIME'S PERIPHERY

THEN FREE FALLING BACK THROUGH TIME

THROUGH OUR DAYS

FILLING YOUR SHOES

LAUGHING IN YOUR HAIR

AS IT CURLS OVER YOUR BREATH

WE WERE SILHOUETTES SKIMMING ACROSS TIME

KNOWING OUR SEAS

WOULD NOT BE TOO ROUGH

BUT MAYBE A BIT TOO MOIST

WOULD YOU DROWN WITH ME?

7-25-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

WHAT IS REAL

AT ONE TIME

UNREAL 

ANOTHER

THEN A DREAM LATER ON

IS BUT
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REFLECTIONS OF A WIND

TRAVELLING THROUGH

THE MANY PASSA COPYRIGHT TERRELL NEUAGEGES

OF EACH 

REAL THING

LAUGHINGLY.

 

 

8-20-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

WHAT WE SHARED

EVEN TOMORROW WILL REMEMBER

FLYING FREE FOREVER FOREIGN FEELINGS

WHILE WATCHING WHERE WE MERGE

AS ALWAYS WE EXPECTED

WE WOULD

.

 

 

11-17-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR SA COPYRIGHT TERRELL NEUAGE
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WHEN I SA COPYRIGHT TERRELL NEUAGEID

I WOULD LIKE

YOU TO BE MY CLONE

YOU THOUGHT I SA COPYRIGHT TERRELL NEUAGEID MY CLOWN

NOW INSTEAD OF TWO OF ME

I HAVE ONE SILLY YOU

PERFORMING LIKE ME

ALONE.

 

 

 

 

 

2-09-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

 

WHAT IS TRASH TO ONE

IS GARBAGE TO ANOTHER

AND BY THIS IDEA

NOTHING IS THE SA COPYRIGHT TERRELL NEUAGEME

THAT IS
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DIFFERENT

EVEN THOUGH IT MAY

BE TRASH

TO ONE

AND GARBAGE TO ANOTHER.

 

 

5-18-74 SA COPYRIGHT TERRELL NEUAGEN FRANCISCO COPYRIGHT TERRELL 
NEUAGE

WHEN I WALKED THROUGH

THE WORLD TODAY

I SA COPYRIGHT TERRELL NEUAGEW AN IMAGE OF YOU

LAUGHING WITH AN IMAGE OF ME

HEARD A WHISPER OF YOURS

WHISPERING TO A WHISPER OF ME

FELT A FEELING FROM YOU

FEELING A FEELING FROM ME

AND I SA COPYRIGHT TERRELL NEUAGEW A THOUGHT OF YOU

LOOKING AT A THOUGHT 

OF ME.
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9-23-71 NEW YORK COPYRIGHT TERRELL NEUAGE CITY

WHEN I WAS YOUNG

SOMEWHERE BETWEEN BIRTH AND NOW

THE WORLD LOOKED BIG

AND THE STARS SMALL

I COULD PUT MY HAND UP

AND BLOCK OUT THE SUN

OR THE MOON COULD DISA COPYRIGHT TERRELL NEUAGEPPEAR

BEHIND MY FINGER

EVERYTHING WAS SMALL

EXCEPT FOR MY DREAMS

WHICH WERE SO BIG

THAT THEY BLOCKED

OUT SO MUCH

OF MY LIFE

THAT IT TOOK UNTIL NOW 

FOR THEM
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TO BECOME REAL. 

 

8-08-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

BETTY

WHEN I WOKE THIS MORNING

COMING BACK FROM FIVE THOUSA COPYRIGHT TERRELL NEUAGEND MILES 
AWAY

COMING BACK FROM FIVE HUNDRED YEARS AGO

COMING BACK FROM SLAYING DRAGONS

FROM REMEMBERING YOU

YOU WERE A PRINCESS

AND I DIDN'T KNOW IT

SO I SLEW YOU

BECAUSE I THOUGHT THE FIRE WAS FROM A DRAGON

I SLEW YOU

BECAUSE I DIDN'T KNOW THE FIRE WAS FROM YOUR LOVE

THIS MORNING WHEN I RETURNED TO TODAY

HERE NOW AGAIN

I SA COPYRIGHT TERRELL NEUAGEW THE WORLD IN ASHES

SHE HAD NO FIRE FOR ME TO SLAY

SHE NO LOVE FOR ME TO KNOW
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SHE HAD NO YESTERDAYS FOR TODAY

ALL THERE WAS

WAS A BIG BED EMPTY ALONE

WITH JUST ENOUGH ROOM

FOR ME TO ROLL OVER

AND GO BACK TO YESTERDAY

WHEN EVERYTHING WAS REAL

IN FIRE. 

9-10-72 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

WHEN WE WALKED THROUGH THE PINES 

EARLY THIS MORNING

I WOULD HAVE PICKED YOU DIAMONDS

A PLENTY

IF ONLY SOMEONE WOULD HAVE SA COPYRIGHT TERRELL NEUAGEID THEN

THAT THE PINE NEEDLES ARE PRICELESS AS DIAMONDS

FOR HE WHO LOVES ON THEM

FIRST OF FALL.
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1978 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

JANIS

WHEN YOUR BREATH STOPPED

YOU BECAME MY WINGS

AND IN MY MIND

YOUR KISS

I HEARD

SPRANG A SPRING

IN MY FREEDOM

TO FLY

ON THE WINGS
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OF YOUR DREAMS

A WORLD DRESSED

TO PARTY.

 

 

 

1-01-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

WHILE FLOATING UPON

THOUGHTS OF YOU

THE WORLD SLIPPED AWAY

LEAVING ME TO WONDER

WHERE I WOULD BE

IF I WASN'T FLOATING UPON

THOUGHTS OF YOU.

 

 

(picture poem order No. 219)

* # 11-18-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR

WISHES AND DREAMS
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ARE SWALLOWED

BY DESIRE

AND LIVE AS PAIN

IN MEMORIES

OF WHAT COULD HAVE BEEN

IF ONLY WISHES AND DREAMS

HAD BEEN 

GIVEN LIFE.

 

 

 

 

3-89 PT. ELLIOT 

WITHOUT YOU

FLOWERS DON'T BLOOM

WITHOUT YOU

AS ME.

 

 

1-12-94 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE
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WRITING A POEM

IS LIKE HAVING A CHILD

THAT WHEN THE BIRTH

PASSES THE PAIN

THERE IS ANOTHER CREATION

TO CARESS

THE UNIVERSE.

 

 

2-01-72 SA COPYRIGHT TERRELL NEUAGEN JUAN PUERTO RICO

WRITING POEMS

TELLING STORIES

MAKING UP LIFE AS I GO

WONDERING IF THERE IS A GOD

WONDERING IF THERE IS A ME

COUNTING DAYS 

YEARS GONE BY

HOW MANY LEFT

BEFORE THE GREAT BIG

'what's next?'
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AND HOW DO I FIT IN 

HOW DO I GET OUT

ONCE I AM IN

ARE THERE WOMEN IN HEAVEN

WHO CAN BREAK YOUR HEART

MAYBE ALL ONE IS LEFT WITH

IS VOLUMES OF POEMS

AND FILES OF STORIES

PILED UPON 

THE FLOOR

FOR A DISTANT GOD

TO SOMEDAY COLLATE

FOR A LADY

WHO WANTED ME

MORE THAN 

MY POEMS

DID.

 

 

7-27-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

YOU ARE THE SUMMER PART OF ME

http://neuage.indiko.com/collection3.htm (95 of 271) [3/8/08 2:55:09 PM]



collection3

THAWING ME IN RHYTHM TO A LOUISIANA RAIN

AND I'VE BEEN HERE BEFORE

SOMEWHERE IN THE BACK OF MY MIND

BUT IT NEVER SEEMED REAL

UNTIL THIS TIME

WHEN WE MOVED TOGETHER

IN A LOUISIANA RAIN.

 

 

 

3-78 BALTIMORE COPYRIGHT TERRELL NEUAGE 

YOU ASKED ME TO BE A BRANCH

TO BE A LEAF

TO BE A PART OF YOU

AND WHEN I ALMOST

CLAIMED A YES

YOU UPROOTED YOURSELF

WITH NO WATER

NO SUN

AIR 
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FOR ME TO GROW

AS A BRANCH

OF YOU.

 

 

6-12-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

YOU HANDED OUT MY LOVE

WITH A COMPUTERIZED EXCELLENCE

I WANTED THE SOFT TOUCH

OF YOUR PASSING LOVE

BUT YOU TOOK MY FLEETING LOVE

AND SOLD IT ON WALL STREET

AS STOCKS AND BONDS

TO A WORLD

STARVING FOR COMPASSION

AND A TASTE

OF YOUR ELEGANT BODY.
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7-15-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

YOU HAVE CAUSED ME TO DANCE UNTIL

THEY HAVE REMOVED THE FLOOR

FROM BENEATH

MY FEET

TAKE ME AGAIN

FOR I STILL SEE THE GROUND

ABOVE ME.

 

 

 

1979 BALTIMORE COPYRIGHT TERRELL NEUAGE 

YOU KNOW 

I WANT TO DANCE

WITH MORE

THAN YOUR MEMORIES

BUT I AM

BUT

A MANIPULATED STATISTIC

IN AN AGE OF

MASS PRODUCED
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BY PRODUCTS.

 

 

 

 

 

YOU KNOW

SO MUCH

WHAT I FEEL

BUT LIKE

WARRIORS

SOME FINAL BATTLE

YOU FIGHT

YOUR FEELINGS

LIKE I DO YOURS

WHEN WILL YOU EVER SEE

WHAT I FEEL

ONLY

YOU.
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4-80 ARIZONA

YOUR EYES 

WHISPERED 

SOME STRANGE DREAM

I HAD OF YOU

LONG AGO

MARCHING US INTO BATTLE

WHEN WILL

WE

EVER LEARN?

 

 

(picture poem order No. 159)

* # 10-04-79 & 1-12-96 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE/
HACKHAM SA COPYRIGHT TERRELL NEUAGE

YOUR LOVE

HAD SO MUCH COLOUR

I HAD TO CLOSE MY EYES
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AND LISTEN TO YOUR SONG

YOUR SONG

HAD SO MANY MELODIES

I HAD TO SHUT MY EARS

AND FEEL YOUR PRESENCE

YOUR PRESENCE

WAS SO JOYFUL

THAT I BECAME

A CRIPPLED

ECSTASY.

 

 

2-07-72 NEW YORK COPYRIGHT TERRELL NEUAGE CITY

YOUR LOVE

THUNDER ON MY HORIZON

LIGHTENING IN MY DAWN

ELECTRICAL STORMS

AT THE TIP

OF MY TONGUE.
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(picture poem order No. 220)

* # 3-20-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

ALL NIGHT

I WROTE POEMS

TO YOU

NOW I AM 

SO WORD DRUNK

I CAN NOT FINE

MY PUNCTUATIONS.

 

 

 

1-12-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

BEVERLY

 

YOUR TOUCH

MAKES ME

FEEL SOFT

AND FREE
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LIKE THE WINE

JESUS BLESSED

AT SOME STRANGE FEAST.

 

 

 

 

5-77 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

YOU SA COPYRIGHT TERRELL NEUAGET DOWN OPPOSITE ME ON THE TRAIN

I FELL IN LOVE WITH YOU

I COULD SEE US

MEETING

EXPLORING

CONQUERING

THEN THE TRAIN STOPPED

YOU LOOKED ME IN THE EYE

SMILED

WINKED

SHOWED ME WHAT I WOULD NEVER KNOW

AND GOT OFF
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TAKING MY MEETING

EXPLORING

CONQUERING

WITH YOU.

 

 

9-09-89 NORALUNGA TRAIN SOUTH SA COPYRIGHT TERRELL NEUAGE

I LIKE THE WAY

YOU LOOK

AT MY NAKEDNESS

AND IMAGINE

HOW IT

WILL

COVER YOU

SOON.
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1-12-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

YOU WERE A WARM CLOUD OF COMFORT

TO MY TOUCH

THE CITY ONCE STEPPED ASIDE TO YOUR APPROACH

COUNTRY ROADS GREW GREAT TREES

TO COOL HER WAY FOR YOU

AND I LAID DOWN TO REST

IN SEARCH OF YOUR RETURN

THE RETURN OF YOU ON A WARM CLOUD

OF COMFORT FOR MY TOUCH.

 

 

 

4-18-78 BALTIMORE COPYRIGHT TERRELL NEUAGE 

MISSY

YOUR LOVE

WAS SO BRIGHT

I COULDN'T SEE

THE STARS

SHINING

OVER US.
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1-31-72 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

YOUR PROMISES

WERE A BALCONY

THAT I STEPPED OUT ON

BEFORE THE RAIN CAME

TO TAKE AWAY

THE PILLARS

THAT HELD YOU AND I

HIGH ABOVE 

THAT WHICH 

WE COULD

NOT SEE.

 

 

10-02-72 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

 

SO AS TO REMEMBER
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THIS

 

3-25-90 11AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

FROM MY WINDOW

I WATCH RAIN FILL 

THE VALLEY

LIKE I USE TO YOU

MY PAST

SO SEEMINGLY AGED

NOW APPEARS IN FRONT OF ME

AS BUT A TODDLER

I FEEL CLEAR NOW

THE MISTRUST HAS GONE

I FORGIVE

I FORGET

4-86 MT COMPASS SOUTH AUSTRALIA

GATES OPENED

EXPERIENCED RUSHED IN

I SA COPYRIGHT TERRELL NEUAGEW

I HEARD
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I ASKED

ANSWERS FLEW PAST

I GRABBED A FEW

LIFE SMILED

IT WAS MY TURN

TO BE KNOWN

PERCEPTIONS HONOURED

MY INTERPOLATIONS

IN OPENED GATES

WHERE ALL COULD SEE

WHAT I HAD PERCEIVED.

 

 

2-24-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

GOLDEN THROW

THICKEN FLOW

CAST FILLED WINDS 

WHERE I'VE BEEN

SING MEMORIES

RING ME FREE

GOING SA COPYRIGHT TERRELL NEUAGEIL
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LIFE'S GAIL

THROWN UPON ROCKS

LIFE'S LONELY DOCKS

ILL TURNED STORMED

COSMIC REFORMS

I GAINED MY STEPS

WHILE THE WORLD SLEPT

AND I LOST M YSHOES

IN MORNING DEW.

 

9-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

GOODBYE PASSING FANTASY

YOUI KEPT ME ENTERTAINED

FOR QUITE SOME TIME

MEVER WERE BIT

MY OWN IMAGINATION

GONE WANDER

YONDER

LEAVING ME

FAR BEHIND AND

http://neuage.indiko.com/collection3.htm (109 of 271) [3/8/08 2:55:09 PM]



collection3

YOU NEVER

NEAR.

3-26-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

GOOD MORNING

FULFILLMENT

HAPPY THOUGHT

I SEE THAT 

YOU BROUGHT LAUGHTER

FOR US

TO CRADLE

THIS MOMENT

IN.

 

2-24-75 SYRACUSE NEW YORK COPYRIGHT TERRELL NEUAGE

HEAVEN = THE PASSION

BETWEEN CHILD AND MAN

DIVINITY = THEIR 

COLOURING BOOK.
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7-10-74 BROWN BROTHERS ABBEY WHICHITA KANSA COPYRIGHT TERRELL 
NEUAGES HOLY ORDER OF MANS

HELLO

HOW ARE YOU?

WE ARE FINE STILL THE SA COPYRIGHT TERRELL NEUAGEME

ACTING OUT

THE SCRIPT

WE MADE UP

SO MANY YEARS AGO?

 

4-22-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

HERE

AGAIN

THERE

BEFORE

TARNISHED DREAMS

LAYING IN THE RAIN

QUIETLY

SPEAK

LOUDLY
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IN WHISPERED MEANINGS

ALONG THE SEA SHORE

HUMUHUMUNNUKUNUKUAPUAA - either of two triggerfishes, found among coral 

reefs of the tropical Indian and Pacific oceans...

WAIT

LEAVE

FORESTS:

GO ONE ON WITHOUT ME

I ONLY FEEL WHAT HURTS

COUNTRY:

TODAY I WATCHED THE CANDIAN GEESE FLY SOUTH FOR THE WINTER LIKE 
YOU DO 

EACH TIME I REACH OUT TO SETTLE YOU DOWN CLIPPED WINGS HELD 
AGAINST 

NATURE LEAVING ALONE CRIPPLED BY THE FIRST OF NEVER

CITY:

FREEZE DRIED TIME ELUCIDATED DAWN PACKAGED MEMORIES ZENTH OF 
FEELINGS WHEN 

FIRST YOU I DID MEET.

PARKS:

I SET MY LIFE OUT ACROSS THE VALLEY TO BE CLEANSED BY THE RAIN TO 
BE FREE 

ONCE AGAIN LIKE I WAS AT THE DAWN OF OUR CREATION WHEN I FIRST 
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FILLED YOU.

FREEWAYS CARRY MASSES:

I THOUGHT OF US PRETENDED US DREAMED US NOW I HAVE TO FACE 

TWO FACED REALITY: YOU

PEOPLE ALL ALONE

YOU 

WE 

THEY LOOK UPON US KINDLY IN THE SHADE.

HELLO MORNING HELLO JESUS

I FEEL YOUR WARMTH

COMING THROUGH ME TODAY

HELLO MORNING HELLO DREAMS

I SEE THAT

EVERYTHING IS COMING TRUE AGAIN

HELLO MORNING HELLO CHANGES

I HEAR THAT THERE IS NO MORE WAITING

WHEN ALL IS FOUND.

 

 

2-28-72 CENTRAL PARK NEW YORK COPYRIGHT TERRELL NEUAGE CITY
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HERE WE ARE

BACK TOGETHER AGAIN

AFTER SO MANY

PARTS

OF US

TAKEN AS A PART

OF WHICH

WE DIDN'T KNOW

UNTIL

HERE WE ARE

AGAIN.

 

2-23-90

HERE WE ARE

FIRST OF NEVER

WANTING YOU

WAS SO EASY

HOLDING ON

SO DIFFICULT

I WATCHED

3-07-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE
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HEY LOOK!

I'M NOT ME ANY

MORE

SHIT!

WHO AM I?

WHAT SHALL I NAME MYSELF

HOW OLD SHOULD I BE

WHERE COULD I BE FROM 

WHAT DO I DO

OH DEAR OH DEAR

IT'S ALL TOO COMPLEXED

LAUGHTER

SCREAMS

THEN MORE LAUGHTER

THERE 

NOW

I'M ME AGAIN.

10-18-83 ADELAIDE SA COPYRIGHT TERRELL NEUAGE

HOW BE IT

WHEN THE SUN DOES SHINE
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WELL I DON'T KNOW

BECAUSE I AM THE FROST

I AM THE DEW

HOW BE IT

WHEN THE MOON DOES SHINE

WELL I DON'T KNOW

BECAUSE I AM A CITY

I AM A CANDLE

HOW BE IT

WHEN LOVE DOES SHINE

WELL I DON'T KNOW

BECASUE I AM ALONE

I AM A TIDAL WAVE

UPON ON ONE'S SHORES.

5-11-74 KANSA COPYRIGHT TERRELL NEUAGES

PEGGY

HOW MANY SCENES DID WE PAINT

HOW MANY LIVES

DID WE DREAM

HOW LONG AS IT BEEN 
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SINCE

WE 

NEVER

SA COPYRIGHT TERRELL NEUAGEID GOOD BYE

BUT 

JUST

DISA COPYRIGHT TERRELL NEUAGEPPEARED

LIKE ANY 

DREAM

WOKEN 

WOULD.

2-22-80 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

HUMBLED

BY THE EXPERIENCE

OF IT ALL

WE WATNDER

IN AMAZEMENT

WONDERING

IF WE

REALLY

EVER

http://neuage.indiko.com/collection3.htm (117 of 271) [3/8/08 2:55:09 PM]



collection3

GOT

TO TOUCH

AT ALL.

2-04-78 BALTIMORE COPYRIGHT TERRELL NEUAGE MARYLAND COPYRIGHT 
TERRELL NEUAGE

I AWOKE WITH YOU

TASTE OF LASA COPYRIGHT TERRELL NEUAGET EVENING

ON YOUR BREATH

SOUND OF WHISPERED FULFILLMENT

IN MY EARS

SIGHT OF PROMISED ETERNITY

IN YOUR EYES

YOUR TOUCH

LED ME INTO NEW MRONING

NEW WORLDS

WHO YOU ARE

WHERE YOU COME FROM

WHAT YOU WANT

IT HAS NO MATTER

ONE NIGHT
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OUR FIRST NIGHT

BROUGHT BACK

MEMORIE

OF A HUNDRED AND TEN LIFE TIMES

TOGETHER

WE RODE INTO THE NIGHT

WE WERE KNIGHTS KINGS

BARBARIANS MONKS

WE DWELT IN A CAVE

GROANED GROAPED GROWLED

AND SA COPYRIGHT TERRELL NEUAGEVAGED ONE ANOTHER

IN PREHISTGORIC LUST

WE WERE PEASA COPYRIGHT TERRELL NEUAGENTS BEGGING FOR LOVE 
BENEATH THE CASA COPYRIGHT TERRELL NEUAGETLE WALLS

THIEFS STEALING EACH OTHER'S PASSIONS

MERCHANTS TRADING SOULS

POETS SA COPYRIGHT TERRELL NEUAGEINTS 

COWBOYS INDIANS

DRUNKEN SA COPYRIGHT TERRELL NEUAGEILORS

KISSING ANOTHER DAWN

WE WERE IT ALL 
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AND IN THIS MOMENT

IN THIS ONE NIGHT STAND

WE LAY 

SEARCHING TIME

AND DRINKING DEEP

OF ONE ANOTHER

IN PREPARATION

FOR THIS MOMENT

AND WHERE IT WILL LEAD.

3-07-80 BALTIMORE COPYRIGHT TERRELL NEUAGE MARYLAND COPYRIGHT 
TERRELL NEUAGE (THE DAY AFTER i MET MYSELF)

I AWOKE 

IN A DIFFERENT MIND

TODAY I WOULD SEE LIFE ANEW

THE INSTANT CHANGE

LONG AGO SOUGHT

BUT SO OFTEN SET ASIDE 

INSTANT LIFE

JUST ADD A THOUGHT

I DID THE RICH MIX

SO NEVER AGAIN
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WOULD I BE

THE OLD ME

AGAIN

UNITL I AWOKE AGAIN.

 

8-27-87 MT COMPASS SA COPYRIGHT TERRELL NEUAGE

 

 

 

 

 

 

THIS LOVE IS NO BARGAIN

THERE IS NO DISCOUNT FEELINGS

GARAGE SA COPYRIGHT TERRELL NEUAGELE HOPES

SECOND HANDED EMOTIONS

OR WALKS OFF A SHORT PIER

BUT THE INVESTMETN

HAS EXCELLENT RETURNS

WITH COMPOUNDED INTEREST
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OFTEN.

 

 

2-07-93 copyright Terrell Neuage EAST END MARKET ADELAIDE

JANET

THIS MORNING

LIKE AN INVITATION TO FLY

EVERYWEHRE SEEMED TO BE THE PLACE TO BE

AND I WAS HERE

SO DIFFERTENT

IT SHOULD FEEL

BUT THE COMFORTS

OF BEING WHERE I FEEL TO BE

IN THIS PASSSING MOMENT

GAVE TO ME 

THE ACCEPTANCE OF SUCH 

AN INVITATION

TO FLY.

 

2-11-80 DALLAS

THIS MORNING 
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ON THE NEWS

THEY SA COPYRIGHT TERRELL NEUAGEID AN AMERCIAN SPACECRAFT

HAD LEFT OUR SOLAR SYSTEM

HEADED FOR DEEP SPACE

LIKE I AM

LOST IN ORBIT

LOOKING HOW TO LAND

DEEP

IN ALIEN TERRITORY

YOU.

 

 

 

(picture-poem order No. 221)

* # 8-24-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

THOUGHT I WOULD NEVER STOP

NEVER REACXH MY END

FIND WHAT I WAS LOOKING FOR

BE SA COPYRIGHT TERRELL NEUAGETISUFIED

BEYOND BELIEF
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SA COPYRIGHT TERRELL NEUAGEY THIS IS IT

AND NOW I SEE

I THOUGHT

RIGHT.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3-04-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE
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TODAY ENDED

LIKE ANY RELATIONSHIP WOULD

LEAVING ME STANDING ALONE

UNDER A WARM AUTUMN NIGHT

WITH AN EMPTY BOTTLE OF WINE.

 

 

10-22-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

'PERFORMANCE'

TODAY I COULD DEFEAT THE WORLD

COULD I TRADE YOU

A DEFEATED WORLD

FOR A CAPTURED HEART

AND I SA COPYRIGHT TERRELL NEUAGEW THE PEOPLE 

MERGE TOGETHERE TODAY

IT WAS NOT A CLEAR VISION

THERE WAS ONLY A BLUR

SHAPED AS THE FUTURE

LIKE LINES NEVER MET

YOU WERE A BLURRED SHADOW

WITH NO AUDIENCE
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BOWING.

 

8-79 BALTIMORE COPYRIGHT TERRELL NEUAGE

TODAY I LOOKED INTO MY FEELINGS

AND THEY SOARED WITH EVERYTHING

THAT CAME TRUE

AND TO GO ON FROM HERE

IS ONLY A PARACHUTE

RIDE BACK

BUT AT LEAAST

THE PARACHUTE IS COLOURFUL.

 

 

 

 

(picture-poem order No. 160)

* @ 7-08-78 LUTHERVILLE

THE ONLY DIFFERENCE

BETWEEN CAVE MAN

AND MODERN MAN
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IS TODAY'S WOMAN.

 

 

 

 

(picture-poem order No. 222)

** # 3-16-93 copyright Terrell Neuage 110 VICTOR COPYRIGHT TERRELL 
NEUAGEIA STREET VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA 
COPYRIGHT TERRELL NEUAGE

TODAY'S VIEW

HELD BY FEW

EAT CARROTS

WITH MERIT

SMELLS RAIN

IN PAIN

SWALLOWS TIME

WITHOUT RHYME

SITS ON THE FENCE

AND MAKES NO SENSE

YIN YANG

THEY SA COPYRIGHT TERRELL NEUAGENG
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WHO CARES

IT'S FAIR

BY FAR

THE STAR

YOU SEE

IS

ME.

 

 

 

2-22-90 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

SO EASY TO PREDICT

THE FUTURE

'YOU

WAKING NEXT TO ME

FAR FROM EARTH

AGAIN TOMORROW

MORNING'.
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(picture-poem order No. 707)

* # 1-13-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

TOO MANY SMILES

TO CHOOSE FROM

TONIGHT ALONE.

 

(picture-poem order No. 37)

** @ 4-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

TOO MANY WORDS

ARE

LIKE

A

FORM

THAT

HAS

NO

PURPOSE.
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(picture-poem order No. 38 )

* @ 5-01-74 KANSA COPYRIGHT TERRELL NEUAGES

TOUCH ME

I NEED TO COME

AMONGST THE STARS

NEED ME

I FEEL YOU TREMBLE

BENEATH MY BODY

WANT ME

FOR I AHVE NEVER WATNED

ANYONE ELSE

IN SUCH

IGNITED PASSIONS

THAT EVEN THE STARS

TURN AWAY

BLUSHING 

IN OUR FINE

DESIRE'S AURA.

 

8-12-78
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TRUE UNION

IS THE REFLECTION

OF CREATION

SMILING 

AT

ITS MIRRORED IMAGE

IN MORNING MIST.

 

(picture-poem order No. 161)

* @ 1-02-80 HONOLULU

I LIKED NOW

SO WELL

I CANCELLED TOMORROW

SO FOREVER

NOW 

I'LL BE.

 

 

 

(picture-poem order No. 223)

* @ 1-12-94 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
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HARBOR SA COPYRIGHT TERRELL NEUAGE

I WILL FOLLOW

YOU

FOR LIFE

MAYBE AT A DISTANCE

SOMETIMES

OTHER TIMES

UP CLOSE

BUT WHAT I SA COPYRIGHT TERRELL NEUAGEW ONCE

WILL NEVER GO AWAY

YOU AND I 

FLYING SO FREE

TOGETHER

BEYOND OUR GALAXIE

IN THE CENTRE

WHERE IT ALL BEGINS

WHERE IT ALL BEGAN

BIRTH OF GALAXIES

BIRTH OF SIGHT

I SA COPYRIGHT TERRELL NEUAGEW YOU
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DEEP TO YOUR CORE

ONCE

I WILL REMEMBER THAT

THE WOMAN 

I ONCE SA COPYRIGHT TERRELL NEUAGEW

I WILL SEE AGAIN

IF IT TAKES

FOREVER

EVEN SEVEN LIFE TIMES

TIMES SEVEN

FROM NOW

I WILL FIND

AND BE FREE

WITH WHAT

ONCE I SA COPYRIGHT TERRELL NEUAGEW.

 

 

3-31-84 37 RICHARD ST. ADELAIDE SA COPYRIGHT TERRELL NEUAGE

I LIVE AN UPLANNED LIFE

LISTENING TO NATURE'S TRUMPETS

AND HUMAN'S LIES
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AND IN BETWEEN

MY AUDIENCE AND THEIR STARS

I ACT OUT

YOUR DREAM.

 

 

 

 

5-20-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

 

I LOOK AT MY DESK

COVERED WITH PAPERS

AND ARTICLES OF OTHER'S IMPORTANCES

ASKING WHEN WILL I BE ABLE

TO STAY WITH YOU

AGAIN

BUT THEY DON'T MOVE AT ALL

TELLING ME

THAT EVERYTHING STAYS AS IT IS

http://neuage.indiko.com/collection3.htm (134 of 271) [3/8/08 2:55:09 PM]



collection3

UNTIL SOMEONE COMES ALONG

AND CHANGES THEIR POSITION

SO I OPEN THE WINDOW

THE WIND BLOWS STRONG

THE PAPERS GRAB AHOLD OF THEMSELVES

AND EVERYTHING ELSE IN SIGHT

IN FLYING ARRAY

OF NATURE'S IMAGINATION

WHILE I LOOK AT MY ASKING TO STAY WITH YOU

SIT ALONE

UNMOVED

DAY AFTER DAY

BUT I AM GOING TO OPEN

SOME KIND OF WINDOW

TO STIR UP THE MOMENT

TO LET FLY MY LOVE

TO SETTLE ME WITH YOU 

IN THE EYE OF AN HURRICANE

THAT SEES ALL

ESPECIALLY

HOW TO STAY

http://neuage.indiko.com/collection3.htm (135 of 271) [3/8/08 2:55:09 PM]



collection3

WITH YOU.

 

 

9-13-978 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

I LOOK AT YOU

ADN REALIZE THAT I KNOW

SO MUCH BEAUTY

COMES

FROM YOU

AND I WHISPER TO MYSELF

WONDERING

HOW I BECAME 

SO UNGRACEFUL

IN SUCH 

A DANCE

I FEEL LIKE ONE OF THOSE BLUEBIRDS

THAT FLY OUT OF A CAKE

AT A CONVENTION

BUT INSTEAD OF FLYING OFF INTO THE ROOM

OF BANQUETTEERS
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I BRAKE A WING

ON THE GLASS

OF CHAMPAGNE

OF THE HONOURED GUESTS

SPILLING IT 

IN THEIR LAP

LEAVING ME EMBARRASSED

AND FEELING CLUMSY

AT MY SIDE.

 

 

10-25-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

I LOOKED BEYOND

MY CITIES WORLDS

INTO NATURE'S

DREAMS

LIKE A CHILD

WATCHING

FOR 

A SIMPLE
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TOUCH 

OF FREEDOM

TO HOLD ON TO.

 

 

 

(picture-poem order No. 162)

* @ 4-19-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

I LOOK FORWARD

NOT TO THE TIME

WHEN EVERYTHING

BECOMES

BEAUTIFUL

AND FULL

IN WINGED

HARMONY

BUT TO WHEN

I

BECOME

AWARE

OF THE BEAUTY
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THAT ALREADY

EXISTS

IN HARMONY'S

EVER UNFOLDINGS

FORMATION.

 

 

8-16-75 SYRACUSE NEW YORK COPYRIGHT TERRELL NEUAGE

I LOST MYSELF

IN YOUR SURRENDER

CAPTURED 

BY PASSION'S

FASHIONS

FREEWILL'S

WILD

FINAL 

RUN.
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(picture-poem order No. 224)

* # 8-16-89 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

 

THIS PLANET

A TURTLE

CARRYING ITS HEAVY LOAD

OUT OF CONTROL

SCROFULOUSLY

SHITFACED

THROUGH 

THE MILKY WAY.
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(picture-poem order No. 708)

* @ 1-14-96

I LOVED YOU TRULY

GIVE OR TAKE

MORE OR LESS

THE WAY WE WERE

OR MIGHT

HAVE BEEN

SO MUCH MORE

IF IT HAD BEEN

JUST A LITTLE

BIT LESS.

 

 

 

3-11-86 TOOPERANG ROAD MT. COMPASS COPYRIGHT TERRELL 
NEUAGEYYYYYYYYYYYYY

I LINED UP MY MEMORIES

MEMORIES ON PARADE

FLOATS OF DREAMS

BANDS OF WISHES
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AND THE DANCING GRILS

EACH ONE

HOLDING MY PROMISE

OF FOREVER

WITH ONLY THEM

AS THEY WOVE THROUGH

THE DOWNTOWN STREETS

OF MY MEMORY

KNOWING TOMORROW

WILL NEVER ARRIVE.

 

 

 

8-02-89 PT. ELLIOT

I LOVED YOU

YOU WERE MY ONLY DREAM

I DREAMED YOU

YOU WERE MY ONLY LOVE

BUT NOW YOU

TRY TO BE REAL
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AND ASK ME TO RESPOND

IN SOME KIND OF

REAL WAY

AND ALL THE STARS

IN THE SKY

CHANT WITH THEIR PLANETS

'I'M GLAD I'M NOT HUMAN

I'M GLAD I'M NOT HUMAN'.

 

 

 

 

4-78-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

I MADE A QUICK OBSERVATION

OF FOREVER 

AND TO MY SURPRISE

IT MADE AN EVEN QUICKER

OBSERVATION OF ME
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5-27-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

TATOOTED DREAM

RIPPED APART

BY SUDDEN

WAKEFULNESS.

 

 

 

 

1-14-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

CAROL ANN

I'M COMING TO SEE YOU MY LADY PAST

COMING TO YOU WITH MEMORIES

OF WHEN WE WERE YOUNG

OF WHEN WE WRE OLD

OF WHEN WE WERE TOGETHER YOUNG ADN OLD

TOGETHER

I'M COING TO HOLD YOU MY LADY GONE
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COMING TO YOU WITH WANDERING THOUGHTS

OF WHO HAVE WE BEEN ALL THESE YEARS

OF WHO WILL WE BE THIS TIME MEET

OF WHO WAS IT THAT WE WERE IN SOME

DISTANT MEMORY LONG AGO

I'M COMING TO YOU MY LADY CHANGED

COMING TO YOU WITHOUT ANY NOTICE

OF WHY I'VE COME SO FAR TO SEE YOU

AFTER THESE YEARS HAVE SEPARATED OUR

DREAMS SO FAR THAT WE FORGOT

WHAT THEY WERE.

 

 

 

12-16-72 MOKENA ILLINOIS

IN A CAUSE TO CELEBRATE

FREEDOM FLIES

NOBODY DENIES

HER WINGS HAVE NO ENDS

TOWARD ME SHE BENDS

TODAY IS YESTERDAY'S CRESENDO
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FLAMED FIRES WILLYFULLY BLOW

WHILE SNOW OUTSDIE

COMES ON INSDIE

FILLING THE BRANCHES

AS SL LONG AGO'S TRANCES

SETTING THE NIGHT

IN A CASUE

TO CELBRATE.

 

3-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

IN A MIST

OF SEPARATED STILLNESS

THE MOMENTS SPOKE TOGEHTER

AND FAR AWAYH

WAY BEYHOND

CHILDISH BELIEFS

PEOPLE TOUCHED

THEIR DREAMS

LIKE YOU AND I DID

BEFROE
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SEPARATED STILLNESS

MADE THE QUIET

SO LOUD AND NEAR

HERE

HEAR?

 

 

 

 

 

 

 

 

12-20-79

I MADE A HUNDRED PHOTOCOPIES

OF THE MOMENT

I MET YOU

AND 

HAND THEM OUT

TO MYSELF
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EACH TIME

THE MOMETN

TRIES

TO SLIP

AWAY

FROM THE CORNER

I STAND ON 

BEGGING 

TO BE

WITH YOU 

ONE MORE TIME.

 

 

 

 

1213-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

IN NATURE'S DRUNKEN WHISPER

THE STORM STRUCK

AND TESTED ME

LIKE A BREATH ANALYZER

ALONG THE INFORMATION HIGHWAY
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ARRESTING ME

FOR SO CONSTANTLY

GOING OVER THE LIMIT.

 

 

1-16-94 copyright Terrell Neuage - 1-14-96 VICTOR COPYRIGHT TERRELL 
NEUAGE HARBOR/HACKHAM SA COPYRIGHT TERRELL NEUAGE

IN BROKEN IMAGES

AND MEANINGLESS DREAMS

THE FUTURE IS DRAFTED

AND SUPERGLUED

INTO PLACE.

 

 

 

 

4-19-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

IN CAPTURED DRAGON'S MEMORIES

AND BUTTERFLY DREAMS

TRANSFERENCE OF AGELESS FEELINGS
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MERGED INSIDE

THE BEYOND

WHERE I THINK OF YOU.

 

 

 

 

 

 

(picture-poem order No. 225)

* # 3-90 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 

IN DIFFERENT STYLES

AND MEANINGLESS SMILES

WE PLACE ALL SOUL MEMORY ON TRIAL

WHILE CHERISHED BELIEFS ARE PILED

ONLY TO BE ITNERRUPTED

BY A THIRTY SECOND COMMERICAL

WHERE GOD SITS AT A BREAKFAST TABLE

EATING CORNFLAKES

AND ASKING DO WE KNOW
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WHERE WE WILL SPEND ETERNITY

WE'RE THEN LEFT TO BLINK AWAY

A CHANGING OPINION POLL'S

CONGRADULATING YESTEDAY'S SA COPYRIGHT TERRELL NEUAGEVIOURS

WHILE WE EAT AWAY

OUR MULTINATINLAL BREAKFAST

AND WATCH THE PROPHETS PROCLAIM

HEAVEN IS EATING HOLLYWOOD ENDEROSEMENTS

AND ETERNITY WILL BE SPENT

IN A BOWL OF HIGH-PROTEIN LOW-FAT MILK.

 

 

 

2-15-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

IN

FORESTS OF FORGOTTEN 

FLAVOURED FOREVER

FORGIVES FOREIGN FREEDOM

FOR FIGHTING

FROZEN

MEMORIES
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TONIGHT.

 

4-27-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

CHAOS THEORIES

 

IN GOD'S CHAOTIC

INNOCENCE

OF CREATION

I HEAR YOU SIGN

FOR ME TO COME AGAIN

THOUGH YOU ARE ON

THE OTHER SIDE OF THE WORLD

WITHOUT ME

I FEEL YOUR BREATH AS IT FLOWS THORUGH TIME

AND EFFECTS THE TIDES

HERE SO FAR AWAY

WILL YOU CHANGE

THE TIDES

ONCE AGAIN

WITH THE BEATING OF YOUR HEART
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THAT TOUCHES

EVEN SOLAR FLARES

AND LENGTHENS

SOLAR SPOT ACTIVITES

AND CORRUPTS

THESE EARTHLY THOUGHTS

I HAVE OF YOUR LIPS

PARTED.

 

5-02-89 PT. ELLIOT

IN MY HUMBLE OPINION

GOD 

SHOULD BE FIRED.

 

 

 

4-27-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

I NEVER COULD BELIEVE YOUR WORDS

BUT YOUR RHYTHM SWALLOWED ME

PROMISES OF DREAMS FROM YOUR PAST
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HOW COULD I ANSWER THEM

I AM A BELIEVER IN A SUSTAINING MOMENT

YOU TOUCHED MY TIMES

BUT YOUR HEART WAS ON FIRE

AND THE BLAZE LASTED

SUCH A SHORT TIME

THAT I MANAGED TO ESCAPE

WITH JSUT A SINGE

I WATNED YOUR WORDS

TO MOVE WITH YOUR BODY

BECASUE YOU TOOK ME

BEYOND ANY WORDS I HAVE EVER HEARD

SO LET ME TOUCH YOU

ONE MORE TIME

FOR I NO LONGER 

CAN HEAR

YOUR WORDS

HERE.

 

1-08-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

I NEVER KNEW I WANTED YOU SO
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UNTIL YOU DIDN'T WANT ME

ANYMORE

SHOWED ME

OUT YOUR DOOR

THEN TOOK ME BACK

FOR A LITTLE BIT MORE

I CAME BACK

GAVE YOU ALL OF ME

(EXCEPT FOR THE FEW PARTS OF ME 

I WATNED MYSELF TO KEEP)

YOU GAVE ME THJE PARTS OF YOU

NO LONGER OF YOUR USE

(THE ALL OF ME WITH THE PART OF YOU

THAT HAD THE ALL OF ME

WANTING YOU)

THANKS.

 

 

8-12-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

IN LOVE
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THE GAME

IS TO BE PLAYED

NOT TO BE LOST.

 

 

 

 

 

 

 

 

 

 

7-06-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

SUCH A CHANGE

IN THE WEATHER

LIKE NIGHT TO DAY

SECONDS BEFORE THE BIG BANG

AND YESTERDAY

OUR FIRST KISS
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AND OUR LAST.

 

 

 

 

1-14-96 HACKHAM

IF THERE WEREN'T SHADOWS LIKE ME

THERE WOULD NEVER BE

STARS LIKE YOU.

 

 

 

@ 12-28-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR

 

 

 

IF THERE WEREN'T STARS LIKE ME

THERE WOULD NEVER BE

SHADOWS

LIKE YOU.
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1-14-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

 

TAMZON

IN THE DREAM I JUST WOKE FROM

ALL MY LOVERS THAT I HAVE LOVED

WERE LAUGHING WITH ME

WE WERE WHERE WE ALWAY WERE

IN EVERY CITY

IN EVERY ROOM

IN EVERY POSITION

ALL AT ONE TIME

AND I FELT LIKE THE THOUSA COPYRIGHT TERRELL NEUAGEND ARMED 
BUDDHA

I FELT LIKE NIAGARA FALLS

I FELT LIKE THE CROSS OF CHRIST

BURNING OUT THE FINAL DESIRE

THERE WAS A PARADE IN MY DREAM

IT WAS MARDI GRAS DAY

THE FIRST FLOAT WENT BY

THROWING BEADS ADN TRINKETS

http://neuage.indiko.com/collection3.htm (158 of 271) [3/8/08 2:55:09 PM]



collection3

AND ONE OF THE THINGS I CAUGHT WAS A STRAW HAT

AT THE SA COPYRIGHT TERRELL NEUAGEME TIME

AS ANOTHER MAN CAUGHT IT

ONLY WE BOTH PULLED ON IT AT ONCE

AND I ENDED UP WITH THE HAT 

MINUS A BIG PIECE OUT OF THE FRONT OF IT

THEN ANOTHER FLOAT WENT BY

AND MY RED HEADED LOVER WAS ON IT

AND IT STOPPED IN FRONT OF ME

AS ALL MY OTHER LOVERS IN ONE

AND SHE ASKED ME TO COME

ABOARD AND SING A SONG WITH HER

BUT I REFUSED AND SO ALSO DID ALL MY OTHERS

LIKEWISE REFUSE

SHE TURNED TO THE CROWDS ADN A GIRL WENT UP 

AND SA COPYRIGHT TERRELL NEUAGENG ALONG WITH HER

THEN ALL MY OTHER LVOERS AND I WETN UP 

TO EVERY CITY

EVERY ROOM

AND ATE SOME ICE CREAM
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THEN I AWOKE IN TIME

TO REALIZE THAT I WASN'T ALONE

AND NONE OF MY LOVERS

WERE ME

AND IT WASN'T A DREAM

BUT I WAS HUNGRY.

 

6-74 20 STEINER ST. SA COPYRIGHT TERRELL NEUAGEN FRANCISCO 
COPYRIGHT TERRELL NEUAGE 

IN THE MORNING

I LOOKED FORWARD TO

MEETING THE NEW ME

I HEARD ABOUT

IN A DREAM

BUT THE NEW ME

STAYED IN THE DREAM

WHILE MIRROR SHOWED

THE SA COPYRIGHT TERRELL NEUAGEME SNAPSHOT

IT HAD SHOWN 

EVERY OTEHR MORNING

FUZZY WAKEFULNESS
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FAR FROM ANY DREAM

POSSIBLE

COULD MAKE

REAL.

 

11-3-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR

I LIKE 

WRITING POEMS

UPON YOUR BREASTS

THEN EATING

MY WORDS.

 

 

 

(picture-poem order No. 709)

* # 1-14-96 HACKHAM SA COPYRIGHT TERRELL NEUAGE

ICE-CREAM LIKE WALLS

MELTING

IN THE HEAT

BETWEEN OUR LIPS
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TOGETHER.

 

 

 

 

(picture-poem order No. 710)

* # 1-14-96

IN TOMORROW'S

UNPREDICTABLRE FUTRUE

I DON'T KNOW

WHAT I WILL FEEL

OR WHAT TO DO

WITH THAT I FEEL

BUT IN THIS FAST PASSING

FLEETING SECOND

IN THIS TWINKLE OF AN EYE

IN CRATIN'S IMMEASRUABLE

SHORETNED BREATH

I KNOW

I WILL LOVE YOU FOREVER.
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3-22-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

I ONCE LAUGHED WITH YOU LONG AGO

BEFORE AMBITION BECAME YOUR POSTIION

WE HAD THE WORLD ON A STRING

FLYING SO HIGH

WE ROLLED AND LAUGHED

DANCED THE TIMES AWAY

THE WORLD KEPT ON SPINNING ON ITS STRINGS

FASTER FASTER FASTER

IT ALL WENT AROUND

'GRAP HOLD OF SOMETHING ELSE'

YOU SA COPYRIGHT TERRELL NEUAGEID

SO I TOOK A HOLD OF YOU

YOU LET GO OF THE STRING TIED TO YOU

THE WORLD GOT AWAY AND YOU FELL THROUGH 

A CANYON IN THE MIDST OF THE UNIVERSE

YOUR LIFE SLIPPED FROM ME

I HAD TO LET GO
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I SA COPYRIGHT TERRELL NEUAGEW THE CANYON

I'VE KNOW THAT DISTANCE

AND I FOUND THE WAY BACK AND HOW TO LET GO OF YOU

I'VE LOST THE DISTANCE

I WAS SORRY TO SEE YOU GO

AND I STILL LOOK INTO SPACE EVERY ONCE IN AWHILE

AND THERE YOUR ARE FLYING

HANDS OUT STRETCHED TRYING TO GRAB HOLD OF THE STRING

THAT HOLDS THE WORLD SO FAR FROM YOU.

 

 

4-80 COLORADO

I ONCE THREW SNOW AT YOU

YOU CHANGED INTO WINE

THAT LIGHTENED MY SOUL

YHOU CHANGED THE WINE

TO TASTE LIKE YOUR HEART

AND I BECAEM INTOXICATED.

 

 

http://neuage.indiko.com/collection3.htm (164 of 271) [3/8/08 2:55:09 PM]



collection3

 

(picture-poem order No. 164)

* # 7-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

 

I ONCE 

WANTED TO BE

WHEREVER YOU WERE

UNTIL 

I SA COPYRIGHT TERRELL NEUAGEW 

YOU WITHOUT ME

SO FAR AWAY

AND LONG AGO

THEN I DECIDED

I DID NOT WANT TO BE THERE

YOU AND ME

TOGEHTER

WITHOUT ME.

 

 

 

4-29-80 BOLINIS CALIFORNIA
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I ONCE WAS FREE

I ONCE HAD ME

I ONCE CONCEIVED

WHAT I BELIEVED

TOOK A RIGHT

TOOK A LEFT

TOOK A BITE

OF WHAT WAS LEFT

SOME TRAINS PASS

SOME TRAINS STOP

BUT I'M AT A STATION

WHERE NOTHING PASSES AT ALL.
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3-18-80 NEW YORK COPYRIGHT TERRELL NEUAGE CITY

LESIA

I SA COPYRIGHT TERRELL NEUAGET DOWN

TO WRITE OUT

ALL MY THOUGHTS

AND FEELINGS 

FOR YOU

AND THE PAGES

WERE BLANK

WHEN I STARTED

AND AGAIN

WHEN I FINISHED.

 

 

 

 

7-20-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

I SA COPYRIGHT TERRELL NEUAGEW ALL THOSE EXPERIENCES

WE HAD TOGETHER

FLY OFF
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TO THE EDGE OF OUR GALAXY TO WAIT FOR US

TO HAVE THEM AGAIN

ONCE THE ONE

WE ARE HAVING NOW

IS OVER.

 

 

5-23-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

I SEE LIFE AHEAD

MADE UP OF

MY CRATIVE ATTITUDES

YIN AND YANG

BLENDED IN A SUM TOTAL

OF ALL I HAVE EVER BEEN

SURROUNDED BY

THE HEART OF EXPERIENCE

I FEEL FREE

KNOWING MY DESTINY

WILL BE COMPOSED

IN RHYTHM
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TO MY IMAGINATION

 

 

 

2-04-78 BALTIMORE COPYRIGHT TERRELL NEUAGE

I SEE THE CITY TURNING ON HER LIGHTS

FAR OFF IN THE DISTANCE

I HEAR HER SONGS DANCE FAR OVER THE PRARIES

I HEAR HER PROMISES

THAT HAVE NO MOUNTAINS TO ECHO OFF OF

BUT JUST KEEP ON TRAVELING

THROUGH THE PRARIES

THROUGH TOWNS

THROUGH MY NIGHT

MAYBE IT IS THAT THE CITIES

LIGHTS

SONGS 

PROMISES

ARE ONLY FOR THE CLOUDS

TO CATCH

http://neuage.indiko.com/collection3.htm (169 of 271) [3/8/08 2:55:09 PM]



collection3

BECAUSE NEVER ON ME

HAVE THEY SETTLED.

 

 

 

 

 

 

5-07-72 ALONG A HIGHWAY IN TEXA

 

I SEE YOUR SMILE

RIDING THE WAVES

ACROSS

THE PACIFIC

LIKE I DO YOU

AS DREAMS

DISA COPYRIGHT TERRELL NEUAGEPPEAR

UPON 

CRASHING SHORES.
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6-28-80 KANEOHE HAWAII

I SEE YOU SOMEWHERE IN MY MIND

TRAVELLING ALONE

IN A WORLD

THAT YOU THOUGHT WAS CROWDED

I SEE YOU

AN IMAGE STANDING

AT A MILLION CROSSROADS

WHEN YHOU BELIEVED 

THERE WAS BUT ONE

AND I HEAR YOU CALLING FOR YESTERDAY

TO START

OVER AGAIN

SOMETIME TOMORROW SOON.

 

 

7-07-72 LAST CHANCE COLORADO

I SENSE THE COLD

IT FORMS GOOSE BUMPS ON MY THOUGHTS
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AND IN TRAPS AND WEBS MY MIND IS CAUGHT

BY SPECTERS I'VE CREATED

AND RELATED

TO 

THROUGH

CHANGES

RANGES

OVER 

CLOVER

AND FIELDS SO WIDE

THAT I'VE NEVER TRIED

BUT THE FUTRUE

LIKE COLD AND GOOSE BUMPS

IS SO APPARAENTLY

ALWAYS APPROACHING

SO QUICKLY

THAT I WONDER

IF I WILL HAVE RESOURCES ENOUGH

TO FUEL

THE FIRES

http://neuage.indiko.com/collection3.htm (172 of 271) [3/8/08 2:55:09 PM]



collection3

WE

SO APTLY

CALL OUR OWN.

 

 

9-24-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 

 
I SHARED MY WHOLE LIFE WITH YOU

EVERY THOUGHT

SECRET

DESIRE

DREAM

WISH

I SHOWED 

TOLD

GAVE

TO YOU

YOU SA COPYRIGHT TERRELL NEUAGEID

'OH! O.K.'

THEN PUT IT ALL 

OUT IN THE NEIGHBOR'S SHED
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AND GAVE THE KEY

TO

A ONE-NIGHT-STAND

LEAVING ME EMPTY

AND SOMEONE ELSE

FILLED

WITH MY EVERY

THOUGHT

SECRET

DESIRE

DREAM

SA COPYRIGHT TERRELL NEUAGENDWICH

AND WISH.

 

 

9-13-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

I SIT AMONGST MY MEMORIES

ROOMS FULL OF YOU

THE DAY WE MET

THE DAY WE LOVED

THE DAY WE LOST
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THE DAY I WROTE THIS

THE DAY THE WORLD

ROLLS UP

USING

MY ROOM OF MEMORIES

AS STICKY AIRPLANES

SENDING ITSELF OFF INTO

GALAXIES OF TIME

LEAVING ME

(LEAVING)

 

9-15-86 MT. COMPASS COPYRIGHT TERRELL NEUAGE

IN SO FEEW WORDS

I SA COPYRIGHT TERRELL NEUAGEID WHAT I FELT

THAT IT WILL TAKE UNTIL

NO MORE MORNINGS COME

TO EXPLAIN IT.
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(picture-poem order No. 215)

** # @ 2-07-93 copyright Terrell Neuage EAST END MARKET ADELAIDE

I READ THROUGH

THE THESA COPYRIGHT TERRELL NEUAGEURAUS

GREEK AND ROMAN MYTHS

POETS AND SONGS

TO FIND THE BEST WAY

TO DESCRIBE YOU

BUT IT WAS MY YOUNGEST CHILD

WHO GAVE ME 

THE PERFECT WORD

TO DESCRIBE YOU WHEN HE DESCRIBED HIS

LATEST BRIGHTEST COLOURED PLASTIC TOY

TOO
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WOW!

 

2-22-93 copyright Terrell Neuage 110 VICTOR COPYRIGHT TERRELL NEUAGEIA 
STREET VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT TERRELL 
NEUAGE

I SA COPYRIGHT TERRELL NEUAGEW

HOW THIS MORNING

SWEPT AWAY YESTERDAY

TO SHINE ANEW

LIKE I DO

EACH MOMENT

I AWAKE

(WITH [IN] YOU)

 

 

(picture-poem order No. 216)

* # 5-23-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR SA COPYRIGHT TERRELL NEUAGE

FLAPPING 

BLOWING

CRYING

IN THE WIND
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FAR AWAY FROM WHERE I SHOULD BE

LIKE

ANY TREE ATOP A MOUNTAIN ALONE

WOULD

TOO.

 

 

 

1-02-94 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

 

 

I SPENT SO MUCH TIME

SEEING WHAT NEEDS

TO BE DONE

IN WHAT I FIGURE

THERE IS LEFT

YET

TO BE

THAT EVERYTHING

GETS LOST IN PEACE
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WITHOUT 

PUZZLE.

 

 

 

8-13-75 SYRACUSE NEW YORK COPYRIGHT TERRELL NEUAGE

 

I STEPPED OUT OF WHO I WAS

WHILE IN THE MIDST

OF A THOUGHT OF YOU

IN THE SPACE

BETWEEN MOMENTS

IN THE VOID

BETWEEN THOUGHTS

OF YOUR LARGE BREASTS

I MERGED WITH YOU.

 

 

 

3-08-89 PT. ELLIOT
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I STORED AWAY MY THOUGHTS OF YOU

WAITING FOR SPRING

WHERE I WOULD FIND YOU IN 

WADED WATERS OF

WARMLY WASHED WISHES

WHISPERING WEALTHY WOVEN

WHOLEHEARTED WOOING WONDERLANDS

WITH 

WE.

 

 

 

9-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

I SURE WAS A FOOL

CHASING AFTER YOU

THINKING YOU THOUGHT LIKE ME

BUT I WAS OUT TO SEA

FLOATING FAR FROM SHORE

WANTING YOU MORE
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I SENT YOU POEMS

EVEN ASKED YOU HOME

SMILED WHEN YOU WALKED BY

YOU KICKED ME IN MY THIGH

I WAS HAPPY FOR AMY TOUCH

SO YOU KICKED ME AGAIN

AND LEFT ME HURTING

LIEK THE FOOL I WAS.

 

 

11-09-91 110 VICTOR COPYRIGHT TERRELL NEUAGEIA STREET VICTOR 
COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT TERRELL NEUAGE

OT ALL SO SEEMS SO DIFFERENT

ONCE WE DISCOVER

THAT HALF OF THE WORLD

JUST PARTIES ALL THE TIME

AND THE OTHER HALF

(OUR HALF)

NOT ONLY SETS

UP FOR THERI PARTY
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BUT PAYS FOR IT

AND CLEANS UP TOO.

 

 

5-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

IT IS EASIER

TO REINVENT OURSELVES

BECAME PART OF THE CROWD

DEVELOP PACK MENTALITY

SWIM WITH THE CURRENT

EXERCISE EAT TOFU

BECOME AN INVESTIGATIVE REPORTED

CHANT TM CRAP

BE A JUNGIAN PSYCHOLOGIST AT THE LOCAL ZOO

THAN IT IS 

TO HOIST THE FLAG

SOUND THE SA COPYRIGHT TERRELL NEUAGELUTE

FIRE THE CANNONS

TO LET EVERYONE SEE WE ACCEPT

THE FUNNY WAY WE ARE

LIVING IN OUR IGLOOS
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BELIEVING IN OURSELVES

BUT THEN

(IF WE DIN REINVBENT OURSELF)

WE WOULD NEVER HAVE A CHANCE TO GET INTO THE MUSEUM

OF WEIRD EARTHLINGS

FROM THE 20TH CENNTURY

WOULD WE?

2-23-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

I THOUGHT I HAD CONTROL

OF MY LIFE 

FREEWILL

FILLED THE PALMS OF MY HAND 

I WANTED YOU

SO I MEDITATED

PRAYED

SA COPYRIGHT TERRELL NEUAGEW US TOGETEHR

WHEN I WAS WELL PREPARED

I TOOK MY HANDS FULL OF FREEWILL

AND POSTIIVE RESOURCEFULLNESS
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TO YOUR DOOR

BUT YOUR SHOWED ME

YOUR FREE WILL

BE CLOSING IT

AND LVOING SOMEONE 

ELSE.

 

8-18-89 PT. ELLIOT

I THOUGHT I WAS IN LOVE

BUT HTEN THE BREWERY

CLOSED FOR THE WINTER

AND I FOUND

IT

EMPTY.

 

3-31-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

I THOUGHT OF EVERY LINE

I COULD SA COPYRIGHT TERRELL NEUAGEY TO YOU

TO MAKE ME SOUND

LIKE THE PERSON YOU

WOULD LIEK TO KNOW
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WORE CLOTHES TO SUIT

MY PERCEPTIONS OF YOU

LOOKED IMPORTANT

BUT CASUAL TOO

TOUGH IN A SENSTITIVE AND ELEGANT WAY

SERIOUS IN MY HUMOR

I TRIED TO STEP

OUT OF A MAGZINE

THAT FINE WOMEN

OFTEN READ

I TRIED IT ALLAND WETN UNNOTICED

SO I WENT BACK 

TO BEING THE PERFECT MAN

THAT 

I HAVE ALWAYS BEEN.

 

4-07-90 MIDDLETON

I THOUGHT NATURE

WAS BLUSHING

FROM LISTENING TO ME
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SPEAK ABOUT YHOU 

BUT IT WAS DAWN

THAT WAS MAKING NATURE COME

WITH SUCH COLOUR

NOT MY DESCRIPTION OF YOU.

 

 

 

 

(picture-poem order No. 165)

* # 12-02-83 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT 
TERRELL NEUAGE

I THOUGHT THAT WE HAD BECOME

SEPARATED ONE

FROM

ANOTHER

UNTIL I SA COPYRIGHT TERRELL NEUAGEW YOU

THAT YOU HAD GONE ON AHEAD

TO OPEN THE DOOR FOR ME

SO I COULD FIND THE WAY

TO WARMTH

http://neuage.indiko.com/collection3.htm (186 of 271) [3/8/08 2:55:09 PM]



collection3

ONCE THE SNOW

BEGAN TO COVER

THE TRACKS OF OUR LOVE

AND I WATCHED THE DOOR

OPEN SLOWLY

MELTING THE PATH

SHINNING OVER 

WHERE OUR STEPS

ONCE LAY

AND WHERE THEY HAD YET TO GROW

AND WE WATCHED THE SUN

REACH OUT IN 

MELTING LOVE

IN THE BIRTH

OF A SONG

THAT WAS TO CARRY

US

BEYOND EVERY MEASURE

THAT WE COULD NOTE.
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5-01-74 SA COPYRIGHT TERRELL NEUAGEN FRANCISCO COPYRIGHT TERRELL 
NEUAGE

IT IS BETTER

TO SEEK AGREEMENT WITH OURSELVES

THAN SOLICIT IT FROM SOMEONE ELSE

DON'T YOU AGREE?

 

 

 

(picture-poem order No. 227)

* @ 4-20-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE 
HARBOR SA COPYRIGHT TERRELL NEUAGE

IT MUST BE MY LUCKY DAY

WEHN I WOKE THIS MORNING

I WAS 42

WHEN I WENT TO LUNCH WITH MY NEW SECRETARY

I WAS 35

AFTER GIN AND TONICS AT THE DISCO

I WAS 21

WHEN I TOOK HER HOME

I WAS 18.

http://neuage.indiko.com/collection3.htm (188 of 271) [3/8/08 2:55:09 PM]



collection3

 

 

 

 

10-18-83 ADELAIDE SA COPYRIGHT TERRELL NEUAGE

I TOOK ALL THE MISTAKES

EVER I MADE

AND LINES THEM UP

THEY REACHED TO THE MOON

AND NOW I WILL WALK ON THEM

AND BRING BACK SOME

GREEN CHEESE AND MARKET IT

BEFORE ANYONE ELSE

GETS THE CHANCE.

 

 

6-17-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

I TOUCHED THE TREES

WHEN I FLEW FREE
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AND I SIPPED THE VALLEY WINES BEFORE I WAS KING

KNOWING THAT NOT ANYONE RALLY KNEW A THING

I'VE PEED WHERE THE SA COPYRIGHT TERRELL NEUAGEINTS ONCE WALKED

AND PRAYED WHEN THE JUNKIES TALKED

BUT NO ONE KNOWS

WHY WE MUCT GO

I'VE LOVED A MILLION WOMEN

THAT NEVER COULD QUTIE STAND STILL

THEY THOUGHT I WAS A SHADOW A SPARK IN THE NIGHT

LIKE A SKY OF CLOUDS WISHING TO SHARE RAYS OF LIGHT

HANGING BY ROPE

TO SOME STAR'S HOPE.

 

3-78 TOWNSON MARYLAND COPYRIGHT TERRELL NEUAGE

I TOUCHED TOMORROW

AND SHE WAS

A SMILE

AT THE END

OF A RAINBOW

I REACHED FOR THE MANY MORE AFTERS

BUT HTE DARKNESS HID THE RAINBOWS
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AND DRIED UP THE RAIN

AT THE TIP

OF SUN'S RAYS

FINGERS

I TOUCHED YOU

AND THERE WAS LAUGHTER

IN ROLLIN--FOREVERS.

 

 

 

5-13-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

IT TOOK ME AWHILE TO REALIZE

MORNING CONTINUED TO RETUREN

SHINNING BEFORE MY EVERY AFTER

LAUGHING AFTER MY EVERY BEFORE

BRINGING LOVE SOFTEN FRAGRANCE

TAKING SHADOWS PACKAGED SORROWS

IT TOOK ME AWHILE TO REALIZE

THAT YOU WERE NOT MY TOMORROW.
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6-09-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

 

IT TOOK ME FORTY-TWO YEARS

TO CATCH UP

TO YOUR TWENTY-SI YEARS

OF REFINED BEAUTY.

 

 

 

 

 

 

(picture-poem order No. 218)

* # 3-29-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

PEGGY

 

I TOUCH THE AIR

THINKING YOU ARE THERE

MY HAND PASSES THROUGH TIME
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LIKE A CHILD'S NURSERY RHYME

THE AIR IS SOFT TO MY TOUCH

REMINDNG ME THAT I MISS YOU MUCH

I FEEL YOU LAUGH

LIKE A WARM BUBBLE BATH

I SIT IN THE MIDST OF SPACE

THERE SEEMS TO BE A TRACE

OF YOU WEHREVER I GO

YOU GOT TO KNOW

I MISS YOU SO.

 

 

 

10-10-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 

I TRAVELLED SO FAR TO GET TO YOU

THAT I HAD TO CALL THE AIR FORCE

TO RESCUE ME

FROM THE CLOUDS

THE COAST GUARD TO SA COPYRIGHT TERRELL NEUAGEVE ME

OUT AT SEA

A TRACKER
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TO FIND ME IN THE DESERT

A PSYCHIC REGRESSING TYPE OF PERSON TO GET ME BACK INTO THIS LIFE

PSYCHOLOGISTS WHO REMINDED ME I WAS STILL LOST

BUT FINALLY I FOUND THE KEY AND MAP TO YO

ON THE BADK OF THE MAP TO ME

NOW WE ARE LOST TOGETHER

WITHOUT THOUGHT

OF OUR DESERT ISLAND

IN THE CLOUD

FAR OUT TO SEA

LAST LIFE.

 

5-25-93 copyright Terrell Neuage VICTOR COPYRIGHT TERRELL NEUAGE HARBOR 
SA COPYRIGHT TERRELL NEUAGE

I TRIED TO UNDERSTAND US

WE WENT AROUND

IN CIRCLES

TRYING TO GET CLOSE

I STUDIED HISTORY

PHILOSOPHY PSYCHOLOGY RELIGION
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AND YOU

NOTHING SEEMED

TO BE CLEAR

EXCEPT THE CRICLES

WE ROLLED

BUT NEVER LEARNED

WE ROLLED

BUT NEVER UNDERSTOOD

WE ROLLED

BUT NEVER GOT CLOSE

BECAUSE WE ROLLED IN OPPOSITE DIRECTIONS.

 

8-17-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

IT'S NOT ENTERING AN EMPTY ROOM

EACH NIGHT

THAT IS SO LONELY

BUT LEAVING IT

TO GO OUT

INTO AN EMPTY WORLD

THE FOLLOWING MORNING

THAT IS SO ALONE.
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5-23-73 NEW ORELANS

YOU AND I

TWO STARS

WITHOUT

A NIGHT TO SHINE THORUGH

OR A SKY TO BE IN

TONIGHT

AGAIN.

 

 

 

5-02-80 CALIFORNIA

IT'S O.K.

THIS TREE I LEAN ON

REALLY KIND OF LIKE IT EVEN

BUT TO THINK

THAT OFF IN THE DISTANCE

OF SOMEONE
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ELSE'S VISION

I'M JUST A BUMP

ON A LOG

MAKES ME WISH

I WAS COURTING

A GALAXY

IN HEAVEN

INSTEAD OF

THE END OF

SOMEONE ELSE'S

HORIZON.

 

7-24-75 LAKE SKANEATELES NEW YORK COPYRIGHT TERRELL NEUAGE 

I TURN AROUND QUITE CONSTATNLY

NO ONE HAS QUITE SEEN THE SA COPYRIGHT TERRELL NEUAGEME

MY FEELINGS ARE ALL DRAWN IN PENCIL

AND ERASED BY THE RAIN

SOMEDAYS I TRY TO BE THE SA COPYRIGHT TERRELL NEUAGEME

BUT THEN EVERYONE ELSE TURNS AROUND

SOMETIMES I WAVE IN FRONT OF A MIRROR
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MAKING BELIEVE THAT THERE IS A CROWD THERE

OTHER DAYS I AVOID MIRRORS BELIEVING

THAT I AM PART OF THE CROWD

AND THE CROWDS TURN AROUND

QUITE CONSTATNLY.

 

3-74 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

IT WOULD BE BETTER

IF LIFE HAD

NO MEANING 
BUT I BELIEVED THAT IT HAD

THAN FOR LIFE TO HAVE MEANIGN

AND I DON'T.

 

 

(picture-poem order No. 219)

* @ 6 - 90 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT 
TERRELL NEUAGE

ABSTRACTION'S

FRACTIONS

DIVIDING EACH OF US

LIKE
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SO MANY

SCHOOL CHILDREN'S

PIES.

 

(picture-poem order No. 170)

* @ 6-25-78 WASHINGTON D.C.

ABSOLUTES

SA COPYRIGHT TERRELL NEUAGELUTES

TO THE MANY

DREAMS

WHO

VISITED

NIGHT AFTER NIGHT

TAKING AWAY 

REALISM'S DAY

MAY TONIGHT

TAKE ME INTO

MY LOVER'S DREAMS

TOO

WHERE WE WILL JOIN IN FLIGHT
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BEYOND EVENING'S

ABSOLUTE SA COPYRIGHT TERRELL NEUAGELUTES.

 

 

3-04-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

A CHILD'S ROCKET SHIP

A FATHER'S LIGHTENING'S IMAGE

A SPACE AGE FANTASY

TO BE A CLOUD

MAKING LOVE

WITH A BOLD OF LIGHTENING

BUT WE DON'T KNOW

WHAT WE CAN BE

SO IF IT'S

ALL

THE SA COPYRIGHT TERRELL NEUAGEME

MAY I BE DIFFERENT

JUST TO RIDE LIKE

WHERE I HAVE NEVER BEEN

PERHAPS JUST TO MAKE
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SOME SENSE

IN AN ADULT'S

CHILDHOOD

BEFORE I AM

PUT OUT TO PASTURE.

 

5-14-75 SA COPYRIGHT TERRELL NEUAGEN FRANCISCO COPYRIGHT TERRELL 
NEUAGE 

AGAIN TO LET GO

WHAT I THOUGHT

THAT I BROUGHT

INTO THIS LIFE'S SHOW T

A U R 

SILENCE OF N E

AWAY FROM CITY STREETS R

SOCIAL NESCIENT TREATS E

TAKE ME BACK TO HER H

T

ALWAYS TO E

G

DIFFERENT VIEWS
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COLOURED HUES

LOVE IN THE HEATHER

 

MEMORIES ARE REAL

THEY CAN DANCE EVEN SPEAK

YOU I NO LONGER SEEK

YOU I ALWAYS FEEL YOU

 

LIFE I THOUGHT TOOK YOU

LEFT ME HERE

LOST IN FEAR

NOW YOU'RE IN MY VIEW

WE'RE BORN WITH IT ALL

NOTHING NEW

ALWAYS YOU

YOU'RE THERE WHEN I CALL

AGAIN TO LET GO

INTO THIS LIFE'S SHOW.
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3-04-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

ALL IS FINE

ALL IS PERFECTLY

ALL IS HERE

WAITING TO SHARE

WITH A LADY

WHO IS FINE

WHO IS PERFECT

WHO IS HERE.

 

 

3-25-90 10.20 AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

ALL THE PEOPLE

WATCHED

ONE ANOTHER

THINKING

THEY WERE

THE LEADERS

EVERYONE ELSE

THE FOLLOWERS

BUT
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I JUST WATCHED

MYSELF

THEN ALL THE PEOPLE

BEGAN TO GIGGLE

SO I FOLLOWED

AND GIGGLED

TOO.

 

8-08-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

ALL BEGINNINGS CHANGE

INTO ALL COMPLETIONS

THE FIRST STEP

IS EITHER OUT THE DOOR

AND OVER THE CLIFF

OR NO WHERE

IN PARTICULAR

OR ON TO

THE NEXT

NEXT STEP

WHICH IS THE FIRST STEP
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ON THE WAY

TO COMPLETION

BUT WE'LL NEVER KNOW

UNTIL LIFE IS OVER

THEN IT'S TOO LATE

TO QUESTION

EACH STEP

ON WHETHER IT'S THE FIRST

ALONG THE WAY

TO SOME PLACE IN PARTICULAR

OR JUST A WANDER DOWN

A DEAD END PATH.

 

3-24-90 12.30 AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

ALL THE LOVERS

I'VE EVER KNOWN

WERE JUST

PRACTICE 

TRAINING

LESSONS
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ON THE WAY TO YOU.

 

 

(picture-poem order No.236)

* 3-29-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

ALONG THE BAY

IN A WIND

I WANDER

THROUGH MY MIND

LIKE CHILDREN

RIDE 

THE FUTURE.

 

 

 

2-24-78 BALTIMORE COPYRIGHT TERRELL NEUAGE MARYLAND COPYRIGHT 
TERRELL NEUAGE

A LONG WAYS AGO

WHEN I WROTE YOU

SO MANY POEMS

IN HOPES TO CATCH A MOMENT'S
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GLIMPSE OF YOUR AFFECTIONS

TUMBLING ALONG ON THE SA COPYRIGHT TERRELL NEUAGEME FOOTPATH AS 
ME

I SA COPYRIGHT TERRELL NEUAGEW THE ROAD AHEAD THAT WE HAD 
STARTED ON 

TOGETHER

BUT THE ROAD I SA COPYRIGHT TERRELL NEUAGEW

WAS JUST THE HIGHWAY WE WERE DRIVING UPON

I DIDN'T LOOK AT 

THIS ROAD THROUGH YOUR LIFE

BUT THE ROADS

HAVE SOME SIMILARITIES

THE LONG 

S T R E TCH ES

THROUGH THE IOWA CORN FIELD

A LOT LIKE WHEN WE SETTLED IN

TO

LIFE TOGETHER

FOR A FEW DAYS

THE BRIGHT LIGHTS OF CITIES LIKE THE ENTHUSIASMS

WE HAVE AT TIMES
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OF WHAT WE THINK WE'LL ACCOMPLISH

IN VARIOUS MOMENTS OF GRANDEUR THE TIME YOU BROKE YOUR SHOE

IN CHICAGO

AND HAD TO HOP ON ONE FOOT

BACK TO THE CAR AND THE TIMES WE BREAK

EACH OTHER'S ....OH NEVER MIND

HOBBLING THROUGH THE DAY WAS THE NEXT LINE

UNTIL WE GET MENDED AGAIN

BOY THIS SUCKS

SOME DAYS IT'S LIKE BEING IN NORTH ENGLISH

THAT'S SOME TOWN I DON'T REMEMBER THAT I MUST HAVE BEEN IN ONCE

SOMETIMES LIKE THE DESSERTS THE OCEAN'S EVENINGS

BOY THAT'S A DUMB LINE ISN'T IT? SWALLOWING THE SUN

LETTING LOOSE THE STARS

GOOD GOLLY DID i USE TO BE THAT MUDDLED? BUT ALWAYS 

I REMEMBER THE SIGNS OF

SOME UNFINISHED FREEWAY

PROCLAIMING THAT THE ROAD

WAS NOT YET COMPLETED AND I THINK OF US

CATCHING GLIMPSES

OF ONE ANOTHER'S BEAUTY
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ALONG OUR UNFINISHED ROAD... NOW I SEE CLEARLY WHY I'M DIVORCED.

1-06-82 ADELAIDE (COMMENTS ADDED 2-01-96)

ALWAYS WANTED TO LIVE

IN A LIGHTHOUSE

TO GUIDE THE SHIPS

IN THEIR STORM

LIKE JESUS DOES

WITH US

BUT IT'S ONLY NEAR

WHERE I AM AT.

 

 

8-07-71 MONTAUK POINT LONG ISLAND NEW YORK COPYRIGHT TERRELL 
NEUAGE

AMAZED 

BY YOUR LOVE

GLAZED 

IN YOUR TOUCH

FOUND IN

YOUR HEART
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THOUSA COPYRIGHT TERRELL NEUAGENDS

OF MILES AWAY.

 

3-22-80 WALPAHU OAHU HAWAII

AMBITION IS SUCH A TOOL

WHAT CAN WE DO

BUT WRING OURSELVES DRY

TRY NOT TO DIE

HEAVEN IS A WASTED DREAM

NOT WHAT IT SEEMS

WE FALL ASLEEP IN OUR LAST STRETCH

THINKING TIME IS BUT A BREATH

OF HOT AIR

FOR WHO CARES

TO TIE THE SKY

AND DIE IT RED

THANK YOU AMERICA

FOR ALLOWING ME TO DIE

IN SUCH A BEAUTIFUL

ILLUSION.

10-31-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 
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AND ALL THE HORSES 

BROKE

FROM THEIR CORRAL

BECAUSE

THEY REMEMBERED

THAT ONCE 

THEY WERE FREE

(TOO).

 

 

(picture-poem order No.171)

* @ 4-09-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE USA 
COPYRIGHT TERRELL NEUAGE

AND I SA COPYRIGHT TERRELL NEUAGEW THE PEOPLE 

MERGE TOGETHER TODAY

IT WAS NOT A CLEAR VISION

THERE WAS ONLY A BLUR

SHAPED AS THE FUTURE

LIKE LOVERS

NEVER MEANT.
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4-04-77 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

AND WHEN

TIME

PUTS ITSELF

ON TRIAL

THE UNIVERSE

GOES OUT

AND

LOOKS

FOR

A 

NEW

JUDGE.

 

 

2-24-74 NEW ORLEANS COPYRIGHT TERRELL NEUAGE 

ANOTHER MOMENT

CAME AND GONE
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LIKE DREAMS

ON PARADE

AND BELIEFS AND MEANINGS

AND PURPOSE WITH OUT DIRECTION

SOME EXPERIENCES

ARE THE HARVEST

OTHERS THE SEEDING

INHALING THE FUTURE

EXHALING THE PAST

TO AND FRO

LEFT AND RIGHT

WE ARE ALL 

THE MOMENTS PUPPETS

ANOTHER MOMENT

COME AND GONE.

 

8-89 MT. COMPASS COPYRIGHT TERRELL NEUAGE

ANOTHER

WINDOW

ANOTHER

http://neuage.indiko.com/collection3.htm (213 of 271) [3/8/08 2:55:09 PM]



collection3

DOOR

ANOTHER

VISION VISITED VERSION

OF

ANY

BELIEF

LIKE

A

DREAM

COME

TRUE

AND I SA COPYRIGHT TERRELL NEUAGEW

THE WAY THROUGH

IN ANOTHER

DOOR

ANOTHER

WINDOW.

2-01-80 HONOLULU HAWAII

 

AREN'T WE ALL
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LIKE A PINBALL MACHINE

BELIEVING

THAT WE ARE A HELPLESS

BALL OF SILVER

BEING BOUNCED

FROM BUMPER TO BUMPER

NOT REALIZING

THAT THE BALL 

IS JUST OUR CHANGES

RINGING BELLS WHEN WE'RE SCORING

TILTING AT TOO MUCH FORCE

AND GIVING FREE GAMES

WHEN WE'RE RIGHT ENOUGH

TO PLAY AGAIN.

 

11-09-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 

ARE WE ANSWERING OUR OWN NEEDS

OR ARE WE JUST ACTING OUT

A PERVERTED GOD'S

EVERY DESIRE.

 

http://neuage.indiko.com/collection3.htm (215 of 271) [3/8/08 2:55:09 PM]



collection3

 

 

3-05-80 3.30 PM LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

AT NOWHERE'S END

I WATCHED YESTERDAY FADE

INTO SOME OTHER TIME

YOU WERE IN

MY TYPICAL DREAM STATE

ALWAYS SO CLOSE

UNTIL I AWOKE

LIKE WHAT I IMAGINED

FLOATING FOREIGN'S FEELINGS

WOULD BE

IN SOME

FAR FLUNG'S FUTURE

CAPTURED INNOCENCE

SLEEPING PEACEFULLY

AT NOWHERE'S END

WITH YOU AND NOT ME

LIKE WHAT I IMAGINED
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FLOATING

FOREIGN'S

FEELINGS

WOULD BE IN SOME

FAR

FLUNG

FUTURE'S

CAPTURED INNOCENCE.

8-20-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

AT WHAT POINT 

DID I REALIZE

I WOULD SEE YOU AGAIN

BECOMES CONFUSED

SOMEWHERE BETWEEN REALITY

AND

SELF-REALIZED GARNETS OF ROMANTIC MYTH

AND

WHICH REALITY TO BELIEVE

IN WHAT MODE

OF TIME SLOTTED
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INCOHERENCY

AND ALL THE HEROES

LOSE THEMSELVES

SOMEWHERE

BETWEEN

THE END

AND THE BEGINNING

OF THIS STATEMENT.

4-03-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

AWAKE!

LOOKING AT YOU LOOKING AT ME

WHAT DO YOU SEE

HOW LONG HAVE YOU BEEN 

WATCHING ME

DID I SNORE TALK IN MY SLEEP

MAYBE EVEN WHISPER YOUR NAME

OR EVEN 

GOD I HOPE NOT

SOMEONE ELSE'S

DID I TOSS AND TURN APPEAR YOUNG

OLD GENTLE TOUGH
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HAPPY WANTING FULL

YOU DIDN'T SMILE

WHEN I OPENED MY EYES TO SEE YOU LOOKING AT ME

YOU JUST LAY THERE

LOOKING AT ME

NOW 

INTO MY NIGHT FILLED EYES

WHAT DO I DO

TOUCH YOU TELL A JOKE SA COPYRIGHT TERRELL NEUAGEY 'GOOD MORNING'

'AM I LATE FOR WORK'

HOW DO I RESPOND TO TEARFUL EYES

THAT WATCHED ME

EMERGE FROM DREAM INTO DAWN?

2-04-78 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

 

AT THE RECITAL

EVERYONE APPLAUDED

AND I LOOKED AROUND

TO SEE NO ONE AT ALL

FILLING THE MEZZANINE
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SETTING METRONOMES

TO A MOVEMENT OF YOUR HEART

SA COPYRIGHT TERRELL NEUAGEYING A DUET FEELS SO WARM

(SO)

WON'T YOU JOIN ME

AGAIN

FOR THE CURTAIN

IS ABOUT TO RISE

AND THE APPLAUSE

IS FROM A WORLD

WANTING

TO HEAR 

SOMETHING WARM.

8-12-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 

AWAKE AGAIN

LIKE LAST NIGHT'S

DREAM

REALLY DIDN'T HAPPEN

AND I STEP OUT

ONTO THE FLOOR
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ONLY TO FALL THROUGH

THE DOWNSTAIRS CEILINGS

INTO

SOMEONE ELSE'S DREAM

OF ME BEING PREGNANT AGAIN.

 

2-25-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

BACK IN THE WHIRL OF IT ALL

SEEMS LIKE THE BIG RUSH

TO ILLUSORY SOMEWHERE

IS CLOGGING

THE ARTERIES OF LIFE

WITH POCKETS OF HOPE

AND DAMAGED HEARTS

AND SO THE WORLD

DRIVES AWAY

IN TWIRLING DRESSES

AND BULGING PANTS

WAITING FOR HANDS

THAT WILL 

SA COPYRIGHT TERRELL NEUAGEVE THEM
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FROM THE BIG CRUSH

RUSH.

7-01-78 BALTIMORE COPYRIGHT TERRELL NEUAGE MARYLAND COPYRIGHT 
TERRELL NEUAGE 

BEFORE LONG

ALL THE PERCEPTIONS

WE HAVE 

WILL BE SO DIFFERENT 

THAN THEY ARE NOW

WE 

WON'T 

WE 

WILL

WE 

WHAT?

 

 

BACK THEN SOMEPLACE

BELIEVING OVERSHADOWS WHAT WE

BELIEVE IN
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THE ONLY WAY TO BELIEVE IS

TO LET GO

AND I HEAR DANIEL SHUDDER AT THE CONCEPT

BELIEFS AND TRUST ARE BASTARD CHILDREN

I KNOW I WAS

OF DREAM'S MEMORIES

I BELIEVED IN YOU

AND OPENED UP

YOU BECAME MY BELIEFS I WORSHIP MY PERCEPTIONS OF YOU EVERY 

MOMENT WAS IS WILL BE YOU

BUT YOU DIDN'T BELIEVE

WHAT I BELIEVED WAS THE WAY

YOU REALLY WERE

YOU SMILED AND WALKED AWAY I REALIZED I WAS WRONG

AND BELIEVED IN A BIRD IN FLIGHT

BECAUSE

IT DOESN'T MATTER WHAT 

WE BELIEVE AS 

LONG AS WE

DO

AND FLY AWAY
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BEFORE.

4-22-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

BELLS AND HORNS

SHIPS IN SONG

ON THE RIVER

RED AND GREEN

FLASH THEIR COLOURS

IN CHRISTMAS TREE WAY

PEOPLE RUNNING

SINGING AND DANCING

IN FLOWING WINE OF DAWN

WHERE IS YOUR PORT

WHAT IS YOUR CARGO

IS THERE STILL ROOM?

WE ALONE TOGETHER ON THIS WARF

WITHOUT YOUR SONG

BELLS AND HORNS

LEAVING

ALONE

IN EARLY MORNING.
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9-65 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

BETWEEN EVENING'S BREATH

AND MORNING'S MOIST MIST

WE DANCED

YOU TOOK ME IN MELTED RIVERS

RUSHING SPRING

WE DANCED IN SPACE

AND SIGHED THROUGH TIME

WE ROLLED ACROSS A DREAM

DAWN LIFTED US

REVEALING OUR NAKEDNESS

IN BURNED WAITINGS

OF A SUFFERING HEART

TIME STEALS AWAY

PURE BORN MEMORIES

IN WINGED FLIGHT

OF WORSHIPPED TOUCHES

I TRY TO CREATE AN OLD CREATION

TO RESUSCITATE MY REMINISCE

AND ERASE THE PRESENT
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FOLDING TIME BACK OVER ITSELF

TO

BEING TOGETHER AGAIN

CONSTANTLY

BETWEEN EVENING BREATH

AND MORNING'S MOIST MIST.

4-08-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

BETWEEN SHEETS

MORNING WARMED

BY THOUGHTS OF YOU

I LAY IN THE STILLNESS

THAT YOU AND I

ONCE SHARED

THAT YOU AND I

SA COPYRIGHT TERRELL NEUAGEID WAS FOREVER

AND FOREVER IT SHALL BE

THAT OUR LOVE WILL GROW

IN THE MEMORIES

OF THE WARM STILLNESS

THAT WE ONCE KNEW

YOU AND I
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TWO THOUGHT PATTERNS

LAUGHING THROUGH ETERNITY

IN WARMNESS.

9-26-72 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

BETWEEN

THE CURDS

AND THE WHEY

LIFE SPITS OUT

FEIGNED EXISTENCE

AND THUS

TOFU IS

FORMED.

 

10-18-83 ADELAIDE SA COPYRIGHT TERRELL NEUAGE

BEYOND

NORMAL THOUGHT

THERE ARE NO LOSSES

AND FOR 

FREEDOMS

FLIGHT
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ALL

IS

GIVEN.

 

2-09-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

BLOWING BREEZES

PASSING MEMORIES

MORNING SCENT

SENT ALL EVENING

A BLAZE

IN THOUGHTS OF YOUR TOUCH

BREEZES

BLOWING

CLEARING THE AIR

MAKING ROOM

FOR YOU AND I 

TO LET LOOSE IN

ROLLED TOUCH FLOWN FREE

BLOWING BREEZES

SWEPT BACK
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CURTAINS OF TIME

DESIRE HAS NO BOUNDARIES

BUT FULFILLMENT DOES\

WHEN IT IS OF MORNING SCENT

AND YOU.

2-15-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

BOARD

LOOKING FOR WONDERLAND

IN A DESERT

EXCITED

FINDING PEACE

IN CELEBRATION

CHANGING

SA COPYRIGHT TERRELL NEUAGEMENESS

WHOSE IN CONTROL

WE WILL NEVER KNOW

BUT WE PRETEND

WE HAVE IT ALL COVERED

DREAM UMBRELLAS

BLOCKING OUT REALITY

AS WE LOOK FOR
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A WONDERLAND

OUTSIDE

AND FIND A DESERT

ON THE INSIDE.

 

 

 

3-26-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

CASUALTY

OF DREAMS

LEFT ME AWAKE

WHILE 

REALITY

PUT ME TO SLEEP

AND THE SPACE

BETWEEN

IS WHERE 

PEOPLE WATCH ME

ACT OUT MY LIFE.
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8-13-89 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

CEILING IS MOST FALLING IN

AND THE WALLS

HAVE THEY EVER BEEN PAINTED

THE STAIRCASE MIGHT NOT HOLD US AGAIN

AND THERE'S NO HOT HOT WATER

BUT THE COLD BATH WOKE US UP

IN TIME TO LOVE AGAIN

AND THE FLOOR HELD US BOTH

THROUGH ANOTHER NIGHT OF JOY

DON'T MATTER IF THE STAIRCASE

DOESN'T HOLD US

OR IF ALL THE PLASTER

FALLS FROM THE CEILING

AND WE'RE THE UNPAINTED WALLS

IN OUR CASTLE

IN THE MIND THAT TOLD US

WE COULD LOVE FOREVER

AS LONG AS WE

DON'T EVER GO
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DOWN THE STAIRCASE.

5-17-73 NEW ORLEANS COPYRIGHT TERRELL NEUAGE

CHANGING POINTS

DISMISSED PLANS

BURIED IN THE SA COPYRIGHT TERRELL NEUAGENDS

WHICH WAY TO GO?

TO FOLLOW THE HEART

TO FOLLOW THE MIND

TO FOLLOW THE SOUL

CHANGING POINTS

WHAT'S LEFT TO FIND

FULL BOXES OF MEMORIES

EMPTY BOXES OF MEMORIES

EMPTY BOXES OF FUTURES

FILLING AND EMPTYING

OPENING AND SHUTTING

START ME OUT

I WILL TRY AGAIN

IN CHANGING POINTS

OF FUTURE PASS

AGAIN TODAY
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I SHALL BE.

12-26-86/APRIL 23, 89 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

CLOSER TO YOU

EACH MOMENT

YOU'RE AWAY

MERGING IN MIND

WITH YOUR THOUGHTS

THINK OF ME

AND I WILL BE THERE

DREAM OF ME

AND I WILL BE WITH YOU

CALL ME IN THE NIGHT

AND I WILL BE WITH YOU

IN THE DAWN.

 

 

4-05-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

MY THOUGHTS

ALL OF YOU

CIRCLING
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CONSTANTLY

AFRAID TO LAND

IN YOUR PEACEFUL WORLD

SO ALWAYS 

ME

YOU SEE

HIGH 

IN FLIGHT

SLIGHTLY TO THE NORTH

OF ALL YOUR THINKING.
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3-25-90 8 AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

WRAP ME

IN YOUR DREAMS

AND BURN AWAY

LONELINESS

THAT I KNOW

WHEN WITH YOU I'M NOT.
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(picture-poem order No. 237)

* # 4-04-90 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

COUNTED WAYS

LEFT UNNUMBERED

BRINGS ME

ALONE

WHEN YOU

COULD HAVE

NUMBERED WITH ME

COUNTED WAYS

I HAD YOU

COUNTED WAYS

I WANTED YOU

COUNTED WAYS 

YOU HAD ME

COUNTED WAYS

YOU DIDN'T WANT ME

LEFT UNNUMBERED

IN TIMES
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THAT NEVER

HAPPENED.

 

 

 

 

3-07-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

COUNTRY LADY IN A WINDOWED FOREST

YOU MAKE LOOKING INTO THE MORNING

FEEL

AND I SA COPYRIGHT TERRELL NEUAGEW THIS MORNING

RUN THROUGH OUR TREES

KISSING EACH NIGHT AWAY

LIKE YOU DO

IN THIS

WINDOWED

FOREST.

 

 

7-19-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 
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DANCING IN THE NIGHT

IN THE DAY IN THE STREET

THROUGH YOUR DREAMS

DANCING TO WHAT YOU SA COPYRIGHT TERRELL NEUAGEY

TAKE ME AWAY TOO

I WANT TO GO THROUGH

THIS LONELY NIGHT WITH YOU

LET GO NOTHING MATTERS

ALL THE PAST IS GONE

SWALLOWED BY ANOTHER DAWN

THERE ARE NO MISTAKES IN LOVE

JUST ACCIDENTS

KICK AWAY LAWS AND PRIDE

AND RIDE SOFTLY UPON ME

LIFE IS SHORT LOVE SO LONG

IN FREEDOM NOTHING IS WRONG

DANCING IN NIGHT

DANCING IN DAY

DANCING TO WHAT I THINK YOU SA COPYRIGHT TERRELL NEUAGEY

HERE IN MY DREAMS.
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3-22-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

DAY AFTER DAY I TRY

TO THINK OF THE 

BEST IDEAS

BIG ONES

LITTLE ONES

ONES THAT ARE GOOD BETTER

OR BEST

BUT NO IDEAS COME

JUST LINES OF WORDS

AND MORE THIN AIR

WHAT WE SEE NOW NO

ONE ELSE EVER

HAS OR EVER

WILL

BUT WE PRETEND EVERYONE

KNOWS AND 

ALWAYS HAS

AND WE ARE WRAPPED 

IN DISSOLVABLE DREAMS
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FOR

HISTORY TO FIND

BUT NEVER IT WILL.

9-16-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

DIFFERENT THOUGHTS CREATED 

IN SOME PAST CHANGES CLOUDED

MY VIEWS OF YOU

UNTIL THIS MOMENT CHASED 

AWAY MEMORIES

THAT HAD CHALLENGED MY 

FREEDOM TO FLY WITH YOU AND

NOW MY THOUGHTS TOO 

SLEEPY TO FIGHT

WITH OLD FEARS EMERGE

INTO FEELINGS OF LOVE

LIKE I DO WITH

YOU EACH TIME YOU

ENTER MY

MIND.
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4-02-80 3.40 AM TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 

DREAMS OUR

ONLY BRIDGE BETWEEN

SOMEWHERE ELSE AND 

NOWHERE'S END

AT THE EDGE OF NOW.

 

 

 

 

 

 

 

 

(picture-poem order No. 238)

* @ 8-20-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

drained walking in the rain

drained walking in the sun

EVERYTHING I HAVE EVER BEEN

CAME THROUGH THE PORES OF MY SKIN

AND I WATCHED LIFE WALK THROUGH MY FEET
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SLIPPING OUT THROUGH THE TEETH

OF THE ZIPPERS OF MY BOOTS

DANCING ON TOP OF THE TOES OF MY FEET

AND LAUGHINGLY NIPPING

AT MY HEELS TELLING ME 

TO START MOVING ON AHEAD

TO STEP OUT OF MY BOOTS 

THAT HOLDS THE PAST SO WELL

AND TO MOVE OUT

PAST MY MIND 

PAST THE RAIN

AND INTO THE SUN.

 

 

 

5-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 

DRAWN CONCLUSIONS

LEFT ME SO I 

SWAM OUT TO SEA

TO FIND THE CENTRE
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OF ME LOST IN

TWILIGHT

OUT OF SIGHT WHOSE

TO KNOW

FINAL SHOW

I ASK AND 

DON'T RECEIVE

NO ONE WROTE MY SCRIPT

I AM JUST FREELANCING

AS I GO 

AFTER THE SHOW

SO YOU KNOW

DRAWN CONCLUSIONS

THAT LEFT ME

WITHOUT 

A FINAL PICTURE.

3-27-89 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

DEEP WITHIN

BEYOND WHERE

RAINBOWS FORM
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AND QUESTS 

HAVE NO NAME

CELLS

OF TOMORROW MERGE

WITH THOUGHTS

OF TODAY

DEEP WITHIN

SETTLED SCENES 

HAVE NO PATHS

IN OR OUT

BUT WHERE WE BEGIN

IS OUR LIFE'S SUM

AS CHILDREN OF DREAMS

LIFE ON EARTH

THIS MOMENT'S BIRTH

COLOURED IN TUNE 

TO EACH FIRST THOUGHT

DEEP WITHIN.

 

2-19-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

DREAMS
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I SHOULD HAVE HAD LONG AGO

I AWOKE IN TODAY

FEELING POSSIBILITIES

THAT

WERE NEVER FEELABLE BEFORE

COOL RAINY MORNING

WARM LOVING WOMAN

FIRES OF NATURE

DREAMING BRIGHT

BRINGING ME TO

CENTRES SO REAL

I NEVER COULD HAVE

DREAMT THEM BEFORE.

11-10-81 6.20 AM ADELAIDE SA COPYRIGHT TERRELL NEUAGE

DOWN THE STAIRS OUT THE DOOR

TAKE MY LOVE FOREVER MORE

TELL ME I'M MEAN SA COPYRIGHT TERRELL NEUAGEY I'M BAD

YELL I WAS THE WORSE YOU EVER HAD

THROW A ROCK AT MY WINDOW GLASS

SA COPYRIGHT TERRELL NEUAGEY A PRAYER AT MORNING MASS
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LIGHT A CANDLE WISH ME TROUBLE

SEE MY WORLD LEFT IN RUBBLE

TELL ME HOW I MADE YOUR LIFE HARD

WHEN I ASK FOR MY CREDIT CARDS

SA COPYRIGHT TERRELL NEUAGEY I WAS A GAMBLE A VERY BAD DEPT

LEAVING ME COLD LEAVING ME HOT

LEAVING ME WITHOUT A RHYME

IN MY EVERY FINAL SENTENCE.

 

2-23-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

DREAMS LIKE STORMS

ARE BUT RIDES 

OF ROMANTIC ADVENTURE

LIKE YOU AND I 

AND ALL

THE PASSING

MOMENTS TOO.

 

8-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 

DREAMS OF GREENER PASTURE
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MAKES THE WAKING MOMENTS

MORE SLEEPY

LIKE WHEN WE BELIEVED

THAT DREAMS COME TRUE.

 

 

 

 

 

 

4-80 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

EACH AGE LIVES AND DIES

ON A CREATOR'S WHIM

POINTED FINGER CHANGING CYCLES

ICE AGES FLICK ON AND OFF

LIKE TELEVISION SOAP OPERAS

TO THE DISTANT SOUNDS

OF EXPLODING AEONS

WE ARE PART OF CONDENSED TIME

BLACK HOLES OF EXPERIENCES

IN ACCELERATED EVOLUTION
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WE ARE MUTATIONS OF CREATION

CHROMOSOME EXPERIMENTS

TRYING TO EXPLAIN WHERE WE WERE

AN HOUR BEFORE THE BIG BANG

AND HOW WE WILL PAY THE ELECTRICITY BILL

NEXT WEEK

SOME BILLION YEARS AFTER

SPACE WAS FILLED WITH ENERGY

AND WE WERE GIVEN

PHILOSOPHICAL PRECEPTS

TO EXPLAIN WHY WE

ARE HERE

AN HOUR AFTER

THE HOUR BEFORE

THE BIG BANG.

 

1-25-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

BLONDIE

EACH DAY BRINGS YOU LIKE A SHADOW 

DANCING IN THE EARLY MORNING FOG
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BUT THE SUN RISES FOG FLEES TO THE SEAS

SHADOWS WANDER OFF

WHILE I CARESS THAT WHICH ISN'T THERE

STORMS THESE DAYS

IN THEIR RAPID SUCCESSIONS MEAN LITTLE

FOR I REALIZE THAT THERE IS MUCH TO DO

TO PREPARE CASTLED FREEDOMS

FOR YOU TO BE WITH MI IN

BUT YOU ARE NO WHERE TO BE FOUND

LOVE IN GERMANY SORROW IN BOSTON

LAUGHTER FLIES YOUR SOUL

I LONG TO TOUCH TO PUSH YOU INTO A SNOW BANK OF CHANGE

AND TO WATCH THE WARMTH OF ME IN YOUR LOVE

MELT EACH PATTERNED FLAKE

LIKE YOU MELTED MY BEING

IN THE MIDST OF YOU

WHEN YOU TIPTOED

THROUGH A MOMENT

SMILING ON ME.

11-77 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 
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EACH ENTRANCE

SEEMS 

SO FUTURELESS

BEFORE 

EMERGENCE.

 

 

 

 

 

 

 

 

 

7-79 TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE

EARLY MORNING

CLEAR OF MIND

LIKE AT BIRTH

YESTERDAY

STARTING OFF ANEW

BEFORE CLUTTERS

http://neuage.indiko.com/collection3.htm (250 of 271) [3/8/08 2:55:09 PM]



collection3

OF IMAGES

CLOG UP MENTAL CIRCUITS

TRAFFIC JAMS 

IN RUSH HOURS

THOUGHTS VIA

FOR

CONTROL SMOG CLOUDS

THE HEAD CROWDS OF

REASONS 

GO BERSERK AS ONCE

CLEAR OF 

MIND BECOMES HOSTS

TO WANDERING PARASITES OF

OTHER'S THOUGHTS.

 

2-27-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

EMPTY PAGES

VIRGIN WANTS

FRESHLY PAINTED IDEAS

IN SCENTED HOPE THAT
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YOU WILL 

WALK OUT OF 

MY WISHES

AND INTO

MY WAKING

DAY.

 

 

 

 

3-25-90 10.30 AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

EVEN LAYING STILL I FEEL YOU PULSE THROUGH

MY LIFE

LIKE A STREAM

THROUGH THE MOUNTAINS 

THROUGH MY HEART

THROUGH THE BEST OF YOU

GLOWING IN MOVEMENT 

TO MY THOUGHTS

AND I SA COPYRIGHT TERRELL NEUAGEW
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THE CHILDREN PLAYING SYMPHONIES

IN THEIR FIRST DAYS TOGETHER

LIKE WE DO 

EACH TIME

WE TOUCH.

 

 

 

9-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE 

 

EVERY MOVE WE

MAKE

IS CONDITIONED BY EVERY THOUGHT

WE HAVE 

EVERY THOUGHT WE HAVE

IS INFLUENCED

BY OUR SUBCONSCIOUS

EVERY SUBCONSCIOUS URGING

IS PROMPTED BY

SOCIETIES PASSING WHIMS

EVERY SOCIAL PASSING FANCY
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IS QUALIFIED BY

THE COLLECTIVE UNCONSCIOUS

OF EVERY HUMAN THOUGHT

EVERY THOUGHT

SINCE HUMANS

WERE GIVEN THOUGHTS

TO THINK 

AND THE FIRST THOUGHT

WAS EVE LOOKING IN A MIRROR AND SEEING ADAM

AND SA COPYRIGHT TERRELL NEUAGEYING

'OH SHIT 

WHAT HAVE I DONE

NOW'
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3-24-90 12.30 AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

LEFT AS

EVOLUTION'S BRIDE

NAKED

AT THE ALTER.

 

 

 

 

 

4-05-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

EVERYONE IS NORMAL

BECAUSE WE ARE EACH

AT WHERE WE ARE SUPPOSE TO BE

ACCORDING TO OUR POINT OF EVOLUTION

BUT SOME OF US

HAVE LEARNED

TO MAKE 

OTHERS BELIEVE

THAT THEY
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AREN'T

AS SPECIAL

AS WE

ARE

SNEAKY 

BASTARDS.

HUH?

 

 

 

 

 

 

 

 

 

 

2-21-80 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

EVERYONES GONE TO THE PARTY

DRESSED UP TO DANCE THE NIGHT

AWAY
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ANTICIPATION OF SA COPYRIGHT TERRELL NEUAGETISFIED NEEDS

FILLS THE AIR

THE MOMENT IS WRAPPED

IN SENSUALITY

ALL IS FORGOTTEN

AND PUT AWAY

TO BE REMEMBERED

IN OLD AGE

I REMEMBER THE PARTIES

RIPENED YOUTH

IN THE SPRING OF DESIRE

BURNING THROUGH EVENING'S FIRE

WHERE EVERYTHING IS FORGOTTEN

UNTIL TWENTY YEARS LATER

WHEN DESIRE BURNS HOLES

THROUGH MY MEMORIES.

 

8-14-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

EVERYTHING I EVER WANTED

FOUND AND LOST
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IN YOUR EYES

NOW 

I AM FOREVER MORE

PROFOUNDLY

LOST.

 

 

 

 

4-19-90 MIDDLETON SA COPYRIGHT TERRELL NEUAGE

EVERY THOUGHT WAS LIKE

A LAST MOMENT TO

ME I WAS AT A 

PINNACLE IN MY

DREAMS WHEN ALL

I FELT WAS

DESPAIR EVERYWHERE I

TURNED ALL THERE

WAS WAS

MORE OF ME UNTIL YOU
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SA COPYRIGHT TERRELL NEUAGENG YOUR 

SONG AND I 

FORGOT ABOUT

ME THE HAZE WAS 

REMOVED EVERY CLOUD

VANISHED THERE WAS NOTHING

BUT DAWN IN MY EVERY CORNER I LISTENED

TO CREATION WHO 

TOLD ME THAT EACH

PERSON HAD THEIR OWN

MESSIAH SO I UPED AND

WALKED AWAY KNOWING THAT

FOR EVERY DANCE THERE WAS 

A SONG LIKE WHEN I WAS FREE

ENOUGH TO TELL YOU HOW 

YOU ONCE HEALED ME AND OPENED A 

DOOR INTO THE DAWN.

THANK YOU.

10-24-79 2.20 PM BALTIMORE COPYRIGHT TERRELL NEUAGE

EXPRESSIONS OF LOST BELIEFS

SOUNDING 
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THE SA COPYRIGHT TERRELL NEUAGEME OVER

AND OVER UNTIL

NO ONE NO

LONGER WOULD

LISTEN BECAUSE

EVERYTHING I DID

SOUNDED THE

SA COPYRIGHT TERRELL NEUAGEME.

 

 

3-25-90 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT 
TERRELL NEUAGE

FALLING BLINDLY AFTER YOU

CAN'T SEEM TO GET ANYWHERE

I LOOKED FOR YOU IN AUCKLAND

TRIED LOS ANGLES AND HONOLULU

TOO

FELL DOWN SUBWAY STEPS IN NEW YORK COPYRIGHT TERRELL NEUAGE CITY

CHASED YOU THROUGH SYDNEY AIRPORT

WHEN I WAS A STREET ARTIST IN NEW ORLEANS COPYRIGHT TERRELL 
NEUAGE
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I WROTE YOU A POEM IN THE SKY

YOU ALWAYS DID FLY SO HIGH

I WANTED YOU WHEN THE SNOW FELL IN CHEYENNE

I CROSSED THE GOLDEN GATE BRIDGE TO GET TO YOU

I GOT A TASTE OF YOU IN THE CITY

FELL ASLEEP ON YOUR BREASTS IN THE COUNTRY

WE CAAAAAAAAAAAAAAAAAAAAAAAAAME IN MY AUTOMOBILE

WE CAAAAAAAAAAAAAAAAAAAAAAAAAAAAAME IN MY DREAMS

WE CAAAAAAAAAAAAAAAAAAAAAAAME ON A MOUNTAIN SIDE

ALONG THE SEA

IN CENTRAL PARK TOO

BUT HERE I AM AGAIN 

FALLING FORWARD

WONDERING IF ANOTHER LADY

WAITS AHEAD

FOR ME TO FALL BLINDLY

AFTER

HER

AGAIN.

3-13-80 7.05 PM NEW YORK COPYRIGHT TERRELL NEUAGE CITY
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FENCED IN LOVE

WE COULDN'T GO PAST

WHAT WE COULD NOT UNDERSTAND

WE REACHED OUT

TIME HAD NO DIMENSION

SKY ABOVE

BEYOND

OUR REACH

LIKE OUR LOVE

BEAUTIFUL TO BEHOLD

IMPOSSIBLE TO TOUCH

NOW MEMORY

THE FENCE

WE CAN'T GO BEYOND

TO LOVE AGAIN.

2-23-90 MIDDLETON SOUTH AUSTRALIA

FIRM TOFU

HAS MORE PROTEIN

AND SO DO I

WHEN THAT WAY

I AM
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TOO.

 

 

10-18-83 ADELAIDE SA COPYRIGHT TERRELL NEUAGE

FENCED IN 

RUN AWAY

IMAGINATION

PACKED

IN A SUIT CASE

FREIGHTER CARGO

SHIPPED TO

DREAM DESTINATIONS

FOR A HOLIDAY

WHILE I STAY

BEHIND

ABSTRACTING

REALITY

FOR A

PROCESSED WORLD.
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3-25-90 8AM MIDDLETON SA COPYRIGHT TERRELL NEUAGE

FLOATING

SO MANY FEELINGS

LIKE LILIES ON A POND

AND I SA COPYRIGHT TERRELL NEUAGEW A FROG

JUMP ONTO THE BIGGEST

LILY

AND

RIDE AWAY

BELIEVING

FEELINGS

WERE PRINCESSES

THAT 

NEEDED TO BE KISSED

TOO

TO

BECOME NEW

LILIES

WOULD YOU SHARE A LILY WITH ME.

 

http://neuage.indiko.com/collection3.htm (264 of 271) [3/8/08 2:55:09 PM]



collection3

8-05-78 LUTHERVILLE MARYLAND COPYRIGHT TERRELL NEUAGE

FLOWERS AND DREAMS

KISSES AND SMILES

LOST IN WISHES

OF WINGS

FLOWN FREE

EVERY THOUGHT

EVER CAUGHT

TURNS INTO

BUTTERFLIES

WHEN THINKING IS GOOD

LIKE FLOWERS AND DREAMS

KISSES AND SMILES

THAT ONE LOST

UPON WINGS

FLOWN FREE.

 

6-02-80 HONOLULU 

FLUNG FAR YOUTH

IN

BURNING DESIRE FOR EXPERIENCE
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TASTING TOUCHING

DIVING IN

ETERNITY IS JUST A BREATH AWAY

BUT WHOSE TO TELL

RIPEN FRUIT

BEFORE THE HARVEST

WAS JESUS EVER AN ADOLESCENT

DID BUDDHA EVER TO GO A TEENAGE PARTY

DID MOHAMMAND GET A FIT OF GIGGLES

LINE UP THE SA COPYRIGHT TERRELL NEUAGEINTS

LINE UP TEENAGERS

THEN TELL ME

WHO KNOWS OF LIFE

MOST.

4-29-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

FRAGILE 

AGILE

CHANGES I HAVE KNOWN

I AM WATCHING

YOU BLOSSOM

http://neuage.indiko.com/collection3.htm (266 of 271) [3/8/08 2:55:10 PM]



collection3

SUCH A WOMAN

YOU HAVE CHANGED MY LIFE SO

AND I SEE THE IMPOSSIBILITIES

AHEAD

BUT I WILL ALWAYS

KNOW THAT 

I'VE MET

THE LADY OF

MY CHOICE

IF CHOICES

WERE MINE

TO HAVE.

4-09-80 7.45 AM BALTIMORE COPYRIGHT TERRELL NEUAGE MARYLAND 
COPYRIGHT TERRELL NEUAGE

FOR ENJOYMENT'S SA COPYRIGHT TERRELL NEUAGEKE

I AM A FAKE

BUT SERIOUS NOTHINGS

TO ME IS SOMETHING

FOREVER WON AND LOST

THE FUN OF COSTS

I WILL NEVER AFFORD
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THE LUST OF THE BOARD

I WILL NEVER KNOW

WILD OATS UNSEWED

VIRGIN BIRTH

OF PREGNANT EARTH

STRANGE AND BOLD

LEFT ME COLD

WITH YOU 

AGAIN.

7-27-89 PT. ELLIOT SA COPYRIGHT TERRELL NEUAGE

FOREST TREES DON'T GO TO THE CITIES

AND CROWD THE PEOPLE

THEY CAN ONLY STAY IN ONE PLACE

WISHING THEY COULD CRY OUT LOUD

"HEY I'M HERE TOO

I'M HERE TO DANCE

I'M HERE TO SING

WE CAN NOT LEAVE

TO SA COPYRIGHT TERRELL NEUAGEVE OUR LIMBS

FROM ALL YOUR FIRES
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WE CAN ONLY STAY

AND KNOW OF GOD

WON'T YOU STAY

AND KNOW OF HIM TOO"?

7-01-72 STRAWBERRY LAKE COLORADO

FOREVER

TO BE SIMPLE AS YESTERDAY

WHEN TOUCH

HAD NO EXPLANATION

KISS 

NO INTERPRETATION

AND LOVE

NO RATIONALIZATION.

 

* @ 3-04-90 VICTOR COPYRIGHT TERRELL NEUAGE HARBOR SA COPYRIGHT 
TERRELL NEUAGE

FOR EVERY FINE DAY

I HAVE KNOWN

I HAVE LOVED 

YOU MORE

AND I SA COPYRIGHT TERRELL NEUAGEW LIFE
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HAPPY IN YOUR EYES

LAUGH LIKE TOMORROW

WAS A PRESENT

WITH BOWS AND

RIBBONS WAITING

FOR YOU

TO OPEN IT UP WOULD

YOU MIND

IF I HELPED WITH

THE RIBBONS.

4-06-80 3.25 AM TOWSON MARYLAND COPYRIGHT TERRELL NEUAGE 
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Leigh Neuage (July 6 1983 - August 16 2003) 
 

 
 

It was Friday afternoon.

The last day of school, before the first day of the holidays.
 
Leigh McGee tried to walk into his room.  He couldn’t get very far.  
There was no room to move.  He tossed his school books onto a very 
high pile of something somewhere in the middle of the room and 
walked away.
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It was summer.  Leigh put his bathers on and threw his school clothes 
into his room. They landed somewhere in the midst of another pile of 
something or other.
 
What Leigh McGee did not know, probably because he didn’t look 
around his room, except to follow a thin cleared path to his bed, was 
that his room was more than just a place where he threw his things.  
 
It was a home.  A home for a hairy-nosed wombat.

   
 illustraton - Aida Pottinger 3-2001

 
The wombat had made a complex tunnel system in Leigh McGee’ s 
room.
 
Its burrow was in the middle of a large pile of clothes in the corner of 
Leigh’s room at the foot of the bed.  The main tunnel from the 

http://neuage.indiko.com/wombat.htm (2 of 13) [3/8/08 2:56:04 PM]



The strange world of Leigh McGee is about a wombat in adelaide south australia written by terrell adsit-neuage

wombat’s home followed the walls around the room. It wandered 
beneath the full length of the bed, behind an antique 18th century 
cupboard, past the overflowing clothing hamper, past the desk – then 
stopped.  At the end of the tunnel the wombat would peek about to see 
that the coast
was clear, then hop up to Leigh’s desk to the window. Leigh had left the 
window open the summer before and because it got stuck he never 
bothered to close it again.
 
Leigh’s desk had a huge pile of things on it.  Papers, books, toys, some 
baseballs, a football, basket ball and a computer that had yet to be 
used, as well as food, clothing, dreams and wishes.
 
The only clearing in Leigh’s room was a narrow path to his bed.
 
Leigh McGee’s dad used to help him clean his room.  Actually his dad 
did the cleaning by himself in the  “old” days while the kids were at 
school.  But since he had started writing his latest novel, he just didn’t 
get to Leigh’s room any more. Leigh’s dad worked in his office writing.  
He would get so involved with writing that he would forget to do the 
things he used to do.  He would leave his desk only to make something 
to eat for the children when he remembered.  Once a week or every 
other week, whenever he remembered, he would go into town and 
purchase groceries, do laundry or buy clothes because the children 
could not find their school uniforms or socks.
 
The children didn’t mind. They knew it was just a phase. Though they 
thought it was a very strange phase.  His other novels had sold well, so 
there was money enough to  live on.  It was easier to give the children 
money to go and buy a new track-suit or sneakers, then it was to take 
the time to try and find the lost sneaker, or the other odd sock, or a 
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favourite jumper.  It was often easier to order pizza or Chinese take 
away than to make a meal. As their father often said. ‘We are flying on 
automatic at the moment.’  The kids understood.
 
The childrens’ parents had once lived together in the city. When their 
dad wanted to
move into their seaside holiday home after the separation, to write his 
novel, the children went with him. They liked the seashore and they 
liked going to school in the small nearby town.  Mom liked the city.  
The noise, the activities, art galleries and museums.  The children liked 
the country.  They wanted to play outside, something they didn’t feel 
free to do in the city.  Most of all they wanted their parents to live 
together and they knew that some day, someway, they would succeed.
 
 
Their mother was an artist and like their dad with his writing, she 
would get so involved with a painting that she would forget everything 
for days, sometimes weeks
and months.
 
It was the novel that Leigh’s dad was writing that was so strange.  Its 
title was, “The
Yellow-bellied Sheath-tailed bat that scared Ned Kelly at Stringbark 
Creek in the Wombat Ranges and the ecological effects on the world if 
it becomes extinct”
 
 
The children tried to tell their dad that the title was too long, and would 
anyone really buy it when it was finished?  He didn’t pay any attention 
though.  To him it was going to be a masterpiece.  Maybe even a major 
movie.  At least, it would become a four part television series.
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After three novels that were easy to write “They just came off the top of 
me head their dad had said” “The Yellow-bellied Sheath-tailed bat that 
scared Ned Kelly at Stringbark Creek in the Wombat Ranges and the 
ecological effects on the world if it becomes extinct.” was the first story 
that he had to do research on.  His office was almost as bad as Leigh 
McGee’s room.  Tables were filled with books and papers.
 
And there was always the lights on, music, television and even singing 
and laughing.
And there were several paths to the desk. No hairy-nosed wombat 
would settle in his
office.
 
Of course no one knew what was going on in Leigh’s room.  It was too 
much of a mess to go inside.  Both children slept in their father’s office.  
The children liked to be near their dad and since he would sit typing 
until the middle of the night they would bring their sleeping bags into 
the office and sleep on the floor.  They had made areas in between 
books, papers, maps and the filing cabinets to sleep in.
 
Sometimes, actually a lot of times, when the children awoke the next 
morning, their father would be asleep at his desk.  The children didn’t 
say too much about, “ The Yellow-bellied Sheath-tailed bat that scared 
Ned Kelly at Stringbark Creek in the Wombat Ranges and the 
ecological effects on the world if it becomes extinct”.
 
 
They wished that the book would become extinct too, so that they could 
go back to living like a normal family again.  Maybe their mother 
would even come and live with them.  At other times they talked about 
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making the title into a cartoon series when they grew up.  But they 
didn’t tell their father that.  They didn’t want to hurt his feelings.
 
The hairy-nosed wombat liked her new home.  She was from the 
Nullarbor Plain and had snuck onto a truck and had ended up at a 
truck depot on the same block as Leigh McGee’s house.
 
When the wombat first walked around the block she wasn’t impressed.  
It was a lot different than the Nullarbor Plains.  She had never seen so 
many houses.  And all so
close together too. There were cats and dogs in her new 
neighbourhood.  The wombat stayed away from them. She didn’t know 
whether they would be friendly toward her or not.  She had watched a 
dog chase a cat up a tree.  It wasn’t a pretty sight.  She didn’t want to 
get involved in rough housing like that.  No way.  Leigh McGee’s house 
was near a river that flowed into the sea, so there was plenty of 
exploring to do and plenty of food left by plenty of tourists. The hairy-
nosed wombat
had a pretty good life, except that there were no other wombats around 
to play with.
 
The wombat used to go out of the open window every night and walk 
over to the truck depot that she had arrived at.  She hoped another 
wombat would arrive at the
truck depot like she had. She had discovered the open window a year 
ago when a dog had spotted her and began to give chase.  She quickly 
looked for a place to hide and that is when she spotted the open window 
to Leigh McGee’s room.
 
She had been hungry too.  She found a lot of food in the room.  There 
were a lot of  new things to try.  There was a half eaten peanut butter 
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and jelly sandwich next to the bed.  It was strange tasting to a wombat 
that had never had anything more than grass and shrubs and herbs 
before.
 
There were other things to eat too.  Biscuits, crackers, toast, potato 
chips, nuts and lollies.  The wombat liked to try different foods.  But 
usually she settled for the normal things growing in the front yard.  The 
family hadn’t mowed their lawn for a long time so there was tall grass 
and the shrubs were good.  And because no one in the house seemed to 
notice much of anything any more, they didn’t notice the partly eaten 
plants in the front yard.  The children would play in a nearby park 
instead of their front yard. At least the nearby park got mowed.
 
One night the wombat was in the front yard chomping on a shrub when 
she heard a commotion.  A dog was barking loudly.  The wombat sat up 
and looked over the tall grass.  Running in her direction was another 
wombat.  The two wombats spotted each other and both ran toward the 
house with the dog loudly barking after them.  The two wombats 
quickly climbed through Leigh’s open window. The visiting wombat 
had climbed aboard a road-train that had arrived at the nearby truck 
depot too.
 
The two wombats took up home in Leigh McGee’s room.  Both 
wombats made their own burrows - though they shared the tunnel to 
the window.  They explored together
and no one knew that they were in Leigh’s room.
 
During the summer more animals arrived at the truck depot.  There 
were marsupial
moles, fat-tailed dunnarts, ring-tailed possums and a wide variety of 
small animals that were looking for places to live.  Soon Leigh McGee’s 
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room was more like a zoo than a child’s bedroom.  It wasn’t possible to 
see at first glance from the doorway to Leigh’s room, all that was going 
on in the bedroom.
 
As more things were thrown into the room and the piles of clothing, 
books and whatever else Leigh didn’t know what to do with landed in 
the room, the animals inside made more and more tunnels.
 
The children’s father was finished with his current writing project. 
“The Yellow- bellied Sheath-tailed bat that scared Ned Kelly at 
Stringbark Creek in the Wombat Ranges and the ecological effects on 
the world if it becomes extinct” was over two- thousand pages not 
counting additional maps, photos, diagrams, and non-related items 
such as pictures of the kids when they were young, a trip to Paris and a 
recipe for tofu cheesecake:
 

 
 
 
Mix in 
a 
blender 
then let 
it set in 
the 
refrigerator. 
Oh! 
cover 
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with 
slices 
of 
mango 
before 
putting 
in the 
fridge.
 
 
 
 
 
He sent 

the manuscript to several book publishers.  The publishers had no idea 
what to do with “The Yellow-bellied Sheath-tailed bat that scared Ned 
Kelly at Stringbark Creek in the Wombat Ranges and the ecological 
effects on the world if it becomes extinct”. One publisher even sent a 
letter saying it was the best book - that made absolutely no sense - that 
she had ever read.
 
The children’s father didn’t understand.  To him it made perfect sense.  
If anything, he thought that maybe the book was too short.  And so was 
the title.  The title clearly had to be longer in order to explain what was 
inside.  The children worried about their father.  They tried to talk to 
their mother about him, but she was very busy painting.
 
Their mother was getting ready to do a major art show at the museum 
in the city.  The children thought her paintings were even more 
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ridiculous than their father’s books.
 
Her paintings were huge.  They didn’t look like anything that was 
describable.  The
closest the children could come to describing her pictures was to say 
that they looked as if someone had poured buckets of paint on the 
canvas then rolled across it.  It was difficult for the children to believe 
that their mother actually spent months on each picture.
 
The children and their father drove to the opening of their mother’s art 
show.  It was very crowded there.  There were radio, television and 
newspaper reporters at the show.
 
After all, both parents were famous people. One for art and one for 
novels.
 
The children’s parents hadn’t seen each other for over a year and they 
were both quite nervous about seeing one another again.
 
 
Their dad brought along his finished novel and handed it to the 
children’s mother.
The children’s mother thought that the book had an excellent title and 
she sat down in the middle of the museum and began to read, “The 
Yellow-bellied Sheath-tailed bat that scared Ned Kelly at Stringbark 
Creek in the Wombat Ranges and the ecological effects on the world if 
it becomes extinct”
 
The children shook their heads and said, “ but mom, it is two-thousand 
pages long.  It will take weeks to read it”. But she wanted to read it, 
then and there. Even when the gallery was closing she was still reading.  
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She hadn’t noticed anyone else.  She just kept reading.  And every once 
in awhile she would say, “This is really good.”
 
Meanwhile the children’s father was standing in front of one of the 
huge paintings.
 
One of the ones that looked like some people had rolled across the 
canvas after spilling buckets of paint.  He stood there for hours, 
staring.  Every once in a while he would say, “This is really excellent.”   
Even when the gallery was closing, he was still standing and staring at 
the painting.
 
The children looked at each other.  They knew what to do.  They 
managed to get their mom and dad into their father’s car.  They put 
their father’s book in with their mom.
 
They talked the security guards at the museum into taking down their 
mother’s painting and had them tie it onto the top of their father’s car.
 
Their father drove to their seashore home.  All the while saying,  “I 
didn’t know your art was so wonderful.   And the mother said, “This 
book is great, I had forgotten what an imaginative writer you were.”
 
It took the children’s mother weeks to finish “ The Yellow-bellied 
Sheath-tailed bat that scared Ned Kelly at Stringbark Creek in the 
Wombat Ranges and the ecological effects on the world if it becomes 
extinct Then she wanted to read it again.  No publisher in the world 
would publish it.  But the children’s mother loved it and to them that 
was what was important. The family was back together again and they 
were all away from the city.
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The huge painting was put up in the garage.  The children said that 
they would never go into the house again if the painting was in the 
living room.  The parents were unhappy about putting it in the garage 
but they did anyway.
 
They hired a house cleaner and the family prepared to go away on 
holiday.
 
Before they left on holiday, the house cleaner came screaming out of 
Leigh’s room.  
 
The animals had been discovered.  Everyone in the family liked the 
animals so much that they fenced in the front yard and let the animals 
live there.
 
When they came back from their holiday, together, the house was 
incredibly tidy.
 
The children’s parents got jobs in a nearby town as shopkeepers.  The 
father still worked on his writing, but wrote stories for children instead 
of long novels that made no sense.  He wrote children’s stories that 
made no sense, but children loved them and they sold well.
 
Leigh’s mother took up film making in her spare time and though the 
children thought some of her movies were a bit strange, they were 
happy that she wasn’t rolling around in paint or whatever it was that 
she did to do her paintings.
 
Most of all, the family was back together again, they didn’t live in the 
city any more, and they had all the animals from the lost world in Leigh 
McGee’s room.  The animals even had a door in the fence where they 
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could go in and out whenever they wanted to.  But most of the animals 
chose to stay in the yard all the time.
 
Terrell Adsit-Neuage 1992 Victor Harbor South Australia
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tree

Once, long ago, there was a Tree that lived on the side of a great mountain, which had no other 
trees for miles around to be friends with.  it was a happy tree though, with birds that lived in nests 
upon her branches and snowflakes that spent most of the year falling into her arms.  Tree lived 
for a very long time in her solitude and peace,  Sure there were the times when she would have to 
dig her roots deep in the earth, to keep from falling by the tremendous wind storms that blew 
across the side of the mountain.  And there were the deer, that would chew at her bark.  But these 
were just part of growing up for Tree.  Life was really enjoyable.  For Tree could see a great 
distance away.  She could see the top of the mountain, where the sun rose each morning.  And she 
could see a forest of trees, that grew a great distance away. 

 Many times, the birds that nested in this great forest would fly up to Tree and tell her what was 
going on in the forest below.  In the middle of the forest, there was a small town.  It was a mill 
town and the people cut down trees; sawed them into logs and sent them floating down a river 
that bordered the outskirts of the town. 

 Tree would often spend the day watching the people cut down the trees in the forest far away; 
and she watched as they floated the newly cut logs down the river. Tree often wondered where 
they were going, if they lived forever, and what would become of them.  And so Tree  would ask 
the birds and they would go off and follow the logs on the river.  Then they would come back to 
say that, "they traveled for quite a distance, days away even.  Then the logs came to a very large 
settlement where they were herded into huge nests and never seen again."  Of course Tree  was 
disappointed.  Why, she could not even speculate on what became of them.  For they did just 
disappear.  So, she went on for many years wondering what became of the trees that the loggers 
rode on down the river, all the time feeling very safe - because she was all alone on top of the 
mountain, far from the town and its clutter. 

 
EPOCH TWO 

 The weather was in its short warm cycle of the year.  And in the town far away there was not a 
bit of snow on the ground.  There was much activity going on now, as during the warmest days 
the town did most of its work cutting down many, many trees and sawing them up and floating 
them down a river that was free of ice. 

 Tree felt very content, for she knew that today was special.  She didn't why; it was just sort of a 
feeling one gets when he knows something special is going to happen. 

Far off in the distance Tree  saw something move.  It came from an area that was not near the 
town, an area where clouds of fluffy puffy smoke came from during the cold days, in the long 
cold cycle of the year.  Tree  had seen much smoke in her days, but never any like the smoke that 
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came from this particular place.  For there were coloured rings that grew into dancing people and 
horses, and even once a large shape that looked just like Tree .  And these beautiful smoke 
images would go high into the sky, where they would join the clouds and wait until wind came 
along.  Then the clouds with the images inside would be carried off into the distance far beyond 
Tree's imagination.  As the moment's movement came closer, Tree  recognized a young man that 
often came up the mountain, he would rest under Tree  and eat some berries and mushrooms that 
grew along the way. And then climb, he would, to the top of the mountain and disappear over the 
top if it, over where the sun would rise. 

 This time the young man, dressed in his usual, very colourful manner, with his bow in his hand 
and arrows upon his back, stopped underneath the grand arms of Tree , looked to the top of the 
mountain, and then sat down.  After a long period of time, Tree  noticed another image.  This 
time, it was at the top of the mountain, and Tree watched in amazement. 

 
There was a woman who at first appeared as a cloud, a very white puffy cloud, set on top of the 
great mountains.  And as she descended down the mountainside, the cloud turned into her, the 
most beautiful human Tree  had ever seen.  She was running down the side of the mountain and it 
appeared as if she were floating.  She was barefoot, dressed in a snow white gown, that covered 
the mountain side like an avalanche, as she swept down its southern slopes. 

 In the middle of her forehead was a star that glowed in many dazzling colours.  When she 
opened her mouth to laugh, a thousand birds came forth singing, and they all flew to Tree  and 
landed in her branches singing.  They then were together, the young man and lady, sitting beneath 
Tree with a thousand birds singing and a stilled mountain that remained covered in white (but it 
was not snow as this was in the warm cycle of the seasons). 

 

Tree  did not know what to do, so she just stood there, still, feeling very chosen.  Then the young 
man took out a knife from his belt and proceeded to carve a young man with a bow in hand and 
next to him was carved a woman with a long flowing gown and a star in the middle of her 
forehead.  Tree  was surprised, for she did not feel any pain, instead she felt very warm and full 
of colour, like any chosen one would feel.  She even grew taller and rose above the clouds and on 
every branch a cloud landed with a singing bird in each one.  Then the young man took out an 
arrow and put it into his bow and looking toward the sky, he shot the arrow and it landed in the 
centre of a puffy white heart shaped cloud.  The cloud changed from one colour to another until it 
became a very bright purple, then wind came along and carried the heart, cloud, and the arrow, 
until it came to the area where Tree  had so often seen the strange shaped and brightly coloured 
rings of smoke.  The end of the day came and the sun settled in the distant lands, far beyond the 
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little towns and the rivers with its logs floating upon it. 

 The next morning Tree looked all over, but there was no sign of the young man with the bow and 
arrows or of the girl with the flowing gown and the star in the middle of her forehead.  Even the 
mountainside was the same as it was before it became covered with white.  The birds were gone, 
the clouds again were high above Tree.  But the carved heart with the young man and his bow 
standing in front of a young woman was still there and neatly engraved in the middle of Tree. 

EPOCH THREE 

It had been a very long time indeed, since Tree had seen the young man, and even longer since 
the day of Tree's great experience.  Things had changed.  The birds came, telling Tree of new 
goings-on in the town.  They came telling what happened to the logs that once were trees. After 
they arrived at the great next (birds have a habit of calling all structures nests).  It was told to 
Tree that the logs were cut into many small blocks of wood, which were then made into little 
boxes, and carved onto by the townspeople.  Then the little boxes were filled with matches and 
sent away to a very large city many distances away, for people to use.  Surrounding the town, far 
away, were fewer and fewer trees.  There were many people now, cutting many trees apparently 
(so the birds believed) because many people needed many boxes with many matches now days.  
The townspeople started spreading out looking for many trees, till the day came, when they came 
to look at Tree.  They came with their saws.  It was a very long day for Tree, but then it was also 
very short, for it was her last day that she would ever be able to remember anything.  They sawed 
and sawed until there was a great noise that shook all the land.  For Tree had fallen, and she had 
made the only sound that she had ever made.  Then away she was dragged, without celebration, 
without song, without wine.  Then on into the town where she was cut into logs, on into the river 
where she floated for many days and into the great nest were many little boxes were made. 

There was one special box, it was different from all the rest.  In the middle of it was a heart and in 
the middle of the heart there was a young man with a bow standing in front of a woman with a 
flowing gown and a star in the middle of her forehead.  But the box disappeared from the factory 
never to be seen by the people who make the boxes with the matches inside. 

EPOCH FOUR 

Inside a small house that was made of hand carved stone, lay a young man.  He was wrapped in 
several blankets that had different figures and symbols embroidered on them.  The blanket that 
was closest to his body was light blue with a yellow sun on it. Outside the cabin the wind 
howled.  Snow fell down the chimney and began to pile up on the floor.  It was very cold and the 
young man lay shivering near the fireplace that could give no heat.  On the stove was a pot of 
frozen water, and next to the stove there was a table with fruit on it, all frozen, and there was 
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some leaves from the forest that the young man often used to make tea with whenever he felt 
despondent. 

Now he just lay there.  There were no thoughts, no dreams, no one to call to - for the winter had 
come suddenly and very severely and there was no time to prepare.  He took a deep breath, rolled 
over and feel sleep.  He awoke sometime later, had some thoughts of trying to get up to go to 
town.  He sat up, only to fall unconscious upon his bed in the biting air of winter.  It was a long 
time before he woke up and when he did, he say the young woman with the star in her forehead 
standing over him with a smile that covered the whole cabin.  As the man sat up the maiden took 
out a small box that had a heart in its middle. 

Inside the box lay one match.  The woman took it out, struck it, and the fireplace caught fire and 
smoke rings of many different colours began to climb up the chimney.  Then the stove began to 
burn and the woman made a tea.  They drank together in the midst of a smoke ring that went up 
the chimney, and they disappeared with the smoke into a cloud, never to be seen again. And the 
ashes from the matchbox were carried away by wind and set on the very spot where Tree once 
grew. 

 When spring cam, there was a small seedling growing there.  When fall came it had become a 
small tree.  And year after year it grew.  In the middle of the tree was a heart with a young man in 
tis centre, holding a bow and standing in front of a woman with a flowing white gown and a star 
in the middle of her forehead. 

© Terrell Adsit (Neuage) 1974  Wichita Kansas. 
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an introduction to... CHAPTER ONE 

Children never grow old 

they just sprout wings

and fly away

"It's not all that bad - being a parent, 
actually it is really almost quite 
easily accomplished. Just put Them out in 
the garden and water Them once in awhile 
and They'll grow up just fine".

I believed that once. Don't any more.

Last night when the policeman knocked on 
the door, or did he ring our doorbell? It was 
so confusing at that moment. Two am - 
dog barking, head-butting the door. 
My girlfriend pushing me out of bed as 
she escapes under 
our sandalwoodstainedsatinsheets. 

Dreams dissolving into dissolution. My 
son says, 'I didn't do it! Sorry dad', as He 
goes off to His room followed by two 'friends' 
I have never seen before -

One of which could possibly be a 
female. Perhaps they both were.

Why is my life like this?

Back in '78 - 1978 that is. I lived with 
Lynn and her eight year old daughter. 

Lynn and I weren't really lovers. Oh, maybe on the odd occasion when snow had newly fallen fresh and 
we didn't have a date we would pretend we were each other with someone different, wanting us more than 
we really did each other, but that was not usual. All I ever wanted in life was to live in a world of usuals. I 
never have. We lived in a small house in the country not far on a clear day from Baltimore to Washington 
DC Leos, pretending we were in a mansion, or just a small weekend retreat in some foreign alps. I was kind 
of happy. Maybe Lynn was too. Her daughter was, she wasn't an adult. How could she be unhappy? Use to 
tell Lynn that some day I too would have children. I would be a single parent...the only way to pretend 
the world is different than it is is to do it alone with no one there saying it isn't. Lynn wasn't happy being 
a single parent but I would be. I had a feeling. It would be great. me and my Children. Having a wonderful 
time frolicking through life. I would live in a two-story house somewhere in New England with two children, 
a story for each child that I would change as they got older and I would write novels as snow climaxed 
outside. Somewhere this story changed when without me paying close enough attention it changed and I 
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didn't with it. Now I have been a single father living in a foreign country with no nearby alps for fifteen, 
longer than would have been if I had not done them here, years, while too poor to buy paper to write novels 
to my two Children reading them if there was snow to read them against down here in Australia.

Lynn committed suicide in 1984. Me in Australia her Maryland. Never got to tell her the joys of 
parenting single handed. Two hands tied behind my back too. Dreaming of developing my beingness in 
lightly falling snow that never here has known.

Snowfall warms the heart 

and freezes the feet

That is why we were born

with boots on.

It keeps happening. The noise and clutter. All my Son wants to do is to beautiful the neighbourhood - 
the ugliness of suburbia is just too much for him. A few cans of spray paint can do wonders for these parts. 
I decide I will learn to understand. my Children. My my my how will I ever understand? Home from 
the library. Arms full of books, articles, magazines. Graffiti. Hip-Hop.

When my son first said he was into Hip-Hop. He was eleven. Year six. We were living in Victor Harbor. 
A tourist destination when there is nowhere else to go. After fifteen years in Australia I am beginning to 
think that most of this big island is a destination. It was originally a destination for convicts...excuse me, that 
is my Americanised colonial self perceiving deceptive perceptions... of course before it was a destination it 
was home to non-convicts, the real owners of this land. Such intruders we whites were. I was a convict of 
mis-guided love, and now I am imprisoned, gently raising my children on this island floating out of 
Dreamtime. Kangaroos. They use to hop across the back of our farm when we lived in Mt. Compass 
before starting over again in Victor Harbor. We would go out to the paddock and watch our dog chase 
them. Hip-hop. Hip-hop. Sacha was not into kangaroos suddenly. It was Hip-Hop. Hip-Hop is a culture: 
rap music, graffiti, skate-boarding and anti: Anti-everything. I wanted to know more. Did my Honours 
thesis on 'Graffiti as text'. Read. Talked. Observed. Even did some myself.

my Children Graffitied

the face of time.

This is going to be longer than I had expected it would be should be could be. I started writing this in 1978 
when I didn't have children - just the imagination of how easy it would be. Having children. Well credit 
to where credit is due. Of course I wouldn't have the children like in those comedy films that come out every 
so often. Arnold what's-his-name having a baby. 

Yeah! Right! Let's be realistic. Some woman would have the baby for me. I would get her pregnant in 
the normal in the back seat of my Chevy, underneath a voyeur moon in Scorpio. A beautiful act in itself. I 
wish I was Mosses or Noah or one of those people who God told to populate the earth. Solomon. No wonder 
he was so wise. What a guy. Seven hundred wives as well as 300 concubines Why hasn't Hollywood done 
a movie on him. Speilberg's 'King Solomon' see randy Soloy seduce one-thousand pin-up broads. Nakedly. 
Then wham. Christianity comes along. Guilt. Guilt.

And more guilt. One woman. One man. Or burn in indignation.. Wow! So I wrote that first few lines at 
the beginning of this chapter long ago. Kept adding to it. Then one day I had some children. A wife. Actually 
the wife came first, then the child then I moved to this foreign shadow. The wife was foreign to begin with, 
she was just returning to her shadow with me in chains crawling behind. Suddenly, I was divorced. It was 
like having a toothache in the middle of the night and even though I pulled the tooth ou sometimes it still 
hurts. I couldn't leave the foreign shadow. My family and friends were dying one by one in America. I 
was dying one by one in Australia. I was very very poor, not very smart and losing my clinically 
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classical Neanderthal mind. I had two children - babies actually, in the year of their Lord, 1984. I had 
no friends. The wonderful South Australia Family courts said, "here, hear, have a couple kids, just don't 
leave town with them. Don't you leave either". I threw away all that I had written about the joys of 
parenting except for the first few lines. Now I will start all over again. About being a single father. Or 
single mother, grandfather, aunt, uncle, grandmother - I am them all - unto to myself, unto THEM - my 
father my dead mother, my dead brother, grandfather, aunt, uncle, grandmother. I have changed 
attitudes, switched gears, toward raising children. I hope by writing this I will realise what that 
changed attitude and in what gear it is. And my children will not be dented in their attitudes toward life 
needing perpetual undenting by future new-age therapists in the future, as they laboriously try to explain:

"Dad? Well he just kept slipping further and further away from reality. Spinningly. We tried to pull 
him back. So did his girlfriend. Then she slipped and fell too. But we were worried that we 
would become sucked into the same vortex, so we sent him to the 'Jimi Hendrix Nursing Home 
for Lost Shadows'."

Today, my son is preparing himself on the other side of me - - upThere in the sTaTes. Middle of the night 
here when I will hear, if my listeners are listening, whether he pitched the bronze medal game or 
slipped across someone's fallen karma and along with Australia came in fourth.

I often come in fourth especially when there are only two places. I create two more losing places just as a 
protest against bronze medal winning life styles.

Wouldn't you?

Hip-Hop. Graffiti. Fences. Next He will say He sprays the morning sky. "It's all Your father's fault". Lying 
is part of a post-modern continuum anyway. Creative story telling that only disintegrates if found to be 
untrue. Lying. Words tossed against the canvas of life. Some red here. Read between the red lines so well 
read. A bit of a collage there. Meaning constructed up in the middle lower. Frameless. Hang it in the museum 
of the subconscious for unconscious masturbating Freudians to sneer at. Legends. Myths. Dream Times. 
"And this mountain fell in love with this river and they had this island." "The great One took a handful of 
stars threw them at the East Wind." 'Burp!' "Jonah spent three days inside of the whale." 'Fart!' Eve 
shafted Adam. My son has painted all the suburbia trains and buses in Adelaide. "When my Children 
first came to this suburb, back in the old days...there was no visible graffiti. Then the cans appeared. 
Messages. Meanings. Graf-gods blessed the suburbs. But then the evil forces of the unhappy adult 
authorities looked upon the suburbs.

The wars began..."

I had a room in heAven once

But I left the door open

and all the bugs got in.

In my room in heAven now

the door is closed.

My room in heAven

has been given to a stranger.

One who will keep out the bugs
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I once let in.

So I tell my children

"Close the door

Keep out

the bugs"

Just in case

they ever get a room

in heAven.

 

These two girls at the door. Thirteen Fourteen. 'Is he there?' He isn't. They leave. Girls don't visit my 
children too often. My children say they'd be embarrassed to bring girls here. I think it's so cute. 
Girls interested in my boys. I try to remember movies and television shows I've seen. Doesn't the boy - 
dressed nicely - go to the girl's house and meet the parents and ask to take the girl out. They say have her 
back by ten. Father sternly looking at the boy - "keep your hands off her if ya know what's good for ya 
matey". I rarely went on dates when I lived at home. Bowling sometimes. My father would sit in the car. 
We lived in Clifton Park - Upstate New York, population about twenty horny frustrated Christian children 
and a handful of adult entities. No public transport so my father had to take us. I would sit in the back 
seat feeling my date up and down all the way home. Presumably my father had his eyes on the road. We 
can't do that here. The fact that our car doesn't even always get us to where we are going or sometimes to 
there but not back is not a fact to consider. I can imagine, though I shouldn't, taking one of my boys on a 
date. Get half-way to where we are going, car breaking down. Broken. RAA towing us home. Me explaining 
to the girl's parents that our car broke down them not believing me thinking I'm some pervert making up 
that we were stranded on a country road with their daughter late at night.

It's all wrong. I want a proper life. A proper suburban car. A Volvo. Maybe a four-wheel drive station 
wagon. Something foreign like me. Take my Children and Their dates to nice places, with my Children 
dressed fashionably. Shoes not worn - with toes trying to escape out the sides, like they do now. Sneakers. 
Good ones. Like the ones in the commercials where the guy is jumping over buildings. My Children 
jumping over their karma, their legacy - me. Pants that aren't worn through to the knees. Up to date stuff. 
I'd take them to a nice restaurant not drive-thru-eateries like we do most days today, where we try to get 
extra free food on out of date vouchers. Maybe a movie. I would go to the library, read USA Today while 
they felt each other up in the darkness. Bowling would be o.k. Miniature golf. Now my Children have no 
money for dates. I have none to give Them. Can't drive Them anywhere anyway. I have been with my 
girlfriend for almost a year. We haven't been on a date yet either. We met in the park she bought some of my

Happy Bi rt hD ay picture poems when I was trying to make money as a 

street artist in Glenelg a resort along the coast to the left of Adelaide. She came to my house a few 
weeks later. We ended up in bed. I still hope to go on a date with her. I need to be a role model for my 
Boys. Teach Them about dating and romance. I don't think I'm doing a good job of it so far. Time is 
slipping by. I don't know anything to pass on about dating. And now in this politically correct new age we live 
in I search for another proper political movement to be correct in. Maybe the girls will do all the date 
teaching stuff, I hope so, it would get me off the hook. Two girls at the door - I wonder what they would think 
of our house that I have yet to clean this week. It's Thursday already. It is good my sons aren't home. Always 
so much to do. We will all die of embarrassment...
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●     

Terrell Neuage ~ New Textual Genres 1964 - 2002 >'nODAM' (neuage 

Online Discourse Analysis Methods)  PhD 

'Graffiti as Text' How youth communicate through street art. Honours, Deakin 
University, Victoria, Australia. 1994

'How the Internet changes literature' 
Masters, Deakin University, Victoria, Australia. 1996 

●      
●     'Picture Poems' - text/art/multimedia/fabrics 1964-2002 

●     Leigh Neuage 6 July 1983 - 16 August 2003 ~ Always Always together

 

.

  PHOTO: Kenneth Adsit age 97: 4/ 02, Robert Adsit, mum reading email about Australia, Terrell eating corn. 
Clifton Park New York 1957 
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Robert Adsit - 1943 - 1994 Clifton Park New York (Shenendehowa Central Sch...lla Iowa: New York City: artist, writer, musician, actor, brother of mine)

Robert Adsit - 1943 - 1994 Clifton Park New York (Shenendehowa Central School, Elnora New York: 
Central College Pella Iowa: New York City: artist, writer, musician, actor, brother of mine) Terrell Adsit-
Neuage May 2000 

Anyone who knew Robert Adsit and would like to contribute to this memorial site is welcome to. Robert's 
father at 100-years of age - at 101 years. 

Dedicated to Leigh Neuage an uncle you never got to know

This site updated Wednesday, 31, 2006 

[We worked on the Souvenir Book together, (HAIR) Robert used all my photographs. Dagmar
http://www.flash.net/~akstudio/dagmar.beginnings.html ]
 

Below are two cuttings from Metascience Quarterly 1980 provided by Marc Seifer
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Robert Adsit - 1943 - 1994 Clifton Park New York (Shenendehowa Central Sch...lla Iowa: New York City: artist, writer, musician, actor, brother of mine)
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Terrell Neuage - a bit about me that I only share with you

leaving australia

A SHORT FACT-THING ON PLANETIER TRAVELER NUMBER 6,065,991,320 (projected to 25 April, 
2000 at 11:20:26 GMT) currently on the planet this page updated Saturday, 3 February 2001

Began somewhere to the left of Motown - Battlecreek, Michigan - August 10th, 1947. 
Like my mate Bill Clinton - I am a Leo with Moon in Taurus. Same year as Letterman, 
O.J. Simpson, Arlo Gunthrie, Schwarzenegger, Gregg Allman, David Bowie, and Elton 
John. Same day and year (me astro twins) as Ian Anderson (Jethro Tull) and Anwar 
Ibrahim deputy prime minister of Malaysia until recently fired by Prime Minister 
Mahathir Mohamad. Oh - and of course Libra rising. With Venus, Pluto, Saturn, Sun 
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conjunct in Leo.

Hung out with my mates in Clifton Park from 1950 until 1965 when I realized there was 
a bigger world out there. All of which I wanted inside of me.

I am you  You are me  
We are her  And she split  
So we are  No more  

Did what I could to make Shenendehowa the great school that it is today - of course I 
had no impact. 

Did the 1960s in Greenwich Village, San Francisco, Los Angles, Eugene - Oregon and 
Honolulu...use your imagination...I did. 

Oh dear! Mistake Mistake - What would 1969 to 1972 be without trying to find the Self 
- going through Illumination, Self-realization ??? - so being one of the masses I did too...
In The Holy Order of Mans in Honolulu. Escaped in 1972 - and landed in New Orleans 
(Acutally I woke up one morning on the lawn of Tulane University, with lots of people 
walking past on their way to class - 24 years later I am still not quite sure how I got 
there. 

Street Artist in New Orleans 1972-1974 - selling and creating picture- poems alongside 
Jackson Square. 

Well what is one mistake without another one? After taking life- vows in the Holy 
Order of Mans then escaping I felt something - don't know what - but I ended up back 
in their *** - 1974 to 1978. 

Sent all over the States as Brother Arthur to heal, save, initiate. learn that I wasn't me... 
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Cheyenne, Wichita, Syracuse, Towson Maryland, Detroit and some other places I no 
longer care to remember. 

1976-1978: Attended Towson State University in Maryland USA for nursing Worked at 
Sheppard Pratt Hospital in Towson as a psychiatric aide or something like that. 

1978 Left the Holy Order of Mans for good (or worse) - 

Between God  And man  
the choice  is easy  

Between God  And woman  
The choice  is woman  

1978-1980: Artist in Baltimore, Washington D.C., and New York City. 

January 1980 lectured at some astrological thingie in Sydney Australia. Met some 
woman that I didn't like. 

Woman I didn't like arrived in the States (Towson) and at my door March 1980. What 
the heck - I'm a guy - and I was going through some promiscuous cycle of any woman 
was the best I had been with in that moment. Several months later while living in 
Honolulu and working at Queens Medical Centre - this person that I never liked but 
she was in my house for the weekend and what the heck why not? rings and says she is 
pregnant from me. 'HELP' 

Sacha comes to hang out on the planet January 6, 1981. Born - Kahuku, Hawaii, out 
there in the sugar fields. 

June 1981 moved with woman I didn't like in Sydney and 'oh what the heck! in 
Baltimore to her home in Adelaide South Australia. 
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Good golly! Worth forgetting - began a tofu business in 1981 and hung in there as the 
'Tofu king of Australia' until 1988...had something like 35 tofu based products for 
awhile there: tofu burgers, cheescakes, spring rolls... 

July 1983 Leigh came along to this planet to play baseball. Leigh signed with the LA 

Dodgers February 1, 2001. comet-memories

October 1984 Left the woman I didn't like in Sydney in 1980 and 'Oh what the heck in 
Baltimore' and moved out to the bush, children in tow. The court gave me custody of 
the kids but said "don't leave town with 'em mate" - so I have been a political prisoner 
of Australia for the past 16 years. - against my free-will

1991-1994 BA in Literature and Journalism at Deakin University, Geelong Victoria. 

February to April 1992 visited New York, Eugene, Indiana, Paris, London, and many 
places in Germany and Switzerland with kids in tow. 

October 1992 toured Australia in a large mobile home with my 87 year old father 
visiting from Clifton Park New York and kids too...good golly - help! What is the 
difference between an 87 year old and an eleven and a nine year old? Not much, believe 
me. 

1995 Honours in Literature - thesis on "Graffiti as Text" 

1996 -97- Masters in Literature - thesis on poetry on the Internet 
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1997 - Post-graduate Degree Computer Technology, Flinders University South 
Australia 

1998--- Ph.D at University of South Australia on Internet Literature

SOMEWHAT ME

Cheers mate!!!! 

early 1999 – South Australia

to read some parenting stuff 
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New York (1952)Snowmen dance only for those who believe - weekly picture poem from Te...ugust-1981) ~ 1-20-72 New York City photo Clifton Park 

 home

Tuesday, June 27, 2000 

last week's poem of the week CURRENT ROMANTIC WEEKLY POEM NEXT WEEKLY 

POEM random picture poem /ALL / home 

Snowmen 
dance
only
for those
who
believe.
(c) Terrell Neuage (Adsit pre-August-1981) ~ 

1-20-72 New York City photo Clifton Park New York (1952)

this picture poem is 8 by 10 inch and is available

(NOTE 1 - EVERY PICTURE-POEM IS DIFFERENT ONLY THE WORDS REMAIN THE SAME  
NOTE 2 - This mat frame is an example of a coloured frame and each pp is available with hand painted mat or plain - please say 
which you wish  
NOTE 3 - All poems less than about 12 lines by Terrell are available as picture poems  
NOTE 4 Other writer's texts are not available in picture-poem form) 

To view a list of picture~poems now on line please go to

This picture poem ( 8 by 10 inch) is available for sale

Leigh Neuage (July 6 1983 - August 16 2003) 
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Current research: 
1. GRIN’s technologies: [Genetics, Robotics, Artificial Intelligence, and Nanotechnology (Joel 
Garreau)] impact on communicational evolutions; how will we translate meaning from sender to receiver if 
the ‘decoder’ is inserted in the minds of but a fraction of society? An extension to my PhD 
thesis: ‘Conversational Analysis of Chatroom “talk”’ 
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and traditional Christianity.
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WEEKLY ROMANTIC POEM FOR Tuesday, 26 December 2000

WEEKLY ROMANTIC POEM FOR Saturday, 3 February 2001 last week's romantic poem of 
the week Next poems

I danced with you in my dream last night
not sure the shore but it was distant

a song you had written
played on your saxophone

lightly
far away

though surprisingly near at the same instant
like in an ancient jungle passion

our movement's swaying embrace
 

there was no fireworks
though a shooting star left a glow

through the night sky
and I saw it reflected in your eyes

no earthquakes
though your lips barely touched mine

a moist feathered caress 
that shook my body to its core

 
we held each other so gentle

swaying like flowers in a flirting breeze
 

I danced with you
was the dream real

http://neuage.indiko.com/romo/danced.htm (1 of 2) [3/8/08 2:59:20 PM]

http://neuage.indiko.com/romo/my_kiss.htm
http://neuage.indiko.com/romo/my_kiss.htm
http://neuage.indiko.com/romo.htm
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or the future to unfold?
 

Terrell Wednesday, 17 January 2001 10:34:57 Magill
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WEEKLY ROMANTIC POEM FOR Thursday, 28 December 2000 last week's romantic poem of 
the weekve s

philosophical of sorts) poem - http://neuage.indiko.com/weekly/snowmen.htm c

Picture Poems by Terrell Neuage HOME ~ Next Picture Poem ~ Previous Picture Poem

If you teach me passion

I will teach you flight

If you teach me freedom

I will teach you passion

If you will teach me expression

I will teach your freedom

If you teach me flight

I will teach you expression

If you teach me passion

I will learn flight

If you teach me freedom

I will learn passion

If you will teach me 
expression

I will learn freedom

If you teach me flight

I will learn expression
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WEEKLY ROMANTIC POEM FOR Tuesday, 26 December 2000 from terrell neuage in adelaide south australia

WEEKLY ROMANTIC POEM FOR Thursday, 8 February 2001 last week's romantic poem 
of the week NEXT POEM 

MY KISS 
So much to say 

To you 
Could write hundreds of emails 

Talk hours on the phone 
Write you a thousand-page book 

Or 
I could look you in the eyes 

Kiss you 
Hands holding your head  
So everything I had to say 

You would know 
From my kiss 

 
Terrell Wednesday, 17 January 2001 10:25:57 Magill 

 

ROMANTIC POEM OF THE WEEK | WEEKLY | About Me | picture poems  / baseball | Robert | 
neuageVIEW | kids | Tree | home /PhD Thesis/ALL

http://neuage.indiko.com/romo/my_kiss.htm (1 of 2) [3/8/08 2:59:33 PM]

http://neuage.indiko.com/romo/3-billion.htm
http://neuage.indiko.com/romo/3-billion.htm
http://neuage.indiko.com/romo/danced.htm
http://neuage.indiko.com/romo.htm
http://neuage.indiko.com/weekly/snowmen.htm
http://neuage.indiko.com/aboutme.htm
http://neuage.indiko.com/racehorse.htm
http://www.geocities.com/leighneuage21/u-18.htm
http://neuage.indiko.com/robert_adsit.htm
http://www.neuage.org/neuage_view.htm
http://neuage.indiko.com/i.html
http://neuage.indiko.com/tree.htm
http://www.neuage.org/
http://neuage.indiko.com/thesis.htm
http://neuage.indiko.com/all.html


WEEKLY ROMANTIC POEM FOR Tuesday, 26 December 2000 from terrell neuage in adelaide south australia

 

 
 Leigh Neuage (July 6 1983 - August 16 2003) 

story index poems collection 1 ª poems collection 2ª poems collection 3ª weekly poem ª my 
photos ª Leigh photos ªPHOTOS ~ terrell and Picture Poem Sampler- order Picture Poems 

8x10 matt framed individually made to order $15 each includes posting from 
terrellneuage@yahoo.com  

View My Guestbook       
Sign My Guestbook 

http://neuage.indiko.com/romo/my_kiss.htm (2 of 2) [3/8/08 2:59:33 PM]

http://www.neuage.org/leigh.htm
http://neuage.indiko.com/i.html
http://neuage.indiko.com/collection1.htm
http://neuage.indiko.com/collection2.htm
http://neuage.indiko.com/collection3.htm
http://neuage.indiko.com/collection3.htm
http://se.unisa.edu.au/weekly/TerrellView.html
http://neuage.indiko.com/collection3.htm
http://f2.pg.photos.yahoo.com/ph/nbiemond/my_photos
http://f2.pg.photos.yahoo.com/ph/nbiemond/my_photos
http://neuage.indiko.com/collection3.htm
http://f2.pg.photos.yahoo.com/ph/nbiemond/my_photos
http://neuage.indiko.com/collection3.htm
http://f1.pg.photos.yahoo.com/ph/restlessdancerau/my_photos
http://htmlgear.lycos.com/guest/control.guest?u=terrell_neuage__1&i=1&a=view
http://htmlgear.lycos.com/guest/control.guest?u=terrell_neuage__1&i=1&a=sign


http://neuage.indiko.com/cards/glow.gif

http://neuage.indiko.com/cards/glow.gif [3/8/08 3:00:37 PM]



http://neuage.indiko.com/cards/flash.gif

http://neuage.indiko.com/cards/flash.gif [3/8/08 3:01:29 PM]



http://neuage.indiko.com/cards/kisses.gif

http://neuage.indiko.com/cards/kisses.gif [3/8/08 3:02:24 PM]



http://neuage.indiko.com/cards/dream.gif

http://neuage.indiko.com/cards/dream.gif [3/8/08 3:03:34 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

 
BACK HOMEcollection 2 

Terrell.Neuage@unisa.edu.au 

COLLECTION 1

 

 

Often I reached out

Often I came close

Often I pulled back

if there was a way to change

wave a magic wand

command a jeanie

roll a lucky dice

Take me deep

Swallow my pride

Tie me down

Chain me up

Let bleed desire's fire

on freedom's alter

http://neuage.indiko.com/collection1.html (1 of 318) [3/8/08 3:04:48 PM]
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before sacred oaths

dissolve saturn's grip that strangles silken whispers

before YES is breathed

and dies without belief

Like I do

each time I reach out

then pull back

12-25-93 Victor Harbor copyright Terrell Neuage(1151) 

While reviewing the past

the way it was

how we were

such easy thoughts

nothing ever to worry

I realized

I saw

I knew

now was just a cartoon

of what would have been

if we could have

been 
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now

then

 

12-25-93 Victor Harbor copyright Terrell Neuage(1990)

Broke the mode

of who I was

now you see

the source of my shadow

the end of my projection

the face behind every mask.

Just before midnight

I began a new day

another era

a beautiful me

alone in flight

over my broken mode.

So the who you see 

who looks like me

but acts so free

is but master of ceremony

grand performance
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finally on stage

with little left to offer

but

the way I am

again today

in broken mode

once again I am.

 

12-25-93 Victor Harbor copyright Terrell Neuage(99D)

So sure

that this was the right direction

everything always

had led to this spot

until we discovered

that we weren't here

and neither was the spot
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12-26-93 Victor Harbor copyright Terrell Neuage(1342 B)

 

We drew a line

in the sand

but the tides

washed us away

leaving the line

that we drew

dividing us

from being one

to fight the tides

that came

and took us 

away
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12-26-93 Victor Harbor copyright Terrell Neuage(1745 B)

Buried treasures

like hidden talents

leaves us poor

and all alone

with no one

sharing

what we'd have

if hidden treasures

and buried talents

weren't.

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(99 D) 

Shattered illusions

Scattered conclusions

Battered delusions

dissolved by the dawn of reason

Now nothing is left

but created reality
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so clear

I can see forever

Hello New Morning

Good Bye every night

12-93 Victor Harbor copyright Terrell Neuage(1256)

At a final frontier

we conquered fear

to devour

each other

like any

cannibal of love

would

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(62 D)

The day after

The night before

left me

wanting to wake with you
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once again

in the day after

the night before

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1405)

 

This year so quickly went

I went back

to do it once again

just to know

it really had happened.

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1565) 

I looked in the dictionary

to find meaning

but no explanation
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cleared up

my wonderment

of what

this means

You and I

three words in the dictionary

one in my mind.

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(512)

I always thought

one more would be enough

and when it is

it will be

But for now

here I am

only one more

from being enough.
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12-26-93 Victor Harbor copyright Terrell Neuage(288)

 

I was wondering

what will be the last word said

the final line written

the last caress

the final bite

before I die

then I realized

I wouldn't remember anyway

so on I ramble

write

touch

and eat

like any eternal consumer

would

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(842)
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If each thing done

we do as

that to be our masterpiece

then our life

that will be

 

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(349 A)

 

Again

my friend

the end

does send

this trend

again

ABOUT FACE 

CHANGE DIRECTION
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whisper loudly

the blind feel what we don't see

the deaf see what we don't hear

the lonely know every face in the crowd

but at the end

I'll still be your friend

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(6 B)

 

'Lucky me'

said the tree

'I will never be

lost on a freeway

short on what to say

found shopping

seen hopping

lucky me

lucky me

said the tree
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12-26-93 Victor Harbor copyright Terrell Neuage(956 D)

All the advice ever asked

never led anyone to the stars

all the questions pursued

never changed the unexpected

all the theories so explained

never

ever

and it will still all be

the same

again tomorrow

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(12)

 

'Oh No! Oh No!'

said the tree

and all the people stopped

http://neuage.indiko.com/collection1.html (13 of 318) [3/8/08 3:04:48 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

to question a tree

that would talk

but never more

did that tree say

And that is how

the religion of the tree began

and why everyone

chants

'Oh No! Oh No!'

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1155 B)

All our possessions

are but props

to insulate our space

before we became to know

that we never

needed them anyway.
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12-27-93 Victor Harbor copyright Terrell Neuage(12 B) 

Cold!

Only the physical body knows

take away the cold

I'm still here

take away my body

the cold remains

if I could

I would be

a naked thought sitting on an arctic flow

and diving into frozen illusion tundra

I'd swim in the cold

and pretend my body was with me

like I do now

in this cold world

I've been given to wander.
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12-27-93 Victor Harbor copyright Terrell Neuage(120)

As fragile as each new moment is

the strength to proceed into in

is but BELIEF

given wings

to give flight

when needed to be.

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(61 D a)

Nature brought forth humans

because

dinosaurs couldn't paint

amoebas wouldn't carry a tune

apes refused to write poetry
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and there was no one to understand this.
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The reason we do everything

done

we did

is to look at it at the end

to see if

we 

did

it correctly

since the beginning.
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12-27-93 Victor Harbor copyright Terrell Neuage(1467 A) 

Like a poem

going no where

a song

without a tune

seeds planted in the desert

and love with no dawn

life is 

without direction.

 

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(908 B)

We had so many backup plans
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that we crashed

backing up

never seeing

where we were going.

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1769)

While looking for the perfect gift

silence screamed at me

'GIVE NOTHING

BECAUSE THAT IS ALL

WE SHALL HAVE AT THE END'

and now 

we could get use to

getting it early.
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I never wanted to be

anything more

than everything

that you are

I never wanted to be white

or so poor

so unknown

I'm not even a part of history's pathways

but if there weren't shadows like me

there would never be

stars like you.

 

 

12-28-93 Victor Harbor copyright Terrell NeuageSA (571 B)

The last verse

was in your purse
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all you had to do

was open and see

but you shot through

and left me free

Yet always the waves

reach the horizon

poems seldom rhyme

nature does not understand humans

and the last verse

was in your purse

lost with my heart

amongst all the things

you carry

wherever you fly.

 

 

 

12-29-93 Victor Harbor copyright Terrell Neuage(1427)

If I said good night

would that change the orbit of the sun

make the collide with Mars
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or a garden snail learn to run

probably not probably not

because within preconceived ideas

giraffes don't become butterflies

love never dies

and I don't hear you

saying good night to me.

 

12-30-93 Victor Harbor copyright Terrell Neuage(380)

We don't live in troubled times

troubled times live in us

swallow butterflies

eat rainbows

drink stars

DIGESTED CHANGE

takes away

troubled times.

 

12-30-93 Victor Harbor copyright Terrell Neuage(1743)

I keep thinking it's a different day
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another life

who opened the windows

and let in

these times

this place

that reflection

which could never be

anything more

than a different day

another life.

 

 

Often I reached out

Often I came close

Often I pulled back

if there was a way to change

wave a magic wand

command a jeanie

roll a lucky dice

Take me deep
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Swallow my pride

Tie me down

Chain me up

Let bleed desire's fire

on freedom's alter

before sacred oaths

dissolve saturn's grip that strangles silken whispers

before YES is breathed

and dies without belief

Like I do

each time I reach out

then pull back

12-25-93 Victor Harbor copyright Terrell Neuage(1151) 

While reviewing the past

the way it was

how we were

such easy thoughts

nothing ever to worry

I realized

I saw

I knew
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now was just a cartoon

of what would have been

if we could have

been 

now

then

 

12-25-93 Victor Harbor copyright Terrell Neuage(1990)

Broke the mode

of who I was

now you see

the source of my shadow

the end of my projection

the face behind every mask.

Just before midnight

I began a new day

another era

a beautiful me

alone in flight

over my broken mode.
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So the who you see 

who looks like me

but acts so free

is but master of ceremony

grand performance

finally on stage

with little left to offer

but

the way I am

again today

in broken mode

once again I am.

 

12-25-93 Victor Harbor copyright Terrell Neuage(99D)

So sure

that this was the right direction

everything always

had led to this spot

until we discovered

that we weren't here

http://neuage.indiko.com/collection1.html (26 of 318) [3/8/08 3:04:48 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

and neither was the spot

 

 

 

 

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1342 B)

 

We drew a line

in the sand

but the tides

washed us away

leaving the line

that we drew

dividing us

from being one

to fight the tides

that came
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and took us 

away

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1745 B)

Buried treasures

like hidden talents

leaves us poor

and all alone

with no one

sharing

what we'd have

if hidden treasures

and buried talents

weren't.

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(99 D) 

Shattered illusions
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Scattered conclusions

Battered delusions

dissolved by the dawn of reason

Now nothing is left

but created reality

so clear

I can see forever

Hello New Morning

Good Bye every night

12-93 Victor Harbor copyright Terrell Neuage(1256)

At a final frontier

we conquered fear

to devour

each other

like any

cannibal of love

would
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12-26-93 Victor Harbor copyright Terrell Neuage(62 D)

The day after

The night before

left me

wanting to wake with you

once again

in the day after

the night before

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1405)

 

This year so quickly went

I went back

to do it once again

just to know

it really had happened.
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12-26-93 Victor Harbor copyright Terrell Neuage(1565) 

I looked in the dictionary

to find meaning

but no explanation

cleared up

my wonderment

of what

this means

You and I

three words in the dictionary

one in my mind.

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(512)

I always thought

one more would be enough

and when it is

it will be

But for now

here I am
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only one more

from being enough.

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(288)

 

I was wondering

what will be the last word said

the final line written

the last caress

the final bite

before I die

then I realized

I wouldn't remember anyway

so on I ramble

write

touch

and eat

like any eternal consumer
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would

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(842)

 

If each thing done

we do as

that to be our masterpiece

then our life

that will be

 

 

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(349 A)

 

Again

my friend

the end

does send
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this trend

again

ABOUT FACE 

CHANGE DIRECTION

whisper loudly

the blind feel what we don't see

the deaf see what we don't hear

the lonely know every face in the crowd

but at the end

I'll still be your friend

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(6 B)

 

'Lucky me'

said the tree

'I will never be

lost on a freeway

short on what to say

found shopping
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seen hopping

lucky me

lucky me

said the tree

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(956 D)

All the advice ever asked

never led anyone to the stars

all the questions pursued

never changed the unexpected

all the theories so explained

never

ever

and it will still all be

the same

again tomorrow
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12-26-93 Victor Harbor copyright Terrell Neuage(12)

 

'Oh No! Oh No!'

said the tree

and all the people stopped

to question a tree

that would talk

but never more

did that tree say

And that is how

the religion of the tree began

and why everyone

chants

'Oh No! Oh No!'

 

 

 

12-26-93 Victor Harbor copyright Terrell Neuage(1155 B)

All our possessions

are but props

to insulate our space
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before we became to know

that we never

needed them anyway.

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(12 B) 

Cold!

Only the physical body knows

take away the cold

I'm still here

take away my body

the cold remains

if I could

I would be

a naked thought sitting on an arctic flow

and diving into frozen illusion tundra

I'd swim in the cold
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and pretend my body was with me

like I do now

in this cold world

I've been given to wander.

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(120)

As fragile as each new moment is

the strength to proceed into in

is but BELIEF

given wings

to give flight

when needed to be.

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(61 D a)
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Nature brought forth humans

because

dinosaurs couldn't paint

amoebas wouldn't carry a tune

apes refused to write poetry

and there was no one to understand this.

 

 

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1002 B) 

The reason we do everything

done

we did

is to look at it at the end

to see if

we 
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did

it correctly

since the beginning.

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1467 A) 

Like a poem

going no where

a song

without a tune

seeds planted in the desert

and love with no dawn

life is 

without direction.
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12-27-93 Victor Harbor copyright Terrell Neuage(908 B)

We had so many backup plans

that we crashed

backing up

never seeing

where we were going.

 

 

 

 

 

 

12-27-93 Victor Harbor copyright Terrell Neuage(1769)

While looking for the perfect gift

silence screamed at me

'GIVE NOTHING

BECAUSE THAT IS ALL
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WE SHALL HAVE AT THE END'

and now 

we could get use to

getting it early.

 

 

 

 

12-28-93 Victor Harbor copyright Terrell Neuage(1983)

I never wanted to be

anything more

than everything

that you are

I never wanted to be white

or so poor

so unknown

I'm not even a part of history's pathways

but if there weren't shadows like me

there would never be

stars like you.
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12-28-93 Victor Harbor copyright Terrell NeuageSA (571 B)

The last verse

was in your purse

all you had to do

was open and see

but you shot through

and left me free

Yet always the waves

reach the horizon

poems seldom rhyme

nature does not understand humans

and the last verse

was in your purse

lost with my heart

amongst all the things

you carry

wherever you fly.
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12-29-93 Victor Harbor copyright Terrell Neuage(1427)

If I said good night

would that change the orbit of the sun

make the collide with Mars

or a garden snail learn to run

probably not probably not

because within preconceived ideas

giraffes don't become butterflies

love never dies

and I don't hear you

saying good night to me.

 

12-30-93 Victor Harbor copyright Terrell Neuage(380)

We don't live in troubled times

troubled times live in us

swallow butterflies

eat rainbows

drink stars

DIGESTED CHANGE
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takes away

troubled times.

 

12-30-93 Victor Harbor copyright Terrell Neuage(1743)

I keep thinking it's a different day

another life

who opened the windows

and let in

these times

this place

that reflection

which could never be

anything more

than a different day

another life.

 

 

12-30-93 Victor Harbor copyright Terrell Neuage(485 B)

Woken highway

reached out

I held on 
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through the deserts

ofpver rivers

into mountains

This highway

would not listen to my pleas to stop

This highway

had heard desperate hooves

as horses escaped in the 1800s

had see Porches and Harleys

had felt pain

joy

but never aloneness

like I so often have

This highway

took me to this realm

I can not escape

my family calls it madness

my doctor - a genetic flaw

my psychic said I was born to the highway

I its slave
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and it will be this highway

at the end of the tunnel

where beings of light

will throw me back

and tell me to follow the highway

until I know where it's headed

(like if I would anyway - ever)

Now I'm quite use to this highway which keeps going

into other dimensions

like I do

each time I think of the road once traveled

the road futures will travel

This highway never ending.

12-31-93 Victor Harbor copyright Terrell NeuageSA. (2055)

Morning swallowed

my dreams

made me hungry 

to see if 

they'd come true

like everything else
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I believe in 

does

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(978)

 

 

 

At the beginning

when all there was

was already there

waiting to be put together

like you and me 

and the galaxies

too
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5-1-93 Victor Harbor copyright Terrell Neuage(64)

I was so sleepy

I slept standing up

while the world

lay on its side

watching

 

 

 

 

 

 

 

5-1-93 (838)

the reason 

we are here

is because dawn

doesn't want to 
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come alone

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430)

like steps through history

or a wander through dreams

today's beliefs,efs

grew out of yesterday's crumbled ideologies

for tomorrow's

individual freedom

finally won

to take wings

never to land again

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(916)

I learned shorthand
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speed reading

computerization

experienced Paris in a day

read 'Readers Digest'

condensed pasteurized homogenized great novels

and watched history of civilization

but time stood still

when your touch

became so 

involved

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(492)

I concentrated so hard

on this moment

that yesterday and tomorrow disappeared

now

like neapolitan ice cream

melted

contains the former and the latter

in a future past tense
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that has no ease 

of

explanation 

in this moment

 

5-1-93 Victor Harbor copyright Terrell Neuage(316 C)

There is little difference

between you and me

except that I am conscious

of the little difference

(even calling them my own)

and you see them

being but variations

of your greater self

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430 D)

This life goes so fast

that when I die

I will need

a thousand years
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to review all that happened

in this life

 

 

 

 

5-1-93 (1508)

The continuous pouring out

of creativity

fueled forever's freedom's

perceptual persuasion's performance

reflected perfectly

for me

to 

know

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1394)

I wouldn't want to live on Venus
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because there are no trees

nor on Mars with its lack of flowers

and there is no chocolate on Jupiter

or ice cream on Mercury

while on earth

everything I want

is between the sea

the trees

and the shopping mall.

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(858)

If I knew how to write

a poem

I would

if I knew how to sing

I would

If I could dance, take photos
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paint or tell your future

I would

But all I can do

is build you a castle

in the sand

and offer it to you

before the sea

take it from me

 

5-1-93 Victor Harbor copyright Terrell Neuage(376)

the reason

we don't have wings

is because we don't have to fly north

for the winter

But can stay all winter-warm

wrapped in each other's

warmth

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(946)
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The reason

we keep coming to earth

is to learn to stop dying

but we keep

getting into the Plato trap

of this is it

why keep going

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(946 C)

Not every time

is everything

going to be

the way it is

at other times

But instead

like any spinning top everything gets a chance\

to be close at hand

again 
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if we see

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(1130 C)

We rush through life

like we're in a hurry

to get to the end

not knowing what it is

except that

it will be different

than the rush through

this life is

 

 

 

5-593 Victor Harbor copyright Terrell Neuage(1768)

I write

for the same reasons

a bird flies

far from an oil slick

a whale stays away
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from a stream

and buffaloes avoid mountains

I write only 

to find these answers

that everyone else

already knows

 

 

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(858)

As if this moment could be preserved:

placed in a safe-deposit box, frozen in space, cloned, kept intact

maybe even used again

reincarnated, transmigrated, resuscitated, 

recycled moments 

in another reality

a paralleling toyed universe

where earth-used moments
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are packaged and sold in day-fill programmes

Drive-thru-take-away-moment-services

'Yes I will take three moments to go

two yesterdays and one tomorrow'

And I reach out to take a hold of a yesterday

the moment we said good bye

in hopes of renaming it and bringing it back to life

only to discover the moment I wanted returned

had been used by a patriot in an alternative drifting energy force

and was no longer mine

to have again

but only to observe 

in mutational memory cells

reflecting changing interpretation of

the way it once was

11-28-93 Victor Harbor copyright Terrell Neuage(61 C)

Before: After was known

When storms were calm 

Emotions describable

And colour bland
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Answers were easy

But meaning wasn't.

 

 

 

 

11-29-93 Victor Harbor copyright Terrell Neuage(76)

Inside wholeness

separation is unknown

like the splitting of an atom

is unknown

inside wholeness

But the results

are the same
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Curtains drawn

over windows of time

left imagination
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without a view

like an unlit night

shows what can not be seen

when all that is revealed

is nothing at all
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In the morning

I looked forward to

meeting the new me

that I heard about

in a dream

But the new me

stayed in the dream 

while mirror showed 

the same snapshot

it had shown

every other morning

fuzzy wakefulness

far from any dream thought possible

http://neuage.indiko.com/collection1.html (61 of 318) [3/8/08 3:04:48 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern
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While sharing one another

with each other

We traded lives

and worked on correcting

all the faults we had

perceived in each other

before we had traded lives 

then we traded back

only to die laughing

at what we had created

Perhaps next time

we'll just accept and not modify

live and not die

and

share and not trade

 

 

http://neuage.indiko.com/collection1.html (62 of 318) [3/8/08 3:04:48 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern
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While making way

for new experiences

the past was stored away

in the attic

where a spider

web-woven

devoured the past

and the present

ran naked

knowing such a fate

could be escaped

if experiences

no longer were stored

away
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Without risk
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a billion galaxies

would have not begun to dance

with questions

a billion suns

in our galaxy

would have not take a first deep breath

without nature

chaos would have no joy

without you

a billion cells in my life

will lose their spark.
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Close to where I want to be

But never there

like a future

reachable

not holdable

hoped for

not known
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seeable

But only in a mist

before form 

covers now

in the never to be

so in today once again

as always

all is within reach

and parts even attainable

but never all

never all

never all
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The release

freed me:

What I once wanted

no longer needed

flew forth

like love does
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once it has wings
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Fresh start

reinvented me

today is the reincarnation of yesterday

But I'm not

Reinvented me

is all I can see.
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yy

Without sounding

too philosophical

spiritual

down-to-earth

metaphysical

or psychological

I need you

like any farmer

the rain 

would
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I thought nature

was blushing

from listening to me

speak about you
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But it was dawn

that was making nature come

with such colour

not my description of you
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sky cleared

darkened thoughts

blocking dawn

so morning could see

my wish had come true

you and I free of

darkened thoughts
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Just when I understood

how the final piece fitted

when nature cheered

exploration showed meaning

changes laughed in reason

I awoke

to see clouds disperse

love leap forward

success call my name
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I use to think 

I was the luckiest person

on earth

to be with you

now I realize

you're the lucky one
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I didn't notice

a difference between

day and night 

until you pointed out

that is how 

we are 

shooting stars 

gone too far

passing midnight

passing noon

we'll know soon

which we're like

which we're not

but sameness

is left out doors

somewhere between

day and night
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I just thought we could stop

along the coast of our first touch

atop the mountain of desire first conquered

past our first laugh over a whispering horizon

But I just got a message from the dawn

saying memory is better than promise

promise is better than forever

forever is better than forever

and in circles

the merry-go-round never strays

like my feelings for you

always changing

never ceasing

always finding

never seeking

always one
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you're never close

because I'm always there

just around a corner

in the back of your memory
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I wanted to be a legend

a whisper amongst time's shadows

spoken about in parliament

dreamt of in alleys

cried over

in Delphi often

number one on MTV

a source of multiple orgasm\inner space colonization\political 
revolution

the dawn at road's end

And I was

somewhere in time
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I wanted to be safe

so I gave you a single rose

instead of promising the world

a smile

rather than tomorrow too

a light touch

that could never the place

of all I wanted to give

beyond a single rose
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I wanted too much

such a short time

to try it all

have a taste
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devour more than before

to go every direction at once

But I did

so excuse the way I am

because I wanted too much

and it all I did

too
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I tried to shake away

shadow's memories

fallen beliefs

and dusty mirages

of when you were

an oasis to me

but trials of now

lost in forests of good byes

took me to this corner

this crossroad

this space
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where I remember everything

no matter how much

I try to strike away

memory will cast me forever 

in the starring role

I had 

once with you
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The cross of reason

tossed experience into now

dreams so real now weren't

feelings once felt dissipated

wishes just another book read

(the seven seas just another pool swam)

The cross of reason

forever there
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The only reason

nature has let us

get this far

is because it needs

someone to water the flowers

when the rain 

doesn't flow

like we do

when together

the dawn we touch
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I sang the same line

over so many times

to make it rhyme
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You were following a star

I followed morning

crossed visions left me alone

if only I knew the tone

take me

the sea

I will sail forever

fallen forgotten endeavour

leave me this moment free

for all I can see

is the remainder of me
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While fading into you

I grabbed on to

a final portion of me

like forever

takes a final glimpse of
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the moment
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As difficult as the moment appears

it is nothing

compared with

a tree from a seed

a president from a collision of sperm and egg

millions of dollars from six numbers in the lottery

another moment with you
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why this is this way

mist rises 

rain falls
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winter froze

you touch 

I melt

this way it is 

tomorrow too

it will be
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Time came

when window

showed little more

than thought cleared sky

echoes whispered

shades of colours

If I knew the way

would have smelt like

a spring morning

when we believed

winter would never return
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"HOLD THE MEMORY!"

I yelled

this isn't all

that can be done

before next moment new packages now into

'remember when?'

and pouring forth

more than

better than

I watch the moment explode

shooting forth

galactic droplets

of new moments

each carrying

more than
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better than

within its form
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Focusing on you

blurred the surroundings

Your life 

nature's victory

Your senses

future's promise

heightened awareness

centred on you

erased everything else

the game in front slipped away

yesterday's storm blew out to sea

questions became irrelevant

answers dissolved

while focusing on you

everything became blurred
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except for you
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Still trying to say

what should be so easy

to explain

how forests

laugh in rain

like I do in you

how the universe 

took 15 billion years

to bring forth

mobile phones

and only 30 years

you

how your touch

makes me

feel like
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a christmas tree

waiting to be

decorated
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I reached through time

to grab the bits

I wanted tomorrow to be made of

like any creator would
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I planted an acorn seed

and heard celery grow

in its place

I put my yacht out to sea

but woke in the bath tub

with a toy boat instead

the weather report said 

the sun would shine

over my tropical island today

but i had to shovel through

four feet of snow

to get to my papaya plantation

You said you would stay with me forever

and we haven't met yet

I swam 

when I should have flown

cried instead of laughed

chased cars

dogs were driving
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stood naked

in a crowded subway

And told secrets on Oprah's show

otherwise

everything seems quite normal
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It was funny the way

we danced

along the shore

in the moonlight

you sang of rainbows

when no storm was in sight

I collected shells

in the night

looking for pearls

looking for love

looking for what I'd wake with

if we ever stopped dancing

long enough to dream
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of the moment

like anyone having

a near-love experience

would 
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In clashing colours

we found every difference

but a taste

of each experience

that was free

in clashing colours
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Rushed through

all we could have

Leaping brushed-fired passions

devoured us

you opened

I gave

you cried

I whispered

you held on

I let go

filling you with every man's desire

ACCUMULATED EVOLUTIONARY WANT

and in the moment

all creation held her breath

wondering if such fulfillment

was possible

as we rushed through

all we could have

in one final release

that is now
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forever

imprinted on my consciousness

a mutating cell in all future creation.
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I waited for the final song

one last curtain call

a good bye kiss

and a passing caress

You were to become a star

here on earth 

or in the sky

I never knew which

But I knew

as the applause faded

and your whispers rang in my ears

that what I wanted

what you gave
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what I took

was just a borrow

an overdue loan

from this stage

just a further experience

and without saying thank you

too many times

I salute you

and ask for nothing more

but an encore

before this stage

dissolves into

some future production
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If nature 

changed her mind

as often as I do

there'd be blizzards in Pago Pago

spring in the winter
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the sun would stop then go the opposite direction

cows would give eggs on Tuesdays

flowers on Friday

and there'd be one of me for each day of the week
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Like when no one notices

what is

Is the best performance possible

while the rain washes away

the stage

and in suspended thought

birds migrate

with little notice

of what is

is the best performance
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possible.
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Everyone stood in line

waiting to be selected

like a best thought of the day

waits to be realized

Friday waits Thursday to end

a rose waits to be given

and I wait for you to see

I have selected you

like I hope you have me
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too much junk mail

too many sensational headlines

and too few peaceful times

left me looking for a comfortable seat

in the midst of a tornado

just to watch 

not be changed
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I was ready 

times weren't

I was there 

space wasn't

I wanted you

you didn't know
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time and space

didn't exist
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One step from the finish

I realized 

I was in the wrong race

But it was o.k.

because I was only one step away

from starting a new one

this time correctly run
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I made 

a hundred 

photocopies

of the moment

I met you

and

hand them out

to myself

each time

the moment

tries

to

slip 

away
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Here we are

http://neuage.indiko.com/collection1.html (95 of 318) [3/8/08 3:04:48 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

funny to say

flowers laugh

rain screams

dove for evening meal

but

though

maybe

it is possible

funny to say

we never knew

that it truly

is this way
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I was just getting warmed up

decades of experience

(lay like tumbled children's blocks)

picked up and used again
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to make a bridge

recycled experiences

led me to be free once again

like before blocks of life

began to tumble
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each moment chosen

like ripen fruit

a perfect gift

each magical touch

the taste of

new fallen snow

and the glow of a first touch

is nothing but perfect

in each moment chosen
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Surprised by the movement

through space

of what I wanted

as it pushed aside

all resistance

and made room in chaos

for all

I wanted

 

 

12-13-93 Victor Harbor copyright Terrell Neuage(1365 B)

Each time I turn around

facing direction's perspective

laughs like time

in the rain

does
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On the back of yesterday

I wrote what happened

How the morning exploded

day gave meaning

freedom flew

and so did I

on the back of yesterday

I never wished for now

to be so far away

from then

and remembered so well
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Children are not

the souvenirs of love

but travelling 

theme parks

they are
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There were so many choices

I fell asleep

and dreamt each one
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complete

that is why

I see rainbows

when others see clouds

And so should we.
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If every direction traveled

arrived at the perfect destination

Discovery forever

would stand behind

closed doors
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laughing at us
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A close score

with little time left

all the players

waited in evening's fading

light

as the stars began to shine

to make complete every game 

that no longer

needs morning to show
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winners

like we do

each time we touch
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I don't like art

I don't like writing

that is why I drew a poem

in the sky

just to watch it

disappear

like I do 
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each time I read

what I write.

 

 

 

 

 

 

 

 

 

 

12-16-93 Victor Harbor copyright Terrell Neuage(330)

Like any good audience

we are still waiting for

the punch line

2000 years later
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In mistaken identities

trees sprout wings
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birds grow roots

and gravity tossed us into space

like love

with no way

to keep us down to earth

 

 

 

 

 

12-17-93 Victor Harbor copyright Terrell Neuage(565 B)

 

Morning filled

night before

breeze returned

with your scents

your desire

still fulfilling

bringing now

with

your return
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12-22-93 Victor Harbor copyright Terrell Neuage(976)

 

If only images

were found

to be real

I would become lost

in the image of you
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I thought it was the end of the world
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when the changes began.

As if time really cared

or the sky would disappear

or elephants would stop dancing.
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With no time left

I asked to spend forever with you

With no space 

I asked

if there was room for me

In the frozen wastelands

I looked for a tropical taste of you.
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I have given you

all the great lines

but we have yet 

to dance

I have shown all the possibilities

you have yet to show any

I have visited the stars

you are still here

and the point is

we never go

beyond our own

perspective
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While focusing on you
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I lost sight

of everything else

that is why

I'm wet

from walking into the sea

thinking I was walking 

into you

That is why 

I'm bleeding

from cutting myself in two

on a mirror

I was hanging 

thinking it was you

That is how 

I became lost

thinking I had found you

focusing too

on me.

 

12-22-93 Victor Harbor copyright Terrell Neuage(1977)
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Brandy coloured morning

revealed

last night

never ending
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Something to reach for like dawn

at the horizon

rain 

above clouds

and love

before doubt

something to reach for

never having
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We touched the stars

before we were ready

NOW

without oxygen

without bodies

without life

WE search

how to come back down-to-earth

once again
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http://neuage.indiko.com/collection1.html (113 of 318) [3/8/08 3:04:49 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

It's o.k. to take a break

waste some time

take a nap

go for a walk

fondle

the sun is expected 

to shine

for a few billion

more years

and so can we

or at least

some part of

us

 

5-7-93 Victor Harbor copyright Terrell Neuage(732)

We are always

While pushing past the limits once believed

I tossed away bewilderment with

'I don't think it is possible'

touching space and understanding it too
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so that all achievments until now

were nothing more

than cave paintings

just some muddled hieroglyphics

like old age without reason

But that's all behind

back in humanity's nursery book stage

Freedom is the real frontier

with fear of guilt and misplaced beliefs

being the savage native

hiding in the psychic

waiting to attack free thinking

with primitive weapons

of guilt, fear, and mysticism

But it is too late

freedom to know will conquer

and push the only true-value frontier open

so every universe 

without secret

is left bare
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to enter

and have

 

 

4/9/93 Good Friday Poem - Victor Harbor copyright Terrell Neuage(1810 
C)

In change

dreams come awake

in sameness

dreams go to sleep.
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Desire is the slave

of freedom

 

 

 

 

 

4-13-92 Victor Harbor copyright Terrell Neuage(155 b)

 

if everyone knew

what I know now

holy cow
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I'd be out the door

for ever more

that's for sure

But I'm not

so here I am

waiting for more

outside your door
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In chosen images 

beliefs reveal 

what is real

like this moment does

rising over a new horizon
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in unsettled times

where seas

pierce clouded evenings

tranquil message

of what is believed,

and in tomorrow like again today

the future's past

reveals secret's timely wish's desire

held like forever's reflection in today

again found to be 

everything worth waiting for

so as to say

yes it was as real

as ever it was meant to be.
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In ancient thought

beyond reason's pillars
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everyone came together

to predict the future

in Diana's shower

But they turned on the video

and forgot to leave behind

much more

than our ancient interpretation 

in times

that dispels

all

 

 

(554)

 

Sun doesn't see

moon doesn't rise

But we do

each time

we watch

where we're going
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somewhere beyond

destiny's favorite thought
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The past 

paints

tomorrow

But if we let go of it

tomorrow 

will have

no added colour

to make it complete 

(and memories only sleep)
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'93 Victor Harbor copyright Terrell Neuage(1424)

This moment

is so close to perfect

that to make it so now

is

no more

than a simple

rearrangement of the way it is

with open door

as an invitation

for nature

to join 

in too

 

 

 

 

'93 Victor Harbor copyright Terrell Neuage(1498 C)

This life

like so many before
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is but a shadow

of our selves

travelling at the speed of laughter

through the universe

on our way

to a fish and chip shop

the only planet

that sells them
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THE BIG BANG

WAS 

JUST
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A WHIMPER

COMPARED TO

WHEN WE MET
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I awoke before time began

before music

before thought

before silence erupted

into the beginning of now

with all the followers

still waiting to awake
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FORGOTTEN

FREEDOMS

FOUND

FROZEN

FAVOUR

FOREVER

FREE
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4-93 Victor Harbor copyright Terrell Neuage(228)

 

How good we are tomorrow

depends on how bad

we are today
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The flower of youth

blossomed

while I looked

the other way
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now in memory

I return

to when my name

was the one called

in morning's sleepless desire

 

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(1402)

 

Forgetfulness of now

took me back to when

I remember you

whispering to me

'never forget this moment 

and it will last forever

somewhere in mind' Now I am a forgotten foreigner

forevermore

full of

forgetfulness
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of now

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(228)

For every gate

that opens

a crowd cheers

I can't see

but I hear

as the melody of strangers

asking for change

like any weekend weather person would
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The only predictable future
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we well 

ever experience

is when we do

what we do

of what we chose to do

 

 

 

4-19-93 (936 B)

I couldn't

t wait

so I rushed toward

the open door...

only realizing there was no floor

on the other side

after my free-fall had begun

lucky for me

I carry a parachute everywhere

for just such an emergency 
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In broken images

and meaningless dreams

the future is drafted

and superglued into place
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While breaking shackles off of
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who we perceived we were to each other

we fell in love

with who we would have been

if broken shackles long ago

had shown us now - then
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While waiting for a new leader

humanity put on clean wool socks

and though it is true

everyone was as lost as ever

we all had warm feet

that didn't smell

and with over five billion people
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that is what is important.
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Platonistic specialization

almost stopped love's integrating freedom

from taking flight

out of the mystic plagued night

that descended so long ago

but now nears its end

as we break the 2000 year old shackles

off of the slaves

we have been
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4-9-93 Victor Harbor copyright Terrell Neuage(1204)Until just a 
moment ago

 

 

everything made sense

now

I will have to
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start all over again

so I say it was logical
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In the silence of my memory

you whispered a song

we once danced too

under a spring filled song

in Golden Gate Park in 1967

And in closed eyes

I now disappear

into your long ago promise

'You'll never need anyone else but me'
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But the ticking of my clock

the barking of the dog

my children yelling for dinner

makes me open my eyes

remembering

I hadn't thought of you

for at least 20 years

until now.

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(649 C)

I am moving to Saturn

where there is more room

more moons

it's a heavy place

the days are longer

and it takes 28 years to equal one year

so now

I can finally get all those things done

I always said I would
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and go multi-moon gazing

with the ones I love

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(292)

today is better than yesterday

tomorrow will be worse

than last Friday

But next Tuesday

will make yesterday look sad

so there!

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(1531 B)

Childhood spent
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childhood saved

childhood's woven parts

superglued together to remember

the moment each piece was a part of something bigger

that went broom broom click click

tick tick like a clock

(that measured the passing days of childhood)

Children never grow old

they just sprout wings and fly away

returning now and then

to look at how everything

once was together

once was a part of a movement

once was a part of everything that really mattered

until

like sections of life they were reassembled

in a mosaic of memory

just abbreviations of symbolic wholes

where one piece represents

what was played with for weeks at a time
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in the labyrinth of childhood

and now is but a collage

on one of the walls of my life.

 

4-19-93 Victor Harbor copyright Terrell Neuage(106)

they've taken away

the walls

left me

with no boundaries

no blocked views

no hiding place

I roll up into a ball

and roll out into the open space

I never knew existed

until they took away my walls

 

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(1465 B)

While stretching logic
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like some do the truth

I noticed an empty explanation

in the corner of a theory that could have unified it all

so now I am proud to present

the X factor that will unify all of existence

that holds it all together 

that was there at the Big Bang

and will be there at the Big Crunch

and the little nibbles afterwards

and wait for it

it is laughter

that holds it all together

Because it is true (I was there)

the beginning of this present universe

started with a sneeze in the middle of a laugh

and all the galaxies

are just droplets from that sneeze

 

4-20-93 Victor Harbor copyright Terrell Neuage(1811 B)
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the meaning of aloha

(hello - goodbye)

changed when you never returned
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It is better

to seek agreement with ourselves

than solicit it from someone else

don't you agree?
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I liked last month so much

I didn't change the calendar

and that made me so happy

I decided to change it back

all the way to when we met

twenty years ago

when I was only a day younger

than I am now

according to my calendar

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(496)
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I talk fast

because I have so much to say

while others listen slowly

so they don't have to hear it all

but that's o.k.

Because the words in between

seldom have much meaning

anyway

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(662 B)

...whether is is better

to be creative and poor

or rich and uncreative

I will know once I become rich

after I find

the most creative way to do it
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While putting things in order

I noticed how random

the galaxies were tossed about

and thought if they can do that

so can I and that is why\
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everything looks so untidy

 

 

 

 

4-20-93 Victor Harbor copyright Terrell Neuage(1810 D)

I wanted to believe

what I used to 

but reality

swept away the myths

But I remember the stories

and tell them to my children

who never believed them 

to begin with
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There are over 5 billion people on the planet

and only one in this space

at this time in history

with these thoughts

and it will never occur again

 

 

 

 

 

 

 

4-21-93 Victor Harbor copyright Terrell Neuage(1429 B)

I thought it was

sounds of waves crashing upon the shore

waking me from sleep

But it was just my stomach

telling me to forget

my diet

and eat a snack
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in rhythm to waves upon the shore

 

 

 

 

 

4-23-93 Victor Harbor copyright Terrell Neuage(668) 

All the strategy

of all the people of all time

can't stop the rising sun

or love, death, taxes, birth

all the philosophies, myths, beliefs

have not changed the colour of the sky

the size of a mountain

or anything much of all

which gives little meaning 

to why

ham on rhyme

is better than tofu on sprouts
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8-23-93 Victor Harbor copyright Terrell Neuage(14 B)

It was as if

you knew all along

and had to wait

all these years

for me to realize

we have been together

in one form or another

since the beginning
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Even with

all the distraction

of these times

I managed

to deliver fax-free
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in person

all my feelings for you

to you

and again tomorrow

too

 

 

 

4-24-93 Victor Harbor copyright Terrell Neuage(178)

It was as if yesterday

never had ended

But was just put on pause

for us to experience today

so we could go back to it

tomorrow

again
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4-24-93 Victor Harbor copyright Terrell Neuage(734)

change creates love

love creates change

create to change

change to create

love to change

change to love
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So simple to please

so please be simple

and let complications melt

like I do 

when we are one
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I wanted the last word

and that's why I'm still here

in the middle of time

and I'll be around at the end

if it too

just to have 

the final say
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* 466 (12x12)

NEC
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Just before God

went off on holiday

I asked if things would change

There was no answer

that was when I realized

God had left earlier

than anticipated

leaving us

in change

to sort out the mess

we're in

 

 

 

 

 

 

June 7 1993 Victor Harbor copyright Terrell Neuage868
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*=465 11x11

NEC

In the fickle

realms of reality

meanings

are invented

as explanations 

while in my world

where reality

is kept out by walls of gold

I am free

in the security

of illusion

and the realism of magic

cascading

through senses

that never were

to be included

in this world

but
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and more ?

No! There was never meant to be anything but this

passing dreams

we have been

seduced by

8-7-93 Victor Harbor copyright Terrell Neuage580

 

 

 

* = 464

NEC

 

 

 

 

 

 

 

 

LIFE 

IS SHORT AND STRANGE
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LIKE

AN ANCIENT POEM

BUT

LIVES FOREVER

LIKE AN ANCIENT POEM

 

 

 

 

 

JUNE 8 93 894 Victor Harbor copyright Terrell Neuage110 VICTORIA 
STREET

 

not quite

but close enough to have a name

different

but up close it all looks the same

meanings

slip away before dawn's early reveal

your touch

http://neuage.indiko.com/collection1.html (154 of 318) [3/8/08 3:04:49 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

for a moment was almost real

tomorrow

maybe longer

pattern upon pattern

assembled secrets

chant my name

who am I?

but just another not a name

lingering on the tip

of too many swallowed 

meanings

and by listening once again

the whispering shadow

reveals

your touch made me real

7/28/93 110 Victoria Street (1134)

 

 

THE WHISPERING MIST

REVEALED

YOUR TOUCH MADE ME REAL
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SO NO LONGER

A SHADOW TOO

I'D BE

 

 

 

 

 

 

7/28/93 100 Victoria Street (1486)

 

 

in Sarajevo, Belfast, Beirut, Victor Harbor, Los Angeles,

trees grow flowers bloom rain falls

doing what they've been governed to do always

like humans

fulfilling genetic destiny

to war, dispute, desire but never learn

and over looking nature 

who will be and always has been unlike humans
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who were created

for nature's amusement

and who will stay 

until something better

can be created

(this time with some proper genes)

a few dawns 

down the road

a few yawns

left in the mold

a few pawns

of nature's soul

then wooosh

only nature

left

humans 

left

7/29/93 (614(

STARS SO FAR AWAY

take no notice of our daily
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wants wishes

dreams desires

loves losses

games growths

problems possessions

beliefs bingo

troubles thoughts

adventures appreciations

families fortunes

But live their cycles

no matter what we do

like love

so far away

yet always

within sight

7/29/93 110 Victoria Street (1352)

Why only in my waking dream

before dawn's shadow stealing smile

do I find us

so wrapped together

like once we knew
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but too soon forgot?

You not on the earth

me so imprisoned in this form 

dreams link us when I am not quite here

And you so surely elsewhere

is memory playing with mirrors deep in my brain

this perfect hologram of you

reflecting our love forever

though where forever we will be one

I do not know

But you are there constantly

(except when I open my eyes

which I do less all the time in fear of losing you forever

before I find the way to you)

Handing out your smile

asking me to follow but I can't 

the dawn came you left today alone

once again I am blind with my eyes open

7/29/93 110 Victoria Street (1818)
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the proof I have

that much I had

to prove

is simple

I'm a man

born of hand-me-down-genes

explorers, conquerors, kings, lovers, saints, jesters

it's in the genes

fighter pilot, basketballer, rocker, movie star

it's in the dreams

today's dreams tomorrow's genes

the only proof

a man will ever need
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7/29/93 110 Victoria Street (1424)

 

 

 

just as I wrote

in New Orleans, Paris

Honolulu, Fiji, Berlin

Sydney, Auckland, London Bangkok

And the places in between

I will write someday

in a space colony

flying past Mars

or on a moon of Jupiter

just as my ancestors

from caveman, to Plato, Jesus, King Arthur, handfuls of Kennedys

Don Juan-Don Quixote-Don Terrell

and the ones in between
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I will write on and on and on

just as all men before me

'how doth I get me a woman tonight'

TECHNOLOGY CHANGES

MAN'S MIND NEVER WILL

 

 

7/29/93 110 Victoria Street (868)

 

winter on parade

frozen

waitings

wanting

wonderful though weird

we

were

writing upon frozen consciousness

like human beliefs

frozen in place

for thousands of years
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needing

a good nuclear winter

to start the cycle

over

once

again

 

 

 

 

 

7/30/93 110 victoria street (1816)

 

 

 

 

I had you in my dream

we made morning come

I had you in my dream

you gave birth to our shadow
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I had you in my dream

safe-sex again this morning

 

 

 

 

 

 

 

 

 

 

7/29/93 110 Victoria Street (456)

 

POSSESSION

while in a dream

silent mist's shadows

its illusive impulses

becoming incoming coming

wrapped by your desire

projected in astral illusions
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I opened up you entered 

took my body for a spin

around la Grand Palais

through la Arc de Triomphe

(where 'we' had a few in a nearby shadow)

then the disco

on Boulevard la Villette

where 'we' charged a night of pleasure

on my wife's credit cards

now awake me in my own body

back at the hotel

I try to explain to my wife

that it was not me on the all night carousel

as love's scents ooze out of my body

and my hoarse gin breath vainly whispers

but but but

it wasn't me I was asleep

while my body was being used

as all men's are in the final analysis

7/30 110 Victoria Street (1810)
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The last time

I saw my love

was where she stood swaying in scented smile

selling her body

to passing relatives and friends

on her fund raising drive

to buy Bibles for the Russians

and provide low cost love

for the poor
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july 31/93 110 Victoria Street

 

 

 

 

if all my heroes knew me

would they still believe

they were just

a mistake of nature

too?

 

 

 

 

 

 

7/31/93 110 Victoria street (342)
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Too often

while meaning something else

the rain fell

the farmer cheered 

sport fans jeered

Too often

while meaning something else

the waves swelled

fishermen ran ashore

surfers grabbed their boards

Too often 

while meaning something else

I ask for love

but never for long

 

 

7/31/93 110 Victoria Street (1552)
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The last time 

I saw my love

was where she stood smiling

selling her body

to passing relatives and friends

on her fund raising drive

to buy Bibles for the Russians

and provide low cost love

for the poor

 

 

 

7-31-93 Victor Harbor copyright Terrell NeuageSA (1408)

 

 

While being slaves of love
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men will never be free

to be possessed by nature

naturally
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8/01 Victor Harbor copyright Terrell Neuage(1809 A)

 

 

 

 

 

men are born free

(according to the constitution)

but all women cost

(according to reality)
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8-10-93 Victor Harbor copyright Terrell Neuage(970)

 

 

 

 

contact made

like being one 

past minutes

equalled

rolling forever

automatically

like thoughts once so sure

to find the reason

for this
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is too

and 

little

more

 

8-10-93 Victor Harbor copyright Terrell Neuage(130)

 

 

 

 

While writing worthless rhymes

I fell off of a verbal

burble

and never found

my way back
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8-01-93 Victor Harbor copyright Terrell Neuage(1815 B)

 

I met a man 

whose stories came true

as soon as they were heard

I met a woman 

whose songs came true

as soon as they were heard

I met a child

whose wishes came true

as soon as they were heard

 

But I've never met 

anyone 

who knew

how this 

ends
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August 11 93 Victor Harbor copyright Terrell Neuage(538)

 

 

 

 

Driven passion

leaps hurdles

forward thrusting

life changes

in blinks

faster than Pluto's stolen shadows

past burn fast

the new me

you see

is to be free
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without thought

of patience

for the role

I once played

 

 

 

10-02-93 Victor Harbor copyright Terrell Neuage(158)

 

 

 

 

 

While wishfully waiting

we watched where we were

sneak us into

last night's remembered touch

and while loosing control

lost in your breath

we disappeared

never to be seen again

http://neuage.indiko.com/collection1.html (176 of 318) [3/8/08 3:04:49 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern
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Like a new page of life

turned too many times

morning's misting memories

made me

remember you

when we galloped forests

to our allegoric lake

We rolled in laughing love
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and captured fleeing passions

that never wanted flight

to begin with

Like now

in too many turned pages\

to remember 

when first

we started over

this our allegoric night
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Asking answers' allegiance

while not
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leaves outdoors there
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11-05-93 V ictor Harbor (56)

 

 

 

 

SHOCKED!

Perception's reflected illusion

reversed reality

I couldn't see

But only beg

I couldn't feel

beliefs were all wrong

morning was night

flowers turned to seed

touch turned to stone
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that made no words

I slept while awake

But IT was all a dream

this isn't

no longer

Shocked!

 

11-05-93 Victor Harbor copyright Terrell Neuage(1260)

 

 

 

 

 

 

 

forgotten foreign feelings

forged freedoms

final 

fate

no longer here
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11-6-93 (218 b)

 

 

 

 

without all the differences

there
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would be

no picture
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In dawn's early revival

I cheered
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to know

this show

I was part of

once again
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While at centre stage

I changed my script
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so this performance

you see

is but a change

I'm going through
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I won

I lost

I was

I am
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Changes came quickly before summer's settled passions

oaths were whispered as spring sown seeds settled passions

the times surely so seemingly sullen

would be remembered when now

would be read as ancient history

inventions failing prospering believers

found anything to hold onto gelatinous as first love

But there is the future no one knows everyone predicts

Though no one is quite correct

Touch my mind in pulled forth desires
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dig deep death's dwindling demand

take changes

reshape nature's woken woven womb

whisper to the deaf

wave to the blind

walk with the lame

wake the dead

wonder what was where when no one was there

Fleeing freedom fondles the enslaved

shackles clasp the different

But for all the troubles

all the worries

all the struggles

That this all important tragedy firmly hangs onto

Nothing can be greater that to know some day

This moment will be viewed as but a hiccup in nature 

when changes came quickly

and oaths were whispered only to never be harvested

The future came too fast to think of now as anything more

than a passing shadow eclipsed

11-6-93 Victor Harbor copyright Terrell Neuage(104)
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Your touch

the change

global warming

here to stay
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initial surrender

lost time

borrowed destiny

controlled laughter

on we could go

choice so rare

or here stay

dwell; on

the whence

of it all 
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11-16-93 Victor Harbor copyright Terrell Neuage(572)

 

 

 

 

I thought we could share the moment

as if it were 

the last, the first, even forever

we'd be unleashed nature

watching humanity begging for rest

we would be the condemned's

final wish

the cry at birth

the anguish at the end

the fireworks at the completion

of the games

the ecstasy of every experience

pulsating in one Grand Moment

I would be your knight, love, knight, love, king, slave, 

fool, hero...
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even a new-age male

if such a perversion

was your wish

Oh! I'm sorry

you just were asking me what time it was

here, in front of the caulaflowers and parsley

at the supermarket

11-7-93 Victor Harbor copyright Terrell Neuage(680)

 

 

 

 

 

 

Caught in between changes

without names

theories without masks

desires without dreams

caught in between voids

where changes create
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voids

creating change
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Forgotten

once again

like watching life pass too quickly

without holding onto

passing reality

nothing comes to be forgotten

and a man in the last row

waves his hands and yells

"forgotten

I'm forgotten"
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But no one hears him 

as the crowds huddle together

trying to remember

what they had forgotten
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I tossed away meaning

like I do apple cores

But it's o.k.

the seeds will grow

and produce meaning

like I once did

before tossed away moments

were used for the landfill programme
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at the edge of the swamp

to build skyscraping apartments

for people to sit in

wondering why there were so many memories

tossed about.
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So much the end here:

less likely futures' glimpse

echoes momentary freedom;

and here brought forth meaning

holds wind chimes'

rhyme
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nature's time

the end falls

from sight

the past strips naked

and sun bathes alongside memory's reflected copulation

HEAR

so much the end.
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When the patterns changed

so much the end looked clear

everything was answered

time lost prescription space discovered dimension
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all figured out the way it should be

why it never is I don't recall

each time a different ending

still the same

always far from the way it should be

if, all-figured-out

was true.
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While building on what went before

I saw tomorrow

glance around the corner

and thank me
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for the foundations 

for future's experience.

 

11-17-93 Victor Harbor copyright Terrell Neuage(1809)

 

 

 

 

 

Too late the thaw

when winter's open door

lays waste

hasty autumn's retreat

and ice slices

fields of harvest forgotten

too late too late

like life known

and frozen in winter's

crystal memory

waiting for spring
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like every lover does

 

 

11-17-93 Victor Harbor copyright Terrell Neuage(1540)

 

 

 

 

While laughing at the changes

even making believe they weren't real

this moment took flight

with me in tow

And I have no intention of every returning

to say

these changes now

are anything more

than forever lost in flight.
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Each variation

is but an interpretation

of choice.
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While floating upon

thoughts of you

the world slipped away

leaving me to wonder

where'd I'd be

if I wasn't floating upon thoughts of you
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11-18-93 Victor Harbor copyright Terrell Neuage((1809 C)

 

 

 

 

 

What we shared

even tomorrow will remember

flying free forever foreign feelings

while watching where we merge

as always we expected

we would
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Without appearing

repetitious

all I want to know is

have I presented before

what now

so often it seems I search

the touch
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WELL!

The point never was anything

anymore than not appearing

in changing beliefs:

Like a stunt actor

filling in

while this moment goes on

and I stay behind
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11-16-93 (1684)

 

 

 

 

 

 

 

More like new morning

each thought of you becomes
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Surprised

the prize rises

but no one held their breath

the wind blew instead

in its tortured

swallowed way

surprise surprise

silently the moment explodes

ripping satin covered dreams

and ravaged virgin thoughts

Take; me

Give me 

There is no exchange

when new born hope drowns
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where too the end?

never knows who to tell
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Changes

like dreams

are programmes

synchronizing
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who we'd be

if all we could be

was let free.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://neuage.indiko.com/collection1.html (210 of 318) [3/8/08 3:04:49 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern
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Perception is just interpretation

And how I perceived you

when we met so long ago

is still the same

because

I never listened too

the world's interpretation
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4-24-93 Victor Harbor copyright Terrell Neuage(1192)

For everything that became

in the way we thought it would

good on ya

and how'd it happen

so as to do it all again

today

 

 

 

 

4-25-93 Victor Harbor copyright Terrell Neuage(218 B)

If I hadn't eaten tomorrow

there'd be something

for the rest of you all

to look forward to

but since there isn't

I'll take your praise today

and remember you well

tomorrow
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creativity is a natural

mutation of nature

free-will is its mutinous crew

and we 

the passing strangers to this life,

the disillusioned captains

looking for a better course

 

 

 

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(136)

 

 

love is a bird
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blown-away

on the first day of hunting season
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love is an experiment

that nature evolves with while

philosophy, religion, psychology

politics and the economy

are the stumbling blocks 

after the hurdles

on the way

to love's tasteful experiment
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I take all the concepts

put forth in a philosopher's

life

and sum it up in a few lines
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and feel good for all the trees saved

instead of explaining in volumes of books

'ain't she nice?

and that's why we're here folks...'
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The new empirical theory of blind love

is you and me

out-of-sight

out-of-mind

together
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4-27-93 Victor Harbor copyright Terrell Neuage(1410)

While searching through

memories on file

I accessed the spring dawn

when we rose out of our selves

in tune to the sound of our breath

that echoes now

through a deep memory of long ago

and where are you now
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In forests of forgotten flavours forever forgives foreign freedom for 
fighting frozen memories

tonight
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The most creative moment of the day

is a moment before we awake

when the waking hours are designed

then hidden behind the screen of back-on-earth again

like when we were born

http://neuage.indiko.com/collection1.html (218 of 318) [3/8/08 3:04:50 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

and to change that moment

would be to change

creation itself

which my dog told me

just before I awoke

this morning

that is not our lot to do

probably

 

4-27-93 Victor Harbor copyright Terrell Neuage(1410)

unlike other poets

who try to sound all flowery, rhyming, mystical, and abstract

I prefer to write down-to-earth-truck-driver's-poetry

like

'hey, where ya goin' baby? 

how about some real lovin' tonight'

and no poet has ever said it

quite as beautiful as that.
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4-27-93 Victor Harbor copyright Terrell Neuage(1573)

We began where we left off

only the century had changed

Now there are flying things

with people in them

and mechanical monsters

carrying the people

doing the work

yeap it was different

but we are the same

I suppose

everyone

really is 

at night with the lights out

it could be 400 BC still

and you would taste just as good
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4-27-93 Victor Harbor copyright Terrell Neuage(1630)

I went to count my money

like I once did my women

OH NO! 

broke again
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full of worry

that missing you

would blind me

from starting over

with someone else

who someday I'd miss too 
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like I once did

and now worry

will never stop 

you

 

 

4-27-93 Victor Harbor copyright Terrell Neuage(234)

 

I showed everything I felt

lucky for me

the President said

it was just another

nuclear accident
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I waited to see if anything

would ever become of me
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before accepting my fate

to be kind of all the local galaxies
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In my humble opinion

God should be

fired
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If we had stopped saying
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this is too difficult 

in 1777

let's go home for tea

we wouldn't be

watching today's battles

on the 6 o'clock news
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I was so sleepy

I slept standing up

while the world

lay on its side

watching
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Like a cloud-free

wind strewn sea
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I reached to be free

But a dawn hugged horizon

showed me

BOUND and ALONE

to WISHES and DREAMS

that filtered through

passing times

when voices believed

merged with my final thought

sinking

this wind stream sea

with me

gasping for a new philosophy

that made sense

to my drowning world.
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waiting for love

is like waiting for a computer to load

with so much memory

and functions

that no end is ever to be

unless it becomes unplugged 

and has no back up batteries.
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So cold

sun so far away

night so close 

of ever I'm warm again

I'll save it 
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at least

in memory

so that when I'm so cold anew

my memory will thaw

my frozen perceptions

that chill me so now

 

6-2-93 Victor Harbor copyright Terrell Neuage(1302)

 

if love

has to 

be explained

it then is a philosophy
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everything we do

is just a preliminary
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for when

there is nothing

left to do
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I don't know why

can't explain it now

perhaps never will

but life never ends

only perceptions

of the moment end

like this verse

one line at a time
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Not enough time?

where'd it go ?

Not enough space?

who filled it up?

not enough love?

why'd they take more than their share?

painted greatness?

we ate the colours

trying to fill time

erase space

wash away loneliness

And that is why 

I am here

you are not 

 

7-6-93 Victor Harbor copyright Terrell Neuage(1130 B)

packaged feelings

on tour

your love 
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my souvenir

come again

like your smile

foreign visa

desire's passport

This is not the real me

I am just like this

because I'm on holiday

your touch

my souvenir

of packaged feelings

placed away

for a rainy day

when I'm without you.

 

 

6-7-93 Victor Harbor copyright Terrell Neuage(1182)

spent the day

sitting in a warm bubble bath

watching life's truths

ricochet off bubbles
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unlike my children

Though I was being lazy

not making their meals

sewing clothes

cleaning house

But I worked very hard to find truths

here in the bubble bath

and the truth is

it is better in here

than out there.
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poems 

like dreams

love

fantasies

and were never meant to be 

translated

interpreted
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realized

 

 

 

8-7-93 Victor Harbor copyright Terrell Neuage(1210)

Without amnesia

we can never

know youth's passion again

like a flower closed

would open again

if it chose

to break free

of what it perceived 

to be its only way

to be
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I translated my feelings

for you
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in so many ways

that I forgot

which language

you understand

and I'm left incoherent

like love is

7-9-93 Victor Harbor copyright Terrell Neuage(720)

it was as if tomorrow had never had happened

and what 

we were looking forward to

was yesterday

before time had yet to discover 

liberality.

 

 

 

7-9-93 Victor Harbor copyright Terrell Neuage(735 A)

The problem with my writing 

is that it begins

before it ends

just like us
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now 

at our beginning

 

7-9-93 Victor Harbor copyright Terrell Neuage(1424 C)

stayed awake

when I went to sleep

to see

where dreams begin

and I discovered

the truth

dreams are televised broadcasts

from a planet of a neighboring star

and their electronic waves

always passing through the earth

are on the same frequency

as our dreams

so it's obvious that what we dream

is just so many soap opera

from a distant star
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7-9-93 Victor Harbor copyright Terrell Neuage(1352 C)

Sitting side-saddled

on a shadow

should show

shades of substance

finally found

so fulfilled

But as times travel

so do shadows 

never showing

which side

is best

like love

and the morning after

and shadows of fences

yet to hurdle

 

6-10-93 Victor Harbor copyright Terrell Neuage(1278)

I thought you were
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someone else

than you are

You thought I was someone different

than I really am

so our someone else

got together and had a real good life

while the real you and me

have had a terrible time

being together

wondering why we weren't

someone else

together

 

 

6-9-93 Victor Harbor copyright Terrell Neuage(680 B)

The good poets

write about

Zeus, buffaloes, dew, trees, morning

But since no real man

is really a poet

I write only about
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nails, hammers, chopping trees, 

footy, beer, and trucks

Because no one

wants sensitive

when they can be a man
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While waiting for fame

I lived and died

and left behind

nothing at all

Because I found fame

on a distant galaxy

that will last a lot longer

than this short lived galaxy

our short lived sun

spends its short life

shinning on
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a short lived planet.
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Behind the mountains

Beyond the sea

in the depths we believed

Bright birth borrowed

tomorrow

thinking forever was a circle

now that we know better

we can rest easy

and live now

like we are

in the midst of forever

 

 

 

 

http://neuage.indiko.com/collection1.html (240 of 318) [3/8/08 3:04:50 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

 

 

6-12-93 Victor Harbor copyright Terrell Neuage(78)

 

The evolution of belief

brings little relief

when the beginning

is unknowable

until now

But for $4.95 plus $5.50 postage and handling

all the answers

will be questioned

and if you act now

a free match will be given

for evolution of belief

to return

to the ashes it first rose from
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6-12-93 Victor Harbor copyright Terrell Neuage(1402 A)

while empty of thought 

I caught

a meaningless pattern

shapeless as love

when first met

I placed it in a motionless container

while rain outside suspiciously fell

and wrote in a cloud above it

'Beware - meaningless pattern near'

but the rain erased my sign

and flooded my empty thoughts

So if I pretend to understand

and smile awhile

remember

so I won't have to next line

 

 

6-12-93 Victor Harbor copyright Terrell Neuage((1809 F)
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To say what everyone wants to hear

like the great Australia statement

is the only reason

all else

will be fillers

until that time

 

 

 

 

 

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1552 B)

As complex

the future may be:

life will be simple

needs met

wishes answered

dreams controlled
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with instant answers

perfect solutions

yet still no cure

for love 

will exist

which is little

different

than

in the beginning

 

6-13-93 Victor Harbor copyright Terrell Neuage(61 B)

Sun rises 

rain falls

river flow

mountain sit

while the rest of us

run around in circles

sorting our selves out.

If we know something nature doesn't

should we say

'hey, we're humans
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we got it all figured out'

or should we let nature

continue along 

without our help

 

6-13-93 Victor Harbor copyright Terrell Neuage(1362 C)

Love like a sun rise

happens every day

but only if we're awake

do we experience it
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While swimming

to the end of this dream

I encountered reality

floating on top
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in a bubble

but like all reality

it popped 

on closer inspection

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1811 E)

Without words

without birds

we wouldn't know

a sentence in flight

And I would be unable

to say Mars is covered

with tomato soup

the moon was of green cheese

Venus - lettuce

and Pluto is made from tofu

(or) in general

we live in an edible section

of the milky way
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but whether we are dessert

or the main course

I can not really say

 

 

6-13-93 Victor Harbor copyright Terrell Neuage(1819 H)

EMPTY

that is the only explanation

FULL

is the goal

LOST

is the way

pieces lay alongside the road

huddled together in hysteria

the state of the condition

is frozen within its code

laughter screams in baroque sonnets

it will be o.k. 

it will be o.k.

the earth will shatter at mid-day

splintered with all its wisdom
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art, poetry and good sex

into so many empty pieces

by some love lost comet

and no one will know

that once we cared

 

6-15-93 Victor Harbor copyright Terrell Neuage(176)

Final moments exit

in rhythm to echoes

of a pulsar

at the end of our small universe

but no one knows why

we're so off-key

and nature isn't
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to understand

is to not to believe
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while getting in touch with my feelings

I tripped over reason

fell in love

and broke my heart

now in hospital

http://neuage.indiko.com/collection1.html (249 of 318) [3/8/08 3:04:50 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

I was given plastic surgery

and though I now look like 

a shadow of myself

at least I'm in touch

with myself

 

 

 

6-15-93 Victor Harbor copyright Terrell Neuage(1809 I)

For the first time

with no reason in sight

we were free 

to be ourself

 

 

 

 

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(218 E)
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while waiting for the right moment

nothing happened

and that was the right 

moment

 

 

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(1815 A)

Today passed with little importance

and so was added

to a pile of yesterdays

and sent to 

a far corner of the universe

to be recycled

as important days

for the inhabitants

of a distant planet

who live forever
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on our discarded memories

 

 

 

6-16-93 Victor Harbor copyright Terrell Neuage(1531 C)

As far as dreams can go

we will find

the end

to where

what

will

we

want

with

what we want

where we were

when we were

who?
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6-17-93 Victor Harbor copyright Terrell Neuage(61 B)

Countless times I stayed awake

to worry about

what would happen

only to find

everything changed

so much

I couldn't keep up

with worrying

so now 

like the endless line

of pine trees on the edge of town

wondering whether

they will become tooth picks

firewood

a book of poems

or a Christmas tree

I wonder

too.

 

6-17-93 Victor Harbor copyright Terrell Neuage(1166)
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I wrote yesterday

for today

forgetting it is me

and not time

that doesn't change

but stays the same

at least in thought

 

 

 

 

6-17-93 Victor Harbor copyright Terrell Neuage(860)

I took all the mistakes

ever I made

and lined them up

they reached to the moon

and now I will walk on them

and bring back some

green cheese and market it

Before anyone else
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gets the chance

 

 

 

 

6-17-93 Victor Harbor copyright Terrell Neuage(686)

It has always been

how to start

that has puzzled

and baffled

everyone so long

But not me

because I never start

 

 

 

 

6-19-93 Victor Harbor copyright Terrell Neuage(663 B)

Passions flame

quickly came
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like youthful desire

burns in the fire

turns to ash

then to dash

off into age

another page

is turned 

past burned

and the future is remembered

before it is experienced

while where we had been

is left like so many ruffled leaves

 

 

 

7-1-93 Victor Harbor copyright Terrell Neuage(1186 B)

The fools have died again

traded their life

for a belief

fought wars to protect dreams

crucified themselves for faith
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sacrificed their lives

thought we all cared

those left behind

playing at the casinos

dancing at the discos

tasting love along the shore

they don't care

what the dead believe

while they lay bleeding

with some noble delusion\

floating in their head

we the living are the heroes

because we knew enough

not to fight the losing battle

that death always is

 

7-1-93 Victor Harbor copyright Terrell Neuage(1402)

Death loves nature

in cycles of birth

nourishing eternal sleep
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society endures suffering

and calls it purpose

the reason to continue

for lessons to learn

then quickly forgotten

when death loving nature

takes one's final breath

so to suffer si so wrong

to love one forever will never be

right morals and happy thoughts die too

when death loving nature

takes the final breath that had happened 

for something more

at the end of this life

than a grave that no one can ever free

themselves from

neither to walk heaven's golden streets

or sweat hell's guilty flames
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7-1-93 Victor Harbor copyright Terrell Neuage(144)

What is poem if not to question?

Written in stops and gaps

unlike nature flowing free

who but man would sentences leave unfinished?

to toss about words

like a juggler at the matinee?

what is poem

but meaning gone astray?

waiting for the best minds to pick up

the content and bury the metre and rhymes

and name themselves critics

while expecting a good wage

to tell what the poverty struck poet

really was saying

Because he was to daft

to make it clear to begin with

and too lazy

to get a proper means of support to begin with

for what is poem
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but an abbreviated excuse

to begin with

7-1-93 Victor Harbor copyright Terrell Neuage(1738 B)

EUHEMERISM

Funeral are for the living

the dead will not see the roses and tulips picked

waiting to wilt and die

on a casket made for the living

What a waste the dead are

filling cemeteries

where skyscrapers of offices and frenzied secretaries

or a freeway or a new bowling alley

could be put in place instead

Shame on the dead 

leaving bodies to pollute the world and take up valuable space

the dead are gone

leave 'em be

why?

when I die I wouldn't be her any longer

take my body
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the good parts give 'em to someone alive

and the rest feed to the lions

at Central Park Zoo

for once long ago

I was a Christian and the lions still remember

when I am dead and all this is left

is my crying children and scribbled poems

do not wrap my death and fill the ground

to shelter my bones

because funerals are for the living

the dead are too far away and sound asleep

to ever care

7-2-93 Victor Harbor copyright Terrell Neuage(234 B)

The life she made

the life she lived

thoughts no one else dared to possess

love to desire's full extent

children born children raised

hopes and dreams 

some even fulfilled
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years and years

life's toil

it was all headed somewhere

until a robber stabbed her

she dies on the subway platform amidst rush hour traffic

people rush by

stepping over a life no more

to get home 

in time for dinner and evening t.v.

not wishing th think

tomorrow it could be them

stabbed to death for a few dollars

the sum value of one's life

to a passing stranger

a few dollars 

the price of a cheap bottle of wine

drunk in haste over a life once so full

7-2-93 Victor Harbor copyright Terrell Neuage(1408)

We slipped away

between the rain and bridge

and memories of before
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along mirrored streets

in pregnant whispers

we wanted to hide behind today

and jump out and surprise a future

the wind was strong

I felt your heart beat inside my breast

if only we could be longer than this passing storm

I would lie with you in the rain

until memories died of exhaustion

then we'd float away

like we've done every time before

7-6-93 Victor Harbor copyright Terrell Neuage(1702)

We played in words

juggled meanings

contested emotions

And still I wanted you to know

I wanted you so

But there were no oscars or trophies

for unknown acts

feelings came feelings left
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But I never could keep straight

which one was the right one

Now you're gone

Now I'm not

Now

the words play off of my performance 

just like once they did when meaning made sense

and the game was to be played not to be lost

but to be shared before too late

changed all to this past

that will always be

just apart of a part

and never again

an all

like us 

again now

7-6-93 Victor Harbor copyright Terrell Neuage(1694)

We camped in childhood

well away from who we'd be

when the world
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would want more than

what we were

when wooded wishes

were so real

 

 

7-17-93 Victor Harbor copyright Terrell Neuage(1636)

In love 

the game

is to be played

not to be lost

 

 

 

 

7-6-93 Victor Harbor copyright Terrell Neuage(564)

When at last

we take our mask off

is it not strange 

that at that moment

our life ends
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7-17-93 Victor Harbor copyright Terrell Neuage(1746)

HOW LONG THE BATH?

When first hot and bubble filled

like before birth

if I could imagine such 

when news is someone else's life

war, discovery, money, sex, hunger

the precise media

shocking a concise audience once again

"oh the way things are

what will become of it all?"

take me back to the slavery of the womb

or at least this hot bubble bath

where I lay in evolution's start

was it not out of a warm bubble bath

that life first emerged?
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I understand 

we are sorry Sarajevo, Belfast, Lebanon, LA, 

City Streets everywhere

The South will rise again

out of a warm bubble bath

But for now like in the beginning

and to be at the end

I wash my genes

I soak my soul

I merge quickly before the water turns cold

and the bubbles disappear

like death does

when life reappears

7-17-93 7-17-93 Victor Harbor copyright Terrell Neuage(1748)

Your guess

is as good as mine

and every human ever to guess
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7-17-93 Victor Harbor copyright Terrell Neuage(1886)

My reality is another's nightmare

my dreams

someone else's reality
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7-17-93 Victor Harbor copyright Terrell Neuage(998)

I came to this world in my body

and I will leave without it

the meaning of which

if only I knew

I'd be the wises of all people

the starter of a religion

the leader of every follower

the host of my own t.v. show

just like Jesus and all the rest were
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A superstar

a living legend

with the philosophy 

to match

7-17-93 Victor Harbor copyright Terrell Neuage(311 E)

Plato if you discovered death was but a change

and came back to earth with no memory of pasts

would you believe again what once you lied

or would you be a common hooker

standing at the corner of Hollywood and Vine

like all the other greats throughout history

have done at one time or another

and I've seen them all waiting for a trick 

like before Emerson, Arthur, Jesus, Aristotle, Einstein,

Jung, Mary, Joan of Arc, the saints

philosophers. poets and artists

T they all taken their turns

selling themselves for a few coins

not knowing once they had known the way

to get so many to believe 
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when nature used them

like the world does no

so well

 

7-18-93 Victor Harbor copyright Terrell Neuage(1203 B)

with a day gone by

to have nothing to remember it by

is to have it go by without ever having been

but to cast a poem

plot a painting

network a joke worldwide

on a bulletin-board

is to access interactively nature's

transparent lines

is to bond in memory

forever

that there was more

to the day

than the passing wind

7-20-93 Victor Harbor copyright Terrell Neuage(1819 C)

everything was put aside
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giving a clean slate 

like birth

new impressions were everywhere

old interpretations

like in a philosophical amnesic

surprised

even reason made sense

though feelings still didn't

and everything is now so new

and exploratively different

that 

(and it sounds so radical)

I can 

(justifiably)

write

(without shock)

the END

and know it is only the beginning.

7-22-93 Victor Harbor copyright Terrell Neuage(194)

I dreamt
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of a moment like this

now

if only

I could recall

what happened

it would be so sensible

7-22-93 Victor Harbor copyright Terrell Neuage(335 B)

everything 

every moment

every thought

is to be grand

the ultimate

what everything

was done for

while all before

was little more

than the step to now

like winter to spring is

 

7-22-93 Victor Harbor copyright Terrell Neuage(192)
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While exploring every thought ever had

I was amazed to discover

they were all edible

and luckily

calorie free

like rain

which has reflected

the world as it travelled

to earth 

so far

 

7-22-93 Victor Harbor copyright Terrell Neuage(1809 F)

As we dreamt

in anticipation

of what waking would be

life separated

leaving us

in dream 

for evermore
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7-23-93 Victor Harbor copyright Terrell Neuage(62 B)

Close to the end

meanings so poignant

that the thought will last a thousand years if not more

If God came to earth 2000 years ago

wow!

why didn't he make a video of it?

why go through the dark ages

(the years before television)

without seeing the way it was

why didn't the crusaders

have land Rovers and laser weapons?

Why didn't Jesus use a microwave oven?

to warm the food for the 500,000 at Woodstock?

Why didn't Caesar become a game-show host?

Why walk on water when one can use a hover craft and skim the top?

who changed the water to wine to blood

at Sarajevo, Belfast, La and in the Townships?

Why didn't the twelve disciples

form a baseball team instead of just getting stoned?
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Why didn't the Church build football stadiums instead of churches?

Why would one leave the job of making billions of suns - many with

earth like planets - and come to our earth?

Well it is all so obvious

God did leave videos

and when they are discovered (beneath my house)

I can say

'see I told you so'

7-25-93 Victor Harbor copyright Terrell Neuage(118)

When what was expected

drowned in the rain

covered by an avalanche

blown away be reality

believe in the immense energy

involved

to make so much expected

be but a fart in time

 

 

7-28-93 (1800)
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I've worked so hard

to become everything

I never wanted to be

that if 

what I wanted

happened

ever

no longer would I know

would you?

 

 

7-28-93 Victor Harbor copyright Terrell Neuage(766)

as if endings really were:

Like stepping out of circles

abandoning cycles

spirals

lateralness can only operate in a circle

(giving it the new age illusions we love to share)

leaves no end

beginnings don't struggle

only aborted consciousness does
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leaving returning

defining

refining

mouths opened wide

everything ever said is wrong

everything ever written false

every love has been scared

the end now is nothing more

but a return on the circle

to doing it all wrong once again

 

 

7-28-93 Victor Harbor copyright Terrell Neuage(61 B)

 

Morning swallowed

my dreams

made me hungry 

to see if 

they'd come true

like everything else
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I believe in 

does

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(978)

 

 

 

At the beginning

when all there was

was already there

waiting to be put together

like you and me 

and the galaxies

too
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5-1-93 Victor Harbor copyright Terrell Neuage(64)

I was so sleepy

I slept standing up

while the world

lay on its side

watching

 

 

 

 

 

 

 

5-1-93 (838)

the reason 

we are here

is because dawn

doesn't want to 

http://neuage.indiko.com/collection1.html (280 of 318) [3/8/08 3:04:50 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

come alone

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430)

like steps through history

or a wander through dreams

today's beliefs,efs

grew out of yesterday's crumbled ideologies

for tomorrow's

individual freedom

finally won

to take wings

never to land again

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(916)

I learned shorthand
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speed reading

computerization

experienced Paris in a day

read 'Readers Digest'

condensed pasteurized homogenized great novels

and watched history of civilization

but time stood still

when your touch

became so 

involved

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(492)

I concentrated so hard

on this moment

that yesterday and tomorrow disappeared

now

like neapolitan ice cream

melted

contains the former and the latter
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in a future past tense

that has no ease 

of

explanation 

in this moment

 

5-1-93 Victor Harbor copyright Terrell Neuage(316 C)

There is little difference

between you and me

except that I am conscious

of the little difference

(even calling them my own)

and you see them

being but variations

of your greater self

 

5-1-93 Victor Harbor copyright Terrell Neuage(1430 D)

This life goes so fast

that when I die

I will need

a thousand years
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to review all that happened

in this life

 

 

 

 

5-1-93 (1508)

The continuous pouring out

of creativity

fueled forever's freedom's

perceptual persuasion's performance

reflected perfectly

for me

to 

know

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(1394)

I wouldn't want to live on Venus
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because there are no trees

nor on Mars with its lack of flowers

and there is no chocolate on Jupiter

or ice cream on Mercury

while on earth

everything I want

is between the sea

the trees

and the shopping mall.

 

 

 

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(858)

If I knew how to write

a poem

I would

if I knew how to sing

I would
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If I could dance, take photos

paint or tell your future

I would

But all I can do

is build you a castle

in the sand

and offer it to you

before the sea

take it from me

 

5-1-93 Victor Harbor copyright Terrell Neuage(376)

the reason

we don't have wings

is because we don't have to fly north

for the winter

But can stay all winter-warm

wrapped in each other's

warmth

 

 

5-1-93 Victor Harbor copyright Terrell Neuage(946)
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The reason

we keep coming to earth

is to learn to stop dying

but we keep

getting into the Plato trap

of this is it

why keep going

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(946 C)

Not every time

is everything

going to be

the way it is

at other times

But instead

like any spinning top everything gets a chance\

to be close at hand

again 
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if we see

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(1130 C)

We rush through life

like we're in a hurry

to get to the end

not knowing what it is

except that

it will be different

than the rush through

this life is

 

 

 

5-593 Victor Harbor copyright Terrell Neuage(1768)

I write

for the same reasons

a bird flies

far from an oil slick
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a whale stays away

from a stream

and buffaloes avoid mountains

I write only 

to find these answers

that everyone else

already knows

 

 

 

 

 

5-5-93 Victor Harbor copyright Terrell Neuage(858)
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y

 

just a thought away

from not believing anymore

then to disappear

without a thought in mind

or to live forever

if we wish to believe

that
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But where ever it is

what we do

forever is created

with what is believed

now.

 

4-14-93 Victor Harbor copyright Terrell Neuage(1660)

Sharing quietly

passing perceived thought

only to be

received

through foggy receptors

like speaking

the same words

some other language

 

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(1254)

too many dreams?
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not enough time awake

to make

them 

come

true

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(1568)

The thought

we go to sleep in 

dream in 

wake

in

is in

side

but if it wasn't

we'd

sleep

dream

wake

in
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side

the 

same thought

like when giving birth

to a dream

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(1462)

Like in any dream

giving birth

only changes

after 

waking

 

 

5-17-93 Victor Harbor copyright Terrell Neuage(914)

On the 8th day

God wrote a poem

on the 9th

some people were created
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to read it

But they couldn't

so every day after more folks

were made 

so now each person on earth

represents on year

since the poem was written

and that's how long ago God wrote the poem

and since no one

as yet has read it

we are all still muddled up

trying to read

something so basic

as a poem

 

5-18-93 Victor Harbor copyright Terrell Neuage(1166)

While stopping for awhile

like a passing smile

captures a moment's trial

standing in single file
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I noticed what was the same

was each ending

like life

and every dream that follows

 

5-18-93 Victor Harbor copyright Terrell Neuage(1942)

Importance is an attribute

slippeWhile pushing past the limits once believed

I tossed away bewilderment with

'I don't think it is possible'

touching space and understanding it too

so that all achievments until now

were nothing more

than cave paintings

just some muddled hieroglyphics

like old age without reason

But that's all behind

back in humanity's nursery book stage

Freedom is the real frontier

with fear of guilt and misplaced beliefs

being the savage native

http://neuage.indiko.com/collection1.html (295 of 318) [3/8/08 3:04:50 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

hiding in the psychic

waiting to attack free thinking

with primitive weapons

of guilt, fear, and mysticism

But it is too late

freedom to know will conquer

and push the only true-value frontier open

so every universe 

without secret

is left bare

to enter

and have

 

 

4/9/93 Good Friday Poem - Victor Harbor copyright Terrell Neuage(1810 
C)

In change

dreams come awake

in sameness

dreams go to sleep.
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Desire is the slave

of freedom
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4-13-92 Victor Harbor copyright Terrell Neuage(155 b)

 

if everyone knew

what I know now

holy cow

I'd be out the door

for ever more

that's for sure

But I'm not

so here I am

waiting for more

outside your door

 

 

 

http://neuage.indiko.com/collection1.html (298 of 318) [3/8/08 3:04:50 PM]



Adelaide poetry, Neuage, Neuage Poetry, South Australian poetry, zzztried, Christie Downs, Noarlunga, Hackham, Southern

 

 

 

4-14-93 Victor Harbor copyright Terrell Neuage(350)

 

 

In chosen images 

beliefs reveal 

what is real

like this moment does

rising over a new horizon

in unsettled times

where seas

pierce clouded evenings

tranquil message

of what is believed,

and in tomorrow like again today

the future's past

reveals secret's timely wish's desire

held like forever's reflection in today
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again found to be 

everything worth waiting for

so as to say

yes it was as real

as ever it was meant to be.

 

 

 

4-16-93 Victor Harbor copyright Terrell Neuage(558)

In ancient thought

beyond reason's pillars

everyone came together

to predict the future

in Diana's shower

But they turned on the video

and forgot to leave behind

much more

than our ancient interpretation 

in times

that dispels

all
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(554)

 

Sun doesn't see

moon doesn't rise

But we do

each time

we watch

where we're going

somewhere beyond

destiny's favorite thought

 

 

 

 

4-16-93 Victor Harbor copyright Terrell Neuage(1362)

 

The past 

paints
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tomorrow

But if we let go of it

tomorrow 

will have

no added colour

to make it complete 

(and memories only sleep)

 

 

 

 

'93 Victor Harbor copyright Terrell Neuage(1424)

This moment

is so close to perfect

that to make it so now

is

no more

than a simple

rearrangement of the way it is

with open door
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as an invitation

for nature

to join 

in too

 

 

 

 

'93 Victor Harbor copyright Terrell Neuage(1498 C)

This life

like so many before

is but a shadow

of our selves

travelling at the speed of laughter

through the universe

on our way

to a fish and chip shop

the only planet

that sells them
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4-18-93 Victor Harbor copyright Terrell Neuage(1497 B)

 

 

THE BIG BANG

WAS 

JUST

A WHIMPER

COMPARED TO

WHEN WE MET
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4-18-93 Victor Harbor copyright Terrell Neuage(1388)

 

I awoke before time began

before music

before thought

before silence erupted

into the beginning of now

with all the followers

still waiting to awake

 

 

 

 

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(298)

 

FORGOTTEN
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FREEDOMS

FOUND

FROZEN

FAVOUR

FOREVER

FREE

 

 

 

 

 

 

 

4-93 Victor Harbor copyright Terrell Neuage(228)

 

How good we are tomorrow

depends on how bad

we are today
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4-18-93 Victor Harbor copyright Terrell Neuage(284)

The flower of youth

blossomed

while I looked

the other way

now in memory

I return

to when my name

was the one called

in morning's sleepless desire

 

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(1402)
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Forgetfulness of now

took me back to when

I remember you

whispering to me

'never forget this moment 

and it will last forever

somewhere in mind' Now I am a forgotten foreigner

forevermore

full of

forgetfulness

of now

 

 

 

4-18-93 Victor Harbor copyright Terrell Neuage(228)

For every gate

that opens

a crowd cheers

I can't see
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but I hear

as the melody of strangers

asking for change

like any weekend weather person would

 

 

 

 

 

9-18-93 Victor Harbor copyright Terrell Neuage(218 B)

The only predictable future

we well 

ever experience

is when we do

what we do

of what we chose to do

 

 

 

4-19-93 (936 B)

I couldn't
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t wait

so I rushed toward

the open door...

only realizing there was no floor

on the other side

after my free-fall had begun

lucky for me

I carry a parachute everywhere

for just such an emergency 

 

 

 

 

 

 

 

 

4-12-93 Victor Harbor copyright Terrell Neuage(317 A)

In broken images

and meaningless dreams
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the future is drafted

and superglued into place

 

 

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(554)

While breaking shackles off of

who we perceived we were to each other

we fell in love

with who we would have been

if broken shackles long ago

had shown us now - then
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11-1-93 Victor Harbor copyright Terrell Neuage(1809 C)

While waiting for a new leader

humanity put on clean wool socks

and though it is true

everyone was as lost as ever

we all had warm feet

that didn't smell

and with over five billion people

that is what is important.

 

 

 

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(1814 B)
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Platonistic specialization

almost stopped love's integrating freedom

from taking flight

out of the mystic plagued night

that descended so long ago

but now nears its end

as we break the 2000 year old shackles

off of the slaves

we have been
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4-9-93 Victor Harbor copyright Terrell Neuage(1204)Until just a 
moment ago

 

 

everything made sense

now

I will have to

start all over again

so I say it was logical
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4-19-93 Victor Harbor copyright Terrell Neuage(1574 B)

In the silence of my memory

you whispered a song

we once danced too

under a spring filled song

in Golden Gate Park in 1967

And in closed eyes

I now disappear

into your long ago promise

'You'll never need anyone else but me'

But the ticking of my clock

the barking of the dog

my children yelling for dinner

makes me open my eyes

remembering

I hadn't thought of you

for at least 20 years

until now.
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4-18-93 Victor Harbor copyright Terrell Neuage(649 C)

I am moving to Saturn

where there is more room

more moons

it's a heavy place

the days are longer

and it takes 28 years to equal one year

so now

I can finally get all those things done

I always said I would

and go multi-moon gazing

with the ones I love

 

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(292)

today is better than yesterday

tomorrow will be worse
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than last Friday

But next Tuesday

will make yesterday look sad

so there!

 

 

 

 

4-19-93 Victor Harbor copyright Terrell Neuage(1531 B)

Childhood spent

childhood saved

childhood's woven parts

superglued together to remember

the moment each piece was a part of something bigger

that went broom broom click click

tick tick like a clock

(that measured the passing days of childhood)

Children never grow old

they just sprout wings and fly away

returning now and then
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to look at how everything

once was together

once was a part of a movement

once was a
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Positions for noon July 
04, 2000 : Adelaide. 
MOON: 14leo52 ~ SUN: 
12cancer26 ~ 
MERCURY: 16cancer10R 
~ VENUS: 18cancer39 ~ 
MARS: 11cancer43 ~ 
JUPITER: 0gemini47 ~ 
SATURN : 26TAURUS58 
~ URANUS: 
20aquarius13R ~ 
NEPTUNE: 5aquarius48R 
~ PLUTO: 
10sagitaruius43R ~ 
CHIRON: 
13sagitarius00R ~ 
CERES: 1libra04 ~ 
VESTA: 27capricorn11R 
~ PALLAS: 3virgo33 ~ 
JUNO: 26aquarius31R ~ 
CUPDIO: 2sagitaruis56 
R ~ HADES: 19gemini37 
ZEUS: 3libra56 ~ 
KRONOS: 28gemini41 
APOLLON: 20libra02R ~ 
ADMETOS: 20taurus35 

GOOD LUCK

Mercury is still retrograde 

CLONE THIS 

Wow. What a week this has been.

Firstly, I get the final three-thousand still owed bill to the Australian Baseball Federation 
for my 16 year-olds trip to the U-19 World Series. As any sole parent would know these are 
bills we like to leave in the mailbox. They want the money this week, before my son 
leaves for the many tournaments during the next two-months. Sure, no worries. I have 
$3.20 in cash. Thanks to the Southern District Baseball Club for holding a fund-raising 
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dinner last weekend I am able to make a dent in what is still owed. Considering the total 
bill was originally $8,368.70 plus I have come up with close to $3,000 spending money, 
still owing only $2,273 is pretty good in my world, but of course, not in other's worlds.

For an unemployed sole-parent uni-student I am doing OK. Money owed can sure make 
everything surrounding one's life problematic. Yes, I realize transit Saturn in 27 Taurus is 
sitting (shitting?) on my Moon, but I have had that before (it happens every 30 years or so, 
so by my age it is old hat) and with my progressed Sun sitting on Neptune for this year I 
doubt I will see anything properly anyway, and with Solar Progressed Uranus (ruler of my 
fourth house) conjunct my Leo Sun (ruler of my tenth - hey, it is time for attention) and 
squaring my Jupiter, in my first, in the same year as transiting Uranus in my fourth is in 
opposition to my Sun and squaring Jupiter in my First. Someone like changes? 

But that is just my life, simple as ever. The real big news this week is the completion of 
the human genome project. Now there is one shit of a reality. Designer children? No! 
Listen, it ain't the way of evolution. It is good that some crap can be fixed but the point is 
being missed. Evolution is what changes everything. If we get too stuck into perfection 
and design there will be no room for the new. Hey Darwin where are you in our hour of 
darkness?

Mutation is the spice of life. The idea that sex will be only for fun, and not for propagation 
- well that is fine, but it misses too much. Sure it is pleasurable, but the real purpose of sex 
is unification. Of course they have a different perspective than we do. See, there is a 
problem right there. I don't want to say she, that is he with an s added to he, to say human 
has man in it, woman has man in it. Dale Spender is right; males have taken over through 
the use of language. I think in a future unified world real sex that is really gratifying will 
have to be a mutual union, something missed these past thousand religiously controlled 
perspective years. It has gone for thousands of years. The local priest sticking it into the 
local youths: male or female, and getting away with it. The genome project may be able to 
delete the religious gene - which would change the world right there. Get rid of religion 
and we can progress. If it hadn't been for the church controlling everything in favour of the 
male (yes, I love being a male, but not that type of male) there would not be the diseases 
such as AIDES and etc. there would not be the drug problems, the polluted earth. Isn't it 
right there in the beginning of their Bible "and god gave man dominion of the earth..." 
well it doesn't take much looking around to see the result of that male manifesto does it 

The way we got where we are today is because of mutations, trial and errors. It would be a 
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shame to delete that aspect. For example, who are the best sports people today? The best 
mathematicians, feminists, philosophers, run on sentence writers? They are all the results 
of genetic mutations. It is change and spontaneity, which produces progress. 

And while we are at it. The cloning trip. Hey, it aint' about to happen. One thing not 
discussed in all this is reality. There is no way to clone another person unless you clone 
every experience, every thought; every feeling that person has ever had, Which could 
mean other life dimensional experiences. Are people really this stupid?

There is the metaphysical aspect too. Real? Who knows? Who cares? But let us say the 
concept of balance is a reality. Well then obviously the next step is that for every action 
there is a reaction (karma). It is not far to go from that thought to realize that if we don't 
sort out our shit this life time, if what we do harms others, the planet, our own evolution, 
then of course in the laws of cause-and-effect it has to be dealt with. Whether 
reincarnation is true, apparently it was in the original teachings of the Essenes which rumor 
has it Jesus was one of, then one of those Catholic Church edits of the early few hundreds 
deleted it so they could gain further control, or not is not really the issue. Well, actually it 
is. If there is such a thing as reincarnation, and of course there is no conclusive proof, just 
lots of theories and gurus mouthing western dollar's textualities, then it would go to show 
that if we stuffed up one time then we would have to do it over until we get it right. If 
there was a stream of logic in all this it would seem obvious that a genetically perfected 
person could not have this karma from before. For example, the reason I have such a 
perfect body, mind and life is because I have been such a saint for the past 33 life times, 
and if you can afford it I can sell you the Brooklyn Bridge for a good price too.

So you see, well just look around the mess the planet is in, thanks to 2000 years of the 
Christian Piscean era, and tell me who does not have immense karma. There will be a lot 
of folks born for a long time with a lot of physical malfunctions, why? They are working 
off their past karma.

If the human - can we please say people genome project? perfects the lot on earth, then for 
all these cruel people that are running riot ruining the planet at present another planet will 
have to be formed before they can incarnate in the physical form in order to work out the 
crap they have inflected. This could actually be happening on one of the moons of Jupiter, 
is it Io? Which is gradually undergoing earth-like changes. And there is speculation that 
Jupiter in the future of its evolution will become a sun then its moons will become planets. 
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But that is all way-out there stuff us guys like to sort out at the pub over a few stubbies on 
a Saturday night. What the genome thingie will really affect the most is the world of 
comedy.

There is enough stuff to keep comedians going for decades. 

Deconstructed genetic engineering. Post-karmic people.

It seems that in the future if we need to fix a part of our body all we will have to do is to 
drink a vial of the gene to replace the stuffed body part. For example, if my liver was 
rotting out from too much bad karma from when I was an alcoholic concubine in 
Cleopatra's court I could get the liver-gene-Terrell replacement and it would grow a new 
one. Clinton could get a straight penis. Prince Charles could get a personality. Australian 
Prime Minister John Howard could - well where would he start?

Then of course they are saying with gene therapy we could live for thousands of years in 
any form we wanted at any age, texture, size, and color.... Yuck. But then again think of 
all the things we could try on to be. I was thinking about this on the toilet the other night 
during a terrible bout of diarrhea and came up with a list. Each genetic formula I would 
take on for twenty-years each. Each one could easily be a complete comedy sketch. 

  Me - just for laughs.

  A New York City pigeon

  A barroom stool

  Pop singer

  an old man - oh shit I am already one of then

  computer

  David Letterman

 A bottle floating in the sea

  Prince Charles' stuffed shirt
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  tree

  Mick Jagger's lips

  taxi cab in LA

  Table top dancing prosititue in an 18-year old female body

  traffic light

  an electric chair in a Texas prison

  a pair of Amanda Marco's shoes

Actually I came up with dozens more - so in a three thousand-year cycle I would have 
quite a set of experiences thanks to genetic engineering. 

Even came up with punishments for bad people. Just think of what a life sentence would 
be if we were living for thousands of years. Like a life sentence for being really bad - ya 
know like dumping someone's genes in the toilet and laughing at the mutations - "You 
have been sentenced to a life of marriage - that will be 4584 years"

But I will leave all that to the comedians, the metaphysical folks, the futurists, moralists 
and post-peoplists. For me I am just happy that my 16 year got on his flight to the States to 
play baseball for the next two-months - and now I can clean my genetically male mutated 
messy house.

Terrell has left the net. 

Ph.D research | Try This | About Me | picture poems   | University Of SA e-zine | 
baseball | romantic | neuageVIEW 
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NeuageVIEW from Adelaide South Australia for June 27 2000

Return to neuageVIEW Life is an array of experiences. But it is the first time experiences that 
are memorable. There is only one first time for any new event. I am 
fortunate. At 52-years I have had two new experiences this year, 
beyond the realm of anything I have known before.

Working for Family and Community Services with pre-teenagers is 
nothing new. Having raised two humans from scratch, alone, on an 
island in a desolate foreign country has been filled with unique 
experiences.

One of my community service's charges is into motor-sports. 
Something I have never been interested. The purpose of a motorized 
vehicle is to get me to where I am going. Overland, sea, through the 
air - who cares - just get me there.

At ten-years old he knows more about cars than I do. We started off 
with the usual hot rod shows. They were OK. His favorite is a '57 
Chevy. I never had a chevy. I grew up in a Ford family. My father, 
now 95, never had anything but a Ford. He got a new Ford every two 
years, a station wagon, usually beige. He was the local Methodist be-
all in Clifton Park, New York. So the station wagon was perfect to 
cart the un~saved children of Clifton Park to church. His father had 
Fords. Started off with a Model-T.
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At hot-rod shows we walk along and I say "I remember that, My 
father had a '55 Ford". Of course I don't recall the engine sticking 20 
feet into the air out of the hood (bonnet here in Australia) and such 
huge wheels and so many exhaust pipes. 

At the hod rod shows there are the '49, '51, '53, '55, '57, '59s - they are 
all there. Believe it, this is Australia where the American car reigns 
supreme, if only at car shows. I was born in '47 - I look around they 
never have cars from '47 - born in a bad year I suppose. The year of 
the pig. Same as my youngest son. Oink!

We progressed in our car lessons. Started going to the drags. This 
amazed me. Cars flying by so fast. The World's fastest '57 
Chevy, the world's fastest GTR Torana (this is Australia, 
sometimes people race cars other than American cars, and Debbie, 
the fastest female around driving the world's fastest GTR Torana, not 
including the long dragsters which I noticed a few females driving; 
Australia the home of the fast woman - probably all Aries at that. At 
one car show we went to, I saw this dragster that was as long as our 
house, and the female driver, young, petite, sat in front of it 
autographing her pin-up calendars, with her in various poses scantly 
clad attired in front of her dragster, I don't understand. I must just be 
getting old. I must admit I was a bit in awe of her. My girl friend, a 
true-blue Aussie feminist and an Aries at that I thought would be 
happy to know about all this. And having her Mars opposite her Sun 
squaring Uranus; all that cardinality unleashed this was the way for 
her. I went and told her about the female drag racer. She was 
impressed, right up her alley. Then I told her about the scantly clad 
posses on the calendar and my ears were ringing for weeks after. 
Seems the female racing a dragster and being an Aries was fine. The 
poses were not. Something about sexist and all. I am getting too old 
for all of this).

Where was I? Oh, the drag races. There were all the cars of my past, 
'55 Chevy, even a '39 Ford (well I am not that old) - all flying by 
making the loudest racket I have ever heard. Two hundred miles an 
hour. The ground shook and my body went numb. Would it be 
inappropriate to say that this is really bad for the environment? After 
five hours my physical was in tatters. I had dreams of thundering cars 
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flying by for days. After a few weekends of this I suggested we try 
something else. Last night we went to indoor motorcycle racing at the 
Adelaide Entertainment Centre. Some grand motocross thingie - world 
class the radio ads bleated all week.

 

The announcer screamed into the PA system louder than the roaring 
bikes. All these names and at the same time telling stories about 
individuals -- now leading ---he won last time in --- and again --- and 
has 23 points this year --- and look, in third place South Australia's 
own --- let's give him a big cheer - opps he fell off his bike, the crowd 
groans, looks like the Vics are going to win again. Basically I worked 
out that some guy has won a lot and Adelaide is round four in this 
season's tour.

 

What I find strange with motorsports - strange because I haven't seen 
it in other sports, is these adolescent scantly clad females come out 
and kiss the winners. They do it at grandprixs for both cars and 
motorcycles, for drag races, though now with females in drag races I 
wonder if some muscle bound guy in his knickers will kiss the winner. 
It has to be regarded as prostitution. Pay the price (win the race) and 
get a kiss from a near naked girl. And they don't just walk up to the 
podium, they wiggle their butts more than an ordinary person would, 
and of course all the males in the crowd go stupid, and the girls smile 
and wiggle some more. No other sport does this, wait - I remember - 
boxing and wrestling do it, but they aren't real sports, they are just 
another form (forum?) for pornography in its ugliest form. Can you 
imagine at an AFL (Australian Football League) footy game a scantly 
clad girl going up and kissing the winners? She'd be rapped on the 
spot right there on the football paddock by the whole team, and of 
course the crowds would cheer. Where are the feminists at 
motorsports? What is wrong with a grandmother or the Australian 
Prime Minister, little Johnny Howard, kissing the winner? Of course 
at the grand prix races the winner gets a kiss from the girl than 
uncorks the champagne after shaking it and letting it spurt all over the 
place - where is Fraud at a time like this. 
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Even five, six and seven year olds raced around, though they didn't do 
the jumps. And the winners are kissed by the scantly clad girls 
rubbing their tits against the winners (first, second and third place) and 
kissing them on the cheek. These junior winners at the motorcross 
were six and seven years old, what an education in how to grow up 
and be a healthy sexist male. It actually borders on paedophilisam.

 

"Watch South Australia beat the Vics, (Victoria, a neighboring 
paddock) the Yanks, (we know who they are) take on the might of New 
South Wales, Queensland, Western Australia... (more neighboring 
paddocks). The drag races were the same. South Australia vs. Western 
Australia, the ultimate funny car shoot-out. South Australians have a 
desperate need to beat someone, anyone, in anything. Just to be 
recognized as an existing spot on earth would be good. For example, 
whilst speaking with a nurse at Ellis Hospital in Schenectady, New 
York last week regarding the condition of my ailing 95-year old father 
I told her I was from Adelaide. She never had heard of Adelaide. I 
said it is in South Australia. She said, Oh is that in the southern part 
of Australia?"

Recently I signed a guestbook of the radio station I listen to over the 
Internet, WGNA in Albany New York, a country and western radio 
station I listen to as a relief from the constant hip hop stuff my kids 
play. In the 'where from" area I put Adelaide, South Australia. I 
actually received an e-mail the following day asking what country was 
Adelaide, South Australia in. 

What is amazing about the Internet is that you realize the rest of the 
world has never heard of the city you live in, and that no one in the 
rest of the world really cares what goes on in your town. But 
Australians are the same. Most people think New York is New York 
City. If I say I grew up in Clifton Park in upstate New York they think 
I mean a suburb in uptown New York City. Very few people know 
that New York is a state and that there are other cities. Even the fact 
that Albany is the capital of New York is unknown.
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I don't know if I could have coped if my children had done 
motorsports. They did the usual sports in youth: soccer, baseketball, 
baseball. My youngest stayed with baseball and is currently on his 
sixth Australian National team. And is off to Edmonton Canada to 
play in the U-19 World Series. My baseballer has topped $30,000 in 
expenses for his travels overseas ( USA, South Africa, USA, Canada) 
plus a dozen tournaments in various cities around Australia.

Apparently motorsports are even more expensive. As a single parent 
these past 15 years it has been nothing short of miracles for me to 
gather the funds for baseball. Nothing to say of all the court 
appearances I had to go to so my son could travel interstate and 
overseas. 

Four hours later the motocross was finished. I dropped my mentored 
youth (though he may be mentoring me when it gets to motor sports) 
and his mate off and lay in bed with the sounds of flying, jumping 
motorcycles and adolescent girls humping the winners on the podium.

Cheers mate! Why do people here say g'day mate - even at night. Why 
not good night? 

Terrell has left the net.
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mind scribbles for June 20 2000 from terrell neuage 
visiting Adelaide South Australia

"I believe that fate has brought us here And we should be together But we're not" macy gray "I try"

MOON: 13aquarius13 ~ SUN: 29gemini51 ~ MERCURY: 19cancer44 ~ VENUS: 2cancer27 ~ MARS: 
2cancer57 ~ JUPITER: 28 taurus00 ~ SATURN : 25TAURUS32 ~ URANUS: 20aquarius33R ~ 
NEPTUNE: 6aquarius06R ~ PLUTO: 11sagitaruius02R ~ CHRION: 13sagitarius00R ~ CERES: 1libra04 
~ VESTA: 29capricorn38R ~ PALLAS: 28leo02 ~ JUNO: 26aquarius46 ~ CUPDIO: 3sagitaruis09 R ~ 
HADES: 19gemini21 ZEUS: 3libra54 ~ KRONOS: 28gemini21 APOLLON: 20libra03R ~ ADMETOS: 
20taurus26 

 Dreams. So much is made of them. Martin Luther King had a dream, though 
some say it was someone else's dream and he repeated it.

Dylan sings 'I"ll let you be in my dream if I can be in yours"

Terrell writes "Pick a dream and stay awake in it". 

A once-were-priest from a former formal foreign Order religious group gave 
me grief over it. Did the religious number on it. Oh we need to be ever vigilant 
not living in dreams and all. Good golly, can't get away from people trying to 
save me. My 95-year-old father still prays for my salvation up there in Clifton 
Park, New York. "Hi dad!" I grew up in a missionary family. Now detest the 
missionary position. Post-missionary position - that's me. We had family 
missionaries to China (back at the beginning of last century before they were 
given the boot), Cambodia, Africa, some other places. To digress just for a 
second here - to make amends for what I had to put up with I kind of pinched a 
few suitcases of things these missionaries stored in our basement from their 
'missionary work'. Some century old robes and stuff like that. We give. They 
give. I got.

Now the world coughs and sputters from the love of God these missionaries 
spread around to the less fortunate.

Dreams! Are we speaking of aspirations? Such as my son's baseball... or my 
son's piecing....? Or are we talking about the dreams we have when we sleep? 
The dreams we drive into town for?
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Day dreams...I had a dream we were not a dream... 

 

I can never sleep alone again

with the dreams I have in my sleep 

The person I am is free to love life away

Whilst in my waking times the who I am could not have 

the same genetic code as 

Last night was extra good

The lady in my dream said so too.

When I awoke she was still smiling then 

as my eyes focused to some distant phase 
of my being.

I walked out into the kitchen

children somewhere on the periphery of my mist ask if 
breakfast is ready.
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I don't even know her name and she was so good.

 Another one night stand 

 Another dream filler come and gone 

Every night it is a different possesor

 Ladies of my night 

 Women of my life 

Months to years I remember them from my dreams

but nothing similar ever happens in my day.

Life can never give contentment when the night is so 
fulfilling.

Last night she was an oriental.

She was my first Asian lover.

After we mad love she asked me not to leave because if I 
did she would become danger's sister

But I did leave her and her .

Now in the kitchen I try to recall how to make a cup of 
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coffee.

She had a perfume on I had never sensed before.

Now the smell drifted through the kitchen while I tried to 
make a cup of coffee.

Soldiers returning from the battle-field say they can 
smell death before it happens

I could smell evanescent love as the sun rose

spread-eagle across morning's desires

I felt dazed again 

it had happened before

Usually I'd awaken during the night

trying to recall that other world

then try to figure out how to bring it into the conscious.

Now it was well into morning

I stood still in the kitchen

My children yelling for breakfast 

it was time to catch the school bus

Cartoons were menacing morning's fading breath
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the dog whined for attention

I wanted to go back to the oriental lover who said she'd 
be in danger if I left.

A refugee trapped in my dream world.

I managed to get milk out of the refrigerator

My children needed nourishment.

I looked for breasts which had faded with morning's 
shadows.

My nourishment had slipped away too, just like my 
motherless children's had long ago.

I gave them milk and ceral 

saw them out the door

watched them catch the Port Elliot school bus.

I yelled .

Children's paraphernalia lay about like the end of every 
battle.

And as I moved about collecting pajamas, comics, lego, 
and G.G. Joes I quietly closed my eyes and slipped back 
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into my lover's arms. 

 

Dreams of one with conjunct 
Saturn/Pluto (exact to the minute) and Sun all in Leo 
whilst semi-squaring Uranus/Mars in Gemini (in 8th), 
square Jupiter (in Scorpio in first) and ruling Libra 
ascendant and Taurus Moon with Neptune, ruling fifth in 
the 12th.

 

there was a point to this at the beginning but I forget what it was.

Sorry.

Deconstructin' with ya next week
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The best-spent hour and a half I spend of the day three days a 
week are when I walk the six kilometers to our local 'fitness 
centre'. 

These walks provide more than an escape and I wonder why 
everyone in the world does not do the same thing. It was a 
forced experience to begin with. But often we are shoved into 
the next thing for our learning, growth, evolution, karma or 
whatever the trendy concept is.

I have been going to the gym since the year dot as they say in 
the comic books. 

However, the walking experience descended upon me several 
years ago when my car came to its ultimate death following a 
series of convulsions; dark smoke pouring out of the exhaust, 
forming fantastic phantom figurines in the mist. Once I saw 
Mother Mary smile at me then give me the finger. I wrote the 
Vatican about it, believing my car had gone through an 
initiation and was worthy to be referred to as a sacred relic and 
should be worshipped as is fitting of a sacred relic. They never 
answered - so I let my older son and his cru piece (bomb is 
their term) or graffiti it completely. Even the windows were 
pieced. 

Anyway to make a long story short, not having my car, I was 
forced to take a bus to the gym three times a week. One day, I 
missed the bus back home and as the buses run once an hour I 
was not in the mood to wait an hour for the bus. That is if the 
buses are running. They are rarely on time, and now thanks to 
the Prime Minister's (a sorry example of a Leo if there ever 
was one) new GST tax prices are going up about 10% for 
buses and trains and trams. Wouldn't it be great if we had a 
10% increase in service and 10% increase in being on time of 
public transport? I was in a very grumpy mood, which I 
usually got into before taking these walks. I thought the hell 
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with it I am going to walk home I don't care if it takes forever. 
Luckily it did not take forever but only an hour and a half. And 
somewhere part way through my walk I actually began to 
enjoy it. I walked through parks, and on trails I didn't know 
existed and maybe they didn't but I don't care I traverse the 
paths through life, real or not.

That was three years ago. I never got a car again. Lost interest 
in the things. My 16-year-old son has one of those nasty 
things, and I drive a new government car on weekends and I 
use to borrow my girl friend's car before the government gave 
me a car on weekends to play with. Otherwise I walk.

Of course the side affect of walking is the physical body side 
of it all. At 52 I have managed to become un-fat, or rather in 
our post-everythingism age, post-fat, deconstructed fatness. I 
stopped eating a lot too. The physical appearance was never a 
goal; yes I was gaining weight, felt sluggish and was a very 
grumpy person. But also, I was a single parent of two full on 
teenage boys. And living in a foreign country and constantly 
going to family-court, fighting the ex-wife so my baseball 
playing son could travel interstate and overseas to play ball. 
These court battles became more and more ugly to the point 
where the ex got her personal psychiatrist, to write untrue and 
most slanderous things about me and submitted her great 
delusion wisdom to the court in affidavits. She had never met 
me, communicated with me in any form, spoken to anyone 
who knew me, except her patient - the one I was fighting in 
court, and she said the dumbest things I have ever heard. For 
example SHE WROTE: 

            "I noted in his writing that he talks about disintegration 
within his         personality; and there is evidence of thought 
disorder such as loose             associations and flight of ideas, 
which together with his general        suspicious demeanour 
suggests psychotic thinking..."

The good doctor then quotes a few lines out of context from a 
prose piece, submitted as part of my Honor's degree at Deakin 
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University, and which my university assessor's comments of 
the exact same piece are 

"There is a wonderful energy in your work and some 

strong things...I hope (I'm sure you will) that this is only 

the start of a long career for you!"

            I received a High Distinction for that piece which she 
refers to as disintegrated and evidence of a thought disorder. 
And she goes for several pages with this type of nonsense. I 
was so amazed at how unethical this all seemed to me that I 
wrote the South Australian Medical Board a 20,000-word 
rebuttal of her affidavits. And of course on my long walks I am 
putting together a law suite and claims of contempt of court 
etc. against this person. But this is all going off track isn't it? 
Fortunately for my son, the court has given him permission to 
play baseball and he is now heading overseas in July to play in 
a tournament with the Australian National Schoolboys squad 
then he flies to Toronto to play with the Australian AAA 
National squad across Canada and on to the U-18 World 
Series. Six national teams (including U-16 World Series in St 
Louis and a tour of South Africa) and 7 States teams and every 
trip overseas and interstate (about 16 trips) has been thanks to 
the family court of South Australia for their permission.        

Drifted a bit here. But walking is great for the body and the 
mind. I worked out my court trials whilst walking, and of 
course won everyone. I worked out designing web pages, my 
Ph.D, metaphysical ha ha, relationship thingies within my 
relationships to my children, girl friend, neighbors and the 
world at large. 

So in short. Walk! It is the way to fix the world. No matter 
what is going in my life, I go out the door and walk, even if it 
is raining. Amazingly, most people drive to the local deli even 
if it is only a few blocks away. The television, Internet, radio, 
sounds everywhere block out our thinking. We never hear the 
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messages we go through life numb. It is our own stupid fault. 
There is always an excuse. My life was not worth a dog's 
breakfast before I began to walk. At first I was grumpy 
because I had to walk, I was upset that there was not enough 
time. Now I get grumpy if I don't walk. Walking is better than 
sex, a good meal, everything - well except sleeping, I even 
enjoy it as much as all my times in court with the ex (several 
dozen times). I love sleeping, though I don't do it much, save it 
for a treat. No mobile phone, no CD player or radio, just me 
and my mind. I have even found routes to the gym, which 
avoid all suburbia. 

So that is it. Walk. There is time. Nothing is more important. 
Relationships, business, everything can be fixed by thinking it 
through on a walk. Oh, and stop and look at a tree along the 
way - no I am not going to say hug the damn tree, we aren't in 
the '60s anymore, just see that there is more than the rush 
around stuff we think is important.

As a fact I thought up this article whilst walking. 

And I have plenty to think about on my next walk. I erased a 
disk with my son's complete semester's schoolwork thinking 
he was done with it. Without any back up this is equivalent to 
the dog ate my homework. Sometimes parenting comes 
unstuck. My excuse? Transit Mars returned on that day. As 
well, Transit Uranus (in my fourth house and home ain't feelin' 
to good at the moment - I may as well sleep out in the paddock 
with the roos this week) is in opposition to my five planets and 
MC and Part of Fortune in Leo now and squaring Jupiter in my 
first as well as Saturn and all that stuff in Taurus squaring and 
opposition and beheading me. That's my story and I am 
sticking to it. Well I have enough to reflect on for the next ten 
walks, so if you see me walking along your trail, best to give 
me a miss this week.

Cheers mate! 

13/06/00 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://neuage.indiko.com/view/escape2.htm (4 of 5) [3/8/08 3:05:23 PM]

http://se.unisa.edu.au/messages.html


ESCAPE ADELAIDE SOUTH AUSTRALIA

 

RETURN TO 
neuageVIEW

Ph.D research | Try This | About Me | picture poems   | University Of SA e-zine | baseball | romantic | 
neuageVIEW 

 

http://neuage.indiko.com/view/escape2.htm (5 of 5) [3/8/08 3:05:23 PM]

http://se.unisa.edu.au/weekly/TerrellView.html
http://se.unisa.edu.au/weekly/TerrellView.html
http://se.unisa.edu.au/a.html%20
http://se.unisa.edu.au/trythis.html
http://se.unisa.edu.au/aboutme.html
http://se.unisa.edu.au/art/picturepoetry/racehorse.html
http://se.unisa.edu.au/
http://neuage.indiko.com/view/%20http://se.unisa.edu.au/U-19.html
http://neuage.indiko.com/view/%20http://se.unisa.edu.au/textuality/poetry/romo2.html
http://neuage.indiko.com/view/%20http://se.unisa.edu.au/weekly/TerrellView.html


Pope John Paul II Seeks Pardon for Catholics

Pope Seeks Pardon for 
Catholics: At Sunday's special Mass (March 12, 2000) the pope asked God's forgiveness for 
the sins of Catholics through the ages, including wrongs inflicted on Jews, women, and minorities

The Catholic Church did the ultimate Catholic thing this week. Instead of dealing with the havoc 
it has wrought for the past 2000 years and attempting to fix anything it said sorry- forgive us - 
forgive us for destroying native cultures, forgive us for burning women at the stake (I will take 
mine well done thank you), forgive us for destroying the earth, for our paedophile priesthood, for 
our rape and plunder. And that was it. The man himself, Pope John Paul II, - the mascot of the 
most evil empire to ever exist on planet earth said sorry, said a few hail Mary's and everything 
was OK.

I suppose it is more than the Australian's 'little Johnny Howard' would do. He can't say sorry for 
the destruction of Aboriginal culture, now he can pass the boomerang over to the Church. "It's 
their fault". When do we deny criminals of their excuses? It reminds me of my ex-wife. Her 
excuse for not mothering for the past 15-years, imprisoning me in a foreign country to be a single 
parent (TRYTHIS) was that I prevented her from mothering. When do we stop listening to 
excuses? Now the Church says we are sorry. WHAT?

Because the Church finally realizes they have been busted for their 2000-years of sins, they now 
know that the millions of unthinking people who have blindly followed in the believe of a better 
after life if they sacrifice themselves to the Church in this one no longer believe that nonsense. 

Isn't it fitting that the pope would give his forked tongue meaningless sack of words when 
Mercury was retrograde in Pisces? Like saying something with fingers crossed, and in Pisces, the 
ultimate "I'm sorry" sign - the sign of the fishy (I will make you fisher of men and all the other 
good Pisces Christian slogans, as well as the fishy symbol they have used for 2000-years as a 
Piscean age symbol of martyrdom and sacrifice, deception, delusion and all the rest of the 
Piscean keywords). Sink or swim mate!

Yes! It is finally over. The Piscean Age is over. Sacrifice and guilt - the big Church control 
devices are no longer valid. Now with Pluto - the planet of transformation in Sagittarius conjunct 
Chiron - the comet of healing currently visiting our realm to fix up what the Church has 
destroyed, the Catholic Church is suddenly shitting in their collective shrouds (Uranus is in 
Aquarius, the end of the age mate. Their 2000-year old mascot allegedly said I will be with you 
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until the end of this age - well that was the glorious Piscean age and it is over. The Aquarius 
cycle shows up the dis-ease of the past. The light shows up the darkness and the darkness just 
ain't getting it. Behold the karma of the Pope - Parkinson's dis-ease - leaves him trembling in his 
self-created guilt.

So bye bye Catholic Church - we don't forgive you and what you have done for the past 2000-
years, but we intend on fixing this planet and getting rid of control of women, destruction of 
cultures, the murdering and rapping of those with different world-views. The great Christian 
mascot said sell what you have and give to the poor. The Vatican needs to sell all it has and give 
to the poor. The reason there are the poor is because the Church has created them. The change is 
here. 

A few of their indiscretions over the years: The church burned heretics at the stake during the 
Inquisition (as well as women throughout the past 2000-years). Armies of the faithful slaughtered 
Muslims during the Crusades. The way it treats gay and lesbian Catholics (why would they want 
to be part of the evil empire anyway?) Discrimination against women; The silence of (Pope) Pius 
XII during Auschwitz and the Holocaust. What the Church at its convents and schools has done 
to children and is still doing; rape and torture continuously here in Australia is criminal and the 
Church should be banned along with all other murderous control institutions, as well as what they 
did to the Indigenous population needs to be brought to accountability. The Catholic Church is 
not a spiritual entity (no religious group of any denomination is). Its sole purpose is to control 
those in the physical and it is not at all interested in anything but its own physical gratification.

Cheers mate.

 

Neuage

Early morning

Run and tell

Early morning

Wake the town
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Early morning

The change has come 

NeuageVIEW for Tuesday, March 14, 2000

DISCLAIMER: The essay above is opinion and 
does not reflect beliefs, goals, guidelines, world 
view etc. of southernexpressway or the University 
of South Australia, the city of Adelaide, Terrell 
Neuage, Australia or anything at all. However, it is 
true.
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a rough draft NOT WORTH READING soon to be 
totally re-written meaning of meaning

HOWEVER WE COULD CLICK THE 
MEANINGFUL IMAGE BELOW AND SEE WHAT 
A DECONSTRUCTED MESS I HAVE MADE OF 
MEANING THUS FAR 
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22/09/98 13:06

Unscientific notes on brain and consciousness. These are notes with no 
scientific, philosophical or metaphysics basis. They are the result of 
personal noticablitliy. I am looking at this from my thesis idea of the Internet 
and its many links and what becomes of literature in this tangled web. 
Obviously not only is the Internet not conscious but it seems most folks 
who use the Internet are not conscious either. What happens with narrative 
if meaning and consciousness are removed? Does it continue?

Brain and consciousness are not necessarily linked.

If the memory is short-circuited through organic means (brain dis-ease, or 
injury) or self induced (drugs, alcohol, meditation, prayer, stress) the 
individual can still be conscious. When one is in a coma we claim they are 
unconsciousness, but we really do not know if this is true. As a species we 
are very physical and earth-bound. What we see is what we get is our 
favourite orientation. 

Philosophers, metaphysicians, religionists usually do not equate 
consciousness with the physical, ie. the brain. In this scenario the brain is 
the servant of the consciousness. A tool for the thinker to think through. 
Delete or change the tool, the thoughts are still available. They just are not 
processed and are not useable in a physical sense.

To others, the idea that there is a separation between mind and brain is 
ridiculous. A damaged brain produces a damaged consciousness. However, 
we all have come across those who have no organic problems with their 
brain, but their consciousness seems to us quite faulty.

In either case we have a linking mechanism happening. My view (and I have 
absolutely no credentials) is that consciousness is separate from the 
physical but we link to it. When the link is broken we are still consciousness 
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but we can not express it in a way which others can be aware of if they are 
using their physical senses. However, another consciousness can access 
the consciousness of the one who has lost their physical connection. 

Perhaps this linking of consciousness is done through a meditative or 
prayer-like state, when an individual separates from their physical senses. 

Consciousness could also be a type of field that physics has yet to detect. A 
philosopher might say there is only one mind in the universe and we as 
individuals wall off one section of that one-mind and call it our mind, our 
consciousness. There could be a similarity to an electrical connection 
between like-minded individuals. 

Astrology attempts (and sometimes does) answers this question by 
claiming folks with certain similarities have affinities with one another, while 
others may irritate them. For example, people with Mercury (ruler of the 
mind) in fire may feel someone with Mercury in a water sign dampens their 
spirits. We all know of personality types that we feel comfortable with and 
others, which annoy us. Having studied astrology for more than three-
decades (not the newspaper sun-sign columns, or any predictive based 
astrology - just personality based astrology) I have seen differences in 
personalities based on elements in the astrological chart numerous times.

Is the connection I have seen in thousands of astrology charts, where the 
individual portrays certain traits based on elements (fire, air, water, earth) 
and aspects to other sections (planets, signs, houses, mid-points) of their 
chart the same as between the brain and consciousness? Neither is 
seeable, yet we can calculate the results. A simple example, I have raised 
two children on my own, As far as I am aware I treated them the same. 
However, they are both incredibly different in every way. They have the 
same 'mother' and father (me). Their personalities are different, their 
ambitions are totally different even their size (the younger is six foot five at 
15-years-old, the older at 17 is six foot two. One lives for sport the other for 
everything else. I realize this is not unique, but I am just using my children 
as an example of how many families are different. I can only explain this 
astrologically (they are even opposite sun-signs, and their every planet is of 
a different nature). Then again my partner and I get on like a house on-fire 

http://neuage.indiko.com/view/brainstuffed.html (2 of 3) [3/8/08 3:05:49 PM]



Returnability

(we are both fire signs). 

 

I went off the track again (was that my Mars conjunct Uranus in the air-sign, 
Gemini, taking over my five planets in Leo?) as an example of how we can 
imagine links to be. In other words, not all physical phenomenon is the 
result of physical causations. 

Many believe our thoughts cause results to our physical well being. Doctors 
have now come to the party on this. Obviously stress or mental anguish can 
produce a reaction in the body. I know for example, one person I annoyed 
so much, she claimed she had a brain-tumour, which a few weeks later she 
downgraded to a migraine. But at the time she really believed she had a 
brain-tumour to the level that she had a doctor say it could be possible, with 
the symptoms she was having. When I stopped annoying her as much as I 
was, she discovered she had had a migraine.

 

What does all this prattle have to do with the Internet?

 

As far as I have gone as of: 22/09/98 13:06
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Do to the many requests to finish this article it will be redone and 
posted here on July 06, 2000 Thursday, June 08, 2000 14:18:35

Post-nuclear families and who cares
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BABYART a children's story by Terrell Neuage from Adelaide South Australia
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At the day care centre the children 
enjoyed painting more than any other 
activity. They were the two to four year 
old children of employees of a large 
computer company.

Beverly Johnston was an artist herself and 
she had the responsibility of keeping 
everyone happy. The parents and the 
children. She had attended school for art 
and had specialised in traditional art; 
the classics, paintings done hundreds of 
years ago. She didn't like modern art. She 
thought that the children's art was better 
than the modern art at art galleries and 
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even better than many of the modern 
paintings at the museum.

Beverly Johnston gave the children all the 
paint they wanted to use on all the canvas 
boards that they wanted. The children made 
a mess. Beverly thought that their 
paintings were excellent. She framed the 
pictures and took them to an art gallery.

To Beverly Johnston modern art looked like 
something a two year had done. She wanted 
to prove her point. She was going to put 
her day-care children's paintings into an 
art gallery. She decided not to tell 
anyone what she was doing. She wondered 
what would happen if people believed she 
had done them, instead of the two and 
three-year olds.

The first gallery she went to said they 
were excellent. They wanted to do a show 
as soon as possible. They even made 
another artist cancel his show so that 
this new art work could be shown to the 
public right away.

On opening night there was a large crowd 
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of important people. There were newspaper 
reporters and television crews to report 
the art gallery's show. The next day the 
world was told about this new and 
important art.

 

Art galleries from around the world wanted 
to show Beverly Johnston's work. She had 
her day-care centre children do more and 
more pictures. Or what the children saw as 
paintings. The pictures were really 
different coloured blobs on canvas, 
usually smeared together. Some paintings 
were large - some small. She framed every 
picture. She did more and more shows.

All the money that was made from the art 
shows was put into a bank account for the 
day-care centre's children. After all it 
was just a bit of fun to her. A way to get 
even with the kind of art she never liked.

Beverly Johnston kept her secret for a 
year. She did shows around the country and 
three overseas. She was on the cover of 
several major magazines and was announced 
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as the most important new artist of the 
decade. All the while she was laughing.

Finally she let out the secret. She called 
a press conference. On national television 
with international pickup to countries 
around the world she made the announcement 
that no one really wanted to hear; that 
she, Beverly Johnston, did not do the art 
that was being called, "the best new art 
of the decade", it was being done by two 
and three year olds.

Many artists from all over the world were 
very upset. Especially the ones who did 
modern art - and tried to imitate 'her' 
work. The artists who did traditional 
paintings laughed at the whole situation. 
They understood what Beverly Johnston was 
really doing. 

The children at the day-care centre all 
received the money from the art sales and 
they had the best Christmas ever - using 
all the money for presents.

Beverly Johnston lived happily ever-after 
forever.
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DINO

Grandpa often said that he didn't like all the newfangled things in his 
house. 

He could do without the fax-machine, computers, compact disks, 
video recorders and most of all, he could do without the microwave 
oven.

"Who knows what these microwave things could do to someone or 
something?," he often said.

But these were the modern days. Microwave ovens had their place. A 
fast cup of tea, instant meals soup in a hurry. What possibly could be 
wrong with having a microwave oven?

Grandpa's microwave oven had sat in his kitchen for a long time. 
Magazines and newspapers were piled on top of it. The 
grandchildren stored their toys inside. It had never been plugged in.

Grandpa's son worked as an advertiser. He loved the world of 
technology. Every new invention that came on the market he'd buy 
two of each, one for himself and one for his father. 
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His father or grandpa to the children, would leave the new things in 
their boxes. Grandpa had closets full of 'the latest things'.

Grandpa liked his wood burning stove. It had been good enough for 
his parents and it was good enough for him.

He'd make his pot of tea on it and it would keep the house warm at 
the same time. In summer he would create his meals outside over the 
barbecue.

Grandpa would not use his modern car. He preferred to ride his bike. 

Grandpa was 90 years old. He had been riding bikes since he was 
ten. Why stop now? In the two years since his son had brought him 
the car it had never been out of the garage

The fax machine sat in its box. When grandpa first installed it the 
grandchildren, Sacha and Leigh, thought it would be fun to play with. 
They wanted to play spy so they sent coded messages to an army 
installation in a foreign

country.     The Army sent several of their top people to 
grandpa's          house, including a general - they were not

impressed.          

After that grandpa packed the fax machine back

into its box and put it on a high shelf in a closet.

The video recorder, compact disk, cameras, computers and gadgets 
that grandpa couldn't even imagine what they did all ended up in 
their boxes in the closets or in the garage.

Some modern things were o.k. There was the washing machine that 
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grandpa finally began to use. He was so use to washing his clothes in 
the sink that his son had to actually talk him into using it. It was 
easier to use than the sink but grandpa reckoned it was because he 
was getting old and lazy.

NeXt

It was a weekend and the grandchildren were staying at grandpa's 
house for the weekend while their father was away on a business trip.

The children were playing military. Sacha was using the kitchen for 
his base. Leigh was in the shed. They were using walkie-talkies to 
talk to one other. Grandpa was taking a nap outside.

Sacha pushed the buttons on the microwave oven. He was 
pretending that it was a missile launcher. He set the timer on five 
minutes. Nothing happened so he plugged the oven into the wall-
socket and turned on the switch. The microwave oven's light went 
on. After two minutes there was a very loud sound coming from 
inside of the oven.

Sacha yelled over his walkie-talkie to Leigh to come into the kitchen 
quickly. The two children looked at the oven. It was making more and 
more noise. Suddenly the five minute buzzer went buzzzzzzzzzz. The 
door popped open.

To the amazement of the children out walked a small dinosaur. It was 
a stegosaurus. It locked more like a model of a stegosaurus than the 
real thing. It walked across the counter top and jumped onto a 
window ledge. It walked up to a Philodendron and ate all its leaves.

"Oh no, that's grandpa's favorite plant," said Leigh.

After chomping away the leaves on the Philodendron the 
stegosaurus knocked the plant into the sink and stomped, in its little 
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toy-like way, over to the Dwarf Umbrella Tree.

"Oh no, that is grandpa's second favorite plant," yelled Sacha.

As the stegosaurus ate, it grew. It grew too big for the kitchen 
window sill and fell off onto the kitchen sink. 

Just then grandpa walked in.

"Who turned on the microwave oven?"

Grandpa stared at the two boys then at the plant eating dinosaur. He 
seemed to already know what would happen if the microwave was 
turned on. The children looked at each other then at grandpa. They 
had often wondered why he had put every modern thing away that he 
had except for that.

The dinosaur climbed out of the sink and jumped to the floor. There 
was a loud crash as it landed. It walked out of the kitchen and headed 
for the front door. It pushed open the door and stomped outside and 
into the garden. Grandpa and the children ran after it.

"NO! NO! NO!"

They all shouted as the rapidly growing prehistoric animal ate and 
ate and ate, and grew and grew and grew as it plodded through the 
garden. It ate the bushes. It ate the shrubs. It ate the flowers. It ate 
the leaves an the tree. It ate the corn the lettuce the spinach which 
the children were delighted to see because they didn't like it. 

It ate the lawn.

Grandpa opened the garage door. There was room for two cars 
though he only had one. The stegosaurus strutted into the garage 
and laid down. It was bigger than the car. 
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Grandpa tried closing the door but the dinosaur's tail would not fit 
into the garage. The door could only go down to where the tail was, 
leaving it to stick about two meters out onto the driveway.

"We must get it back into the oven," grandpa said.

The three went back into the house and put the microwave oven onto 
a wagon and pulled it out to the garage.

They plugged it in.

"It won't fit," Sacha said.

Grandpa laughed, "of course not, we'll have to put him in a little bit at 
a time."

The three started with the tail.

"At least we'll be able to close the door - if we can shrink its tail", 
grandpa said.

They could only get a tip of the tail in, it was so thick. The children 
turned the oven on.

"It has to be an for five minutes," grandpa said.

Slowly the children and grandpa managed to shrink the tail enough to 
close the door by dinner time. They still had the rest of the weekend 
and the dinosaur was fast asleep from growing so fast, so they had a 
lot of time to do a lot of shrinking.

After dinner, cooked on the barbecue, the three humans went to 
work on the one animal.

"It is probably having a dream about the prehistoric days," said 
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Sacha.

I hope it doesn't wake up and decide that it would rather be a meat 
eating dinosaur," said Leigh.

They tried to lift its massive paws but the feet were just too heavy. 
They had to put in one toe at a time. Next they worked on the huge 
spikes on its back. It took a long time but finally the points on the 
stegosaurus's back were all small.

"Look, he's bald," laughed grandpa. 

But the children didn't think it was funny. They were tired and it was 
all getting to be an awful lot of work.

Getting the dino's head in was the hardest part of all. The three had 
to put a heavy rope around it's head and loop the rope around a large 
wooden beam at the top of the garage and pull and pull. The beam 
almost broke. When the stegosaurus's head was finally off of the 
garage floor they quickly pushed the microwave in front of it.

Because the head would not fit in they had to leave the door open. 
They set the oven for five minutes and ran out of the garage. The 
dinosaur was waking up. The feet were already very small, as small 
as a toy and the tail was the size of a pencil. The points an its back 
were hardly noticeable.

There was a very large noise in the garage. After the timer went 
buzzzzzz the three walked in. There was no huge stegosaurus there. 
In front of the microwave oven there was a very small dinosaur going 
on a walk-about. It was headed for the plants by the window. 

The three ran over to the monster and quickly put it back into the 
oven. They unplugged it and lugged it back into the kitchen. They set 
it back onto its counter and put magazines and newspapers on top of 
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it.

The two children and grandpa were exhausted and they all fell to 
sleep on the sofa in the living room.

When the children's father came to pick them up he asked if they had 
had a good time. Before they could answer he said that he had a 
surprise for grandpa. 

It was a new type of microwave oven.

Grandpa and the children looked at each other and cried out, 

"OH NO!"

Sacha and Leigh went home with their father and they never played 
games with microwave ovens again.

Grandpa put the new microwave oven into the garage and never took 
it out of its box.

And I surely can understand why.

© Copyright Terrell Neuage 6 1992 Victor Harbor South Australia
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Leigh Neuage (July 6 1983 - August 16 2003) 
 

THE last NOTE

Leigh sat in the middle of the front row in the balcony overlooking the stage at the 
great music hall. It was his favourite place to sit. Leigh's father played the xylophone 
in the City Orchestra and his older brother played saxophone. Leigh could see them 
both clearly. Sometimes they would sneak waves to each other.

Tonight was a special night. It was the last night that the City Orchestra would play 
here for a long time. The next day the orchestra would go on a tour around the 
country. The music hall was full.

Everyone was dressed very formally. Getting dressed up for concerts wasn’t Leigh's 
favourite past time. But his father said it was important to always look neat and clean 
especially when going out in public, and even more so on concert nights. Leigh's 
brother, Sacha, did not like dressing up for concerts either.

Sacha was an excellent saxophone player. His Father had said, "he could be the best 
one day if he practices enough." He did not always like to practice but then again he 
was the youngest person to ever play in the City Orchestra. He still enjoyed playing 
with toys, computers and roller blading like other children his age. Sacha was ten 
years old. Leigh was seven.

Leigh knew all the songs the City Orchestra played. Most of the songs were classical 
songs and had been written hundreds of years ago, though some of the songs had been 
popular during the past thirty years.

Leigh thought the best song of all was the last song of the concert for several reasons. 
It meant the end of the concert, his father and brother were the only ones who played 
the very last notes of the concert and he liked the song.

The song was a Beatle's song that had been popular twenty years earlier. It was called ' 
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Yesterday'. Of course when the orchestra played it no one sang the words to the song 
but Leigh would sing the words in his mind when he heard it.

The end of the last song of the concert was a special sound. Sacha would blow one 
long note while his father played the last few notes on his xylophone. All the lights 
over the stage would go from the soft colours they were during the concert to full 
bright white and all the people in the audience would stand up and clap loudly.

This night was different. The people in the audience were extra loud. Their clapping 
lasted longer, being the last concert of the year before their tour. The people in the 
audience continued clapping and yelling, 'bravo bravo' something that people liked to 
shout out at concerts. Leigh never did shout out 'bravo bravo' he thought it sounded 
silly.

The musicians on stage were beginning to pack up their instruments. Leigh felt very 
proud of his family and stood looking at the stage. Sacha had already left the stage, no 
doubt headed for the reception room.

After every concert there was a party. There would be tables covered with little 
sandwiches and plate after plate of cakes and cookies. Sacha and Leigh were almost 
always the first ones at the sweets table. They would usually have four or five pieces 
of cakes before their father would say, "Don't eat so much people will think I never 
feed you at home." But they would manage to have several more sweets before the 
night was over. Sometimes they would put pieces of cake in their suit pockets, 
something that their father thought was a horrible thing to do.

Phase Two
Leigh left the balcony when he saw his father leave the stage. He began walking down 
the stairs. There were a lot of people in the upstairs part of the music hall. Halfway 
down the stairs he tripped over a step and fell down. He hit his head on the steps. 
Everything around him started to spin, he tried to sit up but he couldn't. He felt very 
dizzy. People helped him stand. His legs felt weak and he felt very tired. He looked 
around at the people who had helped him up. He did not recognise anyone. As he 
walked down the rest of the stairs he tried to recall where he was. He even forgot who 
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he was. He tried to remember his name and what had just happened to him.

          Leigh followed the crowds through the front doors. It was a warm night. On the 
streets there were a lot of cars. People hurried along on the footpaths. It was Friday 
night in the city.       Leigh looked up and saw a large clock reading

10:30 PM. Nothing looked familiar to him. He crossed the main street. A sign at the 
corner read, 'North Terrace' he shook his head trying to remember anything at all. His 
mind was blank. He walked down a narrow street. There was a huge furniture van with 
its back doors open. He did not see anyone near the truck so he climbed in and crawled 
over the furniture to the front of the truck. Leigh found a very soft sofa and lay down. 
Soon he was asleep.

A few moments after he climbed in the driver of the truck closed the back doors and 
drove away. Leigh slept all night. The truck drove all night.

Phase Three
          The next day the truck with Leigh inside arrived at another city. The truck 
parked in the loading area of a huge department store. Leigh woke up when the back 
of the truck's doors were opened. He heard the driver of the truck say to another 
person, 

"This doesn't have to be unloaded until Monday, so I'll be back then. There is no one 
around here so I won’t lock the truck doors"

After a few minutes Leigh climbed to the back of the truck and looked around the 
large unloading area of the store. He did not see anyone so he climbed out of the truck.

Leigh walked through a door that led into the department store. He did not know 
where he was. He sat down on a chair and tried to remember. All that he remembered 
was falling down the stairs, getting into a truck and waking into another unknown 
place. Why did he have these silly looking clothes on? A suit, tie, polished shoes? He 
did not remember a thing.
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All that Leigh knew was that he was hungry and that his head hurt. He looked around. 
He was in the men's clothing section of the store. He walked through the store looking 
at everything until he came to the children's clothing section. He took off his suit and 
put on a shirt that said New York Yankees on it, and a baseball hat that also had New 
York Yankees on it - now he felt normal. Then he put on a pair of sneakers with air 
systems and pumps on them that made him feel like he could do a backwards two 
handed double pump windmill slam-dunk. Of course he did not know how he knew 
what a windmill slam-dunk was but he felt he could do one or maybe even two.       He 
folded up his suit and together with his shoes threw them into a trash bin. In the 
middle of the first floor there was a food section. He filled up with lollies and cookies. 
Leigh was feeling more normal all the time - if only he could remember where and 
who he was - things would be fine.

Leigh spent the weekend in the store. He ate in a restaurant, making sandwiches and 
eating a lot of ice cream. He slept on a very soft bed in the bed section and changed his 
clothes each day, even though his clothes always looked the same with New York 
Yankees on them. He washed himself in the bathroom. He even brushed his teeth. All 
he needed was there, except for his memory.

Leigh played with toys, read comic books and played with the computers.      He put 
on roller blades and rolled around the store.

From the time he got there in the early afternoon of Saturday until Sunday morning he 
was the only one in the stare.

Phase Four
Monday morning Leigh heard voices and quickly hid in a storage-room. The storage-
room had huge windows and he could look out to the street below. Across the street 
there was a large park. In the park was a stage with hundreds of rows of seats in front 
of it. Leigh did not know what it was. But when he looked down at the stage he felt 
very sad though he didn't know why.

For the next week Leigh lived in the store. During the day when it was open he would 
sleep in the storage room. At night he would wander around, get food and change his 
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clothes always putting the clothes he had on back on the rack they had been on.

He still did not recall a thing, though he could think properly. He could read and he 
knew how to operate computers and how to play computer games. But he did not 
know how he knew how to operate computers.

He was not scared. He he thought he was in a dream. Other times he thought he was 
playing a game but didn't know what the rules were. He knew he was in a department 
store and that he had gotten there by riding in the back of a truck. He did not want to 
meet any people to find out what was going on yet. The only thing that was familiar 
was the stage in the park across the street from his hiding place. It would make him 
sad when he looked at it.

Meanwhile, Sacha and his dad had looked all over for him. They had the police help 
too. Sacha kept saying, "I know that he is alright." But his dad was very worried.

Toward the end of the week, Sacha and his dad decided to join the City Orchestra's 
tour. There was nothing they could do by staying home. They left the doors of their 
house unlocked in case Leigh returned. On Friday, one week after they last saw Leigh 
they flew to the city where the orchestra was to play. The next day the City Orchestra 
was to give a free concert in the park.

Saturday morning Sacha was the first to wake up. "We're going to find Leigh today," 
he said.

"I hope that is true it is getting harder and harder to cope without knowing what 
happened to him," a said his father.

Sacha and his dad went to the park and with the other orchestra members set up. The 
concert began. There were a lot of people there, "Probably because it was free," Sacha 
had said.

Leigh was asleep in the storage area of the department stare when the concert began. 
He heard the music, it woke him. He went to the window saw the people on the stage 
and the audience sitting in front of the stage. It was so -Familiar, suddenly. He even 
knew what the next song would be before it started though he didn't know why he 
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knew that.

The concert went on for over an hour. Leigh wished he had a pair of binoculars so that 
he could see the people up close.        He looked around the storage area but couldn't 
find any.       Then he found a telescope. He looked through it. He looked at each 
person on the stage they all looked familiar.

The one playing the xylophone and a child playing a saxophone looked very familiar. 
Why was it all adults except for this one kid?

Finally the concert came to the last song. Leigh knew it well it was ‘Yesterday by the 
Beatles’. Then there was the end of the song: Where Sacha played loud and clear one 
long note and his father played the last few notes of the song on his xylophone.

Suddenly Leigh remembered everything. He remembered the last concert the fall 
down the stairs and the fact that his father and brother were right there across the 
street. His memory had returned.

Leigh ran out of the storage room, out of the department store and after watching for 
cars ran across the street and up onto the stage.

Once again they were all together. Thanks to the last note.
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Terrell Neuage is finally leaving australia another plane leaving Baltimore I...ghts of Australia astrological conference in Sydney finally leaving Australia

leaving australia 

It is not the flight which was memorable. Just another plane leaving Baltimore International 

Airport.

How many people have done that?

As we went into the clouds I watched the patterns of the traffic in the frozen snowfalls below 
fade and I drifted off into thoughts of Australia where I had never been before and would never 
go to again.  Just a week's visit for an astrological conference in Sydney and soon I would be 
back to what was simple, controllable, comfortable, normal - my life. I had my year; actually I 
had the decade mapped out. Dot points and arrows filled my planning sheet. How could it be 
different?

After twenty-two years and a life I can barely believe I experienced I am finally leaving 
Australia......

Available mid2004 (c) terrell neuage (terrell adsit 1980 when this journey began)

 

 Clifton Park New York 

1955 on the way to Adelaide South Australia 
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Other poems: COLLECTION ONE ~ COLLECTION TWO ~ COLLECTION THREE

Begin World Wide Web poetry journey here

~ Dr. Terrell Neuage

COLLECTION2
EVERYTHING IN PLACE

NOTHING WAITING

THIS IS IT

TO GO BEYOND HERE

IS TO DENY

WE ARE HERE.

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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A WASTED STEP

ONLY WASTED THOUGHTS
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TRYING TO INTERPRET

WHETHER EACH STEP

IS WASTED
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FROM THE MOMENT WE MET

MY LIFE COLLAPSED

INTO PERFECT BALANCE.
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WHAT I MISSED YESTERDAY

TODAY WILL REPEAT

IF IT

I NEED TO KNOW
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TO FEW THE PLENTY

TO PLENTY THE FEW

WILL THERE EVER BE ENOUGH

FOR THE FEW TO HAVE LESS

AND THE PLENTY TO HAVE MORE

?
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WHAT GOD WAS REALLY

TRYING TO SAY WAS

'WELL FOLKS

I HOPE YOU ENJOY

YOUR VISIT TO LIFE ON EARTH

IF YOU DON'T

YA GOT TO DO IT OVER AGAIN.
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WOULD WE CHANGE SOCKS

THE MOMENT

BEFORE OUR

LAST MOMENT

OF LIFE

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

LAST LIFE TIME

I WAS COMMANDER OF A STAR SHIP

THAT CRASHED ON MARS

THIS LIFE TIME

I WROTE THIS POEM ABOUT IT.

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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I FOUND MYSELF

IN THE MARGINS

BETWEEN COMMERCIALS

OF A SATURDAY NIGHT MOVIE

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

LOVE IS MORE

THAN A SIMPLE DISCOVERY

OR REDEFINED DEFINITION

STRANGE INVENTION

AN INVASION OF PASSION

WISH FULFILLED.

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

LOVE IS LIKE A POMEGRANATE
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GROWING ON A LITCHI NUT TREE

SO OBVIOUS

AND ADMIRED

FOR ITS UNIQUENESS

THAT EVERYONE WANTS

A TREE LIKE THAT.

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

TOO OFTEN TO MANY MOMENTS

AREN'T LONG ENOUGH

TO BE FULFILLED MOMENTS.

I KNEW WE'D SPEND TOGETHER

FOREVER

WHEN I FIRST SAW YOU

CROSS THE DANCE FLOOR

THE EVENING PAST

MORNING FOUND US

TANGLED SEAWEED
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ALONG THE DEEP BLUE SEA

ME IN YOU YOU IN ME

IN A MOMENT

LONG AT THE TIME

SHORT NOW THAT

IT'S SO FAR OVER

BUT NEVER GONE

ALWAYS PRESERVED

RIGHT HERE IN THE BACK OF MY MIND.

 

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

I REMEMBER WHEN

THE MORNING FOUND US.

(TANGLED SEAWEED)
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ALONG THE DEEP BLUE SEA

PASSION'S UNDERSTANDING

IN LAUGHTER'S RHYMING COLOUR.

DO YOU REMEMBER THEN

TOO?

 

11-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

I LOST MY BALANCE

FELL OFF THIS DREAM

LANDED IN THE CENTRE

OF REALITY

OH SHIT!
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I GOT TO HAVE YOU
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WITHOUT YOU THE AIR IS THIN

THE COLD FREEZES MY BALLS

PORNOGRAPHY HAS NO MEANING

WITHOUT YOU

LIFE IS THE PITS

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

I'M ALWAYS ACTING

BUT NO ONE SEES

I'M ALWAYS SINGING

BUT NO ONE HEARS

I'M ALWAYS WRITING

BUT NO ONE CAN READ

I'M ALWAYS FEELING

BUT NO LONGER ARE THERE ANY EMOTIONS

TO SHARE WITH NO ONE AT ALL.
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9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

LITTLE LESS

MORE OF YOU

KEPT ME ALONE

AGAIN TONIGHT.

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

SURELY THIS TIME

WE WERE MEANT TO BE

MORE CONSCIOUS

THAT WE ARE MERE

CHIMPANZEES WITH SPEECH

MAYBE WE SHOULD GIVE APES

THE BOMB

AND SEE WHAT
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THEY WOULD DO WITH IT.

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

I LOST MY BREATH

ON THE CURVES

SHE NOTICED I DID TOO.

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

OUR LOVE

HAD ALL THE MAKINGS

OF A GREAT GAME

TO BE RELEASED ON ARCADE MACHINES

ON BOARD GAMES

AS A LOTTERY GAME
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AS OUR LIFE

WINNER TAKES ALL.

 

 

 

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

WITHOUT KNOWING WHY

BLUES TURNS TO RED

SPINACH TO STEAK

YOU TO ME.
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'M ALWAYS OVER

THE TOP

I'VE NEVER KNOWN

ANY OTHER WAY

TO GET PAST THE MOUNTAINS.

9-16-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

SEASONAL CHANGES

ANYTHING ELSE

DOESN'T BELONG.

 

 

 

 

 

http://neuage.indiko.com/collection2.html (14 of 56) [3/8/08 3:06:48 PM]



Terrell Neuage poetry collection2

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

TOO SOFT YOUR TOUCH

FEATHER OF TORTURE

LET ME

FEEL YOUR TOUCH

SO I KNOW

I'M NOT BEING CARESSED

BY A CLOUD

IN MY DREAM.

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

BACK WHEN I WAS A KNIGHT

BEFORE THERE WAS THE GRAND PRIX
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AND THE OZONE WAS STILL LEFT UNPLUGGED

WOMEN DANCED IN AMARANTHINE SILKEN PEIGNOIRS

AND WANTED ME

WHEN THE EARTH WAS FLAT

AND CHIVALRY WAS ALL THE RAGE

I BELIEVED ALL I HAD TO DO

TO FIND THE GRAIL CUP

AND HAVE GUINEVERE

AT THE SAME TIME

WAS TO INVENT CABLE TV

BUT ELECTRICITY WAS YET TO BE DISCOVERED

SO LIKE ALL OTHER HEROES TO BE

I SHORTED OUT BEFORE MY TIME.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

THE PAIN OF TOO MANY PAGES

TO TURN

http://neuage.indiko.com/collection2.html (16 of 56) [3/8/08 3:06:48 PM]



Terrell Neuage poetry collection2

TO CHANGE

TO BE FREE

LEFT ME IN THE CHAINS

I WAS PLACED IN

WHEN I WAS A CHILD

 

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

I NEVER WANTED ANYTHING

MORE THAN TO BE THE TOPPING

OF THE CAKE

THAT SHE WAS

ABOUT TO EAT.
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FINALLY FOUND FREEDOM

LEFT ALL AROUND ME

NOT KNOWING

WHAT TO DO

WITH THE SLAVE
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THAT ONCE HAD.

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

MY MUSE

WAS CONFUSED

WITH MY DEMAND FOR A RAP LYRIC

LEFT MY MUSE CONFUSED.

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

SUCH A SCORE

BURN THE POOR

WHAT'S THE HITCH

BURN THE RICH

I ONCE THOUGHT MY BELIEFS

WOULD GIVE ME RELIEF
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WHAT A DONG

I WAS WRONG.

 

 

 

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

QUIET PERCEPTIONS:

IS THIS ALL DEATH

HAS TO OFFER?

I HAD HOPED TO SEE AN ANGEL OR TWO

SOME RELATIVES

MAYBE SOME FRIENDS

A FEW KENNEDYS

KING ARTHUR, JESUS, ELVIS, EINSTEIN...

I EVEN HAD AN APPLE

TO SHOVE UP EVE

(WHY ARE WE THE SINNERS?)

http://neuage.indiko.com/collection2.html (20 of 56) [3/8/08 3:06:48 PM]



Terrell Neuage poetry collection2

OR WAS THIS MY LIFE

WITH NOTHING TO OFFER?

 

9-17-94

 

 

 

 

 

 

SO MANY YEARS WITHOUT A LOVER

WHAT DID cOLUMBUS DO

WHEN HE TRAVELLED SO FAR?

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

BY WATCHING THE SUN

BREAK FREE
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FROM HORIZON'S HOLD

I TOO

LEARNED TO RISE ABOVE

MY HORIZON.

 

 

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

TRADED WORDS

WITH THE BIRDS

CHIRP

CHIRP

CHIRP

NOW THEY HAVE MY WISDOM

I HAVE THEIRS

CHIRP
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CHIRP

CHIRP

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

DESIRE COLLIDED

WITH THE WIND

NOW LAYING

BROKEN

IN FRONT OF HER

CASTLE'S WALLS

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

THE 1MISSING LINK I

MILLIONS OF YEARS AGO
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WHEN APES WERE FIRST

EXPERIMENTING WITH

GENETIC ENGINEERING

IN THEIR LABS

IN A FOREST

IN CENTRAL AFRICA

THEY CREATED A MONSTER;

HUMANS.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

THE MISSING LINK II

WHILE WATCHING COMMERCIALS

I DISCOVERED THE MISSING LINK

BETWEEN LOWER AND HIGHER LIFE FORMS;

CONSUMERS.

9-17-94
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EVOLUTION

SAVANNAH

CAVES

CASTLES

SHOPPING MALLS

NUCLEAR POWER

CAVES

SAVANNAH

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

HUMANITY FEEL OFF OF

THE EVOLUTION LADDER

WITH THE INVENTION OF TELEVISION.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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I ONCE SAW MY MOTHER

RIDING A COMET THROUGH A NEIGHBORING GALAXY

AND GIVING BIRTH TO NEW LIFE FORMS

AS SHE PAST PLANETS REVOLVING AROUND STARS

AS SHE ONCE DID ME.

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

 

THE BEST ABOUT THE NEW AGE

IS IT WILL WIPE OUT OLD AGE.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THROUGH THE MAGIC OF THINKING

I CAN CLOSE MY EYES

MAKE DISAPPEAR THE MESS MY LIFE IS

AND VISUALIZE THE STARDOM

I WAS ALWAYS MEANT TO HAVE.

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

NATURE BROUGHT FORTH

CHEMICALLY PRESERVED FAST FOODS

TELEVISION, DRUGS, RELIGION, AND ROCK AND ROLL

IN ORDER TO RID THE EARTH

OF ALL HUMANS

SO SHE COULD HAVE IT ALL

TO HERSELF
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LIKE IN THE BEGINNING.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

WHEN WE CAN TAKE A SPACE WALK

WITHOUT PRESSURIZED SUITS, OXYGEN, HELMETS, TETHERS

THEN WE WILL BE FREE TO TOUCH THE STARS

AND EACH OTHER.

 

 

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

SINCE MY MOTHER WAS BURIED

I NO LONGER CAN SEE HER WITH MY EYES OPEN

WHEN I DO SEE HER

SHE IS ALWAYS LAUGHING DANCING

JUMPING ABOUT FROM PLANET TO PLANET

JUST YESTERDAY SHE WAS PLAYING
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WHAT LOOKED LIKE TO ME A GAME OF TENNIS

ON ONE OF JUPITER'S MOONS

WITH MY BROTHER

BUT I HAD TO OPEN MY EYES

TO AVOID HITTING A CAR

AS I WAS DRIVING TO ADELAIDE

AND WHEN I CLOSED MY EYES AGAIN

I NO LONGER COULD SEE THEM

SO I DON'T KNOW WHO WON.

DO YOU?

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

I TOOK A PORTION OF THE MIND

WALLED IT IN

CALLED IT MY MIND

AND LEARNED TO ENJOY MY MISTAKES

TRAPPED INSIDE THESE WALLS.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

DISNEY CREATED NEW TOTEMS

WHERE GROUPS AND INDIVIDUALS

CAN BE UNDERSTOOD THROUGH

ASSOCIATING THEMSELVES WITH

ONE OR MORE PARTICULAR CARTOON.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

IT WASN'T LONG AFTER I FELL AND HIT MY HEAD

THAT ZEUS BEGAN TO VISIT ME

AND TELL ME THAT MY MISSION

WAS TO COLLECT SODA BOTTLES

AND GIVE THEM TO THE SCOUTS.

WOW!
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

THE FUNNY THING

ABOUT FUNNY THINGS

IS THAT THEY ARE NO LONGER FUNNY

WHEN EXPLAINED

IN A RATIONAL MANNER.
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IF WE BLAME YESTERDAY FOR TODAY

CHILDHOOD FOR YESTERDAY

LAST LIFE FOR CHILDHOOD
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THE LIFE BEFORE FOR LAST LIFE...

DO WE GET TO BLAME NEXT LIFE

ON TOMORROW?

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

I HAD THE AMERICAN DECLARATION OF INDEPENDENCE

TATTOOED ON MY RIGHT THIGH IN HIEROGLYPHICS

TO SHOW HOW EQUAL

IF I HADN'T CREATED MYSELF

I COULD HAVE BEEN.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

IF IT WEREN'T FOR TELEVISION

I WOULDN'T BE ABLE

TO LIVE THEIR LIFE

SO COMPLETELY FULFILLED

AS MINE.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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THE WAY I SEE IT IS

I WANT TO SEE IT

DIFFERENTLY.

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

I DON'T CARE ABOUT BEING PRAISED

BY THE LIVING AFTER I DIE

BUT BY THOSE WHO WENT BEFORE

WHO WILL APPLAUD

WHEN I RETURN TO REALITY

THAT WHILE ON EARTH

I DID ALL MY LESSONS SO WELL.

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

I WHISPERED TO THE MOUNTAIN SIDE

'LATER WHEN THE SUN LEAVES

I'LL PUT A FLOODLIGHT ON YOU
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SO ALL CAN SEE YOUR GLORY

IF YOU KEEP SECRET

THE AFFAIR I HAD TODAY

IN YOUR ARMS'.

 

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

LATER...

WHEN WE'RE CONQUERED NATURE

SAID WHEN IT SHALL RAIN

WHEN THE SUN CAN SHINE

WHEN THE MOON CAN BE FULL

WE'LL GO MAKE LOVE

IN THE RAIN

UNDER A FULL MOON

IN THE MIDDLE OF ANY DAY.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

POPULATION CONTROL
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I MARRIED A MANIKIN

AND PLACED IT IN MY SHOP

FOR THIRTY YEARS

AND SHE IS JUST AS BEAUTIFUL TODAY

AS SHE WAS WHEN I MARRIED HER

NEXT YEAR I'M GETTING US

SOME CHILDREN MANIKINS

TO PUT IN THE SHOP WINDOW TOO

AND BECAUSE I KNOW MY PARENTING SKILLS

THEY WILL NEVER GET INTO TROUBLE

TALK BACK, RUN AWAY, DO DRUGS,

EARRINGS IN THEIR NOSES, OR DREAD-LOCKS

HAVE THEIR OWN VIEWS OR BE A BURDEN ON SOCIETY

WHAT A GOOD PARENT AND HUSBAND I AM.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THROUGH GENETIC ENGINEERING

HUMANS WILL BE ABLE TO LIVE

ON INHOSPITABLE PLANETS

LIKE EARTH

IN THE FUTURE.
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9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

ALL NIGHT WHEN THE SUN HAD RUN

DISAPPEARED IN THE MIST

I LONGED FOR ITS RETURN

TAKE AWAY THIS DARKNESS

THAT STABS AT ME IN THE DARK

BRING BACK MY SHADOW

(MY BEST FRIEND WHO HAUNTS THE CITY AVENUES ALONE)

SHOW ME THE PATH I MUST TRAVEL

TO STUMBLE IN THE DARKNESS

TAKES AWAY THE QUIET

I SEEK OUT

IN THE RUSH HOURS OF THE DAY

ALL NIGHT I LIVE IN FEAR

THIS GUILTY WOMB OF DARKNESS

WON'T PUSH ME OUT

INTO THE BREAK OF DAWN

LIKE WHEN MY MOTHER CROSSED HER LEGS

WHEN I SO DESPERATELY TRIED TO BE BORN

HOLDING ME IN
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TO FIGHT THE DARKNESS ALONE

LIKE TONIGHT AGAIN

I SCREAM FOR THE SUN TO RETURN

SO I CAN BE BORN AGAIN.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

WHEN I WAS DEAF

I COULD HEAR THE SONGS OF MY SOUL

NOW ALL I HEAR IS

THE ROAR OF CIVILIZATION

BLOCKING OUT ANY SOUL

THAT CARED TO KNOW.

 

9-17-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

COULD HARDLY SAY

PASSING SHADOWS

ON THE GRAFFITI WALLS

REFLECTED CULTURE'S

DOWNWARD TREND.
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9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

TRIED TO BE LESS IRRITABLE

BUT I LOST THE PLOT

FELL DOWN THE CANYON

BROKE MY DREAM

COULD NOT DIGEST

THINGS AS THEY WERE

SO THIS IRRITABILITY IS THE RESULT

BUT TOMORROW WE WILL HAVE A GIGGLE ABOUT IT
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WON'T WE?

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

HISTORY

WE SAT AROUND

SIGNING THE DECLARATION OF INDEPENDENCE

THEN WENT OUT FOR A BIT OF TEA AND SEX

IT WAS A RAINING EVENING

A CUP OF TEA AND SOFT THIGHS

TO BURY MY HEAD INTO

WOULD SUIT ME JUST RIGHT NOW

1776 - I HAD SUGGESTED WE SIGN THE THING

ON JULY 7TH 1777

ALL THOSE SEVENS

I KNEW BY SIGNING IT IN 1776

THERE'D BE NOTHING BUT TROUBLE

BUT I WAS OUTVOTED

IT DIDN'T MATTER

THE FUTURE WOULD SORT ITS SELF OUT

FOR NOW LIKE ALL GOOD INDEPENDENT MEN

ALL THAT WAS IMPORTANT WAS TEA AND SEX
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WE TRADED PARTNERS THAT NIGHT

I HAD BEN'S WIFE, JOHN HAD MINE

IT TURNED OUT TO BE AN ORGY ACTUALLY

THE WOMEN GOT LAID

ONE BY ONE LAYING ON THE DECLARATION OF INDEPENDENCE

THEN THE MEN

A GOOD TIME WAS HAD BY ALL

BACK ON THAT NIGHT IN JULY 1776.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THE REASON I WANT TO BE

A POLITICIAN OR A USED CAR SALESPERSON

A RELIGIOUS LEADER, A LAWYER

OR A JOURNALIST

IS BECAUSE I ENJOY LYING TOO.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

IF IT HADN'T BEEN

FOR THESE THOUGHTS OF YOU

I WOULD HAVE FROZEN HERE

AT THE TRAIN STATION
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WAITING MY ESCAPE

FROM THIS COLD LONELY PLACE

I CALLED MY LIFE.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

ALL THE ANSWERS

WHAT TO DO WITH THEM

IF NO ONE ELSE

DOES WHAT THEY ARE SUPPOSE TO DO

WHAT IS THE POINT

OF HAVING ALL THESE ANSWERS?

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

 

 

I GAVE UP PROTESTING

TO LIVE MY LIFE

BUT FOUND I COULDN'T

http://neuage.indiko.com/collection2.html (41 of 56) [3/8/08 3:06:48 PM]



Terrell Neuage poetry collection2

BECAUSE OF THE PROTESTERS

NOT UNDERSTANDING.

 

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THEY TOLD US

WE WERE LIVING IN IGNORANCE

SO AS TO HAVE

BETTER CONTROL OF US

NOW THAT WE

LIVE IN THEIR KNOWLEDGE

WE'RE ONLY IGNORANT

OF WHOM WE WOULD BE

IF WE WERE FREE

OF THEIR CONTROL OF US.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

IN OVER FIVE-BILLION YEARS OF EARTH

THIS IS THE FIRST NIGHT

WE COULD SPEND TOGETHER SO FREELY

FIVE-BILLION YEARS
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OF WAITING FOR THIS

AND SO WORTH IT

IT WAS.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I UNDERSTAND THIS FRANTIC PACE

WILL ALL DISAPPEAR

BENEATH THE RUINS OF

OUR CIVILIZATION

BEFORE THE NOT DISTANT FUTURE

REPLACES US

WITH A HIGHER SPECIES.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

CROSSED OUT ALL PAST THOUGHTS

REPLACED WITH COLOURS

NO LONGER DO I THINK

I COLOUR

BLUE, RED, GREEN, BLACK, YELLOW
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AND I'LL ANSWER

JUST THE SAME.

9-18-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

I GREW UP LATE

LONGER AFTER THE OTHERS HAD

AT 47 CLINTON BECAME PRESIDENT

OTHERS...LEADERS IN BUSINESS

DOCTORS, PROFESSORS, ASTRONAUT

ME AT 47

I'M STILL A STUDENT OF LIFE

I PLAN TO GRADUATE IN 20 YEARS

OR SO

BECOME A LEADER

OR A ROCK AND ROLL BAND

OR WRITE OF GREAT STUFF

OR AN ACTOR

WHEN I'M 67

BECAUSE I GREW UP LATE.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

http://neuage.indiko.com/collection2.html (44 of 56) [3/8/08 3:06:48 PM]



Terrell Neuage poetry collection2

 

SEX

LIKE A COMPUTER

REPLICATES WHAT IS PUT INTO IT.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

 

DAMN THESE TIMES

WHERE IS THE PEACE WE ONCE KNEW

SIMPLE WANTS

EASY LIFE

LOVE SO REAL

ALL THESE TROUBLES NOW

THE KILLINGS

DESTRUCTION OF OUR EARTH

DISEASES EVERYWHERE WE TURN

DAMN THESE TIMES

WHAT'S THE POINT

TO CONTINUE
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IS TO END

TO END

END.

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

TODAY'S LARGE VOLCANIC ERUPTIONS

YESTERDAY'S EARTHQUAKE

TOMORROW'S HURRICANE

JUST NATURE

SHOWING HUMANS

WHO TRULY IS THE BOSS.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

THE THRILL OF BEING

WHAT A MOMENT

TO BE CONSCIOUS

SO LONG DREAMS

HELLO MY NEW WORLD.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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I WAS SO FAR AWAY

EVEN MY MIRROR WAS FOREIGN

IF THAT IS ME

THEN I AM SO FAR AWAY

THAT EVEN I

CAN NO LONGER RECOGNIZE MYSELF.

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

PISS OFF

11-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

LIFE

IF THIS IS A GAME

WHAT DOES THE LOSER GET?

 

 

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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STILL TRYING TO FOOL ME

LONG AFTER THE SHADES ARE PULLED

IF I WEREN'T SO TIRED

I WOULDN'T BE

SO FOOLED.

 

 

9-19-94

 

SUCH SIGNIFICANCE

AND SO IT SHOULD BE

NOW THAT IMPORTANCE

IS PUT TO SLEEP.

 

 

9-19-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

MAGIC I

NOT LONG AGO
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EVERYTHING I OWNED

FITTED INTO A SUITCASE

NOW I COULDN'T

FIT IT INTO THE STATE OF NEW YORK.

THEN WHEN I'M OLD

IT WILL ALL FIT

INTO A SUITCASE AGAIN.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

MAGIC II

I SAT DOWN

AND WATCHED MY CHILDREN GROW

FROM UNDER TWO FEET TALL

TO MORE THAN SIX FEET TALL

I SHOULDN'T HAVE

SAT DOWN FOR SO LONG.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

 

IF IT WEREN'T FOR YESTERDAY
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I WOULDN'T BE ABLE TO

PRETEND THAT THIS IS TODAY.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

THE REASON

CAVE MEN

HAD SUCH A DIFFICULT LIFE

WAS DUE TO THE LACK OF

A VARIETY OF TELEVISION SHOWS.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

LIFE IS LIKE A SHOOTING STAR

TO EXPLAIN WHY THOUGH

WOULD BE TO KILL THE METAPHOR.

 

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I TRIED TO EXPLAIN THAT IT IS

6:45 A.M. SEPTEMBER 20TH, 1994

TO MY DOG

http://neuage.indiko.com/collection2.html (50 of 56) [3/8/08 3:06:48 PM]



Terrell Neuage poetry collection2

BUT HE JUST LOOKED AT ME

IN SUCH AN ABSTRACT WAY

AND WENT TO THE DOOR FOR A WALK

LEAVING ME ALONE WONDERING

WHEN WAS IT 00:00 A.M. IN THE YEAR 0

DID THEY HAVE A NEW YEAR'S PARTY TOO

LIKE I DID TODAY?

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

WHEN WE GET TO THE YEAR 2000

WE SHOULD START OVER AGAIN

WITH THE YEAR ONE

JUST TO CONFUSE

THE ARCHAEOLOGISTS

1994 YEARS FROM NOW.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

SOON

THE CHILDREN WILL NO LONGER

TAKE THE SCHOOL BUS

SPEND HOURS ON THE TELEPHONE
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WORRY ABOUT ACME

WHAT THEY'LL BE WHEN THEY GROW UP.

BUT I'LL REMEMBER WHEN THEY DID

AS I SIT IN MY SUDDENLY QUIET LIFE

WONDERING HOW THE YEARS GOT TO GO BY

SO FAST

THAT ALL THAT IS LEFT

IS A SOFT ECHO

OF CHILDHOOD AGAINST THE

EMPTY WALLS OF MY LIFE.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I STILL CALL MY SIX-FOOT 13-YEAR OLD

MY LITTLE BOY

I STILL CALL THIS RAPIDLY EXPANDING SUBURB

MY COUNTRY HOME

I STILL CALL THIS WORLD

MY SAFE LITTLE PLANET

I STILL CALL

BUT NO ONE ANSWERS.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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THE DRIED BLOOD OF THE SINNERS

IS HUNG OVER THE SACRED SHRINES

OF THE MOBILE PHONES

AND SATELLITE DISHES

FOR FUTURE GENERATIONS

TO BE BLESSED BY.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

 

MY LAST DREAM

BEFORE I AWAKE FOR THE DAY

IS MY FINAL FLIGHT

BEFORE LANDING

IN THE WAR TORN ZONE

I CALL MY LIFE.

 

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

I WAS SURFING THE LOCAL DIABOLICAL BILLABONG

WHEN FIRST I SAW HER

SUNBATHING IN THE NAKED PADDOCK
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HER BREASTS LIKE

TWO THIRTY CENT ICE-CREAM CONES

FROM A DRIVE-THRU EATERY

BECKONING ME TO CLOAK HER WITH MY RIGHTEOUS SOUL

TO PROTECT HER FROM A RUDE MOUTHED SUN

TRYING TO MELT HER BREASTS

THEN I AWOKE

WITH MY DOG LICKING MY FACE

AND WHINNING TO GO OUTSIDE.

IS THIS THE LEGACY OF JUNG OR FREUD?

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

THERE ARE ONLY

ONE-HUNDRED THOUSAND AND SEVENTY SIX

POEMS LEFT IN THE MIND OF THE EARTH

TO BE WRITTEN

ON THE FEW REMAINING TREES

AND I WILL SIXTY-NINE PERCENT OF THEM.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE

WHILE INTERPRETING JUNG
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WRITING DOWN WHAT HE WAS (REALLY) TRYING TO SAY

I DRIFTED INTO SLEEP

INTO A DREAM

I WAS A FLY ON THE DOOR OF PERCEPTION

JUNG WAS MY SHADOW

FREUD SPRAYED THE SHADOW WITH FLY SPRAY

JUNG FELL DOWN DEAD

I FELT NOTHING

FREUD DIED OF FLY SPRAY POISONING

SO MUCH FOR MEANING.

9-20-94 VICTOR HARBOR COPYRIGHT TERRELL NEUAGE
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Other poems: COLLECTION ONE ~ COLLECTION TWO ~ COLLECTION THREE

Begin World Wide Web poetry journey here

Guestbook ~ View Guestbook http://infotrain.magill.unisa.edu.au/students/9810252t/
Terrell.Neuage@unisa.edu.au

e-mail 

terrell.neuage@unisa.edu.au or terrell@hello.net.au or "(c)" Terrell Adsit-N
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THE INFLUENCE OF THE WORLD WIDE WEB 
UPON LITERATURE

by

Terrell Neuage B.A.(Honours) 

DECLARATION

I certify that this thesis does not incorporate without acknowledgment any material 
previously submitted for a degree or diploma in any University; and that to the best of 

my knowledge and belief it does not contain any material previously published or 
written by another person except where reference is made in the text. 

NOTICE 

The text for this thesis is written entirely on the Internet for an Internet audience and is 
expected to be viewed primarily within the Internet environment. As it is an hyperlinked 
essay it is advisable to read the entire thesis before following the links. The complete text 

appears on one site at http://www.angelfire.com/hi/FIRSTPOEMS/allhtml.html but it 
may take longer for an older computer to load up the entire document. Following the 
arrows, beginning on this page, will make individual viewing of sections faster to load 

and re-load if links are followed.
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INTRODUCTION

This thesis investigates the influence the World Wide Web is having on literature. The 
purpose of the thesis arose from a concern about the rapid rise in Internet usage in the 
classroom and in the home and what affect this usage will have on how literature is 
created and experienced. My research is taken from more than one-hundred articles 
found on the Internet and from several books and journals which explore the use of the 
World Wide Web as a textual manipulator and extender. During a twelve month period 
I monitored several literature journals and the only two to explore the Internet-
literature pertinence is New Literary History (The University of Virginia) and 
Postmodern Culture (The John Hopkins University Press). The other journals I 
explored: American Literature, Journal of Modern Literature (Indiana University 
Press), Comparative Literature (University of Oregon), and Southern Review 
(Louisiana State University) have not explored the cyberfycation of literature. All of 
these universities have strong World Wide Web presence but none have linked literature 
and the World Wide Web together as a particular discipline. From this limited study of 
journals it seems that the World Wide Web is not as yet accepted as a source of 
scholarly academic work in literature. 

The significance of this work is incorporated within the scope of its presentational 
model. How people throughout the world are now able to link their thoughts with one 
another is a major theme of this thesis. Whether these thoughts are regarded as 
literature once they have been presented on the Internet is dependent on ones definition 
of literature. The term literature has multiple definitions associated with it but for the 
purpose of this thesis I will use a dictionary definition for literature. 

'Writings in which expression and form, in connection with ideas of 
permanent and universal interest, are characteristic or essential features, as 
poetry, romance, history, biography, essays, etc' The Macquarie Dictionary,  
p. 546. 
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As this dissertation was written on the Internet (in http code) I have written it in a 
different manner than would be expected in a traditional scholarly presented thesis. My 
supervisor has remarked that I have presented this in a 'chatty and friendly way' which 
is not in the vein of traditional academic presentation. However, I defend how I present 
this work, in its fragmented, dispersive and multiple sites format. As my supervisor has 
noted there is 'a potentially interesting clash between traditional academic expectations 
(clearly argued and structured, analytical, adding to knowledge...) and web (more 
fragmentary, subjective, wandering, inconclusive etc...) It is not just content which is 
changing but how it is perceived in its final textual manifestation which will forever 
change narrative style. Jay David Bolter in his cyber-article 'Degrees of Freedom' 
writes... 

'In cyberspace the self is no longer constructed as an autonomous, 
authorial voice; it becomes instead a wandering eye that occupies various 
perspectives one after another.' (Bolter) 

Amrohini Sahay refers to the Internetting of literature as 'Cybermaterialism'. 

'Cyberspace is above all the trope for a new cybercultural imaginary which 
is re-energising idealist social theory in its promise of a different (aesthetic) 
experience of culture in the form of technoculture which is increasingly 
informing, if not shaping, everyday life in the advanced industrial nations'. 
Sahay, 1997. 

My dissertation does not agree with Sahay's argument that cyberspace is the domain of 
capitalists as a tool for the advancement of their system of... 

'... bourgeois individualism ('every person for herself') in the cyber-90s of a 
postrepresentational democracy where self-representation has become the 
ideological touchstone for dismantling the meeting of collective needs by the 
liberal state in favor of a vision of a new post-al state operative according to 
the pulsational workings of a radical-semiotic-information-democracy of 
desire...' Sahay p. 559-560. 

and the 'further' enslaving of those who can not access the Internet. Instead of 
cybersubjectivity I will argue that we now have a paradigm of cyberobjectivity where 
'everyone will be able to create what they want to create' (Herz) and this free 
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unrestrained expression will breech the textual elite mindset of the postacademic 
bourgeois who for so long have dictated what and how literature should be created and 
be read. 

Literary researcher, R. P. Carver, theorises that the reader engages in a number of 
important steps in the act of reading. Carver calls his reading model a "Reading 
Program" saying that it is identical to that of a computer program. This program 
consists of two components: the data input component and the data manipulation and 
storage component. (Kutieleh) Carver says the former incorporates the "intermediary 
steps that transform the words from the printed page into a form amenable for 
manipulation in the second component of the program". (Carver, 1971:456). The 
second component, the storage component, involves the comprehension of the meaning 
intended by the author. The onus is then put onto the reader to develop meaning. 
Through digital manipulation of text on the World Wide Web literature will be 
constantly reinvented. 

Writing an academic thesis on the affects the World Wide Web will have on literature is 
a difficult undertaking. Firstly, research conclusions at this juncture can only be 
speculative as we are at the beginning of the Internet era. It would be similar to writing 
a thesis on the affects of the printing press upon literature in the 1450's when the 
printing press was first invented. Secondly, due to the rapid change in Internet 
technology what is presented today may easily become a part of technological history 
tomorrow. What I have attempted to demonstrate, both in my writing style and in its 
presentation is this literary change. There are many articles written on the Internet and 
its affect, but I did not come across a single text that addressed this topic I am 
investigating; 'The Affects of the World Wide Web upon Literature'. 

In this dissertation I have incorporated a lot of hypertech links both to clarify what I am 
saying and to lead to further investigation of a point made. The greatest limitation to 
this work is with its word limit of 10,000 words. It is impossible to do justice to such a 
large and important topic in such a small study. 

I will admit to having done this thesis quite wrongly from the beginning. Because this 
was a combination of research and of an experiment my original mode of presentation 
was flawed. My thinking was that since this was a thesis about the Internet that I should 
naturally create it 'live' on the Internet. I chopped and changed, adding links as I went 
until after a difficult eight or nine months I realised I had a bit of a mess on my hands. 
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The obvious way to go about such a task as I attempted is to write the textual portion 
completely first then add all the links. As can be quickly discovered by looking at 
'source' in Netscape for my thesis (not the Introduction, which I had enough sense to 
write out before adding hypertext) there are portions where almost every line has a 
hypertext link. This causes immense difficulties when trying to edit a work. 

I hope that my attempt in investigating the potential that the World Wide Web will have 
on literature will inspire others to explore and expand this topic. It is a subject which 
will become more important as children learn about literature in school and as many 
classrooms already provide Internet access as part of student's studies, the manipulation 
and re-invention of text (Shakespeare, Shelley, The Koran, Homer...) will be in the 
hands of our children as well as the interpretation of those text. Will the World Wide 
Web become a tool to investigate previous works or a device to create new virtual-texts 
using portions of the old Master's work? 

Bibliography for the Introduction (for a complete bibliography see http://www.geocities.
com/SoHo/Lofts/5289/THESIS2.html) 

Bolter, David. 'Degrees of Freedom', http://wwwlcc.gatech.edu/facultyu/bolter/degrees.
html 

Carver, R.P. 'A Computer model of reading and its implications for measurement and 
research' Reading Research Quarterly, 6(4), 449-471, 1971. 

Herz, J. C. 'What a Wonderful Web It Could Be', Rolling Stone, 30 November 1995, p. 
22. 

Kutieleh, Salah. 'Foreign Language Learners' Perception of Textual Relationships in 
the Process of Reading' Thesis submitted for the degree of Doctor of Philosophy, School 
of Education, Flinders University of South Australia, May 1995. 

Sahay, Amrohini. 'Cybermaterialism' and the Invention of the Cybercultural Everday', 
New Literary History, 1997, Vol. 28, p 543-567, The University of Virginia. 
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Robert James Adsit - 1943 - 1994 Clifton Park New York 
(Shenendehowa Central School, Elnora New York: Central College 
Pella Iowa: New York City: artist, writer, musician, actor, brother of 
mine) Terrell Adsit-Neuage May 2000 

Dedicated to Leigh Neuage an uncle you never got to know
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at your last breath

to see if I could catch a glimpse

of where you were going

The air was still today
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birds were quieter than usual

The neighbor's dog didn't even bark at me

but looked at me knowing my feelings

Me in Australia in Fall

You in New York City in Spring

but for an instant you were here too

yet still I couldn't catch a glimpse

of where you were going

my forever gone brother.

            4-08-94 Victor Harbor SA

 

I did away with time

so we would still be together

I did away with distance

so we would still be together

I did away with death

so we would still be together

3-27-94 Victor Harbor South Australia
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My father rang from across the sea

another son today buried he

He said he had tears in his eyes

as he looked up to the stealing skies

Another hole in the ground

another life without sound

Wife and brothers buried before

gone off to a distant shore

My children and I all that's here

remembered today in my father's tears.

            4-16-94 Victor Harbor SA

 

I want to be with you one more time

but I don't know how to

step into death

and return to life

4-17-94 Victor Harbor SA

 

http://neuage.indiko.com/robert_adsit_poems.htm (3 of 11) [3/8/08 3:07:06 PM]



Robert Adsit - 1943 - 1994 Clifton Park New York (Shenendehowa Central Sch...lla Iowa: New York City: artist, writer, musician, actor, brother of mine)

I have the house yet to clean

the children need to be collected from school

and the dog needs his flea bath

So for now take a neighbor or two

and just leave me be."

 

I was standing in the kitchen thinking about what to make for dessert tonight.

I set the table for you.

Poured the wine.

Hoping it's red that goes with tofu.

We will have such a long talk.

Brother to brother
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You will tell me about life in the Big Apple.

Oh how I envy your life.

Fast paced.

All those people.

Everyday such an adventure.

Me?

Well what can one expect living in this small town in South Australia?

The driest state on the driest continent.

See!

We live by the ocean.

We can surf at any time.

Have to watch for the sharks. 

A different type of shark than you get up there in the Big Apple.

I wish I had some wine glasses.

Who in New York City would ever drink wine out of a mug?

But we are not fancy here.

I can't wait until my brother sees the boys.

They have grown so big since last we were in the Big Apple in 1992.

I was just telling the boys the other day 

how surprised Uncle Robert will be to see them.
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But it is almost time for the school bus.

I better put away the wine and the table settings

before the children see I was pretending again

that you were coming to visit us even though I know you died so far away and all alone up there

in the Big Apple five long months more than I can cope with.

8-14-94 Victor Harbor South Australia

 

Everyone was there

my mom who put me up for adoption

my mom who raised my then died

my brother who was my favourite human

my girl friend who killed herself

my girl friend who society killed

my friend killed in Nam

my master teacher who died of a brain tumor

my master teacher who killed herself

We shared a glass of liquid light

talked about the old days

http://neuage.indiko.com/robert_adsit_poems.htm (6 of 11) [3/8/08 3:07:06 PM]



Robert Adsit - 1943 - 1994 Clifton Park New York (Shenendehowa Central Sch...lla Iowa: New York City: artist, writer, musician, actor, brother of mine)

and how strange it was

that I was still alive

when the plan had always been

that I would go first

and meet all them

after I had set the table

for this our final meal together.

 

            8-2-94 Victor Harbor South Australia

I began to speak with you to tell you

my wishes, hopes and what has happened

since last I saw you

Then I remembered you had died

But I could not believe it when you stood

before my mind saying that the love

you had give me was my sustenance until I became

one with you once again 

in the one world you now know.
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All my dead family and friends keep asking me

for favors

Last night one of my dead girl friends

asked me to feed her dead cat.

            8-25-94 Victor Harbor South Australia

 

            BROTHERS  

Deep in my memory where we still play in childhood

We act out all that we will be when we grow up

Of course we will be famous:

You the artist, musician, actor

Me:

writer, lover.

We will have mansions and limousines, Lear jets.

We will be on the news, in magazines, and in the gossip columns.

We will visit one another on occasion to say how famous

we are and how far we have gone since childhood

when we were so poor and pretended we were rich and successful.
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But then I emerge from deep in my mind

We are no longer children.

You are no longer alive.

And I am middle-aged living in a foreign land with not enough money

for my houseful of children that I am raising on my own. 

Who right now are talking about how great life will be

when they grow up and are famous.

My 10 year old is pitching a no-hitter for the Yankees in the World Series

and is receiving millions of dollars a year.

My 13-year-old is a rap artist doing graffiti and playing basketball for some out-lawed team.

The 14-year-old who lives with us is rich and famous - it doesn't matter at what.

And on the cycle goes.

New memories of what it will be like being created deep inside of young minds all over again.

9-06-94 Victor Harbor South Australia

 

I was looking at what I wrote you

after you died 

seven years ago.
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i remember that day

I told my, then, ten-year-old

whilst shooting baskets in the backyard after drinking

a cast of wine

that brothers are forever

but that you have gone forever no loner seems so important.

Since that time so seemingly long ago and far away

I have watched my children grow to teenagers:

one heading off to New York in just another month to play baseball

the other living on the other side of Australia

doing graffiti and hip hop shows

What has changed?

in this world of the physical there are always changes

ask the folks of ancient Greece

the cave people

the first to speak

the first to crawl upon the land

we live to change

we change to live

it is so sad you could not change to live
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and that the rest of us who are still here could

but what is life?

Do you have more life than I do now?

Every day I think of you and remember all the things I would have said if I had the chance to say 
them now then.

but basically as I am sure you are aware - life sucks - except for the Internet - that is a bit cool, 
and I know you would have had a great time with it - even e-mailed me more often than the once-
a-decade letter you sent during the last thirty years of your life.

Deconstructed post this post that life that we live

a planet full of broken memories

everyone so full of post-shit - not taking the Aquarian experience in its stride

But I do

talking to myself

another senile old man waiting for the train in the rain talking to his brother.

see ya soon bro.

            May 24, 2000 Adelaide South Australia

 

terrell adsit-neuage poem of the week  
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Next story  previous story

Our New House 
When my dad said that we were going to move I wasn't too happy 
about it. We had moved too much as it was. This would be our 
third time in five years.

Our new house was at Monday Bay and my dad said this would be 
our last move for a long time. I liked the new town but I was 
worried about what our neighbors would be like? I know we have 
neighbors, I have seen their houses, but I haven't seen them.

This is the first time I have had neighbors so close. We have 
always lived in the country with a lot of land. At Monday Bay I 
will only have a small yard. I won't be able to fly my radio-
controlled airplane, or go for long walks in the paddocks.

But there is a lot to do in a town. I can join a basketball or 
baseball team and meet more kids. But I am worried what the 
neighbors will be like.

Sometimes I think, 'what if our neighbors raise dragons'? Big 
ugly monster dragons that breathe fire and eat children or even 
their smaller brothers. Maybe the dragons eat parents, or dogs. 
What if it eats our new house before we even move in? Maybe the 
dragons will eat our new house with us all in it for its 
Christmas breakfast.

Then again, I could make friends with the dragons. If I had a 
dragon for a friend I could fly to the mountains, the forests, 
the country or even to an island if I wanted to. I could teach 
the dragon to ride a bike and we could go to the bike track 
together. Now that I think about it I would love to have a 
family of dragons for my neighbors.

What if our house is being built on top of a volcano? That would 
be terrible. In the middle of the night the volcano could erupt. 
Our beautiful new house would go flying into the air. My dad 
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says there isn't a volcano under the ground where our new house 
is but he could be wrong. Even dads are wrong sometimes.

It could be a hidden volcano way way deep under our house. I 
could be jumping on my trampoline and then jump off of it onto 
the ground and that could wake up the earth and then *BOOOOOM*. 
Lucky for me I will have a family of dragons living next to me 
and they will be able to fly my family away from the fiery 
volcano.

What if we have bank robbers next door? Dragons on one side, 
bank robbers on the other - and the volcano, too! Maybe the 
robbers will dig a tunnel in their back yard to the banks three 
blocks away.

The bank robbers may ever steal our dog to dig the tunnel. Our 
dog loves digging holes and he wouldn't know a bad hole from a 
good hole. I will have to teach him about bank robbers. Maybe 
there is a book at the Monday Bay Public Library, How to teach 
your dog to stay away from bank robbers.

I even wrote a letter to the police and told them we had bank 
robbers next to our new house. They will know what to do. Maybe 
I will get a reward. Actually I hope there are bank robbers next 
door because if there are not any I will be in trouble.

What about the Greenhouse effect? Living by the sea may be 
dangerous. The ice could melt at the poles and with dragons 
breathing fire into the air it will only get worse. Luckily we 
are buying a sailboat. We will be able to sail away when the sea 
rises.

There could be Martians next door or people who keep tigers in 
the back yard or even a herd of angry ageing African elephants. 
The army may have a hidden military base under the neighbor's 
house. Maybe my new schoolteacher lives next door or there could 
be a rock and roll band that likes to play loud in the middle of 
the night.

Then again, there could be just regular people next door and 
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they could have regular kids that are fun to play with. Maybe 
they are even worried about us. I will just go and meet them. 
But I will take my dad and our dog with us just in case.

© Terrell Neuage 1997
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traliaPHD thesis on chatroom conversation and internet litearture and communication by Terrell Neuage from the University of South Aus

To PHD thesis on chatroom conversation analysis

         The effect of the World Wide Web on literature

The effect of literature on the World Wide Web 

 

 LITwebERATURE may be defined as literature which is developed and formed in 
webs as it is found on the World Wide Web; with multiple links, levels and 
dimensions and without centre, beginning or end. 

word and definition copyright terrell neuage hackham south australia july 14 1997

•       A GLOSSARY OF COMPUTER ORIENTED ABBREVIATIONS AND ACRONYMS 

•       TERRELL_WEB search engine for PhD and etc.

•       Domain name registries around the world

•       Emoticons/abbreviations used in chatrooms and SMS and Email

•       ONLINE JOURNALS which discuss chatrooms and virtual communities
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PAST

...Narrative is present in myth, legend, fable, tale, novella, epic, history, tragedy, drama, comedy, 
mime, painting (think of Carpaccio's Saint Ursula ), stained glass windows, cinema, comics, news 

items, conversation...narrative is present in every age, in every place, in every society; it begins 
with the very history of mankind. There never has been a time period or a society without 
narrative. Caring nothing for the division between good and bad literature, narrative is 

international, transhistorical, transcultural: it is simply there, like life itself. (Barthes 1977) 

"In the beginning was the word and the word was with God", The Christian Bible 
proclaims. From the time of that first word, which we could date back to a particle of 
a nanosecond before the Big Bang, the word has been formulating itself in clearer 
and clearer forms. Literature is the concreteness, the word made text, of that first 
great word that has brought creation to its present state. On our particular particle 
of dust in this remote area of just another universe we have spent the past few 
thousand years on a quest, the quest of constantly improving communication through 
story telling of who we are and why we believe we are here. 

The World Wide Web, like every particle in the universe is a linking mechanism. 
Before there was the World Wide Web there was a much simpler form of hyper-
communication. Oral story telling, often in tribal settings, was for thousands of years 
the only way to present and preserve narratives. Aside of Palaeolithic cave art with 
its fixation on horses and cows there are no records of the discourses of humans from 
tens of thousands of years ago. 
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Daniel Chandler divides oral and written into two categories giving a list of 
differences: 

Spoken Word Written Word

aural visual
impermanence permanence
fluid fixed
rhythmic ordered 
subjective objective
inaccurate quantifying
resonant abstract
time space
present timeless
participatory detached
communal individual

The World Wide Web combines these narrative dichotomies and takes away much of 
the need to be literary literate. With multimedia computers the literature that we 
once needed to read to understand the narrative we can now hear as well as see; this 
is the combination of the visual and the aural. The World Wide Web makes 
literature both permanent and impermanent. Impermanent narrative is experienced 
through the violative nature of the World Wide Web, both in the way one can link to 
other sites and with the ever possibilities of losing the site one is viewing due either to 
the site being removed from the Internet or the server losing the site all together 
through a crash of its system or deleting the site. All the other paired words of aural 
and written could be isolated and analysed but we can say overall that the World 
Wide Web is the current form in which literature will change in presentation, 
meaning and in experience. 

Human's first exposure to writing began about 3,500 BC in Sumeria and it took five 
hundred years for the development of hieroglyphs and another 1300 years to have 
the first true phonetic alphabet. It took humans five-thousand years to go from their 
first scribbles to finding a way to mass produce printed words with Guttenberg's 
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Press. We only go back to 1964 to have the first word processor being invented. 

Printing has been the tool of learning, the preserver of knowledge, and the medium 
of literature. Until the advent of radio it was the great means of communication. 
(Chappell p. 3) Literature on the World Wide Web has an almost early printing 
press image to it. Books printed during the Renaissance had text surrounded by 
images, usually religious images. The first illustrated book, was made in 1461 by 
Albrecht Pfister. (Carter, Martin, Febvre) 

Before there was the Internet, printed books, the first library at Alexandria and 
before hieroglyphics, humans shared, made up and spread stories. We can only 
speculate how stories were told and spread during pre-recorded history. With no 
way to preserve stories or to pass them on except through oral story telling all stories 
became linked as one person told another and the stories travelled from tribe to 
tribe. Stories would change in their telling and what seemed to be fact to those who 
heard the stories became what we now refer to as myth. 

With the World Wide Web we still may not know the source of a narrative but we 
know it did not arrive through magic or from the gods. Yet there is an easy 
comparison made with early oral story telling and the World Wide Web. Both oral 
and technological story telling are susceptible to flux, revision and the whims of the 
presenter. Whereas, for the past five-hundred years we have had texts preserved 
through the printing process we now have returned to when literature had no fixed 
address. 

In narratives of the past there has been the implied author , the person whom the 
reader assumes is the creator of the narrative. However, on the World Wide Web the 
implied author can easily be a group of authors. The World Wide Web is now a tribe 
with interweaving and constantly changing narratives. 
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GUTENBERG

In Plato's Phaedrus Theuth shows his invention of writing to King Thamus, claiming that it will 
improve both the wisdom and memory of the Egyptians. But the King replies, 

Your pupils will have the reputation for wisdom without the reality; they will receive a 
quantity of information without proper instruction, and in consequence be thought very 
knowledgable when they are for the most part quite ignorant. And because they are 
filled with the conceit of wisdom instead of real wisdom they will be a burden to society. 
(Postman p. 4) 

Whether all the information on the World Wide Web will become a burden to society 
remains to be seen. There is the problem that we do not really know who the source 
of a document is, whether they are qualified to say the things that they say. 
Literature will surely change as it is opened to the masses to express their narratives. 
As the quality of the literature is in the mind of the witness of the text there should 
always be an audience of appreciative readers for whatever text is considered as 
literature and placed upon the World Wide Web. 

The history of printing is an integral part of the general history of civilisation. 
Printing changed the way narration was recorded and perceived and it broke down 
the barriers of order and control in society which were in place during the Middle 
Ages. What was lost with printed literature was the illusion that spoken narrative 
provided with its direct speech. 

The invention of movable type was the greatest single event in the history of 
narration before the computer then the internet and now the World Wide Web 
enhanced the spreading of text. The printing press provided the first information 
revolution and the Internet is providing the second information revolution. And just 
as the printing press brought about a world change so too does the World Wide Web. 

It took a whole century for the printed book to develop a form of its own that was no 
longer dominated by the aesthetic traditions of the medieval manuscript. It was in 
the 16th century Italy that the format of the printed book emerged from the 
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experimental and transitional phase and found a basic stability of form that lasted 
for the next three centuries. By the end of the 19th century the old manual processes 
had been replaced by mechanical production with power-driven machinery. 
(Chaytor, Clancy, Spender, Eisenstein, Butler) It has taken just three years, since the 
release of Netscape , for tens of millions of people to become involved with the World 
Wide Web. The World Wide web may never develop a distinct form, but will 
continually reinvent itself. This means that literature as we know it will continually 
be reinvented too. 

Narrations and information were placed into books as an insurance against the loss 
of oral traditions which grew beyond the possibilities of memorising . As more 
information from more people became known there had to be a means in order to 
save this material. Early books were made up of collections of magic formulas, 
dynastic records, laws, observations , medical experiences and experiments along 
with prayers and rituals (the first manuscript printed by Gutenberg was a copy of 
the Christian Bible in 1450). These first attempts at recorded history were not 
intended as entertainment or causal readings but were a means to reinforce the social 
status quo in which they were read. Today most of these early works would be found 
in the reference section of a library, or they would be stored on the Internet. 

Humanism may have owed the ultimate survival of its ideas to Gutenberg's invention 
(Bolgar p. 280) To repeat what others have said, The Renaissance did less to spread 
printing than printing did to spread the Renaissance (Hirsch pp. 24-37, Eisentein 
p.180, Bolgar p.157) We have this same phenomena with the Internet in this new 
narrative Renaissance. It is the World Wide Web and its huge exposure to and from 
all cultures which is spreading the oneness of multi-cultural narrative. Humanism 
survives and takes on a wider and more holistic scope with many cultures being 
nodes of one another which can be easily linked to. 

The first recorded bodies of texts were done over long periods of time, usually by 
scribes. The beginning of non-linear reading began in late Roman times when books 
began to appear in codex form. This was a gradual transition which extended over 
several hundred years, by the 4th century AD the process was complete. (The 
Encyclopedia Americana Vol. 4, p.220) Previously to pages that could be turned text 
was placed upon papyrus which had to be unrolled to be read. With pages the reader 
could go back and forth within the text they were reading. Also with pages there was 
the possibilities of having page numbers, tables of contents and references. 
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The art of printing originated in Germany in 1440 and spread quickly through the 
world. Commenting on this invention Harmann Schedel published in 1493 (though 
written in 1464) the following notation regarding Gutenberg's invention:  

...by means of this invention the precious treasures of knowledge and wisdom, which 
have long lain hidden in the old manuscripts, as it were, in the grave of ignorance, 
unknown to the world, have now come forth to the light. (Butler p.102) 

The printed form was the only way to permanently record and share ideas for 
hundreds of years after the invention of the printing press. Language, whether it be 
oral or written, was limited to a two-dimensional representation. With the World 
Wide Web a writer no longer is limited to converting their thoughts in such two-
dimensional forms of communication such as writing. The printed page limited the 
writer s expression. Major and minor divisions of the writer s ideas all looked the 
same on the printed page. The printed page becomes an endless uniform series of 
printed symbols. (Showstack p.369-376) The World Wide Web with its multimedia 
enhancements takes narration into a new unpredictable multi-dimensional series of 
linkable nodes imagined by only a few people before the 1990s. 

Marshall McLuhan points to the stripping of the senses and the interruption of their 
interplay in tactile synaesthesia as one of the side effects of the Gutenberg 
technology. (McLuhan 1962, p.17) The World Wide Web further enhances this 
stripping of the senses as multi-directional links and multimedia create the medium 
within the interplays and interpretation of the message . 

The founder of the Internet browser, Netscape, James Barksdale points out that 

"The Internet is the printing press of the technology era. How often have 
you seen technology adopt a rate similar to the Internet's Forty million 
Netscape users in its first two years..."
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MEANING

Meaning within narratives has made dramatic changes between the time of early oral story telling and 
the rise of the World Wide Web. Before the printing press meaning was limited to an ascribed source, 
usually the Church or a ruling person or government. With the mass production provided by the printing 
press, printed text still had an ascribed meaning with the meaning of a text under the control of the 
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creator of the text. Now with the use of the World Wide Web, meaning has made a shift unparalleled in 
human discourse. In the non-linear and unstable environment of the Internet meaning within narrative is 
more of an arbitrary means to an end. 

The medium used to distribute narrative affects the evolution of the narrative. As narrative is valuable 
and grows by an evolutionary process the rate by which the use of the Internet is growing should make 
literature evolve at a rate never conceived of before. The meaning within a narrative on the World Wide 
Web can change instantly. On the Internet Meaning no longer has meaning of any determinable value. 

In the past the broadest categories for literary forms has been prose and verse. These forms now merge 
with nodes of prose and nodes of verse linking to one another. Because of the unstable nature of the 
Internet this merging of various forms is becoming evident even in linear traditional written texts. An 
example of this merged form which is written as a traditional linear text and is also available on the 
Internet can be found at http://www.angelfire.com/hi/OURCHILD/ TRYTHIS.html. Here prose and 
poetry meet on the same page and meaning is dependant on whether the reader reads the poems which 
intercepts the narrative's linear direction. 

Most literature in modern times is printed but long before there was the printing press there was a long 
history of oral narrative. Oral narrative dates back to ancient Greece and was an important part of 
Medieval Europe life. Travelling poets entertained audiences by reciting and performing their works 
prior to the rise of the printing press. On the Internet narrative creators are considered to be travelling the 
electronic highway as they place their stories on the World Wide Web. 

When printing began making its mark on the world some of the first narratives printed were about 
adventures in the New World. Contemporary with the invention of the printing press were the 
discoveries of the Americas. The Conquistadors brought back and had printed their stories of narrative 
acres settled and developed by the new form of interactive literature. Michael St. Hippolyte describes his 
web site, "Mumble Jumble", as,

'Mumbo Jumbo is a few acres of jungle and beachfront on the Web, hoping to provide a 
taste of passion and its nobler fruits. Passion: the collective name for mysterious 
emotive forces churning just below the margin of our consciousness, shooting 
inspiration from time to time into the blue sky of the human imagination.'  

Michael St. Hippolyte
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POETRY

The essential element, if a work is to be classified as poetic or fictional in the 
Aristotelian scheme, is imitation, (Wilson p.5). 

Aristotles distinguished three manners of poetic imitation: 

 
●     1. One can speak invariably in one's own person.  

●     2. One can use actors to imitate the whole thing as though they were living it 
themselves or 

●     3. One can imitate partly by narration and partly by dramatic dialogue (as 
Homer does) (Potts)  

●     We can now add a fourth manner of poetic imitation and that is through the 
use of hypertext. Poetic imitation using multimedia through the World Wide 
Web combines all three of Aristotles manners of poetic imitation.  

Poetry has the widest possibilities in the Internet environment. Poetry has always 
had its experimental bohemian side to it. To play with words is the essence of poetry. 
In the 1950's there was concrete poetry ( Shaped , pattern , Cubist poetry). Shaped 
poetry can be traced to classical Greek times and was adopted in the 1950's as a new 
style by Dylan Thomas, cummings and Mayakovsky to name a few. During the 
1960's two concrete poets; Charles Olson and Susan Howe with their scribbled 
poems that go in circles (Olson) or in Howe's case, of cut lines glued upside down and 

http://neuage.indiko.com/masters6.html (2 of 6) [3/8/08 3:08:53 PM]

hhttp://neuage.indiko.com/thesisall.htm
http://www.geocities.com/picture_poems/thesis/abstract.htm
http://cadre.sjsu.edu/switch/sound/articles/wendt/ng1.htm
http://www.chadwyck.inter.net/lion/l_daap.html
http://www.trillium-arts.on.ca/arts/cubes/
sm3-vox.html
http://watt.seas.virginia.edu/~jef3q/cummings.html
http://homepages.enterprise.net/boffin/index.html
http://cnsvax.albany.edu/~poetry/olson.html
http://orpheus.ucsd.edu/speccoll/findaids/literary/howe


LIGENCE, writing"> Masters thesis on the Influence of the Internet on literature by Terrell...ell Neuage, Hypertext Poets, POETICS ARTIFICIAL INTEL

backwards, were early attempts of unstable texts which the Internet now 
incorporates. Along with experimental poetry there are the Objectivism poets such as 
George Oppen, Louis Zukofsky and Lorine Niedecker and the Beat poets including 
Allen Ginsberg and Leroi Jones (Amirir Baraka). These poetry movements now are 
being explored and experimented with on the World Wide Web canvas. 

What the World Wide Web does for poetry is to make reading an experience. 
Reading becomes a performance taking in both creator and witness. There are 
millions of examples of how present and past poets present their poetry on the 
Internet, some are more dramatic than others. One search engine stated, 'About 
607760 documents match your query,' under the keyword 'poetry', showing how 
many people are willing to share their verses for free with the world. And each 
author hoping to be discovered and loved and understood by the tens of millions of 
Internet viewers we are constantly told are wandering the web. 

In the Preface to the Lyrical Ballads, William Wordsworth wrote,  

'My purpose was to imitate, and, far as is possible, to adopt the very language of men...'  

Today's language of woman and men surely is the language of hypertext as it links 
narratives from node to node. One thing we know about language is that it keeps 
changing. Expressions keep changing, the meanings of words keep changing. 
(Spender p. 09) Narrative is now reader driven. 

The Internet as a transformation of literature as we know it has the good and 
difficult sides to it. On the plus side is that anyone can put their writing on at 
anytime. On the difficult side is the massive amounts of narrative which appear on 
the World Wide Web. There is also the difficulty with knowing who the actual 
creator of the web site we are witnessing is. As an author creating text there are 
dangers to contend with. With a computer it is so easy to lift chunks out of texts and 
copy them. It becomes an almost impossibility to know whether someone will take 
sections of your writing and use it with their own document, and if they do what can 
be done? There is also the issue of money. I doubt that anyone will pay to go to 
someone s sites and read their poems, stories, articles, thesis or even novel. Being 
published on the internet is a long ways from being published by a book publisher. 
There is just too much stuff on the Internet for anyone to care about what an 
individual has to say to pay to read them unless they are already known. 
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With printed literature the reader was able to identify with the text. This 
identification had a morbid affect on many readers of Goethe's novel The Sorrows of 
Young Werther, who either committed suicide or attempted it. Every romantic young 
man felt that he was Werther. (Koestler p. 345) As people have associated and 
projected themselves into the narratives contained within books what becomes of the 
association with characters within web pages on the World Wide Web?

Point of view selects and shapes the meanings of texts. It is not so much a single 
concept as a cluster of concepts, covering several aspects of the relationship between 
narrator, story and reader: the style and structure of the telling, the perspective from 
which things are seen, and the assumptions and values that pervade the text. (Reid 
p.12) Hypertext's greatest value is in its reshaping of the textual landscape of the 
narrative as it has been presented in the past.

The danger of writing hypertext literature is to have too many links so that 
everything breaks down into incoherency. It would be like having Susan Howe write 
a novel instead of just one of her poems. Howe explains her work: 

First I would type some lines. Then cut them apart. Paste one on top of another, move 
them around until they looked right. Then I'd xerrox that version, getting several 
copies, and then cut and paste again until I had it right... (Keller, p.5) 

This is close to what many people do with their World Wide Web pages, they 
combine so much on to one page that it all becomes as incoherent as a Susan Howe 
poem. If her poems are impossible to make sense of what would a hypertext novel 
from her be like? There have been attempts to have a poem with every word linked 
to another site, what happens in these situations is that the reader becomes lost and 
may never find the way back to the origin of the poem. A poem of this sort is at http://
www.ugcs.caltech.edu/~benedett/lit/mercury. html. Produced below to give a feeling 
of a poem with many links. The poem on the left shows the poem without the links 
and on the right with the links.
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Mercury

This is probably not the best way to 
go although I don't know what I 
might have done differently unless I 
had been a different person might 
have had more backbone to stand up 
to him but now I'm almost there and 
what's that noise no it better not be 
oh god it is and well I guess I can 
come back later when the crowd is 
gone the cops will stop them I just 
better not let them see me till later 
I'll just get out here god I need some 
fresh air leave this in the car there's a 
mall I wonder what oh no the keys 
too and there's a phone please no 
trouble no I can't get into my car no 
not there no just don't no please no o 
No. 

Mercury
This is probably not the best way to go although I don't 
know what I might have done differently unless I had 
been a different person might have had more backbone to 
stand up to him but now I'm almost there and what's that 
noise no it better not be oh god it is and well I guess I 
can come back later when the crowd is gone the cops 
will stop them I just better not let them see me till later 
I'll just get out here god I need some fresh air leave this 
in the car there's a mall I wonder what oh no the keys too 
and there's a phone please no trouble no I can't get into 
my car no not there no just don't no please no o 
No. 
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The World Wide Web provides facilities for building multiple views of hypertext applications which are 
linked with other modes within applications. This multiple views affect on narration opens up literature 
to many interpretations of the same text. With alternative routes there is a never ending array of 
possibilities. In print this multiple alternative or branching narrative was first used in Julio Cortazar's 
novel, Hopscotch which was published in 1966. John Irving's The World According to Garp published 
in 1976 also has stories within stories. At the beginning of the 1980's there were the choose your own 
adventure series which were widely available in children's books with their binary decision points 
encoded within portions of the text. For example, 'if you want the good person to wear a black hat go to 
page 40 or for the bad person to go to San Francisco with a flower in her hair pick page 69'. The reader 
takes partial control of the direction of the story. Meaning becomes transcribed by the reader dependant 
upon which view, or now with the Internet, with what multimedia application is being used. An Internet 
example of a work in progress, The Cyberspace Sonnets with hundreds of choices so far can be 
experienced at http://www.teleport. com/~cdeemer/cyberson.html. A much more vast and confusing 
linking work, Queneau's sonnets, can be found at http://www.labri.u-bordeaux.fr/~goudal/htbin/Miliards/
poemes-direct.cgi . Here is where we come across the exponential problem of too many links with just 
too many endings available to ever attempt to use every one. Mathematically narratives can break down 
with too many links. To have a choice in a two page story there would be three pages, the opening page 
and the two possible continuations. To have a five page story there would be thirty-one pages of choices. 
But a dozen pages could lead to over four thousand pages of choices, with a forty page novella needing a 
trillion pages of material. Queneau's sonnets are the results of selecting randomly from ten possibilities 
for each line in each sonnet. Again, it is the reader who is the ultimate creator. 

A more simpler approach to hypertext poetry is at http://www.c3f.com/hyprgrd2.html which announces, 
'Most fucked-up person alive tells all'. In this case we are told to 

Select a word or phrase from the mess below to serve as an entry point into the novel. If 
you don't like where that takes you, come back here and select another. If you don't like 
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where that goes, then turn on some TVs and Stereos and do some more drugs and sex 
and violence and community service, then return here and try again. Keep trying for the 
next few years. Eventually this combination will work, despite what you think now. 

Clicking onto first birthmemory we are treated to the following narrative. 

I was born in a Sony 797, one day, and my first birthmemory was the sight of the pilot, 
co-pilot, and crew, out the window, parachuting by... 

Most of the links on this site are short poetic narratives. 

Another easy to follow story line is Matthew Miller's Trip Across the USA . The site 
has arrows that one may click to move forward or to return to the site's original 
introductory page. Putting the whole story together and printing it out gives a rather 
dull and predictable story, but by random selection of links the reader has a more 
interesting and unpredictable tale to read. Miller's Trip Across the USA is at http://
raven.ubalt.edu/staff/moulthrop/hypertexts/aboutTRIP.html . 

Two other choose your own adventures on the Internet are Shu Kuwamoto's Choose 
your own adventure and Allen Firstenberg's Addventure. Many Choose your own 
fiction stories on the Internet have a tendency to become incoherent. Links can lead 
to irrelevant information or story lines or continually lead back to an earlier section. 
Most readers are not ready for Tree Fiction as they want to known the consequences 
of every decision and will follow each lead. If one wants to follow the author's 
construction then they almost always need to read it in a linear book format.

Being known is the key to Internet success, especially if someone wanted to support 
themselves off of their own writing. The Internet will prove to be a great source of 
introduction to new writings, whether from a new writer or an already established 
writer. For example, a novelist could put their first chapter or an introduction to 
their novel on the Internet and if the reader wanted to purchase the novel then they 
would pay for the remainder of it and either download it to their own computer or 
have it mailed to them.

Several on-line novels are from: 

●     Jeremy Bornstien's Rollover at http://www.rollover.com/notsosecret/ 
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●     Pamela DeCarlo's Today's Woman at http://www.best.com/~nousmeme/
todaysswoman 

●     John Zakour's The Doomsday Brunette, at http://zeb.nysaes.cornell.edu/CGI/
ddb/demo.cgi - which uses the merging of narrative to keep the story on one 
track yet still offereing the reader an illusion of choice 

●     Kurtis Scaletta's Madagascar at http://www.tc.umn.edu/nlhome/g159/scale001 

●     Lewis Call's Indecent Communications at http://scrye.com/~station/ic.toc.html 

Even though it is the easiest way to present a novel to the potential millions of 
readers who view the Internet most cyberwriters have a notation on their web page 
saying they would welcome expressions of interest from traditional publishers. 
(Cohen) 

What web publishing lacks is the respect and realness that Web publishing does not 
(as yet) provide. Aside of the changeable nature of the World Wide Web where one 
day there may be a sophisticated site and tomorrow there will be nothing at that 
URL, demonstrates the fluidity of the Internet. Long pieces of work on the World 
Wide Web are difficult to read with current technology. There is also an issue in 
regards to copyright and payment to the author for their work. Unless one is charged 
for the time they view or for the amount which they download from a site the 
rewards of internet publishing will not be monetary. 

There is a new group of innovative writers who are litweberature literate writing 
hypertextual novels and stories on CD-ROM as well as on the Internet. Several of 
these writers who are published by Eastgate are Michael Joyce (the best known of 
this genre) Judy Malloy and Stuart Moulthrop . Eastgate publishes and advertise 
their many authors who write Hypertext Fiction. It is only since the early 1990's that 
it has become a goal for some writers to remove all thoughts of progression and 
linearity, giving the ultimate freedom of textual chronically to the reader. 

To get a sense of what their hypertextual writing do read what the critics say about 
the various novels that Eastgate publishes. The critics use phrases like 

●     "Shifting narrative voices"
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●     "An electronic tangled strands of knowing and memory" 

●     "The experiment with randomization is bold and surprisingly effective"

●     "The effect is remarkably close to the subjective quirikiness of memory, of past 
moments floating unpredictable to the surface" 

●     "A fractal web that could never be downloaded off the computer and reprinted 
in paper form". 

 
All these quotes were from different critics referring to different texts, but all these 
quotes would apply to any one of the writings. 
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The argument of oral versus literate cultures is once again taking on new dimensions with the rise of the 
Internet. Whether people are Internet-literate or not is adding to the Great Divide theories of the 1980's, 
though they should be short lived. These arguments over whether a literate culture was superior to an 
oral culture threaten to spill over into the debate of technological communication superiority. Just as 
some people believe that literacy leads to higher forms of thought there are those who believe being on-
line is important to communication evolution. It is easy to push this line so far as to seeing non-
technological societies as inferior to ones which embrace new communication technologies such as the 
Internet. But the Internet will be different from other forms of communication which divided people in 
the past. In the past it was difficult for some sectors of society (women, poor, various ethnic and 
religious mixes, age: too young, too old) to obtain the technology to advance themselves. Dale Spender 
writes well on these topics. With the Internet, as I will say below there are many resources for anyone to 
make their presence felt, their say heard and their literature available. 

There was the argument that the Internet would separate the rich from the poor even more. That it would 
be available to middle-class westerns and mainly to males (Spender). Because the United States 
dominants the Internet there is the questioning of United States values being projected to the world 
through literature as it has in past times. But this too will even out as more countries become hooked up 
to the Internet

Other concerns with the use of the World Wide Web as a source of literature are: rarely do articles have 
dates for when they were published on the Internet, was this piece written five years ago or last week 
and what editions or what edit is it of the original piece? At this time no on-line journals has the 
reputation of print academic journals and until they do print journals will be more sought after. Rarely is 
the source or qualifications of the author known. Just because they put a Dr in front of their name or a 
phd after we do not know if the writer is who they say they are. And the most upsetting aspect of the 
Internet is the disappearing web pages. This happens when a site is no longer on-line for any one of a 
variety of reasons: through the server crashing (I lost 200 sites on Angelfire because of a system crash 
they had, I lost over a hundred sites on geocities because they deleted a major site I had and I lost over 
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one-hundred web-pages on another server when they went out of business - for several months there 
were over three-hundred of my sites - mostly poems - giving back the message of 'ERROR - The 
requested URL could not be retrieved'. I also lost a year's work which was difficult at the time to accept.

In Australia the Internet is widely available to anyone anywhere for free. All the libraries and schools 
have computers and Internet available. It is a simple matter of booking time at the library or spending 
long hours at university but at least in Australia there is no excuse why anyone can not have their text 
placed on the Internet and for free. There are many services which give free web sites; the best and 
easiest to use are geocities and Angelfire. There are many free community based servers along with 
universities and public schools that will give users free space. A list of free web sites is available from 
http://www.yahoo.com/Business_and_Economy/Companies/Internet_Services/Web_Services/
Free_Web_Pages/ and http://www.netutopia.com/freebies/freepage.html . Angelfire and Geocities even 
provide templates making it extremely easy for anyone to place their poems or stories on the Internet. 
And for those who want to learn how to make their pages look more interesting there are many Internet 
based tutorials that teach simple World Wide Web language. The point being that anyone can contribute 
to world literature via the Internet. There are also several free World Wide Web E-Mail services, such as 
goplay at http://www.goplay.com and hotmail at http://www.hotmail.com. With Internet Cafes and soon 
Internet computers installed at shopping centres, gas stations, airports and on street corners there will be 
no new class of internet poor. The new World Wide Web based literature will be the literature of the 
people, of the reader and not necessarily of any particular institution or writer.

The World Wide Web will be more accessible to more people to place their literary genius before the 
tens of millions of people who view the Internet on a daily basis. 
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Since 1945 the number of printed journals has increased from 7,500 to 140,000 and currently are 
increasing at the rate of more than one-thousand new journals each year. The number of new book titles 
published each year has increased from 300,000 to more than 850,000 since 1945. (Gilster p. 126) It is 
too early to forecast whether the number of new journals and books printed will decline with the use of 
the Internet. There are already thousands of journals on-line. Some on-line sources have the complete 
journal and some have just indexes to what is within the journal. The advantage of on-line journals to 
print journals is the rapid rate information can be retrieved without needing to have many journals to 
individually shift through. On-line journals will grow in number and most journals will have an on-line 
edition which the reader will be able to interact with. This interaction will come about by the reader 
being able to offer opinions and suggestions in response to what is presented.

Future literature will be made up of multiple modes linking texts, sound and movie bits as well as 
graphics. Literature will become an experience. With the further development of virtual reality we will 
be able to navigate through text, following sentences and paragraphs over textual mindscapes. The 
Internet like the printing press makes literature available to more people and on a larger scale than ever 
possible in the past. Presently hypertext is a one-way avenue, we can hypertext to another site but once 
within another site we can not link back. Within a few years there should be full hypertext where links 
can be followed in both directions. There will be editions of literary works that are intended from the 
start to be only created for the World Wide Web and will never exist in a printed form (Lavagnino)

Every poet or essay writer can now have a world audience . Poets in the past have struggled to get their 
works out. Charles Reznikoff had to publish his own books until he was in his seventies. Lorien 
Niedecker lived all her life in a small fishing village in Wisconsin where she scrubbed hospital floors to 
make a living and was not widely published until the late 1960's. Now we can publish a poem or essay 
as soon as we write it, we can even write it and edit it live on the Internet with the potential tens of 
millions of viewers watching us write. As I have done with this thesis. Of course these millions of 
viewers are only potential. Having had the personal experience of creating hundreds of web sites, and 
promoting them through the various search engines and what's-new sites, I have found that only a few 
sites registered more than a few hits a week. And those sites were because I put the words erotic in the 
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title which is what the search engines display of a web site. Though for a month (September 1996, when 
this site registered 35,000 hits) my erotic poem of the month received over a thousand hits a day, then 
starting the next month it went back to a few dozen a day. I have no idea why that happened, obviously 
it was written up somewhere as a site to visit. I have lost interest in poems of the week and of the month 
and no longer up-date them, but the availability of the internet for poems and stories is always there. 
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FUTURES

CONCLUSION 

Though it is beyond the scope of this thesis one could relate the pattern defining abilities of the brain to 
adapt, change and as mentioned earlier to link, to the rise of the World Wide Web. Everyday thinking is 
equivalent to the narrative which will be redefined because of the use of the Internet. The thought 
processes that we are always encountering within ourselves is one of transferring from node to node. For 
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example as a parent, student, artist, photographer, body builder, astrologer, writer and all the other things 
one does to be part of society, I may be one moment entertaining thoughts about my children's activities, 
then jump to thinking about my girl friend, my studies, body building or which time is the correct birth 
time for Princess Diana (2.15 PM or 7.45 PM?) or any one of a thousand and one things. Society is a 
linking process, and a society's narrative, to be true, is one of linked nodes.

The narrative that we experience within ourselves and within our reading or communications is now part 
of a global syntax. Literature can no longer continue only as a story produced in dead tree printing 
methods. Literature will now become reader driven as the witness-consumer-creator will produce and 
consume a new type of narrative. The narrative of the 21st century will be the narrative of all the world's 
voices weaving in and out and linking within and without providing continuos new structures and new 
literature unknown before this time. 

'In considering transitions of organs, it is so important to bear in mind the probability 
of conversion from one function to another. (Darwin, p 45.) 

The Internet provides us with the first time in recorded history of a world literature. 
For the past several decades there has been a growing consciousness of the world 
being one family, the interconnectedness of all life is a constant theme of the past 
thirty years. World literature is now easily available through the internet. At some 
time someone will begin a project of a world story done on the Internet. Writing a 
story with people from different cultural backgrounds in various countries would 
produce a text that would have ascribed meaning by the readers as well as the 
writers.

The story is no longer about what has happened to men and women and how they 
responded, instead it is about how the subjective and collective meanings of women and 
men as categories of identity have been constructed... (Scott, p.6) 

Just as all forms of literature: drama, epic, essay, novel, poetry, short story, novels, 
plays, and movements in literature: such imagism, romanticism and surrealism and 
the many national literatures: American literature, Catalan literature, English 
Literature and German literature have become available to wide audiences through 
the printed text so they too are becoming popular throughout the world via the 
Internet with the literature of every genre imaginable.

The Internet was made to be indestructible. The American government wanted to 
find a way to survive nuclear war, or asteroid crashes or any of the other predictive 
ends that may occur. It is as if all the prophecies of the pass two thousand years 
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about the end of the twentieth century would end in a destructive manner gave rise 
to the concept of a means of communication that would still be operatable even if the 
destructive predictions came true. 

There is still in the collective memory of the human race the destruction of the 
Library of Alexandria in 641 in which a thousands years of scholarly work was 
stored. Now we have a way to save the world's knowledge no matter what happens, 
whether the vast majority of life on earth is destroyed in nuclear war, or natural 
disaster, global warming or collisions with rocks from space. Human knowledge will 
survive humans. Of course what narrative is found by a future generation will need 
to be de-coded by a future generation.

Books will not lose their place, only the reader will. Books will undergo 
transformation through interpretation and presentation as all literature always has. 
The Biblical scholar Stephen Prickett prefaces his Origins of Narrative with:

 
During the late eighteenth century the Bible underwent a shift in interpretation so 
radical as to make it virtually a different book from what it had been a hundred years 
earlier...far from being divinely inspired or even a rock of certainty in a world of flux, 
its text was neither stable nor original, the new notion of the Bible as a cultural artefact 
became a paradigm of all literature... 

(Prickett 1996)

Just as Prickett speaks about a shift in reading the Bible there is now a shift in 
reading the universe (Pricett 1996 p.155). Our current shift in reading via the World 
Wide Web is a shift in partaking of narrative exchanges. 

The Internet will prove to be a great source of introduction to new writings, whether 
from a new writer or an already established writer. For example, a novelist could put 
their first chapter or an introduction to their novel on the Internet and if the reader 
wanted to purchase the novel then they would pay for the remainder of it by credit 
card and either have it sent to them electronically or download the material and 
print it themselves.

Multimedia is changing how narrative is presented. The onus is upon the reader 
whether to evaluate material on the World Wide Web and to develop the critical 
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skills needed to give meaning to what is seen. Anyone can self-publish and have 
Internet sites looking highly polished and professional with very little effort using 
web page editors. As literature via the World Wide Web becomes ubiquitous, being 
all things to all people, each reader (the witness of the narrative) will create a 
different perspective to the original creation. The author has not died but instead has 
grown up and is part of a true literary-exchange

With the WORLD WIDE WEB's availability to all the individual writer-poet-heroes 
an individual voice of the age will no longer be occurring. There will never again be 
another Roland Barthes, Wordsworth, Shelley or a Shakespeare. Where there was 
once but a few voices now there are thousands each with a different point of view and 
crying out to be heard. 

The World Wide Web is a digital speak-easy where literature is experienced as a 
process of mutating volatile virtual texts. Literature on the World Wide Web reflects 
the unpredictability of human life which has come close to extinction. As narratives 
merge, link and interact through the use of the World Wide Web humanity will 
redefine itself and survive, which without the Internet it might not have. 

GlOsSaRy 

Cyberspace

Term originated by author William Gibson in his novel Neuromancer the word 
Cyberspace is currently used to describe the whole range of information resources available 
through computer networks.

Hyper

- Above, excessive or beyond. meta = among about or between

Hypemedia

- is a subset of interactive multimedia. 
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Hypertext

Generally, any text that contains links to other documents - words or phrases in the document that 
can be chosen by a reader and which cause another document to be retrieved and displayed. Ted 
Nelson claims to have originally coined the term Hypertext. 

WWW

(World Wide Web) -- Two meanings - First, loosely used: the whole constellation of resources that 
can be accessed using Gopher, FTP, HTTP, telnet, USENET, WAIS and some other tools. Second, 
the universe of hypertext servers (HTTP servers) which are the servers that allow text, graphics, 
sound files, etc. to be mixed together.

A more complete 

glossary

may be found at: http://www.matisse.net/files/glossary.html
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Professional summary: Possessing a broad skill set with diverse experience in education, I am a 
motivated and enthusiastic teacher with a strong work ethic. I am able to infuse my courses with 
creativity, and build excellent rapport with my students and co-workers. 
 

•      Computer teacher grades 5-12.
•      Director of Technology. 
•      Teacher Trainer.
•      Online Editor of scholarly magazine.
•      Experienced teacher in university communication courses
•      Designer of on-line courses.
•      Web content and design.
•      International baccalaureate MYP trained.
•      Volunteer work, created safety patrol maps for the Police Liaison Group, Inc. 
http://www.plgnyc.org/maps/ue.html for private schools in the upper east and west 
side of New York City.
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January 2007 - Current
 

The Dwight School 
291 Central Park West
 

•      MYP Computer teacher grades 6-10
•      MYP Computing Design teacher grades 9-10
•      After school program grade 4-6 (photoshop)
•      After school program grade 7-12 (web page design)

 
Software currently teaching: McNeel Rhino 3D (for Mac), Google Sketchup, Scratch, Adobe 
CS: Dreamweaver, InDesign, Flash, Photoshop, Illustrator, Fireworks; Microsoft Office 
(Word, Excel, PowerPoint.
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State University of New York, Albany
1200 Washington Ave, Albany, NY
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August 2004 – June 2006
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•      Computer teacher grades 5-12
•      Academic department Chair of Technology
•      Teacher Trainer
•      Coordinator of Classroom Technology Integration

 
 
Software taught: Microsoft Office, Adobe, Photoshop, GoLive, Sony ACID Music Studio , 
Macromedia: Dreamweaver, Flash, Fireworks, FreeHand, Apple Final Cut Studio – video 
editing, McNeel Rhino 3D, Flamingo - a rendering plug-in, Bongo - an animation tool,  
Penguin - which brings freehand sketching, watercolor painting and cartoon-like rendering 
to Rhino and AutoCAD , Ulead: Cool 3D Studio, Gif Animator, Eastgate Storyspace – 
story-telling web based writing package.
~ Courses online at: http://neuage.org/AA/index.htm

 
August 2002 – June 2006
 

State University of New York, Albany
1200 Washington Ave
Albany, NY
 

•      Adjunct Professor Department of Communication: Speech Presentation
•      Adjunct Professor Department of Communication:  Globalisation and Culture
•      Adjunct Professor Department of Communication:  Communication and the 
Internet
•      Adjunct Professor Department of Communication:  Web Design

 

file:///Users/user/Desktop/neuage/resume3-08.htm (2 of 4) [3/8/08 12:49:03 PM]

http://www.cios.org/
http://neuage.org/AA/index.htm


Terrell Neuage PhD 
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•      Lecturer: Department of Communication and New Media: Computers, 
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•      Lecturer: Department of Communication and New Media: Computers, 
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•      Lecturer: Department of Communication and New Media: Cultural Change 
and Communication Technologies
•      Lecturer: Department of Communication and New Media: Internet, Culture 
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PhD, Communication and New Media, University of South Australia, 2005 (Thesis, 
‘Conversational Analysis of chatroom “talk”’)
~ Thesis online at http://neuage.org/All.htm
 
Masters of Arts, Literature, Deakin University, Victoria, Australia, 1997  (Thesis, ‘Internet 
influence on Literature’)
 
Bachelor of Arts with Honors, Children’s Literature, Deakin University, Victoria, 
Australia, 1995
 
Bachelor of Arts, Journalism, Literature, Deakin University, Victoria, Australia, 1994
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computer courses middle school

"There is your truth, there is my truth  
and there is the truth." Chinese proverb

Dr. Neuage PhD University of South Australia

Our goal with webpages. A website mission statement (evolving). 
Learning Dreamweaver - notes for all classes 

 
2007-2008 basic-plan Revised plan for rest of 2008 
THE DESIGN FOLDER 
Content Skills Tables

Year 6 [2008 plan] MYP year 1 DAY 2 PERIOD 3 AND DAY 5 PERIOD 5 

Year 7 [2008 plan] MYP year 2 DAY 5 and DAY 3Trimester 1 

Year 8 [2008 plan] MYP year 3 DAY 6 PERIOD 0 AND DAY 1 PERIOD 1 and 8b = CLASS MEETS DAY 
3 PERIOD 0 AND DAY 5 PERIOD 1 Timester 1 THE MEDIA 
Year 9 [2008 plan] MYP year 4 DAY 2 PERIOD 2 AND DAY 6 PERIOD 2 

Year 10 [2008 plan] MYP year 5 

9 (Creative Tech) [2008 plan] DAY 2 PERIOD 2 AND DAY 6 PERIOD 2 
10 (Creative Tech) [2008 plan]

The software we are using include Rhino 3-D, Google Sketchup, Macromedia CS3 (Dreamweaver, Flash, Fireworks), 
Adobe CS3 (InDesign, Photoshop, Illustrator)

* All Projects will implement the Design Cycle when it applies. Areas of Interaction: in all grades 

Aims 

Computer Technology is designed to create a balance between the imparting of skills, the acquisition of techniques 
and knowledge, and the growth and awareness of the students' personal responses. This is a practical hands-on course which 

is taught in the computer lab. Students work one to a machine. The aims of computing are to:

●     # encourage an awareness of the impact of computers on society and the environment 
●     # develop an appreciation of the international and intercultural aspects of computers 
●     # provide a variety of technological information and ideas 
●     # encourage curiosity, ingenuity, resourcefulness and discrimination 
●     # stimulate self-confidence through the knowledge and application of computers 
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binary code 
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[citius, altius, fortius!]
Assessment Criteria for the IB MYP 

Criteria Name

A

B

C

D

E

F

investigate

design

plan

create

evaluate

attitudes in technology

TECHNOLOGY
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●     # develop practical skills through the creation of products/solutions 
●     # promote effective, informed, appropriate communication 
●     # foster responsibility for designs, decisions, actions and assessment 
●     # promote effective cooperation and respect for individual differences when responding to technological challenges 
●     # develop logical-thinking skills

The curriculum 

During the MYP course, students will become proficient in the use of:

●     # Word processing programs
●     # Database programs
●     # Spreadsheet programs
●     # Presentations programs
●     # Publishing programs
●     # Computer aided design (CAD) programs
●     # Multimedia programs 

Students will also study ethical issues of computers and the internet, and the impact of computer technology on society.

●     Guidelines for citing Internet sources Please review and cite correctly any online sources.
●     How to save your stuff on firstclass
●     Computer Technology Project Check list
●     Website Design Rubric that we will follow for all webpages / Ten things to think of with Web Design / 

Scoring sheet
●     International Baccalaureate Middle Years Programme Technology Assessment Criteria

Moodle / Wiki / My Dwight / First Class - email is on your desktop - from home log in here then download... 

Dwight Students, post your reviews and opinions about any projects or software you would like to see us work within our 6 
– 10 computer technology courses and our year nine and ten technology and design courses.

Are you ahead of the ‘technology curve’? Inform us and we will explore the latest. Dwight computing will be at the forefront 
in online ‘whatever’ – your impute is important. Do not depend on ‘adults’ to review the latest products, or ‘path’ – be a part 
of our direction even a leader/pointer toward the future. Join our new site and express yourself > http://dwight-
reviews.wikispaces.com/

Other links used in our courses: 
Episode 9: Manipulating Society through Technology

●     Global Issues Network - The Global Issues Network has as its mission: to help students realise they can make a difference 
by empowering them to work internationally with their peers to develop solutions for global issues. Begun by teachers 
and students from six international schools in Europe, the programme is based upon High Noon: Twenty Global 
Problems, Twenty Years to Solve Them by Jean-François Rischard, former World Bank Vice-President for Europe.

●     Global SchoolNet Foundation (GSN) - Resources for global project-based learning, problem-based learning, and 
online collaborative learning
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●     Kurzweilai this is a site we will use for our studies in AI, Nanotechnology and all that is 'the latest'... 
●     ETC. Creating Artificial Intelligence, AthenaWeb > A virtual home for science communicators, 
●     Online Software packages Scratch, Sketchup, 

Australian Schools and projects we will work with (Most private high schools in Australia call themselves colleges): 

1.  MLC (Sydney) Skoolaborate a Teen SecondLife Virtual World project - We may build a virtual Dwight as part of 
Skoolaborate. More information is available on their wiki (skoolaborwiki.wikispaces.com).

2.  St. Leonard’s College (Victoria) The theme of the school is discovery, and each year level has a focusing theme. For 
example, the theme for year seven is ‘my place in the world’ and for year eight, ‘change’.

3.  St. Peter's College (Adelaide, South Australia) St Peter’s College offers Information Technology in Global Society in 
group three of the IB Diploma.

4.  Kilmore International (Victoria) They are the only school in Australia set up as a total IB School. The school of 400 
students caters to Years 7 – 12. It is a boarding school for years 11 and 12 with many students from Asia, the majority 
from Korea. They have 100 percent tertiary institution admissions, with students going to top schools such as Yale, Oxford, 
and the London School of Economics. 

5.  Wesley College in Melbourne (we have had students from this college visit Dwight and students from Dwight have 
visited here) - In year nine, students spend ten weeks at Monash University in Melbourne, living in the city and doing 
their courses at the university. They spend a further ten weeks living at a country school, developing their life skills 
whilst working within the community and doing their courses, often online.

6.  Trinity Grammar School - (Sydney)

I visited and have contact with The International School of Phnom Penh (ISPP), Cambodia, and we may set up a project later 
in the year with them.
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Computer Concepts @ Albany Academies  
May 22, Dr. Ryu (RPI)    will give a demonstration on the nano-electronic microscope and 

at 1.30 the bus leaves from AA for the SUNY nano-technology college for our visit of 
NanoCareer Day 

 

 ~ 
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Computer Concepts at Albany Academies for 2005 - 2006 Dr. Terrell Neuage Ph.D

 
Albany Academy and Albany Academy for Girls

Albany, New York
135 Academy Road, Albany, New York 12208 

(518) 465-1461 (ext. 305) phone; (518) 427-7016 fax
 
  

Dr. Terrell Neuage neuaget@albanyacademyforgirls.org  
BA (Journalism, Literature), Honours (Adolescent Literature), Masters (Internet as Literature), Deakin 

University, Melbourne, Australia; 
Ph.D. (Internet Communication and New Media) University of South Australia  
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Terrell Neuage PhD thesis - charting the ODAM - University of South Australia
Constituting the ODAM (Online Discourse Analysis Method)

1.  Use of mixed linguistic analysis methodology 
2.  Finding strictly regulated language practices 

3.  Main feature of online talk: Open/Creative practices 
4.  Main features of online talk communities – relational talk 

 
Charting ODAM
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Constituting the ODAM (Online Discourse Analysis Method) PhD thesis by Terrell Neuage at the Unversity of South Australia

Building inwards from the broad user-perspectives of Reader Response, examining chat postings as actively 
received interpreted “wreaderly” communication, the ODAM has cut four deep and “rich descriptive” wedges 
from a multi-dimensional, multi-leveled set of chat actions. Beginning simply on an empirically driven arm: to 
cut into actual instances of chat practice using any existing research methods which could examine how online 
talk “works”. The study can now be seen to offer in the first instance, a set of interlocking research tools, any or 
all of which can be picked  up, critiqued and re-applied, to be improved upon in future studies, by future 
researchers.

A second “wedge” or cut from the research findings however establishes that a key direction in linguistic 
research methodologies: the drive towards establishing the “regulatory” or rules-and-systems elements 
behind language  use, is indeed given a different spin within online talk. Here it proves possible, again 
and again, from method to method – across the seven case studies “speech communities”, to reveal tightly 
regulated, recurrent and systematic talk practices, variant from those observable offline, even where there 
are equivalent interest or topic groups. Wedge 2 indicates those already established online practices which 
constitute the difference, and even expertise of online chat, this suggests that it may well be on its way to 
constituting its own “speech community/ies”. 

But it is wedge 3: those descriptive features which reveal a markedly “open” or “creative” set of 
communicative behaviours online, which reveal how chat is being constituted. Here the evidence of 
complexity, semiotic and graphic play, consistent  relational focus and creative expertise introduces the 
dynamic energy of online communication. Favouring members and strategies and expertise which reveal 
skill and creativity and fast-paced interpretive  responsiveness.

Wedge 3 practices lead us on to the discourse-under formation of wedge 4 or discourse demanding 
continual enactment of familiarity, consensual strategies, relational work, and what CA would call 
“category maintenance” – of an exclusively “communal” kind.

Online chat, regardless of topic or the specifics of a participant group, appears directed to community 
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itself. Not quite un-agentric as it dis-connects from action, it becomes meta-agentric: more about how to 
operate than about “what to do”, It is this, contrary to most contemporary public and media’s accounts,  
richer in value than in projects. It is a discourse largely about itself.

Having completed the seven differently-focused case studies designed to investigate these issues, it is now 
possible to see the quite distinctive directions these questions raise and the concomitant ways in which 
equally distinctive “clusters” of research focus have proven to have arise. The studies move from the fine 
focus of what can now be seen as technological and methodological questions (turn-taking; meaning-
making; observational study) to a comparative emphasis cultural sensitivity in chat and in real-life talk; 
chat as reflective of real-life discourses; chat in comparison to natural conversation to the “postulatory” 
emphasis of much broader questions (chat as a useful area for new conversational research theory; chat as 
a new universal language). My own preliminary thinking indicated a three part study program, moving 
from existing linguistic-based observational and analytical methods, to an empirical evidence-founded 
description of actual online “talk” practice, and so to a deeper and richer set of hypotheses relating to 
online “chat” practices and behaviours. The study has thus begun the first stage of a methodological 
design for the study of chat – and perhaps of its future technologisations. The ODAM or Online Discourse 
Analysis Method proposed at the outset has evolved across the seven constitutive Case Studies:

●     CS1  Reader-response 
Meaning-making depends on interpretation 
Interpretation depends on Habitus and e-Habitus

So the study moves to

●     CS2 Technologisation 
CMCs contribute new connective problems (gaps/pauses) and selections (bridgings/ braidings).
IM is relatively familiar (like conversation):
IRC is complex

So the study moves to          

●     CS3 Pragmatics/Semiotics 

How talk is managed and represented online

                                                                                                
Pragmatics                                                             Semiotics
Regulatory online cues/codes           Graphic play
command more response                    Creative play dominant       

So the study moves to

●     CS 4 Speech Act Theory: 
Which talk forms occur in IRC?
Very indirect forms common, to keep relations OPEN. 
Is IRC primarily relational?

So the study moves to
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●     CS 5 Discourse Analysis: 
Does the “relational” work online construct a communication community?

 

 
Consensual semiotic play                                   Speech-Acts-as initiation/termination
                                                                                                of “threads”

So the study moves to

●     CS 6 Conversational Analysis: 
How online communication regulates exchanges. Turn-taking and repair evident, but more complex than in real life 
conversation

So the study moves to

●     CS 7 Grammar: 
How do word selection and order contribute to chat?

Technologisation, creative play, force new “grammars”.

 

Concision       online competency                     familiarity in online community   
                                                                                                relational work

 

5.3 Research Questions and answers

Having revealed them both a tendency towards community-specific chat behaviours and at least the 
foundations for “chat universals”, it is time to revisit the research questions which orginally drove this 
project. How have they contriubted to, or contrained the findings?  The five initial focus areas for this 
study were as follows:

1.  Is meaning communicated in chatrooms? 
2.  How is turn-taking negotiated within chatrooms? 
3.  Are issues of cultural sensitivity as relevant as in face-to-face talk? 
4.  How is electronic chat reflective of current social discourses? 
5.  Will chat become a universally understood language? 

Added to these mixed and incommensurable questions were an equally multi-level listing of my then-
current assumptions on online communication:

1.  That people create a different textual self for the chatroom environment that they are in 
2.  That conversation within chatrooms will change how we come to know others 
3.  That ‘chat’ does not differ from natural conversation 
4.  That observational studies of chatroom conversation can capture some of the adaptations of 

conversational behaviours 
5.  That this work gives us a better understanding of how and why chatrooms are an important area in 

which  to create a new conversational research theory 
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Videos from trip 2006 Albany to Adelaide Return to 06 trip ~ 05 trip

 

Refresh

* Brooklyn updated 
October 27, 2006 

* Photos Slideshow 

* Windows Media Videos 

* Photos 2002 - 2005 

* YouTube

●     Turkey

1.  Bosphorous 
2.  Hotel Poem Rooftop 
3.  Street Cafe 
4.  Rooftop 
5.  Hotel Poem MP4 & 

MP3 
6.  Buyukada-island 

MP4 & MP3 

●     VietNam

Videos Updated October 24, 2006 11:12 PM Brooklyn, NY 

●     TURKEY (1) Bosphorus Boat ride (2) Buyukada [Princes Islands] (3) Hotel 
Poem rooftop 

●     VIETNAM (1) Wild Bike Ride - Ho Chi Minh City (2) Countryside (3) Ho Chi 
Minh City (4) Pandanus Resort 

●     PARIS CHRISTMAS 2005 (1) Leaving Albany (2) Christmas Day (3) Home 
(4) Lourve (5) Walk-about (6) Seine 

●     ADELAIDE (July 2006) (1) Christies Beach Train Station (2) Leigh's Baseball 
- Southern districts (3) Adelaide by train (4) Narda's (3) son's band July 29, 06 at 
the Rocket, Hindley St. Adelaide and at Helena's 50th birthday singing Beatles 
songs with Narda 

 

 

 

 

 

 

.
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1.  Saigon Bike Ride 
2.  Saigon traffic 
3.  Pandanus Resort 
4.  Mekong Delta 
5.  Monsoon
6.  Phan Thiet 
7.  South
8.  Narda-Cyclo
9.  Delta-boat

10.  Delta-Singers

●     Paris Christmas 2005

1.  More Paris b Video 

●     Holland (06)
●     Holland (05) 
●     Germany (06)
●     Germany (05) 

Australia (AUGUST) 

Flight Melbourne - 
AdelaideWMV

1.  Footy 
2.  Narda's (3) son's 

band July 29, 06 at 
the Rocket, Hindley 
St. Adelaide 

3.  Adelaide (Christies 
Beach; Southern 
Districts) 

4.  Train into Adelaide 
(youtube) 

5.  Melbourne 

ALL PHOTOS (1947 - 
2006)
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Trip 04 videos (Ireland, 
Barcelona, Utrecht, 
Hamburg, Hong Kong, 
China) 

Trip 03 videos (Korea, 
Hong Kong, Singapore, 
Sydney) 

Round Lake NY

NYC

Washington D.C. 

videos below open in 
Windows Movie Video 
(much better quality) 

Bosphorous Boat  
Hotel Poem 
Istanbul Cafe 
Saigon Bike Ride  
Saigon Traffic 
Ho Chi Minh City  
Monsoon 
Phan Thiet 
South 
Narda-Cyclo 
Delta-boat 
Delta-Singers

Photos 2002 - 2005 
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  Terrell Neuage PhD 
Brooklyn, New York (September - June School year) 

Adelaide, South Australia (July - August)
tneuage@gmail.com / tneuage@dwight.edu 

Homepage http://neuage.org 
updated, 08 March, 2008 

Middle School (MYP) Computer Teacher 
High School Computer Teacher 
University Communication Professor/Lecturer
Director of Technology K-12
Department Chair Information Technologies K-12 
Teacher Trainer
Online Editor of scholarly magazine
Designer of on-line courses
Researcher
Artist - Writer - Poet
Web content and Design
Newsletters for mobile devices (http://ournews.mobi)
New York City Student Patrol Safety Maps  

  
Recent Employment ~ Past Employment ~ Volunteer Work ~ Education ~ Referees ~ Publication ~ 

Current Research

Current Employment
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Dwight School Technology and Creative Design (course notes http://neuage.org/dwight/) teacher 6 -10 Middle 
Year Program (MYP) International Baccalaureate (IB). Notes on Secondlife project  
Software currently teaching: McNeel Rhino 3D, Google Sketchup, Scratch, Adobe CS3: 
Dreamweaver, InDesign, Flash, Photoshop, Illustrator, Fireworks; Microsoft Office:Word, Excel, 
PowerPoint). After school computer programs for grades 4 - 5.

Recent Employment
Albany Academies; 

ü       As teacher I taught web design 
(Macromedia and Adobe), animation, 
Microsoft software, and developed 
curriculum for these courses. 
ü       As teacher trainer I provided individual 
computer help for teachers on a needs 
basis. 
ü       As Director of Technology I drew up a 
long term technology plan and gave 
oversight to the successful implementation 
of technology into classroom practice. 
ü       As Chair of the computing department I 
oversaw curriculum development, 
administrated budget, and worked with staff. 

  
 
 
 
University at Albany; 
Taught and designed courses in speech, 
“Globalization and Culture” and “Communicating 
on the Internet”. 
  
 
Russell Sage College; 
Taught and designed courses in speech and 
Interpersonal Communication. 
 
University of South Australia;
Taught courses in "Computers, Communication 
and Society", "Information Systems", "Globalisation 

Computer Academic Chair, Teacher Trainer, Computer Teacher (grades 9 -12 Albany 
Academy and Albany Academy for Girls Albany,) New York. 2004-June 2006.  

      Course online at: http://neuage.org/AA/index.htm  
  

SOFTWARE TAUGHT  
Albany Academy and Albany Academy for Girls 

●     Microsoft Office : Word, Excel, Power Point, Publisher, Front Page
●     Adobe : Photoshop, GoLive
●     Sony ACID Music Studio
●     Macromedia : Dreamweaver, Flash, Fireworks, FreeHand
●     Apple Final Cut Studio – video editing 
●     McNeel Rhino 3D , Flamingo - a rendering plug-in, Bongo - an animation tool, 

Penguin - which brings freehand sketching, watercolor painting and cartoon-like 
rendering to Rhino and AutoCAD 

●     Ulead : Cool 3D Studio, Gif Animator
●     Eastgate Storyspace – story-telling web based writing package 

 
Adjunct Professor, University at Albany, State University of New York, Department of 
Communication. Speech Presentation, “Globalisation and Culture” and “Communication and 
the Internet”.   2002-2006. 
Course online at: http://neuage.info/PS/ACOM203-1.htm 

      Course online at: http://neuage.info/GC/gc.htm 
      Course online at: http://neuage.info/COM465/com465.htm 
  

Adjunct Professor, Russell Sage College Troy, New York. Department of Communication. 
Oral Communication, Interpersonal Communication.  2003-2004. 
  
 
Lecturer, University of South Australia. 2000 – 2002. 
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of Technology", "Communications, Internet, 
Culture and Community", and taught Practical 
Computer Skills. 
 
Web editor;
Formatted and edited manuscripts for online 
journals. 

 
 
Web editor, “The Electronic Journal of Communication” / “La Revue Electronique de 
Communication” Communication Institute for Online Scholarship. http://www.cios.org  2002-
Present. 

Past Employment
Adolescent Worker ;
Worked with teenagers in crisis care. 
 
Artist in the Park;
Set up project with the cooperation of the Adelaide 
City Council for artist to display and sell their work 
in Rymill Park on weekends.
 
Light Foods of Australia;
Manufactured and distributed tofu and products 
made from tofu. Gave classes in tofu cooking 
through TAFE Colleges and published "Tofu 
Cooking" (1982 South Australia). Owner of Light 
Foods Australia, five employees.
 
 
Nursing;
Counselor and Psychiatric Nursing Assistant. 
Counseled patients, wrote nursing notes, 
dispensed medication.
 
 
Nursing;
Counselor and Psychiatric Nursing Assistant. 
Counseled patients, wrote nursing notes, 
dispensed medication.

Adolescent worker, South Australia Family and Community Services - Noarlunga and 
Aberfoyle Park. 1999 – 2002. 
 
Manager and artist. Artist in the Park Project, South Australia. 1993 - 1996.
 
 
 
Food Manufacturer. Light Foods Australia, Tofu manufacturer, Adelaide, South Australia. 
1981-1989. 
 
 
 
 
 
Nursing. Queens Medical Center, Honolulu Hawaii. 1979 - 1981.
 
 
 
 
Nursing. Shepherd Pratt Hospital, Towson Maryland. 1974 - 1978. 

Volunteer Work
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Schools Unite Network "SUN"  
http://www.plgnyc.org/sun.php 
New York City

Radio Station;  
Helped to establish community radio station in 
Victor Harbor, South Australia. Worked as 
secretary, prepared news, and established 
children's radio (CAR - Children's Radio Australia). 
Wrote content and bylaws, supervised a volunteer 
team, and established the first community radio 
station in the area. 

Mt. Compass Day Care Centre; 
Established day care centre for country South 
Australia.

February 2007 - current. Creating and maintaining School Safety Patrol Maps. See, Safety Routes 
for the Upper East Side

Community Work, Encounter FM, Victor Harbor, South Australia. 1990 - 1992. 

 

 

 

Day Care Centre. 1985 - 1988, Mt. Compass. 

Education
PhD, Communication and New Media, University of South Australia, 2005 (Thesis, 
‘Conversational Analysis of chatroom “talk”’). 

            Thesis online at http://neuage.org/All.htm   
  
Masters of Arts, Literature, Deakin University, Victoria, Australia, 1997  (Thesis, ‘Internet 
influence on Literature’).  
  
Bachelor of Arts with Honors, Literature, Deakin University, Victoria, Australia, 1995.  
  
Bachelor of Arts, Journalism, Literature, Deakin University, Victoria, Australia, 1994. 
  
Advanced Diploma of Arts, Professional Writing, TAFE, Adelaide, South Australia, 1991. 
  
Advanced TESOL Certification, Global TESOL College, Edmonton, Alberta, Canada, 2004. 
  
TESOL Specialization Certification, 'Teaching Computer English', Global TESOL College, 
Edmonton, Alberta, Canada. 2005. 
 
International Baccalaureate "Teacher Training Level 1 Certifcate" Alexandria, Virginia. 
Completed 08 October 2007.
Bachelor of Science, Computing Science (deferred to begin PhD), Flinders University, 
Adelaide South Australia http://www.flinders.edu.au/  1998. 
Bachelor of Nursing, Nursing (deferred after two years), Towson State University, Towson 
Maryland   1978 - 1980. 
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References
Upon request

Current Research Current research: http://neuage.info/current.htm  

Publications "Conversational Analysis of Chatroom talk" University of South Australia, 2005. 452 p. : ill. (some 
col.); 30 cm. + 1 CD-ROM (4 3/4 in.). National Library of Australia.

“Online research methodologies” (University of South Australia) to be published by Oxford Press, 
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ageAlbany New Yorik to Adelaide South Australia via Utrecht, Hambrug, Prague, Beijing, Singapore with Narda Biemond and Terrell Neu

dinsdag 20 juni 2006

current blog http://neuage.org/06trip.htm 

2005 BLOG

Return to Albany to Adelaide to Albany via Europe and China BLOG

And don’t forget our photos updated Sunday, August 21, 2005 10:45 PM – Lake Albert, South 
Australia (following trip to Sydney for Leigh’s memorial)

last year's trip - http://pg.photos.yahoo.com/ph/restlessdancerau/my_photos

In case our online blog is not up and added to here are our latest views/insights/words

•         vrijdag 17 juni http://neuage.org/05-1.htm Utrecht 

•         zaterdag 18 juni  http://neuage.org/05-2.htm Utrecht - photos added Freitag, 24. 
Juni 9:44:06 AM 

•         19-20 juni   http://neuage.org/05-3.htm PhD notice + Holland - Belgium 

•         dinsdag 21 juni Bruge, Belgium 

•         Donderdag 23 Juni ~ - Utrecht ~ vrijdag 24 juni ~ Hamburg photos added 
Freitag, 24. Juni 

•         pondělí, 27. června Prague photos 

•         年7月5日星期二 Beijing 
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ageAlbany New Yorik to Adelaide South Australia via Utrecht, Hambrug, Prague, Beijing, Singapore with Narda Biemond and Terrell Neu

•         二○○五年七月七日星期四 added photos our photo page Tianjin, China, in 
the Tianjin folder  

•         年7月14日星期四Sunday, 10 July Singapore updated photo album – see 
‘Sentosa_Island_Singapore’ and ‘Boat_Singapore’ folders and added to 
‘Narda=Statue’ folder  added to rambles see blog or 

•         Thursday, 14 July 2005 – Adelaide updated photo album – added to rambles 
see blog or 

•         Sunday, 17 July – - - Melbourne updated photo album see Melbourne file \ 
Tuesday, 19 July – http://neuage.org/05-Melbourne.htm - Melbourne -updated 
photo album see Melbourne file  Thursday, 21 July – updated photo album 
Adelaide - see South Australia file  Thursday, 18 August – http://neuage.org/5-12.
htm - Sydney – Blue Mountains – New South Wales updated photo album see 
Sydney 

•         August 21, 10:42 PM - http://neuage.org/5-13.htm - Lake Albert, South 
Australia -- updated photo album see Sydney 

ALBANY/SCHTDY to WASH/DULLES

Flight 
 
8072 *

Departs 
ALBANY/
SCHTDY 
TUE 14 JUN 
7:03P

Arrives 
WASH/
DULLES 
TUE 14 JUN 
8:45P

WASH/DULLES to FRANKFURT

FRANKFURT to AMSTERDAM
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Flight 
 
9163 *

Departs 
FRANKFURT 
WED 15 JUN 
12:45P 
Terminal 1

Arrives 
AMSTERDAM 
WED 15 JUN 
1:55P

MP Miles 
500

Meals Served 
SNACK

Equip 
737

Weteringschans 82
1017XR Amsterdam

June15 – 16th Sphinx hotel 
Amsterdam

Holland contacts/familyJune 16 – 23

Rienk’s house

030-2893793 
Zeeltstraat 91

3525 TD Ultrecht 

AMSTERDAM to HAMBURG

Flight 
LUFTHANSA 
4665 *

Departs 
AMSTERDAM 
THU 23 JUN 
4:00P

Constanze 
Heller 

Arrives 
HAMBURG 
THU 23 JUN 
5:15P 
Terminal 2

Rotherstrasse 
16

22765 
Hamburg

49-404135 
8619 

HAMBURG to DUSSELDORF
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Flight 
LUFTHANSA 
77 *

Departs 
HAMBURG 
MON 27 JUN 
11:55A 
Terminal 2

Arrives 
DUSSELDORF 
MON 27 JUN 
12:50P

DUSSELDORF to PRAGUE

Flight 
LUFTHANSA 
3284 *

Departs 
DUSSELDORF 
MON 27 JUN 
1:50P

Arrives 
PRAGUE 
MON 27 JUN 
3:05P

Zabehlicka 
35/133 
Prague 10600 
Czech Republic

Mon Jun-27 
Thu Jun-30

Na Zamecku 
Hotel

PRAGUE to VIENNA

Flight 
AUSTRIAN 
710 *

Departs 
PRAGUE 
THU 30 JUN 
6:20P

Arrives 
VIENNA 
THU 30 JUN 
7:20P

VIENNA to BEIJING

Flight 
AUSTRIAN 
63

Departs 
VIENNA 
THU 30 JUN 
8:10P

Arrives 
BEIJING 
FRI 1 JUL 
11:30A

 July 01 2005  
July 04 2005

Golden Sun 
Commercial 
Hotel, Beijing
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 July 04 2005  
July 07 2005

Qingdao 
Dongfang 
Hotel 
(Oriental 
Hotel), 
Qingdao

BEIJING to SINGAPORE

Flight 
SINGAPORE 
811

Departs 
BEIJING 
SAT 9 JUL 
8:45A

Arrives 
SINGAPORE 
SAT 9 JUL 
2:55P 
Terminal 2

392 Havelock Road 
Singapore 169663 
Singapore

July 09 2005  
July 12 2005

Grand 
Copthorne 
Waterfront 
Hotel 
Singapore

SINGAPORE to ADELAIDE

Flight 
SINGAPORE 
229

Departs 
SINGAPORE 
TUE 12 JUL 
11:00P 
Terminal 2

Arrives 
ADELAIDE 
WED 13 JUL 
7:00A 
Terminal I

United Depart

Sydney 
September 06 
Tuesday 1 PM

September 06 
Albany, New 
York midnight
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Columbus Day Parade New York City 2006

Columbus Day Parade New York City 2006

Not a very good parade, surely not up to New York City standards. Most of 
the parade was very disorganised with people wandering around as if they 

were in the parade. Some of the floats were OK but overall very budget.

Return to Narda and Terrell Brooklyn and beyond 2006 
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softly dreaming with Terrell Neuage

WEEKLY ROMANTIC POEM this week's picture poem Sunday, 19 April 

1998 11:22:18 AM revised September 19, 2006
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(c)Terrell Neuage 2006 Photo: Phan Thiet Viet Nam Terrell Neuage July 2006 
before tonight. 

 
 
 Begin World Wide Web poetry journey here

 
 
 
 
 
 
 
 
 
 

 
 

Ships at sea 

rain on roof 

approaching dawn mingled 

with sounds of life and nature 

so thoroughly entwined 

like you and I 
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softly dreaming with Terrell Neuage
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Guestbook ~ View Guestbook  Copyright Terrell Neuage 2-28-79 

 

Masters 

PHD

HYPERTEXTUAL  
LITERATURE

SouthernExpressway 

Novel

Children's 
Stories

Picture-Poems

Thesis Romantic 
Poems 
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WHEN YOUR BREATHING BECOMES IRREGUALR
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When your 
breathing  

becomes irregular 
Your eyes dilate 

Your legs tighten 
around me 

and lions roar  
in the noon day sun 
upon the savannah

I come  
alive.

© TERRELL NEUAGE SEPT 30 1996 
photo over the Pacific 2005  

PicturePoem revised 9-20-06

Picture poem for Sunday, 19 April 1998 11:22:18 AM

 next poem    
      

   

 
 
 
 
 

 
savannah
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WHEN YOUR BREATHING BECOMES IRREGUALR
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 e-mail

 

mailto:%20%20terrell.neuage@unisa.edu.au
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poetry gifts from restlessdancer Australia

home 

 

 

 

Poetry gifts are 
quality 
handmade 
products of 
Australia.

We send 
anywhere in the 
world within 24 
hours of ordering 
through our 
secure storefront.

Except June to 
September each 
year when orders 
are sent from 
Adelaide, South 
Australia

Prices are in 
United States 

PICTURE POEMS FOR Family ~ Friends ~ Lovers ~ Inspiration ~ Events 
~ POETRY ON PILLOWCASES

---- vv 

vvv---- 
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poetry gifts from restlessdancer Australia

dollar.

 

  

●     terrell@neuage.com - web design/poetry/ ~ terrell neuage 

●     restlessdancer mail

●     PO Box 25 Round Lake, New York 12151
●     - general business/ordering/ ~ narda biemond

PICTURE POEMS FOR Family ~ Friends ~ Lovers ~ Inspiration ~ Events
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Trip 06 Albany to Adelaide with Narda Biemond and Terrell Neuage

Trip 06 Albany to Adelaide 

Trip 2007 ~ Sydney, Adelaide, Las Vegas, NYC, San Pedro Guatemala, Warsaw, Hamburg, Edinburgh, Manchester, 
Bangkok, Chiang Mai, Siem Reap, Phnom Penh, Singapore, Adelaide, Melbourne, Sydney

VIDEOS FROM TRIP 2006 updated 24 October 2006

LAST NOTES FOR TRIP 06 

Brooklyn 24 October 2006 our new travel site 

also see my youtube.com (updated 24 October 2006) 

●     Last year’s travel-blog ~ http://neuage.org/05.htm blog from France Christmas 2005 
●     Photos from trips 2002 - 2005 (Melbourne, Seoul, Adelaide, Washington D.C., Ireland, Clilfton Park, Barcelona, 

Utrecht, Beijing, Hawaii, Hong Kong, Sydney, Hamburg, and etc.) 

●     June 18 - Notes from first days – Albany to New York City to Hamburg to Amsterdam to Utrecht 
●     Photos from first days 
●     June 19 – Notes from Utrecht 

June 22 – too busy to write – off to Turkey tomorrow – some photos from Hamburg 

 
The approach The barter The result (see June 24)
 

June 23 - First photos from Istanbul
June 24 - Notes from Istanbul

Photos from next couple of 
days 
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Trip 06 Albany to Adelaide with Narda Biemond and Terrell Neuage

June 26 – From Hotel Poem
June 27 – Australia and the World Cup
June 28 – St. Sophia and island hopping 

Photos from the Bosphorus 
 
Istanbul etc. photos 
including St. Sophia 
Museum

●     June 30-July 1 early notes on Viet Nam 
●     July 2 -3 Pandanus Resort and Mui Ne 
●     Photos of A day in Mui Ne (Quarter 5 - Phan Thiet, Binh Thuan) 
●     Photos of a day in Phan Thiet (July 5) 

Ho Chi Minh July 7 - 10 (notes we will write up in Australia - too much to do - too 
many sites and tours) 
Photos from Ho Chi Minh 
Videos of Narda's Saigon Bike Ride 

Photos from tour of Mekong Delta 09 July 
Photos from Australia 

●     Adelaide July 11 - Semaphore Beach photos July 23, 06, 
●     Glenelg, 
●     Narda's Sons gig 
●     (August 1 - 06) Melbourne / Graffitti - St. Kilda / Sorento (Victoria Coast) / Flight Melbourne to 

Adelaide video see video page 
●     Victor Harbor (Sacha, Leigh and Terrell's home 1986 - 1995) 
●     Sydney August 16 
●     New York City 
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Leigh Neuage

Leigh Neuage 

Children Never grow old
they just sprout wings

and fly away 
 

July 06, 1983 (Adelaide, South Australia) - August 16, 2003 (Sydney, New South Wales)  

 
memorial 04 / 05 / 06/ 07 [5.30 AM ~ 16th July, at The Novotel Hotel Corner Olympic Boulevard 

and Herb Elliott Avenue Olympic Park Homebush Bay Sydney

 
I will always love you 
whatever you are doing

on whatever plane you are
this world was only ever just a stop along the way

I am with you always
Your Father

(SITEMAP) INDEX OF ALL URL 

Australian National Baseball Teams 

1.  August 1997 age 14  U-15 Australian National Team – Brisbane, Old, Australia 
2.  July 1998 age 15  - U 16 National Team July 11-19 World Championships Fairfield Heights, Illinois, USA 

– (Australia fourth in World Championship of 16 countries)
3.  July 1999 age 16  Australian National Team, Johannesburg, South Africa 
4.  July 1999 age 16  Australian Schoolboys National Team Lismore, NSW, Australia
5.  July 2000 age 17  Australian Schoolboys National Team, Florida, USA
6.  July 2000 age 17  Australian National Team, U-18, Canada 
7.  December 2000 age 17  International Baseball League Championship Gold Coast, Queensland, Australia 
8.  

November 7, 2001 World Cup Taiwan

South Australian State Teams 
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Leigh Neuage

1.  State 1/1997 age 13  South Australian U/14 State Squad.  -  Glenelg, South Australia
2.  State 1/1998 age 14  South Australian U-16s State Squad – Canberra, ACT 
3.  State 3/1998 age 14  South Australian School Boy Team – Brisbane, Queensland
4.  State 1/1999 age 15  South Australian U-16s State Squad  - Alice Springs, NT
5.  State 5/1999 age 15  South Australia schoolboy team - Perth, WA 
6.  State 1/2000 age 16   South Australian U-18s State Squad  - Perth, WA
7.  State 5/2000 age 16  South Australia schoolboy team Brisbane - Queensland
8.  State 1/2001 age 17   South Australian U-18s State Squad  - Sydney, NSW

Awards

●     Program athlete of the year 2000 South Australia Sports Institute (SASI) 
●     SASI Baseball Scholarship 1997 - 2002 
●     SASI HALL OF FAME: AAA U19, Australian Schoolboys Team
●     South Australia Sports Star of the Year at the Channel 7 Sports Star of the Year Awards. 

February 2001 age 17 signed with LA Dodgers  

LA Dodgers future is Leigh Neuage

video clip SASI (South Australia Sports Institute) interview November 2001 

●     South Australia Club - Southern Districts Baseball Club (1991-2003)
●     Last American Club; South Georgia Waves

 

Leigh Neuage Photos
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Leigh Neuage

Sign Leigh's Guestbook Read Leigh's Guestbook 

Leigh and Sacha Radio show (Leigh on left); Leigh's first homepage (age 15 - 1998); First World Series (1998 U14 USA 
- scores from the game); Under 18; Australian Nationals; U-18 National Schoolboys championship Under 18 
Canadian guestbook from July 2000, Players from Australian U-18/scores, 

I will be in Sydney to celebrate Leigh’s life on August 16th, 2006, in front of the Novotel Hotel, Sydney Olympic 
Park, Homebush Bay. Last August 16, 2005 (and 2004) was a very cold and windy day in Sydney and as I left that evening 
to return to the States I realised I would be back at this spot on this day every year. For his friends who wish to share 
a thought with Leigh it was approximately five AM on August 16 th when he made his decision to leave – falling from 
the fifteenth floor balcony of his room at the Novotel that faced Olympic Stadium where he had played for Australia. 

 
Leigh Australian Idol

http://neuage.org/leigh.htm (3 of 6) [3/9/08 11:30:33 AM]

http://www.theguestbook.com/egbook/593867.gbook
http://www.theguestbook.com/vgbook/593867.gbook
http://www.neuage.org/neuage_radio.pdf
http://www.neuage.org/leigh_neuage.htm
http://www.angelfire.com/hi/U16/WorldSeries.html
http://www.angelfire.com/hi/U16/australia.html
http://www.geocities.com/leighneuage21/u-18.htm
http://www.geocities.com/leighneuage21/u18schoolboys.htm
http://www.theguestbook.com/read.php/221632
http://www.theguestbook.com/read.php/221632
http://neuage.www.50megs.com/players.html
http://neuage.www.50megs.com/scores.htm
http://www.neuage.org/leigh_end.htm
http://www.neuage.org/leigh.htm
http://neuage.org/australian_idol.htm


Leigh Neuage

 

(July 6 1983 - August 16 2003) 
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Leigh Neuage

  

Rest In Peace that you could not find on this planet. We started on the Internet together in 1995 and on computers in 1991 and 
I am still on the Internet and you chose to move on. Thank you for so many years connected with me on the Internet and 
in Real Life. You are now so more fully connected to a new life that I can not grasp so far beyond the pains and sorrows of 
this life.
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Kenneth Adsit's 100 hundred birthday

Kenneth Adsit died 23 January 2007 at 6 am. age 101 and nine months  
He left peacefully.  

Services will be at the Clifton Park United Methodist Church  
10 Old Plank Road Clifton Park  

Saturday 27 January at 10.45 am. to 11.45  
viewing will be from 10 to 10.45 at the church 

burial will be at the Clifton Park cemetery on Cemetery Road at noon (google map) 
donations should go to the church rather than flowers 

Kenneth Adsit at 100 years old

* Kenneth Adsit Christmas 2006 (21 December age 101 + 8 months)  
101st Birthday (4 - 22 - 2006) 

latest news and open for anyone to add to Kenneth Adsit Wiki 
new clips  

Ken 101 plus - The interviews (talks about early days of Clifton Park and Halfmoon - 1915 - 
1930s) 

* Part One 
* Part Two 

* Visit with Narda's sister from Australia and stories (November 2005 - age 100 and a half) 

See also Kenneth Adsit's one-hundredth birthday at the home of his son, Terrell Neuage and daughter in-
law, Narda Biemond, in Round Lake, New York and at the Manor Care Nursing Home in Ballston Spa. 

See also Kenneth Adsit seeing a story about his 100th birthday in the newspaper; 
See also Kenneth Adsit's 100th birthday celebration at Manor Care Nursing Home, Ballston Spa, New 

York; 

See also, this clip was after a stay in hospital for a cold at age 101 when he got himself into a bit of a 
frail state but he has returned to good health as show in later clips such as show at the bottom of this 

page.
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Kenneth Adsit's 100 hundred birthday

 
1935 age 30 with new 1934 Ford at home in Halfmoon/Clifton Park (98th birthday party, with 

Leigh, 1950 photo, in Australia with kangaroo - 1992) MORE FAMILY PHOTOS 
 A photo of the Adsit farm (1922 - 1964) covering this area is here (Robert and I are on the roof) 

and here - Route Nine is in the front. 
 

Thanks to all who came to Kenneth Adsit's 100th birthday from across the States. Many of us 
saw one another for the first time in many decades - I know I saw several who I had not seen 
since the mid-1960s. I have put several video clips up but they only seem to work in Real Player 
(a free download). This clip (13 minutes long) starts with Narda Biemond's Albany Academy 
chorus singing happy birthday when they visited his nursing home on the 19th of April and 
continues with the houseparty in Round Lake - I realise the clip, as well as the others, needs 
editing and I will do that soon - it takes five to seven hours to get a clip this short to look good; 
this is a 2.40 second clip of a song by the chorus - I will adjust the tracking soon; this is the 
introduction of family members at the nursing home (5 minutes and 48 seconds) on Sunday 24th 
April; a clip from Sunday 1.23 long; and a visit with Kenneth Adsit at the nursing home at the 
beginning of April with Narda's father from Australia and uncle from Holland - there is a good 
description of Kenneth's grandfather, Asa, when he was left to die on the battlefield of Gettysburg 
during the Civil War and how my father could see light through the hole in Asa's body back in 
about 1910 before Asa died - a remarkable story that he has told many times but finally I got him 
to say it on video.. 
Photos of Kenneth Adsit and from his party (video clips to follow in a few days) and Fred 
Miller's photos. Channel Nine's review and video clip; a 
Documents signed by Congressmen Sweeney, Assemblyman James Tedisco, Governor Pataki, 
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Kenneth Adsit's 100 hundred birthday

Town of Halfmoon Supervisor, Kenneth DeCerce and Assembly No. 576 Legislative Resolution 
exist in this corner of cyberspace. 

Kenneth Adsit was born in Halfmoon, New York and graduated from Waterford High School in 1923. 
He was married in 1943 in Round Lake, New York. For most of his life he lived on a farm in Clifton 
Park and in Halfmoom (the border went through the pumpkin patch). The farm was situated along route 
nine and what is now 146. The Northway (Route 87) goes through what was the wooded area of the 
property. The current Hess gas station is where the corn fields were and Cracker Barrel is where the 
melons grew and where the large box stores; Home Depot, Kinens and Things, and Michaels, as well as 
"Halfmoon Crossings" shopping centre are all on the property that was once the farm. I still have a box 
of arrow heads that Ken Adsit collected from his fields as he ploughed them. He travelled a lot and when 
he was 87 he toured Australia for a month. Our actual house was where the a'Park 200 Apartments' now 
are. 

A photo of the Adsit farm (1922 - 1964) covering this area is here and here - Route Nine is in the 
front. View the photo albums for old pictures as well as documents such as this 1928 purchase of 
Kenneth Adsit's car; his 1943 marriage day in Round Lake; the marriage certificate and many 
other items covering the past 100 years. 
 
The original 1770s Adsit Cabin in The Town of Willsboro is now a historical site. 
 
Kenneth Adsit is survived by his son, Terrell, and grandson, Sacha who lives in Melbourne, 
Victoria, Australia. Kenneth's first son, Robert, died in 1993, his wife died in 1992 and grandson, 
Leigh Neuage died August 16th, 2003. 
 
I am collecting old photos of Kenneth Adsit to display on his birthday and to put on a webpage if 

you have and would like to share - thanks.
I will share these with Kenneth Adsit each time anyone signs his guestbook 

 
View My Guestbook 
Sign My Guestbook

 
21 December 2006 
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Kenneth Adsit's 100 hundred birthday
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Robert Adsit (Robert James Adsit) Shenendehowa Central School, Clifton Park, New York

Robert Adsit (Robert James 
Adsit) 
Home Shenendehowa Central School, Clifton Park, New York
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Robert Adsit (Robert James Adsit) Shenendehowa Central School, Clifton Park, New York
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new-video upload place zipdee, Multiply, myboomerplace, eons /Google analyis + http://www.sitescanga.com/ 

Intel k-12 learning    Google Chart API / GOOGLE EDUCATION (NY Times Learnin Centre) Mediating 
Media (PBS) http://www.processing.org/ Webpage removal request tool    http://www.mogulus.com/neuage 
(neu-zak)  mobile-phone web  3d search  web2 directory  rTravel-video   flypaper  lunapic-online photo editor  
- WIRED-how-to-wiki - 

year 8 media ideas NYPC Meetings and Events 
WRITE MYP PLAN 
MARCH 
MONDAY 10th - DAY 3 
survey  
Period 0 - 8.00 - 8.45 Tech 8b  
survey  
Period 3 10.50 - 11.35 Tech10  
Period 4 new teachers meeting 
Period 5 - 12.30 - 1.15 6-8 team 
survey  
Period 6 - 1.20 - 2.05 (2 left) 7a 
Period 7 - 2.10 - 2.55 (2 left) 7B 
TUESDAY 11th MARCH- DAY 4 
ALL DAY FINISH MYP 
monitor IB testing 
PD 1 (Eng) sub 
Period 2 - 10.45 - 10.20 
Period 4 12.05 - 12.40 Grades 9 and 10 team 
Period 5 - 12.45 - 1.20 lunch 
gym 
Wed. 12th Day five  
late picking up Sacha 
Period 1 9.10 - 9.55 - 8b 
Period 3 10.50 - 11.35 - CT 10 
Period 5 12.30 1.15 - 6 webpages 

2008 excel spreadsheeet of classes

Virtual Classroom Adobe videos

fc neuage/dwight All Stud 
Rhino community

CS3 help otheratomiclearning  
dwight-school 
 
my voicemail = 354 
MYP= 5164 26150 firstlastinitial 

March 
08 08
 

 
 
 
 
 
 
 
 
 
SUBMIT-
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https://my.dwight.edu/podium/
http://neuage.org/t1social.html
http://mail.google.com/mail/
http://www.optimum.com/
http://www.timeanddate.com/worldclock/
http://www.oanda.com/convert/classic
http://www.countrycodes.com/
http://www.google.com/search?q=neuage
http://www.searchmash.com/
http://www.schmedley.com/search/
http://search.lycos.com/default.asp?lpv=1&loc=searchhp&query=neuage
http://www.altavista.com/cgi-bin/query?pg=q&kl=XX&q=neuage
http://search.yahoo.com/search?p=neuage
http://start.csail.mit.edu/
http://www.hakia.com/
http://msxml.us.info.com/_1_LUS603FT2WHT__infocom.us/dog/results?otmpl=dog/webresults.htm&qkw=neuage&qcat=web&method=0&top=1&start=&engineset=&ver=7597
http://www.comedycentral.com/tv_schedule/index.jhtml
http://www.fox.com/schedule/
http://www.nbc.com/Schedule/
http://ifc.bside.com/schedule/
http://www.xml-sitemaps.com/
http://ournews.mobi/08/
http://www.zipidee.com/profile.aspx?userid=33a80a55-10a4-45cb-bad3-1b03f05e18a9
http://neuage.multiply.com/
http://www.myboomerplace.com/profile.php?id=4570
http://www.eons.com/members/profile/neuage
https://www.google.com/analytics/home/provision?vid=1001&scid=3578597
http://www.sitescanga.com/
http://www.intel.com/education/tools/index.htm?iid=ed_nav+k12tools
http://code.google.com/
http://www.google.com/educators/tools.html
http://www.nytimes.com/learning/teachers/index.html
http://www.pbs.org/art21/education/technology/lesson2.html
http://www.pbs.org/art21/education/technology/lesson2.html
http://www.processing.org/
https://www.google.com/webmasters/tools/removals?urlremoval=1
http://www.mogulus.com/neuage
http://www.wirenode.com/apps/showAll.do
http://www.redzee.com/
http://www.go2web20.net/
http://www.rtravel.com/Majorpage/index.aspx
http://flypaper.net/default.aspx
http://www.lunapic.com/editor/
http://howto.wired.com/wiki/Main_Page
http://fc.dwight.edu/Login/__WWW/studentweb/8th/media_ideas.html
http://www.calsplus.com/nypcmeetings
http://fc.dwight.edu/Login/__WWW/studentweb/8th/8b/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/10th/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/7th/7a/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/7th/7b/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/8th/8b/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/10design/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/6th/6a/notes3.html
http://neuage.org/dwight/2008classes.htm
http://www.op97.org/lab/index2.html
http://www.adobe.com/designcenter/video_workshop/
http://fc.dwight.edu/studentweb
http://neuage.org/dwight
http://fc.dwight.edu/Login/__WWW/studentweb/students.html
http://community.irhino3d.com/forums/8.aspx
http://www.uwec.edu/help/index.htm
http://www.macupdate.com/education.php?sub=6&order=license
http://movies.atomiclearning.com/
http://occ.ibo.org/
http://www.google.com/addurl/?continue=/addurl
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Period 6 1.20 - 2.20 - 7a 
Period 7 2.10 - 2.55 - 7b 

THURSDAY MARCH 13TH DAY 6 PERSONAL DAY 
Period 0 8 0 8.45 8a 
Period 2 10 - 10.45 CT 9 
Peeriod 3 10.50 - 11.35 Tech10 
Period 5 12.30 - 1.15 lunch

Friday 14th - DAY 1 
Period 1 - 9.10 - 9.55 8a 
Period 3 - 10.50 - 11.35 CT 10 
Period 5 - 12.30 - 1.15 study hall 302 
Period 7 - 2.10 - 2.55 study hall Quad 
 
C train to 125th M60 bus 
5:05 PM 14 Mar 2008 
New York, NY (Laguardia) 10:10 PM 14 Mar  
Chattanooga, TN  
1627 / 2507PSA Airlines 
Stops: CLT  
5 h 5 m 

 

 
Monday 30th? after Holland- DAY 2 
Period 2 - 10.00 - 10.40 CT 9 
Period 3 - 10.45 - 11.25 Tech 6 Benzitine Empire 
Period 5 - 12.30 - 1.15 study hall 302

Fri 4/11/08 Classroom Management For New 
Teachers - Winter/Spring Series 
9:30 AM to 3:00 AM 619 West 114st 
, , 
 

AAG 
nFzW3pms-u38142835 
rubicon luke's 
wiki dwightschool (zak) 
moodle 

sketchup / Fotowoosh's popup / The 
Global Schoolhouse / comic life [video 
sites maybe for school - fireant - 
Subscribe to Internet TV channels and 
Podcasts/ 

download SHADOWS POPFLY-login 
popfly

Central and Eastern European Schools 
Association

Tech Tools 4 Teachers

Global SchoolNet Web dwight email 
plus zak

●     trimester 1 ends Nov. 21
●     trimester 2 begins Nov 26 

ends Feb. 15
●     trimester 3 begins Feb. 20 

ends June 10

 

GOOGLE 
~ 
SUBMIT 
EXPRESS 
- 
video 
player 
Free 
and 
open-source

0 
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http://fc.dwight.edu/Login/__WWW/studentweb/7th/7a/notes2.html
http://fc.dwight.edu/Login/__WWW/studentweb/7th/7b/notes2.html
http://fc.dwight.edu/Login/__WWW/studentweb/8th/8a/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/9design/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/10th/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/8th/8a/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/10design/notes2.htm
http://fc.dwight.edu/Login/__WWW/studentweb/9design/notes3.html
http://fc.dwight.edu/Login/__WWW/studentweb/6th/6a/notes3.html
http://neuage.org/AA/academic.htm
http://dwight.rubiconatlas.org/
http://stlukeschool.rubiconatlas.org/
https://dwight.wikispaces.com/
http://inside.dwight.edu/moodle/
http://scratch.mit.edu/
http://fotowoosh.com/
http://www.gsn.org/about/index.html
http://www.gsn.org/about/index.html
http://plasq.com/
http://getfireant.com/
http://www.shadows.com/
http://www.popfly.ms/?code=20BB5CFE272C9CCB74C4FEF061F41DE6FCDD711194751AA8E90C67373EE6D021196BE095A97E31D9A64DEEEA021B35FA
http://www.popfly.ms/Home.aspx
http://www.popfly.ms/users/Neuage
http://www.ceesa.org/
http://www.ceesa.org/
http://techtools4teachers.mypodcast.com/
http://www.globalschoolnet.org/
http://www.google.com/addurl/?continue=/addurl
http://www.submitexpress.com/
http://www.submitexpress.com/
http://www.getmiro.com/
http://www.getmiro.com/
http://www.getmiro.com/
http://www.getmiro.com/
http://www.getmiro.com/
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`````````````````` 
- 
- DRUDGE - SIGHTINGINGS -  IRAQ-NEWS  - http://www.neuage.org/leighcounter.
htm  name finding sites + http://www.pipl.com/ - http://www.spock.com - http://www.
zabasearch.com/

 
 
 
 
 

Baby Art ~ Vegi Fighters 
 

Domain neuage.org (sitemap) 
Domain neuage.info

●     Sub leigh.neuage.info > /info/leigh (sitemap) 

Domain neuage.mobi > /neuage.mobi (sitemap) 
Domain our-newsletter.info > /news (sitemap)

Sub sample.our-newsletter.info > news/sample  
Domain our-news.mobi > /our-news (sitemap) 
IN OURNEWS FOLDER 
Domain ournews.mobi > /ournews (sitemap)

●     sample.ournews.mobi > /ournews/sample 
●     sample1.ournews.mobi > /ournews/sample1 
●     example.ournews.mobi > /ournews/example 
●     example1.ournews.mobi > /ournews/example1 
●     0.ournews.mobi > /ournews/0 (sitemap) 
●     pricing.ournews.mobi > /ournews/pricing 
●     costs.ournews.mobi > /ournews/costs (sitemap) 
●     charges.ournews.mobi > /ournews/charges 
●     more.ournews.mobi> /ournews/more dynamic site creator in 1&1 
●     nards.ournews.mobi / ournews/nards dynamic site creator in 1&1 
●     HOOM.ournews.mobi / ournews/HOOM
●     HolyOrderOfMANS / ournews/HolyOrderOfMANS
●     cambodia.ournews.mobi / ournews/cambodia
●     thailand.ournews.mobi / ournews/thailand
●     adelaide.ournews.mobi / ournews/adelaide
●     melbourne.ournews.mobi / ournews/melbourne
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http://www.drudgereport.com/
http://www.sightings.com/
http://www.albawaba.com/
http://www.neuage.org/leighcounter.htm
http://www.neuage.org/leighcounter.htm
http://www.pipl.com/
http://www.spock.com/
http://www.zabasearch.com/
http://www.zabasearch.com/
http://neuage.info/BabyArt.html
http://neuage.info/vegi2.htm
http://neuage.org/
http://neuage.info/
http://neuage.mobi/
http://our-newsletter.info/
http://sample.our-newsletter.info/
http://our-news.mobi/
http://ournews.mobi/
http://sample.ournews.mobi/
http://sample1.ournews.mobi/
http://example.ournews.mobi/
http://example1.ournews.mobi/
http://0.ournews.mobi/
http://pricing.ournews.mobi/
http://costs.ournews.mobi/
http://charges.ournews.mobi/
http://more.ournews.mobi/
http://nards.ournews.mobi/
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●     sydney.ournews.mobi / ournews/sydney
●     07.ournews.mobi / ournews/07
●     Mexico.ournews.mobi 

Domain hvuc.mobi > /ournews/HV (sitemap) 
 
Sub blog.neuage.info 
Sub blog.ournews.mobi 
Sub narda.neuage.info 
Sub picture-poems.neuage.info > /pp 
 
 
SENIOR HOME EXCHANGE 
 

Wireless Name (SSID) = jetty---- 
Security Mode = WPA-Personal 
Encryption Method = TKIP 
Encryption Key = NLX5JvStPea1UKYCa67V1f

 
(communicating on the Internet COM465/and GC; IC SPEECH Computer course AA - wiki/wiki -AA 
 
 video sharing compared 

- 1and1 - yahoo terrellneuage - (leigh lskdodger@msn.com) hotmail (MSN-messenger 
- restlessdancer@hotmail.com/id) - ICQ = 91-598-824 Skype (neuage) - (tneuage@gamil.com) - 
- PodCASTs ~ (Pickle) (Melodeo) - australian-idol image - web-video-folders http://www.our-newsletter.
info/  1-1 mail -   

1.  Revver Dec. 28 
2.  Eyespot Dec. 28 - DOES MULTPLE CLIPS AT A TIME (7) -  Thursday http://upload.eyespot.com/upload 
3.  Vimeo Dec. 28 http://vimeo.com/ Appeal: Flickr for video. Sharing: Post to Flickr, send to del.icio.

us, download original file, embed in your MySpace profile or blog, create an RSS feed. 
Verdict:  Good video quality. Embedding the video in Wordpress worked flawlessly.  But: Light 
on community features, and weekly storage cap of 20 megs is too limiting. 

4.  Asian video sharring Dec. 28  http://www.mazooki.com 
5.  Blip TV http://blip.tv/ Dec. 28  same as â€œGrouperâ€• requires an application download.  E-

mail registration system was a pain; had to do it twice to get confirmed.  After several hours, my file was 
still unavailable, as the service was still "upload processing." 
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http://hvuc.mobi/
http://blog.neuage.info/
http://blog.ournews.mobi/
http://narda.neuage.info/
http://picture-poems.neuage.info/
http://www.seniorshomeexchange.com/
http://neuage.org/acom465/syllabus.htm
http://neuage.org/acom465/syllabus.htm
http://neuage.org/GC/gc.htm
http://neuage.org/ic/ic.htm
http://neuage.info/PS/ACOM203-1.htm
http://neuage.org/AA/index.htm
http://academy.wikispaces.com/
http://academy.wikispaces.com/
http://www.albany-academy.org/
http://www.1and1.com/
http://www.yahoo.com/
http://www.hotmail.com/
http://www.skype.com/
http://www.podcastpickle.com/users/neuage/profile
http://www.melodeo.com/neuage
http://neuage.info/australian_idol.gif
http://neuage.info/video-folders.htm
http://www.our-newsletter.info/
http://www.our-newsletter.info/
http://neuage.org/xml/config
http://www.dvguru.com/2006/04/07/ten-video-sharing-services-compared/
http://revver.com/
http://upload.eyespot.com/upload
http://upload.eyespot.com/upload
http://upload.eyespot.com/upload
http://upload.eyespot.com/upload
http://del.icio.us/
http://www.mazooki.com/
http://www.mazooki.com/
http://www.mazooki.com/
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6.  Jumpcut http://www.jumpcut.com/  Interface:  Slick interface feels more like an application than a 
web page.  Scales all videos to a larger size than other sites, but videos don't autoplay and there is 
no indication of what portion of the video has already been downloaded.  
Editing:  Bar-none the best editing options of the bunch.  Splice your footage, reorder the shots, add 
music, photos, transitions, even effects--think iMovie in an online interface.  Very, very slick. No 
current competitor can touch it.  But:  Get too effects crazy and your video slows down.  

7.  Ourmedia Interface: Slow, confusing, and messy.  Requires an Internet Archive account, and the 
integration of the two services is convoluted. Current "alpha" version falls far short of potential--wait for 
the next version. 

8.  Videoegg http://www.videoegg.com/  Appeal: Lets you painlessly upload video of any format to the web 
and post it to other sites or share it with friends. 
Interface: Requires you download an application in order to upload.  The download seamlessly embeds 
in your browser to give you drag-and-drop functionality.  

9.  vSocial http://vsocial.com/  Appeal: "The fastest, easiest way to upload, watch and share your favorite 
video clips." 
Interface: All Web 2.0'd-out.  Big fonts, AJAX, tagging, rating, reviewing, RSS feeds, creative 
commons licenses. Verdict: Lots of community features.  But: Didn't live up to their "fastest" or 
"easiest" claim--I never successfully got a video uploaded (tried three times).  Quality of existing clips is 
less than stellar--everything's resized to 320X240.  Your mileage may vary, but even with a Quicktime 
file that uploaded to other sites without a problem, I never got vSocial to work. 

10.  Indian stuff http://www.webyantra.net/tag/video/  GeoBeats is an interactive media website for 
informing travelers about international destinations through the use of video. Infeedia - This site has 
been launched by a bunch of friends living in US, India and UK. It is positioned as a South Asian 
video aggregator. 

11.  ApnaTube- As the name suggests, this is a YouTube clone to the hilt. The site allows hosting of videos, 
so that's a definite advantage over Infeedia 

12.  esnips
13.  bittorrent

 videos uploaded (each of lots of sites) 

1.  acrobatics- Beijing
2.  phd grad http://ournews.mobi/PhD.htm 
3.  bdelta2 http://ournews.mobi/Delta2.htm 
4.  GW http://ournews.mobi/GW.htm

http://www.vtc.com/ albanyny - academy25 timeline of dotmobi (mobile) all videos on servers 
u2:st="on">Albany 
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http://grouper.com/
http://grouper.com/
http://grouper.com/
http://grouper.com/
http://grouper.com/
http://grouper.com/
http://www.jumpcut.com/
http://www.jumpcut.com/
http://www.jumpcut.com/
http://ourmedia.org/
http://ourmedia.org/
http://ourmedia.org/
http://ourmedia.org/
http://www.videoegg.com/
http://www.videoegg.com/
http://www.videoegg.com/
http://www.videoegg.com/
http://www.videoegg.com/
http://www.videoegg.com/
http://www.videoegg.com/
http://vsocial.com/
http://vsocial.com/
http://vsocial.com/
http://vsocial.com/
http://infeedia.com/
http://infeedia.com/
http://www.apnatube.com/
http://www.esnips.com/
http://www.bittorrent.com/users/neuage/
http://www.bittorrent.com/users/neuage/
http://www.bittorrent.com/users/neuage/
http://ournews.mobi/PhD.htm
http://ournews.mobi/Delta2.htm
http://ournews.mobi/Delta2.htm
http://www.neuage.org/TimelineOurnews.htm
http://neuage.org/TimelineMobile.htm
http://neuage.org/video-servers.htm
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1400 Washington Avenue 
Albany, NY12222

JOBS: 
RPI-communication; UNION; HudsonCCC; SchenectadyCC; SAGE; Siena; Skidmore; TimesUnion
 
(communicating on the Internet COM465/andGC; ICSPEECHComputer course AA- wiki/wiki -AA
 
 video sharing compared

1.  Revver Dec. 28
2.  Eyespot Dec. 28 - DOES MULTPLE CLIPS AT A TIME (7) -  Thursday http://upload.eyespot.com/upload 
3.  Vimeo Dec. 28 http://vimeo.com/ Appeal: Flickr for video. Sharing: Post to Flickr, send to del.icio.

us, download original file, embed in your MySpace profile or blog, create an RSS feed. 
Verdict: Good video quality. Embedding the video in Wordpress worked flawlessly. But: Light on 
community features, and weekly storage cap of 20 megs is too limiting. 

4.  Asian video sharring Dec. 28 http://www.mazooki.com
5.  Blip TV http://blip.tv/Dec. 28 same as “Grouper” requires an application download. E-mail 

registration system was a pain; had to do it twice to get confirmed. After several hours, my file was 
still unavailable, as the service was still "upload processing."

6.  Jumpcut http://www.jumpcut.com/ Interface: Slick interface feels more like an application than a 
web page. Scales all videos to a larger size than other sites, but videos don't autoplay and there is 
no indication of what portion of the video has already been downloaded.  
Editing: Bar-none the best editing options of the bunch. Splice your footage, reorder the shots, add 
music, photos, transitions, even effects--think iMovie in an online interface. Very, very slick. No 
current competitor can touch it. But: Get too effects crazy and your video slows down. 

7.  Ourmedia Interface: Slow, confusing, and messy. Requires an Internet Archive account, and the 
integration of the two services is convoluted. Current "alpha"version falls far short of potential--wait for 
the next version. 

8.  Videoegg http://www.videoegg.com/ Appeal: Lets you painlessly upload video of any format to the web 
and post it to other sites or share it with friends. 
Interface: Requires you download an application in order to upload. The download seamlessly embeds 
in your browser to give you drag-and-drop functionality. 

9.  vSocial http://vsocial.com/ Appeal: "The fastest, easiest way to upload, watch and share your favorite 
video clips." 
Interface: All Web 2.0'd-out. Big fonts, AJAX, tagging, rating, reviewing, RSS feeds, creative 
commons licenses. Verdict: Lots of community features. But: Didn't live up to their 
"fastest"or "easiest"claim--I never successfully got a video uploaded (tried three times). Quality of 
existing clips is less than stellar--everything's resized to 320X240. Your mileage may vary, but even with 
a Quicktime file that uploaded to other sites without a problem, I never got vSocial to work. 
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http://www.llc.rpi.edu/
http://www.union.edu/PUBLIC/HRDEPT/Employment/
http://www.hvcc.edu/admin/hr/employ.html
http://www.sunysccc.edu/student/JPS/Faculty.htm
http://www.sage.edu/TSC/hr/Welcome.html
http://www.siena.edu/humanres/
http://apollo.skidmore.edu/ora/hr.hr_jobs.disp_jobs
http://www.timesunion.com/classifieds/jobs.asp
http://neuage.org/acom465/syllabus.htm
http://neuage.org/acom465/syllabus.htm
http://neuage.org/GC/gc.htm
http://neuage.org/ic/ic.htm
http://neuage.info/PS/ACOM203-1.htm
http://neuage.org/AA/index.htm
http://academy.wikispaces.com/
http://www.albany-academy.org/
http://www.dvguru.com/2006/04/07/ten-video-sharing-services-compared/
http://revver.com/
http://eyespot.com/
http://upload.eyespot.com/upload
http://vimeo.com/
http://vimeo.com/
http://del.icio.us/
http://del.icio.us/
http://www.mazooki.com/
http://grouper.com/
http://blip.tv/
http://jumpcut.com/
http://www.jumpcut.com/
http://ourmedia.org/
http://videoegg.com/
http://www.videoegg.com/
http://vsocial.com/
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10.  Indian stuff http://www.webyantra.net/tag/video/ GeoBeatsis an interactive media website for 
informing travelers about international destinations through the use of video. Infeedia- This site has 
been launched by a bunch of friends living in US, India and UK. It is positioned as a South Asian 
video aggregator. 

11.  ApnaTube- As the name suggests, this is a YouTube clone to the hilt. The site allows hosting of videos, 
so that's a definite advantage over Infeedia 

12.  esnips
13.  bittorrent

 videos uploaded (each of lots of sites) 
1.  acrobatics- Beijing
2.  phd grad http://ournews.mobi/PhD.htm
3.  bdelta2 http://ournews.mobi/Delta2.htm
4.  GW http://ournews.mobi/GW.htm

 
Google Analytics 
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http://www.webyantra.net/tag/video/
http://geobeats.com/
http://infeedia.com/
http://www.apnatube.com/
http://www.esnips.com/
http://www.bittorrent.com/users/neuage/
http://ournews.mobi/PhD.htm
http://ournews.mobi/Delta2.htm


webpage creation mission statement

Our goal with webpages. A website mission statement (evolving).

Everyone will develop a website which will always be a product in progress.

Your MYP will be demonstrated in your ever-evolving homepage. Your page will 
change both as technology changes over the next few years as well as you develop 
new skills to incorporate within your virtual world. Your homepage will link to all that 
you do online at Dwight. From book reports to video clips and mashups, game 
developments to virtual worlds, blogs, programming, cartooning, creating online 
poetry and childrenʼs stories as well as your resume and collaborations within our 
classes  to collaborations overseas. Your homepage will be your portfolio of not only 
what you have learned but how you present yourself online. This will be both 
technical as will as creative. No two sites will be similar.

This will all reside on the Dwight server and only you, using your password and logon 
information will be able to access your site. By year ten, if you wish, you will be able 
to transport your site and save it to present as your portfolio. 
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Macromedia Dreamweaver CS 3 index to learning return to computer technology

●     creating a site folder
●     menu bar 
●     Where are your files - in your site folder of course - check here for help if they 

have gone for a walk-about
●     ASCII Character Chart with Binary and Hexadecimal Equivalents  
●     EMOTICONS 

http://neuage.org/dwight/dreamweaver/index.html [3/9/08 11:31:22 AM]
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back to index
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Design folder As students progress through the different stages...n with the studentʼs investigation and end with the evaluation.

The Design Folder
Design folder

As students progress through the different stages of the design cycle, they are 
constantly experimenting with ideas, researching topics, compiling sources, 
brainstorming issues, sketching possible solutions, making changes, rejecting 
proposals and critically evaluating their work. All relevant activities and 
outcomes should be recorded, and dated, in the design folder. 

The design folder is a compilation of evidence that accompanies the final 
product/solution for a unit of work. Students formally record the results of their 
research, their various plans and designs and the evaluation of their finished 
products/solutions in the design folder. 

The design folder must be clearly divided into its constituent parts according to 
the stages of the design cycle: investigate, design, plan, create, evaluate. The 
design folder must begin with the studentʼs investigation and end with the 
evaluation.

http://neuage.org/dwight/DesignFolder/index.html [3/9/08 11:31:39 AM]
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All Projects will implement the Design Cycle when it applies.   Areas of Interaction: in all grades
Aims
Computer Technology is designed to create a balance between the imparting of skills, the 
acquisition of techniques and knowledge, and the growth and awareness of the students' personal 
responses. This is a practical hands-on course which is taught in the computer lab. Students work 
one to a machine. There will be some homework such as reflections on topic areas we will cover. 

The curriculum
During the MYP course, students will become proficient in the use of: Word processing 
programs, Database programs, Spreadsheet programs, Presentations programs, Publishing 
programs, Computer aided design (CAD) programs, Multimedia programs 

The aims of computing are to:
Areas of Interaction The Design Cycle

[1]: Investigate/
Plan/Create/

Evaluate 
(Specific ATL skills 
that are developed 

through 
technology 

include: 
Information literacy 

skills, 
Communication 
skills, Problem-

solving skills, Social 
and group-work 
skills, Reflections 

skills)
 Description Overview Specifically Communication 

skills
Encourage an 
awareness of the 
impact of computers 
on society and the 
environment

Environment Raising student’s 
awareness of the use of 
computers on the human 
environment

Social and group-
work skills (Blogs, 
Wiki, Moodle) 

Develop an 
appreciation of the 
international and 
intercultural aspects 
of computers

Community and 
Service

Engaging with others in 
our immediate 
community (NYC) and 
communities overseas 
(3rd World Countries; 
for example the impact 
of cheap computers for 
all)

Information literacy 
skills (Blogs, Wiki, 
Moodle)
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Provide a variety of 
technological 
information and ideas

Approaches to 
Learning

The opportunities for the 
development of skills 
and attitudes to learning

Information literacy 
skills, Problem-
solving skills (Word, 
Excel, Moodle)

Encourage curiosity, 
ingenuity, 
resourcefulness and 
discrimination

Homo Faber Personal Attitudes – 
Reflections 

(metacognition) 

Information literacy 
skills, 

Communication 
skills (Blogs, Wiki, 

Moodle)
Stimulate self-
confidence through 
the knowledge and 
application of 
computers

Approaches to 
Learning

Developed thinking 
skills providing 

challenging 
opportunities that 

enable questioning, 
investigation and 
the evaluation of 

data

Problem-solving 
skills Reflections 
skills  (Blogs, Wiki, 

Moodle)

Develop practical 
skills through the 
creation of products/
solutions

Approaches to 
Learning

  

Promote effective, 
informed, appropriate 
communication

Health and 
Social education

  

Foster responsibility 
for designs, decisions, 
actions and assessment

Homo Faber   

Promote effective 
cooperation and 
respect for individual 
differences when 
responding to 
technological 
challenges
 

Health and 
Social 

education, 
Community and 

service

  

Develop logical-
thinking skills
 

Approaches to 
Learning

 Problem-solving 
skills Reflections 
skills  (Blogs, Wiki, 

Moodle)
 
 
Students will also study ethical issues of computers and the Internet, and the impact of computer 
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technology on society. 
 
 

Content/Skills by Grade level and MYP year
Technology/Computer

Stream Grade / MYP 
year

    

 6th / year one          7th / year 
two

8th / year three 9th / year four 10h / year five

Web pages[2] In grade 6 we 
will make 
Webpages from 
a program 
called 
Dreamweaver 
and learn some 
of the basics of 
webpage design 
using the design 
cycle of MYP,
 
Horizontal 
articulation - 
Using the 
design cycle 
Webpages 
working with 
the 6th grade 
teacher

In grade 7 we 
will make 
Webpages from a 
program called 
Fireworks and 
continue with 
learning webpage 
design basics 
using the design 
cycle of MYP,
 
Horizontal 
articulation - 
Using the design 
cycle Webpages 
working with 
Chris 
Cummingham in 
trimester one

 

In grade 8 we 
will use Flash to 
make dynamic 
and interactive 
pages.
 
Horizontal 
articulation - 
Using the design 
cycle Webpages 
working with 
Andre Theisen in 
trimester one

 

In ninth grade we 
will be making 
webpages by 
writing our own 
code with out the 
aid of a package 
like 
Dreamweaver.
 
Horizontal 
articulation - 
(there is not 
currently a year 
nine technology 
class)

 

In tenth grade 
technology we will be 
creating web TV and 
virtual websites with 
more fully integrated 
features to make 
webpages. Each 
student will have a 
final project of 
designing a site for 
someone else.
 
 Horizontal 
articulation - 

New Media 
(Journalism)
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Excel ~ Data Begin Excel 
– simple data

Excel 2 Excel 
advanced

Data 
management

Data mining 
(sorting 

through large 
amounts of 

data and 
picking out 

relevant 
information).

Creative Photoshop Photoshop 
Advanced

Flash 
beginning

Flash 
Advanced / 

Imovie

3D animation and 
CA Virtual spaces

Programming Scratch Scratch 
is a new 
programming 
language that 
makes it easy to 
create your own 
interactive 
stories, 
animations, 
games, music, 
and art -- and 
share your 
creations on the 
web.
 

Scratch is 
designed to 
help young 

people (ages 8 
and up) develop 

21st century 
learning skills. 
As they create 

Scratch 
projects, young 

people learn 
important 

mathematical 
and 

computational 
ideas, while 

also gaining a 
deeper 

understanding 

Google sketchup Flash Flash – Java 
scripting – 

XHTML – AJAX 
(Asynchronous 
JavaScript And 
XML to create 

better, faster, and 
more user-

friendly web 
applications.)
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of the process 
of design.

Text-editing (i.e. 
Word)

Keyboard 
testing, Word 
beginning – text 
- assignments 
on ancient 
civilizations

Word – text - 
assignments on 
Computer and 
Society

Word – text - 
assignments on 
Technology and 
Media / 
LaGuardia paper/ 
Creating news 
content.

InDesign – text – 
advanced features 
of Word – essay 

InDesign – text - 
advanced features of 
Word – essay

Computer BasicsEmail  - 
Firstclass client
School Policy, 
Moodle, 
Acceptable Use 
Policy, Student 
Folders (on the 
server), Wiki, 
Privacy issues 
(See clip on 
Facebook)

Email  - 
Firstclass client
School Policy, 
Moodle, 
Acceptable Use 
Policy, Student 
Folders (on the 
server), Wiki, 
(See clip on 
Facebook)

Email  - 
Firstclass client
School Policy, 
Moodle, 
Acceptable Use 
Policy, Student 
Folders (on the 
server), Wiki, 
(See clip on 
Facebook)

Email  - 
Firstclass client
School Policy, 
Moodle, 
Acceptable Use 
Policy, Student 
Folders (on the 
server), Wiki, 
(See clip on 
Facebook)

Email  - Firstclass 
client
School Policy, 
Moodle, Acceptable 
Use Policy, Student 
Folders (on the 
server), Wiki, (See 
clip on Facebook)

Overseas 
collbarations

     

      
 

New York Standards http://www.moraviaschool.org/NYSLS/mstst5.htm 
 

[1] 
      Design folder
 
      As students progress through the different stages of the design cycle, 
they are constantly experimenting with ideas, researching topics, 
compiling sources, brainstorming issues, sketching possible solutions, 
making changes, rejecting proposals and critically evaluating their work. 
All relevant activities and outcomes should be recorded, and dated, in the 
design folder.
 
      The design folder is a compilation of evidence that accompanies the 
final product/solution for a unit of work. Students formally record the 
results of their research, their various plans and designs and the 
evaluation of their finished products/solutions in the design folder.
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All Projects will implement the Design Cycle when it applies

 
      The design folder must be clearly divided into its constituent parts 
according to the stages of the design cycle: investigate, design, plan, 
create, evaluate. The design folder must begin with the studentʼs 
investigation and end with the evaluation.
 
[2] Our goal with webpages. A website mission statement (evolving).
 
Everyone will develop a website which will always be a product in 
progress.
 
Your MYP will be demonstrated in your ever-evolving homepage. Your 
page will change both as technology changes over the next few years as 
well as you develop new skills to incorporate within your virtual world. 
Your homepage will link to all that you do online at Dwight. From book 
reports to video clips and mashups, game developments to virtual worlds, 
blogs, programming, cartooning, creating online poetry and childrenʼs 
stories as well as your resume and collaborations within our classes  to 
collaborations overseas. Your homepage will be your portfolio of not only 
what you have learned but also how you present yourself online. This will 
be both technical as will as creative. No two sites will be similar.
These will reside on the Dwight server and only you, using your password 
and logon information will be able to access your site. By year ten, if you 
wish, you will be able to transport your site and save it to present as your 
portfolio.
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sixth grade year one MYP notes second trimester

TODAY'S NOTES
Technology Portal >>> ONE ADDRESS FOR EVERYTHING = http://fc.

dwight.edu/studentweb

CLASS MEETS DAY 2 PERIOD 3 AND DAY 5 PERIOD 5

PLAN FOR 2008 Notes for first trimester

SOFTWARE FOR TRIMESTER TWO:  SCRATCH - a social network 
of novice programmers, InDesign (creating a folder), 

Photoshop                                                               Return to year 6 Home / 
Calendar / Student's page / Moodle / Wiki / My Dwight / Curriculum Map / First Class 

- email is on your desktop - from home log in here / assignments / overview of all 
grades for 2008

Assessment Criteria for the IB MYP 

TECHNOLOGY
Criteria Name Max
A investigate 6
B design 6
C plan 6
D create 6
E evaluate 6

F attitudes in 
technology 6

    ALL THING SCRATCH AT DWIGHT     The Scratch website > http://scratch.mit.
edu/    Link to your project             

●     TUESDAY 8Th - DAY 5 Begin Scratch

1.  SCRATCH WHAT IT IS - videos: http://scratch.mit.edu/video. 

http://neuage.org/dwight/6th/6a/notes2.html (1 of 2) [3/9/08 11:31:54 AM]
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sixth grade year one MYP notes second trimester

2.  Visit the registration page to get a login name and a password so that you will 
be able to upload your projects as assigned.

3.  From the Application Folder open Scratch Begin 
using Scratch following with the packet of notes handed out in class. Next class 
you will have an assignment to start a project.
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grade 6 year one of MYP trimester three grade 6 year one of MYP trimester three grade 6 year one of MYP trimester three grade 6 year one of MYP trimester three

Middle Years Programme Technology Grade 6 (year one of MYP) for 2007 - 2008 at The Dwight 
School with Dr. Terrell Neuage 

JUMP TO Today

computer classes homepage GRADE SIX Moodle / Wiki / My Dwight /Trimester Two

Trimester Three
MARCH

TUESDAY 4TH DAY 5  
TASK Organization Creating folders and indexes and the rest

 

ASSESSMENT have your folder set up similar to this:  

df

have 
your folders with an index.html file and images in your images folder so 

expanded your site looks like this 

dfs

WEDNESDAY 27 TH - DAY 2 
TASK EXPLORING THE RENAISSANCE > Creating a page about the Renaissance.  
1. Create a new page in Dreamweaver and title it Renaissance. Put a 
background image. What we will learn today is creating boxes to put titles in. 
1. Create a folder titled Renaissance 
2. Create an index page and name it in the title box 
3. Upload your background image 
4. Place text 
HOW TO DO THIS 
1. Click the drop down menu bar on the Files 

panel. new folder  > click new 

folder  title it Renaissance 
2. Click on your Renaissance folder and do similar to above only click new file 

http://neuage.org/dwight/6th/6a/notes3.html (1 of 2) [3/9/08 11:31:59 AM]
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instead then rename it index.html then dobule click the file. 

3. Title your page  something to do with your new page 
4. Make a wonderful background either with an image or various 

colours  by going to the "Page Properties" 
5. Place text 

A. Be sure Insert is selected: Window > Insert  Select the Layout 

mode  and select the Draw AP Div  
 
 

 

ASSESSMENT In your Renaissance folder have your Title Page or Homepage for 
the Renassance created with background, title and a link to another page you 
will create. This will equal ten points: Two for a folder titled Renaissance, two 
points for your index, two points for your background, two points for a title for 
your page and two points for a title and your name on the page. 

FRIDAY 22ND DAY 5

TASK  
1. Presenting your Scratch Project to the class and to Mrs. Schott  
2. Put a link on your webpage to the Scratch page your work is on

ASSESSMENT 
1. Having your project on the Scratch website - five points 
2. Having a link to your page on Scratch on your website - five pointbsite
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return to notes 2 for sixth grade
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Middle Years Programme Technology Grade 7 (year two of MYP) for 2007 - 2008 at The Dwight 
School with Dr. Terrell Neuage 

JUMP TO Today

computer classes homepage GRADE SEVEN Moodle / Wiki / My Dwight / Trimester Two

After springbreak lesson re. Plagiarism

Trimester Three
MARCH

TUESDAY 4TH DAY 5 need all sketchups of computer lab printed out  

1. TASKs - Details how to do this are below 
a. Get a Google Gmail 
b. To create a Google Notebook with a folder for each class 
c. To add this site to your technology folder as well as your notes for trimester three 
2. ASSESSMENT - This assignment is worth five points toward your final grade 
a. Five points for your folders which should look something like this - of course you will list all 

your classes 
..

 
b. Five points for having the two sites above in your technology folder 

ABOUT Google Notebook http://www.google.com/notebook - a good way to save what you find on the 
Internet into folders accessible anywhere (on earth). Sign onto Google and click notebook or go 
to notebook in a Google search = http://www.google.com/notebook  
1. Set up a google notebook and for assessment set up a folder for each of your classes. Find 
something on the Internet that you will add to your folder. For example, if I had a class 
in Nanotechnology I would make a folder "Nanotechnology" and if I wanted to add something I found 
on nanotechnology Grey Goo right click or on a mac book ctrl click and if you have 
downloaded notebooks you will see "Note this (Google Notebook)" as shown below then put it in 
the correct folder; 
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,

 

FEBRUARY

THURSDAY 28th - DAY 3  
TASK - Microprocessors See Moodle 
ASSESSMENT - Microprocessors See Moodle

FRIDAY 22ND DAY 5 Unit: Networks and The Internet

1. TASK To understand Computer Networks and the Internet 

# Modems 

Internet Camera Hacking ~ Computer Networks ~ LAN LOCAL AREA NETWORKS 
- NETWORKING LIBRARY

2. ASSESSMENT

A. Answer the questions in Moodle
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B. The homework assignment in Moodle is worth ten points

WEDNESDAY 20th - DAY 3 The Language of Machines

TASK To gain an understanding of The Language of Machines. Lessons 1 - 7 at the Intel site 
Video clips we will view: The Art Of Binary Code, Binary Geek, Crop Circle 1, 

FOR HOMEWORK BY NEXT CLASS WATCH THIS VIDEO

ASSESSMENT - Ten points.  
1. Five points Complete exercises in Moodle - tri3 Computers 2 - Digital Information 
(be sure you have finished the Moodle exercises from the prior class) 
2. Five points Write a short essay on why we should know about binary code 
and technology in general - base what you write on the video - This is due before 
Spring Break
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Overview all grades for rest of 2008  SEVENTH GRADE PLAN FOR 2008 TRIMESTER TWO AND 
THREE upgraded Sunday, 06-Jan-2008 10:41 AM
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Middle Years Programme Technology Grade 8 (year three of MYP) for 2007 - 2008 at The Dwight 
School with Dr. Terrell Neuage 

JUMP TO Today

computer classes homepage 8b Moodle / Wiki / My Dwight /Trimester Two

Trimester Three
TUESDAY 4TH DAY 5 

1. TASK To collaborate on a presentation

2. ASSESSMENT Check your gmail. You need to create two related to the topic slides for five 
points. Include text as well as an image. 

wow

 

THURSDAY 28th - DAY 3  
1. TASK Watch this video clip then (putting your first name before what you write) write in 
Google Documents (check your gmail) "Episode 9 Manipulating Society through Technology" of 
your thoughts on the level society is being manipulated with technology. Ten points. Go to http://
www.devsource.com/c/s/Videos/ 

Scroll down to 

2. ASSESSMENT To have written something about this clip in your google documents. Five points.

FRIDAY 22ND DAY 5

1. TASK To share a document with all those in our class. Continuing with Google applications - 
Open Documents 

A. We will collect everyone's email address so that we can work on a document together - See Moodle

B. Open 
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8 b trimester three

2. ASSESSMENT

A. Answer the Google questions - six points 
B. Have written something in our Google Document and "shared it with those in our class - including me 

(DrNeuage@gmail.com) - four points. 

WEDNESDAY 20th - DAY 3   
1. TASKs - Details how to do this are below 
a. To create a Google Notebook with a folder for each class 
b. To add this site to your technology folder as well as your notes for trimester three 
2. ASSESSMENT - This assignment is worth ten points toward your final grade 
a. Five points for your folders which should look something like this - of course you will list all 

your classes  
b. Five points for having the two sites above in your technology folder 

ABOUT Google Notebook http://www.google.com/notebook - a good way to save what you find on the 
Internet into folders accessible anywhere (on earth). Sign onto Google and click notebook or go 
to notebook in a Google search = http://www.google.com/notebook  
1. Set up a google notebook and for assessment set up a folder for each of your classes. Find 
something on the Internet that you will add to your folder. For example, if I had a class 
in Nanotechnology I would make a folder "Nanotechnology" and if I wanted to add something I found 
on nanotechnology Grey Goo right click or on a mac book ctrl click and if you have 

http://neuage.org/dwight/8th/8b/notes3.html (2 of 3) [3/9/08 11:32:26 AM]
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8 b trimester three

downloaded notebooks you will see "Note this (Google Notebook)" as shown below then put it in 
the correct folder; 
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TRIMESTER TWO 9 DESIGN Dr. Terrell Neuage

TECHNOLOGY HOMEPAGE 9 DESIGN DAILY NOTES Return to year 9 

Home / student work / Calendar/ Moodle / Wiki / My Dwight InDesign Notes

TRIMESTER TWO
TUESDAY 11th - DAY 2 Exercise on 4-18 > 4-23 & 4-30 > 4-37

Friday 7th - DAY 6 

1.  Page INDESIGN PAGE 4-3 Tools you'll use > Have them on your desktop 
2.  OPEN ID 4-1 FROM YOUR GROUP FOLDER () CHAPTER 4 Read Pages 4-2 > 4-9 and do the exercise on 

4-9 > 4-14> Read Paages 4 - 14 > 4-17 and do the exercise on pages 4 - 18 > 4-23Working 
3.  Save your work as Ch 4-1 in your folder in the 2011 Design then Print and Hand Up your work 

 

http://neuage.org/dwight/9design/notes2.html [3/9/08 11:32:40 AM]
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nine design 2008 plan

Overview all grades for rest of 2008
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grade 10 year FIVE of MYP trimester three

Middle Years Programme Technology Grade 10 (year five of MYP) for 2007 - 2008 at 
The Dwight School with Dr. Terrell Neuage 

JUMP TO Today

computer classes homepage GRADE TEN Moodle / Wiki / My Dwight / 
Trimester Two

Trimester Three
1. Flash (our index) 2. Rhino  
Technology assessment criteria that will apply to each assignment Criterion A: 
investigate, Criterion B: design, Criterion C: plan, Criterion D: 
create, Criterion E: evaluate , Criterion F: attitudes in 
technology 

 

THURSDAY 28th - DAY 3 

TASK To create a slideshow.  
ASSESSMENT [Criterion B: design] Continue with Flash Slideshow 
presentation and using action scripts have at least ten images change upon pushing a 
button – have them merge and do summersaults 

MONDAY 25TH DAY 6 Continue with creating a slideshow. Go to "slideshow" for 
steps.

TASK To create a slideshow

ASSESSMENT [Criterion B: design - Show your ability to be 
creative by generating a solution (use at least two action 
scripts) to the above task.] Slideshow with five images that do 
something - must use at least two action scripts (rotate, merge, 
bounce, turn into tofu....) = ten points

http://neuage.org/dwight/10th/notes3.html (1 of 2) [3/9/08 11:32:45 AM]
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grade 10 year FIVE of MYP trimester three

WEDNESDAY 20th - DAY 3

TASK To learn about the slide show presenation method in Flash CS3. Go to File New 

> booo  Go to te help files for Flash CS3 and read about 
slideshow presentation and/or go to the webpage for this. Firstly, read about 
templates, then read and apply your knowledge for the slide presentation. Here is an 
example and art and music example (we will add sound next class).

There is a youtube tutorial here, and Create a Flash Slideshow with Fading In and 
Out!!  

ASSESSMENT [Criterion A: investigate] Read the help files and investigate 
the Flash Slide Presentation. Ten points for saving ten photos in a folder and looking 
at the template for slideshow.

Future lesson

TASK Using Flash CS3 and Actionscript 3 to create Atari 7800 Asteroids Part 1 

ASSESSMENT ten points - to successfully create the above game
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nine design trimester three

TECHNOLOGY HOMEPAGE 9 DESIGN / Moodle / Wiki / My Dwight / trimester two

Unit of Work for trimester three will focus on Photoshop Our notes  
CLASS MEETS DAY 2 PERIOD 2 AND DAY 6 PERIOD 2

Technology assessment criteria that will apply to each assignment Criterion 
A: investigate, Criterion B: design, Criterion C: plan, Criterion D: 
create, Criterion E: evaluate , Criterion F: attitudes in technology 

WEDNESDAY 27 TH - DAY 2 
TASK - GO to Page 1-13 and go through the exercise to understand how 
Bridge works. Go through Lesson 4 and Lesson 5 read carefully about 
layers. Layers are the foundation of Photoshop (and all Adobe products).  
DO: 
1. the exercies on PHOTOSHOP 1-26 > 1-27.  
2. Try each shortcut on PHOTOSHOP 1-28 
3. the exercies on PHOTOSHOP 1-34 > 1-35 (though do not print it at the end). 
ASSESSMENT [five points] - Page Photoshop 1-41 plus add your name in the 
lower left corner and print it >  

MONDAY 25TH DAY 6 
TASK Criterion A: investigate To get a starting foundation of Photoshop. In our text 
book please read pages  
"Photoshop 1-2 > 1-15" Lessons 1 - 3.  
Do the exercises in the side panels (photoshop 1-11 open the PS1-1.psd file from 
our group 2011 datafiles) 
ASSESSMENT [five points] Answer the questions in Moodle
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third trimester Design for year ten

TODAY'S CLASS 
year ten design DAILY NOTES Return to year 10 Home / student work /Moodle / 
Wiki / My Dwight /TECHNOLOGY HOMEPAGE InDesign notes (one  two)

TRIMESTER THREE
 
Illustrator ~ Index / Syllabus

TUESDAY MARCH 4TH DAY 5  
1. TASK - Making Direct selections Pages 1 - 36 > 1 - 41 and print (with your name 
on it) your end result 
2. ASSESSMENT - Do and Print page 1-44 (Project Builder 1) as well as page 1-46 
(Design project) Catch up other assignments if not done.

TUESDAY 26th - DAY 1

1. TASK - Creating basic shapes in Illustrator "Illustrator 1-18 > 1-29

2. ASSESSMENT - Print Page 1-31 and 1- 44 for assessment

FRIDAY 22ND DAY 5

1. TASK - Getting started Chapter One: lesson 1 & 2 pages Illustrator 1-2 > 1-17 
Downloading the file Al 1-1.ai from our folder on the server. Illustrator: Creating Text 
and Gradients Be familiar with the Tools on Page 1-3 

KNOW THESE TERMS: Bitmap images, Pixels, resolution, resolution-dependent, 
Vector Graphics, Anchor points, Line segments, Paths, Resolution-independent

2. ASSESSMENT - 

A. Open up a new document as a mobile device then open Device Central. . see if you 
can find your phone or a simliar phone then show me you have done this. Five Points.

B. Print your work for page 1-29 Five points

http://neuage.org/dwight/10design/notes3.html (1 of 2) [3/9/08 11:32:52 AM]
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third trimester Design for year ten

FOR HOMEWORK DUE BY NEXT CLASS IN MOODLE (DESIGN TEN) ANSWER THE 
QUESTIONS)

 

future

1. TASK - 

2. ASSESSMENT

 

1. TASK 

2. ASSESSMENT
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Faculty at Ablany Academy for Girls and Albany Academy

Faculty
Mission Statement of technology @ Albany Academies 

 
Professional Development For Staff

 
Teacher's Resource Page 

 
EELS

 

 

Computer Courses Front Page
Academic Courses
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Computer Courses for 2005 - 2006 at Albany Academy for Girls and Albany Academy by Dr. Terrell Neuage

Computer Concepts @ Albany Academies  
 

Albany Academy and Albany Academy for Girls
Albany, New York

135 Academy Road, Albany, New York 12208 
(518) 465-1461 (ext. 305) phone; (518) 427-7016 fax

  
Dr. Terrell Neuage neuaget@albanyacademyforgirls.org  

BA (Journalism, Literature), Honours (Adolescent Literature), Masters (Internet as Literature), Deakin 
University, Melbourne, Australia; 

Ph.D. (Internet Communication and New Media) University of South Australia  
  
 

Computer Courses for 2005 - 2006 taught by Dr. 
Neuage

     

 Flash-Commercials - Flash Children Stories, Gif Stories, Logo (Cool 
3D), Web-Videos, 3D Modelling, Flash Poems, Birthday Flash, Evening of the Arts

News "Commercials in Flash"
  

SOFTWARE AVAILABLE FOR STUDENT USE: On all AAG PC-lab computers: MacromediaMX 
(Dreamweaver, Flash, FreeHand, Fireworks), Ulead Cool 3D Studio, Ulead Gif Animator, Eastgate 
StorySpace (plus five - full titles), Microsoft Office 2003. On all AA PC-lab computers: Macromedia 
2004 Flash, Microsoft Office 2003 (plus FrontPage 2003), Power DVD, Sony Acid Music Studio 6, 
Finale 2005b, Adobe Photoshop CS and Illustrator CS, Rhino 3D, Flamingo, Bongo, Penguin and many 
other 'minor' programs and plug-ins. 

  

II. Stream one  Internet Media 

●     710 Internet Media: (Fall 2005) Web Design   (Macromedia) Dreamweaver, Fireworks Calendar 

●     711 Internet Animation (Winter 2005-2006) Flash; (Ulead) Gif animator,  Cool 3D Calendar 

http://neuage.org/AA/academic.htm (1 of 4) [3/9/08 11:33:06 AM]
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Computer Courses for 2005 - 2006 at Albany Academy for Girls and Albany Academy by Dr. Terrell Neuage

●     712 Internet Video with this class we will be collaborating with the Music Department and the 
Arts Department
(Spring 2006) Ulead video, Vegas video, Sony Acid Studio, Final Cut Calendar 

III. Stream three “Technology for Expression: CREATIVE DESIGN” 

●     754 3D - CAD  (fall 2005) Rhinoceros 3D modelling, Flamingo’, a rendering plug-in; 
'Bongo', an animation tool and 'Penguin'  which brings freehand sketching, watercolor 
painting and cartoon-like rendering to Rhino and AutoCAD Calendar  

●     755  Computer Writing  (Winter 2005) Hypertextual story designed scripting using Eastgate 
widely considered the tool of choice for hypertext writers. 

●     756 Web design (spring 2006) Web Design with Front Page Calendar 

III. Essential Technologies 760 -

●     (Fall 2005) Outlook, Word, Office Tools, InfoPath  Calendar  
●     (Winter 2005-2006) Calendar - Notes, Course topics:  Excel, PowerPoint, Publisher, Access, 

InfoPath, Nanotechnology, Quantum Computation, Internet Technology - Search Engines 
(Yahoo, Google, MSN, Hotbot, Infoseek, AskJeeves, Altavista, Lycos, Netscape, Altavista and 

etc.), Internet2,  Digital Divides   Nanotechnology    
●     (Spring 2006) FrontPage, HTML. Java Script, Gif Animation, Sony Acid Music Studio 6 

(background for webpages), Internet Technologies: discussion forums and newsletters - Search 
Engines, Hosting, RSS (Really Simple Syndication) Feeds, iPods, Vodcast (Video Podcast):  
WebSites; how the Internet works Calendar

The following are 1/3rd credit units. (3 will make up 1 credit)

Stream one

Internet Media is comprised of three trimester courses that can be taken independently or together.

1. 710 Web Design (Fall) 

Grades 9-12 (1/3 credit) AAG/AA

http://neuage.org/AA/academic.htm (2 of 4) [3/9/08 11:33:06 AM]
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Computer Courses for 2005 - 2006 at Albany Academy for Girls and Albany Academy by Dr. Terrell Neuage

2. 711 Internet Animation (winter) 

Grades 9-12 (1/3 credit) AAG/AA  

3. 712 Internet Video (Spring) with this class we will be collaborating with the Music Department and 
the Arts Department

Projects for trimester three

I.  Hairspray (Medley) Evening of the Arts
II.  Personal Musical Video 

III.  Flash animation of a product 

Stream three “Technology for Expression: CREATIVE DESIGN”

1. 754 3D animation and CAD (Computer Aided Design) (1/3 credit) (fall 2005)

Grades 9-12 AAG/AA 

This course teaches students the fundamental techniques involved in using 3D animation and an 
introduction to CAD. The second half of the trimester will be spent in creating a project using the 
techniques learned in class.

2. 755 Computer Writing (1/3 credit) (Winter 2005) 

Grades 10-12 AAG/AA

An introduction to an exciting form of creative writing using hypertext to invent alternative endings, 
merging stories; thinking of story-writing in a multidimensional form rather than a linear form. Using 
the software Storyspace (www.eastgate.com). 

3. 756 Web design (1/3 credit) (spring 2006) 

Grades 9-12 AAG/AA

This course uses the software, Microsoft Front Page. 

Essential Technologies

760 - 
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Computer Courses for 2005 - 2006 at Albany Academy for Girls and Albany Academy by Dr. Terrell Neuage

●     1st trimester: Outlook, Word, Office Tools, InfoPath 
●     2nd trimester: Excel, PowerPoint, Publisher, Access, InfoPath, Nanotechnology, Quantum 

Computation, Internet Technology - Search Engines (Yahoo, Google, MSN, Hotbot, Infoseek, 
AskJeeves, Altavista, Lycos, Netscape, Altavista and etc.), Internet2,  Digital Divides   

●     3rd trimester: FrontPage, HTML. Java Script, Gif Animation - Internet Technology: 
discussion forums and newsletters - Search Engines, Hosting WebSites; how the Internet 
works (MARVEL: MPEG-7 Multimedia Search Engine)

Nanotechnology - At State University at Albany is the first college in the world devoted exclusively to 
nanoscale science, CNSE is pioneering a new academic model.

NanoFacts: 

●     It is widely accepted that nanotechnology has the potential to revolutionize every area of our 
lives over the next 20 years.

●     The worldwide workforce necessary to support the field of nanotechnology is estimated at 2 
million by 2015.

●     Nanotechnology could most accurately be described as the science of atomic know-how, or a set 
of tools enabling ground-breaking innovations.

●     Nanotechnology refers to the manipulation of matter at the atomic scale, specifically limited to 
the 1-100 nanometer range.

●     Nanotechnology is not one science. It's a platform that encompasses biology, chemistry, physics, 
materials science and engineering.

 

 

http://neuage.org/AA/academic.htm (4 of 4) [3/9/08 11:33:06 AM]

http://www.internet2.edu/
http://www.research.ibm.com/marvel/
http://cnse.albany.edu/


http://neuage.org/ODAMx950.jpg

http://neuage.org/ODAMx950.jpg (1 of 2) [3/9/08 11:33:08 AM]



http://neuage.org/ODAMx950.jpg

http://neuage.org/ODAMx950.jpg (2 of 2) [3/9/08 11:33:08 AM]



Our Newsletter on ournews.mobi

REFRESH 
updated Nov 13 -06 
* Our clips On 
YouTube 
* Window Media 
Videos 
* Photos 2002-2006

text:

●     1st notes 
August 28th

●     04-October-06 
blog 

videos open in right 
panel:

●     move video 
(8/22/06) 

●     Brighton festival
●     looking-out-

apartment
●     Brazilian 

Festival
●     West Indian 

American Fest. 
( 9/ 3/ 06)

●     West Indian 
Carnival 
(9/03/06) 

●     MT festival (9-
17-06) 

●     San Gennaro 
Festival 
(9/24/06)

●     Williamsburng 
Bridge 
(9/24/06) 

 

NYC videos 11/12/06   refresh site 
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●     Biking 
(10/02/06)

●     World Trade 
Centre 
(10/02/06) 

●     Intrepid 
fireworks 
(10/02/06) 

●     Two trumpets 
(10/05/06) 

●     Columbus Day 
(10/09/06) 

●     Hip Hop Exhibit 
(photos) (video 
10/16/06) 

●     Nova Clutch at 
DUMBO 
(10/16/06)

●     DUMBO arts 
festival 
(10/23/06)

●     Bike Ride 
George 
Washington 
Bridge (added 
10/24/06) 

●     Williamsburg 
Bridge Pt2 10-
29-06

●     F Train Nov 
03/06

●     Queen Mary 2 
Nov 05 

●     #1-train Bronx 
Nov 12/06 

photos:

●     apartment
●     Brighton 

Festival 

Our Newsletter on ournews.mobi
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●     West Indian 
Carnavial 

●     Bike riding 10-
02-06

●     Columbus Day 
●     George 

Washington 
Bridge 10-15-
06 

●     Graffiti

Photos 2002 - 2006 
 

Clips below open in 
Windows Media 
Player if you have it 
downloaded 

Nova Clutch  
Intrepid Fireworks 
Bike ride Manhattan 
Brazilian Day 
Brooklyn Hip Hop 
festival  
Colmbus Day Parade 
New York Transit 
Museum 
Two Trumpets  
World Trade Centre  
Williamsburg Bridge 
Moving to Brooklyn  
Our Brooklyn 
Apartment  
Bikes on George  
Brighton Beach 
Festival  
Brooklyn Pier  
Merry-Go-Round-
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Videos from trip 2006 Albany to Adelaide via Utrecht, Hamburg, Istanbul, Ho Chi Minh, Phan Thuan, Adelaide, Melbourne, Sydney
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●     Holland (05) 
●     Germany (06)
●     Germany (05) 

Australia (AUGUST) 

Flight Melbourne - AdelaideWMV

1.  Footy 
2.  Narda's (3) son's band July 29, 06 at the Rocket, Hindley St. Adelaide 
3.  Adelaide (Christies Beach; Southern Districts) 
4.  Train into Adelaide (youtube) 
5.  Melbourne 

ALL PHOTOS (1947 - 2006)

Trip 04 videos (Ireland, Barcelona, Utrecht, Hamburg, Hong Kong, China) 

Trip 03 videos (Korea, Hong Kong, Singapore, Sydney) 

Round Lake NY

NYC

Washington D.C. 

videos below open in Windows Movie Video (much better quality) 

Bosphorous Boat  
Hotel Poem 
Istanbul Cafe 
Saigon Bike Ride  
Saigon Traffic 
Ho Chi Minh City  
Monsoon 
Phan Thiet 
South 
Narda-Cyclo 
Delta-boat 
Delta-Singers
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06 trip to Istanbul with Narda and Terrell clips in this folder 1. Bosphorus Boat ride 2. Buyukada [Princes Islands] 

clips in this folder 1. Bosphorus Boat ride 2. Buyukada [Princes Islands] 3. 
Rooftop of Hotel Poem 

<

 

http://neuage.org/06trip/video/Turkey/Turkey-All.html [3/9/08 11:34:39 AM]




http://neuage.org/trip06/video/Rooftop/rooftop.html

 

 

http://neuage.org/trip06/video/Rooftop/rooftop.html [3/9/08 11:34:58 AM]




Viet Nam videos 2006

Viet Nam July 2006
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Cyclos in Ho Chi Minh City July 2006 

Cyclos in Ho Chi Minh City July 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Mekong Delta Viet Nam

Mekong Delta Viet Nam July 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Christmas 05 to Paris with Narda and Terrell clips in this folder 1. Leaving Albany 2. Seine Rides 3. First night walk-about 4. Lourve 

clips in this folder 1. Leaving Albany 2. Seine Rides 3. First night walk-about 4. Lourve 5. Our 
Apartment (as of July 16th, 2006- more to come) Photos of Paris Christmas 2005 to Turkey videos to 
Viet Nam videos 
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Terrell Neuage August 1 - 5 Melbourne Australia (Grafitti, Sorento, Victoria Coast, St. Kilda Pier, Casino, night views of Yarra River and Melbourne)

August 1 - 5 Melbourne Australia (Grafitti, Sorento, Victoria Coast, St. Kilda Pier, Casino, night views 
of Yarra River and Melbourne) Back to trip 06
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Train ride into Adelaide, South Australia from Noarlunga Centre August 2006

Train ride into Adelaide, South Australia from Noarlunga Centre August 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Narda Terrell

 
Narda Terrell
 
Leaving Albany 
 
Wednesday, June 15, 2005 Washington DC, Dulles Airport
 
All bright eyed and bushy tailed we arrive at the airport 3 hours early, nearly all the painting 
done, and two major school meetings cut. Feeling very powerful we get to create much of the next 
2 months with no timetables except the airlines. On an aircraft, too small for our bags and to 
stand up in, to be told that there is no room in Washington DC for us to land.  So we wait, with 
our glass of tomato juice with no ice.
Meanwhile our plans of heading straight on to Europe slowly fade, as I text message Brendan to 
prepare him, hoping that this does not jinx it. Well it did, we rush into the Dulles terminal, me 
running ahead, Terrell collecting those heavy, ‘we always travel light’  backbacks. And can you 
believe it, the jet to Frankfurt sits there, behind closed doors. No one will open them. Blimey. It 
could be worse. We could still be back home painting, or trying to ring plumbers and painters 
who only answer with answering machines, like the rest of America. Not that it matters much, I 
like America for many other reasons. Perhaps one day we’ll make some money off our house, 
despite the slowest and most expensive tradesmen the world has ever seen. 
And here I sit at Starbucks in the airport again for our rescheduled flight, five and a half 
paranoid hours early, and a short night’s sleep behind us. It’s still fun. It’s always fun with 
Terrell, really. 
 
At Albany airport we were asked to ‘move along’ and rather quickly too - so we could “leave as 
soon as possible”. Those “leave as soon as possible” words had harmonious movement in them, 
there was no reason to question or try and put any meaning other than “leave as soon as possible” 
to them.  
 
Of course, we did not know that she, our airline steward, knew what we did not know and she 
knew that “leave as soon as possible” did mean that and furthermore that there were layers also to 
the meaning. It is safe to say there may have been dimensions that we mere passengers were not 
aware of. We were entering three-dimensional meaning. Narda claims I use far too many words 
to say what others say in much less words. Our stewardess was my verbiage opposite; she used 
far too few words to say way far too much; “leave as soon as possible”.
 
Our jet fighter plane, well that is a slight exaggeration, perhaps we were on the United States 
Presidential Air Force One, closed her genderless doors and we were racing down on the way to 
months of global trotting. We received the safety tour, being notified where the exits were, and 
yes there was a toilet – at the back of the plane and learning that our flight attendant had a name 
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Narda Terrell

of Carol and that she would be there for us. Through thick and thin we had Carol reassuring us 
that our future was secure. 
 
Re-assured that we were safely on our way, Narda opened her book for the blissful reading 
experience ahead and I began reading my short guide to a new software program that I had just 
installed. There was no thought of taking my laptop on board as it would not be worth starting it 
up and using any of the four-hour battery power that I would need in a few hours as we headed 
over the Atlantic bound for endless pleasures and perhaps some sleep. Narda and I were tired to 
begin with. We had little sleep the night before due to the hot and humid night without air 
conditioning at home. And to further my tiredness I was just getting over a week’s bout of the flu.
 
Now we had a fifty-minute flight ahead and I had a fifty page book, surely I would have the 
program figured out by the time we got to DC and I would tryout my new found knowledge on 
the flight; DC to Hamburg. We got to the end of the runway and that was it. After sitting for ten-
minutes, it was now 7.10 PM and by my calculations we would be at Dulles Airport at 8.05, 
plenty of time to catch our departing flight scheduled to leave at 9.35. 
 
Carol passed on the unfortunate news that we would now be departing at 9 pm, two-hours past 
our original time and that would mean we would not be able to make our connection. The reason, 
she passed on, was that we had not been assigned a landing slip at Dulles Airport yet. We of 
course went into panic mode ringing United Airlines and Narda texted messaged Brendan to say 
we would not make the flight. At 7.20 Carol gave us the encouraging news that we would be 
leaving shortly only to deny us any hope a few minutes later when she said we would leave at 
eight, then there was another nine pm departure time announced and I think there was a nine-
thirty departure time thrown in at some point. A lady several rows behind us said she had just 
found out that there were no hotel rooms available anywhere near the airport and United was not 
going to put up the people who would miss their flight. 
 
There was this agonizing announcement and that negative comment and claims of leaving soon 
and I am sure there was a ‘you will never leave this aircraft’ tossed in, no doubt subliminally 
through the air conditioning unit. We asked if we could leave the plane and try our luck at getting 
a flight to Chicago and a connection to Europe but at the end of a runway on the beginning of our 
flight to Australia in the middle of June on a hot summer evening we weren’t goin’ nowhere. To 
cut to the chase we got into the air at 8.30 plus, only one and a half hour late. 
 
Narda got off first and ran to the end of the concourse to gate C7 in hopes of our still getting onto 
our plane. It was due to leave at 9.35 and it was now 9.32. I carried our carryon bags heading 
toward a rendezvous with Narda at a gate that would soon swallow us and toss us out at the other 
end somewhere in Germany. But the cell-phone call was not promising. Narda said the plane was 
there but they would not open the door for us. 
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We got in the rapidly growing line at ‘customer service’. There were seven terminals and three 
girls looking very uncaring and even less helpfully shaking their heads ‘no’ from customer to 
customer.  Soon the line had at least a hundred agitated people in it. Not only was there no way 
anyone was going anywhere but United was not going to help anyone find a place to sleep. The 
man in front of us, arriving from some city in Ohio several hours later than he was suppose to 
have landed in order to get his family’s connecting flight had two small children and he told us 
that his family was told they could get on a flight but they would be on standby. After 
discovering that the flight was full he was back in line for the second time at the ‘customer 
service’. He did get his family on a flight for the next day but United would not help them find a 
place to stay.
 
We were told we would be put on standby for a flight for the next day at 5.30 PM. We pushed 
and pushed until we got the ticket agent to change our ‘standby’ flight to a confirmed booking. 
She told us to keep it to ourselves that we had a confirmed booking as there was a long and 
growing line of agro customers wanting a confirmed flight to Europe on the next day.
 
We left the ticket counter at 11.30 PM. We were lucky we had confirmed tickets. There was still 
the long line behind us and the United staff were acting far from friendly. One of the ticketing 
girls said she was leaving at midnight no matter at how many people were in line. United told us 
the reason we missed our flight was ‘weather related’ meaning they no long were responsible for 
anything. United airlines is in bankruptcy protection and if they run their airline the way we 
witnessed, being rude to customers, not taking responsibility for missed connections, not 
providing for the comfort and care for its customers then I can see why. We are on our third 
around-the-world ticket, and it is clear that our mistake was going with United airlines on our 
latest around-the-world ticket. We have had a lot better service with Qantas and its partners and 
that will be our airline of choice in the future, unless of course we change our mind which we do 
at the drop of a hat or a good deal. We are the archetypical fickle tourist.
 
At 12.30 AM, June 15th, we found ourselves in the bowels (or is that the rectum?) at the baggage 
section only to be told we could not have our baggage. At one AM we rang every hotel-motel 
listed in the airport directory. Out of approximately fifteen places only one had a room at the 
midnight price of $315 plus $45 each way for a taxi. We decided to hire a car and took the shuttle 
bus to Dollar car rental. The people working there were the first pleasant employees we had 
encountered since getting on the plane at 6.30 the night before.
 
The Dollar car rental manager rang several hotels from the Yellow pages and rented us the last 
vehicle they had available. Fifteen minutes later we were driving a new van (it had two-miles on 
it) along the Beltway, Rout 495, I think, (a six-lane freeway that circles the nation’s capital) 
trying to find a Red Roof Inn somewhere along a maze of interwoven freeways. We eventually 
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found Route 95 and the correct exit and by 2 AM we were at in our room and by 2.15 I had my 
earplugs shoved in to the middle of my head and my eye patch safely in place. Five hours later, 
tired, but feeling better than if we had slept in a chair at the airport like many others had to, we 
were up and trying to cancel our hotel in Amsterdam to no avail.
 
Of course why should we complain? There were a lot of people who either had no connecting 
flight for the next day or who were in the ‘standby’ category; which really meant ‘wait-another-
day’. There was the young mother, child in a pram, crying on the shuttle bus as she spoke on her 
cell phone, and a teenage girl very upset she had to spend the night at the airport and a man trying 
to get to Hamburg for the ‘most important meeting of his life’ but the story I found absolutely 
strangest was one flight where the pilot walked off the plane and left his passengers on the 
runway without the plane going anywhere. The man at the baggage counter said he could have 
driven home in two-hours but had decided to fly wherever he was going and now his luggage was 
stuck on a plane with no pilot. He said when the passengers saw the pilot leave they all got off. 
United airlines – you suck. Of course why should we complain? There are many people who have 
not traveled much in life at least physically and this is my eleventh jaunt between East Coast 
America and Australia; six times via the Atlantic and five over the Pacific.  
 
It is now 2.30 PM, Wednesday and hopefully we will get on the flight direct to Amsterdam in 
another three hours.
 
Thursday, June 16, 2005
 
Here we are in Utrecht. Sitting in Rienk’s apartment. Narda, Rieke, Brendan and Kylie. 6:43:20 
PM. Narda and Brendan and Kylie went for a bike ride to the old town and I took a nap and now 
Narda and I are boring everyone with our home videos.  
 
Amsterdam is a rapidly changing city. I judge cities by how many building cranes in the air and 
Amsterdam has about the most, year after year. Albany, New York has one or two every few 
years. Last year we did a couple of day trips from Utrecht. There was the drive there when we 
were out of petrol and after filling up and going inside to pay realized that we did not have any 
cash or credit cards and the attendant did not speak English and Narda’s Dutch got us through the 
moment. I left my driver’s license and we went back to Utrecht and got our credit cards. We lost 
a camera on that visit to Amsterdam, the only thing we remember losing on any trip anywhere in 
the world. The year before I sent Leigh a copy of a National Geographic that we once owned, it 
was a 1983 edition that had a story of minor league baseball clubs in America. I had found the 
magazine in my father’s collection of National Geographics that he had collected from 1921 to 
some current date. Leigh and I had borrowed that edition once in Victor Harbor when he was 
about ten-years old and we talked daily of his future when he would be a major league ball 
player. I mailed that copy in Amsterdam as a birthday card/present in mid-June 2004, two-
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months later he would be dead.
 
On the flight across the Atlantic, on United, even the airline stewards were grumpy and there was 
no free alcohol as there was on every other international flight I had ever been on. Being tired did 
not help. But as one does in these situations I thought of my past ten international trips and in 
comparison was already determining this as being the worst flight. 
 
10. December 2004: New York (Newark) – London – Singapore – Melbourne and back the same 
way January 05; uneventful trip Downunder for Christmas.
9. June 2004: Albany – Chicago – Dublin – Amsterdam – Hong Kong – Sydney – Hawaii – 
Albany
8. June 2003: Albany – Chicago – Miami – Barcelona – Hamburg – Seoul -  Hong Kong – 
Sydney – Albany 
7. March 2002: Adelaide – Orlando, Florida to see Leigh, Clifton Park to see father 
6. March 1992: with Sacha (age 11) and Leigh (eight), Adelaide, Oregon, LA, upstate New York 
and NYC, and a long fourteen hour flight; LA – Hamburg during which time I drank too much 
free alcohol, Paris, London and etc. 
5. January 1985 with Sacha (turned 4 somewhere between Honolulu and Baltimore) and Leigh 
(one and a half); Hawaii, LA, Baltimore, upstate New York and back to Adelaide
4. December 1984: two-months after separation leading to divorce, by myself on a round-the-
world ‘yeah I am free’ trip; Adelaide, Hawaii, LA, NYC, upstate New York, London, Germany, 
Rome, Athens, Bangkok, Perth, Adelaide
3. October 1982 with Lesia and Sacha (age one and a half); Hawaii, LA, upstate New York
2. June 1981; Hawaii to Adelaide with Lesia and Sacha (age six months)
1. December 1980; Baltimore – Auckland – Sydney – Baltimore 
 
Now I get to read my primary reading:  Radical Evolution (The promise and pearl of enhancing 
our minds, our bodies – and what it means to be human) by Joel Garreau
 
Friday, June 17, 2005
 
Finally feel alive after almost twelve hours of sleep. Hello Holland.
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Saturday, June 18, 2005

Saturday, June 18, 2005
 
The luxury of holiday. I got up at 10 AM and the others soon followed. A day without plans is so 
different. After the past six-months of getting up every day at six AM for work and of stressing 
because of all the work on our house it is good to have few concerns other than where should we 
bike ride today? The only thing I ‘need’ to do today is find a charger for our video camera. I 
found an adaptor yesterday so I could plug the one we had in but as soon as I plugged it in (US 
120 voltage into European 240 voltage) smoke came out and the thing became fried. We are 
driving to Belgium tomorrow for a few days and at this point I think we are just pointing the car 
we are borrowing in that direction and as long as we do not end up in the English Channel we 
should be fine.
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Albany New Yorik to Adelaide South Australia via Utrecht, Hambrug, Prague, Beijing, Singapore with Narda Biemond and Terrell Neuage

Sunday, June 19, 2005
 
Up at the crack of dawn and off to Belgium. We are staying at a beachside resort, Bruge. Brendan 
and Kylie are staying at a youth hostel to which we are not invited but we have a good hotel with 
a full smorgasbord breakfast.
 
Narda’s entry for Saturday, June 18, 2005
 
It’s so much fun to be in Holland. I love the food especially. And riding bikes is the best. Now I 
have the extra bonus to see my darling boy again, with his sore foot, which worried me so much. 
That foot was a saga; he spent nearly 2 weeks in the Royal Adelaide with ‘Cellulitis” ..blimey..
have to look that up. It must have been serious and he said it was extremely painful. If I could 
have taken the pain from him to me I would have. Such an emotional thing, mothering…
sometimes I don’t know how it is possible.
We’ve just returned from visiting Tante Willy; she’s lending us her car for a few days and we’ll 
drive off tomorrow, through Scheveningen, then on to Bruge in Belgium. We’re enjoying a beer 
and some blue cheese. Reink is sleeping on the boat these days. He’s completely given us his 
place, very generous. We spent some time today in Utrecht looking for the connections to get our 
video camera working again. It’s 10 pm, and still light outside. 
Nearly time for bed.
 
Friday, June 17, 2005
 
I realize this is out of sync with the actual days of the week but when I uploaded to our blog 
earlier in the day at the local Utrecht Internet Café I left off the file for Friday, June 17, 2005 and 
the only reason I wanted to include it is because it is about a moment I had been wondering 
whether it would ever happen. Of course as Narda says no one would ever read any of this 
anyway except maybe a couple of our family members but this does serve another purpose. 
Because of all that happens in life we forget what happened at different times and where it was at 
that. Just today we struggled to remember where in the world we were when we walked to a 
small town near a place we were staying and had dinner. The more places we go to the more 
difficult it is to remember where different passing thoughts of something that happened actually 
occurred. We have been on the road since we met four years ago. In that time we have lived in 
two places in Adelaide and three in New York. I don’t know if it is Narda or me, I did live in ten 
houses in ten years with my children between 1985 and 1995 and Narda was a bit more stable in 
her life but we have only seen a small part of the world. 
 
Finally feel alive after almost twelve hours of sleep. Hello Holland.
 
The four of us were to ride bikes for a day into the old town but Brendan broke the chain last 
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night so he and Kylie rode bikes and we took a bus. I had my big moment to contend with – to 
find the result of something I began at the beginning of 1991. Back then, living in Victor Harbor 
with Sacha and Leigh and wondering at the age of forty-four what I should do in life. I had sent 
in an application several months before to begin university at Deakin in Melbourne. At the time I 
thought I would give a bachelor of arts a go, never really believing I would complete it. 1995, 
after too much work for any human being; raising kids and studying and finding money to live 
on, I thought ‘why stop now?’ I had a BA in journalism and decided not to ever do anything with 
the degree after seeing how dishonest the media really was so I applied for an honour’s degree in 
children’s literature and by the end of 1995 I was applying for a Masters. 
 
I thought I was pushing the envelope going for a Masters. At the same time I started my BA of 
computing science at Flinders because now I was becoming obsessed with school and learning. 
Furthermore, with the World Wide Web starting to become a way of life (having been ‘invented’ 
a mere four years earlier) and not being able to afford a new enough computer to get online I 
needed the university system to be a part of this new world. At the beginning of 1995 Flinders 
University had two computers online then soon after a room with ten of them. I was spending 
more and more time at university to use this wonderful new way of being connected with the 
world. My master degree was on ‘The influence of the Internet on literature’. 
 
Toward the end of my Masters in literature and computers I had the strange and far out notion of 
getting a PhD. I even got a book out of the Flinders’ library on what a PhD was and what the 
procedure was for getting one. I remember one evening shooting hoops with Sacha in our 
backyard in Hackham and explaining to him that I was going to apply for a PhD which would 
mean, if successful, I would be a doctor. I was doing a lot of picture poems at the time and I 
jokingly said I would be a Doctor of Picture Poems. I was concerned what my title would be 
thought; would my Doctor of Picture Poems be shortened to Doctor of P P or even worse would I 
become Doctor PP or even the P Doctor? 
 
I completed my Masters and applied for a PhD at the University of South Australia. The only 
catch was that I could not continue my BA in computing science at Flinders. The choice was 
either to have a degree that I could get employment with, like a BA in computing science or a 
PhD which was an academic degree and probably not as employable. I started the PhD thinking I 
would do it on my art-writing and it all seemed so simple. However, my supervisor, Jackie Cook, 
(and yes I did make the mistake once of actually calling her Captain Cook to her face as that is 
what I said when I was not with her and it slipped out unintentionally but she just laughed and 
said she was called that at school) thought that it would be best to do my PhD on something else 
and I came up with the idea of doing it on online communication; “Conversational analysis of 
chatroom “talk” would become the next seven years of way too much labour. I was soon not only 
raising two children alone but I was working two jobs and doing my university research. 
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I often thought not only that I would not complete but that I was not capable of competing. It had 
only been seven years earlier when I started the university game and back then my ex-wife 
confidently informed that I would never finish my BA as I was not smart enough. This all begin 
in March 1998. Seven years later, today to be exact, at the Internet Café in old town Utrecht, I 
received an email saying that at the meeting of 14 June 2005, some committee gave the final 
approval for me to graduate. Far away from today and this place all this began. Back when I 
started this educational trek I never considered finishing it or of living anywhere else than I was 
at that moment, in Australia. I thought by the year 2005 Leigh would be a major league baseball 
player and I was not sure what Sacha and I would be doing. Leigh’s future was the only sure 
thing, perhaps it still is.
 
We went out to dinner tonight to celebrate my completing this PhD. It must be the time of year 
we do these journeys but it did not get dark until after ten PM. Of course I did not get up until 
after 9.30 this morning so now at 11 PM it seems time to wrap up a day that had some sort of 
closure following so many years of work. I should find out in the next couple of days whether I 
will graduate on the sixth or on the seventh of September and considering I need to be back at 
work on the seventh in New York I am hoping it is the sixth. 
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Melbourne has always meant more to me than it could possibly live up to in my world

Added photos to photo album see South Australia file  Thursday, 21 July 2005
Melbourne has always meant more to me than it could possibly live up to in my world. 
 
When I first thought of leaving Lesia, a week after arriving in Adelaide, June 1980, I went to the 
Adelaide Public Library and began ‘researching’ where to live. I did not want to go back to the 
States because I did not really have a place to go to and I did not know what state, let alone what 
city, I would want to start over in if I did go back. I had shipped my few belongings to Lesia’s 
house and they were still in route to Australia. I did not want to give up seeing Sacha and being a 
part of his growth. The naturally occurring sequencing in my brain, not really a singularity as in 
the theory of everything Terrell and how and where it should manifest but a ‘this is the only path’ 
surfaced in my ‘investigation’ of what to do. Melbourne seemed the likely choice. After one 
week in Adelaide I had concluded that it was one of the worst places to live in the world. I did not 
like the Australian accent, the trends of the moment, though now, twenty-five years later, I have 
no idea what they were, just that I did not like them, and I did not like the city of Adelaide. I felt 
like I was on an uncultured island (Adelaide) with the nearest island of culture, Melbourne, about 
a thousand kilometres away, and Sydney twice the distance beyond Melbourne. It was worst than 
living in the midst of Iowa. 
 
I read Melbourne newspapers, books on the city and surrounding areas and decided that I would 
move with Sacha, and set up a tofu factory in the Dandalong Ranges outside of Melbourne. I 
plotted and dreamt and thought about it month after month then year after year and when Leigh 
came along and I was divorced and the tofu business was growing I plotted and dreamt and 
thought about it a lot more but for all the reasons in the world it never happened. The first time I 
came to Melbourne I was a student at Deakin University. It was 1993 and I barely had enough 
money to go. I took the overnighter for $30 and sat up all night on the hard seat and attended the 
first of the weekend workshops an hour after I got into Melbourne. That night I found a very 
seedy and cheap hotel for $20 and the next day I attended the Sunday workshops and in the 
evening sat on the cheap hard seat back to Adelaide. The next time I went to Melbourne was in 
April 1995 with Sacha and Leigh  for my BA graduation and we took the day bus to Ballart and 
the train to Melbourne from Ballarat and stayed at a youth hostel going the next day to Geelong 
for my graduation. That was a lot better stay than my previous one. 
 
We never were able to move to Melbourne because ‘the mother’ would not allow us and in fact 
she had a court order stating we had to live in South Australia then eventually she took out a 
court order saying that the children and I had to live in Adelaide (we had previously lived about 
an hour from Adelaide in Mount Compass and Victor Harbor, Port Elliot, Middleton – actually 
we moved ten times in ten years). Then my Melbourne distributor of my tofu products went 
bankrupt owing me more than ten-thousand dollars which was the beginning of the downfall of 
my ‘well thought out and “planned”’ global domination of the bean-curd production and tofu-
product manufacturing foray that barely seemed to grow beyond the wishful thinking stage. 
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Melbourne has always meant more to me than it could possibly live up to in my world

Nevertheless we never moved to Melbourne as a family. Sacha moved here a few years ago and 
Leigh was last here in 2003 before going to spring training with the Dodgers. Leigh received 
‘Channel 7 Australian Junior Sports Star of the year’ award in Melbourne the same year, 2003, 
that Lleyton Hewitt received Senior Sports Star of the year due to his being the number one 
tennis player in the world. Now Lleyton is getting married to Bec Cartwright in Sydney in two 
days and I will be off to put some flowers on where Leigh died two years ago in Sydney on 
August 16.
 
I have been to Melbourne several times the past few years. Last Christmas I spent with Sacha and 
Georgia and the summer before (winter in Australia) Narda and I visited Sacha when he was 
living with Monica and we visited the year before too. Now Sacha has his nice apartment in the 
Docklands (NewQuay), he is in the Palladio Towers overlooking Melbourne and I have a couple 
of houses in New York and I will graduate in several weeks collecting a PhD. We all change of 
course and so do most cities (not Albany, New York or Adelaide, South Australia though, those 
are the only cities I have been in over the past several years, worldwide, that are not dotted with 
cranes. Beijing, Melbourne, Hamburg, Amsterdam and so many places between have a lot of 
buildings going up. This blog is titled ‘Albany to Adelaide to Albany’ why I would live in the 
two cities of the world that have no progress I am not sure. Of course I equate progress to cranes 
putting up buildings – maybe there is some deep metaphysical spiritual thingy happening that has 
slipped by my materialistic and worldly sight. I like to think my changes are in league with cities 
like Melbourne (voted year after year ‘most liveable city in the world’). Maybe so. Maybe no. 
Someday it could just turn out that I will finally live in Melbourne or close to it.
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Thursday, 18 August 2005 Return to Albany to Adelaide to Albany via Europe and China 
BLOG 

Now we are sitting on the train back to civilization. Well… actually we are leaving civilization …
our mountain retreat, where there is time to talk to friends, think, look at the views…back to 
Sydney. I love this train, it’s so smooth and heavy. And when you reach a station there’s this 
silence. It’s lovely.

Yesterday we spent the day with Heather and Mal, my long lost friends. Well, they were not lost, in 
fact they were busy building a new life and house…out of straw bales…very earthy and beautiful 
on a beautiful piece of land in Blackheath. And great careers in counselling and management. I 
had lost their phone number.

We had a fun day sharing stories about difficult and sad family memories, and love, and moving on 
to new things, and old friends left behind. Mal and Heather are very special people and I know 
they will be lifetime friends.

Katoomba is a groovy town up there on top of the mountain, I’m sure we will return. Narda

We saw so a small part of this incredible area of the world. I wanted to take a skytram that went 
over the gorges (‘…the brand new new “Scenic Skyway” is a world first with its Electro-Sceni- 
Glass Floor. Take a 720 metre journey 270 metres above ancient ravines and dazzling waterfall. 
At the flip of a switch, breathtaking views directly below are revealed through the cabin floor – 
which you can stand on… and I didn’t take it – next time) and some train that is billed as ‘the 
steepest train in the world’ (with an incline of 52-degrees, this “Mountain Devil” is the world’s 
steepest railway. The railway was built originally to haul coal and shale out of the valley…) but we 
did not have the time. We saw the three-sisters mountains named according to Gundungurra 
Dreaming. Apparently there were there were these three groovy sisters that were in love with three 
groovy warriors but because of tribal beliefs they weren’t allowed to get on with one another so the 
dudes forcefully acquired the chicks and the Kuraduri (clever priest type of dude) of the 
Gundungurra folks to turn the women folk into stone and therefore we now have these huge rock 
formations waiting until the day they will be turned back to natural women.

The downside of this place is the snakes (tiger snakes) and funnel web spiders both of which can 
send one into a cosmic tailspin (actually make one’s physical and whatever one refers to as the life-
force, separate forever and a day). They seem to be around in the undergrowth and bush wherever 
one wanders. We have red-back spiders in South Australia that can have pretty much the same 
effect but, obviously, I have managed to keep my hands away from them. 
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Now at Sydney airport waiting to fly to Melbourne to stay with Sacha for a couple of days then we 
have hired a car to drive back to Adelaide. We will take three-days and go along the Great Ocean 
Road. The last time I was there was in 1992 when my father came over from New York at the age 
of 87 and Sacha, Leigh and I collected him from Sydney airport. We had hired a large mobile home 
with shower, bath – kitchen – and we drove up through Queensland and back to Adelaide via 
Broken Hill. After a week in Adelaide we drove my father to the Melbourne airport along the Great 
Ocean Road. Terrell

Tuesday, 16 August 2005 6:12:48 PM

‘The oldest land on earth’ 

            It is less than two hundred years since Europeans first gazed in wide-eyed wonder at the 
cascades and canyons of the ancient plateau we call the Blue Mountains.

            The Blue Mountains is one of the oldest places on earth. When the grand canyon in Arizona 
was only a few centimetres deep, the Blue Mountains and their magnificent valleys were very 
much as they are now…” from a tourist brochure

WHY ARE THE BLUE MOUNTAINS BLUE?

They are blue because of the blue haze produced by the scattering of the sun’s rays striking dust 
particles and droplets of moisture in the atmosphere. The blue haze effect is magnified by the 
droplets of oil produced by the extensive population of eucalypt forest within the Blue Mountains. 

Here we are at ‘Sidney’s Retreat’, down on Lurline Street in the great Blue Mountain town of 
Katoomba. [http://www.sidneysretreat.com] what an incredible place after a day in Sydney and at 
Homebush – Olympic Park – where I should not have to go every year on August 16th (Leigh why 
did you make this be this way?). We have a few days at a great home overlooking the Blue 
Mountains. We arrived via train at three PM, found the key to the cottage and are as content as one 
can be. The cottage is old and decorated old – though there is a microwave oven, TV, video, CD 
player [and of all the CDs to have – my all time favourite – Leonard Cohen – he has always been 
number one in my poet-musician type of folks category – I have not heard him in decades as my 
tapes had broken from so much playage and when he was in Adelaide in 1985 or so I could not 
afford to see him – and finding his CD in the Blue Mountains in a guest house cottage is a real 
treat] and a great wood fireplace. We walked into town and found a Coles and brought back 
groceries for a great evening’s dinner. Now Narda is content with reading her book and I am 
writing this. We are here as a holiday within a holiday as part of our (USA) summer holiday – 
though of course it is winter here and the check-out chick at Coles told us they had three inches of 
snow last week – nevertheless there is a holiday in all this somewhere. Perhaps Narda (and she 
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does say so) does not quite understand why I had to bring me laptop with me on holiday but it is 
not just work – editing some CIOS journals for Teresa, preparing a syllabus for Albany Academy 
to begin teaching in three weeks – it is also part of who I have always been – writing, creating – I 
am just doing it with a computer now days instead of pen and paper or paint and paper. This is a 
very peaceful and wonderful place perhaps I will find some peace within myself whilst here and if 
not perhaps I will at least retain some good images to review whilst in the middle of life and stress 
back in New York.  I have put photos of this place in the Sydney folder on our Australian 2005 
folder. Narda just observed that no one has met us (disturbed us) whilst here – the key was left [we 
had payed our bill over the Internet] and we have made ourself at home – all the cookery we 
needed is here, of course we had to get our own food but we are on our own. It is so much better 
than a bed and breakfast or a hotel.  For a few days we have this magnificent home in the Blue 
Mountains of New South Wales and this is our sole experience that does not need to be shared with 
anyone.

Tuesday, 16 August 2005 2PM

We came to Sydney last night and stayed in Kings Cross. This morning we went to Homebush and 
I put up a picture of Leigh where he died. Two-years ago Leigh had flown from Dodgertown in 
Vero Beach, Florida to Sydney to attempt to win back his off and on girlfriend, Veronica. They had 
been together for three or so years. I remember when he first met her in early 1999. It was a few 
days before Leigh went to South Africa with the Australian Under-16 National Team. When he 
came back a couple of weeks later he began his relationship with Veronica in earnest. We (Sacha, 
Leigh and I) were living in Christie Downs and Leigh and Sacha were at Wirreanda High School. 
Leigh was getting his first few recruits from professional baseball teams (Atlanta Braves, Arizona, 
Cleveland, at the time we were leaning toward Arizona), Sacha was getting more involved with his 
art and music and I was in my first years of my PhD. The future looked different than it has turned 
out but that is most of humanities fate – we only head in directions and destinations are often quite 
different than originally thought.

Leigh had not said anything to the Dodgers the afternoon he left. From his five-thousand words 
letter left on his computer and sent to Veronica his decision to go to Sydney was not premeditated. 
Though he did say he could no longer live without her. From what I have pieced together he 
booked his ticket and flew on his frequent flyer points the fifteenth of August. The night before he 
left he went with his Dodger’s team-mates to a game between the Dodgers and the Marlins. 

The Dodgers lost that game 5 to 4 in the 13th inning. Which meant that the Florida Marlins laid 
claim to sole possession of the Wild Card lead for the season.

Ramon Castro's walk-off homer off Paul Shuey with two outs in the 13th inning lifted the Marlins 
to a 5-4 win over the Dodgers, ending an exhausting 4-hour, 5-minutes marathon in front of 12,025 
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at Pro Player Stadium

 What thoughts were in his head during that game? I wonder if he knew that his life would end 
soon. That he would fly to Sydney and never return? Did he watch the game and realize that he was 
no longer interested in baseball? Did he think it was too far to go to get to the majors? Did he see 
the Dodgers as a losing team and that he was losing in life? It was a four-hour game in front of 
12,025 people in a stadium built to hold 36,331. The average attendance for 2003 was 16,290 so 
Leigh may have found he was alone in a huge place. I keep his Dodgers Member entry card on the 
string he would have worn around his neck next to my desk at home in Round Lake. It seems that 
if Leigh was of an ill mood which it appears he was, then spending so long at a game when his 
team lost and not many people were there would just have made him feel worse. The Dodgers lost 
the next night’s game too, 2-1 but Leigh didn’t go to that game, he was headed for Australia.

At the time Leigh was in rehab because of a sore shoulder but from the Dodger’s records he was 
due to go back into the pitching rotation of the South Georgia Waves. 

South Georgia Waves (A)
05/16/03 Leigh Neuage -- Placed on the Disabled List.
05/28/03 Leigh Neuage -- Reinstated from Disabled List.
06/09/03 Leigh Neuage -- Placed on the Disabled List.
08/14/03 Leigh Neuage -- Reinstated from Disabled List.

  Leigh Neuage -- Placed on Suspended List.
08/15/03 Leigh Neuage -- Reinstated from Suspended List.

From the Dodgers webpage of transaction of the time. When the Dodgers realised he had left the States 
without permission (he was on a five-year contract) he was put on suspension on the fourteenth and then 

apparently when he arrived in Sydney he rang them saying he would return and they reinstated him on the 
fifteenth but he had already died on the sixteenth in Australia which is a day ahead of Florida.

The Dodgers I spoke to said they took him to the game because he was very depressed the day 
before and they didn’t want to leave him in his room alone for the evening. Leigh took a limousine 
to Orlando,  and flew via San Francisco to Sydney. Veronica was in the Australian Pop Idol thingy 
– I think she was in the quarter finals. The contestants were staying at the Novotel across from 
Olympic Stadium.  Leigh asked for the highest floor room with a balcony and got a suite on the 
fifteenth floor facing the stadium for Veronica and him. The room had a lounge and a spa. From his 
credit card records, Leigh had something to eat at 12.30 AM. Veronica says she remembers Leigh 
waking her up and saying ‘I love you’ and she saw the clock at 4.30 – she thought he was going to 
the toilet and she went back to sleep. At five-thirty she was a woken by hotel management and 
police and asked to identify Leigh. Veronica would not say what was going on between them 
though I know they had broken up several times previously. On the day Leigh arrived – jetlagged 
and emotionally distraught and on a medication a Dodger’s psychiatrist had put him on (Prosaic) 
he had spent a lot of money on Veronica and she said he rarely spent much money on her or 
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anything – he had paid more than one hundred dollars for lunch and had paid for hundreds of 
dollars of CDs and pocketbooks for her… she said he was limp when she tried to hug him like he 
was not there and he acted all day as if was saying goodbye to her – his last photo on his digital 
camera was a photo he took of himself and it appeared as if had been crying. In his last writing that 
I found on his computer he had said that he knew since the age of ten that he would one day kill 
himself and I never knew this – how could I?  He seemed happy and he worked so hard to become 
a professional baseball player – it was his dream since at eight years old declaring that he would 
‘play for the Yankees one day’ – he played for the Dodgers instead but how would an eight year 
old know that someday he would be a professional baseball player? And especially in a country 
that instead of baseball played cricket, rugby and Aussie Rules footy (as Narda’s sons do and we 
go and watch them on Saturdays – last Saturday two of her sons playing in the A grade for 
Birdwood – beat the number one team, Torrens Valley – and her sons got third and fifth best on 
field).

I was working on my PhD, putting the final touches on what I had hoped would be my final 
submission of my 150,000 word thesis (August 16th, 2003 – and here I am finally graduating two 
years later) when Narda came in to my office at the University of South Australia and put her arms 
around me and said ‘Leigh is dead’. I hear those words a thousand times a day – words that will 
never go away. I live my life constantly holding back tears because as a male I do not know how to 
let them flow in front of others – even Narda, who I am married to and who has a master’s degree 
in counselling is not allowed to see them. 

We took the next flight to Sydney and flew Sacha over from Melbourne. Detective Ryan Malcolm 
met us at the airport and drove us to a morgue. I would easily say Detective Malcolm is the best 
policeman in Australia when it comes to compassion. He even went to where Leigh died last year – 
a year after the event – he said he would have like to have known Leigh as a person after he spent a 
year investigating and speaking with all those who knew him. Every once in a while he writes me 
and asks how am I doing. 

I did not give birth to Leigh – but I helped deliver him and I was the first to hold him – twenty-
years later I was the one to identify what I saw in front of me as the son I raised single-handed. The 
look on his face was of shock – perhaps somewhere in the two second fall he realised what he was 
doing was a mistake but it was too late. Leigh’s left hand was very damaged as was the back of his 
head which he landed on (his brains had been forced out – his brains had made him a skilful pitcher 
and he had received credit on the Australian Math exams and he was tested and rated in the top ten 
percent of people his age in intelligence but his brains were no longer contained in his head) but his 
right hand, his pitching hand, was not even scratched. It was as if he was going to protect that one 
part of his body that had gotten him to be one of the top junior pitchers of Australia (Leigh was 
junior South Australian sports player of the year for 2001 and world number one tennis player, 
Hewett, was the senior sports player of the year that year). His pitching had taken him to many 
places including South Africa when he was 16, the United States of America (Under 14 World 
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Championship in Saint Louis), Canada for the Under 18 World Championships, Taiwan for the 
World Cup in 2002 and of course his signing with the Dodgers when he was 17. Whilst growing up 
I was always concerned that Leigh had a life line that stoped in the middle of his hand – I had 
never seen that before. Sometimes something like that could mean a person is unhealthy but not 
Leigh. At six-foot-four and 210 points he was all muscle and seeing Leigh no longer there in that 
body that he had worked for so long on perfecting is a shock that will never go away. I had been 
told that at his rate of progress, Leigh was two-years from the majors. He was also on the 
Australian Olympic team that went to Athens in 2004 but he ended his life in front of the 
Australian Olympic Stadium a year before he had a chance to go. Leigh had it all going for him 
except for love and without that he no longer wanted to stay in the world. Leigh’s Dodger team 
mates at Vero Beach Florida and in Georgia had a moment of silence and tipped their hats to him at 
their next game and more than two-hundred people attended his wake at his South Australian club, 
Southern Districts and more than one-hundred people have written tributes to him in an online 
guestbook. From his emails I found in his Hotmail account he had a lot of friends and his Dodger 
team mates thought very highly of him. Leigh was loved by a lot of people but at the end he only 
wanted to be loved by one.

Last year when I went to do a memorial at Homebush Stadium in Sydney for Leigh it was cold and 
raining. I put up a picture of him and his baseball card and only spent a few minutes there. This 
year, again I taped his baseball card to the poll next to where he landed. It is a beautiful day today – 
sunny and warm. We only spent a few moments where Leigh landed then we got on this train 
where I am writing this on our way into the Blue Mountains to Katoomba where we will stay for a 
few days in a cabin. We didn’t stay at the Novotel last night because I thought it would be too 
stressful. The last time we stayed was the night Leigh died. I could only stay there one night then 
we stayed in Sydney until after we cremated Leigh. 

There were only six of us at a funeral service for Leigh: Sacha, Narda, Lesia her friend Peter, 
Veronica and me. We had an hour or so there and I forget the name of the place, it is where 
Michael Hutchinson of INXES fame was buried but it was an awful hour. We all sat silently with 
our thoughts. We had decided to play “I try” by Macy Grey, a song that made most of us fall apart 
– and it was suppose to have been played at the start but for whatever reason it came on – very 
loudly – half way through and played over and over, which made us all laugh and lightened up the 
moment for a moment. We had paid for flowers to cover Leigh’s coffin but they were put in the 
wrong hearse and did not arrive until close to the end. It just all demonstrated how dysfunctional 
our lives had been.

 [I had met the mother in Sydney at an astrological conference in January 1980 and we did not get 
along. She was in the States a few months later and remembered me and rang and said she had just 
‘driven across the whole country on the wrong side of the road’ and being the nice person that I am 
I said she could stay at my house in Baltimore, Maryland for one day on her way to NYC to some 
TM conference. I was in my last week in my house as I was headed to Hawaii to do an astrological 
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on-air thing – do not exactly remember what – and the only item that was not packed and sent 
already was my bed and of course we agreed we could not stand each other and sharing a bed was 
just because there was no where else to stay but somewhere during the night – after a bottle of 
something or the other – her leg touched mine or visa versa, and after a week in bed we drove to 
San Francisco and I put her on a plane back to Adelaide and I went on to Hawaii and after a month 
she rang me and said ‘guess what?’ and then she came there and Sacha was born and one day she 
made the statement that if I ever wanted to see Sacha again I would go back to Adelaide with her 
and after arriving in Adelaide she said I was in her home and that was it… then I started a tofu 
factory and a year later we went to the States for a visit and we had sex once that year (we never 
did get on with each other really) and that was in Detroit and that was Leigh then after he was born 
Sacha and Leigh and I lived in my tofu factory then we moved out to the country where we lived in 
ten different houses in ten years]. 

I started writing a story to my children about how we got to where we are in life on July 06 2003. I 
started writing it in Hamburg on our trip to Australia and continued it as we toured Korea, Hong 
Kong and I wrote in between edits of my thesis in Adelaide – a month later Leigh died and I have 
written in pieces for the past two-years, with it being about 120,000 words long so far. ‘Leaving 
Australia’ is a narrative that I currently have been using for therapy of a life of raising two boys in 
a foreign country by myself and how we got to that point. 

Whilst in Sydney, after Leigh died, I call her ‘the witch’, Lesia got stuck into me – I tried so hard 
to be social – even almost nice – to her – she began yelling at me – the morning of the funeral – 
something about ‘you kept taking me to court’ and on and on. I had to go to court – I was a foreign 
male that wanted my children and I was always fighting to have them. Not only that but Lesia was 
against Leigh playing baseball interstate and overseas – she thought it would affect his schooling – 
so I was constantly going to court for him but in the end I think he was angry with both Lesia and 
me – he said as much in his last writings. I use to be so close to him. For awhile I thought he would 
never walk because he was always wanting to be carried. Sacha was independent from the day he 
was born but Leigh was always at my side – that is until he met Veronica – then, and I did not 
mind, I was second. Then after he signed with the Dodgers he became gradually hostile toward me 
– and that was difficult. He said Lesia had told him I was just after his money which was a crazy 
thing to say as every cent I ever could get went toward him playing baseball wherever the 
Australian team was playing. 

A couple of hours ago when I put up Leigh’s baseball card on the poll next to where he died I 
decided that I had to stay at the hotel he last stayed at each year from now on on the 15th  and 16th 
of August. We are staying there on our last night in Australia before leaving Australia in a couple 
of weeks. I will be saying goodbye to both of my children then. Sacha is coming to Adelaide for 
my graduation on the fifth then at six-thirty PM he flies to Melbourne and at 6.35 PM we fly to 
Sydney so I say goodbye to Sacha then we will stay at the Novotel where Leigh last stayed and the 
next afternoon we fly back to Albany, New York – getting back at midnight Tuesday night and we 
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will be back at work at Albany Academy the next morning. 

And here I am on the train into the Blue Mountains. The last time I was in the Blue Mountains was 
in January 2001. I had met someone or the other on an Internet chatroom.

It was all very convenient at the time not only because I was a bit on the single side – having 
watched my six-year relationship with Chris (Kris) Noble end, without, at least my wanting it to – 
she had said “I need a break from you” and I did not know that meant ‘this is the end’ type of 
thing. Being the typical male I had not realised that when she wanted to go to house auctions and 
look for a house for us it meant she wanted to take our relationship to ‘the next level’ but I was so 
content on living with just Leigh at the time and perhaps that was not enough to sustain a 
relationship… so I flew to Sydney and met this girl I had been getting on ‘thick and heavy’ with 
online and what was so convenient was that Leigh was playing in the National championship 
games in Olympic Stadium (right across the Novotel hotel from which he took his final plunge) 
playing of course for South Australia. The girl, forget her name, lived in the Blue Mountains, quite 
a ways past Katoomba, where we are now, past Bathurst – the site of some famous car race, and  - 
well I don’t remember but it was a grand old small town and she lived in an incredible old large 
home. She collected me from the airport and took me to her home and the next day we drove back 
to Sydney to watch Leigh pitch and win against Victoria. It was the last time I would see Leigh 
pitch. I use to love watching him pitch – in the mid 90s per hour when he was 16 – striking out 
batter after batter. I have never seen anyone pitch like him – it was a complete ritual, you knew he 
was going to strike out the batter from the beginning – he had a unique way. Even when there was 
a championship game on the line – with Leigh’s team just a run ahead – bases loaded, three balls 
and two strike count he would move off of the pitchers mound, look around and know he was 
going to throw a fast ball right past the batter to win the game. I watched him do it many times, 
from Under-tens up through seniors when he was the youngest player to be playing in A grade. 
This is not a father saying that but many others who watched him said it too. He had a confidence 
that he would succeed that is rare amongst humans. Even when he decided he no longer wanted to 
live, he was not an attempted suicide – he was successful. 

I would throw one-hundred pitches with Leigh each morning before school from the time he was 
12. By the time he got to 16 I could no longer catch his throws and he would have me sit in a chair 
and throw a tennis ball – I never once caught his curve balls – no matter how hard I would try. And 
I got several black and blue spots on my arms and legs to prove I could not catch him – and that is 
with a tennis ball. With a baseball I would not have him pitch to me but we would do long throws – 
so far that I would have to bat the ball back to him as I could not throw it as far to get it back to 
him. But one thing I can say – about such an athlete is that even at six foot four and 210 pounds 
and with the ability to dunk a basketball (by the way he was an incredible basketball player) I, at 
the age of 54 beat him in a one-on-one game of basketball. [we won’t dwell on the fact that we 
played to 21, that he fronted me 20 points, that he managed to tie the score – with each basket 
being worth one-point, at the score of 20 and that somehow when I had the ball I threw a long shot 
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that somehow went in – giving me the win] I could beat him. I stoped beating him in track when he 
was about 12 years old but then again he got some South Australia State win in several track events 
by the time he was fifteen. 

Where was I? Oh! The girl I met on the Internet – one of those things people like to read about – 
sorry – no spicy stuff here – anyway that was the last time I saw Leigh pitch and the last time I was 
in the Blue Mountains (or saw the girl – though she was an artist who illustrated my children’s 
story ‘Wombat’ and for a moment we thought she would be my children stories illustrator) – soon 
after I teed up with Narda – and she met Leigh shortly before he signed with the Dodgers in 
February 2001 and one time, about the end of February because Leigh went to Spring Training in 
Vero Beach Florida at the beginning of March, we were together with Leigh and Veronica in 
Rundle Mall and Leigh and I bought some clothes that were picked out by our women (Veronica 
and Narda) and then we all had dinner together and that was it – until we were all together again in 
Sydney in August 2003 – except at that time Leigh was dead. Narda and I got married in May of 
2002 – I never told Leigh, he was playing baseball in the States but Sacha was there at our thingy – 
which I call Jettyday, as we did the deed at the end of a jetty in Adelaide and Sacha gave me away 
and Narda’s three sons were there and they [happily] gave her away. And Narda and I are one of 
those rare online meetings that got together and stayed together and here we are in the Blue 
Mountains years later. What amazes me is how much more I think of Leigh than before he died. I 
was always with him until he went off to the States to play baseball – except of course when he 
played in some International tournament – but when he was not with me physically I was not 
constantly thinking of him – I wonder if this is what others do when someone close to them dies – 
or takes their own life…  my brother died of AIDES and I thought a lot about him every day for a 
year or so and both my mothers died (I was adopted) but I never thought that much about them – 
but Leigh I do not have a moment’s rest from. I really do believe if he could have made it through 
one more week he would be playing ball now with the Dodgers. I have recurrent dreams that have 
him in it and it is always the same – he has made some incredible error in life and I am telling him 
that I will help him get back on track to accomplish what he wants in life. Then of course what is 
life? He may be so far from our silly little hopes and wishes. No one has come back from the grave 
– I do not care what religions say [Narda has two sons who are Christian ministers – so far from 
my sons who I shielded from Christianity after growing up in such a strict religious way] – and 
now with my current research into nano-biological-live-forever 

Current research:
1. GRIN’ s technologies: [Genetics, Robotics, Artificial Intelligence, and Nanotechnology (Joel 
Garreau)] impact on communicational evolutions; how will we translate meaning from sender to 
receiver if the  ‘decoder’ is inserted in the minds of but a fraction of society? An extension to my PhD 
thesis: ‘Conversational Analysis of Chatroom’  “talk” 
2. Philosophical clashes between longevity (the race to extend life cycles without end) ~ reincarnation 
and traditional Christianity.
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I do not know if it is worth living for a very long time when one’s son has found a different way. 
Are we kidding ourselves? I know Leigh was reading a lot on different religious thoughts 
[Buddhist as well as Christian and metaphysical] about afterlife before he died – I wish I could 
know of his conclusion, then again I do – he gave us his conclusion.  He had said that he was going 
go off a bridge in Florida but when he went out his door it was raining [this was a couple of weeks 
earlier] and he wanted to be able to be still and think about his final moments in peace and the rain 
stoped him and now forever that I am alive I will find my way to the spot that he left earth to not 
only celebrate his life but to grieve a life that at least to me seemed so confused he could not 
continue. It is not easy getting to Olympic Stadium – the train is out of the way – it was all build 
for the Australian Olympics of 2000 - and most people who stay at the Novotel get there by taxi or 
limo or drive there. And being in Sydney each year on August 16th is not that easy – especially 
when I live in New York. In August 2003, Narda and I were to leave on Monday, stop in Hawaii 
for a four-day vacation then go on to New York to work, me at Russell Sage College Troy, New 
York and State University of New York and Narda at Albany for Girls but instead we were flying 
to Sydney on Saturday and we never had our vacation in Hawaii. We arrived in Albany and the 
next day I was facing a class of twenty girls at Russell Sage College at eight AM. I was grieving 
and did not know how I could face another moment and I had jetlag from twenty-hours since 
Adelaide but that was nothing to what I was feeling about my losses. Now two-years later I feel 
just as bad. What amazes me is the level of survival of humans – some humans – they will go 
through such extraordinary circumstances to survive – we read about them in the news quite 
frequently – then there is Leigh – never did drugs, was strongly against alcohol – exercised daily – 
ran heaps -  lifted weights – was smart – listened to subliminal tapes [he even paid five-hundred 
dollars for one subliminal tape that he received before he died to help become a better pitcher: 
“Inner Talk” subliminal tapes have as their motto; ‘When Believing in Yourself Matters’ What Do 
Our Customers Say? And Leigh had been getting subliminal tapes since that age of eleven - http://
www.eldontaylor.com/what_our_customers_say.html 

Bedwetting, Nail biting, Breast Enlargement, Clean, Neat and Tidy, Baseball 

"I recently purchased an InnerTalk Baseball tape. My batting skills have increased quite a lot since 
using it." 

-         Leigh Neuage, (age 12), Australia.] and his direction in life was to leave this plane. Is there 
really anything more????

At my graduation, September 05, attended by Sacha, Narda, her parents and a couple of her sisters 
I will have one empty seat – the last time I graduated was in Geelong – Deakin University – Sacha 
and Leigh were at that – for my BA and wherever Leigh is there will be a seat at my graduation for 
him because the reason I did my PhD was to make a better life for my sons. And I know it sounds 
as if I focus on Leigh but I am as proud and really more so of Sacha because he has overcome 
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incredible circumstances – which I will not discuss in public – to be doing so well – much better 
than I would have imagined. He will soon surpass both Leigh’s being signed as a professional 
baseball player and my receiving my PhD. What Sacha is on the brink of accomplishing is really 
great. I will not say anything more except that it is in the field of music and art. 

This has drifted off from saying what it is like in Sydney. Gosh – great city – Blue Mountains - - 
take the train from Central Station and stay in Katoomba at Sidney’s Retreat. As far as discussing 
my life with my sons and so much more I will write it in my never ending manuscript ‘Leaving 
Australia’ – and I have begun a blog – with Leigh being the narrator of the story – he continues his 
life – he went to Sydney to end his life because his relationship with Veronica was at its end as 
another youthful relationship come and gone – he flew black to Vero Beach, got ‘right’ with the 
Dodgers – did his last couple of weeks with the team – went back to Australia to play for the USA 
winter and the Australian summer (why do I have to always live in winter? Going to Australia in 
the USA summer which is Australian winter) – playing in the Athens Olympic games for Australia 
– and low and behold getting Australia into the Silver Medal win – and on and on – as long as I am 
alive – or at least alive enough to write – Leigh’s day to day or at least sporadically written blog of 
his life will continue – it is the only way I can continue. I will be able to include whatever is going 
in the world within his story as I hate futuristic stories as we can not really predict the future as I 
have recently found out – we can only function within the future as it unfolds within us.
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●     Sunday, 21 August 2005 
●     Return to Albany to Adelaide to Albany via Europe and China BLOG  
●     UPDATED Photos see Sydney file in Albany - Adelaide - Albany    

Stayed at ‘Orchard Cottages’, ["Sleep to the sound of the ocean, wake to the sound of the birds"] 18 
Gipps Street, Port Fairy last night. A beautiful crafted cottage – we kept the fire burning all night. We 
looked at house prices for this ‘magical place’ (it said the locals called this place ‘magical’ in the tourist 
brochures) but everything was beyond our ability to buy a holiday home or a permanent home. The 
cheapest two-bedroom plywood houses that would be a few dollars and a handful of loose change in 
upstate New York were in the three to five hundred thousand dollar mark. We found an ad for the 
cheapest place available; $179,000 somewhere on the road to Hamilton in Orford. We could not find the 
road to Orford and ended up driving on very narrow one-lane roads that wound through the Victorian 
countryside. We gave up and realised why the three-acre property was cheap – it was impossible to find 
and the countryside looked like the west coast of Ireland. The area was originally settled by Irish 
fishermen and Port Fairy was originally called Belfast. We did the usual tourist thing at the Blue Lake in 
Mount Gambier – taking photos of one another in front of the ‘extinct’ volcano pool. I was here in 1992 
with my 87 year-old father and Sacha and Leigh and now he is 100 back in New York, Leigh is dead, 
Sacha I saw a few days ago back in Melbourne and … well … on we go.Tonight we are staying at the 
Lake Albert caravan park in a cabin, no where near as good as the one in Port Fairy, but on par with 
where we stayed two nights ago in Lorne. Tomorrow we finish our holiday within a holiday within a life 
that is nothing but a holiday if that is what it really is. I suppose it is all in one’s interpretation of life 
whether this life is a passing fun thingy or there is a purpose or we are all a bundle of cells either having 
a good time or not having a good time.Tomorrow we return our rental car and go back to whatever it is 
what we do seriously in life. For me I suppose it is preparing classes for Albany Academy and State 
University at Albany. Tomorrow, being Monday, means we only have two-weeks before we leave 
Adelaide and returning to Albany, New York. 
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Terrell Neuage and Narda Biemond trip 06

Monday, August 14, 2006 ~ 6:41:05 AM
●     Last entry before heading back to the States. This has been a bit of a challenge doing these 

blogs and videos as we traveled; especially in Viet Nam and Turkey but the world is more 
wired all the time so we have managed to keep up. Our next travels will be even easier as 
we do more on our computer phone and use ipodcasting for our journal – our ipodcast will 
be from here for the rest of this year then we will have our own network.

●     Leaving Wednesday for Sydney and memorial for Leigh.
●     We get back to NYC on the 17th then we are packing our belongings and driving a 26-foot 

truck with our stuff to Brooklyn to our new apartment. Moving from our large Victorian 
house in Round Lake to a small one-bedroom apartment in Brooklyn. HELP!!!

●     We will be looking after and visiting my father often – he turned 101 last April and is still 
going strong.

●     Next trip Christmas 06: Terrell in Sydney with Sacha for Christmas Day and Boxing day 
and Narda in Adelaide with family then we are both in Adelaide until January 3rd; to Las 
Vegas for a few days then back to NYC.

●     March or April we are taking a ten-day trip to visit Dell in Guatemala, our first trip to 
South America. 

●     June 2007 – we are buying our tickets for that today (we don’t let what is happening with 
the airlines slow us); Warsaw, Poland for ten-days; Scotland for a week and Narda is 
attending a musical festival-thingy with me in tow in Wales July 7th or so for a week then 
to Cambodia for a week and back to Australia for the rest of July and August.

●     We will continue to add videos on our youtube video site; begin using my (Terrell ) blog 
continuously, add the final videos (Sydney for August 16, 2006) later this August and 
some past videos to our trip 06 site, continue to add photos to our flickr site (slide show) 
and to our yahoo albums and work to earn money to pay for our travels.

●     I will be working on a book on online communication research methodologies with Jackie 
Cook (University of South Australia) and I will have notes as that continues as well as I 
am close to finishing my book; Leaving Australia which currently is much longer than my 
150,000 word PhD thesis…
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Albany to Adelaide 2006 ~ Neuage and Biemond

Sunday, June 18, 2006 Utrecht, The Netherlands – Rienk’s home
Last year’s travel-blog ~ http://neuage.org/05.htm 
 
(Thursday 15th June, sometime in the afternoon) I think we would say that our trip began with 
our flight out of Albany; though this is really a continuation of our around-the-world trip begun 
in Adelaide last September. This is a journey within a journey within a journey; with the overall 
journey being our life and each subset broken down to ‘this-moment’s-trip’. Nano-moments 
producing macro-memories.
 
After nearly killing ourselves with moving our large home’s belongings into a ten-by-ten, foot ‘it-
will-never-fit’ storage space – using every centimeter of the place with a few centimeters merged 
– we managed to pull the roller door down and watched our belongings disappear (with a slight 
crunching sound of merged belongings) and then we headed on down the road. 
 
Whether we will be able to open the doors when we return in a few months and collect everything 
to move to Brooklyn is an easy to forget momentary lapse – at least for a few months.
 
We had to be up Friday at 5 am so that we could leave our mid-town hotel and be in Brooklyn to 
meet with the board of our new apartment at 7. Leaving at 6 we managed front up at the right 
door at the right time to say the right things to get the right apartment for us. We now will go 
from our large Victorian home in Round Lake to a small one-bedroom apartment. So that was 
that min-journey.
 
I had an appointment at 9.30 for a job interview on 3rd Avenue between 87 and 88th street. That 
first interview led me to a second meeting in Queens; I had 40 minutes to make a 45-minute trip 
and somehow I did not get lost whilst changing trains and was at the door of my next interviewer 
at 11.30. From there I was sent to the Village for the third interview portion for the job and by the 
time Narda and I were on the way to JFK we were exhausted. 
 
The line at the Lufthansa gate was very long with soccer fans headed for Germany. They looked 
like soccer fans. Of course it could have just been my interpretation of a large number of people 
on our Frankfurt flight during World Cup soccer week all looking young and sporty. Perhaps I 
was just feeling particularly old and un-sportsmen-like waiting in line.
 
We left on time at 9ish and after impatiently gobbling down something they called supper folded 
my legs to fit into the cramped section we were given. I, as always got the Asian vegetarian 
‘meal’ though I wondered if the Lufthansa caterers had any idea that Asians – especially 
vegetarians – require more than a chopstick pinch of food. It was not long before I was eyeing 
Narda’s meaty serve and my coveting eye was rewarded with her salad and half of her desert.
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I think I fell to sleep not long after the final swallow. I had my earplugs in and my eye-patch 
blocking out the evening ambience of airline lighting. Somewhere over the Atlantic in the deep of 
sleep I was shaken awake by Narda, who told me she was dying. This was a most alarming way 
to be woken and was very disturbing news at the beginning of our trip! Once I was able to get 
fully awake and we found a large plastic bag for Narda to deposit the portion of supper I had not 
eaten we began to make headway. She was feeling really terrible and she did believe she was 
dying. She said everything was going dark and her head was spinning and she had lots of pain. I 
thought maybe she had food poisoning but I think we hit some very bad weather turbulence. We 
managed to get Narda to the toilet and she gradually began to feel alive again. We both managed 
to get a bit of sleep and by the time we landed in Frankfurt we were very tired and feeling better; 
or at least Narda was feeling better. I felt worse because I never got to feeling as bad as Narda did 
whilst over the Atlantic and I could only progress from feeling as tired as I was at the beginning 
of the trip. 
 
We somehow maneuvered our tired bodies through the airport and customs and on to the next 
flight, which by now was in the middle of the day, European time, and about three in the morning 
in our body clock time. We got to Amsterdam, worse for wear for sure, and on to a bus to Utrecht 
and into a taxi to Rienk’s house. Somehow we had enough strength to go bike riding into the 
center of old Utrecht. This was our fourth year in a row here and I was feeling a bit like I knew 
my way around. This is the second time we were here when Holland was doing well in football or 
soccer. Two years ago they were winning something and this year they progressed past the first 
round of the World Cup and the day we go to Hamburg this week, Wednesday, they will be 
playing the powerful Argentinian team (I only know this because there is little else in the news). 
As before, there were orange flags everywhere with ‘hup Holland’. Narda had on her orange 
jumper so we are quite the local folks. We got back to Rienk’s after 11 and slept well.
 
Now, Sunday, Father’s Day here, we are headed back to the center of town to find an Internet 
café then we will peddle off to one of Narda’s many family member’s home.
 
This has been the craziest time so far. This morning at Oom Rienk’s place I slept in until 11.00 
which was wonderful. Terrell is making up for some lost sleep in one of his power naps, which 
means I get to use the computer!  So in the last weeks we have left our jobs, moved out of our 
workplace, rented out our own house, and finished the final bits of renovation, packed up all our 
belongings, sorted them, packed, sold and stored them, applied for new positions with interviews, 
rented a new apartment in NY and planned our summer trips. Blimey. We are now both stark 
raving mad….or at least more so!
But  we are here. Yesterday our start to Holland was my favorite thing, pedaling into Old 
Utrecht. It was a warm evening, and so relaxing. I’m starting to unwind…trading a sore back for 
saddle soreness! Now I get to read my book.
We will be OK. One job between us is enough, but I’m sure we’ll find another one before the 
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summer is over. 
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Monday, June 19, 2006 Utrecht, The Netherlands – Rienk’s home
Last year’s travel-blog ~ http://neuage.org/05.htm Photos from Photos from first days (http://
neuage.org/06trip/06trip-1/index.htm) Previous thingy
 
Utrecht circularity (circularity = lostness + navigational miracles) and other 
insights, observations, experiences, thoughts…
 
Back in Round Lake we have our bikes in the shed. They are not the top of the range and surely 
not worthy of a photograph; then there’s the rust that they have been collecting; but they are bikes 
and as such were bought for the sole purpose of exercise and exploration. We bought them at a 
garage sale years ago and in the past twelve months we rode them once – around the village of 
Round Lake. We surely were not anti-bike, nor lazy as we spent our days racing up and down the 
Northway between home and work. We just never had time. After getting on the freeway at 6.45 
each morning and home too late in the evening we would work at renovating our home. On 
weekends we rushed around – I think we were renovating – we were too exhausted by the 
beginning of the next workweek to separate house work from school work from whatever else it 
was we managed to overwork ourselves with to think about the bikes in the shed. 
 
The reason they had rust was because of the time we took them out of the shed and had intended 
to ride them but did not have the time and we did not put them back in the shed and over the next 
months there was rain and sleet and snow and then the rust came. When we rented out our home 
last week we leaned the bikes against the car and put a cover over the car and bikes. So in actual 
fact they really are not now in the shed but are once again outside though covered from the sun 
and rain of upstate New York summer. I hope we will take them to Brooklyn and ride them in 
New York City when we return. However, we cannot keep them in our apartment, as there is not 
enough room. Whether we can rent a space in the building’s basement remains part of our over 
all inquiry of how we will keep even a portion of all our stuff with us. We just had a big purge as 
we began our downsizing from a large four-bedroom home with a parlor and all the rest an old 
Victorian home has to offer to prepare for the big squeeze into a small one-bedroom apartment in 
New York City.
 
That was a lot of verbiage to get to tell about our bike ride last night.
 
We had already had a long bike ride into the centre of Utrecht when we used the Internet Café 
yesterday. Shops are not open on Sunday in the Netherlands and outside of a few cafes bike 
riding is what there is to do. We do not have a house to renovate, we do not need to look for a 
home, we have no schoolwork to prepare, we have nothing to do but bike ride and that makes this 
a real holiday.  In other years we went on a boat ride with either Reink or Leen and Janny. This 
year Reink’s boat is in dry-dock whilst getting a new coat of paint. We may try our hands or feet 
– at those peddle boats and have a bit of a stroll down the canals at some point before we leave. 
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Because Reink, like most European males, likes to watch the football (soccer) and because we are 
Australians (even with my New York accent I am an Australian, by citizenship, though I would 
not fall into the ‘true-blue’ category) we watched the Australia and Brazil match. It was the first 
time Australia had been in the World Cup in some thirty years and the first time they had scored a 
goal in much longer than that was last week when they beat Japan 3 – 0. They lost 2 – 0 to Brazil 
yesterday but for my lack of football knowledge (American football is called gridiron outside of 
the States) it seemed that Australia played well – they ran around and looked quite busy though 
Brazil always looked like they had control – in other words they had the ball most of the time.
 
Navigational miracles
 

 It was after seven pm when we hopped on the 
bikes. Rienk said that after the second bridge there 
was a bike path that went along canals and rivers 
that we could follow. Perhaps we took the wrong 
path – there are so many bike paths in Utrecht. The 
path followed a canal but of course this is the 
country of canals – then we followed a river. We 
ended up in an industrial section and then came to 
an end because it was blocked off with a large 
fence so we turned about and followed another 
path. Then another path until it was almost dark. It 

was ten to ten and being the summer this far north the daylight is forever when we questioned 
whether we would ever find our way back home. We ended up on a dead-end in a park at one 
point then when hunger over took us we went to McDonalds looking for an elixir or magical 
healthy morsels so we could continue with our lostness. I am not a big fan of any fast-food place 
and the last time I was at a McDonalds was a year ago in Adelaide for an ice cream.  Narda was 
in hopes of getting a Dutch croquette. I had no great hope for much of anything eatable. 
Fortunately there were Dutch croquettes and I had a ‘reasonable’ vegetarian burger. 
 
We had spent more than an hour getting to where we were and we imagined it would take us 
another hour to find the right bike path back home. My bike riding is not all that great at the best 
of times but at least where we were – in some industrial type of area – there were no people to 
bang into. I had come close to knocking folks over earlier in the day. There are so many bikes in 
town and the streets are so narrow I do not know how people continue to keep from crashing into 
one another. Several times I could hear words directed at me but lucky for me I do not understand 
Dutch and I would frequently say ‘sorry’ which I am sure is understandable in most languages. 
 
Maybe it was the McDonalds food but in some miraculous way we were home ten minutes after 
eating. We could not believe it at first. We went a different direction than we had gone so far – 
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following yet again another canal on yet again another footpath. We went from the industrial 
section, past a very large public school and suddenly there were suburbia streets and after only a 
couple of blocks there was our street. 
 
We get lost wherever we are and we just pretend that that is how we explore the world instead of 
saying we always get lost we just say we are exploring or investigating or some such thing. I 
should not speak for Narda so I will claim sole-ownership for my lostness – even back in Albany, 
after living there for four years I am constantly getting lost. I lived in Adelaide for twenty-two 
years and it became a daily occurrence – getting lost. I have even developed my own spiritual 
version of where I am (I am where I am and I am not where I’m not and I am where I am because 
it is where I am to have the insights that I will have where I am at within that particular space in 
time – it is a subsection subset section of Terrellism). Nonetheless we were on our street and we 
even discussed all this in detail and realized that we could not find our way back to McDonalds 
the next day no matter how we tried to retrace our steps. Of course it was not the re-finding of 
McDonalds that intrigued us but the realization that we could not retrace our steps, period. 
 
We even discussed theories of lostness and how we found ourselves within our lostness.   ( LIT - 
 lost in theories) 
                        
Theories of lostness: Part 1 – the Utrecht phase (no doubt there will be the 
German phase as well as the Istanbul and the Viet Nam and the Adelaide 
phase of lostness to theorize in regards to.
 

1.  The bikes that we were borrowing had homing devices and they brought us home with out 
our intervention (this was Narda’s thought),

2.  In the holographic universe that we live in everything is contained within a slice of the 
moment and the path of the past is contained within the path of the future which is really 
the path of this moment (my errant thought),

3.  I have lived here in another life-time and naturally, sub-subconsciously, at a soul level, 
knew my way home because I followed the Self’s within perfect direction and if I were 
regressed (not that I have never regressed in my daily, momentarily lapses of reality 
before) by one of those chanellers one reads about in weird books and magazines it would 
be discovered that I have lived here in another life time. (I suppose I should take credit for 
number three),

4.  Alien abduction…We were whisked away into a parallel universe of virtual reality (where 
several parts of former mes clamor for attention) – actually I got a bit lost with this concept 
so that is probably not the solution to the foundness of our lostness,

5.  Now that I am experiencing my second Saturn Return (in my tenth house at that; as transit 
Saturn has slugged its way through Leo and passed over my Mercury, Mid Haven, Venus, 
and now it sits on my Saturn/Pluto conjunction as it prepares for the onslaught to my Sun 
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square Jupiter – anyone needing some extra Leo – I have always had too much to begin 
with and I will be auctioning off planets in Leo later this year… at my first Saturn return I 
went through the alleged spiritual Self Realization initiation; brought into that ancient 
concept by the cult pseudo religious order, the Holy Order of MANS, in 1976) it is time 
for something significant to happen in my life such as finding my way for once,

6.  We were lucky…
  
It is raining this morning so whether we go bike riding today remains to be seen.
 
There is little I can add. Except to say that the guy we swerved and wobbled to miss asked us 
rather rudely in Dutch if we were awake yet. I suppose he could have said much worse! Last 
night I visited Tante Nel at their place and we had a glass of advocaat. Today’s a bit rainy, but 
who cares. We  have no schedule; that is such a lovely state to be in. The one scoop ice cream for 
1Euro is something you can’t buy in the USA. The serving sizes and 3 times larger there. Same 
for coffee.
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Last year’s travel-blog ~ http://neuage.org/05.htm Photos from first days in Istanbul Previous thingy
  

 

Istanbul ~ First Impressions 
 

 
 
I’m sitting on the bed at Hotel Poem in Istanbul. The window is open, it’s 10pm and the sounds of Turkey are 
coming in through the window. I can hear some singing, an instrument a little like bag pipes without the drone, and 
a drummer of some kind. Nothing matches: it’s so exotic, I don’t want to close the window, even though the 
occasional mozzie is sneaking in. 
Istanbul is an amazing city of 18 million people. Today we visited the Blue Mosque, which is just a few streets 
away from our little humble hotel. The tiles in the mosque are exquisite; all blues and fine patterns. In the 
afternoon we discovered the Grand Bazaar, and got pretty lost going through it. I bought a little recorder from a 
street vendor; my first (in Turkey) attempt a bartering. We enjoyed a ferry ride over the Borphorus to the Asian 
side. Tonight we’re just taking it easy. It sure is nice to be able to take a nap when you feel like it, read a little, 
eat great Turkish food in cheap restaurants. We both love the Turkish food. Tonight we tried our first apple tea: 
very good! Terrell drank a whole glass of very sour yogurt drink: probably an acquired taste, though better than 
the over-sweetened American version. We have had many carpet sellers offer to show us the most beautiful carpets 
in Turkey. Not sure how they make a living. We have yet to see anyone buy one, though they are really nice.
 
We were upgraded to business class for our trip from Hamburg to here. That was a nice surprise, they said it 
was because of our Economy Premium membership. We felt like Lord and Lady Muck. Two days with Mau was 
just wonderful and getting to meet her little baby, Johann.
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My favourite story in yesterday’s media was about Turkey cracking down on under-age camel jockeys. There had 
been more than 1400 arrests over the ‘camel scandal’. The legal age is 18 and many jockeys were underage with 
the youngest being four-years old. “Yo Mabel doesn’t that jockey on camel number four look a tad bit old?’ Gosh 
darn nothing like trying it on. But that is where we are. A dude tried selling Narda a flute for 25 Liras but she got 
it down to 8, though she could probably have done better. I have been temporarily banned from the barter fun since 
last year in Beijing when someone tried to sell me a shirt for some 20-somethings and I said no and walked away 
and was chased and harassed and after a fierce barter exchange paid 30-somethings and proudly walked off with 
my assumed ‘great deal’ until Narda pointed out that I had paid ten more than the starting price. Of course this 
was months before I graduated with my PhD and surely I am smarter a year later or at least I can ‘doctor’ the 
situation a bit better but I a bit reluctant to have a go quite yet.
  
Warm – perfect weather. Took a boat ride and train ride and Narda bought shoes and we took heaps of photos. 
Today we are going to museums. Tonight we will stay up late and cheer for the Netherlands in the World Cup.
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Monday, June 26, 2006
06 Blog Home ~ Last year’s travel-blog ~ http://neuage.org/05.htm Photos from Photos from 
Previous thingy
 
Hotel Poem is not bad for a budget priced hotel. Not sure about the poem part, I have yet to write 
a poem. We are in the ‘dagger’ room – not quite sure of that either. The room is smallish and the 
sounds of Turkey are loud and clear outside: call to prayers (was that three am when they were 
trying to wake the infidels with their chants?) but it is good in many ways. Breakfast is free and 
good we are in the Old Section of Istanbul with lots of hotels and restaurants with lots of English 
speaking tourists. It seems everyone who works in this area speaks English as well as several 
other languages. Narda has had a couple of conversations in Dutch and there are many other 
languages floating around though I am not sure what they are. The merchants are quite fluid with 
their sale pitches in English. We are in the rug centre that is for sure. 
 
When we first got out of our taxi I thought we were on a movie set. The cobblestone streets and 
outdoor cafés, restaurants, rug shops and Turkey men everywhere hustling their rugs, postcards, 
food – always ‘this is the best…in Turkey’. I was looking around for four-year old camel jockeys 
as there is a crackdown on underage camel jockeys at this time and the legal eighteen year old 
limit has been compromised with younger and younger jockeys (down to four –years old as 
written about earlier (see June 24). The local sounding music (I heard the belly music stuff but 
my male fantasy-orientated-searching-eye could not locate it though I know there is some 
shenanigans going on somewhere) mixed with the singing call-to-prayer voice and 1960s rock 
from a place called ‘Cheers Bar’ surely was a movie set from something I had seen before. 
 
We did the old fart thing yesterday and went to a museum, some palace, and a mosque or some 
sort of place. The view was really great of the harbour and city. We do museums really fast. I 
think we would drive others nuts. We surely could not do a guided tour as we are too impatient. 
Who remembers all the stuff that is said anyway? If I don’t know what something is I just make it 
up. When you see a room full of daggers and a room full of thrones and jewels does it matter 
which dude wore what and when? 
 
Most local women just wear a scarf over their head – Narda had to put one on when we went into 
a mosque. There was one moment I was a bit concerned about. We were having a bite to eat at an 
outdoor café and next to us was a woman covered in black from top to bottom – though she had 
Nike sneakers on she was dressed in full-on local stuff. There are not a lot like that but enough to 
really upset Narda and of course the women walk several steps behind the men which does not 
make sense considering the men wear shoes and the woman with Nike sneakers surely could have 
done a runner. At the café Narda said she was going to make a difference and the ‘time had 
come’… and she was going to ‘shove the man’s head into the table’ and gosh I was getting 
nervous but luckily I suggested we go look at shoes (not really that is just as sexist as the man 
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with his woman in tow at the table next to us).
 
We watched the first half of the Dutch soccer game and realized they would lose and it was 
midnight so we did not find out until this morning that they lost one to nil. Tonight we will cheer 
for Australia as they get thrashed by Italy. 
 
Because we live in the rug area and get harassed or chatted up constantly to buy something it was 
only a matter of time… Narda has wanted a rug to cover a table since we came here but our 
budget is like $50 US and what we like starts at one-thousand something before the hardcore 
barter stuff happens. We got lured into the first rug-den and of course I wanted to leave from the 
word go and Narda had already suggested she should be the one who barters as I don’t really 
have the stomach for it and I have not done well in the past (I start feeling sorry for the person 
and their family and extended family and the underfed goats and so on) so I balanced from foot to 
foot as Narda and the merchant went head-to-head. I was thinking about the importance of my 
webpage and some new ideas I had for the Internet and mobile technology and Google-brain 
implants but Narda thought the rug thing was more important than our rushing back to our laptop 
for me to write up my latest technological concepts. I played with my new T-Mobile computer-
phone converting their money into Australian and US money and getting more worried and tried 
to make my Excel spreadsheet say we were spending a lot less than we have been and on they 
went. Soon there were a hundred or so rugs spread out on the floor with a dozen ‘favorites’ 
draped over things. We were told about the artistic quality and the place they were woven and the 
goat’s name or sheep or whatever the wool was from and so much more and I just continued to 
play with my computer-phone and off in the distance more rugs were appearing and suddenly it 
was all over. Narda said we were leaving and I sighed a relief when I saw no big buddle under 
her arm.
 
We went to another rug place and it started all over. Rugs all over the floor and this time we were 
offered apple tea and the merchant said that Dutch women were very beautiful and I was 
fingering my phone-computer thing wondering whether I should make a mobile webpage as an 
SOS signal but then I got dragged into the conversation. I think by the time we left we were 
within five hundred dollars of our goal. 
 
We decided that maybe a rug was not what we wanted (I wanted a new laptop instead) so we 
looked at table covers and got one and got it marked down a lot thanks to Narda’s ability to get 
things marked down a lot. And that is our rug story.
 
Today we are going to the new area to see what a normal Turkey day looks like and then we will 
spend the next couple of days going to Princess Islands to swim in the Black Sea or some such 
place.
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Cheers
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Australia loses to Italy in the World Cup ~ travel adventures of Terell Neuage and Narda Biemond in Istanbul

Tuesday, June 27, 2006  06 Blog Home ~ Last year’s travel-blog ~ http://neuage.org/05.htm ~ 
Previous thingy
 
We thought we had enough of the old stuff and decided to see how the rest of Istanbul functions. 
 
Took a bus into the ‘new area’ then a subway to some large modern shopping centre. We are 
consumers at heart. I know I would prefer a Walmart to bartering any day though Narda likes the 
barter world.
 
They have a short subway here – I think it was six stops on one line for the whole system. Quite a 
production. New York City should have this much precaution; bags get scanned and checked, we 
have to walk through an airport type scanner and past the bored looking police clutching their 
machine guns. After all there is a world war happening though I think we forget at times. The 
subway is clean and we get off at the stop in the midst of a shopping centre and we go through 
scanners and checks to enter. There was nothing special about the place, it was very Western, not 
many people and it was huge. There were the movie theaters (the Di Vinci Code is playing which 
seems out of place here) prices are higher than in New York. We had coffee that cost twice as 
much as our little backpacker type area in the old section where we live, and with our coffee in 
the old section we got cake too for half the price of the shopping centre. Narda got headphones 
for her iPod and that was it. We did check the shoe sales but there was nothing worth adding to 
our collection (well one of our collections and it ain’t mine). On the way back to the bus after 
going through all the scanners to take the subway I was hustled into getting a shoeshine. I thought 
it would be one or two lyres but the boy, on summer holiday and last claiming to have had a shot 
at the eighth grade where he had learned enough English to want to polish shoes, wanted, firstly 
50 then 15 lira (about $8 US) and I said no way and thought to offer him ten which was still to 
much. He was not happy with that but fortunately Narda had my wallet and was in the nearby 
post office so I went to get her and explained the situation and said I would give him ten. Narda 
said “no way” and she gave the boy a strong speech (talk about a scolding from a school teacher) 
and the poor chap was really quiet and looked embarrassed and Narda gave him five and sent him 
off with a “that is much more than you should get”.
 
Back home, in our little section that we are really feeling at home in we got a seat in the street in 
front of a large TV and watched the Australian vs. Italy game with lots of other Australians. 
There were two large Australian flags on the outside wall (there was no Italian representation). It 
seemed like a good game. After thirty years of trying to get into the World Cup here was 
Australia in the second round facing Italy. They controlled the game, had possession for most of 
the game and it got to full time at 90 minutes with no score and five minutes was added on. As 
the five minutes wound down to the last seconds an Italian player tripped and fell over an all 
ready down Australian player and the Italian was awarded a free kick. The free kick was meters 
in front of the goal, the Australian goalie did not stand a chance. Then it was over and everyone, 
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even the Italians seemed stunned. There was not the immediate jumping around as one does when 
they kick a goal. It was really a hollow victory. Everyone knew that it was a bad call and with the 
replay it was obvious the Italian player never touched the Australian but tripped over his own 
feet. 
 
I do not really like sports competition much anymore and this really cemented it for me. Narda 
and I have gone for the losing team three times in a row with this World Cup trip; America, the 
Netherlands and now Australia. Having spent so many mixed emotions with Leigh and his 
baseball career I really do not find joy in sport competition. I think there should be just individual 
sports competition with the person competing against themselves. For example, “Today we have 
the latest Terrell, age 59 competing against Terrell of the 1960s (if you remember he was a bit 
wobbly in those days and there are those persistent rumours to the reason for those wobbles. Was 
his sport really ‘enhanced’?) and the Terrell of the 1980s when he was a single parent with two 
boys. Which Terrell will get the gold? That is the way it should be – not against other people. I 
feel so sorry when someone gets sent off the field and I hear the cheers from those around me if 
he is on the other team. I remember when Leigh would have a rough patch in the midst of a game 
and how bad he would feel after which would make me feel bad. These are young men doing 
their best. You see the tears in their eyes when it all comes undone or in Australia’s case when 
they lose after playing the better game because of a bad call. There are young men just like this 
being killed in Iraq. Why do we do this to our youth? Sitting outside there with a crowd of 
Australians and Americans and a scattering of Europeans I did have my occasional paranoid 
thoughts. We are in a world war. We are in a country that borders Iraq and this is a Muslim 
country with a lot of people that are not that happy with the west. One would be forgiven for 
thinking that everything is fine. The merchants are happy with showing their gear and we have 
lots of laughs with the local hotel and restaurant employees but is it all a ruse? We are sitting 
outside on the sidewalk on a narrow street. I started watching cars that went slowly by. If 
someone wanted to make a statement about Iraq (America’s war they say in these parts) we are 
sitting ducks. I felt uneasy in the Grand Bazaar too – I will stop watching the news and enjoy our 
stay here. We go to Viet Nam in a few days then we will be out of this particular conflict and 
visiting the scene of a previous one, though that conflict was not a world war. The last world war 
ended with a couple of large explosions and things are headed that way once again.
 
That was all quite grim. Another sight that I thought was interesting was young boys that are 
dressed as sultans being paraded around. We were informed they dressed that way on ‘their 
special day’. Like a wedding we were told. In actual fact it is the day of their circumcision – I 
think I will leave that at that.
 
Today we are going to one of the Princess Islands and have a bit of a swim. Narda has managed 
to read two books and I have only gotten through the first part of “For Tibet with love” by Isabel 
Losada. 
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I am still trying to get my mind around the currency here. It seems most stuff is in the millions. 
For example 5 million lira is about 22 dollars US. It is comforting to be a millionaire even though 
it is not really so in US currency. 
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Wednesday, June 28, 2006
 
Yesterday we decided to take a trip out of town. We caught the ferry for a ride to The Princes 
Islands which is a group of 4 islands in the Marmara Sea, not far from Istanbul. There are no 
cars allowed which makes them interesting, so you see horses and carts delivering stuff, and 
tourists riding on the coaches drawn by horses. It’s been perfect weather here. Blue skies and 
lovely evenings. We are really relaxing. 
The other night we sat in a café watching the soccer; Australia loosing to Italy because of a bad 
call by the unpire. Pretty upsetting to the Aussies; there were lots watching with their yellow T-
shirts.
We are enjoying the food too; and the sour tasting apple tea is just great. This morning we 
checked out the St Sophia museum, which is a huge domed church/mosque/museum dating back 
to 300AD or something like that. They have a huge scaffolding set up in the middle as they 
restore it, and remove plaster which reveals ancient Christian mosaics. So here we are back in 
our little room, taking another nap!
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Friday, June 30, 2006 06 Blog Home ~ Last year’s travel-blog ~ http://neuage.org/05.htm 
Previous thingy
 
Ho Chi Minh City - Tan Binh District
 

Vietnam; first impressions. Busy roads filled with 
people and families on little Hondas, all driving with no 
helmets and seemingly minimal road rules. Then at 4ish 
the monsoonal rains begin, cleaning up the dusty 
polluted air. Everyone has rain ponchos on, even when 
they are driving their little motor bikes. Our hotel is 
sensational, a resort near the airport; but we shop for 
water, snack, and meals in the neighbourhood; the local 
joints. Blimey the restaurant tonight….this was on the 
menu. I kid you not!!!
 
Steamed fallopian tubes
Braised chicken testicles
Grilled (live…meaning fresh, we think) turtle

Crispy fried sparrow
Cobra blood mixed with liquor
Grilled lizard in mountaineer style
Cat entrails with bamboo shoots
BBQ snake head
 
I can see some of you shaking your head and saying this is an exaggeration, but no, it is not!
I ordered spring rolls, which were very good, but after a while the smell of unidentifiable food 
started to get to us, (to me it smelled like poo) so we did not finish our dishes.
 
Now we are back in our safe western luxury hotel, suffering just a little from culture shock, but 
feeling good all the same. The things that make this less strange; plenty of French sticks 
everywhere, the use of our alphabet, the lovely bakeries with French goodies …chocolate éclairs, 
macaroons, good stuff. It also helps that is very cheap. Our meal tonight set us back under $5 
(US) and that included beer (Tiger of course!)
People have ready smiles and it’s rather exciting and so very exotic.
 
Saturday, July 01, 2006
 

We slept until nine am, which was a good catch-up to time 
zones and hours missed getting here from Istanbul. There 
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was a stop in Dubai for westerns to take pictures or spend 
money or well I am not sure why.  There were plastic 
everything including big palm trees at the airport. 
 
It was easy getting to our hotel in Ho Chi Minh. We are still 
trying to figure out the money – millions of things equals a 
few dollars US. Actually 30,000 local dongs equal $1.88. It 
cost about three dollars via taxi to our hotel. We chose to 
stay at the Novotel to make an easy transition and it was 

worth the extra few dollars. We seem to be surrounded by local homes, which I suppose 
westerners would refer to as slums but they are not really. 
 
The people are so friendly they stop and wave or just have the biggest smiles. ...unlike China on 
our last two visits where everyone looks grouchy.  I am writing this listening to our CDs we got 
at 9000 a piece, big bucks for sure until I calculated they cost about fifty cents each. Listening to 
Credence Clearwater – the pirated version. We bought eleven CDs.
 

Pet stew
Narda wrote about last night’s dinner – I had the deep fried tofu but only ate half of it. There was 
a diseased looking dog wandering around and sniffing everything and the place really smelt 
different than what we are use to. I must admit the cobra blood casserole did sound tasty and the 
monkey testicles – wow I almost thought of stopping being a vegetarian.  We did see some 
unfortunate animal strung up slowing being barbequed on one of our side street walks though we 
could not determine what it was; too big for a fowl, too small for a pig, a body of a dog for sure. 
When we were in Turkey there were so many stray cats – we haven’t seen a cat in our first two 
days here. Narda was really unsure what was in spring rolls but I am sure I heard an ancestral 
meow as she swallowed.
 
We did our usual wanderings and getting lost down streets no western tourist had ever been. I 
bought a new computer bag for an equivalent $8US and we got a few other things. The streets are 
almost impossible to cross, as there seems that there are no traffic laws. A few times today we 
were escorted across a five-lane street because we stood fearful on the side looking like deer 
caught in headlights. A couple of years ago in Guangzhou it took us three days to get the courage 
to cross the street across from our hotel – even at the crosswalks no one would stop. Finally we 
took the courage and using a group of Chinese as a human shield we got across and took a dinner 
cruise on the Pearl River. In Beijing there were overpasses for pedestrians as they are trying to 
get ready for the Olympics.  Here, forget it. We had one man on a motor scooter go straight 
across all the traffic with us alongside him. A couple of other times we were escorted through 
traffic. I think the trick is to just walk across and the motor scooters dodge us instead of us them. 
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Sunday, July 02, 2006
 
The bus to the Pandanus Resort took four hours. We took the Sinh Café bus which cost 100,000 
dong or about $6.30 US bracket for two tickets for four hours of bus riding through Viet Nam. 
We got a million plus dongs yesterday (making us millionaires for a moment until we realized it 
equaled $US63. The thing to be careful about aside from keeping track of the large amounts is the 
better hotels (we are at a four-star resort) put everything in US dollar, for example the Pandanus 
Resort charges $100 US for a trip to Ho Chi Minh City per person in their mini-van, 96 dollars 
more than what we paid. Everything at this resort is priced in US dollars and we are a bit trapped 
here for six days. A beautiful place to be trapped for sure but we have to eat here as it is too far 
into the nearest town so this could become more expensive than we had thought. We will take a 
taxi to Phan Thiet – a rather interesting looking town (the guide book says there more than a 
million people living there) – about fifteen minutes away tomorrow or the day after. 
 
We are getting adept at sign language. We are trying to get the staff to understand we need coffee 
cups after spending the longest time to get someone to understand that we wanted coffee. Now 
Narda has just drawn a picture of a coffee cup, which got the staff to laughing a lot.
 

 
The resort is rather nice – large comfortable luxury room and a beautiful beach. We are not 
exactly slumming it – just on holiday within a holiday. We have a great balcony looking at the 
beach and South China Sea. It is really hard to imagine this place was at war a few decades ago. I 
am sure in another couple of decades tourists will be visiting Iraq once again.  We are here for six 
days and I plan to get caught up on swimming and the gym and work on my never-ending story, 
‘leaving Australia’ which passed my 150,000 word PhD thesis years ago. I think it was 250,000 
words last count – right up there with the dong in numbers for sure.
 
Even the package food is difficult to figure out. We bought a box of cookies and there was the 
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usual ingredient percentage on the box. However, they added up to 80% so we could only guess 
what the other 20% was.
 
Went for a lovely swim. Currently Narda is on the phone trying to get towels from housekeeping 
and of course one can imagine how hard that is to get across. I think next time we come here we 
will bring a phrase book.
 
The weird thing about this resort is that there are only a few people staying here. There is more 
staff than guests. We ate at the restaurant – being a bit trapped within a resort and all – and there 
were like five other people this evening eating and there were seven or so waitresses and the like 
hovering. The meal was a bit disappointing; Narda could not chew the meat because it was too 
tough (and we did not want to philosophize about missing pets), I got crab in a shell and rice and 
needless to say we left hungry. Luckily there was a deli of sort across the road from the resort. 
We are really out in the country with not much within viewable sight but there was this one place 
across the road. We pointed at what we wanted and left. At about ten pm being hungry still we 
went there again and there was the same person but we noticed that she was preparing to go to 
sleep with her baby on a mat on the floor behind her counter. Nevertheless we look forward to 
our week here and the fact that we are probably just about the only guest at a large resort does not 
bother us. Viet Nam is very new at all this having just gotten freedom from a somewhat brutal 
communist regime in the last few years and of course all the wars the place has been in. The 
resort could rival resorts in Singapore and Hawaii; it is new, beautifully laid out, tropical, large 
swimming pool, health club (though the weight machine does not work and I had to find someone 
and point out that the pulley was broken and of course no one quite knows what to do about it) 
and very friendly staff but there is not anyone who knows more than a handful of English (Narda 
didn’t try Dutch that would be just too confusing) and it really seems a lack of how to do the 
resort thing amongst the staff. I had expected Internet in our room like in China and Singapore 
and Ho Chi Minh City but there are only two old computers and the Internet is very slow and I 
could not use my flash card that I am doing these pages on so I have no idea when I will get these 
pages onto the web. I think if they let Narda and I market this place we could make some minor 
changes and sell it to Australia as a safe destination that is cheap. Of course a four-hour bus ride 
to here is a bit difficult. I think we complain too much. It is Sunday night and the place is quiet 
(well there are five people in a resort that has hundreds of rooms and many cottages). We may be 
putting notes in the suggestion box that sits on the front counter tomorrow. Though we should 
have our comments translated into English first. 
 
Just turned the telly on and there it was: the Crows thrashing Geelong in Aussie rules footy. 
Sitting here in Central Vietnam watching some football seemed pretty weird.  Not sure what to 
expect these next few days. I’m reading a great book now “She’s come undone” by Wally Lamb, 
so who really cares. A nice beach chair and time to burn is the real luxury. Last night at the 
shopping mall near our airport hotel I ordered fried rice and German sausage in a place that 
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also sold pizza. You’d think that would be pretty safe. It tasted OK, but smelled strange and I felt 
sick and couldn’t eat it. Hard to banish those images of cobra blood drinks. 
 
The people are very friendly and smile easily. Perhaps we do look a bit of a sight…too tall, too 
pink…..and they are just laughing at us. Terrell was told the other day he looked like Al Pacino. 
Reminds me of the time in Bali when my blonde Brendan, in his high school, long-haired days, 
was told he looked like Bob Marley…now there’s a stretch!
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Monday, July 03, 2006 06 Blog Home ~ Last year’s travel-blog ~ http://neuage.org/05.htm Photos from Photos 
from Previous thingy
PHOTOS FROM TODAY
 
This morning started off fine and sunny. We had a good breakfast; bit of everything, water melon juice…nice, 
despite Terrell’s misgivings and my terrible curry last night where the beef was as tough as leather. So we decided 
to walk to Mui Ne, a nearby fishing village. It was a decent walk, pretty hot and very rural. There was also this 
smell…not sure ...could have been the off shore fishing boats (very colourful, check out the photos), or some 
dead animal. Still, folks have ready smiles and we made it to the village. We took our first ride on the back of a 
little Honda scooter as the taxi ride back…one each: fun! The guys even rode along side one-another so we could 
chat. That’s it so far, Terrell’s taking a nap and I’m about to start another book. It’s raining buckets outside now, 
but still pretty hot. 
The amazing thing about this large resort is that there seem to be hundreds of employees and few guests. Perhaps 
this is a quiet time of the year, but it’s hard to see how it can be viable. The facilities are pretty amazing, 
beautiful pool, stunning foyer, and huge grounds right to the beach.
 
So we ask at the front desk about taking a bit of a walk to the nearby town. Between two staff we all piece 
together enough words to believe that there is a small fishing town called Mui Ne though the staff with their four-
point-two words of English seem doubtful or rather they portray doubtfulness in their body language as to why 
we would want to go to Mui Ne.
 

                                        Narda’s new bag

No worries. I had a picture of Rockport (Massachusetts) or Glenelg (South Australia) or 
some such quaint boaty type of space. We can see all the fishing boats in the bay from 
our balcony and we just assumed that the fishing village would be along the shore 
somewhere around the next bend or the next one after that, or even further up the road. I 
think one of the staff said it was 25 minutes away (surely he did not say 25 kilometers 
as I began to think when we were well on our way). We bought sun cream from our 
friendly lady at her little live-in deli across the road. She has a very lightly stocked 
store; a few cans of beer and soda, a shelf with a few boxes of cookies and chips and 
three shelves full of spirits (rum, vodka and the like). It is not really a pub as there is no 
place to sit down but I assume one could have a cocktail before motoring on down the 
highway or just purchase a large bottle of vodka and drink all the way to Phan Thiet.  
She had a few handmade things on a rack and Narda picked up a great little bag for 
50,000 dongs ($3.15). 
 
After the first bend we came across the next resort, the Malibu Resort. It is older and 
probably a couple of stars down from where we are but we are not precious-stuffy-elitist so we wandered in. It 
was quite charming and we looked into one of the guestroom and it is surely adequate and we could comfortably 
stay there. We checked out the dinning room overlooking the sea and the prices were in dong and about half what 
they are where we are staying so we will give it a go for dinner tonight. 
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We wandered on down the road around a few more bends. We were definitely in the rural area (something 
customs will ask us when we get to Australia, ‘were you in any rural areas of Asia’) and the poverty is just like 
one would see in one of those documentaries on a third world country’s impoverished countryside. Families living 
in what would barely pass as a chicken shed in a western world. And of course the local chickens or turkeys 
or whatever the scrawny fowls are look like they have Asian flu though I am not quite sure what it would look 
like. The smell was quite bad in some places, perhaps some dead animal that did not quite make it to the dinner table.
 
To make a long morning’s walk description short we got to a road crossing and still no town and some 
dangerous looking characters pointed to the right so we wandered more. We came across what looked like a café 
and managed to convey that we wanted a soda and lots of people smiled and said ‘hello’. Soon we were in a town 
that looked like an American Wild West movie only the shops were selling mobile phones amongst I have no 
idea what. In the centre of town we must have looked like aliens. Narda has seen similar settings when she was 
in India but it was new for me. There was an extended moment where we managed to frighten ourselves when one 
of us questioned our safety. After all we are westerners in a very poor communist part of the world who were at 
war with Cambodia not long ago, and before that with the Yanks and their mates, then the French before that.  I was 
a bit concerned because I had our expensive digital camera in my pocket and my new T-Mobile MDA computer-
video-camera-Microsoft_Mobile_Office and lots of other digital things (digital tracking too but not quite sure how 
to do it here in the Binh Thuan District) which I have become quite fond of in my pocket as well as lots of dongs 
and credit cards and here we are casually walking through town like John Wayne. We began to feel like easy 
pickings but I am sure we had no reason to. Most everyone smiled and said hello. We were just out of place big 
time. We were a tad bit lost and Narda’s feet were hurting from her thongs, which are more suitable for a sandy 
beach than pavement. We got stopped often and asked if we wanted a ride somewhere on a motor scooter. We 
looked about for a taxi but were informed ‘no taxi, motor scooter only’ (typing these words does not come close 
to portraying what those words sound like from a local). Narda wrote ‘Pandanus’ with borrowed pen and paper 
and soon we were motoring down the highway on the back of scooters. I drove a motor scooter forty years ago 
and Narda thirty years ago. I had never ridden on the back of one – and to do it on some country road in 
the backblocks of Viet Nam was unique. I had one short thought about being taken down one of those winding 
dusty roads amongst the sand dunes toward the sea and buried alongside the wife and our camera, wallet packed 
with dongs and groovy MDA computer-phone being traded for a new motor scooter but soon realized those 
are negative thoughts picked up from watching some foreign kung foo movie on television last night. After awhile 
it all became comfortable and Narda’s bike went alongside mine and we chatted away as we hurled down the road. 
In yesterday’s notes I pointed out that there do not seem to be traffic rules in this country and everyone just beeps 
at each other to get out of the way. For better or worse we got to our destination and gave the drivers an 
incredible 10000 dongs (actually that is 63-cents). 
 
We bought noodles in a cup from our deli-lady and Narda went off to the dining room here at the resort to get 
forks. Because we are just about the only ones here she was warmly greeted by four waitresses at the 
restaurant because they assumed we would be eating, giving them something to do. Of course all we wanted was 
forks and to eat in our room our cheap meal. It is all quite strange. There are so many people working here – there 
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are at least a dozen people wandering about working on the landscaping. We went for a swim in the massive 
pool because the sea looked a bit rough (and we are woosses). There were four staff in the pool area doing 
wonderful things like getting little leaves or bugs out of the pool, putting down umbrellas because the 
afternoon monsoon was heading our way, and sweeping the footpath alongside the pool. We were the only 
customers at the pool bar yesterday and today the guy just stood there all day wiping the counter and counting the 
bags of chips and I doubt there were any customers. We were the only pool users. I suppose we should feel 
something about resorts and the environment and all but we are having a restful lovely time. I would think these 
resorts give employment and money into the community where there is incredible poverty. Who knows? We will go 
to the neighboring resort for dinner as last night’s meal here was really quite budget. Tomorrow we will go into 
the major city in these parts (more than a million folks our guide book says) and I hopefully will find an Internet 
café to upload this stuff as the local computer does not have a USB port to put my flash card in and we do not 
have Internet in our room (that is our level of worry these days). Actually I figured out how to get this all on to 
their antique computer and on to my domain - oops sounds like bragging but if anyone ever is in need of a 
webpage developer here I am. 
 
Oh by the way (I got a bit sidetracked in my story telling), Mui Ne is a bit inland and not along the coast like we 
would assume a fishing village to be. In any other place in the world the fishing village is along the sea but this 
is actually a few kilometers inland (we know, we walked it). I have no idea why that would be. They roll round 
basket like boats out to their fishing boats and leave them on shore when not in use. I assume they walk to Mui Ne 
or ride their motor scooters. I did not see any trucks carrying hauls of fish but then the whole fishing fleet has been 
in port for the two days we were here.
 

Basket boat used to go to fishing fleet Narda and Terrell going off to catch dinner Terrell goes to market with day’s catch of fish
 
Tuesday, 4 July, 2006
The American part of me says whoopee it is fourth of July but I doubt I will see much celebration here. We have 
not seen other Americans at this resort. We will stay at the resort I think today. Narda woke up a bit ill so the 
various Asian bugs may be getting to her or is it the Agent Orange residue from indiscretions past. I will get some 
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of our video footage onto the web - like if anyone would care - My friend, Lisa, in Albany says she looks at our 
photos of travel and reads and one or two of Narda's sisters look at our stories and that is probably it. I think our 
sons wonder what we are doing wandering around these parts. Speaking of which - Viet Nam is a great travel place 
for backpackers. It is so cheap. We came across westerns that do the Sinh tours (see http://www.sinhcafevn.
com) which are like about $26 US a day including hotel, travel all day to Cambodia and meals and they are 
quite comfortable. There were a lot of western backpackers in Ho Chi Minh City. Europe is just too expensive. 
For example our Hamburg, two-star hotel, shared toilet and shower was very cheap for Germany (especially during 
the World Cup) at $130 a day and this four-star exclusive resort with a large buffet breakfast included is $64 a day 
for a luxury room. Our Novatel hotel in Ho Chi Minh City - a very high standard - was even less whereas in 
Europe the same room would have been $250 or more. If Narda feels better later we may rent a motor scooter from 
the deli-lady across the street and go to the sand dunes. Some children down the street were trying to hustle us to 
rent their slides to go down the dunes. Narda said we were too old and in quite good English the boy said ‘you 
young you very beautiful’ so with lines like that maybe we will rent their slides and go down the dunes.
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Return to Albany to Adelaide to Albany via Europe and China BLOG        

Tuesday, 16 August 2005 2PM

We came to Sydney last night and stayed in Kings Cross. This morning we went to Homebush and 
I put up a picture of Leigh where he died. Two-years ago Leigh had flown from Dodgertown in 
Vero Beach, Florida to Sydney to attempt to win back his off and on girlfriend, Veronica. They had 
been together for three or so years. I remember when he first met her in early 1999. It was a few 
days before Leigh went to South Africa with the Australian Under-16 National Team. When he 
came back a couple of weeks later he began his relationship with Veronica in earnest. We (Sacha, 
Leigh and I) were living in Christie Downs and Leigh and Sacha were at Wirreanda High School. 
Leigh was getting his first few recruits from professional baseball teams (Atlanta Braves, Arizona, 
Cleveland, at the time we were leaning toward Arizona), Sacha was getting more involved with his 
art and music and I was in my first years of my PhD. The future looked different than it has turned 
out but that is most of humanities fate – we only head in directions and destinations are often quite 
different than originally thought.

Leigh had not said anything to the Dodgers the afternoon he left. From his five-thousand words 
letter left on his computer and sent to Veronica his decision to go to Sydney was not premeditated. 
Though he did say he could no longer live without her. From what I have pieced together he 
booked his ticket and flew on his frequent flyer points the fifteenth of August. The night before he 
left he went with his Dodger’s team-mates to a game between the Dodgers and the Marlins. 

The Dodgers lost that game 5 to 4 in the 13th inning. Which meant that the Florida Marlins laid 
claim to sole possession of the Wild Card lead for the season.

Ramon Castro's walk-off homer off Paul Shuey with two outs in the 13th inning lifted the Marlins 
to a 5-4 win over the Dodgers, ending an exhausting 4-hour, 5-minutes marathon in front of 12,025 
at Pro Player Stadium

What thoughts were in his head during that game? I wonder if he knew that his life would end 
soon. That he would fly to Sydney and never return? Did he watch the game and realize that he was 
no longer interested in baseball? Did he think it was too far to go to get to the majors? Did he see 
the Dodgers as a losing team and that he was losing in life? It was a four-hour game in front of 
12,025 people in a stadium built to hold 36,331. The average attendance for 2003 was 16,290 so 
Leigh may have found he was alone in a huge place. I keep his Dodgers Member entry card on the 
string he would have worn around his neck next to my desk at home in Round Lake. It seems that 
if Leigh was of an ill mood which it appears he was, then spending so long at a game when his 
team lost and not many people were there would just have made him feel worse. The Dodgers lost 

http://neuage.org/leigh_end.htm (1 of 9) [3/9/08 11:44:37 AM]

http://www.bloglines.com/blog/trip05
http://www.veronica.net.au/
http://neuage.org/ODAM.htm


Leigh Neuage, Novotel Hotel, Sydney Olympic Park, New South Wales, Homebush Stadium, Wirreanda High School

the next night’s game too, 2-1 but Leigh didn’t go to that game, he was headed for Australia.

At the time Leigh was in rehab because of a sore shoulder but from the Dodger’s records he was 
due to go back into the pitching rotation of the South Georgia Waves. 

South Georgia Waves (A)
05/16/03 Leigh Neuage -- Placed on the Disabled List.
05/28/03 Leigh Neuage -- Reinstated from Disabled List.
06/09/03 Leigh Neuage -- Placed on the Disabled List.
08/14/03 Leigh Neuage -- Reinstated from Disabled List.

  Leigh Neuage -- Placed on Suspended List.
08/15/03 Leigh Neuage -- Reinstated from Suspended List.

From the Dodgers webpage of transaction of the time. When the Dodgers realised he had left the States 
without permission (he was on a five-year contract) he was put on suspension on the fourteenth and then 
apparently when he arrived in Sydney he rang them saying he would return and they reinstated him on the 
fifteenth but he had already died on the sixteenth in Australia which is a day ahead of Florida.

The Dodgers I spoke to said they took him to the game because he was very depressed the day 
before and they didn’t want to leave him in his room alone for the evening. Leigh took a limousine 
to Orlando,  and flew via San Francisco to Sydney. Veronica was in the Australian Pop Idol thingy 
– I think she was in the quarter finals. The contestants were staying at the Novotel across from 
Olympic Stadium.  Leigh asked for the highest floor room with a balcony and got a suite on the 
fifteenth floor facing the stadium for Veronica and him. The room had a lounge and a spa. From his 
credit card records, Leigh had something to eat at 12.30 AM. Veronica says she remembers Leigh 
waking her up and saying ‘I love you’ and she saw the clock at 4.30 – she thought he was going to 
the toilet and she went back to sleep. At five-thirty she was a woken by hotel management and 
police and asked to identify Leigh. Veronica would not say what was going on between them 
though I know they had broken up several times previously. On the day Leigh arrived – jetlagged 
and emotionally distraught and on a medication a Dodger’s psychiatrist had put him on (Prosaic) 
he had spent a lot of money on Veronica and she said he rarely spent much money on her or 
anything – he had paid more than one hundred dollars for lunch and had paid for hundreds of 
dollars of CDs and pocketbooks for her… she said he was limp when she tried to hug him like he 
was not there and he acted all day as if was saying goodbye to her – his last photo on his digital 
camera was a photo he took of himself and it appeared as if had been crying. In his last writing that 
I found on his computer he had said that he knew since the age of ten that he would one day kill 
himself and I never knew this – how could I?  He seemed happy and he worked so hard to become 
a professional baseball player – it was his dream since at eight years old declaring that he would 
‘play for the Yankees one day’ – he played for the Dodgers instead but how would an eight year 
old know that someday he would be a professional baseball player? And especially in a country 
that instead of baseball played cricket, rugby and Aussie Rules footy (as Narda’s sons do and we 
go and watch them on Saturdays – last Saturday two of her sons playing in the A grade for 
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Birdwood – beat the number one team, Torrens Valley – and her sons got third and fifth best on 
field).

I was working on my PhD, putting the final touches on what I had hoped would be my final 
submission of my 150,000 word thesis (August 16th, 2003 – and here I am finally graduating two 
years later) when Narda came in to my office at the University of South Australia and put her arms 
around me and said ‘Leigh is dead’. I hear those words a thousand times a day – words that will 
never go away. I live my life constantly holding back tears because as a male I do not know how to 
let them flow in front of others – even Narda, who I am married to and who has a master’s degree 
in counselling is not allowed to see them. 

We took the next flight to Sydney and flew Sacha over from Melbourne. Detective Ryan Malcolm 
met us at the airport and drove us to a morgue. Detective Malcolm is the best policeman in 
Australia when it comes to compassion. He even went to where Leigh died last year – a year after 
the event – he said he would have like to have known Leigh as a person after he spent a year 
investigating and speaking with all those who knew him. Every once in a while he writes me and 
asks how am I doing. His assistance to help me get Leigh’s laptop has meant a lot to me.

I did not give birth to Leigh – but I helped deliver him and I was the first to hold him – twenty-
years later I was the one to identify what I saw in front of me as the son I raised single-handed. The 
look on his face was of shock – perhaps somewhere in the two second fall he realised what he was 
doing was a mistake but it was too late. Leigh’s left hand was very damaged as was the back of his 
head which he landed on (his brains had been forced out – his brains had made him a skilful pitcher 
and he had received credit on the Australian Math exams and he was tested and rated in the top ten 
percent of people his age in intelligence but his brains were no longer contained in his head) but his 
right hand, his pitching hand, was not even scratched. It was as if he was going to protect that one 
part of his body that had gotten him to be one of the top junior pitchers of Australia (Leigh was 
junior South Australian sports player of the year for 2001 and world number one tennis player, 
Hewett, was the senior sports player of the year that year). His pitching had taken him to many 
places including South Africa when he was 16, the United States of America (Under 14 World 
Championship in Saint Louis), Canada for the Under 18 World Championships, Taiwan for the 
World Cup in 2002 and of course his signing with the Dodgers when he was 17. Whilst growing up 
I was always concerned that Leigh had a life line that stoped in the middle of his hand – I had 
never seen that before. Sometimes something like that could mean a person is unhealthy but not 
Leigh. At six-foot-four and 210 points he was all muscle and seeing Leigh no longer there in that 
body that he had worked for so long on perfecting is a shock that will never go away. I had been 
told that at his rate of progress, Leigh was two-years from the majors. He was also on the 
Australian Olympic team that went to Athens in 2004 but he ended his life in front of the 
Australian Olympic Stadium a year before he had a chance to go. Leigh had it all going for him 
except for love and without that he no longer wanted to stay in the world. Leigh’s Dodger team 
mates at Vero Beach Florida and in Georgia had a moment of silence and tipped their hats to him at 
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their next game and more than two-hundred people attended his wake at his South Australian club, 
Southern Districts and more than one-hundred people have written tributes to him in an online 
guestbook. From his emails I found in his Hotmail account he had a lot of friends and his Dodger 
team mates thought very highly of him. Leigh was loved by a lot of people but at the end he only 
wanted to be loved by one.

Last year when I went to do a memorial at Homebush Stadium in Sydney for Leigh it was cold and 
raining. I put up a picture of him and his baseball card and only spent a few minutes there. This 
year, again I taped his baseball card to the poll next to where he landed. It is a beautiful day today – 
sunny and warm. We only spent a few moments where Leigh landed then we got on this train 
where I am writing this on our way into the Blue Mountains to Katoomba where we will stay for a 
few days in a cabin. We didn’t stay at the Novotel last night because I thought it would be too 
stressful. The last time we stayed was the night Leigh died. I could only stay there one night then 
we stayed in Sydney until after we cremated Leigh. 

There were six of us at a funeral service for Leigh: Sacha, Narda, Lesia her friend Peter, Veronica 
and me. We had an hour or so there and I forget the name of the place, it is where Michael 
Hutchinson of INXES fame was buried. It was an awful hour. We all sat silently with our thoughts. 
We had decided to play “I try” by Macy Grey, a song that made most of us fall apart. It was 
suppose to have been played at the start but for whatever reason it came on – very loudly – half 
way through and played over and over, which made us all laugh and lightened up the moment for a 
moment. We had paid for flowers to cover Leigh’s coffin but they were put in the wrong hearse 
and did not arrive until close to the end. It just all demonstrated how dysfunctional our lives had 
been.

 [I had met the mother in Sydney at an astrological conference in January 1980 and we did not get 
along. She was in the States a few months later and remembered me and rang and said she had just 
‘driven across the whole country on the wrong side of the road’ and being the nice person that I am 
I said she could stay at my house in Baltimore, Maryland for one day on her way to NYC to some 
TM conference. I was in my last week in my house as I was headed to Hawaii to do an astrological 
on-air thing – do not exactly remember what – and the only item that was not packed and sent 
already was my bed and of course we agreed we could not stand each other and sharing a bed was 
just because there was no where else to stay but somewhere during the night – after a bottle of 
something or the other – her leg touched mine or visa versa, and after a week in bed we drove to 
San Francisco and I put her on a plane back to Adelaide and I went on to Hawaii and after a month 
she rang me and said ‘guess what?’ and then she came there and Sacha was born and one day she 
made the statement that if I ever wanted to see Sacha again I would go back to Adelaide with her 
and after arriving in Adelaide she said I was in her home and that was it… then I started a tofu 
factory and a year later we went to the States for a visit and we had sex once that year (we never 
did get on with each other really) and that was in Detroit and that was Leigh then after he was born 
Sacha and Leigh and I lived in my tofu factory then we moved out to the country where we lived in 
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ten different houses in ten years]. 

I started writing a story to my children about how we got to where we are in life on July 06 2003. I 
started writing it in Hamburg on our trip to Australia and continued it as we toured Korea, Hong 
Kong and I wrote in between edits of my thesis in Adelaide – a month later Leigh died and I have 
written in pieces for the past two-years, with it being about 120,000 words long so far. ‘Leaving 
Australia’ is a narrative that I currently have been using for therapy of a life of raising two boys in 
a foreign country by myself and how we got to that point. 

Whilst in Sydney, after Leigh died, I call her ‘the witch’, Lesia got stuck into me – I tried so hard 
to be social – even almost nice – to her – she began yelling at me – the morning of the funeral – 
something about ‘you kept taking me to court’ and on and on. I had to go to court – I was a foreign 
male that wanted my children and I was always fighting to have them. Not only that but Lesia was 
against Leigh playing baseball interstate and overseas – she thought it would affect his schooling – 
so I was constantly going to court for him but in the end I think he was angry with both Lesia and 
me – he said as much in his last writings. I use to be so close to him. For awhile I thought he would 
never walk because he was always wanting to be carried. Sacha was independent from the day he 
was born but Leigh was always at my side – that is until he met Veronica – then, and I did not 
mind, I was second. Then after he signed with the Dodgers he became gradually hostile toward me 
– and that was difficult. He said Lesia had told him I was just after his money which was a crazy 
thing to say as every cent I ever could get went toward him playing baseball wherever the 
Australian team was playing. 

A couple of hours ago when I put up Leigh’s baseball card on the poll next to where he died I 
decided that I had to stay at the hotel he last stayed at each year from now on on the 15th  and 16th 
of August. We are staying there on our last night in Australia before leaving Australia in a couple 
of weeks. I will be saying goodbye to both of my children then. Sacha is coming to Adelaide for 
my graduation on the fifth then at six-thirty PM he flies to Melbourne and at 6.35 PM we fly to 
Sydney so I say goodbye to Sacha then we will stay at the Novotel where Leigh last stayed and the 
next afternoon we fly back to Albany, New York – getting back at midnight Tuesday night and we 
will be back at work at Albany Academy the next morning. 

And here I am on the train into the Blue Mountains. The last time I was in the Blue Mountains was 
in January 2001. I had met someone or the other on an Internet chatroom.

It was all very convenient at the time not only because I was a bit on the single side – having 
watched my six-year relationship with Chris (Kris) Noble end, without, at least my wanting it to – 
she had said “I need a break from you” and I did not know that meant ‘this is the end’ type of 
thing. Being the typical male I had not realised that when she wanted to go to house auctions and 
look for a house for us it meant she wanted to take our relationship to ‘the next level’ but I was so 
content on living with just Leigh at the time and perhaps that was not enough to sustain a 
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relationship… so I flew to Sydney and met this girl I had been getting on ‘thick and heavy’ with 
online and what was so convenient was that Leigh was playing in the National championship 
games in Olympic Stadium (right across the Novotel hotel from which he took his final plunge) 
playing of course for South Australia. The girl, forget her name, lived in the Blue Mountains, quite 
a ways past Katoomba, where we are now, past Bathurst – the site of some famous car race, and  - 
well I don’t remember but it was a grand old small town and she lived in an incredible old large 
home. She collected me from the airport and took me to her home and the next day we drove back 
to Sydney to watch Leigh pitch and win against Victoria. It was the last time I would see Leigh 
pitch. I use to love watching him pitch – in the mid 90s per hour when he was 16 – striking out 
batter after batter. I have never seen anyone pitch like him – it was a ritual, you knew he was going 
to strike out the batter from the beginning – he had a unique way. Even when there was a 
championship game on the line – with Leigh’s team just a run ahead – bases loaded, three balls and 
two strike count he would move off of the pitchers mound, look around and know he was going to 
throw a fast ball right past the batter to win the game. I watched him do it many times, from Under-
tens up through seniors when he was the youngest player to be playing in A grade. This is not a 
father saying that but many others who watched him said it too. He had a confidence that he would 
succeed that is rare amongst humans. Even when he decided he no longer wanted to live, he was 
not an attempted suicide – he was successful. 

I would throw one-hundred pitches with Leigh each morning before school from the time he was 
12. By the time he got to 16 I could no longer catch his throws and he would have me sit in a chair 
and throw a tennis ball – I never once caught his curve balls – no matter how hard I would try. And 
I got several black and blue spots on my arms and legs to prove I could not catch him – and that is 
with a tennis ball. With a baseball I would not have him pitch to me but we would do long throws – 
so far that I would have to bat the ball back to him as I could not throw it as far to get it back to 
him. But one thing I can say – about such an athlete is that even at six foot four and 210 pounds 
and with the ability to dunk a basketball (by the way he was an incredible basketball player) I, at 
the age of 54 beat him in a one-on-one game of basketball. [we won’t dwell on the fact that we 
played to 21, that he fronted me 20 points, that he managed to tie the score – with each basket 
being worth one-point, at the score of 20 and that somehow when I had the ball I threw a long shot 
that somehow went in – giving me the win] I could beat him. I stoped beating him in track when he 
was about 12 years old but then again he got some South Australia State win in several track events 
by the time he was fifteen. 

Where was I? Oh! The girl I met on the Internet – one of those things people like to read about – 
sorry – no spicy stuff here – anyway that was the last time I saw Leigh pitch and the last time I was 
in the Blue Mountains (or saw the girl – though she was an artist who illustrated my children’s 
story ‘Wombat’ and for a moment we thought she would be my children stories illustrator) – soon 
after I teed up with Narda – and she met Leigh shortly before he signed with the Dodgers in 
February 2001 and one time, about the end of February because Leigh went to Spring Training in 
Vero Beach Florida at the beginning of March, we were together with Leigh and Veronica in 
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Rundle Mall and Leigh and I bought some clothes that were picked out by our women (Veronica 
and Narda) and then we all had dinner together and that was it – until we were all together again in 
Sydney in August 2003 – except at that time Leigh was dead. Narda and I got married in May of 
2002 – I never told Leigh, he was playing baseball in the States but Sacha was there at our thingy – 
which I call Jettyday, as we did the deed at the end of a jetty in Adelaide and Sacha gave me away 
and Narda’s three sons were there and they [happily] gave her away. And Narda and I are one of 
those rare online meetings that got together and stayed together and here we are in the Blue 
Mountains years later. What amazes me is how much more I think of Leigh than before he died. I 
was always with him until he went off to the States to play baseball – except of course when he 
played in some International tournament – but when he was not with me physically I was not 
constantly thinking of him – I wonder if this is what others do when someone close to them dies – 
or takes their own life…  my brother died of AIDES and I thought a lot about him every day for a 
year or so and both my mothers died (I was adopted) but I never thought that much about them – 
but Leigh I do not have a moment’s rest from. I really do believe if he could have made it through 
one more week he would be playing ball now with the Dodgers. I have recurrent dreams that have 
him in it and it is always the same – he has made some incredible error in life and I am telling him 
that I will help him get back on track to accomplish what he wants in life. Then of course what is 
life? He may be so far from our silly little hopes and wishes. No one has come back from the grave 
– I do not care what religions say [Narda has two sons who are Christian ministers – so far from 
my sons who I shielded from Christianity after growing up in such a strict religious way] – and 
now with my current research into nano-biological-live-forever 

Current research:
1. GRIN’ s technologies: [Genetics, Robotics, Artificial Intelligence, and Nanotechnology (Joel 
Garreau)] impact on communicational evolutions; how will we translate meaning from sender to 
receiver if the  ‘decoder’ is inserted in the minds of but a fraction of society? An extension to my PhD 
thesis: ‘Conversational Analysis of Chatroom’  “talk” 
2. Philosophical clashes between longevity (the race to extend life cycles without end) ~ reincarnation 
and traditional Christianity.

I do not know if it is worth living for a very long time when one’s son has found a different way. 
Are we kidding ourselves? I know Leigh was reading a lot on different religious thoughts 
[Buddhist as well as Christian and metaphysical] about afterlife before he died – I wish I could 
know of his conclusion, then again I do – he gave us his conclusion. (my concern is where is he 
now? Is he stuck somewhere – I have begun a life-long search for him, wherever he is – if there is a 
continuation of life – I will one day find him.)  He had said that he was going go off a bridge in 
Florida but when he went out his door it was raining [this was a couple of weeks earlier] and he 
wanted to be able to be still and think about his final moments in peace and the rain stoped him and 
now forever that I am alive I will find my way to the spot that he left earth to not only celebrate his 
life but to grieve a life that at least to me seemed so confused he could not continue. It is not easy 
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getting to Olympic Stadium – the train is out of the way – it was all build for the Australian 
Olympics of 2000 - and most people who stay at the Novotel get there by taxi or limo or drive 
there. And being in Sydney each year on August 16th is not that easy – especially when I live in 
New York. In August 2003, Narda and I were to leave on Monday, stop in Hawaii for a four-day 
vacation then go on to New York to work, me at Russell Sage College Troy, New York and State 
University of New York and Narda at Albany for Girls but instead we were flying to Sydney on 
Saturday and we never had our vacation in Hawaii. We arrived in Albany and the next day I was 
facing a class of twenty girls at Russell Sage College at eight AM. I was grieving and did not know 
how I could face another moment and I had jetlag from twenty-hours since Adelaide but that was 
nothing to what I was feeling about my losses. Now two-years later I feel just as bad. What amazes 
me is the level of survival of humans – some humans – they will go through such extraordinary 
circumstances to survive – we read about them in the news quite frequently – then there is Leigh – 
never did drugs, was strongly against alcohol – exercised daily – ran heaps -  lifted weights – was 
smart – listened to subliminal tapes [he even paid five-hundred dollars for one subliminal tape that 
he received before he died to help become a better pitcher: “Inner Talk” subliminal tapes have as 
their motto; ‘When Believing in Yourself Matters’ What Do Our Customers Say? And Leigh had 
been getting subliminal tapes since that age of eleven - http://www.eldontaylor.com/
what_our_customers_say.html 

Bedwetting, Nail biting, Breast Enlargement, Clean, Neat and Tidy, Baseball 

"I recently purchased an InnerTalk Baseball tape. My batting skills have increased quite a lot since 
using it." 

-         Leigh Neuage, (age 12), Australia.] and his direction in life was to leave this plane. Is there 
really anything more????

At my graduation, September 05, attended by Sacha, Narda, her parents and a couple of her sisters 
I will have one empty seat – the last time I graduated was in Geelong – Deakin University – Sacha 
and Leigh were at that – for my BA and wherever Leigh is there will be a seat at my graduation for 
him because the reason I did my PhD was to make a better life for my sons. And I know it sounds 
as if I focus on Leigh but I am as proud and really more so of Sacha because he has overcome 
incredible circumstances – which I will not discuss in public – to be doing so well – much better 
than I would have imagined. He will soon surpass both Leigh’s being signed as a professional 
baseball player and my receiving my PhD. What Sacha is on the brink of accomplishing is really 
great. I will not say anything more except that it is in the field of music and art. 

This has drifted off from saying what it is like in Sydney. Gosh – great city – Blue Mountains - - 
take the train from Central Station and stay in Katoomba at Sidney’s Retreat. As far as discussing 
my life with my sons and so much more I will write it in my never ending manuscript ‘Leaving 
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Australia’ – and I have begun a blog – with Leigh being the narrator of the story – he continues his 
life – he went to Sydney to end his life because his relationship with Veronica was at its end as 
another youthful relationship come and gone – he flew black to Vero Beach, got ‘right’ with the 
Dodgers – did his last couple of weeks with the team – went back to Australia to play for the USA 
winter and the Australian summer (why do I have to always live in winter? Going to Australia in 
the USA summer which is Australian winter) – playing in the Athens Olympic games for Australia 
– and low and behold getting Australia into the Silver Medal win – and on and on – as long as I am 
alive – or at least alive enough to write – Leigh’s day to day or at least sporadically written blog of 
his life will continue – it is the only way I can continue. I will be able to include whatever is going 
in the world within his story as I hate futuristic stories as we can not really predict the future as I 
have recently found out – we can only function within the future as it unfolds within us.
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Communicating on the Internet

ACOM465  Communicating on the Internet
Class number 2265 
May 27 (Tuesday) - June 19 (Thursday)
06:00PM-08:40PM AS0013 
Neuage,Terrell 
 
Four weeks
15 – three hour classes 
6 – 7:15 PM    7:15–7:30 PM break  7:30-8.40 PM practical
 
Learning skills and aptitudes in searching and analysing information available via the Internet. Learning skills 
in utilising computer mediated communication. Key aspects covered included - ethics and privacy, information 
quality and assessment, search techniques based on reasoned inquiry, critical analysis for information 
use, understanding and exploiting text-based communications technologies - email, asynchronous discussion and 
real-time chat.
 
Course Objectives 

●     To define/describe the Internet and its relationship with the Web. 
●     To articulate the impact the Internet has had on the ways people communicate.
●     To identify the strengths and weaknesses of electronic communication. 
●     To have a working knowledge of several Internet based communication tools.
●     To gain experience working in virtual teams. 

 
YOU WILL LEARN HOW TO

●     take responsibility for your own learning 
●     create an Internet e-zine
●     communicate with others via email, Newsgroups, Mailing Lists, the Internet and Web Conferencing 
●     access and transfer files with Telnet and FTP 
●     build WWW pages (we have Dreamwever 4) 
●     organize information in various formats into WWW (HTML) presentations 

The key for all your projects is to clearly define your audience and demonstrate why this resource will 
be beneficial to them. The final project MUST include a wide range of links to sites that support or 
augment your topic. Remember this is going to be a WWW resource.
 
Markings
 

Internet Mediated Communication as Seen

Through Heidegger, Mead, and Schutz
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Communicating on the Internet

1.  Journal = 20% these will be assessed online and are due on these dates. Journal work is done in class

I.                    5% due 2nd June
II.                 5% due 9th June
III.               10% due 16th June 

2.  Sectional tests = 30%

I.                    10% due 2nd June
II.                 10% due 9th June
III.               10% due 16th June

3.  Bulletin Board contributions = 20%

I.                    5% due 29th May
II.                 5% due 5th June
III.               5% due 12th June
IV.              5% due 19th June

4.  Attendance = 10% attendance is taken after the break (7.30PM each day). Everyone starts with 10% and loses 
two-points each class missed.

5.  Ezine total = 20%

I.                    5% due 5th June
II.                 5% due 12th June
III.               10% due 19th June

Schedule 
 

EVERTHING MUST BE ONTIME – I leave for overseas on 21st June and will need to mark and hand up grades 
on Friday 20th June.

 
 

MAY WEEK  lectuers  
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27 Tuesday 1 Computing 
Concepts 
and Issues

Overview of course.
Explaining Computer-
Mediated 
Communication
 
PRACTICAL
Setting up our Journal 

Every zine will have three parts
1.  for the student
2.  for a small group 4-5
3.  for the class

as well as
1.  chatroom
2.  newsgroup
3.  listserv
4.  sections – sports – news and 

interviews

 

  Computers in 
Teaching and 
Learning

  

  The Interactional Self 
and the Experiences of

  

28 Wednesday  Basics of an Ezine E-
Zines and E-mail 
Marketing

Cyberculture and Digital Society  

29 Thursday  Preparation and 
Research – 
Planning and 
Development 
dreamweaver

Digital Media, Hypertext, Cybernetics, 
Cyborgs and Virtual Realities.

 

02  Monday 2 Content Development 
and Writing Portfolio/
e-zine/folder

  

03 Tuesday  Newsgroups http://www.quasar.ualberta.ca
/edit435/news_lists/nl_facts.htm 

 

04  Wednesday  Listservs Publishing 
and Mailing List 
Management
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05 Thursday  FTP and TELNET   
09  Monday 3 create a MOO or Mush 

virtual community
  

10 Tuesday  Interviews on the net   
11  Wednesday  Story collaboration via 

the net
  

12 Thursday  Web Design and 
Delivery M

Learning Outcomes: Students will be 
able to: understand the theory and 
concepts involved in Web design, 
determination of cognitive aspects, 
and human-computer interaction with 
the Web; identify and analyse the 
informatio and communication needs 
of an organisation and determine 
which needs can be met through the 
development of a website; develop 
skills in writing online policies, 
standards and guidelines for electronic 
publishing of digital information; learn 
skills in writing HTML and use a 
WYSIQG (what you see is what you 
get) software package (Dreamweaver 
or FrontPage) to develop a website; 
and develop skills in best practice 
principles in web design.

 

16  Monday 4    
17 Tuesday     
18  Wednesday     
19 Thursday     

 
 

TEXTS / READINGS

•  Ess, Charles, Ed. (1996). Philosophical Perspectives on Computer-Mediated Communication. State University 
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of New York Press, Albany, NY. 
•  Herring, Susan C., Ed. (1996). Computer-Mediated Communication: Linguistic, Social and Cross-
Cultural Perspectives. John Benjamins, Philadelphia, PA
 

·  COURSE SCHEDULE / CALENDAR

Week One // 

Ontological perspective on CMC Defining, modeling, technological, orality, experiential issues. 
•  Sherri L. Condon and Claude G. Cech, "Functional Comparisons of Face-to-face and Computer-
Mediated Communication" in Herring, Computer-Mediated Communication. 
•  Joan Korenman and Nancy Wyatt, "Group Dynamics in an E-mail Forum" in Herring, Computer-
Mediated Communication. <.i>Oren Ziv, "Writing to Work: How Using E-mail Can Reflect Technological 
and Organizational Change" in Herring, Computer-Mediated Communication. 
•  Laura J. Gurak, "The Rhetorical Dynamics of a Community Protest in Cyberspace: What Happened with 
Lotus Marketplace" in Herring, Computer-Mediated Communication. 

Week Two // 

Epistemological perspective on CMC 
•  David Kolb, "Discourse across Links" in Ess, Philosophical Perspectives on Computer-Mediated Communication. 

Week Three // 

Ethical perspective on CMC 
•  Dag Elgesem, "Privacy, Respect for Persons, and Risk" in Ess, Philosophical Perspectives on Computer-
Mediated Communication. 
•  Peter Danielson, "Pseudonyms, Mailbots, and Virtual Letterheads: The Evolution of Computer-Mediated Ethics" 
in Ess, Philosophical Perspectives on Computer-Mediated Communication. 
•  John Lawrence, "Intellectual Property Rights: The Paper Club and the Digital Commons" in Ess, 
Philosophical Perspectives on Computer-Mediated Communication. 
•  Susan Herring, "Posting in a Different Voice: Gender and Ethics in CMC" in Ess, Philosophical Perspectives 
on Computer-Mediated Communication. 

Week Four //
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Religious perspective on CMC 
•  Stephen D. O'Leary and Brenda E. Brasher, "The Unknown God of the Internet: Religious Communication from 
the Ancient Agora to the Virtual Forum" in Ess, Philosophical Perspectives on Computer-Mediated Communication. 
•  Phil Mullins, "Sacred Text in the Sea of Texts: The Bible in North American Electronic Culture" in 
Ess, Philosophical Perspectives on Computer-Mediated Communication. 

Week Five //

Linguistic/Semiotic perspective on CMC 
•  Gary Shank and Donald Cunningham, "Mediated Phosphor Dots: Toward a Post-Cartesian Model of CMC via 
the Semiotic Highway" in Ess, Philosophical Perspectives on Computer-Mediated Communication. 
•  Milena Collot and Nancy Belmore, "Electronic Language: A New Variety of English: in Herring, 
Computer-Mediated Communication. 
•  Simeon J. Yatees, "Oral and Written Linguistic Aspects of Computer Conferencing: in Herring, Linguistic 
and Interactional Features of Internet Relay Chat" in Herring, 
•  Susan Herring, "Two Variants of an Electronic Message Schema" in Herring, Computer-Mediated Communication. 

Week Six //

Social perspective on CMC 
•  Carol J. Adams, "'This Is Not Our Fathers' Pornography': Sex, Lies, and Computers" in Ess, 
Philosophical Perspectives on Computer-Mediated Communication. 
•  Sunh-Hee Yoon, "Power Online: A Poststructuralist Perspective on CMC" in Ess, Philosophical Perspectives 
on Computer-Mediated Communication. 
•  Charles Ess, "The Political Computer: Democracy, CMC, and Habermas" in Ess, Philosophical Perspectives 
on Computer-Mediated Communication. 
•  Peter Kollock and Marc Smith, "Managing the Virtual Commons: Cooperation and Conflict in 
Computer Commmunities" in Herring, Computer-Mediated Communication. 
•  Nancy R. Deuel, "Our Passionate Response to Virtual Reality" in Herring, Computer-Mediated Communication. 
•  Kira Hall, "Cyberfeminism" in Herring, Computer-Mediated Communication. 

Week Seven //

Cross-cultural perspective on CMC 
•  Ringo Ma, "Computer-Mediated Conversations as a New Dimension of Intercultural Communication between 
East Asian and North American College Students" in Herring, Computer-Mediated Communication. 
•  Mary Elaine Meagher and Fernando Castanos, "Perceptions of American Culture: The Impact of an 
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Electronically-Mediated Cultural Exchange Program on Mexican High School Students" in Herring, 
Computer-Mediated Communication. 
•  Gregory G. Colomb and Joyce A. Simutis, "Visible Conversation and Academic Inquiry: CMC in a 
Culturally Diverse Classroom" in Herring, Computer-Mediated Communication.
 
THE JOURNAL OF COMPUTER-MEDIATED COMMUNICATION
 
Computer-Mediated-Communication and Relationships 

Pew Internet and American Life Project

A series of studies conducted by the Pew Organization reflect the use if the Internet in interpersonal 
communications. Of special note are the studies of Teenage Live Online, Online Communities and Wired Seniors. 
The full text of each of these can be downloaded as a .pdf file.

this course looks at the internet from the perspective of 
interpersonal communication and examines 
online indentities, relationships and communities.
 . http://faculty.washington.edu/thurlow/teaching/com482/ 
 
Interpersonal Communication on the Internet 
                 Comm 385/585 on-line  
                         Spring 2004 http://www.uwsp.edu/comm/jmoe/385ext/ 
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State University of New York Albany
Globalisation and Culture ACOM 465

© Terrell Neuage August 2003
updated Tuesday, September 09, 2003Thursday October 9, 2003 1:48 PM 

 
 
Thanks for being in the class.
 
Cheers
Terrell

 
 

Fall 2003
Calendar 
GRADES   Thursday, December 18, 2003 2:25 PM

 

 
 

COURSE PRESENTED AND DEVELOPED BY TERRELL NEUAGE 
Department of Communication, State University of New York, Albany.

 
                                                                        
 

Syllabus
 
Course: ACOM 465 Intercultural Communication
CLASS: TTH 05:45:00 PM - 07:05:00 PM SS 116 Lecturer T. Neuage 
OFFICE: SS 386   Hours: Tue – Thur 9-5  Phone 442-2604
E-mail: neuage@albany.edu

 
Cover photo: Segregation at McDonalds. Women queue on the left section. Men on the right. May 2000. Riyadh, Saudi Arabia. 
© Copyright Photograph by Dafydd Jones 66 Stockwell Park Rd. London SW9 0DA Tel 020 7733 0108 http://www.dafjones.
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com/
 
 

COURSE GUIDE INDEX
ONLINE NAVIATION
Globalisation definition
Required viewing

1. What this course is about
2. Attendance Policy
3. Grades
3. Assessment
A) Weekly e-discussion Due each Friday 5 PM.
B) Weekly Reading DUE each Thursday 1 PM.
C) Journal DUE WEEK 6 and 11

Journal presentation guidelines:
Journal grading

D) Group presentation DUE WEEK 12 - 14
4. Course Expectations
5. Weekly Reading

WEEKLY TOPICS
Week 1 Introduction
Week 2 Culture and multiculturism
Week 3 Globalisation
Week 4 Individuals, Groups and Corporations and Globalisation
Week 5 The Media, History of writing
Week 6 Gender and globalisation: more or less rights for women?
Week 7 World music
Week 8 TOPIC: World sports and world foods
Week 9  The Internet and Cyber Identities
Week 10  Television and movies how the world sees each other
Week 11 The virtual university
Week 12 Beliefs
Week 13 Digital Resistance – the anti-globalisation movement
Week 14
Week 15

6.  Referencing Guide
7. ASSIGNMENT COVER SHEET

 
 
 
 
 
 
ONLINE NAVIATION
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Two places for information: This is updated and online at: http://se.unisa.edu.au/gc.htm go the week we 
are in and the material will be online and also on WebCT for this course.

                                                
Globalisation definition
An email from Manila...,
Date: Sun, 11 Aug 2002 21:08:49 -0700 (PDT) 
 
From: yas sutaria 
>Question: How to define globalization? 
>Answer: Princess Diana's death 
>Question: How come? 
>Answer: An English princess with an Egyptian boyfriend crashes in a French tunnel, driving a German 
car with a Dutch engine, driven by a Belgian who was pissed on Scottish whiskey, followed closely by 
an Italian Paparazzi, on motorcycles, treated by an American doctor, using Brazilian medicines! And this 
is sent to you by a Filipino, using an American's (Bill Gates') technology which he stole from the Taiwanese.
 
Required viewing
There are several videos used in this course. These are on hold at the library for this course. 
Several sections will be viewed in class and some will be put online to be viewed to answers 
essay questions. Other segments will be referred to in the weekly guide. You will need to look at our 
site each week to know when the tapes are available. 
 
Global Insights 4.
GLOBALISATION 101
 
1. What this course is about
‘Globalisation and culture’ is a large topic. This course will examine and discuss different aspects of 
cultural change as technology has increasingly influenced our lives. We will also consider 
migration/immigration and “brought-in” cultures, beliefs and languages and how we are changing 
because of these influences.  In our exploration we will try to step back from our own personal world-
views as much as possible, though much of the material will necessarily be presented from a Western 
English speaking perspective. We will discuss various cultures but we will focus mainly on how 
Western society is currently influencing the world. And conversely how much our culture is being 
influenced by other cultures.
 
The need to expand, learn and share ideas has been with us as long as life has existed. Expansion 
has been embraced as well as being met with resistance. Whether we see this as conquering, 
colonization, social-evolution or education depends on one’s perspective.
 
We will cover topics as diverse as music, money-exchange, foods, gender, beliefs, communication 
and sports.  Our emphasis will be on technological change, which has positive and negative effects 
on cultures and our own lives. Through viewing and reading sources such as video, Internet and 
journal readings it is hoped that you will be able to formulate a personal informed view of globalization. 
This course is expected to encourage an active approach toward these issues and to provide you with 
new information with which to evaluate these issues.
 
At the end of this course you should have an understanding of cultural issues currently debated 
in contemporary society. Several perspectives will be presented and of course none of them are the 
correct model for everyone.  You may disagree with some of the content, and this will be welcomed. For 
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example, several of the videos shown are from ‘Global Insights’ (http://www.skatv.org.au/skatv/) a series 
of videos, some which are subversive. These are from Australia and show protest activities worldwide that 
are meant to disrupt corporate globalisation. Alternatively, you may agree with issues of globalisation 
and view it as a necessary force of good. Personally I believe there are both positive as well as 
negative aspects to globalisation just as there are aspects of sharing and introducing cultures there is 
the possible destruction of cultures. 
 
From the start I wish to emphasize that globalisation is not Americanisation. Much of what is presented 
in various western sources would lead one to believe it is America’s impact on the rest of the world that 
is globalisation. America’s impact on the world is significant; however other culture’s impact on America 
is also significant. Is the world in the process of homogenization or is there cultural dominance by but a 
few countries is one of the questions we will answer in this course.
 
This course is planned to encourage you to bring some of your own experiences and world-views to 
the course and for you to take responsibility for your learning. We will be working in cluster groups 
on Thursday and our Tuesday classes will be as interactive as possible. More of this will be discussed 
in the next section of this guide.
 
2. Attendance Policy
 
Class attendance will thus be taken each Tuesday and Thursday at the start of class and students 
are encouraged to come to class prepared and participate fully. Two-percent will be deducted from the 
final grade for each class missed that does not have one of the two excuses: 
 

Ø      Illness, Absence must be verified by my sighting, or the Office of Undergraduate Studies stating 
that they have received appropriate documentation of an original copy of a medical excuse. (I do not 
want to know the nature of the illness, only a note stating you were unable to attend class that week 
signed by a doctor with his or her number on it).

 
Ø      An emergency, I must have a letter from the Office of Undergraduate Studies stating that they have 
received appropriate documentation. 

 
 
For university policy, go to the Undergraduate Academic Policy Reminders Page: http://www.albany.
edu/undergraduate_studies/policy_reminders.html
 
3. Grades
A  100-94.5            A- 94.4-90.5
B+ 90.4-87.5          B   87.4-83.5         B- 83.4-80.5
C+ 80.4-77.5          C   77.4-73.5        C- 73.4-70.5
D+ 70.4-67.5          D   67.4-63.5        D- 623.4-60.5
 
3. Assessment
Allocation for this course is three-hours outside of class for each hour in class. You should allow eight 
to nine hours per week for this course outside of class.
 
Your assessment for this course will be made up of these three components: 
 

1)     Weekly Readings   30%    DUE WEEKLY each Thursday. These are short essays and will receive 
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1-3 points for each one. (10 weeks times 3 points. Estimated time for reading and viewing of material is 
three-hours per week.  One point will be lost if the assignment is not handed in Thursday.)

 
2)     Weekly Discussion 20%    DUE 5 PM Friday each week. 

 
3)     Journal                      20%    DUE Tuesday, October 16th, WEEK 7 (10 %) and November20th, 

WEEK 12 (10 %). Eight weeks times 2.5 points each equals 20 points/percent. Estimated time for 
finding and writing up material is three-hours per week.

 
4)     Tests                           15% Three tests @ 5% each

 
 

5)     Group presentation 15%  DUE Thursday November 21 and December 05. Estimated time for 
preparation is two-hours per week.  

 
A) Weekly e-discussion Due each Friday 5 PM.
 
Beginning with week three (September 17th) and for each week until week 13th you will be required 
to contribute to our online discussion group. THE URL FOR THIS WILL BE GIVEN IN CLASS IN 
WEEK TWO. Marking will attract two points: one point will be a result of saying anything on the topic 
and one extra point will come from responding to something someone else said. This will mean that you 
will need to return to the bulletin board later in the week. The question for the week will be posted 
each Monday AM, and will be based on the weekly topic. My suggestion is that you answer the 
question early in the week and return to the discussion board later in the week and read what your 
peers wrote then write a response to what they said. For example:
 
COM378 Discussion Board: Read a Post – 
Topic: Week Three: Discuss in two-three sentences something you did this week that was a result of 
globalisation - 
Subject:  Nike shoes into trash 
Author:   neuage (Terrell.Neuage@unisa.edu.au) 
Posting Date:  8/28/2002 9:17:55 AM 
Message: This week I had a gut-full of participating in the sweat factory practices of multinational 
companies who exploit Third-World countries so I can look as kool as other people my age and cleaned out 
my closet and drawers only to realise I would be lecturing in the nude this semester. After a re-think 
I discovered I was helping employ people who had no income by buying a new set of clothes at the Gap.
Replies
Title   RE:Nike shoes into trash
Author  terrell 
Date 8/28/2002  9:23 AM
Subject:  RE:Nike shoes into trash 
Author:  terrell (neuage@albany.edu) 
Posting Date:  8/28/2002 9:23:23 AM 
 
Message: Your reasoning is really faulty. Should I pay you one dollar a day whilst you work a 12-hour 
day in horrible conditions and then deduct 95-cents of that so you can use the loo twice a day so you can 
look ‘kool’? I think it would be better if you sent people in Cambodia a television so they can watch 
the World Series than to abuse them with sweatshop work. Now that is globalisation at work.
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B) Weekly Reading DUE each Thursday 1 PM.           
 
Total mark for the semester for assignment one is 30%
 
Each week there will be required readings or activities. These will be available a week in advance. 
For example, readings for WEEK TWO (September 10-16) will be available online beginning September 02. 
Each week there will be several questions relating to the required reading or online viewings. You will 
need to answer these questions and hand your answer up at the beginning of the Thursday class of 
the week they are due. 
 
Marks will be awarded in this segment as follows:
 
Questions answered satisfactorily each week, handed up in time (see above)  /33 (Each week 3 marks 
can be earned). Two points will be for answering the questions and one extra point for answering 
the questions extremely well! MISSED ASSIGNMENTS CAN ONLY BE ACCEPTED IF THERE IS 
A DOCTOR’S CERTIFICATE
 
C) Journal DUE WEEK 6 and 11     
 
Due Date: Tuesday, October 16th (Journal Part 1) and Tuesday, November 20th  (Journal Part 2)
 
Total mark for the semester for assignment two (journals) is 20%
 
Your journal will cover an eight-week period beginning with the second week of classes, September 09 
(the week being from Sunday to Saturday) through to November 02. The week of November 03 to 09 
you will have to format your journal to hand up at the beginning of class on Tuesday, November 12th. 
The journal must be done on a weekly basis, as the date of the material used will coincide with the week 
of the entry as explained below. 
 
Your journal will be a weekly record of current topics on globalisation. Each week, beginning with week 
two (September 08) of this semester, find something that mentions or references globalisation. It can be 
an article from a printed source such as a newspaper or magazine or a story on television or from 
the Internet. The story could be about how different culture’s menus are appearing in your local deli. It 
can be a story on world music, the World Bank, or on the exploitation of the Third World to 
manufacture goods bought in your local shop. There is rarely a day that goes by where something 
about how cultures are mixing with business, ideas or world events is not discussed.
 
For your journal, cite the article correctly (see example below), then  type the first paragraph or two if it is 
a print or Internet story.  If it is from television or radio, cite the source correctly then outline it briefly. 
What is important is that the story is from the week of the entry and that the source is noted. Following 
the title and a synopsis, you are to write your own thoughts on the story. There are no right or 
wrong answers but you need to give a reason for your views of the story. Each journal entry 
needs approximately two hundred words.  For example:
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WEEK ONE
 
Jameson, Tonya. (2002) Hip-hop rediscovers its political punch, 
Albany Times Union, August 25, 2002, p.15.  
 
‘ Hip-hop culture has infiltrated entertainment, shaping how we 
dress, talk and see the world…
 
As this story shows, hip-hop has been a global voice of youth for the 
past decade. The youth ‘culture’ has embraced several aspects that 
are associated with hip-hop such as music (rap), art (graffiti/piecing), 
clothing and world-views. For example, in Australia….
 
 
Your weekly entry could be about music such as how hip-hop music has become a point of protest for 
youth throughout the world much as folk music was in the 1960s. This specific topic on youth music 
and protest will be addressed in week seven. It could be about sports. For example, I have a son who 
was born in and grew up in Australia which is a cricket and football (Aussie-rules) mad country but 
he played baseball and is now a pitcher in the Los Angeles Dodgers organization. Baseball is a minor 
sport in Australia so this could be an illustration of how sports are globalised. In other words your 
weekly entries can be on what interests you as long as it was in the news that specific week. I 
would suggest using different sources for your journal entries such as, one week you may decide to use 
an article from a newspaper and another week a story from television or the Internet. THIS NEEDS TO BE 
DONE EACH WEEK AND SHOULD NOT TAKE MORE THAN ONE -HOUR PER WEEK.
 
Weekly marking for your journal (5 marks per week) will be based on the following formula:
Journal presentation guidelines:
 

1.  Word processed! If you use a picture such as a cartoon to illustrate your journal entry for a particular 
week or in your essay it may be pasted in. 

2.  Put your full name in the header of each page and PART ONE. 
3.  One and a half space with appropriate citations and reference pages. See: ‘How to Cite Bibliographic 

Entries and In-Text Citations Electronic Sources MLA Style’ at the end of the guide for this course or 
use the library resources. 

4.  Printed on one side of the page only. 
5.  Written in an easily readable font (e.g. New York, Times Roman) and in a 12-point font. 
6.  Spell and grammar checked and proofread. 
7.  Numbered at the bottom of each page. 
8.  Given a properly filled in cover sheet to be used as the first page of each assignment. Photocopy the 

last page of this course information booklet. 
9.  Stapled in the top left-hand corner. 

Submitted by the deadline. Minus one-half point for each day late.
 
Journal grading
 
Your journal grade will represent 32 percent of your final grade (Part-one will equal 16 percent) and will be 
made up as :
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1)     One-half-point for the weekly entry cited properly,
2)     One-half-point for presentation according to the above criteria, 
3)     Adequate discussion will be worth one-point, 
4)     a well-developed discussion with the reason for your view will be worth two-points,  

 
Part One is due Thursday October 16th, WEEK 07.
 
After four weeks, on Tuesday, October 16th the first four weeks of your journal will be due. You will 
receive it back the following Tuesday (October 21th) with your grade for the first half of your journal. 
 
Part Two is due Tuesday, November 20, WEEK 12.
 
D) Group presentation DUE WEEK 12 - 14
 
Presentations will be done between Thursday November 20 and (Week 12, Thursday November 28 
school is closed) December 02.
 
Thursdays the class will go into cluster-groups. The weekly group-session provides an opportunity 
to discuss the issues and concepts raised in the Tuesday lecture and in the readings and viewings for 
the week as well as exchanging entries in your journal. 
 
These groups will be formed on our first Thursday together and will be made up from the enrollment 
sheet. Doing this gives interactivity in the class that may be different than if individuals picked their 
mates for the group.  The groups will have approximately five students in each.
 
One of the aims of the cluster group sessions is to maximize the use of your time. Working as a small 
group often makes it easier to get involved in class discussions, rather than struggling for airspace in 
our class of 45 or so students and helps with the speaking out in a new setting. 
 
Each cluster group will make one presentation within the broad areas that are indicated in the study 
guide on either Thursday November 21 and December 05.
 
Presentations can be formal or informal, depending on the style with which your group feels 
more comfortable. They can be as simple as generally introducing the topic with each member in the 
group presenting material, such as a video or music. Your group may present a drama or video to 
illustrate your group’s work. Marks will be based on the group presentation and will be one-half 
peer-assessed: each student will be given a list of each group and each individual in it and will be 
expected to give marks on different areas of the presentation. The peer-assessed marks will equal 25% and 
my marking of each student will equal 75% of the presentation (which is worth 27 percent of your 
final grade). Marking of it will be discussed later in the course.
 
I expect your group presentations to extend beyond the original texts by introducing evidence of 
wider research, and using examples to illustrate the theoretical concepts that are discussed.
 
4. Course Expectations
It is a minimum requirement for this course that you attend and participate in all Tuesday lectures 
and Thursday groups as well as do the three assignments above.  
 
This course encourages independent research and it is a minimum expectation that you spend at least 
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8 hours per week outside of class for weekly-readings, assignments and sourcing current events 
on globalisation for your journal.

The expected outcomes for students who successfully complete A COM 378T 1326 are: 

●     An understanding of how you as an individual as well as the communities we live in are effected by 
globalisation; 

●     Being an active participator in cultural issues that are effected by globalisation through accessing 
current events and responding to them; 

●     An ability to reason and communicate your views about issues that arise from our discussions; 
●     Being able to work in small groups that are similar to a community within the larger group (our class). 

5. Weekly Reading
Readings

You will locate and access readings each week by going to the week of the class. All readings 
and viewings will have links to theURL. Readings must be completed before the Tuesday 
class, as you will need to be prepared to discuss issues from the readings in both the Tuesday 
lecture and Thursday group discussions. 

Note: Because of the fluidity of the Internet the article may not be available the week it is due to be 
read. Therefore, it is imperative that you go to the reading for the week the week prior to its 
due viewing.
 

WEEKLY TOPICS
Week 1 Introduction
September 02 - 06
Go to: week_1.htm 
 
Week 2 Culture and multiculturism   
September 07 - 13 week_2.htm 
 
Week 3 Globalisation 
September 14 – 20 week_3.htm 
 
Week 4 Individuals, Groups and Corporations and Globalisation   
September 21-27  week_4.htm 
 
Week 5 The Media, History of writing
September 28-October 04 week_5.htm
 
Week 6 Gender and globalisation: more or less rights for women?  
 October 5-11 week_6.htm
 
PART ONE OF YOUR JOURNAL IS DUE Thursday 16th October (in this weekly are the guidelines 
for your presentation) WEEK 06. There is no journal article due for this week, use this week 
to format your journal.
 
Week 7 World music  
October 12-18 week_7.htm
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Week 8 TOPIC: World sports and world foods
October 19-October 25 week_8.htm
 
Week 9  The Internet and Cyber Identities  
October 26-November 1 week_9.htm
 
Week 10  Television and movies how the world sees each other
November 2-08 week_10.htm 
 
Week 11 The virtual university 
November 9-15 week_11.htm 
 
Week 12 Beliefs 
November 16-22 week_12.htm
 
Week 13 Digital Resistance – the anti-globalisation movement
November 23-November 29  week_13.htm
 
Week 14 
December 01-06 week_14.htm
 
Week 15 
December 09 week_15.htm
 
6.  Referencing Guide
reference.htm 
 

 
 
 
 
7. ASSIGNMENT COVER SHEET 
(to be copied and attached to your journal for presentation)
 

A COM 378T 1326
 

Globalisation and Culture
Fall 2003

 
ASSIGNMENT COVER SHEET

 
 

 
Student name: __________________________________________________________
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Journal Assignment (Part 1 or 2)_______
 
 
 
 
Due Date: /  /03
 
Date of submission:  /  /03
 
DISCLAIMER
I declare the following to be my own work, unless otherwise referenced
 
Signed______________________________________
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newsletters/webpages on mobile phones for your school, business, family, church - ournews.mobi 
from neuage.mobi the name in mobile phone webpages from Terrell Neuage trip 07 
MORE INFORMATION 

Com 251-10: Interpersonal Communications
Sage College Communications Department 

Spring 2004 TTH 11:20-12:50 Albany campus
Terrell Neuage

UPDATES (INCLUDING GRADES AND ASSIGNMENTS) FROM http://www.albany.
edu/~neuage/ic/notes.htm

Course Description:
Text
Course Goals/Objectives:
Course Requirements

oral communication skill work
written work
reading

Exams and Projects
Grading Criteria
Contact

 

Course Description:
The focus for this class is on human interaction. We will investigate the principles of communication 
concentrating on how as individuals we use verbal and nonverbal language in different situations. As well as 
language we will look at how we listen and how we are affected by other’s communication. An important 
theme of this course will be group dynamics and our roles in them.
 
Interpersonal Communication (COM 251) is designed to increase your understanding and implementation of 
effective interpersonal communication behaviors and skills. Throughout the semester we will examine basic 
verbal and nonverbal elements affecting communication between individuals in family, peer group, and work 
contexts. This course requires you to participate in activities designed to develop interpersonal 
communication skills.
 
We will take a scholarly approach to communication at the same time allowing you to explore your own 
notions about the subject. We will look at our own lives as communication platforms but always in context of 
the material we are covering. 
 

Text
 
Verderber, R. F., & Verderber, K. S. (2004). Inter-Act: Interpersonal Communication Concepts, Skills, and 
Contexts (10th ed). New York, NY: Oxford University Press.  ISBN #0-19-516847-X
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Companion Web site to Inter-Act: Interpersonal Communication Concepts, Skills, and Contexts, http://
www3.oup-usa.org/sc/019516847X/ 

Course Goals/Objectives:
 
After completing this course, you will be able to: 

•        describe the process of communication and its various components, 
•        distinguish among various types of communication situations (intrapersonal, interpersonal, group and 
public) 
•        explain the role communication plays in personal and professional relationships
•        display appropriate communications skills depending on various interpersonal situations. 
•        define the basic elements and roles involved in group communication
•        explain ways in which conflict can be managed and identify strategies for resolving conflict
•        demonstrate effective public speaking skills
•        listen effectively to other’s messages, make critical evaluations of the content and respond 
appropriately given the situation

 

Course Requirements 
oral communication skill work

Since this is an oral communication skills course, we want to provide you with many opportunities to develop 
these skills. Aside from general class participation such opportunities may include the preparation for and 
performance and evaluation of role-playing activities, in-class presentations, and briefing sessions and 
discussion, analysis and critique of dyadic communication case studies, etc. 

written work
You will be expected to use correct spelling in all written work. Use of appropriate grammatical skills in oral 
and written communication is also very important. Throughout the course you will expand your personal 
vocabulary through the study of terms related to the course. Your written work will be evaluated on both 
content and mechanics. Good writing should be reasonably free of mistakes and without composition errors 
that are called gross errors (sentence fragments, run-on sentences, subject-verb disagreement, misspelled 
words, and typographical errors which result in such errors). All of your work MUST BE TYPED (using no 
more than 12 point type with margins not exceeding 1 inch on the top, right, and bottom, nor 1.5 inches on 
the left) and double-spaced--unless otherwise indicated by me. 

reading
Your reading assignments are included in the course calendar. In addition to the textbook, I may, from time 
to time, require you to read other material that will be put on reserve or which will be available on the 
Internet. 
 

Exams and Projects 
 
There will be several short true-false/multiple choice quizzes given during the course (approximately one at 
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the beginning of each chapter). In addition, you will be expected to take a comprehensive final, design a 
group workshop which applies interpersonal communication theory and research to an interpersonal 
communication topic, participate in several interpersonal simulations–some of which will involve 
interpersonal assessments, keep an individual journal of specific questions to consider and develop five 
communication improvement plans and a summary document for future implementation of communication 
skills. Miscellaneous activity points may be awarded at the discretion of the instructor. This sounds like a lot 
of work but it is a matter of organisation and we will go through what is expected each class.
 
QUIZZES (200 points)
You will be given several quizzes designed to assess your preparation for lecture and class discussion. Each 
quiz will consist of several multiple-choice questions addressing the reading for the assigned chapter. 
 
APPLICATION JOURNALS (5 X 20 points; 100 points total)
You will be given five journal questions during the semester that are simply short, typed reflections/
application opportunities to relate course material to your own experiences. I will expect you to ‘react’ to 
class activities, videos, stories, simulations, lectures and readings by integrating your knowledge of the 
concepts learned with your interpersonal relationships. These journal responses will be reviewed only by me 
and will be held in confidence between you and me. The journal entries will be graded on completeness, 
clarity, introspection and conceptual foundations. Journal questions will be provided in class on the dates 
noted on your course schedule.  
  
COMMUNICATION IMPROVEMENT PLANS (Goal Statements) (150 points)
As described in Chapter One of your textbook, Inter-Act (p. 24), the communication improvement goal 
statements are your opportunity to intentionally develop your communication skills. There will be five (5) 
plans (CIPs) which will reflect personal goals you will set based on material encountered in sections of the 
text as indicated on your course schedule (worth 15 points each; 75 points total) which will be submitted 
throughout the semester. I will expect a short (1 — 1 _ page) typed skill improvement plan based on the 
concepts learned in your textbook. See pages 24-25 to fine-tune your process. Your last part of the plan is a 3-
5 page typed, double spaced summary of your skill development throughout the semester based on your 
goals. You should identify those areas in which you have made improvements and those areas still needing 
improvement. The summary is worth 75 points. 
 
INTERPERSONAL ASSESSMENTS (50 Points)
One of the most interesting components of this course is the incorporation of interpersonal assessments that 
allow students to determine "baseline" scores for several interpersonal behaviors. Students will assess their 
individual conflict management style, propensity to self-disclosure, temperament and communication 
apprehension. 
 
GROUP WORKSHOPS (200 points)
The importance of developing your interpersonal communication skills when interacting with other students 
cannot be overstated. In order to give you practical experience in developing your interpersonal 
communication competencies, you will design and manage a group workshop on specific concepts related 
to one of the following five major topics: 
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Workshop #1 Communicating Through Nonverbal Behaviors - Chapter 5  
Workshop #2 Holding Effective Conversations - Chapter 6  
Workshop #3 Listening Effectively - Chapter 7  
Workshop #4 Responding with Empathy and Understanding - Chapter 8  
Workshop #5 Self-Disclosure and Feedback - Chapter 9
 

These workshops will include: 1) a one page synopsis of the major conceptual issues, 2) a demonstration of 
key concepts, 3) a brief annotated bibliography (of at least ten resources not included in the textbook) which 
must be integrated into the workshop, and 4) the opportunity for questions from the class and instructor. The 
grade for these presentations will be determined by an evaluation by the other groups and my evaluation. 
Grading criteria include research component (description of communication approach/perspective, literature 
review of theory, insight/interpretation related to chapter concepts), presentation style (attention to audience, 
introduction/conclusion, enthusiasm, delivery, use of materials), distribution of effort, quality of handouts, 
quality of activity, video usage, wrap-up/debriefing linking activities to concepts.  
  
CLASS PARTICIPATION and IN-CLASS ACTIVITIES (100 points)
During the semester we will have several in-class discussions/debates and engage in activities designed to 
sharpen your interpersonal communication skills. The a) more intelligent your comments, b) the more 
prepared you are, and c) the more willing your are to help make this class a productive educational 
experience for all, the more you will be rewarded. 
 

Grading Criteria 
Scores in three major performance categories will determine the grades for this class: Writing, Individual 
Performance/Participation, and Tests. These will be assessed using several assignments, each of which 
must be completed to receive course credit. There are no optional assignments. Course completion is 
accomplished when all necessary assignments have been finished. 
 
 Graded Assignments and Grade Calculation Updated Wednesday, February 04, 7.34 PM
 

Item ID Number of Points Due Date
Quizzes  10 X 20 pts 200 pts  
Application Journal AJ 5 X 20 pts 100 pts 2/5, 2/19, 3/04, 

3/25, 4/08
Communication 
Improvement Plans

CIP 5 x 30 pts 150 pts 2/10, 3/02, 3/23, 
3/30, 4/06     

Group Workshop GW 5 X 40 pts 200 pts 2/24, 3/02, 3/09, 
3/23, 3/30

Interpersonal 
Assessments

IA 5 X 10 pts 50 pts 2/12, 3/11, 4/06, 
4/15, 4/27
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Interpersonal 
Communication 
Survey I

ICS I in class group 
survey (put in GW 
section)

5 pts 1/29

Interpersonal 
Communication 
Survey II

ICS II in class group 
survey (put in GW 
section)

5 pts 4/22

Temperament Style 
Assessment 

TSA online test (Put in 
skills test section of 
folder)

10 pts 2/05

Self-Disclosure 
Assessment (Johari 
Window) 

 Put in skills test 
section of folder 

10 pts 2/12

Conflict Style 
Assessment 

CSA (Put in skills test 
section of folder) 

10 pts 4/06

PRCA I Communication Skills Test online test 
(Put in skills test section of folder)

5 pts 1/29

PRCA II Communication Skills Test online test 
(Put in skills test section of folder)

5 pts 4/22

Comprehensive Final 
Exam

 Chapters 1-14 100 pts  

Journal / folder presentation 50 PTS x 2 100 pts 3/11, 4/29

Participation and In-
class Exercises

 25 classes X 2 pts 50 pts  

TOTAL POINTS 
POSSIBLE

  1000 pts/10  

 
 
A = 94 – 100 % A- = 90 – 93.9 % B+ = 88 – 89.9 %
B = 82 – 87.9 % B- = 80 – 81.9 % C+ = 78 – 79.9 %
C = 72 – 77.9 % C- = 70 – 71.9 % D+ = 68 – 69.9 %
D = 62 – 67.9 % D- = 60 – 61.9 % F = 0 – 59.9 %
 

Contact
Phone 442-2604 (SUNY) I am there MWF 10.30 – 3.30
E-mail: neuage@albany.edu (must have SAGE/yourname  or I will not open the émail)
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Multiple Choices
The document name you requested (/dwight/dreamweaver.html) could not be found on this 
server. However, we found documents with names similar to the one you requested.

Available documents: 

●     /dwight/dreamweaver (common basename) 

Please consider informing the owner of the referring page about the broken link. 
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Basics to know about Dreamweaver CS 3 - index to notes for all classes

The menu bar...

1. Firstly, be sure these menus are selected at the start of your work...

window

 You will need the "Insert", "Properties", and the "Files" ticked. 

2. THE MENU BAR THAT IS AT THE TOP OF YOUR WINDOW

menu bar

 

3. > in years 6 - 10 we will be developing different parts of Dreamweaver. Firstly, all need to know 

how to create a "new file". To create a new page click file 
menu

 which opens the various types of pages we 
are able to create. To begin with everyone will select a new blank page 

blank

 and then click create 

 at the bottom right. 

4. In file 
menu

 select 'preview in Browser" 
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preview  to see what your page will look like on the 
Internet (you will be asked to name and save your document).

5. YOUR VERY FIRST PAGE - WHICH YOU WILL BE DEVELOPING THROUGHOUT YOUR DWIGHT 

SCHOOL LIFE MUST BE index.html and saved in your folder. This is the page that will 
load up first. It does not say index.html - it is the homepage. For example, http://www.dwight.edu

Do that now. File > new (as shown above in 3.) and save it as .html
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index to learning! return to computer technology

where are my pages?????

you will at times be uploading images and other various things to your site. Do you 
know where your site is?

Everything you save is saved in your documents or on your desktop - However, when 
you save material in Dreamweaver you will be saving it in your site.

Follow this path to find your site if it seems lost...

Firstly, at the top of your desktop screen (you will need to click on the desktop to see 

it) is 

home

 click on Go - then Home... you will see 

your name, or at least a small house, such as,  - this is where all 

your files are - look for the "site" folder >  this is where your web files 
are. For example, in Dreamweaver in "files" your folder could look like this > 
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files

 Notice that because I am working on the file called 
"where.html" which is in the the folder "dreamweaver" which is in my site folder "first 
class" where all our material for this class lives it is highlighted in blue. You can also 

look in your Macintosh HD  and navigate down to user > 
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user

 and click your site folder such as my first class folder 
and drag files from your desktop into your site. 
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Macromedia Dreamweaver CS 3 index to learning return to computer technology

ASCII Character Chart with Binary and 
Hexadecimal Equivalents

 
From: http://www.pcguide.com/res/tablesASCII-c.html
 
 

Character Name Char Code Decimal Binary Hex

Null NUL Ctrl @ 0 00000000 00

Start of Heading SOH Ctrl A 1 00000001 01

Start of Text STX Ctrl B 2 00000010 02

End of Text ETX Ctrl C 3 00000011 03

End of Transmit EOT Ctrl D 4 00000100 04

Enquiry ENQ Ctrl E 5 00000101 05

Acknowledge ACK Ctrl F 6 00000110 06

Bell BEL Ctrl G 7 00000111 07

Back Space BS Ctrl H 8 00001000 08

Horizontal Tab TAB Ctrl I 9 00001001 09

Line Feed LF Ctrl J 10 00001010 0A

Vertical Tab VT Ctrl K 11 00001011 0B
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Form Feed FF Ctrl L 12 00001100 0C

Carriage Return CR Ctrl M 13 00001101 0D

Shift Out SO Ctrl N 14 00001110 0E

Shift In SI Ctrl O 15 00001111 0F

Data Line Escape DLE Ctrl P 16 00010000 10

Device Control 1 DC1 Ctrl Q 17 00010001 11

Device Control 2 DC2 Ctrl R 18 00010010 12

Device Control 3 DC3 Ctrl S 19 00010011 13

Device Control 4 DC4 Ctrl T 20 00010100 14

Negative Acknowledge NAK Ctrl U 21 00010101 15

Synchronous Idle SYN Ctrl V 22 00010110 16

End of Transmit Block ETB Ctrl W 23 00010111 17

Cancel CAN Ctrl X 24 00011000 18

End of Medium EM Ctrl Y 25 00011001 19

Substitute SUB Ctrl Z 26 00011010 1A

Escape ESC Ctrl [ 27 00011011 1B

File Separator FS Ctrl \ 28 00011100 1C

Group Separator GS Ctrl ] 29 00011101 1D

Record Separator RS Ctrl ^ 30 00011110 1E
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Unit Separator US Ctrl _ 31 00011111 1F

Space
  

32 00100000 20 

Exclamation Point ! Shift 1 33 00100001 21 

Double Quote " Shift ‘ 34 00100010 22 

Pound/Number Sign # Shift 3 35 00100011 23 

Dollar Sign $ Shift 4 36 00100100 24 

Percent Sign % Shift 5 37 00100101 25 

Ampersand & Shift 7 38 00100110 26 

Single Quote ‘ ‘ 39 00100111 27 

Left Parenthesis ( Shift 9 40 00101000 28 

Right Parenthesis ) Shift 0 41 00101001 29 

Asterisk * Shift 8 42 00101010 2A 

Plus Sign + Shift = 43 00101011 2B 

Comma , , 44 00101100 2C 

Hyphen / Minus Sign - - 45 00101101 2D 

Period . . 46 00101110 2E 

Forward Slash / / 47 00101111 2F 

Zero Digit 0 0 48 00110000 30 

One Digit 1 1 49 00110001 31 
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Two Digit 2 2 50 00110010 32 

Three Digit 3 3 51 00110011 33 

Four Digit 4 4 52 00110100 34 

Five Digit 5 5 53 00110101 35 

Six Digit 6 6 54 00110110 36 

Seven Digit 7 7 55 00110111 37 

Eight Digit 8 8 56 00111000 38 

Nine Digit 9 9 57 00111001 39 

Colon : Shift ; 58 00111010 3A 

Semicolon ; ; 59 00111011 3B 

Less-Than Sign < Shift , 60 00111100 3C 

Equals Sign = = 61 00111101 3D 

Greater-Than Sign > Shift . 62 00111110 3E 

Question Mark ? Shift / 63 00111111 3F 

At Sign @ Shift 2 64 01000000 40 

Capital A A Shift A 65 01000001 41 

Capital B B Shift B 66 01000010 42 

Capital C C Shift C 67 01000011 43 

Capital D D Shift D 68 01000100 44 
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Capital E E Shift E 69 01000101 45 

Capital F F Shift F 70 01000110 46 

Capital G G Shift G 71 01000111 47 

Capital H H Shift H 72 01001000 48 

Capital I I Shift I 73 01001001 49 

Capital J J Shift J 74 01001010 4A 

Capital K K Shift K 75 01001011 4B 

Capital L L Shift L 76 01001100 4C 

Capital M M Shift M 77 01001101 4D 

Capital N N Shift N 78 01001110 4E 

Capital O O Shift O 79 01001111 4F 

Capital P P Shift P 80 01010000 50 

Capital Q Q Shift Q 81 01010001 51 

Capital R R Shift R 82 01010010 52 

Capital S S Shift S 83 01010011 53 

Capital T T Shift T 84 01010100 54 

Capital U U Shift U 85 01010101 55 

Capital V V Shift V 86 01010110 56 

Capital W W Shift W 87 01010111 57 
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Capital X X Shift X 88 01011000 58 

Capital Y Y Shift Y 89 01011001 59 

Capital Z Z Shift Z 90 01011010 5A 

Left Bracket [ [ 91 01011011 5B 

Backward Slash \ \ 92 01011100 5C 

Right Bracket ] ] 93 01011101 5D 

Caret ^ Shift 6 94 01011110 5E 

Underscore _ Shift - 95 01011111 5F 

Back Quote ` ` 96 01100000 60 

Lower-case A a A 97 01100001 61 

Lower-case B b B 98 01100010 62 

Lower-case C c C 99 01100011 63 

Lower-case D d D 100 01100100 64 

Lower-case E e E 101 01100101 65 

Lower-case F f F 102 01100110 66 

Lower-case G g G 103 01100111 67 

Lower-case H h H 104 01101000 68 

Lower-case I I I 105 01101001 69 

Lower-case J j J 106 01101010 6A 
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Lower-case K k K 107 01101011 6B 

Lower-case L l L 108 01101100 6C 

Lower-case M m M 109 01101101 6D 

Lower-case N n N 110 01101110 6E 

Lower-case O o O 111 01101111 6F 

Lower-case P p P 112 01110000 70 

Lower-case Q q Q 113 01110001 71 

Lower-case R r R 114 01110010 72 

Lower-case S s S 115 01110011 73 

Lower-case T t T 116 01110100 74 

Lower-case U u U 117 01110101 75 

Lower-case V v V 118 01110110 76 

Lower-case W w W 119 01110111 77 

Lower-case X x X 120 01111000 78 

Lower-case Y y Y 121 01111001 79 

Lower-case Z z Z 122 01111010 7A 

Left Brace { Shift [ 123 01111011 7B 

Vertical Bar | Shift \ 124 01111100 7C 

Right Brace } Shift ] 125 01111101 7D 
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Tilde ~ Shift ` 126 01111110 7E 

Delta ∆  
127 01111111 7F 
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Technology Portal >>> ONE ADDRESS FOR EVERYTHING = http://fc.dwight.
edu/studentweb

CLASS MEETS DAY 2 PERIOD 3 AND DAY 5 PERIOD 5

 
Return to year 6 Home / Calendar / Student's page / Moodle / Wiki / My Dwight / Curriculum Map / 

First Class - email is on your desktop - from home log in here / assignments 

Assessment Criteria for the IB MYP 

TECHNOLOGY
Criteria Name Max
A investigate 6
B design 6
C plan 6
D create 6
E evaluate 6

F attitudes in 
technology 6

Check here at the start of class for what we will do today ~ as well as for any special notes. Today's 
note will be at the top of the list.

November 
●     Tuesday November 13th DAY 2 continue/FINISH with PowerPoint We have only these days left for this 

trimester and your grade: 13th, 16th, 21st
●     Thursday Novembert 8th DAY 5 continue with PowerPoint
●     MONDAY November 5th - DAY 2 PowerPoint For Mrs. Schott > presenting a section of your book to do 

in pairs.

1.  PowerPoint begin (notes to start) 
2.  The seven points of a good slide show 
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 at http://neuage.info/t-p.htm 
especially slide number 15

3.  Using PowerPoint Firstly, Open Power Point from Macintosh HD applications 

. 
4.  See these beginning notes 
5.  For grades see...

●     Friday Novembert 16th DAY 5 TODAY'S ASSIGNMENT IN MOODLE (after you finish this below)

1.  We will continue with making webpages in Dreamweaver for this trimester. Once Dreamweaver is 
open we will look at some overall structures of this package. Making webpages is our goal. Dreamweaver 
is one of many ways to make a webpage. In grade 7 we will make Webpages from a program called 
Fireworks and in grade 8 we will be using Flash to make dynamic and interactive pages. In ninth grade 
we will be making webpages from scratch with out the aid of a package like Dreamweaver. Today we will 
learn a little of what is behind making a webpage.

2.  Open your file early.html from your list in files. Your file should be under Site 

. We will continue with what we were doing last class. This 
time I will work with you on your computer screen at the same time you are. Continue with adding 
content to your table. In your first table column you were putting images from Early Sumeria. Today we 
will change our table headings later. 

3.  In the left-hand corner of your Dreamweaver window you will see these three buttons 

We will look at these now.
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4.  This is the basis for all webpages =  everything goes between 
these headings. A basic web page is composed of 2 main tags. If you create a web page without these 
tags you will be in trouble! 

5.  <head>
6.  This comes immediately following <html> and is used to tell the browser useful information, such as: 

the title of your page, the topic of your webpage ( used on old search engines ) and more. 
<title>

7.  This tag must comes between <head> & </head> and will label the web browser's title bar, which is 
located in the top left of most browsers. In the previous example, we titled the page "My Own Webpage!" 
and that text would show up as the browser's title. 
<h2>

8.  This is a header tag. It will create a "header" that is much larger than the default font size. The "h2" 
means that it is the 2nd largest header. The largest header is "h1" and the smallest header is 
"h6". Headers should be used for titles, just like the ones you see on this page. 
<p>

9.  This is a paragraph tag. So when you're writing a paragraph make sure you place <p> at the beginning 
of the paragraph and </p> at the end!

10.  The first HTML tag, which is labeled <html> tells the browser that your HTML code is starting. The 
second HTML tag, <body> tells the browser that the visible part of the webpage ( your content ) is going 
to start.

11.  You might be wondering what is the deal with the two tags at the end, </body> and </html>. These 
tags are telling the browser that certain tags are ending. The </body> lets the browser know that your 
content is ending, while the </html> tells the browser that your HTML file is finished.

12.  The "/" that is placed before the tag's name informs the browser that you would like to stop using the 
specified tag. <tag> is used to begin a tag and </tag> is used to end a tag.

13.  HTML Tag Order - Important! The order that opening tags appear and ending tags appear follow an 
important rule. If an HTML tag is opened within another, for example the body tag is opened inside the 
html tag, then that tag(body) must close before the outer(html) tag is closed.

14.  We ended the body tag first because it was opened most recently. This rule of "closing the most recent 
tag before closing older tags" applies to all HTML tags.

15.  Now look at the Code view of your early.html clicking the Code button 
16.  Here is an example of a simple code and what it looks like in your browser: 
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17.  Open Moodle and answer the questions there.

●     LOOKING AT YOUR DREAMWEAVER PAGE = Be sure that these three items [Insert, Properties, Files] are 

checked in your Window Menu  
●     Look at the code in code view and see how much is there. Next class we will start to add more to our 

table and learn what the code is to make a table.

October
●     WEDNESDAY 31st - DAY 5 Period 5 12.30 - 1.15 For some odd reason students think they should do 

something in line with halloween today so for today's work make a halloween based image in photoshop 
and put it in your tri folder. 

●     THURSDAY 25th - DAY 2 Period 3 - 10.45 - 11.25 
●     MONDAY 22nd - DAY 5 Period 5 12.30 - 1.15 Open Dreamweaver. 
●     WEDNESDAY 17th - DAY 2 Period 3 - 10.45 - 11.25 Open Dreamweaver and a new page (File > new > 

blank page) then save it as titled early.html. Make a heading at the top of the page in large colored font 

Early Sumerian. On the menu-bar at the top of your page click on Window > Insert
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 to open this menu > 

 Click on the Common bottom on the 

menu. We will use the buttons on this menu for now. Firstly, click the insert email >  and put in 

your name and Dwight email address > . Next, 

click on the table icon . 
●     Use these numbers in your table (five columns and five rows. Have it set to pixels as I have below. And 

give it some padding and cell spacing.  You will 
now fill your table - each cell with something groovy - like horses, baseballs, stores, tests, computer 
games, songs and so on and so forth. You will need to drag images to your desktop then insert them 

into your page. Click the image icon  which will open this > 
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. Navigate to your image and click on its name. This box 

will appear  Click yes and save it in your 
images folder. Put an image in each of your table cells.

●     FRIDAY 12th - DAY 5 Period 5 - 12.30 - 1.15 6* link index>writing. If you did not finish your setup on 
Tuesday (last class) then you will need to complete that first. 

●     TUESDAY 9th - DAY 2 Period 3 - 10.45 - 11.25 THIS PAGE IS AT http://fc.dwight.edu/studentweb (year 
6 - notes)

Open Dreamweaver

Continuing with our web page. Everyone now should have an index.html page which is you basic 
home page. When you open Dreamweaver and Files you should see your folder at the top with a 
sub-folder in it titled 2007-08 and a sub folder in that titled tri1. 
In your tri1 folder you should have your index.html file (your homepage for this trimester – we will 
make one for each trimester). 
In your tri1 folder titled images. You will keep your images for this trimester here.

1. At the top of your Dreamweaver page be sure you have Window > Files open . Create a 
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new file by using 

the dropdown menu at the top/right (the little lines  ) of the “files” 

 and name this file early-writing.html (you may have 
already done this). 

From your index.html file make a link to your early-writing file in the properties menu at the bottom 
of your page. If you do not see "properties" that means you have 

not ticked it in the Window menu . You will put the page you want to link to in the Link box 

 (you can 

point to a file in your folder using 'the point to file"  and dragging the line to your file. The target 
is whether you want to open your page in a new window or in the same window you are currently in.

On your early-writing file insert an image (and you should have one on your desktop)  from an 
early writing tablet (cuneiform).

From this site http://www.wsu.edu/~dee/GLOSSARY/CUNEI.HTM  

Find out what these two pictographic mean;  and 

and write a brief description (do not copy and paste from the website but use your own words). 
Insert these pictographic onto your early-writing webpage (you will need to drag them onto 
your desktop from this page then insert them into your page – be sure to save them in “images” folder 
in your tri1 folder in your 2007-08 folder.

On your webpage go to “Modify” > “Page properties” and choose a background.

In “title” at the top of your page if you have not already changed it from “untitled” change it to 

Sumerian Writing. 

●     

http://neuage.org/dwight/6th/6a/notes.html (7 of 9) [3/9/08 12:08:36 PM]

http://www.wsu.edu/~dee/GLOSSARY/CUNEI.HTM


Year six daily notes for year six

 

●     WEDNESDAY 3RD - DAY 5 Period 5 - 12.30 - 1.15 We will continue with early writing > cuneiform 
script. 1. In Moodle answer the questions. 2. Open Dreamweaver and open Site 

then 

new site >  and name it tri1  Start a new page by going to File > 

New > Blank Page then Create 

 and save it as early_writing.html.
●     FRIDAY 28th - DAY 2 Period 3 - 10.45 - 11.25 

What we be doing, starting this class, is to explore the evolution of writing; from five-thousand years 
ago to what you read on your mobile phone. 

Firstly, create a new Dreamweaver page  
Select Blank Page and layout = none 

 /  and save it as 
sumerian.html. 

Begin looking at early writing - go to http://www.mesopotamia.co.uk/writing/home_set.html  
See also http://fc.dwight.edu/Login/__WWW/studentweb/6th/SumerianLogographs.htm  
include an image on your new webpage and reference it such as 

 "Sumerian Writing" from http://www.mesopotamia.co.uk/
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Year six daily notes for year six

writing/home_set.html viewed September 25, 2007 and be sure there is a title in the titlebar 

 

To make links go to the toolbar, usually at the bottom of your page and put in the complete URL and 
target whether you want your viewer to open a new page or the page they are on... 

. 

On your  new groovy webpage you will start writing about your research into early writing. What, for 
example, is similar between writing five-thousand years ago and writing on your mobile phone or in 

Instant Messenger?  Hint…. What are emoticons??? 

September 2007 
●     Tuesday 25th Day 5 Period 5 continue with setting up your index page in 2014 folders [last class got as 

far as creating index.html pages - begin with making copies of index.html for each folder (name/
images/6/tri1) then put images folder in tri1folder and then tri1 in 6 folder] 

●     Thursday 20th Day 2 Period 3set up your index page in 2014 folders 
●     MONDAY 17th - DAY 5 Period 5 - 12.30 - 1.15 [1] Sign up or into Moodle and answer today's 

question [2] Setting up your folder in First Class /
●     MONDAY 10th - DAY 2 Period 3 - 10.50 - 11.35 Setting up your folder in First Class / Sign up or into 

Moodle and answer today's question
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scratch

ALL THING SCRATCH AT DWIGHT  

reference   projects 
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scratch projects

Your project will be linked from here Return to notes for trimester two

scratch Project 1 Project 2 Project 3 Project 4
Naomi Adago 
                           

    

Michael Asali 
                           

    

Lawrence 
Edelstein      
              

    

Alix Feldman 
                           

    

Shammiel 
Fleischer-
Amoros        
              

    

Lenna Frechen 
                           

    

Sophia Gorai 
                           

    

Sasha 
Grunberg    
              

    

Alexander 
Hagani           
              

    

Benjamin 
Hecker          
              

    

Sergei 
Klebnikov    
              

    

Gabriel 
Korngold     
              

    

Aurelie Langue 
                           

    

Camilla Longo-
Dente             
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scratch projects

Ram Purovic 
                           

    

Unnur 
Sigurgeirsdottir 
                           

    

Rachel 
Steinman     
              

    

Lisa Van Leer 
                           

    

Grace Villa     
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7a

Today's Class 7a Technology Portal >>> ONE ADDRESS FOR EVERYTHING 

= http://fc.dwight.edu/studentweb 

Trimester Two (one)  Plan for rest of year Google Sketchup (home, our notes)

 
Return to year 7 Home / Calendar / Student's page / Moodle / Wiki / My Dwight / Curriculum Map / 

First Class - email is on your desktop - from home log in here

Assessment Criteria for the IB MYP 

TECHNOLOGY
Criteria Name Max
A investigate 6
B design 6
C plan 6
D create 6
E evaluate 6

F attitudes in 
technology 6

Daily Behaviour = three points each class if there are no infractions: infractions = - 2 points 
for interruption or talking when I am, - 3 points playing games and - 5 points for 
touching someone else's computer. 

Final SketchUp Project: See Rubric

* Use Google SketchUp (our notes - our index) to create a 3-D version of The Dwight School and to 
label using pictures 

February 
TUESDAY February 10th - DAY 5       Parts of a computer and network systems today Computer Components

February 8 Day 3  see rubric - for grade for designing one other class room creating your own furniture.

 

 

JANUARY 2008
  Continue with creating the computer labroom this is one of four projects for this trimester grade. 
Put your lab into Central Park.

See Google tips for these steps
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7a

The first step is to select the location for your SketchUp model. In the Fly To window, type Central 

Park, New York, New York  

THURSDAY 31ST- DAY 3 Working in Sketchup 
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7a

●     If you eed to delete the person at startup select and delete > 

delete

●     Make a simple doghouse 

doghouse

FRIDAY 25Th - DAY 5 Assembly Day Period 6 1.25 - 2.00 Watch the series "Building 3D models"

WEDNESDAY 16Th - DAY 5  Sketchup - 

1.  Have the large toolset open on your desktop (View > Tool Palettes > Large Tool Set

jiopj

2.  Before continuing with you current project (building a house) open a new file and try each tool.
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7a

3.  Investigate 3D Warehouse > 

3d warehouse

 ANSWER THE QUESTIONS 
IN MOODLE

4.  Follow the link > Help Model a City 

model a city

 Read the FAQ section on the 

info

 page.
5.  Print your first model... 

MONDAY 14th - DAY 3 

1.  Moodle MYP Survey
2.  Sketchup 
3.  Notes: As you are modeling, SketchUp gives color-coded feedback regarding exactly where the cursor 

is within your 3D modeling space. Green dots = Endpoints, Red dots = On an edge, Cyan Dots 
= Midpoints of edges and Blue dots = On a surface. Red, Blue and Green lines correspond to 
axis directions. Magenta lines indicate something is parallel or perpendicular to a particular edge.

TUESDAY 8h - DAY 5 Begin using Google Sketchup. Follow and use basic tools to make a house. 
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7a

DECEMBER 2007
TUESDAY 4th - DAY 3 - Photoshop project. We are enlarging this photo >

 Each of you will have a section to work with. The 
final result will be an 11 by 8.5 image that will be printed on glossy paper and put together as a 
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7a

large thingy for our wall. . 

Here is the process - don't stuff it up!!!!!

1.  Click on your desktop and select go at the top > 

2.  Connect to Server 

3.  Type in fs.dwight.edu and open 

4.  Choose 2013 group folder (not 2013) 
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7a

5.  Open the class2013_final folder 

2013

 
6.  Select the file/image assigned to you.

7.  

8.  Click on your image then select Image > Image Size 
9.  Change your image to 11 x 8.5
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7a

10.   
11.  Be sure you have Grid showing. If not go to View > Show 

>Grid 
12.  Click on Photoshop in your top level corner then Preferences > Guides, Grid, Slices & Count

 >>> 
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13.  Put in these numbers 

14.  Using the selection tool > 
wow

 Make a rectangle around one square division 

>  
15.  Insert a photo of you into this square - it should be about 2 square inches (you will need to resize 

your photo using the same method as above Image > Image Size ) so that fits into your square in 
your picture. NOTE: This can be placed in any square that will not interfere with the over all 

picture itself>  

16.  Be sure the Background Content is set to Transparent.  
17.  You will write a short verse/poem/thought next to your picture. Select the Text Tool > 

 and go-for-it

18.  With your text selected > on your photoshop menu select "Create Warped Text" >>>  
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>>>> Select a shape 
19.  Your end result should be similar to my image at the top of this assignment.
20.  Save and print your photo. Save it to your desktop for later use when we have glossy paper.

 

 

Photoshop project.

DAY 5 We will work on our homepage in Dreamweaver. 

Create a new folder in your site folder and name it tri2 then add files for example:
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MONDAY 26th - DAY 3 Next class we will begin Google Sketchup. As I will be putting your grades 
up tomorrow today is your last chance to finish any assignments on Moodle. You will also be assigned 
a computer for you to use each class as it will have your preferences on it and will load faster.
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semester two notes for 8b

Middle Years Programme Technology for 2007 - 2008 at The Dwight School with Dr. Terrell Neuage 

JUMP TO Today

computer classes homepage 8b Return to year 8 Home / YEAR 8A STUDENT'S PAGE / Calendar 
2/ Moodle / Wiki / My Dwight / Curriculum Map / Assignments / How Middle School Boys and Girls 
View Todayâ€™s Computer Culture Criterion for trimester two and more notes

Trimester Two  
Theme for Trimester Two is advertising. Software we will 
use: Photoshop, Dreamweaver, Word, Excel

* Essential Questions: Why do people advertise products? What techniques do advertisers use? How 
can we identify them? 
* Content: ADVERTISING *Uses of advertisements *Common themes in advertising *Product Placement 
* Skills: To become familiar with advertising techniqes. To think critically about how media 
messages are constructed. 
* Assessments: Students write a timed essay based on an advertisement they view. Students take a 
quiz on the 'techniques of persuasion'. Students create a webpage on media techniques. 
* Resources: Files in Media Literacy Folder (in the Grade 8 Advertisement folder)

Daily Behaviour = three points each class if there are no infractions: infractions = - 2 points 
for interruption or talking when I am, - 3 points playing games and - 5 points for touching 
someone else's computer.

 

http://www.mogulus.com  http://www.mogulus.com/dwightschool   http://www.mogulus.com/2012

FEBRUARY 2008

  TUESDAY February 12th - DAY 5  
1. Sign up for Activities 
2. Rubric for advertising grade

  FRIDAY 8th - DAY 3 continue with ad and look at webtv

 

MONDAY FEBRUARY 4TH - DAY 5 Using Indesign Template make a brochure for your product. 
Choose one from the four templates. One person in your group does one side or two columns and 
the other person does the other side. Replace the title with your prouct name and images and script.

THURSDAY 31ST- DAY 3 Finish logos and write your primary slogan - view this site on slogans 
and wikipedia and top ten slogans of the century. View seven basic steps in planning the ad campaign. 

FRIDAY 25Th - DAY 5 Assembly Day Period 1 8.40 - 9.15

Work on logo in Photoshop and slogan. 

First part of class will be demo on Photoshop created Logo. Start with the tutorial " 
Logo making" (another tutorial for logo making), also see Lesson one in Photoshop in our text book 
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semester two notes for 8b

"The Desgin Collection Revealed"

WEDNESDAY 23rd - DAY 3 

1.  The 'Narrowcasting' Future - answer in Moodle. 
2.  Work on logo in Photoshop

FRIDAY 18th - DAY 1

1.  Moodle MYP Survey

= WEDNESDAY 16Th - DAY 5  - The “Narrowcasting” Future - answer in Moodle. Work on logo 
in Photoshop

TUESDAY 8h - DAY 5 - 18 minutes > The Persuaders video part four The Science of Selling. Answer 
the questions in Moodle. Copy into your Dreamweaver folder for tri2. Begin brainstorming your 
project and start notes.

DECEMBER 2007

Friday 7th - DAY 6  
5 minutes > Handouts for essay questions. 
15 minutes > The Persuaders video. We will watch the third section "The Times They Are A-Changing". 
Answer the questions in Moodle - ten minutes. 
Copy and paste your responses in Moodle into your tri2 > persuaders folder as 3. Be sure you have 
done the same for 1 and 2. 

WEDNESDAY 28th - DAY 5 
5 minutes > Handouts. 
15 minutes > The Persuaders (notes) We will watch the first section "A High Concept Campaign". 
Answer the questions in Moodle - ten minutes. 
Dreamweaver > create a folder "tri2" in your site-folder and create an "index.html" page. Create 
another file "advertisement" and make a link in your advertisement page to your "home" page 
which should be in your site folder.  
MONDAY 26th - DAY 3 This is trimester two - however I will put your grades in this afternoon 
giving you today to finish. See your score so far from the spreadsheet I will show in class.
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InDesign Index

InDesign

●     print booklet
●     saving to older versions of inDesign
●     workspaces 
●     Adobe Bridge (over troubled designs)
●     Exploring the InDesign Workspace 
●     Working with Text 
●     Setting Up a Document 
●     Working with Frames 
●     Character and Paragraph Panels labeled
●     PowerPoints Lesson 1, 2, 3, 
●     Impose a document for booklet printing
●     multifile placement
●     InDesign CS3 Inside InDesign CS3!
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TRIMESTER TWO year 10

TODAY
TECHNOLOGY HOMEPAGE year ten Return to year 10 Home / Daily NOTES / Calendar/ 

Moodle / Wiki / My Dwight / Curriculum Map TRIMESTER 
TWO (ONE)

Flash and webpages for mobile 
phones
2007
January
MONDAY 14th - DAY 3 
The scripts for some of these are in the group 10 folder 
(tech10-tri2-Flash-saved-files) and handouts for some are in 
the folder 

1.   
2.  
3.   Source Files in this folder ~ tutorial notes 

available
4.   Source Files in this folder ~ tutorial notes available
5.   Source Files in this folder ~ tutorial notes available

6.   Source Files in this folder
7.   Source Files in this folder

using our handouts and the files in group10folder
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TRIMESTER TWO year 10

Friday 7th - DAY 6 

1.  Put some photos as described in class in your newly created assists folder.
2.  Using the Handout Project 5 "Building a Digital Autobiography" go as far as page 

191. Save your work in your folder. 

TUESDAY 4th - DAY 3 Criterion C: plan
●     Construct a plan to create a flash webpage that has a series of logical steps, and 

that makes effective use of resources and time.
●     Evaluate the plan and justify any modifications to the design.

1.  Plan a site for Flash layout f (page Flash 1-32) 

 See Web page - content 
template example

2.  Do this in Word 
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TRIMESTER TWO year 10

 
Be sure you have the Drawing Toolbar chosen (View > Toolbars > Drawing) 
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TRIMESTER TWO year 10

 
3.  Print and hand in your idea for a flash site - it can be a story, a game (scene 1, 

scene 3 and etc.), or a webpage
4.  From our book Flash 1 - 30 > 1 - 41
5.  In Word answer the questions on Flash 1 - 40 which directs you to http://www.

argosycruises.com/flash.cfm.

THURSDAY 29th - DAY 6 Page 1-14 > 1-15 and Page 1-18 > 1-19 and 1-23 > 1-
25, and 1-28 > 1-29

26th - DAY 3 Begin Flash overview of trimester. How to create a mobile phone page. 
Using the Design Cycle to begin. What we will view together:

1.  Mobile Flash Art: cell phone as artistic platform
2.  Mobile phone movies 
3.  Los Viajes de King Tiny (youtube version)
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TRIMESTER TWO year 10

4.  01design
5.  Making a Film for the Really Small Screen
6.  Flash lite
7.  Adobe Device Central

In the text book read pages Flash 1-2 > 1-9 and do the exercise on pages 1-9 > 1-11
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Untitled Document

Trimester two Flash
Flash Flex 

Web page - content template example
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daily notes for Design ten

 
 

year ten design DAILY NOTES Return to year 10 Home / student work / Calendar/ Moodle / Wiki / My 

Dwight / Curriculum Map TECHNOLOGY HOMEPAGE InDesign notes
Assessment Criteria for the IB MYP 

TECHNOLOGY
Criteria Name Max
A investigate 6
B design 6
C plan 6
D create 6
E evaluate 6

F attitudes in 
technology 6

Check here at the start of class for what we will do today ~ as well as for any 
special notes. Today's class will be at the top of the list. HOME PAGE FOR 
TECHNOLOGY COURSES 

TRIMESTER TWO
November 2007 

●     FRIDAY 16th - DAY 5 continue with 3-14 > 3-17 and print your work. Read pages 3 - 18 > 3-
21 We have only these days left for this trimester and your grade: 16th, 20th

●     MONDAY 12th - DAY 1 Lesson 1 INDESIGN 3-4 3-9 and do the exercise on pages 3-10 > 3-
17 PRINT YOUR FINISHED PAGE AT 3-17

●     THURSDAY 8th - DAY 5 Lesson 3 > 2 - 20 > 2-29. Create and Apply Styles. You will need to 
have character styles panel open 

●     Adobe Bridge For a video on using Bridge see www.adobe.com/go/vid0090
●     Chapter Three. Setting up a document. Pages 3-2 > >

●     The x Location value is the horizontal location - 
how far it is across the page / The y location value 
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daily notes for Design ten

is the vertical location - how far it is down the page.
●     Understanding Master Pages (3-5) To have all your pages look the same use Master Pages; 

Firstly, go to "pages" , double click A-Master  

then go to layout  and in the dialogue box Margins and Columns 

 change the columns number to what you want - 
for example, three... then go any page and see that it has the number of columns you selected.

●     Using the Transform Panel > (page 3-7) 
●     Uing the Control > Page 3-8 
●     Using the Transform Panel Page 3-9
●     FRIDAY 2nd - DAY 1 Period 3 - 10.50 - 11.35
●     Open ID 2-1.indd [Either from your desktop or from the Group Ten Folder . InDesign > Chapter 

2] Do the exercises in the orange column on page 2-8 > 2-11 and 2-16 > 2-19 and 2-22 > 2-
25 > 2-28 - 2-29. For our first quiz do the exericse on page 2-32 and on page 2-36 and save 
it for marking. InDesign panels

●     WEDNESDAY 31nd - DAY 5 Period 3 10.50 11.35 Halloween photoshop
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●     WEDNESDAY 24th - DAY 1 Open ID 2-1.indd then save it to your folder or desktop

1.  Using the 'Making text selections' table on page 2-5 try the various selections. Firstly, change 

the zoom to 150%. Choose various text and change the colour  and the font and size and 
etc in the character panel. Try the things on pages 2-6 > 2-7 and do the exercise in the orange 
columns on pages 2-11. Continue with the rest of the text chater, doing the exercises on pages 
2-16 > 2-19 and on pages 2-22 > 2-25 and 2-28 > 2-29.

2.  For our first quiz do the exericse on page 2-32 and on page 2-36 and save it for marking.

●     MONDAY 22nd - DAY 5 Period 3 10.50 11.35 Tech 10 For the next several classes we will use 
Adobe Indesign CS 3 with the end result of making a brochure for MYP The Design Cycle. 
Approaches to Learning. You will have the cover and three panels: 
Cover will be your design and headings 
* How do I learn best? There will be a text box with your individual Strategies 
* How do I know? There will be a text box with your individual Strategies 
* How do I communicate my understanding? There will be a text box with your individual 
Strategies

Each of these panels will be individualized for your approach with a graphic.

Starting InDesign CS3. 

1. In your applications folder open InDesign CS3 (not CS2) 
2. We have a text book that we will follow - please collect one then return it at the end of the class. 
3. Our student files that are used in the book are in (on your desktop menu at the top 

) click on "Connect to Server". Navigate to the group folder Go > Computer > 
2011 GroupFolder > DataFiles > InDesign > Chapter 1" and open InDesign and Chapter One and 

click on . If the ' ' box appears click it . We will go through 
the panels of InDesign. Look at the Toolbox overview and pages 1-2 > 1-9. Try each tool.
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1 InDesign: Exploring the InDesign Workspace •          Explore the InDesign Workspace 
•          Change Document Views 
•          Navigate Through a Document 
•          Use InDesign Help 

●     FRIDAY 12th - DAY 5 Period 3 - 10.50 - 11.35 creative tech 10 Hank's image in Photoshop

This is the section you are responsible for don't muck it up... it must be finished today as I have to 
present it next Monday.

Reya Benitez > (1) Width = 1-12, (2) 12 - 24, in the first row (1 - 12 down) (with each section 12 
pixels height)  

Aimee Daniels > (3) 24-36, (4) 36 - 48, in the first row (1 - 12 down) (with each section 12 pixels 
height)  

Gabrielle Gaines > (5) 48 - 60 in the first row (6) (1 - 12) in the second row (12-24 down) 1- 12 W 
across  

Vittoria Kamen > (7) 12 - 24 W, and (8) 24 - 36 W > in the second row (12-24 down) 

Maxwell McDermott > (9) 36 - 48 and (10) 48 - 60 W in the second row (12-24 down) 

Adam Mitchell > (11) 1-12 and (12) 12 - 24, in the third row (24 - 36 down) 

Erica Moser > (13) 24 - 36 W and (14) 36 - 48 W in the third row (24 - 36 down) 

Kenzo Semper > (15) 48 - 60 in the third row (24 - 36 down) and (16) 1 - 12 in the fouth row 
(36-48) down 

Luke Soloway > (17) 12 - 24 W, and (81) 24 - 36 W > in the fourth row (36-48 down) 

Katharine Yellin > (19) 36 - 48 W and (20) 48 - 60 in the fourth row (36-48 down) 

> (21) 1 -12 W and (22) 12 - 24 in the fifth row (48 - 60 down) 

> (23) 24 - 36 W and 3 (24) 6 - 48 and (25) 48 - 60 in the fifth row (48 - 60down) 
 
1. Finish the photo - your section and blow it up to 11 inches wide then print your section - Once 

you have your section then re-size it 

resize

 to 10 inches wide > 
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IMPORTANT - put your name on the back and the section your did; for example, (25) 48 - 60 in 
the fifth row "Fideo". This should not take more than 13 minutes to complete. Lay it all out on the 
table to see that it looks complete then put it in the folder that is provided [Cadra]. 

2. Using your image go to FILTERS > ARTISITC and select DRY BRUSH with the same settings as 
shown here and do your selections using these settings tne put them in the folder provided [Cadra]. 
Be sure to put your name on the back and the section your did; for example, 10 - 20 H and 1- 12 W 
"Fideo

 THEN 
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●     WEDNESDAY 3RD - DAY 5 Period 3 - 10.50 - 11.35 For the next couple of classes we will be 
working on a photo of Henry Cadra. I have put this photo in our Studentweb 10 design folder. 
Navigate there and put it on your desktop. We will be enlarging this photo to about five square 

foot. 

Cadra

The way we will do this is to divide the photo into 35 segments with each of you having 3 segments 
to blowup. Firstly. open photoshop and open the photo of Mr. Cadra. You will take your sections and 
enlarge them to 11 inches by about 8 inches.

Be sure the ruler is showing (View > Rulers). Each person will have a section that is 12 X 10 pixels. 

Save your section by the number; and as .jpegfor example 1.jpeg 

first section
 

showing

 and 
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at maxium quality.

max

 to your desktop. Once you have 
your three sections drag you three images into the Cadr folder in studentweb (10-design)

Once you have your section then re-size it 

resize

 to 10 inches wide > 

 

September 2007 
●     THURSDAY 27 th - DAY 1 Period 3 - 10.50 - 11.35 Dreamweaver: The Insert Bar, Layout Insert 

Bar Review these URLs and then review five websites and fill in the Scoring sheet ----- 

http://neuage.org/dwight/10design/notes.html (7 of 8) [3/9/08 12:09:42 PM]

http://neuage.org/dwight/checklistforwebdesign.html


daily notes for Design ten

Website Design Rubric that we will follow for all 
webpages / Ten things to think of with Web 
Design /

●     TUESDAY 25h - DAY 5 Period 3 - 10.50 - 11.35 Begin with Dreamweaver - Setting up a root 
folder HANDOUTS [set up folder, played with text, inserted image and used page properties.

●     WEDNESDAY 19th - DAY 1 Period 3 Set up your folders in Firstclass

●     MONDAY 17th - DAY 5 [1] Go to our Moodle and answer the questions about Rhino in News 

Forums. [2] Setting up our folder in firstclass
●     FRIDAY 07 DAY 1 Introduction - viewing our site, logging onto Firstclass
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indesign semester two

 
 

TODAY'S CLASS 
year ten design DAILY NOTES Return to year 10 Home / student work / Calendar/ Moodle / Wiki / 

My Dwight / Curriculum Map TECHNOLOGY HOMEPAGE InDesign 
notes TRIMESTER TWO (one)
January 2008

TUESDAY 8h - DAY 5 In our book we will continue until the end of 
InDesign before starting a project. Finish chapter 5. You will need to open 
ID 5-1.indd

December 2007

Monday 

 

 

10th - DAY 1

1.  Page INDESIGN 4-3 Tools you'll use > Have them on your desktop
2.  OPEN ID 4-1 FROM YOUR GROUP FOLDER () CHAPTER 4 Read Pages 4-2 > 4-9 and do the exercise on 

4-9 > 4-14> Read Paages 4 - 14 > 4-17 and do the exercise on pages 4 - 18 > 4-23Working 
3.  Save your work as Ch 4-1 in your folder in the 2010 Design then Print and Hand Up your work 

FRIDAY 30th - DAY 1 start a four page document with no columns. Give it a title then "place" 
and image. We will work with images and text on pages today. Select your image then click the fx 

icon  at the to p of your window. You will see this drop down menu 
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dropdown

. Select Directional Feather >  

 .Select breakapart   and Bottom put in a number 
to feather with.

 

WEDNESDAY 28th - DAY 5 We will continue with InDesign 3-14 > 3-17 
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Notes for Illustrator CS3

Syllabus
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Return to InDesign Year 10 Design Year 9 Design
 
 
1 Illustrator: Creating Text and Gradients • 1.      Getting started Chapter One: lesson 1 & 2 pages 

Illustrator 1-2 > 1-17 Downloading the file Al 1-1.ai from 
our folder on the server.
•2.      Create Basic Shapes pp. 1-18 > 1-29
•3.       Transform Objects  pp. 1-30 >  1-41
4. ASSESSMENT Project Builder 1 & 2 pages 1-44 > 1-45
• 5.         Create and Format Text Chapter two pages: 2-2 > 2-
15 
•6.          Position Text on a Path PP 2- 16 > 2-19
7. ASSESSMENT create your own logo with your name 
and a paragraph about yourself in the centre.
•8.          Create Colors and Gradients pp 2-20 > 2-33
9. ASSESSMENT pp 2 - 37 and 2-38
•          Adjust a Gradient and Create a Drop Shadow

2 Illustrator: Drawing and Composing and Illustration •          Draw Straight Lines
•          Draw Curved Lines
•          Draw Elements of an Illustration
•          Apply Attributes to Objects
•          Assemble an Illustration
•          Stroke Objects for Artistic Effect
•          Use Live Trace and the Live Paint Bucket Tool

3 Illustrator: Transform and Distort Objects •          Transform Objects
•          Offset and Outline Paths
•          Create Compound Paths
•          Work with the Pathfinder Palette
•          Create Clipping Masks
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Computer Concepts @ Albany Acade

Computer Concepts @ Albany Academies
Dr. Terrell Neuage neuaget@albanyacademyforgirls.org    

Mission statement 
 EELS

 
The mission of technology at Albany Academy and Albany Academy for Girls  is to 
optimize, enhance, and expedite creative and critical thinking in a technology-based global 
society. Technology is integrated into cross-discipline curriculums in order to develop the 
cognitive skills necessary to communicate in a diverse culture. 
 
Technology at the Academies prepares students for life-long learning whether in the arts, 
the sciences, or in literature.
 
Here are some examples of cross discipline projects.
 

1.      Integration with the Arts Department in  Music Industry I and II for grades 
9-12
2.      We are working on a collaborative project with chorus for Evening of the 
Arts
3.      Integration with the English department; Computer Writing , exploring 
writing children stories in Macromedia Flash as well as electronic poems
4.      We explore nanotechnology in our Essential Technology course.

                        
Technology at the Academies encourages problem solving, exploration, and learning in and 
out of the classroom, promoting higher-order thinking and technological literacy.
 
Activation and Guiding Principles
 

•        Technology should not drive the curriculum but should be used as an appropriate 
tool in the learning process and training will facilitate this. 
•        The technology department at the Academies will provide access and training of 
technology for all staff. 
•        The technology staff will provide leadership and guidance for faculty, 
administration, and other school personnel in the areas of hardware, software, 
application, and usage to support and enhance the instructional program for students 
across all curricular areas. 
•        When new technology is acquired the means and training to use it successfully and 
responsibly will be provided. 
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 Please direct questions to Dr. Terrell Neuage neuaget@albanyacademyforgirls.org 
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Professional Development at AA and AAG

Professional Development from the computer department http://www.albany-academy.org/
compcon/

All teachers and staff from AA and AAG are invited to Room 2- 8 (at AA, go up one floor, turn 
right, last room on left or go up one floor and turn right > dependent on where you are at and 
where you are coming from)

If there is something you want to learn or need to know - do not put off getting up to date with 
technology. If I do not know what you need let me know and I will find out how we can get help. 
For example, if you want to add music samples we have the programs and the person to show it. 
(We have Sony Acid Music Studio 6 and Finale 2005b)

NOTE: we have a license for full access to the VTC Online University for the next twelve 
months on the teacher computer. There are more than 300 courses with more than 35,000 
instructional movies. There may be a course of interest to you. Check it out at VTC Online 
University. It is not a site license so you would need to book in time to use these videos.

Workshops, individual or group, will be in the following areas:

The Microsoft Stable:

�❍     Outlook    (emailing: folders, contacts, organisation, using the calendar)
�❍     Word
�❍     Excel

�❍     PowerPoint
�❍     Publisher

�❍     Acces

The read world:

■     Blogging 
■     Wiki 

(Wiki-Blog: Weblogs and wikis are two technologies that make it possible for readers to write 
the web as envisioned by, Tim Berners-Lee's, the creator of the web.)

[fishbowl] Wiki (In general, the term "fishbowl" is used for any sort of discussion where part of 
the community can observe the conversation but may not participate. In some cases, the presence 
of an active conversation and the identities of the participants is all that is known, while in others, 
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the words being exchanged are also revealed. This type of Wiki is ideal for teachers) 

■     RSS (Really Simple Syndication) Feeds 
■     iPods, Vodcast (Video Podcast)

■     Web Pages (Macromedia MX 2004: Flash, Fireworks, Dreamweaver), Final Cut 
(video editing), Adobe (Photoshop 7 and Photoshop CS2, Illustrator and etc)/

NewsGroups/Usergroups and etc.
■     CAD and 3-D modelling using Rhinoceros NURBS modelling  software. We have several 

products available on all 18 computers to enhance your Rhino modelling experience such 
as ‘Flamingo’, a rendering plug-in; 'Bongo', an animation tool and 'Penguin' which 

brings freehand sketching, watercolour painting and cartoon-like rendering to Rhino and 
AutoCAD.

■     Sony Acid Music Studio 6 on 17 computers
■     Finale 2005b on 10 computers

■     Ulead's Gif Animator
■     Ulead's Cool 3D Studio

We will start iPod [Vodcast (Video Podcast)] broadcasting in 3rd trimester
We have the Academies first electronic white board coming soon.

And/or whatever project you want to work on for your class whether you need assistance or not

At this time the computer room is available (with or without my help - if you want to use training 
videos on your own - go for it)

neuaget@albanyacademyforgirls.org

Monday 11 to noon  

Tuesday 11 to noon 3 - 4

Wednesday 10 to 11  

Thursday 11 to noon 3 - 4

Friday  3 - 4
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Electronic Experience Learning System 

Computer Concepts @ Albany Academies

Mission Statement of technology @ Albany Academies [Activation and Guiding Principles]

Teacher's Resource Page

Dr. Terrell Neuage neuaget@albanyacademyforgirls.org  

Electronic Experience Learning System 

 
EELS
 
Technology should provide our students with the ability to learn through active, as opposed to 
passive, systems. This should be accomplished through a creation of an Electronic Experience 
Learning System (EELS - I made this up but it sounds like what could be a way of seeing how to 
do this) with the student utilising the software to learn creatively with current and possibly future 
orientated technology.

Technology today is becoming more individualised with opportunity for personal expression in 
technology we use daily, such as  cell phones (with individualised ring tones and colours), our 
computers (screensavers, carefully positioned icons, software, favourite links and games, and file 
structures). The world is now a possible audience for each student (via bloggs, emails and 
webpages) and it is at this junction between the world and the student that it is necessary to 
provide adequate tools for self expression in a global communicative environment. So computer 
technology changes from being an end in itself to becoming a vehicle for all (or most) disciplines.
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Rhino

Sunday, March 09, 2008 

 
 

Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org 

http://www.albany-academy.org/compcon

Rhinoceros® Albany Academy trimester 1 lesson plan and notes

Monday:         2:05  -  2:55
Wednesday:    1:10  - 2:00
Thursday:       2:05  -  2:55
Friday:            2:05  -  2:55

    

   

 

(compcon being for 'computer concepts' rhino for '3D animation/CAD course'
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Rhino

■     

Daily Notes
 http://www.albany-academy.org/compcon/rhino/notes/index.

htm updated Monday, November 14, 2005

SUPPORT PAGE - and Rhino Wiki ANYTHING YOU WANT/NEED TO 
KNOW 

■     Introduction: http://www.albany-academy.org/compcon/rhino/rhino_intro.htm
■     Syllabus: http://www.albany-academy.org/compcon/rhino/rhino_calendar.htm
■     Grading: http://www.albany-academy.org/compcon/rhino/gradesRHINO.htm  
■     Quizzes: http://www.albany-academy.org/compcon/rhino/quizzes.htm  

�❍     Home page for Rhinoceros http://www.rhino3d.com/ 

�❍     Job offering for Rhino users http://www2.mcneel.com/rhinojobs/jobs.asp 

�❍     Companies which use Rhino http://www.rhino3d.com/userlist.htm 

�❍     Products modeled in Rhino http://www.rhino3d.com/products.htm 

�❍     Rhino is used in thousands of schools world-wide (my son taught a course in Rhino in 1999 at 
Christies Beach High School, South Australia). For example, Yale University offers it in their 
course 866b, Modeling, Animation, and Assembly

Feature Film Art Department use of Rhino

■     Tutorials: http://www.huntfor.com/3d/tutorials/rhino.htm this site has excellent step-by-step 
tutorials to create models in Rhino  

■      Another page of tutorials - these were created when rhino was rhino 1 - we are using rhino 3 but 
some good ideas here http://www.3drender.com/rhino/index.html 

■     Model links A list of links to Rhino Models on other web sites
■     Yearly list of tutorials
■     another Rhino tutorial http://www.tutorialguide.net/3d_software/rhino/ 
■     for a wealth of Rhino Rhinoceros - Related Products and Services 
■     See what is being done at Temple University in Rhino http://www.temple.edu/crafts/ 
■     If you like modelling Sch-Fi look at these images - many done in Rhino 
■     Rhino Plug-ins
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Rhino

■     Car body projects and several tutorials ~ "how to model a car"

For texturing try the tutorials from accustudio these have tutorials on creating exterior 
lighting, interior renderings  as well as animations and etc.

Other 3d Packages that supplement Rhino and are good for rendering and 
background scenery to enhance your models: LightWave 3D (My favourite); 
Maya 3D; Bryce 3D landscape modeling, animation, and rendering software (reasonably 

priced with a lot of packages individually designed for effects); 3D Studio Max (the leader in 3D 
animation and rendering and a good supplement to Rhino); Autodesk® Gmax® is a free 
3D modeling and animation software from the mob that makes 3D Studio max -  gmax 
allows users to produce everything from characters and vehicles to landscapes and props; 
see http://www.turbosquid.com/gmax 

You may purchase your own copy at a student discount from: 

http://www.rhino3d.com/sales.htm 

http://www.academicsuperstore.com

http://www.journeyed.com
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Computer Writing at Albany Academy and Albany for Girls by Dr. Terrell Neuage

Instructor Dr. Terrell Neuage 

 
 

at Albany Academy and Albany Academy for Girls 

 return to computer courses at Albany Academies    

Daily Notes ~ Calendar ~ Blog ~ 
Wiki ~ Gif Stories ~ Flash Poems

Course Description: This is an introductory course on experimental computer writing using 
hypertext, digital storytelling, Online WebPoetry as well as student's critiques of hypertextual 
literature already produced. We use the hypertext writing environment, Storyspace from 
Eastgate.   

Our course, Computer Writing, looks at electronic narrative. Firstly, we will work with 
hypertextual writing. Hypertext is non-linear and multi-linear narrative that is linked according 
to the witness of the story.
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In essence, the reader becomes the writer-narrator, following self-chosen links. Hypertext 
writing shares some interesting features with folk storytelling traditions, for example, Native 
American due to its digressive elements (stories within stories); what is called "a story" is really 
a Web of stories, and like oral telling, in hypertext, no two explorations of a hypertext narrative 
are exactly the same for readers. In hypertext the focus is on the reader and the appearance of 
choice and some determination of how to read, as every part of a hypertext narrative presents 
multiple choices for the direction and sequence of reading. 

We will be reading and critiquing five stories (Samplers, Deena Larsen; Victory Garden, Stuart 
Moulthrop; We Descend, Bill Bly; Patchwork Girl, Shelley Jackson; and Marble Springs, Deena 
Larsen) from Eastgate publishers (http://www.eastgate.com) then we will create our own 
hypertextual stories in the program ‘Storyspace’.

Later in the course we will explore digital storytelling which is the use of images and 
animations to tell a narrative. We will be using Macromedia Flash (examples of poems made in 
Flash) and Ulead’s gif animator to create electronic poetry and self-reflective diaries of 
alternative selves. 

Grading: 

50 % Five "hypertextual projects". You will have two class periods for each "project" [we may 
change this to more or less time once we are involved] to read - maneuver through the 
landscapes of the "project" then one class period to write up your reflections on it. I will provide 
guidelines for this. These responses will be uploaded to our blog. There will be two entries for 
each "project". One of your original reflections and one responding to what someone else in 
our course has written about a "project". Each "project" is worth ten-points; five for your 
critiquing and five for your response to what someone else has written on a "project". SEE 
CRITIQUING HYPERTEXT 

25 % You will do one project for a grade, which must be done on StorySpace. I will provide the 
guidelines for this but it will be about an alternative-self.

25% Other Projects:

5 % =   1. Making a short hypertext poem in Word about a day in the life of you when you were 
a tree.
5 % =   2. Making a short hypertext poem in Flash
5 % =   3. Making a short hypertext poem in Kurzweil CyberArt's program
10 % = 4. Make a group project

Our sources are:
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●     SAMPLERS, Deena Larsen; VICTORY GARDEN, Stuart Moulthrop; WE DESCEND, Bill 
Bly; Patchwork Girl, Shelley Jackson; and Marble Springs, Deena Larsen

●     Dr. Terrell Neuage: Masters thesis (Writing for the Internet) and PhD writings on 
hypertext and computer communication (thesis on line at http://neuage.org/All.htm) 

●     Mark Bernstein is the chief scientist at Eastgate Systems, Inc. which is what our 
hypertexts are written in and which we will be working in. His website is http://www.
markbernstein.org/ 

●     Hypertext Bibliography - a growing source of hypertextual storytelling throughout this 
course

●     Hyperizons 
●     Online Hypertextual Poetry
●     A directory for finding hypertext/cybertext literature published on the Web and on disk
●     Snakeskin
●     Bly, author of "We Descend' has a blog at http://www.infomonger.com/bbly/blog 
●     Kurzweil CyberArt Technologies, Inc., 
●     Kairos

●     What is HyperText
Hypertext is text which is not constrained to be linear. 

Hypertext is text which contains links to other texts. The term was coined by Ted Nelson 
around 1965 (see History ). 

HyperMedia is a term used for hypertext which is not constrained to be text: it can 
include graphics, video and sound , for example. Apparently Ted Nelson was the first to 
use this term too. 

Hypertext and HyperMedia are concepts, not products. 

See also: 

�❍     A list of terms used in hypertext litterature. 
�❍     Conferences 
�❍     Commercial (and academic) products 
�❍     A newsgroup on hypertext, "alt.hypertext" . 
�❍     WorldWideWeb is a project which uses hypertext concepts. 
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Dreamweaver

Sunday, March 09, 2008 

Instructor Dr. Terrell Neuage 

 
 
neuaget@albanyacademyforgirls.org 

Monday:         9:15  -  10:05
Wednesday:    8:20  - 9.10
Thursday:       9:15  -  10:05
Friday:            8:20  - 9.10

Computer Concepts at Albany Academies for 2005 - 2006 Dr. Terrell Neuage 
Ph.D  

●     Notes Trimester One; Notes 2; Notes Trimester Three ~ see notes 
for assignments - reports - project information and due dates

●     Grading: Grading SECOND TRIMESTER:
●     Calendar for trimester two 
●     Blog 
●     Syllabus: Course description, expectations, grading 
●     information about Copyright and Fair Use

http://neuage.org/AA/web.htm [3/9/08 12:09:54 PM]
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Sunday, March 09, 2008 

 
 

Computer Concepts
 

section 760: Essential Technology 
 

Monday:   8.20 -    9.10
Tuesday:   9.15 – 10.05
Thursday: 8.20 –   9.10
Friday:    10.15 – 11.05

 
Dr. Terrell Neuage neuaget@albanyacademyforgirls.org  
BA (journalism), Honours (Adolescent Literature), Master (Internet as Literature) Deakin University, 
Melbourne, Australia; 
Ph.D. (Internet Communication and New Media) University of South Australia  
 
Blog
Wiki
 
Calendar Calendar for Essential Technology at Albany Academy  
Calendar for Trimester Two http://neuage.org/AA/et/et_calendar2.htm 
Calendar for Trimester Three http://neuage.org/AA/et/et_calendar3.htm 
General Information http://neuage.org/AA/et/GeneralInformation.htm   
Grades http://neuage.org/AA/et/gradesET.htm 
 
Daily Notes for individual classes Trimester One: http://neuage.org/AA/et/notes/index.htm 
Daily Notes for individual classes Trimester Two: http://neuage.org/AA/et/notes2/index.htm 
Daily Notes for individual classes Trimester Three: http://neuage.org/AA/et/notes3/index3.
htm 
 

●     1st trimester: Outlook, Word, Office Tools, Blogs, Wikis 
●     2nd trimester: Excel, PowerPoint, Publisher, Access, InfoPath, Nanotechnology, Quantum 

Computation, Internet Technology - Search Engines (Yahoo, Google, MSN, Hotbot, 
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Infoseek, AskJeeves, Altavista, Lycos, Netscape, Altavista and etc.), Internet2,  Digital 
Divides  

●     3rd trimester: FrontPage, HTML. Java Script, Gif Animation,  Hosting WebSites, Pod 
Casting, VodCasting, RSS (Really Simple Syndication), 
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Designing Web Pages

 
 

Designing Web Pages (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works

Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar 

�❍     Monday March 06

�❍     Wednesday March 08
�❍     Thursday 09 March
�❍     10th Friday
�❍     13 Monday
�❍     15th Wednesday 
�❍     16 Thursday
�❍     17 Friday
�❍     03 April Monday
�❍     05 April yes it is Wednesday already
�❍     07 of April Friday again
�❍     Yes it is another Monday
�❍     Happy Wednesday prior to Groovy Thursday (no school) and Good Friday
�❍     Monday April 17
�❍     TODAY
�❍     Day after yesterday 20 - April
�❍     21st April already
�❍     Monday Monday
�❍     Wednesday April 26
�❍     Thursday April 27
�❍     Test FrontPage
�❍     Monday 01 May 
�❍     Monday May 03
�❍     Thursday May 05
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�❍     Monday May 08 Flash Forward
�❍     Thursday is today
�❍     Friday the 12th
�❍     Monday again
�❍     17th May Wednesday
�❍     Thursday 18th May
�❍     Monday 22
�❍     Thursday May 25
�❍     Wednesday May 31
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Albany Academy Computer classes with Dr. Neuage and our wonderful commercials

Albany Academy Computer Project: Commercials in 
Flash 

Back
Computer Concepts 
Home 

*Web class 

*ET class 

*CREATIVE 

DESIGN Class 

Commercials

Kathleen 
Valerie 
Christopher 
Alexa 
Stephen 
Thomas 
Nicole  
Vivian 
Jeffery 

 
Sage 
Margaret 
Lauren 
Grace 

The world was grey before Computer Concepts at Albany Academy Flashed on 
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Jennifer 
Kelly 
Biz  

Alexander 
William 
Matthew 
Henry 
Jake 
Alex 
Bryan 
Mike 
Denzel 
Christopher 
Aleksander 
Jason 
Riker 

Nathan 
 
Won 
Kyle
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Flash Children Stories

Albany Academy and Albany Academy for Girls 

return to computer courses at Albany Academies   

Gif Stories from Computer Writing second trimester class

Dr. Terrell Neuage

Flash Children Stories

 

●     Valerie's The Bird and the Cookie
●     Lauren's Pick the Animal
●     Kathleen Thomas goes to the store
●     Nic and Biz Herbert's Story 
●     Alexa Jack in the Jungle
●     Jennifer  Counting snowmen
●     Margaret Storybook
●     Kelly Penguin Story
●     Sage Penelope
●     Grace

http://neuage.org/AA/web/FlashStory/FlashStory.htm [3/9/08 12:10:08 PM]
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Gif Stories from Computer Writing Class

Albany Academy and Albany Academy for Girls 

return to computer courses at Albany Academies   

Gif Stories from Computer Writing second trimester class

Dr. Terrell Neuage

    1 2 - WITH VIDEO

Tomas x  

Christopher X  
Kyle X  
Nathan X  
Rachael K. X  
Rachael S.   
Nicola (Niki) X  
Vivian (Viv) X  
Jeffery X  
Nicholas   
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Logos from Cool 3D

Logos from Cool 3D

   

   

http://neuage.org/AA/web/notes3/logos.htm (1 of 5) [3/9/08 12:17:16 PM]





Logos from Cool 3D

   

   

http://neuage.org/AA/web/notes3/logos.htm (2 of 5) [3/9/08 12:17:16 PM]




Logos from Cool 3D

   

   

http://neuage.org/AA/web/notes3/logos.htm (3 of 5) [3/9/08 12:17:16 PM]





Logos from Cool 3D

 

   

http://neuage.org/AA/web/notes3/logos.htm (4 of 5) [3/9/08 12:17:16 PM]





Logos from Cool 3D

 

 

http://neuage.org/AA/web/notes3/logos.htm (5 of 5) [3/9/08 12:17:16 PM]




New Page 2

Academies Web video class 

 

 

[ Lauren ] [ Biz ] 
[ Kathleen ] [ Niki ] 
[ Valerie ] [ Alexa ] 
[ Jennifer ] [ Sage ] 
[ Margaret ] [ Kelly ] 
[ Grace ]

 

Your work is in my folder on the teacher's drive

●     Niki, Biz, and Kathleen > R:\Upper School\Dr_ Neuage\video 
webclass\Biz-Niki-Kath See "NBK(1)" and work with that - be sure 
to save it frequently in your folder.

●     Alexa and Kelly > R:\Upper School\Dr_ Neuage\video webclass
\Kelly-Alexa See "alexis" and work with that - be sure to save it 
frequently in your folder.

●     Lauren R:\Upper School\Dr_ Neuage\video webclass\Lauren See 
"fight" and work with that - be sure to save it frequently in your 
folder.

●     Sage and Margaret > R:\Upper School\Dr_ Neuage\video webclass
\Sage-Margaret See "sageMarg" and work with that - be sure to save 
it frequently in your folder.

●     Valerie and Jennifer > R:\Upper School\Dr_ Neuage\video webclass
\Val-Jenn See "b" and work with that - be sure to save it frequently in 
your folder.

●     Grace > R:\Upper School\Dr_ Neuage\video See "Cat_Fight" and 
work with that - be sure to save it frequently in your folder.
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Flash Poems from the Computer Writing Class

Flash Poems from the Computer Writing class Second Trimester

Christopher
Nathan

Nicola (Niki)

Vivian (Viv)
Kyle
Jeff
Rachael K
Tomas
John
Nicholas
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Flash birthdays for Kathleen and

Flash birthdays for Kathleen and Alexa                                                                                                    
March 03, 2006

Val

Niki

Biz

Alexa

Lauren

Kathleen

Jenny

Kelly

http://neuage.org/AA/web/birthday/happy.htm [3/9/08 12:17:41 PM]
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Project One - Evening of the Arts - Hairspray - Albany Academy for Girls 

712 Internet Video (Spring 2006) at Albany Academy and Albany Academy for Girls   Dr. Terrell Neuage

Hairspray (Medley) ~ Evening of the Arts

Evening of the Arts is on April 10th 

Notes will appear on this page as we progress. For daily notes refer to our daily notes page.

Each student will have one-minute of the overall 18 minutes for our background to the chorus performing songs 
and dance from Hairspray.

We will begin with three-minutes of sound and visual that we will do in groups. Each group of four will do one-
minute of the sound and visual part. 

At this early stage these are the topics so far chosen and sources to look in - taken from 

  slides Overall Topic Specifics Sources

 Valerie 48-56 Music and Dance
Elvis Presley, Bob Dylan, Chubby Checker, and James 
Brown internet, library

 Nicole 66-74 dresses   
 Sage 75-78 fashions women's  
 Margaret 3-9 Time covers   
 Alexa 59-66 celebrities Movie internet sources, parental sources, entertainment 
 Lauren  Political events  
 Grace     
x Kathleen 37-47 Top ten US  
1/2/ Jennifer 19-28 Toys  internet, entertainment
x Kelly 10-18 entertainment music www.wikipedia.org 

 Biz 30-36
dress shoes, or any other key accessories to a 
typical outfit in the 60s  

Google, try and find a book in the library, and maybe 
just poke around the house, ask older people who 
lived in the 60s.

 

http://neuage.org/AA/web/notes3/Hairspray.htm [3/9/08 12:17:51 PM]

http://www.albany-academy.org/
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36 sessions STUDIO MX

Sunday, March 09, 2008 

 
 
36 sessions STUDIO MX 
 Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org  
This calendar will change and be updated constantly please refer to this 
calendar online
Updated Sunday, September 25, 2005 

Week Subject Reading - assignments 
Week 1   
Week 1: Thursday 
September 07. 

(Thursday) We will go 
over the syllabus and 
course requirements. 

 

Week 2: Monday 12 Dreamweaver 9.15 – 10.05 
Wednesday 14  download from http://www.

course.com/ 
for our text 0-619-18396-9 

8.20 - 9.10 Dreamweaver 
Lesson1 pages 3 - 20 
 

Thursday 15  9.15 – 10.05 Lesson2 
Lesson1 pages 20 - 36 

Friday 16  8.20 - 9.10 Lesson3 pages 37 
- 48  

Week 3: Monday 19  9.15 – 10.05 pages 49 - 
56Review of Dreamweaver 
chapters 1 – 3 exercise 1 hand 
in

Wednesday 21   8.20 - 9.10 quiz and finish 
lesson 1 

Thursday
 22 

 9.15 – 10.05 Lesson2  pages 
37 - 48

Friday 23  8.20 - 9.10 
Week 4: Monday 26  9.15 – 10.05 

 Dreamweaver Creating 
Links lesson 3 pp. 49-56 

http://neuage.org/AA/web/calendar.htm (1 of 4) [3/9/08 12:18:02 PM]

mailto:neuaget@albanyacademyforgirls.org
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36 sessions STUDIO MX

Wednesday 28  8.20 - 9.10 Quiz 1 pass 
back Review of chapter2 for 
quiz on Thursday complete 
Lesson 3
 

Thursday 29  9.15 – 10.05 Quiz 2 work on 
Project 1  what I did last 
summer  see notes

Friday 30  8.20 - 9.10  bake and cake 
thingy no class

Week 5: October 3 
Monday

 9.15 – 10.05 
 Dreamweaver  lesson 4 pp. 
57 - 67 (4.2)

Tuesday 4th Rosh Hashanan  
Wednesday 5  8.20 - 9.10  Dreamweaver  

lesson 4 pp. 67 - 76
Thursday 6  9.15 – 10.05 lesson 4 pp. 67 

- 76 continued 
Friday 7th  Complete Lesson 4
Week 6: Monday 
October 10 

Columbus Day NO CLASS

Wednesday 12 PSATs will be administered on 
Wednesday, October 12th for 
all sophomores and juniors. 
Students will go directly to the 
old gym at 8 am and the test 
will soon follow. The exam 
should run until 12noon. If you 
have a class which takes place 
during this time, please contact 
me and you can be assigned the 
wonderful duty of proctoring. 
 
PLAN will be take place in the 
old gym on Sat Oct 22nd for all 
sophomores.

Study Hall for seniors and 
Freshmen

http://neuage.org/AA/web/calendar.htm (2 of 4) [3/9/08 12:18:02 PM]
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36 sessions STUDIO MX

Thursday 13 Yom Kipper NO CLASS
Friday 14th  Quiz from lesson 3  Lesson 4 

"Inserting Data into a table
Homework - outline 
information for 'PROJECT 2' 
see: http://www.albany-
academy.org/compcon/web/
project2.htm 

Week 7: Monday17  9.15 – 10.05  Lesson 4 
"Inserting Data into a table"

Wednesday 19  Lesson 5  Dreamweaver 
'Adding User Interactivity' 
Quiz from lesson 4

Thursday 20  9.15 – 10.05 Lesson 6  Site 
Management 

Friday 21  Project 1 due work whole 
class on submission
Homework due Monday 
quiz number 5 and 6 
answer questions and 
write out answers in full 
sentences.

Week 8: Monday 24  9.15 – 10.05 
Fireworks Lesson 1 pages 1 
- 24

Wednesday 26  Fireworks 
Thursday 27  9.15 – 10.05 Fireworks 
Friday 28  Fireworks 

 
Week 09: October 31 
Monday

 9.15 – 10.05 Fireworks 

November -1 Tuesday   

Wednesday 03   
Thursday  04  9.15 – 10.05 
Friday 05   

http://neuage.org/AA/web/calendar.htm (3 of 4) [3/9/08 12:18:02 PM]
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36 sessions STUDIO MX

Week 10: Monday 7  9.15 – 10.05 FreeHand  
Tuesday 8th   
Wednesday 9th   
Thursday 10th  9.15 – 10.05 
Friday 11th  Review of FreeHand  chapters 

4 - 6 exercise 6 hand in
Week 11: Monday 14 Labour Day NO CLASS

Tuesday 15  Final project due 22nd
Wednesday 16   
Thursday 17  9.15 – 10.05
Friday 18   
Week 12: Monday 21  9.15 – 10.05
Tuesday 22   
 thanksgiving  
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Index for trimester two Web Desi

Web Animation using Macromedia's Flash MX  at Albany Academy and Albany Academy 
for Girls   Dr. Terrell Neuage

Index for trimester two Web Design Animation  2006 Syllabus: Notes: Grading: Calendar: 

Blog 

■     1-04 Wednesday 

■     1-05 Thursday 

■     1-06 Friday 

■     1-09 Monday 

■     1-11 Wednesday 

■     1-12 Thursday 

■     1-13 Friday 

■     1-18 Wednesday 

■     1-19 Thursday 

■     1-20 Friday 

■     1-23 Monday 

■     1-25 Wednesday 

■     1-26 Thursday 

■     1-30 Monday 

■     02-01 Wednesday 

■     2-02 Thursday 

■     2-03 Friday 

■     2-06 Monday 

http://neuage.org/AA/web/notes2/index.htm (1 of 2) [3/9/08 12:18:16 PM]
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Index for trimester two Web Desi

■     2-08 Wednesday  

■     2-09 Thursday 

■     2-10 Friday 

■     2-13 Monday 

■     2-15 Wednesday 

■     2-16 Thursday 

■     2-17 Friday is not just another day 

■     2-22 Wednesday 

■     2-23 Thursday 

■     2-24 Friday 
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39 sessions Essential Technology

711 Internet Animation (Winter 2005-2006) Flash; (Ulead) Gif animinator,  Cool 
3D
November 28 trimester two begins March 03 ends
44 teaching days
Week Subject Days 

left in 
trimester 

NOVEMBER
Week 1: 
Monday 28

chapter 7 Fireworks  

Wednesday 30 Begin Flash  
DECEMBER
Thursday 1

Flash  

Friday 2 Flash  
  Monday  5   

Tuesday 6   
Wednesday 7   
Thursday 8   
Friday 9   
Week 3: 
Monday  12

  

Tuesday  13   
Wednesday 14   
Thursday 15
 

  

Friday  16   
Week 4: 
Monday  19

  

Tuesday   
  

JANUARY 
Wednesday 4

 Lesson six review 32

Thursday 5  Lesson seven 31

http://neuage.org/AA/web/calendar2.htm (1 of 3) [3/9/08 12:18:24 PM]



39 sessions Essential Technology

Friday 6  Lesson seven 30
Week 5:  
Monday 9

 Making own button project 29

Wednesday 11  Lesson 8 28
Thursday 12  Lesson 9 27
Friday 13  Lesson 9 26
Week 6: 
Monday  16

Dr. Martin Luther King Holiday  

Wednesday  
18

 Lesson 10 25

Thursday 19  Lesson 10 24
Friday 20  Lesson 11 23
Week 7: 
Monday 23

 Lesson 11 22

Wednesday 25  Lesson 12 21
Thursday 26  Lesson 12 20
Friday 27 Professional Development day No 

Classes
 

Week 8: 
Monday  30

 Lesson 13 19

FEBRUARY 
Wednesday  1

 Lesson 13 18

Thursday 2  children's story project 17
Friday 3   children's story project 16
Week 09:  
Monday 6

 children's story project 15

Wednesday  8   children's story project 14
Thursday  9  children's story project 13
Friday 10  children's story project 12
Week 10: 
Monday 13

 children's story project 11

http://neuage.org/AA/web/calendar2.htm (2 of 3) [3/9/08 12:18:24 PM]



39 sessions Essential Technology

Wednesday  
15

  children's story project 10

Thursday 16 Flash Test 9
Friday 17  Freehand lesson 1 8
Week 11: 
Monday 20

President's Weekend no classes  

Wednesday 22  Freehand lesson 2 7
Thursday 23  Freehand lesson 3 and 4 6
Friday  24  Freehand lesson 5 and 6 5
Week 12: 
Monday 27

 Final Web project 4

MARCH 
Wednesday 01

 Final Web project 3

Thursday 2 Final Web project 2
Friday  3 Final Web project 1
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Notes

Notes for projects, classes etc

Notes for Project 1 due September 30

Thursday, October 06 notes

Tuesday, November 15, 2005

Wednesday, October 19th - please read

Project 2  (Mayor Photos are in \Upper School\Dr_Neuage\Web Design\mayors > please copy your 
image to your folder) These must be finished by Thursday end of class. Friday we begin with Fireworks.

Fireworks - Wednesday November 16th and Project Three 
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http://www.albany-academy.org/compcon/web/project1.htm
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39 sessions

Rhinoceros® Albany Academy trimester 1
Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org 
39 sessions return to front page of course
 
Week Subject Reading - assignments 
Week 1   
Week 1: Thursday 
September 07. 

Introduction  

Week 2: Monday 12 syllabus and course requirements 
– 

This weeks concentration will 
be Rhino Basics  pp 1 - 22

Wednesday 14 1. hand out acceptable user policy
2. Training Manual - Level 1
3. Save URL of course to email
4. View Notes page for daily 
work

 pp 1 - 10 

Thursday 15   pp. 11 - 22
Friday 16   pp. 23 - 26
Week 3: Monday 19  Design Project: Flashlight 1  This weeks concentration will 

be  creating two-dimensional 
objects pp 27 - 42

Wednesday 21   
Thursday
 22 

  

Friday 23   
Week 4: Monday 26  Design Project: Flashlight 2  This weeks concentration will 

be Precision Modelling  pp. 45 
- 90

Wednesday 28   
Thursday 29   
Friday 30   
Week 5: October 3 
Monday

 Design Project:: Jack 
O'Lantern

 This weeks concentration will 
be  Editing Objects pp. 95 - 125

Wednesday 5   
Thursday 6   

http://neuage.org/AA/rhino/rhino_calendar.htm (1 of 3) [3/9/08 12:18:35 PM]
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39 sessions

Friday 7th   
Week 6: Monday 
October 10 

Columbus Day  

Wednesday 12  Design Project: Cellular Phone  This weeks concentration will 
be Point Editing pp. 135 - 143

Thursday 13 Yom Kipper  

Friday 14   

Week 7: Monday17   This weeks concentration will 
be 3 - D Modelling and Editing 
pp. 145 - 236

Wednesday 19   
Thursday 20   
Friday 21   
Week 8: Monday 24   This weeks concentration will 

be Rendering (Flamingo) pp 
247

Wednesday 26   
Thursday 27   
Friday 28   
Week 09: October 31 
Monday

  Training Manual Level 2 

November Wednesday 
03

  

Thursday  04   
Friday 05   
Week 10: Monday 7   

Wednesday 9th   
Thursday 10th   
Week 11: Labour Day  
Week 11: Monday 14   Special topic for example 

Jewellery making  robotics etc.
Wednesday 16   
Thursday 17   

http://neuage.org/AA/rhino/rhino_calendar.htm (2 of 3) [3/9/08 12:18:35 PM]
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Friday 18   
Week 12: Monday 21   
 thanksgiving  

http://neuage.org/AA/rhino/rhino_calendar.htm (3 of 3) [3/9/08 12:18:35 PM]



39 sessions Essential Technology

756 Web design (spring 2006) Web Design with Front Page
March 06 trimester three begins  June 13 ends
39 teaching days 
 
Week Subject Reading - assignments 
MARCH 
Week 1: 
Monday 06

  

Tuesday 07   

Wednesday 08   

Thursday 09   

Friday 10   

Week 2: 
Monday  13

  

Tuesday 14   

Wednesday 15   

Thursday 16   

Friday 17   

SPRING BREAK MARCH 17 3:30 pm - APRIL 03
April
Week 3: 
Monday  03

  

Tuesday  04   

Wednesday 05   

Thursday 06
 

  

Friday  07   

Week 4: 
Monday  10

  

Tuesday 11   

Wednesday 12   

Thursday 13 PASSOVER NO SCHOOL  

Friday 14 GOOD FRIDAY NO SCHOOL  

http://neuage.org/AA/rhino/calendar3.htm (1 of 3) [3/9/08 12:18:45 PM]



39 sessions Essential Technology

Week 5:  
Monday 17

  

Tuesday  18   

Wednesday 19   

Thursday 20   

Friday 21   

Week 6: 
Monday  24

  

Tuesday 25   

Wednesday  26   

Thursday 27   

Friday 28   

May 
Week 7: 
Monday 01

  

Tuesday 02   

Wednesday 03   

Thursday 04   

Friday 05   

Week 8: 
Monday  08

  

Tuesday 09   

Wednesday  10   

Thursday 11   

Friday 12   

Week 09:  
Monday 15

  

 Tuesday 16   

Wednesday  17   

Thursday  18   

Friday 19   

http://neuage.org/AA/rhino/calendar3.htm (2 of 3) [3/9/08 12:18:45 PM]
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Week 10: 
Monday 22

  

Tuesday  23   

Wednesday  24   

Thursday 25   

Friday 26   

Week 11: 
Monday 29

Memorial day no classes  

Tuesday 30   

Wednesday 31   

June 
Thursday 01

UPPER SCHOOL READING 
DAY

 

Friday  02 EXAMS  

Week 12: 
Monday 05

EXAMS  

Tuesday 06 EXAMS  

Wednesday 07 EXAMS  

Thursday 08 LOWER SCHOOL CLOSING  

Friday  09 MIDDLE SCHOOL CLOSING  

 
JUNE 12 AAG COMMENCEMENT
JUNE 13 AA COMMENCEMENT 
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Calendar for Essential Technology at Albany Academy

Sunday, March 09, 2008 

 
 
39 sessions Essential Technology   updated Wednesday, November 09, 2005 02:38:38 PM
RETURN TO FRONT PAGE OF COURSE

●     1st trimester: Outlook, Word, Office Tools, InfoPath 
●     2nd trimester: Excel, PowerPoint, Publisher, Access, Nanotechnology  
●     3rd trimester: FrontPage, HTML. Java Script, Gif Animation - Internet Technology: 

discussion forums and newsletters - Search Engines, Hosting WebSites; how the 
Internet works (MARVEL: MPEG-7 Multimedia Search Engine)

 
Week Subject Reading - assignments 
Week 1   
Week 1: 
Thursday 
September 07. 

(Thursday) We will go 
over the syllabus and 
course requirements. 

 

Week 2: 
Monday 12 

Outlook 8.20 – 9.10
1.  log on to computer 
2. Review of AA webpage http://www.
albany-academy.org/ 
3. go to the essential technology 
homepage 
http://www.albany-academy.org/
compcon/et.htm 
4. Grading for Essential Technology
http://www.albany-academy.org/
compcon/gradesET.htm 
5. calendar for ET
http://www.albany-academy.org/
compcon/et_calendar.htm 
6. go to your student folder and create 
folder: ET - subfolder, Outlook 
7. open outlook or go via web - http://
aamail.albany-academy.org/exchange/ 
8. folders and more folders - email begin

http://neuage.org/AA/et/et_calendar.htm (1 of 5) [3/9/08 12:18:57 PM]
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Calendar for Essential Technology at Albany Academy

Tuesday 13  DAILY NOTES WILL BE AT 
http://www.albany-academy.org/
compcon/et/notes/index.htm 
 

9.15 – 10.05 Outlook log onto 
Outlook on any computer anywhere in 
the world: http://aamail.albany-academy.
org/exchange/ 
 

Wednesday 14   
Thursday 15  8.20 – 9.10 Outlook differences 

between the Outlook 2003 
program and Outlook Web Access 
working with the "Inbox" 
 

Friday 16   
Week 3: 
Monday 19 

 8.20 – 9.10 Outlook assessment 
attachments

Tuesday 20  
 

9.15 – 10.05 
signatures 

Thursday
 22 

 
 

•         8.20 – 9.10  The View menu, 
The Options Menu, 

Friday 23  9.15 – 10.05  newsgroups - Actions 
menu

Week 4: 
Monday 26 

 
 

•         8.20 – 9.10 "Contacts" 
“Keep track of birthdays”  p65

Tuesday 27  •         9.15 – 10.05 "Contacts" 
“Keep track of birthdays”  p65 

Wednesday 28   
Thursday 29  8.20 – 9.10 “Calendar” (look of 

calendar) “meetings” p87 tasks – p. 
121 calendar continud (share and 
see multiple calendars) 

Friday 30  
 

•         9.15 – 10.05 

http://neuage.org/AA/et/et_calendar.htm (2 of 5) [3/9/08 12:18:57 PM]
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Calendar for Essential Technology at Albany Academy

Week 5: 
October 3 
Monday

 •         8.20 – 9.10 lesson 1 
 

Tuesday 4th Rosh Hashanan No class
Thursday 6  8.20 – 9.10 journal quiz # 2 on 

Outlook
Word lesson 2  Getting Started with 
Word 2003
•         ·         Starting Word and viewing the 
program window
•         ·         Creating, saving, previewing and 
printing a document 
•         ·         Getting Help

·         Closing a document and exiting Word
 

Friday 7th  Lesson Three: Microsoft Word Basic 
Features using Bold, Italicize, Underline, 
Spell check, Setting Options, Shortcut Key, 
Inserting Text 

Week 6: 
Monday 
October 10 

Columbus Day No class

Tuesday 11   Word see http://www.albany-academy.org/
compcon/et/notes/10-11.htm 

Thursday 13 Yom Kipper No class
Friday 14  Word see http://www.albany-academy.org/

compcon/et/notes/10-14.htm 

Week 7: 
Monday17 

 8.20 – 9.10 
 

Tuesday 18  9.15 – 10.05  Word 
Thursday 20  8.20 – 9.10 
Friday 21  9.15 – 10.05 
Week 8: 
Monday 24 

styles see http://www.albany-
academy.org/compcon/et/
notes/10-24.htm 

8.20 – 9.10 
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Calendar for Essential Technology at Albany Academy

Tuesday 25 ●     Writing tools - Thesaurus - 
hyphenation  - change case - 
count words, paragraphs, 
lines - Auto Summarize - 
translate - research - drop 
capitals - headers and 
footers - table of contents II

9.15 – 10.05 
Word galore 

Thursday 27 graphics - insert a drawing - line 
- image - diagrams - charts text 
boxes and frames - creating word 
art - etc

  

Friday 28 referencing - bookmark - 
footnotes/endnotes - caption - 
cross-reference - index and 
tables - and 

9.15 – 10.05 

Week 09: 
October 31 
Monday

Templates - working with others 
- comments - tracking -  Outline 
- for organizing ideas headings 
and subheadings - working with 
lists 
working in XML

8.20 – 9.10 

November -1 
Tuesday

mail merge 
holiday letter

9.15 – 10.05 
•         9.15 – 10.05 

Thursday  04 newspaper columns - makes a 
newsletter - group project two - 
days

8.20 – 9.10

Friday 05 newspaper columns - makes a 
newsletter - group project two - 
days - final word on printing 

9.15 – 10.05
assessed assignment

Week 10: 
Monday 7 

Word Test 8.20 – 9.10 

Tuesday 8th 8    T   Election Day – Parent/
Teacher Conferences – No 
Classes 

8    T   Election Day – Parent/
Teacher Conferences – No Classes 

Thursday 10th Blogging 8.20 – 9.10 
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Calendar for Essential Technology at Albany Academy

Friday 11th Veterans Day NO CLASS

Week 11: 
Monday 14

Word Test 8.20 – 9.10 

Tuesday 15 Office Tools 9.15 – 10.05
Thursday 17  InfoPath 1 - 3 8.20 – 9.10
Friday 18  InfoPath 1 - 3 9.15 – 10.05
Week 12: 
Monday 21 

 8.20 – 9.10

Tuesday 22  InfoPath 1 - 3 9.15 – 10.05
 thanksgiving  
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39 sessions Essential Technology

Essential Technologies (Winter 2005-2006)  Publisher, Excel, PowerPoint,  Access, 
InfoPath, Nanotechnology, Quantum Computation, Internet Technology - Search Engines 
(Yahoo, Google, MSN, Hotbot, Infoseek, AskJeeves, Altavista, Lycos, Netscape, Altavista 
and etc.), Internet2,  Digital Divides 
November 28 trimester two begins March 03 ends
44 teaching days
Week Subject Reading - assignments 
NOVEMBER
Week 1: 
Monday 28

blog  

Tuesday 29 Publisher Introduction Publisher 
home page

DECEMBER
Thursday 1

●     Publisher 
●     First Creations - 

certificates of greatness 

Printing 

Friday 2 Publisher Creating a  newsletter

Week 2: 
Monday  5

Publisher Music publication

Tuesday 6 Publisher Holiday greeting 
publication

Thursday 8 Excel 

Friday 9 Excel

Week 3: 
Monday  12

Excel

Tuesday  13 Excel

Thursday 15
 

Excel  

Friday  16 Excel  

Week 4: 
Monday  19

Excel  

Tuesday Excel  
WINTER RECESS DECEMBER 20 3:30 pm  - WEDNESDAY JANUARY 4

Thursday 5 Excel  
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39 sessions Essential Technology

Friday 6 Excel Final Test  

Week 5:  
Monday 9

Power Point  

Tuesday  10 Power Point  

Thursday 12 Power Point  

Friday 13 Power Point  

Week 6: 
Monday  16

Dr. Martin Luther King Holiday  

Tuesday 17 Power Point Presentation  

Thursday 19   

Friday 20   

Week 7: 
Monday 23

  

Tuesday 24 Power Point  

Thursday 26 Power Point  

Friday 27 Professional Development day 
No Classes

 

Week 8: 
Monday  30

Power Point  

Tuesday 31 Power Point  

Thursday 2 Power Point  

Friday 3 Power Point  

Week 09:  
Monday 6

  

 Tuesday 7 Access  

Thursday  9 Access  

Friday 10 Access  

Week 10: 
Monday 13

Access  

Tuesday  14 Access  

Thursday 16 Access  

Friday 17 Access  
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39 sessions Essential Technology

Week 11: 
Monday 20

President's Weekend no classes  

Tuesday 21 President's Weekend no classes  

Thursday 23 Access  

Friday  24 Access  

Week 12: 
Monday 27

Access  FINAL TEST  

Tuesday 28 Nanotechnology  

MARCH
Thursday 2

Nanotechnology VISIT RPI  

Friday  3 Nanotechnology  VISIT SUNY  
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Monday

 
 

Essential Technologies (Winter 2005-2006)  Publisher, Excel, PowerPoint,  Access, InfoPath, Gif Animator   
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar 

 1.                   Week One
Monday 28 blogs from trimester one
Tuesday 29 blog and wiki 
Thursday  December 1 begin Publisher 
Friday 2

2.                   Week Two
Monday 12 - 05  Blog answer the Wassail questions 
Tuesday 12 - 06 Publisher  Fun
Thursday  12-08 Begin Excel

Friday 12 - 09 

3.                   Week Three
Monday  Excel - formatting cells
Tuesday Excel
Thursday  Excel - pie-charts and other things
Friday Excel - formulas 

4.                   Week Four
Monday 
Tuesday - greeting cards and brochures in Publisher

Thursday  
Friday 

5.                   Week Five
Monday 
Tuesday 
Thursday  
Friday 

6.                    Week Six ET All Assignments
Tuesday final Excel test FRIDAY
Thursday  
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Monday

Friday  

7.                   Week Seven
Monday bit of a snow day
Tuesday Second part of Excel test
Thursday  Power Point to the MAX
Friday 

8.                  Week Eight
Monday 
Tuesday 
Thursday  
Friday 

9.                    Week Nine
Monday 
Tuesday Power  Point presentations
Thursday  Power  Point presentations
Friday Gif animation 

10.          Week Ten
Monday  2/13 Gif animation 

Tuesday 2/14 Gif animation Using Objects to Compose an Animation
Thursday  2/16 Gif animation Your Banner
Friday 2/17 Gif animation Text Tools

11.              Week Eleven
Monday 2/20 President's Weekend no classes
Tuesday 2/21  President's Weekend no classes
Thursday  2/23 Gif animation Tweening
Friday 2/24  Gif animation Thumping Heart/Yapping Dog
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Monday

12.           Week Twelve 
Monday 2/27  Gif animation Project
Tuesday 2/28   Gif animation Project
Thursday  03/02   Final Exam
Friday 03/03   Final Exam
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39 sessions Essential Technology

Essential Technologies (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works
March 06 trimester three begins  June 13 ends
39 teaching days 
 
Week Subject Reading - assignments 
MARCH 
Week 1: Monday 
06

  

Tuesday 07   
Thursday 09   
Friday 10   
Week 2: Monday  
13

  

Tuesday 14   
Thursday 16   
Friday 17   

SPRING BREAK MARCH 17 3:30 pm - APRIL 03

April Week 3: Monday  03  P. 66 know terms P 73. ex. 9  34 days left

Tuesday  04  p. – 81 ex. 10 & 11 images  33
Thursday 06
 

 p. 93 & 95 ex. 12  32

Friday  07  Ex 13  31
Week 4: Monday  10  Tables ex. 14 - 15  30

Tuesday 11  Tables ex. 16-18  29
Thursday 13 PASSOVER NO SCHOOL  
Friday 14 GOOD FRIDAY  
Week 5:  Monday 17  Nanotechnology guest  28

Tuesday  18  Nanotechnology assignment  27
Thursday 20  Frames and Special Effects ex. 

19 and 20
 26

Friday 21 Frames and Special Effects ex. 
19 and 20

 25
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39 sessions Essential Technology

Week 6: Monday  24  Nanotechnology return guest  24

Tuesday 25 Exercise 21 -23  23
Thursday 27  Music Mr. Johnson  22
Friday 28  Music  21
May 
Week 7: Monday 01

 Themes and styles ex. 24 -25  20

Tuesday 02  Ex. 26 - 27  19
Thursday 04  Ex 28-30  18
Friday 05  Ex. 31-32  17
Week 8: Monday  08 Lesson 7 Web Publishing ex. 33-

34
 16

Tuesday 09 Ex. 35 -37  15
Thursday 11 Ex. 38 - 40  14
Friday 12 Discussion groups/databases  13
Week 09:  Monday 15   12

 Tuesday 16  Creating a website in geocities  11
Thursday  18  Creating a website in geocities  10
Friday 19  Creating a website in geocities  9
Week 10: Monday 22  Creating a website in geocities  8

Tuesday  23  Creating a website in geocities 
Nanotechnology trip to SUNY

 7

Thursday 25   6
Friday 26   5
Week 11: Monday 29 Memorial day no classes  

Tuesday 30   4
June Thursday 01 UPPER SCHOOL READING 

DAY
 

Friday  02 EXAMS  3
Week 12: Monday 05 EXAMS  2

Tuesday 06 EXAMS  1
Thursday 08 LOWER SCHOOL CLOSING  
Friday  09 MIDDLE SCHOOL CLOSING  
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JUNE 12 AAG COMMENCEMENT
JUNE 13 AA COMMENCEMENT 
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Trimester Three 712 Internet Video (Spring 2006)

712 Internet Video (Spring 2006) at Albany Academy and Albany Academy for Girls   
Dr. Terrell Neuage

 

 

Back to Albany Academy's Computer Web Page ~ Computer Concepts @ Albany Academies ~ 
Calendar for trimester three  ~ Blog ~ Grading 

Commercials - Flash Children Stories ~ Birthday Flash ~ Evening of the 
Arts ~ Videos 

This course teaches students the fundamental techniques involved in adding video to a website. Students 
studying video will learn to edit video clips using a variety of techniques found in the production of 
movies, TV shows and commercials. The video editing techniques include panning, cropping, replacing 
narration, adding music beds, transition effects, envelops, creating composites and rendering. The 
second half of our trimester will be spent creating projects using the techniques learned in class.

Projects for trimester three

I.  Hairspray (Medley) ~ Evening of the Arts

II.  Personal  Video 
III.  Making a commercial Flash animation of a product  
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Trimester Three 712 Internet Video (Spring 2006)

Daily 

Monday 06, March making e-birthday cards and Discussion of our first video project - Hairspray 
background for Evening of the Arts.
Wednesday 08 What we will do What you will do
Thursday March 09  Topics
Friday 10th approaches for example collages 
Monday 13th 
Wednesday 15th
Thursday  16th 
Friday 17th
Monday April 03
Wednesday April 05 - 
today 

 

Monday 10th April
Happy Wednesday prior to Good Friday
Monday April 17
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Trimester Three 712 Internet Video (Spring 2006)

Video Wednesday or it is the 19th of April today
Thursday April 20
Week of April 24 - 28 Wednesday is Evening of the Arts and you are on the brochure for background to 
Ms. Biemond's chorus thingie 
May 1 and on
Wednesday May 3rd 
Monday 08 May
Wednesday May 10

Thursday 11th Maybe or not sell it with AA-web Flash
Friday 12th 
Monday again
May 17th Wednesday 
18th May Thursday
Friday May 19th
Monday 22nd
Friday 26th
Wednesday 31
information about Copyright and Fair Use
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Narda and Terrell August to December 2006 (the rest of the story) 06 trip, 05 trip, photos, youtube clips

REFRESH 
updated Nov 13 -06 
* Our clips On YouTube 
* Window Media Videos 
* Photos 2002-2006

text:

●     1st notes August 28th
●     04-October-06 blog 

videos open in right panel:

●     move video (8/22/06) 
●     Brighton festival
●     looking-out-apartment
●     Brazilian Festival
●     West Indian American Fest. ( 9/ 3/ 06)
●     West Indian Carnival (9/03/06) 
●     MT festival (9-17-06) 
●     San Gennaro Festival (9/24/06)
●     Williamsburng Bridge (9/24/06) 
●     Biking (10/02/06)
●     World Trade Centre (10/02/06) 
●     Intrepid fireworks (10/02/06) 
●     Two trumpets (10/05/06) 
●     Columbus Day (10/09/06) 
●     Hip Hop Exhibit (photos) (video 10/16/06) 
●     Nova Clutch at DUMBO (10/16/06)
●     DUMBO arts festival (10/23/06)
●     Bike Ride George Washington Bridge (added 10/24/06) 
●     Williamsburg Bridge Pt2 10-29-06
●     F Train Nov 03/06
●     Queen Mary 2 Nov 05 
●     #1-train Bronx Nov 12/06 

photos:
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Narda and Terrell August to December 2006 (the rest of the story) 06 trip, 05 trip, photos, youtube clips

●     apartment
●     Brighton Festival 
●     West Indian Carnavial 
●     Bike riding 10-02-06
●     Columbus Day 
●     George Washington Bridge 10-15-06 
●     Graffiti

Photos 2002 - 2006  

Clips below open in Windows Media Player if you have it downloaded 

Nova Clutch  
Intrepid Fireworks 
Bike ride Manhattan 
Brazilian Day 
Brooklyn Hip Hop festival  
Colmbus Day Parade 
New York Transit Museum 
Two Trumpets  
World Trade Centre  
Williamsburg Bridge 
Moving to Brooklyn  
Our Brooklyn Apartment  
Bikes on George  
Brighton Beach Festival  
Brooklyn Pier  
Merry-Go-Round-Brighton 
River Tug East River  
Williamsburg Bridge Pt2 10-29-06 
F Train Nov. 03 - 06 
# 1 Bronx Train 12Nov06 
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Hi family

Hi family
 
Here we are all settled into our new home. It’s raining today, but we’ve had quite a few hot days. 
We really love our first impression of Brooklyn, or at least our little corner of it. Our street ( and 
area ) is mainly residential. (see below)
 
Here’s the story…we had a bad flight going form Sydney to LA, with a baby next to us, wailing 
most of the way. The advantage of this is that for the next segment, LA to NY we slept like the 
dead! So when we arrived we felt OK. The hotel at JFK was excellent (a Priceline bargain) Next 
day we met our land lord Jim, young guy, works in the film industry, editing or something, got 
the keys, then headed up to Albany. Loading the truck…..a huge truck….see photos …went well, 
no dramas, the guy who helped us was good. Did not say much, just lifted and lifted..that’s what 
you want.
Driving the truck back was really fun. We took turns. New York itself was interesting because I 
didn’t realize that so many streets, tunnels and exits are marked      “ passenger cars only”.
 
But here we are. Today, Sunday we drove to Coney Island/Brighton Beach, which is about 15 
minutes drive away. It’s a surprisingly nice beach, thought the “fun park” for which Coney Island 
is famous, is a bit seedy. Everyone in this area is Russian and many shops only have Russian 
signs in the windows. They call Brighton Beach “Little Russia”.
We now have everything in place and it’s starting to feel like home. Tomorrow I’ll be at school; 
takes about 40 minutes in the subway, and then a 7 or 8 minute walk.
 
So that’s a summary of our news up until now. 
Love, Narda and Terrell.
 

Kensington is a neighborhood in the center of the New York City borough of Brooklyn. It is 
bordered by Coney Island Avenue to the east, Caton Avenue to the north, Dahill Road to the 
west, and Ditmas Avenue to the south. The neighborhoods that border it are Ditmas Park and 
Prospect Park South to the east, Windsor Terrace to the north, Borough Park to the west, and 
Parkville to the south.

Kensington is a predominantly residential area consisting of housing types that run the gamut 
from brick rowhouses, to detached one family Victorians and apartment buildings. Pre-war brick 
apartment buildings dominate the Ocean Parkway and Coney Island Avenue frontage, many 
operating as co-ops. There is a commercial area on Church Avenue. Ocean Parkway bisects the 
neighborhood and the F train (IND Culver Line) runs along the western part of the neighborhood. 
In addition, Kensington is served by the B16, B23, B35, B67, B68, and B103 local buses, as well 
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Hi family

as the X29 express bus to Manhattan.
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our adventures in New York - Wednesday, October 04, 2006

The next installment of our adventures in New York
Wednesday, October 04, 2006

 
We have discovered, or rediscovered our bikes. They are two rather rusty, but working bikes, ‘classic’ we 
bought for $10 each at a garage sale last year and rarely used. Well, now almost everyday after work and on 
weekends we go on a pedal. Brooklyn (or Breuckelen, as it was called by the Dutch) is a fairly flat city, at least 
around where we are, and some streets have bike lanes.
 
Last weekend was a long weekend, like in Australia, and gorgeous weather. (We were told it rained in 
Albany!) We take these bikes on the subway trains, and that gets us everywhere. On Monday we rode down 
the East side of Manhattan, following bike trails all the way. It’s very spectacular, as you can see from 
Terrell’s photos.
 
On Sunday we discovered a new ‘China town’ in Brooklyn, about 15 minutes ride from our place. It’s the real 
‘McCoy’. No tourists to be found; just Chinese markets and stores and stacks of Chinese people.
 
We never realized that Brooklyn is such a ‘united nations’. I think I wrote this before, but you can really go 
for a long time without hearing any English spoken.
 
The New Utrecht area is a little rough; though very interesting too. It surprises us, because you see a few 
blocks where you think there are many crack addicts and shootings, and then 2 blocks further it will be 
regular family homes, and middle class.
 
Yesterday we watched a movie shoot in Manhattan. It is set in the future, can’t remember the name, but it’s 
supposed to be a remake of a movie made in the 70’s about the last remaining person on earth. They had all 
these cars along the side of the street covered in dust and with ‘weeds’ growing under them.
 
So there you go, enough for now. Hope everyone is well.
 
Much love
Narda and Terrell
 
See more at http://neuage.org/NYC/index.htm  videos on youtube at http://www.youtube.com/user/tneuage
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Brooklyn moving August 2006 

Brooklyn moving August 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Jamaica - West Indian American Day Parade Brooklyn New York City October 2006

West Indian American Day Parade 2006 Brooklyn New York City October 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Jamaica - West Indian American Day Parade Brooklyn New York City October 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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San Gennaro Festival Little Italy New York City October 2006 

San Gennaro Festival Little Italy New York City October 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Williamsburg Bridge linking Brooklyn with New York City October 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Narda and Terrell's fabulous bike ride along the East River New York City, September 2006

Narda and Terrell's fabulous bike ride along the East River New York City, September 2006 
New York video clips with Terrell Neuage and Narde Biemond  

Return to our video page (with frames)  
Our News will put your travels on the web on mobile phones  

NEXT CLIP IN SERIES going back in time  
PREVIOUS CLIP IN SERIES going forward in time  

 

Launch in external player 
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New York City World Trade Centre as of October 2006 

Return to Narda and Terrell Brooklyn and beyond 2006 
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Two trumpets played at the same time Greenwich Village

Two trumpets played at the same time Greenwich Village

Return to Narda and Terrell Brooklyn and beyond 2006 
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graffiti at Brooklyn museum of hip hop

graffiti at Brooklyn museum of hip hop

photo album

Return to Narda and Terrell Brooklyn and beyond 2006  
NEW: ournews.mobi (travels 2007 site for mobile devices)
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Queen Mary 2 at Red Hook Terminal Brooklyn New York

Queen Mary at Red Hook Terminal Brooklyn New York Return to Brooklyn New York video clips with 
Terrell Neuage and Narde Biemond 

Return to our video page 
Our News will put your travels on the web on mobile phones  
Our News will put your travels on the web on mobile phones  

NEXT CLIP IN SERIES going back in time  
PREVIOUS CLIP IN SERIES going forward in time 

 

Launch in external player 
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our Brooklyn Apartment

our Brooklyn Apartment
August 27 2006 
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Brighton Festival
August 28th 2006 
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East Indian Day Parade Labor Day Weekend 2006 Brooklyn New York photos by Terrell Neuage

East Indian Day Parade

Labor Day Weekend 2006

to video clips
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A day riding along the East River

We took our ten-dollar rusty bikes on the subway to Manhattan and spent the day weaving between 
motorized things and humans and a variety of pets. Photos from Monday October 02 - 2006 videos on 
youtube - more on our Brooklyn page. The photo of Narda in New Utrecht (Brooklyn) did not fit in the 
flash video so it is here. A few videos from this past weekend: our Bike riding, Fireworks over the 
Intrepid before it leaves port, and the World Trade Centre Site. These videos open in a new window in 
Window's Media Player (a free download if you don't have it). 

If you have flash 8 then watch it as a slide show in a new page from here
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A day riding along the East River
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Columbus Day weekend 10/09/06 photos (c) Terrell Neuage and Narda Biemond videso from this weekend

Columbus Day weekend 10/09/06 
photos (c) Terrell Neuage and Narda Biemond videos from this weekend 

return to Brooklyn 
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George Washington bridge bike ride 
October 15, 2006  
back to Narda and Terrell 06 
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Graffiti in New York City Queens November 12 2006

Queens November 12 2006
other graffiti photos (Brooklyn Hip Hop Show) Williamsburg Bridge Graffiti Europe July 2003 

Video clips - the number one train out of the Bronx/07 train to Flushing/F Train to Brooklyn; (DUMBO - 
DownUnderManhattanBridgeOverpass)

my youtube clips our videos and blogs and Brooklyn clips  
this page updated 27/November 2006 
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●     Same images ~ with slideshow and music

●     Paris Short Video Clip  

●     All Photo Albums

●     trip 2005 / trip 2006 / Mexico / trips 2007
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Other video servers with my clips uploaded (updated 29, April 2007 ) youtube / goggle / 
Eyespot  / SevenLoad / msnSOAPBOX / esnips /  Blip TV / bittorrent  /  vSocial / MySpace / 
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Trip 2007 Narda and Terrell's amazing adventures again

●     Trip 2007 ~ Sydney, Las Vegas, NYC, Warsaw, Hamburg, Edinburgh, Manchester, Bangkok, 
Siem Reap, Phnom Penh, Singapore, Adelaide, Melbourne, Sydney 

●     trip 06 ~ Albany, New York, Hamburg, Amsterdam, Utrecht, Istanbul, Mui Ne (Viet Nam), 
Saigon, Adelaide, Melbourne, Sydney

●     Christmas 05 ~ Paris 
●     trip 05 ~Albany, New York, Hamburg, Amsterdam, Utrecht, Bruge, Belgium, Prague, Beijing, 

Adelaide, Melbourne, Sydney 
●     Brooklyn life (September - December 2006)

Leave JFK December 22, 2006 - arrive Sydney - Terrell staying with Sacha, Narda to Adelaide with 
family - Terrell to Adelaide December 27th

Leave Adelaide January 03, 2007 to Las Vegas - January 3 - 06  
Arrive JFK January 06

June 16 Leave JFK to Warsaw  
June 23 leave Warsaw afternoon arrive Hamburg 
June 25 Hamburg to Edinburgh, Scotland 
July 08 leave from Manchester to Bangkok  
July 10 bus to Siem Reap, Cambodia seeing ruins at Angkor (I grew up knowing about this as my 
relatives were missionaries here) 
July 15th to Phnom Penh  
July 17th or so to Singapore then Adelaide 
end of August 2007 back to NYC 
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Tuesday, February 18, 2003 Due to snow day and speeches being rather long please follow the new calendar below

 
Globalisation and Culture ACOM 465 (Fall 2003)

 
Terrell Neuage back to syllabus 

 
UPDATED Thursday, November 13, 2003 1:23 PM

 
DATE   TOPIC  
Week 11   Education and test  
   group preparation for presentation

 
 

Week 12 11/18 tu Beliefs  
 11/20 th group preparation for presentation  last 

day to hand up weekly papers
 

Week 13 11/25 tu NO CLASS
last day for online discussion check
topics for final essay posted from our 
front page http://se.unisa.edu.au/gc.htm 

 

 11/27 th NO CLASS  
Week 14 12/02 tu Digital Resistance – the anti-

globalisation movement
 

 12/04 th Class presentation 
ALL REPORTS DUE

 

Week 15 12/09 tu Class presentation
Essay for final marks due

 

 12/11 th   
 
Week 16

12/16 tu   

 12/18 th   
 12/22 M MARKS on webCT  
 
 

http://neuage.org/GC/calendar.htm [3/9/08 12:49:32 PM]
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updated Friday, 
December 18, 
2003  2.22  PM                                                                                                                                                                                                                                         
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week 1 Globalisation and Culture

Globalisation and Culture ACOM 465 Fall 2003
© Terrell Neuage
 
September 1-6 
 

Week 1 Introduction
There are two readings to be done this week (or by the next class)
Go to: 
 
(Tuesday) 

•        Introduction (overview of course, expectation etc).
•        What do you hope to get out of this semester? (survey handed out in class)

 
 
________ initial of your first name ______ initial of your last name
 
PLEASE ANSWER THE FOLLOWING QUESTION – DO NOT PUT YOUR HAME ON THE 
PAPER/ though you will need to put the initials of your first and last name on the top. 
 YOU WILL BE GIVEN THIS PAPER BACK AT THE END OF THE SEMESTER FOR YOU 
TO WRITE YOUR THOUGHTS ON THE SAME QUESTION. 
 
This course will look at the issues surrounding the cultural dimensions of globalization, which 
includes debates about what globalization is and whether it is a meaningful term. 
You may view globalization as a phenomenon wholly without precedent or you may see it 
simply as modernization, imperialism, or global capitalism with a new face.
Think of distinct regions—China, Africa, South America, Australia, Asia, Europe—and different 
disciplines and genres—anthropology, literature, political science, sociology, music, cinema, 
photography… 
 

1.      What is your short answer on what globalisation is and do you think it is good, bad 
or a combination of positive and negative.

 

2.    Are you a global person? If so why? If not, why?

 
•        Citations. How to reference for this course (see referencing in this guide)

 

Group discussion

http://neuage.org/GC/1-week%20one/week_1.htm (1 of 3) [3/9/08 12:49:38 PM]
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•        Groups: expectations, topic, ‘why groups succeed or fail’.     
•        Formation of cluster-groups
•        Return to class group: who led your group, who spoke, who didn’t and why? 

 
 
NOTE: You will need to read the articles following the Introduction section by next Tuesday.

 

Readings

 
Please read the follow two articles: One is a positive and one is a negative toward globalisation.
 

Reading one 

http://www.environicsinternational.com/global/press_inside.html 
last viewed Thursday, August 14, 2003
 

 
People around the World Increasingly  
Favor Globalization but Worry about  

Jobs, Poverty and Environment 
 

World Economic Forum Survey of 25,000 Citizens across 25 Countries

Reading two

Globalization and Resistance http://www.dis.org/daver/anarchism/chomsky2.html viewed Tuesday, 
September 03, 2002

An Interview with Noam Chomsky by Husayn Al-Kurdi

This article originally appeared in issue #35 (Summer, 1995) of Kick It Over  
P.O. Box 5811  

Station A  
Toronto, Ontario, Canada  

M5W 1P2 

 
(Thursday) Groups: expectations, Discussion, ‘why groups succeed or fail?’ and the ‘rules’ we will 
create for our class. Formation of cluster-groups
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REMEMBER
1.  Save all your work to at least two-disks
2.  A paper is to be handed up next Thursday and every Thursday following with the answers to a 

few questions based on the readings for the week. 
3.  Your journal entry is due by each Tuesday. Your journal entry is one article that has been in the 

media regarding globalisation.
 
Go to week 2 for the readings for the week of September 8-12

1.  Your journal article will be due on the eleventh
2.  Your answers to the questions in the reader is due at the beginning of class on the 13th.

http://neuage.org/GC/1-week%20one/week_1.htm (3 of 3) [3/9/08 12:49:38 PM]
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Week 2 September  8-13 
Week two notes Tuesday/Thursday
Globalisation and Culture ACOM 465 Terrell Neuage 
 Updated 9/11/2003 10:29 AM 
 
Today’s class will discuss
 
What’s the Culture in Multiculturalism  
What’s the Difference of Identities? 
Are we contesting the Future of Equality, Secularism, and National Solidarity
Is there a move toward global homogenization? 
What makes a multicultural aspiration relevant at all?
What is egalitarian and does it matter?
 

Journal

This is the first week of your journal entries. Your journal entry for this week is an article 
that has been in the media regarding globalisation during the time of last Tuesday’s 
class (9th September) and this week’s class (September 11th).
 
Find an article in any printable media (including online) and print it and staple it to your 
report. Write a report about it of approximately 300 words. In your report discuss 
whether there is an equalitarian view being taken such as we discussed in class today. 
Be sure to label your paper and article Journal 1 Week 1.
 
Online reading and viewing for this week

Readings:

A paper is to be handed up at the beginning of the class on Thursday, 12th, with 
the answer to the FOLLOWING FOUR questions (and your name at the top of the 
page). Hebdige's basic idea of hegemony is that as a society we are told what is normal 
and we assume that it is right.Who is it that tells us what is normal? TYPE YOUR ANSWERS AND 
HAVE IT READY TO HANDUP AT THE BEGINNING OF CLASS  3-possible marks. Course 

http://neuage.org/GC/2-week%20two/week_2.htm (1 of 4) [3/9/08 12:49:39 PM]
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Guide pp 8.
 

1.      From the reading, Kellner,Douglas. Theorizing Globalization. http://
www.gseis.ucla.edu/faculty/kellner/papers/theoryglob.htm  

There are no questions for this reading but read it for a background in 
globalisation for our Tuesday discussion.

2.      Mosa, Ali A. Why Globalisation? King Saud University, Abha, Saudi 
Arabia http://www.edfac.usyd.edu.au/projects/wcces96/papers/mosaa.
pdf.

There are no questions for this reading but read it for a background 
in globalisation

3.      Global Village of the Damned by Kevin Ridofli.  http://www.
renaissancemag.com/columnists/ridolfi/current.asp 

Question week 2/1.  Do you agree with the author’s assessment 
of website communication?  Why?   
4.      GLOBAL INSIGHTS 4 PROGRAM
Look at the site of ‘accessnews’ from Melbourne, Australia and click on the 
global insights link at the top of the page. We will be viewing segments of 
these videos in class and discussing globalisation and culture from an 
activist’s view. A COPY OF THIS VIDEO IS AVAILABLE AT THE 
REFERENCE DESK AT THE LIBRARY FOR 1-2 HOUR VIEWING IN THE 
LIBRARY.

http://www.accessnews.skatv.org.au/
                         

Question week 2/2.  List two of the listings from the Insights 4 program 
and write a couple of sentences what you think the video clip will be 
about. IT IS NOT NECESSARY TO VIEW THE CLIPS AS WE WILL 
VIEW THEM IN CLASS
5. CULTURAL  COLLABORATORY: The Dynamics of Cultural 
Globalization. The myths of cultural globalization. Joana Breidenbach / 
Ina Zukrigl (Berlin) http://www.inst.at/studies/collab/breidenb.htm 

Question week 2/3.                 Using the sentence in this article, ‘Over 
the last 20 years a "culture of cultures" (Marshall Sahlins) has emerged’ 
name two cultures that you see on the Albany University campus.
6. Hebdige's basic idea of hegemony is that as a society we are told what 

http://neuage.org/GC/2-week%20two/week_2.htm (2 of 4) [3/9/08 12:49:39 PM]
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is normal 
and we assume that it is right.Who is it that tells us what is normal? 
  http://www-personal.umd.umich.edu/~aquail/page1.html

Question week 2/4.  What is it about globalisation that makes this article 
valid?
 

 
(Thursday) Group discussion: what communities do you belong to? (i.e. Sports, Social, 
Groups…)
Week Two Group worksheet. This week’s topic is multiculturalism. 
The word ‘culture’ has its roots in the ancient Latin word cultura, "cultivation" or 
"tending." The 1960 Webster's a definition of culture is: 1. The cultivation of soil. 2. The 
raising, improvement, or development of some plant, animal or product" (Friend and 
Guralnik 1958). By the 1970s culture was coming to mean "the training, development, 
and refinement of mind, tastes, and manners" (Oxford English Dictionary). Now it is 
meant more to be. The totality of socially transmitted behavior patterns, arts, beliefs, 
institutions, and all other products of human work and thought that are embraced by a 
group of people. 

 
I.                     What makes an American an American?

i.e. birth, Greencard, parents, acceptance of views/products, immigration…? 
 

II.                   Can a person be an American and never have lived in the States? 
___________________________________________________
III.                  Is someone from Canada or Central America or South America an 
American? ___________________________________________________
IV.               What are some groups you belong to?  Social, religion, sports, 
ethnicity, peers… 
___________________________________________________ 

What are some of the rules of the group? 
________________________________________________________
 

Who determines the rules 
________________________________________________________
Is there a caste system or class system in the States? Like being middle-class, old-
money, new-money, sexual behaviours, political – divisions of others sorts…. Are these 
the basis for sub-culture?How do several subgroups become a larger group? For 
example what are four subgroups that make up what would be considered the youth 
movement (world-wide) 

http://neuage.org/GC/2-week%20two/week_2.htm (3 of 4) [3/9/08 12:49:39 PM]
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________________________________________________________
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Week 3 September 14-20 UPDATED 9/16/2003 3:18 PM
 
(Tuesday) 
 

1.  Are you a part of a Global culture? This is a follow-on of our Group Discussions of last 
week. 

One way to understand the extent of globalisation is to look at some traditional events such as 
marriage: see: http://www.kendricksdesignerimgs.com/trad.html We will view ‘Global news’ 
from “Global Insights 3”

2.  The pros and cons of globalisation: the global debate See http://www.globalisationguide.
org/03.html 

3.  Migration as globalisation.  Video of Australian migration from Global Insights 3 Also 
view the clip ‘a Muslim family describes their feelings and thoughts on the issue of 
Western (Australian) Governments VS asylum seekers’, 

Visit the following website where you will have an opportunity to apply the law in an asylum 
case. 
http://www.pbs.org/pov/pov1999/wellfoundedfear/frameset.php3?section=yourdecision
 
Discussion Board
THIS IS THE FIRST WEEK OF THE DISCUSSION BOARD. You will need to make two 
entrees per week to get both marks. 
 
GO TO THE LIBRARY WEBPAGE Electronic Reserves Course Index (http://eres.ulib.
albany.edu/courseindex.asp) 

Ø      Department – communication
Ø      Instructor – neuage
Ø      Click go

Communication COM465 Globalisation and Culture Terrell Neuage  Fall 03  
 

PASSWORD is gc
on the right side is: COM378 Discussion Board AND click the discussion board.
 

Course Page Links 
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- Discussion Board 
 
CLICK 
Week Three: Discuss in two-three sentences something you did this week that was a result of 
globalisation
CLICK
Post a new message
Leave your message.
Come back toward the end of the week and do the same only respond to something someone else 
has said.
 
(Thursday) Discussion in groups

 
●     Reports from your country’s news (the country you were given to report on)

�❍     How is culture changed by technology?
�❍     What other culture would you like to experiment living in?
�❍     How would you feel if another ‘culture’ wished to destroy your culture

 
Journal article due Tuesday 23 September
 

YOUR JOURNAL ARTICLE FOR THIS WEEK MUST COME FROM A 
FOREIGN NEWSOURCE FROM THE COUNTRY YOU ARE ASSIGNED – THE 
ARTICLE NEEDS TO ADDRESS AN ISSUE ON GLOBALISATION – you will 
need to do this via the Internet unless you can get a paper from that country in the 
library.
 

For example –  If your group’s country was Zimbabwe. From Africa daily at: http://www.
africadaily.com/  You would then discuss this article bringing up the issue why international 
isolation is bad for Zimbabwe. 
Posted on Tue, Sep. 16, 2003  
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Zimbabwe Police Seize Newspaper Equipment 
ANGUS SHAW 
Associated Press

HARARE, Zimbabwe - Police seized computers and other equipment Tuesday from 
Zimbabwe's only independent daily newspaper, which was shut down last week for failing to 
register under sweeping media laws.

The closing of the Daily News comes amid a government crackdown on dissent as Zimbabwe 
struggles with an economic collapse and international isolation.

 
 Thursday – 12 September

1.  Report from the country you were given See the groups page in this folder (week3-stuff)
2.  Information on next two week’s project: making a ‘chatroom pal’ in a foreign culture/

country

Readings 

due Tuesday 23rd September:
 

From the web viewing, Maduagwu, Michael. GLOBALIZATION AND ITS 
CHALLENGES TO NATIONAL CULTURES AND VALUES: A PERSPECTIVE 
FROM SUB-SAHARAN AFRICA http://i-p-o.org/Maduagwu.htm

Question 3/a. 
What does Maduagwu say are the three essential dimensions of globalisation? 
Provide an example of each one in relationship to Sub-Saharan Africa.

 
From the web viewing, Globalisation guide: http://www.globalisationguide.org/ 

Question 3/b.
Is globalisation ‘Americanisation’? Following ONE Internet link under the 
heading of either Anti-globalisation or Pro-globalisation and answer this 
question.  
It is important that you cite which site you are going to. For example,  ‘Rifklin 
argues in his online article, Can Civilization Survive? by Jeremy Rifklin, http://
mai.flora.org/forum/18507, that ….

 
Question 3/c

Kellner, Douglas. CULTURAL STUDIES, MULTICULTURALISM, AND MEDIA 
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CULTURE
http://www.gseis.ucla.edu/faculty/kellner/papers/SAGEcs.htm 
Chose one of Kellner’s Ideologies (gender, race, class) and discuss whether you agree 
or disagree. As always in this course there is no right or wrong but you need to have a 
think after reading the article what you feel on the topic.

 
Bring to class Thursday

From one foreign news site show one headline story for the week 14-20tht 
September. A selection of foreign news services follows.
PRINT YOUR ARTICLE AND BRING IT TO CLASS THURSDAY FOR 
DISCUSSION IN YOUR GROUP. 
For example, From the African Daily online http://www.africadaily.com/

 
Kenya look boost Test bid 
11/09/2002 12:31  - (SA) South Africa 

Brian Murgatroyd 

Colombo - Kenya coach Sandip Patil is hoping that a strong showing by his team at the 
International Cricket Council (ICC) Champions Trophy will strengthen the country's case for 
elevation to full Test status. 

"The talent in this team deserves Tests but it's not in our hands," said Patil ahead of Thursday's 
start to the 12-team tournament, which is being hosted by Sri Lanka. 

"Our job is to play good cricket, to put the scores on the right track and that will push our case 
and make it stronger. It's up to the ICC to recognise that talent but I'm sure Kenya deserves Test 
status." 

Kenya's application to become the 11th Test-playing country has already been lodged 
with the ICC and is being reviewed on an ongoing basis.

Foreign news sources 
 Africa Daily / Al-Jazeera / Australia Daily / Asia Daily / BBC /  Berlin News / 
Bloomberg / Bosnia Post /  CBC.ca  / Telegraph (UK) / Estonia Times /  Europe Daily / Fox 
News / GlobalBus. Radio / Guardian / Hong Kong Daily / Independent (UK) / Herald Tribune 
(FR) / Middle East Daily / Russia Today / Sydney Post / SCMP.com / Tokyo Globe / Vatican 
Post  / JEWISH WORLD REVIEW / PAKISTAN BROADCASTING / ISLAMIC 
REPUBLIC WIRE /ITAR-TASS / KYODO WIRE / PR NEWSWIRE
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Thursday class:
Answer these questions and bring them to your group to discuss with the other two projects for 
this week 
 

A.     What was the top sport, song, food, artist and issue from your group’s country? This was 
in last week’s handout for you to do for today’s group/
B.     Discuss the news story you printed and brought to class with your group.
 
This will be a worksheet handed out in class:
 
1.  What other culture would you like to experiment living in? 
2.  If there was no concern about your safety or cost of living or questioning of your world-

views would you choose a different country than above? 
3.  If it is different than the country in one why would it matter?
4.  How would you feel if another ‘culture’ wished to destroy your culture?Would it be better 

to fight against losing your way of life or better to be assimilated by another culture?
5.   Do you think you would be the same person if it were not for globalisation? I.e you had 

nothing to do with any multi-national products – etc. Is it possible not to be part of a 
globalised world?

6.  From your readings this week do you think the World Bank is helpful to other countries or 
is it a negative influence? 
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Globalisation and Culture  ACOM 465 Fall 2003
© Terrell Neuage
Week 4 21 – 27 September

Individuals, Groups and Corporations and Globalisation   

 
There will be a short test next week Thursday 2nd October covering material we 
have discussed in the first four weeks.
Next week is the end of Journal Part 1
The questions will come from Week 2, 3 and four. There will be some short answer and a few 
short essay questions. The questions will come from Tuesday presentations and from the 
readings. 
 
Tuesday

Banking World Bank pros and cons – video on World Bank
Journal
(Thursday)

Bring to class Thursday
Discussion Board:
Readings  for this week to be handed in class 30th September

Question 4/1.
Question 4/2.
Question 4/4.
Question 4/5.
Question 4/6.

Thursday
1. videos
2. Groups

 

Tuesday 

Individuals, Groups, Corporations and Globalisation. Are we being ‘globalised’ by individuals 
(think of celebrates), corporations (Nike, the Gap), Groups (special interest groups etc), 
governments or do you chose what part of other cultures you want to incorporate into your life?

 
The following sites will be discussed in class:

1.  Marketing of celebrities
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a.       Nike -  Nike launched a campaign of jamming the jammers http://
www.adbusters.org/creativeresistance/36/1.html (the ad) http://www.
subvertise.org/details.php?
code=674&PHPSESSID=f12cd143fe9442457b898c09132142cd 

o       Nike defends itself http://news.bbc.co.uk/olmedia/970000/
video/_973324_codes_vi.ram 
o       BBC news on Nike and the Gap http://news.bbc.co.uk/1/hi/
audiovideo/programmes/panorama/970385.stm 
o       More video clips http://www.behindthelabel.org/sitemap.
php#video

b.      Amount paid to celebrities http://www.organicconsumers.org/clothes/
nikesweatshop.cfm 
c.       Personal shoe protest http://abcnews.go.com/sections/business/
DailyNews/nike010402.html 

1.      ad for Nike sweatshop http://www.toolness.com/nike/ 
2.      ad for Nike sweatshop http://www.subvertise.org/details.php?
code=580 

 
2.  Multinational Companies

A.  The Effect of Multinational Companies on Development http://www.
foundation.novartis.com/multinational_companies.htm 

B.  Multinational Companies in the Geneva Area http://www.geneva.ch/multinationals.
htm 

 
3.  Marketing of Products

A.  Behind the label http://www.behindthelabel.org/  video – something to hide – (video 
is in the library – VidCas HD 2337 S78V 1999 –

B.  Bangladesh factories - http://www.nlcnet.org/bangladesh/1001/youngan.htm  

Banking World Bank pros and cons – video on World Bank

Journal

 
Journal Part One is due Thursday 9th October (four weeks)
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THIS WEEK’S JOURNAL WILL BE FROM YOUR GROUP’S COUNTRY AND YOU ARE 
TO FIND TWO ARTICLES that show an interaction from that country and the United States: 

1.  One article is to be on your group’s country and one instance of an issue with the United 
States affected its country that is negative (or they are having a cow about it, or they are 
spitting the dummy, etc)

2.  One article is to be on your group’s country and one instance of an issue with the United 
States affected its country that is positive (something our of the States is helping them)

 

(Thursday)

 In your group discuss the different sites that were found for this week’s viewing.
 

Bring to class Thursday

 
Find two online articles that discuss Groups and Corporations from your assigned group 
country, print them out and bring them to your group for discussion on Thursday the 25th.

 

Discussion Board: 

1.  Discuss in two-three sentences an individual who is marketed by groups or corporation: 
hint, think of a sports star, the Pope, singer… and whether you are sucked in by them I 
mean whether you are affected by their trip. (1 point)

2.  Respond to someone else. (1 point)

 

Readings  for this week to be handed in class 30th September

Question 4/1. 
From the site: ‘Digital Freedom Network’ read Eddie Koch’s article, Southern 
Africans use globalization to their advantage. http://www.globalpolicy.org/
globaliz/econ/2002/0816safrica.htm 

Why is it  ‘vital to nourish and support indigenous enterprises like those that 
are already working within international markets to debunk images of Africa as 
a destitute and unproductive basket case.’? Give two examples of countries that 
have used globalisation to their advantage that are discussed in this article.
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Question 4/2. 
If an individual such as Bertolt Brecht has an International Brecht Society for 
him [see http://polyglot.lss.wisc.edu/german/brecht/]  

A.     Does this mean he has been globalised? 
B.     Have you ever heard of him? 
C.     Do you know anyone who ever has?  
D.     Now that you know who Brecht is tell what he was influenced by 
aQuestion 4/3.

 

Question 4/4.
According to Norman Solomon (You Are Being Lied To, 2001), six corporations 
control the American media: who are they?  http://members.shaw.ca/charenton_/
media.html Discuss how one of the countries that Solomon mentions is influenced by 
foreign media.
 

Question 4/5.
Read: High coffee prices leave bitter taste in mouths of impoverished farmers.  By 
Chris Gray

 http://archives.econ.utah.edu/archives/a-list/2002w38/msg00064.htm  sited: 19 
September 2002What percentage of American households buy these four coffee 
products Maxwell House, Jacobs, Café Hag, Carte Noire?
 

Question 4/6. 
Go to the World Bank and the World Trade Organisation sites: 
http://www.worldbank.org/ and http://www.wto.org/ 
Go to an anti-World Bank site such as:  http://www.irn.org/wcd/worldbank.shtml and http://www.
abolishthebank.org/en/ 
 
In three-five sentences why is the World Bank good or bad?
 
From your readings this week do you think the World Bank is helpful to other countries or is it a 
negative influence? 
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Thursday

1. videos 
1.      Video ‘Global Assembly Line’ available in the library - VidCas HD 8039 
O33 G56X 1986 ON RESERVE
2.      Video ‘Something to Hide’ available in the library VidCas HD 2337 S78V 
1999

 
For next week’s question 5.
 
From the video ‘Global Assembly Line’ (for next week’s question five - )
 

1.  What is the difference in buying cost between the minimum wage in the States compared 
to the minimum wage in the Philippines?

2.  Besides the cost saving why do companies move overshore.
3.  What protections do the companies shown in Mexico use for their workers against toxic 

fumes etc?

What do workers in the Philippines leave their rice fields for? (to aspire to get what?)
 
From the video ‘Something to Hide’ (for next week’s question five - )
 

1.  What is a Free Trade Zone?
2.  What are three things that multinational companies look for in a cheap work force
3.  Do the workers want a union and if so why?
4.  What is the difference between a prison and a Nike factory in a Free Trade Zone?
5.  What does S.A.M stand for? (In relation to the chart shown of how many pieces of 

clothing need to be made)material 
6.  What is the minimum wage for El Salvador?
7.  What percent of the workers are female?  What percent are female?

 

2. Groups
 
Find two online articles that discuss Groups and Corporations from your assigned group country, 
print them out and bring them to your group for discussion on Thursday the 25th.
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4.     Corporations
 
McSpotLight see Mac the Knife  McLibel case 
 
McDonald’s 2002 Worldwide Convention in Las Vegas 
 
McDonald's Worldwide Social Responsibility Report
 
McDonald's(R) unveils "i'm lovin' it(TM)" worldwide brand campaign

There are several features that govern corporate behaviour (adapted from Jerry Mander): 

●     profit 
●     growth 
●     aggressive competition 
●     amorality 
●     rigid hierarchy 
●     dehumanising 
●     exploitation 
●     ephemeral and mobile 
●     in opposition to nature 
●     anti-democratic 
●     homogenisation
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Globalisation and Culture
 
Updated Thursday, September 25, 2003
 
Week 5 October 1-7

Journal
Discussion Board:
Tuesday Class
Questions from readings

1.     Your biological footprint
2. Information and communication technologies
3. Compare news stories

Thursday group

Week 5 September 28 October 4
 
(Tuesday) Communications. The Media, History of writing 
 

Journal
 
Journal Part One is due Thursday 9th October (four weeks)
 
This is due Tuesday 7th October 
 
Go to a foreign chat site – try one of these larger foreign servers:
http://www.alamak.com/login.phtml 
http://www.chatinternational.com/ 
or find one in Yahoo, Excite etc.
 
In the chatroom carry on a discussion with others. When you have finished your chat (it 
should have lasted at least an hour) discuss five things you have discovered about the 
other person’s culture, this could be the result of a number of people talking about 
anything or a few – but get past the ‘hi’ ‘any girls in here’ stage and talk about a topic 
that has something to do with globalisation.  For your journal you will need to save the 
whole log of the conversation. I realise this could be a few hundred lines long. [Note: if 
you are using a java chatroom you will not be able to cut and paste the log. You will 
either have to type out your dialogue the best you can plus capture a screen shot by 

http://neuage.org/GC/5-week%20five/week_5.htm (1 of 4) [3/9/08 12:49:45 PM]

http://eres.ulib.albany.edu/coursepage.asp?cid=823&action=of&f=4
http://www.alamak.com/login.phtml
http://www.chatinternational.com/


Globalisation and Culture

holding (at the same time) alt+shift+printscreen to capture and Shift+Insert to save it 
for printing.] 
 
NOTE: If you cannot find a chat site for the country your group is doing then find another 
one. What I want is for you to communicate with someone with a different mind-set and 
background than yourself. 
 
This will be the last week of the Part One half of this assignment. There will be no 
assignment due during week six – you will have that week to format and assemble your 
journal. How that should be done will be in next week’s assignment.
 

Discussion Board: 
Discuss in a few sentences what communicative device you use to interact with another 
culture or country (i.e. phone, Internet: chat, e-mail, etc, post [mail], and one example/
experience doing so. Secondly respond to something someone else has written. 

 

Tuesday Class
The topic for this class is ‘How the media reports the news’. As we are discussing 
globalisation it is important to be aware of how we see other cultures and countries. See: 
MEDIA IN THE MIDST OF WAR http://www.tbsjournal.com; The Information 
Revolution in the Arab World http://www.georgetown.edu/research/arabtech/
mch397.htm; 
 

Questions from readings

5/1. Your biological footprint

a.  You are to do your biological footprint and print a copy to hand in with the 
other questions. Go to: http://www.lead.org/leadnet/footprint/intro.htm

b.  What are some of your personal reflections on how your life may affect other 
‘less-prosperous’ societies? 

 
For example print the whole page including how many earth-like planets it would take for 
everyone to live like you do: i.e. 
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YOUR RESULTS:  
Food Footprint 1.9 hectares or 4.7 acres 
Transportation Footprint 21.3 hectares or 52.7 acres 
Housing Footprint 13.5 hectares or 33.5  acres 

Other Footprints 13.6  hectares 
or 33.5 acres 

Total Footprint per person 

 

50.3  hectares 
or 

124.3 acres 
 

IN COMPARISON: 
 
Your Eco-Footprint measures 493.3   % of an average American Footprint. 
Worldwide, the biologically productive space available per person is 2.2 hectares or 5.4 acres. 
  
Your choice means the following: You maintain that every person should be able to live a satisfying 

life within an average of hectares or acres.   

Hence, it requires     Earths to support each member of the present human 
population at your standard of living. 
  

5/2. Information and communication technologies

From web viewing,  Bechtel, Marie-Franise. Public Administration between 
Globalisation and Decentralisation.  Istanbul, TURKEY, 17-20 JUNE 2002 http://www.
iiasiisa.be/schools/aeistanbul/KeynBechtelA.pdf
Do new information and communication technologies introduce changes in the exercise 
of democracy, notably with reference to globalisation and decentralisation that they 
facilitate?

5/3. Compare news stories

You will need to go to the follow five sites. Each one has an entirely different (agenda?) 
way of telling ‘the way it is’ in the world today. Write a few sentences on whether you 
believe the news source is telling the truth and whether you would trust their reporting of 
current affairs.
 

a.      http://news.bbc.co.uk/2/hi.html
b.      http://www.rense.com/ 
c.      http://www.cnn.com/ 
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d.      http://www.davidicke.com/ take the red pill to -  (http://www.davidicke.com/
icke/index.html) 
e.      http://www.cursor.org/aljazeera.htm 

 
5/4 From Thursday videos
 
From the video ‘Something to Hide’ (for next week’s question five - )
 

1.  What is a Free Trade Zone?
2.  What are three things that multinational companies look for in a cheap work force
3.  Do the workers want a union and if so why?
4.  What is the difference between a prison and a Nike factory in a Free Trade Zone?
5.  What does S.A.M stand for? (In relation to the chart shown of how many pieces of 

clothing need to be made)material 
6.  What is the minimum wage for El Salvador?
7.  What percent of the workers are female?  What percent are female?

 
From the video ‘Global Assembly Line’ (for next week’s question five - )
 

1.  What is the difference in buying cost between the minimum wage in the States compared 
to the minimum wage in the Philippines?

2.  Besides the cost saving why do companies move offshore?
3.  What protections do the companies shown in Mexico use for their workers against toxic 

fumes etc?
4.  What do workers in the Philippines leave their rice fields for? (to aspire to get what?)

 

Thursday group
(Thursday) Bring to your group one kind of printed material that you often tend to read: 
magazine, novel, webpage, newspaper etc. In your group you will discuss how you use 
this material, how you learned to use it, and what purpose it serves you. What are the 
ranges of tastes and reading practices among the members of your group? Are there 
certain reading practices found among particular groups of individuals, or among women 
as compared to men, younger people compared with older and etc?
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Week 6 Gender and globalisation: more or less rights for women?  
 (October 5-11) 
 
Power Point for class
 
PART ONE OF YOUR JOURNAL IS DUE Thursday, 16th October (in this weekly are 
the guidelines for your presentation) WEEK 06. There is no journal article due for 
this week, use this week to format your journal.
 
(Tuesday) 
Gender and globalisation: more or less rights for women, for men? Sexuality and the 
beauty-youth market and globalisation. 
 
In class we will watch some of  ‘Killing us softly 3’ by Jean Kilbourne. It is in the library: 
VidCas HF 5822 S75V 2000 ON RESERVE

(Thursday) 

Online Discussion

Discuss the Internet and women. Take a stand: for example, women are worse off 
because of Internet pornography and stereotyping or they are better off due to the use of 
the Internet to change public perspectives and create more equal

 
Discussion in your group will be on whether women are better off than they were before 
the most recent period of globalisation: 1980 – 2002 as well as Sexuality and the beauty-
youth market and globalisation.
 

Readings:

Nyman, Roseline The impact of globalisation on human rights, women and good 
governance Southern African Peoples Solidarity Network. 26 - 28 November 2001 
Malawi
You will need to find this article yourself on the Internet (it is there).
Question 1. 
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What has been done to change women's realities in Africa according to this study?
 
Shiva, Vandana. The effects of WTO on women's rights. (Third World Resurgence No. 
61/62, Sept/Oct 1995)
Question 2.  
What does Shiva say are the two major shifts in Gender analysis in a period of 
globalisation? 
You will need to find this article yourself on the Internet. 
 
Dale Spender is a writer on women and computers. Her book: Spender, Dale. Nattering 
on the Net Women, Power and Cyberspace. Toronto: Garamond Press, 1996 is not 
available in our library. If you can find it in another library it is well worth the read.
Question 3.
Read the following sites and discuss what Spender’s view on women and computers is:
http://www.stumptuous.com/comps/spender.html
http://www.wel.org.au/inkwel/ink956/956spend.htm
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Week 7 World music  
 (Tuesday) 
TOPIC: World music 
 
Power Point for class 

Discussion Board: 

WEEK 7 (WORLD MUSIC) Discuss what your favourite music is and give its origins & 
cultural roots and where it is currently situated in the world (pick a world such as 
Western/Eastern/Developing. 1/2 pt. will be for you listing your music and 1/2-pt for the 
other 2-questions as well as 1-pt for

Journal

Journal  for week 7.
This will be due for 17 October. (though this is your Part-Two of your journal and will be 
due November 20th – but it needs to be done for this week  for Class discussion.
 
Look up some definitions; if possible find different ones.
Choose ONE of these two areas and be prepared to engage in a class debate on this on 
Thursday 17 October. Write notes for yourself to help you in the debate. Be prepared to 
take either side. You will need to submit this to me as your journal entry. You will receive 
one point for engaging the topic, one point for citing at least three sources and two- 
points possible for a 300-word (approximately) discussion of your findings. 
 
                               
TOPIC #1

1. What is world music?
2. Do you think ethnic cultures suffer from being grouped together in a genre 
called ‘World Music’?
3. List some arguments for using this new genre, and some against. Find 
examples from different countries or styles to support your argument. The 
debate topic is “Globalization of ethnic music has helped promote the music 
of many cultures”
What is the music of the country your group chose?
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       OR
 
 

TOPIC #2
Piracy of music is a problem. Do you pirate music? Do you have an ethical 
problem with that? If so, why, and if not why not? (don’t be concerned I am 
not with the cyberpolice)
 
The debate topic could be
       “ I pirate music by burning CD copies and I don’t feel it is wrong”
Consider the following in your thinking and research
       The role of the musician/composer
       The role of recording companies
       
Be prepared to back your arguments with some articles. I am not only 
interested in your own opinions; they should be supported with ‘evidence’.
 
A useful site is
 
http://www.isop.ucla.edu/lac/bibliography-music.htm
 
but I’m sure you will find more, you need to have cited at least three-sources 
for your marks.
 
You may wish to choose one particular style, country, band or musician as an 
example in your argument.
 

 
(Thursday) Group discussion 
will be on what music others in your group enjoy and whether it is world music
 

 

Readings

White, Miles. The Phonograph Turntable and Performance Practice in Hip Hop Music 
http://research.umbc.edu/eol/2/white/ 

 
Question 1. Discuss whether Hip Hop and Rap are a form of ‘resistance and 
contestation’ used on a world scale much as folk-music of the 1960’s (ask your 
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grandparents) was? 
 
Singh, Amardeep. 'World Music' and the Globalizing of 'Punk' http://lists.village.
virginia.edu/~spoons/global/Abstracts/singh.html  
 
Question 2.  If you listen to popular music produced in the States by an American are 
you listening to world music? If so why?

 
Question 3.  Name one of the top bands and their music from the country your group 
is currently working on: For example my article below comes from Kenya (African 
Daily), the top album there is by Fundi Konde  with his top album: ‘Retrospective / 
vol.1 which is in the style of  Taarab, the popular music of the East African coast.
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see This week's World Food Summit will once again avoid the real issues 
 
Power Point
 
Class notes

Week 8 TOPIC: World sports and world foods
October 19-October 25 
 
Group discussion will be on what sports others in your group enjoy and whether they are 
world sports and GM foods. Twenty-minutes will be for working on your group’s 
presentation in four-weeks.
 

Discussion Board 

(food & sports) Discuss whether you would eat genetically modified foods (GM Foods) if 
you knew it was in your favourite product. Respond to someone else.

 

Journal 

 
From your group country find articles on each of this week’s topics:
Globalisation and food
Globalisation and sports
 
I do not need the articles but you will need to cite them properly, including last visited 
URL.
 
Write two short essays (about 200 words each) answering these questions:
 

1.      Sports – 
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a.  How is the number one sport of your country (of course you have to find that 
part out yourself) been affected by stereotypes of Western cultural sports?  
Look at how sports are portrayed in your country currently and how they 
have changed from their traditional portrayal (for example, for Japan look at 
kendo, judo, or aikido then at Jackie Chan)

b.  Is (are) the traditional sport of your country an Olympic sport? What does 
this say for the sport(s) in question and globalisation?

 
 

Readings

 

Please write out your answers in paragraph form as would be expected for any 
academic handup. 

 
 
Where Food Crops Originated and GM foods 
●      http://www.mnh.si.edu/garden/history/ 
●     http://www.balwynhs.vic.edu.au/home/mendels/againstgm.html 

Question 1. From the two sources above or any other source, list three foods that 
you eat tell what country they had their origins in and whether they are likely 
candidates for GM foods. 
 
Question 2. Is Zambia doing the right thing for its people by halting its emergency 
food aid program? Read http://www.newscientist.com/hottopics/gm/gm.jsp?
id=ns99992806 and any other article you can find on it. 

Whatever your answer – support what you say based on your reading. Please cite 

sources.

 
Question 3. 
Do you think the problem of world hunger can be solved by using GM foods. What 
could be the arguments for or against this? Is the problem of world hunger related to 
this at all, or are there other factors involved. Whatever your answer – support what 
you say based on your reading. Please cite sources.
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Week 9  The Internet and Cyber Identities  
October 26-November 1 
 
NOTE THURSDAY CLASS WILL BE IN CETL (THE “new” SCIENCE LIBRARY) digital 
Workshop 1 (as you go in to the right)
 
We will be doing some online activities 
 
Class powerpoint 
 
There will be a short test next week Thursday 6th November covering material we 
have discussed in the first nine weeks. 

Journal 

From the CyberAnthropology Page: http://www.fiu.edu/~mizrachs/cyberanthropos.html 
pick any one of the links in the categories of: Theory, Reflections, Praxis, Cyborg 
Eschatology, Predictions, AnthroFuturism, AnthroFuturism or Ethnogenesis and analyse 
the material in respect to how people in different cultural groupings would view it. (At the 
end of the day it really is just a bunch of anti-language so you should be able to go pass 
the words and read the techno-centerness of the author(s).
 
For example if you are using the article ‘TECHGNOSIS, INFOMYSTICISM, AND THE 
WAR AGAINST ENTROPY’ from Cyborg Eschatology  at http://www.fiu.edu/~mizrachs/
techgnosis.html - reference it and relate it to the Internet, globalisation and discuss how 
someone from a different cultural background that had no knowledge of the Internet or 
cyberspace would view the article. WHAT IN THE ARTICLE YOU READ MADE IT 
PARTICULARILY WESTERN? For example is there an assumption that anyone can 
relate to the material presented or only those in the same mindset?  I would expect 
about three to four hundred words.
 
(Tuesday October 29) TOPIC: 
The Internet and Cyber Identities

Discussion Board: 
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Discuss whether the Internet should be regulated and censored.

 

Reading 

There are three readings on Internet chatrooms below. Read and critique two of the 
readings and discuss how chatrooms create a space where one can mold him or her 
self into anything – without boundaries and discuss whether these three readings pertain 
to people in Western/First World cultures or would they hold true in an Indigenous 
culture also?
 

•        Rheingold, Howard. A Slice of Life in My Virtual Community. http://interact.
uoregon.edu/MediaLit/mlr/readings/articles/aslice.html  Last viewed, Wednesday, 
October 23, 2002 (note: this article is of interest as it was written ten-years ago)
•        Neuage, Terrell. Case Study One, Conversational Analysis of Chatroom Talk. 
PD Thesis.  http://se.unisa.edu.au/1.html Last viewed, Wednesday, October 23, 
2002
•        Suler, John The Psychology of Avatars and Graphical Space 
in Multimedia Chat Communities: http://www.rider.edu/users/suler/psycyber/psyav.
html Last viewed, Wednesday, October 23, 2002

 
(Thursday) Group discussion 
NOTE THURSDAY CLASS WILL BE IN CETL (THE “new” SCIENCE LIBRARY) digital 
Workshop 1 (as you go in to the right)
 
CLASS POWERPOINT FOR THURSDAY
 

•        Discuss the downsides of the Internet and the positives.
•        Do you think relationships in cyberspace are real?

 

Below from Introduction to “Conversational Analysis of online talk”

Electronic communication has been important to globalisation and the rise of modern society, not 
simply for its capacity to “transmit” neutral information globally and in real time, but as a stage 
for the enactment of modernity itself, with all of its contending views and forces. The evolution 
of the media has had important consequences for the form that modern societies have acquired 
and it has been interwoven in crucial ways with the major institutional transformations which 
have shaped modernity. John B. Thompson argues that:  
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The development of communication media was interwoven in complex ways with a number 
of other developmental processes which, taken together, were constitutive of what we 
have come to call ‘modernity’. Hence, if we wish to understand the nature of modernity - that 
is, of the institutional characteristics of modern societies and the life conditions created by 
them - then we must give a central role to the development of communication media and their 
impact (1995:3). 

In particular, the reinforcement within modern communications media of an individualised 
transmission and reception – an increasingly personalised rather than a massed or communal 
pattern of use – has produced the sorts of pluralism, selectivity and inclusivity /exclusivity 
witnessed in CMC use. It is arguably these same features which have contributed to the rise of 
“interactivity” as a dominant CMC form – one suited, I will contend, to the “personalised” and 
“responsibilised” user-consumer central to contemporary economic productivity and social order. 
It is within an analysis of how ‘chatrooms’, as among the latest forms of communication, ‘work’ 
or do not ‘work’ that I explore electronic conversation as a force of social change.
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Week 10  Television and movies how the world sees each other
November 2-08 
 

Week 10  Television and movies how the world sees each other
Question 3.

Thursday
 
 
Power Point Presentation
 
From last week’s work in the computer lab (CETL interactive room) have the answers to 
these questions in your journal for week 9.
9-1, 9-2, 9-6, 9-8, 9-9, 9-10 and 9-11. The others we will give a miss as there was too 
much difficulty with getting into chatrooms together because the computers would not 
allow java scripts to open.
 
There will be a short (easy) test NEXT Thursday covering material we have 
discussed in the first 9 weeks – actually on weeks 5 - 10. As we agreed that notes 
from classes can be used – and no consulting of one another – there will be a time 
constraint on the test. It will be 25 questions or so and we can easily cover it in 
twenty minutes so that will be the time allocation.

Journal 

There is only one assignment for this week’s journal – but it is a lot of work and I would 
expect 500 + words plus your references (which do not count as word count)
 
Using your group’s country find what is a top movie, sitcom or play particular to that 
country and discuss (you are now a movie review critic) how culture identity (of that 
country’s culture) is affected by globalisation. You may need to translate the site (as I 
showed in class last Thursday) – there are several site translators (each worse than the 
one before – so you will have to figure out what the site is saying on your own) such as 
Altavista’s Babelfish Translation http://world.altavista.com
Google’s stie translator  http://www.google.com/language_tools?hl=en 
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and some will translate better or more languages than others. Most search engines have 
a ‘translate this page’ message if it is not in English.
 

1.  Please cite any URL’s authors – date accessed etc that you use – including the 
translator. If you speak the language and translate yourself all the better (list 
yourself as translator); the one I used in class - http://www.humanitas-international.
org/newstran/index.html

2.  Do not just describe but write an essay – argue that your groups country’s culture 
is or is not affected  by globalisation

3.  For example, a movie now playing in Japan is WELCOME BACK MR. 
McDONALD (Japanese): A farcical sitcom set in a Tokyo radio station which 
takes some shots at Japan's rigid social codes. Kyoka Suzuki plays a sappy 
housewife whose romantic play is chosen to be broadcast over the radio.  "With its 
zany humor and hysterical (yet logical) leaps into the absurd, WELCOME BACK, 
MR. McDONALD exposes the fissures in Japan's much-vaunted social apparatus, 
particularly the collective decision-making process...and the (misguided?) 
appropriation of American culture." - Noah Cowan (Toronto Film Festival)

4.  Print out the translated page and include it with your journal if you use a translator.
 

If you were reviewing this film you may write a review as Cowan did above. This will 
mean that you will need to do some research – you will be doing secondary research 
as you most likely will not have seen the movie. However, if you are doing England – 
and you watch an English sit-com on the telly such as ‘Keeping up appearances’ or 
‘Neighbours’ (Australia) you can write on them.

 
There is more work in this than the others – that is because there is only this and next 
week’s journal to do and you have until 03 December to hand it up – do not wait until the 
last moment –
 

Discussion Board

Discussion Board: Discuss whether American sitcoms or movies portray other cultures 
differently than the way they are. Give an example explaining whether it seems accurate 
or not.

 Readings
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Reading 1
MUÑOZ, LORENZA, (Tuesday, April 24, 2001) The Silver Screen That Divides Us, 
Times Staff Writer. Online: 
http://events.calendarlive.com/top/1,1419,L-LATimes-Calendar-X!ArticleDetail-30164,00.
html  
Accessed, Friday, November 01, 2002. 
 
Question 1. 
 
Discuss what MUÑOZ’s problem is with how Hollywood portray’s Mexican’s in movies. 
Do you agree or disagree with his assessment and why?
 
Reading 2
 

Sohrabi, Naghmeh (August 24, 2000) Not THAT good Patronizing adoration for Iranian 
cinema, The Iranian. Viewed online: http://www.iranian.com/Arts/2000/August/Film 
Accessed, Friday, November 01, 2002.
 
Question 2.
 
THIS ANSWSER YOU WILL NEED TO SUBMIT BOTH TO THE IRANIAN ONLINE 
(See, http://www.iranian.com/write.html AND TO ME NEXT TUESDAY. (I have 
submitted articles to this before and they do put them on their site and so have students 
in past classes – it would be worthwhile to read some of the material here) 
 
Read this and any other article and discuss whether you believe the West is patronizing 
Iranian cinema or does Sohrabi have it wrong. 
 
Reading 3
 
Farrah, Joseph, Hollywood goes Havana, again. Viewed online: http://www.worldnetdaily.
com/news/article.asp?ARTICLE_ID=21973
Accessed, Friday, November 01, 2002.

Question 3.
 
Is Farrah having an unjustified spit at the celebrities who visited Cuba – does he have a 
point or was he just having a bad day? Justify your answer
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Thursday
Continuation of globalisation of television and movies
 
Powerpoint 
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Week 11 The virtual university 
 
and Digital Resistance (if there is time)
 
Online discussion
Journal
Readings.

Reading 1.
Question 1

Reading 2.
Question 2

Reading 3.
(Thursday)
 
(Tuesday) TOPIC: The virtual university and globalisation of learning.
 
Power Point 
 
Re. Last week’s assignment, to send your question/answer to the Irianian.com was well 
written. What I find interesting is that the writer of the article, Naghmeh Sohrabi 
(received his PhD from Harvard recently) responded to one of us, Megan Bogart’s piece 
(http://www.iranian.com/Letters/2002/November/nov5.html#3) was replied to in length by 
Sohrabi (http://www.iranian.com/NaghmehSohrabi/2002/November/Film/index.html) it is 
well worth the read and fits with our topic on globalisation and especially films –

Online discussion
 
Discuss which is best; doing your uni degree totally online from another place in the 
world or as you are presently doing it – why?

Journal
 
By my count you have done four weeks of journal writing for Part-Two. 
As we decided in class you have until 03 December to hand it up.
 
There are two-weeks left of discussion board.
 
There are two-weeks left of readings.  However, this will be your last week of readings 
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as we have been doing them (unless I forget and give you reading assignments for next 
week). For your final readings you will be formulating your own theory of globalisation 
based on your work in this class – more on that next week.

Readings.
 

Reading 1. 
 
Lipman, Pauline.  Bush's Education Plan, Globalization, and the Politics of Race. http://
eserver.org/clogic/4-1/lipman.html Viewed 7 November 2002.
 
 Question 1 
 
The pressure to succeed rapidly in English on standardized tests in American schools 
takes away from cultures that have English as a second language according to Lipman. 
Discuss why the privatization of education will erode cultural diversity in America which 
ultimately will make American education a global product, which I believe is not a good 
thing. However, if you believe this is a good model feel free to express that. As I say 
often, don’t be affected by my world-views – having your view is fine but quote 
something in the article to back up your view.
 

Reading 2.
Cogburn, Derrick. GLOBALIZATION, KNOWLEDGE, EDUCATION AND TRAINING IN 
THE INFORMATION AGE.  http://www.unesco.org/webworld/infoethics_2/eng/papers/
paper_23.htm Viewed 7 November 2002.
 
Question 2
 
How does the Fordist—Taylorist development model fail or encourage to impart formal 
knowledge? Take a stand.
 
 

Reading 3.
 
 
Neave, Guy. Globalization: Threat, Opportunity or Both? http://www.unesco.org/iau/
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globalization/newsletter-globalization.html
 
Question 3
 
 
Anderson, Khadija.  Western Education vs. Muslim Children http://www.jannah.org/
articles/westernedu.html 
 
What is the difficulty within an Islamic household when sending them to local public 
schools?  For example, my wife is the music teacher at the Albany Academy for Girls 
and two of her students (one Muslim and one Hindi) said that she had too many 
Christian songs in her program for their Christmas production. Of course she said ‘fair 
enough’ (as Australians tend to say) and took some out – however, her thinking is that 
as Christmas is a Christian holiday taking out that genre of music makes it no longer 
Christmas. 
 
 
 
 

(Thursday) 
 

1.  Continuation of education (view slide 3, 4, 8, 22, 
2.  group discussion in preparation for group presentation
3.  test (6.30)

Group discussion: Is one culture’s educational system better than another?
 

Group presentation
 
You will be notified next Thursday – 20th November when your group will present. 
 
You are responsible to your group for the presentation. 
 
Each individual will be expected to give a five-minute presentation – and a paper for 
their presentation. 
 
If your presentation is a PowerPoint or video or playing music or performance you will 
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still need to hand up a paper as a report of your presentation. 
 
The paper should be about 500-words and will equal ten-points of your grade.
 
This represents 20% of your final grade.
Your marks will be as follows:
 
Peer assessment equals 30% of your mark (6 points) and 70% (14 points) is my mark. 
 
A mark sheet will be available soon. Roughly (and this will change somewhat) you will 
be marked by your peers on clarity of presentation (2 points), subject matter (2 points) 
and interest (2 points). I will mark you on group cohesion (i.e. there is a smooth 
transition between speakers – topics flow: for example, one person gives the 
introduction, the next focuses on a point, then an issue and finally a conclusion) (2 
points), content (2 points) and ten-points for a five-hundred plus word report.
 
 
All presentations will be on these two dates:
Week 14 12/04 th Class presentation

Week 15 12/09 tu Class presentation
 
For information guidance on report writing see http://se.unisa.edu.au/gc/report.htm 
 
For how you will be graded see
http://se.unisa.edu.au/gc/marking.htm 
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Week 12 Beliefs 
November 16-22
 
(Tuesday) TOPIC: Beliefs (Astrology: different techniques from various cultures and how 
they produce similar results, Religion, Movements)
Discussion Board: 
 
Religious: Christians – Moslems – Bahai Faith. Hip-Hop, graffiti
 
 
Power point 
 
 
 
 
 
 
Barcelona – graffiti (July, 2003)
 

Hamburg, Germany – graffiti (July, 2003)
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Amsterdam, Holland - graffiti (July, 2003)
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Seoul Hip-Hop Club (July, 2003)
 

E-group
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“Are religions a significant element in the constitution of global society?”
 
 
LAST ONE ( I will not check the discussion board after this week – meaning anything not 
in by Friday does not count)
 
Last week of readings – final grades for all readings go up Friday.
 
 

Thursday
 11/20 th group preparation for presentation 

JOURNALS DUE
 

Week 13 11/25 tu NO CLASS  

 11/27 th NO CLASS  

Week 14 12/02 tu Digital Resistance – the anti-
globalisation movement – review for 
test

 

 12/04 th Class presentation  

Week 15 12/09 tu Class presentation  

 12/11 th   

 
Week 16

12/16 tu  Exam 3
 

 

Presentations

 

Peer assessment equals 30% of your mark and 70% is my mark. Please give a mark from 1-20 for 
each of the five categories below. Please be fair, meaning no favours – no giving all 20s unless the 
person really deserves it. This is an academic thingy not a popularity contest. I will divide the final 
mark by ten and ten will come from your report paper due on the last day of presentation (10 
December) to equal 20 points for this assignment.
Introduction – was the topic introduced so you 
knew what the student was going to present?

Ø      
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Ø      Clarity – was the subject matter clear 
and on globalisation?

Ø      Issues – was 
there at 
least one 
issue 
discussed 
that 
addressed 
either a 
negative or 
a positive 
to 
globalisation?
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Week 13 Digital Resistance – the anti-globalisation movement
 
POWERPOINT PRESENTATION FOR TODAY
 
November 30 – December 6  http://se.unisa.edu.au/gc/week_13.htm
(Tuesday) TOPIC:  
see group presentation sheet
Reading and Viewing: 

(Thursday) presentations
 
CHECK YOUR GRADES IT IS YOUR RESPONSIBILITY THAT IT IS CORRECT 
Tuesday, December 02, 2003  10:37 AM

You will need to hand in a report when you present either Thursday or the 
following Tuesday

If you need assistance on report writing please view REPORT WRITING

This is how your report will be graded – it is worth ten-percent of your final grade

Section of your report What to put in this section Percentage of 
the whole 
report 

Introduction Set the scene - which topic have you chosen and 
what aspect are you investigating? Why does it 
interest you? 

10%

Define the problem Outline the issue/problem. Define any key terms of 
your chosen topic from your perspective or 
interpretation. Make the topic analytical eg How has 
globalisation influenced the topic you are 
researching

20%
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Method Describe how you investigated your chosen topic. 
Include here your search strategy, including search terms 
and which resources, databases, catalogues, websites etc 
you used. NB This is NOT a bibliography of the actual 
items searched

10%

Results – what I found Outline what you found. Choose sources to support 
your topic and your argument and analyse your 
findings.

30%

Discussion This is where you stick your neck out and make 
your own interpretation/analysis of what your 
research has shown and support your argument 
with references

15%

Conclusion Here you join it all together and make concluding 
statements about the issue and your research and 
findings

10%

Bibliography I expect at least 5 unique (different) citations, from 
a variety of sources including databases, and 
websites throughout your report. Construct a 
Bibliography using these references and any other 
resources you used when constructing your report. 

5%
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There will be a final test next week covering material we have discussed in this 
course.

Week 14 
Review and presentations 
 

http://neuage.org/GC/14-week%20fourteen/week_14.htm [3/9/08 12:49:56 PM]
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Referencing 
 
All work is to be properly cited. Below is how to cite electronic sources and below that is 
using the Chicago Manual of Style for citing material in print.
 

A) Electronic sources citation
 
‘How to Cite Bibliographic Entries and In-Text Citations Electronic Sources MLA Style’ 
from the University Library Site: http://library.albany.edu/usered/style/mlaelec.html  
 

The following guidelines for the construction of a bibliography and the use 
of in-text citations are based on the 5th edition of the Modern Language 
Association of America's style manual, MLA Handbook for Writers of 
Research Papers (Ref LB 2369 G53 1999, also available on reserve at the 
University Library). This style is used primarily by those in the arts and 
humanities discipline. 

WORKS CITED
Entries for electronic sources follow the same basic pattern as those for 
print sources (author, title, publication information). Citations should 
include the date assigned to the document in the source AS WELL as 
the date on which you accessed the document. For online works, it is 
recommended that citations include the URL, enclosed in angled brackets. 
If a URL must be divided between two lines, break it only after a slash. 
Note, the entire list should be double-spaced throughout each entry, and 
the lines after the first line of each entry should be indented 5 spaces. 

http://neuage.org/GC/reference.htm (1 of 4) [3/9/08 12:50:01 PM]
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Journal 
Article in 
Online Source

Christian, David. "Silk Roads or Steppe Roads? The Silk Roads in 
World 

History."Journal of World History11.1 (2000):1-26. 19 June 
2000 
< http://muse.jhu.edu/journals/journal_of_world_history/
v011/11.1christian.html?> 

Vogel, Gretchen. 揚aleobiology: Insect Wings Point to Early 
Sophistication.?P> 

Science 282.5389 (1998): 599. 17 October 2000 
<http://dialog.carl.org:3005/cgi-bin/cw_cgi?fullRecord+22668
+6523+3:507739+3+6>. 

Mann, Charles C. 揟he Heavenly Jukebox.? Atlantic Monthly 286.3 
(2000): 39-56. 

25 October 2000 
<http://ehostvgwl.epnet.com/ ehostl.asp?
key=204.179.122.141_8000_178994538&return=y&site=ehost>. 

Web Page 
Professional 
Site

Cope, Virginia. Mark Twain's Huckleberry Finn: Text, 
Illustrations, and Early Reviews. 1995. The University of 
Virginia Library. 19 
June 2000 <http://etext.lib.virginia.edu/twain/huckfinn.html> 

Web Page 
Personal Site

Kennedy, William. Home page. 25 October 2000 
<http://www.albany.edu/writers-inst/wjkennedybio.html> 

NOTE : If available, include the name of the person who created the page; 
the title of the site, underlined; and the name of the organization 
associated with the site. If no title exists, then include a description such as 
Home page , with no underlining. See Personal Site example. 
NOTE : The date preceding the URL is the date you accessed the Web 
site or the article. 

CD-ROM (Abstract) Boyatzis, Chris J. 揕et the Caged Bird Sing: Using 
Literature to Teach Developmental 

Psychology.? 19.4 (1992): 221-22. ERIC. CD-
ROM. SilverPlatter. December 1997. 

NOTE : To determine the publication date of a CD-ROM database, look at 
the latest date of the section of the database you are searching. For 
example, if the menu gives you a choice of documents: Jan. 1980 through 
Dec. 1990 / Jan. 1991 through Dec. 1996, and you find a document dated 
May 17, 1986, the electronic publication date is December 1990. 

CITATIONS IN TEXT
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In-text citations for electronic sources follow the same pattern as those for 
print sources: use the author's last name or the title of the work, which may 
be abbreviated. If you use an abbreviated title, begin the shortened version 
with the word by which the work is alphabetized in your list of works cited. 
 
University Libraries - University at Albany, SUNY 
Ask at the Reference Desk for further assistance

 

B) Chicago Manual of Style for print material 

Copied from: http://web.library.emory.edu/services/ressvcs/citation/citationstyles.html 

Following the format suggested by the Chicago Manual of Style, here are some 
examples of general citation styles for the most common types of print and electronic 
publications. For more extensive guidelines be sure to consult one of the style manuals 
(make link to Web site on General Style Manuals) included in this guide. 

Books 
Single author/editor: 
Bibliography: Simon, Jeffrey D. Terrorist trap: America's experience with terrorism.  
2nd edition. Bloomington: Indiana University Press, 2001. 
Footnote: Jeffrey D. Simon, Terrorist trap: America's experience with terrorism.  
(Bloomington: Indiana University Press, 2001). p.117.
Multiple authors/editors:
Bibliography: Turnbull, Linda S., Elaine Hallisey Hendrix and Borden S. Dent. Atlas of 
crime: mapping the criminal landscape. Phoenix, AZ: Oryx Press, 2001.
Footnote: Linda S. Turnbull, Elaine Hallisey Hendrix and Borden S. Dent. Atlas of crime: 
mapping the criminal landscape. (Phoenix, AZ: Oryx Press, 2001). p. 145.
Journals 

Single author:
Bibliography: Bradford, Helen. "Women, Gender and Colonialism: Rethinking  
the History of the British Cape Colony and Its Frontier Zones, C. 1806-70." Journal  
of African History 37: 3 (1996): pp. 351-370.
Footnote: Helen Bradford. "Women, Gender and Colonialism: Rethinking  
the History of the British Cape Colony and Its Frontier Zones, C. 1806-70." Journal  
of African History 37: 3 (1996): p. 362.
Note: Note: you don't need to provide the name of a magazine publisher or a place 
of publication in your citation.

http://neuage.org/GC/reference.htm (3 of 4) [3/9/08 12:50:01 PM]

http://web.library.emory.edu/services/ressvcs/citation/citationstyles.html


week 1 Globalisation and Culture

Multiple authors:
Bibliography: Ham John C., Jan Svejnar, and Katherine Terrell. "Unemployment  
and the Social Safety Net during Transitions to a Market Economy: Evidence from the 
Czech and Slovak Republics." The American Economic Review 88:. 5 (December 
1998): pp. 1117-1142.
Footnote: John C. Ham, Jan Svejnar, and Katherine Terrell. "Unemployment  
and the Social Safety Net during Transitions to a Market Economy: Evidence from the 
Czech and Slovak Republics." The American Economic Review 88: 5 (December 1998): 
p. 1118.
Electronic Sources:
Book:
Bibliography: Manley, Mary de la Riviere. The lost lover, or the jealous husband,  
a comedy. [London: 1696]. Available at http://chaucer.library.emory.edu/cgi-bin/
sgml2html/wwrp.pl. Last accessed on the World Wide Web on January 16, 2002.
Footnote: Mary de la Riviere Manley, The lost lover, or the jealous husband,  
a comedy. [London: 1696]. 6. Available at http://chaucer.library.emory.edu/cgi-bin/
sgml2html/wwrp.pl. Last accessed on the World Wide Web on January 16, 2002.
Article:
Bibliography: Dobson, Roger. "Scientists produce genetically engineered, cloned  
pigs for xenotransplantation." BMJ: British Medical Journal 324: 7329 (January 12, 
2002): pp. 67-69. EBSCO Academic Search Premier via GALILEO. Last accessed on 
the World Wide Web on February 7, 2002.
Footnote: Rodger Dobson. "Scientists produce genetically engineered, cloned  
pigs for xenotransplantation." BMJ: British Medical Journal 324: 7329 (January 12, 
2002): pp. 67-69. EBSCO Academic Search Premier via GALILEO. Last accessed on 
the World Wide Web on February 7, 2002.
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For credit for this part you will need firstly, a table as discussed last week, uploaded to our 
Moodle account  
Before the end of this trimester all blogs caught up and your final PowerPoint project uploaded 
 
In Power Point look at the menu across the top; specific points to be aware of:  
File > New Presentation > Save As (save in your 'documents' folder) >  
View > Normal (view) > Slide Master (have your slides look the same) > Toolbars (be sure "Standard" 
and "Formatting" are ticked)  
Insert > depending on what you will be adding such as Pictures, Moviews and etc.  
and the rest of the toolbar menus go through for what you will need, especially the Action Buttons and 
Action Settings (under Slide Show) 
 
You PowerPoint must have the following elements for 100%:

●     10 % Your table 
●     15 % Creativity/Originality Is your presentation interesting or just 'elevator music for the 

eyes?' (I get bored very easy) 
●     15% At least five images - not including background images and of course each will be 

referenced fully. 
●     Your slides will be marked on  

14 % Appearance (are your slides easy to view? - see the seven points of a good slide show at 
http://neuage.info/t-p.htm especially slide number 15)  

The Seven Rules of Design (two percent each rule) 
good templates - or easy to view words with backgrounds that are not too busy 

high-contrast colors - The lightest tint of gray will do better than white with bright letters 
sans serif fonts - consistent fonts and styles 

efficient text - only three or four (at the max) points for each slide 
wisely chosen images - clear images only 

appropriate “build” effects - stay away from too many moving elements - but have a link (Slide 
Show > Action Buttons > Next Slide or Previous Slide) 

visual balance of slide elements
16 % Content (be sure each slide continues with your story) You need at least fifteen slides but 
not more than 20. 

●     10% Show time - Three minutes (ten seconds either way) 
●     15% Reference slide (referenced properly) (10 %) Two references must be from the library 

database.
●     5 % uploading to your blog. 

How to design your own templates that we can use over again today.

You apply a design template to give your slides their look, including the font styles they use; their 
background image, color scheme, logo, or other art; and their layout.

http://neuage.org/dwight/templates.htm (1 of 4) [3/9/08 12:50:05 PM]
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To create your own customized template, start with the plainest one in PowerPoint and transform it with 
your changes.

The templates you find in the Slide Design task pane are design templates only.  Go to Format > Slide 
Design (you will see the Slide Designs in the panel on the right)

To create a new template in PowerPoint, you start with one that's already there and then modify it as you 
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choose.

To give yourself the cleanest slate possible, start with the design template that PowerPoint defaults to 

whenever you click the New button Button image  on the Standard toolbar. The picture shows you how 
the default slide looks with this template.

Default Design template 
applied to default slide in 
new presentation  

   When you open a new, "blank" presentation, the very simple Default Design template is applied. 
Use this design as the basis for your new template.

   This is how the Default Design template is represented in the Slide Design task pane, which shows 
you the templates currently used.

Every design template in PowerPoint includes a slide master. The master stores the styles for the design 
template. It's the place you go in any presentation to change aspects of the design that's applied.

The picture shows the relationship between the slide master and a slide in the show. The fonts and font 
styles that are in place on the master for the title and body text are reflected in the title text and bulleted 
points on the slide.

So if you want to change the font for the title text in the show, you'd just change the title text's font on 
the master. You can make other presentation-wide changes here, too, such as applying a background 
design or arranging and sizing placeholders.

While you can change the master to effect design changes throughout any presentation, saving those 
changes as a template preserves them as a design that can be applied to any presentation.

The slide master sits behind the scenes, in its own place, called master view (more on that in the next 
section). It is never part of the slide show that people see.
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View > Master > Slide Master 

A toolbar for your pleasure will drop down - 

In master view, a thumbnail of the slide master appears in the upper left.

The slide master is displayed in the slide pane, ready for you to make changes to it.
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Scratch is developed by the Lifelong Kindergarten Group at the MIT Media Lab, with financial  support 
from the National Science Foundation, Intel Foundation, and the MIT Media Lab research  consortia. 

1. INTRODUCTION 
 
Scratch is a new programming language that makes it easy to create interactive stories, 
games, and animations – and share your creations with others on the web.

This Reference Guide provides an overview of the Scratch software. If you are just 
getting started with Scratch, we encourage you to try the Getting Started Guide first 
(http://scratch.mit.edu/files/ScratchGettingStarted.pdf). Then, if you want more detailed 
information, come back to the Reference Guide.

The Scratch website has many other resources to help you learn Scratch: Video Tutorials, 
Scratch Cards, and Frequently Asked Questions (FAQs). See http://scratch.mit.edu/howto

For the latest version of this Reference Guide, see 
http://scratch.mit.edu/files/ScratchReferenceGuide.pdf
 
 
BASIC INGREDIENTS OF A SCRATCH PROJECT 
Scratch projects are made up of objects called sprites. You can change how a sprite 
looks by giving it a different costume. You can make a sprite look like a person or a 
train or a butterfly or anything else. You can use any image as a costume: you can draw 
an image in the Paint Editor, import an image from your hard disk, or drag in an image 
from a website. 

You can give instructions to a sprite, telling it to move or play music or react to other 
sprites. To tell a sprite what to do, you snap together graphic blocks into stacks, called 
scripts. When you double-click on a script, Scratch runs the blocks from the top of the 
script to the bottom.
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2. SCRATCH INTERFACE

STAGE
The Stage is where you see your stories, games, and animations come to life. Sprites move 
and interact with one another on the Stage. 

The Stage is 480 units wide and 360 units tall. It is divided into an x-y grid. The middle of 
the Stage has an x-coordinate of 0 and a y-coordinate of 0.

To find out x-y positions on the Stage, move the 
mouse around and look at the mouse x-y display 
just below the Stage, on the right.

Click the Presentation Mode button to see projects at full-screen size. 
To exit Presentation Mode, press the Esc key.

y

x

x:240 y:180

x:240 y:-180

x:-240 y:180

x:-240 y:-180

ROTATION STylE 
Control whether costumes 
rotate with the sprite.

TABS 
Click tabs to edit scripts, 
costumes, or sounds.

GREEN FlAG 
A way to start scripts.

STAGE
Where your scratch 
creations come to life.

NEW SPRITE BUTTONS
Create a new character or 
object for your project.

SPRITE lIST 
Thumbnails of all your 
sprites. Click to select and 
edit a sprite.

PRESENTATION mODESCRIPTS AREA
Drag blocks in, snap them 
together into scripts.

BlOCkS PAlETTE 
Blocks for 
programming 
your sprites.

CURRENT 
SPRITE 
INFO TOOlBAR

PROJECT NOTES
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NEW SPRITE BUTTONS
When you start a new Scratch project, it begins with a single cat sprite. To create new 
sprites, click on these buttons: 
 
  Paint your own costume for a new sprite using the Paint Editor.

  Select a costume for a new sprite – or import an entire sprite.
   
  Get a surprise sprite.

If you want to delete a sprite, select the scissors from the Toolbar and click on the sprite. 
Or right-click on the sprite and select delete from the pop-up menu.

To make a sprite that looks like part of the Stage background, right-click the Stage and 
select grab screen region for new sprite. 
 
SPRITE lIST
The Sprite List displays thumbnails of all of the sprites in the project.  For each sprite, it 
shows the sprite’s name, how many scripts it has, and how many costumes it has.
 
 
 
 
 
 
 
 
To see and edit a sprite’s scripts, costumes, and sounds, click on the sprite’s thumbnail 
in the Sprite List – or double-click on the sprite itself on the Stage. (The selected sprite is 
highlighted and outlined in blue in the Sprite List.) To show, export, duplicate, or delete a 
sprite, right-click on the sprite’s thumbnail in the Sprite List. To show a sprite that is off 
the stage or hidden, Shift+click on the sprite’s thumbnail in the Sprite List - this will bring 
the sprite to the middle of the Stage and show it.

You can rearrange the sprites in the Sprite List by dragging the thumbnails.

Just as a sprite can change its appearance by switching costumes, the Stage can change 
its appearance by switching backgrounds. To see and edit the scripts, backgrounds, and 
sounds associated with the Stage, click on the Stage icon at the left of the Sprite List.
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BlOCkS PAlETTE and SCRIPTS AREA
To program a sprite, drag out blocks from the Blocks Palette to the Scripts Area. To run 
a block, double-click on it.

Create scripts (programs) by snapping blocks together into stacks. Double-click anywhere 
on the stack to run the whole script, from top to bottom. To find out what a block does, 
right-click on it, then select help from the pop-up menu. 
 
When you drag a block around the Scripts Area, a white highlight indicates where you can 
drop the block and form a valid connection with another block. You can insert blocks in the 
middle of a stack or at the end.

To move a stack, pick it up from the top block. If you drag out a block from the middle of 
a stack, all of the blocks beneath it will come along with it. To copy a stack of blocks from 
one sprite to another, drag the stack to the thumbnail of the other sprite in the Sprite List.

Some blocks have white editable text fields inside, such as       . To change the value, 
click inside the white area and edit the number. You can also drop rounded blocks, like
               , inside these areas. 

Some blocks have pull-down menus, such as     . Just click on the     to see the 
menu, then click again to make a selection.

To clean up the Scripts Area, right-click and select clean up from the menu. To export a 
screenshot of the Scripts Area, right-click and select save picture of scripts.

COSTUmES
Click the Costumes tab to see and edit the sprite’s costumes.

 
 
 
 
 
 
 

This Sprite has two costumes. The sprite’s current costume (girl1-walking) is highlighted. 
To switch to a different costume, simply click on the thumbnail of the costume you want.



REFERENCE GUIDEhttp://scratch.mit.edu

REFERENCE GUIDE

5

There are three ways to create new costumes:
	 •	Click										to	paint	a	new	costume	in	the	Paint	Editor.
	 •	Click												to	import	an	image	file	from	your	hard	disk.
	 •	Drag	in	one	or	more	images	from	the	web	or	your	desktop.

Scratch can recognize many different image formats: JPG, BMP, PNG, and GIF (including 
animated GIF).

Each costume has a costume number (displayed to its left). You can rearrange the order of 
the costumes by dragging the thumbnails. The costume numbers will update if you change 
their order.
 
Right-click on a costume thumbnail to convert the costume into a new sprite, or to export 
a copy of the costume as a separate file.

SOUNDS
Click the Sounds tab to see the sprite’s sounds. 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can record new sounds and import sound files. Scratch can read MP3 files and 
uncompressed WAV, AIF, and AU files (encoded with 8-bits or 16-bits per sample, but not 
24-bits per sample).



REFERENCE GUIDEhttp://scratch.mit.edu

REFERENCE GUIDE

6

CURRENT SPRITE INFO
 
 
 
 
 
Current Sprite Info shows a sprite’s name, x-y position, direction, and lock state. 
 
You can type in a new name for the sprite.

The sprite’s direction indicates which direction the sprite will move when it runs a move block 
(0=up, 90=right, 180=down, -90=left). The blue line on the thumbnail shows the sprite’s direction. 
You can drag this line to change the sprite’s direction. Double-click on the sprite to set the 
direction back to its original state (direction=90).

Click the Lock to change the sprite’s lock state. An unlocked sprite can be dragged in presentation 
mode and the web player.

Click Export to save the sprite as a separate file, allowing it to be imported into another project. 
 

ROTATION STylE
Click the Rotation Style buttons to control how the costume appears as the sprite changes its 
direction.
  Rotate: The costume rotates as the sprite changes direction. 
  Left-right flip: The costume faces either left or right. 
  No-rotate: The costume never rotates (even as the sprite changes direction). 
 
 
TOOlBAR 
 
 
 

Click on the Toolbar to select a tool, then click on other objects to perform an action.
 Arrow: Normal mode. Pick up and move sprites and blocks.
 Duplicate: Duplicate sprites, costumes, sounds, blocks, and scripts. (Shift+click for   
 multiple.)
 Delete: Delete sprites, costumes, sounds, blocks, and scripts. (Shift+click for multiple.)
 Grow: Make sprites bigger. (Shift+click for larger size steps.)
 Shrink: Make sprites smaller. (Shift+click for larger size steps.)
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mENU 
 
 
 
New, Open, Save, and Save As do what you would expect them to do.

Share! uploads your project to the Scratch website (http://scratch.mit.edu).

Undo allows you to retrieve the last block, script, or sprite you deleted (but does not allow 
you to undo most other actions).

Language allows you to select the language of the user interface. While complete 
translations are provided for some languages, only the scripts and command blocks are 
translated for others (improved translations will be released on the Scratch website as 
they become available). Anyone can add or edit language translations of Scratch. To add 
or change a translation, simply edit the files in the locale folder within the top level of the 
Scratch folder. (Please refer to the Scratch.pot file for further instructions.) Translations 
are currently limited to the Latin character set.

Extras gives a pop-up menu with special features:
 Import Project: Bring all of the sprites and backgrounds from another project 
 into this project. This feature is useful for combining sprites from multiple projects.
 Start Single Stepping: The Scratch program runs one step at a time, 
 highlighting each block as it runs. This feature can be useful for finding bugs in   
 programs, and for helping new programmers understand the flow of a program.
 Compress Sounds: Compress sounds used in the project, to reduce the overall 
 file size of the project.
 Compress Images: Compress images used in the project, to reduce the overall file 
 size of the project.

Want Help? brings up a page with links to reference materials, tutorials, and frequently 
asked questions. To get help on an individual block, right-click on the block and select help 
from the pop-up menu.
 
GREEN FlAG
The Green Flag provides a convenient way to start many scripts at the same time. Click 
the Green Flag to start all scripts with        at the top. 

In Presentation Mode, the Green Flag appears as a tiny icon          at the top-right corner of 
the screen. Pressing the Enter key has the same effect as clicking the Green Flag.
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PAINT EDITOR 
You can use the Paint Editor to create or edit costumes and backgrounds.

The Paint Editor Toolbar has the following tools:
Paintbrush: Paint freehand using the current foreground color. When you click on this 
tool, the Options Area shows the brush size. Click       to pick a different brush size.
Eraser: Erase with freehand strokes. The areas that you erase become transparent. When 
you click on this tool, the Options Area shows the eraser size. Click       to pick a different 
eraser size.
Fill: Fill connected areas with a solid color or gradient. When you click this tool, the 
Options Area shows the fill style (solid color, horizontal gradient, vertical gradient, or radial 
gradient). Gradients blend from the selected foreground color to the selected background 
color.
Rectangle: Draw a filled or outlined rectangle (Shift+drag for a square) using the current 
foreground color. When you click this tool, the Options Area shows the fill style (solid or 
outlined).
Ellipse: Draw a filled or outlined ellipse (Shift+drag for a circle) using the current 
foreground color. When you click this tool, the Options Area shows the fill style (solid or 
outlined).

TOOlBAR

OPTIONS AREA
Tool settings.

CANVAS

UNDO/REDO

ClEAR
Erase canvas.

SCAlE BUTTONS
Change size of
current selection.

ROTATE BUTTONS 
Rotate current
selection.

FlIP BUTTONS
Flip current selection 
horizontally or vertically.

CURRENT COlORS

COlOR PAlETTES
Pick the current 

colors.

ImPORT
Add image
from file.

SET ROTATION CENTER ZOOm
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Line: Draw a straight line (Shift+drag for a horizontal or vertical line) using the current 
foreground color. When you click on this tool, the Options Area shows the brush size.  
Click       to pick a different brush size.
Text: Add text to the drawing. When you click on this tool, the Options Area allows you to 
change the font face and font size. Each costume can only have one block of text.
Selection: Select a rectangular region, then move it to a new location (press delete to 
remove the selection, Shift+delete or Shift+backspace to crop).
Stamp: Select a rectangular region, then copy it to new locations (Shift+click+drag for 
repeated stamping).
Eyedropper: Use the tip of the eyedropper to choose the foreground color (click on the 
Canvas and drag the eyedropper to pick a color from outside the Canvas).

The Current Colors (foreground and background) are shown below the Options Area. You can 
click the color swap arrow to exchange the foreground and background colors. Click in one of the 
Color Palettes to pick a new foreground color (Shift+click to select a background color). 

Click the Set Rotation Center button to select the location within the drawing that will be used 
as the center of rotation when the Costume is rotated on the Stage. 

Click the Zoom buttons (in or out) to increase or decrease the view magnification of the Canvas. 
When the zoom is greater than 100%, scroll bars are used to pan around the Canvas. Zoom does 
not change the size of the image.

Click on the Import button to open an image from file and add it to the Canvas. 

Click the Clear button to remove all content from the Canvas. 

To change the size of the Canvas content, or just the current selection, click on the Scale buttons 
(grow or shrink).  You can Shift+click on the buttons to enter a precise value. Shrinking decreases 
the size and resolution of the image.

To rotate the Canvas content, or just the current selection, click on the Rotate buttons (counter-
clockwise or clockwise). You can Shift+click on the buttons to enter a precise value. 

To flip the Canvas content, or just the current selection, click on the Flip buttons (horizontal or 
vertical).

If you make a mistake, you can click the Undo button repeatedly to undo the last several actions. 
If you change your mind, you can click the Redo button to restore the undone actions. 
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3. SCRATCH BlOCkS
TyPES OF BlOCkS
There are three main types of blocks in the Blocks Palette:

Stack Blocks: These blocks have bumps on the bottom and/or notches on the top, such 
as         . You can snap these blocks together into stacks. Some stack blocks have an input  
area inside them, where you can type a number (such as 10 in the                      block) or  
choose an item from a pull-down menu (such as pop in the                       block). Some  
stack blocks, such as       , have a C-shaped “mouth” where you can insert other  
stack blocks.

Hats: These blocks have rounded tops, such as              . These blocks are placed  
at the tops of stacks. They wait for an event to happen, such as a key being pressed, then  
run the blocks underneath them.

Reporters: These blocks, such as          and                    , are designed to fit in the input  
area of other blocks. Reporters come in two shapes, and fit only into “holes” of the same  
shape. Reporters with rounded ends (such as   ) report numbers and fit inside blocks  
with rounded holes (such as                         ). Reporters with pointed ends (such as                    ) 
report boolean values (true or false) and fit inside blocks with pointed holes (such as                     ).

Some reporter blocks have a check box next to them, such as                  . If you click in the check 
box, a monitor appears on the stage, displaying the current value of the reporter. As the value 
of the reporter changes, the monitor updates automatically. A monitor can display the value of 
the reporter in several different formats: 

     a small readout with the name of the reporter
     a large readout without any name 
     a slider that allows you to manipulate the value  
  of the reporter (available only for variables)

Double-click or right-click on the monitor to change from one format to another. 

The slider format is available only for user-created variables. Right-click on the monitor in slider 
format to adjust its minimum and maximum values.
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BlOCk DESCRIPTIONS
The Scratch blocks are organized into eight color-coded categories: motion, looks, sound, pen, control, 
sensing, numbers, and variables. 
 
motion

Moves sprite forward or backward.

Rotates sprite clockwise.

Rotates sprite counterclockwise.

Points sprite in the specified direction. (0=up, 90=right, 
180=down, -90=left)

Points sprite toward mouse-pointer or another sprite.  

Moves sprite to specified x and y position on Stage.

Moves sprite to the location of the mouse-pointer 
or another sprite.

Moves sprite smoothly to a specified position over 
specified length of time.

Changes sprite’s x-position by specified amount.

Sets sprite’s x-position to specified value.

Changes sprite’s y-position by specified amount.

Sets sprite’s y-position to specified value.

Turns sprite in opposite direction when sprite touches 
edge of Stage.

Reports sprite’s x-position. (Ranges from -240 to 240)

Reports sprite’s y-position. (Ranges from -180 to 180)

Reports sprite’s direction. (0=up, 90=right, 180=down, -90=left)
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looks
Changes sprite’s appearance by switching to different 
costume.

Changes sprite’s costume to next costume in the cos-
tume list. (If at end of the costume list, jumps back to first costume.)

Reports sprite’s current costume number.

Changes Stage’s appearance by switching to a different 
background.

Changes Stage’s background to next background in 
the background list.

Reports Stage’s current background number.

Displays sprite’s speech bubble for specified 
amount of time.

Displays sprite’s speech bubble. (you can remove speech 

bubble by running this block without any text.)

Displays sprite’s thought bubble for specified  
amount of time.

Displays sprite’s thought bubble.

Changes a visual effect on a sprite by specified amount.
(Use pull-down menu to choose effect.)

Sets a visual effect to a given number. (most visual effects 
range from 0 to 100.)

Clears all graphic effects for a sprite.

Changes sprite’s size by specified amount.

Sets sprite’s size to specified % of original size.

Reports sprite’s size, as % of original size.

Makes sprite appear on the Stage.
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Makes sprite disappear from the Stage. (When sprite is  
hidden, other sprites cannot detect it with touching? block.)

Moves sprite in front of all other sprites.

Moves sprite back a specified number of layers, so that 
it can be hidden behind other sprites.

Sound
Starts playing a sound, selected from pull-down menu, 
and immediately goes on to the next block even as 
sound is still playing.

Plays a sound and waits until the sound is finished 
playing before continuing with next block.

Stops playing all sounds.

Plays a drum sound, selected from pull-down menu, for 
specified number of beats.

Plays a musical note (higher numbers for higher pitches) for 
specified number of beats.

Sets the type of instrument that the sprite uses for 
play note blocks. (Each sprite has its own instrument.)

Changes sprite’s sound volume by specified amount.

Sets sprite’s sound volume to specified value.

Reports sprite’s sound volume.

Changes sprite’s tempo by specified amount.

Sets sprite’s tempo to specified value in beats per min-
ute.

Reports sprite’s tempo in beats per minute.
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Pen

Clears all pen marks and stamps from the Stage.

Puts down sprite’s pen, so it will draw as it moves.

Pulls up sprite’s pen, so it won’t draw as it moves.

Sets pen’s color, based on choice from color picker.

Changes pen’s color by specified amount.

Sets pen’s color to specified value. (pen-color=0 at red end of 
rainbow, pen-color=100 at blue end of rainbow)

Changes pen’s shade by specified amount.

Sets pen’s shade to specified amount.  (pen-shade=0 is very 
dark, pen-shade=100 is very light)

Changes pen’s thickness.

Sets pen’s thickness.

Stamps sprite’s image onto the Stage.

Control

Runs script below when green flag is clicked.

Runs script below when specified key is pressed.

Runs script below when sprite is clicked.

Waits specified number of seconds, then continues 
with next block.

Runs the blocks inside over and over.

Runs the blocks inside a specified number of times.
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Sends a message to all sprites, triggering them to do 
something, and waits until they all finish before con-
tinuing with next block.

Sends a message to all sprites, then continues with the 
next block without waiting for the triggered scripts.

Runs script below when it receives specified broadcast 
message.

Continually checks whether condition is true; when-
ever it is, runs the blocks inside.

If condition is true, runs the blocks inside.

If condition is true, runs the blocks inside the if por-
tion; if not, runs the blocks inside the else portion.

Waits until condition is true, then runs the blocks 
below.

Checks to see if condition is true; if so, runs blocks 
inside and checks condition again. If condition is not 
true, goes on to the blocks that follow.

Stops the script.

Stops all scripts in all sprites.
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Sensing

Reports the x-position of mouse-pointer.

Reports the y-position of mouse-pointer.

Reports true if mouse button is pressed.

Reports true if specified key is pressed.

Reports true if sprite is touching specified sprite, edge, 
or mouse-pointer. (Selected from pull-down menu.)

Reports true if sprite is touching specified color. (Click on 
color patch, then use eyedropper to select color.)

Reports true if first color (within sprite) is touching  
second color (in background or another sprite). (Click on 
color patch, then use eyedropper to select color.)

Reports distance from the specified sprite or  
mouse-pointer.

Sets the timer to zero.

Reports the value of the timer in seconds. (The timer is 
always running.)

Reports a property or variable of another sprite.

Reports the volume (from 1 to 100) of sounds detected 
by the computer microphone.

Reports true if computer microphone detects a sound 
volume greater than 30 (on scale of 1 to 100).

Reports the value of specified sensor. To use this block, you 
need to have a Scratch Board connected to your computer. See http://
scratch.mit.edu/scratchboard

Reports true if specified sensor is pressed. To use this 
block, you need to have a Scratch Board connected to your computer. 
See http://scratch.mit.edu/scratchboard
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Numbers

Adds two numbers.

Subtracts second number from first number.

Multiplies two numbers.

Divides first number by second number.

Picks a random integer within the specified range.

Reports true if first number is less than second.

Reports true if two numbers are equal.

Reports true if first number is greater than second.

Reports true if both conditions are true.

Reports true if either condition is true.

Reports true if condition is false; reports false if  
condition is true.

Reports result of selected function (abs, sqrt, sin, cos, tan, 

asin, acos, atan, ln, log, e^, 10^) applied to specified number.

Reports remainder from division of first number by 
second number.

Reports closest integer to a number.

Variables
Allows you to create and name a new variable.  When you 
create a variable, three blocks are created automatically (see below). you 
can choose whether the variable is for all sprites (global) or just for one 
sprite (local).

Deletes all three blocks associated with the variable.

Changes variable by specified amount.

Sets variable to specified number.

Reports value of variable.
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print book

Impose a document for booklet printing See 
Adobe on printing

Consecutive  
Creates a two-, three-, or four-page panel appropriate to a foldout booklet or 
brochure. The Bleed Between Pages, Creep, and Signature Size are dimmed when a 
Consecutive option is selected.

For example, if you want to create printer spreads for a traditional six-panel, trifold 
brochure, choose 3-up Consecutive. You may be accustomed to setting up trifolds as 
one page with three different columns. With InDesign imposition, you can simply 
create pages that are the size of each panel.

 
An 8-page booklet, the pages appear in sequential order in the layout window. 
However, in printer spreads, page 2 is positioned next to page 7, so that when the 
two pages are printed on the same sheet, folded, and collated, the pages end up in 
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the appropriate order.  
Pages appear in sequence in the layout window, but are printed in a different order so 
that they appear correct when folded and bound.

The process of creating printer spreads from layout spreads is called imposition. 
While imposing pages, you can change settings to adjust spacing between pages, 
margins, bleed, and creep. The layout of your InDesign document is not affected, 
because the imposition is all handled in the print stream. No pages are shuffled or 
rotated in the document.

1. Choose File > Print Booklet. 
2. If a printer preset has the settings you want, choose it in the Print Preset menu.

To use the print settings (as they appear in the Print dialog box) of the current 
document, choose Current Document Settings from the Print Preset menu. 
3. If you donʼt want the entire document to be imposed, select Range in the Setup 
area and specify which pages to include in the imposition.

Use hyphens to separate consecutive page numbers, and commas for nonadjacent 
page numbers. For example, typing 3-7, 16 imposes pages 3 through 7 and 16. 
Note: If you have divided the document into sections of page numbers, you should 
enter section page numbers (such as Sec2:11) in the Range field. 
4. To change settings such as printerʼs marks and color output, click Print Settings. 
Using the options on the left, change settings as needed, and then click OK. 
5. In the Print Booklet dialog box, specify other booklet setup options as appropriate, 
and then click Print.
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Spacing, bleed, and margin options for booklet 
printing
You can change the following options in the Setup area of the Print Booklet dialog box.

Space Between Pages 
Specifies the gap between pages (the right side of the left page and the left side of 
the right page). You can specify a Space Between Pages value for all the booklet types 
except Saddle Stitch.

For Perfect Bound documents, if you are creeping in (with a negative value), the 
minimum Space Between Pages value is the width of the Creep value. If youʼre 
manually creating signatures (for example, if there are different stocks in the same 
document), you can enter a Space Between Pages value to specify a starting creep for 
spreads that belong to different signatures.

Bleed Between Pages 
Specifies the amount of space used to allow page elements to encroach the gap in 
Perfect Bound printer spread styles. This option is sometimes referred to as 
crossover.) The field accepts values between 0 and half the Space Between Pages 
value. You can specify this option only when 2-up Perfect Bound is selected. 

Creep 
Specifies the amount of space necessary to accommodate paper thickness and folding 
on each signature. In most cases, youʼll want to specify a negative value to create a 
push-in effect. You can specify Creep for 2-up Saddle Stitch and 2-up Perfect Bound 
booklet types. (See Understanding creep.) 

Signature Size 
Specifies the number of pages in each signature for 2-up Perfect Bound documents. If 
the number of pages to be imposed is not evenly divisible by the Signature Size value, 
blank pages are added to the end of the document as necessary. 

Automatically Adjust To Fit Marks And Bleeds 
Lets InDesign calculate the margins to accommodate the bleeds and the other printer 
mark options currently set. The fields under Margins are dimmed when this option is 
selected, but they reflect the actual values that will be used to fit marks and bleeds. If 
you deselect this option, you can adjust the margin values manually. 
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Margins 
Specifies the amount of space that surrounds the actual printer spread after 
trimming. To specify individual values for Top, Bottom, Left, and Right, deselect 
Automatically Adjust To Fit Marks And Bleeds, and increase the values to insert extra 
space beyond the default marks and bleeds. (Decreasing the values may result in 
clipping the marks and bleeds.) You can specify margin values for all booklet printing 
types. 

Print Blank Printer Spreads 
If the number of pages to be imposed is not evenly divisible by the Signature Size 
value, blank pages or spreads are added to the end of the document. Use this option 
to determine whether those blank spreads at the end of the document are printed. 
Note that printing other blank pages in the document is controlled by the Print Blank 
Pages option in the Print dialog box.
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Saving to Older Versions of InDesign 
See Chapter 12: “Collaboration” from Mastering InDesign CS3 for Print Design and 
Production by Pariah S. Burke (Sybex, 2007).

Not all of us upgrade as quickly or regularly as others. For some, InDesign CS2 is 
ideal, with all the features needed for their particular work; they donʼt need or want 
CS3 and will not upgrade to it for a while if ever. (I doubt you are included in this 
group; after all, you obviously bought a book titled Mastering InDesign CS3 for Print 
Design and Production.) Others may lust after a new version but simply canʼt justify 
its price tag. Whatever the reason, it becomes necessary on occasion to move 
documents between the latest and earlier versions of InDesign.

The fact that InDesign CS (CS1, version 3.0) did not save backward for compatibility 
with 2.0 (the first commercially successful edition of InDesign) brought forth a public 
outcry so vociferous that it still echoes throughout the halls of Adobe and many press 
and pre-press shops around the world. Allow me to dispel another common 
misconception: Despite what you may have heard, InDesign does save backward. It 
has done so since CS2, which saved documents compatible with CS1.

To save a document such that it can be opened in CS2, choose File > Export. In the 
Export dialog, change the Save as Type drop-down to InDesign Interchange format. 
When you save the document, it will be with the .inx file extension. InDesign 
Interchange documents are XML based, and may be opened in InDesign CS2 or CS3 
with the File > Open command. Both versions can also export them, although CS2 
users sending documents to CS3 users can simply send documents in the standard 
INDD format. CS3 will open documents created by any prior version of the program. It 
will only save INDD files as CS3 version, however.

Maintaining a round-trip editing workflow between InDesign CS2 and CS3 is tedious, 
but doable. The CS2 user can send his work as either INDD or INX formats, but the 
CS3 user must send her work back as INX files, which the CS2 user can open and edit.

Note: An update to InDesign CS2 was released shortly prior to the release of CS3. 
Contained in the update was a new version of the INX filter that enables CS2 to open 
CS3-authored INX documents. If you or a CS2-based associate experiences any 
problems opening such documents, ensure that InDesign CS2 has been updated to 
the latest version. You can do that by opening InDesign and choosing Updates from 
the Help menu. The Adobe Updater utility will then check for recent updates to 
InDesign and all installed Adobe applications and present you with a list of available 
downloads. Install any available InDesign updates. While youʼre at it, itʼs a good idea 
to install available updates and patches for all your Adobe applications.
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Chapter Two from InDesign Revealed by Chris Botello and 
Elizabeth Eisner Reding 

Adobe learning http://livedocs.adobe.com/en_US/InDesign/5.0/WSa285fff53dea4f8617383751001ea8cb3f-6f43.html

Place (import) text For a video on importing content into InDesign, see www.adobe.com/go/
vid0067. 
1. (Optional) To create links in placed files, click Type in the Preferences dialog box and select Create Links 
When Placing Text And Spreadsheet Files.

Selecting this option creates a link to the placed file. You can use the Links panel to update, relink, or remove 
links to text files. However, if you format linked text in InDesign, the formatting may not be preserved when 
you update the link. If this option isn’t selected, imported text and spreadsheet files are embedded (not linked). 
2. Do one of the following: 
To create a new frame for the placed text, make sure that no insertion point is present and that no text or 
frames are selected. 
To add text to a frame, use the Type tool to select text or place the insertion point. 
To replace the contents of an existing frame, use a selection tool to select the frame. If the frame is threaded, a 
loaded text cursor appears. 
If you accidentally replace a text file or graphic using this method, choose Edit > Undo Replace, and then 
click or drag to create a text frame. 
3. Choose File > Place. 
4. Select Replace Selected Item if you want the imported file to replace the contents of a selected frame, to 
replace selected text, or to be added to the text frame at the insertion point. Deselect this option to flow the 
imported file into a new frame. 
5. Select Show Import Options, and then double-click the file you want to import. 
6. Set import options, and then click OK.

If you haven’t already designated an existing frame to receive text, the pointer becomes a loaded text icon, 
ready to flow text wherever you click or drag.

If you receive an alert that the requested filter wasn’t found, you may be trying to place a file from a different 
word-processing application or from an earlier version of Microsoft® Word, such as Word 6. Open the file in 
its original application and save it as RTF, which preserves most formatting.

If the imported Microsoft Excel document displays red dots in cells, adjust cell size or text attributes so that 
overset content becomes visible. You can also place the file as unformatted tabbed text, and then convert the 
tabbed text to a table.

Create footnotes
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A footnote consists of two linked parts: the footnote reference number that appears in text, and the footnote 
text that appears at the bottom of the column. You can create footnotes or import them from Word or RTF 
documents. Footnotes are automatically numbered as they are added to a document. Numbering restarts in 
each story. You can control the numbering style, appearance, and layout of footnotes. You cannot add 
footnotes to tables or to footnote text.

For a video on creating footnotes, see www.adobe.com/go/vid0218.

1. Place the insertion point where you want the footnote reference number to appear. 
2. Choose Type > Insert Footnote. 
3. Type the footnote text.

Footnote added to document

A. 
Reference number

B. 
Footnote text

As you type, the footnote area expands while the text frame remains the same size. The footnote area 
continues to expand upward until it reaches the line with the footnote reference. At that point, the footnote is 
split to the next text frame column or threaded frame, if possible. If the footnote cannot be split and if more 
text is added than can fit in the footnote area, the line containing the footnote reference is moved to the next 
column, or an overset icon appears. In such a case, you should resize the frame or change the text formatting. 
When the insertion point is in a footnote, you can choose Type > Go To Footnote Reference to return to where 
you were typing. If you use this option frequently, consider creating a keyboard shortcut.
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Chapter 2 
Working with Text
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Chapter Objectives
•       Format text
•       Format paragraphs
•       Create and apply styles
•       Edit text
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Location Provided Filename Saved Filename
Lessons 1-2 ID 2-1.indd Min-Pin Intro 

Lesson 3 ID 2-2.indd Jake's Diner

Lesson 4 ID 2-3.indd Final Edit

Skills Review ID 2-4.indd Independence

Skills Review ID 2-5.indd Toy Breeds

Skills Review ID 2-6.indd Declaration Edit

Project Builder 1 ID 2-7.indd Drop Cap Modifications

Project Builder 2 ID 2-8.indd Hanging Indents

Design Project ID 2-9.indd Latin Lingo

Group Project ID 2-10.indd Crushing Impact

 

 

Projects to Assign:
 
The Skills Review covers all of the objectives covered in the chapter in a step-by-step progression. Assign this 
exercise for extra reinforcement. Solution files will be very similar.
Two project builders, a design project, and a group project. These projects include content from sidebars and 
marginal information within lessons.
 
Project Builder 1 gives students additional practice working with drop caps.
 
Project Builder 2 gives students additional practice with hanging indents and formatting paragraphs.
 
Design Project lets students practice kerning.
 
Group Project allows students to evaluate the effectiveness of a headline. They are asked to discuss topics such as 
the choice of font, and then they practice with formatting the text using the Character palette.
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INSTRUCTOR’S NOTES
 
Lecture Note: Chapter Overview 
 
In Chapter 2, students will work with text. They will learn about text layout and formatting paragraphs. They'll also 
learn about InDesign utilities, such as Find/Change, and Check Spelling. Students will then learn how to apply 
character and paragraph styles to text. This chapter is chock full of new terms for the students to digest.  
 
Lecture Note:    Format Text
 
Chapter 2 is about text: text formatting, paragraph formatting and text editing. In between the lines, Chapter 2 is 
also about typography. The narrative and the lessons in Chapter 2 focus on function: How to change a typeface, 
type size, how to format a paragraph, create an indent, create a space after a paragraph, etc. These same functions 
can be used to create beautiful and sophisticated typography in InDesign. So, while students are learning the type 
functions of InDesign, the instructor may also want to prompt them to consider the typographical abilities of 
InDesign as well.
 
A good way to do so at this stage of the book is to focus on tracking and kerning. Lesson 1, Objective 2 offers an 
exercise in tracking and kerning. This is a good starting point. Once this lesson is completed, the instructor may 
want to encourage students to continue exploring tracking and kerning in InDesign.
 
First, the instructor can stress an ease of use: Students should become very comfortable with tracking and kerning 
text using the Character palette and with using keyboard shortcuts for tracking and kerning. This should not be 
glossed over: the more comfortable students become with tracking and kerning, the more they will incorporate it 
into their work.
 
Next, the instructor can have students type a word and then track and kern it as they see fit. Since “good” tracking 
and kerning is somewhat subjective, this can lead to interesting debates between students. One classic word that is 
often used as a challenge for tracking and kerning is ATLANTA – in all caps. 
 
Finally, the instructor can have students tear ads and headlines from newspapers and magazines that show examples 
of good and bad tracking choices. 
 
InDesign CS2 offers a new feature when formatting text called Paste without Formatting. This command, on the 
Edit menu, does just what it says. It allows you to paste copied text without the text's formatting. You can also drag 
and drop text from one location to another in CS2. This feature is common in word processing programs so 
students should be happy to see it in InDesign.
 
Another new feature is the ability to insert footnotes automatically. Click Type on the menu bar, and then click 
Insert Footnote. Be sure to point out the Document Footnote Options dialog box, also on the Type menu. Students 
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who are familiar with older versions of InDesign will find these new text formatting features interesting.
 

Figures 1: Kerning text

 
 
Lecture Note:    Formatting Paragraphs   
 
This is perhaps the most important lecture associated with this chapter, because poor paragraph formatting is 
commonplace with both experienced users and novices. 
 
Two problems are classic: Incorrect indents and incorrect spacing.
 
The instructor can begin the lesson by saying: “In InDesign, if you press the spacebar two times, you’ve made an 
error.” This will get the students thinking. It seems like a very broad statement, but it is true. The spacebar is used to 
create a space between two words. That’s it. “What about two spaces after a period?” you might ask. Indeed, that 
was standard for typewriters, but inserting two spaces after a period is incorrect formatting when working on a 
computer. (Only a single space is necessary; word processing applications apply an extra space at the end of a 
sentence).
 
The classic crime is pressing the spacebar 5 or 10 times to create an indent at the beginning of a new paragraph. This 
is a common error.
 
The second classic crime is pressing [Return] or [Enter] twice to create a space after a paragraph. The instructor can 
note: “In InDesign, if you press [Return] twice, you’ve made an error.”
 
It must be stressed that indents and spaces after paragraphs are formatted in the Paragraph palette. The instructor 
must plan for a thorough lecture and discussion on this fact. Moreover, this lecture should be expanded to include 
right indents, inserting a space before a paragraph, pull quotes, and the important role of the soft return. All of this 
is covered in Chapter 2. It needs to be reinforced by the instructor.
 
Once students are comfortable with formatting paragraphs, take some time to point out another new CS2 feature 
that deals with formatting paragraphs: Bullets and Numbering. This dialog box, available on the Paragraph palette 

http://neuage.org/dwight/inDesign/manual/InDesign-chap02.htm (6 of 9) [3/9/08 12:51:08 PM]



Chapter B

menu, allows you to apply bullets or numbers to your text. Students will most likely be very familiar with this feature 
from using it in other programs. This is a fun and self-explanatory feature. Remind students that bullets and 
numbers are applied to paragraphs: this will help them remember how to access the feature. See Figure 2 below.
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Figure 2: Accessing Bullets and Numbering

 
 
 
Lecture Note:    Create and Apply Styles
 
Styles represent one of the great benefits of digital word processing. The ability to assign a style to a headline or to a 
paragraph and to use that style throughout a document is truly a powerful option. The ability to edit those styles and 
have the edit execute itself throughout the document saves time and offers unprecedented consistency. It’s not hard 
to sell the benefits of working with styles.
 
Yet, in addition to the lessons in the book, many students will need a lecture on styles to reinforce their importance. 
Why? Because many younger users tend to jump right in and start working. This lecture should be designed to 
encourage students to plan their document before they start working. Part of that planning will be to determine styles 
– headline styles, paragraph styles, styles for pull quotes, styles for footnotes, etc. The New Paragraph Style dialog 
box, where these choices are made, is shown below in Figure 3. Throughout, students should be reminded that no 
choice they make with styles is set in stone. Styles can always be updated.
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Figure 3: New Paragraph Style dialog box

 
Another new feature in CS2 is the Quick Apply command on the Edit menu. Quick Apply allows you to find and 
apply a style quickly, select text or a text frame, click Edit on the menu bar, then click Quick Apply. Begin typing the 
style name, which displays matching styles in the Quick Edit list. Click the style that you want to apply, then click 
[Enter] (Win) or [return] (Mac) to apply it. As students will learn later on in the book, you can now apply object 
styles to objects. Quick Apply works for object styles as well as character and paragraph styles. 
 

 
Lecture Note:  Edit Text
 
Throughout Chapter 1, we stressed the primary role of InDesign as being a layout application. This lecture is 
designed to remind students that InDesign is also a fully-functional word processing application. This distinction 
might be lost on younger student, many of whom will have grown up with computers and have never used a 
typewriter.
 
An interesting way to begin the lecture would be to ask, “What is word processing?” This is a term that most if not 
all of the students will have heard, but will they be able to define it? Have they ever thought about what it means? 
This lecture will give the instructor the opportunity to contrast text editing in an application like InDesign with that 
of old-fashioned typewriter work. The distinctions are endless. For the students, the contrast will spark an 
appreciation and a deeper understanding of the power of digital word processing.
 
This lecture should flow naturally into a focus on two of the most powerful features of word processing: The Find/
Change dialog box and the Spell Checker. Both of these features are covered thoroughly in the exercises in Lesson 
4. The instructor is encouraged to introduce this lecture before the students tackle the exercises in Lesson 4. The 
instructor should remind students not to take these features for granted and to explore them more thoroughly. For 
example, the Add function of the spell checker – the ability to create a customized dictionary – is a truly 
empowering feature and should not be overlooked. 
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InDesign CS2 has added two new features to help with spell checking: Dynamic Spelling and Autocorrect. Like 
many of the new type-related features in CS2, these two may be familiar with students who have used word 
processing programs. When Dynamic Spelling is activated, a red squiggly line is drawn under words that InDesign 
considers misspelled. Autocorrect will correct a misspelled word if you type the word incorrectly, and then press 
[Spacebar] twice. The words that Autocorrect reacts to must appear in the list of misspelled words in the 
Autocorrect Preferences dialog box. Note that you can add your own commonly misspelled words to the list. See 
Figure 4 below. Autocorrect and Dynamic Spelling are found by clicking Type on the menu bar, under the Spelling 
command.
 

Figure 4: Autocorrect Preferences dialog box

 
Classroom Activity Matching

As a fun way to end this chapter, hand out a quick quiz of matching all of the terms in this 
chapter with their definitions. This will be a great way for students to make sure they are 
clear on all of the new information.
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TODAY
TECHNOLOGY HOMEPAGE year ten Return to year 10 Home / Daily NOTES / Calendar/ Moodle / 

Wiki / My Dwight / Curriculum Map TRIMESTER TWO
First Class - email is on your desktop - from home log in here

 

Assessment Criteria for the IB MYP 

TECHNOLOGY
Criteria Name Max
A investigate 6
B design 6
C plan 6
D create 6
E evaluate 6

F attitudes in 
technology 6

September 2007 Rhino tutorial index Rhino 4.0 
vidoes on iTunes 

yaucht

 pdf download of boat
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●     WEDNESDAY 14th - DAY 3 Do Exercise 23 and exercise 24. We have only these days left for 
this trimester and your grade: 14th, 19th

●     FRIDAY 9TH - DAY 6 Exercise 21, pages 73 - 75; page 75 go over the button commands; Exercsie 
23 and 24.

●     TUESDAY 6th - DAY 3 Period 3 – 10.50- 11.35 

1.  Do exercise 18 on page 59.

2.  Page 60 look at Object Snaps - 

osnap

 / 
3.  explore what happens when you draw new lines with center and etc. 

selected. 

osnaps

4.  Do exercise 19 page 61. It is in the help tutorials >  

http://neuage.org/dwight/10th/notes.html (2 of 5) [3/9/08 12:51:16 PM]



year ten class notes

> level 1  > 

Osnap 
5.  Do exercise 20 on page 67
6.  Do exercise 21 on page 72..
7.  Analysis Commands pages 64 - 65. You should have at the bottom of your screen this 

number 
distance

 (the F2 key does not seem to give the other results).

●     THURSDAY 1st - DAY 6 Period 3 - 10.50 - 11.35 Chapter 4. Read up to and do page 52 Make 
the arrow and print it. Also do the exercises on page 55 - 58 - make the chair.

●     MONDAY 29th - DAY 3 Period 3 – 10.50- 11.35 Going over our Rhino Index page; Properties (are 

not under File > Properties in 0SX) are here (hold down and click properties to get this) 
properties

 

grids

 Click on Grid and change to ...
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1.  

2.  In your guide go to page 37 to page 43 and work with layers - layers are under edit or  Set 
up several layers 

3.  Start on section 5 handouts

●     TUESDAY 23rd - DAY 6 Period 3 - 10.50 - 11.35 NEW TUTORIALS >
●     THURSDAY 18th - DAY 3 Period 3 – 10.50- 11.35 Today we will:

1.  join the Rhino forums http://community.irhino3d.com/forums/, 
2.  Look at support and help notes: http://community.irhino3d.com/forums/8.aspx
3.  Look at the renderosity site, http://www.renderosity.com/
4.  youtube Rhino tutorials, see our tutorial page http://fc.dwight.edu/studentweb//Rhino/index.html
5.  iTune videos,
6.  handout for "Creating Two-Dimensional Objects",
7.  Flashlight tutorial and arm tutorial 
8.  You can download the latest Rhino Beta for Mac for free at http://download.mcneel.com/

wenatchee/ lastest version  This is the latest as of the 17th of October 2007.

●     MONDAY 15th - DAY 6 Rhino shapes
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●     THURSDAY 4th - DAY 6 Period 3 - 10.50 - 11.35 See xhtml for today learning CCS and division tags
●     Monday 01 - DAY 3 Period 3 – 10.50- 11.35 xhtml Before goint to the xhtml notes look up the home 

of html and read for fifteen minutes or so about the organisation that controls the language of the 
Web. Find something about the history of html and write about it in our Moodle assignment for 
today. Moodle is at inside.dwight.edu/moodle

●     TUESDAY 25h - DAY 5 Period 3 - 10.50 - 11.35 continue with textedit and use dreamweaver to set up 
a folder

●     FRIDAY 21th - DAY 3 Period 0 - 8.00 - 8.35 using textedit to create a page
●     TUESDAY - 18 DAY 6 Period 3 Set up a folder on the desktop and create an index.html page and 

move the folder to studentweb. Log onto my.dwight.edu - use your user ID then dwight as the 
password and change it when asked.

●     TUESDAY 11th - DAY 3 Period 3 - 10.50 - 11.35 Setting up your folder in First Class / Sign up or 
into Moodle and answer today's question. What we will do this trimester - setting up a virtual world

●     
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Flash files and sites for trimester two year ten technology

See also Flash - index

Atomic Learning username: dwight password student

Mobile Flash Art: cell phone as artistic platform 
Advergames 
Flash Training:  
Flash lite 
Adobe Device Central

Ping Magazine 
01design

Mobile phone movies 

●     Los Viajes de King Tiny 
●     Making a Film for the Really Small Screen
●     HIGH WAY HER LIFE

 

Mobile phone games
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design that moves 
 
Lorem ipsum placerat quisque molestie. mauris accumsan, lectus sit amet venenatis ornare, dui 
sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac dolor 
sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis scelerisque 
consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat enim in 
massa. nunc ac dolor sit amet dui ultricies facilisis. suspendisse turpis. proin libero leo, rhoncus 
id, pharetra non, laoreet eu, sem. praesent mattis laoreet velit. nunc vehicula congue nulla. cras 
vestibulum diam vitae pede  
 

 ornare, dui sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis 
scelerisque consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat 
enim in massa. nunc ac do 

Nec lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. 

design that moves 
 
onsequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc 
ac dolor sit ame venenatis ornare, dui 
sapien consequat purus, eget pulvinar 
metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. 
nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. 
Lorem ipsum placerat quisque molestie. 
mauris accumsan, lectus sit amet venenatis 
ornare, dui sapien consequat purus, eget 
pulvinar metus velit vel justo. ut pulvinar 
venenatis quam. nam sed urna nec lacus 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. nullam eu enim. nullam 
tristique, nunc quis scelerisque consequat, 
leo wisi aliquet enim. sed urna nec lacus 
rutrum euismod. nunc ac dolor sit ame 
venenatis ornare, dui sapien consequat 
purus, eget pulvinar metus velit vel justo. ut 
pulvinar venenatis quam. nam sed urna nec 
lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. mauris accumsan, lectus 
sit amet venenatis ornare, dui sapien 
consequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar.
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animate me

Monday, November 14, 2005

Bongo is the animation package to Rhino and we will work (play) with it this week with the hopeful 
outcome of having an animated animal, modeled in Rhino, rendered in Flamingo, and animated in 
Bongo by the end of this course - next Monday.

1. Start Bongo; either key in 'Bongo' in the Command line or start from the Bongo menu.

2. Begin with page 3 - 'To start using Bongo' - choose Timeline

3. Have a 'look' at the timeline - see what the deal is. For example, what is the difference between the 
Timeline Slider and the Timeline Markers? 

4. 

http://neuage.org/AA/rhino/notes/11-14.htm [3/9/08 12:51:20 PM]
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Rhinoceros® Albany Academy trimester 1 lesson plan and notes

return to front page of course

 

Students will be instructed in the principles of 3-D modelling using Rhinoceros NURBS 
modelling  software. In a laboratory setting, students will have an opportunity to practice the 
strategies and  methods commonly used in creating and solving 2-D and 3-D geometric problems. 
Information given in lectures and demonstrations will address aspects of modelling free-form 
curves, surfaces, and solids. Students will be introduced to a variety of 3-D model applications as 
they are used in illustration, engineering, design, documentation drawing, entertainment, and 
animation. 
 
In addition to developing a working knowledge of 3-D terminology and concepts, each student 
will learn how to create a variety of 3-D geometric models from technical drawings, sketches, 
real models, and written descriptions. 
 

Course objectives 
 
This course will: 

●     Provide a working foundation in sketching, interpreting, and creating computer-generated 
●     models. 
●     Provide students with the ability to describe the organization, terminology, function, 
●     capabilities, and limitations of 3-D computer graphic software in regards to modeling. 
●     Use Rhino 3-D modelling software to create surface and solid models. 
●     Set up a 3-D scene and view 3-D space. 
●     Develop sketches of models and practice viewpoint identification and selection. 
●     Place lights and render scenes. 
●     Create 2-D dimensioned drawings of 3-D models. 

About Rhino

■     Rhino is a powerful design and visualization tool you can use with most computers 
running Windows. The home page for Rhino is at http://www.rhino3d.com/. If you want to 
try it at home you can download a 30-day free trial. If you prefer to load the trial program 
from a disk I will make available the 30-day program. The trial program has all the 
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features of what we will use in class except for the plug-ins for rendering and animation 
discussed below. 

■     Once a model is completed in Rhino, it can then be used with other applications to further 
enhance a project. For example, you can create a model and export the file to a CNC 
machine (Computer Numeric Control) for prototyping or manufacturing or render the 
model and use it on Web pages, newsletters, and presentations. Models can be exported to 
other software programs for animation. We have several products available on our 
computers that we will use to enhance our Rhino modelling experience such as 
‘Flamingo’, a rendering plug-in; 'Bongo', an animation tool and 'Penguin' which brings 
freehand sketching, watercolour painting and cartoon-like rendering to Rhino and 
AutoCAD.

■     Rhinoceros is a 3-D NURBS modelling program for Windows. With Rhino you can model 
anything from a heart valve to a ship hull and from a mouse to a monster. Rhino provides a 
flexible, accurate, and fast working environment. You can model and render objects that 
you could previously create only using software and hardware many times more 
expensive. 

■     Rhino is easy to learn and use. With Rhino, you can create free-form curves, surfaces, and 
solids. 

■     You are free to create the model any way you want. 

Our course

■     Each student will receive a training manual of 270 pages (training manual level 1). Mid-trimester 
you will receive training manual level 2. NOTE: These manuals are yours to keep and make 
notes in.You will need to keep notes in a folder on your 'U' drive.

■     We have several training CDs for special interests such as 'Rhino-Advanced Training Series: 3-D 
Modelling for the Marine Industry', 'Modelling and Mould Making for Jewellery Designers' and 
'Forms vs Shape 1' and 'Form vs Shape 2' as well as CDs on 'Rhinoceros Visual Tips Sampler' 
and 'Flamingo Visual Tips' all of which may be used in the classroom during non-teaching 
periods if I am in the room.

■     Peer review is an expected source of feedback for all students. There will be a form and 
methods established that would encourage each student to be a part of the evaluation 
process. Modellers should save or archive their model files. Files of the rendered image 
should also be saved. Make sure that wherever your model is saved, you include your 
name and the date on the label. These files will be used as examples for other students and 
may be posted on an internet gallery. SEE http://gallery.mcneel.com/?language=en&g=47 
FOR EXAMPLES
 

Evaluation 
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Our grading rubric is interpreted as 
4.0=A, 3.0=B, 2.0=C, 1.0=D, 0.0=F. In this scale, half points could be interpreted as pluses 
or 
minuses. 
 
Grading Rubric 
 
Unique/innovative design AND All of the elements presented excellently 4.0 points 
All of the elements presented well 3.5 points 
Most of the elements adequately presented 3.0 points 
Some of the elements adequately presented 2.0 points 
Some of the elements shown 1.0 points 
None of the elements adequately presented 0.0 points 
 
Assignments
 
Assignments are based on using the Rhino Level 1 Training manual as a reference and the 
Sample Design Activities for projects. 
 
Weekly assignments are at http://www.albany-academy.org/compcon/rhino/notes/index.htm 
 
Design assignments 50% 
 
Completing assigned activities on time is essential to learning computer software. We must 
 keep up with the daily computer work so future projects can be completed. 
Students who fall behind in assignments in the first few weeks of class find it difficult to 
produce 
more complicated designs near the end of the semester. 
 
Worksheets and Quizzes 20% 
 
Learning the terminology of a software program us use the correct term when asking a 
question or 
contributing to a class discussion.  Weekly quizzes require students to commit to memory 
the 
vocabulary used in the software program and the general commands for navigating around 
the 
software. 
 
Midterm and Final Tests 5% 
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The midterm is the halfway point in the semester. The midterm gives both myself and you 
the opportunity to look at the progress you have made so far. This is a good time for me to 
evaluate the pace of the class and make any necessary changes in the curriculum. The final 
is a cumulative collection of information given over the course of the semester. The final 
covers vocabulary and a computer modelling section. By the end of the semester, students 
should be able to re-create simple computer models without detailed instruction. 
 
Student Notebook 10% 
 
A required student notebook is one way for me to teach the importance of  keeping all of 
your work together. Students should keep a notebook containing their projects for the 
entire semester. This is a good way for me to see the improvement in your progress over a 
period of time. For you the notebook is a valuable source of reference for future design 
projects. It also becomes the basis for the required portfolio of work that will be done at 
the end of the class. 
 
Students are required to keep all handouts, sketches, photographs, computer printouts, 
projects, and any other information that pertains to the class in the notebook. 
 
Final Project Portfolio 15% 
 
The final project is your chance to show off the work you have put into learning the 
software and design elements over the semester. Although you will be given final project 
guidelines to follow, I encourage you to be inventive and creative. The final project should 
be a major portfolio piece when completed. 

NURBS 

Non-uniform rational B-splines (NURBS) geometry is a mathematical representation that can 
accurately define any shape from a simple line, circle, arc, or box to the most complex 3-D free-
form organic surface or solid. Because of their flexibility and accuracy, NURBS models can be 
used in any process from illustration and animation to manufacturing. 

Rhino’s Geometry Types 

There are four fundamental geometric objects in Rhino: points, NURBS curves and surfaces, and 
polygon meshes. 

Ø      Points. 
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Ø      NURBS curves. 

Ø      NURBS surfaces. 

Ø      Polygon meshes. 
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Grading for Rhinoceros

Grading for Rhinoceros
return to front page of course
 
Teaching Methods:
 

1.        Lectures/Demonstrations:  The first half of each class will be used to highlight the important material we will work 
on for the class using interactive discussions, group work, handouts, and computer demos. 
2.        Labs:  The last half of each class is dedicated to hands-on learning.  You will work at your own pace during this 
portion of the class to solidify the lesson material or to begin work on the weekly projects. 
3.        Projects:  Each project consists of three parts:  the Concepts Review, Skills Review, and Visual Workshop.
4.        Quizzes:  Ten hands-on quizzes will be given.  Quiz exercises are pulled from what we discuss in class and work on 
in lab. 

 
 TOTAL 

POSSIBLE 
POINTS

 
YOUR
SCORE

FINAL 
LETTER 
GRADE

 
TOTAL 
POINTS

PROJECTS    A 180-200
10 @ 10 points each each Monday quizz 100  B 160-179
    C 140-159
    D 120-139
    F 0-119
     
    
    
    
Projects   
5 @ 20 points each   100
   
   
TOTAL:  200  
 
Quiz each Monday 
September

1.  Week 3: Monday 19
2.  Week 4: Monday 26 PROJECT ONE DUE

October 
3.  Week 5: Monday 03
4.  Week 6: Wednesday 12 (Monday is Columbus Day - Tuesday not a class) PROJECT TWO 

DUE
5.  Week 7: Monday17
6.  Week 8: Monday 24 PROJECT THREE DUE
7.  Week 09: Monday 31

November
8.  Week 10: Monday 7 PROJECT FOUR DUE
9.  Week 11: Monday14
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10.  Week 12: Monday 21 PROJECT FIVE DUE
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Quiz answers

Quiz answers: answers will be up until Monday morning

Week Two: first quiz Wednesday, September 21, 2005

Week Three: second quiz Wednesday, September 29

http://neuage.org/AA/rhino/quizzes.htm [3/9/08 12:51:23 PM]
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index for daily notes in Compute

index for daily notes in Computer Writing 

Monday November 28 Introduction - setting up our blog - and 'what is hypertextual story telling'?
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Gif Stories from Computer Writing Class

Albany Academy and Albany Academy for Girls 

return to computer courses at Albany Academies   

Gif Stories from Computer Writing second trimester class

Dr. Terrell Neuage

    1 2 - WITH VIDEO

Tomas   

Christopher X  
Kyle X  
Nathan X  
Rachael K. X  
Rachael S.   
Nicola (Niki) X  
Vivian (Viv) X  
Jeffery X  
Nicholas   
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Teaching Methods

Grading 

Web designing Albany Academy lesson plan and notes calendar/grading/daily notes/
home/all

Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org
Assessment Plan
Student Evaluation:
Students will be given objective quizzes on application concepts as well as subjective quizzes and 
projects where the aesthetic considerations and originality and quality of the finished project is 
evaluated.
Students will be evaluated as follows:
 
Projects 1/2                                                               
Quizzes 1/2
APPROXIMATE POINT TOTALS: 
Midterm and Final- up to 100 points each  
Final Project- up to 100 points 
Portfolio – which will be worked saved in the student’s folder - up to 100 points 
Weekly assignments & quizzes- 10 points per week 
GRADE SCALE: The following grade scale will be used in this course: 
90-100% = A 
80-89% = B 
70-79% = C 
60-69% = D 
59% & below = F
DEFINITION OF GRADE SYMBOLS 
A Exemplary achievement of the course objectives. In addition to being clearly and significantly 
above the requirements, work exhibited is of an independent, creative, contributory nature.
B Superior achievement of the course objectives. The performance is clearly and significantly 
above the satisfactory fulfillment of course requirements.
C Satisfactory achievement of the course objectives. The student is now prepared for advanced 
work or study. Note: The letter grade “C” does not imply satisfactory achievement at the graduate 
level.
D Unsatisfactory achievement of course objectives, yet achievement of a sufficient proportion of 
the objectives so that it is not necessary to repeat the course unless required to do so by the 
academic department.
F Unsatisfactory achievement of course objectives to an extent that the student must repeat the 
course to receive credit. 
Quiz each Monday 
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Teaching Methods

September
1.  Week 3: Wednesday 21 lesson 1 
2.  Week 4: Thursday 29 QUIZ 2 PROJECT ONE DUE 

October 
3.  Week 5: Thursday 06 Quiz 3 
4.  Week 6: Wednesday 12 (Monday is Columbus Day - Tuesday not a class) 

PROJECT TWO DUE 
5.  Week 7: Monday17 
6.  Week 8: Monday 24 PROJECT THREE DUE 
7.  Week 09: Monday 31 

November
8.  Week 10: Monday 7 PROJECT FOUR DUE 
9.  Week 11: Monday14 

10.  Week 12: Monday 21 PROJECT FIVE DUE 
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Grading general

see below for trimester two

Web designing Albany Academy lesson plan and notes calendar/grading/
daily notes/home/all

Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org
Assessment Plan
Student Evaluation:
Students will be given objective quizzes on application concepts as well as subjective 
quizzes and projects where the aesthetic considerations and originality and quality of the 
finished project is evaluated.
Students will be evaluated as follows: [this of course may change] 

 this in front of anything means you will see it on a test 
 

 Three Projects = 30 %     
1.  December Week 2: Wednesday, 7
2. JANUARY Week 5:   Monday 9 Making own button project 
3. February Week 11: Wednesday 22 Project in FreeHand

 Finishing lessons (lesson 6 - 13 - Flash and 1 - 7 FreeHand) on time = 15% 
or 1% each

  Final Flash Test 20%  Week 8: FEBRUARY  Thursday 2nd 
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 FreeHand Test 15% Week 11: Wednesday 22 FreeHand test
 

 Final Flash Project  20%   Week 12:  MARCH  Friday  3                                          
 
 
 
 
GRADE SCALE: The following grade scale will be used in this course: 
92.5-100% = A+
89.5 - 92.4 = A 
84.5-89.4% = B+ 
80.5-80.4% = B 
75.5 - 80.4% = B- 
70.5 - 75.4% = C+
65.5 - 70.4% = C
 
DEFINITION OF GRADE SYMBOLS 
A + Exemplary achievement of the course objectives. In addition to being clearly and 
significantly above the requirements, work exhibited is of an independent, creative, 
contributory nature.
A Superior achievement of the course objectives. The performance is clearly and 
significantly above the satisfactory fulfillment of course requirements.
B+ Satisfactory achievement of the course objectives. The student is now prepared for 
advanced work or study. Note: The letter grade “C” does not imply satisfactory 
achievement at the graduate level.
C Unsatisfactory achievement of course objectives, yet achievement of a sufficient 
proportion of the objectives so that it is not necessary to repeat the course unless 
required to do so by the academic department.
F Unsatisfactory achievement of course objectives to an extent that the student must 
repeat the course many many times to receive credit. 
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Web designing Albany Academy lesson plan and notes calendar/grading/daily notes/
home/all courses taught by Dr. Neuage at AAG and AA

Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org 

Monday:         9:15  -  10:05
Wednesday:    8:20  - 9:10
Thursday:       9:15  -  10:05
Friday:            8:20  - 9:10

 
1.      710 Web Design (Fall 2005 First Trimester) – Dreamweaver – Fireworks – Ulead 
Gif animinator 
2.      711 Web Animation (Winter 2005 Second Trimester)
3.      712 Web video (Spring 2006 Third Trimester)

 
Grades 9-12
1/3 credit – No pre-requisite 
 
Course Description
 
This course teaches students the fundamental techniques involved in building a website using the 
program Dreamweaver. Students will learn to scan and edit photographs and text for use in their 
web pages and web photo albums. Topics will include learning the language of html, creating 
tables and layers, adding graphics, photos and animated gifs, wrapping text, and creating 
hypertext links. The second half of the trimester will be spent creating projects using the 
techniques learned in class.  
 
Web Design is a full year course designed to provide you with the skills necessary to plan, create, 
and maintain web sites. These skills include creating both static & animated graphics, and 
navigation systems; managing files through directory structures that mirror the site information 
structure; producing readable text blocks based on relatively unsophisticated Web typography; 
and general information management and presentation techniques. 
 
Throughout the course, emphasis will be placed on both information and graphic design, stressing 
four basic design principles: alignment, proximity, repetition, & contrast.
 
COURSE OBJECTIVES: 
Upon completion of the course students will: 
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1. Operate (at an entry level) the software used in web design, image editing, and related topics. 
2. Successfully build a variety of Web sites, based on the lecture and the textbook information. 
3. Demonstrate a basic understanding of the Macintosh computer systems and components. 
4. Understand basic file management as it relates to Web design. 
5. Have fun, get creative, expand their Web design skills, develop a portfolio and more....
 
Academic

Effectively follow written and oral instructions
Proofread and edit material
Use simple mathematical computational skills to create proper document layout
Use simple English skills in language development activities and composition

Thinking
Use critical thinking to plan, design, and create presentations, web pages, 
designs, and newsletter layouts
Apply decision making skills to select the order of completion of certain 
elements of projects

Personal
Maintain good attendance and punctuality
Effectively use time to complete projects
Model good work ethics regarding classwork and use of the internet
Maintain clean, neat work station
Bring proper supplies to class (paper, pencil and keep all handouts in folders)
 

Guidelines
Each student will be assigned a specific computer to use for the duration of the school year. 
Students will sign an acceptable user policy before using any computer equipment
All work must be completed at school. No disks from outside may be used without prior approval 
for any reason. 
While cooperation and collaboration is an important part of academic work; and we will do 
webpages as a collaborative effort for a few exercises, class assignments should not be 
duplications of work done by others. All assignments should be the original work of the 
individual student/student teams and should include appropriate citations as appropriate. Makeup 
work may be completed with prior approval of me It is the students’ responsibility to get missed 
assignments and complete them within two weeks from the date of excused absence. No makeup 
work will be completed during class unless and until all current classwork is done.
Instructional Delivery Plan
The primary emphasis of the course will be hands-on planning, design, and production of 
interactive multimedia applications; but the course will also include demonstration, discussion, 
and limited lecture. 
First Trimester
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2. Dreamweaver. The first unit, which we will spend three weeks on, will integrate the Fireworks 
graphics created in the first units with text in fully designed web pages using Macromedia 
Dreamweaver MX. This unit will last two to three weeks and cover the following topics:

●     Dreamweaver basics 
●     Working with graphics 
●     Creating links 
●     Elements of page design 
●     User interactivity 
●     Site management 
●     Library items 
●     Templates 
●     Style sheets 

Depending on your skills and interest, server-side technologies may be explored. This unit will 
culminate with an individual web site.
2. Fireworks. The second unit spanning two to three weeks will focus on Macromedia Fireworks 
MX, a Web graphic creation tool that includes image and vector editing capabilities as well as the 
ability to create animated gifs. Topics studied will include:
You will have reading assignments and small projects to practice and refine your graphic creation 
skills.
Second Trimester 
Flash. The second trimester will be spent developing facility with Macromedia Flash MX, and 
Ulead’s Gif animator. As such, learning Flash will involve you in the artistic and analytic aspects 
of animation, using both drawing tools and programming in Actionscript. Topics studied will 
include:

●     Flash basics 
●     Symbols and basic animation 
●     Complex animation and basic actions 
●     Buttons and sound 
●     Complex interactivity 
●     Dot syntax and the creation of objects 
●     Multi-level communication 
●     Advanced uses of the movie clip symbol 
●     Controlling sound and text dynamically 
●     Advanced manipulation of information 
●     Managing content and troubleshooting 

Through reading assignments and small projects you will develop and prove your abilities in 
these areas. A more extensive final project will finish this section of the course.
      3. 712 Internet Video (Spring) – AAG – Cool 3D – Ulead video – Vegas video
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Grades 9-12
1/3 credit – prerequisite Web Design
This course teaches students the fundamental techniques involved in adding video to a website. 
Students studying video will learn to edit video clips using a variety of techniques found in the 
production of movies, TV shows and commercials. The video editing techniques include panning, 
cropping, replacing narration, adding music beds, transition effects, envelops, creating 
composites and rendering. The second half of trimester will be spent creating projects using the 
techniques learned in class.
Animation 
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General Information

General Information: see calendar for dates of work due and notes for what we are doing on a 
daily basis and grades for this course assessment is on.
 

Essential Technology 
Albany Academy lesson plan and notes

Courses taught by Dr. Neuage at AAG and AA
http://www.albany-academy.org/compcon/

 
Instructor Dr. Terrell Neuage neuaget@albanyacademyforgirls.org

BA (journalism), Honours (literature), Master (Internet Literature) Deakin University, 
Melbourne, Australia; Ph.D. (Internet Communication and New Media) University of South 

Australia
 

Monday:   8.20 -    9.10
Tuesday:   9.15 – 10.05
Thursday: 8.20 –   9.10
Friday:    10.15 – 11.05

 
Teaching Methods:
 

1.        Lectures/Demonstrations:  The first half of each class will be used to highlight the 
important material we will work on for the class using interactive discussions, group work, 
handouts, and computer demos. 
2.        Labs:  The last half of each class is dedicated to hands-on learning.  You will work 
at your own pace during this portion of the class to solidify the lesson material or to begin 
work on the weekly projects. 
3.        Projects:  Each project consists of three parts:  the Concepts Review, Skills Review, 
and Visual Workshop.
4.        Quizzes:  Ten hands-on quizzes will be given.  Quiz exercises are pulled from what 
we discuss in class and work on in lab.
 
Material for these classes come from the Microsoft Office Online Training Pages as well as 
'Microsoft Office Outlook 2003' (2004), Matthews, Marty; Diamanti, Kellen; Simmons, 
Curt; McGraw-Hill, Emeryville, California and from our practice sessions using the 
Microsoft packages. 

 
Course Description
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General Information

 
This class meets four days a week.
This course is designed to give students daily use of computers and to be exposed to MicroSoft 
Office as well as the Internet. 
Our plan for the year is:

●     1st trimester: Outlook, Word, Office Tools, InfoPath 
●     2nd trimester: Excel, PowerPoint, Publisher, Access, Nanotechnology   
●     3rd trimester: FrontPage, HTML. Java Script, Gif Animation - Internet Technology: 

discussion forums and newsletters - Search Engines, Hosting WebSites; how the 
Internet works

 
Grading see: http://www.albany-academy.org/compcon/et/gradesET.htm
Calendar see: http://www.albany-academy.org/compcon/et/et_calendar.htm
 
COURSE OBJECTIVES: 
Upon completion of the course students will: 
1. Operate (at an entry level) the software used in all forms of computer writing, spreadsheets, 
calendars, email, web design, image editing, and related topics. 
2. Successfully build a variety of Web sites, be successful at organizing data online; being 
efficient with email and other online communications; creating online journalistic articles, 
reviewing other technologies such as Nanotechnology (State University at Albany has the first 
Nanotechnology College in the world).  
4. Understand basic file management as it relates to email, Word documents, new letters, Web 
design. 
5. Have fun, get creative, expand computer design skills, develop a portfolio and more....
Academic
Effectively follow written and oral instructions
Proofread and edit material
Use simple mathematical computational skills to create proper document layout
Use simple English skills in language development activities and composition
Thinking
Use critical thinking to plan, design, and create presentations, web pages, spreadsheets, 
datadesigns, and newsletter layouts
Apply decision making skills to select the order of completion of certain elements of projects
Personal
Maintain good attendance and punctuality
Effectively use time to complete projects
Model good work ethics regarding classwork and use of the internet
Maintain clean, neat work station
Bring proper supplies to class (paper, pencil and keep all handouts in folders) 
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General Information

Guidelines
Each student will be assigned a specific computer to use for the duration of the school year. 
Students will sign an acceptable user policy before using any computer equipment
All work must be completed at school. No disks from outside may be used without prior approval 
for any reason. 
 
While cooperation and collaboration is an important part of academic work; and we will do 
webpages as a collaborative effort for a few exercises, class assignments should not be 
duplications of work done by others. All assignments should be the original work of the 
individual student/student teams and should include appropriate citations as appropriate. 
 
Makeup work may be completed with prior approval of me It is the students’ responsibility to get 
missed assignments and complete them within two weeks from the date of excused absence. No 
makeup work will be completed during class unless and until all current classwork is done.
Instructional Delivery Plan
The primary emphasis of the course will be hands-on planning, design, and production of 
interactive multimedia applications; but the course will also include demonstration, discussion, 
and limited lecture. 
 

Headphones are not allowed when a student is in a class.  

Cell phones should be off during the day - or used outside of the school building.  Any phone left 
on will be given back at the end of the class.
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Grading for Essential Technology 
 
Instructor Dr. Terrell Neuage 
neuaget@albanyacademyforgirls.org 

 Assessment Plan
Student Evaluation:
Students will be given objective quizzes on application concepts as well as subjective quizzes and 
projects where the aesthetic considerations and originality and quality of the finished project is 
evaluated.
Students will be evaluated as follows:
Daily Work 1/3
Projects 1/3                                                                
Quizzes 1/3
APPROXIMATE POINT TOTALS: 
Midterm and Final- up to 100 points each  
Final Project- up to 100 points 
Portfolio – which will be worked saved in the student’s folder - up to 100 points 
Weekly assignments & quizzes- 10 points per week 
GRADE SCALE: The following grade scale will be used in this course: 
90-100% = A 
80-89% = B 
70-79% = C 
60-69% = D 
59% & below = F
DEFINITION OF GRADE SYMBOLS 
A Exemplary achievement of the course objectives. In addition to being clearly and significantly 
above the requirements, work exhibited is of an independent, creative, contributory nature.
B Superior achievement of the course objectives. The performance is clearly and significantly 
above the satisfactory fulfillment of course requirements.
C Satisfactory achievement of the course objectives. The student is now prepared for advanced 
work or study. Note: The letter grade “C” does not imply satisfactory achievement at the graduate 
level.
D Unsatisfactory achievement of course objectives, yet achievement of a sufficient proportion of 
the objectives so that it is not necessary to repeat the course unless required to do so by the 
academic department.
F Unsatisfactory achievement of course objectives to an extent that the student must repeat the 
course to receive credit.
Quiz each Monday unless otherwise noted see calendar for changing dates of 
quizzes – projects
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September
1.  Week 3: Monday 19 
2.  Week 4: Thursday 29th 

October 
3.  Week 5: Thursday  06 First project due 
4.  Week 6: Tuesday 11 (Monday is Columbus Day) 
5.  Week 7: Monday17 
6.  Week 8: Monday 24 Second Project due 
7.  Week 09: Monday 31 

November
8.  Week 10: Monday 7 Third project due 
9.  Week 11: Tuesday 15 (Monday is Labour Day) 

10.  Week 12: Monday 21 Fourth project due 
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Begin FrontPage

Dr. Terrell Neuage teacher
Essential Technologies (Spring 2006) FrontPage, HTML. Java Script, Acid Music 

Studio,  Search Engines, Hosting WebSites; how the Internet works
Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides

 
Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar 

 
May 22, Dr. Ryu (RPI)    will give a demonstration on the nano-electronic microscope and 

at 1.30 the bus leaves from AA for the SUNY nano-technology college for our visit of 
NanoCareer Day 

 
March 06
Tuesday March 07
Thursday March 09
Friday March 10
Monday March 13
Tuesday March 14
Thursday 16th
Friday 17th
Monday April 03
Tuesday April 04 
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Begin FrontPage

  inserting video clips

and other groovy things
Friday April 07 1934
Monday April 10
Tuesday April 11 
Monday April 17th
Tuesday April 18
Today
Friday April 21
Monday 24th
25 - April Tuesday
27th Thursday
test for FrontPage
Monday Sony Acid
Tuesday Sony Acid
Thursday May 04 Flash
Friday Flash 5
Tuesday May 09 Mini movie
Thursday May 11
Friday 12th of May
Monday again
Tuesday 16th May
18th May Thursday
Friday 19th Friday
Monday 22 May
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Tuesday 23 May
Thursday 25 May
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Grading for trimester three web

Grading for trimester three web design with Front Page

●      15 Points for Spring Break project page
●      40 points - daily exercises from the book
●     20 points major website May third
●     15 points major website last week of Trimester 
●     10 points for test (terms and etc)
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Begin FrontPage

We will start off with learning/using FrontPage as our webpage maker.

NOTE 1: Front Page, like everything in life, will only be around for a short time. If we get Dreamweaver before the 
end of the trimester we will use that. However, there are many things we can learn about making a webpage using Front 
Page that will be transferable to other web design tools.

"Microsoft will close the book on its FrontPage Web-design program with the release of Office 2007, formerly known as 
Office 12, late this year..." Wednesday, posted at PC World February 15, 2006.  
 

Microsoft's new product coming out soon "Microsoft® Expression®" with Office 2007 will use many of the features we 
will be learning.

NOTE 2:We are using Front Page 2003 but our books are 2002. When there are 
differences I will point them out as I see them.

PLEASE return the book at the end of the class.

  Create a folder in your ET folder labeled FrontPage 

 Create a folder in your  FrontPage  folder labeled  Lesson 1 your work for this I will be 
able to find in your lesson 1 folder.

 Create a folder in your  FrontPage  folder labeled Terms  
Beginning with Lesson 1 today we will cover Exercises 1 and 2.
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Begin FrontPage

Open  Word   copy the terms from page two and three in Exercise 1 and their definition then copy it to 

your    Terms   folder.

 read over page three and four then open FrontPage

 Do the exercise on page 15 and save it to your  FrontPage  folder labeled  Lesson 1 

The data you will need is in my folder R:\Upper School\Dr_ Neuage\FrontPage\Lesson 1 and save them in your folder for 
today (Lesson 1)

If you can not access the "teacher folder" because you are a girl > you are using AAG server then key in your browser  \\aag-
s1\aag-aa and find Front Page
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FrontPage

 
 
(Spring 2006) FrontPage, HTML. Java Script, Acid Music Studio,  Search Engines, 

Hosting WebSites; how the Internet works
Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides

 
Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER 

Even though FrontPage will "gradually" fade away and is no longer 
being upgraded by Microsoft what we will cover in this class is usable 
in other web developing programs. 

To get three points for today you must do exercise secondly, thirdly 
and fourthly. Note that thirdly and fourthly must be save in your 
FrontPage  folder labeled  Lesson 1 with your answers saved as exercise 2 and exercise 
3. You will need to write them in Word first then save them as exercise 2 and exercise 3.

 

Add the terms on page 10 and 16 to your 'Terms" folder or document that you began yesterday and 

saved in FrontPage  folder. 

This is the basis of all web pages and what we learn today will be useable in any webpage making 
program.

You will need to know HTML - what it is and how to work with it.
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FrontPage

After reading these pages start a new page and try different lettering in "Split" view. What is the tag for 
Bold? and Italics  and Underline?

Go to your blog. Firstly write your answers in Word, secondly, paste them into your blog at the end of 
the class. 

Read pages 10 - 15 in the book and do the exercises on page 15.  Pages 11- 13 are the most important 
part of the whole course - learn the tags.

NOTE - on page 15  - these answers are on the previous pages -  ON YOUR OWN answer questions 
6, 7, 8 and 12 (you can do these answers either in a Word document or in FrontPage) and in 

FrontPage  folder labeled  Lesson 1 save your answer as exercise 2.
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FrontPage

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER 

March 09 Thursday

At the end of today's exercises for ten points, 2.5 each, you will have the following saved in your lesson 1 
folder. Every day late it is one-point less. 

These exercises do not take more ten minutes each to do. Following instructions is an important part of life

in your FrontPage  folder labeled  Lesson 1
2.5 
points

exercise 2

2.5 
points

2.5 
points

  of course your name for your website will be different than mine

2.5 
points

Hexadecimal

 worth one-point if I see exercise 2 in your FrontPage  folder labeled  

Lesson 1
If you have not yet done it - read pages 10 - 15 in the book and do the exercises on page 15.  Pages 11- 13 are 
the most important part of the whole course - learn the tags.

NOTE - on page 15  - these answers are on the previous pages -  ON YOUR OWN answer questions 6, 7, 
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FrontPage

8 and 12 (you can do these answers either in a Word document or in FrontPage) and in 

FrontPage  folder labeled  Lesson 1 save your answer as exercise 2.

 worth one-point if I see the web folder  in your FrontPage  folder 

labeled  Lesson 1
Read pages 16 - 21 on creating a web site using a template

Do the exercises on page 22 

You will need to carefully follow these steps. Once you have it right this time then you will be right as rain for 
the rest of your life or at least this course or at least for the next few weeks - which ever comes first... 

A.  As is shown on page 17 begin a new web template by selecting File > New >  New Web site  "One 
page Web site..."

B.  At the end of where it will be saved - in this case it goes to your desktop  > C:\Documents and Settings
\YOURNAME\My Documents\My Web Sites\glass YOU WILL NEED TO TYPE IN THE WORD 

glass FOLLOWING \My Web Sites\

C.  What happens next is as is described on page 17 and again in the exercise (#3) that you will do on page 
22 - you will have three files in your folder view such as 

D.  Proceed as is described on page 22 step 4
E.  NOW FOR THE crucial STEP. In order for me to see your work in your folder you will need to drag 

the "Glass folder" into your FrontPage  folder labeled  Lesson 1. Of course as you 
know you will need to open My Computer and navigate to your "my Documents" folder" where you 
will behold the presence of your "My Web Sites" folder - and at the same time you will need to have 
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FrontPage

your FrontPage  folder labeled  Lesson 1 opened. 

 in this "special" place will reside each new web site folder 
that you will make. 

F.  Your folder will have all the stuff in it - including index.htm so at the end this is what I will 

see when I wander into the depths of your FrontPage  folder labeled  Lesson 1 = 

Do the exercise on page 24 and save it as WHAT YOUR NEW WEB SITE (AS DESCRIBED ON PAGE 

24) WILL BE CALLED [FOR EXAMPLE I SET UP MY EXAMPLE AS ] in your  

FrontPage  folder labeled  Lesson 1 

TO DO BEFORE LEAVING THIS SECTION:
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■     If you skipped any pages so far - go back and know these pages. On page 13 'DISPLAY HTML TAGS' 
do that now in your FrontPage window. (View > Reveal Tags)

■     Click the 'Split' view button at the bottom of the FrontPage window. Watch what happens as you type 
something here - try putting it in bold - deselect the bold. Notice how the html code brackets what you 

write in bold - <b> try putting it in bold - </b>  Try different font sizes; for example big, small, 
green, orange, underline, italics, and covered in poo colour. 

 

I.  Open Word and save your document as Hexadecimal in your FrontPage  folder labeled  

Lesson 1
II.  Find the MAJOR HEXADECIMAL COLOUR CODES somewhere online and in a Word 

document list the Hexadecimal codes for the colours listed below. For example, by 
looking in the code in FrontPage - when you have "Split" view happening you will see the number for 
Light Purple is <font color="#ff0080">Light Purple</font> so you would write  Light Purple is #ff0080

1.  Dark Purple
2.  Black
3.  Red
4.  White
5.  Green
6.  Pale Violet Red
7.  Medium Aquamarine
8.  Khaki
9.  Dark Salmon

10.  Lemon Chiffon
11.  What is the Hexadecimal numbering system?
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER 

March 10 Friday

At the end of today's exercises for ten points, 2.5 each, you will have the following saved in your lesson 
1 folder. Every day late it is one-point less. 

These exercises do not take more ten minutes each to do. Following instructions is an important part of 
life

 worth  2.5 points if I see the web folder if I see your new website in your 
folder.

Do the exercise on page 24 and save it as WHAT YOUR NEW WEB SITE (AS DESCRIBED ON 
PAGE 24) WILL BE CALLED [FOR EXAMPLE I SET UP MY EXAMPLE AS 

] in your  FrontPage  folder labeled  Lesson 1 

TO DO BEFORE LEAVING THIS SECTION:

■     If you skipped any pages so far - go back and know these pages. On page 13 'DISPLAY HTML 
TAGS' do that now in your FrontPage window. (View > Reveal Tags)

■     Click the 'Split' view button at the bottom of the FrontPage window. Watch what happens as you 
type something here - try putting it in bold - deselect the bold. Notice how the html code 
brackets what you write in bold - <b> try putting it in bold - </b>  Try different font sizes; for 

example big, small, green, orange, underline, italics, and covered in poo colour. 
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  worth  2.5 points if I see the web folder if there is Hexadecimal in your 
folder.

I.  Open Word and save your document as Hexadecimal in your FrontPage  folder 

labeled  Lesson 1
II.  Find the MAJOR HEXADECIMAL COLOUR CODES somewhere online and in a Word 

document list the Hexadecimal codes for the colours listed below. For example, by 
looking in the code in FrontPage - when you have "Split" view happening you will see the 
number for Light Purple is <font color="#ff0080">Light Purple</font> so you would write  Light 
Purple is #ff0080

1.  Dark Purple
2.  Black
3.  Red
4.  White
5.  Green
6.  Pale Violet Red
7.  Medium Aquamarine
8.  Khaki
9.  Dark Salmon

10.  Lemon Chiffon
11.  What is the Hexadecimal numbering system?

 3 points 

Do exercise 4 and save it in your Lesson one folder Page 31 - the "Cooking" folder is in my folder you 
will need to drag it into your Lesson Folder to do the exercise.
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We are too far behind

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER 

Monday 13th of never

This should have been done last Friday.... be sure your new sites have a new name

 - most of you have nothing on your index page

Do the exercise on page 24 and save it as WHAT YOUR NEW WEB SITE (AS DESCRIBED ON PAGE 24) WILL 

BE CALLED [FOR EXAMPLE I SET UP MY EXAMPLE AS ] in your  FrontPage  

folder labeled  Lesson 1 

TO DO BEFORE LEAVING THIS SECTION:

■     If you skipped any pages so far - go back and know these pages. On page 13 'DISPLAY HTML TAGS' do that now in 
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We are too far behind

your FrontPage window. (View > Reveal Tags)
■     Click the 'Split' view button at the bottom of the FrontPage window. Watch what happens as you type something here - 

try putting it in bold - deselect the bold. Notice how the html code brackets what you write in bold - <b> try putting it in 

bold - </b>  Try different font sizes; for example big, small, green, orange, underline, italics, and covered in poo colour. 

 

I.  Open Word and save your document as Hexadecimal in your FrontPage  folder labeled  Lesson 1
II.  Find the MAJOR HEXADECIMAL COLOUR CODES somewhere online and in a Word document list 

the Hexadecimal codes for the colours listed below. For example, by looking in the code in FrontPage - when 
you have "Split" view happening you will see the number for Light Purple is <font color="#ff0080">Light Purple</font> 
so you would write  Light Purple is #ff0080

1.  Dark Purple
2.  Black
3.  Red
4.  White
5.  Green
6.  Pale Violet Red
7.  Medium Aquamarine
8.  Khaki
9.  Dark Salmon

10.  Lemon Chiffon
11.  What is the Hexadecimal numbering system?

 3 points 

Do exercise 4 and save it in your Lesson one folder Page 31 - the "Cooking" folder is in my folder you will need to drag it 
into your Lesson Folder to do the exercise.
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We are too far behind

 
 

We are missing the big picture here a bit. Before we continue with FrontPage we need to get a grasp 
on webpages and websites.
If you had been reading the material and not just doing the exercises you would know this.
 
Websites are all the material for one topic - like your folder where you store everything under a specific name.

 

Open Word and save it in your FrontPage  folder labeled  Lesson 1 as footy.
Go to http://afc.com.au/  You will get most of your answers from the code of the page - to do this go to View > Source 
which will open up the html code in Notepad. 

 What is the title of this page?

  Looking at the <META NAME= what is the description of this page?

  What are the keywords of this page?

  In our example  "afc/com.au" is the website ~ list three pages that are within the website. Now save your work with 
your four answers.
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 What is the name of the Adelaide football team? The Adelaide .....

1.  In Front Page create a new website and call it "footy" it will be saved on your desktop folder as thus C:\Documents and 
Settings\neuaget\My Documents\My Web Sites\footy

2.  Drag your new folder into your FrontPage  folder labeled  Lesson 1 

3.  From the Adelaide football page go to the Player's Page - pick a player and save it in your Lesson 1 folder 
labeled  "footy"  For example, I saved McLeod > be sure you save it as Webpage, complete 

 You will then have it like this Dr_ 
Neuage\FrontPage\Lesson 1\footy\McLeoud.htm WHERE footy is your website and McLeoud.htm is the page. You will 
save someone else

4.  Change the text size of the following information on your new page from <h3> to H1 
Guernsey Number: 23
Height 180cm
Weight: 83kg

5.  Add a picture to your new player page.

  Put the words "Adelaide footy" into a Google search engine - what is the first site you come up with? Why did it 
come up with this site? Where are the keywords placed when you look at the page in View > Source?
 

`  Read pages 34 - 38 and do Exercise 5 on page 39. and the On your Own exercise on page 41.
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We are too far behind

Format styles and bulleted and numbered lists - know pages 35 - 40

■     Format styles this is heading one
■     Format styles this is heading four
■     

■     Format styles what is this heading?
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March 16 Thursday

We are missing the big picture here a bit. Before we continue with FrontPage we need to get a grasp on 
webpages and websites.
If you had been reading the material and not just doing the exercises you would know this.
 
Websites are all the material for one topic - like your folder where you store everything under a specific name.

 

Open Word and save it in your FrontPage  folder labeled  Lesson 1 as footy.
Go to http://afc.com.au/  You will get most of your answers from the code of the page - to do this go to View > Source 
which will open up the html code in Notepad. 

 What is the title of this page?

  Looking at the <META NAME= what is the description of this page?

  What are the keywords of this page?

  In our example  "afc/com.au" is the website ~ list three pages that are within the website. Now save your work with 
your four answers.
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 What is the name of the Adelaide football team? The Adelaide .....

1.  In Front Page create a new website and call it "footy" it will be saved on your desktop folder as thus C:\Documents 
and Settings\neuaget\My Documents\My Web Sites\footy

2.  Drag your new folder into your FrontPage  folder labeled  Lesson 1 

3.  From the Adelaide football page go to the Player's Page - pick a player and save it in your Lesson 1 folder 
labeled  "footy"  For example, I saved McLeod > be sure you save it as Webpage, complete 

 You will then have it like this Dr_ 
Neuage\FrontPage\Lesson 1\footy\McLeoud.htm WHERE footy is your website and McLeoud.htm is the page. You 
will save someone else

4.  Change the text size of the following information on your new page from <h3> to H1 
Guernsey Number: 23
Height 180cm
Weight: 83kg

5.  Add a picture to your new player page.

  Put the words "Adelaide footy" into a Google search engine - what is the first site you come up with? Why did it 
come up with this site? Where are the keywords placed when you look at the page in View > Source?
 

`  Read pages 34 - 38 and do Exercise 5 on page 39. and the On your Own exercise on page 41.
 

Format styles and bulleted and numbered lists - know pages 35 - 40

■     Format styles this is heading one
■     Format styles this is heading four
■     
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■     Format styles what is this heading?

 

 

http://neuage.org/AA/hypertext/notes3/3-15.htm (3 of 3) [3/9/08 12:52:11 PM]



get to work

 

 

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

March 16 Thursday

Thursday 16th

Do the exercise on page 51 and for ten points show me your new web site saved in FrontPage  folder labeled  

Lesson 1 as Milers with the web-page title Home Page.

Remember to change the name to 

A.  C:\Documents and Settings\YOURNAME\My Documents\My Web Sites\MilersYOU WILL NEED TO TYPE IN 

THE WORD Milers FOLLOWING \My Web Sites\  
B.  And you will get this new page as shown below as we did before and which you will need to drag from your My 

Documents folder into your  FrontPage  folder labeled  Lesson 

1                                                                          

1.  You will get one point for #2 
2.  You will get one point for #3 
3.  You will get one point for #7 
4.  You will get one point for #8 
5.  You will get one point for #12 
6.  You will get one point for #13 
7.  You will get one point for #14 
8.  You will get one point for #15 
9.  You will get one point for #16 
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10.  You will get one point for #18 

Make a website called SpringBreak

For ten points by end of tomorrow's class

have your index with two pages created and linked to it with pictures and titles and meta tags
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For 15 points toward your final grade show us how far you have gotten.

Make a new website labeled SpringBreak

You will receive points for

1.  One-point for a proper title to your page
2.  One-point for a proper index page
3.  three-points for three proper pages linked to your index page
4.  two-points for two proper external links to other sites related to your site
5.  One-point for proper keywords - meta tags
6.  Creativity

7.  Using styles give us a heading One at the top of your Index page and at least two other headings 
8.  (page 35) Two-points - At least three items for a bulleted or numbered lists - for example; things to do... 
9.  One-point - have a background pattern or colour to one of your pages - Format > Theme > (a set of themes appears in the 

panel on the right of your screen

10.  Have one animated gif on your page - go to Picture > Clip Art (put in a word in the panel on the right)
11.  Have a sound to your page - to do this you will need to save a sound to your site such as can be found at http://

www.stonewashed.net/sfx.html  or http://www.thefreesite.com/Free_Sounds/Free_WAVs/ Firstly, save the file to your 
folder then go to Format > Background > General 
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get to work

> 
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

April 03 Monday     

If you were not here Friday before leaving us see the assignment for that day. It 
counts for 15% of our final grade.  see http://www.albany-academy.org/compcon/
hypertext/notes3/3-17.htm You will need to do this on your own time.

Because only two out of our 489,457,904 students in our class are caught up with what I am grading for; 
we will have this be the only day to do the back assignments. The two assignments that most of you are 
missing are from the two days before break.

The assignment for Thursday entitled Milers (page 51) You will need to have read the pages 42 - 50)

1.  You will get one point for #2 
2.  You will get one point for #3 
3.  You will get one point for #7 
4.  You will get one point for #8 
5.  You will get one point for #12 (I will need to see the page titled "training.htm" in your folder)
6.  You will get one point for #13 (have your hyperlink to "training.htm")
7.  You will get one point for #14 (have bookmarks)
8.  You will get one point for #15 
9.  You will get one point for #16 

10.  You will get one point for #18 

and the assignment for Friday before we left which was to make your own webpage with what we have 
done so far.

You will receive points for (see the page for the day for more details) 

1.  One-point for a proper title to your page 
2.  One-point for a proper index page 
3.  three-points for three proper pages linked to your index page 
4.  two-points for two proper external links to other sites related to your site 
5.  One-point for proper keywords - meta tags 
6.  Creativity 
7.  Using styles give us a heading One at the top of your Index page and at least two other headings 
8.  (page 35) Two-points - At least three items for a bulleted or numbered lists - for example; things 
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Welcome Back from La La land

to do... 
9.  One-point - have a background pattern or colour to one of your pages - Format > Theme > (a set 

of themes appears in the panel on the right of your screen 
10.  Have one animated gif on your page - go to Picture > Clip Art (put in a word in the panel on the 

right) 
11.  Have a sound to your page - to do this you will need to save a sound to your site such as can be 

found at http://www.stonewashed.net/sfx.html  or http://www.thefreesite.com/Free_Sounds/
Free_WAVs/ Firstly, save the file to your folder then go to Format > Background > General > 
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

April 05 Wednesday     

We are skipping page 51 - 65 as we covered this in Word

Make a new folder in your FrontPage folder and label 
it Lesson 2 for the exercises for this week. 

Because we are not meeting tomorrow or Friday we 
will need to progress at special warp-web-speed
Read and know pages 66 to 70. On page 66 the terms either learn them or put them in your folder that 
you began entitled 'terms'. Know specifically the differences between GIF, JPEG, and PNG.

Due to lack of time or at least lack of time for this groovy class we will skip exercise 9.

The files you need are in lesson two Exercise 10 in the Lesson 2 folder in my folder. If you can not 
access my folder look to see if there is a Lesson 2 folder in your folder that I put in - if not your folder 
was full.

Continue with page 74 read and add the two terms in the TERMS to your terms list.

We are creating hotspots in webpages today. You should be familiar with page 74-75 
'Picture Attributes' if not review these pages.

 Firstly have your picture toolbar available at the top of your screen 
(View > Toolbars > Pictures). Right click on your picture > Picture 
Properties > to wrap text to the right or left of your image. We did not 
get this right yesterday.

So do this: insert a picture and wrap text around it, add a border - bevel 
your picture (bevel is on your picture toolbar). 
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Welcome Back from La La land

 

(show me for five points) an image with some text wrapped around it (1-
point) and bevel it (1-point)and change the format of it as shown on page 75 (either use the picture-
toolbar or right click on you image and "change picture file type") and set the transparent colour (page 
75 right column) (1-point) add a border to your image (either use the picture-toolbar or right click on 
you image and in 'Picture Properties' give a border (1-point), and put in an alternative text as described 
on page 76 (1-point).

 

Do the exercise on page 79. The file is in my folder > Lesson 2 > Exercise 10. Save it in your 
Lesson 2 folder.  

You will need to have read page 77 - 78 to do the hotspots

Do steps 1 - 29 and for ten points do

●     1-point show me number 7 (the picture is the cactus that is already there) resized to 100 pixels,
●     1-point show me number 10 the linked hotspot to index.html
●     1-point show me number 12 as a set size of 400 pixels   (number 12 the picture is already on the 

page) 
●     1-point show me number 14  the alternative text
●     1-point show me number 17 border thickness of 2  
●     1-point show me number 18 hotspot link to index.html  
●     1-point show me number 21 thumbnail from this picture see page 78
●     1-point show me number 23 cactus image linked to desert.htm 
●     1-point show me number 24 text reading Holiday Show to the Holiday.jpg and Desert House 

to the cactus.jpg
●     1-point show me the finished thingy to look like page 80
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For five points do page 81 
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catch up to tomorrow

 

  April 07, 1937

Since 76.4 percent of you were not here Wednesday do that day's work http://www.albany-academy.org/
compcon/hypertext/notes3/4-05.htm it is worth twenty-points. The four of you who were here can have a 
party.
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Monday April 10    

Inserting a video clip

 page 82 - 95

15 POINTS FOR TODAY

Do the exercise on page 86  The files are in my folder in Lesson 2 and Exercise 11. The "heading.gif" is 
in the images folder in lesson 11. 

Remember to start by opening the "index" page.

ALSO, you will need to find some pictures of eagles for your new page to insert.

For your navigation bar use the Insert > Insert interactive button - put in your link - change the font and 

colour to what floats your boat 

Show me this work done for five points for today.

Do page 87 and show me that done for five points.

Pages 88 - 91 we covered in Word. However, refresh your brain by reading it again and for five points 
do Exercise 12 ON PAGE 92 AND FIVE BONUS POINTS DO EXERCISE "ON YOUR OWN? 
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ON PAGE 95.
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 stuff

04/12/2006

For fifteen points please read the pages preceding and do the exercises on page 97 (exercise 13) and 
lesson three exercise 14 on page 104 and page 105.

Five points for each.

Save them in your FrontPage folder under lesson three. 

Have a great holiday and treat your bunny with respect.
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tables to present 

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

Start a folder Lesson 3 in your Front 
Page folder

and for fifteen easy points do the 
four exercises below

1.  Read the material p. 100 - 104 on using a table to place your material for a webpage (we did 
tables in Word so this so be a piece of cake) and do the exercise on page 104 (exercise 14 in the 
teacher's folder) do not do family reunion.

2.  Read the material p. 106 - 110 continuing with tables and do the exercise 15 on page 110 and on 
page 111.
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In your folder Lesson 3 in your 
Front Page folder

and for twenty-five easy points do 
the five exercises below

1.  Read the material p. 112 - 116 entering data in table cells - spreadsheets (remember Excel????) 

Do  Lesson 3 on page 116 and the 

2.  Read the material p. 118 - 121 continuing with tables and do the 

 on page 122 and the 

 and 

exercise .
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We have a bit more to do in Front Page then we will 
move on to making a musical clip then slip into a silent 
video using Sony Acid mind-set then we will do Flash 

then we will go away for the summer
 

In your ET-FrontPage folder create 

Lesson  folder and for twenty 
easy (did I mention fun too?) cosmic 

points do the four exercises below

 

I.  Read the material p. 128 - 131 entering - Do  Lesson 4 on 
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tables to present 

page 132 and the 

II.  Read the material p. 134 - 137 continuing with frames and do the 

 on page 138 and the 
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test is Friday the 28th

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX 
FOR THIS TRIMESTER

get to work

●     TODAY
●     HoMe
●     INDEX 
●     Calendar 
●      Blog
●     Grading for 

this course
●     AA
●     AAG
●     Computer 

Concepts

Click in the left column -  to see the remaining assignments 
before our test next Friday.

that was easy
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silent movies

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

May 1 - 5 You will be using already scripted silent movies - but they should look something like 
the web-video class work....

Using a silent movie to make a sound wave background to.

We will use the program (on your desktop) Sony Acid to make a music clip. YOU NEED TO 
BRING IN HEADPHONES/EARPHONES TO DO THIS.

The files are (after opening Sony Acid) - go to Explore (should show in left bottom corner of 
screen or at top under VIEW)

C > Program files > SONY > Shared Plug-ins

use files from Loops; or Old Time Project

Drag the icon (quick movie icon) up to the time line above

The movie clips you will put these as background sounds to are in C > Teachers > Arts > 
Mr_Johnson

play each and you will pick one and make a sound track to it. 

Delete everything in your folder except last Friday's test so you have room

MAKE A FOLDER video for this 
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sound waves to silent movie

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

May 3

You will be using already scripted silent movies - but they should look something like the web-
video class work....

Using a silent movie to make a sound wave background to.

We will use the program (on your desktop) Sony Acid to make a music clip. YOU NEED TO 
BRING IN HEADPHONES/EARPHONES TO DO THIS.

The files are (after opening Sony Acid) - go to Explore (should show in left bottom corner of 
screen or at top under VIEW)

C > Program files > SONY > Shared Plug-ins

use files from Loops; or Old Time Project

Drag the icon (quick movie icon) up to the time line above

The movie clips you will put these as background sounds to are in C > Teachers > Arts > 
Mr_Johnson

play each and you will pick one and make a sound track to it. 

Delete everything in your folder except last Friday's test so you have room

MAKE A FOLDER video for this 
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Flash

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

May 3

Make a folder "Flash" for the last two projects of the trimester

In the Flash MX 2004 "Project 4" folder do pages 123 - 143
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Welcome Back from La La land

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

05/08/2006

In the Flash MX 2004 "Project 4" folder be sure you know pages up to 161

We should be well pass this point but be sure that in Flash MX 2004 you know the exercises up to 
4.16 so we can have this on a bit of a quiz in a week or so.

Especially how to change colours in different frames: lesson 4.14, 4.15, 4,16, 4.17 

Insert > Create Motion Tween you need to go Insert > Timeline > Create Motion Tween

For five points have three balls that change colours, direction, shape and that pass each 
other - have your movie change every five frame and have forty frames. SAVE THIS AS BALLS  
>EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT IN YOUR "Project 4" folder. 
thanks

  

For five points Creating Animated Text ~ Instead of clicking Insert > Convert to Symbol you 
need to go to Modify > Convert to Symbol

SAVE THIS AS LESSON 1 > EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT 
IN YOUR "Project 4" folder. thanks

Go through to less 4.20 so you have a button doing things at the end of the lesson

http://neuage.org/AA/hypertext/notes3/5-08.htm (1 of 2) [3/9/08 12:53:32 PM]

http://www.albany-academy.org/compcon
http://www.albanyacademyforgirls.org/
http://www.albany-academy.org/
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/hypertext/notes3/index.htm
http://www.albany-academy.org/compcon/hypertext/calendar3.htm
http://www.albany-academy.org/compcon/hypertext/notes3/grading.htm



Welcome Back from La La land

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

05/10/2006

In the Flash MX 2004 "Project 4" folder be sure you know pages up to 161

We should be well pass this point but be sure that in Flash MX 2004 you know the exercises up to 
4.16 so we can have this on a bit of a quiz in a week or so.

Especially how to change colours in different frames: lesson 4.14, 4.15, 4,16, 4.17 

Insert > Create Motion Tween you need to go Insert > Timeline > Create Motion Tween

For five points have three balls that change colours, direction, shape and that pass each 
other - have your movie change every five frame and have forty frames. SAVE THIS AS BALLS  
>EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT IN YOUR "Project 4" folder. 
thanks

  

For five points Creating Animated Text ~ Instead of clicking Insert > Convert to Symbol you 
need to go to Modify > Convert to Symbol

SAVE THIS AS LESSON 1 > EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT 
IN YOUR "Project 4" folder. thanks

Go through to lesson 4.20 so you have a button doing things at the end of the lesson for five 
big points. DO NOT DO THE "ADDING ACTION TO A BUTTON" STEP ON PAGE 149
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Flash buttons

  name each one lesson1a; lesson 1b; lesson1c

For five points Do Activity 4: Importing Sound 

EXPORT IT AS A MOVIE AND SAVE IT IN YOUR "Project 4" folder. thanks

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Commercial 

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading 

Friday May 12th or so have ready for Friday the below written in Word

I.  In your folder have your story written up for your commercial 
II.  What is your 60 second commercial?  answer these in a Word document    

The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone 
with the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to 

buy your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

V.  Storyboard - what will be in each of at least ten scenes    [I want this done in Word and in your folder “Flash 
> Commercial”]

The process of creating a rich and engaging animation involves so much more than "leading the character" 
around the stage. Some of the other common elements that will be discussed in this class are as follows:

a)      Firstly, Building the story. Before you begin to develop your commercial, you need to design your 
story. Planning ahead- not DOING IT ON THE "FLY" IS IMPORTANT so you do not waste lots of time.

b)      Create a character for your story. This can be a stick figure or something more elaborate. There 
are two parts here:

i.                    Creating the Script 
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Commercial 

Script development, like many writing projects, provides structure and detail. Start in an outline form to make 
sure you get all the bits and pieces you want to use. When you have your outline, you can develop the details. 
The areas on which you will want to focus are these: 

·         Descriptive setting. The first thing is to describe the environment for the opening scene. Your 
opening scene may be the title of your product or commercial or it may be more subtle. For example, if you 
were selling an ad for condominiums in Hawaii you may want to begin with a photo of an Hawaiian sunset. 
This description needs to encompass the set, setting, atmosphere, and mood. It also needs to place the 
main character or subject matter – the title or an image in the scene. Then, as your story transitions from one 
scene to the next, you describe these changing settings. 

·         Character and subject development. As characters or subject matter are introduced to the scene, 
you'll need a brief description of their characteristics, appearance, and style.

·         Transitions. When moving the action from one scene to the next, you need to think through how 
the transition will be handled. You don't want to alienate your audience with inappropriate scene changes. 
This might be in the form of fades; camera motions (pan/zoom), refocusing, and so on. Transitions are covered 
in more detail in Chapter 12, "Making the Transition."

·         Character dialogue or action. When you actually have a character or characters, you will need to detail 
the dialogue and actions.

·         Important action characteristics. If there are sound effects, visual effects, or action sequences, they 
need to be described in context with the character, object, action, or transition with which they are associated.

Your script puts your words in order; your storyboard organizes your animation's visuals.

ii.                  Storyboarding Your Action

·                                                        Storyboarding is the same format as you see in newspaper cartoons and 
in comic books. Illustrations are provided inline with the script to provide a visual narrative for what is 
being described by the words themselves. Your average set of storyboards is a sequence of illustrated 
and numbered panels arranged in a linear fashion. Next to or below these panels is an area for the related 
script text that accompanies the illustration. When you look at the storyboards, you are looking at the 
animation itself, but in skeletal form. 
·                                                        When preparing your storyboards, you'll want to set them up in roughly 
the same aspect ratio as you anticipate you'll use for your final animation. That way, when you're 

http://neuage.org/AA/hypertext/notes3/5-12.htm (2 of 3) [3/9/08 12:53:34 PM]



Commercial 

illustrating scenes, sets, and actions on your boards, you'll have a good visual sense of how the scene will play out. 
·                                                        The average computer monitor displays at an aspect ratio of 3 x 4. Thus, if 
you set up your storyboards as a series of 3-inch-by-4-inch or 6-inch-by-8-inch panels, you'll be in good shape. 
We will do this in Word but blank 3x5 cards would be easier.
·                                                        When your storyboards are complete, you have a number of options at 
your disposal to aid you in the process of converting your story to reality. Hand-drawn storyboards can be 
scanned, placed on a background layer in Flash, and traced using the drawing tools in Flash. If you are artistic 
you can start out the process by hand sketching, this can be an appealing option.
·                                                        Another option is to use Macromedia FreeHand as your storyboarding tool. 
We do not have this in our PC lab at AA but you can do it (remember from before Christmas break?) in PC lab 
at AAG. 
·                                                        As you would obviously remember, FreeHand enables you to define 
multiple pages inside a single FreeHand document, much like a Microsoft Word document can contain hundreds 
of pages. Because the two programs are so tightly integrated, you can copy your illustrations from FreeHand 
and paste them into Flash in the standard Flash format. Although this might seem insignificant, if you are trying 
to create storyboards in some other illustration packages, you'll need to create several documents to 
accomplish the same task.

 

In our next class we will begin using building our scenes and characters and get the animation thingy happening.

 

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.
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Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
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IF YOU HAVE SCRIPTED YOUR COMMERCIAL THEN GO TO OUR NEXT SECTION 5-15B

Friday May 12th or so have ready for Friday the below written in Word 

 

I.  In your folder have your story written up for your commercial 
II.  What is your 60 second commercial?  answer these in a Word document    

http://neuage.org/AA/hypertext/notes3/5-15.htm (1 of 4) [3/9/08 12:53:37 PM]

http://www.albany-academy.org/compcon/web.htm
http://www.albany-academy.org/compcon/web/notes3/index.htm
http://www.albany-academy.org/compcon/
http://www.albany-academy.org/compcon/
http://www.albany-academy.org/compcon/web/calendar3.htm
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/web/notes3/Grading.htm
http://neuage.org/AA/hypertext/notes3/5-15b.htm



Commercial 

The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone 
with the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to 

buy your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

V.  Storyboard - what will be in each of at least ten scenes    [I want this done in Word and in your folder “Flash 
> Commercial”]

The process of creating a rich and engaging animation involves so much more than "leading the character" 
around the stage. Some of the other common elements that will be discussed in this class are as follows:

a)      Firstly, Building the story. Before you begin to develop your commercial, you need to design your 
story. Planning ahead- not DOING IT ON THE "FLY" IS IMPORTANT so you do not waste lots of time.

b)      Create a character for your story. This can be a stick figure or something more elaborate. There 
are two parts here:

i.                    Creating the Script 

Script development, like many writing projects, provides structure and detail. Start in an outline form to make 
sure you get all the bits and pieces you want to use. When you have your outline, you can develop the details. 
The areas on which you will want to focus are these: 

·         Descriptive setting. The first thing is to describe the environment for the opening scene. Your 
opening scene may be the title of your product or commercial or it may be more subtle. For example, if you 
were selling an ad for condominiums in Hawaii you may want to begin with a photo of an Hawaiian sunset. 
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Commercial 

This description needs to encompass the set, setting, atmosphere, and mood. It also needs to place the 
main character or subject matter – the title or an image in the scene. Then, as your story transitions from one 
scene to the next, you describe these changing settings. 

·         Character and subject development. As characters or subject matter are introduced to the scene, 
you'll need a brief description of their characteristics, appearance, and style.

·         Transitions. When moving the action from one scene to the next, you need to think through how 
the transition will be handled. You don't want to alienate your audience with inappropriate scene changes. 
This might be in the form of fades; camera motions (pan/zoom), refocusing, and so on. Transitions are covered 
in more detail in Chapter 12, "Making the Transition."

·         Character dialogue or action. When you actually have a character or characters, you will need to detail 
the dialogue and actions.

·         Important action characteristics. If there are sound effects, visual effects, or action sequences, they 
need to be described in context with the character, object, action, or transition with which they are associated.

Your script puts your words in order; your storyboard organizes your animation's visuals.

ii.                  Storyboarding Your Action

·                                                        Storyboarding is the same format as you see in newspaper cartoons and 
in comic books. Illustrations are provided inline with the script to provide a visual narrative for what is 
being described by the words themselves. Your average set of storyboards is a sequence of illustrated 
and numbered panels arranged in a linear fashion. Next to or below these panels is an area for the related 
script text that accompanies the illustration. When you look at the storyboards, you are looking at the 
animation itself, but in skeletal form. 
·                                                        When preparing your storyboards, you'll want to set them up in roughly 
the same aspect ratio as you anticipate you'll use for your final animation. That way, when you're 
illustrating scenes, sets, and actions on your boards, you'll have a good visual sense of how the scene will play out. 
·                                                        The average computer monitor displays at an aspect ratio of 3 x 4. Thus, if 
you set up your storyboards as a series of 3-inch-by-4-inch or 6-inch-by-8-inch panels, you'll be in good shape. 
We will do this in Word but blank 3x5 cards would be easier.
·                                                        When your storyboards are complete, you have a number of options at 
your disposal to aid you in the process of converting your story to reality. Hand-drawn storyboards can be 
scanned, placed on a background layer in Flash, and traced using the drawing tools in Flash. If you are artistic 
you can start out the process by hand sketching, this can be an appealing option.
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·                                                        Another option is to use Macromedia FreeHand as your storyboarding tool. 
We do not have this in our PC lab at AA but you can do it (remember from before Christmas break?) in PC lab 
at AAG. 
·                                                        As you would obviously remember, FreeHand enables you to define 
multiple pages inside a single FreeHand document, much like a Microsoft Word document can contain hundreds 
of pages. Because the two programs are so tightly integrated, you can copy your illustrations from FreeHand 
and paste them into Flash in the standard Flash format. Although this might seem insignificant, if you are trying 
to create storyboards in some other illustration packages, you'll need to create several documents to 
accomplish the same task.

 

In our next class we will begin using building our scenes and characters and get the animation thingy happening.

 

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.
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Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts 
@ Albany Academies ~ Calendar for trimester three  Blog ~ Grading 

 

put three movies (Export movie) into your Flash folder - label it activities : then do the 
exercises we will do from the online tutorial and name them (1) Squash, (2) Anticipation and (3) 
Ease

1. Have objects move smoothly over one another (this will not work with very complicated scenes). 
Have a layer for three different objects > label your layers > and be sure you have 'Converted to 
symbol" each image > to have your image move smoothly from frame 1 - 30 > click in frame 10 > 
F6 > move your image to where you want it > click in frame 20 > F6 > move your image to where 
you want it > click in frame 30  F6 > move your image to where you want it. In Properties select 
your frame and Tween > Motion
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activities 

 

2. Anticipation. If you have your figure just move across the screen then that is quite budget

  have your figure begin moving in the first frames and 
at the end as shown in Dr. Blob Rocks below. Don't have your figure just move quickly - 
ANTICIPATE 
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activities 

 

3. Squash and stretch See that when you move and select your character that "Free Transform tool" is 
selected and then when the figure is where you want it using the alt - key on your keyboard squash your 
thingy > REMEMBER TO HOLD ALT KEY TO STRETCH JUST THE TOP - otherwise the whole 
image moves.

 

Squash is good for something that is hitting the ground or hitting a wall   and Stretch is good for 
something that is spring into action....
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take home a forum today

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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wild cats 

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts 
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take home a forum today

firstly make a birthday card for Chris 

 

today we will look at a couple of other features in Flash to add to your arsenal of creating a 
great ad

1. Shape tweening  

http://neuage.org/AA/hypertext/notes3/5-18.htm (1 of 5) [3/9/08 12:53:41 PM]
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wild cats 

   

2.  shape and blob- create a shape blob as these two combined and save it in your activities folder 
as 'shap-blob'
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And "break apart" if you are using an image you want to separate or have do various things
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MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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he bus will be in front of AA at

he bus will be in front of AA at 1.30 next Tuesday - everyone is required to go on this trip.

 
at 1.30 the bus leaves from AA for the SUNY nano-technology college for our visit of 

NanoCareer Day 

 

Work on your advertising projects today they will be due next Wednesday the 31st.

Your ads must be in a folder labeled AD in your main folder (U - drive, not 
a flash folder or et folder etc)

●     ten points - correct folder
●     ten points -one-minute of continuous time - at at least twelve frames 

per second - you can either group in scenes or layers
●     ten points -background sound - that changes and dramatizes your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - 
●     

 

 

take home a forum today

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Your Flash commercial project is

Thursday, May 25, 2006

Your Flash commercial project is due Tuesday 30th May 

  Flash ads will be at http://neuage.info/AA/commercial/ads.htm

Three days left of classes 

May 25 Thursday commercial

Your ads must be in a folder labeled AD in your main folder (U - drive, not a flash folder 
or et folder etc) THIS IS DUE NEXT TUESDAY

●     ten points - correct folder
●     ten points -thirty-seconds of continuous time -  at least twelve frames per second - you 

can either group in scenes or layers
●     twenty points -background sounds, using SONY ACID - that changes and dramatizes 

your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - shape tween and a motion tween (seee star below for motion tween concept)
●     ten points - exported and placed in a Frontpage page with an order form on the page 

to purchase your product 

http://neuage.org/AA/hypertext/notes3/5-25.htm (1 of 2) [3/9/08 12:53:42 PM]
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Your Flash commercial project is

Wednesday, May 31, 2006

Your Flash commercial project is due Wednesday31st May

No days left of classes 

May 31 Wednesday   See http://neuage.info/AA/commercial/ads.htm for your ad when it 
is finished

Your ads must be in a folder labeled AD in your main folder (U - drive, not a flash folder 
or et folder etc) THIS IS DUE NEXT TUESDAY

●     ten points - correct folder
●     ten points -thirty-seconds of continuous time -  at least twelve frames per second - you 

can either group in scenes or layers
●     twenty points -background sounds, using SONY ACID - that changes and dramatizes 

your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - shape tween and a motion tween (see star below for motion tween concept)
●     ten points - exported and placed in a FrontPages page or Dreamweaver with an order 

form on the page to purchase your product 
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Designing Web Pages

 
 

Designing Web Pages (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works

Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar 

Trimester Three

�❍     Monday March 06

�❍     Wednesday March 08
�❍     Thursday 09 March
�❍     10th Friday
�❍     13 Monday
�❍     15th Wednesday 
�❍     16 Thursday
�❍     17 Friday
�❍     03 April Monday
�❍     05 April yes it is Wednesday already
�❍     07 of April Friday again
�❍     Yes it is another Monday
�❍     Happy Wednesday prior to Groovy Thursday (no school) and Good Friday
�❍     Monday April 17
�❍     TODAY
�❍     Day after yesterday 20 - April
�❍     21st April already
�❍     Monday Monday
�❍     Wednesday April 26
�❍     Thursday April 27
�❍     Test FrontPage
�❍     Monday 01 May 
�❍     Monday May 03
�❍     Thursday May 05
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Designing Web Pages

�❍     Monday May 08 Flash Forward
�❍     Thursday is today
�❍     Friday the 12th
�❍     Monday again

http://neuage.org/AA/web/index.htm (2 of 2) [3/9/08 12:53:43 PM]
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Computer Writing at Albany Academy and Albany for Girls by Dr. Terrell Neuage

at Albany Academy and Albany Academy for Girls 

return to computer courses at Albany Academies 

Dr. Terrell Neuage neuaget@albanyacademyforgirls.org

Daily Notes ~ Calendar ~ Blog
Course Description: This is an introductory course on experimental computer writing using hypertext, digital 
storytelling, Online WebPoetry as well as critique hypertextual literature already produced. We use the hypertext 
writing environment, Storyspace from Eastgate.   

Grading: 

50 % Five "hypertextual projects" (we have the CDs on the PCs at AAG. Because we have a site license for only ten of 
each "project" [we can not call them stories or fiction at this point - by the end of the course we will create a better term 
for them] everyone will not be working with each one at the same time. You will have two class periods for each 
"project" [we may change this to more or less time once we are involved] to read - maneuver through the landscapes of 
the "project" then one class period to write up your reflections on it. I will provide guidelines for this. This will be uploaded 
to our blog. There will be two entries for each "project". One of your original reflections and one responding to what 
someone else in our course has written about a "project". Each "project" is worth ten-points; five for your critiquing and 
five for your response to what someone else has written on a "project". 

25 % You will do one project for a grade, which must be done on StorySpace. I will provide the guidelines for this.

 

Our sources are:

●     SAMPLERS, Deena Larsen; VICTORY GARDEN, Stuart Moulthrop; WE DESCEND, Bill Bly; Patchwork Girl, 
Shelley Jackson; and Marble Springs, Deena Larsen

●     Dr. Terrell Neuage: Masters thesis (Writing for the Internet) and PhD writings on hypertext and computer 
communication (thesis on line at http://neuage.org/All.htm) 

●     Hypertext Bibliography - a growing source of hypertextual storytelling throughout this course
●     Hyperizons 
●     Online Hypertextual Poetry
●     A directory for finding hypertext/cybertext literature published on the Web and on disk
●     Snakeskin
●     Kurzweil CyberArt Technologies, Inc., 

●     What is HyperText
http://neuage.org/AA/ComputerWriting/computer_writing.htm (1 of 2) [3/9/08 12:53:44 PM]
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Computer Writing at Albany Academy and Albany for Girls by Dr. Terrell Neuage

Hypertext is text which is not constrained to be linear. 

Hypertext is text which contains links to other texts. The term was coined by Ted Nelson around 1965 (see History ). 

HyperMedia is a term used for hypertext which is not constrained to be text: it can include graphics, video and sound , 
for example. Apparently Ted Nelson was the first to use this term too. 

Hypertext and HyperMedia are concepts, not products. 

See also: 

�❍     A list of terms used in hypertext litterature. 
�❍     Conferences 
�❍     Commercial (and academic) products 
�❍     A newsgroup on hypertext, "alt.hypertext" . 
�❍     WorldWideWeb is a project which uses hypertext concepts. 

 

http://neuage.org/AA/ComputerWriting/computer_writing.htm (2 of 2) [3/9/08 12:53:44 PM]
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Untitled Document

Kathleen's ad (Children story) (Birthday card) 

 

 

http://neuage.org/AA/commercial/KT/KT.htm [3/9/08 12:53:50 PM]

http://neuage.info/AA/FlashStory/Kathleen.htm
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Valerie's Shoes

Valerie 

 

Other Valerie projects: Children's story, Birthday Card, 

http://neuage.org/AA/commercial/VA/VA.htm [3/9/08 12:53:53 PM]


http://neuage.org/AA/commercial/VA/Valerie.htm
http://neuage.org/AA/commercial/VA/PigBirthday.htm



Untitled Document

Christopher's ad (Gif story) (Flash Poem) 

 

http://neuage.org/AA/commercial/CE/CE.htm [3/9/08 12:53:55 PM]

http://neuage.org/AA/commercial/CE/Christopher-story1.htm
http://neuage.org/AA/commercial/CE/Christopher.htm



Alexa's Commercial 

Alexa's Commercial 

 

http://neuage.org/AA/commercial/AG/AG.htm [3/9/08 12:53:57 PM]




Stephen's commercials 

Stephen's commercials 
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Thomas's commercial 

Thomas's commercial 

 

http://neuage.org/AA/commercial/TV/TV.htm [3/9/08 12:54:01 PM]




Nicola's commercial 

Nicola's commercial 

 

http://neuage.org/AA/commercial/NS/NS.htm [3/9/08 12:54:08 PM]




Vivian's commercial 

Vivian's commercial 

 

http://neuage.org/AA/commercial/VS/VS.htm [3/9/08 12:54:23 PM]




http://neuage.org/AA/commercial/JS/js.html

 

 

http://neuage.org/AA/commercial/JS/js.html [3/9/08 12:54:38 PM]




Untitled Document

Sage 

http://neuage.org/AA/commercial/SC/SC.htm [3/9/08 12:54:41 PM]



Margaret's Commercial 

Margaret's Commercial 

http://neuage.org/AA/commercial/MF/MF.htm [3/9/08 12:54:43 PM]



Lauren's Commercial 

Lauren's Commercial 

http://neuage.org/AA/commercial/LL/LL.htm [3/9/08 12:54:46 PM]



Grace's Commercial 

Grace's Commercial 

http://neuage.org/AA/commercial/GT/GT.htm [3/9/08 12:54:48 PM]



Jennifer's Commercial 

Jennifer's Commercial 

http://neuage.org/AA/commercial/JW/JW.htm [3/9/08 12:54:50 PM]



Kelly's Commercial 

Kelly's Commercial 

http://neuage.org/AA/commercial/KW/KW.htm [3/9/08 12:54:53 PM]



Biz's Commercial 

Biz's Commercial 

http://neuage.org/AA/commercial/BD/BD.htm [3/9/08 12:54:55 PM]



Valerie's story - The Bird and the Cookie

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story Lauren

 

http://neuage.org/AA/web/FlashStory/Valerie.htm [3/9/08 12:58:00 PM]

http://www.albany-academy.org/compcon/web/notes2/index.htm
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Flash Assignments Trimester Two

Flash Assignments Trimester Two Children Stories next story Kathleen

http://neuage.org/AA/web/FlashStory/Lauren.htm (1 of 2) [3/9/08 12:58:01 PM]
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Flash Assignments Trimester Two
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Flash Assignments Trimester Two

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story Biz and Nic

 

http://neuage.org/AA/web/FlashStory/Kathleen.htm (1 of 2) [3/9/08 12:58:10 PM]
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Flash Assignments Trimester Two
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Flash Assignments Trimester Two

Flash Assignments Trimester Two Children Stories next story Alexa
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Flash Assignments Trimester Two
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Flash Assignments Trimester Two

Flash Assignments Trimester Two Children Stories next story Jennifer

http://neuage.org/AA/web/FlashStory/Alexa.htm (1 of 2) [3/9/08 12:59:44 PM]
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Flash Assignments Trimester Two
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Flash Assignments Trimester Two

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story 
Margaret

 

http://neuage.org/AA/web/FlashStory/Jennifer.htm (1 of 2) [3/9/08 12:59:48 PM]
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Flash Assignments Trimester Two

 

http://neuage.org/AA/web/FlashStory/Jennifer.htm (2 of 2) [3/9/08 12:59:48 PM]




Flash Assignments Trimester Two

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story 
Kelly

 

http://neuage.org/AA/web/FlashStory/Margaret.htm (1 of 2) [3/9/08 12:59:50 PM]
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Flash Assignments Trimester Two

 

http://neuage.org/AA/web/FlashStory/Margaret.htm (2 of 2) [3/9/08 12:59:50 PM]




children story

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story 
Sage

 

http://neuage.org/AA/web/FlashStory/Kelly.htm (1 of 2) [3/9/08 12:59:51 PM]
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children story
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Flash Assignments Trimester Two

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story 
Grace

http://neuage.org/AA/web/FlashStory/Sage.htm (1 of 2) [3/9/08 12:59:52 PM]
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Flash Assignments Trimester Two

 

http://neuage.org/AA/web/FlashStory/Sage.htm (2 of 2) [3/9/08 12:59:52 PM]




Lauren

Valerie

http://neuage.org/AA/web/notes3/Valerievideo.htm [3/9/08 12:59:53 PM]



Lauren

Alexa

 

http://neuage.org/AA/web/notes3/Alexavideo.htm [3/9/08 12:59:53 PM]



Lauren

Jennifer

http://neuage.org/AA/web/notes3/Jennifervideo.htm [3/9/08 12:59:54 PM]



Lauren

Sage

http://neuage.org/AA/web/notes3/Sagevideo.htm [3/9/08 12:59:54 PM]



Lauren

Margaret

http://neuage.org/AA/web/notes3/Margaretvideo.htm [3/9/08 12:59:54 PM]



Lauren

Kelly

http://neuage.org/AA/web/notes3/Kellyvideo.htm [3/9/08 12:59:55 PM]



Lauren

Grace

http://neuage.org/AA/web/notes3/Gracevideo.htm [3/9/08 12:59:55 PM]



Christopher

Christopher's flash poem 

Flash Poems

next poem - Nathan

 

http://neuage.org/AA/hypertext/flashpoem/Christopher.htm [3/9/08 12:59:56 PM]

http://www.albany-academy.org/compcon/hypertext/flash_poems.htm
http://www.albany-academy.org/compcon/hypertext/flashpoem/Nathan.htm



Nathan

Nathan's flash poem 

Flash Poems

next poem Niki's 

 

 

 

http://neuage.org/AA/hypertext/flashpoem/Nathan.htm [3/9/08 12:59:56 PM]

http://www.albany-academy.org/compcon/hypertext/flash_poems.htm
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Niki

Niki's flash poems  

Flash Poems

next poem Vivian's

1.

 

2.

http://neuage.org/AA/hypertext/flashpoem/niki.htm (1 of 2) [3/9/08 12:59:57 PM]
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Niki

 

 

http://neuage.org/AA/hypertext/flashpoem/niki.htm (2 of 2) [3/9/08 12:59:57 PM]



Vivian

Vivian's flash poems  

Flash Poems

next poem 's Kyle's poem

 

http://neuage.org/AA/hypertext/flashpoem/vivian.htm (1 of 2) [3/9/08 12:59:57 PM]
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Vivian

 

 

http://neuage.org/AA/hypertext/flashpoem/vivian.htm (2 of 2) [3/9/08 12:59:57 PM]



Kyle

Kyle's flash poems  

Flash Poems

next poem  Jeff's poem

 

http://neuage.org/AA/hypertext/flashpoem/kyle.htm [3/9/08 12:59:58 PM]
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Jeff

Jeff's flash poems  

Flash Poems

next poem  Rachael K's poem

 

http://neuage.org/AA/hypertext/flashpoem/jeff.htm [3/9/08 12:59:59 PM]
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Rachael K

Rachael K's flash poems  

Flash Poems

next poem  Tomas' poem

 

http://neuage.org/AA/hypertext/flashpoem/rachael_k.htm [3/9/08 1:00:00 PM]
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Tomas

Tomas' flash poems  

Flash Poems

next poem  John's poem

 

http://neuage.org/AA/hypertext/flashpoem/tomas.htm [3/9/08 1:00:01 PM]
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John

John's flash poems  

Flash Poems

next poem  Nicholas's poem

 

http://neuage.org/AA/hypertext/flashpoem/john.htm (1 of 2) [3/9/08 1:00:03 PM]
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John

 

http://neuage.org/AA/hypertext/flashpoem/john.htm (2 of 2) [3/9/08 1:00:03 PM]



Nicholas

Nicholas's flash poems  

Flash Poems

next poem  Christopher's poem

 

http://neuage.org/AA/hypertext/flashpoem/nicholas.htm (1 of 2) [3/9/08 1:00:04 PM]
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Nicholas
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Grading Web Design trimester three

Back to Albany Academy's Computer Web Page ~ Computer Concepts @ Albany Academies ~ 
Calendar for trimester three  ~ Blog ~ Grading 

Projects for grades for trimester three 

I.  Hairspray (Medley) 10%
II.  Cool 3d Project 10% Eight lessons ~ April 03 - 19

III.  FreeHand project 10%
IV.  Personal Musical 25 %
V.  Flash animation of a product 25%

VI.  Final Webpage developed project 20%

 

http://neuage.org/AA/web/notes3/Grading.htm [3/9/08 1:00:04 PM]
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Monday March

Monday March

We will be meeting this week beginning today to discuss projects for this trimester.

Kathleen and Alexa are having birthday's today so our first task is to send each one a e-birthday card. 
Look in Google under e-birthday cards and find the best - Kathleen and Alexa will be judge of which 
card is the best.

Discussion of our first video project - Hairspray background for Evening of the Arts.

We have two weeks to put this together in - 

 

http://neuage.org/AA/web/notes3/3-06.htm [3/9/08 1:00:05 PM]



Hairspray brainstorm

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading 

 

Did you see the flash birthday cards at http://www.albany-academy.org/compcon/web/birthday/happy.
htm ??????

●     Discussion of our first video project - Hairspray background for Evening of the Arts.
●     We have two weeks to put this together in - 
●     What we will be looking at together - 
●     The chorus will give an 18 - minute presentation 

What we will do

1.  We will have a three to four minute lead-in with sound of the 1960s as well as the visuals  = 3 
minutes 30 seconds

2.  Each student will have one minute of a visual collage of the 1960s with no sound  = 11 minutes
3.  We will have a three to four minute lead-out with sound of the 1960s as well as the visuals  = 3 

minutes 30 seconds
4.  Total 18 minutes

What you will do

●     have photos and fade in fade out affects every 15 or so seconds - today you will begin collecting 
photos

●     have a specific topic ???? cars, fashions, music, politics etc of the 1960s with an emphasis on 
Baltimore Maryland

●     you will have a well presented flash presentation that will join in with each other's

http://neuage.org/AA/web/notes3/3-08.htm [3/9/08 1:00:06 PM]
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Back to Albany Academy

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading OVERALL NOTES FOR PROJECT ONE 
(HAIRSPRAY); PROJECT TWO; PROJECT THREE

 

______________________________________

__theme____________________________________

 What are your sources?

Magazines/Catalogues/Internet/Library/school yearbooks – do not depend on one source

_______________________________________________________________________

________________________________________________________________________

Various topics – keep a log of where you get photos – not everything has to be from the web – we 
can scan pictures

Ø      Cars - Fuel Dragsters, 1962 Style – Drag racing

http://neuage.org/AA/web/notes3/3-09.htm (1 of 2) [3/9/08 1:00:09 PM]
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Back to Albany Academy

Ø      Vintage Guitars 1962 style

Ø      Classic 1962 Design: Clean up your face on men.style.com men's fashion, men's clothing, 
news, gear, entertainment, travel and trends

Ø      Events

Ø      Music

Ø      Hair

Ø      Travel

Ø      Politics 

Ø      Celebrities - Marilyn Monroe and etc

Ø      School – pictures of Albany Academy for Girls 1962 – yearbooks

Ø      Did you know? One trend that was inescapable in early 1962 Pop Culture was a revival of 
the Twist.

Ø      Sports

Ø      Architecture 

Ø      Fads

Ø      Surfing 

 

Steps toward completion 

 

http://neuage.org/AA/web/notes3/3-09.htm (2 of 2) [3/9/08 1:00:09 PM]



REFERENCE EVERYTHING

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany Academies ~ 
Calendar for trimester three  Blog ~ Grading OVERALL NOTES FOR PROJECT ONE (HAIRSPRAY); 
PROJECT TWO; PROJECT THREE

Thursday - continue with our Hairspray project. See the first part of this if you need more info 

 Go to our Blog - Web Design 'Internet Video and answer the questions for today.

Begin thinking about how your presentation will look. Remember 

to .

There are several approaches you can take for this project. Collage, individual images, short video clips - you may come 

up with others. The project must be finished in Flash which I will put into two formats;  as scenes in Flash with 

12 scenes and each scene will be your one-minute  in Power Point with slides scrolling through your work. 

You can  use Publisher as I did for the brochure/newsletter for the Chorus Trip to NYC or you can use Photoshop to make 
your collage (we have it on two machines at AA PC lab) or Fireworks at AAG.

For anyone with a bit of a morbid slant here is a great site ANDY WARHOL/SUPERNOVA: Stars, Deaths, and 
Disasters, 1962 - 1964 In the 1960s, Andy Warhol found images of current events and superstars in the daily newspaper for 

his silk-screened and printed artworks. 

The 35th Academy Awards - 1962 

The thirty-fifth Academy Awards ceremony was held on Monday, April 8, 1963 at the Santa Monica 
Civic Auditorium. Frank Sinatra, the host for the evening, 
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REFERENCE EVERYTHING

collage[1] (from French coller, “to glue”) Pictorial technique of applying printed or found materials (e.
g., newspaper, fabric, wallpaper) to a flat surface, often in combination with painting. Long popular as a pastime 
for children and amateurs, it was first given serious attention as an art technique by Pablo Picasso and Georges 
Braque in 1912–13. Many other 20th-century artists produced collages, including Juan Gris, Henri Matisse, 
Joseph Cornell, and Max Ernst. In the 1960s collage was employed as a major form of Pop art, exemplified in 
the work of Robert Rauschenberg.

Here are some examples of collages. See more at http://www.artnet.com/Magazine/features/polsky/polsky12-13-00.asp 

[2]

 [3]
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[4]

[5]

 

Video Collages appliances from http://automaticwasher.org/vintage_video.htm
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REFERENCE EVERYTHING

 

 

 
 

[1] Encyclopædia Britannica Online Thursday, March 09, 2006

[2] ArtNet, Joseph Cornell/Marcel Duchamp… in Resonance by Susan Davidson et al. Online at http://www.
artnet.com/Magazine/features/polsky/polsky12-13-7.asp Copied Thursday, March 09, 2006

[3] Joseph Cornell. Robert Schumann (+German romanticism, verso) paper collage w. pencil on board 13.8 x 9.3 
in. Sold for $49,350 at Christie's May 2000. Online at http://www.artnet.com/Magazine/features/polsky/polsky12-13-5.
asp Copied Thursday, March 09, 2006

[4] Joseph Cornell. Soap Bubble Set (Ostend Hotel), ca. 1958. Online at http://www.albrightknox.org/ArtStart/Cornell.
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REFERENCE EVERYTHING

html  Copied Thursday, March 09, 2006

[5] Collage by Dr. Neuage - Images from fashion-era.com - http://www.fashion-
era.com/1960s/1962_fashion_drawings_colouring_in.htm copied Thursday, March 09, 2006
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hairspray me
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Thursday - continue with our Hairspray project. See the first part of this if you need more info 

 Go to our Blog - Web Design 'Internet Video and answer the questions for last Friday.

Begin thinking about how your presentation will look. Remember to 

.

Draw up a storyboard and list how many pages and what will be on them for your one minute

A storyboard is a sketch of how to organize your presentation and a list of its contents. 

A storyboard helps you:

●     Define the parameters of what will be on your one-minute using available resources and time 
●     Organize and focus a coherent presentation
●     Figure out what medium to use for each part of the story - will you do a collage or single pictures? Will they fade or move 

in from the side and etc?

How to Do a Rough Storyboard

Your presentation will be some combination of video, text, still photos, audio, graphics and interactivity presented in 
a nonlinear format in which the information in each medium is complementary, not redundant.

 So your storyboard should be put together with all those elements in mind.

The first thing to tackle is the part about the story being nonlinear. 

1. Divide the story into its logical, nonlinear parts, such as: 

●     a lead such as a heading  essentially addressing why this section is important 
●     profiles of the main person or people in the story 
●     the event or situation 
●     any process or how something works 
●     the history of the event or situation 
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hairspray me

●     other related issues raised by the page/image

Decide what pieces of my presentation  work best in video

Decide what pieces of my presentation  work best in still photos. 

Does the audio work best with video, or will it be combined with still photos?

What part of my presentation  works best in graphics? Such as Animated graphics

What part of my presentation belongs in text?

On a sheet of paper, sketch out what each page will look like 
and the elements it will include. 
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hairspray me

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading OVERALL NOTES FOR PROJECT ONE 
(HAIRSPRAY); PROJECT TWO; PROJECT THREE

Thursday - continue with our Hairspray project. See the first part of this if you need more info 

 Go to our Blog - Web Design 'Internet Video and answer the questions for last Friday.

Wrap up your image presentation today
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Finish your projects today

http://neuage.org/AA/web/notes3/3-16.htm [3/9/08 1:01:16 PM]

http://www.albany-academy.org/compcon/web.htm
http://www.albany-academy.org/compcon/web/notes3/index.htm
http://www.albany-academy.org/compcon/
http://www.albany-academy.org/compcon/
http://www.albany-academy.org/compcon/web/calendar3.htm
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/web/notes3/Grading.htm
http://www.albany-academy.org/compcon/web/notes3/Hairspray.htm


watching hairspray the movie
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We will watch the movie Hairspray in class today. If you have any more finishing touches to do on your presentation do 
them today.
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Welcome back from or is it to La La Land?

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
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April 03

REMEMBER WE ARE MEETING IN THE AAG CLASSROOM TODAY

We have our images for the first project for Hairspray  -I have put them into a PowerPoint - we 
will do a bit more with these later in the week - and next week we will do a mini-show for the 
lower grades of the 1962 Background plus your animated stories. Look at our calendar for a 
general idea of what we should accomplish this trimester.

We will begin using a 3D Text and Graphic program - Ulead Cool 3D

Getting Started 

load the program and look at the workspace
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Cool as 3d can be

I overwrote today's lesson but since we have done it we will move on to Friday's 
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Cool as 3d can be

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading 

April 07 or thereabouts 

 Do the Creating a Custom Can 
Tutorial and save it in your folder "cool". Hold doing this as I am not sure we have 
the correct version of Cool 3D to do this I will not know until class - the file is in the 
teacher folder. For now do the next exercise.

  Make a logo as we have been doing it > save 
it and import it into a Dreamweaver page following this way:
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Cool as 3d can be

In your cool 3D program after making your groovy logo > File > Create animated file > Export to 
Macromedia (SWF) > with JPEG > remember Dreamweaver? we will be doing heaps more in it sooner 
or later

An example of what your end result should look better than.
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April 10 Monday and Wednesday the 12th or thereabouts 

Firstly, for those of you who were not here you will need to do the exercise two from Friday on your 
own http://www.albany-academy.org/compcon/web/notes3/4-07.htm follow the instructions and let me 
know when it is done. It counts for ten-points toward your final grade. Look at Logo (Cool 3D) and 
when your Logo is added then you will be graded. Remember to export it as a flash file per 
instructions.

We will do more with Cool 3D when we need an animated title for your project that we will begin today.

We have changed a few classes in our calendar so if you are following the calendar as diligently as I 
know you are then you will see I have changed what we are doing for this week. Originally, as you 
would know because you engage so well with this course and read all that I say you will remember that 
we were doing more with Cool 3D this week. Unfortunately, as software goes, we do not have version 
3.5 on our computers. In version 3.5 we can do more 3D modelling than we can with our current Cool 
3D version 1.1 thingy. So we will move on to our next thing. Please see our calendar so that you can 
change the dates in your diary for when things are due - http://www.albany-academy.org/compcon/web/
calendar3.htm. 

OK this should be fun.

Our next project is to create a video that we will lay tracks over - add beats and samples. We will do this 
in the AA lab using Sony Acid. 

Firstly, we need topics and films. I have changed my thoughts on doing a rock video though that is 
possible. What I want to have us do is create a short narrative 
in groups of two or more. If you want to include someone outside the class for the film-acting part this is 
fine. However, at the end of the day you will be responsible for your own film and its eventual 
manifestation in a webpage. 
 
Simply put; you will spend today brainstorming and thinking of what you wish to do. Wednesday you 
will begin writing up your script. I will put up a rubric for grading following our break.
 
Basically, you will create a story which will be a silent movie and you will have text inserted as shown 
in the samples below. 
 
To get you into the mindset we have several videos we will look at. These are from Mr. Johnson's class 
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Cool as 3d can be

where he has a course called 'Script to screen' which is a full year course and of course much more 
involved than what we will do. These particular clips Mr. Johnson's "Music and Technology" course are 
using to put backbeats and samples to the actions in the films.
 
Go to this address to see the examples http://neuage.info//AA/web/video/myvideoplayer-catfight.html  
because this is a trail video software we need to see the little clip at the beginning then click player list 
and we will play the various clips.
If the first video (the TV screen is not working then view the four clips below) 
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Happy Wednesday

Happy Wednesday

04/12/2006

I want a written out sketch of what you will be doing and what your filming scene/requirements/settings 
will be for when we return by the end of today's class.

Have a great holiday and when we return we WILL MEET IN THE AA LAB
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silent movies R-us
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Welcome back from too many days from learning academic stuff...

We need to begin having a concrete direction for our filming today.

Firstly, where is your filming taking place?

We will attempt a practice trial session today and upload it and then begin adding background tracks.
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This is it

Film day

Three cameras are available from Mrs. Goold's computer lab upstairs they must be signed out and 
returned by end of class - use tripods if you wish. The future of cinema silliness is in your hands. Good 
luck.
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May 1 - 5 finish your movie this week
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This is it

Film day two (too?)

Continue to work on your clips this week 

Three cameras are available from Mrs. Goold's computer lab upstairs they must be signed out and 
returned by end of class - use tripods if you wish. The future of cinema silliness is in your hands. Good 
luck.
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Web Class videos to the MAX

Academies Web video class 

 

 

[ Lauren ] [ Biz ] 
[ Kathleen ] [ Niki ] 
[ Valerie ] [ Alexa ] 
[ Jennifer ] [ Sage ] 
[ Margaret ] [ Kelly ] 
[ Grace ]

 

Your work is in my folder on the teacher's drive

●     Niki, Biz, and Kathleen > R:\Upper School\Dr_ Neuage\video 
webclass\Biz-Niki-Kath See "NBK(1)" and work with that - be sure 
to save it frequently in your folder.

●     Alexa and Kelly > R:\Upper School\Dr_ Neuage\video webclass
\Kelly-Alexa See "alexis" and work with that - be sure to save it 
frequently in your folder.

●     Lauren R:\Upper School\Dr_ Neuage\video webclass\Lauren See 
"fight" and work with that - be sure to save it frequently in your 
folder.

●     Sage and Margaret > R:\Upper School\Dr_ Neuage\video webclass
\Sage-Margaret See "sageMarg" and work with that - be sure to save 
it frequently in your folder.

●     Valerie and Jennifer > R:\Upper School\Dr_ Neuage\video webclass
\Val-Jenn See "b" and work with that - be sure to save it frequently in 
your folder.

●     Grace > R:\Upper School\Dr_ Neuage\video See "Cat_Fight" and 
work with that - be sure to save it frequently in your folder.

 

 

http://neuage.org/AA/web/notes3/5-01.htm [3/9/08 1:05:03 PM]

http://neuage.info/video/Lauren/LaurenVideo.htm
http://neuage.info/video/Biz/BizVideo.html
http://neuage.info/video/Kathleen/KathleenVideo.htm
http://neuage.info/video/Niki/NikiVideo.html
http://neuage.org/AA/web/notes3/Valerievideo.htm
http://neuage.org/AA/web/notes3/Alexavideo.htm
http://neuage.org/AA/web/notes3/Jennifervideo.htm
http://neuage.org/AA/web/notes3/Sagevideo.htm
http://neuage.org/AA/web/notes3/Margaretvideo.htm
http://neuage.org/AA/web/notes3/Kellyvideo.htm
http://neuage.org/AA/web/notes3/Gracevideo.htm


Digital Autobiograpy
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(HAIRSPRAY); PROJECT TWO; PROJECT THREE

05/08/2006

Building a Digital Autobiography

We are moving forward - if you have not finished your video we will have to find another time for it - I 
will put them up as I have time. So far we have just two that I have working: Biz and Lauren from our 
video class site. I will find Valerie's and get that working.

Today we will begin building a Digital Autobiography and we will do this for these next two weeks then 
make a commercial using every thing we have learned this year.

■     Do Activity 1: Planning Your Movie
■     Activity 2: Setting Basic Movie Properties
■     Activity 3: Creating an Opening Page and a Menu

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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05/10/2006

We will continue with our Building a Digital Autobiography; having done:

■      Activity 1: Planning Your Movie 
■     Activity 2: Setting Basic Movie Properties - page 175 - be sure this done as per instructions (p. 

176) Window > Design Panel > Scene
■     Activity 3: Creating an Opening Page and a Menu - be sure you have your three scenes. Your tree 

which you imported from my folder (Flash > Project 5 > Assets) Be sure you have Converted it 
to a Symbol (page 177) > Modify > convert to symbol (Not insert)

Starting with today we will do 

■     Activity 3 continued: If you did not resize your tree go to (page 178 - Step 5.5) Window > Design 
Panel > Transform

■          page 179 step 5.6 have your groovy title and if you used an unusual font save it as a symbol in 
your library as described in 5.6 

■     Activity 4:  Creating Animated Buttons - be sure you are in your introduction scene - page 184 
step 16 the actions shortcut is Windows > Development panel 

■     Activity 5:  Create an Animated Graphic
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- 4 PM I will keep you posted when the bus leaves.
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Thursday May 11th or so have ready for Friday the below written in Word

I.  In your folder have your story written up for your commercial 
II.  What is your 60 second commercial?  answer these in a Word document    

The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone with 
the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to buy 

your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.
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Friday May 12th or so have ready for Friday the below written in Word

I.  In your folder have your story written up for your commercial 
II.  What is your 60 second commercial?  answer these in a Word document    

The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone with 
the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to buy 

your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.
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Monday May 15th or so have ready by end of class or your name will be mud 

 

I.  In your folder have your story written up for your commercial - the easiest would be to copy and paste the 
questions below and answer them - be sure to save them in your folder
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II.  What is your 60 second commercial?   
The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone 
with the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to 

buy your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

V.  Storyboard - what will be in each of at least ten scenes    [I want this done in Word and in your folder “Flash 
> Commercial”]

The process of creating a rich and engaging animation involves so much more than "leading the character" 
around the stage. Some of the other common elements that will be discussed in this class are as follows:

a)      Firstly, Building the story. Before you begin to develop your commercial, you need to design your 
story. Planning ahead- not DOING IT ON THE "FLY" IS IMPORTANT so you do not waste lots of time.

b)      Create a character for your story. This can be a stick figure or something more elaborate. There 
are two parts here:

i.                    Creating the Script  WRITE OUT YOUR ANSWERS TO THESE SECTIONS - BEFORE MAKING 
BEGINNING FLASH

Script development, like many writing projects, provides structure and detail. Start in an outline form to make 
sure you get all the bits and pieces you want to use. When you have your outline, you can develop the details. 
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The areas on which you will want to focus are these: 

·         Descriptive setting. The first thing is to describe the environment for the opening scene. 
Your opening scene may be the title of your product or commercial or it may be more subtle. For example, if 
you were selling an ad for condominiums in Hawaii you may want to begin with a photo of an Hawaiian sunset. 
This description needs to encompass the set, setting, atmosphere, and mood. It also needs to place the 
main character or subject matter – the title or an image in the scene. Then, as your story transitions from one 
scene to the next, you describe these changing settings. 

·         Character and subject development. As characters or subject matter are introduced to the scene, 
you'll need a brief description of their characteristics, appearance, and style. WE WILL BEGIN USING 
THE DRAWING TOOLS TODAY TO MAKE A FIGURE OR YOU CAN IMPORT AN IMAGE

·         Transitions. When moving the action from one scene to the next, you need to think through how 
the transition will be handled. You don't want to alienate your audience with inappropriate scene changes. 
This might be in the form of fades; camera motions (pan/zoom), refocusing, and so on. Transitions are covered 
in more detail in Chapter 12, "Making the Transition."

·         Character dialogue or action. When you actually have a character or characters, you will need to detail 
the dialogue and actions.

·         Important action characteristics. If there are sound effects, visual effects, or action sequences, they 
need to be described in context with the character, object, action, or transition with which they are associated.

Your script puts your words in order; your storyboard organizes your animation's visuals.

ii.                  Storyboarding Your Action

·                                                        Storyboarding is the same format as you see in newspaper cartoons and 
in comic books. Illustrations are provided inline with the script to provide a visual narrative for what is 
being described by the words themselves. Your average set of storyboards is a sequence of illustrated 
and numbered panels arranged in a linear fashion. Next to or below these panels is an area for the related 
script text that accompanies the illustration. When you look at the storyboards, you are looking at the 
animation itself, but in skeletal form. 
·                                                        When preparing your storyboards, you'll want to set them up in roughly 
the same aspect ratio as you anticipate you'll use for your final animation. That way, when you're 
illustrating scenes, sets, and actions on your boards, you'll have a good visual sense of how the scene will play out. 
·                                                        The average computer monitor displays at an aspect ratio of 3 x 4. Thus, if 
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you set up your storyboards as a series of 3-inch-by-4-inch or 6-inch-by-8-inch panels, you'll be in good shape. 
We will do this in Word but blank 3x5 cards would be easier.
·                                                        When your storyboards are complete, you have a number of options at 
your disposal to aid you in the process of converting your story to reality. Hand-drawn storyboards can be 
scanned, placed on a background layer in Flash, and traced using the drawing tools in Flash. If you are artistic 
you can start out the process by hand sketching, this can be an appealing option.
·                                                        Another option is to use Macromedia FreeHand as your storyboarding tool. 
We do not have this in our PC lab at AA but you can do it (remember from before Christmas break?) in PC lab 
at AAG. 
·                                                        As you would obviously remember, FreeHand enables you to define 
multiple pages inside a single FreeHand document, much like a Microsoft Word document can contain hundreds 
of pages. Because the two programs are so tightly integrated, you can copy your illustrations from FreeHand 
and paste them into Flash in the standard Flash format. Although this might seem insignificant, if you are trying 
to create storyboards in some other illustration packages, you'll need to create several documents to 
accomplish the same task.

 

In our next class we will begin using building our scenes and characters and get the animation thingy happening.

 

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.
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For a review we will go over a few things from what we should know in Flash:

put three movies (Export movie) into your Flash folder: Squash, Anticipation and Ease

1. Have objects move smoothly over one another (this will not work with very complicated scenes). 
Have a layer for three different objects > label your layers > and be sure you have 'Converted to 
symbol" each image > to have your image move smoothly from frame 1 - 30 > click in frame 10 > 
F6 > move your image to where you want it > click in frame 20 > F6 > move your image to where 
you want it > click in frame 30  F6 > move your image to where you want it. In Properties select 
your frame and Tween > Motion

 

2. Anticipation. If you have your figure just move across the screen then that is quite budget
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  have your figure begin moving in the first frames and 
at the end as shown in Dr. Blob Rocks below. Don't have your figure just move quickly - 
ANTICIPATE 

 

3. Squash and stretch See that when you move and select your character that "Free Transform tool" is 
selected and then when the figure is where you want it using the alt - key on your keyboard squash your 
thingy > REMEMBER TO HOLD ALT KEY TO STRETCH JUST THE TOP - otherwise the whole 
image moves.
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Squash is good for something that is hitting the ground or hitting a wall   and Stretch is good for 
something that is spring into action....

 

take home a forum today

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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today we will look at a couple of other features in Flash to add to your arsenal of creating a 
great ad

1. Shape tweening  

   

2.  shape and blob- create a shape blob as these two combined and save it in your activities folder 
as 'shap-blob'
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take home a forum today

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.

the bus will be in front of AA at 1.30 next Tuesday - everyone is required to go on this trip.

today we will look at a couple of other features in Flash to add to your arsenal of creating a 
great ad

If you have been missing classes you will need to do the exercises for Wednesday and Thursday. You 
can follow the tutorial (http://www.vtc.com log on = albanyny - password = academy25) but it can only 
be done on one computer at a time so share a computer and listen to "animating in flash" > Basic 
Animation Techniques > tutorial on "Anticipation"; :squash and stretch"; "Easing"; and under "Morph 
Animation" > "Shape tweens"; 

Today we will spend the whole time on your project except for one tutorial and that is for breaking apart 
an image and on "explode"

Break apart
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Explode = Insert > Timeline Effects > Effects > Explode
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take home a forum today

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.

the bus will be in front of AA at 1.30 next Tuesday - everyone is required to go on this trip.

 
at 1.30 the bus leaves from AA for the SUNY nano-technology college for our visit of 

NanoCareer Day 

 

Work on your advertising projects today they will be due next Wednesday the 31st.

Your ads must be in a folder labeled AD in your main folder (U - drive, not 
a flash folder or et folder etc)

●     ten points - correct folder
●     ten points -one-minute of continuous time - at at least twelve frames 

per second - you can either group in scenes or layers
●     ten points -background sound - that changes and dramatizes your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - 
●     
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take home a forum today
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Your Flash commercial project is

Friday, May 26, 2006

Your Flash commercial project is due Wednesday31st May

Two days left of classes 

May 26 Friday   See http://neuage.info/AA/commercial/ads.htm for your ad when it 
is finished

Your ads must be in a folder labeled AD in your main folder (U - drive, not a flash folder 
or et folder etc) THIS IS DUE NEXT TUESDAY

●     ten points - correct folder
●     ten points -thirty-seconds of continuous time -  at least twelve frames per second - you 

can either group in scenes or layers
●     twenty points -background sounds, using SONY ACID - that changes and dramatizes 

your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - shape tween and a motion tween (see star below for motion tween concept)
●     ten points - exported and placed in a FrontPages page or Dreamweaver with an order 

form on the page to purchase your product 
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information about Copyright and Fair Use 

Computer Ethics (a student-created ThinkQuest site) http://library.advanced.org/26658/ 

CONFU: The Conference on Fair Use 

http://www.utsystem.edu/OGC/intellectualproperty/confu.htm 

Copyright and Intellectual Property http://www.ala.org/work/copyright.html 

Copyright and K-12 http://www.ed.gov/Technology/Futures/rothman.html 

Copyright and Licensing Website for Educators http://www.kent.wednet.edu/staff/epeto/
copyright/index.html

Copyright Clearance Center http://www.copyright.com/ 

Copyright Guidelines: Library Services, Jefferson County Public Schools (a handy chart!) 

http://204.98.1.2/plmc/copyright.html 

Copyright Implementation Manual Groton (CT) Public Schools 

http://groton.k12.ct.us/mts/cimhp01.htm 

Copyright Website http://www.benedict.com/ 

Copyright Workshop (Linda Joseph) http://www.cyberbee.com/copyrt.html 

Digital Copyright Website http://www.benedict.com/digital/digital.htm 

Digital Future Coalition http://www.dfc.org// 

District Copyright Web Publishing Rules (Bellingham, WA) 
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http://www.bham.wednet.edu/copyrule.htm 

Fair Use Guidelines for Educational Multimedia and Related Documents and Links 

http://www.libraries.psu.edu/mtss/fairuse/default.html 

Regents Guide to Understanding Copyright and Educational Fair Use (Real-life questions and 
answers for teachers) 

http://www.peachnet.edu/admin/legal/copyright/copy.html 

SPA Anti-Piracy http://www.spa.org/piracy 

Stanford University Libraries: Copyright and Fair Use 

http://fairuse.stanford.edu/ 

Tell it to the Judge (a quiz for educators) http://www.news.com/Quiz/Entry/ 

Ten Big Myths of Copyright Explained http://www.templetons.com/brad/copymyths.html 

US Copyright Office http://lcweb.loc.gov/copyright/ 

UT System Crash Course in Copyright http://www.utsystem.edu/OGC/intellectualproperty/
cprtindx.htm 

Visit to Copyright Bay (a tutorial for teachers) http://www.nmjc.cc.nm.us/copyrightbay/ 

Website Management: Keeping it Legal http://www.fno.org/jun96/legal.html 

What You Need To Know About Copyright and Citations on Educational Internet Materials 
http://www.technology4u.com/ton/copyright.html

When Works Pass Into the Public Domain http://www.unc.edu/~unclng/public-d.htm 

 

http://neuage.org/AA/web/notes3/information.htm (2 of 2) [3/9/08 1:05:15 PM]

http://www.bham.wednet.edu/copyrule.htm
http://www.libraries.psu.edu/mtss/fairuse/default.html
http://www.peachnet.edu/admin/legal/copyright/copy.html
http://www.spa.org/piracy
http://fairuse.stanford.edu/
http://www.news.com/Quiz/Entry/
http://www.templetons.com/brad/copymyths.html
http://lcweb.loc.gov/copyright/
http://www.utsystem.edu/OGC/intellectualproperty/cprtindx.htm
http://www.utsystem.edu/OGC/intellectualproperty/cprtindx.htm
http://www.nmjc.cc.nm.us/copyrightbay/
http://www.fno.org/jun96/legal.html
http://www.technology4u.com/ton/copyright.html
http://www.unc.edu/~unclng/public-d.htm


our newsletter on ournews.mobi

Back 
 
Videos Recent 

 

Videos Past 

 

Photos  
 

Blogs 06 
 

Blogs 05 
 

 

 

NYC videos 11/12/06   refresh site 

Welcome to our family newsletter on ournews.mobi. 

http://neuage.org/news/yourschool/content.html [3/9/08 1:05:17 PM]

http://ournews.mobi/album.htm
http://our-newsletter.info/yourschool/content.html
http://ournews.mobi/


Narda and Terrell's fabulous subway ride on the Number 1 train out of the Bronx New York City, November 05 2006 page by terrell neuage

Narda and Terrell's fabulous subway ride on the Number 1 train out of the Bronx New York City, 
November 05 2006 

New York video clips with Terrell Neuage and Narde Biemond  
Return to our video page (with frames)  

Our News will put your travels on the web on mobile phones  
NEXT CLIP IN SERIES going back in time  

PREVIOUS CLIP IN SERIES going forward in time  

 

Launch in external player 

 

http://neuage.org/06/01-train.htm [3/9/08 1:05:17 PM]

http://neuage.org/06.html
http://neuage.org/news/yourschool/content.html
http://ournews.mobi/
http://neuage.org/06/EastRiverBikeRide.html
http://servername/path/to/media.file


graffiti at Brooklyn museum of hip hop 

graffiti at Brooklyn museum of hip hop
video at http://neuage.org/NYC/hiphop.htm

 

  
P1204320.JPG

  
P1204321.JPG

  
P1204322.JPG

  
P1204323.JPG

  
P1204324.JPG

  
P1204325.JPG

  
P1204326.JPG

  
P1204327.JPG

  
P1204328.JPG

  
P1204329.jpg

  
P1204330.jpg

  
P1204331.jpg

  
P1204332.JPG

  
P1204361.JPG

http://neuage.org/NYC/graffiti/index.htm [3/9/08 1:05:19 PM]

http://neuage.org/NYC/hiphop.htm
http://neuage.org/NYC/graffiti/pages/P1204320_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204321_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204322_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204323_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204324_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204325_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204326_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204327_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204328_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204329_jpg.htm
http://neuage.org/NYC/graffiti/pages/P1204330_jpg.htm
http://neuage.org/NYC/graffiti/pages/P1204331_jpg.htm
http://neuage.org/NYC/graffiti/pages/P1204332_JPG.htm
http://neuage.org/NYC/graffiti/pages/P1204361_JPG.htm


our Brooklyn Apartment / bedroom.JPG

our Brooklyn Apartment/bedroom.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/bedroom_JPG.htm [3/9/08 1:05:21 PM]

http://neuage.org/06/apartment/pages/u-haul_truck_gif.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/bedroom2_JPG.htm
http://neuage.org/06/apartment/images/bedroom_JPG.jpg


our Brooklyn Apartment / bedroom2.JPG

our Brooklyn Apartment/bedroom2.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/bedroom2_JPG.htm [3/9/08 1:05:22 PM]

http://neuage.org/06/apartment/pages/bedroom_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/blimey_gif.htm
http://neuage.org/06/apartment/images/bedroom2_JPG.jpg


our Brooklyn Apartment / blimey.gif

our Brooklyn Apartment/blimey.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/blimey_gif.htm [3/9/08 1:05:24 PM]

http://neuage.org/06/apartment/pages/bedroom2_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/entrance-hall_JPG.htm
http://neuage.org/06/apartment/images/blimey_gif.jpg


our Brooklyn Apartment / entrance-hall.JPG

our Brooklyn Apartment/entrance-hall.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/entrance-hall_JPG.htm [3/9/08 1:05:25 PM]

http://neuage.org/06/apartment/pages/blimey_gif.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/entrance_hall_JPG.htm
http://neuage.org/06/apartment/images/entrance-hall_JPG.jpg


our Brooklyn Apartment / entrance_hall.JPG

our Brooklyn Apartment/entrance_hall.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/entrance_hall_JPG.htm [3/9/08 1:05:26 PM]

http://neuage.org/06/apartment/pages/entrance-hall_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/front door_JPG.htm
http://neuage.org/06/apartment/images/entrance_hall_JPG.jpg


our Brooklyn Apartment / kitchen-terrell.JPG

our Brooklyn Apartment/kitchen-terrell.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/kitchen-terrell_JPG.htm (1 of 2) [3/9/08 1:05:27 PM]

http://neuage.org/06/apartment/pages/front door_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/kitchen-terrell2_JPG.htm
http://neuage.org/06/apartment/images/kitchen-terrell_JPG.jpg
http://neuage.org/06/apartment/images/kitchen-terrell_JPG.jpg


our Brooklyn Apartment / kitchen-terrell.JPG

http://neuage.org/06/apartment/pages/kitchen-terrell_JPG.htm (2 of 2) [3/9/08 1:05:27 PM]



our Brooklyn Apartment / kitchen-terrell2.JPG

our Brooklyn Apartment/kitchen-terrell2.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/kitchen-terrell2_JPG.htm (1 of 2) [3/9/08 1:05:29 PM]

http://neuage.org/06/apartment/pages/kitchen-terrell_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/lounge-Terrell-desk_JPG.htm
http://neuage.org/06/apartment/images/kitchen-terrell2_JPG.jpg
http://neuage.org/06/apartment/images/kitchen-terrell2_JPG.jpg


our Brooklyn Apartment / kitchen-terrell2.JPG

http://neuage.org/06/apartment/pages/kitchen-terrell2_JPG.htm (2 of 2) [3/9/08 1:05:29 PM]



our Brooklyn Apartment / lounge-Terrell-desk.JPG

our Brooklyn Apartment/lounge-Terrell-desk.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/lounge-Terrell-desk_JPG.htm [3/9/08 1:05:30 PM]

http://neuage.org/06/apartment/pages/kitchen-terrell2_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/lounge_JPG.htm
http://neuage.org/06/apartment/images/lounge-Terrell-desk_JPG.jpg


our Brooklyn Apartment / lounge.JPG

our Brooklyn Apartment/lounge.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/lounge_JPG.htm [3/9/08 1:05:32 PM]

http://neuage.org/06/apartment/pages/lounge-Terrell-desk_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/lounge2_JPG.htm
http://neuage.org/06/apartment/images/lounge_JPG.jpg


our Brooklyn Apartment / lounge2.JPG

our Brooklyn Apartment/lounge2.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/lounge2_JPG.htm [3/9/08 1:05:33 PM]

http://neuage.org/06/apartment/pages/lounge_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/lounge_desk_JPG.htm
http://neuage.org/06/apartment/images/lounge2_JPG.jpg


our Brooklyn Apartment / lounge_desk.JPG

our Brooklyn Apartment/lounge_desk.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/lounge_desk_JPG.htm [3/9/08 1:05:36 PM]

http://neuage.org/06/apartment/pages/lounge2_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/moving-in_gif.htm
http://neuage.org/06/apartment/images/lounge_desk_JPG.jpg


our Brooklyn Apartment / moving-in.gif

our Brooklyn Apartment/moving-in.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/moving-in_gif.htm [3/9/08 1:05:37 PM]

http://neuage.org/06/apartment/pages/lounge_desk_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/Narda-desk_JPG.htm
http://neuage.org/06/apartment/images/moving-in_gif.jpg


our Brooklyn Apartment / Narda-desk.JPG

our Brooklyn Apartment/Narda-desk.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/Narda-desk_JPG.htm [3/9/08 1:05:38 PM]

http://neuage.org/06/apartment/pages/moving-in_gif.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/Nardas-space_JPG.htm
http://neuage.org/06/apartment/images/Narda-desk_JPG.jpg


our Brooklyn Apartment / Nardas-space.JPG

our Brooklyn Apartment/Nardas-space.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/Nardas-space_JPG.htm [3/9/08 1:05:40 PM]

http://neuage.org/06/apartment/pages/Narda-desk_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/Terrell's 'office'_JPG.htm
http://neuage.org/06/apartment/images/Nardas-space_JPG.jpg


our Brooklyn Apartment / u-haul_truck.gif

our Brooklyn Apartment/u-haul_truck.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/apartment/pages/u-haul_truck_gif.htm [3/9/08 1:05:41 PM]

http://neuage.org/06/apartment/pages/Terrell's 'office'_JPG.htm
http://neuage.org/06/apartment/index.htm
http://neuage.org/06/apartment/pages/bedroom_JPG.htm
http://neuage.org/06/apartment/images/u-haul_truck_gif.jpg


Brighton Festival / All-American-drugs.gif

Brighton Festival/All-American-drugs.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/BrightonBeach/pages/All-American-drugs_gif.htm (1 of 2) [3/9/08 1:05:43 PM]

http://neuage.org/06/BrightonBeach/pages/fan_gif.htm
http://neuage.org/06/BrightonBeach/index.htm
http://neuage.org/06/BrightonBeach/pages/BrightonBeach-Brooklyn_gif.htm
http://neuage.org/06/BrightonBeach/images/All-American-drugs_gif.jpg
http://neuage.org/06/BrightonBeach/images/All-American-drugs_gif.jpg


Brighton Festival / All-American-drugs.gif

http://neuage.org/06/BrightonBeach/pages/All-American-drugs_gif.htm (2 of 2) [3/9/08 1:05:43 PM]



Brighton Festival / BrightonBeach-Brooklyn.gif

Brighton Festival/BrightonBeach-Brooklyn.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/BrightonBeach/pages/BrightonBeach-Brooklyn_gif.htm (1 of 2) [3/9/08 1:05:47 PM]

http://neuage.org/06/BrightonBeach/pages/All-American-drugs_gif.htm
http://neuage.org/06/BrightonBeach/index.htm
http://neuage.org/06/BrightonBeach/pages/BrightonBeachBoardwalk_gif.htm
http://neuage.org/06/BrightonBeach/images/BrightonBeach-Brooklyn_gif.jpg
http://neuage.org/06/BrightonBeach/images/BrightonBeach-Brooklyn_gif.jpg


Brighton Festival / BrightonBeach-Brooklyn.gif

http://neuage.org/06/BrightonBeach/pages/BrightonBeach-Brooklyn_gif.htm (2 of 2) [3/9/08 1:05:47 PM]



Brighton Festival / BrightonBeachBoardwalk.gif

Brighton Festival/BrightonBeachBoardwalk.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/BrightonBeach/pages/BrightonBeachBoardwalk_gif.htm (1 of 2) [3/9/08 1:05:49 PM]

http://neuage.org/06/BrightonBeach/pages/BrightonBeach-Brooklyn_gif.htm
http://neuage.org/06/BrightonBeach/index.htm
http://neuage.org/06/BrightonBeach/pages/fan_gif.htm
http://neuage.org/06/BrightonBeach/images/BrightonBeachBoardwalk_gif.jpg
http://neuage.org/06/BrightonBeach/images/BrightonBeachBoardwalk_gif.jpg


Brighton Festival / BrightonBeachBoardwalk.gif

http://neuage.org/06/BrightonBeach/pages/BrightonBeachBoardwalk_gif.htm (2 of 2) [3/9/08 1:05:49 PM]



Brighton Festival / fan.gif

Brighton Festival/fan.gif

Previous | Home | Next 
 

 

 

http://neuage.org/06/BrightonBeach/pages/fan_gif.htm (1 of 2) [3/9/08 1:05:52 PM]

http://neuage.org/06/BrightonBeach/pages/BrightonBeachBoardwalk_gif.htm
http://neuage.org/06/BrightonBeach/index.htm
http://neuage.org/06/BrightonBeach/pages/All-American-drugs_gif.htm
http://neuage.org/06/BrightonBeach/images/fan_gif.jpg
http://neuage.org/06/BrightonBeach/images/fan_gif.jpg


Brighton Festival / fan.gif

http://neuage.org/06/BrightonBeach/pages/fan_gif.htm (2 of 2) [3/9/08 1:05:52 PM]



East Indian Day Parade / Brooklyn-carnival.jpg

East Indian Day Parade/Brooklyn-carnival.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn-carnival_jpg.htm (1 of 2) [3/9/08 1:05:56 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/West_Indian_Parade_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn_carnival_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/Brooklyn-carnival_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/Brooklyn-carnival_jpg.jpg


East Indian Day Parade / Brooklyn-carnival.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn-carnival_jpg.htm (2 of 2) [3/9/08 1:05:56 PM]



East Indian Day Parade / Brooklyn_carnival.jpg

East Indian Day Parade/Brooklyn_carnival.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn_carnival_jpg.htm (1 of 2) [3/9/08 1:06:01 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn-carnival_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/Brooklyn_carnival_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/Brooklyn_carnival_jpg.jpg


East Indian Day Parade / Brooklyn_carnival.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn_carnival_jpg.htm (2 of 2) [3/9/08 1:06:01 PM]



East Indian Day Parade / carnival.jpg

East Indian Day Parade/carnival.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_jpg.htm (1 of 2) [3/9/08 1:06:05 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn_carnival_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/carnival_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/carnival_jpg.jpg


East Indian Day Parade / carnival.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_jpg.htm (2 of 2) [3/9/08 1:06:05 PM]



East Indian Day Parade / carnival_girl_pink.jpg

East Indian Day Parade/carnival_girl_pink.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink_jpg.htm (1 of 2) [3/9/08 1:06:09 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink2_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/carnival_girl_pink_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/carnival_girl_pink_jpg.jpg


East Indian Day Parade / carnival_girl_pink.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink_jpg.htm (2 of 2) [3/9/08 1:06:09 PM]



East Indian Day Parade / carnival_girl_pink2.jpg

East Indian Day Parade/carnival_girl_pink2.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink2_jpg.htm (1 of 2) [3/9/08 1:06:14 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cop-face_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/carnival_girl_pink2_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/carnival_girl_pink2_jpg.jpg


East Indian Day Parade / carnival_girl_pink2.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink2_jpg.htm (2 of 2) [3/9/08 1:06:14 PM]



East Indian Day Parade / cop-face.jpg

East Indian Day Parade/cop-face.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cop-face_jpg.htm (1 of 2) [3/9/08 1:06:17 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/carnival_girl_pink2_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cops_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/cop-face_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/cop-face_jpg.jpg


East Indian Day Parade / cop-face.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cop-face_jpg.htm (2 of 2) [3/9/08 1:06:17 PM]



East Indian Day Parade / cops.jpg

East Indian Day Parade/cops.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cops_jpg.htm (1 of 2) [3/9/08 1:06:20 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cop-face_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/girls_subway_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/cops_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/cops_jpg.jpg


East Indian Day Parade / cops.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cops_jpg.htm (2 of 2) [3/9/08 1:06:20 PM]



East Indian Day Parade / girls_subway.jpg

East Indian Day Parade/girls_subway.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/girls_subway_jpg.htm (1 of 2) [3/9/08 1:06:23 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/cops_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/police-girls_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/girls_subway_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/girls_subway_jpg.jpg


East Indian Day Parade / girls_subway.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/girls_subway_jpg.htm (2 of 2) [3/9/08 1:06:23 PM]



East Indian Day Parade / police-girls.jpg

East Indian Day Parade/police-girls.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/police-girls_jpg.htm (1 of 2) [3/9/08 1:06:27 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/girls_subway_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/tour_bus_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/police-girls_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/police-girls_jpg.jpg


East Indian Day Parade / police-girls.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/police-girls_jpg.htm (2 of 2) [3/9/08 1:06:27 PM]



East Indian Day Parade / tour_bus.jpg

East Indian Day Parade/tour_bus.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/tour_bus_jpg.htm (1 of 2) [3/9/08 1:06:30 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/police-girls_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/waiting_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/tour_bus_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/tour_bus_jpg.jpg


East Indian Day Parade / tour_bus.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/tour_bus_jpg.htm (2 of 2) [3/9/08 1:06:30 PM]



East Indian Day Parade / waiting.jpg

East Indian Day Parade/waiting.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/waiting_jpg.htm (1 of 2) [3/9/08 1:06:34 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/tour_bus_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/West_Indian_Parade_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/waiting_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/waiting_jpg.jpg


East Indian Day Parade / waiting.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/waiting_jpg.htm (2 of 2) [3/9/08 1:06:34 PM]



East Indian Day Parade / West_Indian_Parade.jpg

East Indian Day Parade/West_Indian_Parade.jpg

Previous | Home | Next 
 

 

 

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/West_Indian_Parade_jpg.htm (1 of 2) [3/9/08 1:06:41 PM]

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/waiting_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/index.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/Brooklyn-carnival_jpg.htm
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/West_Indian_Parade_jpg.jpg
http://neuage.org//NYC/East-Indian-Carnival/Photos/images/West_Indian_Parade_jpg.jpg


East Indian Day Parade / West_Indian_Parade.jpg

http://neuage.org//NYC/East-Indian-Carnival/Photos/pages/West_Indian_Parade_jpg.htm (2 of 2) [3/9/08 1:06:41 PM]



http://neuage.org/NYC/photo6.jpg

http://neuage.org/NYC/photo6.jpg (1 of 2) [3/9/08 1:06:44 PM]



http://neuage.org/NYC/photo6.jpg

http://neuage.org/NYC/photo6.jpg (2 of 2) [3/9/08 1:06:44 PM]



bike / photo10.jpg

bike/photo10.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo10_jpg.htm [3/9/08 1:06:45 PM]

http://neuage.org/NYC/pages/photo1_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo11_jpg.htm
http://neuage.org/NYC/images/photo10_jpg.jpg


bike / photo11.jpg

bike/photo11.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo11_jpg.htm [3/9/08 1:06:47 PM]

http://neuage.org/NYC/pages/photo10_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo12_jpg.htm
http://neuage.org/NYC/images/photo11_jpg.jpg


bike / photo12.jpg

bike/photo12.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo12_jpg.htm [3/9/08 1:06:48 PM]

http://neuage.org/NYC/pages/photo11_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo13_jpg.htm
http://neuage.org/NYC/images/photo12_jpg.jpg


bike / photo13.jpg

bike/photo13.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo13_jpg.htm [3/9/08 1:06:50 PM]

http://neuage.org/NYC/pages/photo12_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo14_jpg.htm
http://neuage.org/NYC/images/photo13_jpg.jpg


bike / photo14.jpg

bike/photo14.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo14_jpg.htm [3/9/08 1:06:51 PM]

http://neuage.org/NYC/pages/photo13_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo18_JPG.htm
http://neuage.org/NYC/images/photo14_jpg.jpg


bike / photo18.JPG

bike/photo18.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo18_JPG.htm [3/9/08 1:06:53 PM]

http://neuage.org/NYC/pages/photo14_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo19_JPG.htm
http://neuage.org/NYC/images/photo18_JPG.jpg


bike / photo19.JPG

bike/photo19.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo19_JPG.htm [3/9/08 1:06:55 PM]

http://neuage.org/NYC/pages/photo18_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo2_jpg.htm
http://neuage.org/NYC/images/photo19_JPG.jpg


bike / photo2.jpg

bike/photo2.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo2_jpg.htm [3/9/08 1:06:57 PM]

http://neuage.org/NYC/pages/photo19_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo20_JPG.htm
http://neuage.org/NYC/images/photo2_jpg.jpg


bike / photo20.JPG

bike/photo20.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo20_JPG.htm [3/9/08 1:06:58 PM]

http://neuage.org/NYC/pages/photo2_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo21_JPG.htm
http://neuage.org/NYC/images/photo20_JPG.jpg


bike / photo21.JPG

bike/photo21.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo21_JPG.htm [3/9/08 1:07:00 PM]

http://neuage.org/NYC/pages/photo20_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo22_JPG.htm
http://neuage.org/NYC/images/photo21_JPG.jpg


bike / photo22.JPG

bike/photo22.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo22_JPG.htm [3/9/08 1:07:01 PM]

http://neuage.org/NYC/pages/photo21_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo23_JPG.htm
http://neuage.org/NYC/images/photo22_JPG.jpg


bike / photo23.JPG

bike/photo23.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo23_JPG.htm [3/9/08 1:07:03 PM]

http://neuage.org/NYC/pages/photo22_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo24_JPG.htm
http://neuage.org/NYC/images/photo23_JPG.jpg


bike / photo24.JPG

bike/photo24.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo24_JPG.htm [3/9/08 1:07:04 PM]

http://neuage.org/NYC/pages/photo23_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo25_JPG.htm
http://neuage.org/NYC/images/photo24_JPG.jpg


bike / photo25.JPG

bike/photo25.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo25_JPG.htm [3/9/08 1:07:06 PM]

http://neuage.org/NYC/pages/photo24_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo26_jpg.htm
http://neuage.org/NYC/images/photo25_JPG.jpg


bike / photo26.jpg

bike/photo26.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo26_jpg.htm (1 of 2) [3/9/08 1:07:07 PM]

http://neuage.org/NYC/pages/photo25_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo27_JPG.htm
http://neuage.org/NYC/images/photo26_jpg.jpg
http://neuage.org/NYC/images/photo26_jpg.jpg


bike / photo26.jpg

http://neuage.org/NYC/pages/photo26_jpg.htm (2 of 2) [3/9/08 1:07:07 PM]



bike / photo27.JPG

bike/photo27.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo27_JPG.htm [3/9/08 1:07:09 PM]

http://neuage.org/NYC/pages/photo26_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo28_jpg.htm
http://neuage.org/NYC/images/photo27_JPG.jpg


bike / photo28.jpg

bike/photo28.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo28_jpg.htm [3/9/08 1:07:10 PM]

http://neuage.org/NYC/pages/photo27_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo29_jpg.htm
http://neuage.org/NYC/images/photo28_jpg.jpg


bike / photo29.jpg

bike/photo29.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo29_jpg.htm [3/9/08 1:07:12 PM]

http://neuage.org/NYC/pages/photo28_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo3_jpg.htm
http://neuage.org/NYC/images/photo29_jpg.jpg


bike / photo3.jpg

bike/photo3.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo3_jpg.htm [3/9/08 1:07:14 PM]

http://neuage.org/NYC/pages/photo29_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo30_jpg.htm
http://neuage.org/NYC/images/photo3_jpg.jpg


bike / photo30.jpg

bike/photo30.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo30_jpg.htm (1 of 2) [3/9/08 1:07:16 PM]

http://neuage.org/NYC/pages/photo3_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo31_JPG.htm
http://neuage.org/NYC/images/photo30_jpg.jpg
http://neuage.org/NYC/images/photo30_jpg.jpg


bike / photo30.jpg

http://neuage.org/NYC/pages/photo30_jpg.htm (2 of 2) [3/9/08 1:07:16 PM]



bike / photo31.JPG

bike/photo31.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo31_JPG.htm [3/9/08 1:07:17 PM]

http://neuage.org/NYC/pages/photo30_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo32_jpg.htm
http://neuage.org/NYC/images/photo31_JPG.jpg


bike / photo32.jpg

bike/photo32.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo32_jpg.htm [3/9/08 1:07:18 PM]

http://neuage.org/NYC/pages/photo31_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo33_jpg.htm
http://neuage.org/NYC/images/photo32_jpg.jpg


bike / photo33.jpg

bike/photo33.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo33_jpg.htm [3/9/08 1:07:20 PM]

http://neuage.org/NYC/pages/photo32_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo34_JPG.htm
http://neuage.org/NYC/images/photo33_jpg.jpg


bike / photo34.JPG

bike/photo34.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo34_JPG.htm [3/9/08 1:07:22 PM]

http://neuage.org/NYC/pages/photo33_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo35_JPG.htm
http://neuage.org/NYC/images/photo34_JPG.jpg


bike / photo35.JPG

bike/photo35.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo35_JPG.htm [3/9/08 1:07:24 PM]

http://neuage.org/NYC/pages/photo34_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo4_jpg.htm
http://neuage.org/NYC/images/photo35_JPG.jpg


bike / photo4.jpg

bike/photo4.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo4_jpg.htm [3/9/08 1:07:25 PM]

http://neuage.org/NYC/pages/photo35_JPG.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo5_jpg.htm
http://neuage.org/NYC/images/photo4_jpg.jpg


bike / photo5.jpg

bike/photo5.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo5_jpg.htm [3/9/08 1:07:27 PM]

http://neuage.org/NYC/pages/photo4_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo6_jpg.htm
http://neuage.org/NYC/images/photo5_jpg.jpg


bike / photo6.jpg

bike/photo6.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo6_jpg.htm (1 of 2) [3/9/08 1:07:29 PM]

http://neuage.org/NYC/pages/photo5_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo7_jpg.htm
http://neuage.org/NYC/images/photo6_jpg.jpg
http://neuage.org/NYC/images/photo6_jpg.jpg


bike / photo6.jpg

http://neuage.org/NYC/pages/photo6_jpg.htm (2 of 2) [3/9/08 1:07:29 PM]



bike / photo7.jpg

bike/photo7.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo7_jpg.htm [3/9/08 1:07:30 PM]

http://neuage.org/NYC/pages/photo6_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo8_jpg.htm
http://neuage.org/NYC/images/photo7_jpg.jpg


bike / photo8.jpg

bike/photo8.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo8_jpg.htm [3/9/08 1:07:31 PM]

http://neuage.org/NYC/pages/photo7_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo9_jpg.htm
http://neuage.org/NYC/images/photo8_jpg.jpg


bike / photo9.jpg

bike/photo9.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/pages/photo9_jpg.htm [3/9/08 1:07:32 PM]

http://neuage.org/NYC/pages/photo8_jpg.htm
http://neuage.org/NYC/index.htm
http://neuage.org/NYC/pages/photo1_jpg.htm
http://neuage.org/NYC/images/photo9_jpg.jpg


v / building-crown.JPG

v/building-crown.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/building-crown_JPG.htm [3/9/08 1:07:33 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/table-girls_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/cars_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/building-crown_JPG.jpg


v / cars.JPG

v/cars.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/cars_JPG.htm [3/9/08 1:07:35 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/building-crown_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/cars2_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/cars_JPG.jpg


v / cars2.JPG

v/cars2.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/cars2_JPG.htm [3/9/08 1:07:37 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/cars_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/church-buildings_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/cars2_JPG.jpg


v / church-buildings.JPG

v/church-buildings.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/church-buildings_JPG.htm [3/9/08 1:07:38 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/cars2_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/dancer_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/church-buildings_JPG.jpg


v / dancer.JPG

v/dancer.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/dancer_JPG.htm [3/9/08 1:07:40 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/church-buildings_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/dancer_JPG.jpg


v / girl-water.JPG

v/girl-water.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water_JPG.htm [3/9/08 1:07:41 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/dancer_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water2_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/girl-water_JPG.jpg


v / girl-water2.JPG

v/girl-water2.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water2_JPG.htm [3/9/08 1:07:43 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water3_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/girl-water2_JPG.jpg


v / girl-water3.JPG

v/girl-water3.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water3_JPG.htm [3/9/08 1:07:46 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water2_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water4_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/girl-water3_JPG.jpg


v / girl-water4.JPG

v/girl-water4.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water4_JPG.htm [3/9/08 1:07:48 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water3_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water5_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/girl-water4_JPG.jpg


v / girl-water5.JPG

v/girl-water5.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water5_JPG.htm [3/9/08 1:07:50 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water4_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/Narda-crowd_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/girl-water5_JPG.jpg


v / Narda-crowd.JPG

v/Narda-crowd.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/Narda-crowd_JPG.htm [3/9/08 1:07:51 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/girl-water5_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/P1144303_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/Narda-crowd_JPG.jpg


v / P1144303.JPG

v/P1144303.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/P1144303_JPG.htm [3/9/08 1:07:52 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/Narda-crowd_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/P1144304_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/P1144303_JPG.jpg


v / P1144304.JPG

v/P1144304.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/P1144304_JPG.htm [3/9/08 1:07:54 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/P1144303_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo1-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/P1144304_JPG.jpg


v / photo1-carover.JPG

v/photo1-carover.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo1-carover_JPG.htm [3/9/08 1:07:55 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/P1144304_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo10-UN_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo1-carover_JPG.jpg


v / photo10-UN.JPG

v/photo10-UN.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo10-UN_JPG.htm [3/9/08 1:07:57 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo1-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo11-emigrant_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo10-UN_JPG.jpg


v / photo11-emigrant.JPG

v/photo11-emigrant.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo11-emigrant_JPG.htm [3/9/08 1:07:59 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo10-UN_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo12-PoliceVan_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo11-emigrant_JPG.jpg


v / photo12-PoliceVan.JPG

v/photo12-PoliceVan.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo12-PoliceVan_JPG.htm [3/9/08 1:08:00 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo11-emigrant_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo13-Empire_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo12-PoliceVan_JPG.jpg


v / photo13-Empire.JPG

v/photo13-Empire.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo13-Empire_JPG.htm [3/9/08 1:08:01 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo12-PoliceVan_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo14-Narda-liberty_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo13-Empire_JPG.jpg


v / photo14-Narda-liberty.JPG

v/photo14-Narda-liberty.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo14-Narda-liberty_JPG.htm [3/9/08 1:08:03 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo13-Empire_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo15-building_reflections_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo14-Narda-liberty_JPG.jpg


v / photo15-building_reflections.jpg

v/photo15-building_reflections.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo15-building_reflections_jpg.htm (1 of 2) [3/9/08 1:08:04 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo14-Narda-liberty_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo16-reflections_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo15-building_reflections_jpg.jpg
http://neuage.org/NYC/Columbus_Day_NYC/images/photo15-building_reflections_jpg.jpg


v / photo15-building_reflections.jpg

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo15-building_reflections_jpg.htm (2 of 2) [3/9/08 1:08:04 PM]



v / photo16-reflections.jpg

v/photo16-reflections.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo16-reflections_jpg.htm (1 of 2) [3/9/08 1:08:06 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo15-building_reflections_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo17-toys-round_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo16-reflections_jpg.jpg
http://neuage.org/NYC/Columbus_Day_NYC/images/photo16-reflections_jpg.jpg


v / photo16-reflections.jpg

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo16-reflections_jpg.htm (2 of 2) [3/9/08 1:08:06 PM]



v / photo17-toys-round.jpg

v/photo17-toys-round.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo17-toys-round_jpg.htm [3/9/08 1:08:07 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo16-reflections_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo18-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo17-toys-round_jpg.jpg


v / photo18-toys.jpg

v/photo18-toys.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo18-toys_jpg.htm [3/9/08 1:08:09 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo17-toys-round_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo19-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo18-toys_jpg.jpg


v / photo19-toys.jpg

v/photo19-toys.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo19-toys_jpg.htm [3/9/08 1:08:10 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo18-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo2-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo19-toys_jpg.jpg


v / photo2-carover.JPG

v/photo2-carover.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo2-carover_JPG.htm [3/9/08 1:08:14 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo19-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo20-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo2-carover_JPG.jpg


v / photo20-toys.jpg

v/photo20-toys.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo20-toys_jpg.htm [3/9/08 1:08:15 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo2-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo21-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo20-toys_jpg.jpg


v / photo21-toys.jpg

v/photo21-toys.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo21-toys_jpg.htm [3/9/08 1:08:17 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo20-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo22-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo21-toys_jpg.jpg


v / photo22-toys.jpg

v/photo22-toys.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo22-toys_jpg.htm [3/9/08 1:08:19 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo21-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo23-subway-entrance_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo22-toys_jpg.jpg


v / photo23-subway-entrance.JPG

v/photo23-subway-entrance.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo23-subway-entrance_JPG.htm [3/9/08 1:08:21 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo22-toys_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo24-buildings_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo23-subway-entrance_JPG.jpg


v / photo24-buildings.JPG

v/photo24-buildings.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo24-buildings_JPG.htm [3/9/08 1:08:24 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo23-subway-entrance_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo25-toys-boats_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo24-buildings_JPG.jpg


v / photo25-toys-boats.jpg

v/photo25-toys-boats.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo25-toys-boats_jpg.htm [3/9/08 1:08:26 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo24-buildings_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo26-narda-chair_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo25-toys-boats_jpg.jpg


v / photo26-narda-chair.JPG

v/photo26-narda-chair.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo26-narda-chair_JPG.htm [3/9/08 1:08:27 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo25-toys-boats_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo3-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo26-narda-chair_JPG.jpg


v / photo3-carover.JPG

v/photo3-carover.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo3-carover_JPG.htm [3/9/08 1:08:30 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo26-narda-chair_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo4-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo3-carover_JPG.jpg


v / photo4-carover.JPG

v/photo4-carover.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo4-carover_JPG.htm [3/9/08 1:08:34 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo3-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo5-c_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo4-carover_JPG.jpg


v / photo5-c.JPG

v/photo5-c.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo5-c_JPG.htm [3/9/08 1:08:36 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo4-carover_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo6-festival_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo5-c_JPG.jpg


v / photo6-festival.JPG

v/photo6-festival.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo6-festival_JPG.htm [3/9/08 1:08:38 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo5-c_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo7-building-crane_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo6-festival_JPG.jpg


v / photo7-building-crane.JPG

v/photo7-building-crane.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo7-building-crane_JPG.htm [3/9/08 1:08:39 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo6-festival_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo8-building-crane_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo7-building-crane_JPG.jpg


v / photo8-building-crane.jpg

v/photo8-building-crane.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo8-building-crane_jpg.htm (1 of 2) [3/9/08 1:08:41 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo7-building-crane_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/photo9-NardaPeace_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo8-building-crane_jpg.jpg
http://neuage.org/NYC/Columbus_Day_NYC/images/photo8-building-crane_jpg.jpg


v / photo8-building-crane.jpg

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo8-building-crane_jpg.htm (2 of 2) [3/9/08 1:08:41 PM]



v / photo9-NardaPeace.JPG

v/photo9-NardaPeace.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo9-NardaPeace_JPG.htm [3/9/08 1:08:43 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo8-building-crane_jpg.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/table-girl_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/photo9-NardaPeace_JPG.jpg


v / table-girl.JPG

v/table-girl.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/table-girl_JPG.htm [3/9/08 1:08:46 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/photo9-NardaPeace_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/table-girls_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/table-girl_JPG.jpg


v / table-girls.JPG

v/table-girls.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/Columbus_Day_NYC/pages/table-girls_JPG.htm [3/9/08 1:08:47 PM]

http://neuage.org/NYC/Columbus_Day_NYC/pages/table-girl_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/index.htm
http://neuage.org/NYC/Columbus_Day_NYC/pages/building-crown_JPG.htm
http://neuage.org/NYC/Columbus_Day_NYC/images/table-girls_JPG.jpg


g / city-bridge.JPG

g/city-bridge.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/city-bridge_JPG.htm [3/9/08 1:08:49 PM]

http://neuage.org/NYC/George/pages/under-bridge_jpg.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/from-bridge_JPG.htm
http://neuage.org/NYC/George/images/city-bridge_JPG.jpg


g / from-bridge.JPG

g/from-bridge.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/from-bridge_JPG.htm [3/9/08 1:08:50 PM]

http://neuage.org/NYC/George/pages/city-bridge_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/on-bridge_JPG.htm
http://neuage.org/NYC/George/images/from-bridge_JPG.jpg


g / on-bridge.JPG

g/on-bridge.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/on-bridge_JPG.htm [3/9/08 1:08:51 PM]

http://neuage.org/NYC/George/pages/from-bridge_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204333_JPG.htm
http://neuage.org/NYC/George/images/on-bridge_JPG.jpg


g / P1204333.JPG

g/P1204333.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204333_JPG.htm [3/9/08 1:08:52 PM]

http://neuage.org/NYC/George/pages/on-bridge_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204335_JPG.htm
http://neuage.org/NYC/George/images/P1204333_JPG.jpg


g / P1204335.JPG

g/P1204335.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204335_JPG.htm [3/9/08 1:08:54 PM]

http://neuage.org/NYC/George/pages/P1204333_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204336_JPG.htm
http://neuage.org/NYC/George/images/P1204335_JPG.jpg


g / P1204336.JPG

g/P1204336.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204336_JPG.htm [3/9/08 1:08:56 PM]

http://neuage.org/NYC/George/pages/P1204335_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204337_JPG.htm
http://neuage.org/NYC/George/images/P1204336_JPG.jpg


g / P1204337.JPG

g/P1204337.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204337_JPG.htm [3/9/08 1:08:58 PM]

http://neuage.org/NYC/George/pages/P1204336_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204339_JPG.htm
http://neuage.org/NYC/George/images/P1204337_JPG.jpg


g / P1204339.JPG

g/P1204339.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204339_JPG.htm [3/9/08 1:09:00 PM]

http://neuage.org/NYC/George/pages/P1204337_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204340_JPG.htm
http://neuage.org/NYC/George/images/P1204339_JPG.jpg


g / P1204340.JPG

g/P1204340.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204340_JPG.htm [3/9/08 1:09:01 PM]

http://neuage.org/NYC/George/pages/P1204339_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204342_JPG.htm
http://neuage.org/NYC/George/images/P1204340_JPG.jpg


g / P1204342.JPG

g/P1204342.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204342_JPG.htm [3/9/08 1:09:02 PM]

http://neuage.org/NYC/George/pages/P1204340_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204343_JPG.htm
http://neuage.org/NYC/George/images/P1204342_JPG.jpg


g / P1204343.JPG

g/P1204343.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204343_JPG.htm [3/9/08 1:09:05 PM]

http://neuage.org/NYC/George/pages/P1204342_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204344_JPG.htm
http://neuage.org/NYC/George/images/P1204343_JPG.jpg


g / P1204344.JPG

g/P1204344.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204344_JPG.htm [3/9/08 1:09:06 PM]

http://neuage.org/NYC/George/pages/P1204343_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204345_JPG.htm
http://neuage.org/NYC/George/images/P1204344_JPG.jpg


g / P1204345.JPG

g/P1204345.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204345_JPG.htm [3/9/08 1:09:08 PM]

http://neuage.org/NYC/George/pages/P1204344_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204346_JPG.htm
http://neuage.org/NYC/George/images/P1204345_JPG.jpg


g / P1204346.JPG

g/P1204346.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204346_JPG.htm [3/9/08 1:09:11 PM]

http://neuage.org/NYC/George/pages/P1204345_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204347_JPG.htm
http://neuage.org/NYC/George/images/P1204346_JPG.jpg


g / P1204347.JPG

g/P1204347.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204347_JPG.htm [3/9/08 1:09:13 PM]

http://neuage.org/NYC/George/pages/P1204346_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204348_JPG.htm
http://neuage.org/NYC/George/images/P1204347_JPG.jpg


g / P1204348.JPG

g/P1204348.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204348_JPG.htm [3/9/08 1:09:14 PM]

http://neuage.org/NYC/George/pages/P1204347_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204349_JPG.htm
http://neuage.org/NYC/George/images/P1204348_JPG.jpg


g / P1204349.JPG

g/P1204349.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204349_JPG.htm [3/9/08 1:09:16 PM]

http://neuage.org/NYC/George/pages/P1204348_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204351_JPG.htm
http://neuage.org/NYC/George/images/P1204349_JPG.jpg


g / P1204351.JPG

g/P1204351.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204351_JPG.htm [3/9/08 1:09:19 PM]

http://neuage.org/NYC/George/pages/P1204349_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204352_JPG.htm
http://neuage.org/NYC/George/images/P1204351_JPG.jpg


g / P1204352.JPG

g/P1204352.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204352_JPG.htm [3/9/08 1:09:20 PM]

http://neuage.org/NYC/George/pages/P1204351_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204353_JPG.htm
http://neuage.org/NYC/George/images/P1204352_JPG.jpg


g / P1204353.JPG

g/P1204353.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204353_JPG.htm [3/9/08 1:09:26 PM]

http://neuage.org/NYC/George/pages/P1204352_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204354_JPG.htm
http://neuage.org/NYC/George/images/P1204353_JPG.jpg


g / P1204354.JPG

g/P1204354.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204354_JPG.htm (1 of 2) [3/9/08 1:09:46 PM]

http://neuage.org/NYC/George/pages/P1204353_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204355_JPG.htm
http://neuage.org/NYC/George/images/P1204354_JPG.jpg
http://neuage.org/NYC/George/images/P1204354_JPG.jpg


g / P1204354.JPG

http://neuage.org/NYC/George/pages/P1204354_JPG.htm (2 of 2) [3/9/08 1:09:46 PM]



g / P1204355.JPG

g/P1204355.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204355_JPG.htm (1 of 2) [3/9/08 1:10:01 PM]

http://neuage.org/NYC/George/pages/P1204354_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204356_JPG.htm
http://neuage.org/NYC/George/images/P1204355_JPG.jpg
http://neuage.org/NYC/George/images/P1204355_JPG.jpg


g / P1204355.JPG

http://neuage.org/NYC/George/pages/P1204355_JPG.htm (2 of 2) [3/9/08 1:10:01 PM]



g / P1204356.JPG

g/P1204356.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204356_JPG.htm [3/9/08 1:10:02 PM]

http://neuage.org/NYC/George/pages/P1204355_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204359_JPG.htm
http://neuage.org/NYC/George/images/P1204356_JPG.jpg


g / P1204359.JPG

g/P1204359.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204359_JPG.htm [3/9/08 1:10:04 PM]

http://neuage.org/NYC/George/pages/P1204356_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204360_JPG.htm
http://neuage.org/NYC/George/images/P1204359_JPG.jpg


g / P1204360.JPG

g/P1204360.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204360_JPG.htm [3/9/08 1:10:06 PM]

http://neuage.org/NYC/George/pages/P1204359_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204363_JPG.htm
http://neuage.org/NYC/George/images/P1204360_JPG.jpg


g / P1204363.JPG

g/P1204363.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204363_JPG.htm [3/9/08 1:10:07 PM]

http://neuage.org/NYC/George/pages/P1204360_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1204364_JPG.htm
http://neuage.org/NYC/George/images/P1204363_JPG.jpg


g / P1204364.JPG

g/P1204364.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1204364_JPG.htm [3/9/08 1:10:08 PM]

http://neuage.org/NYC/George/pages/P1204363_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/P1214367_JPG.htm
http://neuage.org/NYC/George/images/P1204364_JPG.jpg


g / P1214367.JPG

g/P1214367.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/P1214367_JPG.htm [3/9/08 1:10:10 PM]

http://neuage.org/NYC/George/pages/P1204364_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/tunnel_JPG.htm
http://neuage.org/NYC/George/images/P1214367_JPG.jpg


g / tunnel.JPG

g/tunnel.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/tunnel_JPG.htm [3/9/08 1:10:11 PM]

http://neuage.org/NYC/George/pages/P1214367_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/under-bridge_jpg.htm
http://neuage.org/NYC/George/images/tunnel_JPG.jpg


g / under-bridge.jpg

g/under-bridge.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/George/pages/under-bridge_jpg.htm (1 of 2) [3/9/08 1:10:13 PM]

http://neuage.org/NYC/George/pages/tunnel_JPG.htm
http://neuage.org/NYC/George/index.htm
http://neuage.org/NYC/George/pages/city-bridge_JPG.htm
http://neuage.org/NYC/George/images/under-bridge_jpg.jpg
http://neuage.org/NYC/George/images/under-bridge_jpg.jpg


g / under-bridge.jpg

http://neuage.org/NYC/George/pages/under-bridge_jpg.htm (2 of 2) [3/9/08 1:10:13 PM]



graffiti photos (Brooklyn Hip Hop Show) Williamsburg Bridge Europe Ju...; (DUMBO - DownUnderManhattanBridgeOverpass) photos by Terrell Neuage

graffiti photos (Brooklyn Hip Hop Show) Williamsburg Bridge Europe July 2003 Queens NYC 
(November 2006) 

Graffiti Video clips - the number one train out of the Bronx/07 train to Flushing/F Train to Brooklyn; 
(DUMBO - DownUnderManhattanBridgeOverpass) / N - train from Times Square to Brooklyn over 

Manhattan Bridge

my youtube clips our videos and blogs and Brooklyn clips Tribeca Hip Hop 
this page updated 27/November 2006

Mexico graffiti Lycos ReMix 

Mexico video clips

Mexico subway Blind singers on subway Graffiti Mexico

(c) Terrell Neuage November 2006 

Other video servers with my clips uploaded (updated 29, April 2007 ) youtube / goggle / 
Eyespot  / SevenLoad / msnSOAPBOX / esnips /  Blip TV / bittorrent  /  vSocial / MySpace / 
Metacafe /  Mazooki /  Jumpcut  / Bolt.com   / Daily Motion / zippyvideos   / xanga   / hi5   /
Vimeo / PhotoBucket / LiveLeak / twango / veoh / videojug / sharkle / livevideo / digg / DropShots / 
motiono / clipshack / flukiest / yahoo / vmix / brightcove / 

http://neuage.org/graf/graffiti.html [3/9/08 1:10:17 PM]

http://neuage.org/NYC/graffiti/index
http://www.flickr.com/photos/44756228@N00/
http://neuage.org/graf/europe/03/index.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://ournews.mobi/01-train.html
http://ournews.mobi/07-train.html
http://ournews.mobi/f-train.html
http://neuage.org/NYC/hiphop.htm
http://ournews.mobi/f-train.htm
http://www.youtube.com/user/tneuage
http://ournews.mobi/album.htm
http://neuage.org/06.html
http://ournews.mobi/Tribeca.html
http://graffiti.ournews.mobi/
http://mix.lycos.com/mix/graffiti
http://mexico.ournews.mobi/video.htm
http://mexico.ournews.mobi/subway.htm
http://mexico.ournews.mobi/blind.htm
http://graffiti.ournews.mobi/
http://neuage.org/
http://www.digits.com/
http://www.youtube.com/user/tneuage
http://video.google.com/videosearch?q=neuage
http://eyespot.com/search?word=neuage&t=1168291408721
http://en.sevenload.com/users/neuage
http://soapbox.msn.com/?user=4655795804306782086
http://www.esnips.com/user/tneuage
http://grouper.com/Members/2034611
http://www.bittorrent.com/users/neuage/
http://www.vsocial.com/user/?d=106530
http://www.myspace.com/neuage
http://www.metacafe.com/user/2824717/saint_terrell/private/
http://www.mazooki.com/search_result.php?search_id=neuage&search_typ=search_videos
http://jumpcut.com/neuage
http://www.bolt.com/neuage
http://www.dailymotion.com/neuage
http://neuage.zippyvideos.com/
http://premium.xanga.com/tneuage
http://neuage.hi5.com/
http://www.vimeo.com/user:149441
http://s145.photobucket.com/albums/r236/neuage/
http://www.liveleak.com/
http://www.twango.com/channel/neuage.public
http://www.veoh.com/users/neuage
http://www.videojug.com/user/neuage/myjug
http://www.sharkle.com/member/neuage/
http://www.livevideo.com/neuage
http://digg.com/users/neuage/edit
http://www.dropshots.com/neuage
http://www.motiono.com/neuage
http://www.clipshack.com/34332
http://www.flukiest.com/p/neuage
http://video.yahoo.com/video/profile?sid=413978
http://www.vmix.com/neuage/
http://www.brightcove.com/channel.jsp?channel=769316457


graffiti europe 2003

graffiti europe 2003

other graffiti photos (Brooklyn Hip Hop Show) Williamsburg Bridge Queens NYC (11-2006)

Video clips - the number one train out of the Bronx/07 train to Flusing/F Train to Brooklyn; (DUMBO - 
DownUnderManhattanBridgeOverpass)

my youtube clips our videos and blogs and Brooklyn clips  
this page updated 27/November 2006

 

  
amsterdam-graffiti.jpg

  
amsterdam.jpg

  
barcelona.jpg

  
barcelonaN-T.jpg

  
bush.jpg

  
hamburg-alley.jpg

  
hamburg-shop.jpg

  
hamburg-shop2.jpg

  
hamburg-shop_closeup.jpg

  
hamburg-smokes.jpg

  
hamburg-street.jpg

  
hamburg-street2.jpg

  
hip-hop_seoul.jpg

  
mcdonalds.jpg

  
mois-window.jpg

  
riverside.jpg

  
seoul-terrell.jpg

http://neuage.org/graf/europe/03/index.htm [3/9/08 1:10:20 PM]

http://neuage.org/graf/graffiti.html
http://neuage.org/NYC/graffiti/index
http://www.flickr.com/photos/44756228@N00/
http://neuage.org/NYC/12Nov06/graf/index.htm
http://ournews.mobi/01-train.html
http://ournews.mobi/07-train.html
http://ournews.mobi/f-train.html
http://neuage.org/NYC/hiphop.htm
http://www.youtube.com/user/tneuage
http://ournews.mobi/album.htm
http://ournews.mobi/album.htm
http://neuage.org/06.html
http://neuage.org/graf/europe/03/pages/amsterdam-graffiti_jpg.htm
http://neuage.org/graf/europe/03/pages/amsterdam_jpg.htm
http://neuage.org/graf/europe/03/pages/barcelona_jpg.htm
http://neuage.org/graf/europe/03/pages/barcelonaN-T_jpg.htm
http://neuage.org/graf/europe/03/pages/bush_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-alley_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-shop_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-shop2_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-shop_closeup_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-smokes_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-street_jpg.htm
http://neuage.org/graf/europe/03/pages/hamburg-street2_jpg.htm
http://neuage.org/graf/europe/03/pages/hip-hop_seoul_jpg.htm
http://neuage.org/graf/europe/03/pages/mcdonalds_jpg.htm
http://neuage.org/graf/europe/03/pages/mois-window_jpg.htm
http://neuage.org/graf/europe/03/pages/riverside_jpg.htm
http://neuage.org/graf/europe/03/pages/seoul-terrell_jpg.htm


Queens November 12 2006 / P2174380.JPG

Queens November 12 2006/P2174380.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174380_JPG.htm [3/9/08 1:10:22 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174398_jpg.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174381_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174380_JPG.jpg


Queens November 12 2006 / P2174381.JPG

Queens November 12 2006/P2174381.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174381_JPG.htm [3/9/08 1:10:24 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174380_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174382_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174381_JPG.jpg


Queens November 12 2006 / P2174382.JPG

Queens November 12 2006/P2174382.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174382_JPG.htm [3/9/08 1:10:25 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174381_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174383_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174382_JPG.jpg


Queens November 12 2006 / P2174383.JPG

Queens November 12 2006/P2174383.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174383_JPG.htm [3/9/08 1:10:27 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174382_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174384_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174383_JPG.jpg


Queens November 12 2006 / P2174384.JPG

Queens November 12 2006/P2174384.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174384_JPG.htm [3/9/08 1:10:28 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174383_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174385_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174384_JPG.jpg


Queens November 12 2006 / P2174385.JPG

Queens November 12 2006/P2174385.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174385_JPG.htm [3/9/08 1:10:31 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174384_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174386_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174385_JPG.jpg


Queens November 12 2006 / P2174386.JPG

Queens November 12 2006/P2174386.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174386_JPG.htm [3/9/08 1:10:33 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174385_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174387_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174386_JPG.jpg


Queens November 12 2006 / P2174387.JPG

Queens November 12 2006/P2174387.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174387_JPG.htm [3/9/08 1:10:35 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174386_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174388_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174387_JPG.jpg


Queens November 12 2006 / P2174388.JPG

Queens November 12 2006/P2174388.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174388_JPG.htm [3/9/08 1:10:37 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174387_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174389_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174388_JPG.jpg


Queens November 12 2006 / P2174389.JPG

Queens November 12 2006/P2174389.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174389_JPG.htm [3/9/08 1:10:38 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174388_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174390_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174389_JPG.jpg


Queens November 12 2006 / P2174390.JPG

Queens November 12 2006/P2174390.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174390_JPG.htm [3/9/08 1:10:40 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174389_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174391_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174390_JPG.jpg


Queens November 12 2006 / P2174391.JPG

Queens November 12 2006/P2174391.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174391_JPG.htm [3/9/08 1:10:41 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174390_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174392_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174391_JPG.jpg


Queens November 12 2006 / P2174392.JPG

Queens November 12 2006/P2174392.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174392_JPG.htm [3/9/08 1:10:43 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174391_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174393_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174392_JPG.jpg


Queens November 12 2006 / P2174393.JPG

Queens November 12 2006/P2174393.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174393_JPG.htm [3/9/08 1:10:44 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174392_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174394_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174393_JPG.jpg


Queens November 12 2006 / P2174394.JPG

Queens November 12 2006/P2174394.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174394_JPG.htm [3/9/08 1:10:46 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174393_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174395_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174394_JPG.jpg


Queens November 12 2006 / P2174395.JPG

Queens November 12 2006/P2174395.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174395_JPG.htm [3/9/08 1:10:47 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174394_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174396_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174395_JPG.jpg


Queens November 12 2006 / P2174396.JPG

Queens November 12 2006/P2174396.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174396_JPG.htm [3/9/08 1:10:49 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174395_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174397_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174396_JPG.jpg


Queens November 12 2006 / P2174397.JPG

Queens November 12 2006/P2174397.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174397_JPG.htm [3/9/08 1:10:51 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174396_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174398_jpg.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174397_JPG.jpg


Queens November 12 2006 / P2174398.jpg

Queens November 12 2006/P2174398.jpg

Previous | Home | Next 
 

 

 

http://neuage.org/NYC/12Nov06/graf/pages/P2174398_jpg.htm [3/9/08 1:10:53 PM]

http://neuage.org/NYC/12Nov06/graf/pages/P2174397_JPG.htm
http://neuage.org/NYC/12Nov06/graf/index.htm
http://neuage.org/NYC/12Nov06/graf/pages/P2174380_JPG.htm
http://neuage.org/NYC/12Nov06/graf/images/P2174398_jpg.jpg


Paris Christmas December 25 2005, video, by, Terrell Neuage, for, ournewsdotmobi

Paris Christmas December 25 2005

Home ournews 

site (c) Terrell Neuage November 14, 2006

  

http://neuage.org/album/Paris05.htm [3/9/08 1:10:53 PM]

http://ournews.mobi/album.htm
http://ournews.mobi/
http://neuage.org/


PARIS Christmas week 2005 / -Chartres.JPG

PARIS Christmas week 2005/-Chartres.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/-Chartres_JPG.htm [3/9/08 1:10:55 PM]

http://neuage.org/Paris/pages/window-SainteChapelle_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/11th-A_JPG.htm
http://neuage.org/Paris/images/-Chartres_JPG.jpg


PARIS Christmas week 2005 / 11th-A.JPG

PARIS Christmas week 2005/11th-A.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/11th-A_JPG.htm [3/9/08 1:10:57 PM]

http://neuage.org/Paris/pages/-Chartres_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Another-Chartres-Street_JPG.htm
http://neuage.org/Paris/images/11th-A_JPG.jpg


PARIS Christmas week 2005 / Another-Chartres-Street.JPG

PARIS Christmas week 2005/Another-Chartres-Street.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Another-Chartres-Street_JPG.htm [3/9/08 1:10:58 PM]

http://neuage.org/Paris/pages/11th-A_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/apartment-window_JPG.htm
http://neuage.org/Paris/images/Another-Chartres-Street_JPG.jpg


PARIS Christmas week 2005 / apartment-window.JPG

PARIS Christmas week 2005/apartment-window.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/apartment-window_JPG.htm [3/9/08 1:11:00 PM]

http://neuage.org/Paris/pages/Another-Chartres-Street_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Canal-Chartres_JPG.htm
http://neuage.org/Paris/images/apartment-window_JPG.jpg


PARIS Christmas week 2005 / Canal-Chartres.JPG

PARIS Christmas week 2005/Canal-Chartres.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Canal-Chartres_JPG.htm [3/9/08 1:11:01 PM]

http://neuage.org/Paris/pages/apartment-window_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Carrousel-bridge_JPG.htm
http://neuage.org/Paris/images/Canal-Chartres_JPG.jpg


PARIS Christmas week 2005 / Carrousel-bridge.JPG

PARIS Christmas week 2005/Carrousel-bridge.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Carrousel-bridge_JPG.htm [3/9/08 1:11:03 PM]

http://neuage.org/Paris/pages/Canal-Chartres_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/cathedral-chartres_JPG.htm
http://neuage.org/Paris/images/Carrousel-bridge_JPG.jpg


PARIS Christmas week 2005 / cathedral-chartres.JPG

PARIS Christmas week 2005/cathedral-chartres.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/cathedral-chartres_JPG.htm [3/9/08 1:11:05 PM]

http://neuage.org/Paris/pages/Carrousel-bridge_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Chartres--_JPG.htm
http://neuage.org/Paris/images/cathedral-chartres_JPG.jpg


PARIS Christmas week 2005 / Chartres--.JPG

PARIS Christmas week 2005/Chartres--.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Chartres--_JPG.htm [3/9/08 1:11:06 PM]

http://neuage.org/Paris/pages/cathedral-chartres_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Chartres-_JPG.htm
http://neuage.org/Paris/images/Chartres--_JPG.jpg


PARIS Christmas week 2005 / Chartres-.JPG

PARIS Christmas week 2005/Chartres-.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Chartres-_JPG.htm [3/9/08 1:11:07 PM]

http://neuage.org/Paris/pages/Chartres--_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Chartres-canal-3_JPG.htm
http://neuage.org/Paris/images/Chartres-_JPG.jpg


PARIS Christmas week 2005 / Chartres-canal-3.JPG

PARIS Christmas week 2005/Chartres-canal-3.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Chartres-canal-3_JPG.htm [3/9/08 1:11:09 PM]

http://neuage.org/Paris/pages/Chartres-_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Chartres-Cedex_JPG.htm
http://neuage.org/Paris/images/Chartres-canal-3_JPG.jpg


PARIS Christmas week 2005 / Chartres-Cedex.JPG

PARIS Christmas week 2005/Chartres-Cedex.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Chartres-Cedex_JPG.htm [3/9/08 1:11:11 PM]

http://neuage.org/Paris/pages/Chartres-canal-3_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Chartres-hill_JPG.htm
http://neuage.org/Paris/images/Chartres-Cedex_JPG.jpg


PARIS Christmas week 2005 / Chartres-hill.JPG

PARIS Christmas week 2005/Chartres-hill.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Chartres-hill_JPG.htm [3/9/08 1:11:13 PM]

http://neuage.org/Paris/pages/Chartres-Cedex_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Chartres3_JPG.htm
http://neuage.org/Paris/images/Chartres-hill_JPG.jpg


PARIS Christmas week 2005 / Chartres3.JPG

PARIS Christmas week 2005/Chartres3.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Chartres3_JPG.htm [3/9/08 1:11:14 PM]

http://neuage.org/Paris/pages/Chartres-hill_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/ChartresCathedral-24-Cloitre-Notra-Dame_JPG.htm
http://neuage.org/Paris/images/Chartres3_JPG.jpg


PARIS Christmas week 2005 / ChartresCathedral-24-Cloitre-Notra-Dame.JPG

PARIS Christmas week 2005/ChartresCathedral-24-Cloitre-Notra-Dame.
JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/ChartresCathedral-24-Cloitre-Notra-Dame_JPG.htm [3/9/08 1:11:16 PM]

http://neuage.org/Paris/pages/Chartres3_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/ChartresStreets_JPG.htm
http://neuage.org/Paris/images/ChartresCathedral-24-Cloitre-Notra-Dame_JPG.jpg


PARIS Christmas week 2005 / ChartresStreets.JPG

PARIS Christmas week 2005/ChartresStreets.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/ChartresStreets_JPG.htm [3/9/08 1:11:17 PM]

http://neuage.org/Paris/pages/ChartresCathedral-24-Cloitre-Notra-Dame_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Christmas-Ave-Des-Champs-Elysees_JPG.htm
http://neuage.org/Paris/images/ChartresStreets_JPG.jpg


PARIS Christmas week 2005 / Christmas-Ave-Des-Champs-Elysees.JPG

PARIS Christmas week 2005/Christmas-Ave-Des-Champs-Elysees.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Christmas-Ave-Des-Champs-Elysees_JPG.htm [3/9/08 1:11:18 PM]

http://neuage.org/Paris/pages/ChartresStreets_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Christmas-Day_JPG.htm
http://neuage.org/Paris/images/Christmas-Ave-Des-Champs-Elysees_JPG.jpg


PARIS Christmas week 2005 / Christmas-Day.JPG

PARIS Christmas week 2005/Christmas-Day.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Christmas-Day_JPG.htm [3/9/08 1:11:20 PM]

http://neuage.org/Paris/pages/Christmas-Ave-Des-Champs-Elysees_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Conciergerie_JPG.htm
http://neuage.org/Paris/images/Christmas-Day_JPG.jpg


PARIS Christmas week 2005 / Conciergerie.JPG

PARIS Christmas week 2005/Conciergerie.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Conciergerie_JPG.htm [3/9/08 1:11:21 PM]

http://neuage.org/Paris/pages/Christmas-Day_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-10_JPG.htm
http://neuage.org/Paris/images/Conciergerie_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-10.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-10.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-10_JPG.htm [3/9/08 1:11:23 PM]

http://neuage.org/Paris/pages/Conciergerie_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-11_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-10_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-11.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-11.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-11_JPG.htm [3/9/08 1:11:24 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-10_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-12_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-11_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-12.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-12.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-12_JPG.htm (1 of 2) [3/9/08 1:11:25 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-11_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-13_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-12_JPG.jpg
http://neuage.org/Paris/images/Dali-Espace-Montmartre-12_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-12.JPG

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-12_JPG.htm (2 of 2) [3/9/08 1:11:25 PM]



PARIS Christmas week 2005 / Dali-Espace-Montmartre-13.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-13.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-13_JPG.htm [3/9/08 1:11:26 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-12_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-14_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-13_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-14.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-14.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-14_JPG.htm (1 of 2) [3/9/08 1:11:28 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-13_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-15_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-14_JPG.jpg
http://neuage.org/Paris/images/Dali-Espace-Montmartre-14_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-14.JPG

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-14_JPG.htm (2 of 2) [3/9/08 1:11:28 PM]



PARIS Christmas week 2005 / Dali-Espace-Montmartre-15.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-15.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-15_JPG.htm [3/9/08 1:11:30 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-14_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-16_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-15_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-16.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-16.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-16_JPG.htm [3/9/08 1:11:31 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-15_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-4_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-16_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-4.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-4.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-4_JPG.htm [3/9/08 1:11:33 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-16_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-5_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-4_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-5.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-5.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-5_JPG.htm (1 of 2) [3/9/08 1:11:34 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-4_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-7_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-5_JPG.jpg
http://neuage.org/Paris/images/Dali-Espace-Montmartre-5_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-5.JPG

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-5_JPG.htm (2 of 2) [3/9/08 1:11:34 PM]



PARIS Christmas week 2005 / Dali-Espace-Montmartre-7.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-7.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-7_JPG.htm [3/9/08 1:11:35 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-5_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-8_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-7_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-8.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-8.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-8_JPG.htm [3/9/08 1:11:37 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-7_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre-9_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-8_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre-9.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre-9.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-9_JPG.htm [3/9/08 1:11:38 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-8_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-Espace-Montmartre_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre-9_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre.JPG

PARIS Christmas week 2005/Dali-Espace-Montmartre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-Espace-Montmartre_JPG.htm (1 of 2) [3/9/08 1:11:39 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre-9_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Dali-musee_JPG.htm
http://neuage.org/Paris/images/Dali-Espace-Montmartre_JPG.jpg
http://neuage.org/Paris/images/Dali-Espace-Montmartre_JPG.jpg


PARIS Christmas week 2005 / Dali-Espace-Montmartre.JPG

http://neuage.org/Paris/pages/Dali-Espace-Montmartre_JPG.htm (2 of 2) [3/9/08 1:11:39 PM]



PARIS Christmas week 2005 / Dali-musee.JPG

PARIS Christmas week 2005/Dali-musee.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Dali-musee_JPG.htm [3/9/08 1:11:40 PM]

http://neuage.org/Paris/pages/Dali-Espace-Montmartre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/frozen-at-louvre_JPG.htm
http://neuage.org/Paris/images/Dali-musee_JPG.jpg


PARIS Christmas week 2005 / frozen-at-louvre.JPG

PARIS Christmas week 2005/frozen-at-louvre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/frozen-at-louvre_JPG.htm [3/9/08 1:11:42 PM]

http://neuage.org/Paris/pages/Dali-musee_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/grafitti-Paris_JPG.htm
http://neuage.org/Paris/images/frozen-at-louvre_JPG.jpg


PARIS Christmas week 2005 / grafitti-Paris.JPG

PARIS Christmas week 2005/grafitti-Paris.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/grafitti-Paris_JPG.htm [3/9/08 1:11:43 PM]

http://neuage.org/Paris/pages/frozen-at-louvre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/hallway-outside-renovations_JPG.htm
http://neuage.org/Paris/images/grafitti-Paris_JPG.jpg


PARIS Christmas week 2005 / hallway-outside-renovations.JPG

PARIS Christmas week 2005/hallway-outside-renovations.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/hallway-outside-renovations_JPG.htm [3/9/08 1:11:46 PM]

http://neuage.org/Paris/pages/grafitti-Paris_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Lourve-restlessdancers_JPG.htm
http://neuage.org/Paris/images/hallway-outside-renovations_JPG.jpg


PARIS Christmas week 2005 / Lourve-restlessdancers.JPG

PARIS Christmas week 2005/Lourve-restlessdancers.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Lourve-restlessdancers_JPG.htm [3/9/08 1:11:47 PM]

http://neuage.org/Paris/pages/hallway-outside-renovations_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Louvre-ceiling_JPG.htm
http://neuage.org/Paris/images/Lourve-restlessdancers_JPG.jpg


PARIS Christmas week 2005 / Louvre-ceiling.JPG

PARIS Christmas week 2005/Louvre-ceiling.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Louvre-ceiling_JPG.htm [3/9/08 1:11:49 PM]

http://neuage.org/Paris/pages/Lourve-restlessdancers_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Montmartre-artists_JPG.htm
http://neuage.org/Paris/images/Louvre-ceiling_JPG.jpg


PARIS Christmas week 2005 / Montmartre-artists.JPG

PARIS Christmas week 2005/Montmartre-artists.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Montmartre-artists_JPG.htm [3/9/08 1:11:51 PM]

http://neuage.org/Paris/pages/Louvre-ceiling_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Montmartre-Shopping_JPG.htm
http://neuage.org/Paris/images/Montmartre-artists_JPG.jpg


PARIS Christmas week 2005 / Montmartre-Shopping.JPG

PARIS Christmas week 2005/Montmartre-Shopping.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Montmartre-Shopping_JPG.htm [3/9/08 1:11:52 PM]

http://neuage.org/Paris/pages/Montmartre-artists_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Montmartre_JPG.htm
http://neuage.org/Paris/images/Montmartre-Shopping_JPG.jpg


PARIS Christmas week 2005 / Montmartre.JPG

PARIS Christmas week 2005/Montmartre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Montmartre_JPG.htm [3/9/08 1:11:54 PM]

http://neuage.org/Paris/pages/Montmartre-Shopping_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Montmartre3_JPG.htm
http://neuage.org/Paris/images/Montmartre_JPG.jpg


PARIS Christmas week 2005 / Montmartre3.JPG

PARIS Christmas week 2005/Montmartre3.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Montmartre3_JPG.htm [3/9/08 1:11:56 PM]

http://neuage.org/Paris/pages/Montmartre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Moulin-Rouge_JPG.htm
http://neuage.org/Paris/images/Montmartre3_JPG.jpg


PARIS Christmas week 2005 / Moulin-Rouge.JPG

PARIS Christmas week 2005/Moulin-Rouge.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Moulin-Rouge_JPG.htm [3/9/08 1:11:57 PM]

http://neuage.org/Paris/pages/Montmartre3_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Musee-boulevard-de-Clichy_JPG.htm
http://neuage.org/Paris/images/Moulin-Rouge_JPG.jpg


PARIS Christmas week 2005 / Napoleon-bed.JPG

PARIS Christmas week 2005/Napoleon-bed.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Napoleon-bed_JPG.htm [3/9/08 1:11:58 PM]

http://neuage.org/Paris/pages/Musee-boulevard-de-Clichy_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Napoleon-table_JPG.htm
http://neuage.org/Paris/images/Napoleon-bed_JPG.jpg


PARIS Christmas week 2005 / Napoleon-table.JPG

PARIS Christmas week 2005/Napoleon-table.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Napoleon-table_JPG.htm [3/9/08 1:12:00 PM]

http://neuage.org/Paris/pages/Napoleon-bed_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Narda-ChartreFrance_JPG.htm
http://neuage.org/Paris/images/Napoleon-table_JPG.jpg


PARIS Christmas week 2005 / Narda-ChartreFrance.JPG

PARIS Christmas week 2005/Narda-ChartreFrance.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Narda-ChartreFrance_JPG.htm (1 of 2) [3/9/08 1:12:02 PM]

http://neuage.org/Paris/pages/Napoleon-table_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Notre-Dame_JPG.htm
http://neuage.org/Paris/images/Narda-ChartreFrance_JPG.jpg
http://neuage.org/Paris/images/Narda-ChartreFrance_JPG.jpg


PARIS Christmas week 2005 / Narda-ChartreFrance.JPG

http://neuage.org/Paris/pages/Narda-ChartreFrance_JPG.htm (2 of 2) [3/9/08 1:12:02 PM]



PARIS Christmas week 2005 / Notre-Dame.JPG

PARIS Christmas week 2005/Notre-Dame.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Notre-Dame_JPG.htm (1 of 2) [3/9/08 1:12:07 PM]

http://neuage.org/Paris/pages/Narda-ChartreFrance_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/our-apartment-dining_JPG.htm
http://neuage.org/Paris/images/Notre-Dame_JPG.jpg
http://neuage.org/Paris/images/Notre-Dame_JPG.jpg


PARIS Christmas week 2005 / Notre-Dame.JPG

http://neuage.org/Paris/pages/Notre-Dame_JPG.htm (2 of 2) [3/9/08 1:12:07 PM]



PARIS Christmas week 2005 / our-apartment-dining.JPG

PARIS Christmas week 2005/our-apartment-dining.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/our-apartment-dining_JPG.htm [3/9/08 1:12:08 PM]

http://neuage.org/Paris/pages/Notre-Dame_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/our-apartment-outside_JPG.htm
http://neuage.org/Paris/images/our-apartment-dining_JPG.jpg


PARIS Christmas week 2005 / our-apartment-outside.JPG

PARIS Christmas week 2005/our-apartment-outside.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/our-apartment-outside_JPG.htm [3/9/08 1:12:09 PM]

http://neuage.org/Paris/pages/our-apartment-dining_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/our-kitchen_JPG.htm
http://neuage.org/Paris/images/our-apartment-outside_JPG.jpg


PARIS Christmas week 2005 / our-kitchen.JPG

PARIS Christmas week 2005/our-kitchen.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/our-kitchen_JPG.htm (1 of 2) [3/9/08 1:12:11 PM]

http://neuage.org/Paris/pages/our-apartment-outside_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Our-Metro_stop_JPG.htm
http://neuage.org/Paris/images/our-kitchen_JPG.jpg
http://neuage.org/Paris/images/our-kitchen_JPG.jpg


PARIS Christmas week 2005 / our-kitchen.JPG

http://neuage.org/Paris/pages/our-kitchen_JPG.htm (2 of 2) [3/9/08 1:12:11 PM]



PARIS Christmas week 2005 / Our-Metro_stop.JPG

PARIS Christmas week 2005/Our-Metro_stop.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Our-Metro_stop_JPG.htm [3/9/08 1:12:13 PM]

http://neuage.org/Paris/pages/our-kitchen_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/our-street-Rue-Jean-Pierre-Timbaud_JPG.htm
http://neuage.org/Paris/images/Our-Metro_stop_JPG.jpg


PARIS Christmas week 2005 / our-street-Rue-Jean-Pierre-Timbaud.JPG

PARIS Christmas week 2005/our-street-Rue-Jean-Pierre-Timbaud.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/our-street-Rue-Jean-Pierre-Timbaud_JPG.htm [3/9/08 1:12:14 PM]

http://neuage.org/Paris/pages/Our-Metro_stop_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Paris-Metro_JPG.htm
http://neuage.org/Paris/images/our-street-Rue-Jean-Pierre-Timbaud_JPG.jpg


PARIS Christmas week 2005 / Paris-Metro.JPG

PARIS Christmas week 2005/Paris-Metro.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Paris-Metro_JPG.htm [3/9/08 1:12:15 PM]

http://neuage.org/Paris/pages/our-street-Rue-Jean-Pierre-Timbaud_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Paris_Metro_JPG.htm
http://neuage.org/Paris/images/Paris-Metro_JPG.jpg


PARIS Christmas week 2005 / Paris_Metro.JPG

PARIS Christmas week 2005/Paris_Metro.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Paris_Metro_JPG.htm [3/9/08 1:12:17 PM]

http://neuage.org/Paris/pages/Paris-Metro_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Parmentier-Metro_JPG.htm
http://neuage.org/Paris/images/Paris_Metro_JPG.jpg


PARIS Christmas week 2005 / Parmentier-Metro.JPG

PARIS Christmas week 2005/Parmentier-Metro.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Parmentier-Metro_JPG.htm [3/9/08 1:12:18 PM]

http://neuage.org/Paris/pages/Paris_Metro_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263366_JPG.htm
http://neuage.org/Paris/images/Parmentier-Metro_JPG.jpg


PARIS Christmas week 2005 / PC263366.JPG

PARIS Christmas week 2005/PC263366.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263366_JPG.htm [3/9/08 1:12:20 PM]

http://neuage.org/Paris/pages/Parmentier-Metro_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263390_JPG.htm
http://neuage.org/Paris/images/PC263366_JPG.jpg


PARIS Christmas week 2005 / PC263390.JPG

PARIS Christmas week 2005/PC263390.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263390_JPG.htm [3/9/08 1:12:21 PM]

http://neuage.org/Paris/pages/PC263366_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263392_JPG.htm
http://neuage.org/Paris/images/PC263390_JPG.jpg


PARIS Christmas week 2005 / PC263392.JPG

PARIS Christmas week 2005/PC263392.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263392_JPG.htm [3/9/08 1:12:23 PM]

http://neuage.org/Paris/pages/PC263390_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263396_JPG.htm
http://neuage.org/Paris/images/PC263392_JPG.jpg


PARIS Christmas week 2005 / PC263396.JPG

PARIS Christmas week 2005/PC263396.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263396_JPG.htm (1 of 2) [3/9/08 1:12:24 PM]

http://neuage.org/Paris/pages/PC263392_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263408_JPG.htm
http://neuage.org/Paris/images/PC263396_JPG.jpg
http://neuage.org/Paris/images/PC263396_JPG.jpg


PARIS Christmas week 2005 / PC263396.JPG

http://neuage.org/Paris/pages/PC263396_JPG.htm (2 of 2) [3/9/08 1:12:24 PM]



PARIS Christmas week 2005 / PC263408.JPG

PARIS Christmas week 2005/PC263408.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263408_JPG.htm [3/9/08 1:12:26 PM]

http://neuage.org/Paris/pages/PC263396_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263423_JPG.htm
http://neuage.org/Paris/images/PC263408_JPG.jpg


PARIS Christmas week 2005 / PC263423.JPG

PARIS Christmas week 2005/PC263423.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263423_JPG.htm [3/9/08 1:12:27 PM]

http://neuage.org/Paris/pages/PC263408_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC263429_JPG.htm
http://neuage.org/Paris/images/PC263423_JPG.jpg


PARIS Christmas week 2005 / PC263429.JPG

PARIS Christmas week 2005/PC263429.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC263429_JPG.htm [3/9/08 1:12:28 PM]

http://neuage.org/Paris/pages/PC263423_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC273447_JPG.htm
http://neuage.org/Paris/images/PC263429_JPG.jpg


PARIS Christmas week 2005 / PC273447.JPG

PARIS Christmas week 2005/PC273447.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC273447_JPG.htm (1 of 2) [3/9/08 1:12:30 PM]

http://neuage.org/Paris/pages/PC263429_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC273448_JPG.htm
http://neuage.org/Paris/images/PC273447_JPG.jpg
http://neuage.org/Paris/images/PC273447_JPG.jpg


PARIS Christmas week 2005 / PC273447.JPG

http://neuage.org/Paris/pages/PC273447_JPG.htm (2 of 2) [3/9/08 1:12:30 PM]



PARIS Christmas week 2005 / PC273448.JPG

PARIS Christmas week 2005/PC273448.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC273448_JPG.htm (1 of 2) [3/9/08 1:12:32 PM]

http://neuage.org/Paris/pages/PC273447_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC273465_JPG.htm
http://neuage.org/Paris/images/PC273448_JPG.jpg
http://neuage.org/Paris/images/PC273448_JPG.jpg


PARIS Christmas week 2005 / PC273448.JPG

http://neuage.org/Paris/pages/PC273448_JPG.htm (2 of 2) [3/9/08 1:12:32 PM]



PARIS Christmas week 2005 / PC273465.JPG

PARIS Christmas week 2005/PC273465.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC273465_JPG.htm [3/9/08 1:12:33 PM]

http://neuage.org/Paris/pages/PC273448_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC273470_JPG.htm
http://neuage.org/Paris/images/PC273465_JPG.jpg


PARIS Christmas week 2005 / PC273470.JPG

PARIS Christmas week 2005/PC273470.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC273470_JPG.htm [3/9/08 1:12:35 PM]

http://neuage.org/Paris/pages/PC273465_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC283522_JPG.htm
http://neuage.org/Paris/images/PC273470_JPG.jpg


PARIS Christmas week 2005 / PC283522.JPG

PARIS Christmas week 2005/PC283522.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC283522_JPG.htm [3/9/08 1:12:36 PM]

http://neuage.org/Paris/pages/PC273470_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC293532_JPG.htm
http://neuage.org/Paris/images/PC283522_JPG.jpg


PARIS Christmas week 2005 / PC293532.JPG

PARIS Christmas week 2005/PC293532.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC293532_JPG.htm [3/9/08 1:12:37 PM]

http://neuage.org/Paris/pages/PC283522_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC293578_JPG.htm
http://neuage.org/Paris/images/PC293532_JPG.jpg


PARIS Christmas week 2005 / PC293578.JPG

PARIS Christmas week 2005/PC293578.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC293578_JPG.htm [3/9/08 1:12:39 PM]

http://neuage.org/Paris/pages/PC293532_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC303613_JPG.htm
http://neuage.org/Paris/images/PC293578_JPG.jpg


PARIS Christmas week 2005 / PC303613.JPG

PARIS Christmas week 2005/PC303613.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC303613_JPG.htm [3/9/08 1:12:41 PM]

http://neuage.org/Paris/pages/PC293578_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/PC313630_JPG.htm
http://neuage.org/Paris/images/PC303613_JPG.jpg


PARIS Christmas week 2005 / PC313630.JPG

PARIS Christmas week 2005/PC313630.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/PC313630_JPG.htm [3/9/08 1:12:43 PM]

http://neuage.org/Paris/pages/PC303613_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Point_Neuf_JPG.htm
http://neuage.org/Paris/images/PC313630_JPG.jpg


PARIS Christmas week 2005 / Point_Neuf.JPG

PARIS Christmas week 2005/Point_Neuf.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Point_Neuf_JPG.htm [3/9/08 1:12:44 PM]

http://neuage.org/Paris/pages/PC313630_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Richelieu-Louvre_JPG.htm
http://neuage.org/Paris/images/Point_Neuf_JPG.jpg


PARIS Christmas week 2005 / Richelieu-Louvre.JPG

PARIS Christmas week 2005/Richelieu-Louvre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Richelieu-Louvre_JPG.htm [3/9/08 1:12:46 PM]

http://neuage.org/Paris/pages/Point_Neuf_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Rue-Coustou-Montmartre_JPG.htm
http://neuage.org/Paris/images/Richelieu-Louvre_JPG.jpg


PARIS Christmas week 2005 / Rue-Coustou-Montmartre.JPG

PARIS Christmas week 2005/Rue-Coustou-Montmartre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Rue-Coustou-Montmartre_JPG.htm [3/9/08 1:12:47 PM]

http://neuage.org/Paris/pages/Richelieu-Louvre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Sainte-Chapelle-3_JPG.htm
http://neuage.org/Paris/images/Rue-Coustou-Montmartre_JPG.jpg


PARIS Christmas week 2005 / Sainte-Chapelle-3.JPG

PARIS Christmas week 2005/Sainte-Chapelle-3.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Sainte-Chapelle-3_JPG.htm [3/9/08 1:12:50 PM]

http://neuage.org/Paris/pages/Rue-Coustou-Montmartre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Sainte-Chapelle_JPG.htm
http://neuage.org/Paris/images/Sainte-Chapelle-3_JPG.jpg


PARIS Christmas week 2005 / Sainte-Chapelle.JPG

PARIS Christmas week 2005/Sainte-Chapelle.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Sainte-Chapelle_JPG.htm [3/9/08 1:12:52 PM]

http://neuage.org/Paris/pages/Sainte-Chapelle-3_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/sculpture-chartres-cateral_JPG.htm
http://neuage.org/Paris/images/Sainte-Chapelle_JPG.jpg


PARIS Christmas week 2005 / sculpture-chartres-cateral.JPG

PARIS Christmas week 2005/sculpture-chartres-cateral.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/sculpture-chartres-cateral_JPG.htm [3/9/08 1:12:54 PM]

http://neuage.org/Paris/pages/Sainte-Chapelle_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Seine-River_JPG.htm
http://neuage.org/Paris/images/sculpture-chartres-cateral_JPG.jpg


PARIS Christmas week 2005 / Seine-River.JPG

PARIS Christmas week 2005/Seine-River.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Seine-River_JPG.htm [3/9/08 1:12:56 PM]

http://neuage.org/Paris/pages/sculpture-chartres-cateral_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/self-Portrait_JPG.htm
http://neuage.org/Paris/images/Seine-River_JPG.jpg


PARIS Christmas week 2005 / self-Portrait.JPG

PARIS Christmas week 2005/self-Portrait.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/self-Portrait_JPG.htm [3/9/08 1:12:57 PM]

http://neuage.org/Paris/pages/Seine-River_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Snowy-Louvre_JPG.htm
http://neuage.org/Paris/images/self-Portrait_JPG.jpg


PARIS Christmas week 2005 / Snowy-Louvre.JPG

PARIS Christmas week 2005/Snowy-Louvre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Snowy-Louvre_JPG.htm [3/9/08 1:12:59 PM]

http://neuage.org/Paris/pages/self-Portrait_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Stairs-Chartre_JPG.htm
http://neuage.org/Paris/images/Snowy-Louvre_JPG.jpg


PARIS Christmas week 2005 / Stairs-Chartre.JPG

PARIS Christmas week 2005/Stairs-Chartre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Stairs-Chartre_JPG.htm (1 of 2) [3/9/08 1:13:00 PM]

http://neuage.org/Paris/pages/Snowy-Louvre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/Streets-of-Chartres_JPG.htm
http://neuage.org/Paris/images/Stairs-Chartre_JPG.jpg
http://neuage.org/Paris/images/Stairs-Chartre_JPG.jpg


PARIS Christmas week 2005 / Stairs-Chartre.JPG

http://neuage.org/Paris/pages/Stairs-Chartre_JPG.htm (2 of 2) [3/9/08 1:13:00 PM]



PARIS Christmas week 2005 / Streets-of-Chartres.JPG

PARIS Christmas week 2005/Streets-of-Chartres.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/Streets-of-Chartres_JPG.htm [3/9/08 1:13:01 PM]

http://neuage.org/Paris/pages/Stairs-Chartre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/The-Louvre_JPG.htm
http://neuage.org/Paris/images/Streets-of-Chartres_JPG.jpg


PARIS Christmas week 2005 / The-Louvre.JPG

PARIS Christmas week 2005/The-Louvre.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/The-Louvre_JPG.htm [3/9/08 1:13:03 PM]

http://neuage.org/Paris/pages/Streets-of-Chartres_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/window-SainteChapelle_JPG.htm
http://neuage.org/Paris/images/The-Louvre_JPG.jpg


PARIS Christmas week 2005 / window-SainteChapelle.JPG

PARIS Christmas week 2005/window-SainteChapelle.JPG

Previous | Home | Next 
 

 

 

http://neuage.org/Paris/pages/window-SainteChapelle_JPG.htm [3/9/08 1:13:04 PM]

http://neuage.org/Paris/pages/The-Louvre_JPG.htm
http://neuage.org/Paris/index.htm
http://neuage.org/Paris/pages/-Chartres_JPG.htm
http://neuage.org/Paris/images/window-SainteChapelle_JPG.jpg


http://neuage.org/05/prague/images/photo1_JPG.jpg

http://neuage.org/05/prague/images/photo1_JPG.jpg [3/9/08 1:13:05 PM]



http://neuage.org/05/prague/images/photo10_JPG.jpg

http://neuage.org/05/prague/images/photo10_JPG.jpg [3/9/08 1:13:05 PM]



http://neuage.org/05/prague/images/photo11_JPG.jpg

http://neuage.org/05/prague/images/photo11_JPG.jpg [3/9/08 1:13:06 PM]



http://neuage.org/05/prague/images/photo12_JPG.jpg

http://neuage.org/05/prague/images/photo12_JPG.jpg (1 of 2) [3/9/08 1:13:07 PM]



http://neuage.org/05/prague/images/photo12_JPG.jpg

http://neuage.org/05/prague/images/photo12_JPG.jpg (2 of 2) [3/9/08 1:13:07 PM]



http://neuage.org/05/prague/images/photo13_JPG.jpg

http://neuage.org/05/prague/images/photo13_JPG.jpg [3/9/08 1:13:07 PM]



http://neuage.org/05/prague/images/photo14_JPG.jpg

http://neuage.org/05/prague/images/photo14_JPG.jpg (1 of 2) [3/9/08 1:13:08 PM]



http://neuage.org/05/prague/images/photo14_JPG.jpg

http://neuage.org/05/prague/images/photo14_JPG.jpg (2 of 2) [3/9/08 1:13:08 PM]



http://neuage.org/05/prague/images/photo15_JPG.jpg

http://neuage.org/05/prague/images/photo15_JPG.jpg [3/9/08 1:13:08 PM]



http://neuage.org/05/prague/images/photo16_JPG.jpg

http://neuage.org/05/prague/images/photo16_JPG.jpg [3/9/08 1:13:08 PM]



http://neuage.org/05/prague/images/photo17_JPG.jpg

http://neuage.org/05/prague/images/photo17_JPG.jpg [3/9/08 1:13:09 PM]



http://neuage.org/05/prague/images/photo18_JPG.jpg

http://neuage.org/05/prague/images/photo18_JPG.jpg [3/9/08 1:13:09 PM]



http://neuage.org/05/prague/images/photo19_JPG.jpg

http://neuage.org/05/prague/images/photo19_JPG.jpg [3/9/08 1:13:09 PM]



http://neuage.org/05/prague/images/photo2_JPG.jpg

http://neuage.org/05/prague/images/photo2_JPG.jpg [3/9/08 1:13:10 PM]



http://neuage.org/05/prague/images/photo20_JPG.jpg

http://neuage.org/05/prague/images/photo20_JPG.jpg (1 of 2) [3/9/08 1:13:10 PM]



http://neuage.org/05/prague/images/photo20_JPG.jpg

http://neuage.org/05/prague/images/photo20_JPG.jpg (2 of 2) [3/9/08 1:13:10 PM]



http://neuage.org/05/prague/images/photo21_JPG.jpg

http://neuage.org/05/prague/images/photo21_JPG.jpg [3/9/08 1:13:11 PM]



http://neuage.org/05/prague/images/photo22_JPG.jpg

http://neuage.org/05/prague/images/photo22_JPG.jpg [3/9/08 1:13:11 PM]



http://neuage.org/05/prague/images/photo23_JPG.jpg

http://neuage.org/05/prague/images/photo23_JPG.jpg [3/9/08 1:13:11 PM]



http://neuage.org/05/prague/images/photo24_JPG.jpg

http://neuage.org/05/prague/images/photo24_JPG.jpg [3/9/08 1:13:12 PM]



http://neuage.org/05/prague/images/photo25_JPG.jpg

http://neuage.org/05/prague/images/photo25_JPG.jpg [3/9/08 1:13:12 PM]



http://neuage.org/05/prague/images/photo26_JPG.jpg

http://neuage.org/05/prague/images/photo26_JPG.jpg [3/9/08 1:13:13 PM]



http://neuage.org/05/prague/images/photo27_JPG.jpg

http://neuage.org/05/prague/images/photo27_JPG.jpg [3/9/08 1:13:13 PM]



http://neuage.org/05/prague/images/photo28_JPG.jpg

http://neuage.org/05/prague/images/photo28_JPG.jpg [3/9/08 1:13:13 PM]



http://neuage.org/05/prague/images/photo29_JPG.jpg

http://neuage.org/05/prague/images/photo29_JPG.jpg [3/9/08 1:13:14 PM]



http://neuage.org/05/prague/images/photo3_jpg.jpg

http://neuage.org/05/prague/images/photo3_jpg.jpg [3/9/08 1:13:14 PM]



http://neuage.org/05/prague/images/photo30_JPG.jpg

http://neuage.org/05/prague/images/photo30_JPG.jpg [3/9/08 1:13:15 PM]



http://neuage.org/05/prague/images/photo31_JPG.jpg

http://neuage.org/05/prague/images/photo31_JPG.jpg [3/9/08 1:13:15 PM]



http://neuage.org/05/prague/images/photo32_JPG.jpg

http://neuage.org/05/prague/images/photo32_JPG.jpg [3/9/08 1:13:15 PM]



http://neuage.org/05/prague/images/photo4_JPG.jpg

http://neuage.org/05/prague/images/photo4_JPG.jpg [3/9/08 1:13:16 PM]



http://neuage.org/05/prague/images/photo5_JPG.jpg

http://neuage.org/05/prague/images/photo5_JPG.jpg [3/9/08 1:13:16 PM]



http://neuage.org/05/prague/images/photo6_JPG.jpg

http://neuage.org/05/prague/images/photo6_JPG.jpg [3/9/08 1:13:17 PM]



http://neuage.org/05/prague/images/photo7_JPG.jpg

http://neuage.org/05/prague/images/photo7_JPG.jpg [3/9/08 1:13:17 PM]



http://neuage.org/05/prague/images/photo8_JPG.jpg

http://neuage.org/05/prague/images/photo8_JPG.jpg [3/9/08 1:13:17 PM]



http://neuage.org/05/prague/images/photo9_JPG.jpg

http://neuage.org/05/prague/images/photo9_JPG.jpg [3/9/08 1:13:18 PM]



http://neuage.org/06trip/06trip-1/images/1-Hudson_River_gif.jpg

http://neuage.org/06trip/06trip-1/images/1-Hudson_River_gif.jpg [3/9/08 1:13:21 PM]



http://neuage.org/06trip/06trip-1/images/10-houseboat_gif.jpg

http://neuage.org/06trip/06trip-1/images/10-houseboat_gif.jpg [3/9/08 1:13:25 PM]



http://neuage.org/06trip/06trip-1/images/11-barge_gif.jpg

http://neuage.org/06trip/06trip-1/images/11-barge_gif.jpg [3/9/08 1:13:26 PM]



http://neuage.org/06trip/06trip-1/images/12-kong_gif.jpg

http://neuage.org/06trip/06trip-1/images/12-kong_gif.jpg (1 of 2) [3/9/08 1:13:26 PM]



http://neuage.org/06trip/06trip-1/images/12-kong_gif.jpg

http://neuage.org/06trip/06trip-1/images/12-kong_gif.jpg (2 of 2) [3/9/08 1:13:26 PM]



http://neuage.org/06trip/06trip-1/images/13-Narda_at_end_of_bikes_gif.jpg

http://neuage.org/06trip/06trip-1/images/13-Narda_at_end_of_bikes_gif.jpg (1 of 2) [3/9/08 1:13:27 PM]



http://neuage.org/06trip/06trip-1/images/13-Narda_at_end_of_bikes_gif.jpg

http://neuage.org/06trip/06trip-1/images/13-Narda_at_end_of_bikes_gif.jpg (2 of 2) [3/9/08 1:13:27 PM]



http://neuage.org/06trip/06trip-1/images/14-house-of-rocks_JPG.jpg

http://neuage.org/06trip/06trip-1/images/14-house-of-rocks_JPG.jpg [3/9/08 1:13:27 PM]



http://neuage.org/06trip/06trip-1/images/15-Ann_Frank_JPG.jpg

http://neuage.org/06trip/06trip-1/images/15-Ann_Frank_JPG.jpg (1 of 2) [3/9/08 1:13:27 PM]



http://neuage.org/06trip/06trip-1/images/15-Ann_Frank_JPG.jpg

http://neuage.org/06trip/06trip-1/images/15-Ann_Frank_JPG.jpg (2 of 2) [3/9/08 1:13:27 PM]



http://neuage.org/06trip/06trip-1/images/16-Old_bike_riders_JPG.jpg

http://neuage.org/06trip/06trip-1/images/16-Old_bike_riders_JPG.jpg [3/9/08 1:13:28 PM]



http://neuage.org/06trip/06trip-1/images/17-Yearly_diary_Store_JPG.jpg

http://neuage.org/06trip/06trip-1/images/17-Yearly_diary_Store_JPG.jpg [3/9/08 1:13:28 PM]



http://neuage.org/06trip/06trip-1/images/18-Utrecht_streets_JPG.jpg

http://neuage.org/06trip/06trip-1/images/18-Utrecht_streets_JPG.jpg [3/9/08 1:13:29 PM]



http://neuage.org/06trip/06trip-1/images/2-NYC-air4_gif.jpg

http://neuage.org/06trip/06trip-1/images/2-NYC-air4_gif.jpg [3/9/08 1:13:29 PM]



http://neuage.org/06trip/06trip-1/images/3-NYC-air2_gif.jpg

http://neuage.org/06trip/06trip-1/images/3-NYC-air2_gif.jpg [3/9/08 1:13:29 PM]



http://neuage.org/06trip/06trip-1/images/4-NYC-plane_gif.jpg

http://neuage.org/06trip/06trip-1/images/4-NYC-plane_gif.jpg [3/9/08 1:13:30 PM]



http://neuage.org/06trip/06trip-1/images/5-Tudor_Village-NYC_JPG.jpg

http://neuage.org/06trip/06trip-1/images/5-Tudor_Village-NYC_JPG.jpg [3/9/08 1:13:30 PM]



http://neuage.org/06trip/06trip-1/images/6-NYC-Dutch-influence_gif.jpg

http://neuage.org/06trip/06trip-1/images/6-NYC-Dutch-influence_gif.jpg [3/9/08 1:13:31 PM]



http://neuage.org/06trip/06trip-1/images/7-UN_JPG.jpg

http://neuage.org/06trip/06trip-1/images/7-UN_JPG.jpg [3/9/08 1:13:31 PM]



http://neuage.org/06trip/06trip-1/images/8-Schiphol-Amsterdam_JPG.jpg

http://neuage.org/06trip/06trip-1/images/8-Schiphol-Amsterdam_JPG.jpg [3/9/08 1:13:31 PM]



http://neuage.org/06trip/06trip-1/images/9-Utretch_JPG.jpg

http://neuage.org/06trip/06trip-1/images/9-Utretch_JPG.jpg [3/9/08 1:13:32 PM]



http://neuage.org/06trip/06trip-2/images/1-Schiphol-airport_gif.jpg

http://neuage.org/06trip/06trip-2/images/1-Schiphol-airport_gif.jpg [3/9/08 1:13:32 PM]



http://neuage.org/06trip/06trip-2/images/2_gif.jpg

http://neuage.org/06trip/06trip-2/images/2_gif.jpg [3/9/08 1:13:33 PM]



http://neuage.org/06trip/06trip-2/images/3-bikes-Hamburg_gif.jpg

http://neuage.org/06trip/06trip-2/images/3-bikes-Hamburg_gif.jpg [3/9/08 1:13:33 PM]



http://neuage.org/06trip/06trip-2/images/4-Porn_Sandwiches_gif.jpg

http://neuage.org/06trip/06trip-2/images/4-Porn_Sandwiches_gif.jpg [3/9/08 1:13:33 PM]



http://neuage.org/06trip/06trip-2/images/5-bikes_gif.jpg

http://neuage.org/06trip/06trip-2/images/5-bikes_gif.jpg [3/9/08 1:13:34 PM]



http://neuage.org/06trip/06trip-2/images/6-restlessdancers_gif.jpg

http://neuage.org/06trip/06trip-2/images/6-restlessdancers_gif.jpg [3/9/08 1:13:34 PM]



http://neuage.org/06trip/06trip-2/images/7-Hamburg-Narda-Mau_gif.jpg

http://neuage.org/06trip/06trip-2/images/7-Hamburg-Narda-Mau_gif.jpg [3/9/08 1:13:35 PM]



http://neuage.org/06trip/06trip-2/images/8_gif.jpg

http://neuage.org/06trip/06trip-2/images/8_gif.jpg [3/9/08 1:13:35 PM]



http://neuage.org/06trip/06trip-2/images/9-Maus-baby_gif.jpg

http://neuage.org/06trip/06trip-2/images/9-Maus-baby_gif.jpg [3/9/08 1:13:35 PM]



http://neuage.org/06trip/06trip-2/images/10-breakfast_gif.jpg

http://neuage.org/06trip/06trip-2/images/10-breakfast_gif.jpg [3/9/08 1:13:36 PM]



http://neuage.org/06trip/06trip-2/images/11-Hotel-Stephan_gif.jpg

http://neuage.org/06trip/06trip-2/images/11-Hotel-Stephan_gif.jpg [3/9/08 1:13:36 PM]



http://neuage.org/06trip/06trip-2/images/12-Frankfurt-airport_gif.jpg

http://neuage.org/06trip/06trip-2/images/12-Frankfurt-airport_gif.jpg [3/9/08 1:13:36 PM]



http://neuage.org/06trip/06trip-3/images/1-TUurkey_gif.jpg

http://neuage.org/06trip/06trip-3/images/1-TUurkey_gif.jpg [3/9/08 1:13:37 PM]



http://neuage.org/06trip/06trip-3/images/2-Istanbul_gif.jpg

http://neuage.org/06trip/06trip-3/images/2-Istanbul_gif.jpg [3/9/08 1:13:37 PM]



http://neuage.org/06trip/06trip-3/images/3-Turkey_gif.jpg

http://neuage.org/06trip/06trip-3/images/3-Turkey_gif.jpg [3/9/08 1:13:38 PM]



http://neuage.org/06trip/06trip-3/images/4-Istanbul-suburbs_gif.jpg

http://neuage.org/06trip/06trip-3/images/4-Istanbul-suburbs_gif.jpg [3/9/08 1:13:38 PM]



http://neuage.org/06trip/06trip-3/images/5-Blue-Mosque-From-our-hote_gif.jpg

http://neuage.org/06trip/06trip-3/images/5-Blue-Mosque-From-our-hote_gif.jpg [3/9/08 1:13:38 PM]



http://neuage.org/06trip/06trip-3/images/6-our-hotel-roof_gif.jpg

http://neuage.org/06trip/06trip-3/images/6-our-hotel-roof_gif.jpg [3/9/08 1:13:39 PM]



http://neuage.org/06trip/06trip-3/images/7-our-hotel-roof_gif.jpg

http://neuage.org/06trip/06trip-3/images/7-our-hotel-roof_gif.jpg [3/9/08 1:13:39 PM]



http://neuage.org/06trip/06trip-3/images/8-swirling-Dervis_gif.jpg

http://neuage.org/06trip/06trip-3/images/8-swirling-Dervis_gif.jpg [3/9/08 1:13:40 PM]



http://neuage.org/06trip/06trip-3/images/9-Blue-Mosque_gif.jpg

http://neuage.org/06trip/06trip-3/images/9-Blue-Mosque_gif.jpg [3/9/08 1:13:40 PM]



http://neuage.org/06trip/06trip-3/images/11-Alien-Turkey_gif.jpg

http://neuage.org/06trip/06trip-3/images/11-Alien-Turkey_gif.jpg (1 of 2) [3/9/08 1:13:40 PM]



http://neuage.org/06trip/06trip-3/images/11-Alien-Turkey_gif.jpg

http://neuage.org/06trip/06trip-3/images/11-Alien-Turkey_gif.jpg (2 of 2) [3/9/08 1:13:40 PM]



http://neuage.org/06trip/06trip-4/images/1-breakfast-Poem-Hotel_gif.jpg

http://neuage.org/06trip/06trip-4/images/1-breakfast-Poem-Hotel_gif.jpg [3/9/08 1:13:41 PM]



http://neuage.org/06trip/06trip-4/images/10_gif.jpg

http://neuage.org/06trip/06trip-4/images/10_gif.jpg [3/9/08 1:13:41 PM]



http://neuage.org/06trip/06trip-4/images/11-local-Soccer-Team_gif.jpg

http://neuage.org/06trip/06trip-4/images/11-local-Soccer-Team_gif.jpg [3/9/08 1:13:44 PM]



http://neuage.org/06trip/06trip-4/images/12_gif.jpg

http://neuage.org/06trip/06trip-4/images/12_gif.jpg [3/9/08 1:13:44 PM]



http://neuage.org/06trip/06trip-4/images/13_gif.jpg

http://neuage.org/06trip/06trip-4/images/13_gif.jpg [3/9/08 1:13:44 PM]



http://neuage.org/06trip/06trip-4/images/14_gif.jpg

http://neuage.org/06trip/06trip-4/images/14_gif.jpg [3/9/08 1:13:45 PM]



http://neuage.org/06trip/06trip-4/images/15-Grand-Bazaar_gif.jpg

http://neuage.org/06trip/06trip-4/images/15-Grand-Bazaar_gif.jpg [3/9/08 1:13:45 PM]



http://neuage.org/06trip/06trip-4/images/16-shoppers-in-drag_gif.jpg

http://neuage.org/06trip/06trip-4/images/16-shoppers-in-drag_gif.jpg (1 of 2) [3/9/08 1:13:46 PM]



http://neuage.org/06trip/06trip-4/images/16-shoppers-in-drag_gif.jpg

http://neuage.org/06trip/06trip-4/images/16-shoppers-in-drag_gif.jpg (2 of 2) [3/9/08 1:13:46 PM]



http://neuage.org/06trip/06trip-4/images/17-Grand-Bazaar_gif.jpg

http://neuage.org/06trip/06trip-4/images/17-Grand-Bazaar_gif.jpg [3/9/08 1:13:46 PM]



http://neuage.org/06trip/06trip-4/images/18_gif.jpg

http://neuage.org/06trip/06trip-4/images/18_gif.jpg [3/9/08 1:13:47 PM]



http://neuage.org/06trip/06trip-4/images/19-Grand-Bazaar_gif.jpg

http://neuage.org/06trip/06trip-4/images/19-Grand-Bazaar_gif.jpg [3/9/08 1:13:47 PM]



http://neuage.org/06trip/06trip-4/images/2-neighbours_gif.jpg

http://neuage.org/06trip/06trip-4/images/2-neighbours_gif.jpg [3/9/08 1:13:47 PM]



http://neuage.org/06trip/06trip-4/images/20_gif.jpg

http://neuage.org/06trip/06trip-4/images/20_gif.jpg [3/9/08 1:13:48 PM]



http://neuage.org/06trip/06trip-4/images/21_gif.jpg

http://neuage.org/06trip/06trip-4/images/21_gif.jpg [3/9/08 1:13:48 PM]



http://neuage.org/06trip/06trip-4/images/22_gif.jpg

http://neuage.org/06trip/06trip-4/images/22_gif.jpg [3/9/08 1:13:49 PM]



http://neuage.org/06trip/06trip-4/images/23-from-our-rooftop_gif.jpg

http://neuage.org/06trip/06trip-4/images/23-from-our-rooftop_gif.jpg [3/9/08 1:13:49 PM]



http://neuage.org/06trip/06trip-4/images/24_gif.jpg

http://neuage.org/06trip/06trip-4/images/24_gif.jpg [3/9/08 1:13:49 PM]



http://neuage.org/06trip/06trip-4/images/25-Not-Our-Family_gif.jpg

http://neuage.org/06trip/06trip-4/images/25-Not-Our-Family_gif.jpg [3/9/08 1:13:50 PM]



http://neuage.org/06trip/06trip-4/images/25_gif.jpg

http://neuage.org/06trip/06trip-4/images/25_gif.jpg [3/9/08 1:13:50 PM]



http://neuage.org/06trip/06trip-4/images/26-ouch_gif.jpg

http://neuage.org/06trip/06trip-4/images/26-ouch_gif.jpg [3/9/08 1:13:51 PM]



http://neuage.org/06trip/06trip-4/images/27_gif.jpg

http://neuage.org/06trip/06trip-4/images/27_gif.jpg [3/9/08 1:13:51 PM]



http://neuage.org/06trip/06trip-4/images/28_gif.jpg

http://neuage.org/06trip/06trip-4/images/28_gif.jpg [3/9/08 1:13:52 PM]



http://neuage.org/06trip/06trip-4/images/3-Blue_Mosque_gif.jpg

http://neuage.org/06trip/06trip-4/images/3-Blue_Mosque_gif.jpg [3/9/08 1:13:52 PM]



http://neuage.org/06trip/06trip-4/images/4-Blue_Mosque_gif.jpg

http://neuage.org/06trip/06trip-4/images/4-Blue_Mosque_gif.jpg (1 of 2) [3/9/08 1:13:52 PM]



http://neuage.org/06trip/06trip-4/images/4-Blue_Mosque_gif.jpg

http://neuage.org/06trip/06trip-4/images/4-Blue_Mosque_gif.jpg (2 of 2) [3/9/08 1:13:52 PM]



http://neuage.org/06trip/06trip-4/images/5-Blue_Mosque_gif.jpg

http://neuage.org/06trip/06trip-4/images/5-Blue_Mosque_gif.jpg [3/9/08 1:13:53 PM]



http://neuage.org/06trip/06trip-4/images/6-Blue_Mosque_gif.jpg

http://neuage.org/06trip/06trip-4/images/6-Blue_Mosque_gif.jpg [3/9/08 1:13:53 PM]



http://neuage.org/06trip/06trip-4/images/7-Yo_Mo_gif.jpg

http://neuage.org/06trip/06trip-4/images/7-Yo_Mo_gif.jpg (1 of 2) [3/9/08 1:13:53 PM]



http://neuage.org/06trip/06trip-4/images/7-Yo_Mo_gif.jpg

http://neuage.org/06trip/06trip-4/images/7-Yo_Mo_gif.jpg (2 of 2) [3/9/08 1:13:53 PM]



http://neuage.org/06trip/06trip-4/images/8-Fast_Food_Menu_gif.jpg

http://neuage.org/06trip/06trip-4/images/8-Fast_Food_Menu_gif.jpg [3/9/08 1:13:54 PM]



http://neuage.org/06trip/06trip-4/images/9_gif.jpg

http://neuage.org/06trip/06trip-4/images/9_gif.jpg [3/9/08 1:13:54 PM]



http://neuage.org/06trip/06trip-4/images/NardaBarter1_gif.jpg

http://neuage.org/06trip/06trip-4/images/NardaBarter1_gif.jpg [3/9/08 1:13:55 PM]



http://neuage.org/06trip/06trip-4/images/NardaBarter2_gif.jpg

http://neuage.org/06trip/06trip-4/images/NardaBarter2_gif.jpg [3/9/08 1:13:55 PM]



http://neuage.org/06trip/06trip-4/images/NardaBarter3_gif.jpg

http://neuage.org/06trip/06trip-4/images/NardaBarter3_gif.jpg [3/9/08 1:13:57 PM]



http://neuage.org/06trip/06trip-5/images/1-local-boat_gif.jpg

http://neuage.org/06trip/06trip-5/images/1-local-boat_gif.jpg [3/9/08 1:13:57 PM]



http://neuage.org/06trip/06trip-5/images/10-arrival-Heybeliada_gif.jpg

http://neuage.org/06trip/06trip-5/images/10-arrival-Heybeliada_gif.jpg [3/9/08 1:13:57 PM]



http://neuage.org/06trip/06trip-5/images/11-Heybeliada-fire-COMPANY_gif.jpg

http://neuage.org/06trip/06trip-5/images/11-Heybeliada-fire-COMPANY_gif.jpg [3/9/08 1:13:58 PM]



http://neuage.org/06trip/06trip-5/images/12-looking_for_beer_gif.jpg

http://neuage.org/06trip/06trip-5/images/12-looking_for_beer_gif.jpg [3/9/08 1:13:58 PM]



http://neuage.org/06trip/06trip-5/images/2-Princes-Island_Kinahada_gif.jpg

http://neuage.org/06trip/06trip-5/images/2-Princes-Island_Kinahada_gif.jpg [3/9/08 1:13:59 PM]



http://neuage.org/06trip/06trip-5/images/3-Princes-Island_Buyukada_gif.jpg

http://neuage.org/06trip/06trip-5/images/3-Princes-Island_Buyukada_gif.jpg [3/9/08 1:13:59 PM]



http://neuage.org/06trip/06trip-5/images/4-Buyukada_beer-delivery_gif.jpg

http://neuage.org/06trip/06trip-5/images/4-Buyukada_beer-delivery_gif.jpg [3/9/08 1:14:00 PM]



http://neuage.org/06trip/06trip-5/images/5-downtown-Buyukada_gif.jpg

http://neuage.org/06trip/06trip-5/images/5-downtown-Buyukada_gif.jpg [3/9/08 1:14:00 PM]



http://neuage.org/06trip/06trip-5/images/6-rush_hour-Buyukada_gif.jpg

http://neuage.org/06trip/06trip-5/images/6-rush_hour-Buyukada_gif.jpg [3/9/08 1:14:00 PM]



http://neuage.org/06trip/06trip-5/images/7-Alien-invasion-Buyukada_gif.jpg

http://neuage.org/06trip/06trip-5/images/7-Alien-invasion-Buyukada_gif.jpg [3/9/08 1:14:01 PM]



http://neuage.org/06trip/06trip-5/images/8-captain_gif.jpg

http://neuage.org/06trip/06trip-5/images/8-captain_gif.jpg [3/9/08 1:14:01 PM]



http://neuage.org/06trip/06trip-5/images/9-traffic_jam_gif.jpg

http://neuage.org/06trip/06trip-5/images/9-traffic_jam_gif.jpg [3/9/08 1:14:01 PM]



http://neuage.org/06trip/06trip-6/images/10-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/10-St-Sophia_gif.jpg [3/9/08 1:14:02 PM]



http://neuage.org/06trip/06trip-6/images/11-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/11-St-Sophia_gif.jpg [3/9/08 1:14:02 PM]



http://neuage.org/06trip/06trip-6/images/12-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/12-St-Sophia_gif.jpg [3/9/08 1:14:03 PM]



http://neuage.org/06trip/06trip-6/images/13-Saint-Terrell_gif.jpg

http://neuage.org/06trip/06trip-6/images/13-Saint-Terrell_gif.jpg (1 of 2) [3/9/08 1:14:03 PM]



http://neuage.org/06trip/06trip-6/images/13-Saint-Terrell_gif.jpg

http://neuage.org/06trip/06trip-6/images/13-Saint-Terrell_gif.jpg (2 of 2) [3/9/08 1:14:03 PM]



http://neuage.org/06trip/06trip-6/images/14-pick-the-infidel_gif.jpg

http://neuage.org/06trip/06trip-6/images/14-pick-the-infidel_gif.jpg [3/9/08 1:14:03 PM]



http://neuage.org/06trip/06trip-6/images/15_gif.jpg

http://neuage.org/06trip/06trip-6/images/15_gif.jpg (1 of 2) [3/9/08 1:14:04 PM]



http://neuage.org/06trip/06trip-6/images/15_gif.jpg

http://neuage.org/06trip/06trip-6/images/15_gif.jpg (2 of 2) [3/9/08 1:14:04 PM]



http://neuage.org/06trip/06trip-6/images/16-hotel-poem_gif.jpg

http://neuage.org/06trip/06trip-6/images/16-hotel-poem_gif.jpg (1 of 2) [3/9/08 1:14:04 PM]



http://neuage.org/06trip/06trip-6/images/16-hotel-poem_gif.jpg

http://neuage.org/06trip/06trip-6/images/16-hotel-poem_gif.jpg (2 of 2) [3/9/08 1:14:04 PM]



http://neuage.org/06trip/06trip-6/images/5-oh-no_gif.jpg

http://neuage.org/06trip/06trip-6/images/5-oh-no_gif.jpg [3/9/08 1:14:05 PM]



http://neuage.org/06trip/06trip-6/images/6-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/6-St-Sophia_gif.jpg [3/9/08 1:14:05 PM]



http://neuage.org/06trip/06trip-6/images/7-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/7-St-Sophia_gif.jpg [3/9/08 1:14:05 PM]



http://neuage.org/06trip/06trip-6/images/8-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/8-St-Sophia_gif.jpg (1 of 2) [3/9/08 1:14:06 PM]



http://neuage.org/06trip/06trip-6/images/8-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/8-St-Sophia_gif.jpg (2 of 2) [3/9/08 1:14:06 PM]



http://neuage.org/06trip/06trip-6/images/9-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/9-St-Sophia_gif.jpg (1 of 2) [3/9/08 1:14:06 PM]



http://neuage.org/06trip/06trip-6/images/9-St-Sophia_gif.jpg

http://neuage.org/06trip/06trip-6/images/9-St-Sophia_gif.jpg (2 of 2) [3/9/08 1:14:06 PM]



http://neuage.org/06trip/06trip-8/images/1-streets_gif.jpg

http://neuage.org/06trip/06trip-8/images/1-streets_gif.jpg [3/9/08 1:14:07 PM]



http://neuage.org/06trip/06trip-8/images/2-bargan-hunter_gif.jpg

http://neuage.org/06trip/06trip-8/images/2-bargan-hunter_gif.jpg [3/9/08 1:14:07 PM]



http://neuage.org/06trip/06trip-8/images/3-shower-girl_gif.jpg

http://neuage.org/06trip/06trip-8/images/3-shower-girl_gif.jpg [3/9/08 1:14:07 PM]



http://neuage.org/06trip/06trip-8/images/4-motorbikes_gif.jpg

http://neuage.org/06trip/06trip-8/images/4-motorbikes_gif.jpg [3/9/08 1:14:08 PM]



http://neuage.org/06trip/06trip-8/images/5-balcony-Pandnaus-resort_gif.jpg

http://neuage.org/06trip/06trip-8/images/5-balcony-Pandnaus-resort_gif.jpg [3/9/08 1:14:08 PM]



http://neuage.org/06trip/06trip-8/images/6--Pandanus-resort_gif.jpg

http://neuage.org/06trip/06trip-8/images/6--Pandanus-resort_gif.jpg [3/9/08 1:14:09 PM]



http://neuage.org/06trip/06trip-8/images/7-Pandanus-resort_gif.jpg

http://neuage.org/06trip/06trip-8/images/7-Pandanus-resort_gif.jpg [3/9/08 1:14:09 PM]



http://neuage.org/06trip/06trip-8/images/8-Pandanus-resort_gif.jpg

http://neuage.org/06trip/06trip-8/images/8-Pandanus-resort_gif.jpg [3/9/08 1:14:11 PM]



http://neuage.org/06trip/06trip-8/images/9-Pandanus-resort_gif.jpg

http://neuage.org/06trip/06trip-8/images/9-Pandanus-resort_gif.jpg [3/9/08 1:14:11 PM]



http://neuage.org/06trip/06trip-8/images/HoChiMinh-from-Novatel-hote_gif.jpg

http://neuage.org/06trip/06trip-8/images/HoChiMinh-from-Novatel-hote_gif.jpg [3/9/08 1:14:11 PM]



http://neuage.org/06trip/06trip-8/images/lobby-Novatel_gif.jpg

http://neuage.org/06trip/06trip-8/images/lobby-Novatel_gif.jpg (1 of 2) [3/9/08 1:14:12 PM]



http://neuage.org/06trip/06trip-8/images/lobby-Novatel_gif.jpg

http://neuage.org/06trip/06trip-8/images/lobby-Novatel_gif.jpg (2 of 2) [3/9/08 1:14:12 PM]



http://neuage.org/06trip/06trip-8/images/P7024049_JPG.jpg

http://neuage.org/06trip/06trip-8/images/P7024049_JPG.jpg [3/9/08 1:14:12 PM]



http://neuage.org/06trip/06trip-9/images/1-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/1-Phan_Thiet_gif.jpg [3/9/08 1:14:13 PM]



http://neuage.org/06trip/06trip-9/images/2-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/2-Phan_Thiet_gif.jpg [3/9/08 1:14:14 PM]



http://neuage.org/06trip/06trip-9/images/3-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/3-Phan_Thiet_gif.jpg [3/9/08 1:14:15 PM]



http://neuage.org/06trip/06trip-9/images/4-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/4-Phan_Thiet_gif.jpg [3/9/08 1:14:15 PM]



http://neuage.org/06trip/06trip-9/images/5-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/5-Phan_Thiet_gif.jpg [3/9/08 1:14:15 PM]



http://neuage.org/06trip/06trip-9/images/6-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/6-Phan_Thiet_gif.jpg [3/9/08 1:14:16 PM]



http://neuage.org/06trip/06trip-9/images/7-Phan_Thiet_gif.jpg

http://neuage.org/06trip/06trip-9/images/7-Phan_Thiet_gif.jpg [3/9/08 1:14:21 PM]



http://neuage.org/06trip/06trip-10/images/1-Pandanus-lobby_gif.jpg

http://neuage.org/06trip/06trip-10/images/1-Pandanus-lobby_gif.jpg [3/9/08 1:14:23 PM]



http://neuage.org/06trip/06trip-10/images/10-view-our-balcony_gif.jpg

http://neuage.org/06trip/06trip-10/images/10-view-our-balcony_gif.jpg (1 of 2) [3/9/08 1:14:26 PM]



http://neuage.org/06trip/06trip-10/images/10-view-our-balcony_gif.jpg

http://neuage.org/06trip/06trip-10/images/10-view-our-balcony_gif.jpg (2 of 2) [3/9/08 1:14:26 PM]



http://neuage.org/06trip/06trip-10/images/11-fear-of-flight-2_gif.jpg

http://neuage.org/06trip/06trip-10/images/11-fear-of-flight-2_gif.jpg [3/9/08 1:14:26 PM]



http://neuage.org/06trip/06trip-10/images/11-fear-of-flight_gif.jpg

http://neuage.org/06trip/06trip-10/images/11-fear-of-flight_gif.jpg [3/9/08 1:14:26 PM]



http://neuage.org/06trip/06trip-10/images/12-flight_gif.jpg

http://neuage.org/06trip/06trip-10/images/12-flight_gif.jpg [3/9/08 1:14:27 PM]



http://neuage.org/06trip/06trip-10/images/13-easy-rider_gif.jpg

http://neuage.org/06trip/06trip-10/images/13-easy-rider_gif.jpg [3/9/08 1:14:27 PM]



http://neuage.org/06trip/06trip-10/images/14-straight-ahead-through-t_gif.jpg

http://neuage.org/06trip/06trip-10/images/14-straight-ahead-through-t_gif.jpg [3/9/08 1:14:28 PM]



http://neuage.org/06trip/06trip-10/images/15-World_cup_goalie_gif.jpg

http://neuage.org/06trip/06trip-10/images/15-World_cup_goalie_gif.jpg (1 of 2) [3/9/08 1:14:28 PM]



http://neuage.org/06trip/06trip-10/images/15-World_cup_goalie_gif.jpg

http://neuage.org/06trip/06trip-10/images/15-World_cup_goalie_gif.jpg (2 of 2) [3/9/08 1:14:28 PM]



http://neuage.org/06trip/06trip-10/images/16-Vinh-Nghiem-Pagoda_gif.jpg

http://neuage.org/06trip/06trip-10/images/16-Vinh-Nghiem-Pagoda_gif.jpg [3/9/08 1:14:28 PM]



http://neuage.org/06trip/06trip-10/images/17-Vinh-Nghiem-Pagoda_gif.jpg

http://neuage.org/06trip/06trip-10/images/17-Vinh-Nghiem-Pagoda_gif.jpg [3/9/08 1:14:29 PM]



http://neuage.org/06trip/06trip-10/images/18-dragon-ChinaTown_gif.jpg

http://neuage.org/06trip/06trip-10/images/18-dragon-ChinaTown_gif.jpg [3/9/08 1:14:29 PM]



http://neuage.org/06trip/06trip-10/images/19-Giac-Lam_gif.jpg

http://neuage.org/06trip/06trip-10/images/19-Giac-Lam_gif.jpg [3/9/08 1:14:30 PM]



http://neuage.org/06trip/06trip-10/images/2-Pandanus-lobby_gif.jpg

http://neuage.org/06trip/06trip-10/images/2-Pandanus-lobby_gif.jpg [3/9/08 1:14:30 PM]



http://neuage.org/06trip/06trip-10/images/3-Mui-Ne_gif.jpg

http://neuage.org/06trip/06trip-10/images/3-Mui-Ne_gif.jpg [3/9/08 1:14:30 PM]



http://neuage.org/06trip/06trip-10/images/4-downtown-Mui_Ne_gif.jpg

http://neuage.org/06trip/06trip-10/images/4-downtown-Mui_Ne_gif.jpg [3/9/08 1:14:31 PM]



http://neuage.org/06trip/06trip-10/images/5-country-Viet_Nam_gif.jpg

http://neuage.org/06trip/06trip-10/images/5-country-Viet_Nam_gif.jpg [3/9/08 1:14:31 PM]



http://neuage.org/06trip/06trip-10/images/6-rush-hour_gif.jpg

http://neuage.org/06trip/06trip-10/images/6-rush-hour_gif.jpg [3/9/08 1:14:32 PM]



http://neuage.org/06trip/06trip-10/images/7-California-Karaoke_gif.jpg

http://neuage.org/06trip/06trip-10/images/7-California-Karaoke_gif.jpg [3/9/08 1:14:32 PM]



http://neuage.org/06trip/06trip-10/images/8-Que-Huong_Liberty4-balcon_gif.jpg

http://neuage.org/06trip/06trip-10/images/8-Que-Huong_Liberty4-balcon_gif.jpg [3/9/08 1:14:34 PM]



http://neuage.org/06trip/06trip-10/images/9-HCM-balcony_gif.jpg

http://neuage.org/06trip/06trip-10/images/9-HCM-balcony_gif.jpg [3/9/08 1:14:34 PM]



http://neuage.org/06trip/06trip-10/images/9-Liberty4-balcony_gif.jpg

http://neuage.org/06trip/06trip-10/images/9-Liberty4-balcony_gif.jpg [3/9/08 1:14:35 PM]



http://neuage.org/06trip/06trip-11/images/1-Mekong-Riviere_Tien_gif.jpg

http://neuage.org/06trip/06trip-11/images/1-Mekong-Riviere_Tien_gif.jpg [3/9/08 1:14:35 PM]



http://neuage.org/06trip/06trip-11/images/10-Mekong-taxi_gif.jpg

http://neuage.org/06trip/06trip-11/images/10-Mekong-taxi_gif.jpg [3/9/08 1:14:35 PM]



http://neuage.org/06trip/06trip-11/images/11-traffic-jam-Sunday-morni_gif.jpg

http://neuage.org/06trip/06trip-11/images/11-traffic-jam-Sunday-morni_gif.jpg [3/9/08 1:14:36 PM]



http://neuage.org/06trip/06trip-11/images/12-oh-no-part_2385_gif.jpg

http://neuage.org/06trip/06trip-11/images/12-oh-no-part_2385_gif.jpg [3/9/08 1:14:36 PM]



http://neuage.org/06trip/06trip-11/images/2-Mekong-traffic_jam_gif.jpg

http://neuage.org/06trip/06trip-11/images/2-Mekong-traffic_jam_gif.jpg [3/9/08 1:14:37 PM]



http://neuage.org/06trip/06trip-11/images/3-dinner-captured_gif.jpg

http://neuage.org/06trip/06trip-11/images/3-dinner-captured_gif.jpg [3/9/08 1:14:37 PM]



http://neuage.org/06trip/06trip-11/images/3-dinner_gif.jpg

http://neuage.org/06trip/06trip-11/images/3-dinner_gif.jpg [3/9/08 1:14:37 PM]



http://neuage.org/06trip/06trip-11/images/4-Mekong-Riviere_Tien_gif.jpg

http://neuage.org/06trip/06trip-11/images/4-Mekong-Riviere_Tien_gif.jpg [3/9/08 1:14:38 PM]



http://neuage.org/06trip/06trip-11/images/5-Mekong-construction_gif.jpg

http://neuage.org/06trip/06trip-11/images/5-Mekong-construction_gif.jpg [3/9/08 1:14:38 PM]



http://neuage.org/06trip/06trip-11/images/6-ferry-Riviere_Tien_gif.jpg

http://neuage.org/06trip/06trip-11/images/6-ferry-Riviere_Tien_gif.jpg [3/9/08 1:14:39 PM]



http://neuage.org/06trip/06trip-11/images/7-DeltaQueen_gif.jpg

http://neuage.org/06trip/06trip-11/images/7-DeltaQueen_gif.jpg [3/9/08 1:14:39 PM]



http://neuage.org/06trip/06trip-11/images/8-Mekong_SaintTerrell_gif.jpg

http://neuage.org/06trip/06trip-11/images/8-Mekong_SaintTerrell_gif.jpg [3/9/08 1:14:39 PM]



http://neuage.org/06trip/06trip-11/images/9-Mekong_upriver_gif.jpg

http://neuage.org/06trip/06trip-11/images/9-Mekong_upriver_gif.jpg [3/9/08 1:14:40 PM]



http://neuage.org/06trip/06trip-11/images/attentive-tourist_gif.jpg

http://neuage.org/06trip/06trip-11/images/attentive-tourist_gif.jpg [3/9/08 1:14:40 PM]



http://neuage.org/06trip/06trip-11/images/baby-on-board_gif.jpg

http://neuage.org/06trip/06trip-11/images/baby-on-board_gif.jpg [3/9/08 1:14:41 PM]



http://neuage.org/06trip/06trip-11/images/canal-quoi-son_gif.jpg

http://neuage.org/06trip/06trip-11/images/canal-quoi-son_gif.jpg [3/9/08 1:14:41 PM]



http://neuage.org/06trip/06trip-11/images/CIA-tours_gif.jpg

http://neuage.org/06trip/06trip-11/images/CIA-tours_gif.jpg [3/9/08 1:14:41 PM]



http://neuage.org/06trip/06trip-11/images/coconut-candy-De_Chuong_Duo_gif.jpg

http://neuage.org/06trip/06trip-11/images/coconut-candy-De_Chuong_Duo_gif.jpg [3/9/08 1:14:42 PM]



http://neuage.org/06trip/06trip-11/images/coffee-shop_gif.jpg

http://neuage.org/06trip/06trip-11/images/coffee-shop_gif.jpg [3/9/08 1:14:42 PM]



http://neuage.org/06trip/06trip-11/images/Delta-burial_gif.jpg

http://neuage.org/06trip/06trip-11/images/Delta-burial_gif.jpg [3/9/08 1:14:42 PM]



http://neuage.org/06trip/06trip-11/images/FBI-tours_gif.jpg

http://neuage.org/06trip/06trip-11/images/FBI-tours_gif.jpg [3/9/08 1:14:43 PM]



http://neuage.org/06trip/06trip-11/images/HCM-traffic-2_gif.jpg

http://neuage.org/06trip/06trip-11/images/HCM-traffic-2_gif.jpg [3/9/08 1:14:43 PM]



http://neuage.org/06trip/06trip-11/images/HCM-traffic_gif.jpg

http://neuage.org/06trip/06trip-11/images/HCM-traffic_gif.jpg [3/9/08 1:14:46 PM]



http://neuage.org/06trip/06trip-11/images/honey_gif.jpg

http://neuage.org/06trip/06trip-11/images/honey_gif.jpg [3/9/08 1:14:47 PM]



http://neuage.org/06trip/06trip-11/images/huh-1-second_cousins_gif.jpg

http://neuage.org/06trip/06trip-11/images/huh-1-second_cousins_gif.jpg [3/9/08 1:14:47 PM]



http://neuage.org/06trip/06trip-11/images/huh-1_gif.jpg

http://neuage.org/06trip/06trip-11/images/huh-1_gif.jpg [3/9/08 1:14:47 PM]



http://neuage.org/06trip/06trip-11/images/jungle-chick_gif.jpg

http://neuage.org/06trip/06trip-11/images/jungle-chick_gif.jpg [3/9/08 1:14:48 PM]



http://neuage.org/06trip/06trip-11/images/P7094141_gif.jpg

http://neuage.org/06trip/06trip-11/images/P7094141_gif.jpg [3/9/08 1:14:48 PM]



http://neuage.org/06trip/06trip-11/images/rickety-boat-tour-R_us_gif.jpg

http://neuage.org/06trip/06trip-11/images/rickety-boat-tour-R_us_gif.jpg [3/9/08 1:14:50 PM]



http://neuage.org/06trip/06trip-11/images/risky-events_gif.jpg

http://neuage.org/06trip/06trip-11/images/risky-events_gif.jpg [3/9/08 1:14:50 PM]



http://neuage.org/06trip/06trip-11/images/river-girl_gif.jpg

http://neuage.org/06trip/06trip-11/images/river-girl_gif.jpg [3/9/08 1:14:50 PM]



http://neuage.org/06trip/Beach/images/beach_jpg.jpg

http://neuage.org/06trip/Beach/images/beach_jpg.jpg [3/9/08 1:14:51 PM]



http://neuage.org/06trip/Beach/images/jetty_jpg.jpg

http://neuage.org/06trip/Beach/images/jetty_jpg.jpg [3/9/08 1:14:51 PM]



http://neuage.org/06trip/Beach/images/Largs-Pier-hotel_jpg.jpg

http://neuage.org/06trip/Beach/images/Largs-Pier-hotel_jpg.jpg [3/9/08 1:14:52 PM]



http://neuage.org/06trip/Beach/images/Nards_jpg.jpg

http://neuage.org/06trip/Beach/images/Nards_jpg.jpg [3/9/08 1:14:52 PM]



http://neuage.org/06trip/Beach/images/Palais-Semaphore_jpg.jpg

http://neuage.org/06trip/Beach/images/Palais-Semaphore_jpg.jpg [3/9/08 1:14:52 PM]



http://neuage.org/06trip/Beach/images/Roo-filet_jpg.jpg

http://neuage.org/06trip/Beach/images/Roo-filet_jpg.jpg [3/9/08 1:14:53 PM]



http://neuage.org/06trip/Beach/images/Semaphore-beach_jpg.jpg

http://neuage.org/06trip/Beach/images/Semaphore-beach_jpg.jpg [3/9/08 1:14:53 PM]



http://neuage.org/06trip/Beach/images/Semaphore-hotel_jpg.jpg

http://neuage.org/06trip/Beach/images/Semaphore-hotel_jpg.jpg [3/9/08 1:14:54 PM]



http://neuage.org/06trip/Beach/images/Semaphore-houses_jpg.jpg

http://neuage.org/06trip/Beach/images/Semaphore-houses_jpg.jpg [3/9/08 1:14:54 PM]



http://neuage.org/06trip/Beach/images/Semaphore-pier_jpg.jpg

http://neuage.org/06trip/Beach/images/Semaphore-pier_jpg.jpg [3/9/08 1:14:54 PM]



http://neuage.org/06trip/Beach/images/Semaphore-resident_jpg.jpg

http://neuage.org/06trip/Beach/images/Semaphore-resident_jpg.jpg [3/9/08 1:14:55 PM]



http://neuage.org/06trip/resized/images/Bufallo-Glenelg-South-Austr_jpg.jpg

http://neuage.org/06trip/resized/images/Bufallo-Glenelg-South-Austr_jpg.jpg [3/9/08 1:14:55 PM]



http://neuage.org/06trip/resized/images/Centralmarket-Adelaide_jpg.jpg

http://neuage.org/06trip/resized/images/Centralmarket-Adelaide_jpg.jpg [3/9/08 1:14:56 PM]



http://neuage.org/06trip/resized/images/Glenelg-beach_jpg.jpg

http://neuage.org/06trip/resized/images/Glenelg-beach_jpg.jpg [3/9/08 1:14:56 PM]



http://neuage.org/06trip/resized/images/Glenelg-HotelGrand_jpg.jpg

http://neuage.org/06trip/resized/images/Glenelg-HotelGrand_jpg.jpg [3/9/08 1:14:56 PM]



http://neuage.org/06trip/resized/images/Glenelg-Jetty_Road_jpg.jpg

http://neuage.org/06trip/resized/images/Glenelg-Jetty_Road_jpg.jpg [3/9/08 1:14:57 PM]



http://neuage.org/06trip/resized/images/Glenelg_jpg.jpg

http://neuage.org/06trip/resized/images/Glenelg_jpg.jpg [3/9/08 1:14:57 PM]



http://neuage.org/06trip/resized/images/Glenelg3_jpg.jpg

http://neuage.org/06trip/resized/images/Glenelg3_jpg.jpg [3/9/08 1:14:58 PM]



http://neuage.org/06trip/resized/images/Gumeracha-South-Australia_jpg.jpg

http://neuage.org/06trip/resized/images/Gumeracha-South-Australia_jpg.jpg [3/9/08 1:14:58 PM]



http://neuage.org/06trip/resized/images/GumerachaSouth-AustraliaSig_jpg.jpg

http://neuage.org/06trip/resized/images/GumerachaSouth-AustraliaSig_jpg.jpg (1 of 2) [3/9/08 1:14:58 PM]



http://neuage.org/06trip/resized/images/GumerachaSouth-AustraliaSig_jpg.jpg

http://neuage.org/06trip/resized/images/GumerachaSouth-AustraliaSig_jpg.jpg (2 of 2) [3/9/08 1:14:58 PM]



http://neuage.org/06trip/resized/images/Gumeracha_South-AustraliaSi_jpg.jpg

http://neuage.org/06trip/resized/images/Gumeracha_South-AustraliaSi_jpg.jpg [3/9/08 1:14:59 PM]



http://neuage.org/06trip/resized/images/Gumeracha_South-Australia_s_jpg.jpg

http://neuage.org/06trip/resized/images/Gumeracha_South-Australia_s_jpg.jpg (1 of 2) [3/9/08 1:14:59 PM]



http://neuage.org/06trip/resized/images/Gumeracha_South-Australia_s_jpg.jpg

http://neuage.org/06trip/resized/images/Gumeracha_South-Australia_s_jpg.jpg (2 of 2) [3/9/08 1:14:59 PM]



http://neuage.org/06trip/resized/images/SmartNarda-Glenelg_jpg.jpg

http://neuage.org/06trip/resized/images/SmartNarda-Glenelg_jpg.jpg (1 of 2) [3/9/08 1:15:00 PM]



http://neuage.org/06trip/resized/images/SmartNarda-Glenelg_jpg.jpg

http://neuage.org/06trip/resized/images/SmartNarda-Glenelg_jpg.jpg (2 of 2) [3/9/08 1:15:00 PM]



http://neuage.org/06trip/resized/images/SmartNarda_jpg.jpg

http://neuage.org/06trip/resized/images/SmartNarda_jpg.jpg [3/9/08 1:15:00 PM]



http://neuage.org/06trip/Petersons/images/P7294245_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294245_JPG.jpg [3/9/08 1:15:00 PM]



http://neuage.org/06trip/Petersons/images/P7294246_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294246_JPG.jpg [3/9/08 1:15:01 PM]



http://neuage.org/06trip/Petersons/images/P7294247_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294247_JPG.jpg [3/9/08 1:15:01 PM]



http://neuage.org/06trip/Petersons/images/P7294248_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294248_JPG.jpg [3/9/08 1:15:01 PM]



http://neuage.org/06trip/Petersons/images/P7294249_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294249_JPG.jpg [3/9/08 1:15:02 PM]



http://neuage.org/06trip/Petersons/images/P7294250_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294250_JPG.jpg [3/9/08 1:15:02 PM]



http://neuage.org/06trip/Petersons/images/P7294251_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7294251_JPG.jpg [3/9/08 1:15:03 PM]



http://neuage.org/06trip/Petersons/images/P7304252_JPG.jpg

http://neuage.org/06trip/Petersons/images/P7304252_JPG.jpg [3/9/08 1:15:03 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Arts-Centre_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Arts-Centre_gif.jpg (1 of 2) [3/9/08 1:15:03 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Arts-Centre_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Arts-Centre_gif.jpg (2 of 2) [3/9/08 1:15:03 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Captain-Flinders_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Captain-Flinders_gif.jpg (1 of 2) [3/9/08 1:15:04 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Captain-Flinders_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Captain-Flinders_gif.jpg (2 of 2) [3/9/08 1:15:04 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Casino_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Casino_gif.jpg [3/9/08 1:15:04 PM]



http://neuage.org/06trip/Melbourne-Australia/images/CasinoWaterfall_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/CasinoWaterfall_gif.jpg [3/9/08 1:15:05 PM]



http://neuage.org/06trip/Melbourne-Australia/images/CasinoWaterfall2_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/CasinoWaterfall2_gif.jpg [3/9/08 1:15:05 PM]



http://neuage.org/06trip/Melbourne-Australia/images/first-class-carriages_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/first-class-carriages_gif.jpg [3/9/08 1:15:06 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Flinders-Train-Station_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Flinders-Train-Station_gif.jpg (1 of 2) [3/9/08 1:15:06 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Flinders-Train-Station_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Flinders-Train-Station_gif.jpg (2 of 2) [3/9/08 1:15:06 PM]



http://neuage.org/06trip/Melbourne-Australia/images/footy-shadows_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/footy-shadows_gif.jpg [3/9/08 1:15:06 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-City-Centre_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-City-Centre_gif.jpg [3/9/08 1:15:07 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-skyline_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-skyline_gif.jpg [3/9/08 1:15:07 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-StKilda_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-StKilda_gif.jpg [3/9/08 1:15:07 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-StKilda2_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Melbourne-StKilda2_gif.jpg [3/9/08 1:15:08 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Melbourne_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Melbourne_gif.jpg [3/9/08 1:15:08 PM]



http://neuage.org/06trip/Melbourne-Australia/images/night-melbourne_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/night-melbourne_gif.jpg [3/9/08 1:15:09 PM]



http://neuage.org/06trip/Melbourne-Australia/images/night-Yarra-river_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/night-Yarra-river_gif.jpg [3/9/08 1:15:09 PM]



http://neuage.org/06trip/Melbourne-Australia/images/NightMelbourne_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/NightMelbourne_gif.jpg [3/9/08 1:15:09 PM]



http://neuage.org/06trip/Melbourne-Australia/images/NightMelbourne2_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/NightMelbourne2_gif.jpg [3/9/08 1:15:11 PM]



http://neuage.org/06trip/Melbourne-Australia/images/P8034329_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/P8034329_gif.jpg (1 of 2) [3/9/08 1:15:12 PM]



http://neuage.org/06trip/Melbourne-Australia/images/P8034329_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/P8034329_gif.jpg (2 of 2) [3/9/08 1:15:12 PM]



http://neuage.org/06trip/Melbourne-Australia/images/P8034332_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/P8034332_gif.jpg (1 of 2) [3/9/08 1:15:12 PM]



http://neuage.org/06trip/Melbourne-Australia/images/P8034332_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/P8034332_gif.jpg (2 of 2) [3/9/08 1:15:12 PM]



http://neuage.org/06trip/Melbourne-Australia/images/row-houses_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/row-houses_gif.jpg [3/9/08 1:15:12 PM]



http://neuage.org/06trip/Melbourne-Australia/images/runner_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/runner_gif.jpg [3/9/08 1:15:13 PM]



http://neuage.org/06trip/Melbourne-Australia/images/South-Yarra_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/South-Yarra_gif.jpg [3/9/08 1:15:13 PM]



http://neuage.org/06trip/Melbourne-Australia/images/StKilda_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/StKilda_gif.jpg [3/9/08 1:15:13 PM]



http://neuage.org/06trip/Melbourne-Australia/images/StKildaNight_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/StKildaNight_gif.jpg [3/9/08 1:15:14 PM]



http://neuage.org/06trip/Melbourne-Australia/images/tourist_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/tourist_gif.jpg (1 of 2) [3/9/08 1:15:14 PM]



http://neuage.org/06trip/Melbourne-Australia/images/tourist_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/tourist_gif.jpg (2 of 2) [3/9/08 1:15:14 PM]



http://neuage.org/06trip/Melbourne-Australia/images/walk_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/walk_gif.jpg [3/9/08 1:15:14 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Worlds-tallest-apartment_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Worlds-tallest-apartment_gif.jpg [3/9/08 1:15:15 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Yarra2_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Yarra2_gif.jpg [3/9/08 1:15:15 PM]



http://neuage.org/06trip/Melbourne-Australia/images/Yarra_River-night_gif.jpg

http://neuage.org/06trip/Melbourne-Australia/images/Yarra_River-night_gif.jpg [3/9/08 1:15:16 PM]



http://neuage.org/06trip/grafitti/images/sacha400_gif.jpg

http://neuage.org/06trip/grafitti/images/sacha400_gif.jpg [3/9/08 1:15:16 PM]



http://neuage.org/06trip/grafitti/images/Sachas-picture_gif.jpg

http://neuage.org/06trip/grafitti/images/Sachas-picture_gif.jpg [3/9/08 1:15:16 PM]



http://neuage.org/06trip/grafitti/images/Sachas-picture2_gif.jpg

http://neuage.org/06trip/grafitti/images/Sachas-picture2_gif.jpg [3/9/08 1:15:17 PM]



http://neuage.org/06trip/grafitti/images/St-Kilda-Grafitti-2_gif.jpg

http://neuage.org/06trip/grafitti/images/St-Kilda-Grafitti-2_gif.jpg [3/9/08 1:15:17 PM]



http://neuage.org/06trip/grafitti/images/St-Kilda-Grafitti-3_gif.jpg

http://neuage.org/06trip/grafitti/images/St-Kilda-Grafitti-3_gif.jpg [3/9/08 1:15:18 PM]



http://neuage.org/06trip/grafitti/images/St-Kilda-Grafitti_gif.jpg

http://neuage.org/06trip/grafitti/images/St-Kilda-Grafitti_gif.jpg [3/9/08 1:15:18 PM]



http://neuage.org/06trip/Sorento/images/beach-houses_gif.jpg

http://neuage.org/06trip/Sorento/images/beach-houses_gif.jpg [3/9/08 1:15:18 PM]



http://neuage.org/06trip/Sorento/images/beach_gif.jpg

http://neuage.org/06trip/Sorento/images/beach_gif.jpg [3/9/08 1:15:19 PM]



http://neuage.org/06trip/Sorento/images/beach2_gif.jpg

http://neuage.org/06trip/Sorento/images/beach2_gif.jpg [3/9/08 1:15:19 PM]



http://neuage.org/06trip/Sorento/images/beach3_gif.jpg

http://neuage.org/06trip/Sorento/images/beach3_gif.jpg [3/9/08 1:15:19 PM]



http://neuage.org/06trip/Sorento/images/beach4_gif.jpg

http://neuage.org/06trip/Sorento/images/beach4_gif.jpg [3/9/08 1:15:20 PM]



http://neuage.org/06trip/Sorento/images/beach5_gif.jpg

http://neuage.org/06trip/Sorento/images/beach5_gif.jpg [3/9/08 1:15:20 PM]



http://neuage.org/06trip/Sorento/images/London-Bridge_gif.jpg

http://neuage.org/06trip/Sorento/images/London-Bridge_gif.jpg [3/9/08 1:15:21 PM]



http://neuage.org/06trip/Sorento/images/Sacha-Georgia_gif.jpg

http://neuage.org/06trip/Sorento/images/Sacha-Georgia_gif.jpg (1 of 2) [3/9/08 1:15:21 PM]



http://neuage.org/06trip/Sorento/images/Sacha-Georgia_gif.jpg

http://neuage.org/06trip/Sorento/images/Sacha-Georgia_gif.jpg (2 of 2) [3/9/08 1:15:21 PM]



http://neuage.org/06trip/Sorento/images/Sorrento-beach-Melbourne_gif.jpg

http://neuage.org/06trip/Sorento/images/Sorrento-beach-Melbourne_gif.jpg [3/9/08 1:15:21 PM]



http://neuage.org/06trip/Sorento/images/steps_gif.jpg

http://neuage.org/06trip/Sorento/images/steps_gif.jpg [3/9/08 1:15:22 PM]



http://neuage.org/06trip/Sorento/images/trail_gif.jpg

http://neuage.org/06trip/Sorento/images/trail_gif.jpg [3/9/08 1:15:22 PM]



http://neuage.org//06trip/Victor_Harbor/images/fairy-penguin_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/fairy-penguin_jpg.jpg [3/9/08 1:15:22 PM]



http://neuage.org//06trip/Victor_Harbor/images/give_way-to_penguins_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/give_way-to_penguins_jpg.jpg (1 of 2) [3/9/08 1:15:23 PM]



http://neuage.org//06trip/Victor_Harbor/images/give_way-to_penguins_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/give_way-to_penguins_jpg.jpg (2 of 2) [3/9/08 1:15:23 PM]



http://neuage.org//06trip/Victor_Harbor/images/Granite_island_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/Granite_island_jpg.jpg [3/9/08 1:15:23 PM]



http://neuage.org//06trip/Victor_Harbor/images/Middleton-house_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/Middleton-house_jpg.jpg [3/9/08 1:15:24 PM]



http://neuage.org//06trip/Victor_Harbor/images/occupied-territory_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/occupied-territory_jpg.jpg [3/9/08 1:15:24 PM]



http://neuage.org//06trip/Victor_Harbor/images/occupied-territory400_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/occupied-territory400_jpg.jpg [3/9/08 1:15:24 PM]



http://neuage.org//06trip/Victor_Harbor/images/seal_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/seal_jpg.jpg [3/9/08 1:15:25 PM]



http://neuage.org//06trip/Victor_Harbor/images/to-Granite_island-Victor_Ha_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/to-Granite_island-Victor_Ha_jpg.jpg [3/9/08 1:15:25 PM]



http://neuage.org//06trip/Victor_Harbor/images/tram-to-Victor_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/tram-to-Victor_jpg.jpg [3/9/08 1:15:25 PM]



http://neuage.org//06trip/Victor_Harbor/images/tram_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/tram_jpg.jpg [3/9/08 1:15:26 PM]



http://neuage.org//06trip/Victor_Harbor/images/Victor-from-granite_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/Victor-from-granite_jpg.jpg [3/9/08 1:15:26 PM]



http://neuage.org//06trip/Victor_Harbor/images/whale-sign_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/whale-sign_jpg.jpg [3/9/08 1:15:26 PM]



http://neuage.org//06trip/Victor_Harbor/images/whale_jpg.jpg

http://neuage.org//06trip/Victor_Harbor/images/whale_jpg.jpg [3/9/08 1:15:27 PM]



Kenneth Adsit 98th year Birthday party Clifton Park New York***

Kenneth Adsit at 98 and some before
 

  
1952.jpg

  
Australians_Brendan-

Daniell.jpg
  

Birthday-Boy.jpg

  
Brendan-Danielle-

Narda-Terr.jpg

  
Brendan-

Danielle.jpg

  
But_I_feel_like_a_teenager.

jpg

  
Eugene_Oregon69_jpg.

jpg

  
Fred-Keneth-

Joyce.jpg
  

Fred_Miller.jpg
  

Narda-Terrell.jpg

  
Nov-13-1954-Clifton_Park.

jpg
  

party-folks.jpg

  
party_boy-at-98.

jpg

  
saratogaNewYork-

1992_TIF_JPG.
jpg

Father's Birthday2003 ~ Trip 2002~ Hawaii 2002; Narda's sons New York 2002/3; Danielle & Brendan's visit; winter 
2002-2003; Jetty Day; Terrell photos; brother - Robert Adsit; children: Sacha-Leigh together/and more; Sacha/Sacha2, 
Leigh/Leigh2

Video of our area from this winter

●     Roundlake, New York (our new home)

●     Terrell Neuage home/photopage

●     Narda Biemond home

 

http://neuage.org/father/index1.htm [3/9/08 1:15:28 PM]

http://neuage.org/father/pages/1952_jpg.htm
http://neuage.org/father/pages/Australians_Brendan-Daniell_jpg.htm
http://neuage.org/father/pages/Birthday-Boy_jpg.htm
http://neuage.org/father/pages/Brendan-Danielle-Narda-Terr_jpg.htm
http://neuage.org/father/pages/Brendan-Danielle_jpg.htm
http://neuage.org/father/pages/But_I_feel_like_a_teenager_jpg.htm
http://neuage.org/father/pages/Eugene_Oregon69_jpg_jpg.htm
http://neuage.org/father/pages/Fred-Keneth-Joyce_jpg.htm
http://neuage.org/father/pages/Fred_Miller_jpg.htm
http://neuage.org/father/pages/Narda-Terrell_jpg.htm
http://neuage.org/father/pages/Nov-13-1954-Clifton_Park_jpg.htm
http://neuage.org/father/pages/party-folks_jpg.htm
http://neuage.org/father/pages/party_boy-at-98_jpg.htm
http://neuage.org/father/pages/saratogaNewYork-1992_TIF_JPG_jpg.htm
http://se.unisa.edu.au/father/index.htm
http://www.restlessdancer.com/trip2002/index.htm
http://se.unisa.edu.au/hawaii2002/index.htm
http://se.unisa.edu.au/stu-chris/index.htm
http://www.neuage.org/april2003/index.htm
http://se.unisa.edu.au/photos/index2.htm
http://se.unisa.edu.au/photo/index.htm
http://se.unisa.edu.au/robert_photos/index.htm
http://se.unisa.edu.au/sacha-leigh/index.htm
http://se.unisa.edu.au/sacha-leigh_neuage/index.htm
http://se.unisa.edu.au/sacha/index.htm
http://se.unisa.edu.au/sacha_neuage/index.htm
http://se.unisa.edu.au/leigh/index.htm
http://se.unisa.edu.au/leigh_neuage/index.htm
http://media1.acs.albany.edu:8080/ramgen/neuage/adirondack_New_York_2003.rm
http://www.neuage.org/roundlake/roundlake_new-york.htm
http://www.neuage.org/
http://www.neuage.org/terrell.html
http://se.unisa.edu.au/narda.htm


http://neuage.org/father/images/1952_jpg.jpg

http://neuage.org/father/images/1952_jpg.jpg [3/9/08 1:15:28 PM]



http://neuage.org/father/images/Australians_Brendan-Daniell_jpg.jpg

http://neuage.org/father/images/Australians_Brendan-Daniell_jpg.jpg [3/9/08 1:15:29 PM]



http://neuage.org/father/images/Birthday-Boy_jpg.jpg

http://neuage.org/father/images/Birthday-Boy_jpg.jpg [3/9/08 1:15:32 PM]



http://neuage.org/father/images/Brendan-Danielle-Narda-Terr_jpg.jpg

http://neuage.org/father/images/Brendan-Danielle-Narda-Terr_jpg.jpg [3/9/08 1:15:32 PM]



http://neuage.org/father/images/Brendan-Danielle_jpg.jpg

http://neuage.org/father/images/Brendan-Danielle_jpg.jpg [3/9/08 1:15:32 PM]



http://neuage.org/father/images/But_I_feel_like_a_teenager_jpg.jpg

http://neuage.org/father/images/But_I_feel_like_a_teenager_jpg.jpg [3/9/08 1:15:33 PM]



http://neuage.org/father/images/Eugene_Oregon69_jpg_jpg.jpg

http://neuage.org/father/images/Eugene_Oregon69_jpg_jpg.jpg [3/9/08 1:15:33 PM]



http://neuage.org/father/images/Fred-Keneth-Joyce_jpg.jpg

http://neuage.org/father/images/Fred-Keneth-Joyce_jpg.jpg [3/9/08 1:15:34 PM]



http://neuage.org/father/images/Fred_Miller_jpg.jpg

http://neuage.org/father/images/Fred_Miller_jpg.jpg [3/9/08 1:15:34 PM]



http://neuage.org/father/images/Narda-Terrell_jpg.jpg

http://neuage.org/father/images/Narda-Terrell_jpg.jpg [3/9/08 1:15:34 PM]



http://neuage.org/father/images/Nov-13-1954-Clifton_Park_jpg.jpg

http://neuage.org/father/images/Nov-13-1954-Clifton_Park_jpg.jpg [3/9/08 1:15:35 PM]



http://neuage.org/father/images/party-folks_jpg.jpg

http://neuage.org/father/images/party-folks_jpg.jpg [3/9/08 1:15:35 PM]



http://neuage.org/father/images/party_boy-at-98_jpg.jpg

http://neuage.org/father/images/party_boy-at-98_jpg.jpg [3/9/08 1:15:35 PM]



http://neuage.org/father/images/saratogaNewYork-1992_TIF_JPG_jpg.jpg

http://neuage.org/father/images/saratogaNewYork-1992_TIF_JPG_jpg.jpg [3/9/08 1:15:36 PM]



http://neuage.org/Adsit-Family/images/James-Adsit_Robert__mom_dad_jpg.jpg

http://neuage.org/Adsit-Family/images/James-Adsit_Robert__mom_dad_jpg.jpg [3/9/08 1:15:37 PM]



http://neuage.org/Adsit-Family/images/James_Adsit-Clifton-Park-19_jpg.jpg

http://neuage.org/Adsit-Family/images/James_Adsit-Clifton-Park-19_jpg.jpg [3/9/08 1:15:38 PM]



http://neuage.org/Adsit-Family/images/James_Adsit-Clifton-Park_jpg.jpg

http://neuage.org/Adsit-Family/images/James_Adsit-Clifton-Park_jpg.jpg [3/9/08 1:15:38 PM]



http://neuage.org/Adsit-Family/images/mom-1922_jpg.jpg

http://neuage.org/Adsit-Family/images/mom-1922_jpg.jpg [3/9/08 1:15:38 PM]



http://neuage.org/Adsit-Family/images/mom-dad1945_jpg.jpg

http://neuage.org/Adsit-Family/images/mom-dad1945_jpg.jpg [3/9/08 1:15:39 PM]



http://neuage.org/Adsit-Family/images/New_truck_jpg.jpg

http://neuage.org/Adsit-Family/images/New_truck_jpg.jpg [3/9/08 1:15:39 PM]



http://neuage.org/Adsit-Family/images/Robert_Terry_mom_dad-1950s_jpg.jpg

http://neuage.org/Adsit-Family/images/Robert_Terry_mom_dad-1950s_jpg.jpg [3/9/08 1:15:39 PM]



http://neuage.org/Adsit-Family/images/Robert_Terry_mom_dad-1953_jpg.jpg

http://neuage.org/Adsit-Family/images/Robert_Terry_mom_dad-1953_jpg.jpg [3/9/08 1:15:40 PM]



http://neuage.org/Adsit-Family/images/Robert_Terry_mom_dad-1960_jpg.jpg

http://neuage.org/Adsit-Family/images/Robert_Terry_mom_dad-1960_jpg.jpg [3/9/08 1:15:40 PM]



http://neuage.org/Adsit-Family/images/Ruth-Adsit-1940s_jpg.jpg

http://neuage.org/Adsit-Family/images/Ruth-Adsit-1940s_jpg.jpg [3/9/08 1:15:41 PM]



 1

Contents 
Contents ....................................................................................................................... 1 
Welcome to SketchUp (Mac OS X)............................................................................. 7 
SketchUp for Mac OS X............................................................................................... 8 
Technical Support ..................................................................................................... 10 
What's New in this Release? .................................................................................... 11 
Learning SketchUp.................................................................................................... 13 
Concepts .................................................................................................................... 15 
Designing in SketchUp ............................................................................................. 16 
Drawing Quickly......................................................................................................... 21 
Viewing Models in 3 Dimensions............................................................................. 28 
Adding Detail to Your Models .................................................................................. 31 
Presenting Your Models ........................................................................................... 39 
Modeling Terrain and Organic Shapes.................................................................... 42 
The SketchUp User Interface.................................................................................... 45 
Introduction to the SketchUp Interface ................................................................... 46 
SketchUp Menu.......................................................................................................... 49 
File Menu .................................................................................................................... 51 
Edit Menu.................................................................................................................... 56 
View Menu .................................................................................................................. 60 
Camera Menu ............................................................................................................. 62 
Draw Menu.................................................................................................................. 64 
Tools Menu................................................................................................................. 65 
Window Menu............................................................................................................. 68 
Help Menu................................................................................................................... 70 
Tool Palette ................................................................................................................ 72 
Toolbar........................................................................................................................ 74 
Context Menus........................................................................................................... 78 
Dialog Boxes.............................................................................................................. 79 
Drawing Axes............................................................................................................. 81 
Inference..................................................................................................................... 84 
Principal Tools........................................................................................................... 87 

.Select Tool .......................................................................................................... 88 



 2

 Eraser Tool ......................................................................................................... 92 

 Paint Bucket Tool............................................................................................... 93 
Drawing Tools ............................................................................................................ 97 

 Line Tool ............................................................................................................. 98 

Arc Tool.............................................................................................................. 102 

 Freehand Tool ................................................................................................ 105 

 Rectangle Tool ................................................................................................. 107 

 Circle Tool......................................................................................................... 109 

 Polygon Tool .................................................................................................... 111 
Modification Tools................................................................................................... 113 

 Move Tool ......................................................................................................... 114 

 Rotate Tool ....................................................................................................... 120 

 Scale Tool ......................................................................................................... 125 

 Push/Pull Tool .................................................................................................. 129 

 Follow Me Tool ................................................................................................. 133 

 Offset Tool ........................................................................................................ 137 
Intersect With Model Tool....................................................................................... 140 
Position Texture Tool.............................................................................................. 142 
Construction Tools.................................................................................................. 149 

 Tape Measure Tool........................................................................................... 150 

 Protractor Tool ................................................................................................. 153 

 Axes Tool .......................................................................................................... 157 

 Dimension Tool ................................................................................................ 158 

 Text Tool ........................................................................................................... 160 

3D Text Tool....................................................................................................... 162 



 3

 Section Plane Tool ......................................................................................... 164 
Camera Tools ........................................................................................................... 166 

 Previous ............................................................................................................ 167 

 Next ................................................................................................................. 168 
Standard Views........................................................................................................ 169 
Matching Photos and Models................................................................................. 170 

 Orbit Tool .......................................................................................................... 177 

 Pan Tool ............................................................................................................ 178 

 Zoom Tool......................................................................................................... 179 

 Zoom Window Tool .......................................................................................... 180 

 Zoom Extents Tool........................................................................................... 181 
Zoom to Photo ......................................................................................................... 182 
Walkthrough Tools .................................................................................................. 183 

Position Camera Tool ....................................................................................... 184 

 Walk Tool .......................................................................................................... 186 

 Look Around Tool ............................................................................................ 187 
Sandbox Tools......................................................................................................... 188 

 Sandbox From Contours Tool ........................................................................ 189 

 Sandbox From Scratch Tool ........................................................................... 190 

 Smoove Tool..................................................................................................... 192 

 Stamp Tool........................................................................................................ 194 

 Drape Tool ........................................................................................................ 195 

 Add Detail Tool................................................................................................. 197 

 Flip Edge Tool .................................................................................................. 200 
Google Toolbar ........................................................................................................ 202 

 Get Current View Button ................................................................................. 204 



 4

 Toggle Terrain Button...................................................................................... 205 

 Place Model Button.......................................................................................... 206 

 Share Model Button ......................................................................................... 207 

 Get Models Button ........................................................................................... 208 
Model Settings and Managers................................................................................ 209 
Model Info Dialog Box............................................................................................. 210 
Entity Info Dialog Box ............................................................................................. 220 
The Color Picker ...................................................................................................... 221 
Component Browser ............................................................................................... 229 
Styles Browser......................................................................................................... 233 
Watermark ................................................................................................................ 245 
Scene Manager ........................................................................................................ 247 
Shadows Dialog Box ............................................................................................... 250 
Layer Manager ......................................................................................................... 252 
Soften Edges Dialog Box........................................................................................ 254 
Outliner ..................................................................................................................... 256 
Fog Dialog Box ........................................................................................................ 260 
Match Photo Dialog Box ......................................................................................... 262 
Instructor .................................................................................................................. 263 
Application Preferences Dialog Box ..................................................................... 264 
Entities...................................................................................................................... 269 
3D Polyline Entities ................................................................................................. 270 
Arc Entities............................................................................................................... 271 
Circle Entities........................................................................................................... 273 
Component Entities................................................................................................. 275 
Curve Entities........................................................................................................... 284 
Dimension Entities .................................................................................................. 285 
Face Entities............................................................................................................. 286 
Guide Line Entities .................................................................................................. 287 
Guide Point Entities ................................................................................................ 288 
Group Entities.......................................................................................................... 289 
Image Entities .......................................................................................................... 292 
Line Entities ............................................................................................................. 293 



 5

Polygon Entities....................................................................................................... 294 
Section Plane Entities ............................................................................................. 296 
Surface Entities........................................................................................................ 297 
Text Entities ............................................................................................................. 300 
Context Menu Items ................................................................................................ 301 
Entity Info ................................................................................................................. 307 
Input and Output...................................................................................................... 311 
2D Graphic Import ................................................................................................... 312 
3D Model (DWG/DXF) Import .................................................................................. 313 
3D Model (3DS) Import ............................................................................................ 315 
3D Model (DEM) Import ........................................................................................... 316 

3D Model (SHP) Import..................................................................................... 318 
2D Graphic Export ................................................................................................... 320 

2D Graphic (DWG/DXF) Export ....................................................................... 322 

 2D Graphic (PDF/EPS) Export ........................................................................ 325 

 2D Graphic (Epix) Export ................................................................................ 327 

 3D Model (DWG/DXF) Export.......................................................................... 329 

3D Model (3DS) Export..................................................................................... 330 

3D Model (VRML) Export.................................................................................. 334 

3D Model (OBJ) Export .................................................................................... 336 

3D Model (FBX) Export..................................................................................... 338 

3D Model (XSI) Export ...................................................................................... 340 
3D Model (KMZ) Export ........................................................................................... 342 
3D Model (DAE) Export ........................................................................................... 343 

Section Slice Export......................................................................................... 345 

 Animation Export............................................................................................. 347 
Scenes and Animations .......................................................................................... 350 
Printing ..................................................................................................................... 351 



 6

Technical Info........................................................................................................... 355 
Raster File Formats ................................................................................................. 356 
2D Vector File Formats ........................................................................................... 358 
SketchUp and OpenGL ........................................................................................... 360 
Codec Lists .............................................................................................................. 361 
SketchUp Ruby API and Console .......................................................................... 363 
Uninstalling SketchUp ............................................................................................ 364 
Common Tasks........................................................................................................ 365 
Activating the Sandbox Tools ................................................................................ 366 
Adding a Background to Your Model .................................................................... 367 
Copying Geometry .................................................................................................. 368 
Creating Models to Scale........................................................................................ 369 
Creating and Using Keyboard Shortcuts .............................................................. 370 
Drawing Accurate Angled Lines ............................................................................ 371 
Flipping or Mirroring Geometry ............................................................................. 372 
Reorienting Materials .............................................................................................. 375 
Using SketchUp With Google Earth....................................................................... 376 
Glossary ................................................................................................................... 377 
Index ......................................................................................................................... 383 

 



 7

Welcome to SketchUp (Mac OS X) 
Developed for the conceptual stages of design, SketchUp is powerful yet easy-to-learn 3D 
software. We think of it as the pencil of digital design. This award-winning software 
combines a simple, yet robust tool-set that streamlines and simplifies 3D design inside your 
computer. SketchUp is being used by anyone with the desire to Dream, Design and 
Communicate in 3D!  

From the entire SketchUp team, thank you for trying SketchUp, and welcome to the 
SketchUp user community. 

SketchUp Versions 
SketchUp is available in personal and professional versions. Google SketchUp (free) is 
available for free on sketchup.google.com. 

Google SketchUp Pro is available to purchase at http://sketchup.google.com/gsu6/buy.html. 
You need Google SketchUp Pro if you want to: 

• Export models in 3DS, DWG, DXF, OBJ, XSI, VRML, and FBX file formats 

• Use the LayOut tools to create page and screen-based presentations of your models. 

• Receive free email technical support for two years after purchase 

Google SketchUp (free) and Google SketchUp Pro 6 Documentation 
This documentation represents all of the functionality in both Google SketchUp (free) and 
Google SketchUp Pro 6. Functionality that is specific to Google SketchUp Pro 6 is identified 

with the pro icon ( ) in this documentation. 

Using this Guide 
Familiarity with computer basics is all you need to use SketchUp. Continue with the Learning 
SketchUp section of this guide for assistance with learning SketchUp. Or, read the What's 
New in This Release section of this guide to become familiar with SketchUp's new features.    
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SketchUp for Mac OS X  
SketchUp for Mac OS X has been designed and developed as a native Macintosh OS X 
application. SketchUp provides features and performance exclusive to MacOS X by taking 
advantage of the Macintosh Aqua user interface and dynamic, object-oriented, Cocoa 
Application Programmer's Interface (API). Below are some examples of the SketchUp and 
MacOS X integration. 

Fast OpenGL 3D Rendering 
Mac OS X is a state-of-the-art operating system designed to support intensive 2D and 3D 
graphics. Every Macintosh computer shipping today comes with incredibly powerful 3D 
graphics hardware providing you with the best possible user experience. SketchUp uses 
these features of your Macintosh by automatically running in accelerated OpenGL mode. 

Document Icons 
Your SketchUp documents can be saved in such a way that they contain a thumbnail view of 
their contents. This feature can help you quickly organize and locate your files in the Finder. 

Portable Document Format (PDF) 
SketchUp leverages Mac OS X built-in support for Adobe® Portable Document Format 
(PFD) which is the worldwide standard for electronic document distribution. 

Drag and Drop 
SketchUp leverages the Macintosh drag and drop feature. For example, you can drag image 
files, such as scans or digital photos, from the Finder, directly into your SketchUp drawing 
window. You can also drag SketchUp files (.skp) into the drawing window. These .skp files 
will be placed in your model as components. 

Apple Color System 
SketchUp for MacOS X has a completely redesigned color and materials management 
system based on Apple Computer's System Color Picker. SketchUp modifies this color 
picker to enable texture image management and to easily keep track of materials specified 
in your model. 

One Button Mouse 
Macintosh computers traditionally ship with a one-button mouse. SketchUp has been 
designed to allow you to be effective using a one-button mouse through the use of keyboard 
shortcuts as follows: 

Orbit 
Hold down the Control and Command keys, while clicking the mouse button, to orbit using a 
one-button mouse. This key combination temporarily invokes the Orbit Tool. 

Pan 
Hold down the Shift key along with Control and Command, while clicking the mouse button, 
to pan using a one-button mouse. This key combination temporarily invokes the Pan Tool. 

Three-Button, Scroll-Wheel Mouse 
SketchUp is most efficient when used with a three-button, scroll wheel, mouse. Behaviors 
for a three-button mouse are as follows: 
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• Clicking the left mouse button is equivalent to clicking the button on a single-button mouse. 

• Clicking the right mouse button activates context menus (the equivalent of a Control-click 
with a single-button mouse).  

• Clicking and holding the middle mouse wheel while scrolling the wheel forward or 
backward activates the Zoom Tool.  

• Clicking and holding the middle mouse wheel while moving your cursor around the drawing 
window activates the Orbit Tool. 
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Technical Support 
Google SketchUp (Free) and Google SketchUp Pro users have different levels of technical 
support. Review the following technical support explanation for your product. 

Google SketchUp Free 
SketchUp Free is a self-supporting product. There are several options available to find 
answers to SketchUp issues: 

• Use the online user's guide index to find a topic. 

• Search the knowledge base to find a topic. 

• Post a question in our user forum.  

Visit the Online Help Center by clicking on the Online Help Center menu item in the Help 
Menu (Help > Online Help Center). You must be connected to the Internet to access the 
user forums. 

Google SketchUp Pro 
In addition to the self-supporting options for Google SketchUp Free, Google SketchUp Pro 
users can request installation and configuration help using email through the Online Help 
Center (your serial number will be required).  

Please include the following with your email: 

• A copy of the SketchUp file you are creating 

• A list of your computer system's resources (CPU type, RAM, video card details, and the 
exact release of your operating system, such as OS X 10.3.9) 

• A detailed description of your question or issue  
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What's New in this Release? 
Google listens to your requests and attempts to implement many into SketchUp 
enhancements and new features. Google SketchUp (free) and Google SketchUp Pro 6 
contain the following enhancements and new features: 

Matching Photos and Models 
A new matching feature provides a way to set up a camera view so that the modeling 
environment matches up with a photograph. Matching can be used to match an existing 
model with a background photo or one can start from scratch with a photo and then trace 
over it in 3D!   

Styles 
A style is simply a saved collection of SketchUp display settings. No more fussing with many 
settings every time you want to change or customize your model's appearance. No longer is 
it necessary to use scenes (formerly known as pages) to save your display settings. With a 
single click, you can quickly apply a style to any model by selecting it from the new Styles 
browser. 

You can personalize your own styles and save them as part of a library, and you can easily 
share your style files with others.  

Watermarks 
Watermarks are images placed in the background or foreground of the drawing area and 
span the entire area just as sky and ground. Watermarks are great for creating 
backgrounds, such as simulating paper textures beneath a model. Watermarks can also be 
used to place logos and other graphics directly on the screen. Watermarks are part of 
Sketchup's new styles system for easy management. 

Sketchy Edges 
Sketchy Edges is a new way to render edges to look as if they were drawn by hand. Sketchy 
Edges are part of SketchUp's new styles system. 

Fog 
Add atmospheric haze to a model with the new fog display. 

3D Text Tool 
Now its easy to create signs and letters directly in SketchUp using the new 3D text Tool. 
Choose from simple outlines, filled surfaces and fully extruded 3d text using most fonts on 
your computer.  

LayOut 
SketchUp 6 features a set of LayOut tools for 3D designers who need a page layout 
program to communicate complex concepts. The new feature will provide simple tools to 
place, arrange, title and annotate SketchUp models, photographs and other drawing 
elements to assemble presentation and documentation graphics for both print and screen. 

Text and Dimension Improvements 
We've made the text and dimension tools more versatile by supporting font sizes that remain 
fixed relative to a model. We've also improved the quality on screen, in images and in 
printing. 

Speed 
SketchUp is now faster, up to 5x faster depending on models and hardware. 



 12

Force Inference Directions 
Now its easy to tell SketchUp exactly which direction you want using the arrow keys. Left = 
red, Up & down = Blue and, Right = Green. We've also added toggle functionality so you 
don't have to hold the keys down. 

Component, Materials, and Styles Browsers 
The components and materials browsers have been streamlined to improve ease-of-use. 

Intersect Tool 
We've made the intersect feature more robust. We've also added two new ways to intersect: 
Intersect Selected Only and Intersect With Context.  

Paste in Place 
Paste in place is an improvement to copy, cut, and paste functions. The precise location is 
remembered for quick placement of pasted selections. These enhancements are great for 
moving geometry in and out of components or groups without having to reposition your 
selection. 

Two-Point Perspective 
Two point perspective views are now possible in SketchUp. Easily recreate this classic style 
used by draftsmen and illustrators to create 3D renderings of buildings. 

Better Modifier Keys  
Use modifier keys to invoke operations like copy at any time during an operation.  

Native Support for 3D Warehouse and Google Earth 
Interaction with the 3D Warehouse and Google Earth is built into Google SketchUp Pro 6 
and no longer requires a plugin. 

  



 13

Learning SketchUp 
As with any software tool, there is a minimum level of learning you must do to attain 
proficiency with SketchUp. The following information can help you learn how to use 
SketchUp. 

 

Video Tutorials 
Google has created several video tutorials to facilitate learning of the SketchUp tools and 
drawing procedures. View these tutorials through the View Tutorials menu item in the Help 
Menu (Help > Video Tutorials). You must be connected to the Internet to access these 
tutorials. 

Self-Paced Tutorials 
Google has also created several self-paced tutorials to help you learn SketchUp. Access 
these tutorials through the Self-Paced Tutorials menu item in the Help Menu (Help > Self-
Paced Tutorials). You must be connected to the Internet to access these tutorials. 

Online User's Guide 
This online user's guide contains a Concepts section for users who are new to working in 
three dimensions or new to SketchUp. This section is meant to be read sequentially before 
using SketchUp for the first time. You must be connected to the Internet to access this 
guide. 

Menus 
Most SketchUp commands are accessible using both tool buttons and drop-down menus. 
Examine SketchUp's menus to become familiar with the breadth of features.  

Instructor 
Enable the Instructor (Window>Instructor) to display information related to the currently 
selected tool.  
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Quick Reference Card  
The SketchUp Quick Reference Card, available in the SketchUp Help Menu and on the 
sketchup.google.com, contains a list of all of toolbar tools and their modifier keys. Examine 
the SketchUp Quick Reference Card to become familiar with using SketchUp's tools. Click 
on the Help>Quick Reference Card menu item to display the Quick Reference Card . 

The Status Bar  
The Status Bar, located at the bottom of the SketchUp  Drawing Area, displays tips for the 
active tool, including special functions accessible using keyboard shortcuts. Watch the 
status bar while you are working in SketchUp to discover advanced capabilities of each of 
the SketchUp tools. 

User Forum 
The SketchUp forums are a great way to contact others in the SketchUp user community. 
These forums provide a unique environment for you to obtain help, suggest new features, 
offer advice, and share your models. Visit the SketchUp user forums by clicking on the 
SketchUp Community menu item in the Help Menu (Help > SketchUp Community). You 
must be connected to the Internet to access the user forums. 

SketchUp Training 
Google provides training courses for users who want extra assistance with SketchUp from 
the experts at Google. Visit http://www.sketchup.com/training to see a list of training courses 
available in your area. 
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Concepts 
This section of the user's guide covers the numerous 3D design and SketchUp concepts 
found within the product and in the user community. This section was primarily written for 
users who are new to 3D modeling or SketchUp.  

Note - This section does not cover how to do something in SketchUp, but 
covers important concepts necessary to model in 3D. 

 
This section is organized into the following topics: 

• Designing in Sketchup - Introduces you to the basic concepts behind drawing accurately in 
SketchUp.  

• Drawing Quickly - Introduces you to SketchUp tools and concepts necessary to draw 
quickly. 

• Viewing Models in 3D - Presents the concept of the camera and manipulation of a model in 
3D space. 

• Adding Detail to Your Models - Introduces you to mechanisms to quickly add realism to 
your SketchUp models. 

• Presenting Your Models - Presents concepts related to the presentation of your models to 
clients. 

• Modeling Terrain and Organic Shapes - Presents concepts related to working with mesh 
tools to create both terrain and organic shapes. 
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Designing in SketchUp 
SketchUp models are fundamentally created by joining lines as the edges of the model. 
Faces are automatically created when any three or more lines or edges are in the same  
plane (an infinite flat 2D space), or  coplanar, and form a closed loop. These edge and face 
combinations are combined to create 3D models. The following image shows three 
unconnected coplanar lines. These lines were drawn with the  Line Tool (this tool looks like 
a pencil).  

 
The following image shows four connected coplanar lines and the subsequently created flat, 
2 dimensional, face. 

 
  

 Note - Everything you draw in SketchUp is generically referred to as  
geometry.  

To create a 3D model, simply draw up or down in the blue direction (parallel to the blue 
axes). The coordinate system (axes) is covered later in this section. The following image 
shows the first line created in 3D space. 
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As you continue to draw lines, following the colored axes, faces are created. The following 
image shows four faces created simply by drawing lines parallel to the three axes directions 
(red, green, and blue).  

 
There is one line left to draw to finish a 3 dimensional box. Notice that when this one line is 
drawn in, two faces are created (the top and front faces). 
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You can do a lot in SketchUp simply by drawing lines to form faces using the Line Tool. And, 
you can draw lines starting anywhere (on another line, on a face, at a point, and so on). Can 
you recognize the previous 3D box within the model of the following house? 

 
Look around the room you are in. Notice how everything you look at has faces. Some faces 
might be rounded, some might be flat. Additionally, everything has edges that bound the 
face, such as the edge of a shelf in a bookshelf. 

Note - SketchUp is not the same as  Computer Assisted Design or CAD. 
CAD applications are designed specifically for representing concrete 
information, while SketchUp is for exploration and design of concepts and 
ideas (though you are not prohibited from designing models that are as 
concrete or accurate as those designed in CAD).  

 SketchUp files can be imported into several different CAD applications for further 
processing and several different CAD files can be imported into SketchUp to quickly create 
3D models. 
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Introduction to Entities 
As mentioned previously, lines are combined to create faces in SketchUp. Lines (also called 
edges) and faces, are just two of the many building blocks (called entities) used for creating 
models in SketchUp. A full list of SketchUp entities follows. 

Name Notes 

Line Lines in SketchUp are straight. Lines, also referred to as edges, are 
the most basic building block for all SketchUp models.  

Face Faces are created automatically when three or more coplanar edges 
form a closed loop. Faces have a front side and a back side. 
SketchUp attempts to put the front side of all faces on the outside 
(facing out) of all of your models, though sometime you might have to 
tell SketchUp the direction for your faces.  

Circle Circle, arcs, and curves are comprised of several lines or edges. 

Arc   

Polygon   

Curve   

 Polyline   

Group Group entities are used to combine two or more entities in your model 
for quick operations such as a copy. 

Component Component entities are like groups but can be reused in all of your 
SketchUp models. Components are just SketchUp models used within 
other SketchUp models. 

Guide Line A Guide Line entity is a temporary line used as a drawing guide. 

  

Dimension A notation indicating length of an edge or a radius.  

Surface Surface entities are the result of combining a number of faces to give 
the impression of smoothness. 

Section Plane   

Image An imported raster, or pixel-based, image. 

Text Text can be unattached (floating) or attached to a specific entity using 
a leader line.  

The SketchUp Coordinate Systems 
SketchUp uses a 3D coordinate system whereby points in space are identified by position 
along three drawing axes: plus or minus X, Y, and Z (above ground/below ground) values. In 
SketchUp, plus or minus X is represented by solid red and dotted red lines respectively; plus 
or minus Y are represented by a solid green and dotted green axis lines respectively; plus or 
minus Z (above and below the ground plane) are represented by solid blue and dotted blue 
lines respectively. The plane where the red and green axes lines lie is called the  ground 
plane. Finally, the term  origin, is used to define the place where all of axes lines start or 
originate.  
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The following image shows the drawing axes in SketchUp (the lines have been thickened to 
make the axes easier to read). The black circle represents the origin.  

 
Understanding SketchUp’s coordinate system is important because SketchUp’s inference 
engine (explained next) provides you help with drawing accurately.  

Following the Inference Engine 
SketchUp has an invisible inference engine to help you draw accurate and realistic models. 
The inference engine locates or infers points from other points in your model, such as the 
center of a circle, the midpoint of a line, a line that is perpendicular to the ground plane, a 
point on a face, a point on an edge, and so on.  

SketchUp notifies you of these points by using both color indicators and tool tags, which are 
on-screen messages indicating the location of the cursor as you draw an entity. For 
example, SketchUp displays the string “On Face" when the cursor is touching a face. The 
following image contains five common inference  tool tags.  

 
Additional information on the inference engine, including inference types, is in the User 
Interface section of this guide. 

The first step to drawing in SketchUp is to learn how to draw accurately by following the 
cues of the inference engine. Simply select the Line Tool (it looks like a pencil in the tool 
palette) and start drawing. Pay attention to the on-screen  tool tags from the inference 
engine as you draw. Most everything you will create in SketchUp can be created by 
inference using the Line Tool.  

You can move on to learning how to draw quickly after you master using the inference 
engine.  

 = Functionality only available in SketchUp Pro 
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Drawing Quickly 
As mentioned in the Design in SketchUp topic, you can use the Line Tool and the inference 
engine, to draw just about anything in SketchUp. It is recommended that you use the Line 
Tool and inference engine to create your initial models.  

Tip - Learn to draw accurately before you learn to draw quickly and you 
will master SketchUp in a shorter amount of time. 

SketchUp implements several concepts which you will use to help you draw quickly. These 
are dividing and healing, pushing and pulling, sticky geometry, autofold, and intersections. 

Dividing and Healing Geometry 
Some tools speed up design dramatically by allowing you to perform modifications on 
existing geometry. For example, the Line Tool allows you to split faces and edges to create 
additional independent faces and edges. Simply divide the face or edge with another edge. 
This concept is similar to cutting a piece of paper in half and having two separate remaining 
pieces. The following image shows how two faces are created when dividing the face with a 
line. Notice the image on the left has one solid top face, while the image on the right has two 
independent faces when split with a line. Note that the dividing line does not cut through the 
model from top to bottom, but just cuts the top face in half. 

 
  

The following image shows how the edges at each end of the face have been split to create 
additional edges. Note four edges bounding the face in the left image, while four edges 
bounding each of two faces in the image on the right (the middle edge being common to 
both top faces).  
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If you remove the line that shared by the two faces in the image on the right, the two faces 
will be glued back together or healed back into one face. It is common in SketchUp to 
perform these dividing and healing operations to your model.  

Pushing and Pulling 
The Push/Pull Tool allows you to take any non-curved face in SketchUp and push it away or 
pull it toward a starting point (these operations are also referred to as extrusions). Pushing is 
the process of reshaping a portion of your model by shrinking the portion away from its 
starting point and along a single axis. The following image shows the right-most face of the 
split face (shown earlier) pushed down toward the ground plane. 

 
In the previous image, there are eight faces that can be pushed, can you find them (some 
are hidden out of view)? 

Pulling is the process of expanding a portion of your model away from the starting point 
along a single axis. The following image shows the same face having been pulled up toward 
the sky. Any face in SketchUp can be pushed and pulled (with some minor limitations). 
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In both of the images, the left side of the cube remained the same size, while the right side 
was pushed and pulled (shrunk and expanded) independently. The Push/Pull Tool is one of 
the most commonly used tools in SketchUp to add the sense of volume to your model. 

Manipulating Connected Faces 
Geometry in SketchUp is sticky meaning that it can be manipulated (skewed, distorted, or 
folded) by selecting an edge or face and moving the edge or face with the Move Tool 
(causing all entities attached or "stuck" to the edge or face to move too). Following are three 
examples of sticky geometry in SketchUp: 

1. The following image shows a line dividing the top face of a box being moved up with a 
Move Tool. The faces that were connected to the middle line followed the line as it was 
moved to create a roof-like effect. 

 
  

2. The following image shows the left-most top face being moved down in the blue direction. 
This action causes the right-most top face to angle to create a slant on one side.  
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3. Finally, the following image shows the left-most top-edge being moved to the left. The 

model is skewed into a trapazoid-like shape. 

 
Be sure to use the Move Tool to grab and move edges and faces while you begin to 
experiment with modeling in SketchUp.  

Tip - Experimentation and play is highly important in learning how to 
draw in SketchUp! Learn how to draw accurately first, then learn how to draw 
quickly using the concepts in this portion of the user's guide. 

Autofold 
Faces must remain planar at all times in SketchUp. Therefore, SketchUp will Autofold, or 
score, faces as necessary to accommodate any operation that will result in warped faces.  

 
In the left-most image above, a six-sided polygon volume's top face (created with the 
Polygon Tool followed by the Push/Pull Tool) was rotated using Rotate Tool. Because of 
SketchUp's sticky nature, the sides of the shape, which share common edges with the top 
face, twisted and folded with the rotate operation (right-most image). 
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What you are not seeing is that SketchUp has created hidden geometry when performing 
this Autofold operation. The following image shows the 3 dimensional shape with the hidden 
geometry shown (dotted lines). Notice that each twisted faces are actually comprised of two 
triangular faces. 

 

Intersections (Boolean Operations) 
SketchUp allows you to easily create complex geometry by intersecting two geometrical 
forms, such as a box and a tube, creating new edges where the elements intersect, merging 
the geometry, and subtracting parts of the combined geometry.  

 
In the left-most image above, a cylinder shape was moved into a cube shape. Notice, that 
no lines appear where the two shapes intersect, indicating that the shapes have not truly 
merged. A special tool, called the Intersect with Model Tool, is used to create intersection 
lines (the middle image), merging the two shapes together to form one new shape. Finally, 
the cylinder shape is deleted (using the eraser tool on the cylinder's edges) and because the 
intersection lines were created, the resulting curved face is left within the cube creating a 
new complex geometrical shape (right image). 
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SketchUp Tools 
Most entities in SketchUp, including arcs and circles, are actually just a combination of small 
lines or edges. Thankfully, you do not have to use only the Line Tool to sketch your models. 
Instead, SketchUp provides many other tools to help you draw quickly. Some of these tools 
are for creating common entities such as a circle, arc, polygon, or freehand line. Other tools 
allow you to quickly draw complex models by modifying your models (splitting, skewing, and 
even merging geometry together).  

Tools in SketchUp are divided into five categories: principal tools (tools that are used a lot to 
select and modify geometry), drawing tools (tools used to create geometry), modification 
tools (tools used to modify existing geometry), construction tools (tools used to create guide 
lines or points, and document your model), camera tools (tools used to view geometry; 
discussed later), and walkthrough tools (tools to explore your model). The following table 
lists all of the Drawing and Modification tools: 

Tool Type Notes 

Line Drawing Can be used to create, intersect, or divide a face or other line 
(edge) 

Arc Drawing Can be used to create, intersect, or divide a face or other line 
(edge) 

Freehand Drawing Can be used to create, intersect, or divide a face or other line 
(edge) 

Rectangle Drawing Can be used to create, intersect, or divide a face or other line 
(edge) 

Circle Drawing Can be used to create, intersect, or divide a face or other line 
(edge) 

Polygon Drawing Can be used to create, intersect, or divide a face or other line 
(edge) 

Select Principa
l 

Used to select entities 

Eraser Principal Used to delete geometry and heal faces 

Paint 
Bucket 

Principal Used to apply materials (combinations of color and texture) 

Position 
Texture* 

Modificatio
n 

Used to manipulate materials painted on a surface.  

Move Modificatio
n 

Used to move, distort (autofold), and copy entities 

Rotate Modificatio
n 

  

Scale Modificatio
n 

  

Push/Pull Modificatio
n 

Used to expand and shrink geometry 

Follow Me Modificatio
n 

Used to duplicate a profile along a path 



 27

Intersect 
With Model* 

Modificatio
n 

Used to create complex geometry by piecing together separate 
geometry 

Offset Modificatio
n 

  

3D Text Construction Used to draw 3 dimensional text geometry 
Tape 
Measure 

Constructi
on 

Used to get a measurement and create guide line entities 

Protractor Constructi
on 

Used to set angles 

Axes Constructi
on 

  

Dimensions Constructi
on 

Used to calculate and display a dimension 

Text Constructi
on 

  

Section 
Plane 

Constructi
on 

Used to create section cut effects 

 *These menu items are available in menus, not from the tool palette, and are discussed in the 
tools sections of this user's guide. 

Each of these tools is discussed further in this guide. As a recommendation, however, learn 
the Line Tool and Eraser Tool first, followed by the Orbit Tool (discussed in the next 
section), Push/Pull, and Move Tools. 

 Note - Most drawing tools can perform modifications as well, such as the 
Line Tool being used to draw a line to divide a face. 
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Viewing Models in 3 Dimensions 
SketchUp implements the concept of a camera to represent your  point of view of the model. 
Simply, you (the user) are treated as though you were a camera looking at your model as 
you work. This concept is particularly important when your model is something that you want 
to tour, such as a house, as though you were walking through it in the real world. In this 
case, SketchUp allows you to change your point of view to a specific height and angle to the 
model and walk through the model as though it were real.  

Manipulating the Camera 
You can manipulate the camera (your view) in a number of ways to aid you in your 
designing. The first, called an orbit,  

  

Camera Tools 
There are other ways to manipulate the camera (your point of view) in SketchUp, including 
zooming in and out and panning. The following table lists all of the camera tools in 
SketchUp: 

Tool Type 

Orbit Camera 

Pan Camera 

Zoom Camera 

Zoom Window Camera 

Zoom Extents Camera 

Position Camera Walkthrough 

Walk Walkthrough 

Look Around Walkthrough 

Perspective and Paraline Projections 
In addition to your point of view, you can view items in SketchUp in a paraline (also called 
axonometric) projection or in a  perspective projection. Axonometric means “measurable 
from the axes” and an axonometric projection is a view of a model in which lines appear 
parallel in both 3 dimensional and 2 dimensional space. Also, lines have a length that is to 
some scale in an axonometric projection when printed (for example 4' in SketchUp = 1" on 
paper). The following image shows a axonometric or paraline projection, notice how the roof, 
and wall lines appear parallel. 
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Perspective, however, distorts the view such that it represents the model as though the lines 
were vanishing to a horizon (certain items appear closer while other items appear to be far 
away; entities are not to scale). The following image shows a perspective projection. 

 
SketchUp defaults to a perspective view, but can be toggled into a paraline view for those 
who prefer a point of view that is similar to what you would see when drawing 3D objects in 
a 2D space (such as when drawing a cube on flat paper). 

 Note - The iso camera view in SketchUp is not the same as an isometric 
projection in which anything along the x, y or z axis are in proportion. This view 
simply shows you ¾ of your model and is a standard camera angle for viewing 
models in a 3D space.  

Layers 
SketchUp layers are used to control the visibility of geometry within large models. A 
SketchUp layer is an attribute with a name, such as "Layer0," "Layer9," or "Chairs." 
Elements can be assigned different layers. For example, all Component entities that are 
chairs can be assigned to the "Chairs" layer. This layer can be then be hidden temporarily to 
hide everything on the layer from view. 

 Note - Geometry on one layer is not separated from geometry on 
another layer. For example, faces sharing a common edge will both be 
affected by a modification to that edge regardless of what layer the faces are 
on.  
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Default "Layer0" 
There is one Layer, Layer0, in SketchUp, by default. All entities are automatically placed on 
this layer unless you create another layer, designate the new layer as the active layer, and 
create entities on the new layer. 
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Adding Detail to Your Models 
You will likely want to create progressively more detailed models as you become more 
proficient with SketchUp. SketchUp contains several features allowing you to quickly create 
detailed or life-like models. These features include components, materials, shadows, and 
styles. 

Materials 
SketchUp allows you to paint materials on faces to add detail and realism to your models. 
Materials are essentially paints that have a  color and optional texture (defined within a 
image file). For example, a siding material with the color of grey and an appearance or 
texture simulating real overlapped composite siding. Following is a building painted with grey 
composite siding and grey shingle roofing materials. A grass material is also used on the 
ground. 

 
As with components, SketchUp comes with a library of materials. You can paint these 
materials on your models using the Paint Bucket Tool. Additionally, you can create your own 
materials within SketchUp (using the color wheel), or by importing texture-like images (such 
as the image of a wood flooring). In fact, you can import an entire image of a real-world 
object (such as a picture of a car), and manipulate it over your 3D model to give your model 
a truly realistic appearance. 

Default Material 
Geometry in SketchUp is assigned a default material as it is created. The default material 
can be changed by painting the geometry with a material. 

Material Transparency 
Materials also have a opacity property (a number between 0 and 100%) allowing you to 
create materials that behave like glass. Paint these materials on faces to create windows.  
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Faces have two sides. SketchUp materials are normally applied to a single side of a face at 
a time. Painting a default colored side with transparent material will result in both sides of 
that face being treated as transparent allowing the surface to be transparent when viewed 
from both sides. If the back side of a face has already been painted with some non-
transparent material, applying a transparent material to the front side will not cause the back 
side to also display as transparent. Likewise, if you paint the back side of a face with a 
different transparent material, it will not effect the front side. Thus, by specifically applying a 
material to both sides, it is possible to have transparent faces that can have different colors 
and levels of transparency on each side. 

Groups and Components 
Groups and  components are entities that can hold other entities. Groups are commonly 
used to combine several entities into a single entity for the purposes of performing a quick 
operation on the group (such as a copy or move). For example, you might draw a model, 
group the entities that compose model and move the entire model. The characteristics of 
groups are: 

• Quick selection. When you select a Group, all elements within that group are selected as 
well. 

• Isolation of geometry. Entities within groups are protected from the rest of the model. 
Geometry outside of the group does not affect the geometry within the group 

• Model organization. Groups can be nested within other groups resulting in hierarchical 
collection of subgroups. 

• Group material. The group as a whole can be assigned a material of its own, which is 
separate from the materials painted on individual entities within the group. See the 
Materials section within this topic for further information. 

• Drawing Axes. Groups maintain their own internal drawing axes. 

• Alignment and Hole Cutting. Groups have a special behavior that allows them to properly 
align themselves and stick to faces on which they are placed (as well as cut holes in those 
faces).  

Components are just a group with special behaviors, namely behaviors allowing them to be 
inserted in other models. For example, you might create a model of a car that you want to 
bring into other SketchUp models, such as the model of a house. Any models you create 
can be a component. 
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Components have the following characteristics, in addition to the characteristics of groups: 

• Instancing Behavior. Each copy of a component that you insert into a model is considered 
an instance of a  component definition.  The component definition is the blueprint that 
defines the appearance and behavior of all component instances (created when you insert 
the component in the model). Editing a component instance edits the definition and all 
instances accordingly. However, some actions, such as scaling an instance, only affects 
the instance itself. 

• Improved Performance. Components allow SketchUp to more efficiently use your 
computer's resources because the information necessary to describe a component is only 
stored once, in the component definition, and then referenced for every component 
instance.  

• Drawing Axes. Components display their own internal drawing axes when you are editing 
the component. 

• Alignment and Hole Cutting. You can define alignment and hole cutting behavior when 
creating components (it is automatically defined for groups). 

 Note - You can define the characteristics of the component during 
component creation.  

Group and Component Context 
Entities within a group or component are said to exist within the group or component's scope 
or context. You can modify a group or component as a whole (affecting all of the entities 
within the group or component) or edit the group or component's individual entities (within 
the group or component's context). Additionally, you can nest components within other 
components, groups within components, components within groups and so on. The following 
image shows a shelf component has been selected (as indicated by the yellow selection 
color) using the Select Tool. This shelf is composed of several subcomponents, such as 
slats. 

 



 34

The following image shows the shelf component being edited. Notice that it has a dashed 
bounding box to indicate you are in the component's context. In this case, a subcomponent, 
one of the slats in the shelf, has been selected. That slat is within the context of the shelf. 
Also notice that the component's axes are displayed in the lower left-hand corner. 

 
Finally, the following image shows the slate component being edited. Notice now that there 
is a dashed bounding box around the component, and around the slat being edited. The 
entities, such as the lines and face, that compose that individual slat are said to be in the 
context of the slat. 

 

Component Libraries 
Component libraries have been created and included with SketchUp to allow you to easily 
add detail to your models. These components range from standard architectural 
components (doors, windows, and so on) to people, cars, trees, and geometric shapes. You 
can also create your own libraries of components from pre-existing components or 
components you create yourself. 
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 Note - Additional industry-specific content libraries are available on the 
SketchUp web site under the download section (www.sketchup.com). 

Component Axes 
Components have their own axes which, by default, are aligned to the global axes in the 
drawing area. These axes can be moved affecting component placement in the model.  

Cutting and Gluing Behavior 
Components, such as doors and windows, can be designed such that they can be placed on 
specifically-oriented surfaces such as vertical wall surfaces. This behavior is referred to as 
the gluing behavior of a component. 

Additionally, components can be designed to automatically cut holes in surfaces, such as in 
the case of a window component being able to cut a hole in a wall. This behavior is referred 
to as the cutting behavior of a component.  

Layers, Groups and Components 
Layers are a mechanism for controlling the visibility of entities within a model. Entities can 
be assigned to different layers in a model and those layers, and their contents, can be 
displayed independently. Groups and Components are used to isolate geometry as sub-
models within an overall model, such as a component of a chair within a model of a room. 

 Note - Entities within a group or component can be on several different 
layers.  

Styles 
A style is a predefined set of display 
settings that can be applied to a model, and the drawing area, to give it a specific look-and-
feel. A style can consist of a specific edge type, face type, sky and background color, 
watermark, and other drawing area effects (such as the color used to represent selected 
geometry). SketchUp has multiple styles, some best used while drawing a model (because 
they don't use any intensive rendering effects), others are best suited for printing or 
presenting a model (because they use rendering effects to give a model a hand-drawn 
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appearance). For example, a pre-defined style might have an edge type of jitter edges, a 
face type of hidden line mode, a background color of white, a sky color of blue, a ground 
color of brown, and so on. 

Sketchy Edges 
SketchUp allows you to apply various edge types, including hand-drawn sketchy edges, to 
your model. Sketchy edges are edges that can be unique from any other edge style in 
SketchUp because, unlike other pre-defined edge types, you can create your own sketchy 
edge using a drawing program like PhotoShop. Sketchy edges are simply a collection of 
different hand-drawn strokes that, when combined and applied to model, give the a model a 
unique hand-drawn appearance.   

Watermarks 
Watermarks are images placed in the background or foreground of the drawing area and 
span the entire area just as sky and ground. Watermarks are great for creating 
backgrounds, such as simulating paper textures beneath a model. Watermarks can also be 
used to place logos and other graphics directly on the screen.  

  

Shadows 
SketchUp allows you to cast shadows on your model as though the model were in a real-
world environment. These shadows can be cast based on time of day and virtual location of 
the model in the real-world. For example, you can set shadows to see exactly what a model 
of a house would look like at 10:20 am, December 10, in Boulder, Colorado, which is the 
default location. Finally, SketchUp's shadows are designed to provide dynamic feedback as 
you change geometry and your camera viewpoint. The shadow casting feature in SketchUp 
is a great way to give your models a better sense of depth and realism.  
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 Note - While SketchUp's projected shadow angles are accurate, the 
rendering effect is not intended to be photo-realisitc. Fortunately, SketchUp 
can export models to other many other applications that excel at photo-
realistic renderings. 

Ground Shadows 
Ground shadows use the faces in your model to create a flattened set of faces on the 
ground plane. These faces are colored and positioned based on the background color and 
the angle of the sun. Although faster than face shadows, the illusion that ground shadows 
provide only works on the ground plane. The following figure shows a model whose 
geometry all lies on or above the ground plane. 

 

Note - Ground shadows create unexpected geometry, called  artifacts, 
when your model contains geometry beneath the ground plane. Ground 
shadows works well for models with solid color backgrounds and in which all 
geometry is above the ground plane. 

Face Shadows 
Face shadows use the sun angle to project shadows based on the location of faces relative 
to other faces. For example, a shadow is cast on the stairs in the following figure, based on 
the face of the vertical 3d rectangle. The calculation used to create face shadows is 
processor-intensive, however, and will slow down performance with large models. 

 

Note - Faces with less than 70 percent opacity are considered 
transparent, and do not cast shadows. Faces with 70 percent opacity or 
greater cast shadows. Transparent faces cannot receive shadows. The 
following image shows a transparent (less than 70% opacity) rectangle that 
does not cast a shadow (left) and a opaque (70% or greater opacity) rectangle 
that does cast a shadow (right). 
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The two shadow systems are designed to be complimentary, and you may often wish to 
have both types enabled simultaneously. 
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Presenting Your Models 
There are several things you can do after you create a model. For example: 

• You can add dimensions, section cut effects, and other entities to your model for use in 
documenting the actual physical item. 

• You can present the model within SketchUp as an animation. 

• You can print your model 

• You can export all or portions (such as a section slice) of the model for post processing in 
another application 

Section Cut Effects 
SketchUp allows you to create section cut effects which are the result of slicing through your 
model to see and work inside its interior. The following image shows a model of a building 
with a section cut affect active allowing the designer to work inside the model or present 
interior detail to a client.  

  

 
The following model shows the section cut effect resulting from slicing through the model of 
a cup. 
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Section Planes 
Section cut effects are created by section planes which are special entities used to control 
the selection, placement, orientation, direction, of the  section slice. Section planes are 
generated using the Section Plane Tool. 

 
The previous image shows a section plane entity intersecting the cup and creating a section 
slice through the cup. 

Section Slices 
The term section slice refers to the edges that are highlighted after intersecting geometry 
with a section plane. The following image shows a section slice in red.  
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These edges act as dynamic virtual edges in that they continually change as you move the 
section plane through your model with the Move Tool. You can create a group from these 
edges, such as when slicing horizontally through a house, to create a wire frame of the 
model (such the outline of a floor plan). Then, export this section slice for use in a CAD 
program to add additional detail (such as wall construction detail).  

Animations 
SketchUp allows you to create different scenes, similar to slides in traditional presentation 
software, each containing different settings for your model (point of view, section cut effects, 
and so on). These scenes can be combined and executed sequentially as an animation. The 
animation engine can be set to gradually transition between effects on different scenes for a 
truly dynamic presentation. 
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Modeling Terrain and Organic Shapes 
SketchUp implements the concept of a sandbox which refers to a surface that can be 
generated and manipulated using sandbox tools. A sandbox in SketchUp (and in other 3D 
modeling tools) is commonly referred to as a triangulated irregular network or TIN in terrain 
modeling terminology. The following image shows a TIN (sandbox) in SketchUp.  

 

 Note - This documentation uses the term TIN, sandbox, and terrain 
interchangeably. A TIN is like a sandbox because it has a boundary and 
contains a sculpted surface (sand). Sandbox tools are those tools that are 
included in SketchUp for creating and manipulating TINs. 

The following image shows a TIN in SketchUp with hidden geometry displayed (so you can 
see the triangles that are the foundation of the TIN). 

 
There is nothing special about a TIN, it is simply several connected triangular faces that, 
when smoothed, appear like one continuos smooth surface. Note that you are not limited to 
creating terrain with the sandbox tools, you can create other organic shapes (shapes that 
appear to be crafted by hand) using these tools. For example, you might create a person's 
face, a bowl, or a swimming pool using the sandbox tools. 

Another type of TIN-like surface, which the sandbox tools can work with, is called a polygon 
mesh. A polygon mesh is similar to a TIN, but contains faces with more than three vertices.  

 Note - SketchUp's Sandbox From Scratch Tool and Sandbox From 
Contours Tool only create TINs, but you can import a polygon mesh or create 
a polygon mesh (manually) using other SketchUp tools. 
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Triangulation 
Triangles in a TIN can be oriented in different directions. The orientation of triangles is 
referred to as triangulation. Notice in the previous image that some triangles are oriented 
vertically while others are oriented horizontally. This concept is important because some 
sandbox tools allow you to change the direction of the triangles as a way to further smooth 
TINs. 

Creating a TIN 
There are several ways to obtain a starting TIN as the foundation of your model. These are: 

• Create or import contour lines and use the Sandbox From Contours Tool to create a TIN. 

• Import an image of a site plan or contour map and trace its contours with the Freehand 
Tool. Then, adjust the contours to their proper elevation and use the Sandbox From 
Contours Tool to create a TIN. 

• Import a TIN using the SketchUp ArcGIS Plug-in available at  
www.http://www.sketchup.com/markets/gis.php. ArcGIS is an industry standard application 
suite or Geographic Information System for working with geographical information such as 
the location of buildings within a world-wide global coordinate system. 

• Import a digital terrain model (DTM) file.  

• Create sandbox (TIN) using the Sandbox From Scratch Tool. 

Modifying a TIN 
SketchUp contains several tools for modifying TINs. The following table lists all of the 
sandbox tools in SketchUp. 

Tool Type Notes 

Sandbox 
From 
Scratch 

Create 
TIN 

Creates a flat, rectangular shaped, TIN or sandbox that can be 
modified by other sandbox tools. 

Sandbox 
From 
Contours 

Create 
TIN 

Creates TIN or a sandbox from contour lines at various elevations. 

Smoove Large 
Modificati
ons 

Allows you sculpt or make large modifications to a TIN by moving 
groupings of vertices to create hills, berms, or other features. 

Stamp Large 
Modificati
ons 

Allows you to sculpt or make large modifications to a TIN by 
stamping footprints into the TIN, such as the footprint of a building. 

Drape Large 
Modificati
ons 

Allows you to drape the outlines of roads, paths and buildings, 
drawn on a flat plane, onto a TIN.  

Add Detail Small, 
Detailed, 
Modificati
ons 

Allows you to sculpt or make small, detailed, modifications to the a 
TIN by adding additional triangles to a TIN. 

Flip Edge Small, 
Detailed, 

Allows you to sculpt or make small, detailed, modifications to the 
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Modificati
ons 

TIN by adjusting the triangulation of a TIN. 

  

 Note - The sandbox tools can also be used to create organic geometry 
or geometry that appears to be hand-crafted. 

Functional Terrain 
The term functional terrain is used to describe terrain that has no portion bending back upon 
itself creating overhangs, underhangs, or caves. If you draw a vertical line through your 
terrain at any point and the line only touches the terrain at one point, your terrain is 
functional.  

This concept is important because certain tools, such as the Smoove Tool, can create 
unexpected results when working on nonfunctional terrain (the neighboring points included 
in the sculpting operation by the Smoove Tool are often undesirable).  
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The SketchUp User Interface 
This section of the user's guide covers the SketchUp user interface, including menus, 
toolbars, dialog boxes, and the drawing area.  
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Introduction to the SketchUp Interface 
The SketchUp user interface is designed to be simple and easy to use. The main parts of 
the SketchUp user interface are the title bar, menus, toolbar and tool pallets, drawing area,  
status bar, and the value control box.  

 

 Note - The previous image contains a screenshot of the Google 
SketchUp Pro application. The Google SketchUp (free) application looks the 
same. 

Title Bar 
The title bar (at the top of SketchUp) contains the standard Macintosh OS X window controls 
(close, minimize, and maximize) on the left, and a title bar collapse/expand button on the 
right. In the middle of the title bar is the name of the currently opened file. 

A blank drawing area appears when you start SketchUp and the name of the currently 
opened file is "Untitled" in the title bar, indicating that you have not yet saved your work. 

Menus 
Menus appear below the title bar. The majority of SketchUp tools, commands, and settings 
are available within these menus. The menus that appear by default are: SketchUp ,File, 
Edit, View, Camera, Draw, Tools, Window, and Help.  

Toolbar and Tool Pallets 

 
The toolbar, appearing below the menus, contains a set of user-defined controls. By default, 
the Toolbar contains controls for  Standard Views, Shadows and  Layers. Additional controls 
can be added using the View > Customize Toolbar menu item. 

The Tool Pallet, appearing on the left side of the application, contains most of the tools 
within SketchUp. 
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Drawing Area 
The drawing area is where you create your model. The 3D space of the drawing area is 
identified visually by the  drawing axes. 

Status Bar 
The status bar is the long gray rectangular area at the bottom of the drawing area. 

 
The left side of the status bar displays tips for the currently used drawing tools, including 
special functions accessible using keyboard shortcuts. Watch the status bar to discover 
advanced capabilities of each of the SketchUp tools. 

 Note - Use the resize handle to make the drawing area larger so you 
can see the entire message in the status bar. 

Value Control Box (VCB) 
The value control box (VCB) is located on the right side of the status bar. The VCB displays 
dimensional information while you draw. You can also enter values into the VCB to 
manipulate currently selected entities, such as creating elements of a specific dimension. 
Other behaviors of the VCB are as follows: 

• You can type a value in the VCB before or after an operation is complete as long as the 
value is entered prior to the start of a new operation. Detailed information on the VCB 
values accepted for each tool appears in the Drawing Tools and  Modification Tools 
sections of this user's guide.  

• You must press the Enter or Return key to accept a typed value. 

• You can change the value of the geometry as many times as you like before you start a 
new operation. 

• The VCB cannot be used again to enter values for a tool once you have exited the tool. 

• SketchUp will display a tilde (~) before the number to indicate that a number is not precise 
(not within precision settings as set in the Units panel of the Model Info Dialog Box). 

• It is not necessary to click in the VCB before typing. The VCB is always awaiting input from 
your keyboard. 

• You can type values in the VCB using an alternate measuring system than the default 
system. SketchUp will convert the value to the default system. For example, you can type 
in 3' 6" even if you are using metric system as your default. Units are set within the Units 
panel of the Model Info dialog box.  

Window Resize Handle 
To the right of the VCB is the window resize handle which is used to change the size of the 
drawing area. 

Scene Tabs 
Click on a scene tab to switch between the scenes in your file. Scene Tabs are created for 
each scene as each scene is created using the Scene Manager. 
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Scene Tab Context Menu Items 
Scene Tabs contain their own context menus. Context-click on a scene tab to access its 
context menu. 

Move Left/Move Right 
The Move Left and Move Right menu items are used to reposition a scene in the series of 
scenes. 

Add 
The Add menu item is used to add a new scene to the current file. 

Update 
The Update menu item is used to update a scene if you have made changes to the scene. 

Delete 
The Delete menu item is used to delete the currently selected scene. 

Scene Manager 
The Scene Manager menu item invokes the Scene Manager dialog box.  
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SketchUp Menu 
The SketchUp Menu contains menu items that control the SketchUp application, including 
items to show and hide SketchUp, application preferences, and the SketchUp license 
manager. 

About SketchUp 
The About SketchUp menu item activates the About SketchUp dialog box, containing the 
SketchUp version number, technical support contact information, and a link to the SketchUp 
web site. 

About Plugins 
The About Plugins submenu contains information about each SketchUp plugin, such as the 
3DS exporter.  

Preferences 
The Preferences menu item opens SketchUp's application Preferences for setting various 
global settings for the program. 

Keyboard Shortcut: Command+, 

License 
The License menu item displays SketchUp's licensing dialog box used to enter a new 
license, determine which licences are currently in use, and view a list of all available 
licenses. Directions for entering a new license should accompany any new license. 

Check for Update 
The Check for Update menu item checks to see if you have the most current version of 
SketchUp. You will be prompted to download the current version if your version is out-of-
date. A Internet connection is required to use this feature. 

Services 
The Services menu item provides access to Mac OS X's system-wide services, which might 
vary on different computers depending on additional functionality of your other applications. 

Hide SketchUp 
The Hide SketchUp menu item hides SketchUp and all of its open drawing windows, 
allowing you access to other programs running in Mac OS X. Clicking on the SketchUp icon 
in your Dock returns SketchUp to view. 

Keyboard Shortcut: Command+H 

Hide Others 
The Hide Others menu item hides all visible applications except SketchUp allowing you to 
focus on SketchUp alone. Clicking on any icon in the doc will return that application to view.  

Show All 
The Show All menu item unhides all running programs in Mac OS X. 

http://www.sketchup.google.com/
http://www.sketchup.google.com/
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Quit SketchUp 
The Quit SketchUp menu item quits SketchUp and closes all open documents. You will be 
prompted to save any unsaved work before SketchUp exits. 

Keyboard Shortcut: Command+Q 
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File Menu 
The File menu contains items that relate to SketchUp model files, including commands to 
create, open, save, print, import, and export model files. 

New 
The New menu item is used to create a blank drawing area and begin a new SketchUp 
model. SketchUp will use the settings in the template file to define the initial model state if 
you have selected a template file in  template panel under SketchUp > Preferences.  

Keyboard Shortcut: Command+N 

Open 
Use the Open menu item to launch the Open dialog box, allowing you to open a previously 
saved SketchUp file.  

Keyboard Shortcut: Command+O 

Problem Detection 
Minor problems can occur with your model given the infinite flexibility that SketchUp 
provides when designing in 3D. You likely will not notice anything different in your model, 
except that it will perform better, after these problems are fixed.  

SketchUp checks all files for problems when they are opened and saved if the Automatically 
check models for problems check box is checked in the General Panel of the Application 
Preferences. SketchUp displays a dialog box allowing you to fix problems if they are found. 
This dialog box has three options: Always fix my models, Fix it now, and Fix it later. Google 
recommends you click on the Always fix my models button in this dialog box to fix the 
problem. This button also checks the Automatically fix problems when they are found 
checkbox in the  General Panel of the Application Preferences. This preferences option 
causes SketchUp to automatically fix problems without user intervention. Refer to the 
Automatically fix problems when they are found option for further information. 

SketchUp will check your model for unrecoverable errors during the open, preventing the 
overwriting of a good auto-save file. Sketchup will display a dialog box in the rare case that 
unrecoverable errors are found in your model. This dialog box contain the option to quit 
SketchUp and send a report. Google recommends you click on the quit SketchUp and send 
report button to terminate SketchUp and preserve your previously valid auto-save file. This 
report contains valuable information regarding the unrecoverable errors.  

Open Recent 
Use the Open Recent submenu to quickly access recently opened SketchUp files. You can 
clear the list of recent files by selecting the Clear menu item from the end of the recent files 
list. 

Close 
The Close menu item closes the active drawing window. This action is the same as clicking 
on the close button in your drawing's title bar. You will be prompted to save your changes if 
the model in the active drawing window has not been saved recently. 

Keyboard Shortcut: Command+W 
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Save 
Use the Save menu item to save the currently active SketchUp model to your file system. 
When you close an unsaved document, or attempt to quit SketchUp with unsaved open 
documents, SketchUp will prompt you to save your work before continuing. 

Keyboard Shortcut: Command+S 

Tip -  If Create Backup is enabled within the  General panel of the 
preferences dialog box, the existing file will be converted to a backup file 
(.skb), and the new drawing will be saved in place of that currently existing file 
(.skp). The Create Backup option can help preserve your data in the event of 
an accidental removal of a .skp file. 

Tip -  It is good to save often. You can have SketchUp automatically 
save for you at a specific time increment by enabling the Auto-save option 
within the  General panel of the Preferences dialog box. 

Problem Detection 
Minor problems can occur with your model given the infinite flexibility that SketchUp 
provides when designing in 3D. You likely will not notice anything different in your model, 
except that it will perform better, after these problems are fixed.  

SketchUp checks all files for problems when they are opened and saved if the Automatically 
check models for problems check box is checked in the General Panel of the Application 
Preferences. SketchUp displays a dialog box allowing you to fix problems if they are found. 
This dialog box has three options: Always fix my models, Fix it now, and Fix it later. Google 
recommends you click on the Always fix my models button in this dialog box to fix the 
problem. This button also checks the Automatically fix problems when they are found 
checkbox in the  General Panel of the Application Preferences. This preferences option 
causes SketchUp to automatically fix problems without user intervention. Refer to the 
Automatically fix problems when they are found option for further information. 

SketchUp will check your model for unrecoverable errors during the save, preventing the 
overwriting of a good auto-save file. Sketchup will display a dialog box in the rare case that 
unrecoverable errors are found in your model. This dialog box contain the option to quit 
SketchUp and send a report. Google recommends you click on the quit SketchUp and send 
report button to terminate SketchUp and preserve your previously valid auto-save file. This 
report contains valuable information regarding the unrecoverable errors.  

Save As 
Use the Save As menu item to open the Save As dialog box which defaults to the current 
document's folder. You can use this dialog box to save the current drawing as a new 
document. This file can be assigned a new name, a new location, and a previous version of 
SketchUp. The new file will becomes the current file in the drawing window. 

Keyboard Shortcut: Shift+Command+S 

Problem Detection 
Minor problems can occur with your model given the infinite flexibility that SketchUp 
provides when designing in 3D. You likely will not notice anything different in your model, 
except that it will perform better, after these problems are fixed.  

SketchUp checks all files for problems when they are opened and saved if the Automatically 
check models for problems check box is checked in the General Panel of the Application 
Preferences. SketchUp displays a dialog box allowing you to fix problems if they are found. 
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This dialog box has three options: Always fix my models, Fix it now, and Fix it later. Google 
recommends you click on the Always fix my models button in this dialog box to fix the 
problem. This button also checks the Automatically fix problems when they are found 
checkbox in the  General Panel of the Application Preferences. This preferences option 
causes SketchUp to automatically fix problems without user intervention. Refer to the 
Automatically fix problems when they are found option for further information. 

SketchUp will check your model for unrecoverable errors during the save as, preventing the 
overwriting of a good auto-save file. Sketchup will display a dialog box in the rare case that 
unrecoverable errors are found in your model. This dialog box contain the option to quit 
SketchUp and send a report. Google recommends you click on the quit SketchUp and send 
report button to terminate SketchUp and preserve your previously valid auto-save file. This 
report contains valuable information regarding the unrecoverable errors.  

Save A Copy As 
Use the Save A Copy As menu item to save a new file based on your current model. This 
menu item does not overwrite or close the current file and is useful for saving incremental 
copies or tentative schemes of your work. 

Problem Detection 
Minor problems can occur with your model given the infinite flexibility that SketchUp 
provides when designing in 3D. You likely will not notice anything different in your model, 
except that it will perform better, after these problems are fixed.  

SketchUp checks all files for problems when they are opened and saved if the Automatically 
check models for problems check box is checked in the General Panel of the Application 
Preferences. SketchUp displays a dialog box allowing you to fix problems if they are found. 
This dialog box has three options: Always fix my models, Fix it now, and Fix it later. Google 
recommends you click on the Always fix my models button in this dialog box to fix the 
problem. This button also checks the Automatically fix problems when they are found 
checkbox in the  General Panel of the Application Preferences. This preferences option 
causes SketchUp to automatically fix problems without user intervention. Refer to the 
Automatically fix problems when they are found option for further information. 

SketchUp will check your model for unrecoverable errors during the save a copy as, 
preventing the overwriting of a good auto-save file. Sketchup will display a dialog box in the 
rare case that unrecoverable errors are found in your model. This dialog box contain the 
option to quit SketchUp and send a report. Google recommends you click on the quit 
SketchUp and send report button to terminate SketchUp and preserve your previously valid 
auto-save file. This report contains valuable information regarding the unrecoverable errors.  

Revert 
Use the Revert menu item to revert your current document to its last saved state. 

Send to LayOut 
Use the Send to LayOut menu item to send the current model to LayOut. 

3D Warehouse 
The 3D Warehouse submenu contains menu items for accessing the 3D Warehouse 
repository of models. 

Get Model 
Use the Get Models menu item to download a model from the Google 3D Warehouse.  
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Share Model 
Use the Share Model menu item to post your SketchUp model file and corresponding KML 
file to the Google 3D Warehouse. The Google 3D Warehouse is a repository where models 
can be shared with other Google Earth or SketchUp users.  

Export 
Use the Export submenu to access SketchUp's export functionality, which is useful for 
sharing your work with other people or exporting your drawings for use in other applications. 
You can export your SketchUp model as a 3D model, a 2D graphic, section slice, or 
animation. 

Google Earth 
Use the Google Earth menu item to export your SketchUp model as a KMZ file for use in 
Google Earth. Refer to the 3D Model (KMZ) Export topic for additional information on this 
menu item. 

 3D Model 
Use the 3D Model menu item to export you SketchUp file to 3D formats, such as KMZ files. 

Further file formats are available for export using Google SketchUp Pro. 

 2D Graphic 
Use the 2D Graphic menu item to export 2D bitmap and dimensionally accurate, resolution 
independent, 2D vector drawings. Pixel-based images can be exported in JPEG, PNG, Epix,   
and TIFF file formats.  

Vector images can be exported in PDF, EPS, DWG, and DXF file formats. This option 
makes it easy to send your SketchUp files to a plotter, quickly integrate them into 
construction documentation, or further modify your models using vector-based illustration 
software. Note that vector output formats may not support certain display options, such as 
shadows, transparency, and textures. 

 Section Slice 
Use the Export 2D Section Slice menu item to output dimensionally accurate 2D section 
slices in standard vector formats. 

 Animation 
Use the Animation menu item to export a pre-rendered animation file containing the scene 
sequence you have created. This option makes it easy to archive your animations to CD or 
DVD and to create smooth animations of complex models. 

Import 
Use the Import menu to import information from other files into your SketchUp drawings. 

Scene Setup 
Use the Scene Setup menu item to access the Mac OS X scene setup dialog box. This 
dialog box is used to select and configure printer and scene properties to use for printing. 
Consult the Mac OS X system help for more information about Scene Setup. 

Keyboard Shortcut: Shift+Command+P 
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Document Setup 
Use the Document Setup menu item to access to the Document Setup dialog box. This 
dialog box is used to configure the document properties prior to printing. 

Print 
The Print menu item opens the standard Print dialog box. This dialog box enables you to 
print the current model in SketchUp's  drawing area to the currently selected printer.  Consult 
the Mac OS X system help for more information about printing. 

Keyboard Shortcut: Command+P 

 = Functionality only available in Google SketchUp Pro 6 
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Edit Menu 
The Edit menu contains items allowing you to perform editing functions on SketchUp 
geometry. These menu items include those for creating and editing groups and components, 
visibility operations, and standard cut, copy, paste commands. 

Undo 
Use the Undo menu item to undo the last drawing or editing commands performed. 
SketchUp allows you to undo all operations you have performed, one at a time, to the state 
at which you saved your file. The number of possible sequential Undo commands is limited 
to 100 steps.  

Keyboard Shortcut: Command+Z 

 Note - Undo will undo any operation that creates or modifies geometry, 
but it does not undo changes to your point of view. Use the  Previous menu 
item under the  Camera menu to undo a point of view change. 

Redo 
The Redo menu item returns the last undo to its previous state. 

Keyboard Shortcut: Shift+Command+Z 

Cut 
The Cut menu item removes the selected elements from your model and places them in the 
clipboard. The contents of the clipboard can then be inserted back into any open SketchUp 
document by using the Paste menu item. 

You can use cut, copy and paste to move geometry between open SketchUp windows. 
Contents of the clipboard will remain on the clipboard until replaced with other content using 
an additional Cut or a Copy command. 

Keyboard Shortcut: Command+X 

Copy 
The Copy menu item copies the selected items to the clipboard without deleting the items 
from the model. The contents of the clipboard can then be inserted back into any open 
SketchUp document by using the Paste menu item. 

You can use cut, copy and paste to move geometry between open SketchUp windows. 
Contents of the clipboard will remain on the clipboard until replaced with other content using 
an additional Cut or a Copy operation. 

Keyboard Shortcut: Command+C 

Paste 
Use the Paste menu item to paste the contents of the clipboard into the current SketchUp 
document. The pasted geometry will be attached to and placed by the point of the cursor, 
allowing you to position the new geometry when it is pasted.   

You can use cut, copy and paste to move geometry between open SketchUp windows. 
Contents of the clipboard will remain on the clipboard until replaced with other content using 
an additional Cut or a Copy operation. 
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Keyboard Shortcut: Command+V 

Paste in Place 
Use the Paste in Place menu item to paste an item at the same location where it was cut or 
copied. 

Delete 
Use the Delete menu item to remove the currently selected entities from your model. 

Delete Guides 
Use the Delete Guides menu item to delete all of the guides that are in the drawing area. 

Select All 
Use the Select All menu item to select all selectable entities in the model. Hidden entities, 
any items on a hidden layer, or geometry that is clipped away using a section plane cannot 
be selected with the Select All menu item. 

Keyboard Shortcut: Command+A 

Select None 
The Select None menu item clears the selection set, deselecting any currently selected 
items in the model. 

Keyboard Shortcut: Shift+Command+A 

Hide 
Use the Hide menu item to hide any selected object. Hiding geometry can help simplify your 
current view, or enable viewing and working inside tight areas. 

Keyboard Shortcut: Command+E 

Unhide 
The Unhide submenu contains options for unhiding hidden entities.  

Selected 
The Selcted menu item unhides any selected hidden object. Ensure Show Hidden Geometry 
is enabled under the View Menu to view and select hidden geometry. 

Last 
The Last menu item unhides the last entities hidden with the Hide command. 

All 
The All menu item unhides all hidden entities in your current document. 

Keyboard Shortcut: Shift+Command+E 

Lock 
The Lock menu item is used to lock any component or group that you do not wanted to be 
able to be moved or edited.  
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Unlock 
The Unlock submenu contains options for unlocking components and groups. 

Selected 
Use the Selected menu item to unlock all components and groups in a selection set. 

All 
Use the All menu item to unlock all components and groups in your drawing area. 

Make Component 
Use the Make Component menu item to create a  component entity from the selected 
entities. 

Keyboard Shortcut: Shift+Command+G 

Keyboard Shortcut: Ctrl+C 

Make Group 
The Make Group menu item creates a group entity from the selected entities. 

Keyboard Shortcut: Command+G 

Close Group/Component 
Use the Close Group/Component menu item to exit from a group or component's context or 
editing session. 

Keyboard Shortcut: Control-Shift+Command+G 

Intersect 
The Intersect sub-menu contains menu items for intersecting geometry with other geometry. 

Intersect With Model 
Complex geometry in SketchUp can be easily created using the Intersect With Model menu 
item (also called the  Intersector). Use the Intersect with Model menu item to intersect all 
entities overlapping with the currently selected entity (such as a box component and a tube 
component).  

Keyboard Shortcut: I 

Intersect With Context 
Select the Intersect With Context menu item to intersect two entities within the current 
context (excluding all entities outside of the context). 

Intersect Selected Only 
Select the Intersect Selected Only to intersect only those items that are selected. 

Entity Commands Sub-Menu 
The Entity Commands sub-menu contains all of the commands available to manipulate the 
currently selected entity (which are the same as the commands found in the entity's context 
menu). The sub-menu's name and contents will change depending on the entity that you 
have selected. 
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Special Characters 
The Special Characters menu item opens the Mac OS X Character Palette allowing you to 
insert special characters, such as mathematical symbols, letters with accent marks, arrows, 
and other "dingbats," into your model. The Mac OS X help system contains additional help 
on this feature. 
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View Menu 
The View menu contains menu items that alter the display of entities within your model.  

 Note - Items in the View menu alter the display of entities. Items in the 
Camera menu alter your point of view.  

Tool Palettes 
The Tool Palettes submenu contains all of the tool palettes. There are two tool 
palettes: Large Tool Set and Google. The Large Tool Set palette contains all tools needed 
by advanced SketchUp users. The Google palette has tools for using SketchUp with Google 
Earth.   

Scene Tabs 
The Scene Tabs command toggles the display of scene tabs. See the Scene Manager topic 
for further information.  

Hidden Geometry 
Use the Hidden Geometry menu item to display hidden geometry or entities that have been 
hidden using the Hide menu item or context command. The Hidden Geometry menu item 
displays hidden faces with a light cross-hatch pattern (edges are displayed dashed), 
enabling you to select the geometry. Once selected, hidden geometry can be made visible 
with the  Unhide and  Unhide All menu items. 

Section Planes 
The Section Planes menu item toggles the display section plane entities. 

Section Cuts 
The Section Cuts menu item toggles the display of any section cut effects. 

Axes 
The Axes menu item toggles the display of the drawing axes. 

Guides 
The Guides menu item toggles the display of guide line entities and guide point entities. 

Shadows 
The Shadows menu item activates shadows. 

Fog 
The Fog menu item activates fog. Refer to the Fog Dialog Box for information on configuring 
fog settings. 

Edge Style 
The Edge Style submenu contains options to activate edge styles. The edge styles are 
Profiles, Depth Cue, and Extension. Refer to the Styles topic for further information. 
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Face Style 
The Face Style submenu contains options to activate face styles. The face styles are X-ray, 
Wireframe, Hidden Line, Shaded, Shaded with Textures, and Monochrome. See the Styles 
topic for further information. 

Component Edit 
The Component Edit submenu contains commands to alter the display of other entities when 
editing components.  

Hide Rest of Model 
Use the Hide Rest of Model menu item to toggle the display of the model when editing a 
component.  

Hide Similar Components 
Use the Hide Similar Components menu item to toggle the display of similar components 
when editing a component. 

Animation 
The Animation submenu contains several menu items related to scenes and animations. 
See the Scenes and Animations topic for further information. 

Add Scene 
Use the Add Scene menu item to add a new scene to the current file. 

Update Scene 
Use the Update Scene menu item to update a scene if you have made changes to the scene 

Delete Scene 
Use the Delete Scene menu item to delete a scene from the current model. 

Previous Scene  
Use the Previous Scene menu item to transition to the previous scene. 

Next Scene  
The Next Scene menu item is used to transition to the next scene. 

Play  
The Play menu item starts an animation. See the Scenes and Animations topic for further 
information. 

Settings 
The Settings item invokes the Animation panel of the Model Info dialog box. 

Hide/Show Toolbar 
The Hide/Show Toolbar menu item controls the visibility of the toolbar. You can also modify 
the visibility of the toolbar by clicking on the Toolbar collapse/expand button at the top right 
corner of the title bar. 

Customize Toolbar 
The Customize Toolbar menu item launches the Customize Toolbar dialog box allowing you 
to place command buttons on the toolbar. 
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Camera Menu 
The Camera menu contains items for altering your point of view of the model. 

Previous 
Use the Previous menu item to back up to the previous saved point of view. Point of view 
are saved automatically when the camera is moved in SketchUp. 

Next 
Use the Next menu item to advance to the next saved point of view. Point of view are saved 
automatically when the camera is moved in SketchUp. 

Standard Views 
The Standard Views submenu provides access to standard views: Top, Bottom, Front, 
Right, Back, Left, and Isometric. Selecting any of these model views will immediately set 
your active drawing window to that view. 

Parallel Projection 
Select the Parallel Projection menu item to enter a paraline projection.  

 Note - SketchUp must be in paraline mode to print to scale. Be aware 
that faces and edges that are parallel to the view plane will be measurable. 

Perspective 
Select the the Perspective menu item to enter a  perspective  projection.   

Two-Point Perspective 
A two-point perspective is a common drawing technique in which all verticals lines in the 
model will appear straight. Use the Two-Point Perspective menu item to achieve a 2-point 
perspective view of your 
model. You will be placed in the Pan Tool to pan around your model.  

Caution - Orbiting will move a model out of 2-point perspective.  

Match New Photo 
Select the Match New Photo menu item to start a match new photo session. Refer to the 
Match New Photo section in this user's guide for further information. 

Edit Matched Photo 
Select the Edit Matched Photo menu item to edit a previously matched photo. Refer to the 
Match New Photo section in this user's guide for further information. 

Orbit 
The Orbit menu item invokes the Orbit Tool. 
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Pan 
The Pan menu item invokes the Pan Tool. 

Zoom 
The Zoom menu item launches the Zoom Tool. 

Field of View 
Use the Field of View menu item to invoke the Zoom Tool in Field of View mode allowing 
you to widen or narrow your field of view. 

Zoom Window 
The Zoom Window menu item launches the Zoom Window Tool. 

 Note - The Zoom Window Tool is not in the Google SketchUp (free) 
toolbar, but is available to use from the Camera menu. 

Zoom Extents 
The Zoom Extents menu item launches the Zoom Extents Tool. 

Zoom to Photo 
Select the Zoom to Photo menu item, while using matching, to zoom such that the photo fills 
the entire drawing area.  

Position Camera 
The Position Camera menu item launches the Position Camera Tool allowing you to 
investigate fixed views of your model (such the an eye-level view of a house). This option is 
often used with the Walk Tool to take an eye-level tour of a structure. 

Walk 
The Walk menu item invokes the Walk Tool for maneuvering through your SketchUp model 
as though you taking a virtual tour of the model. 

Look Around 
The Look Around menu item invokes the Look Around Tool which pivots the camera around 
a stationary point at the point of view. 
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Draw Menu 
The Draw menu contains all of the SketchUp drawing tools and provides an alternative to 
using the Tool Palette or keyboard shortcuts. 

Line 
The Line menu item invokes a Line Tool used to draw  line entities, or edges, within the 
drawing area. 

Arc 
The Arc menu item invokes a Arc Tool used to draw  Arc entities, comprised of multiple 
connected straight line segments (editable as a single curve). 

Freehand 
Use the Freehand menu item to invoke a Freehand Tool used to draw irregular, coplanar 
connected lines in the form of  Curve entities. 

Rectangle 
The Rectangle menu item invokes a Rectangle Tool used to draw four coplanar intersecting 
edges and a subsequent  Face entity.  

Circle 
The Circle menu item invokes a Circle Tool used to draw  Circle entities. 

Polygon 
The Polygon menu item invokes a Polygon Tool used to draw regular  Polygon entities, 
inscribed within a circle, consisting of 3 to 100 sides. 
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Tools Menu 
The Tools menu provides access to all of the modification tools in Sketchup. This menu 
represents one of three mechanisms for accessing these tools (additional mechanisms are 
the Tool Palette and keyboard shortcuts). 

Select 
The Select menu item invokes a Select Tool allowing you to select one or more entities to 
modify.  

Keyboard Shortcut: Spacebar 

Eraser 
Use the Eraser menu item to invoke the Eraser Tool allowing you to erase entities from the  
drawing area. This tool also allows you to hide and soften edges. 

Keyboard Shortcut: E 

Paint Bucket 
The Paint Bucket menu item invokes the Paint Bucket Tool used to assign materials to 
entities in your model. Use the Paint Bucket Tool to paint individual elements, fill a number 
of connected faces, or replace a material in your model.  

 Note - The Paint Bucket Tool is different than the Apple  Color Picker 
used to select colors and materials.  

Keyboard Shortcut: B 

Move 
The Move menu item invokes the Move Tool allowing you to move, manipulate, and copy 
geometry. This tool can also be used to rotate  Component entities.  

Keyboard Shortcut: M 

Rotate 
Use the Rotate menu item to invoke the Rotate Tool used to rotate drawing elements and 
single or multiple objects within a single rotation plane. The Rotate Tool can also be used to 
stretch and distort geometry by selecting only a portion of a model. 

Keyboard Shortcut: Q 

Scale 
The Scale menu item invokes the Scale Tool allowing you to resize and stretch selected 
geometry relative to other elements in your SketchUp model. 

Keyboard Shortcut: S 

Push/Pull 
The Push/Pull menu item invokes the Push/Pull Tool used to manipulate faces of your 
model. This tool can be used to displace, extrude, re-attach, or subtract faces, depending on 
the context of selected geometry. 



 66

Keyboard Shortcut: P 

Follow Me 
Use the Follow Me menu item to invoke the Follow Me Tool used to extrude faces along a 
path such as an edge or line drawn with the  Freehand Tool. This tool is useful when adding 
details to a model because it allows you to draw the detail at one end of a path on the model 
and then repeat that detail along the path.  

Offset 
The Offset menu item invokes the Offset Tool used to create copies of co-planar lines and 
faces that are a uniform distance from original lines and faces. Lines and faces can be offset 
either inside or outside the original face. Offsetting a face will always create a new face. 

Keyboard Shortcut: F 

Tape Measure 
Use the Tape Measure menu item to invoke the Tape Measure Tool used to perform a 
number of dimension-related operations. These operations include measuring the distance 
between two points, creating guide line entities, and re-scaling an entire model to an exact 
dimension. 

Keyboard Shortcut: T 

Protractor 
The Protractor menu item invokes the Protractor Tool allowing you to measure angles and 
create guide line entities (usually at some angle). 

Axes 
The Axes menu item invokes the Axes Tool allowing you to move the  drawing axes. This 
tool is often used when constructing rectangular objects that are skewed relative to one 
another, or to allow for more accurate scaling of entities that are not oriented along the 
default coordinate planes. 

Dimensions 
Use the Dimensions menu item to invoke a Dimension Tool used to place  Dimension 
entities in your model. 

Text 
The Text menu item launches a Text Tool used to insert  Text entities into your model. 

3D Text 
The 3D Text menu item launches a 3D Text Tool used to create modeled 3 dimensional text. 

Section Plane 
The Section Plane menu item invokes a Section plane Tool used to make section cuts in 
your model. 

Google Earth 
The Google Earth submenu contains menu items for interacting with Google Earth.  
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Get Current View 
Use the Get Current View menu item to capture 2D and 3D snapshot images of the current 
view in Google Earth. 

Toggle Terrain 
Use the Toggle Terrain menu item to toggle the Google Earth snapshot image between a 2D 
and 3D image. 

Place Model 
Use the Place Model menu item to place your SketchUp models in Google Earth. 

Sandbox 
The Sandbox submenu contains options for modifying terrain. This menu item only appears 
after enabling the terrain modeling tools using the Extensions panel of the Preferences 
dialog box. See the  Sandbox Tools  topic for further information. 

Utilities 
The Utilities submenu contains various utilities and macros created using the Sketchup 
Ruby API. This menu item only appears after enabling the utilities tools using the  
Extensions panel of the Preferences dialog box. 

 Note - Ruby scripts are contained in the Plugins directory under the 
installation directory. 

Create Face 
The Create Face menu item invokes the Create Face utility allowing you to troubleshoot 
face creation and, in most cases, create a face for three or more intersecting edges. 
Specifically, the Create Face utility is useful when: 

• A model has two edges that have a common end point geometrically (the coordinates of 
the end point are the same), but the edges are not connected topologically. In this case, 
the Create Face utility will properly coNnect Edges and create a face. 

• A face cannot be created because edges are not exactly planer, or appear to be 
connected when there is actually a small gap between the ends of the edges. In these 
instances, Create Face will not create a face, but displays a message indicating why 
SketchUp cannot create a face. This message can be used to troubleshoot face creation. 

Query Tool 
The Query Tool menu item invokes a Query Tool utility that displays the current mouse 
position in the VCB. 
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Window Menu 
The Window menu contains model settings and managers for your models. Model settings 
are dialog boxes with settings that affect the model, such as shadows, display settings, and 
model information. Managers are dialog boxes that manage certain aspects of your model 
such as scenes, layers, materials, and components.  

Minimize 
The Minimize menu item minimizes the current document window and places it in the dock. 
Click on the minimized view in the doc to re-activate a minimized window. 

Keyboard Shortcut: Command+M 

Zoom 
The Zoom menu item toggles between shrinking and expanding the main document window. 
This item works similarly to clicking the plus icon at the top of the document window. 

Model Info 
Use the Model Info menu item to display the Model Info dialog box used to set settings for 
your entire model. 

Entity Info 
The Entity Info menu item displays the Entity Info dialog box used to view and set settings 
for the currently selected entity (or entities). 

Materials 
The Materials menu item invokes the Color Picker used for selecting and applying colors 
and materials to your models. 

Components 
The Components menu item displays Component Browser used for managing your 
components.  

Show Fonts 
The Show Fonts sub-menu includes options for toggling the display of the Fonts Panel 
allowing you to choose a font face and type. The Font Panel also allows you to select bold 
and italic versions of your fonts. 

Styles 
The Display Settings menu item invokes the Display Settings dialog box containing options 
to activate the face and edge rendering styles. The face rendering styles are wireframe, 
hidden line, shaded, shaded with textures, and Monochrome. The edge rendering styles are 
profile lines, jitter lines, and extended edges.  

Layers 
Use the Layers menu item to display the Layer Manager used to manage your SketchUp 
layers. 
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Oultiner 
The Outliner menu item invokes the Component Outliner used to display components and 
groups in a hierarchy. 

Scenes 
The Scenes menu item invokes the Scene Manager used to manage scenes for 
an animation. The Scene Manger will display with the current scene highlighted.  

Shadows 
The Shadows menu item invokes Shadow Settings dialog box for manipulating shadows in 
your model. 

Fog 
The Fog menu item invokes the Fog dialog box used to add a fog effect to your model. 

Match Photo 
The Match Photo menu item invokes the Match Photo dialog box used to help you create 
accurate 3D models from photos and to accurately place models in a photo's context.   

Soften Edges 
The Soften Edges menu item invokes the Soften Edges dialog box used to soften and 
smooth edges in your model. 

Instructor 
The Instructor menu item invokes the Instructor used to display information about the 
currently activated tool. 

Hide/Show Panels 
Use the Hide/Show Panels menu item to hide and show all currently active dialog boxes. 

Ruby Console 
The Ruby Console menu item displays the Ruby Console where you can type Ruby script. 

Bring All To Front 
Use the Bring All To Front menu item to bring all of your open SketchUp windows to the 
foreground of Mac OS X. All open document windows and active panels and palettes are 
brought to front. 

(Open Documents) 
The (Open Documents) menu items represent a dynamically generated list of all your open 
SketchUp files . Select the file you want to activate from this menu to switch between files. 
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Help Menu 
The Help menu contains items relating to receiving help with the product. These items 
include the SketchUp on-line user's guide, a quick reference card, and video tutorials. 

SketchUp Help 
The SketchUp Help menu item opens SketchUp's online user's guide.  

Keyboard Shortcut: Command+? 

Online Help Center 
The Online Help Center menu item launches the Google SketchUp Help Center in your 
default web browser. This web site contains a list of Frequently Asked Questions (FAQs) 
and a knowledge base of technical support issues and solutions. 

Learning Center 
The Learning Center menu item invokes the Learning Centerdialog box containing useful 
information to help you learn SketchUp. 

Quick Reference 
Use the Quick Reference menu item to display SketchUp's Quick reference card in your 
default PDF viewer. 

License 
The License submenu includes several options allowing you to view and manage your 
SketchUp license. 

License Info 
The License Info menu item displays information about your SketchUp license, including the 
type of license and serial number. 

Authorize 
Use the Authorize menu item to authorize your SketchUp licence to extend the use of 
SketchUp beyond the 8 hour trial period. Click on this menu item to display the SketchUp 
Authorization Screen. Type in the authorization number, provided by Google when you buy 
SketchUp, to authorize SketchUp.  

Unauthorize 
Use the UnAuthorize menu item to unauthorize your SketchUp licence. This menu item is 
used primarily when switching from a single-user license to a multiuser network license. 

Caution - SketchUp will not run after you unauthorize your license. You 
must authorize a new single-user or network license to use SketchUp again.  

  

Set Network License File 
Use the Set Network License File menu item to relocate the network license file on the 
network. 
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Unset Network License File 
Use the Unset Network License File menu item to delete the location of the network license 
file on the network. 

Lan License Monitor 
The Lan License Monitor menu item displays the LAN License Monitor dialog box. This 
dialog box displays single user licenses on the network. 

Check for Update 
The Check For Update menu item checks to see if you have the most current version of 
SketchUp. You will be prompted to download the current version if your version is out-of-
date. A Internet connection is required to use this feature. 

SketchUp Community 
The SketchUp Community menu item launches a the SketchUp user's forum in your default 
web browser.  

Send a Suggestion 
The Send a Suggestion menu item launches the Google SketchUp Help Center in your 
default web browser. This web site will prompt you to fill out suggestion form to be submitted 
to Google. This form contains fields for your name, email, and a comment related to one of 
the following categories: bug report, feature request, comment, training question.  

Video Tutorials  
The Video Tutorials menu item launches the Video Tutorials portion of the SketchUp web 
site. Select this command to open your default web browser and connect to the SketchUp 
online video tutorials. 

Ruby Help  
The Ruby Help menu item opens Ruby Help online user's guide. The user's guide contains 
reference information for the SketchUp Ruby APIs and examples.  
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Tool Palette 
SketchUp's tool palette is similar to those in other Apple OS X applications. Display the 
standard tool palette by clicking on the View > Tool Palettes > Large Tool Set menu item. 

Principal Tools 
The buttons on the principal tools section of the tool palette activate the Select Tool, Make 
Component,  Paint Bucket Tool, and  Eraser Tool. 

 

Drawing Tools 
The buttons on the drawing tools section of the tool palette activate the Rectangle Tool,  
Line Tool,  Circle Tool,  Arc Tool,  Polygon Tool, and  Freehand Tool. 

 

Modification Tools 
The modification tools section of the tool palette contains geometry modification tools. The 
tools on this toolbar are the Move Tool,  Push/Pull Tool,  Rotate Tool,  Follow Me Tool,  
Scale Tool, and  Offset Tool. 

 
  

Construction Tools 
The buttons on the construction tools section of the tool palette activate the Tape Measure 
Tool, Dimensions Tool, Protractor Tool, Text Tool, Axes Tool, and 3D Text Tool.  

 

Camera Tools 
The buttons on the camera tools section of the tool palette activate the Orbit Tool,  Pan Tool,  
Zoom Tool,  Zoom Window Tool, Previous, Next, and the  Zoom Extents Tool. 

 

Walkthrough Tools 
The buttons on the walkthrough tools section of the tool palette activate the Position Camera 
Tool,  Walk Tool, and  Look Around Tool.  
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Google Toolbar 
The buttons on the Google Toolbar are used to collaborate between SketchUp and other 
Google products. The toolbar contains the Get Current View,  Toggle Terrain,  Place Model,  
Get Models, and  Share Model buttons. 

 

Use Large Tool Buttons 
The tool palette can be displayed using large and small tool buttons. Check the Use large 
tool nuttons checkbox in the General panel of the Preferences dialog box to switch between 
large and small tool buttons. 

Tool Help Tips 
Hover over a tool to display a help tag with the name of the tool. A longer help tag will 
appear in the Status Bar when you activate a tool.  
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Toolbar 
The Toolbar is a customizable and collapsible region along the top of drawing area 
containing a variety of different SketchUp controls. 

Showing or Hiding the Toolbar 
Select Show/Hide Toolbar from the View Menu or click on the Toolbar collapse/expand 
button at the top right corner of the Title bar to show or hide the Toolbar. The following 
image contains a screenshot of the collapse/expand button. 

 

Customizing the Toolbar 
You can modify the Toolbar by adding, removing, and repositioning controls within the 
Toolbar. To customize your Toolbar: 

1. Select Customize Toolbar from the View Menu, or Context-click on the Toolbar and select 
Customize Toolbar from the context menu, to customize the controls that are visible in the 
Toolbar. The Customize Toolbar dialog box appears.  

2. Perform one of the following Toolbar customizations: 

• Drag the controls from the Customize Toolbar dialog box, to the desired position in 
the Toolbar, to add a control to the Toolbar. 

• Drag a control from the Toolbar and drop it anywhere outside of the Toolbar to 
delete a control. A smoke cloud will appear indicating that the control has been 
removed. 

• Drag a control left or right, within the Toolbar, to reposition the control.  

3. Click the Done button in the Customize Toolbar dialog box when you have finished 
customizing your Toolbar. 

 Note - Remove all of the controls from your toolbar and drag the default 
set of controls to your Toolbar to reset the toolbar controls to its original state.  

Toolbar Control Types 
SketchUp contains a variety of controls you can place into your toolbar for easy access. The 
following section covers each of these controls. 

Standard Views 
The Standard Views control gives you quick access to SketchUp's Standard Views (not 
including a bottom view). 

 

Display Style 
The Display Style control allows you to quickly switch between SketchUp's Face Rendering 
Styles. You can also use the View Menu or the  Display Settings dialog box to switch 
between these styles. 
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Undo/Redo 
The Undo command will undo the last drawing or editing command performed. The Redo 
Command cancels Undo operations, stepping forward in the modification history. 

 

Rendering Options 
The Rendering Options controls gives you quick access to other settings, such as X-Ray 
mode, Shadows, and the Jitter Edge Rendering style. 

 

Shadows (sliders) 
The Shadows sliders controls gives you quick access to the most frequently used shadow 
settings. You can turn shadow casting on and off with the checkbox, and adjust date and 
time with the sliders. 

 

You can also use the Shadow Settings dialog box to access more detailed shadow settings. 

Shadows (icon) 
The Shadows icon control toggles shadows on and off. 

Layers 
The Layers Toolbar provides quick access to several often used layer operations. 

 
Display the Current Layer: The Layers Toolbar displays the current layer name. Any 
new entities you draw will be assigned to the current layer. 

Add a Layer: Click in the text field of the drop-down list and type a new layer name to add a 
new layer to the model. 

Animation 
The Animation control is used to start and stop Animations. 

 

Model Info 
The Model Info control is used to display the Model Info dialog box. 

 

Section Display 
The Section Display control toggles the display of Section Planes. 

 

Section Cuts 
The Section Cuts control toggles the display of the Section Cut Effect. 
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X-Ray Mode 
The X-Ray Mode control toggles the X-Ray display mode. 

 

Component Maker 
The Component Maker creates a Component entity from the selected geometry. You will be 
prompted to set a few characteristics for the Component entity upon clicking this toolbar 
control. 

 

Separator 
The Separator is used to add a vertical line to separate controls in your toolbar.  

Space 
The Space is used to add a space between controls.  

Flexible Space 
The Flexible Space is used to add an adjustable space between controls. A Flexible Space 
automatically adjusts spacing between toolbar controls depending on the number and size 
of controls in the toolbar. 

Print 
The Print control activates the Print Dialog Box, enabling you to print the current view of 
your model. 

 

Colors 
The Colors control launches the Color Picker. 

 

Fonts 
The Fonts control launches the Font dialog box. 

 

Customize 
The Customize control invokes the Customize Toolbar dialog box. 

Toolbar Context Menu 
The Toolbar context menu is activated by context-clicking on the Toolbar. This menu 
contains options for manipulating the appearance of your Toolbar.  

Icon & Text: The Icon & Text option allow you to display both icons and names of controls 
in the Toolbar. The Toolbar shows both controls and their labels as a default. 
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Icon Only: The Icon Only option allows you to only display icons for controls in the Toolbar.  

Text Only: The Text Only option allows you to only display the names of controls in the 
Toolbar. 

Use Small Size: The Use Small Size option provides additional space in the Toolbar by 
shrinking the size of individual icons.  This option does not change the size of textual names 
or icon groups, such as the Display Style group of controls. 

Remove Item: The Remove Item option removes the control that you have selected. 
Context-click on a control to display the Toolbar Context Menu and select Remove Item to 
delete the control. 

Customize Toolbar...: The Customize Toolbar... menu item displays the Customize Toolbar 
dialog box containing all of the controls that can be placed in the toolbar. 
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Context Menus 
Menu items also appear in special context menus which are menus whose contents vary 
depending on the context in which they are invoked (usually on one or more entities in the 
drawing area or within a user interface component, such as a dialog box). The following 
image shows a context menu for a Face entity. 

 

Context-Clicking 
Context menus on Mac OS X are invoked by selecting one or more entities, holding down 
the Control key, and clicking with the mouse. Users with three-button or scroll-wheel mice 
can also use the right mouse button instead of Control-clicking. This operation is referred to 
as a context-click. 

Detailed information on the context menu for each entity appears in the Entities section of 
this user's guide. 

Other dialog boxes and user interface components have their own context menus, including 
drawing axes, the toolbar, the Material Browser, and so on. 

  

http://neuage.org/Flare Projects/SketchUp User's Guide/Content/F-Model_Settings_and_Managers/Settings-MatBrowser.htm
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Dialog Boxes 
Most dialog boxes in SketchUp are modeless, meaning they do not limit your 
interaction with the rest of the application by requiring user input before continuing 
with your work. Instead, these dialog boxes can be displayed while you work 
allowing you to make dynamic settings changes to your model while you are 
sketching. Dialog boxes in SketchUp can be snapped to other user interface 
components on your screen, resized, and minimized (with some exceptions).  

Snapping Dialog Boxes to Other User Interface Components 
Some dialog boxes, such as the Display Settings dialog box, automatically snap to the 
outside edges of the application window, the outer edge of the screen, with the top and 
bottom of other dialog boxes to create a dialog stack. To snap a dialog box to another user 
interface component: 

1. Display a dialog box, such as the Window > Display Settings dialog box. 

2. Click and hold on the dialog box's title bar. 

3. Move the dialog box to the outside edge of the application window, outside edge of the 
screen, or top or bottom edge of another dialog box (such as the Shadow Settings dialog 
box). The dialog box will snap to and align with the edge.  

 Note - Dialog boxes that have been snapped to the application window 
do not move when the application window is moved (they are not stuck to the 
window).  

Tip - Snap several dialog boxes together at their top and bottom edges to 
form a dialog box stack. Dialog boxes in a dialog box stack move with the 
stack when the top-most dialog box's title bar is moved. 

Manipulating Dialog Boxes in a Dialog Box Stack 
A dialog box stack refers to a series of dialog boxes snapped together at their 
bottom and top edges such that they form a stack. The following image contains a 
dialog box stack with the Shadow Settings dialog box opened in the middle. 

 
You can manipulate the dialog boxes in a dialog box stack in the following ways: 

• Move the entire dialog box stack by clicking, holding, and moving the top-most dialog box's 
title bar. 

• Click on any dialog box's title bar to minimize or maximize a dialog box within the stack. 



 80

• Move a dialog box, residing in the middle of the stack, to the right or left to break it from the 
stack. Move a dialog box, residing at the bottom of the stack, down to break it from the 
stack. 

• Reinsert the dialog box at the beginning or end of the stack by snapping the dialog box to 
the bottom or top edge of the stack, respectively.  

• Reinsert the dialog box in the middle of the stack by moving sideways into a middle 
position. 

• Snap the entire dialog box stack to the application window or screen by moving it to the 
outer edge of the application window or screen.  

Resizing Dialog Boxes 
Some SketchUp dialog boxes, such as the Component Browser dialog box, can be resized. 
Move the cursor around the dialog box's edges to display a resize cursor (two arrows). Click 
on the edge and move the edge to resize the dialog box. 

Minimizing Dialog Boxes 
Click on any dialog box's title bar to minimize or maximize the dialog box (even those that 
can not be placed in a dialog box stack). 
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Drawing Axes  
SketchUp's drawing axes consist of three colored lines, perpendicular to each other, 
displayed in the drawing area. These axes are helpful in providing a sense of direction in 3D 
space while you work.  

  

 

 Note - The Drawing Axes will be automatically hidden in any images 
exported from SketchUp. 

Moving the Drawing Axes 
The drawing axes can be manipulated (moved, moved and rotated, and hidden) through 
their context menu. To move the drawing axes: 

1. Context-click on the Drawing Axes and select Place from the context menu. The cursor 
changes to a collection of axes.  

2. Move your cursor to the point in your model to be the new coordinate origin. You will see 
the axes snap to inferred alignments and points as you move around your model.  

3. Click to accept the new coordinate origin. 

4. Drag your cursor away from the origin to set an alignment for the red axis. Use the 
inference help tags to make sure you are aligned precisely.  

5. Click to accept the alignment. 

6. Move your cursor away from the origin to set an alignment for the green axis. Use 
inference help tags again to make sure you are aligned precisely.  

7. Click again to accept the alignment. 
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Moving and Rotating the Drawing Axes Relative to Current Position  
You can quickly and accurately move and rotate the drawing axes relative to their current 
position using the Move Sketching Context dialog box. To move and rotate the drawing 
axes: 

1. Context-click on the drawing axes. The drawing axes context menu is displayed. 

2. Select Move from the context menu. The Move Axes dialog box is displayed. 

 
3. Specify displacement and rotation values in the units specified under the Units panel of the 

Model Info dialog box. 

4. Click OK. 

Aligning the Point of View to the Current View 
You can align SketchUp's point of view to be perfectly aligned with the current view. To align 
the point of view to the current view: 

1. Context-click on the drawing axes. The drawing axes context menu is displayed. 

2. Select Align View from the context menu.  
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Hiding the Drawing Axes 
You can display or hide the drawing axes from the View menu. You can also hide the 
drawing axes from the drawing axes's  context menu (when the drawing axes are visible). 
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Inference 
SketchUp features a geometric analysis engine, called the inference engine, allowing you to 
work in 3D space using a 2D screen and input device. This engine helps you draw very 
accurately by inferring points from other points as you draw while also providing you with 
visual cues. 

Inference Cues 
The inference engine uses help tag cues, appearing automatically while working on the 
model, to identify significant points or geometric conditions. These cues make complex 
inference combinations clear to you as you draw 

Additionally, the inference engine uses specific colors to indicate its type of inference 
(covered further in Inference Types). 

Inference Types 
There are three main types of inferences: point, linear, and planar. SketchUp often 
combines inferences together to form a complex inference. 

Point Inference 
A point inference is based on an exact point of your cursor in your model. 

 
Endpoint: The green Endpoint inference identifies the end of a  Line entity or  Arc entity. 

Midpoint: The cyan Midpoint inference indicates the middle point on a line or edge. 

Intersection: The black intersection inference indicates an exact point where a line 
intersects another line or face. 

On Face: The blue On Face inference identifies a point which lies on a  Face Entity. 

On Edge: The red On Edge inference identifies a point that lies along an edge.  

Equi-Distant On Edge: The Equi-Distant On Edge inference indicates an equidistant point, 
or a chamfer, when a magenta line appears between two connected edges. 

Half Circle: The Half Circle inference appears when drawing an arc to indicate the point that 
creates an exact half circle. 
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Linear Inference 
A linear inference snaps along a line or direction in space. In addition to a help tag, a linear 
inference sometimes displays a temporary dotted line while you draw. 

 
On Axis: The On Axis inference indicates a linear alignment to one of the  drawing axes. 
The solid line is drawn in the color associated with the corresponding axis (red, green, or 
blue). 

From Point: The From Point inference indicates a linear alignment from a point along the  
Drawing Axes directions. The dotted line is drawn in the color associated with the 
corresponding axis (red, green, or blue). 

Perpendicular: Tie Perpendicular magenta line indicates perpendicular alignment to an 
edge. 

Parallel: The Parallel magenta line indicates a parallel alignment to an edge. 

Tangent at Vertex: When drawing from the endpoint of an  Arc entity using the  Arc Tool. 

Planar Inference 
A planar inference snaps to a plane in space. 

Drawing Planes: SketchUp will snap to the planes defined by the  Drawing Axes and your 
view when it cannot snap to geometry in the drawing area. For example, SketchUp will draw 
on the ground plane when the point of view is that of the ground plane. 

On Face: A blue On Face inference identifies a point which lies on a face. Although initially 
a point inference, On Face can also serve as a planar alignment by using inference locking 
(described below). 

Encouraging an Inference 
At times, the inference you need may not come up immediately or SketchUp might choose 
alignments with the wrong geometry. In these cases, you can increase the chances of a 
particular alignment by pausing your mouse cursor over the particular location that you want 
SketchUp to infer from. When the help tags appears, SketchUp will briefly prioritize that 
alignment as you continue drawing. For example, to encourage SketchUp to create a line to 
match another, parallel, line (such as when drawing the third line of a rectangle): 
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1. Create the first two edges of a rectangle with the first edge being parallel to the red axes. 

2. Click on the start point of the third edge and move the line tool as though you were 
creating the third line parallel to first line. As you begin to move the Line Tool, the line 
should appear in red. 

3. Mid-line creation, move the Line Tool over the start point of the start point of the first line 
you created for the rectangle. Your line will extend diagonally to this point.  

4. Leave the tool over this point until the Endpoint help tag displays. 

5. Move the Line Tool to the approximate location where the end of the third line should 
appear. A dotted line, with the color of the corresponding axes (green) will follow the Line 
Tool to indicate you are directly inline with the start point of the first line. 

6. Click when the line you are drawing is indicated by an axes color (red) and is directly 
perpendicular to the green dotted line.  

Component Inferences 
All normal geometry inferences can be obtained from geometry inside Component entities or  
Group entities. Group and Component inferences are all indicated by magenta dots. 

Inference Locking 
At times, geometry might interfere with your ability to infer points from other points, making it 
difficult to draw accurately. Use an inference lock, which tells SketchUp not to waver from 
the direction it is currently inferring from, to solve this problem. To use the inference lock, 
hold down the Shift key when SketchUp infers the desired alignment (the inference line will 
bold). The alignment will remain locked, even as you move the mouse and/or pick a 
secondary inference point. The following image shows the inference locked in the blue 
direction to ensure that a new line is exactly perpendicular to the face. 

 
Any of the inference conditions may be locked; along an axis direction, along an edge 
direction, on a face, from a point, parallel or perpendicular to an edge, and so on. 
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Principal Tools 
This section of the user's guide covers the principal tools within SketchUp. Principal tools 
are those tools that tend to be used most often in SketchUp.  

Tools in this section are covered in the order they appear within the Tools menu. 
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.Select Tool 
Use the Select Tool to specify the entities you will modify when using other tools or 
commands. The entities that are included in a selection are referred to as the selection set. 
Activate the Select Tool from the  Tool Palette or from the  Tools menu. 

Keyboard Shortcut: Spacebar 

Selecting a Single Entity 
SketchUp allows you to make both single-entity and multiple-entity selections. To select a 
single entity: 

1. Select the Select Tool. The cursor changes to an arrow. 

2. Click on an entity. The selected entity is highlighted in yellow. 

Selecting Multiple Entities 
Multiple-entity selections are useful when you want to perform a single operation on several 
entities (the selection set). Multiple-entity selections use an expandable selection box to 
surround the entities you want in the selection set. To select multiple entities:  

1. Select the Select Tool. The cursor will change to an arrow. 

2. Click and hold the mouse button a short distance away from the entities you want to select 
to start a selection box.  

3. Drag the mouse to expand the selection box over the elements you want to select. 

• Clicking to the right-side and dragging to the left, called a crossing selection, selects 
any elements within the selection rectangle, including those that are only partially 
contained in the rectangle. The following images show a right-to-left selection 
selecting two components, though none are completely within the bounds of the 
selection box. 
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• Clicking to the left-side of the entities and dragging right, called a window selection, 
selects only those elements completely within the selection rectangle. The following 
image shows a left-to-right selection selecting one component because only one 
component (the left speaker) is completely within the bounds of the selection box. 
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4. Release the mouse button when all of the elements are either partially included (left-to-

right selection) or fully included (right-to-left selection) in the selection box. 

Adding and Subtracting From a Selection Set 
The Select Tool can be used with one or more keyboard modifiers to add or remove entities 
from a selection set. 

Adding to the Selection Set (Option) 
Press and hold the Option key (the cursor will change to an arrow with a plus sign) while 
clicking on additional entities to add entities, one-by-one, to the selection set. Or, press and 
hold the Shift key (the cursor will change to an arrow with a plus and minus signs) while 
clicking on additional entities to add entities, one-by-one, to the selection set. 

Changing Selection Status for an Entity (Shift) 
Press and hold the Shift key (The cursor will change to an arrow with plus and minus signs) 
while clicking on entities to invert the selection status of the entity (currently selected entities 
will become unselected, unselected entities will be come selected). 

Subtracting from the Selection Set (Shift+Option) 
Press and hold the Shift and Option keys simultaneously (the cursor will change to an arrow 
with a minus sign) while clicking on currently selected entities to remove entities from the 
selection set. Or, press and hold the Shift key (the cursor will change to a plus sign and 
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minus sign) while clicking on currently selected entities to remove the entities, one-by-one, 
from the selection set. 

Tip - Use the Group entity to group items within a selection set as a 
temporary way of quickly reselecting the same group of items. See the Group 
entity for additional information. 

Expanding the Selection Set Using the Mouse 
You can automatically add to a selection set clicking the Select Tool multiple times in rapid 
succession. Click once on an entity to select that entity. Click rapidly twice (double-click) on 
an entity, namely an edge or face, to select corresponding faces or edges respectively. Click 
three times (triple-click) on an entity, namely an edge or face, to select he edge or face and 
all entities physically connected to that edge or face. The following image shows this 
click/selection sequence. 

 

Tip - Use a context-click to invoke the context menu for an entity. Many 
context menus have a Select submenu allowing you to expand a selection 
using one of the following commands: Bounding Edges, Connected Faces, All 
Connected, All on same layer, and All with same material. 

Selecting or Unselecting All Geometry 
Use either the Select All menu item in the Edit menu or press Command+A on the keyboard 
to select all visible elements in your model.  

Use the Deselect All menu item in the Edit menu,press Shift+Command+A, or click on any 
empty space in the drawing area to de-select all currently selected entities.  
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 Eraser Tool  
Use the Eraser Tool to delete entities. The Eraser Tool can also be used to hide and soften 
edges. Activate the Eraser Tool from the Tool Palette, or by selecting Eraser from the  Tools 
menu. 

Keyboard Shortcut: E 

Erasing Entities 
As mentioned previously, the Eraser Tool is used to erase entities in the drawing area. Note, 
the Eraser Tool does not allow you to erase faces (faces are erased after their bounding 
edges are erased). To erase entities: 

1. Select the Eraser Tool. The cursor changes to an eraser with a small box. 

2. Click on an entity to erase it. Alternatively, erase several entities at once by holding down 
the mouse button and dragging it over several entities to be erased. All selected geometry 
will be erased once you release the mouse button. 

If you accidentally select geometry you do not wish to delete, press the Esc key to cancel 
the erase operation before it deletes your selection.  

Tip - Try erasing entities slowly if you continuously skip over entities you 
want to erase.  

Tip - It is usually faster to erase a large number of entities by selecting 
the entities with the Select Tool and pressing the Delete key on your keyboard. 
You can also delete selected items by selecting Erase from the Edit menu. 

Hiding Lines 

Press and hold the Shift key and use the Eraser Tool to hide lines (instead of erasing lines). 

Softening/Unsoftening Edges  
Press and hold the Option key to soften/smooth edges (instead of erasing entities). Press 
and hold the Shift and  Option keys simultaneously to unsoften/unsmooth edges. 
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 Paint Bucket Tool 
Use the Paint Bucket Tool to assign materials and colors to entities in your model. You can 
use it to paint individual entities, fill a number of connected faces, or replace a material with 
another throughout your model. Note that the Paint Bucket Tool is separate from the Apple 
Color Picker used to select colors and materials. Activate the Paint Bucket Tool from the  
Tool Palette, or by choosing Paint Bucket from the  Tools menu. 

Keyboard Shortcut: B 

Applying Materials 
Ensure you are using either the Shaded or Shaded with Textures display setting so that you 
can see materials as they are applied to your model (Window > Display Settings > Shaded 
or Shaded with Textures). To apply materials: 

1. Select the Paint Bucket Tool. The cursor will change to a paint bucket and the Mac OS X 
Color Picker (if it is not already open) is activated. The color picker has five  pickers used 
to select colors and materials. 

2. Click on the Materials Picker icon (the icon is a brick).  

3. Select a materials library using the drop down list box. SketchUp contains several default 
materials libraries, including landscape, roofing, and transparent materials. 

4. Select a material from the library of materials. 

5. Click on the faces you want to paint. The faces will receive the material. 

6. If you select multiple elements using the Select Tool, clicking on the selection with the 
Paint Tool will paint all of them with a single click. 

Tip - You can also apply and modify materials using the  Entity Info 
dialog box. Or, drag and drop color swatches from any color well onto 
SketchUp entities. 

Face Painting Rules 
There are several face painting rules that apply when painting multiple faces or edges at the 
same time. These rules follow: 

• The side of the faces that will be painted depends on the side initially painted when more 
than one face is selected. For example, if all faces are selected and you paint the front of 
one face, the front of all faces will be painted. Conversely, if all faces are selected and you 
paint the back of one face, all back faces will be painted.  

• All selected edges will be painted when you select a face and all edges and paint the front 
of the face. No edges are painted when you select a face and all edges and paint the back 
of one face. Ensure you have the Window > Display Settings > Edge color set to By 
Material to see the painted effect applied to edges. 

Fill Options  
The Paint Bucket Tool can be used with one or more keyboard modifiers to perform various 
painting operations. 
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Element Fill  
The Paint Bucket Tool normally operates by filling in faces as you click on them. As 
mentioned previously, entities selected with the Select Tool can be painted with a single 
click of the Paint Bucket Tool.  

Adjacent Fill  
Press and hold the Option key while clicking on a face with the Paint Bucket Tool to fill that 
face and any adjacent (connected) face with the same material. The face you click on and 
the adjacent face must have the same material prior to performing this operation. 

 

 Note - Selecting a number of entities with the  Select Tool and painting 
using the  Optionmodifier keys causes just the entities within the selection set 
to be painted. 

Replace  
Press and hold the Shift key prior to clicking on a face with the Paint Bucket Tool to apply a 
material to every face, with the same material in the current context, with the new material. 

 

 Note - Selecting a number of entities with the  Select Tool and painting 
using the Shift modifier key causes just the entities within the selection set to 
be painted. 

Adjacent Replace 
Press and hold both the Shift and the Option keys simultaneously while painting to only 
replace the material on the face within the confines of geometry that is physically connected 
to that face. 

 Note - Selecting a number of entities with the  Select Tool and painting 
using the  Optionmodifier keys causes just the entities within the selection set 
to be painted. 
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Sampling a Material  
Press and hold the Command key to change from the Paint Bucket Tool to a Sample Tool 
for sampling materials within your model. The cursor will change to an eye dropper. Click on 
the face whose material you want to sample. Release the  Command key to return to the 
Paint Bucket Tool. Paint the sampled material on a face.  

 

 Note - The sampled material is placed in the Active Color Well of the 
Color Picker, where it can be painted on new entities, modified, or used as the 
basis of a new material.  

Painting Groups and Components 
Materials can be painted on entire Group entities or  Component entities or to the individual 
entities within the Group or Component. To assign materials to an entire Group or 
Component: 

1. Select the Paint Bucket Tool. The cursor will change to a paint bucket and the Mac OS X 
Color Picker (if it is not already open) is activated. The color picker has five  pickers used 
to select colors and materials. 

2. Click on the Materials Picker icon (the icon is a brick).  

3. Select a materials library using the drop down list box. SketchUp contains several default 
materials libraries, including landscape, roofing, and transparent materials. 

4. Select a material from the library of materials. 

5. Click on the Group or Component you want to paint. The faces will receive the material. 

6. If you select multiple Groups or Components using the Select Tool, clicking on the 
selection with the Paint Tool will paint all of them with a single click. 

 Note - If a face within a Group or Component is already painted with a 
material (other than the default material), before applying a material to the 
entire Group or Component, the face will not adopt the new material. For 
example, the windshields, bumpers, and tires in the following image were 
already painted before a material was applied to these components. 
Therefore, the windshields, bumpers, and tires maintained their original 
material.  
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 Note - Exploding a Group or Component assigns the object materials to 
any elements assigned the default material, thus making the material override 
permanent. 
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Drawing Tools 
This section of the user's guide covers the drawing tools within SketchUp. Drawing tools are 
those tools used to create new geometry. These tools include the Line Tool, Rectangle Tool, 
and Freehand Tool. 

Tools in this section are covered in the order they appear within the Draw menu. 
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 Line Tool 
Use the Line Tool to draw edges or Line entities. Line entities can be joined to form a face. 
The Line Tool can also be used to divide faces or heal deleted faces. Activate the Line Tool 
from either the  Tool Palette or the  Draw menu. 

Keyboard Shortcut: L 

Drawing a Line 
Lines can be placed on existing faces or separate from existing geometry. To draw a Line: 

1. Select the Line Tool. The cursor changes to a pencil. 

2. Click to set the starting point of your line.  

 Note - Press the Esc key at any point during the operation to start over. 

3. Move the cursor to the ending point of your line. As you draw a line, the length is displayed 
dynamically in the Value Control Box (VCB).  

4. Click to draw your line. This ending point can also be the starting point of another line.  

 
The line length can be specified precisely using the VCB either before clicking the second 
point or immediately after the line has been drawn. See Specifying Precise Line Values for 
further information on using the VCB with Line entities. 

Tip - Alternately, you can click and hold the mouse button to set the 
starting point of the line, and drag outward without releasing the button to set 
the length. Release the mouse button to complete the line. See the  Drawing 
panel of the Preferences dialog box for further information on setting drawing 
behavior. 

Creating a Face  
The Line Tool will remain at the ending point of every line you create. This end point is 
automatically treated as a starting point for another line. You can create another line by 
moving the cursor and clicking again from this new starting point. These two lines are said to 
be coplanar, intersecting lines (intersecting at starting and ending points). 

Three or more coplanar lines, intersecting at their ending and starting points (forming a 
loop), generate a Face entity. Ensure that the Endpoint inferencehelp tag is visible whenever 
you close a Face entity to ensure that any lines you draw are continuous. The Line Tool is 
released but is still active after a face has been created. 
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Tip - Set the display settings (Window > Display Settings ) to the Shaded 
rendering style to clearly show new faces as they are created. 

Splitting a Face 
Draw a line with starting and ending points on the face's edges to split a face. The following 
image shows a rectangle being split when a line is drawn from one edge of a face to another 
opposite edge. 

 

Integrating Lines 
Occasionally, overlapping lines will not be split or integrate with a face. Any lines that are not 
part of a face perimeter will be displayed with a thicker line (left-most image below) . The 
Profile Edge rendering style must be enabled in the Display Settings dialog box to see this 
behavior.  

Use the Line Tool to trace along an existing line to attempt to split overlapping lines. 
SketchUp will re-analyze your geometry and attempt to reintegrate the line. The following 
images show a bold line that did not effectively split a face (left-most image). The line was 
traced (middle-image) and the line became thin indicating that the line was reintegrated.  

 

Splitting a Line  
SketchUp automatically splits line segments when new lines are drawn perpendicular to a 
line. For example, draw a new line to the midpoint (identified by a cyan square) of another 
line to split a line in half. The following example shows one line being intersected at the 
midpoint, resulting in two lines. 
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Select the original line to verify that the line has been split into two equal segments.  

Dividing a Line into Equal Segments 
Line segments can be divided into any number of equal line segments. To divide a line into 
equal segments: 

1. Context-click on a line. 

2. Select Divide from the context menu. SketchUp will place points on the line to show where 
the line will be divided.  

3. Move the cursor toward the center of the line to reduce the number of segments. Move 
cursor toward either end of the line to increase the number of segments. 

4. Click on the line when the number of segments you would like is shown. The line will be 
divided into an equal number of joined line segments. 

Specifying Precise Line Values 
The VCB displays the length of your line while you are drawing lines. You can also specify a 
line length value using the VCB. 

Entering a Length Value 
The VCB label indicates "Length" after you place the starting point of a line. The following 
image shows the length value in the VCB. 

 
Type the length into the VCB, after placing the starting point of the line, and press the Enter 
or Return key. SketchUp will use the current document units setting if you only type in a 
numerical value. You can also specify either Imperial (1'6”) or Metric (3.652m) units at any 
time, regardless the model units setting. 

 Note - The Line Tool will snap to any previously entered length within 
the VCB. 

Entering a 3D Coordinate 
The VCB can also be used to place the end of the line at an exact coordinate in space. 

Entering an Absolute Coordinate: Type in the coordinates of a point in 3D space enclosed 
by brackets, such as [x, y, z], to get absolute coordinates relative to the current axes.  

 
Entering a Relative Coordinate: Type the coordinate points enclosed by angle brackets, in 
the format <x, y, z>, where x, y, and z values are relative distances from the starting point of 
your line.  
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 Note - The exact format for VCB entries will vary depending on your 
computer's Regional Settings. For European users, the list separator symbol 
may be a semi-colon instead of a comma, so the format would be   
[x; y; z]. 

Drawing Lines by Inference 
The Line Tool uses SketchUp's sophisticated geometric inference engine to help you place 
your lines in 3D space. The inference decisions, made by the inference engine, are 
displayed in the  drawing area as inference lines and inference points. These lines and 
points show precise alignment between the line you are drawing and the geometry of your 
model. Refer to the  inference engine topic for additional information. 

Locking a Line to the Current Inference Direction 
Press and hold the Shift key, while the line you are drawing is the specific color of an axis, to 
lock drawing operation to that axis. 

Locking a Line to a Specific Inference Direction 
Press and hold either the up arrow, left arrow, or right arrow keys, where the up arrow 
equals blue, left arrow equals green, right arrow equals red, while drawing a line to lock the 
line to a specific axis. 
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Arc Tool  
Use the Arc Tool to draw Arc entities, comprised of multiple line segments (which can be 
edited as a single arc). Activate the Arc Tool from the  Tool Palette or from the  Draw menu.  

Keyboard Shortcut: A 

Drawing an Arc 
Arc entities consist of three parts: the starting point, the ending point and the bulge distance. 
The distance between the starting point and the ending point is also known as the chord 
length. To draw an arc: 

1. Select the Arc Tool. The cursor changes to a pencil with an arc. 

2. Click to place the starting point of your arc. 

3. Move the cursor to the ending point of your chord. 

4. Click to place the ending point of your arc. A straight line is created. 

5. Move your cursor perpendicular to the straight line to adjust the bulge distance. A straight 
line will extend perpendicular from the straight line.  

 

 Note - Press the Esc key at any point during the operation to start over. 

6. Click to set the bulge distance. 

Chord length can be specified after you place the ending point of your arc. Bulge 
distance, radius, and number of segments can be specified using the VCB 
immediately after a arc is drawn. See Specifying Precise Arc Values for more 
information on manipulating arcs using the VCB. 

Drawing a Half-Circle 
The arc temporarily snaps to a half-circle as you pull out a bulge distance. Watch for the 
half-circle inference help tag indicating when your arc is a half-circle. 
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Drawing Tangentially 
The Arc Tool displays a cyan tangent arc while you are drawing from an unconnected end or 
start point of an existing arc. = 

 

Specifying Precise Arc Values 
The VCB displays the chord length of the arc (after setting the starting point), then the bulge 
distance (after setting the ending point). Use the VCB to enter exact lengths for the chord 
length, bulge distance, radius value, and number of segments. 

 Note - SketchUp will use the current file units setting if you only type in a 
numerical value. You can also specify either Imperial (1'6”) or Metric (3.652m) 
units at any time, regardless the file's units setting. Units are set within the  
Units panel of the Model Info dialog box.  

  

Entering a Chord Length 
The VCB's label indicates "Length" after you place the starting point of an arc. Type the 
chord length into the VCB, after placing the starting point of the arc, and press the Enter or 
Return key. Specify a negative value, such as -6.5", to indicate that you want the length to 
apply in an opposite direction to the current drawing direction.  

Specifying a Bulge Distance 
The VCB's label indicates "Bulge" after you place the ending point of an arc. Type the bulge 
length in the VCB, after placing an ending point, and press the Enter or Return Key. You can 
also enter the bulge distance after the creation of the arc as long as "Bulge" is displayed as 
the VCB label. Negative bulge values can also be used to create an arc in an opposite 
direction to the current drawing direction. 

Specifying a Radius  
You can specify an arc radius instead of a bulge distance. Type the desired radius in the 
VCB, followed by the letter 'r' and press the Enter or Return Key. You can perform this 
action either during or immediately following the creation of the arc. For example:  24r or  
3'6"r or  5mr. 

Specifying the Number of Segments 
You can also specify the number of segments in an arc. Type the number of segments in the 
VCB, followed by the letter 's', and press the Enter or Return key. You can perform this 
action either during or immediately following the creation of the arc. For example: 20s. 
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 Freehand Tool 
Use the Freehand Tool to draw irregular hand-drawn lines in the form of Curve entities and  
3D Polyline entities. Curve entities are comprised of multiple line segments that are 
connected together. These curves behave as a single line in that they can define and divide 
faces. They are also connected such that selecting one segment selects the entire entity. 
Curve entities can be useful for representing contours in a  contour map or other  organic 
shapes. Activate the Freehand Tool from the  Draw menu or from the  Tool Palette. 

Drawing Curves 
Curves can be placed on existing faces or separate from existing geometry (aligned to an 
axes plane). To draw a Curve: 

1. Select the Freehand Tool. The cursor will change to a pencil with a curve. 

2. Click and hold to place the starting point of your curve.  

3. Drag the cursor to draw. 

4. Release the mouse button to stop drawing. 

 
5. (optional) End your curve at point where you started drawing to draw a closed shape.  

 
  

Drawing 3D Polyline Entities 
3D polylines do not generate inference snaps or affect geometry in any way. 3D polylines 
are usually used for tracing imported drawings, 2D sketching, or for decorating your model. 
Press and hold the Shift key, before you begin drawing, to draw a 3D polyline. 
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 Note -  Select Explode from the 3D polyline's context menu to convert a 
Freehand Sketch into regular edge geometry. 
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 Rectangle Tool 
Use the Rectangle Tool to draw rectangular Face entities, specified by clicking at two 
opposite corners of the desired shape. Activate the Rectangle Tool from either the  Tool 
Palette or the  Draw menu. 

Keyboard Shortcut: R 

Drawing a Rectangle 
Rectangles can be placed on existing faces or separate from existing geometry (aligned to 
an axes plane). To draw a rectangle: 

1. Select the Rectangle Tool. The cursor changes to a pencil with a rectangle. 

2. Click to set the first corner point of the rectangle. 

3. Move the cursor diagonally. 

 Note - Press the Esc key at any point during the operation to start over. 

4. Click again to set the second corner point of the rectangle. 

 

Drawing a Square 
Squares are created with the rectangle tool in conjunction with the Square help tag. To draw 
a Square: 

1. Select the Rectangle Tool and Click once on the first corner point. 

2. Move your mouse to the opposite corner. A diagonal dotted line will appear, along with a 
Square help tag, when you are in a position that will create a square.  

 Note - Press the Esc key at any point during the operation to start over. 

3. Click to finish. 

Tip - A dotted line and Golden Section help tag appears when you are in 
a position to create a Golden Section. 

Alternately, you can press your mouse button on the first corner of your rectangle, drag to 
the opposite corner, and release the mouse button. 

Tip - Use the  Axes tool to re-align the axes, prior to drawing your 
rectangle, if you want to draw a rectangle that is not aligned with the default  
drawing axes orientation. 
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Specifying Precise Rectangle Values 
A rectangle's dimensions dynamically appear in the VCB as you draw. Specify exact length 
and width dimensions by typing them in the VCB, and pressing Enter or Return, either after 
the first corner is clicked or immediately after the rectangle is drawn. 

 
SketchUp will use the current document units setting if you only type in a numerical value. 
You can also specify either Imperial (such as 1'6”) or Metric (such as 3.652m) units at any 
time, regardless the document units setting.  

You can also type one dimension at a time in the VCB. If you enter a value and a comma 
(3',), the new value will be applied to the first dimension, and the second dimension will be 
retained from before. Similarly, if you type a comma and then a value (,3'), only the second 
dimension will be changed. 

Tip - If you enter a negative value (-24, -24), SketchUp will apply that 
value in a direction opposite to the one you indicated while drawing and 
accept any new values in the new direction. 

Drawing Rectangles by Inference 
The Rectangle Tool uses SketchUp's geometric inference engine to help you place your 
rectangles in 3D space. The inference decisions, made by the inference engine, are 
displayed in the  drawing area as inference lines and inference points. These lines and 
points show precise alignment between the rectangle you are drawing and the geometry of 
your model. 

For example, if you move your mouse over an endpoint of an existing edge and then move 
away in the direction of an axis, a dotted inference line with a From Point help tag will 
appear. 

 
This help tag indicates that you are aligned to that end point. You can also use a From Point 
inference to draw rectangles vertically or at non-orthogonal planes. 

Locking a Rectangle to the Current Inference Direction  
Press and hold the Shift key, while the rectangle you are drawing is the specific color of an 
axis, to lock drawing operation to that axis. 
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 Circle Tool  
Use the Circle Tool to draw Circle entities. Activate the Circle Tool from the   or the  Draw 
menu. 

Keyboard Shortcut: C 

Drawing a Circle 
Circles can be placed on existing faces or separate from existing geometry. To draw a circle: 

1. Select the Circle Tool. The cursor changes to a pencil with a circle. 

2. Click to place the center point of the circle. 

3. Move the cursor out from the center point to define the radius of your circle. As you move 
the cursor, the radius value is displayed dynamically in the VCB and can be specified by 
typing in a length value followed by the Enter or Return key. You can also specify the 
segmentation for the circle in the VCB. 

  

 

 Note - Press the Esc key at any point during the operation to start over. 

4. Click to finish the circle.  

Tip - You can also click and hold the mouse button to set the center of 
the circle, and drag outward without releasing the button to set the radius. 
Release the mouse button to complete the circle. 

Radius and segment values can be specified using the VCB immediately after a circle is 
drawn. See Specifying Precise Circle Values for more information on setting the radius and 
segment values with the VCB. 

Specifying Precise Circle Values 
The VCB displays the radius after setting the center point of a circle. Use the VCB to enter 
an exact radius and number of segments.  

Specifying a Radius  
The VCB's label indicates "Radius" after you place the center point of the circle. Type the 
radius size in the VCB, after placing the center point, and press the Enter or Return key. You 
can perform this action either during or immediately following the creation of the circle. For 
example: 24r or  3'6"r or  5mr. 

 Note - The Circle Tool will snap to any previously entered radius within 
the VCB. 
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Specifying the Number of Sides 
The VCB's label indicates "Sides" when the Circle Tool is initially activated. Specify the 
number of sides in the VCB, and press the Enter or Return key, before clicking to set the 
center point of the circle. For example: 100. 

You can also specify the number of sides in a circle immediately after the creation of the 
circle. Type the number of sides in the VCB, followed by the letter 's', and press the Enter or 
Return key. For example: 20s. This number will be applied to any future circles.  

  Note - The default number of segments for a circle is 24. 

Locking a Circle to its Current Orientation 
Press and hold the Shift key, before you begin drawing a circle, to lock drawing operation to 
that orientation. 
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 Polygon Tool 
Use the Polygon Tool to draw regular Polygon entities. Activate the Polygon Tool from either 
the  Tool Palette, or by selecting Polygon from the  Draw menu. 

Drawing a Polygon  
Polygons can be placed on existing faces or separate from existing geometry. To draw a 
polygon: 

1. Select the Polygon Tool. The cursor changes to a pencil with a polygon. 

2. Click to place the center point of the polygon.  

3. Move the cursor out from the center point to define the radius of your polygon. As you 
move the cursor, the radius value is displayed dynamically in the VCB and can be 
specified by typing in a length value followed by the Enter or Return key.  

 

 Note - Press the Esc key at any point during the operation to start over. 

4. Click a second time to finish the polygon. (Alternately, you can click once to set the center 
of the polygon, and drag outward without releasing the button to set the radius. Release 
the mouse button to complete the polygon.) 

Radius and segment values can be specified using the VCB immediately after a polygon is 
drawn. See Specifying Precise Polygon Values for more information on setting the radius 
and segment values with the VCB. 

Specifying Precise Polygon Values 
The VCB displays the radius after setting the center point of a polygon. Use the VCB to 
enter an exact radius and number of segments.  

Specifying a Radius  
The VCB's label indicates "Radius" after you place the center point of the polygon. Type the 
radius size in the VCB, after placing the center point, and press the Enter or Return key. You 
can perform this action either during or immediately following the creation of the polygon. 
For example: 24r or  3'6"r or  5mr. 

 Note - The Polygon Tool will snap to any previously entered radius within the 
VCB. 

Specifying the Number of Sides 
The VCB's label indicates "Sides" when the Polygon Tool is initially activated. Specify the 
number of sides in the VCB, and press the Enter or Return key, before clicking to set the 
center point of the polygon. For example: 10. 

You can also specify the number of sides in a polygon immediately after the creation of the 
polygon. Type the number of sides in the VCB, followed by the letter 's', and press the Enter 
or Return key. For example: 6s. This number will be applied to any future polygons.  
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Locking a Polygon to its Current Orientation 
Press and hold the Shift key, before you begin drawing a polygon, to lock drawing operation 
to that orientation. 
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Modification Tools 
This section of the user's guide covers the modification tools within SketchUp. Modification 
tools are those tools used to modify existing geometry. These tools include the Push/Pull 
Tool, Eraser Tool, and Select Tool. 

Tools in this section are covered in the order they appear within the Tools menu. 
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 Move Tool 
Use the Move Tool to move, stretch and copy geometry. This tool can also be used to rotate 
components and groups. Activate the Move Tool using the Tool Palette or the  Tools menu. 

Keyboard Shortcut: M 

Moving a Single Entity 
You can activate the Move Tool when nothing is selected to select a single entity to move. 
The selection click point becomes the base point for the move operation. To select and 
move a single entity: 

1. Select the Move Tool. The cursor will change to a four-way arrow. 

2. Click on an entity to begin the move operation.  

3. Move the cursor to move the entity. The selected entity will follow as you move the cursor. 

4. Click at the destination point to finish your move operation.  

 Note - If the entity you are moving is connected to other entities, the 
other entities will be moved or modified accordingly. See the  Stretching 
Geometry section for further information on this behavior. 

Moving Several Entities 
You can preselect several entities to move prior to performing a move operation. To 
preselect and move entities: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the entities to be moved. 

3. Select the Move Tool. The cursor will change to a four-way arrow. 

4. Click once on an entity to begin the move operation. The point where you click on the 
entity is called the move point. 

5. Move your mouse to move the entities. The selected entities will follow as you move your 
mouse. Also, an inference line will appear between the start and ending points of the 
move, and the distance of the move is displayed dynamically in the VCB. You can also 
type in a specific distance as described below. The following image shows a component 
being moved: 
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Tip - Follow inference lines to easily align items in 3D space. Select 
corners of components as your move point and align to corners of other 
components when aligning components side-by-side (such as when aligning 
kitchen cabinet components). 

6. Click at the destination point to finish your move operation. 

 Note - Press the Esc key at any point during the operation to start over. 

Moving by Inference 
The Move Tool uses SketchUp's sophisticated geometric inference engine to help you place 
entities in 3D space. The inference decisions, made by the inference engine, are displayed 
in the  drawing area as inference lines and inference points. These lines and points show 
precise alignment between the move operation and the geometry of your model. Refer to the  
inference engine topic for additional information. 

Locking a Move to the Current Inference Direction 
Press and hold the Shift key, while the move you are performing is the specific color of an 
axis, to lock move operation to that axis. 

Locking a Line to a Specific Inference Direction 
Press and hold either the up arrow, left arrow, or right arrow keys, where up arrow equals 
blue, left arrow equals green, and right arrow equals red, while moving to lock the move to a 
specific axis. 

Moving Groups and Components  
If a component is glued to a face, the component will stay in the plane of that face when 
moved unless it is unglued. Copies of a glued component will also be glued to the originating 
plane. 

Stretching Geometry 
When you move an element that is interconnected with others, SketchUp will stretch 
geometry as necessary. You can move points, edges, and faces in this manner. For 
example, the following Face entity can be moved back in the negative red direction or up in 
the positive blue direction: 

 
You can also move single line segments to stretch an object. In the following example, a line 
is selected and moved up in the blue direction to form a sloped roof. 
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Moving/Stretching With Autofold 
SketchUp will Autofold faces automatically when a move or stretch operation will create non-
planar faces. For example, clicking on the corner of a box with the Move Tool and move 
down in the blue direction causes SketchUp to create a fold line along the box's top face. 

 

Forcing Autofold Behavior 
There are times when SketchUp constrains an operation in favor of keeping all faces planar 
and not creating additional fold lines. For example, clicking on the edge of a box with the 
Move Tool only allows you to move the edge in a horizontal direction (red and green), but 
not vertically (blue). 

You can override this behavior by pressing and releasing the Command key before 
performing the move operation. This key sequence enables Autofold allowing geometry to 
move freely in any direction.  

 

Making Copies 
As mentioned previously, the Move Tool can be used to make copies of entities within your 
model. To make copies of an entity using the Move Tool: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the entities to be copied. 
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3. Select the Move Tool. The cursor will change to a four-way arrow. 

4. Press and release the Option key on your keyboard. The cursor will change to a four-way 
arrow with a plus sign. This action informs Sketchup that you want to duplicate the 
selected entities. 

5. Click on the selected entities to copy.  

6. Move the cursor to copy the entities. A copy of the selected entities will follow as you move 
your mouse. 

7. Click at the destination point to finish your copy operation. The copied entities are now 
selected and the original entities are deselected.  

 Note - You can press and release the  Option key on your keyboard at 
any time during a move operation to perform a copy (not just at the start).  

Creating Multiple Copies (Linear Arrays)  
The Move Tool can also be used to create arrays, or a series of copies of geometry. To 
create multiple copies of one or more entities: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the entities to be copied. 

3. Select the Move Tool.  

4. Press and release the Option key on your keyboard. The cursor will change to an arrow 
with a plus sign. This action informs SketchUp that you want to duplicate the selected 
entities. 

5. Click on the selected entities to copy.  

6. Move your mouse to copy the entities. A copy of the selected entities will follow as you 
move your mouse. 

7. Click at the destination point to finish your copy operation. The copied entities are now 
selected and the original entities are deselected.  

8. Type a multiplier value to create additional multiple copies. For example, typing in 2x (or 
*2) will create one additional copy (or 2 copies total, the one you manually copied plus one 
you automatically copied using this step) instead of just one. 

Creating Copies at an Equal Distance Apart 
You can divide the distance between the copy and the original by typing in a divisor value. 
For example, typing 5/ (or /5) will create five copies evenly distributed between the original 
and the first copy. You can keep typing in distances and multipliers until you perform another 
operation. 
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Tip - This feature is particularly useful in creating models of items such 
as fences, bridges, and decks, where you might want several posts or beams 
an equal distance apart.  

Specifying Precise Move Values 
The VCB at the bottom right corner of the SketchUp window displays the length of the move 
operation (displacement) in the default units, as specified under the Units panel of the Model 
Info dialog box, while moving, copying, or stretching entities. In addition to creating arrays, 
you can also specify an exact displacement or a relative or absolute 3D coordinate for the 
finishing point during, or immediately after, a move operation.  

Entering a Displacement Value 
You can specify a new displacement length during or directly following a move operation. To 
enter a displacement value during a move operation: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the entities to be moved. 

3. Select the Move Tool. The cursor will change to a four-way arrow. 

4. Click once to select the start point of the move operation.  

5. Move your mouse to begin moving the entities in the correct direction. The selected 
entities will follow as you move your mouse. Also, an inference line will appear between 
the start and ending points of the move, and the distance of the move is displayed 
dynamically in the VCB.  

6. Type the positive or negative displacement value (such as 20' or -35mm) in the VCB and 
press Enter or Return. 

 Note - You can type values in the VCB using an alternate measuring 
system than the default system. SketchUp will convert the value to the default 
system. For example, you can type in 3' 6" even if you are using metric system 
as your default. 
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Entering a 3D Coordinate 
SketchUp can move your entities to exact (using []) or relative (using <>) coordinates in 3D 
space. To enter a 3D coordinate during a move operation: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the entities to be moved. 

3. Select the Move Tool. The cursor will change to a four-way arrow. 

4. Click once to select the start point of the move operation.  

5. Move your mouse to begin moving the entities in the correct direction. The selected 
entities will follow as you move your mouse. Also, an inference line will appear between 
the start and ending points of the move, and the distance of the move is displayed 
dynamically in the Value Control Box (VCB).  

6. Type the exact or relative coordinate.  

 Global Coordinates: [x, y, z] of the current Sketch Axes:  

 
 Relative Coordinates: <x, y, z> relative to the start point: 

 

 Note - You can define only one or two values as part of your 3D 
coordinate. For example, to move geometry to 2 feet in the z or blue direction 
enter the following in the VCB: [,,2'] 

 Note - The exact format for values typed in the VCB will vary depending 
on your computer's regional settings. For some European users, the list 
separator symbol is a semi-colon instead of a comma. For example,  [x; y; z] 
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 Rotate Tool  
Use the Rotate Tool to rotate, stretch, distort, or copy entities along a rounded path. Activate 
the Rotate Tool from either the Tool Palette or the  Tools menu. 

Keyboard Shortcut: Q 

Rotating Geometry 
You can rotate geometry in three different planes in a 3D environment. To rotate geometry 
using the Rotate Tool: 

1. Select the Rotate Tool. The cursor will change to a protractor with a circular arrow. 

2. Click on the entity to rotate.  

3. Move the cursor in a circle until it is at the starting point of the rotation.  

 
4. Click to set the starting point of the rotation. Use the inference help tags help you to find 

the center of the rotation. 

5. Move the cursor until it as at the ending point of the rotation. If the Enable angle snapping 
checkbox is checked in the Units Panel of the Model Info dialog box, movements close to 
the protractor result in angle snaps, while those further away from the protractor allow free 
rotation. 

 Note - Press the Esc key at any point during the operation to start over. 
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6. Click to complete the rotation.  

Rotational Stretching with Auto-Fold 
The Rotate Tool can also be used to stretch geometry by selecting and rotating a portion of 
the geometry. Any rotational movement that would cause a face to twist in on itself or 
otherwise become non-planar will activate SketchUp's Auto-Fold feature. 

 

Making Copies  
The Rotate Tool can be used to make rotated copies of entities within your model. To make 
copies of an entity using the Rotate Tool: 

1. Select the Rotate Tool. The cursor will change to a protractor with a circular arrow. 

2. Click on the entity to rotate.  

3. Press and release the Option key on your keyboard. The cursor will change to a protractor 
with a plus sign. This action informs Sketchup that you want to duplicate the entity. 

4. Move the cursor in a circle until it is at the starting point of the rotation.  

5. Click to set the starting point of the rotation. Use the inference help tags help you to find 
the center of the rotation. 

6. Move the cursor until it as at the ending point of the rotation. A copy of the entity appears 
and is rotated about the starting point. If the Enable angle snapping checkbox is checked 
in the Units Panel of the Model Info dialog box, movements close to the protractor result in 
angle snaps, while those further away from the protractor allow free rotation.  

7. Click to complete the rotation.  
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 Note - You can press and hold the  Option key on your keyboard at any 
time during a move operation to perform a copy (not just at the start).  

Creating Multiple Copies (Radial Arrays)  
The Rotate Tool can also be used to create radial arrays, or a series of copies around a 
rotate point. To create a radial array. 

1. Select the Rotate Tool. The cursor will change to a protractor with a circular arrow. 

2. Click on the entity to rotate.  

3. Press and release the Option key on your keyboard. The cursor will change to a protractor 
with a plus sign. This action informs Sketchup that you want to duplicate the entity. 

4. Move the cursor in a circle until it is at the starting point of the rotation.  

5. Click to set the starting point of the rotation. Use the inference help tags help you to find 
the center of the rotation. 

6. Move the cursor until it as at the ending point of the rotation. A copy of the entity appears 
and is rotated about the starting point. If the Enable angle snapping checkbox is checked 
in the Units Panel of the Model Info dialog box, movements close to the protractor result in 
angle snaps, while those further away from the protractor allow free rotation.  

7. Click to complete the rotation.  

8. Type a multiplier value to create additional multiple copies. For example, typing in 2x (or 
*2) will create one additional copy (or 2 copies total, the one you manually copied plus one 
you automatically copied using this step) instead of just one. 

.  

 Note - You can press and hold the  Option key on your keyboard at any 
time during a rotate operation to perform a copy (not just at the start).  

Creating Copies at an Equal Distance Apart 
You can divide the distance between the copy and the original by typing in a divisor value in 
the VCB. For example, typing 5/ (or /5) will create five copies evenly distributed between the 
original and the first copy. You can enter distances and multipliers until you perform another 
operation. 

Folding Along an Axis of Rotation 
You can fold geometry by setting the protractor along an edge that will act like a fold line and 
then folding geometry at that line. To fold geometry along an axis of rotation:  

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the geometry to rotate. The bottom of the triangle will act as a fold line. 
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3. Select the Rotate Tool. The cursor will change to a protractor with a circular arrow. 

4. Click and hold on one end of the fold line or edge where the fold will appear in your 
geometry. 

5. Drag the cursor along the fold line to align the protractor to the fold line (the bottom of the 
triangle). 

 
6. Release the mouse button to set the rotation point or the point upon which the geometry 

will rotate. 

7. Click the mouse again to set the starting point of the rotation. 
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8. Move the mouse to rotate. If angle snaps are active under preferences, you'll notice that as 
you move the mouse, movements close to the protractor will result in angle snaps, while 
those further away from the protractor will allow free rotation. 

 
9. Click a third time at the ending point of the rotation (to complete the rotation).  

 

Specifying Precise Angular Values 
The degree of rotation you have indicated appears in angular degrees in the VCB while 
rotating. You can also manually enter in angular rotation or slope values directly into the 
VCB while rotating geometry.  

Entering an Angular Rotation Value 
To specify an exact angle in degrees, type a decimal value into the VCB while rotating the 
cursor around the protractor. For example, typing in 34.1 will give you an exact 34.1 degree 
angle. Negative values will move angle in a counter-clockwise direction. You can specify an 
exact angular value either during or immediately after your rotation operation. 

Entering a Slope Value 
To specify a new angle as a slope, type in the two values separated by a colon in the VCB, 
such as 8:12. Negative values will move angle in a counter-clockwise direction. You can 
specify an exact angular value either during or immediately after your rotation operation. 

Locking the Rotate Tool to its Current Orientation 
Press and hold the Shift key, before you click on an entity, to lock the operation to that 
orientation. 
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 Scale Tool 
Use the Scale Tool to resize and stretch portions of geometry relative to other entities in 
your model. Activate the Scale Tool from the Tool Palette or the  Tools menu. 

Keyboard Shortcut:S 

 Note - A Global Scale is an operation whereby the entire model is 
scaled simultaneously by applying a desired dimension to the distance 
between two points. The Scale Tool is only intended to perform scaling 
operations on portions of your model (not the entire model). Use the  Tape 
Measure Tool's  Global Re-Scale functionality to perform global scaling 
operations.  

Scaling Geometry  
1. Select the Scale Tool. The cursor will change to a box within another box.  

2. Click on the entity. Scaling grips will appear around the selected geometry. 

 
3. Click on a scaling grip. The selected grip and the opposite scaling grip will highlight in red. 

Each scaling grip provides a different scaling operation. See Scaling Options section for 
further information. 

4. Move the cursor to scale the entity. The Value Control Box (VCB) displays relative size of 
the item as you scale the item. You can enter the desired scale dimensions after the scale 
operation is complete.  

 Note - Press the Esc key at any point during the operation to start over. 

5. Click to finish scale operation. 

Scaling Auto-Folding Geometry 
SketchUp's Auto-fold feature works automatically with all Scale operations. SketchUp will 
create folding lines as necessary to maintain planar faces. 

Scaling a 2D Surface or Image Entity 
Two-dimensional surfaces and Image entities can be scaled just as easily as three-
dimensional geometry. The Scale Tool's bounding box contains nine scaling grips when 
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scaling a 2D face. These operate in a similar manner to the grips in a 3D bounding box, and 
also work with the  Option and Shift modifiers. 

The bounding box is a 2D rectangle when scaling a single 2D surface that lies in the red-
green plane. The bounding box will be a 3D volume if the surface to be scaled is out of 
plane with the current red-green plane. You can ensure a 2D scale by aligning the Drawing 
Axes to a surface prior to scaling. 

Scaling Components 
Scaling a Component entity scales the individual instance. All other instances of the 
component will retain their individual scales. This feature allows you to have many differently 
scaled versions of the same component in your model.  

Scale operations within a component's context (such as scaling a Line entity within a 
component) affects the component definition and, therefore, all instances of the component 
will be scaled to match (all instances of the same Line entity in all component instances).  

Scaling Grip Types 
Upon activation, the Scale Tool displays all the grips you may use. Any grips hidden behind 
geometry will become visible whenever touched by the mouse cursor, and remain fully 
operable. Turn on X-ray Transparency mode to reveal any hidden grips. 

The Scale Tool allows you to perform both uniform scaling and nonuniform scaling 
(stretching operations). The scaling grip that is used dictates the type of scaling you perform. 

 
  

Corner Grips 
Corner grips scale the selected geometry from the opposite corner. The default behavior is a 
uniform scale such that the proportions remain intact and a single scale factor or dimension 
is displayed in the VCB. 

Edge Grips 
Edge grips scale the selected geometry from the opposite edge by two dimensions 
simultaneously. The default behavior is a nonuniform scale, meaning that the proportions of 
the object will change. The VCB displays two values separated by a comma. 

Face Grips 
Face grips scale the selected geometry from the opposite face in only one dimension. The 
default behavior is a nonuniform scale, meaning that the proportions of the object will 
change. The VCB displays and accepts a single value. 
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Scaling About the Geometry Center  
The Scale Tool allows you to scale outward from geometry's center point. Hold down the 
Option key at any time during a scale operation to display the geometry's center point, click 
on any of the other scaling grips, and drag outward or inward to scale accordingly. 

Scaling Uniformly 
You might need to maintain the uniformity of geometry as it is being scaled, despite 
performing nonuniform scaling. The Shift key toggles to uniform scaling operation (from a 
nonuniform scaling operation) and to nonuniform scaling operation (from a uniform scaling 
operation).  

 Note - The  Option and Shift keys can be used in conjunction to allow 
uniform and non-uniform scaling from the center of the selected geometry. 

Controlling Scaling Direction With The Axis Tool  
You can precisely control the direction of scaling by first repositioning the drawing axes with 
the  Axes Tool. The Scale Tool will use the new red, green, and blue directions to orient 
itself, and control grip direction, after the axes are repositioned.  

 

Specifying Precise Scale Values 
The VCB at the bottom right corner of the SketchUp window displays the axis dimensions 
that are being scaled, and the value of the scale itself, in the default units (as specified 
under the Units panel of the Model Info dialog box) during a scaling operation. Type a scale 
value into the VCB to directly scale geometry during or immediately after a scaling 
operation.  

Entering a Scale Multiplier Value 
You can specify a new dimensional length value during or directly following a scaling 
operation. To enter a dimensional length value during a scaling operation: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the geometry to scale. 

3. Select the Scale Tool. The cursor will change to a box within another box. Scaling grips will 
appear around the selected geometry. 

4. Click on a scaling grip to select the grip. The selected grip and the opposite scaling grip 
will highlight in red. Each scaling grip provides a different scaling operation. See Scaling 
Options section for further information. 
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5. Move the mouse to scale the geometry. The Value Control Box (VCB) displays relative 
size of the item as you scale the item. You can enter the desired scale dimensions after 
the scale operation is complete. 

6. Type the dimensional length value (such as 2' 6" for two feet and six inches or 2m for two 
meters) in the VCB and press Enter or Return. 

Mirroring Geometry using the Scale Tool 
The Scale Tool can also be used to mirror geometry by pulling a grip towards and then 
beyond the point about which you are scaling. This operation allows you to pull geometry 
inside out. Note that the grips snap to certain negative values (such as -1, -1.5, and -2) just 
as they do in the positive direction. You can force a mirror by typing in a negative value or 
dimension. 

Entering Multiple Scale Values  
The VCB always indicates the scaling factors associated with a particular operation. A 1D 
scaling operation requires one value. A 2D scaling operation requires two values, separated 
by a comma. A Uniform 3D scaling operation requires only one value whereas a Non 
Uniform 3D scaling operation requires three values, each separated by a comma. 

You'll notice that during the scale operation, a dashed line appears between the scaling 
point and the grip you've selected. Entering a single value or distance in the VCB tells 
SketchUp adjust the anchor to grip distance to be that scale value or distance, regardless of 
which mode (1D, 2D, 3D) is active. 

When scaling in multiple directions, typing in multiple values separated by commas will 
resize the object(s) based on the entire bounding box dimension(s), not the objects 
individually. (To scale objects based on a particular edge or known distance, you can use 
the Tape Measure Tool.) 

  



 129

 Push/Pull Tool 
Use the Push/Pull Tool to push and pull Face entities to add volume to or subtract volume 
from your models. You can use push/pull to create volume out of any face type, including 
circular, rectangular, and abstract faces. Activate the Push/Pull Tool from either the  Tool 
Palette or the  Tools menu. 

Keyboard Shortcut: P 

 Note - Push/Pull works only on faces, and therefore does not work when 
SketchUp is set to a Wireframe rendering style. 

Creating a Volume 
Push/Pull Tool is used to expand or decrease the volume of geometry in your models. To 
push or pull faces: 

1. Select the Push/Pull Tool. The cursor will change to a 3D rectangle with an up arrow. 

2. Click on the face that you want to expand or decrease. 

 
3. Move the cursor to create (or decrease) volume. 

 

 Note - Press the Esc key at any point during the operation to start over. 

4. Click when the volume has reached the desired size. 

 Note - You can also press and hold the mouse button, drag the mouse, 
and release the mouse button to create a volume. 
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 Note - When you create a single face, as shown previously in step 4, on 
the ground plane (the red/green plane), SketchUp assumes you are going to 
be using that face as the floor of a structure. The front of the face (gray) points 
down and the back of the face (purple) points up. When you use the Push/Pull 
Tool on this single face (in the blue direction), you are really pulling up from 
the back of the face. The positive blue direction temporarily acts as the "below 
ground" or negative blue direction. A double-click, after performing the initial 
push/pull, applies a positive amount and returns the entity to the single face 
you started with.  

Repeating a Push/Pull Operation 
Double-clicking on another face immediately after a push/pull operation will automatically 
apply another push/pull operation, of the same amount, to the other face.  

 Note - The side of the face that you double-click on affects the direction 
of the repeated push/pull operation. If your last push/pull was on a front face, 
and you double-click on the back side face, the push/pull will occur in the 
opposite direction. 

Creating Voids 
Push/pull will implode the shape into the volume and toward the back face of the volume 
when you use push/pull on a shape that is part of another volume. SketchUp will subtract 
the shape and create a 3D void if the shape is pushed completely out of the back of the 
volume as in the following example. 
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 Note - This operation only works when the front and back faces are 
parallel. Such as when you have two parallel walls in a house and you want to 
create a void for a door or window. 

Creating a New Push/Pull Starting Face 
Push/Pull a face (click on the face, move, and then click again) and then press and release 
Option (the cursor will contain a plus sign) and push/pull again. The lines that represent the 
edges of the top-most face will remain as the starting point for a new push/pull operation. 
This mechanism is useful for creating quick multilevel buildings. The following image shows 
a face that was pulled up (left), then the user pressed and released  Option and pulled again 
(middle) and then the user pressed and released  Option and pulled again (right). 
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This operation is particularly useful for creating quick space planning diagrams (such as for 
an office building). Simply use a combination of push/pull and push/pull with Ctrl to create 
offices, halls, break rooms, meeting rooms and so on (with walls created when Ctrl is 
pressed). 

Pushing and Pulling a Curved Face 
You can use the Push/Pull Tool on faces that have an arc as an edge similarly to using the 
Push/Pull Tool on regular faces. The curved face that results from the push/pull operation is 
called a  Surface entity. Surfaces can be adjusted as a whole, but are comprised of a 
number of faces or a  curved face set. 

 

Tip - Select View > Hidden Geometry to view and manipulate the 
individual faces in the surface. 

Specifying Precise Push/Pull Values 
The displacement of a push/pull operation is displayed in the Value Control Box. You can 
specify an exact push/pull value either during or immediately after your push/pull operation. 
Negative values will perform the push/pull in the opposite direction. 
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 Follow Me Tool 
Use the Follow Me Tool to duplicate the profile of a face along a path. This tool is especially 
useful when trying to add details to a model, such as a crown molding, because you can 
draw the profile of the molding at one end of a path on the model and using the Follow Me 
Tool continue that detail along the path. You can manually and automatically extrude a face 
along a path using the Follow Me Tool. Activate the Follow Me Tool from the Tools menu or 
the  Tool Palette.  

 Note - The path and the face must be in the same context. 

Manually Extruding a Face Along a Path  
The manual method for extruding a face along a path allows you to control the direction the 
face will travel while performing the extrude. To manually extrude a face along a path using 
the Follow Me Tool: 

1. Identify the edge of the geometry you want to modify. This edge will be your path. 

2. Draw a face that you want to follow the path. Make sure that this profile is approximately 
perpendicular to the path. 

 
3. Click on the Follow Me Tool from the toolbar. The cursor will change to a slanted cylinder 

with an arrow.  

4. Click on the face that you created. 

5. Drag the cursor along the path. SketchUp will highlight the path, in red, you are following 
as you drag your cursor around the model. You must touch the segment of the path 
immediately adjacent to the profile for the Follow Me to start in the correct location. If you 
select an edge, as your starting edge, that is not touching the profile, Follow Me will start 
extruding at that edge, not from the profile to that edge. 
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 Note - Press the Esc key at any point during the operation to start over. 

6. Click to complete the Follow Me operation when you reach the end of the path. 

  

Preselecting the Path 
You can preselect the path using the Select Tool to help the Follow Me Tool follow the 
correct path. To extrude a face along a pre-selected path: 

1. Draw a profile of the face that you want to follow the path. Make sure that this profile is 
approximately perpendicular to the path. 

2. Select the continuous set of edges that represent the path. 

3. Select the Follow Me Tool from the Tools menu (the edges should still be selected). The 
cursor will change to a slanted box with an arrow.  

4. Click on the profile that you created. The surface will be extruded continuously along your 
pre-selected path. 

Automatically Extruding a Face Along a Single Surface Path 
The simplest and most accurate way to extrude a face along a path is to have the Follow Me 
Tool automatically select and follow a path on a single coplanar surface. To automatically 
extrude a face along a path on an single surface using the Follow Me Tool: 

1. Identify the edge of the geometry you want to modify. This edge will be your path. 

2. Draw a profile of the face that you want to follow the path. Make sure that this profile is 
approximately perpendicular to the path. 
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3. Select the Follow Me Tool from the Tools menu. 

4. Press and hold the Command Key. 

5. Click on the profile that you created. 

6. Move the cursor off the profile surface onto the surface around which you wish to sweep. 
The path will automatically close. 

 

 Note - If your path consists of the edges around a single surface, you 
can select the surface and then the Follow Me Tool to automatically follow the 
edges around the surface. 

7. Click to commit the follow-me operation. 
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Creating a Lathed Shape 
You can use the Follow Me Tool to create full lathed shapes using circular paths. To create 
a lathed shape:  

1. Draw a circle whose edge will represent the path. 

2. Draw a face perpendicular to the circle. The face does not have to be on or even touch the 
circle's path. 

 
3. Select the Follow Me Tool from the Tools menu. The cursor will change to a slanted box 

with an arrow.  

4. Follow the edge of the circle with the face using one of the methods above. 
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 Offset Tool 
Use the Offset Tool to create copies of lines and faces at a uniform distance from the 
originals. You can offset edges of faces either inside or outside of the original face. 
Offsetting a face will always create a new face. Activate the Offset Tool from the Tool 
Palette or from the  Tools menu. 

Keyboard Shortcut: F 

Offsetting a Face 
The most common use of the Offset Tool is to offset the edges that bound a face. To 
perform a face offset: 

1. Select the Offset Tool. The cursor will change to two offset corners. 

2. Click on the face to be offset.  

 
3. Move the mouse cursor to define the offset dimension. The offset distance is displayed in 

the VCB. You can offset either within or outside of the face; on rectangular face or circular 
face. 

 

 Note - Press the Esc key at any point during the operation to start over. 

4. Click to finish the offset operation. 

Offsetting Lines 
You can also select and offset connected, co-planar, lines (and arcs) for an offset. To offset 
lines: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the lines to be offset. You must select two or more connected lines, and all your 
lines must be coplanar. 
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3. Select the Offset Tool. 

4. Click on one of your selected line segments. The cursor will automatically snap to the 
nearest line segment.  

5. Move the cursor to define the offset dimension. 

 
6. Click to finish the offset operation. 

Tip - You can click once on the selected line segments, drag to set the 
offset while holding down the mouse button, and release the button to accept. 

 Note - Offsetting an Arc entity will create a Curve entity that cannot be 
edited. The original Arc, however, can still be edited after this operation. 

Repeating an Offset Operation 
Double-clicking on another face immediately after a offset operation will automatically apply 
another offset operation, of the same amount, to the face.  

Specifying Precise Offset Values 
The VCB at the bottom right corner of the SketchUp window displays the length of the offset 
in the units as specified under the Units panel of the Model Info dialog box, while offsetting 
entities. You can also specify an exact offset during, or immediately after, an offset 
operation.  

 Note - You can type values in the VCB using an alternate measuring 
system than the default system. SketchUp will convert the value to the default 
system. For example, you can type in 3' 6" even if you are using metric system 
as your default. 
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Entering an Offset Value  
You can specify a new offset length during or directly following an offset operation. To enter 
an offset value during an offset operation: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the lines to be offset. You must select two or more connected lines, and all your 
lines must be coplanar. You can use the Option and/or Shift key to change your selection. 

3. Select the Offset Tool. 

4. Click on one of your selected line segments. The cursor will automatically snap to the 
nearest line segment.  

5. Move the mouse to define the offset dimension. 

6. Click your mouse to accept the offset lines. 

7. Type the positive or negative offset value (such as 20' or -35mm) in the VCB and press 
Enter or Return. 
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Intersect With Model Tool 
Use the Intersect With Model Tool to create complex geometry. This tool allows you 
intersect two elements, such as a box and a tube, to automatically create new edges and 
faces where the elements intersect. These faces can then be pushed, pulled or deleted to 
create new geometry. Activate the Intersect With Model Tool from either context menu or the 
Edit menu. 

Creating Complex Geometry 
To create complex geometry using the Intersect With Model Tool: 

1. Create two distinct geometries, such as a box and a tube. 

 
2. Select the Select Tool. The changes to an arrow. 

3. Triple-click on the tube to select all of the entities of the tube 

4. Select the Move Tool. The cursor will change to a four-way arrow. 

5. Move the tube such that it intersects the box completely in any way you like. Notice that no 
edges exist where the tube meets the faces of the box on the box's top face. The tube 
should remain selected although it is within the box. 

 
6. Context-click on the selected tube. 

7. Select Intersect With Model from the context commands menu. The tool creates edges 
where the tube intersects the box. 
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8. Delete or move the portions of the tube that you do not want to keep. Notice that SketchUp 

will have created new subdivided faces where the tube intersected the box. 

 

Intersect With Model, Groups, and Components 
Edges created by the Intersect With Model Tool are drawn in the current context. For 
example, if one of your intersecting entities is a group, and you perform the Intersect with 
Model while editing that group (such as while editing the tube), the intersection lines will be 
applied within the group (right-most image below). 
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Position Texture Tool 
Materials within SketchUp are applied as tiled images meaning that the pattern or image will 
repeat both vertically and horizontally across any entities you paint. Use the Position Texture 
Tool to adjust a material on a surface in a number of ways, including repositioning, resizing, 
and distorting. Additionally, this tool allows you to perform unique actions on images such as 
painting a picture around a corner or projecting it on a model. Activate the Position Texture 
Tool from the context menu for a Face entity. 

 Note - The Position Texture Tool can only be used to modify textures 
applied to flat surfaces. You cannot edit a texture applied to a curved surface 
as a whole though you can use the View > Hidden Geometry menu item view 
and edit the texture on the individual faces that make up the curve's face set. 

 Note - Normally a texture is a subset of a material. However, the terms 
material and texture are used interchangeably in this topic.  

Repositioning a Material 
Repositioning the material is the easiest of position texture operations. To reposition a 
material: 

1. Context-click on the material to display its context menu.  

2. Select the Position option from the Texture sub-menu. A matrix of dotted lines is displayed 
on the material to indicate the material's individual tiles. The cursor also changes to a hand 
and four pins are displayed. 

3. Drag the cursor on the surface to reposition the texture on that surface. If you want to 
rotate the tiled image, context-click on the surface again and select Rotate or Flip. 

4. When you are finished modifying the texture, context-click and select Done, or just click 
outside the texture to exit the Position Texture Tool.  

Tip - Press the Esc key anytime during editing to reset the material's 
position to its previous position. Press Esc twice to cancel the entire texture 
positioning operation. While positioning a texture, you can back up a step at 
anytime by context-clicking and selecting Undo from the context menu. 

Material Positioning Pins 
The Position Texture Tool uses pins to manipulate a material. Pins can be moved or 
dragged. A move operation simply moves the pin to another location on the material. A drag 
operation performs some manipulation of the material, such as a resize or skew.  

The Position Texture Tool has two modes: Fixed Pin Mode and Free Pin Mode. 

Manipulating a Material Using Fixed Pin Mode 
Fixed pin mode allows you to scale, skew, shear and distort a texture, while constraining or 
"fixing" one or more pins. Fixed pin mode is best for materials that tile like brick or roofing 
textures. To manipulate a material using Fixed Pin Mode: 

1. Context-click on the material to display its context menu.  
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2. Select the Position option from the Texture submenu. A matrix of dotted lines are 
displayed on the material to indicate the materials individual tiles. The cursor also changes 
to a hand and four pins are displayed. 

3. Context-click on the material 

4. Select the Fixed Pins menu item if there is not a check mark next to the item. Colored 
icons appear next to each pin, each icon representing a specific position texture operation. 

 
5. Manipulate the material by clicking, holding, and dragging on one of the pins. See Fixed 

Pin Mode Options in this topic for additional information. 

 Note - Single-clicking on a pin grabs the pin allowing you to move the 
pin to a different location on the texture. This new position will be the starting 
point for any of the fixed pin mode operations. This action works in both Fixed 
Pin and Free Pin modes. 

6. When you are finished modifying the texture, context-click and select Done, or just click 
outside the texture to exit the Position Texture Tool.  

Fixed Pin Mode Options 
 Move Icon and Pin: Drag (click and hold) the Move icon or pin to reposition the 

texture. When you are finished modifying the texture, context-click and select Done, or just 
click outside the texture to close it. Or you can simply press Return (Enter) when finished.  

 Scale / Rotate Icon and Pin: The Scale/ Rotate icon or pin is used to scale and rotate 
the material to any angle, based on the fixed pin location of the move pin. Dragging the 
cursor closer to, or farther from, the base pin will scale the material. Dragging the pin icon 
around the base pin causes SketchUp to rotate the material. A dashed arc is created in the 
direction that you rotate the material. If you hold the cursor over the dashed arc, the material 
will rotate, but not scale.  

Notice that the dots along the dashed lines and arcs show you the current size and the 
original size of the texture for reference. You can change back to the original size by moving 
the cursor to the original arc and line. Or you can select Reset from the Context menu. Be 
forewarned that selecting Reset also resets the rotation as well as the scale. 
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 Scale / Shear Icon and Pin: The Scale/Shear icon or pin is used to simultaneously 
slant or shear and resize the material. Notice that the two bottom pins are fixed during this 
operation. 

 Distort Icon and Pin: The Distort icon or pin is used to perform a perspective 
correction on the material. This feature is useful for applying image photos to geometry. 

Manipulating a Material Using Free Pin Mode 
Pins are not constrained to other pins in Free Pin Mode allowing you to drag pins anywhere 
to distort the material just as you might distort a material as you stretch it over a drum. Free 
pin mode is best for positioning and removing the distortion from photographs. To 
manipulate a material using Free Pin Mode: 

1. Context-click on the material to display its context menu.  

2. Select the Position option from the Texture submenu. A matrix of dotted lines are 
displayed on the material to indicate the materials individual tiles. The cursor also changes 
to a hand and four pins are displayed. 

3. Context-click on the material 

4. Select the Fixed Pins menu item if there is a check mark next to the item. Four pins 
appear. 

 
5. Manipulate the material by clicking, holding, and dragging on one of the pins.  

 Note - Single-clicking on a pin grabs the pin allowing you to move the 
pin to a different location on the texture. This new position will be the starting 
point for any of the fixed pin mode operations. This action works in both Fixed 
Pin and Free Pin modes. 

6. When you are finished modifying the texture, context-click and select Done, or just click 
outside the texture to exit the Position Texture Tool.  

Manipulating a Image as Material Using Free Pin Mode 
Free pin mode is especially useful when using an image as the foundation for geometry. For 
example, you can use a picture containing a door as the foundation for a photo-realistic door 
in a SketchUp model. To manipulate an image using Free Pin Mode: 

1. Create a rectangular face. 
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2. Select the File > Import menu item to insert an image, such as the image of a real door. 
The Open dialog box is displayed. 

3. Select an image format from the Files of type drop-down list. 

4. Click on the Use as texture radio button.  

5. Select the image file. 

6. Click on the Open button. 

7. The cursor changes to the Paint Bucket Tool with the image.  

8. Click on one corner of the face to place the starting point of the texture. 

9. Drag the cursor away from the starting point so that the texture is resized over the 
rectangular face. 

10. Click again to place the texture on the rectangular face. 

11. Context-click on the material to display its context menu.  

12. Select the Position option from the Texture submenu. A matrix of dotted lines are 
displayed on the material to indicate the materials individual tiles. The cursor also changes 
to a hand and four pins are displayed. 

13. Context-click on the texture 

14. Select the Fixed Pins menu item if there is a check mark next to the item.  

15. Manipulate the material by clicking, holding, and dragging on one of the pins.  

 Note - Single-clicking on a pin grabs the pin allowing you to move the 
pin to a different location on the texture. This new position will be the starting 
point for any of the fixed pin mode operations. This action works in both Fixed 
Pin and Free Pin modes. 

11. When you are finished modifying the texture, context-click and select Done, or just click 
outside the texture to exit the Position Texture Tool.  

Fixed Pin and Free Pin Mode Context Commands 
Context-click while using the Position Texture Tool to display the position texture context 
menu. 

Done: The Done menu item is used to exit the Position Texture Tool and save the 
current texture position. 

Reset: The Reset menu item is used to reset the position of the texture to the position 
prior to using the Position Texture Tool. 

Flip: The Flip menu item is used to flip the texture horizontally (Left/Right) or 
vertically (Up/Down). 

Rotate: The Rotate menu item is used to rotate the texture one of three predefined 
increments: 90, 180, and 270 degrees. 

Fixed Pins: The Fixed Pins menu item is used to toggle between Fixed Pin and Free 
Pin modes. 

Undo: The Undo menu item will undo the last position texture command.  Unlike the 
Undo command in the Edit menu, this undo command will only keep track of a single 
operation at a time. 
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Redo: The Redo menu item cancels Undo operations, returning you to the texture 
positioning state previous to using the Undo command. 

Caution - The Edit > Undo command and Undo button will Undo 
everything you did during your texture positioning session. The Edit > Redo 
operation cancels the Undo Edit > Undo operation, returning you to the last 
texture positioning command that you performed. 

Wrapping Material Around Corners 
The texture can be wrapped around a corner, just as you might wrap a package with 
wrapping paper. To wrap textures around corners: 

1. Create a three-dimensional cube. 

2. Select the File > Import menu item to insert an image. 

3. Select an image format from the Files of type drop-down list. 

4. Select the image file. 

5. Click the Open button. The cursor changes to the Select Tool with the image.  

6. Click in the drawing area to place the starting point of the image. 

7. Drag the cursor away from the starting point so that the image is resized. 

8. Click again to place the image. 

9. Context-click on the image. The Image entity's context menu appears. 

10. Select Use as Material. The image appears in the Colors In Model material library within 
the Materials Browser. 

11. Select the Paint Bucket Tool. The cursor will change to a paint bucket and the Materials 
Browser is activated. 

12. Click and hold the Commandkey while using the Paint Bucket Tool to change to the eye 
dropper.  

13. Click on the thumbnail of your image in the Colors In Model material library within the 
Materials Browser. 

14. Release the Command. 

15. Click on a face of your model and paint the material. 

16. Context-click on the material to display its context menu.  

17. Select Texture > Position. Don't position anything! 

18. Context-click again  

19. Select Done from the Position Texture Tool context menu. 

20. Click and hold the Command while using the Paint Bucket Tool to change to the eye 
dropper.  

21. Click on the painted material using the eye dropper to sample the material. 

22. Release the Command. 

23. Paint the sampled texture on the remainder of the model. The texture is wrapped around 
corners. 

http://neuage.org/Flare Projects/SketchUp User's Guide/Content/F-Model_Settings_and_Managers/Settings-MatBrowser.htm
http://neuage.org/Flare Projects/SketchUp User's Guide/Content/F-Model_Settings_and_Managers/Settings-MatBrowser.htm
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Wrapping Material Around a Cylinder 
A texture can also be wrapped around a cylinder. To wrap a texture, such as an image 
texture, around a cylinder: 

1. Create a cylinder. 

2. Select the File > Import menu item to insert an image. 

3. Select an image format from the Files of type drop-down list. 

4. Select the image file. 

5. Click the Open button. The cursor changes to the Select Tool with the image. 

6. Click in the drawing area to place the starting point of the image. 

7. Drag the cursor away from the starting point so that the image is resized. 

8. Click again to place the image. 

9. Context-click on the image. The Image entity's context menu appears. 

10. Select Use as Material. The image appears in the Colors In Model material library within 
the Materials Browser. 

11. Click on the material in the Materials Browser. The cursor changes to the Paint Bucket 
Tool.  

12. Paint the Material on the cylinder. The material will automatically wrap around the cylinder, 
repeating itself as necessary to wrap the entire model. 

Repositioning a Material on Hidden Geometry 
You can adjust textures on a face, such as the faces of a cylinder, and then repaint the 
adjust texture across the entire curved surface of the cylinder. For example, to adjust a 
texture on a cylinder: 

1. Create a cylinder. 

2. Select the File > Import menu item to insert an image. 

3. Select an image format from the Files of type drop-down list. 

4. Select the image file. 

5. Click the Open button. The cursor changes to the Select Tool with the image. 



 148

6. Click in the drawing area to place the starting point of the image. 

7. Drag the cursor away from the starting point so that the image is resized. 

8. Click again to place the image. 

9. Context-click on the image. The Image entity's context menu appears. 

10. Select Use as Material. The image appears in the Colors In Model material library within 
the Materials Browser. 

11. Click on the material in the Materials Browser. The cursor changes to the Paint Bucket 
Tool.  

12. Paint the Material on the cylinder. The material will automatically wrap around the cylinder, 
repeating itself as necessary to wrap the entire model. 

10. Select the Display > Hidden Geometry menu item. 

11. Select one of the faces of the cylinder 

12. Context-click on the selected face. The Face entity's context menu appears.  

13. Select the Texture > Position menu item. 

14. Reposition the texture on the face. 

15. Sample the repositioned texture using the eyedropper button on the material browser, or 
using the Alt key with the Paint Bucket Tool. 

16. Click on Display > Hidden Geometry to turn off Hidden Geometry.  

17. Paint the sampled, repositioned, texture on the remainder of the cylinder. Your texture now 
appears as though it has been repositioned on the entire cylinder.  

Projecting a Material 
SketchUp's Texturing Positioning feature also lets you project materials or images onto 
faces as though projected using a slide projector. This feature is particularly useful if you 
wish to project a topographic image over a site model, or an image of a building onto a 
model representing the building. To project an image over a model: 

1. Create a model, such as a cone, topography, or building front. This model will receive the 
projected image. 

2. Insert an image using File > Import. The cursor changes to the Select Tool with the image.  

3. Place the image in front of the model that will receive the projection. 

4. Size the image so it is large enough to cover the entire model. 

5. Context-click on the image and select Explode to turn the image into a projected texture.  

 Note - Turn on x-ray display mode for the image to ensure the image is 
positioned such that it will cover the entire model.  

6. Select the Sample Paint Tool (eyedropper) from the Materials Browser.  

7. Sample the projected texture with the Sample Paint Tool. 

8. Paint the texture onto the faces of the model. The image will appear as though it were 
projected directly on the faces, adjusting to the contours of model. 
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Construction Tools 
This section of the user's guide covers the construction tools within SketchUp. Construction 
tools are those tools used to create construction geometry and prepare physical 
documentation. These tools include the Measure Tool, Text Tool, and Dimension Tool. 

Tools in this section are covered in the order they appear within the Tools menu. 
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 Tape Measure Tool 
Use the Tape Measure Tool to measure distances, create guide lines or points, or scale a 
model. Activate the Tape Measure Tool from the Tool Palette or the Tools menu. 

Keyboard Shortcut: T 

Measuring Distance 
The Tape Measure Tool is primarily used to measure distances between two points. To 
measure a distance between two points: 

1. Select the Tape Measure Tool. The cursor changes to a tape measure.  

2. Click at the starting point of your measurement. Use the inferencehelp tag to make sure 
you click on the exact point.  

3. Move the cursor in the direction you want to measure. A temporary measuring tape line, 
with arrows at each end, will stretch out from your starting point as you move the mouse. 
The Tape Measure Tool's measuring tape line functions like an inference line and will 
change color to match axes colors when it is parallel to any axes. The VCB dynamically 
displays the length of your measuring tape as you move the mouse around your model. 

 

 Note - Press the Esc key at any point during the operation to start over. 

4. Click at the ending point of your measurement. The final distance is displayed.  

Tip - You can also click and hold on the starting point of the distance you 
wish to measure, drag the mouse to the endpoint of the measurement, and 
release the mouse to obtain a measurement. 

Creating guide lines and guide points 
guide line entities and guide point entities are useful for drawing precisely. To create an 
infinite parallel guide line using the Tape Measure Tool: 

1. Select the Tape Measure Tool. The cursor changes to a tape measure.  

2. Click on a line that will be parallel to the guide line, to set the starting point of your 
measurement. You must click on an "On Edge" or "Midpoint" point between the start and 
end points in the line segment.  

 Note - Start from an "On Edge" point inference and move across a face 
to generate an infinite parallel guide line. Start from an "Endpoint" to create a 
finite guide line with a guide point at the end. 

3. Move the cursor the direction you want to measure. A temporary measuring tape line and 
a guide line will stretch out from your starting point.  
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4. Click again at the point where you want to set your guide line. The final distance is 

displayed in the VCB. 

Tip - Starting from an endpoint or midpoint results in a guide point. 

 

Scaling an Entire Model 
You can rescale your model to a more precise dimension during the modeling process by 
specifying the desired dimension between two points using the Tape Measure Tool. This line 
is referred to as the reference line. To scale an entire model: 

1. Select the Tape Measure Tool. The cursor changes to a tape measure.  

2. Click one end of a line segment to set the starting point of a measurement. Use the 
inferencehelp tag to make sure you click on the exact point.  

3. Move the mouse to the end point of the same line segment. A temporary measuring tape 
line, with arrows at each end, will stretch out from your starting point as you move the 
mouse.  

4. Click again at the other end of the line segment. The final distance is displayed in the VCB. 

5. Enter a new size for the line in the VCB and press the Return key. This size will be used as 
the basis for a proportional rescale of your model. The following dialog box appears. 
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6. Click the Yes button. The model will be rescaled proportionally.  

 Note - Only components that are created within the current model (not 
dragged from the Component Browser and loaded from an external 
component file) can be resized. 

Specifying Precise Distance Values 
The VCB displays the distance that a guide line is from the starting point. Specify a different 
distance simply by typing it in the VCB. Specify a negative length to draw the line in the 
direction opposite the one indicated. 

Locking a Line to a Specific Inference Direction 
Press and hold either the up arrow, left arrow, or right arrow keys, where up arrow equals 
blue, left arrow equals green, and right arrow equals red, while measuring to lock a specific 
axis. 
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 Protractor Tool  
Use the Protractor Tool to measure angles and create angled guide lines. Activate the 
Protractor Tool from the Tool Palette or the Tools menu. 

Measuring an Angle  
Measure an angle when you want to duplicate that angle elsewhere in your model or create 
plans, such as for a woodworking project. To measure and an angle: 

1. Select the Protractor Tool. The cursor will change to a protractor, aligned to the red/green 
plane and with its center point fixed to the cursor. 

2. Place protractor's center at a vertex of the angle (where two lines meet).  

3. Click to set the vertex of the angle you will measure. The following image shows the 
protractor being placed at the angle's vertex. 

 
4. Move the cursor in a circle until it is touching the start of the angle (one of the lines). The 

following image shows the first line in the angle (from the vertex out along to the red 
square). 

 
5. Click to set the start of the angle. 

6. Move the cursor in a circle until it is touching the end of the angle (other line). Notice that 
the protractor has marks, indicating 15 degree increments, on its edge. The angle will snap 
to these tick marks when the cursor is close to the protractor while moving around the 
protractor. Conversely, angle will move in more precise (smaller) increments when your 
cursor is farther from the center of the protractor while moving around the protractor. 

 Note - Press the Esc key at any point during the operation to start over. 



 154

7. Click to measure angle. The angle's measurement will appear in the VCB. The value 
displayed in the VCB is referred to as the angular rotation value. The following image 
shows the second line in the angle (from the vertex out along to the red square). The angle 
measures 120 degrees. 

 

 Note - Set the angle manually by entering a value in the VCB, and 
pressing  Return. The value can either be in decimal degrees, such as  34.1, 
 or slope, such as  1:6. This value can be changed any number of times before 
proceeding to the next command. 

Creating Angled guide lines 
Angled guide lines are useful to draw angled geometry such as a roof slope. To create an 
angled guide line: 

1. Select the Protractor Tool. The cursor will change to a protractor, aligned to the red/green 
plane and with its center point fixed to the cursor. 

2. Place protractor's center at a vertex of the angle. 

3. Click to set the vertex of the angle you will measure. The following image shows the 
protractor being placed at the angle's vertex. 

 
4. Move the cursor in a circle until it is touching the start of the angle (one of the lines). The 

following image shows the first line in the angle (from the vertex out along to the red 
square). 
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5. Click to set the start of the angle. 

6. Move the cursor in a circle until the guide line is at the desired angle. Notice that the 
protractor has marks, indicating 15 degree increments, on its edge. The angle will snap to 
these tick marks when the cursor is close to the protractor while moving around the 
protractor. Conversely, angle will move in more precise (smaller) increments when your 
cursor is farther from the center of the protractor while moving around the protractor. 

 Note - Press the Esc key at any point during the operation to start over. 

7. Click to create the guide line. The following image shows a guide line created at a 45 
degree angle so that a profile of a roof can be drawn. 

 

Entering Exact Angular Values 
The degree of rotation you have indicated appears in angular degrees in the VCB while 
creating guide lines using the Protractor Tool. You can also manually enter in angular 
rotation or slope values directly into the VCB while measuring an angle and setting a guide 
line. 

Entering an Angular Rotation Value 
To specify an exact angle in degrees, type a decimal value into the VCB while rotating the 
cursor around the protractor. For example, typing in 34.1 will give you an exact 34.1 degree 
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angle. Negative values will move angle in a counter-clockwise direction. You can specify an 
exact angular value either during or immediately after your rotation operation. 

Entering a Slope Value 
To specify a new angle as a slope, type in the two values separated by a colon in the VCB, 
such as 8:12. Negative values will move angle in a counter-clockwise direction. You can 
specify an exact angular value either during or immediately after your rotation operation. 

 Note - SketchUp can handle up to 0.1 of a degree of angular precision. 

Locking the Protractor Tool to its Current Orientation 
Press and hold the Shift key, before you click on an entity, to lock the operation to that 
orientation. 
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 Axes Tool 
Use the Axes Tool to move, or reorient, the drawing axes within your model. For example, 
you might want to move the axes when you are constructing rectangular objects that are 
skewed relative to one another. Or, you might use this tool to allow for more accurate 
scaling of objects that are not oriented along the default coordinate planes.  Activate the 
Axes Tool from either the Tool Palette or the Tools menu.  

Moving the Drawing Axes 
To move the Drawing Axes: 

1. Select the Axes Tool. The cursor changes to a collection of axes.  

2. Move your cursor to a point in your model that you want to be the new origin. You will see 
the axes snap to inferred alignments and points as you move near them around your 
model. Use the inference help tags to make sure your cursor is located exactly where you 
want it to be.  

3. Click to establish the origin. 

4. Move cursor away from the origin to set the direction for the red axis. Use the inference 
help tags to make sure you are aligned precisely.  

5. Click to accept the direction. 

6. Move your cursor away from the origin to set the direction of the green axis. Use inference 
help tags again to make sure you are aligned precisely.  

 Note - Press the Esc key at any point during the operation to start over. 

7. Click again to accept the direction. 

 
You have moved your axes. The blue axis will appear perpendicular to the new red/green 
plane. 

 Note - Moving the drawing axes does not change the true ground plane 
for shadows and ground/sky display. 

Resetting the Drawing Axes 
Context-click on the drawing axes and select Reset from the context menu to restore the 
axes to the default position. 
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 Dimension Tool 
Use the Dimension Tool to place Dimension entities in your model. Activate the Dimensions 
Tool from either the  Tool Palette or the  Tools menu. 

Placing Linear Dimensions 
Dimensions in SketchUp are based on a 3D model. Edges and points can be used to take 
dimensions. Suitable points include: end points, midpoints, on edge points, intersections, 
and arc and circle centers. Dimension leaders can be adjusted to span between non-linear 
points in a model so that your dimensions are as useful as possible in 3D. To take a 
dimension between two points in your model: 

1. Select the Dimension Tool. The cursor changes to an arrow. 

2. Click at starting point of your dimension. 

3. Move the cursor toward the endpoint of your dimension.  

 
4. Click on the endpoint of your dimension.  

5. Move the cursor perpendicular to create a dimension string. 

 

 Note - Press the Esc key at any point during the operation to start over. 

6. Click the mouse to fix the position of the dimension string.  
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Tip - You can take a dimension of a single line simply by clicking on the 
line and moving the cursor.  

Tip - You might need to occasionally rotate your model, as you 
dimension, to position the dimension to the proper plane. 

The appearance of all Dimensions are set and controlled from the Dimension panel of the 
Model Info dialog box. These settings affect all dimensions already in the model. 

Dimension Plane 
You can take dimensions in one of several planes. These include the current axial planes 
(red/green, red/blue, red/green) or the plane aligned to the edge you are measuring. Radius 
and Diameter dimensions are limited to the plane defined by the arc or circle. Once a 
dimension is taken and placed within a plane, it can only be moved within that plane. 

Placing Radius Dimensions 
To place a Radius Dimension on an Arc entity: 

1. Activate the Dimension Tool. The cursor changes to an arrow. 

2. Click on an Arc entity. 

3. Move the cursor to pull a dimension string out from the model. 

4. Click the mouse again to fix the position the dimension string.  

Placing Diameter Dimensions 
To place a diameter dimension on a Circle entity: 

1. Activate the Dimension Tool. The cursor changes to an arrow. 

2. Click on a Circle entity. 

3. Move the cursor to pull a dimension string out from the model. 

4. Click the mouse again time to fix the position of the dimension string.  

Toggling Dimension Type 
Context-click on the dimension and choose Type > Radius or Diameter, to change a radius 
dimension to a diameter dimension (or a diameter dimension to a radius dimension). 
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 Text Tool 
Use the Text Tool to insert Text entities into your model. Activate the Text Tool from either 
the  Tool Palette or the  Draw menu. 

There are two types of text in SketchUp: Leader Text and Screen Text.  

Creating and Placing Leader Text 
Leader Text contains characters and a leader line that points (refers) to an entity. To create 
and place leader text: 

1. Select the Text Tool. The cursor changes to an arrow with a text prompt.  

2. Click on any entity to indicate the ending point of the leader line (the location where the 
leader should point). 

3. Move the cursor to position the text. The leader line will grow and shrink as you move the 
cursor around the screen. 

4. Click to position the text. A text entry box appears with default text, such as the name of a 
component (if the ending point of the leader line is attached to a component), or the square 
footage of a square (if the ending point of the leader line is attached to the face of a 
square).  

 
5. (optional) Click in text box. 

6. (optional) Enter text in the text box. 
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 Note - Press the Esc key at any point during the operation to start over. 

7. Click outside of the text box, or press the Return key twice, to complete text entry. 

Tip - Press the Esc at any time to cancel creation of the Text entity.  

 Note - There are two styles of leaders: View Based and Pushpin. A View 
Based leader will always retain its 2D screen orientation. A Pushpin leader is 
aligned in 3D space, and rotates with your model as you change your view. 
You can specify which type of leader is used from the  Text panel of the Model 
Info dialog box. 

Tip - Double-click on any face, while in the Text Tool, to display the area 
of the face as a Text entity. 

Placing Screen Text 
Screen Text contains characters and is not associated with an entity and is fixed to the 
screen regardless of how you manipulate or orbit the model. To create and place screen 
text: 

1. Select the Text Tool. The cursor changes to an arrow with a text prompt. 

2. Move your mouse to a blank area on the screen where you want the screen text to appear. 

3. Click to position the text. A text entry box appears. 

4. Enter text in the text entry box. 

5. Click outside of the text box, or press the Return key twice, to complete text entry. Screen 
text will stay fixed on the screen regardless of how you manipulate and orbit the model. 

Editing Text 
Double-click on text , with the Text Tool or Select Tool active, to edit the text. You can also 
context-click on a Text entity and select the Edit Text menu item from the Text entity's 
context menu. 

Configuring Text Settings 
Text entities are created using the settings found in the Text panel of the Model Info dialog 
box. Refer to the  Text entity topic for further information. 

 Note - Text entities can have different attributes (font, size, and so on) 
while dimension settings are global. 
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3D Text Tool 
Use the 3D Text Tool to create 3 dimensional geometry from text. Activate the 3D Text Tool 
from either the  Tool Palette or the  Tools menu. 

 

Creating 3D Text 
3D text is text that has been extruded (push/pulled). To create 3D text: 

1. Select the 3D Text Tool. The 3D Text dialog box appears. 

2. Type text in the text field.  

3. (optional) Modify settings in the Place 3D Text dialog box. See The 3D Text Dialog Box for 
further information. 

4. Click on the Place button. You are placed in a move operation with the 3D text and the 
Move Tool. 

5. Move the 3D text to the desired location. Refer to the Move Tool for further information. 

 Note - Press the Esc key at any point during the operation to start over. 

Place 3D Text Dialog Box 
Use the options in the Place 3D Text dialog box to enter and configure 3D text. 

Font 
Select a Font from the drop-down list to change font. Select Regular or Bold from the drop-
down menu to create regular (non-bold) or bold text, respectively. 

Height 
Type the height, in current units, in the Height text entry box.  

Align 
Select Left, Center, or Right, from the drop-down list to align two or more lines text to the 
left, center, or right respectively. 

Filled 
The 3D Text Dialog Box allows you to create 2D text with just outlines (edges) or faces, or 
3D extruded text. Check the Filled checkbox to create faces for 3D text. Uncheck the Filled 
checkbox to create 2D text outlines (just edges). 
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 Note - The Filled checkbox must be checked to create 3D text. 

Extruded 
Check the Extruded checkbox to create extruded (push/pull) 3D text. Uncheck the Extruded 
checkbox to create 2D text. 

 Note - The extruded checkbox must be checked to create 3D text. 
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 Section Plane Tool 
Use the Section Plane Tool to create section cuts enabling you to view geometry within your 
model. Activate the Section Plane Tool from the Tool Palette or the  Tools menu. 

Creating Section Cut Effects 
To add a section plane entity: 

1. Select the Section Plane Tool. The cursor changes to a pointer with a section plane.  

 Note - Press the Esc key at any point during the operation to start over. 

2. Click on a face to create a Section Plane entity and resulting section cut effect.  

 Note - A section plane will not work on a selection set (you cannot 
preselect only those items you want to slice). Instead, the section plane will 
create a section slice in all entities in the current context and, therefore, the 
slice will expand to cover all entities in the context.  

Manipulating Section Planes 
You can use the Move Tool and  Rotate Tool to reposition section planes just as you 
reposition other entities. Additional methods for manipulating section planes follows. 

Reverse Cutting Direction 
The direction of a section plane can be reversed by context-clicking on the section plane 
and selecting reverse from context menu. 

Changing The Active Section Plane 
Newly placed section planes are active until another entity, such as another section plane, is 
selected.  

There are two ways to activate a section plane: double-click on the section plane with the 
Select Tool or context-click on the section plane and select Activate from the context menu. 

 Note - One section plane can be active for each context in your model. 
Therefore a section plane within a group or component can be active at the 
same time, because they are in separate contexts, as a section plane outside 
of any group or component. A model that has a group that also contains two 
other groups has four different contexts (one context outside of any group, one 
context inside the top level group, and one context each for the groups 
contained within the top-level group), and can have four active sections at 
once.  

Customize Toolbar screen Customize Toolbar screen 

Creating Grouped Section Slices 
1. Context-click on a Section Plane, then select Create Group from Slice from the context 

menu. 

2. This will generate new edges, encapsulated within a group, wherever the Section Plane 
intersects with faces. 
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This Group may be moved off to the side as a section outline, or it may be immediately 
exploded, making the edges merge with the geometry from which they were generated. This 
technique allows you to quickly make slices through any complex shape. 

 Exporting Sections 
Sketchup allows you to export section cut effects (your model with a section slice) and 
section slices themselves. 

Exporting Models with Section Cut Effects 
Exporting models with section cut effects is the equivalent of exporting any model as a 
bitmap image file. Section planes and section cuts will appear in the exported file depending 
on the visibility of the section plane and section cut.  

Section Slice 
SketchUp can also export section slices using the Section Slice export feature. 2D vector 
sections can be accurately scaled and measured similarly to other 2D vector exports. 

Using Sections with Scenes 
Active Section Plane may be saved to a scene. Section cut effects will animate during 
animations.  

Aligning your View 
Use the Align View command from the Section Plane Context menu to re-orient the model 
view to a view perpendicular to the section plane. Use this command, in conjunction with 
Paraline mode, to quickly generate sectional elevation or 1-point perspective views of your 
model.  

 = Functionality only available in SketchUp Pro 
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Camera Tools 
This section of the user's guide covers the camera tools within SketchUp. Camera tools are 
those tools used to manipulate your point of view of the model. These tools include the Orbit 
Tool, Pan Tool, and zoom Tool. 

Tools in this section are covered in the order they appear within the Camera menu. 

 

Camera Tools Context Menu 
Context-clicking while using any camera tool launches the camera tools context menu. This 
menu enables you to switch between camera tools. 
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 Previous 
Use the Previous option to return to the last view of your model. Previous can be used after 
using the Orbit Tool,  Pan Tool,  Position Camera Tool,  Look Around Tool, or any of the 
Zoom tools. Activate the Previous option from either the  Tool Palette or the  Camera menu. 
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 Next 
Use the Next option to advance to the next view of your model. Next can be used after using 
the Orbit Tool,  Pan Tool,  Position Camera Tool,  Look Around Tool, or any of the Zoom 
tools. Activate the Next option from the  Camera menu. 
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Standard Views 
SketchUp provides several pre-defined standard point of views for your convenience. These 
point of views are (from left-to-right in the image below): Top (Shift+2), Front (Shift+4), Right 
(Shift+6), Left (Shift+7), Back (Shift+5), Isometric (Shift+1), and Bottom (Shift + 3). Select a 
Standard View from Standard Views Toolbar or the  Camera menu.  

 

Tip - The standard views can be used with a paraline projection to 
produce elevation, plan, and  section drawings. 

Printing Standard Views in Perspective Mode 
Traditional rules of perspective apply when you are in Perspective mode and want to print or 
export your model as a 2D vector drawing, (the output will not be to scale as it is in the 
SketchUp  drawing area ). For example, the Top and Isometric views will reorient your view 
in a similar way, but cannot create a true plan or isometric drawing unless SketchUp is in 
Paraline mode. 

 Note - You are in a perspective projection when the Camera > 
Perspective menu item has a checkmark. 

Using the Isometric (Iso) View 
SketchUp will move your view to the true Isometric view closest to your current view angle 
when you activate the Isometric View. Use the Orbit Tool to orient the camera approximately 
where you want the view to be to change to a different Isometric view. Finally, activate the 
Isometric view to lock into an actual Isometric view. (Remember that true Isometric views 
require Paraline mode.) 
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Matching Photos and Models 
Use the Match New Photo and Edit Matched Photo menu items to create a 3D model to 
match a photo or to match an existing 3D model to a photo's context. Activate the Match 
New Photo and Edit Matched Photo menu items from the  Camera menu. 

SketchUp is commonly used to create designs of buildings or structures. SketchUp allows 
you to create these designs using the actual real-world scale (a scale of 1:1 where a unit of 
measurement in SketchUp represents that actual unit of measurement in the real world). 
However, digital pictures are not at a 1:1 scale. Therefore, to create a 3D model that 
matches a photo (or to match an existing SketchUp model to a scale in a photo), you must 
calibrate SketchUp's camera to match the position and focal length of the digital camera 
used to take the picture. Matching consists of 4 high-level steps: 

1. Take digital pictures of a building or structure. See Taking Digital Photos for Use When 
Matching for further information. 

2. Start matching. Matching involves loading a digital picture and calibrating SketchUp's 
camera to the position and focal length of the camera used to take the actual photo (you 
are setting up the exact criteria used to take your picture so you can draw on the picture). 
You can also set the scale of the actual building or structure while matching, or just resize 
the entire model after it has been drawn. 

3. Start sketching. Once you have duplicated the position and focal length of the camera 
used to take the picture, you can draw over the image in SketchUp. SketchUp moves into 
a 2D sketching mode from matching (it is 2D because you are drawing on a 2D photo that 
needs to be oriented at a specific camera angle to you). 

4. Repeat Step 2 and 3 with any other photos that make up the building or structure. 

Creating a 3D Model to Match a Photo 
Use the matching process to create a 3D model to match one or more photos of a building 
or structure. This process is best suited for making models of images that have parallel 
lines, such as the top and bottom of a square window. To create a 3D model to match a 
real-world building or structure: 

1. Take digital pictures of the building or structure. See "Taking Digital Photos for Use When 
Matching" for further information. 

2. Select the Match New Photo menu item from the Camera menu. The Select background 
image file dialog box is displayed. 

3. Navigate to the first photo in the series of photos for your building or structure. 

4. Click on the first photo in the series of photos for your building or structure. The photo is 
selected. 

5. Click the Open button. The photo will appear in the drawing 
area on its own scene in SketchUp. You are also placed in a matching mode where you 
will calibrate SketchUp's camera to duplicate 
the position and focal length of the camera used to take the actual photo . The words 
"Match Photo" appear in the upper-left of the drawing area. 
Finally, the Match Photo dialog box appears. Refer to Matching Controls and Context-
Menu Items for further information. 

6. Click and hold the cursor on the origin. The cursor changes to a hand. 

7. Move the cursor to a distinct origin-like point on photo (where three axes might intersect, 
such as bottom corner of building). The origin you use depends on the photo:  
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• For 
photos that are usually taken indoors where walls, ceiling, and floor of a room meet 
at a corner, the origin is usually at the bottom corner where the walls, ceiling, and 
floor meet.  

• For photos that are taken from a vantage point where you are looking down on the b
uilding or structure, the origin would be at the top corner of the building where roof 
and walls meet.  

• For photos that are taken from a vantage point where you are standing on the 
ground, the origin would be the bottom corner where the walls and ground meet. 

8. Release the mouse button. The origin is established. 

9. Click on an red axis bar grip. The cursor changes to a hand. 

10. Move the cursor to the starting point of a position on the photo representing a line parallel 
to the red axis. 

11. Release the mouse button. 

12. Click on the other red axis bar grip. The cursor changes to a hand. 

13. Move the cursor to the ending point of a position on the photo representing a line parallel 
to the red axis. 

14. Release the mouse button. The first axis bar is aligned to the red axis. 

15. Repeat steps 9 through 14 for the remaining three (one red and two green) axis bars.  

16. Context-click to invoke the matching context-menu.  

17. Select Done. You are placed in a sketching mode. This mode, unlike normal SketchUp 
drawing mode, is a 2D drawing mode. The words "Sketch Over" appear in the upper-
left of the drawing area. Refer to Sketch-Over-Image Controls and Context-Menu Items for 
further information. 

18. Sketch on photo using the SketchUp drawing tools.  

Caution - Tools that manipulate your point of view force you out of 
Sketch-Over-Image mode into normal SketchUp drawing mode. These POV 
tools are the Orbit Tool, Position Camera Tool, Walk Tool, and Look Around 
Tool.   

19. Repeat steps 2-12 with other sides (photos) of the building until building or structure is 
done.  

Matching an Existing 3D Model to a Photo's Context 
Use the matching process to match an existing 3D model to a photo's context. To match an 
existing 3D model to a photo's context: 

1. Take a digital picture of the location where you will place your building. This photo might or 
might not have an existing building where the model will be located. 

2. Select the Open menu item from the File menu. The Open dialog box appears. 

3. Navigate to your model. 

4. Select the model. 

5. Click Open. The model appears in the drawing area. 
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6. Select the Match New Photo menu item from the Camera menu. The Select background 
image file dialog box is displayed. 

7. Navigate to the photo where you want to place your building or structure. 

8. Click on the photo. The photo is selected. 

9. Click Open. The photo will appear in the drawing area on its own scene in SketchUp. The 
photo will appear in the drawing area on its own scene in SketchUp. You are also placed in 
a matching mode where you will calibrate SketchUp's camera to duplicate 
the position and focal length of the camera used to take the actual photo . The words 
"Match Photo" appear in the upper-left of the drawing area. 
Finally, the Match Photo dialog box appears. Refer to Matching Controls and Context-
Menu Items for further information. 

10. Click and hold the cursor on the origin. The cursor changes to a hand. 

11. Move the cursor to a distinct origin-like point on photo (where three axes might intersect, 
such as bottom corner of building).  

12. Release the mouse button. The origin is established. 

13. Uncheck the Model checkbox in the Match Photo dialog box. The model will be hidden.  

14. Click on an red axis bar grip. The cursor changes to a hand. 

15. Move the cursor to the starting point of a position on the photo representing a line parallel 
to the red axis. 

16. Release the mouse button. 

17. Click on the other red axis bar grip. The cursor changes to a hand. 

18. Move the cursor to the ending point of a position on the photo representing a line parallel 
to the red axis. 

19. Release the mouse button. The first axis bar is aligned to the red axis. 

20. Repeat steps 9 through 14 for the remaining three (one red and two green) axis bars.  

21. Check the Model checkbox in the Match Photo dialog box. The model will reappear, 
oriented correctly to the photo (but likely not-to-scale with the photo).  

22. Click and hold on any of the axes. The cursor will change to two opposing arrows. 

23. Move the cursor up or down the axis to scale your model. Your model will scale to fit the 
photo. 

24. (optional) If your photo contains an existing building that is now represented by your 
model, click the Project textures from photo button in the Match Photo dialog box to 
project. 

25. Context-click to invoke the matching context-menu.  

26. Select Done. You are placed in a sketch-over-image mode. This mode, unlike normal 
SketchUp drawing mode, is a 2D drawing 
mode. The words "Sketch Over" appear in the upper-left of the drawing area. See Sketch-
Over-Image Controls and Context-Menu Items for further information. 

Caution - Tools that manipulate your point of view force you out of 
Sketch-Over-Image mode into normal SketchUp drawing mode. These POV 
tools are the Orbit Tool, Position Camera Tool, Walk Tool, and Look Around 
Tool. 
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Editing a Previously Matched Photo 
There are two options to resume matching . These options are: 

• Select the photo you were matching from the Camera > Edit Matched Photo sub-menu. 

• Context-click on the Scene tab for the photo you were matching and select Edit Matched 
Photo. 

Resuming Sketch-Over-Image Mode 
Click on the scene tab that represents the photo to return to sketching over the image. 

Matching Controls and Context-Menu Items 
There are three sets of controls that are accessible from the matching mode. These controls 
are: The matching controls, Match Photo dialog box controls, and the matching context-
menu items. 

Matching Controls 
Use the matching controls to adjust the axis such that you can draw a model to match a 
photo or match a model to a photo. 

Origin: The origin represents the point where all axes in SketchUp originate. Click and hold 
on the origin to select the origin. Move the cursor to reposition the origin. 

Red and Green Axes bars: The red and green axes bars are used to align the camera to a 
photo. Click and hold the axes bar grips to reposition the axes bars. 

Axes lines: The axes lines represent the 3 dimensional axes and help to establish the 
vanishing points. Click and hold on the axis line to select the axis line. Move the cursor 
along the axis line to resize a model. 

Vanishing points: There are three vanishing points in the matching mode (red, green and 
blue). The vanishing point is a place along the horizon of a perspective photo where all the 
parallel lines seem to converge. Click and hold on a vanishing point to select the vanishing 
point. Move the cursor to reposition the vanishing point. 

Match Photo Dialog Box 
The Match Photo dialog box controls are used to help you create accurate 3D models from 
photos and to accurately place models in a photo's context. 

New Matched Photo: Click on the New Matched Photo button to start a new matching.  

Edit Matched Photo: Click on the Edit Matched Photo button to reenter the matching mode. 
This button is only active in a Sketch-Over-Image mode. 

Photo: Check the Photo checkbox to display the photo. Uncheck the Photo checkbox to 
hide the photo. This option is also available in sketch-over-image mode. 

Opacity: Move the Opacity slider to the left to make the photo more transparent. Move the 
Opacity slider to the right to make the photo more opaque. This option is also available in 
sketch-over-image mode. 

Model: Check the Model checkbox to display the model. Uncheck the Model checkbox to 
hide the model. This option is also available in sketch-over-image mode. 

Project Textures From Photo: Click on the Project textures from photo button to 
automatically project the photo as a texture onto your model. 

Grid: Check the On radio button to continuously display the axes grid. Check the Auto radio 
button to only show the grid when manipulating one of the matching controls. 
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Style: Click on the Style icons to change the style of the grid. Grid styles are used to set the 
grid to best complement a specific type of photo. The left-most style is used for 
photos that are usually taken indoors where walls, ceiling, and floor of a room meet at a corn
er (the origin is usually at the bottom corner where the walls, ceiling, and floor 
meet). The middle style is used for photos that are taken from a vantage point where you ar
e looking down on the building or structure (the origin would be at the top corner of the 
building where roof and walls meet). Finally, the right-most style is used for photos that are 
taken from a vantage point where you are standing on the ground (the origin would be the 
bottom corner where the walls and ground meet). 

Planes: Click on the planes buttons to toggle the display of grid lines on a particular plane. 
The Red/Green button toggles grid lines in the red and green planes. The Red and Blue 
button toggles grid lines in the red and blue planes. Finally, the Green/Blue button toggles 
grid lines in the green and blue planes. 

Spacing: The spacing field is used to set the scale of your model before you start sketching 
over the image. Enter a value in the spacing text-entry box to change the size of grid 
spacing to represent some multiple of the overall structure size. Then, drag the axes lines to 
line grid squares up with your image.  

Matching Context-Menu Items 
Context-click during matching to display the matching context-menu. 

Done: Select the done menu item to end your matching. 

Start over: Select the Start Over menu item to restart matching. 

Cancel match: Select the Cancel Match menu item to cancel and exit your matching. 

Zoom matched photo: Select the Zoom matched photo menu item to fit the entire drawing 
area. 

Zoom vanishing points: Select the Zoom vanishing points menu item to zoom to fit all 
vanishing points in the drawing area. 

Rotate 90 left: Select the Rotate 90 left menu item to rotate the red and green axes 90 
degrees left. Use this menu item primarily when creating a model to match several photos 
(to rotate the model as you draw the model's sides to match the different sides of the 
structure in different photos). 

Rotate 90 right: Select the Rotate 90 right menu item to rotate the red and green axes 90 
degrees right. Use this menu item primarily when creating a model to match several photos 
(to rotate the model as you draw the model's sides to match the different sides of the 
structure in different photos). 

Undo: Use the Undo menu item to undo the last matching command. 

Redo: Use the Redo menu item return the last undo to its previous state. 

Sketch-Over-Image Controls and Context-Menu Items 
There are three sets of controls that are accessible from a Sketch-Over-Image mode. These 
controls are: The SketchUp tools, Sketch Over dialog box controls, and the Sketch-Over-
Image context-menu items. 

Sketch-Over-Image Context-Menu Items 
Context-click during a Sketch-Over-Image to display the Sketch-Over-Image context-menu.  

Edit Matched Photo: Select the Edit Matched Photo menu item to resume matching . 
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Project Photo: Select the Project Photo menu item to project the photo's texture on your 
model. 

Zoom Matched Photo: Select the Zoom Matched Photo menu item to fit the entire drawing 
area. 

Sketch Over Dialog Box Controls 
The Sketch Over dialog box controls are used to help you create accurate 3D models from 
photos and to accurately place models in a photo's context. 

Photo: Check the Photo checkbox to display the photo. Uncheck the Photo checkbox to 
hide the photo. This option is also available during matching.  

Opacity: Move the Opacity slider to the left to make the photo more transparent. Move the 
Opacity slider to the right to make the photo more opaque. This option is also available 
during matching. 

Model: Check the Model checkbox to display the model. Uncheck the Model checkbox to 
hide the model. This option is also available during matching.  

Taking Digital Photos for Use When Matching 
Your success with matching depends highly on the quality of photographs taken of your 
building or structure. Following are a few tips regarding matching photographs. 

• Sketch Over Image works best on pictures of structures composed of predominantly right 
angles and taken at a roughly a 45 degree angle from a corner.  

• The images should not be distorted and should be of a “reasonable” resolution. 

• Barrel distortion typically comes from wide angle lens cameras, and users should use a 
third party product to eliminate it from images prior to using them within SketchUp. All 
cameras have a little bit of this distortion, typically worse around the edges of the image, 
and we have a simple tool for compensating for this visually.  

•  There are many other kinds of subtle lens distortions which I won't go into. Ultimately, we 
assume that perfectly straight lines in the original object are shown as perfectly straight 
lines in the photograph.  

• Cropped (or expanded) images. A cropped image, or one which has been expanded to 
have extra white space around it, will not have the ‘center of projection’ in the center of the 
image. Sketch Over Image currently requires that the point you aimed the camera at is 
located in the center of the image. Although it may seem possible to use an image like this, 
typically, vertical lines will not align well across the image and the results will be 
unsatisfactory.  

• Warped images. Images which have been manually warped via an image processing 
program, or specialized camera are not supported. For example, some cameras used for 
architectural photographs adjust for vertical perspective distortion, by tilting the camera 
plane. The resulting photo is an image similar to our “Two Point Perspective” mode.  

• Stitched images (for example panoramic images). These images are typically excessively 
warped and will have multiple vanishing points for each axis.  

• Non right angle models. Sketch Over Image relies on SketchUp's red/green/blue axes and 
limits most drawing to the axis planes. The more right angled reference lines in the original 
image, the better results you will get. Sketch Over Image will also struggle with: - 
Vanishing points which are at infinity. This happens in two common situations. A one point 
perspective, for example, an image which is looking down a hall way, will be difficult to 
align because you only adjust one vanishing point and the other two are far away. 
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Likewise, an image taken with a very long tele-photo lens (or say a satellite or aerial 
image) will not have very useful vanishing points and will be difficult to align. 

•  Extremely high resolution images. Images are currently embedded within the skp file and 
duplicated when made into a material. This makes for large model sizes. There is also no 
resolution control over the export process and this may be a problem when exporting to 
GE (for example).  

• Excessive foreground. If there are trees and other foreground objects blocking the view of 
the building, it may be difficult to Sketch Over top of the image.  
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 Orbit Tool 
Use the Orbit Tool to rotate the camera about the model. The Orbit Tool is useful when 
viewing geometry from the outside. Activate the Orbit Tool from either the Tool Palette or the  
Camera menu. 

Keyboard Shortcut: O 

Orbiting the View 
The Orbit Tool performs a 3D orbit. To orbit using the Orbit Tool: 

1. Select the Orbit Tool. The cursor changes to two interconnected perpendicular ovals. 

2. Click anywhere in the drawing area. 

3. Move your cursor in any direction to rotate around the center of the drawing area. 

Tip - Double-click the left mouse button on your model to center to the 
model in the drawing area.  

Orbiting With a Three Button Mouse 
The Orbit Tool is used heavily when creating and editing models. SketchUp contains a few 
mouse enhancements and modifier keys to allow easy access to the Orbit Tool. 

Activating the Orbit Tool While in Another Tool 
Click and hold middle mouse button (scroll wheel) on a three-button mouse to temporarily 
activate the Orbit Tool while in any other tool (except the Walk Tool).  

Tip - Click and hold the Control and Command keys simultaneously while 
clicking and holding the left mouse button to temporarily activate the Orbit Tool 
(if you have only one mouse button).  

Tip - You will also be put in pan temporarily if you click on the middle-
mouse wheel and then click and hold the left mouse button or press and hold 
the Shift key. 
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 Pan Tool 
Use the Pan Tool to move the camera (your view) vertically and horizontally. Activate the 
Pan Tool from either the Tool Palette or the  Camera menu. 

Keyboard Shortcut: H 

Panning the View 
The Pan Tool performs a pan operation. To pan using the Pan Tool: 

1. Select the Pan Tool. The cursor changes to a hand.  

2. Click anywhere in the drawing area. 

3. Move the cursor in any direction to pan. 

Panning While in the Orbit Tool (3-Button Mouse) 
Press and hold the Shift key while in the Orbit Tool to temporarily activate the Pan Tool. Or, 
press and hold the left mouse button while pressing and holding the middle mouse button 
(scroll wheel) to activate the  Pan Tool. 

Panning While in Other Tools (1-Button Mouse)  
Click and hold the Control, Command, and Shift keys simultaneously while clicking and 
holding the left mouse button to temporarily activate the Pan Tool (if you have only one 
mouse button).  
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 Zoom Tool 
Use the Zoom Tool to move the camera (your view) in or out. Activate the Zoom Tool from 
either the Tool Palette or the  Camera menu. 

Keyboard Shortcut: Z 

Zooming In and Zooming Out of Your Model 
To zoom in and out using the Zoom Tool: 

1. Select the Zoom Tool. The cursor changes to a magnifying glass with a plus and minus 
sign. 

2. Click and hold anywhere in the drawing area.  

3. Drag the cursor up to zoom in (closer to the model) and down to zoom out (farther from the 
model).  

Zooming With a Scroll Wheel Mouse 
Rolling wheel forward on a scroll wheel mouse zooms in on your model. Rolling the wheel 
backward on a scroll wheel mouse zooms out from your model.  

 Note - The cursor position determines the center of zoom when using 
the scroll wheel whereas the center of the screen determines the center of 
zoom when zooming using the left mouse button. 

Centering the Point of View 
Double-click the left mouse button on your model to center the model in the drawing area.  

Perspective Adjustment (Field of View) 
Adjust the screen to an exact perspective or camera lens by typing an exact value in the 
VCB while the Zoom Tool is active. For example, "45 deg" sets a 45 degree field of view and 
"35 mm" sets the equivalent focal length of a 35mm camera. Press and hold the Shift key 
while in the Zoom Tool to visually adjust the camera lens or field of view. Remember, 
changing the FOV keeps the camera in the same location in 3D space.  
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 Zoom Window Tool 
Use the Zoom Window Tool to zoom in on a specific portion of your model. Activate the 
Zoom Window Tool from either the Tool Palette or the  Camera menu. 

Zooming in on a Portion of Your Model 
The Zoom Window Tool allows you to draw a rectangular zoom window around a portion of 
your model. The Zoom Window Tool will then zoom in on the content within the zoom 
window. To zoom in on a portion of your model: 

1. Select the Zoom Window Tool. The cursor changes to a magnifying glass with small 
square. 

2. Click and hold a short distance away from the entities you want to appear in the zoom 
window. This is the zoom window starting point. 

3. Move cursor diagonally. 

4. Release the mouse button when all of the entities are enclosed within the zoom window. 
These entities will fill the screen.  
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 Zoom Extents Tool 
Use the Zoom Extents Tool to zoom your view to a distance which makes the whole model 
visible and centered in the drawing area. Activate the Zoom Extents Tool from either the 
Tool Palette or the  Camera menu. 

Keyboard Shortcut: Shift+Z 
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Zoom to Photo 
Use the Zoom to Photo Tool to move the camera (your view) in such that the entire photo 
fills the drawing area. This menu item is active while the photo matching feature. Activate 
the Zoom to Photo Tool from either the Tool Palette or the  Camera menu. 
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Walkthrough Tools 
This section of the user's guide covers the walkthrough tools within SketchUp. Walkthrough 
tools are those tools used to view your model as through walking around and in your model. 
These tools are the Position Camera Tool, Look Around Tool, and Walk Tool. 

Tools in this section are covered in the order they appear within the Camera menu. 
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Position Camera Tool 
Use the Position Camera Tool to position the camera (your view) at a specific eye height so 
that you can check the line of sight of a model or walk through a model. Activate the Position 
Camera Tool from either the Tool Palette or the  Camera Menu. 

Positioning the Camera 
The camera is positioned using one of two methods. The first method places the camera at 
eye-level above a specific point (5' 6" above that point by default). The second method 
placing the camera at a specific point, facing a specific direction.  

Positioning the Camera at an Eye-Level View 
The first position camera method allows you to position the camera at a specific eye-height 
above a specific point that you choose. The camera does not point at anything in particular. 
However, you are placed in the Look Around Tool allowing you to move the camera around 
the point to look at items in your model.  

1. Select the Position Camera Tool. The cursor changes to a small person with a red X. 
Notice that the Value Control Box (VCB) indicates that the eye height above the ground 
plane is set to 5 feet, 6 inches. You can override this height at this time by typing in a 
desired value. 

2. Click on a point in your model. SketchUp places the camera's point of view at an average 
eye-height over the point you click on. You are also placed in the Look Around Tool. The 
following image shows a point in the middle of a room. The camera will be positioned 
directly above this point (5' 6") facing the television set if you click at this point. 

 

 Note - The viewing direction defaults to the top of screen, which is due 
north, if you place the camera from a plan view.  

Positioning the Camera Using Specific Target Points 
The second position camera method allows you to position the camera at a specific point, 
facing a specific direction.  
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1. Select the Position Camera Tool. The cursor changes to a small person with a red X. 
Notice that the Value Control Box (VCB) indicates that the eye height above the ground 
plane is set to 5 feet, 6 inches. You can override this height at this time by typing in a 
desired value. 

Tip - Use the Tape Measure Tool and the VCB to drag parallel guide 
lines off of edges as a method to provide accurate camera placements. 

2. Click and hold mouse button on a point in your model.  

3. Drag the cursor to the portion of the model that you want to look at. A dotted line is 
extended from the point selected in step 2 to the portion of the model you want to look at. 

4. Release the mouse button. The camera is repositioned at a height of 0 at the point 
selected in step 2. The camera faces the item you dragged the cursor to in step 3. The 
following image shows a point in the middle of a room with a dotted line to the window on 
the left wall of the room. The camera will be positioned directly at the first point (at 0 
height) facing up at the window if you release the mouse button on the window.  

 
5. (optional) Type a new eye height into the VCB to reposition the camera at eye height 

above the point selected in step 2. 

Tip - Position the camera directly horizontal to the model to achieve a 2 
Point Perspective.  

Tip - Hold the Shift key while clicking on a surface to position the camera 
directly on the surface. 
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 Walk Tool 
Use the Walk Tool to maneuver through your SketchUp model as though you were walking 
through your model. Specifically, the Walk Tool fixes the camera to a particular height, and 
then allows you to maneuver the camera around your model. The Walk Tool is available 
only in Perspective mode. Activate The Walk Tool from either the Tool Palette or the  
Camera menu. 

Touring Your Model 
The Walk Tool is primarily used to take an interactive walk through or around your model. To 
use the Walk Tool to tour your model: 

1. Select the Walk Tool. The icon changes to a pair of shoes. Notice that the VCB indicates 
that the eye height above the ground plane is set to 2 feet, 10 1/2 inches. You can override 
this height at this time by typing in a desired value. 

2. Click and hold anywhere in the drawing area. A small plus sign (cross hair) is placed at the 
location where you clicked.  

3. Move the cursor up (forward), down (backward), left (to go left) or right (to go right) to walk 
through or around your model. The further you are from the cross hair, the faster you walk. 

 Note - Press and hold the Shift key while moving the cursor up and 
down allows you to move up or down instead of forward or backward. Press 
and hold the  Option key to run instead of walk. Press and hold the Alt key to 
avoid collision detection (walk through walls). 

Tip - It is often desirable to tour a model with a wide field of view. 
Activate the  Zoom Tool, press and hold the Shift key, and press and drag up 
and down to widen your field of view prior to walking through a model. 

Looking Around While in the Walk Tool 
Click and hold the middle mouse button, while using the Walk Tool, to use the Look Around 
Tool. 

Ascending and Descending  
The Walk Tool automatically walks up and down inclines or steps while maintaining eye 
height. 

Toggling Collision Detection 
Press the Command key while walking around to temporarily turn off collision detection. This 
option is useful when examining models such as mechanical devices or furniture (anything 
other than the interior of a building).  
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 Look Around Tool 
Use the Look Around Tool to pivot the camera (your view) around a stationary point. The 
Look Around Tool behaves similarly to a person standing still while turning their head to up, 
down (tilt), and side to side (pan). The Look Around Tool is particularly useful for viewing the 
inside of spaces, or to evaluate visibility after using the  Position Camera Tool. Activate the 
Look Around Tool from either the  Tool Palette or the  Camera menu. 

Looking Around 
The Look Around Tool performs tilt and pan operations. To tilt and pan using the Look 
Around Tool: 

1. Select the Look Around Tool. The cursor changes to a pair of eyes.  

2. Click to start pivot. 

3. Move the cursor up or down to tilt; right or left to pan. 

Specifying an Eye Height 
Type the eye height for the camera in the VCB and press the Enter or Return key to change 
the height above the ground plane for the camera. 

Activating the Look Around Tool While in the Walk Tool 
Click the middle mouse button to activate the Look Around Tool while in the Walk Tool.  
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 Sandbox Tools 
This section of the user's guide covers the sandbox tools within SketchUp. Sandbox tools 
are those tools used to create and manipulate large surfaces (TINs) in your models. These 
tools include the Sandbox From Scratch Tool, Sandbox From Contours Tool, Smoove Tool, 
Stamp Tool, and Drape Tool.  

 
  

Sandbox tools are not just for modeling terrain, they can also be used to model other 
organic shapes such as the curved portions of a hand-built wooden chair or a wooden bowl. 
Organic shapes are those that have a hand-made or custom appearance.  

Tools in this section are covered in the order they appear within the Draw > Sandbox and 
Tools > Sandbox sub-menus. 

Enabling the Sandbox Tools 
The sandbox tools do not appear in SketchUp by default, but can easily be enabled using 
the Extensions Manager (the Extensions panel of the Preferences dialog box). To enable 
the sandbox tools: 

1. Open the Extensions Manager (SketchUp > Preferences > Extensions) 

2. Click the check box next to the extension that you want to enable. 

3. Click Ok 
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  Sandbox From Contours Tool 
Use the Sandbox from Contours Tool to create a TIN from contour lines. You must create or 
import contour lines that are offset in their height prior to using this tool. Activate the 
Sandbox from Contours Tool from the Draw menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

The following image shows several contour lines offset in height from the ground plane. 

 
The following image shows the resulting terrain created when the Sandbox From Contours 
Tool is used on the selected contours. 

 

  Note - In some cases the Sandbox From Contour Line Tool might 
create triangulations in the TIN that result in flat spots or plateaus. These 
plateaus can be retriangulated (to create a slope) using the  Flip Edge Tool. 

Creating a Sandbox From Contour Lines 
To create a sandbox from contour lines: 

1. Import or draw several contour lines. Ensure that the contour lines are offset in their height 
from the ground plane. 

2. Select all of your contour lines. 

3. Select the Draw > Sandbox > From Contours. Terrain will be filled in using the contour 
lines as a guide. 
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  Sandbox From Scratch Tool 
Use the Sandbox From Scratch Tool to generate a flat triangulated TIN that can be sculpted 
into other forms using other sandbox tools. The Sandbox From Scratch Tool generates the 
TIN in the red/green or ground plane. This tool is useful in creating terrain when no other 
terrain model or data is available. Activate the Sandbox From Scratch Tool from the Draw 
menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

Creating a New TIN 
To create a new TIN: 

1. Select the Sandbox From Scratch Tool. The cursor changes to a pencil with a grid.  

 Note - The Sandbox from Scratch Tool defaults to 10' square grid sizes. 
You might want to zoom out or change the grid size (Grid Spacing) in the VCB 
to before creating your sandbox. 

Tip - You can optionally enter a value in the VCB for the size of each 
square in your grid at this time (Grid Spacing). 

2. Click to set the starting point of your TIN. 

3. Move the mouse in the direction you want to be the length of the TIN. As you move your 
mouse a line appears with tick marks at a specific spacing. The length value is displayed 
dynamically in the Value Control Box (VCB).  

4. Click a second time to establish the length of your TIN. 

5. Drag the mouse perpendicular to the length line to establish the width of your TIN.  

6. Click a third time to establish the width of your TIN. The following image shows the flat TIN 
created with the Sandbox From Scratch Tool. 

 

 Note - The terrain will be placed inside of a Group entity. You must edit 
or explode the group to perform other operations, such as smoothing with the 
Smoove Tool, on the TIN. 
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Specifying Precision Line Values 
The VCB displays the length and width of your TIN while you are drawing a flat TIN. You can 
also specify a line length and width value using the VCB. 

Entering a Length Value 
Specify a length and width in the VCB by typing in the desired length after placing the 
starting point of the flat TIN. SketchUp will use the current document units setting if you only 
type in a numerical value. You can also specify either Imperial (1'6”) or Metric (3.652m) units 
at any time, regardless the model units setting. 

Entering a Width Value 
Specify a width and width in the VCB by typing in the desired length after setting the length 
of the flat TIN . SketchUp will use the current document units setting if you only type in a 
numerical value. You can also specify either Imperial (1'6”) or Metric (3.652m) units at any 
time, regardless the model units setting. 

Drawing a Flat TIN by Inference 
The Sandbox From Scratch Tool uses SketchUp's sophisticated geometric inference engine 
to help you place your terrain in 3D space. The inference decisions, made by the inference 
engine, are displayed in the  drawing area as inference lines and inference points. These 
lines and points show precise alignment between the line you are drawing and the geometry 
of your model. Refer to the  inference engine topic for additional information. 
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  Smoove Tool 
Use the Smoove Tool to sculpt an existing TIN by allowing vertical movement of a selection 
of points, edges, or faces and their immediately adjacent geometry. The result is a smooth 
deformation of a triangulated surface. Activate the Smoove Tool from the Tools menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

Sculpting a Terrain 
To sculpt a terrain: 

1. Create, such as with the Sandbox From Scratch Tool, or import a TIN. The following image 
shows a flat terrain created with the Sandbox From Scratch Tool. 

 
2. Select the Smoove Tool. The cursor changes to an arrow. 

Tip - Alternatively, you can preselect a series of points, edges, and faces 
and then click on the Smoove Tool to begin a smoove operation. 

3. Click on a point, edge, or face within the TIN. SketchUp highlights all neighboring vertices 
to be included in the sculpting operation within the radius specified in the VCB. The 
following image shows the point that was selected (the largest square in the middle) and 
neighboring vertices. 

 

 Note - Remember to ungroup a terrain created with the Sandbox From 
Scratch Tool prior to using the Smoove Tool. 
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4. Move the mouse up or down in the vertical (blue) direction to sculpt the TIN. The TIN will 
expand or contract accordingly. You can also type offset value in the VCB, such as 10'. 
The following image shows the terrain resulting from moving the point and neighboring 
vertices up.  

 

 Note - You can sculpt in a direction other than vertical by holding down 
the Shift key while moving the mouse. However, this operation can result in a 
non-functional terrain or terrain that can no longer be manipulated in a known 
way. This operation can only be performed while in active selection (not after 
preselection). 

5. Smooth and soften the TIN to get your final model.  

Tip - Double-click to repeat the last smoove operation.  

Specifying Sculpting Radius Values 
SketchUp determines the number of vertices included in the sculpting operation based on a 
radius value. The larger the radius the more vertices included in the sculpt. The VCB 
displays this radius while you are sculpting a TIN. You can also specify a radius value while 
sculpting, such as 10'r, using the VCB. 

Tip - Preselect a series of points, faces, and edges within your TIN to 
sculpt more specific shapes such as ridges and berms. 

Specifying an Offset Value 
The VCB also specifies an offset while you are sculpting. You can also specify an offset 
value, such as 10', using the VCB.  
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 Stamp Tool 
Use the Stamp Tool to create impressions in a TIN by pushing a duplicate of the base of 
geometry, such as a house, into a TIN. Activate the Stamp Tool from the Tools menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

Creating Impressions of Geometry in a TIN 
To create an impression of geometry in a TIN: 

1. Create your TIN, such as the terrain where a building might exist 

2. Create the faces to be used as the stamp, such as the bottom faces of the building. 

3. Move the stamp over the location in the TIN where you want to create an impression. 

 

 Note - The stamp can be an individual face, selection set of faces, a 
group, or a component. 

4. Select the Stamp Tool. The cursor changes to an arrow.  

5. Click on the stamp. SketchUp will create an offset around the stamp. 

6. (optionally) Adjust the offset size by typing in a new value in the VCB. 

7. Click on the TIN. 

8. A copy of the stamp will be indented into the TIN. The cursor will be on the copy of the 
stamp allowing you to move the stamp, and connected TIN, up or down. 

9. Move the mouse to adjust the stamp within the TIN. 

10. Click when you are done adjusting the stamp. 

11. Smooth and soften the TIN to get your final model.  

 Note - The Stamp tool will not work on a group or component that is 
open for editing. 
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  Drape Tool 
Use the Drape Tool to project edges, such as the edges in a road, onto a terrain. Activate 
the Drape Tool from the Tools menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

Draping Edges Onto a TIN 
To drape edges onto a TIN: 

1. Create, such as with the Sandbox From Scratch Tool, or import a terrain.  

2. Create the edges you want to drape over the TIN. The edges can be in a single plane (flat) 
and must be positioned above a TIN. The following image shows a 2D road positioned 
above a terrain. 

 

 Note - The Drape Tool will only drape the edges surrounding a face if 
you attempt to drape a face or series of faces over the TIN. 

3. Select the edges that you want to drape over the TIN. 

4. Select the Drape Tool. The cursor changes to an arrow. 

5. Click on the TIN to drape the selected edges on the TIN. The following image shows the 
edges draped over the terrain. 

 

 Note - The draped edges will be outside of a group or component 
context if the TIN is encapsulated within a group or component. 
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Tip - This tool also works in active selection mode to select the drape 
edges if nothing is preselected. 
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 Add Detail Tool 
TINs do not have to consist of triangles of the same size. Use the Add Detail Tool to split 
triangles into additional, smaller triangles, and make small detailed modifications to your 
TIN. Any click on your TIN creates new triangles centered around a new vertex that you can 
manipulate. Activate the Add Detail Tool from the Tools menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

Smaller triangles equate to a smoother final TIN. However, having an abundance of small 
triangles in your TIN can also decrease performance. The Add Detail Tool can help strike a 
balance between detail and performance by allowing you to add detail only to areas of the 
TIN where it is needed. 

Detailing a TIN 
To detail a terrain:  

1. Create a TIN. The following image shows a flat TIN or sandbox created with the Sandbox 
From Scratch Tool. 

 
2. Select the Add Detail Tool. The cursor changes to an arrow. 

3. Click on a point, edge, or face within the TIN. SketchUp creates a new vertex where you 
clicked with new triangles spanning out from the new vertex. The following image shows 
two additional triangles created when the midpoint of a line was selected. 
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4. Move your mouse up or down to adjust the height of the vertex and surrounding triangles. 
The following image shows the resulting TIN when the new vertex was lifted. 

 

 Note - You can also type in an offset distance to adjust the height of the 
vertex after clicking on a point, edge, or face within the terrain. For example, 
10' will raise the new vertex 10' above the starting terrain. 

 Note - You can sculpt in a direction other than vertical by holding down 
the Shift key while moving the mouse. However, this operation can result in 
non-functional terrain or terrain that can no longer be manipulated in a known 
way. 

5. Continue clicking on points, edges, or faces (either on the TIN you created in step 3, or on 
other portions of the TIN) to create additional triangles for manipulation. 

6. Smooth and soften the TIN to get your final surface.  

Creating Smooth Areas 
You can preselect a series of triangles in your model using the Select Tool and then use the 
detailer to divide those triangles to create a smoother area. The following image shows a flat 
TIN with a selection set that was detailed two times (creating several tiny triangles). This 
area of the model will appear very smooth when sculpted, using a tool such as the Smoove 
Tool. 
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Specifying an Offset Value 
The VCB also specifies an offset while you are detailing a TIN. You can also specify an 
offset value, such as 10', using the VCB.  
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  Flip Edge Tool 
Use the Flip Edge Tool to manually adjust the triangulation for any pair of adjacent triangles 
in a TIN. This tool is useful in removing flat spots or plateaus in a terrain generated from 
contour lines. Activate the Flip Edge Tool from the Tools menu. 

 Note - You must enable the sandbox tools before you can use them. 
See  Enabling the Sandbox Tools for further information. 

The following image contains a terrain with several opposing triangulations (triangles that 
point opposite to each other). 

 
Triangulations whose sides run north and south create plateaus in the TIN. The Flip Edge 
Tool can be used to flip these triangulations and remove these plateaus (creating slopes). 
The following image shows terrain with the triangulations flipped. 
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Tip - You can easily see triangles with opposing triangulation by 
displaying hidden geometry. Turn on hidden geometry (View > Hidden 
Geometry) to view the triangles in the TIN.  

Modifying TIN Triangulations 
To modify TIN triangulations: 

1. Create a TIN using a tool such as the Sandbox From Contours Tool. 

2. Select the Flip Edge Tool.  

3. Move the mouse over the TIN to highlight edges that can be flipped.  

4. Click on any edge to flip the edge to an opposite triangulation. SketchUp analyzes the two 
adjacent triangles that share the edge, removes the selected edge, and replaces it with a 
perpendicular edge.  
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Google Toolbar 
This section of the user's guide covers the Google Toolbar within SketchUp. Buttons on the 
Google Toolbar are used to interact with other Google technologies, such as Google Earth.  

 
Items in this section are covered in the order they appear within the Google menu. 

Configuring Google Earth 
There are a few configuration options you should set before using the Google Toolbar 
buttons. These are as follows: 

• Install Google Earth 3.0.640 or higher. 

• Turn Elevation Exaggeration to 1 in Google Earth (Tools > Options > View) 

• Turn terrain on in Google Earth. Click on the Terrain check box toward the bottom middle 
of Google Earth to turn on terrain.  

• Change your image resolution in Google Earth to the largest available setting (Tools > 
Options > View > Detail Area) to ensure the best images captures in SketchUp. 

Google Earth and SketchUp Workflow 
SketchUp can be used to create three-dimensional models for Google Earth. The workflow 
for creating and placing SketchUp models in Google Earth follows: 

1. (Google Earth) Navigate to the location where you want your model to appear. 

2. (SketchUp) Click on the Get Current View button to get an image of the current view from 
Google Earth. This image contains the location information needed to properly place the 
model at the correct location in Google Earth.  



 203

3. (SketchUp) Create your model on top of the 2D image. 

4. (SketchUp) Click on the Toggle Terrain button to toggle to the 3D image. 

5. (SketchUp) Reposition the model to conform to the terrain in the 3D image.  

6. (SketchUp) Click on the Place Model button to place the model in Google Earth. 

7. (SketchUp) Export the final model for use in Google Earth using the KMZ export option 
found in File > Export > 3D Model. 

8. (SketchUp/Optional) Click on the Share Model button to post the model to the Google 3D 
Warehouse. 
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 Get Current View Button 
Use the Get Current View button to capture 2D and 3D snapshot images of the current view 
in Google Earth. These images are used as the context for your 3D SketchUp models. 

Getting the Current View From Google Earth  
To get the current view: 

1. (Google Earth) Find the location where you want your 3D model to appear. For example, 
type street and city where a new building will be built.  

2. (Google Earth) Zoom in on this location until you have a fairly detailed view of a building 
that you want to model. 

 Note - Ensure terrain is turned on  in Google Earth. Click on the Terrain 
check box toward the bottom middle of Google Earth to turn on terrain.  

3. (SketchUp) Click on the Get Current View button to capture an image of the current 
Google Earth view. A 2D image of the current view in Google Earth is placed in SketchUp. 
This image is locked so that you cannot delete it. 

4. (optional) Click on Undo if the image is not satisfactory and you need to reposition the view 
in Google Earth and repeat this process. 

 

 Note - If your snapshot appears solid black in SketchUp, adjust your 
graphics mode option in Google Earth. Go to Tools > Options > View and 
change your graphics mode setting from Open GL to Direct X. Exit and restart 
Google Earth for this setting to take effect. 

 Note - The snapshot of the Google Earth view is locked in SketchUp so 
that it is not mistakenly deleted. You cannot delete this snapshot, but you can 
use the Materials Browser to change the opacity of the image to 0, making the 
image 100% transparent. 
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 Toggle Terrain Button 
Use the Toggle Terrain button to toggle the Google Earth snapshot image between a 2D 
and 3D image.  

Toggling Terrain 
To toggle a terrain: 

1. Get the current view from Google Earth using the Get Current View button. A 2D Google 
Earth image will appear by default. 

2. Click on the Toggle Terrain button. The 2D Google Earth image will toggle to a 3D Google 
Earth image (with terrain). 

 

 Note - The Get Current View button actually captures two images from 
Google Earth, one with terrain and one without terrain. Each image is 
assigned to a different layer in SketchUp whose visibility is toggled using the 
Toggle Terrain button. 

Tip - Develop your model on the 2D image then toggle to the 3D image 
and adjust the model's location to the contours of the terrain. 
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 Place Model Button 
Use the Place Model button to place your SketchUp models in Google Earth. This button is 
used as a quick mechanism for viewing your model in Google Earth as you are working on 
your model. 

Placing Your Model in Google Earth 
To place your model Google Earth: 

1. Use the Snapshot, Toggle Terrain, and SketchUp Tools to create and place your model on 
a Google Earth snapshot image.  

2. Ensure Google Earth is running. 

3. Click the Place Model button to send your model to Google Earth. SketchUp creates a 
temporary file of your model and places the model in Google Earth at the proper location. 

 

 Note - Reverse the faces in your model (within SketchUp) if your model 
appears black in Google Earth. Select the faces to reverse and then context-
click and select Reverse Faces from the context menu. 

4. Repeat this process until your model appears as you would like it in Google Earth. 

 Note - Use the KMZ export option to export the final model for use in 
Google Earth. See the Input and Output section of this guide for further 
information. 
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 Share Model Button 
Use the Share Model button to post your model to the 3D Warehouse. Refer to the 3D 
Warehouse documentation for further information. 

 Note - The thumbnail of your model appearing in the 3D Warehouse will 
represent the view of the model in SketchUp at the time the model was 
shared. 
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 Get Models Button 
Use the Get Models button to download models from the 3D Warehouse. Refer to the 3D 
Warehouse documentation for further information. 
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Model Settings and Managers 
This section of the user's guide covers the various model settings and manager dialog boxes 
within SketchUp. These dialog boxes include the Component Browser, Application 
Preferences, Material Browser, and Display Settings dialog boxes. 

Each dialog box in this section is covered in the order they appear within the Window and 
SketchUp menus. 
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Model Info Dialog Box 
The Model Info dialog box allows you to configure a number of different settings specific to 
your current SketchUp model. Activate the Model Info dialog box from the Window menu. 

The Model Info dialog box contains several panels, including the Dimensions panel for 
setting global dimensions and the Units panel for setting units to be used in your model. 

Animation 
The Animation panel allows you to set properties for animations.  

 
  

Scene Transitions 
The Scene Transitions section of the Animation panel allows you to determine the amount of 
time it takes to transition from one scene in the animation to another scene. 

Enable scene transitions: Click on the Enable Scene Transitions checkbox to enable 
scene transitions.  

Seconds: Enter the number of seconds that should transpire before the next scene 
appears. 

Scene 
The Scene section of the Animation panel allows you to determine the amount of time an 
animation will spend on each scene before transition to another scene. 

Seconds: Enter the number of seconds that should transpire before the transition begins to 
another scene.  

Components 
The Components panel allows you to modify the visual appearance of your model while 
editing groups and components. SketchUp allows you to fade or hide other similar 
components or fade or hide the rest of the model to make it easier to concentrate on 
modifications to the edited component. 
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Component/Group Editing 
The Component/Group Editing portion of the Components panel allows you to define how 
geometry outside a component appears when editing a component. 

Fade Similar Components: Slide the Fade similar components slider to control the 
degree of fading of other visible instances of the component you are editing. Click the 
Hide checkbox to toggle the display of components similar to the one you are editing.  

Fade Rest of Model: Slide the Fade rest of model slider to control the fading of 
geometry unrelated to the group or component you are editing. Click on the Hide 
check box to toggle the display of the rest of the model while editing a component or 
group.  

Component Axes: Components contain their own axes. Click the Component Axes 
checkbox to display component axes. 

Dimensions 
The Dimensions panel allows you to change the appearance and behavior of Dimension 
entities in your model. 

 

Text 
The Text portion of the Dimensions panel allows you to select the font used by Dimension 
entities in the drawing area. 
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Fonts: Click on the Fonts button to select the font to be used for all Dimension entities in 
SketchUp. Click on the font color button to choose a font color for Dimension entities. 

Leader Lines 
The Leader Lines portion of the Dimensions panel allows you to choose an end point style 
for your leader lines. 

Endpoints: Select the end point style for all of your end points from the Endpoints drop-
down list. These styles are None, Slash, Dot, Closed and Open. 

 

Dimension 
The Dimension portion of the Dimensions panel contains default display options for 
Dimension entities. 

Align to screen: Click on the Align to screen radio button to allow Dimension entities to 
rotate as you orbit the model (always face the camera).  

Align to dimension line: Click on the Align to dimension line radio button to allow 
Dimension entities to align to the dimension line instead of the camera. As you orbit your 
model, the text will remain aligned with the dimension lines. 

Select all dimensions: Click on the Select all dimensions button to select all 
dimension entities in the model. 

Update selected dimensions: Click on the Update selected 
dimensions to update the currently selected entities with the currently selected dimen
sion settings.  

Expert Dimension Settings 
Click on the Expert dimension settings button to display the Expert Dimension Settings 
dialog box. 

Hide when foreshortened: Click the Hide when foreshortened checkbox to allow 
Dimension entities to hide when they become foreshortened.  Slide the slider to set the 
threshold angle that will cause Dimension entities to become hidden. 

Hide when too small: As your view moves further away from your model, dimensions 
appear smaller and text remains the same size. This behavior can result in a unclear 
Dimension text. Click on the Hide when too small checkbox to automatically hide dimensions 
when they are hard to read. Slide the slider to set the size that will cause Dimension entities 
to be hidden.  

Highlight Non-Associated Dimensions: Click on the Highlight non-associatied dimensions 
checkbox to assign a color to dimensions that are not associated with entities in your model. 
Non-associated dimensions are usually the result of erasing an entity that was used to 
calculate a dimension, such as an edge.  

File 
The File panel allows you to configure settings related to your SketchUp model's file, 
including the location of the file (on your file system), size, date of last modification, and 
version of SketchUp used for last modification. 
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General 
The General portion of the File panel contains default file options for the current model. The 
Description field is the only field that is editable within the General section. 

Location: The Location field contains the location of the model's file on the file system (if it 
has been saved). 

Version: The Version field contains the version of SketchUp last used to modify the model. 

Size: The Size field contains the Size, in kilobytes, of the current SketchUp model's file. 

Description: Click in the Description field to enter a description for your model.  

Alignment 
The Alignment portion of the File panel allow you to determine the alignment of the model 
when loaded and used as a component.  

 Note - These options are also displayed when you create a component 
from a selection set within SketchUp. However, the options presented during 
component creation pertain to components that are already within a model 
while the options in the Model Info dialog box pertain to a model file that can 
be loaded as a component in another model. 

Glue to: Select a menu item from the Glue to menu to identify the surfaces where your 
file can be placed. For example, a model of a door would only be glued to surfaces in 
the horizontal planes. 

Cut Opening: Click the Cut Opening checkbox to cause your model to able to penetrate a 
face, thus creating an opening, when used as a component. The model will cut the face to 
which it is attached at the model's perimeter. 

Always face camera: Click the Always face camera checkbox to treat the model as 
though it were a 2D component by forcing the model to always face forward when 
loaded as a component. This option increases performance by eliminating the need to 
render the component as a 3D form. 
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Shadows face sun: This option is only available when the Always face camera option is 
enabled. Click the Shadows face sun checkbox to cause shadows to be cast from the 
components' current position as though the components were facing the sun. The shadow 
shape does not change as the component rotates to face the camera. This option works 
best with components that have narrow bases (such as trees). This option does not work 
well with components that have wide bases (such as people in mid stride).  

 Note - Ensure the component's axis is positioned at the bottom center of 
the component for best results. 

Uncheck this option to cause the shadow to be cast from the component's current position. 
The size of the shadow changes based on view point.   

Location 
The Location panel allows you to specify a location for your model based on the nearest 
major city. This option is useful to determine accurate shading of architectural and 
geographical models.  

 Note - There is a different process for specifying a location for your 
model using Google SketchUp (free). Refer to  Specifying a Model's Location 
in the World for more information. 

 

Geographic Location 
The Geographic Location portion of the File panel allow you to assign a geographic location 
to your model. 

Country: Select a country from the Country list box to assign a country of origin for your 
model.  

Location: Select a city from the Location list box to assign a city of origin for your model.  

Custom Location: Click on the Custom location button to display the Custom Location 
dialog box. This dialog box allows you to manually enter Country, Location, Latitude, 
Longitude, and Timezone for any geographic location that is not already in the Country or 
Location drop-down list boxes. 

Solar Orientation 
The Solar Orientation portion of the Location panel allow you to set the path of the Sun in 
relation to the axes.  

http://neuage.org/Flare Projects/SketchUp User's Guide/Content/S-Common_Tasks/Tasks-SettingLocation.htm
http://neuage.org/Flare Projects/SketchUp User's Guide/Content/S-Common_Tasks/Tasks-SettingLocation.htm
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North Angle: Enter a North Angle to establish the path of the Sun. East, West, and South 
(0.0 by default for a model whose faces are directly aligned to the axes). Enter a new North 
angle if your north is at an angle to your model. Or, to determine a less precise North angle 
using the Select button:  

1. Click on the Select button. The cursor changes to a cross within a circle.  

2. Place the center of the cross at the origin of the North angle (usually the axes origin) 

3. Click the left mouse button. 

4. Drag the cursor away from the origin in the north direction 

5. Click again to establish the new north angle. 

Show in Model: Click the Show in Model checkbox to highlight the North angle in orange. 

Statistics 
The Statistics panel allows you to troubleshoot performance issues in SketchUp. This panel 
displays information about the type and number of drawing elements in your model and 
allows you to perform verifications on your model. 

 

Entire Model and Components 
The Entire Model and Components options in the drop-down list box allow you to toggle 
between displaying statistics for your entire model and displaying statistics related only to 
components. The Components option is useful for generating a tally of the number of certain 
components used in your model (such as the number of a particular part in an assembly). 

Show Nested Components 
Click the Show nested components checkbox to include individual elements within placed 
components in the statistics totals. 

Purge Unused 
Click the Purge Unused button to remove any unused components, materials, image 
objects, layers, and other extraneous information from your file. 
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Fix Problems 
Click the Fix Problems button to find minor issues with your SketchUp model due to the 
infinite flexibility that SketchUp provides when designing in 3D. Click the Fix Problems 
button to scan your model, and report and fix any problems. This option checks for several 
cases, including: 

• faces bounded by properly connected edges. 

• vertices of faces are on the same plane.  

• edges bounding a face are in the same component. 

• faces do not have zero area size. 

• start and end points of an edge are not the same.  

 Note - Problem checking is also performed automatically (if turned on 
within the  General panel of the Application Preferences dialog box) when a 
file is loaded, manually saved, or automatically saved (using the SketchUp 
auto-save feature). Refer to the Save menu item in the  File menu or the auto-
save feature in the  General panel of the Application Preferences dialog box 
for further information.  

Text 
The Text panel allows you to change the appearance and behavior of Text entities in your 
model. 

 

Screen Text 
Screen text is text that is not attached, using a leader line and arrow, to a specific piece of 
geometry. The Screen Text portion of the Text panel allows you to select the font used 
by screen text in the drawing area.  

Fonts: Click on the Fonts button to define the font to be used for all scren text in SketchUp. 
The Font dialog box, containing the font, font style, and size for your dimensions font, is 
invoked. 
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Text Color Swatch: Click on the text color swatch to select the default display color for any 
unpainted screen text (those painted with the default material). 

Select all screen text: Click the Select all screen text to select all screen text in the 
drawing area. 

Leader Text 
Leader text is text that is attached, using a leader line and arrow, to a specific piece of 
geometry. The Leader Text portion of the Text panel allows you to select the font used 
by leader text in the drawing area. 

Fonts: Click on the Fonts button to define the font to be used for all leader text in SketchUp. 
The Font dialog box, containing the font, font style, and size for your dimensions font, is 
invoked. 

Leader Text Color Swatch: Click on the leader text color swatch to select the default 
display color for any unpainted leader text (those painted with the default material). 

Select all leader text: Click the Select all leader text to select leader text in the 
drawing area. 

Leader Lines 
The Leader Lines options allow you to identify the type of leader line used with Text. Text 
might or might not have leader lines. 

End Point:  Click on the End Point drop-down menu to select the end point type for the 
leader line. Choose between None, Dot, Closed Arrow, and Open Arrow. 

 
Leader: Click on the Leader drop-down menu to select between View Based and Pushpin 
leader types. A View Based leader will always retain its 2D screen orientation. A Pushpin 
leader is aligned in 3D space, and rotates with your model as you change your view. 

 
Update Selected Text: Click the Update selected text button to apply the current settings to 
any selected Text entities. 

  

Units 
The Units panel is allows you to set defaults for linear and angular unit measurements.  

 Note - You can override the default units using the VCB to work in 
different units simultaneously. 
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Length Units 
The Length Units section of the Units panel allows you to set the default units for your 
model. 

Format: Click on the Format drop-down menu to set the type of units displayed for 
measurements, dimensions, and within the VCB. Architectural displays as feet and inches. 
Decimal displays decimal units, including inches, feet, millimeters, centimeters, and meters. 
Engineering displays feet and decimal units of feet, and fractional units display only 
fractional inches. 

 Note - Fractional units are primarily used by wood workers in the United 
States. 

Precision: Click on the Precision drop-down menu to set the precision for displaying units. 
Architectural unit precision can be set from 1" to 1/64". Decimal unit precision can be set in 
numbers of decimal places beyond zero for any of these units. SketchUp users working in 
Metric should use the decimal unit setting. Engineering unit precision can be set in decimal 
places beyond zero. 

Enable length snapping: Click the Enable length snapping checkbox to snap lines and 
other entities to the specified sized increments. Length snaps can be overridden by entering 
exact values into the VCB. Type the snap length in the text field to have SketchUp snap to 
specific increments when drawing.  

 Note - SketchUp does not have a grid snap option similar to other CAD 
applications.  

Display units format: Click the Display units format checkbox to display unit markers, such 
as the double quotes (") for inches.  

Force Display of 0": Click on the Force Display of 0" checkbox to display 0" in architectural 
units when there are no inches in the measurement. Ordinarily, inches would be suppressed 
in this case. For example, a measurement of three feet in length would read as 3'0" with this 
setting enabled. 

Angle Units 
The Angle Units portion of the Units panel allow you to define how units are displayed for 
angled measurements 
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Precision: Click on the Precision drop-down list to set the use of decimal degree units to 
either a level of precision of 0 (no decimal places) or 0.0 (one decimal place) for greater 
accuracy. 

Enable angle snapping: Click on the Enable angle snapping checkbox to enable snapping 
to the specified increment while using the Protractor or Rotate Tool. Move your cursor inside 
the protractor to snap to the specified increment while using these tools. You will see tick 
marks corresponding to your snap angle on the Protractor. 

Snap Angle: Click on the Snap Angle drop-down list to choose the snap increment for 
angular measurements and rotations. 
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Entity Info Dialog Box 
The Entity Info dialog box displays information about selected entities, and allows you to 
view and change their properties. The Entity Info dialog box is context-sensitive, and will 
contain different options as you select different entities in your model. Activate the Entity Info 
dialog box from either the Window menu or through a  context menu. 

 
Entity Info Properties for each type of entity are described in detail within each entity in this 
section.  

Details Arrow 
Click on the arrow in the upper-right portion of the Entity Info dialog box to show or hide 
additional Entity Info details. 
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The Color Picker 
SketchUp on OS X uses the Apple System Color Picker, with some enhancements for 
SketchUp, for all operations in which you create, modify and apply color. However, 
SketchUp's Color Picker has been enhanced.  

Activate the Color Picker by clicking on any color well in SketchUp's interface (such as in the 
Material Browser), by clicking on the Colors control in the Toolbar, or by selecting the Paint 
Bucket Tool. 

 Note - SketchUp supports the new system-wide Color Picker in OS X 
10.2 (called "Jaguar").  

The Color Picker Dialog Box 
The Color Picker dialog box contains a variety of different material and color controls 
providing several options for experimenting with color and materials in your SketchUp 
models. 

 

Toolbar 
The toolbar at the top of the Color Picker dialog box contains icons representing each of the 
available color pickers. Switch between these color pickers by clicking one on of these 
icons. 

Active Color Well 
The Active Color Well, below the toolbar, contains the current color selection. You can drag 
and drop color swatches from this color well into your model or into any other visible color 
well. 

The contents of the Active Color Well are maintained as you switch between color pickers, 
allowing you to use different pickers to create your colors.  

 Note - Ensure that the Shaded or Shaded with Textures display style is 
selected to ensure applied colors and materials are displayed. 
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Screen Picker 
The Screen Picker, represented as a magnifying glass, is used to choose a color from any 
element currently visible on your Apple Macintosh screen. To select a color using the 
Screen Picker: 

1. Click on the magnifying glass icon to activate the Screen Picker. The cursor changes into a 
large magnifying glass.  

2. Move the cursor around the screen until you are magnifying the color you want to use. 

3. Click the mouse button to place the color in the Active Color Well.  

Color Picker Controls 
The Color Picker Controls, below the Active Color Well, differ for each Color Picker. See the 
Color Pickers section of this topic for additional information. 

Opacity Slider 
SketchUp supports adjustable, by material, transparency. The Opacity slider, below the 
Color Picker Controls, is used to adjust the opacity level. Type an opacity value in the text 
field to the right of the slider if you prefer to set opacity levels more precisely. 

Be sure to activate SketchUp's material transparency from the Display Settings dialog box 
before experimenting with the Opacity Slider. 

User Palette 
The User Palette, at the bottom of the Color Pickers, is an expandable palette of small color 
wells. To use the User Palette: 

• Drag and drop a color or texture swatch from any visible color well, including 
the Active Color Well, and drop it over a User Pallet well to add a color to the 
User Palette.  

• Drag an drop a new swatch in the place of another color swatch to replace a 
swatch in the User Palette. 

• Drag and drop an empty swatch onto a color to remove a color from the 
User Palette. 

• Click and drag down on the size handle (a small circle) in the middle of the 
bottom edge of the palette to see more wells.  

 Note - The colors and materials in the User Palette are saved in 
SketchUp and can be used between multiple modeling sessions. 

 Note - Ensure that the Shaded or Shaded with Textures display style is 
selected to see the colors that you have applied to entities. 

Color Pickers 
SketchUp contains four color pickers, used to select materials that do not have texture (just 
color), and a materials picker (containing color/texture combinations that mimic real-world 
construction materials). 

 Note - Ensure that the Shaded or Shaded with Textures display style is 
selected to see the colors that you have applied to entities. 
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 Color Wheel Picker 
The Color Wheel picker allows you to select a color by Hue, Saturation, and Brightness. 

Select the color you want by clicking your mouse over that color in the Color Wheel. You can 
also click and drag the cursor around the Color Wheel to quickly browse through many 
different colors. You will see a dynamic preview of the selected color in the Active Color Well 
at the top of the Color Picker. 

The Color Wheel arranges color hue radially around the wheel, with the highest saturation at 
the outer edge of the wheel. Slide the value slider, to the right of the wheel, up or down, to 
change the brightness of the color. 

The Color Wheel Color Picker is the simplest and most versatile of the standard Apple Color 
Pickers, though it is also the least precise. You might want to use the Color Wheel picker to 
make a rough color choice, and then use one of the Color Slider pickers to fine tune your 
choice. 

 Color Slider Picker 
The Color Slider Picker contains four pickers: Gray Scale Slider, RGB Sliders, CMYK 
Sliders, and HSB Sliders. These color pickers differ only in the components they use to mix 
colors. Select the Color Slider picker from the pop-up menu at the top of the Picker control 
area to choose one of the Color Slider pickers. 

Gray Scale Slider: The Gray Scale slider allows you to select colors from the grayscale 
color range (shades of gray). 

Adjust the slider until you see the color you want in the Active Color Well. Alternatively, you 
can select a color by typing a percent gray value directly in the text box to the right of the 
slider. Or, choose from one of the five preset gray values below the slider. 

RGB (Red, Green & Blue) Sliders: The RGB sliders allow you to select colors from the 
RGB (Red, Green and Blue) color range. RGB colors are traditionally used when modeling 
color on a computer screen and represent the closest approximation of the actual range of 
colors recognizable by the human eye. RGB has a wide color gamut and is one of the most 
effective color spaces to use in SketchUp. 

Drag the sliders left and right for each of the component colors (red, green and blue) to 
create the color that you want to use. The background color of each slider changes as you 
modify values to help you predict how adjustments will change your color mix.  

Alternatively, you can type in exact numerical values for red, green or blue in the value 
boxes to the right of the sliders to precisely match a color that you have specified elsewhere.  

CMYK (Cyan, Magenta, Yellow & Black) Sliders: The CMYK sliders allow you to select 
colors from the CMYK (Cyan, Magenta, Yellow and Black) color range. CMYK is traditionally 
used to select colors intended for professional printing, where colors are usually specified in 
percentages of these four basic ink colors. RGB or HSB color pickers are generally sufficient 
for most work in SketchUp. 

Drag the sliders left and right for each of the component colors (cyan, magenta, yellow and 
black) until you have the color you want to use. To help you find an exact color , the 
background color of each slider will change as you modify values to help you predict how 
adjustments will change your color mix. 

HSB (Hue, Saturation & Brightness) Sliders: The HSB Color sliders allow you to pick 
colors from the HSB (Hue Saturation and Brightness) color range. HSB often gives you a 
more intuitive color model for selecting desaturated colors. 
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Adjust the sliders for Hue, Saturation and Brightness until you see the color you want in the 
Active Color Well. 

Sometimes it is easier to mix de-saturated colors using the HSB Color Picker in conjunction 
with one of the other color pickers.  Switch to another color picker to make your rough color 
selection, then switch back to the HSB Color Picker to fine tune or mix desaturated colors. 

 Image Palettes 
The Image Palettes Picker allows you to load an image file into the Color Picker and select 
colors from anywhere in that image. The Image Palettes Picker has a spectrum image 
loaded as a default. To load and select a color from an image: 

1. Select New From File from the pop-up menu at the bottom of the image well.  

2. Locate your image in the New Color Palette dialog box. 

3. Click Open. 

4. Click and Drag your cursor around the Image Well until the color you want is in the Color 
Well. 

 Note - To switch from image to image, use the pop-up list at the top of 
the Image Well. 

 Note - You can also load an image you have copied to the OS X 
clipboard by selecting New From Pasteboard from the pop-up menu at the 
bottom of the image well. Additionally, you can drag an image file from the 
Finder and drop it on the Image Well. 

  

 Texture Palette Picker 
The Texture Palette Picker is unique to SketchUp and is the picker that you use to create, 
modify and manage SketchUp-specific materials. 

Swatch Browser: The middle of the Texture Palettes Picker contains a Swatch Browser, in 
which thumbnail images for all available materials from the currently selected materials List 
are displayed. To use the Swatch Browser: 

• Drag your mouse over a swatch to see a tool tip with the texture's name.  

• Click on a swatch to load it in the Active Color Well for use in your model. 

• Double-click on a swatch to open the material for editing. See the "Editing 
Materials" section for more information. 

• Drag and drop materials within the Swatch Browser to re-sort the materials. 

• Drag and drop image files directly from the finder into the Swatch Browser. 
You will be prompted to supply a name and dimensions for the material 
when you drag and drop an image file into the Swatch Browser. 

The Color and List drop-down menu are below the Swatch Browser. Use the Color menu to 
manage and create new materials and the List menu to manage and create new material 
lists. See Material Libraries for additional information. 
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 Crayons Picker 
The Crayons Picker displays a graphic representation of a box of crayons with a small range 
of standard Apple colors. The Crayon Picker is the simplest picker to use and is fairly limited 
in the range of colors available. 

Click on the crayon whose color you want to use to select a color with the Crayon Picker. 
The crayon's color will be transferred to the Active Color Well.  

Texture Pallet Picker Options 
SketchUp contains a library of predefined materials. These materials are grouped into 
categories, within the Texture Palette Picker, in the pop-up menu below the Active Color 
Well. Select the category of material you want to use to see several related materials. Or, 
use the forward and backward arrows next to this pop-up to quickly step forward and 
backward through your previously selected material categories. 

Colors In Model 
The Texture Palettes Picker includes a special material library called Colors In Model 
containing all materials currently used in your model. The contents of this library are 
generated automatically as you add materials to your SketchUp model. 

Select the Colors In Model from the materials library drop-down menu, or simply click on the 
icon shaped like a house, to view all of the materials in your model.  

Color Menu 
The Color drop-down menu allows you to manipulate materials within the Colors In Model 
materials library.  

Edit: Click on the Edit menu item to edit the material. See Editing Materials below for further 
information. 

Remove: Click on the Remove menu item to remove the material from the Colors In Model 
materials library. You will be prompted to replace the material with the default material if the 
material is currently used within your model.  

Duplicate...: Click on the Duplicate... menu item to duplicate a material within the Colors In 
Model materials library. You will be prompted to provide a new name for the duplicate 
material. 

New Texture...: Click on New Texture... menu item to import an image file containing new 
material. You will be prompted to select the image file from a file system to import as a new 
texture. After you have selected the image file to import, type in the name for the new 
material followed by the dimension, in inches, that comprise the size of the texture swatch 
that will be repeated when painted on your model. 

SketchUp can place any image supported by Apple's QuickTime media layer as a texture. 
Supported Image file types include JPEG,  PNG, PDF, PICT, PSD, EPS, SGI, and  TIFF 
files.  

Note: SketchUp for OS X supports the alpha channel in image files that 
support transparency, such as PNG, PSD and TIFF files. 

List Menu 
The List drop-down menu allows you to create, duplicate, remove, and purge unused 
materials libraries. 
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New...: Click on New... to create a new materials library. You will be prompted to provide a 
name for the new library. 

Duplicate...: Click on Duplicate... to Duplicate the currently selected materials library. You 
will be prompted to provide a name for the duplicate library. 

Remove: Click on Remove to remove a materials library. You will be prompted to click 
Remove or Cancel to commit this action. Certain standard Apple color libraries, such as the 
Web Safe Colors library, cannot be removed. 

Purge Unused: Click on Purge Unused, from within the Colors In Model library to remove 
any materials that appear in this library, but are not being used in the model. This option is 
useful when your Colors In Model library becomes cluttered with materials that are no longer 
used in your model. 

Applying Materials and Colors 
There are multiple methods to apply a material to entities in your model. To apply materials 
using the Paint Bucket Tool: 

1. Select the Select Tool. The cursor will change to an arrow.  

2. Select the entities to receive materials or colors. 

3. Select the Paint Bucket Tool. The cursor will change to a paint bucket. The Color Picker 
will open. 

4. Click on a Color Picker 

5. Locate and click on a color or material 

6. Drag the paint bucket cursor over the selected entities. 

7. Click on the selected entities to apply the color or material. 

Alternatively: 

• Click and drag a material swatch from the Texture Pallet Picker and drop it 
on the a single entity you want to color.  

• Select several entities with the Select Tool and then click and drag a swatch 
from the library and drop it on one of the selected entities. 

• Select the material you want to use and then select the Paint Bucket Tool. 
Click the Paint Bucket Tool's cursor over the entity or selection set you wish 
to color. 

 Note - Ensure that the Shaded with Textures display style is selected to 
see the materials that you have applied to entities. 

Deleting Materials 
Materials added to your model are stored within the model's .skp file. A material with only 
color information is very small, but materials with textures can get fairly large, depending on 
the file size of your texture. Therefore, it is suggested you delete unused materials from the 
In Model tab to minimize the size of your model file. To delete a material: 

1. Select the In Model tab of the Materials Palette. This panel displays all materials defined in 
your model.  Materials that are used in your model have a small triangle in the bottom right 
corner. 

2. Right click on the material you want to delete to display the material's context menu. 



 227

3. Select Delete from the context menu. A dialog box will appear if you are deleting a material 
that is currently used in your model.  

1. Click Yes to delete the material and replace it with the default material. 

2. Click No to retain the material. 

Editing Materials 
Material editing in SketchUp is a dynamic process. If you edit a material that has been 
assigned to your model, changes you make to that material will automatically appear in the 
model. This interaction makes it easy to interactively experiment with color variations in your 
model. To edit a material: 

1. Double-click on the material's swatch in the Colors In Model library to edit the material. 
This action will open the material for editing in the Edit Material panel at the bottom of the 
Color Picker. A material swatch will appear in this panel for the material you selected.  

2. Click on any of the color pickers to change the color of the material 

3. Modify the name, texture, width, and size as needed. See Edit Material Panel for further 
information. 

4. Click the Close button at the bottom of the Edit Material panel when you are done editing a 
material. SketchUp will also automatically close this panel when you change between 
tools.  

 Note - Use Edit > Undo to revert back to a previous material if you make 
a mistake while you are editing a material. 

Edit Material Panel 
The Edit Material panel allows you to modify the following material properties: 

Name: Enter a new name for a material to change the name of the material being edited. 

Texture: This drop-down menu allows you to load a materials image file, remove the texture 
portion of an image file that you are editing, or reset any colorization applied to the material. 
A flat color approximation of the removed image appears when the texture image is 
removed. 

Width/Size: Using the Width and Height text boxes, you can change the actual size of the 
texture material in your model. To maintain the proportions of the material you are editing, 
ensure that the chain icon to the right of the fields is unbroken. Click on the chain icon to 
toggle aspect locking on and off. 

 Note -If you have a texture image assigned to the material you are 
editing, picking a color from any of the Color Pickers will colorize the texture 
image instead of replacing it with a flat color. This is a great way to quickly and 
loosely experiment with variations in material color. 

Using SketchUp Material Libraries 
SketchUp stores materials in the cross-platform .SKM file format. Following are some details 
about materials files: 

• .SKM files are also created every time you use the Texture Palette Picker to 
create a new material library. 
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• .SKM files are stored in the directory ~/Library/Application 
Support/SketchUp. Place a .SKM file in this directory to add a new materials 
library to SketchUp. 

• .SKM files created on Mac OS X are identical to those created under Windows 
and can be shared transparently between platforms. 

Adding Materials From Image Files 
You can create realistic materials from image files (such as .jpg pictures taken with a digital 
camera) using the materials browser. To add materials from image files: 

1. Create a folder for your image files. 

2. Place your image files into the new folder. 

 Note - You must create a new materials library if you wish to add 
materials to SketchUp from image files. You cannot add materials to the 
materials libraries that are included with SketchUp.   

3. Launch SketchUp. 

4. Select Window > Colors. The Color Picker dialog box is displayed. 

5. Click on the Texture Pallet Picker. 

6. Click on the List drop-down menu. 

7. Select New. 

8. Enter a name for the new materials library that will contain your image-based materials. 

9. Click OK. A new materials library is saved at ~/Library/Application 
Support/SketchUp/Materials/<libraryname>.skm 

10. Click on the Color drop-down menu. 

11. Select New Texture.  

12. Locate the image-based material to add to the library. 

13. Click Open. The image-based material will be added to your new materials library. 
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Component Browser 
The Component Browser is used to instance Component entities from component 
definitions, including those components that you create and a variety of pre-built 
Components that you can use in your models. SketchUp adds the components definitions 
for the components you create to the In Model library, which is one of the libraries in the 
drop-down list of component libraries in SketchUp. Activate the Component Browser from 
the  Window menu.  

 Note - See component definitions and instances for further information. 

 

Finding a Component 
There are several ways to find components within the component library. These include the 
backward and forward buttons, the home button, and the component library list. 

Backward and Forward  
Click on the forward and back arrow buttons to navigate forward and back through the 
previously browsed component libraries. 

Home 
Click on the button shaped like a house to navigate to the In Model component library. This 
library contains all components within the current model.  

Component Library List  
Select one of the component libraries from the component library list box to navigate to the 
library. The component library list represents a series of directories in the file system where 
components are stored.  

Inserting a Component 
Components can be inserted from any component library into your model within the drawing 
area. To insert a component in your drawing area: 
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1. Navigate to a component in the component browser.  

2. Click on the component. 

3. Move the mouse to the location in the drawing area where you want to place the 
component. The cursor changes to the Move Tool. 

 Note - The Move Tool will usually be anchored to the origin of the 
component's axes (also called the insert point ). To see the origin of the 
component, select Window > Model Info > Components > Show component 
axes.  

Tip - The component axes is the default insertion point (the point where 
the cursor grabs the component) for a component the first time you place the 
component in the model from the Component Browser. The insertion point will 
change to the point where the Move Tool selects a component if you place a 
component and then reposition the component using the Move Tool. 

3. Click the mouse button again to release the component.  

 Note - You can also insert components from an external SketchUp 
(.skp) file or by dragging and dropping a file from the  Finder into your model. 
See the  Component entity for further information.  

Component Browser Controls 
Use Component Browser controls to navigate among components in your component 
libraries.  

Component Thumbnail 
The component thumbnail displays the currently selected component. 

Component Name Field  
The component name field displays the name of the currently selected component. 

Component Description Field  
The component description field displays a description of the currently selected component. 

Display Secondary Selection Pane Button 
The Display Secondary Selection Pane button displays a second select panel below the 
primary select panel. This feature allows you to display both your components libraries and 
the in model library at the same time. This feature is useful when you want to drag 
components between libraries and the in model library.  

Get a Models Button 
Click on the Get Models button to download models from the 3D Warehouse. Refer to the 
3D Warehouse documentation for further information. 

Select Tab 
Click on the Select tab to display the select panel . Use the select panel to navigate between 
component libraries. 

Back Arrow: Click the Back arrow to navigate to the previous location in the hierarchy of 
libraries. 
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Forward Arrow: Click the Forward arrow to navigate to the next location in the hierarchy of 
libraries. 

In Model Button: Click on the In Model button to navigate to the In Model component 
library. The In Model component library contains all of the component currently included with 
your model file. 

 Note - You can have components in your In Model component library 
that are not being used by your model. 

Libraries Drop-Down List: Click on the libraries drop-down list to list all of the component 
libraries in SketchUp. Click on a library to select the library. 

Details Menu: Click on the Details arrow to display the Details Menu. See Details Menu for 
further information. 

Edit Tab 
The Edit tab contains properties specific to the currently selected component. These 
properties can only be edited for components that are selected in the In Model component 
library. These are the same properties, whose values you define, when a component is 
created. See the Create Component Dialog Box for further information on these properties.   

Statistics Tab 
 The Statistics reports quantities of various elements, such as faces, edges, guide lines, 
within the component. Select All geometry from the drop-down list to see statistics for all 
geometry in the component or group. Alternatively, select Components from the drop-down 
list to see statistics for all components in the component. Finally, click on Expand to see 
components and groups nested within the currently selected component or group. 

Component Browser Context Menus 
A number of useful Component Browser-related commands are accessible using context 
menus. Context-click on any component's icon or name to access the Component Browser 
context menus. The following options appear depending on whether you are clicking on 
icons in an established component library or in the In Model library: 

Properties  
Select the Properties menu item to display the Properties dialog box. This dialog box 
contains the location for the component file, when the file was last opened, the name of the 
component, and the number of component instances in the model.  

Delete 
Select the Delete menu item to delete a single component from a component library. 

Reload 
Select the Reload menu item to reload a component from its original file in the event that the 
component's file has changed since being used in your model. 

Save As 
Select the Save As menu item to save the selected component to a separate SketchUp file, 
with a new name and location. You can use this menu item to save components that have 
been modified or created during a drawing session.  

Reset Insertion Point 
Select the Reset Insertion Point menu item to reset any changes made to a component 
definition's insertion point. 
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Select Instances 
Select the Select Instance menu item to select all of the instances of a specific component in 
your model. 

Replace Selected 
Select the Replace Selected menu item to replace the currently selected components in the 
drawing area with the currently selected component in the Component Browser.  

Details Menu 
Click on the right arrow next to the components library drop-down list to open the details 
pop-up menu. This menu allows you to perform additional component-related functions. 

Open or Create a Library 
Select the Open or create a library menu item to open an existing library (or file) or create a 
new library (folder).  

  Note - The open or create a library menu item displays a Browse for 
Folder dialog box. This dialog box does not display files, only folders. Select 
the folder or location containing the file and click the OK button. 

Save Library As 
Select the Save Library As menu item to save a copy of a library with a new name.  

Add Library to Favorites 
Select the Add Library to Favorites menu item to add an existing library to the list of favorite 
libraries (appearing at the bottom of the libraries drop-down list). 

Remove Library From Favorites 
Select the Remove Library from Favorites menu item to remove a library from your list of 
favorites (appearing at the bottom of the libraries drop-down list). 

Expand 
Select the Expand menu item to see all sub-components within the components the In 
Model library. 

Purge Unused 
Select the Purge Unused menu item to remove all components in the In Model library that 
are not actually used in your model. 

Small Images, Medium Images, Large Images, Extra Large Images 
Select the Small Images, Medium Images, Large Images, or Extra Large Images menu item 
to change the size of the thumbnails in the Select panel. 

List View 
Select the List View menu item to display the components in list form. 

Refresh 
Select the Refresh menu item to update the components appearing in the component 
browser. 

Get More 
Select the Get More menu item to get more components from the SketchUp web site.   
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Styles Browser 
The Styles Browser contains options used to alter how your model and the drawing area is 
rendered (its edge type face type, background colors, watermarks, and so on). Activate the 
Styles Browser from the Window menu. 

 

Applying Styles 
Select one of many pre-defined styles from the Styles Browser and apply it to your model. 
Each pre-defined style represents a collection specific settings that can be applied to your 
model and the drawing area. To select and apply a pre-defined style: 

1. Select the Styles menu item. The Styles Browser is displayed. 

2. Click on the Select tab. 

3. Click on the styles library drop-down list.  

4. Select the Styles library. All of the pre-defined styles in the library are displayed in 
thumbnail form. 

5. Click on one of the pre-defined styles. The style is applied to your model and the drawing 
area. 

Editing Styles 
Styles are comprised of several different settings found under the Edit tab. To Edit a style: 

1. Select the Styles menu item. The Styles Browser is displayed. 

2. Click on the Select tab. 

3. Click on the styles library drop-down list.  

4. Select the Styles library. All of the pre-defined styles in the library are displayed in 
thumbnail form. 
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5. Click on one of the pre-defined styles. The style is applied to your model and the drawing 
area. A copy of the style appears in the In Model library. 

6. Click on the Edit tab. One of five panels is displayed (Edge, Face, Background, 
Watermark, and Modeling). 

7. Modify settings in any of the edit panels. Refer to Edge Panel, Face Panel, Background 
Panel, Watermark Panel, or Modeling Panel for further information.  

8. Click on the Update Style button. The copy of the style in the In Model library is updated 
with your changes. 

9. (optional) Save your changes to the edited style:  
 

a. Click on the In Model button. The In Model library is displayed. 

b. Context-click on the edited style. The In Model context-menu is displayed. 

c. Select the Save As menu item.  

d. Navigate to a directory (folder) where you want to save the style.  

e. Type a name in the File name field and click the Save button. The file is saved. 
Refer to the Open or create a library context-menu item for information on how to 
retrieve this style for use in other SketchUp files. 

Styles Browser Controls 
Use the Styles Browser controls to navigate among styles in your styles libraries. 

Style Thumbnail  
The style thumbnail displays the style currently applied to your model. 

Style Name Field  
The style name field displays the name of the currently active style. 

Style Description Field  
The style description field displays a description of the currently active style. 

Display Secondary Selection Pane Button 
The Display Secondary Selection Pane button displays a second select panel below the 
primary select panel. This feature allows you to display both your styles libraries and the in 
model library at the same time. This feature is useful when you want to drag styles between 
libraries and the in model library. 

 Note - You can only apply one style at a time, but you might want 
multiple styles in the In Model library. For example, you might have one style 
that you apply when you are working on the model (because performance is 
better when you use the style) and another style you use for presenting the 
model. Styles in the In Model library are also saved with your SketchUp file.  

Create New Style Button 
Click on the Create new style button to create a copy of the currently active style in the In 
Model library.  

Update Style Button 
Click on the Update style button to update the copy of the currently active style in the In 
Model library. 
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Select Tab 
Click on the Select tab to display the select panel . Use the select panel to navigate between 
style libraries. 

Back Arrow: Click the Back arrow to navigate to the previous location in the hierarchy of 
libraries. 

Forward Arrow: Click the Forward arrow to navigate to the next location in the hierarchy of 
libraries. 

In Model Button: Click on the In Model button to navigate to the In Model styles library. The 
In Model styles library contains all of the styles currently included with your model file. 

 Note - You can have styles in your In Model style library that are not 
being used by your model. 

Libraries Drop-Down List: Click on the libraries drop-down list to list all of the styles 
libraries in SketchUp. Click on a library to select the library. 

Details Menu: Click on the Details arrow to display the Details Menu. See Details Menu for 
further information. 

Edit Tab 
The Edit tab contains five separate panels: The edge rendering panel, face rendering panel, 
drawing area styles panel, watermark panel, and other styles panel. 

Mix Tab 
The Mix tab contains five wells corresponding to the five categories of styles in the styles 
browser (edge, face, background, watermark, and modeling styles). Click on this tab to 
display the five wells and a secondary style pane. Select a style from the secondary style 
pane and click on one or more wells to sample the corresponding settings from that style. 
For example, click on a style in the secondary style pane and click on the Edge Settings well 
to sample the edge settings from that style. The style in the style thumbnail change to reflect 
the newly sampled settings. 

Edge Panel 
SketchUp contains a variety of edge rendering styles allowing you to manipulate the edge 
appearance on the screen.  

 Note - Endpoints and Jitter edge rendering styles are not available for 
NPR Edges.  

Tip - Models with perfectly straight digitally drawn lines are often 
perceived to be in a finished state. Edge Rendering Styles are useful in 
conveying that a model is still in conceptual state and, therefore, is open for 
feedback. 

  

Display Edges 
Check the Display Edges checkbox to activate the display of edges in your model. The 
following images shows a series of cubes without and then with edges. 
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Profiles 
Check the Profiles checkbox to emphasize the outlines or profiles of major shapes in your 
model. This style is particularly useful in ensuring the 3D nature of geometry is emphasized 
and borrows from a proven traditional media drawing technique. Enter a thickness, in pixels, 
for the profile lines in the pixels field. The following image shows a series of cubes with 
edges and profile edges. 

 

Depth Cue 
Check the Depth Cue checkbox to emphasize the lines of geometry in the foreground over 
the lines of geometry in the background. The following image shows a series of cubes with 
edges and depth que edges on. Notice that the foreground edges on each cube get 
progressively thinner from front to back and top to bottom. Enter a thickness, in pixels, for 
the depth cue lines in the pixels field. This thickness determines the thickness of the 
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forward-most lines (such as for the bottom middle cube in the following image) of your 
model. 

 

Extension 
Check the Extension checkbox to extend each line slightly past its endpoint, giving your 
model hand-drawn sketched appearance. This edge rendering style does not affect 
inference behavior. Enter a length, in pixels, for the extension lines in the pixels field. The 
following image shows a series of cubes with edges and extension edges.  

 

Endpoints 
Check the Endpoints checkbox to place additional line thickness at the endpoints of lines. 
Enter a length, in pixels, for the length of the emphasized endpoints in the pixels field. The 
following image shows a series of cubes with edges and endpoints edges.  
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Jitter  
Check the Jitter checkbox to render each line multiple times at a slight offset, giving your 
model hand-drawn sketched appearance. This edge rendering style does not affect 
inference behavior. The following image shows a series of cubes with edges and jitter 
edges.  

 

Halo 
Check the Halo checkbox to create a halo affect where lines overlap in your model by 
ending lines, that would normally overlap, a certain distance away from the overlap point. 
Type a number in the halo text field representing the distance away from the intersection 
where lines will end. This option is only available for styles that have a Sketchy Edge. 

Level of Detail 
Move the Level of Detail slider to the right increase the number of displayed edges. Move 
the Level of Detail slider to the left to decrease the number of displayed edges. This option 
is only available for styles that have a Sketchy Edge. 

  

  

Tip - Experiment with combinations of edge renderings to see how they 
appeal to you. 

Color 
SketchUp also allows you to manipulate the edge color on the screen. 

 Note - Edge Colors are only available when using Shaded and Shaded 
with Textures Face Rendering Styles.  Inference alignments to edges are not 
available when edges are hidden.  

All Same: Select the All Same drop-down list item to display all edges using the Edges color 
as defined in color swatch. This option does not actually change any edge color 
assignments you may have made, but preserves them if you choose to view them again. 
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By Material: Select the By Material drop-down list item to display edges using an assigned 
material color. The following image contains edges painted with a grey material. 

 
By Axis: Select the By Axis drop-down list item to display edges in colors corresponding to 
the color of the Drawing Axes to which they are parallel. This option is helpful in determining 
when edges are not aligned to an axis. The following image has lines colored red, green, 
and blue corresponding to the axes to which they are aligned. 

 

Face Panel 
SketchUp contains a variety of face rendering styles allowing you to manipulate the amount 
of material and textures displayed on the screen. 

Front Color   
Click on the Front color button to set the default color for all front sides of faces. Materials 
assigned to faces override this setting. 

Back color 
Click on the Back color button to set the default color for the back sides of faces. Materials 
assigned to faces override this setting.  

Wireframe 
Click on the Wireframe face rendering style button to display the model as a collection of 
lines. Faces are not displayed in Wireframe mode.  
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 Note - You cannot use face modification tools, such as the  Push/Pull 
Tool, on a wireframe rendered model 

Hidden Line 
Click on the Hidden Line button to display faces in the model without any shading or 
textures. 

Tip - Use this face rendering style when creating black and white 
printouts which you might want to modify further with traditional media, or 
which you might use as an underlay for hand drawings. 

 

Monochrome 
Click on the Monochrome button to display the model as an assembly of edges and faces, 
just as with the Hidden Line face rendering style. However, Monochrome mode provides 
default shading and is useful for shadow studies whereby you turn the face front and face 
back to white and then display shadows. 

 

Shaded 
Click on the Shaded button to display faces in the model as shaded to reflect a light source. 
Any color that had been applied to a face will be displayed. Remember that both sides of 
faces can have different colors. The default colors for front and back face are displayed 
when no color has been applied to a face. 
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Shaded with Textures 
Click on the Shaded with Textures button to display the faces in model with the texture 
images that have been applied to a face.  

Tip - Textures can slow down SketchUp's performance. Use other face 
rendering styles, such as the Shaded face renderings style, when performance 
slows dramatically. Switch back to the Shaded with Textures face rendering 
mode to create your final output. 

 

Monochrome 
Click the Monochrome button to display the faces with the default front and back face color. 

 X-Ray 
Click on the X-Ray button to display all faces in SketchUp with a global transparency. This 
option allows you to see through the model's faces and edit edges behind faces and can be 
combined with any of the above face rendering styles. 

You can easily visualize, select, and snap to points and edges that would otherwise be 
hidden behind faces when modeling with X-ray mode. Remember, however, that it is not 
possible to select and infer faces that would otherwise be hidden. 

Faces can not cast Shadows when using X-ray mode. Shadow display will default to ground 
plane shadows only when X-ray mode is enabled. X-ray mode is different than material 
transparency. 
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Enable Transparency 
Click on the Enable transparency checkbox to enable or disable global material 
transparency.  

Transparency Quality 
The Transparency Quality options allow you to select the quality of transparency display 
between faster, medium, and nicer. Each option differs in its speed and quality of 
transparency sorting. The Faster display sacrifices sorting accuracy to provide a faster 
rendering update rate. Conversely, the Nicer display performs additional calculations to 
correctly sort transparent surfaces.  

Because SketchUp's transparency system is designed for real-time feedback and display, it 
may sometimes display transparent faces in an unrealistic way: Faces may appear as if they 
were in front of other surfaces when they are really behind, and vice-versa.   

Background Panel 
Styles also contain options for configuring the drawing area background, sky, and ground 
colors.  

Background 
Click on the Background button to select a background color for SketchUp's  drawing area. 

Sky 
Check on the Sky checkbox to have a sky color that is different from the background color. 
Click on the Sky button to select a sky color.  

Ground 
 Check on the Ground checkbox to select a ground color that is different from the 
background color. 

  

Transparency 
Slide the Transparency slider to adjust the level of transparency for the ground plane. Place 
the slider toward the left-most position to minimize below-ground visibility. Place the slider 
toward the right-most position to maximize below-ground visibility.  

Show Ground from Below 
Check the Show ground from below checkbox to toggle the display of the ground plane from 
a viewpoints below the horizon.  

Watermark Panel 
Refer to the Watermark section of this User's Guide for additional information on the 
watermark feature. 

Modeling Panel 
The Modeling panel contains styles for how a variety of entities are displayed on the screen. 
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Selected 
Click on the Selected button to set the color of the highlight used to indicate a selection. Use 
a color that will contrast well with the other colors in your model when selecting a selected 
color.  

Locked 
Click the Locked button to set the color of any locked component. 

Guides  
Click on the Guides button to set the color of any guide line entities in your model. 

Inactive Section 
Click on the Inactive Section button to define the color for the currently inactive (not 
highlighted) Section Plane entities in your model. 

Active Section 
Click on the Active Section button to define the color for the currently active (highlighted) 
Section Plane entity. 

Section Cuts 
Click on the Section Cuts button to define the color for the active section plane's section 
slice line.  

Section Cut Width 
Enter a Section Cut Width to define the thickness (in pixels) of all cut lines in the active 
section plane.  

Hidden Geometry 
Check the Hidden Geometry checkbox display hidden geometry or entities that have been 
hidden using the Hide menu item or context command. The Hidden Geometry checkbox 
displays hidden faces with a light cross-hatch pattern (edges are displayed dashed), 
enabling you to select the geometry. Once selected, hidden geometry can be made visible 
with the  Unhide> Selected, UnHide>Last, and  Unhide>All menu items. 

Color by Layer 
Check the Color by Layer checkbox to apply materials to geometry on a per layer basis 
using the color associated with the layer. Ensure shaded or shaded with Textures display is 
turned on to view materials.  

Guides 
Check the Guides checkbox to display guide line entities and guide point entities. 

Section Planes 
Check the Section Planes checkbox to display section plane entities. 

Section Cuts 
Check the Section Cuts checkbox to display section cut effects. 

Model Axes 
Check the Axes checkbox to display the drawing axes. 

Styles Browser Context Menus 
A number of useful Styles Browser-related commands are accessible using context menus. 
Context-click on any style's icon or name to access the Styles Browser context menus. The 
following options appear depending on whether you are clicking on icons in an established 
styles library or in the In Model library: 



 244

Delete 
Select the Delete menu item to delete a single style from a styles library. 

Make a Copy 
Select the Make a Copy menu item to make a copy of the currently selected style. 

Save As 
Select the Save As menu item to save the selected style to a separate file (.style), with a 
new name and location. You can use this menu item to save styles that have been modified 
or created during a drawing session.  

Details Menu 
Click on the right arrow next to the styles library drop-down list to open the details pop-up 
menu. This menu allows you to perform additional styles-related functions.  

Create Style 
Select the Create style menu item to create a copy of the currently active style in the In 
Model library.  

Open or Create a Library 
Select the Open or create a library menu item to open an existing library (or file) or create a 
new styles library (folder).  

  Note - The open or create a library menu item displays a Browse for 
Folder dialog box. This dialog box does not display files, only folders. Select 
the folder or location containing the file and click the OK button. 

Save Library As 
Select the Save Library As menu item to save a copy of a library with a new name.  

Add Library to Favorites 
Select the Add Library to Favorites menu item to add an existing library to the list of favorite 
libraries (appearing at the bottom of the libraries drop-down list). 

Remove Library From Favorites 
Select the Remove Library from Favorites menu item to remove a library from your list of 
favorites (appearing at the bottom of the libraries drop-down list). 

Purge Unused 
Select the Purge Unused menu item to remove all styles in the In Model library that are not 
actually used in your model. 

Small Images, Medium Images, Large Images, Extra Large Images 
Select the Small Images, Medium Images, Large Images, or Extra Large Images menu item 
to change the size of the thumbnails in the Select panel. 

List View 
Select the List View menu item to display the styles in list form. 

Refresh 
Select the Refresh menu item to update the styles appearing in the styles browser. 

Get More 
Select the Get More menu item to get more styles from the SketchUp web site. 
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Watermark 
 Watermark is part of the Styles Browser. This feature allows you to add a watermark-like 
image to foreground or background of the drawing area.  

Adding a Watermark to the Drawing Area 
To add a watermark to the drawing are: 

Select the Styles menu item from the Window menu. The Styles Browser is displayed.   

1. Click on the Edit tab. 

2. Click on the Watermark panel button. The Watermark panel is displayed. 

3. Click on the Add button. The Choose Watermark dialog box is displayed. 

4. Navigate to an image you will use as a watermark. 

5. Click the Open button.The image will appear as a watermark in the background of the 
drawing area. The Create Watermark dialog box is displayed. 

6. Click either the Background button to have the image appear behind your model as a 
background watermark, or the Overlay button to have the image appear in front of your 
model as an overlay. 

7. Click on the Next button. 

8. (optional) Check the Create Mask checkbox.  Refer to Watermark Settings for further 
information. 

9. (optional) Move the Blend slider to the left to fade the watermark. Or, move the Blend 
slider to the right to fade the model. 

10. Click on the Next button. 

11. Check the radio button that reflects where you want the watermark to appear on the 
screen. Refer to Watermark Settings for further information. 

12. Click on the Finish button. 

Watermark Panel 
 The watermark panel contains settings for all of the watermarks in a style. 

Display Watermarks 
Check the Display watermarks checkbox to display all active watermarks (all watermarks 
whose Active checkbox is checked). Uncheck the Display Watermarks checkbox to hide all 
watermarks. 

Watermark Settings 
There are several settings that you can make when creating or editing a watermark. These 
settings follow. 

Create Mask 
Uses brightness of the color to create a vignette-like mask. The white portion of the graphic 
will become transparent and the black portions of the graphic will use the background color. 
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Blend 
Move the Blend slider to the right to increase the presence of the watermark while 
decreasing the presence of the model. Move the Blend slider to the left to increase the 
presence of the model while decreasing the presence of the watermark. 

Position  
There are three options for positioning your watermark. The positioning options are: 

Stretched: Select the Stretched option to stretch the watermark across the drawing area. 
Check the Lock Aspect Ratio checkbox if you want the aspect ratio (height of image to width 
of image) to remain consistent such that the image is not distorted (the image might not fill 
the entire drawing area when aspect ratio is locked). 

Tiled: Select the Tiled option to create copies, or tiles, of the watermark and tile them across 
the drawing area. Move the Scale slider to the left to create progressively more, smaller, 
watermarks. Move the Scale slider to the right to create progressively fewer, larger, 
watermarks. 

Positioned: Select the Positioned option to position the watermark at one of nine pre-
defined screen locations. Check the radio button in the Position matrix that 
best represents the location on the screen where you want your watermark.Move the Scale 
slider to the left to create decrease the size of the watermark. Move the Scale slider to the 
right to increase the size of the watermark.  
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Scene Manager 
The Scene Manager is used to control the various features of SketchUp Scenes. Activate 
the Scenes dialog box from the  Window menu or from the scene tabs. 

The Scene Manger contains a list of all of the scenes for the model. Scenes in this list are 
displayed in the order in which they will be displayed when running a animation. 

 

Caution - Each scene has a series of properties that you can store with 
that scene (Properties to save). Additionally, when you update a scene, you 
can choose those properties, of the properties that are stored with the scene, 
to update (the dialog box that appears when the Update button is clicked). If 
you choose to update a property that you are not storing with a scene (using 
Properties to save), the property will not be updated. Therefore, it is important 
to ensure you have all of the properties you want to store with a scene 
checked prior to updating a scene. 

Scenes Manager Options 
 Add Scene 
The Add Scene button allows you to add a new scene to the current file. To add a scene: 

1. Click on the Add Scene button. A new scene, with a default scene name, is added to the 
list of scenes and a scene tab appears above the drawing area.  

2. (optional) Rename the default scene name to something that represents the view of the 
model that will appear in the scene. For example, if your scene contains a top-down view 
of the model, call the scene "Top." 

3. (optional) Provide a description of the scene. 

4. (optional) Unselect any properties you do not want to save with the scene.  
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Delete Scene 
The Delete Scene button allows you to delete a scene from the current file. Select the scene 
in the list of scenes and click the Delete Scene button to delete the scene. 

 Update Scene 
Use the Update Scene button to update a scene if you have made changes to the scene. To 
update a scene: 

1. Select the scene you want to update. 

2. Click on the properties, within Properties to save, to store with the scene. 

Caution - Each scene has a series of properties that you can store with 
that scene (Properties to save). Additionally, when you update a scene, you 
can choose those properties, of the properties that are stored with the scene, 
to update (the dialog box that appears when the Update button is clicked). If 
you choose to update a property that you are not storing with a scene (using 
Properties to save), the property will not be updated. Therefore, it is important 
to ensure you have all of the properties you want to store with a scene 
checked prior to updating a scene. 

3. Click on the Update Scene button. A Properties to Update dialog box appears. 

4. Click on the properties you want to update. Remember, you can only update those 
properties that you have previously selected to be stored with the scene. 

5. Click on the Update button. 

Include in Animation 
Use the Include in Animation option to indicate whether a scene should be used in the 
animation. Select a scene and check the Include in Animation option to include the scene in 
animation. Disable this option for scenes you want to work on but do not want in a 
animation. 

Name 
Click in the Name field to name the currently active scene.  

Description 
Click in the Description field to provide a short description or note for the currently active 
scene. 

Properties to Save 
The Properties to Save options are used to control the different properties that can be stored 
with each scene. Properties that are not checked in the Properties to save section cannot be 
updated with the Update button. 

Camera Location: Click on the Camera Location checkbox to store the point of view, 
including the zoom distance and field of view, with the scene. 

Hidden Geometry: Click on the Hidden Geometry checkbox to store 
the hidden geometry visibility with the scene.  

Visible Layers: Click on the Visible Layers checkbox to store the visible layers with the 
scene.  

Active Section Planes: Click on the Active Section Planes checkbox to store the active 
section planes with a scene. 
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 Tip - Use different section cuts in successive scenes to create exciting 
animations with different cross sections of your model. 

Drawing Style: Click on the Drawing Style checkbox to store the drawing style settings, 
such as edge rendering, with the scene.  

Shadows Settings: Click on the Shadows Settings checkbox to store all shadow-related 
information, including type, time, date, and so on, with the scene. 

Axes Location: Click on the Axes checkbox to store display and position of SketchUp's 
drawing axes with the scene. 

Details Arrow 
Click on the arrow in the upper-right portion of the Scene Manager dialog box to show or 
hide additional Entity Info details. 

  



 250

Shadows Dialog Box 
The Shadows dialog box is used to control SketchUp's Shadows feature, including display, 
time and date, and site location and orientation. You can also use the Shadows Toolbar 
control to control shadows. Activate the Shadow Settings dialog box from the  Window 
menu.  

 

 Note - Ensure you have set the proper location for your model set 
through the  Location panel of the Model Info dialog box for accurate shadow 
casting. 

 Note - Daylight savings time is not factored into shadow calculations. 

Shadows Options 
SketchUp contains a variety Shadow setting options allowing you to manipulate the use of 
shadows within your model. 

Display Shadows 
Click on the Display Shadows checkbox to toggle between displaying and not displaying 
shadows within your model.  

Time 
Use Time slider to adjust the time of day used by SketchUp to determine the location of the 
sun for shadow casting. The slider adjusts the time from sunrise to sunset, with 12:00 noon 
in the middle of the slider. Type a time into the time text field to set a precise time.  

Date 
Use the Date slider to adjust the day of the year used by SketchUp to determine the location 
of the sun for shadow casting. The slider adjusts the date from January 1st to December 
31st. Type a date into the date text field to set a precise day. You can specify the date in 
numerical form (11/8). 

Light 
Use the Light slider to control the intensity of the light in the model. (it lightens or darkens 
light). This option effectively lightens and darkens illuminated surfaces. 

Dark 
Use the Dark slider to control the intensity of light in the model. This option (it lightens or 
darkens shadows). This option effectively lightens and darkens the areas under shade and 
shadows. 
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On Faces 
Click on the Faces checkbox to enable casting of Face shadows. This feature makes 
intensive use of your 3D graphics hardware and can cause performance degradation. 

On Ground 
Click the On Ground checkbox to enable the casting of shadows on the ground plane (the 
red/green plane). 

From Edges 
Click the From Edges checkbox to enable the casting of shadows from edges that are not 
associated with a face. 

Details Arrow 
Click on the arrow in the upper-right portion of the Scene Manager dialog box to show or 
hide additional Entity Info details. 
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Layer Manager 
The Layer Manager is used to apply and manage layers in your model. Activate the Layers 
Manager from the Window menu. 

 
The Layers Manager displays all the layers and their associated visibility in the model. Every 
model has one layer, called Layer0, which will be visible the first time you activate the 
Layers dialog box. 

 Note - You cannot delete Layer0.  If you use any other layer as a 
drawing layer, all the entities that were created on that layer will become 
invisible when you hide that layer. This is not the case when hiding layer 0. 
Any entities that are on layer 0, but inside a group or component that is on 
another layer, will remain visible when you hide layer 0. 

Caution - Remember, layers in SketchUp do not work exactly like layers 
in 2 dimensional programs. Namely, entities drawn with one layer appear in all 
layers in SketchUp.  

Moving Geometry Between Layers 
To move geometry from one layer to another: 

1. Select the Select Tool. The cursor changes to an arrow. 

2. Select one or more entities. The selected entities are highlighted in yellow. 

3. Activate the context menu for the selected entities.  

4. Select the Entity Info menu item. The Entity Info dialog box appears. 

5. Select the layer for the entities from the Layers drop-down list. 

Layer Manager Options 
Add 
Click on the Add button to create additional layers. Enter the layer name (or press Enter or 
Return to accept the default name). Each new layer has a different color to help you 
distinguish layers. 

Delete 
Select a layer and click on the Delete button to delete a layer. You will be prompted to move 
entities on the deleted layer to another layer (the default or current layer) if there are entities 
unique to that layer.  
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Name  
The Name column lists all the layers, by name, in the drawing. The current layer has a 
check next to its name. Check the box next to a layer name to make it the current layer. 
Click on the name of a layer to edit the name of the layer. 

Click on the Name column header to sort the layer alphabetically. Click on the Name column 
again will reverse the order. You can select a multiple layers by dragging. You can also 
press the Ctrl key and click on layer names to selectively pick layers or press the Shift key 
and click to select a series of contiguous layers. 

Visible 
Click on the Visible checkbox to toggle the visibility of a layer. Click on the Visible column 
header to sort layers by visibility. Click again on the Visible column header to reverse the 
order. A hidden layer becomes automatically visible when you select the layer.  

Color 
The color column displays a color associated with each layer. Click on a layer and select a 
new color to change the color of the layer. Click on the Color column header to sort layers 
by color. Click again on the Color column heading to reverse the order. 

Details Menu 
Click on the right arrow next to the Delete button to open the details pop-up menu. This 
menu allows you to perform additional Layer Manager-related functions. 

Select All 
Select the Select All menu item to select all layers in the list of layers.  

Purge 
Select the Purge option to delete all unused layers (layers without any geometry). 

Color by Layer 
Select the Color by Layer menu item to apply materials to geometry on a per layer basis 
using the color associated with the layer. Ensure shaded or shaded with Textures display is 
turned on to view materials.  
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Soften Edges Dialog Box 
SketchUp's edges can be softened and smoothed to achieve a real-world appearance. 
Edges are automatically hidden when softened. Softened edges can also be smoothed 
rendering the adjoining faces with a smooth tonal gradient. The following series of images 
contains a column (lower part of each image) that is first softened (middle column) and then 
smoothed (right-most column). 

 

 Note - Softened edges are hidden automatically (but still exist in your 
model). Edges that are currently not visible will be displayed, along with any 
explicitly hidden geometry, when you enable the Hidden Geometry menu item 
on the View menu. 

Tip - Triple-click on geometry to ensure you have hidden and unhidden 
geometry selected before performing a soften or smooth operation. 

The Soften Edges dialog box allows you to automatically apply or remove softness and 
smoothing effects to the edges in your model. Activate the Soften Edges dialog box from the 
Window menu.  

 

Tip - There are a several components to achieving a desired result using 
soften and smoothing effects. Namely, detailed geometry require additional 
facets (such as a column having many small sides) to achieve a clean soften 
or smooth effect. However, additional detail can affect the computer's 
performance. Conversely, adding detail to portions of a model that will be seen 
at a distance is likely a waste of the computer's resources. A good strategy for 
creating useful models is to try to use the least amount of geometry in 
conjunction with soften or smoothing effect to achieve the desired result 
(whether it be a detailed close-up or a panoramic). 

Soften Edges Options 
SketchUp contains a few Soften Edges options allowing you to manipulate the use of 
softening within your model. 
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 Note - Edges that are shared by three or more faces cannot be 
softened. The following image shows an edge shared by three faces. 

 

Angle Between Normals 
Use Angle Between Normals slider to set the maximum size of all angles that will be 
smoothed or softened. The higher the setting, the more angles you are likely to smooth or 
soften with a smooth or soften command. Consequently, the higher the setting the more 
performance might degrade.  

Smooth Normals 
Click on the Smooth Normals checkbox to smooth any edges, essentially spreading color 
and texture over edges, to make the edges appear smooth. 

Soften Coplanar 
Click on the Soften Coplaner checkbox to soften edges, essentially deleting edges, between 
coplanar surfaces. 

Tip - Create a three dimensional multi-sided polygon (with more than 5 
sides) and experiment with these options to become familiar with softening 
and smoothing models. For example, create a 6-sided polygon, expand the 
polygon using the Push/Pull Tool, select the entire 3D polygon, click on 
Smooth Normals, and move the Angle Between Normals to 61 degrees. 
Notice that each edge of the polygon looks smooth because the angle 
between each normal is 60 degrees and, therefore, can be smoothed. Now 
move the slider to 59 degrees. Notice that the sides no longer look smoothed 
because the Angle Between Normals only operates on angles below or equal 
to 59 degrees. Experiment further by turning on the Soften Coplaner option to 
see edges appear and disappear.  
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Outliner 
The Outliner is used to view your Group and Component hierarchies as a hierarchical tree. 
This feature is great for navigating through large models, restructuring the model hierarchy, 
locating instances of a particular component, or renaming groups and components. Activate 
the Outliner dialog box from the Window menu. 

 

Traverse Component and Group Hierarchies 
The outliner contains a hierarchy view that reflects your hierarchy of components and 
groups in your model. To navigate a component or group hierarchy using the hierarchical 
view: 

1. Display the Outliner using the Window > Component menu item. The Outliner dialog box 
opens with a hierarchical view of your model. The Group and Component entities at the 
root (top-most) level of the hierarchy are displayed. An icon with a plus sign will appear 
next to any components or groups if additional levels in the hierarchy exists (additional 
groups or components within the top-level groups or components).  

2. Click on the plus (+) icon to list groups or components within other groups or components. 
Or, optionally, click on the Outliner's Details Menu and select the Expand All menu item to 
expand the hierarchy so all levels are displayed. 

3. Click on any group or component name in the hierarchical view to select the group or 
component in your model.  

4. (optional) Double-click on the group or component name in the hierarchical view to edit the 
group or component in your model.  

Identifying Entries in the Outliner Hierarchy 
The Outliner uses a combination of icons and text to identify groups and component status 
in a hierarchy.  

• Component - Four black squares 

• Group - One solid square 

• Locked Component - Four grey squares with small lock in lower right corner  
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• Locked Group - One grey square with small lock in lower right corner 

• Open Component - Four hollow squares 

• Open Group - One hollow square 

• Hidden Component or Group - Name of component or group is in italics 

Moving Items Within the Outliner 
Use the Outliner to reorganize groups and components in the hierarchy. For example, you 
can move a group, buried deep within the hierarchy, to the top of the hierarchy for easy 
editing. To move items within the outline: 

1. Display the Outliner using the Window > Outliner menu item. The Outliner dialog box 
opens with a hierarchical view of your model. The Group and Component entities at the 
root (top-most) level of the hierarchy are displayed. An icon with a plus sign will appear 
next to any components or groups if additional levels in the hierarchy exists (additional 
groups or components within the top-level groups or components). 

2. Click on the plus (+) icon to list groups or components within other groups or components. 
Or, optionally, click on the Details Menu and select the Expand All menu item to expand 
the hierarchy so all levels are displayed. 

3. Click and hold on the group or component you want to move in the hierarchy. 

4. Move the group or component to a new position in the hierarchy. 

Filtering Groups and Components in the Hierarchical View 
The Outliner contains a Filter field for displaying only those groups or components 
containing a specific filter string. This feature helps you to locate only like components or 
groups. To filter items within the Outliner: 

1. Display the Outliner using the Window > Outliner menu item. The Outliner dialog box 
opens with a hierarchical view of your model. The Group and Component entities at the 
root (top-most) level of the hierarchy are displayed. An icon with a plus sign will appear 
next to any components or groups if additional levels in the hierarchy exists (additional 
groups or components within the top-level groups or components). 

2. Type a string in the Filter field.  

3. Click on the plus (+) icon to list groups or components within other groups or components. 
Or, optionally, click on the Details Menu and select the Expand All menu item to expand 
the hierarchy so all levels are displayed. Items containing the filter string will be listed, in 
red, in the hierarchical view. 

Name Groups and Components Within the Outliner 
The Outliner displays groups by their group names and components by a combination of the 
definition and specific instance name.  

Naming a Component Definition 
As mentioned in the previous paragraph, components are identified in the outliner by a 
combination of their instance and definition names (the definition name is enclosed in less-
than and greater-than symbols). For example, Jim's Office <Cubicle Style 1>. Where you 
may have several Cubicle Style 1 components in your model, but only one instance 
represents Jim's Office. 

The component definition name generally refers to type of component, such as a certain 
type of cubicle (Cubicle Style 1) or certain type of video camera (VideoX 8mm camera). This 
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name can either be established when the component is first created, or you can accept the 
default (Component#X, X being some number) and rename the component definition using 
the outliner. To rename the component definition: 

1. Context-click on the component in the Outliner. The context menu for the Component 
entity is displayed. Notice that this is the same context menu as the context menu 
displayed when you context-click on an entity in the drawing area (except this context 
menu has a Rename menu item). 

2. Click on Entity Info menu item. The Entity Info dialog box is displayed. 

3. Click on the Definition tab to display information about this component's definition. 

4. Type a new name in the definition's name field. 

5. Click outside of the Entity Info dialog box to save your change.  

Naming a Component Instance 
A component instance name is useful when you want to differentiate different component 
instances from each other in the Outliner (the default name for all component instances is 
"Component"). For example, you might want to have different instance names if several 
chairs are all from the same definition in your model. To rename the component instance: 

1. Context-click on the component in the Outliner. The context menu for the Component 
entity is displayed. Notice that this is the same context menu as the context menu 
displayed when you context-click on an entity in the drawing area (except this context 
menu has a Rename menu item). 

2. Select the Rename menu item 

3. Type the new component instance name in the Outliner.  

4. Press Return to save your change. 

 Note - You can also use the Name field at the top of a component's 
Entity Info dialog box to rename component instances. 

Tip - Use instance names to differentiate different instances of the same 
definition in your model. This tip is particularly useful if you want to easily 
locate a specific component instance in the outliner.  

Naming a Group 
You can also name your groups for easy identification in the Outliner. To rename a group: 

1. Context-click on the group in the Outliner. The context menu for the Component entity is 
displayed. Notice that this is the same context menu as the context menu displayed when 
you context-click on an entity in the drawing area (except this context menu has a Rename 
menu item). 

2. Select the Rename menu item 

3. Type the new component instance name in the Outliner.  

4. Press Return to save your change. 

Details Menu 
Click on the right arrow next to the Filter field to open the details pop-up menu. This menu 
allows you perform additional Outliner-related functions. 
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Expand All 
Select the Expand All menu item to expand (open all branches) the entire hierarchical view 
in the Outliner.  

Collapse All 
Select the Collapse All menu item to collapse (close all branches) the entire hierarchical 
view in the Outliner. 

Sort by Name 
Select the Sort by name menu item to toggle the sorting of the groups and components 
alphabetically. 
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Fog Dialog Box 
 Fog is primarily used as a special effect during presentations. Click on the Fog menu item 
within the Window menu to display the Fog dialog box. 

 

Setting Fog 
Use the Fog dialog box to apply Fog-like effects to your model. To apply Fog: 

1. Check the Enable Fog checkbox. Fog might appear around your model (depending on 
your view of the model and the settings of the fog sliders). 

2. Adjust the sliders. See Adjusting the Fog Sliders for further information. 

 Note - Fog sliders will move automatically when you change your point 
of view, such as when you zoom in or zoom out. As with real fog, the geometry 
will become more clear as you zoom closer to it, and less clear as you move 
away. 

Fog Options 
There are a few options in the Fog dialog box for configuring fog. 

Display Fog 
Check the Display Fog checkbox to display fog in the drawing area. Uncheck the Display 
Fog checkbox to hide fog. 

Fog Sliders 
The left-most fog slider determines where you want the fog to start relative to the camera 
(your view). Fog can begin right in front of the camera which is zero on the scale or further 
away from the camera. Move the left-most slider to the right to start fog somewhere beyond 
the camera. 

The right-most slider determines where you want the fog to be at 100% strength 
(known as zero visibility). Move the right-most slider to the left to establish 
100 percent strength closer to the camera (your view). Move the right-most slider all the way 
to the left to have zero visibility right in front of the camera and extending out to infinity (you 
wont actually be able to see your model at all and at any distance). 

Use Background Color 
Check the Use background color checkbox to use the currently configured background color 
as the fog color. Refer to the Background Panel section of the Styles Browser topic for further 
information on setting the background color. 
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Uncheck the Use background color and click on the color swatch to select a different color to 
be used as the fog color. 

  Note - Use the OpenGL panel in the Application Preferences dialog box 
to set hardware acceleration before using fog.   
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Match Photo Dialog Box 
 The Match Photo dialog box controls are used to help you create accurate 3D models from 
photos and to accurately place models in a photo's context. This dialog box is only relevant 
during matching. Activate the Match Photo dialog box from the Window menu. Refer to the 
Match Photo dialog box section of the Matching Photos and Models topic for further 
information. 
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Instructor 
The Instructor dialog box displays information related to the currently selected tool. Click on 
a tool in the toolbar or menu to view information about that tool in the instructor. Click on 
links in the instructor to navigate to sections in the online SketchUp User's Guide. 
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Application Preferences Dialog Box 
SketchUp's application preferences are used to set various global behaviors for SketchUp. 
Activate the Preferences from the SketchUp menu. 

Compatibility 
Use the Compatibility preferences panel to identify component and group highlighting and 
mouse wheel setting preferences. 

Mouse Wheel Style 
Google EarthInvert: Click the Google Earth checkbox to change SketchUp scroll wheel 
behavior to match Google Earth scroll wheel behavior (rolling forward zooms out, rolling 
backward zooms in). 

Component/Group Highlighting 
Bounding box only: Click the Bounding box only checkbox to toggle between displaying 
only one bounding box or displaying a bounding box for each component and it's 
corresponding edges when selected. 

Drawing 
Use the Drawing preferences panel to define global mouse (or other input device) behavior. 

Click Style 
The Click Style options allows you to define how your input device reacts to clicks. 

Click-drag-release: Click the Click-drag-release radio button to force the  Line Tool to draw 
by click and holding the mouse button to define the start point of the line, dragging the 
mouse to extend the line, and releasing the mouse to establish the end point of the line.  

Auto Detect: Click the Auto Detect radio button to use either Click-drag-release and Click-
move-click as necessary.  

Click-move-click: Click the Click-move-click radio button to force the  Line Tool to draw by 
clicking and releasing the mouse button to define the start point of the line, moving the 
mouse to extend the line, and clicking again to establish the end point of the line.  

Continue Line Drawing: Click the Continue line drawing checkbox to force the  Line Tool to 
treat an end point as the start point of a new line, saving you one extra click required 
establish a new start point for the second line.  

Miscellaneous 
The Miscellaneous options define other global mouse behaviors. 

Display crosshairs: Click the Display crosshairs checkbox to display a set of colored 
crosshairs (corresponding to axes colors) when drawing. 

Auto-activate paint tool: Click the Auto-activate paint tool checkbox to automatically 
activate the Paint Bucket Tool after you select a color swatch. 

Extensions 
Use the Extensions preferences panel to add or remove SketchUp extensions from the user 
interface. An extension can be an add-on tool or feature created by Google that is not 
necessarily a part of core SketchUp functionality. 
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Click in the check box next to the extension that you want to enable in SketchUp. The 
extension will be available (menu items and optional toolbar) the next time your run 
SketchUp.  

General 
Use the General preferences panel to define global save and user interface settings. 

Create Backup 
Click on the Create Backup checkbox to automatically create a backup file whenever you 
save a drawing. The backup file is the previously saved version of the file. This file will be 
saved to the same folder as the drawing file. For example, if your drawing is hotel.skp, the 
backup will be called hotel.skb. 

Auto-Save 
Click the Auto-Save checkbox to automatically save changes to your drawing into a 
temporary file at specific time interval. This temporary file is available on the file system 
should SketchUp abnormally exit. Type the auto-save interval, in minutes, into the minutes 
field.  

The temporary file's name will be a combination of the word "AutoSave" with the original 
filename, such as AutoSave_hotel.skp. This file is saved in the  Autosave folder under 
<user>/Library/Application Support/SketchUp/Autosave if the model has never been saved. 
SketchUp puts the auto save file in the same directory as the model file. 

 Caution - Google strongly recommends you keep the Auto-Save option 
checked to ensure that your valuable work is retained.  

SketchUp checks your model for unrecoverable errors during the auto-save, preventing the 
overwriting of a good auto-save file. Sketchup will display a dialog box in the rare case that 
 unrecoverable errors are found in your model. This dialog box contain the option to quit 
SketchUp and send a report. Google recommends you click on the quit SketchUp and send 
report button to terminate SketchUp and preserve your previously valid auto-save file. This 
report contains valuable information regarding the unrecoverable errors.   

Tool Palette 
SketchUp has two differently sized Tool Pallets. The large tool buttons are easier for some 
users to see and use (they provide larger areas to click with your mouse) and are easier to 
use with a pen and tablet. Smaller buttons save screen space, allowing a larger drawing 
area.  

Use Large Tool Buttons: Click on the Use large tool buttons checkbox to toggle between 
large and small tool buttons. 

Main Window 
The Main Window options allow you to  set the behavior for the main SketchUp window. 

Cascade main windows: Click on the Cascade main windows checkbox to place newly 
created drawing windows lightly below and to the right (cascaded) of the previous drawing 
window. This feature is useful if you want to see all of your drawing window title bars. Newly 
created drawing windows will appear directly on top of each other when this option is not 
enabled. 

Save current window size: Click on the Save current window size button to save the 
window size for the currently active drawing window as the default size for SketchUp. 
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Check Model For Problems 
The Check Models for Problems options allow you to enable problem checking for your 
SketchUp models. 

Automatically check models for problems: Check the Automatically check model for 
problems checkbox to check for minor problems with your model. These problems can occur 
given the infinite flexibility that SketchUp provides when designing in 3D. Your model is 
assessed for problems when it is loaded or saved. Google strongly recommends checking 
this box to ensure that problems are corrected proactively, allowing your model to perform 
optimally. You must manually check for problems using the Fix Problems button in the  
Statistics panel of the Model Info dialog box if you leave this checkbox unchecked. 

Automatically fix problems when they are found: Check the Automatically fix 
problems when they are found checkbox to have SketchUp fix problems found in 
your model automatically (without having to display a dialog box). Leave this 
checkbox unchecked if you want SketchUp to display a dialog box (with the Always 
fix my models, Fix it now, and Fix it later options) when a problem is found. 

 
Scenes and Styles 
The Scenes and Styles options allow you to enable warnings for style changes. 

Warn of Style Changes When Creating Scenes: Click the Warn of style changes when 
creating scenes if you want to be notified when a style has changed when adding 
scenes to your file. 

OpenGL 
Use the OpenGL preferences panel to define how the OpenGL standard should be applied 
within SketchUp. 

 Note - You might notice intermittent streaks or small spots of light within 
face shadows. A minimal amount of these artifacts is to be expected on most 
systems, and can vary greatly with the quality of your OpenGL driver. 

Caution - Certain OpenGL drivers do not fully support casting shadows 
on faces.  

Caution - SketchUp's Shadow feature can have a severe performance 
impact on slower computers or those using software rendering. 

Acceleration 
The Acceleration options allow you to speed up OpenGL drawing. 

Use Hardware Acceleration: Click on the Use Hardware acceleration checkbox to use the 
hardware acceleration features of a video card.  Unfortunately, only a small percentage of 
3D drivers in the consumer video card market are 100% OpenGL compatible and can use 
this feature (though many cards claim to be 100% OpenGL compatible).  Most 3d drivers are 
designed for games, and are rarely tested using other 3D programs. Consequently, 
numerous incompatibility problems can occur requiring a fix from the video card 
manufacturer. Disable this option if you are having problems with the 3D rendering of your 
models or if your video card is not 100% OpenGL compatible and does not support 
hardware acceleration. 
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 Note - Hardware Acceleration might only be available on your system for 
certain resolutions and color depths.  Check the system settings for your 
graphics card to see if it supports hardware acceleration (using the  System 
Preferences on Macintosh OS X). 

Google cannot control the quality of the OpenGL driver on your computer system.  Video 
card device drivers are proprietary and are maintained solely by the manufacturer of the 
video card in your system.  Therefore, Google cannot guarantee that SketchUp will work 
with hardware acceleration on your system. Refer to the OpenGL topic for further 
information. 

Use Fast Feedback 
Check the Use fast feedback checkbox to increase performance when editing large models. 
SketchUp runs a test to assess whether your video card can support this option on startup. 
SketchUp will activate (check) this option if fast feedback is supported. You can also attempt 
to use this feature by checking the Use Fast Feedback checkbox manually, however you will 
be warned by SketchUp that enabling this option could cause problems on your system if 
fast feedback is not supported. 

Shortcuts 
Use the Shortcuts preferences panel to define keyboard shortcuts for most SketchUp 
commands.  

Assigning Keyboard Shortcuts 
Keyboard shortcuts can dramatically speed up your drawing by allowing you to change tools 
while keeping the mouse cursor near the drawing area. To assign a keyboard shortcut:  

1. Select the command to which you will assign a keyboard shortcut (within the Function list). 
Existing keyboard shortcuts for this command will display in the Key column. 

 Note - The list of commands available in the Shortcuts panel is 
dynamically generated and includes all menu items and active context menu 
items. Some context menu items become active only after performing another 
task. For example, select a face to activate the Reverse Faces command and 
then open Preferences > Shortcuts to set a keyboard shortcut for Reverse 
Faces. 

2. Type the keyboard shortcut key sequence In the text field at the bottom of the panel. 
Shortcut keys can consist of any keyboard key, except number keys, with a few 
exceptions. Any key that can be used as a shortcut can also be assigned a modifier key 
like Shift, Control, or Alt. SketchUp will indicate when a key or key combination cannot be 
used or is already assigned. 

SketchUp will prompt you before allowing you to assign a keyboard shortcut that is already 
assigned to  another command. Some keys are reserved for use by Microsoft Windows and 
can not be assigned as a keyboard shortcut. 

 Note - Keyboard shortcuts are saved  to Home/Library/Application 
Support/SketchUp/Shortcuts.plist. You can copy this file to other users or 
computers. 

The VCB and Keyboard Shortcuts 
Temporary focus is given to the VCB when you type a number while in the drawing area. 
Therefore, numbers cannot be used as shortcut keys. The letters S, R, X, and the symbols / 
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and * can be used within keyboard shortcuts and as you enter values in the VCB. Prepend 
any of these letters with a number in the VCB to ensure that a command with a 
corresponding keyboard shortcut letter is not invoked. For example,  7s would be the correct 
entry to redefine a segmentation in the VCB. However, s7 will activate whatever command is 
invoked with the letter S as a keyboard shortcut. 

Tip - Do not use the spacebar or backspace keys as keyboard shortcuts 
to avoid conflict with values entered in the VCB. 

Template 
Use the Template preferences panel to designate a SketchUp file that you would want to 
use as a template for all of your subsequent models.  

Creating a Template 
A template file contains default settings from the Model Info dialog box and base geometry. 
To create a template: 

1. Select File > New menu item to start a new SketchUp file. 

2. Modify the Model Info settings to fit your particular needs. For example, you might want to 
set default units and snaps, activate a ground plane, and set a geographic location. 

3. Modify the Preference settings to fit your particular needs.  

4. (optionally) Draw any geometry that you want to share among all of your models. For 
example, you might want all of your models of houses to be created within the same 
starting terrain (such as when you are creating models of houses within a housing 
development). 

5. Select File > Save to save the SketchUp file. Save this file in the Templates directory 
(under the ~/Library/Application Support/SketchUp/Templates directory) if you want this file 
to appear in the drop-down list of templates within the Preferences dialog box. 

Automatically Loading a Template 
You can load a template SketchUp file manually using File > Open every time you want to 
create a model. Or, you can identify a file as a template using the Template section of the 
Preferences dialog box to load the template automatically when you run SketchUp.  

Select a template from the list of templates to load a template (if your SketchUp template file 
is in the Templates directory). Click the Browse button to locate templates that do not 
appear in the drop-down list. 

Your template will load every time you run SketchUp. 
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Entities 
This section of the user's guide covers the various entities used to construct a model in 
SketchUp. These entities include faces, arcs, dimensions, and lines.  

Entities are covered in alphabetical order. 
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3D Polyline Entities 
SketchUp's 3d Polyline entities are curve-like entities that do not generate inference snaps 
or affect geometry in any way. Freehand sketches are usually used for tracing imported 
drawings, 2D sketching, or for decorating your model.  

Draw 3D Polyline entities with the Freehand Tool.  

 Note - You can explode a freehand sketch into regular edge segments 
using the Explode context menu item (see the 3D Polyline Context Menu 
Items section later in this topic). 

 Note - A 3D Polyline looks just like a Curve entity, but is thinner. 
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Arc Entities 
Arc entities are a combination of multiple line segments connected together to approximate 
the curvature of the arc. These entities act as a single line in that they can define the edge of 
a face and also divide a face. Additionally, selecting one segment of the arc selects the 
entire Arc entity. However, all inference techniques will operate on the Arc as though it were 
comprised of segments. For example, every point on the arc is inferred as an endpoint of the 
segment. Draw Arcs with the Arc Tool. 

 Note - You can explode a arc into regular edge segments using the 
Explode Curve context menu item (see the Arc Context Menu Items section 
later in this topic). 

Arc entities are comprised of a length (also called the base chord), bulge, radius, and 
number of segments. The following image shows an Arc entity. 

 

 Note - Arc and  Circle entities are special in that they automatically 
produce softened edges when extruded using the  Push/Pull Tool. 

Editing an Arc Entity 
You can edit the radius of an Arc entity by using the Move Tool. To edit an Arc entity: 

1. Select the Move Tool. The cursor will change to an four-way arrow. 

2. Move over the Arc entity to locate the midpoint of the Arc entity.  

3. Click and hold on the midpoint of the Arc entity. 

4. Move the cursor to adjust the bulge of the Arc entity. 

  

 
5. Click and hold on the starting or ending point of the Arc.  

6. Move the mouse to adjust the radius and length of the arc entity. The radius attempts to 
stay proportional to the base chord length. 

You can also adjust the radius and number of segments using the Arc entity's Entity Info 
dialog box. 
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Editing an Extruded Arc 
When you use the Push/Pull Tool to extrude a 2D face that includes an arc, it extrudes a 
special arc  Surface entity which can also have its radius edited. Use the  Move Tool to 
reposition the midpoint edge, and the arc curved face set (as well as the midpoints of the 
two arc entities that define it) will move accordingly. 

 

Arc Segmentation 
Arcs with more line segments appear to have smoother curvature than arcs with fewer line 
segments. However, more line segments increases the size of your model and degrades 
performance. You can often achieve acceptable results by indicating small segmentation 
and using smoothing and edge softening to create the impression of smoothness. 

Arc Deformation 
If an Arc is deformed in a way that destroys its radial definition, such as with a non-uniform 
scale operation, it will become a non-parametric Curve entity. Polyline Curves can no longer 
be edited as arcs. 
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Circle Entities 
Circle entities are a combination of multiple line segments that are connected together to 
form a circle. These entities act as a single line in that they can define the edge of a face 
and also divide a face. Additionally, selecting one segment of the arc selects the entire 
Circle entity. However, all inference techniques will operate on the Circle as though it were 
comprised of segments. For example, every point on the circle is inferred as an endpoint of 
the segment. Draw circles with the Circle Tool. 

 Note - You can explode an Circle into regular edge segments using the 
Explode Curve context menu item (see the Circle Context Menu Items section 
later in this topic). 

Circle entities are comprised of a radius and number of segments. The following image 
shows a Circle entity with 24 segments. 

 

 Note - The model in the previous image contains two entities: a Face 
entity (in the middle) surrounded by a Circle entity (the circular edge). 

 Note -  Arc and Circle entities are special in that they automatically 
produce softened edges when extruded using the  Push/Pull Tool. 

Editing a Circle Entity 
You can edit the radius of an Circle entity, that does not yet bound a face, by using the Move 
Tool. To edit an Circle entity: 

1. Select the Move Tool. The cursor will change to an four-way arrow. 

2. Move over the Circle entity to locate one of the four cardinal points of the Circle entity.  

 
3. Click and hold on the cardinal point of the Circle entity. 

4. Move the cursor to adjust the radius of the Circle entity. 
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You can also adjust the radius and number of segments using the Circle entity's Entity Info 
dialog box. 

Tip - The  inference engine sometimes can get distracted, preventing it 
from snapping to the center of a circle. You can encourage a center point 
inference by hovering the mouse cursor over the edges of the circle and then 
moving it towards the center point. 

Editing an Extruded Circle 
When you use the Push/Pull Tool to extrude a 2D face that includes a circle, it extrudes a 
special cylindrical  Surface entity which can also have its radius edited. Use the  Move Tool 
to reposition one of the four cardinal edges, and the cylindrical curved face set radius (as 
well as the radii of the two circle entities that define it) will be adjusted accordingly. 

 

Circle Segmentation 
Circles with more line segments appear to have smoother curvature than circles with fewer 
line segments. However, more line segments increases the size of your model and 
degrades performance. You can often achieve acceptable results by indicating small 
segmentation and using smoothing and edge softening to create the impression of 
smoothness. 

Circle Deformation 
If an Arc is deformed in a way that destroys its radial definition, such as with a non-uniform 
scale operation, it will become a non-parametric Curve entity. Polyline Curves can no longer 
be edited as arcs. 
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Component Entities 
Components are entities that can hold other entities. Components are similar to Group 
entities, but they are commonly used to combine several entities as a single entity for the 
purposes of reuse in multiple models. Use the Make Component menu item from the  Edit 
menu to create a component from the currently selected entities. 

 

Creating a Component 
Components are useful for creating reusable models to be placed within other models. The 
most important issue to consider when creating components is how you want them to be 
placed when inserted into the model from the Component Browser. The component axes will 
dictate both component orientation on insert and cutting plane (for components that are to 
automatically cut holes in faces, such as windows). To create a component: 

1. Select the Select Tool. The will change to an arrow. 

2. Click and hold the mouse button a short distance away from the entities you want to select 
to start a selection box.  

3. Drag the mouse to the opposite corner of the selection starting point. 

4. Release the mouse button when all of the elements are either partially included (left-to-
right selection) or fully included (right-to-left selection) in the selection box. 

  

 
5. Select the Make Component menu item from the Edit Menu. Alternatively, context-click on 

the currently selected entities and select Make Component from the context menu. The 
Create Component dialog box is displayed.  
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6. Fill out the fields in the dialog box. Ensure you make all of the appropriate selections and 

check all of the appropriate boxes before continuing. Specifically, decide whether the 
component should glue to faces in a specific orientation and cut openings. See The Create 
Component Dialog Box for further information. 

7. Click the Create button. SketchUp adds the newly created component to the In Model 
Component Library. 

 

 Note - The Make Component operation disconnects any geometry that 
was connected to selected geometry prior to placing the selected geometry in 
the component. The disconnected geometry is maintained outside of the 
component's context. 

 Note - You can make component hierarchies by grouping other 
Component entities within a component. Additionally, you can mix your 
hierarchies by including components and groups within other components and 
groups.  

Tip - Create components that can be attached or glued to a surface in 
context (on a surface) to ensure that the cutting plane is established correctly. 
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The Create Component Dialog Box 
The Create Component dialog box is displayed when you attempt to create a component 
using the Make Component menu item.  

General 
Name: The Name field can contain the name of the component definition. All component 
definitions must have a name.  

Description: The Description field can contain a description of the component. 

Alignment 
Glue to: The Glue to drop-down list is used to identify the faces where your 
component can be placed when initially placed from the Component Browser. For 
example, a standard door might only be glued to faces in the horizontal (blue) plane. 
A grey gluing plane guide will appear when a specific gluing plane is selected. This 
plane represents exactly where the component will orient to a face and cut into a face. 
The following image shows a window component during component creation. Notice 
that the gluing plane (the grey plane) is parallel to the red/green plane and bottom of 
the window). This window component was also set to glue to vertical surfaces. 

 
The following image shows what occurs when the previously mentioned window component 
is placed, from the Component Browser, against a vertical surface. Notice that the window 
meets the vertical face at the window's bottom because it was created with a gluing plane 
that is parallel to the bottom of the window.  
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Usually you want windows and doors to have a gluing plane that is parallel to the front or 
back of the window or door (not the bottom). You might need to reorient the component's 
axes at creation, using the Set Plane button, to properly set the gluing or cutting plane. 

Set Gluing Plane: The component axis defines how the component inserts and aligns to 
other geometry or to the camera. The component axis also defines the cutting plane by the 
orientation of the red/green plane. The Set Plane option is used to specify a different origin 
for the Component and to modify the orientation of the component when it is placed. To set 
the origin and plane of a component: 

1. Follow the steps 1 through 5 in the Creating a Component section of this topic.  

2. Select Show Component Axes in the Components Panel of Model Info dialog box to see 
the existing axes on a Component before using the set plane option to move the axes.  

3. Click on the Set Plane button. The cursor changes to an arrow with axes attached to it. 

4. Click on a location of the component to set the origin of the component's axes. The origin 
and insertion point is now set to this location.  

 Note - When you change the axes you change the orientation of the 
component when dragged from the Component Browser and the cutting plane. 
By default, the component's axes are placed as though the component will be 
inserted from the Component Browser in the exact orientation as the 
component is in while you create the component. Generally, you will not want 
to change this orientation unless, for example, you are creating a window 
component independent of other geometry and in the vertical plane (blue). In 
this case, the bottom of the window will be on the red/green plane. The 
red/green plane is the gluing and cutting plane. As such, this window's bottom 
will therefore want to align and cut into a face when placed in the model from 
the Component browser. As mentioned previously, however, it is best to 
create window and door components within the context of a surface type 
where they will ultimately be placed, such as a wall, so you do not have to 
reorient the axes. Follow the last two steps in this list if you need to reoriented 
the component axes. 

5. (optional) Move the mouse around the origin to redefine the orientation of the component. 
The axes of the component will rotate suggesting a new orientation for the component. 
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The cut plane will also move to represent where the component will cut into a face when 
placed vertically or horizontally. For example, if you rotate the axes such that red is up and 
green is to the left, the component will be inserted horizontally to its orientation when 
created. The following image shows a window component during component creation. The 
component's axes have been reoriented such that the cutting plane is now parallel to the 
front of the window. 

 
6. (optional) Click to set the new orientation.  

Cut Opening: The Cut Opening option allows the Component to create openings in the face 
onto which it is placed. For example, a door or window component might be set to cut an 
opening in any wall where instances of the component are placed.  

 Note - There must be edges along the cutting plane of the component to 
cut a hole in a face. 

Always face camera: The Always face camera option allows the component to take on 
billboard behavior by drawing the component as a 2D form. This option increases 
performance by eliminating the need to render the component as a 3D model. 

 Note - Components with the Always face camera option enabled cannot 
have gluing behavior. 

Shadows face sun: This option is only available when the Always face camera option is 
enabled. The shadows face sun option causes the shadow to be cast from the component's 
current position as though the component were facing the sun. The shadow shape does not 
change as the component rotates to face the camera. This option works best with 
components that have short bases (such as trees). This option does not work well with 
components that have wide bases (such as people in mid stride).  

 Note - Ensure the component's axis is positioned at the bottom center of 
the component for best results. 

Uncheck this option to cause the shadow to be cast from the component's current position. 
The size of the shadow changes based on view point.  



 280

Replace selection with component: The Replace selection with component option causes 
the currently selected entities to be turned into a Component instance. Uncheck this option 
to create a component definition in the Component Browser without creating a component 
instance from selection set.  

Component Definitions and Instances 
A Component Definition and a Component Instance are created when a component is 
created using the Create Component dialog box. Components Definitions define or provide 
a blueprint for how all components of a specific type, called instances, appear and behave 
within the drawing area (whether they can be glued to faces, where insertion points appear, 
and so on). Component Definitions are represented by thumbnail images in the Component 
Browser.  

Component Instances are components definitions that have been inserted in the drawing 
area (called instancing). Component Instances all look like and have the same default 
behavior as the Component Definition, but, once brought into the drawing area, can be 
rotated, scaled, and painted independently of other instances.  

Inserting Components 
There are a variety of different ways to insert component instances in SketchUp. 

Inserting Components from Component Browser 
Pre-defined Components are most often inserted from the Components Browser into a 
model. See the  Component Browser for further information.  

Insert a Component From an External SketchUp (.skp) File 
You can also insert a component from an external SketchUp file. To insert a component 
from an external SketchUp file: 

1. Select the File > Import > 3D Model menu item. The Open file dialog box appears.  

2. Select the type of file to import from the Format drop-down list (.skp). 

3. Click Open. The cursor changes to the Move Tool anchored to the component's insertion 
point. 

Tip - The component axes origin is the default insertion point for a 
Component. Change the location of the component's axes before you insert 
the component to change the default insertion point. 

4. Move the mouse to the location in the Drawing area where you want to place the 
component. 

5. Click the mouse button again to release the component.  

Insert a Component From the Finder. 
Finally, you can also insert a component from the Finder. To insert a component from the  
Finder: 

1. Locate the icon representing the file you want to insert. 

2. Click and hold the mouse button on the icon. 

3. Drag the icon into the drawing area. The cursor changes to the Move Tool anchored to the 
component's insertion point. 
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Tip - The component axes origin is the default insertion point for a 
Component. Change the location of the component's axes before you insert 
the component to change the default insertion point. 

4. Release the mouse button to place the component into your model. 

Editing a Component Instance as a Whole 
You can edit the component as a whole or edit individual entities within a component. 
Editing or modifying the component instance as a whole affects only the component 
instance, not the component definition or other instances. 

Scaling a Component 
Scaling a component as a whole scales the individual component instance, not the 
component definition, allowing you to have many differently scaled instances of the same 
component in your model. 

A component can become skewed when you scale the component in multiple directions. 
You can reset both a components scale and skew using the Reset Scale and Reset Skew 
context menu items. 

Flipping a Component 
You can flip (or mirror) a component along its axes using the Flip Along component context 
menu item. Choose Component's Red, Component's Blue, or Component's Green 
depending on the direction to flip the component.  

Rotating a Component Using the Move Tool 
Components can be rotated using either using the Move Tool or Rotate Tool. The first 
rotation method rotates the component about its center of mass and in the planes of the 
component bounding box. The second rotation method allows you to specify precise rotate 
planes and center of rotation. See the Rotate Tool for further information on this second 
rotation method. To rotate a component using the Move Tool: 

1. Select the Move Tool. The cursor will change to a four-way arrow. 

2. Move the cursor over a face that is perpendicular to the desired axis of rotation. Four 
rotation handles and a protractor appear on the face.  

3. Click on a rotation handle  

4. Rotate the Component.  

Editing Entities Within a Component Instance 
Editing the entities within a component requires you to enter the component's context. 
Editing or modifying the entities within a component instance affects the component 
definition and other instances of the component. To edit the entities within a component: 

1. Select the Component Instance > Edit Component command from the Edit Menu to edit 
the component. Alternatively, context-click on the currently selected component and select 
Edit Component from the context menu. An edit bounding box will surround the component 
and entities exterior to the component will turn grey. 

Tip - Double-click on the component to edit the component.  

2. Make changes to entities within the component. Any changes while in the context of the 
component affects each component instance and the component definition. You can also 
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perform inference alignments to geometry outside of the component while you are editing 
the component. 

3. Select the Close Group / Component command from the Edit Menu to end the edit 
session. Alternatively, context-click on the component's bounding box and select Close 
component from the context menu. 

Tip - Click outside of the component to close the component.  

Video -  A video tutorial on this topic is available at 
http://www.sketchup.com/training/tutorials.php 

Exploding a Component 
You can explode a Component entity to break it back into its original entities. To explode a 
component: 

1. Select the Select Tool. The will change to an arrow. 

2. Select the component you want to explode. 

3. Select the Component Instance > Explode command from the Edit Menu. Alternatively, 
context-click on the currently selected group and select Explode from the context menu. 
The Component will be split back into its entities. 

Elements within components that were placed adjacent to other geometry might become 
joined to elements exterior to the component when the component is exploded.  

Applying Materials to Components 
Any geometry inside a component that is painted with the default material will be painted 
when you paint the instance as a whole. Therefore, you can have entities within a 
component painted individually while other elements painted using the material assigned to 
the entire component. The following image contains four cars all enclosed in components. 
The tires, bumper, and windshield have been painted black when editing the component. 

 
Each entire component instance was then painted after being edited, turning each of the 
faces with the default material to the color applied on the group (green, blue, red, and yellow 
from left to right): 

 



 283

Moving the Insertion Point 
The Component Browser switches the insertion point from the origin of the component's 
axes to another point on the component when you use the Move Tool to select a 
component, that is already in your model, using a different (non-origin) point. For example, if 
you have a 3d rectangle component, the origin and insertion point will be the lower left-hand 
corner. However, if you insert this component and then move it by a midpoint, the insertion 
point changes to the mid point (while the origin remains at the lower left hand corner).  

This feature is useful when aligning components, such as cabinet components in a kitchen. 
Consider the following: 

1. Insert one kitchen cabinet component with the insertion point at the lower left corner of the 
component. 

2. Insert a second instance of the same cabinet to the left of the previously inserted cabinet 
(so that the two cabinets touch). Notice that it is hard to accurately place the second 
cabinet because the insertion point is at the origin at the lower left corner of the component 
(away from where the two cabinets will touch). 

3. Reposition the second kitchen cabinet away from the first.  

4. Select the Move Tool and click the lower-right corner of the second kitchen cabinet 
component. 

5. Now move the second kitchen cabinet such that it is aligned on the left-side of the first 
cabinet. This process should be easier now that the insertion point has been moved to the 
lower-right corner of the component. If you drag a third instance of the same cabinet into 
the model, the insertion point will now be at the lower-right corner (making it easier to 
place more cabinets to the left of each other). 

Resetting Component Axes 
Context-click on the component in the component browser and select Reset Insert Point if 
you want to reset the insertion point to the origin of the component's axes. 
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Curve Entities 
SketchUp's Curve entities are a combination of multiple line segments that are connected 
together. These entities act as a single line in that they can define the edge of a face and 
also divide a face. Additionally, selecting one segment of the curve selects the entire Curve 
entity.  

Draw curves with the Freehand Tool. 

 Note - You can explode a curve into regular edge segments using the 
Explode Curve context menu item (see the Curve Context Menu Items section 
later in this topic). 

The following image contains a Curve entity. Curves can begin and end at the same point 
(as in the following image) or start and end at different points. 

 

 Note - The model in the previous image contains two entities: a Face 
entity (in the middle) surrounded by a Curve entity (the continuous edge). 

  

Editing a Curve Entity 
You can change the length of a Curve entity, that does not yet bound a face, by using the 
Move Tool. To edit a Curve entity: 

1. Select the Move Tool. The cursor will change to an four-way arrow. 

2. Move over the Curve entity to locate an endpoint of the Curve entity.  

3. Click and hold on the endpoint of the Curve entity. 

4. Move the cursor to adjust the length of the Curve entity. 
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Dimension Entities 
Dimension entities are finite lines with length information allowing you to quickly and 
effectively communicate key dimensions of your model. Dimensions can move and update 
automatically as you make changes to your model. Draw dimensions with the Dimension 
Tool. 

 
Each Dimension Object lies in its own plane, which is determined by the entity from which it 
is drawn and the direction used when it was created. 

Dimension display properties, for all dimension entities in your model, can be adjusted using 
the Dimension panel of the Model Info dialog box. 

Changing Dimension Text 
A Dimension entities text displays the dimension by default. You can, however, change the 
dimension text to include additional information, such as text. Include the symbols <> 
anywhere in your text to insert the dimension. For example, "The length of this line is <>." 

Caution - Dimensions that have lost their direct link to geometry or that 
have had their text edited might not show accurate measurements. Select the 
Highlight non-associated dimensions option in the  Dimension panel of the 
Model Info dialog box to highlight these dimensions in a specified color. 
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Face Entities 
Face entities are flat plane-like entities that combine to form the 3D geometry in a SketchUp 
model. Faces are automatically created when any three or more intersecting lines or edges 
are in the same plane (an infinite flat 2D space), or coplanar. 

The edges that bound a face remain when you delete a face. However, a face is erased 
automatically when you delete one of its bounding edges. SketchUp will create new edges 
and faces using the Auto-fold feature if you alter one of the edges of a face so that it is no 
longer co-planar with that face. 

Draw faces with the Line Tool,  Arc Tool,  Freehand Tool,  Rectangle Tool,  Circle Tool, or  
Polygon Tool. The following image was created simply by joining arcs and lines to form the 
edges and subsequent faces. 
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Guide Line Entities 
Guide Line entities are infinite dashed lines used as guides to draw precisely. Guide Lines 
do not interfere with regular geometry. Guide lines can also be hidden and erased 
independent of regular geometry. Draw guide lines with the  Tape Measure Tool. 

You can use the Move,  Rotate, and  Erase Tools to reorient a guide line. But, you cannot 
resize a guide line because guide lines are infinite in length.  

Hiding/Erasing All Guide Lines 
Guide lines are usually created as a temporary means to build a portion of your model. 
Keeping too many guide lines in your model can decrease SketchUp's inference accuracy 
and display performance, so you might want to hide guide lines as you work or delete all 
guide lines at once when you have finished your model. 

Use Edit > Hide to hide the currently selected guide line. Use Edit > Erase Guides to erase 
all guides in the current context.  
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Guide Point Entities 
Guide Point entities are finite dashed lines with end points as guides to draw precisely. 
Guide points do not interfere with regular geometry. Guide points can also be hidden and 
erased independent of regular geometry. Draw guide points with the  Tape Measure Tool. 

You can use the Move,  Rotate, and  Erase Tools to reorient a guide point.  

Hiding/Erasing All Guide Points 
Guide points are usually created as a temporary means to build a portion of your model. 
Keeping too many guide points in your model can decrease SketchUp's inference accuracy 
and display performance, so you might want to hide guide points as you work or delete all 
guide points at once when you have finished your model. 

Use Edit > Hide to hide the currently selected guide line. Use Edit > Erase Guides to erase 
all guides in the current context.  
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Group Entities 
Groups are entities that can hold other entities. Groups are commonly used to combine 
several entities as a single entity for the purposes of performing a quick operation with the 
combination (such as a copy). Use the Make Group menu item from the Edit menu to create 
a group from the currently selected entities. 

Creating a Group 
Groups are useful for combining entities to perform a quick operation such as copy or move 
operations. To create a group: 

1. Select the Select Tool. The will change to an arrow. 

2. Click and hold the mouse button a short distance away from the entities you want to select 
to start a selection box.  

3. Drag the mouse to the opposite corner of the selection starting point. 

4. Release the mouse button when all of the elements are either partially included (left-to-
right selection) or fully included (right-to-left selection) in the selection box. 

  

 
5. Select the Make Group menu item from the Edit Menu. Alternatively, context-click on the 

currently selected entities and select Make Group from the context menu. The geometry 
you selected appears grouped within a highlighted bounding box. 

 

 Note - The Make Group operation disconnects any geometry that was 
connected to the grouped geometry prior to placing the geometry in the group. 
The disconnected geometry is maintained outside of the group's context. 

 Note - You can make group hierarchies by grouping other Group entities 
within a group. Additionally, you can mix your hierarchies by including 
components and groups within other components and groups.  
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Exploding (Ungrouping) a Group 
You can explode (ungroup) a Group entity to break it back into its original entities. To 
explode a group: 

1. Select the Select Tool. The will change to an arrow. 

2. Select the group you want to explode. 

3. Select the Group > Explode command from the Edit Menu. Alternatively, context- click on 
the currently selected group and select Explode from the context menu. The Group will be 
split back into its entities. 

Elements within groups that were placed adjacent to other geometry might become joined to 
elements exterior to the group when the group is exploded.  

Editing a Group 
Groups can be opened for editing, placing you in the Group's context. To edit a group: 

1. Select the Group > Edit Group command from the Edit Menu to edit the group. 
Alternatively, context-click on the currently selected group and select Edit Group from the 
context menu. An edit bounding box will surround the group and entities exterior to the 
group will turn grey. 

 

Tip - Double-click on the group to edit the group.  

2. Make changes to entities within the group. Any changes while in the context of the group 
only affects the Group entity. You can, however, perform inference alignments to geometry 
outside of the group while you are editing the group. 

3. Select the Close Group / Component command from the Edit Menu to end the edit 
session. Alternatively, context-click on the currently selected group's bounding box and 
select Close Group from the context menu. 

Tip - Click outside of the group to close the Group.  

Applying Materials to Groups 
Any geometry inside a group that is painted with the default material will be painted when 
you paint an unexploded group. Therefore, you can have entities within a group painted 
individually while other elements painted using the material assigned to the entire group. 
The following image contains four cars all enclosed in groups. The tires, bumper, and 
windshield have been painted black when editing the group. 
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Each entire Group entity was then painted after being edited, turning each of the faces with 
the default material to the color applied on the group (green, blue, red, and yellow from left 
to right): 
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Image Entities 
Image entities are essentially special groups consisting of a face with an applied bitmap 
image material. Image Objects can be moved, rotated and scaled. They can also be 
stretched horizontally or vertically, but they cannot be made non-rectangular. Import Images 
using the File > Import > 2D Graphic menu item. 

Image Formats 
SketchUp supports the following formats for import as an Image Object: JPEG,  PNG,  PDF, 
PICT, PSD, EPS, SGI, , and  TIFF. Some formats may be more appropriate than others for 
certain types of images and applications. 

Inserting Image Entities 
Images can be added to SketchUp models in one of two ways. First, you can use the File > 
Import > 2D Graphic  menu item, which will open a File Open dialog allowing you to navigate 
to the file you want. Alternately, you can simply drag and drop from the  Finder directly into 
your  drawing area. 

 Note - Image Objects can also be inserted as textures ( File > Insert > 
Image as Texture ). For additional information on using images as textures, 
see the  Texture Positioning topic. 

  

Image Proportions 
By default, Image Objects retain the proportions of the file from which they are derived. 
While inserting an image, you can hold down the Shift key to de-constrain the proportions. 
You can also use the Scale Tool to alter the image object's proportions after it is placed. 

Image File Size Versus Quality 
When you add an Image Object to your scene, the image file it is based on becomes 
embedded in your SketchUp document. This allows you to send your SketchUp files to 
others without any data loss through misplaced linked files, but it also means that your files 
can quickly balloon to unwieldy sizes. When inserting images, try to keep file size as small 
as possible: 

Resolution 
Resolution can have a large impact on image size. Try to use only as much resolution as 
you need, and no more. You may sometimes find that even a pixilated, low resolution file 
can be sufficient to provide the information you need from a photograph, sketch, or drawing. 
You can also cut down on image file size by converting your images to grayscale before 
inserting them into SketchUp. 

Also, the resolution of Image Objects is limited to the largest texture that OpenGL can 
handle. For most systems this limit is 1024 x 1024 pixels. This should be sufficient for most 
purposes, but if higher resolution is required, you can always stitch together multiple Image 
Objects. 

Image File Compression 
Another way to minimize file size is to use compressed file formats such as JPEG and PNG. 
These take up far less space both on disk and inside a SketchUp file.  
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Line Entities 
Lines, also referred to as edges, form the structural foundation of all models. Draw lines with 
the Line Tool. 

Editing a Line Entity 
You can edit the length the of a Line entity, that does not yet bound a face, by using the 
Move Tool. To edit an Line entity: 

1. Select the Move Tool. The cursor will change to a four-way arrow. 

2. Move over the Line entity to locate an endpoint of the Line entity.  

3. Click and hold on the endpoint of the Line entity. 

4. Move the cursor to adjust the length of the Line entity. 

You can also adjust the length using the Line entity's Entity Info dialog box. 
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Polygon Entities 
SketchUp's Polygon entities are similar to Faces entities, but can have 3 or more sides. 
These entities act as a single line in that they can define the edge of a face and also divide a 
face. Additionally, selecting one segment of the polygon selects the entire Polygon entity. 
However, all inference techniques will operate on the Polygon as though it were comprised 
of segments. Draw polygons with the Polygon Tool. 

 Note - You can explode a polygon into regular edge segments using the 
Explode Curve context menu item (see the Polygon Context Menu Items 
section later in this topic). 

Polygon entities are comprised of a radius and number of segments. The following image 
shows a six-sided polygon.  

 

 Note - The model in the previous image contains two entities: a Face 
entity (in the middle) surrounded by a Polygon entity (the six-sided edge). 

  

Editing a Polygon Entity 
You can edit the radius of a circle in which the polygon is inscribed, that does not yet bound 
a face, by using the Move Tool. To edit a Polygon entity: 

1. Select the Move Tool. The cursor will change to a four-way arrow. 

2. Move over the Polygon entity to locate the midpoint of a side. At least one midpoint of the 
polygon will allow you to resize the entity.  

3. Click and hold on the midpoint of the Polygon entity. 

4. Move the cursor to adjust the radius of the Polygon entity. Click and hold on another 
midpoint if the polygon does not resize. Try each midpoint until you find the midpoint that 
will resize the entity. 

You can also adjust the radius and number of segments using the Polygon entity's Entity 
Info dialog box. 
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Editing an Extruded Polygon 
When you use the Push/Pull Tool to extrude a 2D face that includes a polygon, it extrudes a 
special polygonal curved face set which can also have its radius edited. Use the  Move Tool 
to reposition one of the control edges, and the polygonal curved face set radius (as well as 
the radii of the two polygon entities that define it) will be adjusted accordingly. 

Polygon Deformation 
If a polygon is deformed in a way that destroys its radial definition, such as with a non-
uniform scale operation, it will become a non-parametric  Polyline Curve. Polyline Curves 
can no longer be edited as polygons. 
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Section Plane Entities 
Section Planes are special entities that control the SketchUp section cutting effect. Their 
position in space and in relation to  groups and  components determine the nature of the 
section cut effect. The following image shows a rectangular section plane creating a section 
cut effect in a model of a cup. 
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Surface Entities 
Surface entities are a number of faces joined together to give the impression of roundness 
(using soft edges). Although the individual planar faces that make up a curved face set are 
still separate entities, they can act like a single group when selected or painted. 

There are three types of surfaces, though the Entity Info dialog box will recognize each as 
just a Surface entity: 

• Arc surface. An arc surface is generated when a face with an Arc entity has one or more of 
its edges extruded (usually with the Push/Pull Tool).  

• Cylindrical surface. A cylindrical surface is similar to an arc surface, but is generated when 
a circular face is extruded to form a cylinder. 

• Polyface surface. A polyface surface is generated when a face with a Polyline Curve entity 
has one or more of its edges extruded (usually with the Push/Pull Tool). You can also 
create one manually by softening edges with the Erase Tool or using the Soften/Smooth 
Control. Polyface surfaces do not have special editable properties, but respond to tool 
operations as a single entity. 

The following image contains the three types of surfaces, an arc surface, cylindrical surface, 
and polyface surface, from left to right. 

 

Creating an Arc Surface 
As mentioned previously, arc surfaces are extruded faces with one or more arc edges. To 
draw an arc surface: 

1. Select the Arc Tool. The cursor changes to a pencil with an arc. 

2. Click to place the starting point of your arc. 

3. Click again to place the ending point of your arc.  

4. Move your mouse to adjust the bulge distance. Or, optionally type in values for the chord 
length, bulge distance, radius, and number of segments in the VCB.  

5. Click again to set the bulge distance. 

6. Select the Line Tool. The cursor changes to a pencil. 

7. Click at one end of the arc set the starting point of your line. 

8. Click at the other end of the arc to set the ending point of your line. This step completes a 
face consisting of an arc and a straight line. 

9. Select the Push/Pull Tool. The cursor will change to a 3D rectangle with an up arrow. 
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10. Click on the face 

11. Move the cursor up to create an arc curve in the positive direction or move the cursor 
down the expand the arc curve the negative direction. 

12. Click again when the arc curve has reached the desired size. The vertical curved surface 
is an arc surface. 

Creating a Cylindrical Surface 
As mentioned previously, cylindrical surfaces are extruded circles. To draw a cylindrical 
surface: 

1. Select the Circle Tool. The cursor changes to a pencil with a circle. 

2. Click to place the center point of the circle. 

3. Move the mouse out from the center point to define the radius of your circle. As you do so, 
the radius value is displayed dynamically in the VCB and can be specified by typing in a 
length value followed by the Enter or Return key. You can also specify the segmentation 
for the circle in the Value Control Box (VCB). 

  

 
4. Click a second time to finish the circle.  

5. Select the Push/Pull Tool. The cursor will change to a 3D rectangle with an up arrow. 

6. Click on the face 

7. Move the cursor up to create cylinder in the positive direction or move the cursor down the 
expand the cylinder in the negative direction. 

8. Click again when the cylinder has reached the desired size. The vertical surface is a 
cylindrical surface. 

Creating a Polyface Surface 
As mentioned previously, polyface surfaces are extruded faces with one or more polyline 
curve edges. To draw an polyface surface: 

1. Select the Freehand Tool. The cursor will change to a pencil with a polyline curve. 

2. Click and hold to place the starting point of your polyline curve.  

3. Drag the cursor to draw a polyline curve. Do not close the curve. 

4. Release the mouse button to stop drawing. 
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5. Select the Line Tool. The cursor changes to a pencil. 

6. Click at one end of the polyline curve to set the starting point of your line. 

7. Click at the other end of the polyline curve to set the ending point of your line. This step 
completes a face consisting of an arc and a straight line. 

8. Select the Push/Pull Tool. The cursor will change to a 3D rectangle with an up arrow. 

9. Click on the face 

10. Move the cursor up to create the polyface surface in the positive direction or move the 
cursor down the expand the polyface surface in the negative direction. 

11. Click again when the polyface surface has reached the desired size. The vertical curved 
surface is an polyface surface. 

  



 300

Text Entities 
Text entities allow you to annotate your SketchUp model in several ways. There are two 
types of Text entities: Leader Text, which has leader lines and can be attached to a face, or 
Screen Text, which remains fixed to a point on your screen. 

 
Text entities can have their own font, color, and size settings. Use the Text Tool to place 
Text Objects in your model.  

Attaching Text Directly to a Face 
Double-click on a face with the Text Tool to attach text, without leader, to the face.  

Text Leaders 
Text Objects can have one of four leader arrow styles: None, Dot, Closed arrow, and Open 
arrow. This can be changed using the context menu or its Entity Info dialog box. 

 
Text leaders are tied to the model, so as you rotate the model, the text information continues 
to be valid. As you move and adjust surfaces, the notes attached to those surfaces adjust 
with them. Once a leader arrow is obscured the text will be hidden. 

All text interacts with the model in three dimensions, but there are two ways for it to look on 
the screen. Thus, there are two main styles of leaders: View Based and Pushpin. A View 
Based leader will always retain its 2D screen orientation. A Pushpin leader is aligned in 3D 
space, and rotate with your model as you change your view. 

View Based 
2D View Based leaders do not change as the model view is changed. There appearance 
remains the same based on the screen layout and viewing direction present when they were 
placed. As you rotate the model, the actual text tries to stay oriented on the screen the same 
way, and the entire entity will follow whatever it is attached to. When the leader arrow 
becomes obscured, the whole text entity disappears. This method works well for 
presentation of still images from a particular vantage point. 

Pushpin 
3D Pushpin leaders do change appearance as your view changes because they are drawn 
in 3D space just like model geometry. As you rotate the model, the leader foreshortens, 
rotates and hides just like any edge geometry. 3D text can be repositioned in 3D space just 
like any other edge entity. This method works well for planning studies and models that will 
be examined using fly-bys. 
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Context Menu Items 
Access context menu items by context-clicking on an entity. All of the context menu items for 
all entities in SketchUp follow: 

Active Cut 
The Active Cut menu item is used to activate and de-activates the Section Plane Object, as 
indicated by the check mark. Activating a Section Plane will automatically de-activate all 
other planes in that context. 

This menu item is available for the Section Plane entity. 

Align View 
The Align View menu item is used to align the SketchUp Camera to the currently selected 
face.  

This menu item is available for Face, Section Plane, and Surface entities. 

Align Axes 
The Align Axes menu item is used to align the Drawing Axes to the currently selected face. 

This menu item is available for the Face and Surface entities. 

Area 
The Area sub-menu of the Face context menu is used to calculate the surface area in your 
SketchUp model. The results of the calculation are displayed in a Area dialog box.  

This menu item is available for the Face and Surface entities. 

Selection: The Selection menu item is used to calculate the total surface area of the 
currently selected face. 

Layer: The Layer menu item is used to calculate the total area for all faces in the layer of 
the currently selected face. 

Materials: The Materials menu item is used to calculate the total area of the faces in the 
entire model, hidden or unhidden, with the material of the currently selected face. 

This menu item is available for the Face and Surface entities. 

Arrow 
Click on the Arrow sub-menu menu to select the end point type for the leader line. Choose 
between None, Dot, Closed Arrow, and Open Arrow  

Change Axes 
The Change Axes menu item is used to redefine the origin axes of the selected component. 
This option is similar to changing the local coordinate system in other 3D applications.  

This menu item is available for the Component entity. 

Close Component 
The Close Component menu item is used to end an editing session and close the 
component. You can also click outside of the component with the Select Tool, or press the 
Esc key to close the component. 

This menu item is available for the Component entity. 

Close Group 
The Close Group menu item is used to end an editing session and close the group. You can 
also click outside of the group with the Select Tool, or press the Esc key to close the group. 
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This menu item is available for the Group entity. 

Convert to Polygon 
The Convert to Polygon menu item is used to convert the entity into a polygon arc, which will 
remain editable yet generate standard facets when extruded. 

This menu item is available for the 3D Polyline, Circle, and Curve entities. 

Create Group from Slice 
Generates new edges, encapsulated within a Group, wherever the section intersects with a 
face. 

This menu item is available for the Section Plane entity. 

Divide 
The Divide menu item is used to divide an entity into any number of equal segments. This 
menu item is not available when an arc bounds a curved surface. To divide an entity: 

1. Context-click on the entity to invoke the entity's context menu 

2. Select Divide. A string of red dots appears along the line segment.  

3. Drag the cursor back and forth along the length of the entity to increase or decrease the 
number of divisions. A help tag displays the number and length of segments that will be 
created if you pause briefly on the entity. 

 

 Note - The number of divisions is also displayed in the Value Control 
Box (VCB). Type in the number of desired segments followed by the  Return 
key to manually divide the entity. 

4. Click again to divide the entity. The entity will be broken into separate segments. 

This menu item is available for the 3D Polyline, Circle, Line, and Polygon entities. 

Edit Component 
The Edit Component menu item is used to edit the currently selected component. You can 
also use the Select Tool to double-click on the component, or select the component and 
press Enter or Return to edit a component. 

This menu item is available for the Component entity. 

Edit Group 
The Edit Group menu item is used to edit the currently selected group. You can also use the 
Select Tool to double-click on the group, or select the group and press Enter or Return to 
edit a group. 

This menu item is available for the Group entity. 
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Edit Text 
The Edit Text menu item is used to edit the dimensions text. Type in the new text and press 
Enter or Return to accept your changes. 

This menu item is available for the Dimension and Text entities. 

Entity Info 
The Entity Info menu item is used to display the Entity Info dialog box for viewing and 
changing the entity's attributes.  

This menu item is available for all entities. 

Erase 
The Erase menu item is used to delete the selected entity from your model. 

This menu item is available for the all entities. 

Export 
The Export menu item is used to save the image entity to a file that can be edited in an 
image editor.  

This menu item is available for the Image entity. 

Explode 
The Explode menu item is used to break the entity into the separate entities. An exploded 
entity will appear the same, but it can no longer be edited, and will no longer respond to tool 
operations as a single entity. 

This menu item is available for the 3D Polyline, Component, Group, and Image entities. 

Explode Curve 
The Explode Curve menu item is used to break the entity into regular edges. An exploded 
entity will appear the same, but it can no longer be edited, and will no longer respond to tool 
operations as a single entity. 

This menu item is available for the 3D Polyline, Circle, Curve, and Polygon entities. 

Flip Along 
The Flip Along menu item is used to mirror the selected geometry along an axis . You can 
use the Axis Tool to reposition the drawing axes, allowing you to flip in virtually any direction. 

This menu item is available for the Component and Group entities. 

Group 
This creates a Group entity out of the selected geometry. 

Hide/Unhide 
The Hide/Unhide menu item hides or unhides the select entity. All hidden entities are 
displayed in a ghosted pattern, allowing you to select them, if View > Show Hidden 
Geometry is enabled. This menu item changes to Unhide when selected geometry is hidden. 
Select Unhide to restore visibility for the entity. 

This menu item is available for all entities. 

Intersect With Model 
The Intersect With Model menu item is used to intersect two elements, such as a box and a 
tube, and automatically create new faces where the elements intersect. These faces can 
then be pushed, pulled or deleted to create new geometry.  

This menu item is available for the Component, Face, Group, and Surface entities. 
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Leader 
Click on the Leader sub-menu to select between View Based, Pushpin, and Hidden leader 
types. A View Based leader will always retain its 2D screen orientation. A Pushpin leader is 
aligned in 3D space, and rotates with your model as you change your view.  

Lock/Unlock 
The Lock menu item is used to lock the component so that it cannot be moved or edited. 
Additional copies of the component can be dragged into the work area from the component 
browser, however. 

The Unlock menu item is used to unlock the component so it can be edited. 

Make Component 
The Make Component menu item converts the Group into a new Component entity 
(component definition). 

This menu item is available for the Group entity. 

Make Unique 
The Make Unique menu item converts the currently selected component into a unique 
component, with a new definition. The original component definition and all other instances 
will not be affected when you edit the component after using the Make Unique menu item. 

This menu item is available for the Component entity. 

Orient Faces 
The Orient Faces menu item is used to automatically orient all the connected faces of your 
model to the orientation of the currently selected face. This option could lead to unexpected 
results when an edge of a face bounds three or more other faces.  

This menu item is available for the Face and Surface entities. 

Point at Center 
The Point at Center menu item is used to place a point at the center of your arc or circle 
entity. This menu item is generated by a Ruby script. 

This menu item is available for the 3D Polyline, Circle, and Polygon entities. 

Reload 
The Reload menu item is used to update the currently selected component with a new 
revision from the file system.  

This menu item is available for the Component and Image entities. 

Reverse 
The Reverse menu item is used to reverse the direction of a Section Plane entity. 

This menu item is available for the Section Plane entity. 

Reverse Faces 
The Reverse Faces menu item is used to flip the front and back sides of the currently 
selected face. ), it becomes important to know which side of the face will be exported.  

This menu item is available for the Face, Section, and Surface entities. 

Reset Scale 
The Reset Scale menu item is used to remove any scaling operations applied to the 
component. 

This menu item is available for the Component and Group entities. 
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Reset Skew 
The Reset Skew menu item is used to remove any skewing applied to the component.  

This menu item is available for the Component and Group entities. 

Save As 
The Save As menu item is used to save the selected component to a separate SketchUp 
file, with a new name and location in your file system. This menu item is commonly used to 
create component files that can be included in the component library or reused in other 
models. 

This menu item is available for the Component entity. 

Scale Definition 
The Scale Definition menu item applies any scaling operations, to the currently selected 
component, to the component definition in the Component Browser.  

This menu item is available for the Component entity. 

Select 
The Select submenu contains several options for selecting geometry related to the entity. 

Bounding Edges: The Bounding Edges menu item is used to select all of the edges 
currently bounding the selected entity. 

Connected Faces: The Connected Faces menu item is used to select all of the faces 
currently connected to the selected entity. 

Connected Faces: The Connected Faces menu item is used to select all of the faces 
currently connected to the selected arc. 

All Connected: The All Connected menu item is used to select all of the elements 
currently connected to the selected arc. 

All on same Layer: The All on same Layer menu item is used to select all of the 
elements on the current layer. 

This menu item is available for the 3D Polyline, Circle, Curve, Face, Line, Polygon, and 
Surface entities. 

Shadows 
The Shadows submenu contains cast and receive shadow options for the Image entity. 

Cast: The Cast Shadows menu item allows the face of the entity to cast a shadow. 

Receive: The Receive Shadows menu item allows the face of the entity to receive a 
shadows cast by other entities.  

This menu item is available for the Image entity 

Soften 
The Soften menu item is used to soften a faceted surface. Softened edges are not visible 
unless displayed in profile.  

This menu item is available for the 3D Polyline, Circle, Curve, Line, and Polygon entities. 

Texture 
The Texture submenu contains several options for repositioning textures on a face. This 
menu item only appears when a texture is painted on the face. See Position Texture Tool for 
additional information.  
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Position: The Position menu item is used to manipulate textures (reposition, stretch, skew, 
and so on) directly on a face.  

Reset Position: The Reset Position menu item is used to reset the texture to its previous 
state. 

Projected: The Projected menu item is used to wrap images and textures over forms as 
though projected onto the form. 

This menu item is available for the Face and Surface entities. 

Text Position 
The Text Position menu item is used to position text either at the start of the dimension line 
(Outside Start), center (Centered), our end of the dimension line (Outside End). 

This menu item is available for the Dimension entity.  

Unglue  
The Unglue menu item is used to free a component from a face (if you've attached a hole-
cutting component to a face). 

This menu item is available for the Component, Group,and Image entities. 

Zoom Extents 
The Zoom Extents menu item is used to zoom your view to a distance where the whole 
entity is visible and centered in the drawing window. 

This menu item is available for the 3D Polyline, Circle, Component, Curve, Face, Group, 
Image, Line, Polygon, and Surface entities. 

Use As Material 
The Use As Material menu item is used to create a material, in the Colors In Model section 
of the Material Browser, from the image. 

This menu item is available for the Image entity. 

  



 307

Entity Info 
Select an entity and either context-click on the entity or select Window > Entity Info to view 
and change the entities attributes. All of the Entity Info dialog box fields for all entities in 
SketchUp follow: 

 Note - Some of these items are only visible when the details arrow in the 
upper right-hand corner is pointing up. 

Area 
The Area field displays the area of the selected entity. Use the Area > Selection context 
menu item to calculate the area of multiple selected entities. 

This Entity Info dialog box item is available for the Face entity. 

Arrow 
The Arrow drop-down list contains a list of arrowheads permitted for the selected Text entity. 

This Entity Info dialog box item is available for the Text entity. 

Cast Shadows 
The Cast Shadows menu item allows the entity to cast a shadow. 

This Entity Info dialog box item is available for the Arc, Circle, Component, Curve, Face, 
Group, Image, Line, Polygon, and Surface entities. 

Definition Tab 
The Definition Tab displays an optional description in additional to other component 
definition options. 

Name: The Name field can contain the name of the component definition.  

Description: The Description field can contain a description of the component. 

Glue to: The Glue to drop-down list is used to identify the surfaces where your 
component can be placed. For example, a standard door might only be glued to 
surfaces in the horizontal planes. 

Cut Opening: The Cut Opening option allows the Component to create openings in the face 
into which it is placed. For example, a door or window component might be set to cut an 
opening in any wall where they are placed. 

Note - The location where the hole will exist corresponds to the 
red/green plane for the component. See the Set Plane option, in this topic, for 
further information. 

Always face camera: The Always face camera option allows the component to take on 
billboard behavior by drawing the component as a 2D form. This option increases 
performance by eliminating the need to render the component as a 3D model. 

 Note - Components with the Always face camera option enabled cannot 
have gluing behavior.  

Reload: Click on the reload button to reload (update) the component instance after its 
component definition has changed. 
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Shadows face sun: This option is only available when the Always face camera option is 
enabled. The shadows face sun option causes the shadow to be cast from the component's 
current position as though the component were facing the sun. The shadow shape does not 
change as the component rotates to face the camera. This option works best with 
components that have short bases (such as trees). This option does not work well with 
components that have wide bases (such as people in mid stride).  

 Note - Ensure the component's axis is positioned at the bottom center of 
the component for best results. 

Uncheck this option to cause the shadow to be cast from the component's current position. 
The size of the shadow changes based on view point.  

This Entity Info dialog box item is available for the Component entity.  

Expand 
Click on Expand to see components and groups nested within the currently selected 
component or group. 

This Entity Info dialog box item is available for the Component and Group entities.  

Font 
The Font button is used to select a new font for the selected Text or Dimension entity. 

This Entity Info dialog box item is available for the Text and Dimension entities. 

Hidden 
The Hidden check box is used to hide or unhide the entity. Hidden entities are displayed in a 
ghosted pattern, allowing you to select them, if View > Show Hidden Geometry is enabled.  

This Entity Info dialog box item is available for all entities.  

Layer 
The Layer field displays the layer of the currently selected entity. Select a new layer to move 
the entity to that layer.  

This Entity Info dialog box item is available for the all entities.  

Leader 
The Leader drop-down list contains a list of leader-types permitted for the selected Text 
entity.  

This Entity Info dialog box item is available for the Text entity.  

Length 
The Length field displays the length of the currently selected entity. 

This Entity Info dialog box item is available for the Arc, Circle, Curve, Line, and Polygon 
entities.  

Locked 
The Locked check box is used to lock the component so that it cannot be moved or edited. 
Additional copies of the component can be dragged into the work area from the component 
browser, however. 

Uncheck the Locked check box to unlock the component so it can be edited. 

This Entity Info dialog box item is available for the Component and Group entities.  
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Material 
The Material swatch displays the material used on the currently selected entity. The default 
material for an entity is represented by a gray/blue box. There are two default material 
swatches for faces and surfaces because faces and surfaces have both a front and a back 
side. The left swatch represents the front-side material. The right swatch represents the 
back-side material. 

This Entity Info dialog box item is available for the 3D Polyline, Arc, circle, Component, 
Curve, Dimension, Face, group, Line, Polygon, Surface, and Text entities.  

Name 
The Name displays the name of the currently selected component instance or group. Image 
entities also have an uneditable name field in the Entity Info dialog box. 
  

This Entity Info dialog box item is available for the Component, Group, and Image entities.  

Radius 
This Radius field displays the radius of the selected entity. Type new values in to this field to 
change the radius of the entity. 

This Entity Info dialog box item is available for the Arc, Circle, and Polygon entities.  

Receive Shadows 
The Receive Shadows menu item allows the component to receive a shadows cast by other 
entities. 

This Entity Info dialog box item is available for the Component, Face, Group, Image, and 
Surface entities.  

Segments 
The Segments field displays the number of segments in the selected entity. Type new 
values in this field to change the number of segments for the entity. 

 Note - Arc segmentation can only be changed when the Arc entity is part 
of 2 dimensional geometry (not part of a curved surface). 

This Entity Info dialog box item is available for the Arc, Circle, Curve, and Polygon entities  

Size 
The Size  field displays the pixel dimensions of the currently selected image. 

This Entity Info dialog box item is available for the Image entity.  

Soft 
The Soft option is used to render the edge as a soft edge. 

This Entity Info dialog box item is available for the Line entity.  

Smooth 
The Smooth option is used to render the faces connected to the edge with a varying tonal 
value. 

This Entity Info dialog box item is available for the Line entity.  

Statistics Table 
The Statistics reports quantities of various elements, such as faces, edges, guide lines, 
within a group. Select All geometry from the drop-down list to see statistics for all geometry 
in the group. Alternatively, select Components from the drop-down list to see statistics for all 
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components in the component. Finally, click on Expand to see components and groups 
nested within the currently selected component or group. 

This Entity Info dialog box item is available for Group entities.  

Text 
The Text field contains the text string for the selected Text entity. Click in this field to modify 
the text. Click in the drawing area to save your changes. 

This Entity Info dialog box item is available for the Text entity.  

Width and Height 
The Width and Height fields displays the dimensions of the currently selected image. Type in 
a new width or height to rescale the Image entity proportionally. Or, click on the lock icon to 
rescale the Image entity's width and height independently (nonproportional scale). 

This Entity Info dialog box item is available for the Image entity.  
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Input and Output 
This section of the user's guide covers the various mechanisms for inputting items, such as 
graphic images, into your SketchUp file and outputting or presenting your model once it is 
finished.  

 
The items in this section are divided into the following categories: 

• Importers and Exporters 

• Presentations 

• Printing 
The majority of the items in this section are found in the File menu. 
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2D Graphic Import 
SketchUp allows you to import 2D raster images, including JPEG and BMP, for placement 
within your model Import a file using the Import menu item in the File menu. 

Importing 2D Graphic Files 
To import a 2D graphic file: 

1. Select the File > Import menu item from the File menu. The Open dialog box is displayed. 

2. Select the type of file to import from the Format drop-down list. 

3. Locate the file you want to import 

4. Click OK to import the file. The image will appear in the drawing area. Your cursor, which 
will be an arrow, will be anchored to one of the image's corners.  

5. Click anywhere in the drawing area to anchor the point of the image held by the cursor.  

6. Drag your mouse away from the anchor point to increase the size of the image. 

7. Click again to finish placing your image.  

Importing 2D graphics as Textures 
To import a 2D graphic file as a texture: 

1. Select the File > Import menu item from the File menu. The Import dialog box is displayed. 

2. Select the type of file to import from the Format drop-down list. 

3. Locate the file you want to import 

4. Click the Use As Texture check box if you want your image to be used as a texture upon 
import (this will require you to paint the image on a an existing surface). See the following 
Importing 2D Graphics as Textures section for additional information. 

5. Click OK to import the file. The image will appear in the drawing area. Your cursor, which 
will be the paint bucket, will be anchored to one of the image's corners. The paint bucket 
cursor only appears when the image is over a surface where it can be painted. 

6. Click on a surface to anchor the point of the image held by the cursor.  

7. Drag your mouse away from the anchor point to increase the size of the image on the face. 

8. Click again to paint your image on the face. The image will repeat, if necessary, to fill the 
entire face. A thumbnail of the image appears in the Materials Browser's Colors  section to 
indicate that the image is a texture. Refer to the  Paint Bucket Tool for additional 
information on working with textures. 
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3D Model (DWG/DXF) Import 
SketchUp allows you to import 3D models, such as DWG and DXF CAD files, for placement 
within your model. Import a file using the Import menu item in the File menu. 

 Note - Google is a member of the  OpenDWG Alliance, allowing 
SketchUp to offer the most reliable DWG file translation available. 

Importing DWG/DXF Files 
To import a 3D model file: 

1. Select the File > Import menu item from the File menu. The Open dialog box is displayed. 

2. Select the type of file to import from the Format drop-down list. 

3. (optional) Click on the Options button to modify the import options, such as units, for the 
incoming file. See the following Import Options section for further information. 

4. Click OK to import the file. The Import Results dialog box will appear containing details of 
the imported model.  

 Note - It can take several minutes to import a large file because 
SketchUp's native geometry is very different from most CAD software and the 
conversion process is calculation-intensive. 

5. Click OK in the Import Results dialog box. The model will appear in the drawing area at the 
origin.  

 Note - The imported model's entities will be enclosed within a group if 
geometry existed in the drawing area prior to importing the model. 

6. (optional) Click on the Zoom Extents Tool to locate the imported model if it is not currently 
displayed in your drawing area. 

Supported CAD Elements 
SketchUp must translate the elements within a CAD file into SketchUp entities when 
importing a CAD file. Supported CAD elements include lines, arcs, circles, polylines, faces, 
entities with thickness, 3D faces, and nested blocks. CAD layers are also supported. 

SketchUp does not support AutoCAD regions, XREFs, hatching, dimensions, text, and 
proprietary ADT or ARX objects. These CAD elements will be ignored on import.  

You can change any unsupported elements into primitive CAD drawing elements, within 
your CAD application, if you need to import these elements into SketchUp. For example, you 
can explode ADT walls and extrusions in Autodesk Architectural Desktop so they will import 
as faces in SketchUp. Some elements might need to be exploded multiple times in your 
CAD package to be translated into SketchUp entities. 

Reducing Import File Size 
Try to keep the size of imported files to a minimum. Importing very large CAD files can take 
a long time because each CAD element must be analyzed and converted into a SketchUp 
entity. Also, once imported, a complex CAD file can slow SketchUp's performance because 
lines and faces in SketchUp have a lot more "intelligence" than their CAD equivalents.  

http://www.opendwg.org/
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Strategies for Minimizing CAD File Size 
SketchUp models can be designed to be as accurate as models in CAD. However, 
SketchUp is not designed for the same type of line-intensive drawings done in CAD 
software. Therefore, it is a good idea to clean up and import only the CAD content that is 
absolutely necessary into SketchUp. 

Another strategy is to keep different levels of detail in separate CAD files. For example, one 
imported CAD file can contain site plan information, another can have a floor plan, and a 
final file can have a specific detail.  

Import Options 
Some CAD files might contain non-standard units, coplanar faces, or inconsistently oriented 
faces. You can force SketchUp to automatically analyze and repair these issues during the 
import process. 

Geometry 
Merge Coplanar Faces: Planes can import into SketchUp with triangulated lines. Removing 
these lines manually can be tedious. The Merge coplaner faces option is used to have 
SketchUp automatically remove these lines. 

Orient Faces Consistently: The Orient faces consistently option is used to analyze the 
direction of imported faces and orient these faces so that they are uniform in 
direction.  

Scale 
Some CAD formats, such as DXF, save data in generic units.  

Units: Select the unit type used in the original CAD file to import geometry at the correct 
scale.  

Caution - SketchUp only recognizes faces of .001 square inches and 
larger. It is possible to have create very small faces on import if you select 
millimeters as your SketchUp units but the model was originally intended to be 
displayed in feet. Therefore, use a large unit type, such as feet or meters, if 
you do not know the units used in the original file. Resize the model as 
necessary after it is imported.  

Preserve Drawing Origin: The Preserve drawing origin option is used to define where the 
DWG/DXF file will be placed when it is inserted into a SketchUp file. Check this box if you 
want to place the DWG/DXF file at the origin, as originally defined in the DWG/DXF file. Do 
not check this box if you want the DWG/DXF file to be placed near the SketchUp origin. 
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3D Model (3DS) Import 
SketchUp allows you to import 3D Studio (3DS) files. Import a file using the Import menu 
item in the File menu. 

Importing 3DS Files 
To import a 3DS model file: 

1. Select the File > Import menu item from the File menu. The Open dialog box is displayed. 

2. Select the type of file to import from the Format drop-down list. 

3. (optional) Click on the Options button to modify the import options for the incoming file. 
See the following Import Options section for further information. 

4. Click OK to import the file.  

 Note - It can take several minutes to import a large file because 
SketchUp's native geometry is very different from most CAD software and the 
conversion process is calculation-intensive. 

5. Click OK in the Import Results dialog box. The model will appear in the drawing area at the 
origin.  

6. (optional) Click on the Zoom Extents Tool to locate the imported model if it is not currently 
displayed in your drawing area. 

Import Options 
Geometry 
Merge Coplanar Faces: Planes can import into SketchUp with triangulated lines. Removing 
these lines manually can be tedious. The Merge coplanar faces option is used to have 
SketchUp automatically remove these lines. 

Scale 
Units: The Units drop-down list is used to import 3DS geometry at the correct scale. A 3DS 
file has a field which indicates its units value. Sometimes this value is explicitly set in the 
3DS file (such as millimeters) and sometimes it is missing and set to a generic value. The 
Model Units list item will import your 3DS file with the unit value it finds in your 3DS file. 
SketchUp will import your file using inches if a units value is not set in the 3DS file. 
SketchUp will import your 3DS file at the unit you choose if you pick anything other than 
Model Units.  

For example, a face that is 1cm x 1cm will be imported into SketchUp as 1cm x 1cm if your 
3DS file has its units value set to centimeters and you select Model Units in this drop-down 
list. A 1cm x 1cm face will import into SketchUp with dimensions of 1in x1in if you choose 
inches in the drop-down list.  

Caution - SketchUp only recognizes faces of .001 square inches and 
larger. It is possible to have create very small faces on import if you select 
millimeters as your SketchUp units but the model was originally intended to be 
displayed in feet. Therefore, use a large unit type, such as feet or meters, if 
you do not know the units used in the original file. Resize the model as 
necessary after it is imported.  
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3D Model (DEM) Import 
SketchUp allows you to import a digital elevation models (DEM) containing point data 
relating to terrain elevations. Unfortunately, there is not a single standardized file format for 
digital elevation models. However, SketchUp supports the following two important file 
formats: USGS DEM and spatial data transfer standard (SDTS). 

  

The USGS DEM file format is an ASCII format for storing geographical information. These 
files can have an extension of .dem. You will have to add the .dem extension to your USGS 
DEM files if they do not have this extension.  

  

SDTS is a complex geographical data format. SDTS models usually consist of 20 or more 
files, all with the extension of .ddf, stored in a single directory. You can select any of the 
*.ddf files in a SDTS directory to import the entire set of files.  

  

Import a USGS DEM or SDTS file using the Import menu item in the File menu. 

Importing DEM File 
To import a DEM file: 

1. Select the File > Import menu item from the File menu. The Open dialog box is displayed. 

2. Select the type of file to import from the Format drop-down list. 

Caution - You must add the .dem file extension to your DEM files to 
open these files. Additionally, you can select any file with the .ddf extension 
from your directory to open DDF files. 

3. (optional) Click on the Options button to modify the import options, such as points, for the 
incoming file. See the following Import Options section for further information. 

4. Click OK to import the file. The Import Results dialog box will appear containing details of 
the imported model.  

 Note - The file import time corresponds to the number of maximum 
points defined in the Import Options dialog box: the greater number of 
maximum points, the longer it takes the file to load.  

5. Click OK in the Import Results dialog box. The model will appear in the drawing area at the 
origin.  

 Note - The imported model's entities will be enclosed within a 
component. 

6. (optional) Click on the Zoom Extents Tool to locate the imported model if it is not currently 
displayed in your drawing area. 

DEM Import Options 
DEM files can contain thousands of points yielding a very detailed, yet very slow, SketchUp 
model. The CAD files might contain non-standard units, coplanar faces, or inconsistently 
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oriented faces. You can force SketchUp to automatically analyze and repair these issues 
during the import process. 

TIN 
Points and Faces: The Points and faces fields are used to identify the number of points, 
and subsequent faces, that will be created upon import. The fewer the points and 
subsequent faces, the better the performance in SketchUp. However, the fewer the points 
and subsequent faces, the lesser the detail of the imported model.  

 Note - (2 * points) + 1 = approximate number of faces created upon 
import. 

Color 
Generate Gradient Texture: The Generate gradient texture field is used to apply a gradient 
texture to the imported DEM model. This texture will be darker in lower areas of the model 
and lighter in high areas. 
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3D Model (SHP) Import 
SketchUp allows you to import shape files. A shape file is file type commonly used in Global 
Information Systems (GIS) containing a set of geographic features such as points, streets 
(lines), and building footprints (polygons). Import a file using the Import menu item in the  
File menu. 

Obtaining the SHP Import Plug-In 
Download the SHP import plug-in from the downloads section of the SketchUp web site 
(www.sketchup.com).  

Note - The SHP import plug-in is currently unavailable for Google 
SketchUp 6. 

Importing Shape Files 
To import a shape file: 

1. Select the File > Import menu item from the File menu. The Open dialog box is displayed. 

2. Select the type of file to import from the Format drop-down list. 

3. Click OK to import the file. The Options dialog box is displayed. 

Note - It can take several minutes to import a large file because 
SketchUp's native geometry is very different from most CAD software and the 
conversion process is calculation-intensive. 

4. (optional) Adjust the options in the KMZ Export Options dialog box. 

5. Click OK. 

6. (optional) Click on the Zoom Extents Tool to locate the imported model if it is not currently 
displayed in your drawing area. 

The Options Dialog Box 
The shape file import options dialog box is used for adjusting how your shape file will appear 
in SketchUp. These options are available depending on the features in the shape file. 
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Elevate by field 
Click on this checkbox if you want the geometry in this shape file to be elevated in the Z 
direction. Select the field from the drop-down list whose value you want to use as the 
elevation. 

Extrude by field 
Click on this checkbox if you want the geometry in this shape file to be extruded in the Z 
direction. Select the field from the drop-down list whose value you want to use as the 
extrusion. 

Name group using 
Each shape in the shape file is imported into its own group within SketchUp. Click on this 
checkbox if you want the group for each shape to be automatically named using the value in 
the corresponding drop-down list. Select the field from the drop-down list whose value you 
want to use as the name of the group containing the shape. 

Tip - The Text Tool displays the group name when you click on the group 
and create leader text using the Text Tool. Use this method to display the 
incoming shapes' names.  

Point size (in inches) 
SketchUp places an X for points in a point feature class. Type the point size (the size of the 
X) for the points in a point feature class in this field.  

Tip - Each point in a point feature class is placed in a component when 
imported in SketchUp. Select all of these points in SketchUp and then context-
click on a component in the component browser. Select the Replace selected 
menu item to replace the component in the component browser with all 
instances of the point (X) in SketchUp. 

 = Functionality only available in Google SketchUp Pro 6 
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2D Graphic Export 
SketchUp allows you to export 2D raster image files in JPEG,  TIFF,  PNG, and  Epix 
formats. Export a file using the Export > 2D Graphic menu item in the  File menu. 

 Note - Shadows cannot be saved with a 3D model. None of the 2D 
vector output formats support rendering features such as shadows, textures, 
or transparency. The only export formats that will represent shadows as seen 
on your display are pixel-based raster images and animations. 

Exporting a Raster Image 
To export a 2D graphic file: 

1. Manipulate the view of the model so that it appears as you would like it to appear in the 
exported file. SketchUp will export the model view as it is currently displayed, including 
display style, edge rendering, shadows, and point of view. 

2. Select File > Export > 2D Graphic.  

3. Enter a file name for the exported file in the Save As field. 

4. Select the export type from the Format drop-down list. 

5. Click the Export button. 

6. (optional) Click on the Options button. The Export Image Options dialog box is displayed. 

7. (optional) Adjust the options in the Export Image Options dialog box. 

8. (optional) Click the OK button. 

9. Click the Export button. 

Export Image Options Dialog Box 
The Export Image Options dialog box contains options for exporting raster image files. 

Image Size 
Use View Size: The Use view size is used to set your output to a 1:1 (real world) scale.  

Width/Height: The Width and Height fields are used to control the size of image as 
measured in pixels or specific units.  Click on the chain icon to the right of the text fields to 
lock the aspect ratio of the export. 

Resolution 
The Resolution drop-down list is used to select the resolution for the exported image. For 
viewing images on the screen, 72-96 pixels/inch is adequate. For printing, you might want to 
increase the resolution to 150-300 pixels/inch. Remember, high resolution images take 
longer to generate. 

Rendering 
Anti-Alias: When enabled, SketchUp will smooth the exported image. This method can take 
longer, but it helps to reduce jagged lines and pixilated artifacts in images. 

JPEG Compression 
The slider bar for a JPEG export is used to define the level of JPEG compression quality. 
The level of quality becomes lesser and the file size is smaller as the slider is moved to the 
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left. Conversely, the level of quality becomes higher and the file size is larger if the slider is 
moved to the right.  
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2D Graphic (DWG/DXF) Export 
SketchUp allows you to export your models as 2D vector drawings, including DWG and 
DXF. Export a file using the Export > 2D Graphic menu item in the File menu. 

Exporting a DWG or DXF File 
To export a 2D DWG or DXF graphic file: 

1. Manipulate the view of the model so that it appears as you would like it to appear in the 
exported file.  

2. Select File > Export > 2D Graphic.  

3. Enter a file name for the exported file in the Save As field. 

4. Select the DWG or DXF export type from the Format drop-down list. 

5. (optional) Click on the Options button. The DWG/DXF Hidden Line Options dialog box is 
displayed. 

6. (optional) Adjust the options in the DWG/DXF Export Options dialog box. 

7. (optional) Click the OK button. 

8. Click the Export button. 

 Note - SketchUp exports the model using the current point of view with 
the exception of unsupported features such as textures and shadows.  

DWG/DXF  Export Options Dialog Box 
The DWG/DXF Export Options dialog box contains options for exporting 2D DWG and DXF 
Files. 

Drawing Scale & Size 
The Drawing Scale & Size section of the DWG/DXF Hidden Options Dialog box contains 
scaling options for your model. 

Full Scale (1:1): The Full Scale (1:1) option is used to set your output to a 1:1 (real world) 
scale.  

In Drawing/In Model:  The In Drawing/In Model fields are used to scale your model for 
export. The first measurement, labeled In the Model, is the measurement of the exported 
geometry. The second measurement, labeled In Drawing , is the actual measurement of the 
object in real scale. For example, for a scale of 1/4" = 1', simply enter 1 inch In Model equals 
4 feet In Drawing.  

 Note - It is not possible to print a perspective image to scale.  Ensure 
perspective is disabled and you are using one of the Standard Views in the 
Camera > Standard submenu, to enable this scale option.  

Width/Height: The width and height fields are used to enter a custom page size for your file. 

Profile Lines 
The Profile Lines section of the Export Options Dialog box contains options for exporting 
profile lines. 

None: The None option is used to export profile lines at standard width. 
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Polylines with width: The Polylines with width option is used to export profile lines as 
AutoCAD polyline entities. 

Wide line entities: The Wide line entities option is used to export profile lines as AutoCAD 
wide line entities. This option is only available when saving AutoCAD 2000 or later DWG 
files. 

Separate on a layer: The Separate on a layer option is used to output profile lines onto their 
own layer. This option is useful if you would like to plot profile lines using a different pen 
weight or quickly change the line width of all profile lines in a separate CAD or Illustration 
program. 

 Note - The Separate on a layer option creates a single additional layer 
for profile edges. SketchUp Layer assignments do not translate directly when 
exporting 2D hidden line vectors. 

Width: The Width field is used to specify an exact width for the Polylines with width option. 
 This option is only available when Polylines with width is checked and Automatic is 
unchecked. 

Automatic: The Automatic option is used to set the width of profile lines by matching the 
output to the proportions you see in the SketchUp drawing area. This option is only available 
when Polylines with width is checked.  

Section Lines 
The Section Lines section of the Export Options Dialog box contains options for exporting 
section lines. 

None: The none option is used to export section slice lines at standard width. 

Polylines with width: The Polylines with option is used to export section slice lines as 
AutoCAD polyline entities.  

Wide line entities: The Wide line entities option is used to export section slice lines as 
AutoCAD wide line entities. This option is only available when saving AutoCAD 2000 or later 
DWG files. 

Separate on a layer: The Separate on a layer option is used to output section slice lines 
onto their own layer. This option is useful if you would like to plot section slice lines using a 
different pen weight or quickly change the line width of all section slice lines in a separate 
CAD or Illustration program. 

 Note - The Separate on a layer option creates a single additional layer 
for section slice edges. SketchUp Layer assignments do not translate directly 
when exporting 2D hidden line vectors. 

Width: The Width field is used to specify an exact width for the Polylines with width option. 
 This option is only available when Polylines with width is checked and Automatic is 
unchecked. 

Automatic: The Automatic option is used to set the width of section slice lines by matching 
the output to the proportions you see in the SketchUp drawing area. This option is only 
available when Polylines with width is checked.  

Edge Extensions 
The Edge Extensions section of the  Export Options Dialog box contains options for 
exporting extension lines. 
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Show extensions: Some CAD applications might have problems recognizing endpoints and 
intersections of lines with SketchUp extensions. The show extensions option is used to 
toggle the export of line extensions.    

Length: The Length field is used to specify an exact length for line extensions.  This option 
is only available when Show extensions is checked and Automatic is unchecked. 

Automatic: The Automatic option is used to set the length of extension lines by matching 
the output to the proportions you see in the SketchUp drawing area. This option is only 
available when Show extensions is checked. 

 = Functionality only available in Google SketchUp Pro 6 
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 2D Graphic (PDF/EPS) Export 
SketchUp allows you to export your models as 2D vector drawings, including PDF and EPS. 
Export a file using the Export > 2D Graphic menu item in the File menu. 

Exporting a PDF or EPS File 
To export a 2D PDF or EPS graphic file: 

1. Manipulate the view of the model so that it appears as you would like it to appear in the 
exported file.  

2. Select File > Export > 2D Graphic.  

3. Enter a file name for the exported file in the Save As field. 

4. Select the PDF or EPS export type from the Format drop-down list. 

5. (optional) Click on the Options button. The PDF/EPS Hidden Options dialog box is 
displayed. 

6. (optional) Adjust the options in the PDF/EPS Hidden Options dialog box. 

7. (optional) Click the OK button. 

8. Click the Export button. 

  Note - SketchUp exports the model using the current point of view with 
the exception of unsupported features such as textures and shadows. 

Export Options Dialog Box 
The Export Options dialog box contains options for exporting 2D PDF and EPS Files. 

Image Size 
The Image Size section of the PDF/EPS Hidden Options Dialog box contains size options 
for your model. 

Match View Size: The  Match View Size option is used to set your output to a 1:1 (real 
world) scale.  

Width/Height: The width and height fields are used to enter a custom page size for your file. 

Image Scale 
The Image Scale section of the PDF/EPS Hidden Options Dialog box contains scaling 
options for your model. 

In Image/In Model: The  In Image/In Model fields are used to scale your model for export. 
The first measurement, labeled  In Model, is the measurement of the exported geometry. 
The second measurement, labeled  In Model, is the actual measurement of the object in real 
scale. For example, for a scale of 1/4" = 1', simply enter 1 inch  In Model equals 4 feet  In 
Image.  

 Note - It is not possible to print a perspective image to scale. Ensure 
perspective is disabled and you are using one of the Standard Views in the 
Camera > Standard submenu, to enable this scale option.  

Line Quality 
The Line Quality section contains a setting for exported line weights. 
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Line Weight: This option is used to apply a weight to all profile lines, or lines that have 
space behind them as they are displayed. 

2D PDF/EPS Export Details 
The PDF and EPS export is used to export vector SketchUp files for use in other vector -
based editing programs like Adobe Illustrator.  

Caution - Some graphic features of SketchUp, including textures, 
shadows, smooth shading, backgrounds, and transparency, cannot be 
exported to PDF and EPS. 

Text and Dimensions 
SketchUp will attempt to output text annotation and notes to your 2D drawing. Please note 
the following limitations: 

• Text and Dimension entities that are obscured (partially or totally) by other 
geometry in the SketchUp drawing area export on top of the geometry. 

• Text and Dimension entities that are partially clipped by the edges of the 
SketchUp Drawing Area are not exported. 

• Certain fonts may not export exactly. 

 = Functionality only available in Google SketchUp Pro 6 
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 2D Graphic (Epix) Export 
Piranesi is a painting application that enables you to create stunning renderings from your 
SketchUp models. For more information, please visit the Piranesi Web Site: 
www.informatix.co.uk/piranesi.htm 

SketchUp allows you to export your models as Epix files for use in Piranesi. Export an Epix 
file using the Export > 2D Graphic menu item in the File menu. 

Exporting an Epix File 
To export a Epix file: 

1. Manipulate the view of the model so that it appears as you would like it to appear in the 
exported file.  

2. Select File > Export > 2D Graphic.  

3. Enter a file name for the exported file in the Save As field. 

4. Select the Epix export type from the Format drop-down list. 

5. (optional) Click on the Options button. The Export Options dialog box is displayed. 

6. (optional) Adjust the options in the Export Options  dialog box dialog box. 

7. (optional) Click the OK button. 

8. Click the Export button. 

9.   

  Note - SketchUp exports the model using the current point of view with 
the exception of unsupported features such as textures and shadows. 

The Export Options  dialog box 
The Export Options dialog box contains options for exporting Epix files. 

Image Size 
The Image Size section of the Export Options dialog box contains size and scaling options 
for your model. 

Use View Size: The Use View Size option is used to set your output to the exact 
dimensions of your SketchUp drawing area.  

Width/Height: The width and height fields are used to enter a custom page size for your file. 

Tip - SketchUp cannot export Epix files with compression enabled. Re-
saving your file in Piranesi can reduce file size considerably. 

Resolution 
The Resolution drop-down list is used to select the resolution for the exported image. For 
viewing images on the screen, 72-96 pixels/inch is adequate. For printing, you might want to 
increase the resolution to 150-300 pixels/inch. Remember, high resolution images take 
longer to generate. 

http://www.informatix.co.uk/piranesi.htm


 328

EPIX 
The EPIX section of the Export Options dialog box contains options for the contents of the 
exported file. 

Export Edges: The Export Edges check box is used to maintain the edge rendering style 
from the drawing area when saving your drawings as an Epix file. 

 Note - Edges will not appear in your Epix file if edges are disabled using 
Window > Display Settings. 

Export Textures: The Export Textures check box is used to maintain textures from the 
drawing area when saving your drawings as an Epix file. 

 Note - The Export Textures option is only applicable when materials 
have been assigned to faces and SketchUp is in the Shaded with Textures 
display setting. 

Export Ground Plane: The Export Ground Plane check box is used to create a ground 
plane in the Epix file without explicitly modeling a ground in SketchUp.  

 = Functionality only available in Google SketchUp Pro 6 
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 3D Model (DWG/DXF) Export 
SketchUp can export 3D geometry to several AutoCAD formats: DWG r12, DWG r13, DWG 
r14, DWG r2000, DWG r2004, DXF r12, DXF r13, DXF r14, DXF r2000, and DXF r2004. 
SketchUp uses the industry standard OpenDWG Alliance file import/export model libraries to 
ensure maximum possible compatibility with AutoCAD. Export a file from the  File menu. 

Exporting 3D DWG/DXF Files 
To export a 3D DWG or DXF file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the export type from the Format drop-down list. 

4. (optional) Click on the Options button. The AutoCAD Export Options dialog box is 
displayed. 

5. (optional) Adjust the options in the AutoCAD Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

AutoCAD Export Options Dialog Box 
The AutoCAD Export Options dialog box contains options for exporting AutoCAD files. 

Geometry 
The Geometry section of the  Export Options dialog box contains the various entities that 
can be exported into your DWG/DXF file. 

SketchUp can export faces, edges (wires), dimensions, text, or guides in any combination.  

3D DWG/DXF Export Details 
The 3D DWG and DXF export is used to export SketchUp files for use in other CAD 
programs such as AutoCAD. The following details apply to this export:  

• Faces in SketchUp are exported as a triangulated polyface mesh with interior 
splframe hidden lines (if applicable). This conversion helps to simulate the 
appearance of your native SketchUp file, even when all exported faces are 
triangular. 

• SketchUp uses the current units set in the Units Panel of the Model Info 
dialog box as a reference for translation to a DWG or DXF file. For example, 
if the current unit setting is Decimal and Meters, SketchUp will export the 
DWG file accordingly. AutoCAD must be set to decimal for the units to 
translate correctly as meters. 

• When exporting, duplicate line entities will not be created on top of a p-line 
entity. 

 = Functionality only available in Google SketchUp Pro 6 

  

http://www.opendwg.org/
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3D Model (3DS) Export 
The 3DS format is native to the original DOS-based 3D Studio modeling and animation 
application. Although obsolete in many ways, the 3DS format is still widely used and offers a 
direct way to export simpler SketchUp models into a wide range of 3D modeling packages. 
Because 3DS preserves material assignments, texture mapping, and camera position, it can 
often allow ideas generated in SketchUp to be transferred with greater fidelity than formats 
designed for CAD. 

Exporting 3DS Files 
To export a 3DS file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the 3DS export type from the Format drop-down list. 

4. (optional) Click on the Options button. The 3DS Export Options dialog box is displayed. 

5. (optional) Adjust the options in the 3DS Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

3DS Export Options Dialog Box 
The 3DS Export Options dialog box contains options for exporting 3DS files. 

Geometry 
The Geometry section of the 3DS Export Options dialog box contains options for 
determining how geometry will be represented in a 3DS file. 

Export (Full hierarchy): The Export (Full hierarchy) option is used to create meshes 
for each top level nested component and group and, additionally, meshes for non-
grouped entities based on the connection of faces. These meshes will be organized 
based on where they fit in the component and group hierarchy. This option allows 
you (using a tree view in AutoDesk 3DS Max, for example) to select individual 
components and groups with all their children and each connected face set as 
separate meshes. This option preserves the name of the component or group using 
the following rule for components: if an instance name exists, that name will be used; 
if an instance name does not exist, the definition name will be used.  

 Export (By layer): The Export (By layer) option is used to create separate meshes 
based on a combination of how faces are connected and what layer (from SketchUp) 
they are on. All faces that are connected and are on the same layer will be grouped 
together in separate meshes. These meshes will then be organized based on the layer 
to which they belong. This option allows you (using a tree view in AutoDesk 3DS Max, 
for example) to select all objects on a layer using the organization scheme and then 
to drill down and select individual meshes within that layer. No hierarchy will be 
created with this option.  

Export (By material): The Export (By material) option is used to create separate 
meshes based on a combination of how faces are connected and what material they 
have. All faces that are connected and have the same material will be grouped 
together in separate meshes. These meshes will then be organized based on their 
materials. This option allows you (using a tree view in AutoDesk 3DS Max, for 
example) to select all objects with the same material using the organization scheme 
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and then to drill down andselect individual meshes having that material. No hierarchy 
will be created with this option.  

Export (Single Object): The Export (Single object) item is used to export your 
SketchUp model as a single 3DS mesh. This single mesh will be simple to select and 
manipulate once imported into another application. Because there is a limitation in 
the 3DS format that meshes can only have 65,536 vertices and faces, if this limit is 
exceeded, more than one mesh will be created with emphasis on keeping the number 
of meshes to the minimum amount necessary. 

Export Only Current Selection: The Export only current selection checkbox is used to 
export the currently selected geometry. The entire SketchUp model is exported when there 
is no selection. Additionally, the entire model is exported when this checkbox is not checked.  

Export Two-Sided Faces: The Export two-sided faces checkbox is used to export 
faces twice, once for the front and once for the back. This option doubles the number 
of polygons in the resulting 3DS file and can slow down rendering. However, this 
option ensures that your model will appear more like it appears in SketchUp. Both 
faces will always render, and materials applied to front and back faces are preserved. 
When this option is selected, SketchUp will weld the vertices of the front faces 
together and the vertices of the back faces together according to the logic for texture 
mapping and welding outlined in the following Export texture maps option. 

Export Standalone Edges: Standalone  Line entities (lines not connected to any faces) are 
somewhat unique to SketchUp and not supported by many other 3D programs or the 3DS 
format. The Export standalone edges check box creates very thin rectangles that appear as 
standalone lines in the 3DS files. Unfortunately, this option can result in invalid texture 
coordinates requiring UV mapping to be re-applied before the scene is rendered. Also, 
certain exported standalone edge geometries can create invalid 3DS files altogether. The  
VRML format may better suit your needs if you need to export standalone edges. 

Materials 
Export Texture Maps: The Export texture maps checkbox is used to assign texture maps to 
3DS materials whenever the corresponding SketchUp material uses a texture image. The 
3DS format allows only one UV mapping coordinate per vertex, meaning you can not have a 
different UV mapping on two faces that share the same vertex. Given this limitation of the 
3DS format, a tradeoff between preserving texture coordinates and welding geometry is 
sometimes necessary and reflected in the following two sub-options: Favor Preserving 
texture coordinates and Favor Welding Vertices. 

Favor (Preserving Texture Coordinates): When the Preserving texture coordinates option 
is selected, and UV mappings are different, the exporter breaks up geometry so that each 
coplanar group of polygons has its own set of vertices. In this case, vertices will not be 
welded together and no smoothing of faces will be evident. If UV mappings are identical, 
vertices will be welded. 

 Note - Use this option if the preservation of textures is of most 
importance. 

Favor (Welding Vertices): When the Welding Vertices option is selected, the exporter 
will weld together vertices which will keep your geometry intact and allow smoothing 
to be preserved. However, when two faces share the same vertex but have different 
UV mappings, this option will only allow one of the texture mappings to be preserved. 

  Note -  Use this option if the preservation of smoothing and welding is of 
most importance. 
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Use “Color by Layer” Materials: The 3DS file format does not support layers directly. The 
Use "Color by Layer" Materials checkbox is used to assign 3DS materials based on your 
model's layer assignments in SketchUp. Check this checkbox to export materials based on 
layers, such as when exporting to other rendering applications. 

Cameras 
Generate Cameras From Scenes: The Generate Cameras from Scenes checkbox is used 
to create a camera for the default view as well as any SketchUp  Scenes which have been 
defined. The current SketchUp view is exported with the name “Default Camera," and other 
Scene camera definitions are output using their Scene Name. 

Scale 
Units: The units drop-down list is used to determine the unit size in the 3DS output.  

Known Issues and Limitations 
2 Sided Faces 
Faces are only visible from the front in some programs while both sides of a face are always 
visible in SketchUp. These two-sided faces can appear to be missing in other applications if 
not facing the correct direction. You an manually reorient your faces in SketchUp using the 
Reverse command or the  Orient Faces command to make face directions uniform for a 
given set of connected geometry.  

Additionally, you can use the Export two-sided checkbox to correct this issue. 

Flipped Textures 
Textures and materials exported with the two-sided/geometry checkbox can appear flipped 
in certain applications (such as, Maya version 6.0 and 6.5). A 3DS mesh does not store any 
normal data so normals must be computed by the target system. Some importers might 
compute the normals incorrectly resulting in the appearance of flipped textures. 

Texture Map Names 
The 3DS format was designed in an era when DOS-based systems were prevalent. 
Therefore, 3DS is not capable of storing texture filenames that exceed the 8.3 DOS 
character limit. This issue can be a limitation to anyone who uses modern OS filename 
capabilities to manage large, complex projects or file libraries.  

SketchUp create unique names for each texture by adding unique suffixes to file names. For 
example, a file named “corrugated metal.jpg” will be described in the 3DS file as 
“corrugat.jpg”. Any other files that use the same first six letters is truncated and the sufix 
"01," 02," and so on, are added.  

Visibility 
Only entities that are currently visible in SketchUp are output to the 3DS file. Rendering 
display options are not taken into account, which means that faces are output even if 
SketchUp is in wireframe mode. Faces are not output, however, if they are hidden or if they 
reside on a layer that is hidden. 

Multiple Cameras 
3DS format can not store an orthographic camera. This format will be simulated through a 
perspective camera with a very small field of view or a very large lens length. The eye point 
will be moved as far away as is possible to yield the same width and height of the projection 
plane. Certain applications might have problems with a small field of view. For example, 
Maya does not read the field of view at all and only lets it become as small as 2.5. 
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Layers 
The 3DS format does not support layers. Any layers you assign in SketchUp will be lost. The 
DWG format might be a better solution if you need layers to export. Alternately, you can 
export with the “Color by Layer materials" option enabled, which might allow you to easily 
select and organize geometry in your model based on SketchUp layers once your model is 
imported into another application. 

Units 
SketchUp exports 3DS files at the units specified in the 3DS export options dialog box. This 
setting can affect the way geometry is described within the 3DS file. For example, a 1 meter 
cube in SketchUp will export to 3DS with sides of length 1 when units are set to meters. If 
you change the export units to centimeters, the same cube will export to 3DS with a length 
of 100. 

The 3DS format contains extra information that indicates the original units using a scale 
factor. This information allows an application that reads 3DS to automatically adjust the size 
of 3DS models to the correct "real world" size. 

Unfortunately, many applications ignore this extra unit scale information meaning that the 
centimeter cube imports as 100 times larger than the 1 meter cube, instead of at the same 
size. Worse, it is not always clear in which unit 3DS files are saved, resulting in considerable 
trial and error. In these cases, the best work-around is simply to export files at the units 
setting expected by the 3DS importing application. 

 = Functionality only available in Google SketchUp Pro 6 
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3D Model (VRML) Export 
VRML 2.0 (Virtual Reality Modeling Language) is a 3D scene/object description format often 
used to exchange data between 3D applications and to publish 3D information to the web. 
VRML files can store SketchUp geometry in the form of edges, faces, groups, materials and 
textures, transparency, camera views, and lights. 

Exporting VRML Files 
To export a VRML file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the VRML export type from the Format drop-down list. 

4. (optional) Click on the Options button. The VRML Export Options dialog box is displayed. 

5. (optional) Adjust the options in the VRML Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

VRML Export Options Dialog Box 
The VRML Export Options dialog box contains options for exporting VRML files. 

Geometry 
Use VRML Standard Orientation: The Use VRML Standard Orientation checkbox is used 
to export a file that conforms to the VRML standard. The VRML standard considers the XZ 
plane to be horizontal the ground plane) whereas SketchUp considers the XY plane to be 
the ground plane.  

Allow Mirrored Components: The Allow Mirrored Components check box is used to export 
components that have been mirrored or resized so they are an opposite of the original 
component. 

Output Edges: The Output Edges check box exports displayed edges as VRML edge 
entities. 

Materials 
Ignore Back of Face Materials: The Ignore Back of Face Materials checkbox is used to 
export both front and back faces with the front material. SketchUp exports VRML files with 
double faces so that files will be viewable from any viewpoint.  

Check for Material Overrides: The Check for Material Overrides check box is used to 
determine if any of the faces, edges, or components within this component contain 
references to the default material or default layer. 

Output Texture Maps: If enabled, SketchUp will export texture information to the VRML file. 
When disabled, it will export colors only. When publishing VRML files to the web, you may 
want to edit the files so that textures read from the relative location rather than from your 
local hard drive. Also, VRML texture and material names cannot have blanks, so SketchUp 
will use the underscore character instead. 

Use “Color by Layer” Materials: The VRML file format does not support layers directly. 
The Use "Color by Layer" Materials checkbox is used to assign VRML materials based on 
your model's layer assignments in SketchUp. Check this checkbox to export materials based 
on layers, such as when exporting to other rendering applications. 
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Cameras 
Generate Cameras from Scenes: The Generate Cameras from Scenes checkbox is used 
to create a camera for the default view as well as any SketchUp  Scenes which have been 
defined. The current SketchUp view is exported with the name “Default Camera”, and other 
Scene camera definitions are output using their Scene Name. 

 = Functionality only available in Google SketchUp Pro 6 
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3D Model (OBJ) Export 
The OBJ file format is a 3D file format created by Wavefront for use in their Advanced 
Visualizer™ product. These files text-based and support free-form and polygonal geometry. 
An additional .mtl file describes materials defined in the .obj file. 

Exporting OBJ Files 
To export an OBJ file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the OBJ export type from the Format drop-down list. 

4. (optional) Click on the Options button. The OBJ Export Options dialog box is displayed. 

5. (optional) Adjust the options in the OBJ Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

OBJ Export Options Dialog Box 
The OBJ Export Options dialog box contains options for exporting OBJ files. 

Geometry 
Export only current selection: The Export only current selection checkbox is used to 
export the currently selected geometry. The entire SketchUp model is exported when 
there is no selection. Additionally, the entire model is exported when this checkbox is 
not checked. 

Triangulate all faces: The Triangulate all faces checkbox is used to break the output 
into triangles instead of multi-sided faces. 

Export two-sided faces: The Export two-sided faces checkbox is used to export faces 
twice, once for the front and once for the back. This option doubles the number of 
polygons in the resulting OBJ file and can slow down rendering. However, this option 
ensures that your model will appear more like it appears in SketchUp. Both faces will 
always render, and materials applied to front and back faces are preserved. 

Export edges: The Export edges checkbox is used to write SketchUp line entities as OBJ 
line entities. Edges are ignored when this checkbox is not checked. Usually this checkbox is 
not checked because most applications will ignore edges on import. 

Materials 
Swap YZ coordinates (Y is up): The Swap YZ coordinates check box is used to output the 
model with the vertical direction as Y. This orientation is the default orientation for some 
applications, such as Maya. Do not check this box if you want your model to be output with 
the Z axis in the vertical direction, such as when using 3D Studio Max. 

Units: The units drop-down list is used to determine the unit size in the OBJ output. 
The Model Units setting is used to select the units that are being used in SketchUp.  
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Known Issues and Limitations 
OBJ file names 
OBJ files do not support spaces in their filenames. SketchUp will replace any space with an 
underscore (_) when the file is saved.  

Triangulation errors 
SketchUp will export one face entity as one polygon in an OBJ file. This ratio of faces to 
polygons can create some problems for some OBJ importers (polygons might appear 
missing or reversed). Use the Triangulate faces option to create additional polygons for 
importers that seem to have problems with the OBJ file exported from SketchUp. 
Additionally, you can import the OBJ file into an application that does not have problems 
with the SketchUp faces-to-polygons ratio and then export that file as another file type to be 
used in the less-qualified application. 

Flat set hierarchy 
The OBJ output supports a flat set membership hierarchy meaning that the format identifies 
which objects belong to any set. This output does not support a tree hierarchy because it 
cannot identify if one particular set is actually a component of another set. This limitation is a 
limitation of the OBJ format. 

NURBS 
SketchUp does not output nurbs or any of the advanced OBJ entities. SketchUp outputs 
polygon faces only. 

Maya and PNG or JPG files 
PNG and JPG images included in an OBJ do not always appear in Maya. This issue 
appears to occur due to a Maya bug on the Macintosh platform.  

 = Functionality only available in Google SketchUp Pro 6 
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3D Model (FBX) Export 
SketchUp allows you to export your models as Kaydara (FBX) files. Export a FBX file using 
the Export > 3D Model menu item in the File menu. 

Exporting a FBX File 
To export a FBX model file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the FBX export type from the Format drop-down list. 

4. (optional) Click on the Options button. The FBX Export Options dialog box is displayed. 

5. (optional) Adjust the options in the FBX Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

The FBX Export Options Dialog Box 
The XSI Export Options dialog box contains options for exporting XSI Files. 

Geometry 
The Geometry section of the FBX Export Options Dialog box is used to identify the geometry 
that will be exported. 

Export only current selection : The Export only current selection only checkbox is 
used to export the currently selected geometry. The entire SketchUp model is 
exported when there is no selection. Additionally, the entire model is exported when 
this checkbox is not checked. 

Triangulate all faces: The Triangulate all faces checkbox is used to break the output 
into triangles instead of multi-sided faces. 

Export two-sided faces: The Export two-sided faces checkbox is used to export faces 
twice, once for the front and once for the back. This option doubles the number of 
polygons in the resulting XSI file and can slow down rendering. However, this option 
ensures that your model will appear more like it appears in SketchUp. Both faces will 
always render, and materials applied to front and back faces are preserved.   

Materials 
The Materials section of the FBX Export Options Dialog box is used to identify how materials 
will be exported. 

Export texture maps: Check the Export texture maps checkbox to export textures with 
your FBX file. 

Scale 
The Scale section of the FBX Export Options Dialog box is used to identify the scale used in 
the F BX output. 

Swap YX coordinates (Y is up): The Swap YZ coordinates check box is used to output 
the model with the vertical direction as Y. This orientation is the default orientation for 
some applications, such as Maya. Do not check this box if you want your model to be 
output with the Z axis in the vertical direction. 
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Units: The units drop-down list is used to determine the unit size in the FBX output.  

 = Functionality only available in Google SketchUp Pro 6 
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3D Model (XSI) Export 
SketchUp allows you to export your models as Soft Image (XSI) files. Export a XSI file using 
the Export > 3D Model menu item in the File menu. 

Exporting a XSI File 
To export a XSI model file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save Asfield. 

3. Select the XSI export type from the Format drop-down list. 

4. (optional) Click on the Options button. The XSI Export Options dialog box is displayed. 

5. (optional) Adjust the options in the XSI Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

The XSI Export Options Dialog Box 
The XSI Export Options dialog box contains options for exporting XSI files. 

Geometry 
The Geometry section of the FBX Export Options Dialog box is used to identify the geometry 
that will be exported. 

Export only current selection : The Epxort only current selection only checkbox is 
used to export the currently selected geometry. The entire SketchUp model is 
exported when there is no selection. Additionally, the entire model is exported when 
this checkbox is not checked. 

Triangulate all faces: The Triangulate all faces checkbox is used to break the output 
into triangles instead of multi-sided faces. 

Export two-sided faces: The Export two-sided faces checkbox is used to export faces 
twice, once for the front and once for the back. This option doubles the number of 
polygons in the resulting XSI file and can slow down rendering. However, this option 
ensures that your model will appear more like it appears in SketchUp. Both faces will 
always render, and materials applied to front and back faces are preserved.   

Materials 
The Materials section of the XSI Export Options Dialog box is used to identify how materials 
will be exported. 

Export texture maps: Check the Export texture maps checkbox to export textures with 
your XSI file. 

Scale 
The Scale section XSI Export Options Dialog box is used to identify the scale used in the 
XSI output. 

Swap YX coordinates (Y is up): The Swap YZ coordinates check box is used to output 
the model with the vertical direction as Y. This orientation is the default orientation for 
some applications, such as Maya. Do not check this box if you want your model to be 
output with the Z axis in the vertical direction. 
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Units: The units drop-down list is used to determine the unit size in the OBJ output.  

 = Functionality only available in Google SketchUp Pro 6 
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3D Model (KMZ) Export 
The KMZ format is a zipped form of Google Earth's proprietary Keyhole Markup Language 
(KML). These files can contain location data (latitude and longitude) along with other 
information (such as SketchUp geometry). 

Exporting KMZ Files 
To export a KMZ file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the KMZ export type from the Format drop-down list. 

4. Click the Export button. 
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3D Model (DAE) Export 
SketchUp allows you to export your models as DAE (Collada) files. Export a DAE file using 
the Export > 3D Model menu item in the File menu. 

Exporting a DAE File  
To export a DAE file: 

1. Select File > Export > 3D Model.  

2. Enter a file name for the exported file in the Save As field. 

3. Select the DAE export type from the Format drop-down list. 

4. (optional) Click on the Options button. The DAE Export Options dialog box is displayed. 

5. (optional) Adjust the options in the DAE Export Options dialog box. 

6. (optional) Click the OK button. 

7. Click the Export button. 

The DAE Export Options Dialog Box  
The DAE Export Options dialog box contains options for exporting DAE Files. 

Geometry 
The Geometry section of the DAE Export Options Dialog box is used to identify the 
geometry that will be exported. 

Export only current selection: The Export only current selection only checkbox is used to 
export the currently selected geometry. The entire SketchUp model is exported when there 
is no selection. Additionally, the entire model is exported when this checkbox is not checked. 

Triangulate all faces: The Triangulate all faces checkbox is used to break the output into 
triangles instead of multi-sided faces. 

Export two-sided faces: The Export two-sided faces checkbox is used to export faces 
twice, once for the front and once for the back. This option doubles the number of polygons 
in the resulting DAE file and can slow down rendering. However, this option ensures that 
your model will appear more like it appears in SketchUp. Both faces will always render, and 
materials applied to front and back faces are preserved. 

Materials 
The Materials section of the DAE Export Options Dialog box is used to identify how 
materials will be exported. 

Export texture maps: Check the Export texture maps checkbox to export textures with your 
DAE file. 

Cameras 
The Cameras section of the DAE Export Options Dialog box is used to identify how cameras 
will be exported. 

Generate cameras from scenes: Check the Generate cameras from scenes checkbox to 
create a camera object in the DAE file for each default camera position from each scene in 
your SketchUp file. 
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Scale 
The Scale section of the DAE Export Options Dialog box is used to identify the scale used in 
the DAE output. 

Units: The units drop-down list is used to determine the unit size in the DAE output. 
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Section Slice Export 
SketchUp can save the active Section Slice as its own 2D file in the DWG and DXF formats. 
As with all vector information, section slice export has the advantage of preciseness. Export 
a section slice using the Export > Section Slice menu item in the  File Menu. 

Exporting Section Slices 
To export a section slice: 

1. Double-click on the Section Plane entity whose section slice you want to export. 

2. Select File > Export > Section Slice.  

3. Enter a file name for the exported file in the Save As field. 

4. Select the export type from the Format drop-down list. 

5. (optional) Click on the Options button. The Section Slice Export Options dialog box is 
displayed. 

6. (optional) Adjust the options in the Section Slice Export Options dialog box. 

7. (optional) Click the OK button. 

8. Click the Export button. 

2D Section Slice Options Dialog Box 
The 2D Section Slice Export Options dialog box contains options for exporting 2D section 
slice files. 

Drawing Size 
Width/Height: These values represent the overall dimensions of the slice output, and will 
update depending on the slice being exported and its scale. 

Drawing Scale 
Full Scale (1:1): When enabled, This outputs your section slice to CAD at a true 1:1 scale. 

In Drawing/In Model: These controls allow you to specify a certain drawing scale, and 
follow architectural conventions. The first measurement, labeled 'In Drawing' is the 
measurement of the exported geometry. The second measurement, labeled 'In Model' is the 
actual measurement of the object in real scale. 

For example, for a scale of 1/4" = 1', simply enter 1 inch in the output equals 4 feet in 
SketchUp. 

 Note - You can't export a perspective screen projection to scale. Also, 
even if the view is a paraline projection, only faces whose normals are 
perpendicular to the view angle will be measurable. 

Section Lines 
None: Outputs section slice lines at normal width. 

Polylines With Width: Outputs lines as polyline entities.   

Wide Line Entities: Outputs lines as wide line entities. This option is only available when 
saving AutoCAD 2000 or later DWG files. 
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Automatic/Width: When enabled, this automatically sets the width of profile lines by 
matching the output to the proportions you see in the SketchUp display. If disabled, you can 
specify an exact width. 

Projection 
The projection section contains options for selecting the type of exported file. 

True Section (Orthographic): This option outputs the section slice as a true orthographic 
drawing. This is useful for creating templates for CD drawings or any other time you want to 
generate accurate, measurable slices. 

Screen Projection (WYSIWG): This projects the section cut as you see it on your SketchUp 
screen, including any perspective distortion. This is most useful for diagrams that need not 
be measured. 

 = Functionality only available in Google SketchUp Pro 6 
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 Animation Export 
You can export animations as video animation files (  files) or as series of image file, one file 
for each frame per second of your presentation. Export an animation using the Export > 
Animation menu item in the  File Menu. 

 

Tip - Use the Animation Export feature when you need to provide a presentation of 
your model to a client who does not have SketchUp or the SketchUp viewer. Or, export a 
video animation for post-processing in another presentation software package. Use 
SketchUp for simple presentations or when the customer has the SketchUp viewer. 

Selecting Animation Type 
SketchUp supports both single video animation file export (in the form of a QuickTime file) 
and multiple image file export.  

Single Video File Animations 
SketchUp allows you to export animation as a single video animation file (QuickTime files). 
These files can be played using any compatible software video player or incorporated into a 
professional presentation using additional software presentation tools. SketchUp utilizes 
special third-party software called codecs (compressor/decompressor) to create these files.  

 
Each codec included with SketchUp implements a compression technique designed for a 
specific medium such as Web video, Email, or CD-ROM.  

Multiple Image File Animations 
SketchUp also allows you to export an animation as a series of progressive image files. The 
number of files exported depends on the frame rate for the presentation. For example, a 5 
minute presentation exported at 10 frames per-second will yield 3000 files (60 seconds x 5 
minutes x 10 frames per-second). Multiple image file animations are typically generated to 
use as input into video animation software products for post-processing. 

Exporting Animations 
Animation files can be used to present your model without the need for SketchUp. Or, you 
import your files into another presentation or animation product to further enhance your 
animations. To Export an animation as an animation file (or series of image files): 

1. Select the File > Export > Animation menu item. The Export Animation Dialog box is 
displayed. 
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2. Select the export type from the Export type drop-down list. 

3. Enter the name for the exported file or series of files. The animation exporter will combine 
this name with a sequencing number for each image file that is created as part of a 
multiple image file animation. For example, if you export a 1 minute presentation called 
mypres.jpg, at 10 frames per-second, you will get 600 files, each named mypres0001.jpg, 
mypres0002.jpg, mypress0003.jpg all the way to mypress0600.jpg. 

4. Click on the Options button. The Animation Export Options dialog box is displayed.  

 
5. Modify animation export options as necessary. See Animation Export Options in this topic 

for further information. 

6. Click on the Export button to export the presentation as an animation. 

The Animation Export Options Dialog Box 
The Animation Export Options dialog box contains options for exporting Animation files. 

Settings 
The settings section of the Animation Export Options dialog box contains options for 
controlling resolution and frame size for the video animation. 

Format: The Format drop-down list is used to select the combination of resolution, frame 
rate, and codec based on your particular output medium (Web, CD ROM, Email, and so on. 
For example, the suggested combination of settings for streaming a video over the Web is 
160x120 resolution at 10 frames per second using the Sorenson codec. 

Select Custom from the Format drop-down list configure your own custom 

Width/Height: The Width and Height fields are used to control the frame size of the 
animation, as measured in pixels. The smaller the width and height values, the smaller the 
overall size, in kilobytes, the video animation file. 

Tip - Computer screens can handle resolutions of 1024x768 pixels and 
above. However, 640x480 pixels is considered a full-size video. Typical videos 
are created at an even lower frame size. For example, 320x240 is yields 
acceptable data rates for CD-ROM, and transfers acceptably to videotape 
while 240x180 is acceptable for Web streaming. Values larger than 640x480 
are not recommended unless specifically require such as when creating Full 
Quality Digital Video similar to that of professional videographers. 
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 Note - Most personal computers can transfer 5 to 7 megabytes of data 
per second from the hard drive. The larger the frame size, the larger the 
resulting video animation file. Large video animation files can slow down your 
computer resulting in skipping.  

Aspect Ratio Lock: The Aspect Ratio Lock icon is used to maintain a fixed proportion of 
video at any frame size. Click on this lock to use a nonproportional frame size in your video 
animation. 

Frame Rate: The Frame Rate drop-down list is used to select the number of frames of 
animation per second (fps) of time in the presentation. The more frames per-second, the 
smoother the video animation. However, doubling the frame rate generally doubles the 
rendering time as well as the final size of the video. A setting between 8 and 10 is 
considered the minimum required for to produce smooth movement in your video animation. 
You might consider using a frame rate of 3 frames per-second while testing video animation 
export. 

 Note - There are frame rate requirements for certain mediums, such as 
29.97 fps for television in the United States, 25 fps for television in Europe, 24 
fps for film, and so on. 

 Note - Most personal computers can transfer 5 to 7 megabytes of data 
per second from the hard drive. The larger the frame rate, the larger the 
resulting video animation file. Large video animation files can slow down your 
computer resulting in skipping.  

Loop to Starting Scene: The Loop to Starting Scene option is used to generate an 
additional video segment that animates from the last scene of your presentation to the first 
(forming a continuous loop of video).  

Expert: Click the Expert button to launch the Compression Settings dialog box. This dialog 
box allows you to modify the settings used by a specific codec. 

Rendering 
The rendering section of the Animation Export Options dialog box contains options for 
rendering your video animation. 

Anti-Alias: The Anti-Alias option is used to smooth the exported image. This option can 
increase the export time, but helps to reduce jagged lines and pixilated artifacts in images. 

Transparent Background: The Transparent Background option is used to save the 
animation with a transparent background to aid in compositing. However, not all codecs are 
capable of storing transparency. Following is a list of codes that support transparency: 

 = Functionality only available in Google SketchUp Pro 6 
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Scenes and Animations 
Your SketchUp file can contain one or more scenes. A scene consists of your model and a 
series of scene-specific settings, such as a specific point of view, shadow, display setting, 
and section cut. For example you can have your model on one scene with a morning 
shadow and on another scene with your model and a evening shadow. Then, use the 
animation feature of SketchUp to cycle through the scenes and watch the shadow transition 
from morning to evening (this is called a shadow study). Link several scenes together, each 
with different settings, to form a animated tour of your model. Activate the  Scene Manager 
from the  Window menu to add, delete, and update scenes. 

Animations 
Animations are used to gradually transition the model from one state, in one scene, to 
another state in another scene.  

Running an Animation 
SketchUp contains controls for starting, stopping, and pausing an animation. To run an 
animation: 

1. Select the View > Animation > Play menu item. The animation controls are displayed and 
the animation starts to cycle through your scenes. 

2. Press the Pause button to pause the animation. 

3. Press the Stop button to stop the animation. 

 Note - You can also context-click on a scene tab and select 
Play Animation to begin an animation 

 Saving an Animation 
SketchUp animations can be exported as a video animation, or series of progressive raster 
images, using the File > Export > Animation menu item. Refer to Animation Export Options 
for further information. 

 = Functionality only available in SketchUp Pro 
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Printing 
Print Quality 

SketchUp allows you to print your designs using any Mac OS X-compatible printing device. 
Printing is a four-step process: 

1. Select the paper size for your printer using File > Page Setup 

2. Configure your model size printing using File > Document Setup 

3. Preview your output using File > Print > Preview 

4. Print your model using File > Print 

Tip - Select the File > Print menu item to print using paper size and model size 
defaults.  

The Page Setup Dialog Box 
The Page Setup dialog box is used to set paper size and orientation specific to your printer. 
This dialog box is the same as all standard Page Setup dialog boxes found in OS X 
applications. Select File > Page Setup to invoke the Page Setup dialog box. 

Settings 
The Settings drop-down list of the Page Setup dialog box contains a list of settings panels to 
appear in the Page Setup dialog box..  

Page Attributes: The Page Attributes panel contains primary configuration settings for the 
Page Setup dialog box. Its settings are defined below in detail. 

Custom Paper Size: The Custom Paper Size panel allows you to define custom paper 
sizes not currently configured for your selected printer.  

Caution - You can define a paper size that your printer is not capable of 
using. 

Summary: The Summary panel contains a summary of all current page attributes. You can 
use this panel to troubleshoot difficult print jobs, or to verify all the current page attributes in 
one quick view. 

Format for 
The Format For drop-down list of the Page Setup dialog box is used to select a specific 
printer and printer settings. Select the printer to use from the Name drop-down list.  

 Note - The Any Printer setting is a generic printer description that should 
set up a print job for any printer available. Use this setting if you are preparing 
a PDF file for printing on a printer that is not configured on your system. 

Paper Size 
The Paper Size section of the Page Setup dialog box is used to select the paper size used 
for your output. 

Orientation 
The Orientation section of the Page Setup dialog box is used to select the orientation 
(landscape or portrait) for your output. 
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Scale 
The Scale section of the of the Page Setup dialog box is used to override any SketchUp-
specific scale settings. 

The Document Setup Dialog Box 
The Document Setup dialog box is used to configure settings specific to the current 
SketchUp model. Use Document Setup to set the print size, print scale and to preview the 
number of pages required to print your drawing. Select File > Document Setup to invoke the 
Page Setup dialog box. 

Print Size 
The Print Size section of the Document Setup dialog box is used to determine the size of the 
page size for your output. 

Fit View to Page: The Fit View to Page option is used to size the model to fit on a single 
sheet of paper. This option must be disabled in to specify a different size or scale. 

Width/Height: The width and height fields are used to enter a custom page size for your 
output. If you define a size larger than the page size you selected in Page Setup, SketchUp 
will print your drawing on multiple pages (tiles) that you can affix together manually after 
printing. 

SketchUp will calculate the number of pages required to print your drawing at that size 
automatically, and display it below. 

Print Scale 
The Scale section of the of the Page Setup dialog box is used to override any SketchUp-
specific scale settings. 

In Drawing/In Model: The In Drawing/In Model fields are used to scale your model for 
printing. The first measurement, labeled In the Model, is the measurement of the exported 
geometry. The second measurement, labeled In SketchUp, is the actual measurement of the 
object in real scale. For example, for a scale of 1/4" = 1', simply enter 1 inch In Drawing 
equals 4 feet In Model.  

 Note - It is not possible to print a perspective image to scale. Ensure 
perspective is disabled and you are using one of the Standard Views in the 
Camera > Standard submenu, to enable the scale option.  

 Note - Even though paraline projection is used to get an output that is to 
scale, not all angles will be measurable to a scale. This issue is the result of 
SketchUp using foreshortening, or a technique of shortening lines to create a 
3D effect on a 2D medium such as paper.  

Pages Required (Section Tiling) 
If the current Scale is larger than the paper size of your printer or plotter, the entire model 
can be printed by printing on several pieces of paper. These pieces of paper can then be 
taped together to create the final scaled model. For example, tiling lets you print proofs of a 
large model, such as a B size (11" x 17"), on a printer that uses a smaller paper size, such 
as an A size (8.5" x 11"). Tiling also lets you print banners that are made up of multiple 
pagess.  

Tiling is available when you use the Scale fields to scale a model to be larger than the 
current paper size available in your printer.  
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You can display a preview of tile pages by clicking on the Preview button at the bottom of 
the Print dialog box. 

The Print Dialog Box 
The Print dialog box is used to send your output to a printer, PDF file, or Fax. This dialog 
box is the same as all standard Print dialog boxes found in OS X applications. Select File > 
Print to invoke the Print dialog box. 

The Settings drop-down list displays various settings panels within the Print dialog box. The 
settings drop-down list is in the middle of the Print dialog box and normally displays the 
Copies & Pages settings. 

The Copies and Pages Print Dialog Box Panel 
The Copies and Pages Print dialog box panel is used to control the number of copies and 
tiled output. 

Copies: The Copies section of the Print dialog box is used to select the number of copies to 
print Click the collate button if you want each copy to be collate (instead of printing several 
page ones, then several page twos, and so on). 

Pages: The Pages section of the Print dialog box is used to print selected page tiles within a 
set of tiled Pages by entering a page number range in the Pages from fields. Page tiles are 
numbered top to bottom beginning at the top left of the drawing page.  

The Layout Print Dialog Box Panel 
The Layout Print dialog box panel is used to select the orientation (landscape or portrait) for 
your output. 

The Scheduler Print Dialog Box Panel  
The Scheduler Print dialog box panel is used schedule the printing of your model for a later 
time. 

The Paper Handling Print Dialog Box Panel 
The Paper Handling Print dialog box panel is used alternate between printing odd or even 
numbered pages. 

The Color Sync Print Dialog Box Panel 
The Color Sync Print dialog box panel is used perform color conversion (if supported by your 
printer) and filters to your output. 

The Paper Feed Print Dialog Box Panel 
The Paper Feed Print dialog box panel is used select the tray that contains the paper you 
want to use. 

The SketchUp Print Dialog Box Panel 
There are a few SketchUp-specific settings in the Print dialog box that you can access by 
selecting SketchUp from the settings drop-down list in the middle of the dialog box.  

You can expedite the printing of print jobs and rough drafts by selecting the appropriate print 
quality. 

Draft: The Draft setting is used to produces quick images (usually output has jagged 
lines). 

Standard: The Standard setting is used to produce output with a the optimum balance 
of speed and quality. 

High Definition: The High Definition setting is used to produce high-quality output. 
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Ultrahigh Definition: The Ultrahigh Definition setting is used to produce the highest-
quality output. This setting can slow down your system, but is best for measured 
drawings or ultra-fine prints. 

Large Format: The Large Format setting produces images that are optimized for large 
format output or that are meant to be viewed from several feet away. Resolution and 
line weights are set accordingly. This setting is useful for plotters and tiled sheets. 

2D Section Slice Only: The 2D Section Slice Only option is used to output only the 
section slice outlines in your model (if present). 

Use High Accuracy HLR: The Use High Accuracy HLR option is used to send the 
model information to the printer as vector information.  

The Summary Print Dialog Box Panel 
The Summary Print dialog box panel contains a summary of all current page attributes. You 
can use this panel to troubleshoot difficult print jobs, or to verify all the current page 
attributes in one quick view. 

 = Functionality only available in Google SketchUp Pro 6 
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Technical Info 
This section of the documentation contains additional detailed information about various 
aspects of SketchUp. 
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Raster File Formats 
Raster images are made up of individual square colored pixels that, when combined, form 
some image. SketchUp supports several different raster image formats, each of which has 
its own particular advantages and should be selected depending on the task you want to 
perform. 

JPEG (Joint Photographic Experts Group) 
JPEG image files enjoy wide support across many applications, computer platforms, and 
digital cameras. The most prominent feature of JPEG is its compression scheme, which can 
reduce file size to a fraction of other formats. This compression scheme makes the JPEG 
format particularly useful for sending images, such as digital photographs, using email or for 
viewing on the world wide web. 

Tip - Consider using JPEG if your image contains lots of textured areas 
or fine detail 

JPEG compression works so well because it analyzes an image, divides it into blocks, and 
then discards the information which the human eye does not readily perceive. However, this 
high-level of compression yields a lower image quality and therefore, sometimes resulting in 
blocky patterns of color referred to as artifacts. JPEG images are referred to as  lossy 
because data is actually lost during the compression process and an uncompressed JPEG 
file will never be identical to the original file.  

 
The previous image shows the artifacts resulting from JPEG compression (in the right-most 
portion of the image). 

Fortunately, you can adjust the amount of JPEG compression to suit your needs using the 
File > Export > 2D Graphic Options > Image Quality slider bar.  

Tip - Resaving a JPEG image multiple times can result in compounded 
artifacts. Work with original raster images in a non-lossy format, such as PNG, 
before saving to JPEG for final output. 

PNG (Portable Network Graphics) 
The PNG format was developed for transferring images efficiently over the world wide web 
without data loss. Like JPEG, PNG does use compression, but it is a non-lossy variety that 
is free from artifacts. 
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Tip - Consider using PNG for models that have large areas of solid, 
uniform, colors (such as non-textured SketchUp models).  

TIFF (Tagged Image File Format) 
The TIFF file format is often used to exchanged files between applications and computer 
platforms (Mac and Personal Computers). There are a large number of variations to the 
TIFF format available, and therefore TIFF might not be as universally accessible as other 
formats such as PNG and JPEG. SketchUp supports as wide a range of TIFF formats as 
possible, and you should test compatibility with other applications before exporting to TIFF 
file. 1-bit raster files, or TIFF files with gif encoding, are not compatible with SketchUp. 

Also, while formats such as PNG and JPEG are viewable by any web browser and can 
therefore be sent to virtually any other person with good chance of success, TIFF files may 
require additional software to be viewed on some systems. TIFF is primarily used for high-
resolution printing from desktop publishing applications. 

 Note - SketchUp does not support TIFF files at 1 bit per pixel. Images 
compressed using RLE will expand to uncompressed sizes once imported into 
SketchUp. 

BMP (Bitmap) 
The BMP file format was created for Microsoft Windows operating systems primarily as the 
format used for the Microsoft Windows clipboard and for viewing (especially as wallpaper). 
BMP does not use compression. Therefore, BMP can be useful for creating temporary files 
to be further modified in other applications. However, BMP tends to create very large files 
that are not suitable for archive, web, and email use. 

TGA (Truevision Advanced Raster Graphics Adapter or Targa) 
TGA files were developed by AT&T for use with Truevision video boards, which brought high 
resolution and full color capability to early computers. Today, all personal computers have 
graphics capabilities that easily surpass the early Targa boards. Nonetheless, the TGA 
format remains in use today for its combination of non-lossy compression, stability, and 
alpha channel support. 

Epix 
Epix is the native format of Piranesi which is an architectural painting application designed to 
work with images generated from 3D models. See Piranesi Epix Export for more information. 
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2D Vector File Formats 
2D vector file formats have advantages over bitmap image export in that they produce 
drawings that are resolution independent and can be easily imported and modified in many 
other programs. These file formats are useful for creating a set of 2D construction 
documents, plotting a perspective in a large format, or for import into vector illustration 
software for further refinement . 

EPS 
Encapsulated PostScript format is based on PostScript, a graphics description language 
developed by Adobe as a standard way for graphics programs and print devices to 
communicate. EPS is widely used in the graphic design and publishing industries. 

PDF 
Adobe® Portable Document Format (PDF) is the open standard for worldwide electronic 
document distribution. PDF preserves all the fonts, formatting, graphics, and color of the 
source document, regardless of the application and platform used to create the document. 
Also, PDF files are compact and can be shared, viewed, navigated, and printed exactly as 
intended by anyone with free Adobe Acrobat® Reader® software. 

Caution - Some graphic features of SketchUp, including textures, 
shadows, smooth shading, backgrounds, and transparency, cannot be 
exported to PDF and EPS. 

DWG (AutoCAD Drawing File) 
DWG was created by AutoDesk as the file format for their AutoCAD program. There are 
many different versions of DWG, including DWG r12, r2000, and r2004.  

DXF (Data Exchange File) 
DXF is a 2D graphics file format supported by most all Macintosh and PC-based CAD 
applications. DXF was created by AutoDesk as the method for exchanging CAD data 
between their AutoCAD application and other CAD applications. 
  

The Anatomy of an Epix File 
The native file format of Piranesi is referred to as an Epix (Extended Pixel) file. In addition to 
storing the actual rendered image, Epix embed additional information from the original 3D 
model. This information allows Piranesi's paint tools to intelligently render the image. There 
are three "channels" of an Epix file: 

RGB: The first, known as the RGB Channel, contains the color of each pixel. This is the 
same data typically stored in other raster image formats. (In fact, Epix files are readable in 
most image editors as TIFF files.) 

Depth: The second, known as the Depth Channel, stores the distance of each pixel from the 
eye point. This information helps Piranesi understand the surface topology under the image 
and allows it to apply textures, scale objects, lock orientation, and many other capabilities 
dependant on the 3D surfaces of your model. 

Material: The third, a Material Channel stores the material for each pixel. This lets you paint 
one part of your rendering loosely without having to worry about painting another by 
mistake. 
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In General, Piranesi expects a flat shaded, non-textured Epix file. Some of the rendering 
modes in SketchUp, such as Wireframe and Hidden Line, don't really work well for Piranesi, 
and are disabled during export in favor of shaded output. 

Other features of SketchUp, such as edges and textures, are also different from that which 
Piranesi expects, yet may be desirable in many cases. While adding support for Epix files in 
SketchUp, we have tried to adhere to Piranesi's expectations whenever possible while 
retaining enough flexibility to accommodate the varying needs of different artists and 
renderers. 

  



 360

SketchUp and OpenGL 
3D applications, such as SketchUp, require abundant system resources. Aside from having 
a fast CPU and large amounts of RAM, your video card and video card drivers must be 
100% OpenGL compliant. 

What is OpenGL? 
OpenGL is the industry-standard, used in numerous software applications and games, to 
draw 3D geometry. Most Microsoft Windows and Apple OS X operating systems come with 
a software-based OpenGL driver. However, these drivers rely heavily on the CPU to perform 
the rendering calculations of OpenGL (a task that is not done efficiently by most CPUs). 

Many video card manufacturers have also built cards that support the OpenGL standard. 
These cards perform the rendering calculations using a specialized chip called the Graphics 
Processing Unit or GPU (instead of relying on the CPU). These chips significantly enhance 
OpenGL performance upward of 3000 percent. This performance enhancement is known as 
Hardware Acceleration. 

Hardware Acceleration 
SketchUp will can take advantage of hardware acceleration if your computer has a 100% 
OpenGL compatible video card. 

Unfortunately, only some 3D drivers in the consumer video card market are 100% OpenGL 
compatible and can use this feature (though many cards claim to be 100% OpenGL 
compatible). Most 3d drivers are designed for games, and are often not tested using other 
3D programs. Consequently, incompatibility problems can occur requiring a fix from the 
video card manufacturer. Disable this option if you are having problems with the 3D 
rendering of your models or if your video card is not 100% OpenGL compatible and does not 
support hardware acceleration. 

 Note - Hardware Acceleration might only be available on your system for 
certain resolutions and color depths. Check the system settings for your video 
card to see if it supports hardware acceleration (using the  System 
Preferences on Macintosh OS X). 

Google cannot control the quality of the OpenGL driver on your computer system. Video 
card device drivers are proprietary and are maintained solely by the manufacturer of the 
video card in your system. Therefore, Google cannot guarantee that SketchUp will work with 
hardware acceleration on your system.  

Compatibility Issues 
OpenGL incompatibility is a significant system configuration issue leading to problems with 
SketchUp. Difficulties with Sketchup tools, performance, and rendering (such as mysterious 
graphics appearing on your screen) are usually the result of a video card not fully supporting 
OpenGL (despite claims by the manufacturer), an out-of-date video card driver, or 
incompatibility with 32-bit color depth. A temporary solution is to disable hardware 
acceleration in SketchUp while troubleshooting the problem. 

Consult the Video Card Compatibility section of the Readme file (in the SketchUp installation 
directory) for additional details regarding compatibility issues for specific video cards.  
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Codec Lists 
SketchUp's animation export feature uses codecs (COmpressor/DECompressor) to create 
the appropriately sized video depending on your needs. Codecs differ in their intended use, 
compression method, and handling pictures and sound. If you plan to edit your video, you 
might want to choose a codec that provides higher quality at the expense of file size and 
compatibility. Conversely, if you plan to email your video or play it off a CD, you might want 
to select a codec that provides lower data rates at the expense of quality. Some codecs are 
also designed specifically for a certain device, such as a digital video camera. 

You can also choose to create uncompressed video by not using a codec. However, a large 
uncompressed animation file might require a fast system and very large amounts of disk 
space. 

OS X Codecs 
Following is an explanation of codecs that are included with SketchUp. 

Animation 
This codec works well for images that use large areas of solid colors, and is great for 
SketchUp images that have no textures or background gradients. It is lossy, but a 
compression setting of 100% is lossless. 

Apple H.263 
H.263 is a QuickTime codec designed for video conferencing at low data rates and may not 
be suitable for general-purpose video. 

Apple Pixlet Video 

Apple VC H.263 
This codec is a modified version of H.263 for iChat  

Cinepak 
This is the default codec for SketchUp. Although not as advanced as modern codecs, videos 
compressed using Cinepack will work reliably on any platform, play smoothly from CD-ROM, 
and will provide decent file size compression. Cinepak is asymmetrical and lossy. 

Component video 
This codec provides relatively little compression, which means files can get large. It's useful 
for archiving, or temporarily storing video. 

DV - PAL 
Used by PAL digital video hardware such as camcorders. 

Graphics 
This provides a high quality, 8-bit color image that can work well with SketchUp output. The 
compression ratio is low, however, which means that it might not be well suited to playback 
from CD-ROM or the web. 

H.261 
H.263 is a codec designed for video conferencing at low data rates and may not be suitable 
for general-purpose video. The H.263 requires half the bandwidth to achieve the same video 
quality as in the H.261. 
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JPEG 2000 

Motion JPEG A and Motion JPEG B 
These codecs are designed for many video-capture cards, which provide hardware 
acceleration for JPEG compression. 

MPEG-4 Video 
MPEG-4 is the new worldwide standard for interactive multimedia creation, delivery, and 
playback for the Internet. The MPEG-4 video codec is designed to provide the highest 
quality across a wide array of data rates over the Internet.  

None 
This option allows you to export your animation without any compression. 

Photo - JPEG 
The Photo JPEG codec is built into QuickTime and implements the Joint Photographic 
Experts Group ISO version 9R9 algorithm for image compression. This codec is generally 
used for storage of still images, but can also be used for editing and storage of high-quality 
video files.  

Planar RGB 
This is similar to the Animation codec in that it is effective for images that use large areas of 
solid colors. 

PNG 
The PNG codec implements the lossless PNG compression - decompression algorithm used 
by many Web browsers. 

Sorenson Video 
This is a very good codec for general video, and is great for playback from CD-ROM the 
web. It is similar to Cinepak, but provides better picture quality and smaller file sizes at the 
cost of lightly longer compression times. It also supports dynamic playback that 
automatically adjusts to available bandwidth and CPU resources. 

Sorenson Video 3 
Makes improvements over Sorenson Video in the form of higher quality video and better 
data compression. 

TGA 
The TGA codec implements the lossless TGA compression - decompression algorithm. 

TIFF 
The TIFF codec implements the lossless PNG compression - decompression algorithm. 

Video 
This provides high-quality playback from hard disk and moderate quality playback from CD-
ROM. It supports both spatial and temporal compression of 16-bit video. Data can be re-
compressed or recompiled later for higher compression ratios with minimal or no quality 
degradation. 
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SketchUp Ruby API and Console 
SketchUp contains a Ruby application programming interface (API) for users who are 
familiar with (or want to learn) Ruby scripting and want to extend the functionality of 
SketchUp. This interface allows users to create tools, menu items, and other macros, such 
as automated component generators, to be included in the menus within SketchUp. In 
addition to the API, SketchUp also includes a Ruby console which is an environment where 
you can experiment with Ruby commands or methods . 

For additional information on the Ruby programming language, visit www.rubycentral.com. 

Click on Help > Ruby Help for additional information on SketchUp Ruby API. 

Currently, Google does not offer technical support for the Ruby Application Programmers 
Interface (API) or for any Ruby scripts created by third parties. We encourage posting Ruby 
API questions to our SketchUp Ruby API Forum. General Ruby information may be obtained 
at http://www.ruby-lang.org/en/. 

Google reserves the right to change this policy at any time.  
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Uninstalling SketchUp 
Uninstallng SketchUp is as simple as dragging three folders and two files to the Trash. 

Uninstalling SketchUp on MacOS X 
Follow these steps to uninstall SketchUp on OS X: 

1. Navigate to the Applications folder (or wherever you installed SketchUp. For example, 
navigate to /Macintosh HD/Applications/ 

2. Drag the Google SketchUp 6 folder to the Trash. 

3. Navigate to the system-level Application Support folder. For example, navigate to 
/Macintosh HD/Library/Application Support/ 

4. Drag the Google SketchUp 6 folder to the Trash. 

5. Navigate to the user-level Application Support folder. For example, navigate to 
Jon/Library/Application Support/ 

6. Drag the Google SketchUp 6 folder to the Trash 

7. Navigate to the user-level Preferences folder. For example, navigate to 
Jon/Library/Preferences/ 

8. Drag the com.Google.sketchup.plist file and com.Google.LayOut.plist files to the Trash. 

9. Empty the Trash. 
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Common Tasks 
This section of the user's guide addresses common tasks that new users ask about as they 
are learning SketchUp. These tasks are covered within other topics in the user's guide, but 
are addressed as high-level topics here to facilitate the search capabilities of the online 
user's guide (so these issues are listed when a search is performed). 
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Activating the Sandbox Tools 
The sandbox tools do not appear in SketchUp by default, but can easily be enabled using 
the Extensions Manager (the Extensions panel of the Preferences dialog box). See Enabling 
the Sandbox Tools for further information. 
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Adding a Background to Your Model 
SketchUp allows you add image files to your model and position those images such that 
they act as a background. For example, you can have a single image placed vertically 
behind a house so that you can study what will be seen from certain angles within the 
house. 

See Importing 2D Graphic Images for further information. 
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Copying Geometry 
There are two ways to copy geometry in SketchUp: 

1. Use the Copy, and Paste commands 

Use the Copy and Paste commands to copy geometry. See Copy and  Paste for 
further information. 

2. Use the Move Tool 

Use the Move Tool if you want to create one or more copies of a piece of geometry at 
a specified distance intervals from the original piece of geometry. See Making Copies 
and  Creating Multiple Copies for further information. 
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Creating Models to Scale 
You can create models that are not based on any scale, useful for drafting quick concepts, 
or are based on some scale, useful for creating a final produced product. Models that are 
not created based on some scale, can be rescaled when accuracy becomes important. 

• Use the Measure Tape Tool to rescale an entire model to a specific scale. See Scaling an 
Entire Model for further information. 

• Use the Value Control Box to provide specific dimensions as you draw. The values 
accepted by VCB depend on the tool you are using. See the Value Control Box for further 
information. 
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Creating and Using Keyboard Shortcuts 
SketchUp contains a default set of keyboard shortcuts for most tools. These shortcuts are 
listed in SketchUp's menus and in the menu topics in this user's guide. You can also 
configure shortcuts using the Preferences panel of the Application Preferences dialog box. 
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Drawing Accurate Angled Lines 
Drawing accurate angled lines is a two-step process. To draw accurate angled lines: 

1. Use the Protractor Tool to create a guide line entity at some angle. See Measuring an 
Angle and Placing Angled guide lines for further information. 

2. Use the LineTool to trace over the guide line entity and create the line. See the Drawing a 
Line for further information. 
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Flipping or Mirroring Geometry 
A flip operation refers to making a mirror of your geometry. A mirror is creating a mirrored 
copy of your geometry.  

Flipping Geometry 
Flipping is useful when you want to create an exact mirror of your geometry. You can flip 
geometry by: 

1. Selecting the geometry to be flip. 

2. Context-clicking on the geometry. The context menu is displayed. 

3. Selecting the Flip Along context menu item.  

4. Choosing the direction or axis for the flip. The following image shows the geometry before 
the flip operation. 

 
The following image shows the geometry after the flip operation. 
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See Flip Along for further information. 

 Note - You can also use the  Scale Tool to flip or mirror geometry. 

Mirroring Geometry 
The process for mirroring geometry is essentially the same process as for flipping, but you 
are creating an additional copy. Mirroring allows you to create one half of a model and then 
duplicate and mirror that half to create the rest of the model. For example, you could create 
the left-side of a model of a car and then duplicate and mirror that side to create the right-
side of the car. The process to mirror geometry follows: 

1. Select the geometry to be mirrored. The following image shows the left-side of a car. 

 
2. Make a copy of the geometry 

3. Paste the copy. 

4. Context-click on the geometry. The context menu is displayed. 
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5. Select the Flip Along context menu item.  

6. Choose the direction or axis for the flip. The following image shows the left-side of the car 
and copy of the left-side of the car that has been flipped. 

 

See Flip Along for further information. 

 Note - You can also use the  Scale Tool to flip or mirror geometry. 
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Reorienting Materials 
You can reorient materials (skew, rotate, resize, and so on) using the Position Texture Tool. 
See Position Texture Tool for more information. 
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Using SketchUp With Google Earth 
You can use SketchUp with Google Earth to create 3D structures within the Google Earth 
environment. Refer to the Configuring Google Earth and Google Earth and SketchUp 
Workflow sections for further information. 
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Glossary 
A 
Angular Rotation Value - The value in the VCB that is displayed when measuring an angle 
with the Protractor Tool. 

Autofold - The process of skewing, distorting, or folding geometry by selecting a specific 
point on an edge or face and moving the points. See also Sticky. 

Axonometric - Meaning "measurable from the axes." An axonometric projection is a view of 
a model in which lines appear parallel in both 3 dimensional and 2 dimensional space, and 
lines have a length that is to some scale, (for example 1? in SketchUp = 1? in the real 
world).  

B 
C 
CAD - See Computer Assisted Design 

Camera - A software implementation of the user's point of view. See also Point of View. 

Camera Angle - See Point of View. 

Camera Tool - A software tool used to alter the user's point of view of a SketchUp model. 

Chord Length - The distance between the starting point and the ending point of an Arc 
entity. 

Component entity - An entity that contains other entities. Components are models that are 
saved as SketchUp files for reuse in other SketchUp files.  

Component Browser - The Component Browser is used to instance Component entities from 
component definitions, including those components that you create and a variety of pre-built 
Components that you can use in your models. 

Component Definition - The blueprint that defines the appearance and behavior of all 
component instances. Component definitions are created and stored in the Component 
Browser either as part of a Component Library or when you create a component. 

Component Instance - An instance of a component definition, such as an a single instance 
of an office chair component. You can have multiple component instances from the same 
component definition. 

Component Library - A series of related component definitions, such as a component library 
of doors or windows. 

Computer Aided Design - Software used for precision design. CAD is traditionally rigid and 
is often used for creating construction documents from which you would create the actual 
item you are designing. 

Construction Tools - Tools used to create construction geometry and prepare physical 
documentation. 

Context - An isolated realm that separates geometry within from anything outside. When you 
start a SketchUp model you are working within the model context. When you make a Group 
or Component you are essentially creating other contexts inside of the model context. When 
you edit groups or components you are in the group or component context. Certain 
commands or operations, such as the Unhide All command, scaling using the Measure Tool, 
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and placing active Section Planes, are limited to a particular context. Additionally, when you 
create and select other entities, you are essentially in the entity's context. 

Context Menu - A menu of menu items or commands available in a particular context, such 
as when a line or component is selected. 

Cutting Behavior - The ability of component entities to cut holes in faces. The component's 
cutting behavior is established when the component is initially created. 

Cutting Plane - A plane defining the exact location where the component will cut into a face.  

Coplanar - Refers to entities that existing in the same plane. 

Curved Face Set - A series of faces joined to make up a curved surface, such as a tube or 
arch. 

D 
Dialog Stack - Dialog boxes arranged such that they form a stack. 

Distort -Twisting out of natural shape. 

Drawing Area - The area within the Drawing Window where you create your model. See also 
Drawing Window. 

Default Material - A material assigned to all newly created faces. The default material is 
different for the front and back of faces. 

Drawing Tool - A software tool used to create entities and geometry from scratch. 

Drawing Window - The entire application window for SketchUp. The Drawing Window 
contains menus, toolbars, the status bar, and the Drawing Area. See also drawing area. 

E 
Edge-Based Modeling - A form of modeling in which a surface is automatically created for 3 
intersecting coplanar edges. 

Edge entity - Edges bound faces within geometry. The term edge and line are used 
interchangeably 

Entity - The smallest graphical building blocks in SketchUp. Entities are used to create 
geometry which, in turn, is used to create models.  

Extrude - The action of thrusting out or growing a form. 

Extrusion -A from that has been extruded. See Extrude. 

F 
Functional Terrain - Terrain that has no portion of itself bending back upon itself creating 
overhangs, underhangs or caves. 

Face entity - A planer entity bounded by 3 or more intersecting coplanar edges or lines. 

Face Shadows - Shadows projected onto horizontal faces by vertical faces based on the 
sun's angle in the sky. 

G 
Geometry - The combination of 3 or more entities. Geometry in SketchUp usually refers to a 
indistinguishable portion of a component or model. 
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Ground Plane - A flat or level surface representing the ground. In SketchUp, the ground 
plane is represented by the exact location of the red and green axes. 

Group entity - An entity that contains other entities. Groups are commonly used to combine 
several entities into a single entity for the purposes of performing a quick operation, such as 
a copy and paste. 

Gluing Behavior - The ability of component entities to align to faces in a specific orientation. 
The component's gluing behavior is established when the component is initially created. 

Ground Shadows - Shadows projected onto the ground plane by vertical faces based on the 
sun's angle in the sky.  

H 
Healing - The concept of joining two faces by erasing, or "healing" a line that intersects a 
face. Creating one face from two. 

I 
Inference - The identification of relationships between entities in the drawing area. These 
relationships are identified and pointed out to the user by the inferencing engine and can be 
used as references for drawing in 3D space.  

Inference Engine - Functionality built into SketchUp to locate or infer points from other points 
in your model, such as the center of a circle, the midpoint of a line, a line that is 
perpendicular to the ground plane, a point on a face, a point on an edge, and so on. The 
Inference Engine notifies you of these points by using both color indicators and on-screen 
messages indicating the location of the cursor as you draw an entity. For example, 
SketchUp displays the string ?From Point? when the line you are drawing is in plane with 
another point.  

Insertion Point - The point where the cursor will grab and insert the component in to a model 
from the component browser. 

Instance - see Component Instance. 

Intersection - The concept of splitting faces and edges to create additional independent 
faces and edges by intersecting the face or edge with a line. 

J 
K 
L 
Layer - Layers are used to control the visibility of geometry within large models. A SketchUp 
layer is an attribute with a name, such as "Layer0," "Layer9," or "Chairs." Elements can be 
assigned different layers. 

Layer Manager - A dialog box used to apply and manage layers in your model 

M 
Manager - A dialog box used to store and manipulate a specific aspect of SketchUp 
functionality such as scenes, components, or materials. 
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Material - Software-simulated paints that have both color and texture attributes. For 
example, a brick material might contain the color of red and a rough appearance or texture 
similar to real brick.  

Modal Dialog Box - A dialog box that temporarily prohibits the user's interaction with the 
application. Modal dialog boxes usually require the user to perform some action prior to 
returning to normal application use. 

Model - The contents of a SketchUp file. See also component. 

Modification Tool - A software tool used to modify existing entities or geometry. 

Modeless Dialog Box - A dialog box that does not prohibit the user's interaction with the 
application. See also Modal Dialog Box. 

Move Point - The point where you click on the entity with the Move Tool. 

O 
One-Point Perspective - In central perspective or one point perspective there is only one 
vanishing point (vp), which is located straight in front of the viewer: it is the vanishing point 
for the direction of view. This is not determined by our view, but the flat faces and tunnel 
walls of all objects within view. All lines drawn in the blue axes are exactly perpendicular to 
the ground plane and all of the lines drawn in the red and green axes are exactly 
perpendicular to the blue axes when viewing a 2 or 3 dimensional drawing viewed in one 
point perspective. 

Origin - The point where the Drawing Axes start or originate. 

Organic Shape - Geometry or models that have a hand-made or custom appearance. 

P 
Pan - A camera movement in which the camera turns side to side. 

Paraline - See Axonometric. 

Perspective - A distortion of the Camera Angle such that it represents the model as though 
you were standing at a fixed position and looking at it without moving (certain items appear 
closer while other items appear to be far away; entities are not to scale).  

Plane - A flat or level surface. 

Point of View - The user's view of the model.  

Polygon Mesh - A surface comprised of polygons, each derived from irregularly spaced 
points.  

POV - see Point of View. 

Principal Tools - Tools that tend to be used most often in SketchUp.  

Pulling - The process of reshaping your model by shrinking a portion of your model back 
toward its starting point along a single axis.  

Pushing - The process of reshaping a your model by expanding a portion away from its 
starting point and along a single axis.  

Q 
R 
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Ruby Console - Ruby console which is an environment where you can experiment with Ruby 
commands or methods. 

Ruby Script - A small program, written in the Ruby programming language, that adds 
functionality to SketchUp.  

Ruby Console - Ruby console which is an environment where you can experiment with Ruby 
commands or methods. 

Ruby Programming Language - An object oriented scripting language. 

S 
Sandbox - Surfaces created with the Sandbox from Scratch and Sandbox from Contours are 
referred to as sandboxes because like sand in a sandbox, these surfaces can be sculpted 
using a special set of tools called sandbox tools. Other terms for sandbox are terrain or 
Triangulated Irregular Network. 

Scene - Similar to a slide in presentation software, a scene consists of your model and a 
series of scene-specific settings, such as a specific point of view, shadow, display setting, 
and section cut. Scene can be combined to form animations in SketchUp. 

Score - A thin slice allowing for folding. 

Section Cut Effect - The result of slicing through your model to see inside and optionally 
modify its inner working. 

Section Plane - Special entities that are used to control the selection, placement, orientation, 
direction, of the section slice. 

Section Slice - The edges created by the intersection of geometry at a section plane.  

Segment - A segment is a single line that, when combined, form an arc, circle, or polygon. 
The more segments an entity has, the smoother it appears. 

Skew - To place at an angle. 

Split - The concept of creating two faces from one by dividing the face with a line.  

Stickiness - Entities are said to be "sticky" in that when connected to another entity, moving 
one entity might move or alter the another, attached, entity. See also Autofold. 

Surface - A series of joined faces. 

T 
Three-Point Perspective - in three-point perspective there are three vanishing points (vp), 
allowing you to construct a form in any orientation. Three-point perspective is usually used 
to represent three dimensions in a three-dimensional medium such as SketchUp. 

Tilt - A camera movement in which the camera tilts up or down. 

TIN - See Triangulated Irregular Network. 

Triangulated Irregular Network - A surface comprised of triangles, each derived from 
irregularly spaced points. This surface is also referred to as a Sandbox and Mesh. 

Triangulation - The orientation of triangles in a TIN (horizontal or vertical). See also 
Triangulated Irregular Network. 

Two-Point Perspective - In two-point perspective there are two vanishing points (vp), which 
are located to the left and right of the viewer.Two-point perspective is usually used to 
represent three dimensions on a two-dimensional medium. All lines drawn in the blue axes 
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are exactly perpendicular to the ground plane when viewing a 3 dimensional drawing viewed 
in 2 point perspective. 

U 
V 
Value Control Box (VCB) - The VCB displays dimensional information while you draw. You 
can also enter values into the VCB to manipulate the selected entity. 

W 
Walkthrough Tools - Tools used to view your model as through walking around and in your 
model 

X 
X-Ray Mode - A display setting whereby all faces have an applied global transparency. X-
Ray mode is useful for seeing, and sometimes editing, the inner workings of your model 

Y 
Z 
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Keyboard shortcuts, 267 
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Arc entity, 271 

Creating, 102 

Editing, 271 

Editing extruded, 272 

Introduction to, 271 

Segmentation, 272 
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Specifying precise values, 103 

Using, 102 

AutoCAD, 312, 313, 329 

Autofold, 24 

Axes, 28 

Axes tool, 26, 157 

Resetting the axes, 157 

Using, 157 

C 

Camera, 28 

Introduction to, 28 

Camera menu, 62 

Camera Tools, 28 

Camera tools context menu, 166 

Introduction to, 28, 166 

Next, 168 

Orbit tool, 177 

Pan tool, 178 

Previous, 167 
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Standard views, 169 

Zoom extents tool, 181 

Zoom tool, 179 

Zoom window tool, 180 

Circle entity, 273 

Creating, 109 

Editing, 273 

Editing extruded, 274 

Introduction to, 273 

Segmentation, 274 

Circle tool, 26, 109 

Locking orientation, 110 

Specifing precise values, 109 

Using, 109 

Codec, 361 

Introduction to, 361 

Common tasks 

Activating the sandbox tools, 366 

Adding a background to your model, 
367 

Copying geometry, 368 

Creating and using keyboard shortcuts, 
370 

Creating models to scale, 369 

Drawing accurate angled lines, 371 

Flipping or mirroring geometry, 372 

Introduction to, 365 

Reorienting materials, 375 

Using SketchUp With Google Earth, 
376 

Component browser, 229 

Context commands, 231 

Details menu, 232 

Finding a component, 229 

Inserting a component, 229 

Component entity, 32 

Axes, 35 

Cutting and gluing behavior, 35 

Layers, groups, and components, 35 

Libraries, 34 
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Component outliner, 256 

Details menu, 258 

Filtering, 257 
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Moving entities within, 257 

Naming entities in, 257 

Traverse hierarchies, 256 

Concepts, 15 

Adding realism to your models, 31 

designing in SketchUp, 16 

Drawing quickly, 21 

Modeling terrain and organic shapes, 
42 

Presenting your models, 39 

Viewing models in 3D, 28 

Connected faces, 23 

Manipulating, 23 

Construction tools, 26, 149 

3D text tool, 162 

Axes tool, 157 

Dimension tool, 158 

Introduction to, 149 

Protractor tool, 153 

Section plane tool, 164 

Tape measure tool, 150 

Text tool, 160 

Context, 33 

Introduction to, 33 

Context clicking, 78 
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Context menu items, 78 

Complete list, 301 

Introduction to, 78 

Coordinate system, 19 

Introduction to, 19 

Copy, 56, 116 

Copying geometry, 368 

Creating and using keyboard shortcuts, 
370 

Creating models to scale, 369 

Curve entity, 284 

Creating, 105 

Editing, 284 

Introduction to, 284 

Customizing the toolbar, 74 

D 

DAE, 343 

Export options, 343 

Exporting, 343 

DEM, 316 

Import options, 316 

Importing, 316 

Dialog boxes, 79 

Introduction to, 79 

Minimizing, 80 

Resizing, 80 

Snapping, 79 

Stacking, 79 

Dimension entity, 285 

Changing text, 285 

Creating, 158 

Introduction to, 285 

Dimension tool, 26, 158 
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Toggling dimension type, 159 

Using, 158 

Display settings 

Edge colors, 238 

Dividing and healing geometry, 21 

Drape tool, 43, 195 

Using, 195 

Draw menu, 64 

Drawing accurate angled lines, 371 

Drawing axes, 81 

Initroduction to, 81 

Drawing tools, 97 

Arc tool, 102 

Circle tool, 109 

Freehand tool, 105 

Introduction to, 97 

Line tool, 98 

Polygon tool, 111 

Rectangle tool, 107 

DWG/DXF 

2D graphic export options, 322 

2D graphic exporting, 322 

3D model export details, 329 

3D model export options, 329 

3D model exporting, 329 

3D model import options, 314 

3D model importing, 313 

Reducing import file size, 313 
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Edge, 16 

Smooth, 254 

Soften, 254 

Edge rendering 

Colors, 238 

Edit menu, 56 

Entities, 19, 269 

3D polyline, 270 

Arc, 271 

Circle, 273 

Component, 275 

Construction point, 288 

Curve, 284 

Dimension, 285 

Face, 286 

Group, 289 

Guide line, 287 

Image, 292 

Introduction to, 19, 269 

Line, 293 

Polygon, 294 

Section plane, 296 

Surface, 297 

Text, 300 

Entity, 269 

Entity info, 220 

Complete list, 307 

Details menu, 220 

EPIX, 327 

Exporting, 327 

Eraser tool, 26, 92 

Hiding edges, 92 

Introduction to, 92 

Soften edges, 92 

Using, 92 

Export, 311 

Exporting, 311 

2D DWG/DXF, 322 

2D EPIX, 327 

2D Graphics, 320 

2D PDF/EPS, 326 

3D 3DS, 330 

3D DWG/DXF, 329 
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3D KMZ, 342 

3D OBJ, 336 

3D VRML, 334 

3D XSI, 340 

3DDAE, 343 

Animation, 347 

Section slice, 165, 345 

Extension manager, 264 
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Face entity, 286 

Creating, 19 

Introduction to, 286 

FBX, 338 

Export options, 338 

Exporting, 338 

File menu, 51 

Flip edge tool, 43, 200 

Using, 201 

Flipping or mirroring geometry, 372 

Fog dialog box 

Fog options, 260 

Introduction to, 260 

Setting fog, 260 

Follow me tool, 26, 133 

Automatic extruding, 134 
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Creating a lathed shape, 136 

Preselecting the path, 134 

Using, 133 

Forum, 14 

Introduction to, 14 

Freehand tool, 26, 105 

Drawing 3D polylines with, 105 

Using, 105 
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Glossary, 377 

Google Earth, 202 

Configuring for SketchUp, 202 

Get current view button, 204 

Place model button, 206 

Toggle terrain button, 205 

Toggle terraing button, 205 

Workflow with SketchUp, 202 

Google toolbar, 202 

Get current view button, 204 

Get models button, 208 

Place model button, 206 

Share model button, 207 

Toggle terrain button, 205 

Group entity, 290 

Applying materials to, 290 

Creating, 289 
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Exploding, 290 

Introduction to, 289 

Groups, 32 

Guide line entity, 287 

Creating, 150, 154 

Erasing, 287 

Hiding, 287 

Introduction to, 287 

Guide point entity, 288 

Creating, 150 

Erasing, 288 

Hiding, 288 

Introduction to, 288 
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Help menu, 70 
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Image entity, 292 

File size and quality, 292 
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Introduction to, 292 
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Import, 311 

Importing, 311 

2D Graphics, 312 

3D 3DS, 315 

3D DEM, 316 
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Inference, 20 

Introduction to, 20, 84 

Inference engine, 19 

Input/Output, 311 

Introduction to, 311 

Instructor, 263 
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Using, 140 
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K 

Keyboard shortcuts, 267 

Configuring, 267 
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Layers, 29 

Adding, 252 

Introduction to, 29 

Moving geometry between, 252 

Layers manager, 252 

Color by layer, 253 

Details menu, 253 

Options, 252 

Line entity, 293 

Creating, 98 

Editing, 293 

Introduction to, 293 

Line tool, 26, 98 

Creating a face, 98 

Dividing lines by equal segments, 100 

Drawing lines by inference, 101 

Specifying precise values, 100 

Splitting a face, 99 

Splitting a line, 99 

Using, 98 

Look around tool, 28, 187 

Activating while in walk tool, 187 

Specifying eye height, 187 

Using, 187 
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Match 

Match Photo dialog box, 262 

Matching, 174 

Creating a 3D model to match a photo, 
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Introduction to, 170 
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photo's context, 171 

Photo Match session controls and 
context-menu items, 173 

Resuming a matching session, 173 
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session, 173 

Sketch-over-image session controls 
and context-menu items, 174 
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Materials, 31 

Default, 31 

Introduction to, 31 

Transparency, 31 
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Display, 60 
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Help, 70 

Introduction to, 13 

Tools, 65 

Window, 68 
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File panel, 212 

Location panel, 214 

Statistics panel, 215 

Text panel, 216 
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Units panel, 217 
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Application preferences, 264 

Component browser, 229 

Component outliner, 256 

Entity info, 220 

Introduction to, 209 

Layer manager, 252 

Model info, 210 

Page manager, 247 

Shadow settings, 250 

Soften/smooth edges, 254 

Modification tools, 113 

Follow me tool, 133 

Intersect with model tool, 140 

Introduction to, 113 

Move tool, 114 

Offset tool, 137 

Position texture tool, 142 

Push/Pull tool, 129 

Rotate tool, 120 

Scale tool, 125 

Move tool, 26, 114 

Autofold, 116 

Entering precise values, 118 

Making copies with, 116 

Moving by inference, 115 

Multiple copies with, 117 
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Using, 114 
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OBJ, 336 

Export options, 336 

Exporting, 336 

Exporting issues, 337 

Offset tool, 26, 137 

Offsetting lines, 137 

Repeating, 138 

Specifying precise values, 138 

Using, 137 

OpenGL, 360 
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Preferences, 266 
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Using, 177 
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Page, 350 
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Deleting, 248 

Manager, 247 

Updating, 248 
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Options, 247 
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Introduction to, 93 

Modifier keys, 93 
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Pan tool, 28, 178 

Panning while in other tools, 178 
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Panning while orbiting, 178 

Using, 178 

Paraline, 28 

PDF/EPS, 325 

Export details, 326 

Export options, 325 

Exporting, 325 

Perspective, 28 

Polygon entity, 294 

Creating, 111 

Editing, 294 

Editing extruded, 295 

Introduction to, 294 

Polygon tool, 26, 111 

Locking orientation, 112 

Specifying precise values, 111 

Using, 111 

Position camera tool, 28, 184 

Using, 184 

Position texture tool, 26, 142 

Context menu, 145 

Fixed pin mode, 142 

Free pin mode, 144 

Images as materials, 144 
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Pins, 142 

Projecting materials, 148 

Using, 142 

Wrapping textures around corners, 146 

Wrapping textures around cylinders, 
147 

Preferences, 264 

Previous, 167 

Principal Tools, 87 

Eraser tool, 92 

Introduction to, 87 

Paint bucket tool, 93 

Select tool, 88 

Printing, 351 

Introduction to, 351 
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Specifying precise values, 155 

Using, 153 

Push/Pull, 22 

Introduction to, 22 

Push/Pull tool, 26, 129 

Creating a starting face, 131 

Creating voids, 130 
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Repeating, 130 

Specifying precise values, 132 

Using, 129 
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Quick reference card, 14 

Introduction to, 14 
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Raster files, 357 

File formats, 356 

Rectangle tool, 26, 107 

Creating a square, 107 
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Specifying precise values, 108 

Using, 107 

Reorienting materials, 375 

Rescale, 125, 151 

Resizing, 125 
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Model, 151 

Rotate tool, 26, 120 

Copying, 121 

Creating multiple copies, 122 

Folding along an axis of rotation, 122 

Specifying precise values, 124 

Using, 120 

Ruby, 363 

Introduction to, 363 
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Sandbox, 42 

Creating, 43 

Introduction to, 42 

Modifying, 43 

Sandbox from contours tool, 43, 189 

Using, 189 

Sandbox from scratch tool, 43, 190 

Specifying precise values, 191 

Using, 190 

Sandbox tools, 43, 188 

Add detail tool, 197 

Drape tool, 195 

Enabling, 188 

Flip edge tool, 200 

Introduction to, 188 

Sandbox from contours tool, 189 

Sandbox from scratch tool, 190 

Smoove tool, 192 

Stamp tool, 194 

Scale, 125, 151 

Scale tool, 26, 125 

Controlling scaling direction, 127 

Options, 126 

Scaling 2d surface or image, 125 
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Scaling components, 126 

Specifying precise values, 127 
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Introduction to, 350 
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Introduction to, 39 
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Introduction to, 296 

Section plane tool, 26, 164 

Aligning the view, 165 

Creating grouped section slices, 164 

Exporting section slices, 165 

Manipulating section planes, 164 

Using, 164 

Using with pages, 165 

Select tool, 26, 88 

Deselect all, 91 

Expanding selection set, 91 

Introduction to, 88 

Multiple entities, 88 

Select all, 91 

Selection set, 90 

Using, 88 

Shadow settings, 250 

Details arrow, 251 

Options, 250 
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Shadows, 36 

Introduction to, 36 

On faces, 37 

On ground, 37 

Settings, 250 

Showing or hiding the toolbar, 74 

SketchUp 

Learning, 13 

Support, 10 

Training, 14 

Uninstalling, 364 

Uninstalling SketchUp on Mac OS X, 
364 

User interface, 45, 46 

versions, 7 

What's new in this release, 11 

SketchUp for Mac OS X, 8 

Smoove tool, 43, 192 

Specifying an offset, 193 
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Using, 192 
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Options, 254 

Stamp tool, 43, 194 

Using, 194 
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Printing, 169 
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Introduction to, 14 
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Introduction to, 233 
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Styles browser context menus, 243 
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Introduction to, 297 
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Tape measure tool, 26, 150 
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Locking a line to a specific inference 
direction, 152 

Rescaling your entire model, 151 
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Technical support, 10 
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Using, 268 
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Functional, 44 

Introduction to, 42 
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 393

Introduction to, 300 
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Placing screen text, 161 

Settings, 161 
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Deleting materials, 226 
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Introduction to, 221 
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Look around tool, 187 

Position camera tool, 184 
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Have your textedit page open 

# Open TextEdit

* Open a Finder window 
* Switch to the Applications folder 
* Scroll down to TextEdit and double-click on it

# Change the format to plain text 
TextEdit defaults to a rich text format, so you need to switch it to plain text to write HTML

* Open the Format tab 
* Choose "Make Plain Text" 
* You can also hit Shift-Apple-T to switch to plain text

Review last lesson as everyone did not get through it

You should have this much in your textedit > template page > once you have you can open 
your template page and save it as whatever name you wish.
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/
TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en"> 
<head> 
<title>Title of Page goes here</title> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
</head> 
<body>

</body> 
</html>

Blank Spaces and Paragraph Formatting 
Whitespace is characters such as space, tab or return ( Enter).

No matter how many whitespace characters you put in a row, or which ones you use, the browser 
will only show one single space. 
Line breaks, forced new line

If you want to force a line break use the tag <br />. the text following the <br /> tag will continue 
on the next line.

Don't use a <br / > tag at the end of every line. Let the browser wrap your text to 
fit. You don't know how wide the visitor's browser window is and your line lengths may not 
work well for them. This paragraph contains <br /> tags to attempt to demonstrate the 
problem. If this paragraph is not very annoying to read, you've struck a lucky line length. Try 
resizing your 
browser window a bit to see how awful it can be.

Use a <br /> tag when you deliberately have short lines, such as in poetry. 
Paragraphs

Begin paragraphs with a <p> tag and end them with a </p> tag. The browser will automatically skip 
a line between paragraphs.
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In HTML people often used to put a <p> tag between paragraphs to separate them, this is not correct 
in XHTML. Even in HTML, if you put any attributes in the <p> tag, then you will need a closing </p> tag. 

 

Today we will continute with paragraphs and headings. Firstly, we can make comments in our code 
that can not be seen by the viewer by putting in <!-- This is an example of a comment --> after 
the <head> tag

Adding comments to your XHTML documents to remind yourself, or to document to others what 
you were trying to do in your Web page. XHTML comments only appear in the page source, and 
are invisible to users browsing your page - i.e. Web browsers ignore the contents of XHTML 
comments. An XHTML comment example is shown here: 

and here

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/
xhtml1/DTD/xhtml1-transitional.dtd">

<!-- This is an example of a comment --> 
<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en"> 
<head>

<title>Title of Page goes here</title> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
</head> 
<body> 
boooooo 
</body> 
</html>

1. Put a comment in your page

2. XHTML Div - Breaking up a Page Into Divisions XHTML Div 

To break up a page into different divisions, follow 
these steps:
* At the start of the division, type "<div" 
* Optionally type in id="name", where name uniquely identifies the division. 
* Optionally type in class="name", where name corresponds to the name of the class that 
the division belongs to. 
* Type ">" to complete the opening div tag. 
* Create the contents of the division. 
* Complete the division by typing "</div>"
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Tips and Tricks on How to use the XHTML Div Tag

* A division is a block-level element - i.e., its contents automatically start on a new line. 
* id and class are optional attributes used to label your divisions, which can be used with CSS to 
create powerful page layouts. 
* The main difference between an id and a class is that class is for a group of elements while id is 
for identifying unique, individual elements. 
* You can nest div's - in the XHTML div example, an outer div with id="pagecontents" enclosed 
three nested div's. 
* Don't use tables to lay out your HTML pages - use div and span instead! That's the XHTML way!

Breaking up a page into divisions allows you to mark regions of your document, then, in 
conjunction with Cascading Style Sheets (CSS) you can globally apply styles to an entire region of a 
page. We'll cover more about CSS in our CSS tutorial section - for now, just remember that the 
XHTML div tag enables you to create more advanced layouts while making it easier to maintain pages 
by decoupling a page's content from its' layout. 
XHTML <div> Example

Here's an example XHTML code fragment that shows a very typical use of the div tag, used to 
structure the various parts of a webpage: 
Code Sample:

<div id="pagecontents">

<div class="leftnavigation"> 
<h3>Learning HTML</h3> 
<h3>Learning XHTML</h3> 
<h3>Learning CSS</h3> 
</div>

<div class="centercolumn"> 
<h1>Tables are Dead! Use &lt;div&gt;'s and CSS Instead</h1> 
<p>Div and Span tags along with CSS are the greatest invention since sliced bread.</p> 
</div>

<div class="rightcallout"> 
<h3>Did you Know?</h3> 
<p>The XHTML Div tag simplifies advanced page layouts?</p> 
</div> 
 
</div>

This goes after the <body> tag

thus your page looks like this 
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3. XHTML Span - Creating Inline Spans

To break up a page into different divisions, follow these steps:

* At the start of the division, type "<span" 
* Optionally type in id="name", where name uniquely identifies the span of content. 
* Optionally type in class="name", where name corresponds to the name of the class that the 
span belongs to. 
* Type ">" to complete the opening span tag. 
* Type in the contents of the span. 
* Complete the span typing "</span>"

# A span tag has no inherent formatting - you need to associate it with a particular style 
defined elsewhere, using the class or id attribute. 
# The difference between id and class is that id is for identifying individual, unique elements, where 
as class is used for a group of elements. 
# We'll learn how to use span with CSS later in the CSS tutorial section. 
# Don't use font tags to style inline elements - use span tags instead! 

The XHTML span tag alows you to further organize your page's content into smaller chunks or spans 
of information. By naming spans of text, you can use Cascading Style Sheets (CSS) to apply styles 
to those regions in a global manner. The XHTML span tag simplifies the development of 
advanced layouts by further decoupling a page's content from its' presentation on a more granular level. 
XHTML <span> Example

Here's an example XHTML code fragment that shows a typical use of the span tag, used to apply 
various formatting to certain in-line aspects of a page's contents: 
Code Sample:

<p>The XHTML span tag is useful for applying inline styles such as a different font  
<span style="font-size:large;">size</span> or <span style="color:red;">color</span>  
to your content.</p>

<p>You'll find that the span tag is <span style="font-style:italic;">very</span>  
helpful in maintaining consistent styles across your site.</p>

view code in new window. 
render sample in browser. 
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Download code sample on your computer.

The preceeding XHTML span example shows how you might use span tags to mark up certain aspects 
of a page, for example, code fragments, which might be displyed using a monospace font like 
courier new -- or to bring attention to certain key words that might require special emphasis, 
for example, through the application of an underline, bold, or larger font face. Every enclosed 
<span> references either a class or an id, which corresponds to a particular style defined in a 
stylesheet somewhere else - typically in a separate file. Using XHTML span you could then update 
your styles for code text, or emphasis text, or whatever, simply by updating a single stylesheet, 
rather then manually going through all of your documents, which is more managable and saves time.

4. Adding an Image (of course you need to have your image saved on your desktop or in your 
folder ) <img src="nameofyourimagefile.gif" height="100" width="100" alt="Sensible description of 
your image." />

if the image is on another server you will need to use the entire URL (eg: http://www.domain-of-
image.com/path/image.gif ). Usually you should avoid pulling images off of other servers. It slows 
down load time and if you don't have permission from the other site they could get angry at you 
for stealing bandwidth and remove the image or replace it with something you don't want.

Other img attributes (with CCS we will not be doing these as frequently

align

To make text wrap around an image you need to add an align attribute to the image tag. 
align="right" will put the image to the right side of the text and align="left" will put it to the left. If 
you want text inbetween two images, first put the one that is aligned right, then the one aligned 
left, and then the text that goes in the middle.

If the image is align="top" then the top of it is lined up to the top of the text.

If the image is align="bottom" then the bottom of it lines up to the bottom of the text.

If the image is align="center" then it puts its center at the bottom of the text These alignments are 
very quirky though. If these three lines were on the same line they won't work right. I very rarely 
use these, but I use "right" and "left" all the time. 
hspace, vspace

hspace stands for horizontal space, with it you can set how much space there is on the sides of an 
image before the text or next image.

vspace stands for vertical space, with it you can set how much space there is on the top and bottom 
of an image before the text or next image. 
Using image as a link

To use an image as a link, all you have to do is place it between a link <a href=....> tag and a </a> 
tag. You may place text within the same a href tag if you wish. Be extra sure to use useful alt text for 
an image used as a link.

There will be a border around the graphic in the same color as your links are when you use it as a link. 
If you don't want the border you will need to add border="0" inside the image tag. 
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# Open TextEdit

* Open a Finder window 
* Switch to the Applications folder 
* Scroll down to TextEdit and double-click on it

# Change the format to plain text 
TextEdit defaults to a rich text format, so you need to switch it to plain text to write HTML

* Open the Format tab 
* Choose "Make Plain Text" 
* You can also hit Shift-Apple-T to switch to plain text

Important File Saving Tips

For all around compatibility on the Web, it is important to follow these simple rules for saving any 
file that is meant for Web viewing. This includes the (X)HTML files along with any other files uploaded 
to your Web site.

* No capital letters in the file name. Use only lower case. Using uppercase letters are not 
necessarily harmful, but since web page file names are case sensitive, it makes it a lot easier if you 
use all lowercase. 
* No spaces or special characters. In example: & , " # 
* You may use a -dash or _underscore In example: my-file.html or my_file.html

Keep your blank "template.html" file handy as we delve deeper into XHTML.

Setting Up a Bare Bones Template File

A re-usable template file can be utilized as the base for all your web files. It can be saved as a new 
file name whenever you want to start a brand new web page.

New File

If you did not create and save your "template.html" file yet, please start with a new document in 
your text editor. Delete any coding your editor included in the new document. Save the file as 
"template.html". 

DOCTYPE Declaration

The first element that any web page should have is the DOCTYPE declaration. This informs the 
browser which "flavor" of (X)HTML you are using. This element is also extremely important 
when validating your page properly. 

There are three flavors (versions) of XHTML: Strict, Transitional, and Frameset. When first learning 
or "transitioning" into XHTML, it is best to utilize the Transitional DOCTYPE.

A Transitional DOCTYPE means that you are aiming to build strong XHTML pages, but are still using 
just a few little pieces of older (deprecated) code until more advanced coding can be learned.

The Transitional DOCTYPE looks like this: 
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<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/
TR/xhtml1/DTD/xhtml1-transitional.dtd">

There is no sense typing all this each time, so please highlight, copy and paste the above code 
into the top line of your template file. Be sure to keep the code exactly as written, and do not 
change any of the text.

Your cursor in your text editor should be blinking at the end of the pasted DOCTYPE coding. Click 
enter to move to the next line.

The Html Tag

As we have done in the previous two classes we need to tell the browser that this is an HTML page. 
So type the opening <html> tag and pair it with a closing </html> tag. Give yourself some space 
in between the opening and closing tags because all the other tags on our page will be nested in 
these two tags. Nested? That is a new word. Nested means surrounded by or enclosed inside. Tags 
can reside on their own, or be nested inside other tags.

Remember that the FIRST tag opened, must be the LAST tag closed. 

Here is the coding for your template file so far: 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html>

</html>

The Namespace Declaration

We need to add a little bit of coding to that opening <html> tag to make it valid for XHTML 
standards. But since it is a bit confusing to type, you might want to copy and paste the text below 
into Notepad:

<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en">

This tells browsers and validation services that the web page is written in English (en) and that 
the version of xml is also in English.

It also states that the xml namespace (ns) for this page is located at the listed online address. 
The address is a page listed at The World Wide Web Consortium (W3C) which is the Web site 
that develops the HTML and XHTML standards. Sort of like the Big Boss of Web coding 
languages. Decisions about what code is "downgraded" (deprecated) and what code is "the 
standard" come from this Consortium.

To learn more about the W3C, please check out http://www.w3.org/. There, it is a bit overwhelming 
to read.

Here is how our template file is shaping up. Notice the new <html> tag including the namespace 
has replaced the original <html> tag. 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en">

</html> 
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xhtml

Type the the <head> and </head> tags right after the opening <html> tag.

Nest the <title> and </title> in between the <head> and </head> tags. See below: 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/
xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en"> 
<head> 
<title>Title of Page goes here</title> 
</head> 
</html>

Some facts about the <title> tag:

* The <title> tag is always nested in the <head> tag. 
* The <title> tag is where you type the text to briefly describe your web page. 
* This text will not be viewable as web page content, but it will be viewed at the top of the 
browser window. 
* The text you type in the <title> tag will also be used when someone saves your page to their 
favorites list or bookmark list. 
* It is also very important for search engine optimization, as most search engines (Google) describe 
your page by using the <title> text. 
* Only text is allowed in the title area. No tags or other formatting. Keep it simple!

The Body Tag

The <body> opening tag needs to be paired with a closing </body> tag. The opening <body> tag 
is typed after the closing </head> tag. The closing </body> tag is typed before the closing </
html> tag.

The <body> tag is very important. The content of your page is contained inside the body. Whatever 
you want viewed on your web page (other tags, text, images, etc) must be nested in between 
the <body> and </body>. Give yourself a few lines of space in between the two tags so there will 
be room for your page contents.

And this is what you should have on your template page so far.

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/
TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en"> 
<head> 
<title>Title of Page goes here</title> 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
</head> 
<body>

</body> 
</html>
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texitedit

Using the text edit pad on mac NEXT

Applications > textedit

Firstly go to Preferences (the Open and Save tab) and check "Ignore rich text 
commands in HTML files".

textedit
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Space

subscribe directory contact

serious alternative working situation

mid-century modern 
 
Lorem ipsum placerat quisque molestie. mauris accumsan, lectus sit amet venenatis ornare, dui 
sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac dolor 
sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis scelerisque 
consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat enim in 
massa. nunc ac dolor sit amet dui ultricies facilisis. suspendisse turpis. proin libero leo, rhoncus 
id, pharetra non, laoreet eu, sem. praesent mattis laoreet velit. nunc vehicula congue nulla. cras 
vestibulum diam vitae pede  
ornare, dui sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis 
scelerisque consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. 
 
ulvinar metus velit vel justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac 
dolor sit amet dui ultricies facilisis. Lorem ipsum placerat quisque molestie. mauris accumsan, 
lectus sit amet venenatis ornare, dui sapien consequat purus, eget pulvinar metus velit vel 
justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum euismod. nunc ac dolor sit 
amet dui ultricies facilisis. nunc ac dolor sit amet dui ultricies facilisis. nullam eu enim. mauris 
placerat enim in massa. nunc ac do 

Nec lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. 

finnish woods 
 
onsequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc 
ac dolor sit ame venenatis ornare, dui 
sapien consequat purus, eget pulvinar 
metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. 
nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. 
Lorem ipsum placerat quisque molestie. 
mauris accumsan, lectus sit amet venenatis 
ornare, dui sapien consequat purus, eget 
pulvinar metus velit vel justo. ut pulvinar 
venenatis quam. nam sed urna nec lacus 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. nullam eu enim. nullam 
tristique, nunc quis scelerisque consequat, 
leo wisi aliquet enim. sed urna nec lacus 
rutrum euismod. nunc ac dolor sit ame 
venenatis ornare, dui sapien consequat 
purus, eget pulvinar metus velit vel justo. ut 
pulvinar venenatis quam. nam sed urna nec 
lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. mauris accumsan, lectus 
sit amet venenatis ornare, dui sapien 
consequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar.
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Space

subscribe directory contact

serious alternative working situation

pastels in small spaces 
 
Lorem ipsum placerat quisque molestie. mauris accumsan, lectus sit amet venenatis ornare, dui 
sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac dolor 
sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis scelerisque 
consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat enim in 
massa. nunc ac dolor sit amet dui ultricies facilisis. suspendisse turpis. proin libero leo, rhoncus 
id, pharetra non, laoreet eu, sem. praesent mattis laoreet velit. nunc vehicula congue nulla. cras 
vestibulum diam vitae pede  
ornare, dui sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum euismod. nunc ac 
 
ulvinar metus velit vel justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac 
dolor sit amet dui ultricies facilisis. Lorem ipsum placerat quisque molestie. mauris accumsan, 
lectus sit amet venenatis ornare, dui sapien consequat purus, eget pulvinar metus velit vel 
justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum euismod. nunc ac dolor sit 
amet dui ultricies facilisis. nunc ac dolor sit amet dui ultricies facilisis. nullam eu enim. amet dui 
ultricies facilisis. nullam eu enim. nullam tristique, nunc quis scelerisque consequat, leo wisi 
aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat enim in massa. nunc ac do 

Nec lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. 

textured white walls 
 
onsequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc 
ac dolor sit ame venenatis ornare, dui 
sapien consequat purus, eget pulvinar 
metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. 
nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. 
Lorem ipsum placerat quisque molestie. 
mauris accumsan, lectus sit amet venenatis 
ornare, dui sapien consequat purus, eget 
pulvinar metus velit vel justo. ut pulvinar 
venenatis quam. nam sed urna nec lacus 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. nullam eu enim. nullam 
tristique, nunc quis scelerisque consequat, 
leo wisi aliquet enim. sed urna nec lacus 
rutrum euismod. nunc ac dolor sit ame 
venenatis ornare, dui sapien consequat 
purus, eget pulvinar metus velit vel justo. ut 
pulvinar venenatis quam. nam sed urna nec 
lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. mauris accumsan, lectus 
sit amet venenatis ornare, dui sapien 
consequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar.
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Space

subscribe directory contact

serious alternative working situation

bright colors 
 
Lorem ipsum placerat quisque molestie. mauris accumsan, lectus sit amet venenatis ornare, dui 
sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac dolor 
sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, 
 
lvinar metus velit vel justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac 
dolor sit amet dui ultricies facilisis. Lorem ipsum placerat quisque molestie. mauris accumsan, 
lectus sit amet venenatis ornare, dui sapien consequat purus, eget pulvinar metus velit vel 
justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum euismod. nunc ac dolor sit 
amet dui ultricies arcu. mauris placerat enim in massa. nunc ac dolor sit amet dui ultricies 
facilisis. suspendisse turpis. proin libero leo, rhoncus id, pharetra non, laoreet eu, sem. 
praesent mattis laoreet velit. nunc vehicula congue nulla. cras vestibulum diam vitae pede  
ornare, dui sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis 
scelerisque consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat 
enim in massa. nunc ac do 

Nec lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. 

a bit of the mod 
 
onsequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc 
ac dolor sit ame venenatis ornare, dui 
sapien consequat purus, eget pulvinar 
metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. 
nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. 
Lorem ipsum placerat quisque molestie. 
mauris accumsan, lectus sit amet venenatis 
ornare, dui sapien consequat purus, eget 
pulvinar metus velit vel justo. ut pulvinar 
venenatis quam. nam sed urna nec lacus 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. nullam eu enim. nullam 
tristique, nunc quis scelerisque consequat, 
leo wisi aliquet enim. sed urna nec lacus 
rutrum euismod. nunc ac dolor sit ame 
venenatis ornare, dui sapien consequat 
purus, eget pulvinar metus velit vel justo. ut 
pulvinar venenatis quam. nam sed urna nec 
lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. mauris accumsan, lectus 
sit amet venenatis ornare, dui sapien 
consequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar.
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Space

subscribe directory contact

serious alternative working situation

white woods vs. dark 
 
Lorem ipsum placerat quisque molestie. mauris accumsan, lectus sit amet venenatis ornare, dui 
sapien consequat purus, eget pulvinar metus velit vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac dolor 
sit amet dui ultricies facilisis. nullam eu enim. nullam tristique, nunc quis scelerisque 
consequat, leo wisi aliquet enim, vitae scelerisque elit orci sed arcu. mauris placerat enim in 
massa. nunc ac dolor sit amet dui ultricies facilisis. suspendisse turpis. proin libero leo, rhoncus 
id, pharetra non, laoreet eu, sem. praesent mattis laoreet velit. nunc vehicula congue nulla. cras 
vestibulum diam vitae pede  
 
ulvinar metus velit vel justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. nunc ac dolor sit amet dui ultricies facilisis. nunc ac 
dolor sit amet dui ultricies facilisis. Lorem ipsum placerat quisque molestie. mauris accumsan, 
lectus sit amet venenatis ornare, dui sapien consequat purus, eget pulvinar metus velit vel 
justo. ut pulvinar venenatis quam. nam sed urna nec lacus rutrum etrum euismod. nunc ac 
dolor sit amet dui ultricies facilisis. nunc ac dolor sit amet dui ultricies facilisis. nullam eu enim. 
nullam tristique, nunc quis scelerisque consequat, leo wisi aliquet enim, vitae scelerisque elit 
orci sed arcu. mauris placerat enim in massa. nunc ac do 

Nec lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. 

against the grain 
 
onsequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar venenatis quam. nam 
sed urna nec lacus rutrum euismod. nunc 
ac dolor sit ame venenatis ornare, dui 
sapien consequat purus, eget pulvinar 
metus velit vel justo. ut pulvinar venenatis 
quam. nam sed urna nec lacus rutrum 
euismod. nunc ac dolor rutrum euismod. 
nunc ac dolor sit amet dui ultricies facilisis. 
nunc ac dolor sit amet dui ultricies facilisis. 
Lorem ipsum placerat quisque molestie. 
mauris accumsan, lectus sit amet venenatis 
ornare, dui sapien consequat purus, eget 
pulvinar metus velit vel justo. ut pulvinar 
venenatis quam. nam sed urna nec lacus 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. nullam eu enim. nullam 
tristique, nunc quis scelerisque consequat, 
leo wisi aliquet enim. sed urna nec lacus 
rutrum euismod. nunc ac dolor sit ame 
venenatis ornare, dui sapien consequat 
purus, eget pulvinar metus velit vel justo. ut 
pulvinar venenatis quam. nam sed urna nec 
lacus rutrum euismod. nunc ac dolor 
rutrum euismod. nunc ac dolor sit amet dui 
ultricies facilisis. nunc ac dolor sit amet dui 
ultricies facilisis. Lorem ipsum placerat 
quisque molestie. mauris accumsan, lectus 
sit amet venenatis ornare, dui sapien 
consequat purus, eget pulvinar metus velit 
vel justo. ut pulvinar.
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return to Gif Stories from Compu

return to Gif Stories from Computer Writing second trimester class

Christopher's story

next story - Rachael K
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return to Gif Stories from Compu

return to Gif Stories from Computer Writing second trimester class

Kyle's story

next story - Nathan's story
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return to Gif Stories from Compu

return to Gif Stories from Computer Writing second trimester class

Nathan's story

next story - Jeffery's story
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return to Gif Stories from Compu

return to Gif Stories from Computer Writing second trimester class

 Rachael K.'s story

next story - Niki's story
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return to Gif Stories from Compu

return to Gif Stories from Computer Writing second trimester class

Niki 's story

next story - Vivan's story  
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return to Gif Stories from Computer Writing second trimester class

 Vivian 's story

next story -  Kyle's story

http://neuage.org/AA/gif/vivian-story1.htm [3/9/08 1:31:42 PM]
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return to Gif Stories from Compu

return to Gif Stories from Computer Writing second trimester class

Jeffery 's story

next story - Christopher's Story

http://neuage.org/AA/gif/jeffery-story1.htm [3/9/08 1:40:22 PM]
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Essential Technologies (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works

Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar INDEX FOR THIS 
TRIMESTER 

NOTE 1: Front Page, like everything in life, will only be around for a short time. If we get 
Dreamweaver before the end of the trimester we will use that. However, there are many things we can 
learn about making a webpage using Front Page that will be transferable to other web design tools.

"Microsoft will close the book on its FrontPage Web-design program with the release of Office 2007, 
formerly known as Office 12, late this year..." Wednesday, posted at PC World February 15, 2006.  
 

Microsoft's new product coming out soon "Microsoft® Expression®" with Office 2007 will use many of 
the features we will be learning.

NOTE 2:We are using Front Page 2003 but our books are 2002. When 
there are differences I will point them out as I see them.

Even though FrontPage will "gradually" fade away and is no longer 
being upgraded by Microsoft what we will cover in this class is usable 
in other web developing programs. 

To get three points for today you must do exercise secondly, thirdly 
and fourthly. Note that thirdly and fourthly must be save in your 
FrontPage  folder labeled  Lesson 1 with your answers saved as exercise 2 and exercise 
3. You will need to write them in Word first then save them as exercise 2 and exercise 3.

http://neuage.org/AA/et/notes3/3-07.htm (1 of 3) [3/9/08 1:40:29 PM]
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Add the terms on page 10 and 16 to your 'Terms" folder or document that you began yesterday and 

saved in FrontPage  folder. 

This is the basis of all web pages and what we learn today will be useable in any webpage making 
program.

You will need to know HTML - what it is and how to work with it.

After reading these pages start a new page and try different lettering in "Split" view. What is the tag for 
Bold? and Italics  and Underline?

Go to your blog. Firstly write your answers in Word, secondly, paste them into your blog at the end of 
the class. 

Read pages 10 - 24 in the book and do the exercises on page 15 and on 24. Pages 11- 13 are the most 
important part of the whole course - learn the tags.

NOTE - on page 15     ON YOUR OWN answer questions 6, 7, 8 and 12 and in FrontPage  

folder labeled  Lesson 1 save your answer as exercise 2.

http://neuage.org/AA/et/notes3/3-07.htm (2 of 3) [3/9/08 1:40:29 PM]
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fourthly

Do the exercise on page 24 and save it as exercise 2-index.htm in your  FrontPage  folder 

labeled  Lesson 1 save your answer as exercise 2-index.htm

http://neuage.org/AA/et/notes3/3-07.htm (3 of 3) [3/9/08 1:40:29 PM]
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Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar INDEX FOR THIS 
TRIMESTER 

March 09 Thursday

At the end of today's exercises for ten points, 2.5 each, you will have the following saved in your lesson 1 
folder. Every day late it is one-point less. 

These exercises do not take more ten minutes each to do. Following instructions is an important part of life

in your FrontPage  folder labeled  Lesson 1
2.5 
points

exercise 2

2.5 
points

2.5 
points

  of course your name for your website will be different than mine

2.5 
points

Hexadecimal

 worth  2.5 points if I see exercise 2 in your FrontPage  folder labeled  

Lesson 1
If you have not yet done it - read pages 10 - 15 in the book and do the exercises on page 15.  Pages 11- 13 are 
the most important part of the whole course - learn the tags.

NOTE - on page 15  - these answers are on the previous pages -  ON YOUR OWN answer questions 6, 7, 

http://neuage.org/AA/et/notes3/3-09.htm (1 of 4) [3/9/08 1:40:34 PM]
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8 and 12 (you can do these answers either in a Word document or in FrontPage) and in 

FrontPage  folder labeled  Lesson 1 save your answer as exercise 2.

 worth  2.5 points if I see the web folder  in your FrontPage  

folder labeled  Lesson 1
Read pages 16 - 21 on creating a web site using a template

Do the exercises on page 22 

You will need to carefully follow these steps. Once you have it right this time then you will be right as rain for 
the rest of your life or at least this course or at least for the next few weeks - which ever comes first... 

A.  As is shown on page 17 begin a new web template by selecting File > New >  New Web site  "One 
page Web site..."

B.  At the end of where it will be saved - in this case it goes to your desktop  > C:\Documents and Settings
\YOURNAME\My Documents\My Web Sites\glass YOU WILL NEED TO TYPE IN THE WORD 

glass FOLLOWING \My Web Sites\

C.  What happens next is as is described on page 17 and again in the exercise (#3) that you will do on page 
22 - you will have three files in your folder view such as 

D.  Proceed as is described on page 22 step 4
E.  NOW FOR THE crucial STEP. In order for me to see your work in your folder you will need to drag 

the "Glass folder" into your FrontPage  folder labeled  Lesson 1. Of course as you 
know you will need to open My Computer and navigate to your "my Documents" folder" where you 
will behold the presence of your "My Web Sites" folder - and at the same time you will need to have 

http://neuage.org/AA/et/notes3/3-09.htm (2 of 4) [3/9/08 1:40:34 PM]



FrontPage

your FrontPage  folder labeled  Lesson 1 opened. 

 in this "special" place will reside each new web site folder 
that you will make. 

F.  Your folder will have all the stuff in it - including index.htm so at the end this is what I will 

see when I wander into the depths of your FrontPage  folder labeled  Lesson 1 = 

 worth  2.5 points if I see the web folder if I see your new website in your folder.

Do the exercise on page 24 and save it as WHAT YOUR NEW WEB SITE (AS DESCRIBED ON PAGE 

24) WILL BE CALLED [FOR EXAMPLE I SET UP MY EXAMPLE AS ] in your  

FrontPage  folder labeled  Lesson 1 

TO DO BEFORE LEAVING THIS SECTION:

http://neuage.org/AA/et/notes3/3-09.htm (3 of 4) [3/9/08 1:40:34 PM]
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■     If you skipped any pages so far - go back and know these pages. On page 13 'DISPLAY HTML TAGS' 
do that now in your FrontPage window. (View > Reveal Tags)

■     Click the 'Split' view button at the bottom of the FrontPage window. Watch what happens as you type 
something here - try putting it in bold - deselect the bold. Notice how the html code brackets what you 

write in bold - <b> try putting it in bold - </b>  Try different font sizes; for example big, small, 
green, orange, underline, italics, and covered in poo colour. 

  worth  2.5 points if I see the web folder if there is Hexadecimal in your folder.

I.  Open Word and save your document as Hexadecimal in your FrontPage  folder labeled  

Lesson 1
II.  Find the MAJOR HEXADECIMAL COLOUR CODES somewhere online and in a Word 

document list the Hexadecimal codes for the colours listed below. For example, by 
looking in the code in FrontPage - when you have "Split" view happening you will see the number for 
Light Purple is <font color="#ff0080">Light Purple</font> so you would write  Light Purple is #ff0080

1.  Dark Purple
2.  Black
3.  Red
4.  White
5.  Green
6.  Pale Violet Red
7.  Medium Aquamarine
8.  Khaki
9.  Dark Salmon

10.  Lemon Chiffon
11.  What is the Hexadecimal numbering system?

http://neuage.org/AA/et/notes3/3-09.htm (4 of 4) [3/9/08 1:40:34 PM]
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Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar INDEX FOR THIS 
TRIMESTER 

March 10 Friday

At the end of today's exercises for ten points, 2.5 each, you will have the following saved in your lesson 
1 folder. Every day late it is one-point less. 

These exercises do not take more ten minutes each to do. Following instructions is an important part of 
life

 worth  2.5 points if I see the web folder if I see your new website in your 
folder.

Do the exercise on page 24 and save it as WHAT YOUR NEW WEB SITE (AS DESCRIBED ON 
PAGE 24) WILL BE CALLED [FOR EXAMPLE I SET UP MY EXAMPLE AS 

] in your  FrontPage  folder labeled  Lesson 1 

TO DO BEFORE LEAVING THIS SECTION:

■     If you skipped any pages so far - go back and know these pages. On page 13 'DISPLAY HTML 
TAGS' do that now in your FrontPage window. (View > Reveal Tags)

■     Click the 'Split' view button at the bottom of the FrontPage window. Watch what happens as you 
type something here - try putting it in bold - deselect the bold. Notice how the html code 
brackets what you write in bold - <b> try putting it in bold - </b>  Try different font sizes; for 

example big, small, green, orange, underline, italics, and covered in poo colour. 

http://neuage.org/AA/et/notes3/3-10.htm (1 of 2) [3/9/08 1:40:39 PM]
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  worth  2.5 points if I see the web folder if there is Hexadecimal in your 
folder.

I.  Open Word and save your document as Hexadecimal in your FrontPage  folder 

labeled  Lesson 1
II.  Find the MAJOR HEXADECIMAL COLOUR CODES somewhere online and in a Word 

document list the Hexadecimal codes for the colours listed below. For example, by 
looking in the code in FrontPage - when you have "Split" view happening you will see the 
number for Light Purple is <font color="#ff0080">Light Purple</font> so you would write  Light 
Purple is #ff0080

1.  Dark Purple
2.  Black
3.  Red
4.  White
5.  Green
6.  Pale Violet Red
7.  Medium Aquamarine
8.  Khaki
9.  Dark Salmon

10.  Lemon Chiffon
11.  What is the Hexadecimal numbering system?

Do exercise 4 and save it in your Lesson one folder Page 31 - the "Cooking" folder is in my folder you 
will need to drag it into your Lesson Folder to do the exercise.
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER 
 

Monday March 13
 

We are missing the big picture here a bit. Before we continue with FrontPage we need to 
get a grasp on webpages and websites.
If you had been reading the material and not just doing the exercises you would know this.
 
Websites are all the material for one topic - like your folder where you store everything under a specific 
name.
 

Open Word and save it in your FrontPage  folder labeled  Lesson 1 as footy.
Go to http://afc.com.au/  You will get most of your answers from the code of the page - to do this go to 
View > Source which will open up the html code in Notepad. 

 What is the title of this page?

  Looking at the <META NAME= what is the description of this page?

  What are the keywords of this page?

  In our example  "afc/com.au" is the website ~ list three pages that are within the website. Now 
save your work with your four answers.

http://neuage.org/AA/et/notes3/3-13.htm (1 of 3) [3/9/08 1:40:46 PM]
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 What is the name of the Adelaide football team? The Adelaide .....

1.  In Front Page create a new website and call it "footy" it will be saved on your desktop folder as 
thus C:\Documents and Settings\neuaget\My Documents\My Web Sites\footy

2.  Drag your new folder into your FrontPage  folder labeled  Lesson 1 
3.  From the Adelaide football page go to the Player's Page - pick a player and save it in your 

Lesson 1 folder labeled  "footy"  For example, I saved McLeod > be sure you save it as 
Webpage, complete 

 You will then 
have it like this Dr_ Neuage\FrontPage\Lesson 1\footy\McLeoud.htm WHERE footy is your 
website and McLeoud.htm is the page. You will save someone else

4.  Change the text size of the following information on your new page from <h3> to H1 
Guernsey Number: 23
Height 180cm
Weight: 83kg

5.  Add a picture to your new player page.

  Put the words "Adelaide footy" into a Google search engine - what is the first site you come up 
with? Why did it come up with this site? Where are the keywords placed when you look at the page in 
View > Source?
 

`  Read pages 34 - 38 and do Exercise 5 on page 39. and the On your Own exercise on page 41.
 

http://neuage.org/AA/et/notes3/3-13.htm (2 of 3) [3/9/08 1:40:46 PM]



Computer Concepts

Format styles and bulleted and numbered lists - know pages 35 - 40

■     Format styles this is heading one
■     Format styles this is heading four
■     

■     Format styles what is this heading?
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Computer Concepts ~ AAG ~ AA ~ B

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER 

Tuesday, March 14, 2006

Today we are doing a very straight forward Read the pages and do the exercises - 

1. If you did not do Lesson 1 Exercise 5 do that first. We were missing some of the files and they are 

now in my folder in the Swap 

Format styles and bulleted and numbered lists - know pages 35 - 40

■     Format styles this is heading one
■     Format styles this is heading four
■     

■     Format styles what is this heading?

 

2. Read exercise 6 and do the exercise 6 on page 49 and on your own on page 50.

http://neuage.org/AA/et/notes3/3-14.htm [3/9/08 1:40:48 PM]
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get to work

 

 

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

March 17 Friday

 

Make a new website labeled SpringBreak

 

 

 

http://neuage.org/AA/et/notes3/3-16.htm [3/9/08 1:40:54 PM]

http://www.albany-academy.org/compcon/et.htm
http://www.albanyacademyforgirls.org/
http://www.albany-academy.org/
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/hypertext/notes3/index.htm


get to work

 

 

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

March 17 Friday

For 15 points toward your final grade show us how far you have gotten.

Make a new website labeled SpringBreak

You will receive points for

1.  One-point for a proper title to your page
2.  One-point for a proper index page
3.  three-points for three proper pages linked to your index page
4.  two-points for two proper external links to other sites related to your site
5.  One-point for proper keywords - meta tags
6.  Creativity

7.  Using styles give us a heading One at the top of your Index page and at least two other headings 
8.  (page 35) Two-points - At least three items for a bulleted or numbered lists - for example; things to do... 
9.  One-point - have a background pattern or colour to one of your pages - Format > Theme > (a set of themes appears in the 

panel on the right of your screen

10.  Have one animated gif on your page - go to Picture > Clip Art (put in a word in the panel on the right)
11.  Have a sound to your page - to do this you will need to save a sound to your site such as can be found at http://

www.stonewashed.net/sfx.html  or http://www.thefreesite.com/Free_Sounds/Free_WAVs/ Firstly, save the file to your 
folder then go to Format > Background > General 

http://neuage.org/AA/et/notes3/3-17.htm (1 of 2) [3/9/08 1:41:00 PM]
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get to work

> 
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Welcome Back from La La land

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

April 03 Monday     

If you were not here Friday before leaving us see the assignment for that day. It 
counts for 15% of our final grade.  see http://www.albany-academy.org/compcon/
hypertext/notes3/3-17.htm You will need to do this on your own time.

We are skipping page 51 - 65 as we covered this in Word

Beginning with page 66 Exercise 9 today...

Today moving forward per our  Calendar we are to do P. 66 know terms

Make a new folder in your FrontPage folder and label 
it Lesson 2 for the exercises for this week. 
Read and know pages 66 to 71 and for ten points do the exercises on page 71 (five-points), P 73 (five-
points) I will check before you leave class.

We do not have the PC30015.jpg so choose your own background image

The files you need are in lesson two Exercise 9 in my folder

 

http://neuage.org/AA/et/notes3/4-03.htm [3/9/08 1:41:03 PM]

http://www.albany-academy.org/compcon
http://www.albanyacademyforgirls.org/
http://www.albany-academy.org/
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/et/notes3/index3.htm
http://www.albany-academy.org/compcon/et/et_calendar3.htm
http://www.albany-academy.org/compcon/et/notes3/grading.htm
http://www.albany-academy.org/compcon/hypertext/notes3/3-17.htm
http://www.albany-academy.org/compcon/hypertext/notes3/3-17.htm
http://www.albany-academy.org/compcon/et/et_calendar3.htm


Welcome Back from La La land

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

April 07    

Inserting a video clip

 page 82 - 85 

 

Do the exercise on page 86  

http://neuage.org/AA/et/notes3/4-04.htm [3/9/08 1:41:11 PM]
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

April 07    

Inserting a video clip

 page 82 - 95

15 POINTS FOR TODAY

Do the exercise on page 86  The files are in my folder in Lesson 2 and Exercise 11. The "heading.gif" is 
in the images folder in lesson 11. 

Show me this work done for five points for today.

Do page 87 and show me that done for five points.

Pages 88 - 91 we covered in Word. However, refresh your brain by reading it again and for five points 
do Exercise 12 ON PAGE 92 AND FIVE BONUS POINTS DO EXERCISE "ON YOUR OWN? ON 
PAGE 95.

http://neuage.org/AA/et/notes3/4-07.htm [3/9/08 1:41:14 PM]
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Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

Monday April 10    

Inserting a video clip

 page 82 - 95

15 POINTS FOR TODAY

Do the exercise on page 86  The files are in my folder in Lesson 2 and Exercise 11. The "heading.gif" is 
in the images folder in lesson 11. 

Remember to start by opening the "index" page.

ALSO, you will need to find some pictures of eagles for your new page to insert.

For your navigation bar use the Insert > Insert interactive button - put in your link - change the font and 

colour to what floats your boat 

Show me this work done for five points for today.

Do page 87 and show me that done for five points.

Pages 88 - 91 we covered in Word. However, refresh your brain by reading it again and for five points 
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do Exercise 12 ON PAGE 92 AND FIVE BONUS POINTS DO EXERCISE "ON YOUR OWN? 
ON PAGE 95.
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bunch of bunnies

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

Tuesday April 11    

Thanks for such a well behaved class today - of course as you know I am watching you through the TV 
in the back of the room.

For fifteen points please read the pages preceding and do the exercises on page 97 (exercise 13) and 
lesson three exercise 14 on page 104 and page 105.

Five points for each.

I will look in your folder. Save them in your FrontPage folder under lesson three. 

 

Have a great holiday and treat your bunny with respect.
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Talbes

 
 

Essential Technologies (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works

Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar INDEX FOR THIS 
TRIMESTER 

 

Start a folder Lesson 3 in your Front 
Page folder

and for twenty easy points do the 
four exercises below

1.  Read the material p. 100 - 104 on using a table to place your material for a webpage (we did 
tables in Word so this so be a piece of cake) and do the exercise on page 104 (exercise 14 in the 
teacher's folder) and 105 a family reunion for you or some farm animals that you may refer to as 
"family". Be sure to click preview before starting the corrections.

2.  Read the material p. 106 - 110 continuing with tables and do the exercise 15 on page 110 and on 
page 111.
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Talbes

 
 

Essential Technologies (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works

Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar INDEX FOR THIS 
TRIMESTER 

 

In your folder Lesson 3 in your 
Front Page folder

and for twenty-five easy points do 
the five exercises below

1.  Read the material p. 112 - 116 entering data in table cells - spreadsheets (remember Excel????) 

Do  Lesson 3 on page 116 and the 

2.  Read the material p. 118 - 121 continuing with tables and do the 

 on page 122 and the 
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Talbes

 and 

exercise .
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Frames R-us

 
 

Essential Technologies (Spring 2006) FrontPage, HTML. Java Script, Acid Music 
Studio,  Search Engines, Hosting WebSites; how the Internet works

Nanotechnology, Quantum Computation, Internet Technology -  Internet2,  Digital Divides
 

Computer Concepts: AAG: AA: Grading for this course: Blog: Calendar INDEX FOR THIS 
TRIMESTER 

 

We have a bit more to do in Front Page then we will 
move on to making a musical clip then slip into a silent 
video using Sony Acid mind-set then we will do Flash 

then we will go away for the summer
 

In your ET-FrontPage folder create 

Lesson  folder and for twenty 
easy (did I mention fun too?) cosmic 

points do the four exercises below

http://neuage.org/AA/et/notes3/4-20.htm (1 of 2) [3/9/08 1:41:32 PM]

http://www.internet2.edu/
http://www.albany-academy.org/compcon/et.htm
http://www.albanyacademyforgirls.org/
http://www.albany-academy.org/
http://www.albany-academy.org/compcon/et/notes2/grading.htm
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/et/et_calendar2.htm
http://www.albany-academy.org/compcon/et/notes3/index3.htm
http://www.albany-academy.org/compcon/et/notes3/index3.htm


Frames R-us

 

I.  Read the material p. 128 - 131 entering - Do  Lesson 4 on 
page 132 and the 

II.  Read the material p. 134 - 137 continuing with frames and do the 

 on page 138 and the 
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300 Multiple Choices

Multiple Choices
The document name you requested (/AA/et/notes3/4-21.htm) could not be found on this server. 
However, we found documents with names similar to the one you requested.

Available documents: 

●     /AA/et/notes3/4-11.htm (mistyped character) 
●     /AA/et/notes3/4-20.htm (mistyped character) 
●     /AA/et/notes3/4-28.htm (mistyped character) 

Please consider informing the owner of the referring page about the broken link. 
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300 Multiple Choices

Multiple Choices
The document name you requested (/AA/et/notes3/4-24.htm) could not be found on this server. 
However, we found documents with names similar to the one you requested.

Available documents: 

●     /AA/et/notes3/4-04.htm (mistyped character) 
●     /AA/et/notes3/4-20.htm (mistyped character) 
●     /AA/et/notes3/4-28.htm (mistyped character) 

Please consider informing the owner of the referring page about the broken link. 
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300 Multiple Choices

Multiple Choices
The document name you requested (/AA/et/notes3/4-25.htm) could not be found on this server. 
However, we found documents with names similar to the one you requested.

Available documents: 

●     /AA/et/notes3/4-20.htm (mistyped character) 
●     /AA/et/notes3/4-28.htm (mistyped character) 
●     /AA/et/notes3/5-25.htm (mistyped character) 

Please consider informing the owner of the referring page about the broken link. 
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300 Multiple Choices

Multiple Choices
The document name you requested (/AA/et/notes3/4-27.htm) could not be found on this server. 
However, we found documents with names similar to the one you requested.

Available documents: 

●     /AA/et/notes3/4-07.htm (mistyped character) 
●     /AA/et/notes3/4-17.htm (mistyped character) 
●     /AA/et/notes3/4-20.htm (mistyped character) 
●     /AA/et/notes3/4-28.htm (mistyped character) 

Please consider informing the owner of the referring page about the broken link. 
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Flash 5

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

In the Flash MX 2004 "Project 4" folder do pages 123 - 143
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Flash buttons

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

05/10/2006

In the Flash MX 2004 "Project 4" folder be sure you know pages up to 161

We should be well pass this point but be sure that in Flash MX 2004 you know the exercises up to 
4.16 so we can have this on a bit of a quiz in a week or so.

Especially how to change colours in different frames: lesson 4.14, 4.15, 4,16, 4.17 

Insert > Create Motion Tween you need to go Insert > Timeline > Create Motion Tween

For five points have three balls that change colours, direction, shape and that pass each 
other - have your movie change every five frame and have forty frames. SAVE THIS AS BALLS  
>EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT IN YOUR "Project 4" folder. 
thanks

  

For five points Creating Animated Text ~ Instead of clicking Insert > Convert to Symbol you 
need to go to Modify > Convert to Symbol

SAVE THIS AS LESSON 1 > EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT 
IN YOUR "Project 4" folder. thanks

Go through to lesson 4.20 so you have a button doing things at the end of the lesson for five 
big points. DO NOT DO THE "ADDING ACTION TO A BUTTON" STEP ON PAGE 149

http://neuage.org/AA/et/notes3/5-09.htm (1 of 2) [3/9/08 1:41:50 PM]
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Flash buttons

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Flash buttons

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

May 11th I will look in your folders for these

In the Flash MX 2004 "Project 4" folder be sure you know pages up to 161

We should be well pass this point but be sure that in Flash MX 2004 you know the exercises up to 
4.16 so we can have this on a bit of a quiz in a week or so.

Especially how to change colours in different frames: lesson 4.14, 4.15, 4,16, 4.17 

Insert > Create Motion Tween you need to go Insert > Timeline > Create Motion Tween

For five points have three balls that change colours, direction, shape and that pass each 
other - have your movie change every five frame and have forty frames. SAVE THIS AS BALLS  
>EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT IN YOUR "Project 4" folder. 
thanks

  

For five points Creating Animated Text ~ Instead of clicking Insert > Convert to Symbol you 
need to go to Modify > Convert to Symbol

SAVE THIS AS LESSON 1 > EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT 
IN YOUR "Project 4" folder. thanks

Go through to lesson 4.20 so you have a button doing things at the end of the lesson for five 
big points.
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Flash buttons

 

For five points Do Activity 4: Importing Sound 

EXPORT IT AS A MOVIE AND SAVE IT IN YOUR "Project 4" folder. thanks

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Flash buttons

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER ~ Calendar ~ 
Grading for trimester three  

05/12/2006

Finish up to Activity Six today
No One has made a  "Project 4" folder so do that first.

If you did not do through Activity 4: Importing Sound finish that now.  

Today- Friday the 12th continue with page 153 adding buttons to the movie - page 152 is 
missing from our folder and I will give that to you Monday.

step 4.25 step 6 "Paste Frames" is now under "edit" > "Timeline" > "Paste Frames"

be sure you know pages up to 161
We should be well pass this point but be sure that in Flash MX 2004 you know the exercises up to 4.16 
so we can have this on a bit of a quiz in a week or so.

Especially how to change colours in different frames: lesson 4.14, 4.15, 4,16, 4.17 

Insert > Create Motion Tween you need to go Insert > Timeline > Create Motion Tween

For five points have three balls that change colours, direction, shape and that pass each 
other - have your movie change every five frame and have forty frames. SAVE THIS AS BALLS  
>EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT IN YOUR "Project 4" folder. 
thanks
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Flash buttons

  

For five points Creating Animated Text ~ Instead of clicking Insert > Convert to Symbol you 
need to go to Modify > Convert to Symbol

SAVE THIS AS LESSON 1 > EXPORT IT AS A MOVIE AS SHOWN BELOW AND SAVE IT 
IN YOUR "Project 4" folder. thanks

Go through to lesson 4.20 so you have a button doing things at the end of the lesson for five 
big points.

 

For five points Do Activity 4: Importing Sound 

EXPORT IT AS A MOVIE AND SAVE IT IN YOUR "Project 4" folder. thanks

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Flash buttons
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Commercial 

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading 

Monday May 15th or so have ready by end of class or your name will be mud 

 

I.  In your folder have your story written up for your commercial 
II.  What is your 60 second commercial?  answer these in a Word document    

http://neuage.org/AA/et/notes3/5-15.htm (1 of 4) [3/9/08 1:42:05 PM]

http://www.albany-academy.org/compcon/web.htm
http://www.albany-academy.org/compcon/web/notes3/index.htm
http://www.albany-academy.org/compcon/
http://www.albany-academy.org/compcon/
http://www.albany-academy.org/compcon/web/calendar3.htm
http://www.albany-academy.org/blog/
http://www.albany-academy.org/compcon/web/notes3/Grading.htm



Commercial 

The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone 
with the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to 

buy your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

V.  Storyboard - what will be in each of at least ten scenes    [I want this done in Word and in your folder “Flash 
> Commercial”]

The process of creating a rich and engaging animation involves so much more than "leading the character" 
around the stage. Some of the other common elements that will be discussed in this class are as follows:

a)      Firstly, Building the story. Before you begin to develop your commercial, you need to design your 
story. Planning ahead- not DOING IT ON THE "FLY" IS IMPORTANT so you do not waste lots of time.

b)      Create a character for your story. This can be a stick figure or something more elaborate. There 
are two parts here:

i.                    Creating the Script 

Script development, like many writing projects, provides structure and detail. Start in an outline form to make 
sure you get all the bits and pieces you want to use. When you have your outline, you can develop the details. 
The areas on which you will want to focus are these: 

·         Descriptive setting. The first thing is to describe the environment for the opening scene. Your 
opening scene may be the title of your product or commercial or it may be more subtle. For example, if you 
were selling an ad for condominiums in Hawaii you may want to begin with a photo of an Hawaiian sunset. 
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Commercial 

This description needs to encompass the set, setting, atmosphere, and mood. It also needs to place the 
main character or subject matter – the title or an image in the scene. Then, as your story transitions from one 
scene to the next, you describe these changing settings. 

·         Character and subject development. As characters or subject matter are introduced to the scene, 
you'll need a brief description of their characteristics, appearance, and style.

·         Transitions. When moving the action from one scene to the next, you need to think through how 
the transition will be handled. You don't want to alienate your audience with inappropriate scene changes. 
This might be in the form of fades; camera motions (pan/zoom), refocusing, and so on. Transitions are covered 
in more detail in Chapter 12, "Making the Transition."

·         Character dialogue or action. When you actually have a character or characters, you will need to detail 
the dialogue and actions.

·         Important action characteristics. If there are sound effects, visual effects, or action sequences, they 
need to be described in context with the character, object, action, or transition with which they are associated.

Your script puts your words in order; your storyboard organizes your animation's visuals.

ii.                  Storyboarding Your Action

·                                                        Storyboarding is the same format as you see in newspaper cartoons and 
in comic books. Illustrations are provided inline with the script to provide a visual narrative for what is 
being described by the words themselves. Your average set of storyboards is a sequence of illustrated 
and numbered panels arranged in a linear fashion. Next to or below these panels is an area for the related 
script text that accompanies the illustration. When you look at the storyboards, you are looking at the 
animation itself, but in skeletal form. 
·                                                        When preparing your storyboards, you'll want to set them up in roughly 
the same aspect ratio as you anticipate you'll use for your final animation. That way, when you're 
illustrating scenes, sets, and actions on your boards, you'll have a good visual sense of how the scene will play out. 
·                                                        The average computer monitor displays at an aspect ratio of 3 x 4. Thus, if 
you set up your storyboards as a series of 3-inch-by-4-inch or 6-inch-by-8-inch panels, you'll be in good shape. 
We will do this in Word but blank 3x5 cards would be easier.
·                                                        When your storyboards are complete, you have a number of options at 
your disposal to aid you in the process of converting your story to reality. Hand-drawn storyboards can be 
scanned, placed on a background layer in Flash, and traced using the drawing tools in Flash. If you are artistic 
you can start out the process by hand sketching, this can be an appealing option.
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Commercial 

·                                                        Another option is to use Macromedia FreeHand as your storyboarding tool. 
We do not have this in our PC lab at AA but you can do it (remember from before Christmas break?) in PC lab 
at AAG. 
·                                                        As you would obviously remember, FreeHand enables you to define 
multiple pages inside a single FreeHand document, much like a Microsoft Word document can contain hundreds 
of pages. Because the two programs are so tightly integrated, you can copy your illustrations from FreeHand 
and paste them into Flash in the standard Flash format. Although this might seem insignificant, if you are trying 
to create storyboards in some other illustration packages, you'll need to create several documents to 
accomplish the same task.

 

In our next class we will begin using building our scenes and characters and get the animation thingy happening.

 

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.
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Adding life to your character

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

Tuesday, May 16, 2006 09:05:30 AM

Adding Life to Your Character

When you create a character, you need to think about its personality and how its personality relates to its 
appearance. You can give personality to almost anything. A line or a dot can have character. 

Draw sketches of your character in different moods so that as you animate, you have a visual reference 
from which to work

 

In this class we will begin by using the basic drawing tools.

After you have tried the tools take an image and animate it.

Import "to state" your image > select your image > Modify Break apart > lasso tool > edit > cut > make 
a new layer and name it > Paste in Place > lock the image > Modify > Convert to Symbol > use the free 
transform tool to move > select frame ten or so and then "create motion tweens

For ten points have one animated image by end of class
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Adding life to your character
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activities 

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts 
@ Albany Academies ~ Calendar for trimester three  Blog ~ Grading 

 

put three movies (Export movie) into your Flash folder - label it activities : then do the 
exercises we will do from the online tutorial and name them (1) Squash, (2) Anticipation and (3) 
Ease

1. Have objects move smoothly over one another (this will not work with very complicated scenes). 
Have a layer for three different objects > label your layers > and be sure you have 'Converted to 
symbol" each image > to have your image move smoothly from frame 1 - 30 > click in frame 10 > 
F6 > move your image to where you want it > click in frame 20 > F6 > move your image to where 
you want it > click in frame 30  F6 > move your image to where you want it. In Properties select 
your frame and Tween > Motion
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activities 

 

2. Anticipation. If you have your figure just move across the screen then that is quite budget

  have your figure begin moving in the first frames and 
at the end as shown in Dr. Blob Rocks below. Don't have your figure just move quickly - 
ANTICIPATE 
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activities 

 

3. Squash and stretch See that when you move and select your character that "Free Transform tool" is 
selected and then when the figure is where you want it using the alt - key on your keyboard squash your 
thingy > REMEMBER TO HOLD ALT KEY TO STRETCH JUST THE TOP - otherwise the whole 
image moves.

 

Squash is good for something that is hitting the ground or hitting a wall   and Stretch is good for 
something that is spring into action....
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activities 

 

take home a forum today

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 
- 4 PM I will keep you posted when the bus leaves.
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Your Flash commercial project is

Monday, May 22, 2006

Your Flash commercial project is due Tuesday 30th May

May 22, Dr. Ryu (RPI)    will give a demonstration on the nano-electronic 
microscope and at 1.30 the bus leaves from AA for the SUNY nano-
technology college for our visit of NanoCareer Day 

Your ads must be in a folder labeled AD in your main folder (U - drive, not 
a flash folder or et folder etc)

●     ten points - correct folder
●     ten points -one-minute of continuous time - at at least twelve frames 

per second - you can either group in scenes or layers
●     ten points -background sound - that changes and dramatizes your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - 
●     

 

http://neuage.org/AA/et/notes3/5-22.htm [3/9/08 1:42:32 PM]



Virtual Microscope

Computer Concepts ~ AAG ~ AA ~ Blog ~ INDEX FOR THIS TRIMESTER

May 23 06

Today Dr. Chang Ryu, professor in the Department of Chemistry and Chemical Biology at 
the Rensselaer Polytechnic Institute, will have a workshop on the The Virtual Microscope 
with us.

The Virtual Microscope is a NASA-funded project that provides simulated scientific instrumentation for 
students and researchers worldwide as part of NASA's Virtual Laboratory initiative.

Dr. Ryu's presentation for today is accessible here as a PDF file ...

http://virtual.itg.uiuc.edu/

http://neuage.org/AA/et/notes3/5-23.htm [3/9/08 1:42:34 PM]
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Your Flash commercial project is

Thursday, May 25, 2006

Your Flash commercial project is due Tuesday 30th May 

Three days left of classes 

May 25 Thursday

Your ads must be in a folder labeled AD in your main folder (U - drive, not a flash folder 
or et folder etc) THIS IS DUE NEXT TUESDAY

●     ten points - correct folder
●     ten points -thirty-seconds of continuous time -  at least twelve frames per second - you 

can either group in scenes or layers
●     twenty points -background sounds, using SONY ACID - that changes and dramatizes 

your ad
●     twenty points - creativity and originality 
●     movements including 
●     ten points - anticipation
●     ten points - (easing) slow down or speed up of a title or object
●     ten points - shape tween and a motion tween (seee star below for motion tween concept)
●     ten points - exported and placed in a Frontpage page with an order form on the page 

to purchase your product 

 

http://neuage.org/AA/et/notes3/5-25.htm [3/9/08 1:42:37 PM]



Next Friday we will have our fin

Next Friday we will have our final test on Front Page

All the terms will be on the test or at least a fair swag of them

The final will be part-terms and part webpage creation using what we have covered in the exercises.

Our plan is to cover the following before next Friday.

BE SURE TO CREATE A FOLDER FOR EACH LESSON. FOR EXAMPLE, LESSON 4 (exercise 21, 22, 23)

 Lesson # Exercises needed 
done page points for day  content

Friday, April 21 4 21, 22, 23 145, do not do 
147 - 152, 154 15

dynamic 
effects, 
hover 
buttons

Monday, 24th 5 - 6 26, 30, 31 172, 196, 202 15
styles, 
navigation 
bars

Tuesday, 25 8 38, 39, 40 244, 252, 260 15

web 
forms, 
link 
thingies

Thursday, 27 9 42, 43 272  10 big points Discussion 
Groups

Friday the 28th

THE BIG 
TEST

     

http://neuage.org/AA/hypertext/notes3/4-21st.htm [3/9/08 1:42:40 PM]



Adding Life to Your Character 

 

Adding Life to Your Character

When you create a character, you need to think about its personality and how its personality relates to its 
appearance. You can give personality to almost anything. A line or a dot can have character. 

Draw sketches of your character in different moods so that as you animate, you have a visual reference 
from which to work

 

In this class we will begin by using the basic drawing tools.

 

http://neuage.org/AA/hypertext/notes3/5-15b.htm [3/9/08 1:42:47 PM]




Commercial 

Back to Albany Academy's Computer Web Page Home ~ Daily Notes ~  Computer Concepts @ Albany 
Academies ~ Calendar for trimester three  Blog ~ Grading 

Friday May 12th or so have ready for Friday the below written in Word 

 

I.  In your folder have your story written up for your commercial 
II.  What is your 60 second commercial?  answer these in a Word document    

http://neuage.org/AA/web/5-15.htm (1 of 4) [3/9/08 1:42:55 PM]
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Commercial 

The objective of your 60 second commercial is to have 55 to 60 seconds of information that informs someone 
with the following information: 

�❍     Who are you? product or thingy
�❍     Who is your company? that sells your product or thingy or vote for you or go to your favourite city (planet?). 
�❍     What does your company do? that sells your product or thingy
�❍     How can you help? or how is your product better, bigger, faster and etc
�❍     Why your customer should act now? 

 

�❍     brainstorm product features and identify the most marketable uses. 
�❍     write Internet commercial using Flash to persuade consumers to 

buy your product or vote for you or go to your favourite city. 
�❍     dramatize the commercial with Sony ACID . 

 
IV.  Storyboard - what will be in each of at least ten scenes

V.  Storyboard - what will be in each of at least ten scenes    [I want this done in Word and in your folder “Flash 
> Commercial”]

The process of creating a rich and engaging animation involves so much more than "leading the character" 
around the stage. Some of the other common elements that will be discussed in this class are as follows:

a)      Firstly, Building the story. Before you begin to develop your commercial, you need to design your 
story. Planning ahead- not DOING IT ON THE "FLY" IS IMPORTANT so you do not waste lots of time.

b)      Create a character for your story. This can be a stick figure or something more elaborate. There 
are two parts here:

i.                    Creating the Script 

Script development, like many writing projects, provides structure and detail. Start in an outline form to make 
sure you get all the bits and pieces you want to use. When you have your outline, you can develop the details. 
The areas on which you will want to focus are these: 

·         Descriptive setting. The first thing is to describe the environment for the opening scene. Your 
opening scene may be the title of your product or commercial or it may be more subtle. For example, if you 
were selling an ad for condominiums in Hawaii you may want to begin with a photo of an Hawaiian sunset. 

http://neuage.org/AA/web/5-15.htm (2 of 4) [3/9/08 1:42:55 PM]



Commercial 

This description needs to encompass the set, setting, atmosphere, and mood. It also needs to place the 
main character or subject matter – the title or an image in the scene. Then, as your story transitions from one 
scene to the next, you describe these changing settings. 

·         Character and subject development. As characters or subject matter are introduced to the scene, 
you'll need a brief description of their characteristics, appearance, and style.

·         Transitions. When moving the action from one scene to the next, you need to think through how 
the transition will be handled. You don't want to alienate your audience with inappropriate scene changes. 
This might be in the form of fades; camera motions (pan/zoom), refocusing, and so on. Transitions are covered 
in more detail in Chapter 12, "Making the Transition."

·         Character dialogue or action. When you actually have a character or characters, you will need to detail 
the dialogue and actions.

·         Important action characteristics. If there are sound effects, visual effects, or action sequences, they 
need to be described in context with the character, object, action, or transition with which they are associated.

Your script puts your words in order; your storyboard organizes your animation's visuals.

ii.                  Storyboarding Your Action

·                                                        Storyboarding is the same format as you see in newspaper cartoons and 
in comic books. Illustrations are provided inline with the script to provide a visual narrative for what is 
being described by the words themselves. Your average set of storyboards is a sequence of illustrated 
and numbered panels arranged in a linear fashion. Next to or below these panels is an area for the related 
script text that accompanies the illustration. When you look at the storyboards, you are looking at the 
animation itself, but in skeletal form. 
·                                                        When preparing your storyboards, you'll want to set them up in roughly 
the same aspect ratio as you anticipate you'll use for your final animation. That way, when you're 
illustrating scenes, sets, and actions on your boards, you'll have a good visual sense of how the scene will play out. 
·                                                        The average computer monitor displays at an aspect ratio of 3 x 4. Thus, if 
you set up your storyboards as a series of 3-inch-by-4-inch or 6-inch-by-8-inch panels, you'll be in good shape. 
We will do this in Word but blank 3x5 cards would be easier.
·                                                        When your storyboards are complete, you have a number of options at 
your disposal to aid you in the process of converting your story to reality. Hand-drawn storyboards can be 
scanned, placed on a background layer in Flash, and traced using the drawing tools in Flash. If you are artistic 
you can start out the process by hand sketching, this can be an appealing option.

http://neuage.org/AA/web/5-15.htm (3 of 4) [3/9/08 1:42:55 PM]



Commercial 

·                                                        Another option is to use Macromedia FreeHand as your storyboarding tool. 
We do not have this in our PC lab at AA but you can do it (remember from before Christmas break?) in PC lab 
at AAG. 
·                                                        As you would obviously remember, FreeHand enables you to define 
multiple pages inside a single FreeHand document, much like a Microsoft Word document can contain hundreds 
of pages. Because the two programs are so tightly integrated, you can copy your illustrations from FreeHand 
and paste them into Flash in the standard Flash format. Although this might seem insignificant, if you are trying 
to create storyboards in some other illustration packages, you'll need to create several documents to 
accomplish the same task.

 

In our next class we will begin using building our scenes and characters and get the animation thingy happening.

 

 

 

MAY 23 WE HAVE A FIELD TRIP TO THE NANOTECHNOLOGY CENTRE AT SUNY AT 2 - 4 PM I will 
keep you posted when the bus leaves.

http://neuage.org/AA/web/5-15.htm (4 of 4) [3/9/08 1:42:55 PM]



Valerie's story - The Bird and the Cookie

Albany Academy for Girls Web Design Flash Assignments Trimester Two Children Stories next story Lauren

 

http://neuage.org/AA/commercial/VA/Valerie.htm [3/9/08 1:44:26 PM]

http://www.albany-academy.org/compcon/web/notes2/index.htm
http://www.albany-academy.org/compcon/web/FlashStory/FlashStory.htm
http://www.albany-academy.org/compcon/web/FlashStory/Lauren.htm



Pig Birthday

by Val next card back to all cards

 

http://neuage.org/AA/commercial/VA/PigBirthday.htm [3/9/08 1:44:27 PM]
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return to Gif Stories from Compu

Christopher's story
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Christopher

Christopher's flash poem 

 

http://neuage.org/AA/commercial/CE/Christopher.htm [3/9/08 1:44:34 PM]
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html with comments which will not show INDEX for textedit webpages Previous page - 
Next page

 

The opening bracket is followed by an element, which is a browser command, and 
ends with the closing bracket.

<font size=2>

An element may also be followed by attributes, which are words describing the 
properties of the element, and further instruct the browser.

<font size=2>

Attributes are only contained in the opening HTML tags to the right of the element 
and are separated by a space and followed by an equal (=) sign.

The value follows the equal sign and is enclosed in quotes.

<font size=2> 

Basic HTML Document Code Structure

Begin writing your HTML tags by creating your document's basic layout. Copy and 
paste this code into your text or HTML editor.

<HTML> 
<HEAD> 
<TITLE>Your Page Title</TITLE> 
</HEAD> 
<BODY>

This area will contain everything that will be visible through a web browser, such as 
text and graphics. All of the information will be HTML coded.

For a complete list of HTML codes, tags and examples, see the HTML chart below.

</BODY> 
</HTML>
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<HTML> - Begins your HTML document.

<HEAD> - Contains information about the page such as the TITLE, META tags for 
proper Search Engine indexing, STYLE tags, which determine the page layout, and 
JavaScript coding for special effects.

<TITLE> - The TITLE of your page. This will be visible in the title bar of the viewersʼ 
browser.

</TITLE> - Closes the HTML <TITLE> tag.

</HEAD> - Closes the HTML <HEAD> tag.

<BODY> - This is where you will begin writing your document and placing your HTML 
codes.

</BODY> - Closes the HTML <BODY> tag.

</HTML> - Closes the <HTML> tag. 

1.
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headings

2. 
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fill in

3.
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4.
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5.  

Your Guide to Professional 
Web Site Design and Development 
• HTML Tips 
• HTML Codes 
• Web Development • Web Design Tips 
• JavaScript Codes 
• 216 Web Safe Colors 
• CSS Tutorial 
• JavaScript Tutorial 
• ASCII Character Codes
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Wednesday, September 26, 2007

| Web Site Development | HTML Codes | HTML Tips | Web Design Tips | Javascript 
Snippets | 216 Safe Colors | Symbols | CSS Tutorial | JavaScript Tutorial | 
how to write html 
html tags, html codes, html help 
HTML Tags / Codes / Web Page Design

If you're doing business on the Internet, taking the time to learn how to design your 
own web site and write your own HTML code (hypertext markup language) will play a 
major role in your success. Not only will learning HTML coding provide you with the 
freedom to update your own HTML documents, but it will also save you a great deal of 
money, as you will be able to avoid hiring a professional web designer.

If you're looking for some HTML tags to spice up your web site, you've come to the 
right place. You will find a variety of HTML codes and tips to assist you below.

However, before reviewing the HTML tags, if you're new to HTML and web site design, 
the following section will assist you in creating an HTML web page. For additional web 
site design information, make sure you don't miss the web design articles and 
tutorials at the bottom of this page. 

Creating an HTML Page

A web page is created using a language called, Hypertext Markup Language, better 
known as HTML Code. You can write your own coding within a plain text editor, such 
as Note Pad, or use an HTML editor, which will write the code for you.

HTML codes, also referred to as HTML tags, are enclosed by the lesser than (<) and 
greater than (>) brackets and may be written in capital or lower case letters.

The opening bracket is followed by an element, which is a browser command, and 
ends with the closing bracket.

<font size=2>

An element may also be followed by attributes, which are words describing the 
properties of the element, and further instruct the browser.

<font size=2>
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Attributes are only contained in the opening HTML tags to the right of the element 
and are separated by a space and followed by an equal (=) sign.

The value follows the equal sign and is enclosed in quotes.

<font size=2> 

Basic HTML Document Code Structure

Begin writing your HTML tags by creating your document's basic layout. Copy and 
paste this code into your text or HTML editor.

<HTML> 
<HEAD> 
<TITLE>Your Page Title</TITLE> 
</HEAD> 
<BODY>

This area will contain everything that will be visible through a web browser, such as 
text and graphics. All of the information will be HTML coded.

For a complete list of HTML codes, tags and examples, see the HTML chart below.

</BODY> 
</HTML>

<HTML> - Begins your HTML document.

<HEAD> - Contains information about the page such as the TITLE, META tags for 
proper Search Engine indexing, STYLE tags, which determine the page layout, and 
JavaScript coding for special effects.

<TITLE> - The TITLE of your page. This will be visible in the title bar of the viewersʼ 
browser.

</TITLE> - Closes the HTML <TITLE> tag.

</HEAD> - Closes the HTML <HEAD> tag.

<BODY> - This is where you will begin writing your document and placing your HTML 
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codes.

</BODY> - Closes the HTML <BODY> tag.

</HTML> - Closes the <HTML> tag. 
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Nanotechnology Educational 
Resources for High Schools

Chang Y. Ryu

HS outreach program coordinator of Rensselaer Nanotechnology Center
Assistant Professor of Chemistry and Chemical Biology

Rensselaer Polytechnic Institute
Troy, NY 12180

May 23, 2006
Albany Academy for Girls (http://www.albanyacademyforgirls.org/)
Albany, NY  (Host: Dr. Terrell Neuage) 



RPI (est. 1824)

www.nano.rpi.edu



Outline
• Brief Introduction on Nanotechnology
• Educational Resources on nanotechnology

– www.nano.gov

• RPI Nanoscale Science and Engineering Center: High 
school outreach program
– Bringing nanotechnology to the classroom (Program coordinator: 

Chang Y. Ryu (ryuc@rpi.edu)
• Hands on module: Carbon nanotube synthesizer
• Multimedia module: Virtual Scanning Electron Microscopy (SEM)
• Lecture module: Atomic Force Microscopy (AFM)
• Class supplementary information using nanoscale microscopy tools



nano-meter
• 1 mm = 1,000 μm = 1,000,000 nm
• nm = 10-9 m

– Thickness of human hair = 100 μm
– Typical size of cells = 30 – 1 μm
– Wave length of visible lights ~ 0.5 μm
– Nanoparticles, nanotubes, nanowires, …
– Length of C-C bond: 0.15 nm (1.5 Å)

Xe on NickelIron on Copper

NIST magnetic nanoparticles Carbon nanotubes



Technological advances 
• In 1900,

– Most people did not have cars, electricity, or indoor plumbing
• By 1950

– Most people have cars, electricity, or indoor plumbing
– Development of antibiotics, radio, TV, plastics, nuclear weapons

and power, and the computer
• By 2000

– Jet airliners are common
– TV, computers, cell phones, global communications network, 

internet, biotechnology
• Future? 

– Nanotechnology, biotechnology, information technology, energy 
technology, ???



Transistor & Information Technology
http://nobelprize.org/physics/educational/transistor/history/index.html

Computer
(late 1940’s)

Vacuum tube
(“Triodes”, Thomson 
– Nobel,1906)

Solid state
(Bardeen and Brattain
-Nobel, 1956)

Integrated Circuit
(Jack Kilby
- Nobel, 2000)

Portable radio from 
Motorola (1959)

time



Nanotechnology: Definition
(National Science Foundation ) 

http://www.nsf.gov/crssprgm/nano/reports/omb_nifty50.jsp

• Research and technology development at the atomic, molecular or 
macromolecular levels, in the length scale of approximately 1 - 100 
nanometer range, to provide a fundamental understanding of 
phenomena and materials at the nanoscale and to create and use 
structures, devices and systems that have novel properties and 
functions because of their small and/or intermediate size. The novel 
and differentiating properties and functions are developed at a critical 
length scale of matter typically under 100 nm. 

• Nanotechnology research and development includes manipulation 
under control of the nanoscale structures and their integration into 
larger material components, systems and architectures. Within these 
larger scale assemblies, the control and construction of their 
structures and components remains at the nanometer scale. In some 
particular cases, the critical length scale for novel properties and 
phenomena may be under 1 nm (e.g., manipulation of atoms at ~0.1
nm) or be larger than 100 nm (e.g., nanoparticle reinforced polymers 
have the unique feature at ~ 200-300 nm as a function of the local 
bridges or bonds between the nano particles and the polymer).



Nanotechnology is the creation of USEFUL/FUNCTIONAL
materials, devices and systems through control of matter on the 
nanometer length scale and exploitation of novel phenomena and 
properties (physical, chemical, biological) at that length scale

“If I were asked for an area of science 
and engineering that will most likely 
produce the breakthroughs of 
tomorrow, I would point to nanoscale 
science and engineering.”

-Neal Lane
Former Assistant to the President for Science
And Technology

Source: http://www.ipt.arc.nasa.gov/



Current Nanotechnology examples
- Size matters! -

• Nanoparticles & “quantum dots”
• Carbon nanotubes
• Micro- and nano-lithography
• Nano- and molecular-electronics
• Nano-materials
• Nano-batteries



Quantum dot – Biological tags
(www.qdots.com)



Carbon nanotubes



e.g. Nanotube chemical sensors
Kim and Nuckolls et al. (Columbia Univ.), Science (Jan, 2006) 311, 356 

“connection” after cutting



• Computing and Data Storage

• Materials and Manufacturing

• Health and Medicine

• Energy and Environment

• Transportation

• National Security

• Space exploration
•

Nanotechnology is an
enabling technology

Source: http://www.ipt.arc.nasa.gov/



Outline
• Brief Introduction on Nanotechnology
• Educational Resources on nanotechnology

– www.nano.gov

• RPI Nanoscale Science and Engineering Center: High 
school outreach program
– Bringing nanotechnology to the classroom (Program coordinator: 

Prof. Chang Y. Ryu (ryuc@rpi.edu)
• Hands on module: Carbon nanotube synthesizer
• Multimedia module: Virtual Scanning Electron Microscopy (SEM)
• Lecture module: Atomic Force Microscopy (AFM)
• Class supplementary information using nanoscale microscopy tools



Melting point - 1064° C

Source: K.J. Klabunde, 2001Source: http://www.ipt.arc.nasa.gov/



www.nano.gov



NNI
• The National Nanotechnology Initiative (NNI) is a federal 

R&D program established to coordinate the multiagency
efforts in nanoscale science, engineering, and 
technology. 

• The goals of the NNI are to:
– Maintain a world-class research and development program 

aimed at realizing the full potential of nanotechnology; 
– Facilitate transfer of new technologies into products for 

economic growth, jobs, and other public benefit; 
– Develop educational resources, a skilled workforce, and the 

supporting infrastructure and tools to advance nanotechnology; 
and, 

– Support responsible development of nanotechnology 



NNI – Educational Resources



http://www.nclt.us/



NSF
NISE network

(2005)

Informal Education
on

Nanotechnology



For Students K-12 
@ www.nano.gov



Nano IQ from NIST
http://www.nist.gov/public_affairs/nanotechquiz.htm



Nanotech Gallery from NASA
http://www.ipt.arc.nasa.gov/gallery.html



NASA - continued



Nano screen saver from NSF
http://www.nsf.gov/news/overviews/nano/screensaver.jsp#pc





• Brief Introduction on Nanotechnology
• Educational Resources on nanotechnology

– www.nano.gov

• RPI Nanoscale Science and Engineering Center: High 
school outreach program
– Bringing nanotechnology to the classroom (Program coordinator: 

Prof. Chang Y. Ryu (ryuc@rpi.edu)
• Hands on module: Carbon nanotube synthesizer
• Multimedia module: Virtual Scanning Electron Microscopy (SEM)
• Lecture module: Atomic Force Microscopy (AFM)
• Class supplementary information using nanoscale microscopy tools

Outline



RPI NSEC High School Outreach

Summer, 2005
(will continue in the summer of 2006)

2003 2004



Hands on Module: 
Carbon nanotube synthesizer

Tom Pittman, BHBL High School, “Metal-Tech” Teacher



Actual module – CNT synthesizer



Virtual Scanning Electron Microscopy (SEM) Laboratory
- Developed by UIUC (Our RPI NSEC partner) –

http://virtual.itg.uiuc.edu/downloads/

Go to www.java.com
And download java program first.

Also download images from
http://virtual.itg.uiuc.edu/data/



Actual module on Virtual SEM
- Paul Fedoroff, BHBL Physics teacher -



Actual module on Virtual SEM
- Paul Fedoroff, BHBL Physics teacher -



Atomic Force Microscopy (AFM) & Data Storage
Paul Fedoroff & Dr. Hoichang Yang (NSEC staff)



Optical Storage media – Tapping AFM

2μm

Topography TM AFM

CD-R (optical media) DVD-RW (optical media)

10μm10μm



CD vs. DVD

CD DVD

Specification CD                   DVD
Track Pitch                1600 nm            740 nm
Min. Pitch Length        860 nm            400 nm

The schematic diagrams above 
were obtained from http://www.howstuffworks.com/



Magnetic media - AFM

10μm

Floppy disk

10μm

Hard Disk

10μm

Mini Disk

20μm

Zip disk



5μm

10μm

Floppy disk

20μm

Zip disk

10μm

Hard Disk

1μm

10μm

Mini Disk

Zip disk Zip disk
TOP:
Topography

BOTTOM
: “magnetic”

Phase

Magnetic Force AFM



Summary
• Nanotechnology

– K-12 educational resources are abundant 
– Many nano-research centers have HS outreach 

programs. 
– www.nano.gov is a good place to start.

• RPI Nanoscale Science & Engineering Center
– “Bringing Nanotechnology to the Classroom”

• Carbon nanotube synthesizer (Hands on activities)
• Virtual SEM (Computer-based JAVA software)
• AFM and other class supplementary materials using state-of-

the-art nanoscale imaging tools at RPI
– Contact me at RPI (Prof. Chang Y. Ryu (ryu@rpi.edu))

NSEC: 
www.nano.rpi.edu

My research homepage
http://block.chem.rpi.edu
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